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СПИСОК СОКРАЩЕНИЙ 

3D – трехмерный 

SMD (Surface Mounted Device) – прибор, монтируемый на поверхность 

АЧХ – амплитудно-частотная характеристика 

ВАХ – вольт-амперная характеристика 

ВУ – внешнее управление 

ГПК – гибкий печатный кабель 

ДПП – двусторонняя печатная плата 

ЕСКД – единая система конструкторской документации 

ЗП – защита от переполюсовки 

ИИ – извещение об изменении 

ИПС – индикация питания на выходе стабилизатора 

КД – конструкторский документ 

КП – контактная площадка 

ЛКМ – левая кнопка мышки 

ЛР – лист регистрации изменений 

МПЛ – микрополосковая линия 

МПП – многослойная печатная плата 

ОПП – односторонняя печатная плата 

ПИ – панель инструментов 

ПКМ – правая кнопка мышки 

ПП – плата печатная 

ПФ – полосовой фильтр 

РФ – режекторный фильтр 

РУ – ручное управление 

САПР – система автоматизированного проектирования 

СВЧ – сверхвысокие частоты 

СКМ – средняя кнопка мышки 

СЛ – полосовой фильтр на параллельно связанных резонаторах 

ТТ – технические требования 

УГО – условное графическое обозначение 

ФВЧ – фильтр верхних частот 

ФНЧ – фильтр нижних частот 

ШТ – встречно-штыревой полосовой фильтр 
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ПРЕДИСЛОВИЕ 

В данном учебном пособии подробно рассматривается процесс разра-

ботки изделия, представляющего собой усилитель сигнала СВЧ-диапазона с 

регулировкой выходной мощности. 

Последовательность действий в пособии приведена для условного вари-

анта задания с обозначением «П1» (см. 1.2), а каждому студенту предлагается 

произвести аналогичную разработку по уникальному варианту индивидуаль-

ного задания. Оригинальность достигается разнобразием использованных 

параметров, их количеством и комбинациями: 

– 50 диапазонов частот от 1,5 до 9,6 ГГц; 

– 33 микросхемы усилителей фирмы Mini-Circuits; 

– 40 СВЧ-материалов фирм Arlon, Isola, Rogers и Taconic; 

– 6 вариантов схем защиты от переполюсовки; 

– 9 вариантов формы печатной платы (ПП) и др. 

Некоторые различия также появляются и в процессе проектирования, 

однако основные функциональные узлы, взаимосвязи между ними и подклю-

чение микросхем во всех вариантах остаются практически одинаковыми. 

В конечном итоге студенты разработают не только полный комплект 

конструкторских документов (КД) в соответствии с требованиями единой си-

стемы конструкторской документации (ЕСКД), но и выполнят следующие 

сопутствующие действия: 

– осуществят предварительный расчет полосового фильтра (ПФ) и его 

моделирование; 

– создадут библиотечный компонент; 

– выполнят расчеты номиналов резисторов и параметров питания изде-

лия в схеме электрической принципиальной; 

– произведут компоновку и трассировку ПП; 

– разработают 3D-модели и др. 

Процесс создания изделия в пособии разделен на этапы, каждый из ко-

торых посвящен решению отдельной задачи (например, разработка схемы 

электрической структурной) и находится в отдельном разделе или приложе-

нии. Этапы расположены в том порядке, в котором следует выполнять проек-

тирование, и разделены на две группы: 

– основные (разделы 1–24) – обязательные; 

– дополнительные (прил. Е–Р) – делаются по желанию. 
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Общая информация об этапах проектирования содержится в 2.6. 

В приложениях к пособию кроме описания дополнительных этапов про-

ектирования также приведены: внешний вид изготовленного опытного об-

разца для варианта «П1», результаты его работы, вспомогательные теорети-

ческие и практические сведения. 

Отличительными чертами учебного пособия являются: 

1. Подход к проектированию. Здесь используется не подбор задач для их 

решения с помощью одного программного продукта, а применение ряда про-

грамм и взаимосвязей между ними для достижения поставленной цели.  

Стоит отметить, что всек возможностей используемых в рамках настоя-

щего курса программ в короткие сроки раскрыть невозможно. Тем не менее 

преследуется цель ознакомления с основами работы на конкретных приме-

рах, что облегчит, при необходимости, дальнейшее освоение не только опи-

санных в пособии средств проектирования. 

2. Самодостаточность. В пособии содержится вся необходимая инфор-

мация для выполнения разработки: 

– подробные инструкции по выполнению этапов проектирования рас-

считаны на пользователей, впервые сталкивающихся с используемыми про-

граммными продуктами; 

– основные правила оформления КД и общие теоретические сведения 

позволяют понять процессы производства и проектирования, а также прин-

ципы работы изделия; 

– текстовые и графические пояснения приведены не только для рассмат-

риваемого варианта «П1», но и для всех возможных ситуаций из других ва-

риантов задания. 

3. Результаты проектирования. В конце этапов проектирования приво-

дятся результаты их выполнения для варианта «П1». Для лучшего понимания 

изложенного материала перед началом каждого этапа рекомендуется про-

сматривать эту информацию. 

Кроме того, в Г.18 содержатся полноценные результаты трех этапов 

проектирования (схема электрическая принципиальная, перечень элементов к 

ней и трассировка ПП) для варианта с обозначением «П2», максимально от-

личающегося от варианта «П1».  

Теоретические сведения в совокупности с результатами для одного кон-

кретного изделия позволяют использовать пособие в качестве справочника 

для аналогичных разработок. 
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4. Наличие внутритекстовых гиперссылок. Для удобства работы с посо-

бием в тексте присутствует большое количество гиперссылок, выделенных 

серым цветом. Переход между местами назначения и отправления при их ис-

пользовании осуществляется комбинациями клавиш: 

– Alt+Left (назад); 

– Alt+Right (вперед). 

Для быстрого перехода к любому разделу или подразделу можно вос-

пользоваться как гиперссылками из содержания, находящегося в конце посо-

бия, так и списком закладок, расположенным в левой части окна просмотра 

pdf-документа. 
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1. ЗАДАНИЕ НА ПРОЕКТИРОВАНИЕ 

1.1. Цели и задачи проектирования 

В ходе выполнения данного практического курса студенты осваивают 

этапы разработки радиоэлектронного СВЧ-устройства с использованием ос-

новных возможностей программного обеспечения, начиная с получения тех-

нического задания и заканчивая созданием его 3D-модели как альтернатив-

ного варианта производству. По окончании проектирования студенты будут 

обладать следующими навыками: 

– иметь представление и уметь пользоваться основными возможностями 

программного обеспечения по созданию радиоэлектронного устройства (со-

здание основных типов электрических схем, 3D-моделей устройств, черте-

жей, компоновка печатного узла, трассировка ПП и др.); 

– иметь представление и уметь пользоваться справочной информацией 

(datasheet) на электронные компоненты; 

– иметь представление о типоразмерах электронных компонентов; 

– уметь производить теоретический расчет СВЧ-структур и осуществ-

лять моделирование, понимать влияние геометрических параметров на их ха-

рактеристики; 

– уметь оформлять КД согласно требованиям ЕСКД. 

1.2. Содержание задания на проектирование 

В результате проектирования необходимо разработать полный комплект 

КД и 3D-модели на устройство СВЧ-диапазона, выполняющее три функции: 

– усиление сигнала заданной частоты; 

– ослабление помех, поступающих с полезным сигналом; 

– регулировка уровня выходной мощности. 

Разработка изделия осуществляется в соответствии с заданием на проек-

тирование, которое состоит из двух частей: индивидуальное и общее. 

Индивидуальное задание на проектирование. Данная часть задания 

представлена вариантами с примерно одинаковой сложностью выполнения. 

Они распределяются между студентами (один вариант на бригаду из 1–2 че-

ловек) и состоят из набора уникальных параметров. 

В учебном пособии разработка изделия осуществляется для данных из 

варианта с обозначением «П1» (пример № 1), приведенных в табл. 1.1. Здесь 

содержится следующая информация: 
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1. В столбце 1 – название СВЧ-материала ПП, на котором необходимо 

разработать устройство. 

Например, AD1000-0,508-18/18 из варианта «П1» – фольгированный ди-

электрик AD1000 фирмы Arlon с толщиной основания 0,508 мм и с двусто-

ронней металлизацией толщиной по 18 мкм. 

Необходимые параметры СВЧ-материалов, используемых при проекти-

ровании, приведены в табл. Б.2. 

2. В столбце 2 – аббревиатура структуры СВЧ-фильтра. Возможные ва-

рианты:  

– СЛ – ПФ на параллельно связанных резонаторах (рис. 4.6, а); 

– ШТ – встречно-штыревой ПФ (рис. 4.6, в). 

3. В столбце 3 – уровень мощности входного сигнала. 

4. В столбце 4 – нижняя и верхняя граничные частоты полосы пропуска-

ния СВЧ-фильтра, указанные через дробную черту (на устройство будет по-

даваться сигнал со средней частотой из указанного диапазона). 

5. В столбце 5 – частоты помех, подлежащие ослаблению. Указаны через 

дробную черту. 

6. В столбце 6 – значения, на которые необходимо ослабить соответ-

ствующие помехи с частотами из столбца 5. 

Например, в варианте «П1» помеху на частоте 1,8 ГГц требуется осла-

бить на величину 30 дБ, а помеху на частоте 2,85 ГГц – на 35 дБ. 
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7. В столбце 7 – типоразмер (типовой размер) корпуса танталового кон-

денсатора, для которого необходимо разработать посадочное место, условное 

графическое обозначение (УГО) и 3D-модель. 

Параметры корпусов типоразмеров A, B, C, D, E и V приведены на 

рис. 5.13 и в табл. 6.2. 

8. В столбце 8 – наименование микросхемы усилителя. 

9. В столбце 9 – наименование микросхемы аттенюатора. 

10. В столбце 10 – способ управления аттенюатором. Возможные вари-

анты: 

– ВУ – внешнее управление (через разъем по кабелю); 

– РУ – ручное управление (ручное замыкание или размыкание контактов 

в коммутационных устройствах, расположенных в изделии). 

11. В столбце 11 – наименования одного или двух разъемов: 

– первый – разъем питания. Через него на изделие будет подаваться 

внешнее напряжение питания; 

– второй (только для вариантов задания с ВУ) – разъем управления. Че-

рез него будет осуществляться управление аттенюатором. 

Например, для варианта «П1»: 

– разъем питания – вилка угловая MW-2MR фирмы Connfly; 

– разъем управления – розетка прямая IDC-20MS фирмы Connfly. 

Для вариантов задания с РУ для управления аттенюатором вместо разъ-

ема управления необходимо выбрать коммутационные устройства в соответ-

ствии с табл. 1.2. 

Таблица 1.2 

Коммутационные устройства для вариантов задания с РУ 

Кол. управляющих 

выводов аттенюатора 

Коммутационное устройство 

Наименование Кол. 

От 1 до 3 включ. 

Тактовая кнопка DTSM-32N-V-T/R фирмы 

Diptronics или кнопка с фиксацией MPS-

580D-G фирмы Switronic 

На каждый управ-

ляющий вывод атте-

нюатора по 1 шт. 

4 DIP-переключатель SWD4-4 фирмы Connfly 1 шт. 

5 DIP-переключатель SWD4-5 фирмы Connfly 1 шт. 

Примечания: 

– тактовая кнопка не имеет фиксации толкателя, тогда как кнопка с 

фиксацией работает по аналогии с кнопкой в шариковой ручке;  

– DIP (Dual In-line Package) – тип корпуса прямоугольной формы с дву-

мя рядами выводов по длинным сторонам. 
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Внешние виды некоторых используемых при проектировании разъемов 

показаны на рис. 8.33, а коммутационных устройств – на рис. 8.35. 

12. В столбце 12 – вариант формы ПП с рис. 1.1. 

Сплошной линией на рисунке показан контур ПП, а пунктирной – кон-

тур экранирования (область, в которой необходимо разместить СВЧ-тракт). 

Также на рисунке отмечены положения входа и выхода изделия. 

 

13. В столбце 13 – значения размеров с рис. 1.1 в формате «A / B / C». 

Допуски на размеры следующие: 

– для A и C – не более указанных значений; 

– для B – плюс-минус 1 мм от указанного значения. 

Например, в варианте «П1» размер А (ширина области экранирования по 

рис. 1.1, б) должен быть не более 25 мм, а размеров B и C нет. 

Отсутствующие и неуказанные на рисунке размеры ПП должны быть 

минимально возможными. Определяются они на этапе компоновки и трасси-

ровки ПП отдельно для каждого варианта задания в зависимости от исполь-

зованных компонентов (их количество, размеры и расстановка на ПП). 

Рис. 1.1 

а б в 

г д 

ж з 

е 

и 
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14. В столбце 14 – дополнительные требования: 

– ЗП-N – номер (N) схемы защиты от переполюсовки (см. В.11); 

– ИПС – наличие схемы индикации питания на выходе стабилизатора, 

выполненной на основе светодиода. 

Например, в варианте «П1» необходимо организовать только схему за-

щиты от переполюсовки № 3 (ЗП-3). 

Общее задание на проектирование. Данная часть задания содержит 

общие для всех вариантов задания требования к изделию: 

– изделие должно быть выполнено на двусторонней ПП (ДПП, см. Б.2) с 

расположением компонентов и печатных проводников только на верхней ее 

стороне; 

– на нижней стороне ПП должна быть сплошная металлизация, за ис-

ключением частей контактных площадок (КП) выводных компонентов; 

– габариты ПП – минимальные; 

– округление размеров элементов топологии ПП – до десятых долей 

миллиметра; 

– класс точности ПП – 4-й по ГОСТ Р 53429–2009 (табл. Б.6) [1]; 

– входное и выходное волновые сопротивления – 50 Ом; 

– наименование печатного узла – «усилитель»; 

– для крепления «усилителя» должна быть разработана деталь с наиме-

нованием «основание» из алюминиевого сплава Д16 ГОСТ 4784–97; 

– для экранирования СВЧ-тракта должна быть разработана деталь с 

наименованием «экран» из алюминиевого сплава Д16 ГОСТ 4784–97;  

– внешний контур «экрана» – пунктирная линия на рис. 1.1. В местах, в 

которых на рисунке «экран» и ПП имеют общие стороны, внешний контур 

«экрана» должен проходить по контуру ПП; 

– тип коаксиальных СВЧ-разъемов для подачи и снятия полезного сиг-

нала – розетка SMA-KFD5A фирмы-поставщика ООО «Амитрон Электро-

никс» (рис. 10.2); 

– СВЧ-разъемы должны крепиться к «основанию» винтами М2; 

– наименование изделия в сборе («усилитель», «экран», «основание» и 

СВЧ-разъемы) – «модуль усилителя»; 

– соединение «усилителя», «экрана» и «основания» – винты М2,5; 

– толщина «модуля усилителя» в области «экрана» – не более 10 мм; 

– необходимо предусмотреть возможность использования «усилителя» 

отдельно от «основания» и «экрана» с установкой двух торцевых коаксиаль-
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ных СВЧ-разъемов EMPCB.SMAFSTJ.B.HT фирмы Taoglas, для чего на ПП 

должны быть размещены соответствующие КП (см. рис. 12.51, в). 

Структура изделия для варианта «П1» приведена на рис. 2.1. 

1.3. Содержание отчета 

По 1-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Содержание варианта индивидуального задания на проектирование в 

виде таблицы с расшифровкой всех указанных в нем данных. 

2. Содержание общего задания на проектирование. 
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2. ПЕРЕЧЕНЬ КД И ОСОБЕННОСТИ ПРОЕКТИРОВАНИЯ 

2.1. Виды изделий 

Виды изделий всех отраслей промышленности при выполнении кон-

структорской документации устанавливает ГОСТ 2.101–2016 [2]. 

Изделие – предмет или набор предметов производства, подлежащих из-

готовлению в организации (на предприятии) по КД. 

Составная часть изделия – изделие, выполняющее определенные 

функции в составе другого изделия. 

Виды изделий по конструктивно-функциональным характеристикам: 

1. Деталь – изделие, изготовленное из однородного по наименованию и 

марке материала, без применения сборочных операций (например, литой 

корпус или колпачок от шариковой ручки).  

К деталям также относятся указанные изделия, подвергнутые покрытиям 

(защитным или декоративным), независимо от вида, толщины и назначения 

покрытия, или изготовленные с применением местной сварки, пайки, склей-

ки, сшивки и т. п., например: винт, подвергнутый хромированию; трубка, 

спаянная или сваренная из одного куска листового материала; коробка, скле-

енная из одного куска картона; ДПП. 

2. Сборочная единица – изделие, составные части которого подлежат со-

единению между собой на предприятии-изготовителе сборочными операци-

ями (свинчиванием, пайкой, клепкой, сваркой, опрессовкой, склеиванием, 

сшивкой, развальцовкой и т. п.), например: автомобиль, телефонный аппарат, 

микромодуль, сварной корпус, шариковая ручка, многослойная ПП (МПП). 

К сборочным единицам также относят следующие изделия: 

– изделия, для которых конструкцией предусмотрена разборка их на со-

ставные части, например для удобства транспортирования; 

– совокупность сборочных единиц и (или) деталей с общим функцио-

нальным назначением, устанавливаемых на предприятии-изготовителе вме-

сте в другой сборочной единице, например: электрооборудование автомоби-

ля, набор составных частей врезного замка (замок, запорная планка, ключи); 

– совокупность сборочных единиц и (или) деталей, имеющих общее 

функциональное назначение, совместно уложенных на предприятии-изгото-

вителе в укладочные средства (футляр, коробку и т. п.), которые предусмот-

рено использовать вместе с уложенными в них изделиями (например, набор 

чертежных инструментов – готовальня); 
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– упаковочную единицу, представляющую изделие, создаваемое в ре-

зультате соединения упаковываемой продукции с упаковкой. 

3. Комплекс – два и более специфицированных изделия, не соединенных 

на предприятии-изготовителе сборочными операциями, но предназначенные 

для выполнения взаимосвязанных эксплуатационных функций. Каждое из 

этих изделий служит для выполнения одной или нескольких основных функ-

ций, установленных для всего комплекса, например изделие, состоящее из 

метеорологической ракеты, пусковой установки и средств управления. 

В комплекс также могут входить детали, сборочные единицы и комплек-

ты, предназначенные для выполнения вспомогательных функций, например 

для монтажа комплекса на месте его эксплуатации. 

4. Комплект – два и более изделия, не соединенных на предприятии-

изготовителе сборочными операциями и представляющих набор изделий, 

имеющих общее эксплуатационное назначение вспомогательного характера, 

например комплект запасных частей, укладочных средств или тары. 

К комплектам также относят сборочную единицу или деталь, поставля-

емую вместе с набором других сборочных единиц и (или) деталей, предна-

значенных для выполнения вспомогательных функций при эксплуатации 

этой сборочной единицы или детали, например осциллограф в комплекте с 

укладочным ящиком и сменными частями. 

Виды изделий по назначению: 

– основного производства – изделие, предназначенное для поставки (ре-

ализации) в качестве товарной продукции; 

– вспомогательного производства – изделие, предназначенное для нужд 

предприятия, изготовившего его (нетоварное изделие). 

Виды изделий по разработке: 

– собственного производства – изделие, изготавливаемое на данном 

предприятии по КД, переданным держателем подлинника (разработчиком 

или другой организацией, предусмотренной техническим заданием); 

– покупное – изделие, изготовленное по КД предприятия-поставщика, 

приобретаемое в готовом виде с эксплуатационной документацией; 

– кооперированное – изделие, получаемое предприятием в готовом виде 

и изготовленное по его КД; 

– заимствованное – изделие, которое применяют в другом изделии по 

ранее разработанной КД данным предприятием. 

Виды изделий по структуре: 
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– специфицированное – изделие из двух и более составных частей (сбо-

рочная единица, комплекс, комплект); 

– неспецифицированное – изделие без составных частей (деталь). 

Виды изделий по уровню стандартизации: 

– оригинальное – изделие, примененное в КД только одного изделия; 

– унифицированное – изделие, примененное в КД нескольких изделий; 

– стандартное – изделие, примененное по стандарту, полностью и одно-

значно определяющему его конструкцию, показатели качества, методы кон-

троля, правила приемки и поставки. 

2.2. Стадии разработки изделий 

По ГОСТ 2.103–2013 [3] установлены следующие стадии разработки КД 

на изделия всех отраслей промышленности: 

1. Техническое предложение – совокупность КД, содержащих техниче-

ские и технико-экономические обоснования целесообразности разработки 

документации изделия на основании анализа технического задания и вариан-

тов возможных решений изделий, сравнительной оценки разрабатываемого и 

существующих изделий, а также патентные исследования. 

Техническое предложение после утверждения является основанием для 

разработки эскизного проекта, а КД присваивается литера П (реквизит КД на 

изделие, соответствующий стадии разработки). 

2. Эскизный проект – совокупность КД, содержащих принципиальные 

конструктивные решения, дающие общее представление о назначении, об 

устройстве, принципе работы и габаритных размерах разрабатываемого из-

делия, а также данные, определяющие его основные параметры. 

Эскизный проект после утверждения является основанием для разработ-

ки технического проекта или рабочей конструкторской документации, а КД 

присваивается литера Э. 

3. Технический проект – совокупность КД, содержащих окончательные 

технические решения, дающие полное представление об устройстве разраба-

тываемого изделия, и исходные данные для разработки рабочей конструктор-

ской документации. 

Технический проект после утверждения является основанием для разра-

ботки рабочей конструкторской документации, а КД присваивается литера Т. 

КД, созданные на стадиях технического предложения, эскизного и тех-

нического проектов образуют проектную конструкторскую документацию. 
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4. Рабочая конструкторская документация – совокупность КД, выпол-

ненных на стадиях опытного образца (опытной партии), серийного (массово-

го) и единичного производства и предназначенные для изготовления, эксплу-

атации, ремонта (модернизации) и утилизации изделия.  

КД на данной стадии присваиваются следующие литеры: 

– без литеры – КД до изготовления и испытания опытного образца 

(опытной партии) изделия; 

– О – скорректированные КД после изготовления и испытания опытного 

образца (опытной партии) изделия; 

– О1 – скорректированные КД после приемочных испытаний опытного 

образца (опытной партии) изделия; 

– А – скорректированные КД после изготовления и испытания устано-

вочной серии, а также оснащения технологического процесса изготовления 

изделия; 

– И – КД, предназначенные для изготовления и испытания изделий еди-

ничного производства. 

Для изделий, разрабатываемых по заказу Министерства обороны, также 

предусмотрены следующие литеры: 

– О2, О3, …, Оn – скорректированные КД после повторных изготовлений 

и испытаний опытного образца (опытной партии) изделия; 

– Б – скорректированные КД после изготовления и испытания головной 

(контрольной) серии по КД с литерой А. 

2.3. Обозначение изделий и КД 

Правила обозначения изделий машиностроения всех отраслей промыш-

ленности и КД кроме эксплуатационных и ремонтных документов устанав-

ливает ГОСТ Р 2.201–2023 [4]. 

Общие положения: 

– каждому изделию и КД должно быть присвоено уникальное обозначе-

ние, которое нельзя использовать для идентификации другого изделия и КД; 

– обозначение присваивает организация – разработчик изделия и КД; 

– изделия и КД сохраняют присвоенное им обозначение независимо от 

того, в каких изделиях и КД они применяются; 

– обозначение представляет собой совокупность идентифицирующих и 

разделительных знаков (последние в отдельных случаях могут отсутство-

вать). Идентифицирующими знаками могут быть арабские цифры и пропис-
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ные буквы латинского и русского алфавита, а разделительными знаками – 

точка (код в Unicode16: 002Е) и дефис (код в Unicode16: 2012); 

– при обозначении изделий и КД применяют два способа: обезличенный 

и объектно-ориентированный. Способ обозначения и детальные требования к 

присвоению обозначений с учетом особенностей изделий устанавливают в 

стандартах организации, при этом для изделий, разрабатываемых по заказам 

государственного заказчика, такие документы должны быть согласованы с 

заказчиком (представительством заказчика). 

Обезличенный способ обозначения изделий основан на использовании 

кода организации-разработчика и классификации изделия по конструктив-

ным, функциональным, геометрическим и иным признакам. Структура обо-

значения изделия для данного способа приведена на рис. 2.1. 

 

Код организации-разработчика – код из четырех прописных букв рус-

ского алфавита, который присваивает Федеральное агентство по техническо-

му регулированию и метрологии или иные уполномоченные организации, 

например для СПбГЭТУ «ЛЭТИ» – СПВГ. Также возможны допущения: 

– при невозможности использования букв русского алфавита в обозна-

чении (например, при поставке изделия на экспорт) допускается записывать 

восьмизначный цифровой код из арабских цифр, представляющих собой 

цифровую кодировку имеющихся четырех букв, например для «СПВГ» – 

19170304. При наличии у организации-разработчика четырехзначного бук-

венного кода дополнительная регистрация (присвоение) восьмизначного 

цифрового кода уполномоченной организацией не требуется; 

– допускается применять код по Общероссийскому классификатору 

предприятий и организаций (ОК 007-93 – ОКПО) [5], присвоенный Феде-

ральным агентством государственной статистики (Росстат), например для 

СПбГЭТУ «ЛЭТИ» – 02068539. 

Код классификационной характеристики определяют по Общероссий-

скому классификатору изделий и конструкторских документов (ОК 012–93 – 

классификатор ЕСКД) [6]. Например, код 687252 означает: 

Рис. 2.1 

Код организации-разработчика 

Код классификационной характеристики, где AA – класс, 

B – подкласс, C – группа, D – подгруппа, E – вид 

Порядковый регистрационный номер 

XXXX.AABCDE.NNN 
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– класс 68 – оборудование электротермическое, электросварочное и для 

диффузионной сварки. Устройства магнитопроводящие, токопроводящие, 

электроизолирующие, электромонтажные. Монтаж механический; 

– подкласс 7 – устройства электромонтажные. Монтаж механический; 

– группа 2 – элементы электромонтажные; 

– подгруппа 5 – ПП многослойные до 5 слоев включительно шириной; 

– вид 2 – свыше 20 до 50 мм включительно. 

Расшифровка некоторых других кодов приведена в прил. Р. 

Допускается применение иных классификаторов, принятых в отрасли, 

корпорации или организации с другим количеством знаков, уровней и при-

знаков классификации, указанных в стандарте организации. Однако для из-

делий, разрабатываемых по заказу государственного заказчика, данное реше-

ние должно быть согласовано с заказчиком (представителем заказчика). 

Порядковый регистрационный номер присваивают последовательно в 

рамках изделий с одной классификационной характеристикой. Количество 

знаков может быть увеличено по усмотрению организации-разработчика (на 

один и более). 

Обозначение КД должно содержать обозначение изделия, на которое 

оно разработано. Общая структура обозначения КД при обезличенном спосо-

бе приведена на рис. 2.2. 

 

Код вида документа указывают по ГОСТ Р 2.102–2023 [7] (например, 

для сборочного чертежа – СБ). Отдельно следует обратить внимание на ос-

новные КД (см. п. 1 из 2.4), обозначения которых должны совпадать с обо-

значением изделия (код вида документа отсутствует), однако при необходи-

мости код все же допускается указывать (например, для спецификации – СП). 

Примеры обозначений по обезличенному способу для двадцатой четы-

рехслойной ПП шириной 40 мм, разработанной в СПбГЭТУ «ЛЭТИ»: 

– СПВГ.687252.020СБ – сборочный чертеж; 

– СПВГ.687252.020 – изделие и спецификация. 

Объектно-ориентированный способ обозначения изделия основан на ис-

пользовании кода конечного изделия и признаков, указывающих на позицию 

изделия в структуре конечного изделия. Структура обозначения для данного 

Рис. 2.2 

Код вида документа 

Обозначение изделия 

XXXX.AABCDE.NNNKKK 
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способа по общему виду похожа на приведенную на рис. 2.1 и состоит из 

трех групп идентифицирующих знаков с разделителями между ними (по 

умолчанию – точки; допускается использованием дефисов): 

– код конечного изделия; 

– код, отражающий позицию изделия в структуре конечного изделия; 

– порядковый регистрационный номер. 

Код (индекс) конечного изделия (итоговая разработка данной организа-

ции) присваивает организация-разработчик или заказчик изделия. Если ко-

нечное изделие имеет несколько вариантов (модификаций), то код может со-

стоять из кода типа изделия (идентифицирующий признак, общий для сово-

купности всех вариантов (модификаций) изделия) и кода варианта (модифи-

кации) изделия. При необходимости, эти две части могут быть записаны че-

рез разделительный знак. 

Код, отражающий позицию изделия в структуре конечного изделия, 

присваивают по принятым в отрасли или организации правилам. Он может 

характеризовать данное изделие как составную часть другого изделия по раз-

личным признакам: 

– принадлежность к функциональной системе (подсистеме); 

– входимость в агрегат или значимый конструктивный узел; 

– отнесение к конструктивной группе (подгруппе); 

– иные принципы декомпозиции и (или) классификации составных ча-

стей (в том числе по классификатору ЕСКД); 

– сочетание перечисленных выше признаков. 

Код данной группы может быть представлен совокупностью нескольких 

групп знаков, отделенных разделительными знаками. 

Порядковый регистрационный номер изделия присваивают в рамках вы-

деленной составной части (предыдущей группы знаков) или конечного изде-

лия в целом. Он также может быть представлен совокупностью нескольких 

групп знаков (например, при разделении сборочных единиц и деталей), отде-

ленных разделительными знаками. 

Количество знаков в рассмотренных трех группах идентифицирующих 

знаков – 4, 6 и 4 соответственно, однако в каждой группе оно может быть как 

увеличено, так и уменьшено. 

Структура обзначения КД в объектно-ориентированном способе совпа-

дает с показанной на рис. 2.2, за исключением того, что по умолчанию обо-

значение изделия отделяется от кода вида документа точкой. 
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Примеры обозначений по объектно-ориентированному способу для пер-

вой четырехслойной ПП шириной 40 мм (использована классификация изде-

лия по классификатору ЕСКД) в конечном изделии «0110»: 

– 0110.687252.0001.СБ – сборочный чертеж; 

– 0110.687252.0001 – изделие и спецификация. 

Особенности структур обозначения изделия и КД: 

– при использовании исполнений изделий по ГОСТ 2.113–75 [8] (см. 

прил. Н) к общей части обозначения изделия по рис. 2.1 (в этом случае оно 

называется базовым обозначением) через дефис добавляется номер исполне-

ния (например, СПВГ.687252.020-05) и (при необходимости) дополнитель-

ный номер исполнения, отделяемый от первого точкой; 

– между обозначением изделия и кодом вида документа допускается как 

использовать разделительный знак, так и не применять его исходя из особен-

ностей КД; 

– после кода вида документа в случае, если на одно изделие разрабаты-

вается больше одного КД определенного вида (например, несколько ин-

струкций со сведениями разного характера), добавляется порядковый номер 

такого КД (по умолчанию через точку в объектно-ориентированном способе 

и без разделительного знака в обезличенном способе); 

– в текстовых КД, разбитых на части и книги, после кода вида докумен-

та (или порядкового номера КД при наличии) указывают порядковые номера 

части и книги (по умолчанию через точки в объектно-ориентированном спо-

собе и без разделительных знаков в обезличенном способе). 

При проектировании в данном учебном пособии обозначение изделий 

будет строиться по объектно-ориентированному способу, но без кода, отра-

жающего позицию изделия в структуре конечного изделия (рис. 2.3). 

 

Код конечного изделия состоит из буквы «У», обозначающей «учебный 

проект», и номера варианта. Например, У15. 

Порядковый номер сборочной единицы начинается с 00, при этом 00 

обозначает разрабатываемое изделие в целом (1-ю сборочную единицу), 01 – 

2-ю сборочную единицу, 02 – 3-ю сборочную единицу и т. д. 

Рис. 2.3 

Код конечного изделия 

Порядковый номер сборочной единицы 

Порядковый номер детали  

XXX.NN.NN 
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Порядковый номер детали начинается с 01 и определяет номер детали из 

состава указанной сборочной единицы, при этом 01 означает саму сборочную 

единицу, 02 – 1-ю деталь, 03 – 2-ю деталь и т. д. 

Примеры обозначений: 

– У06.00.03 – основной КД (чертеж) 2-й детали из состава 1-й сборочной 

единицы, разработанной в учебном проекте по 6-му варианту задания; 

– У10.00.01 – основной КД (спецификация) 1-й сборочной единицы, раз-

работанной в учебном проекте по 10-му варианту задания; 

– У15.01.01СБ – неосновной КД (сборочный чертеж) 2-й сборочной еди-

ницы, разработанной в учебном проекте по 15-му варианту задания. 

Преимущество принятой структуры состоит в следующем: 

– по ней легко определить вхождение одного изделия в другое; 

– обозначение изделия не зависит от его функционального назначения, 

особенностей работы и конструктивных различий, поэтому для каждого ва-

рианта задания оно будет отличаться только номером варианта. 

2.4. Комплектность КД 

При определении комплектности КД, устанавливаемой на стадиях раз-

работки изделия в ГОСТ Р 2.102–2023, следует различать: 

1. Основной КД изделия в отдельности или в совокупности с другими 

записанными в нем КД (неосновными КД) полностью и однозначно опреде-

ляет данное изделие и его состав. Основными КД являются: 

– для деталей – чертеж или электронная модель детали; 

– для сборочных единиц, комплексов и комплектов – спецификация или 

электронная конструктивная структура изделия. 

Изделие записывают в документы других изделий, в которых оно при-

менено, за обозначением своего основного КД. 

2. Основной комплект КД изделия состоит из основного КД изделия, а 

также КД, относящихся ко всему изделию в целом и записанных в его основ-

ном КД (например, сборочный чертеж, схема электрическая принципиальная, 

технические условия). КД на составные части изделия в основной комплект 

КД данного изделия не входят. 

3. Полный комплект КД изделия в общем случае состоит из: 

– основного комплекта КД на данное изделие; 

– основных комплектов КД на все составные части данного изделия, 

кроме покупных и стандартных изделий. 
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2.5. Перечень разрабатываемых КД 

Для составления перечня полного комплекта КД необходимо предста-

вить внешний вид разрабатываемого изделия и понять, из каких составных 

частей оно состоит. 

На рис. 2.4 показан эскиз изделия для варианта «П1» с разнесенными со-

ставными частями (в других вариантах задания будут точно такие же состав-

ные части, но они могут отличаться внешним видом и расположением в со-

ответствии с рис. 1.1). Винты представлены в виде условных изображений по 

ГОСТ 2.315–68 [9]. 

 

Из приведенного эскиза видно, что изделие, имеющее по общему зада-

нию на проектирование наименование «модуль усилителя», является сбороч-

ной единицей, т. е. оно состоит из составных частей, соединяемых друг с 

другом. Основным КД для сборочной единицы является спецификация, в ко-

торой перечисляются ее составные части. Правила выполнения специфика-

ций приведены в 18.1. 

По структуре обозначения с рис. 2.3 спецификации на «модуль усилите-

ля» будет присвоено обозначение УП1.00.01. Следует обратить внимание на 

то, что код документа в обозначении отсутствует. 

Чтобы собрать «модуль усилителя», необходим сборочный чертеж, ко-

торый содержит изображение изделия и данные, требуемые для осуществле-

ния сборки (взаимное расположение деталей после сборки, способ стопоре-

Рис. 2.4 
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ния крепежных винтов, покрытия и т. п.). Правила выполнения сборочных 

чертежей приведены в 19.4. 

Любому неосновному документу, разработанному для сборочной еди-

ницы, присваивается обозначение его спецификации с добавлением соответ-

ствующего кода документа. Для сборочного чертежа – СБ. Таким образом, 

обозначение сборочного чертежа «модуля усилителя» будет записано в виде 

УП1.00.01СБ. 

Кроме сборочного чертежа будет разработан документ, в котором пока-

зывается полный состав компонентов в виде УГО и их взаимосвязи. В вари-

антах задания – соединение входного и выходного СВЧ-разъемов с печатным 

узлом (ПП с установленными на ней компонентами). Этим документом явля-

ется схема электрическая принципиальная (полная), правила выполнения ко-

торой приведены в 8.1. Код документа для такой схемы – Э3. Обозначение 

документа – УП1.00.01Э3. 

Так как на схеме Э3 присутствуют только УГО компонентов, то для по-

лучения подробной информации о них (фирма, обозначение производителя 

и др.) необходим перечень элементов, правила оформления которого приве-

дены в 9.1. Код документа для перечня элементов состоит из буквы П и кода 

схемы, для которой он разрабатывается. Таким образом, обозначение перечня 

элементов для схемы Э3 «модуля усилителя» – УП1.00.01ПЭ3. 

Для отражения функциональных частей изделия, их назначения, взаимо-

связей и путей распространения основных сигналов необходимо разработать 

схему электрическую структурную, правила выполнения которой приведены 

в 3.1. Код документа для такой схемы – Э1. Обозначение документа – 

УП1.00.01Э1. Перечень элементов для схемы Э1 не разрабатывается, так как 

все необходимые данные указываются прямо на ней. 

Перечисленные выше документы представляют собой основной ком-

плект КД на «модуль усилителя». 

Как видно из рис. 2.4, «модуль усилителя» состоит из двух деталей и од-

ной сборочной единицы. По общему заданию на проектирование детали 

имеют наименования «экран» и «основание», а сборочная единица (печатный 

узел) – наименование «усилитель». 

Для детали основным КД является ее чертеж, т. е. документ, по которо-

му ее можно изготовить. Правила выполнения чертежей приведены в 

прил. Д. Обозначение чертежа детали составляется аналогично специфика-

ции на сборочную единицу без указания кода документа. 
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Так как «экран» и «основание» входят в состав сборочной единицы с 

порядковым номером «00», то в соответствии с рис. 2.3 обозначения черте-

жей будут следующими: 

– для «основания» – УП1.00.02;  

– для «экрана» – УП1.00.03. 

Так как «усилитель» является 2-й сборочной единицей и представляет 

собой ПП с размещенными на ней компонентами (резисторами, конденсато-

рами, микросхемами и т. п.), то для него, как и для «модуля усилителя», бу-

дут разработаны спецификация и сборочный чертеж с обозначениями 

УП1.01.01 и УП1.01.01СБ соответственно. 

Для получения полного состава компонентов «усилителя» (резисторы, 

микросхемы и др.) и их взаимосвязей, а также для последующей разработки 

ПП понадобится создать схему Э3 с обозначением УП1.01.01Э3 и перечень 

элементов к ней с обозначением УП1.01.01ПЭ3. 

ПП выполняет функцию несущей конструкции для обеспечения элек-

трического соединения и механического крепления устанавливаемых на нее 

компонентов. Также на ней будет реализован один из функциональных узлов 

изделия – полосовой СВЧ-фильтр. 

ДПП (именно такая задана по общему заданию на проектирование) яв-

ляется деталью, поэтому на нее необходимо выпустить чертеж, правила 

оформления которого приведены в 17.1. Так как ПП входит в состав «усили-

теля» и является 1-й деталью, то ее обозначение – УП1.01.02. Наименование 

детали должно быть «плата печатная». 

Для «платы печатной» будет создан документ «данные проектирова-

ния», состоящий из одного файла на носителе данных. Код документа – Д33. 

Обозначение – УП1.01.02Д33. 

Указанный файл из «данных проектирования» появится после расста-

новки компонентов и разработки топологии по разд. 12 и обеспечит получе-

ние на предприятии-изготовителе полного комплекта или части комплекта 

КД на ПП. В нем содержится информация для изготовления рисунка ПП 

(например, положение и параметры печатных проводников), координаты и 

размеры отверстий, области нанесения защитной паяльной маски и др. 

Для указания лиц, ответственных за разработку, изготовление, согласо-

вание и утверждение «данных проектирования», разрабатывается удостове-

ряющий лист. Его обозначение складывается из обозначения «данных проек-

тирования» и кода УД через дефис: УП1.01.02Д33-УД. 
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Компоненты, устанавливаемые на ПП, являются покупными, поэтому на 

них КД не разрабатываются. 

Все указанные выше КД, перечень которых для варианта «П1» приведен 

в табл. 2.1, разрабатываются на основных этапах проектирования. Аналогич-

ные КД необходимо создать и в каждом варианте задания. 

Таблица 2.1 

Перечень КД, разрабатываемых на основных этапах проектирования 

Обозначение КД Наименование КД 
Наименование  

изделия 

Раздел 

пособия 

УП1.00.01 Спецификация 

Модуль усилителя 

22 

УП1.00.01СБ Сборочный чертеж 23 

УП1.00.01Э1 Схема электрическая структурная 3 

УП1.00.01Э3 Схема электрическая принципиальная 10 

УП1.00.01ПЭ3 Перечень элементов 11 

УП1.00.02 Чертеж Основание 21 

УП1.00.03 Чертеж Экран 20 

УП1.01.01 Спецификация 

Усилитель 

18 

УП1.01.01СБ Сборочный чертеж 19 

УП1.01.01Э3 Схема электрическая принципиальная 8 

УП1.01.01ПЭ3 Перечень элементов 9 

УП1.01.02 Чертеж 

Плата печатная 

17 

УП1.01.02Д33 Данные проектирования 12 

УП1.01.02Д33-УД Удостоверяющий лист 12.6 

В прил. Р для сравнения приведена запись перечисленных КД по основ-

ной структуре системы обозначения. 

Кроме перечисленных КД в пособии предлагается разработать также 

схему электрическую функциональную «усилителя» и ведомость покупных 

изделий для «модуля усилителя», но уже в рамках дополнительных этапов 

проектирования. 

2.6. Средства и последовательность проектирования 

Как отмечалось ранее, весь процесс разработки изделия в пособии раз-

делен на этапы проектирования, каждый из которых содержит необходимую 

информацию по выполнению отдельной задачи. Этапы проектирования 

представлены в виде двух групп: основные и дополнительные. 

Основные этапы проектирования. Данные этапы являются обязатель-

ными и при очной форме обучения выполняются в основном в выделенные 

на дисциплину аудиторные часы в присутствии преподавателя. 
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Основные этапы проектирования приведены в разделах с 1-го по 24-й 

(каждый раздел содержит описание только одного этапа того же номера), а 

последовательность их выполнения показана в виде блок-схемы на рис. 2.5. 

Каждый из десяти блоков на рисунке – это условное занятие (суммарное 

время всех занятий по дисциплине в неделю), за которое необходимо выпол-

нить приведенные в нем этапы. Около блоков размещены характерные для 

них графические пояснения – миниатюры разработанных КД, скриншоты 

программ, в которых производится проектирование, и др. 

Указанный на рис. 3.5 порядок выполнения обусловлен тем, что практи-

чески для каждого последующего этапа проектирования нужны результаты 

предыдущих, например: 

– для создания чертежа «экрана» желательно наличие его 3D-модели; 

– для создания 3D-модели «экрана» нужны размеры ПП и вид проводя-

щего рисунка на ней; 

– для трассировки ПП нужны схема Э3 «усилителя» и геометрические 

размеры топологии ПФ и др. 

На основных этапах проектирования необходимо выполнить следующие 

ключевые действия: 

1. На этапе 1 (разд. 1) разобраться с требованиями общего задания на 

проектирование и с параметрами варианта индивидуального задания на про-

ектирование в соответствии с описанием, приведенным для варианта «П1». 

2. На этапе 2 (разд. 2): 

– разобраться с принятой в пособии системой обозначений КД; 

– ознакомиться с внешним видом разрабатываемого изделия и его со-

ставными частями, а также составить перечень разрабатываемых КД; 

– ознакомиться с кратким содержанием этапов проектирования, а также 

с последовательностью и средствами их выполнения; 

– получить представление о способе организации файловой структуры 

проекта и при желании продумать свой вариант. 

3. На этапе 3 (разд. 3): 

– ознакомиться с правилами выполнения структурных схем;  

– настроить редактор схем, в котором будет производиться работа, и 

осуществить подключение рамок и заполнение их полей; 

– нарисовать схему Э1 «модуля усилителя»; 

– произвести необходимые вычисления с использованием данных из до-

кументации на микросхемы усилителя и аттенюатора. 
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17. Чертеж ПП 

18. Спецификация на «усилитель» 

19. Сборочный чертеж «усилителя» 

20. Чертеж «экрана» 
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Разработка схем, трассировка ПП и создание библиотечных компонен-

тов в пособии будет производиться в системе автоматизированного проекти-

рования (САПР) Altium Designer. По отраслевому назначению такие САПР, 

используемые в области радиоэлектроники, имеют аббревиатуры EDA (elec-

tronic design automation) или ECAD (electronic computer-aided design). 

Altium Designer – передовая динамично развивающаяся профессиональ-

ная САПР фирмы Altium Limited, предоставляющая пользователям максимум 

возможностей по разработке радиоэлектронных устройств: схемотехническое 

моделирование, интерактивная и автоматическая трассировка сложных циф-

ровых ПП, 3D-режим просмотра, совместная работа над большими проекта-

ми, импорт и экспорт файлов в форматы других САПР, разработка програм-

мируемых логических интегральных схем (ПЛИС), написание собственных 

приложений и др. 

Примерами похожих САПР являются Mentor Graphics Expedition фир-

мы Mentor Graphics и OrCAD фирмы Cadence Design Systems. 

Следует отметить, что профессиональные САПР, несмотря на все свои 

достоинства, обладают и вытекающими из них недостатками: требователь-

ность к системным ресурсам, высокая цена и относительно большие времен-

ные затраты на их освоение из-за разнообразных настроек и функций. 

Среди более простых развивающихся ECAD, предназначенных для раз-

работки ПП, можно выделить две группы: 

– САПР, подходящие для разработки небольших ПП и имеющие огра-

ниченный набор функций и возможностей. Например, Sprint-Layout фирмы 

Abacom позволяет трассировать ПП только с двумя сигнальными слоями, а 

DipTrace фирмы Novarm Limited хоть и обладает возможностями, уступаю-

щими Altium Designer, но для некоммерческого использования является бес-

платной со всеми функциями полной версии при ограничении на 300 выво-

дов и два сигнальных слоя максимум; 

– САПР, распространяемые по лицензии на свободное программное 

обеспечение (GNU General Public License). Например, KiCad под разработ-

кой KiCad Developers Team. 

Отдельно стоит выделить САПР P-CAD. Несмотря на то что в 2006 г. 

фирма Altium Limited прекратила ее поддержку, при работе в одиночку над 

относительно несложными проектами ПП она уступает Altium Designer по 

большей части только отсутствием 3D-режима просмотра, но при этом имеет 

существенно более низкие системные требования. 
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Каждая из перечисленных САПР обладает своими достоинствами и не-

достатками, которые в том числе определяются и личными предпочтениями 

пользователя (например, удобство интерфейса). Тем не менее общий прин-

цип работы в целом одинаковый. 

4. На этапе 4 (разд. 4): 

– ознакомиться с теоретической информацией по фильтрам, а также по 

ПП из прил. Б; 

– произвести предварительные расчеты, определив ширину 50-омного 

полоскового элемента и порядок СВЧ-фильтра; 

– нарисовать схему структуры СВЧ-фильтра из варианта индивидуаль-

ного задания на проектирование (СЛ или ШТ) и произвести ее оптимизацию; 

– выполнить статистический анализ; 

– осуществить электромагнитное моделирование СВЧ-фильтра и сохра-

нить полученную топологию в формате DXF для последующего импорта в 

Altium Designer для разработки ПП. 

Моделирование СВЧ-фильтра будет производиться в редакторе Micro-

wave Office (MWO) из состава САПР NI AWR Design Environment фирмы 

National Instruments (ранее – AWR Corporation). Он предназначен для проек-

тирования радиочастотных устройств и устройств СВЧ, позволяет произво-

дить линейное (2D-анализ) и электромагнитное моделирование (2.5D-ана-

лиз – EMSight-симулятор; 3D-анализ планарных СВЧ-структур – AXIEM-

симулятор), а также обладает рядом других возможностей. 

Примерами САПР, предназначенных для электромагнитного моделиро-

вания с 3D-анализом планарных СВЧ-структур (микрополосковые линии 

(МПЛ), копланарные линии, МПП с переходными отверстиями различных 

конфигураций и др.), являются Genesys фирмы Keysight Technologies, Inc. и 

Sonnet Suites фирмы Sonnet Software, Inc. В Sonnet Suites отсутствует 2D-

анализ, но при этом доступна бесплатная версия (Sonnet Lite) для моделиро-

вания несложных СВЧ-структур. 

Примерами САПР, позволяющих моделировать произвольные 3D-объек-

ты СВЧ-диапазона с построением объемной сетки (объемные антенны, вол-

новодные элементы, 3D-неоднородности, СВЧ-фильтры и др.), являются 

CST Microwave Studio фирмы CST и HFSS фирмы ANSYS. 

5. На этапе 5 (разд. 5): 

– создать посадочное место для танталового конденсатора с типоразме-

ром из варианта индивидуального задания на проектирование; 
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– нарисовать УГО поляризованного конденсатора; 

– подключить посадочное место к УГ0 и создать интегрированную биб-

лиотеку, необходимую для создания схемы Э3 «усилителя». 

Работа будет производиться в Altium Designer в редакторах посадочных 

мест и УГО. 

6. На этапе 6 (разд. 6): 

– произвести настройку САПР и ознакомиться с основными понятиями 

при создании 3D-моделей; 

– разработать 3D-модель танталового конденсатора с типоразмером из 

варианта индивидуального задания на проектирование, которая понадобится 

для получения 3D-модели «усилителя»; 

– добавить 3D-модель в состав посадочного места библиотечного ком-

понента для 3D-визуализации печатного узла в Altium Designer. 

Для работы будет использоваться САПР КОМПАС-3D российской 

компании АСКОН, которая максимально соответствует требованиям ЕСКД, 

предназначена для выполнения чертежных КД и построения 3D-моделей, об-

ладает интуитивно понятным интерфейсом, высокой производительностью и 

занимает относительно малый объем дискового пространства.  

Для некоммерческого использования существует бесплатная версия ука-

занной САПР (КОМПАС-3D LT) со следующими ограничениями: недо-

ступно создание 3D-моделей сборок, многолистовых чертежей и др. 

Примерами похожих САПР являются AutoCAD фирмы Autodesk и 

SolidWorks фирмы SolidWorks Corporation. 

По отраслевому назначению подобные САПР, используемые в машино-

строении, имеют аббревиатуру MCAD (mechanical computer-aided design). 

7. На этапе 7 (разд. 7): 

– ознакомиться с видами и масштабами изображений на чертеже; 

– в КОМПАС-3D по ранее разработанной 3D-модели танталового кон-

денсатора создать его установочный чертеж, который понадобится для полу-

чения сборочного чертежа «усилителя». 

8. На этапе 8 (разд. 8): 

– ознакомиться с правилами выполнения принципиальных схем; 

– по прил. В освежить в памяти назначение применяемых при проекти-

ровании компонентов, посмотреть системы их обозначений (Part Number), а 

также понять работу схемы ЗП, номер которой указан в варианте индивиду-

ального задания на проектирование; 
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– в редакторе схем Altium Designer с использованием библиотечных 

компонентов нарисовать схему Э3 «усилителя», которая в дальнейшем будет 

использоваться для разработки ПП; 

– в процессе создания схемы Э3 по документации выбрать номиналы 

конденсаторов, рассчитать номиналы резисторов и записать их наименова-

ния, определить значения напряжений и токов; 

– проверить правильность соединений. 

9. На этапе 9 (разд. 9): 

– ознакомиться с правилами оформления перечня элементов; 

– заполнить перечень элементов для схемы Э3 «усилителя». 

Основные действия будут осуществляться в редакторе Microsoft Word, 

так как он удобен в работе с текстовыми данными и таблицами. 

10. На этапе 10 (разд. 10) в редакторе схем Altium Designer нарисовать 

схему Э3 «модуля усилителя». 

11. На этапе 11 (разд. 11) в Microsoft Word заполнить перечень элемен-

тов для схемы Э3 «модуля усилителя». 

12. На этапе 12 (разд. 12): 

– осуществить настройку редактора ПП Altium Designer; 

– внимательно и основательно изучить пример, разобранный в 12.2; 

– в соответствии со схемой Э3 «усилителя» произвести расстановку и 

группировку компонентов внутри контура ПП (процесс компоновки) и осу-

ществить соединение их КП печатными проводниками (процесс трассировки) 

для получения файла трассировки, который в дальнейшем будет использо-

ваться для создания чертежа ПП и 3D-модели «усилителя»; 

– в Microsoft Word создать удостоверяющий лист. 

13. На этапе 13 (разд. 13): 

– в КОМПАС-3D из файла трассировки создать 3D-модель «усилителя» 

(сборка из 3D-моделей компонентов, ПП и топологии СВЧ-фильтра); 

– рассчитать толщину и массу ПП. 

14. На этапе 14 (разд. 14): 

– рассчитать высоту «экрана» и его внутренней полости; 

– в КОМПАС-3D создать пустой файл сборки 3D-модели «модуля уси-

лителя», добавить в него 3D-модель «усилителя» и со стороны размещения 

компонентов создать 3D-модель «экрана». 

15. На этапе 15 (разд. 15) в КОМПАС-3D в составе 3D-модели «модуля 

усилителя» создать 3D-модель «основания» с отверстиями под СВЧ-разъемы. 
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16. На этапе 16 (разд. 16) в КОМПАС-3D завершить создание 3D-модели 

«модуля усилителя»: 

– отредактировать 3D-модель «экрана», добавив необходимые надписи и 

изменив размеры прорезей в боковых стенках; 

– проверить отсутствие пересечений между всеми 3D-моделями, и при 

необходимости внести корректировки в 3D-модель «основания»; 

– добавить все необходимые крепежные изделия (шайбы и винты) для 

соединения составных частей «модуля усилителя»; 

– добавить на верхнюю и нижнюю поверхности ПП из состава 3D-мо-

дели «усилителя» рисунки с информацией слоев из файла трассировки. 

Созданные 3D-модели понадобятся для разработки чертежей, а 3D-мо-

дель «модуля усилителя» – еще и для получения файла 3D-pdf. 

17. На этапе 17 (разд. 17): 

– ознакомиться с правилами выполнения чертежей ПП и деталей; 

– в КОМПАС-3D создать чертеж ПП, используя файл трассировки и 

3D-модель ПП. 

18. На этапе 18 (разд. 18): 

– ознакомиться с правилами выполнения спецификаций; 

– в Microsoft Word создать спецификацию на «усилитель», воспользо-

вавшись перечнем элементов ПЭ3 «усилителя». 

19. На этапе 19 (разд. 19): 

– ознакомиться с правилами выполнения сборочных чертежей и особен-

ностями монтажа компонентов на ПП; 

– в КОМПАС-3D создать сборочный чертеж «усилителя», используя его 

3D-модель, файл трассировки и установочные чертежи компонентов. 

20. На этапе 20 (разд. 20): 

– в КОМПАС-3D создать чертеж «экрана», используя его 3D-модель; 

– произвести расчеты допусков расположения крепежных отверстий. 

21. На этапе 21 (разд. 21): 

– в КОМПАС-3D по аналогии с «экраном» создать чертеж «основания»; 

– произвести расчеты допусков расположения крепежных отверстий для 

СВЧ-разъемов. 

22. На этапе 22 (разд. 22) в Microwave Word создать спецификацию на 

«модуль усилителя», используя данные из его 3D-модели. 

23. На этапе 23 (разд. 23) в КОМПАС-8D создать сборочный чертеж 

«модуля усилителя», используя его 3D-модель и спецификацию. 
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24. На этапе 24 (разд. 24): 

– преобразовать 3D-модель «модуля усилителя» в формат PDF с добав-

лением текстур верхнего и нижнего слоев ПП 

– сохранить рисунок устройства с прозрачным экраном, используя воз-

можности Adobe Reader. 

Примечание. Многие САПР (например, Altium Designer, КОМПАС-3D) 

предлагаются их фирмами в виде бесплатных пробных версий без ограниче-

ния функционала на небольшой срок (15–30 лет). 

В процессе выполнения основных этапов проектирования необходимо 

формировать отчет, требования по содержанию которого и краткие инструк-

ции приведены в конце соответствующих разделов. 

Перечень основных этапов проектирования с указанием баллов за их 

выполнение приведен в табл. 2.2. 

Таблица 2.2 

Основные этапы проектирования 

Этап 

Б
ал

л
 Раздел пособия 

с описанием 
Основной  

программный 

продукт этапа отчета 

1. Получение задания 0,05 1 1.3 
MS Word 

2. Проработка перечня КД 0,05 2 2.8 

3. Схема Э1 0,2 3, 8 3.4, 8.5 Altium Designer 

4. Моделирование СВЧ-фильтра 0,6 4 4.5 MWO 

5. Библиотечный элемент 0,2 5 5.6 Altium Designer 

6. 3D-модель компонента 0,1 6 6.7 
КОМПАС-3D 

7. Установочный чертеж компонента 0,1 7 7.4 

8. Схема Э3 «усилителя» 0,6 8 8.5 Altium Designer 

9. Перечень элементов ПЭ3 «усилителя» 0,2 9 9.3 MS Word 

10. Схема Э3 «модуля усилителя» 0,05 10 10.2 Altium Designer 

11. Перечень элементов ПЭ3 «модуля  

усилителя» 
0,05 11 11.2 MS Word 

12. Компоновка и трассировка ПП, разра-

ботка удостоверяющего листа 
0,7 12 12.7 

Altium Designer,  

MS Word 

13. 3D-модель «усилителя» 0,1 13 13.2 

КОМПАС-3D 

14. 3D-модель «экрана» 0,1 14, 16 

16.2 15. 3D-модель «основания» 0,1 15, 16 

16. 3D-модель «модуля усилителя» 0,1 16 

17. Чертеж ПП 0,3 17 17.4 

18. Спецификация на «усилитель» 0,1 18, 19 19.4 MS Word 



 

 36 

Окончание таблицы 2.2 

Этап проектирования 

Б
ал

л
 Раздел пособия 

с описанием 
Основной  

программный 

продукт этапа отчета 

19. Сборочный чертеж «усилителя» 0,3 19 19.4 

КОМПАС-3D 20. Чертеж «экрана» 0,3 20 20.2 

21. Чертеж «основания» 0,3 21 21.2 

22. Спецификация на «модуль усилителя» 0,05 22, 23 
23.2 

MS Word 

23. Сборочный чертеж «модуля усилителя» 0,2 23 КОМПАС-3D 

24. 3D-модель «модуля усилителя» в PDF 0,15 24 24.5 Adobe Reader 

Максимальный балл за выполнение всех основных этапов проектирова-

ния составляет 5,0. 

Дополнительные этапы проектирования. При медленном выполнении 

основных этапов проектирования и отсутствии предварительной подготовки 

(знакомство с теоретическими сведениями и графической информацией по 

предстоящим этапам, а также выполнение предварительных расчетов) может 

наметиться отставание от плана, приведенного на рис. 2.5. Для получения 

дополнительных знаний и навыков и для повышения оценки предусмотрены 

дополнительные этапы проектирования, которые выполняются по желанию в 

любое время и в любом месте до окончания проектирования. 

На дополнительных этапах проектирования необходимо выполнить сле-

дующие ключевые действия: 

1. На этапе 1 (прил. Е) создать эскиз (или эскизы) «модуля усилителя» с 

обозначениями его составных частей одним из двух способов: 

– от руки или в любом пригодном для этого графическом редакторе с 

соблюдением требований ЕСКД; 

– в КОМПАС-3D с использованием 3D-модели (как на рис. 2.4). 

2. На этапе 2 (прил. Ж) рассчитать коэффициент шума «модуля усилите-

ля» и сравнить его со значением при взаимной замене первых каскадов. 

3. На этапе 3 (прил. И): 

– вывести формулу в символьном виде для корректировки сопротивле-

ния одного из резисторов в схеме «токового зеркала»; 

– по полученной формуле вычислить сопротивление резистора и запи-

сать его Part Number; 

– с учетом скорректированного сопротивления резистора определить 

значения всех токов и напряжений в схеме «токового зеркала»; 
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– сформулировать условия, при которых по приближенной формуле, ис-

пользованной на этапе создания схемы Э3 «усилителя» в расчетах схемы 

«токового зеркала», будут получаться достаточно точные результаты, т. е. 

выполнение корректировки номинала резистора не потребуется. 

4. На этапе 4 (прил. К): 

– ознакомиться с правилами выполнения функциональных схем; 

– в редакторе схем Altium Designer создать схему электрическую функ-

циональную «усилителя» из схем Э3 «усилителя» и Э1 «модуля усилителя». 

5. На этапе 5 (прил. Л): 

– ознакомиться с особенностями форматов Gerber и Excellon; 

– в редакторе ПП Altium Designer получить из файла трассировки все 

необходимые для ее производства данные в указанных форматах. 

6. На этапе 6 (прил. М): 

– ознакомиться с правилами выполнения извещения об изменении (ИИ); 

– в КОМПАС-3D составить ИИ и внести необходимые изменения по 

данному ИИ в соответствующие КД. 

Таблица 2.3 

Дополнительные этапы проектирования 

Этап 

Б
ал

л
 Раздел  

пособия 

с описанием 

Основной этап, после 

которого указанный 

этап станет доступным 

1. Эскиз «модуля усилителя» 0,15 Прил. Е 2 или 16 

2. Расчет коэффициента шума 0,1 Прил. Ж 3 

3.1. Вывод формулы для корректировки со-

противления резистора 
0,15 

Прил. И 
8 

3.2. Расчет сопротивления резистора 0,05 

3.3. Расчет токов и напряжений 0,1 

3.4. Условия получения точных результатов 

по приближенной формуле 
0,1 

4. Схема Э2 0,15 Прил. К 

5. Файлы форматов Gerber и Excellon 0,15 Прил. Л 12 

6. Выпуск ИИ и внесение изменений в КД 0,15 Прил. М 18 (8) 

7. Исполнение «усилителя» 0,15 Прил. Н 19 (8) 

8. Ведомость покупных изделий 0,1 Прил. П 22 (18) 

9. Замена обозначений КД 0,15 Прил. Р 23 (3) 

 Примечание – В скобках указаны номера основных этапов проектирования, после 

выполнения которых соответствующие дополнительные этапы становятся доступными в 

ограниченном объеме, т. е. возможный балл за их выполнение не будет максимальным. 
 



 

  

 

1. Эскиз «модуля усилителя» 

Р
и
с. 2

.6
 

2. Расчет коэффициента шума 

3.1. Вывод формулы для корректировки сопротивления резистора 

3.2. Расчет сопротивления резистора 

3.3. Расчет токов и напряжений 

3.4. Условия получения точных результатов по приближенной формуле 

4. Схема электрическая функциональная 

5. Файлы форматов Gerber и Excellon 

 

6. Выпуск ИИ и внесение изменений в КД 

 

7. Исполнение «усилителя» 

 

8. Ведомость покупных изделий 

 

9. Замена обозначений КД 

Дополнительные этапы проектирования Основные этапы 

проектирования 

Номер 

занятия 

1 1, 2, 3 

2 4 

3 5, 6, 7 

4 8, 9, 10, 11 

5 12 

6 12 

7 13, 14, 15, 16 

8 17, 18, 19 

9 20, 21 

10 22, 23, 24 

3
8
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7. На этапе 7 (прил. Н): 

– ознакомиться с правилами выполнения групповых КД; 

– скорректировать необходимые КД для создания исполнения «усилите-

ля», в котором для подачи и снятия СВЧ-сигнала используются указанные в 

общем задании на проектирование коаксиальные торцевые СВЧ-разъемы. 

8. На этапе 8 (прил. П): 

– ознакомиться с правилами выполнения ведомости покупных изделий; 

– в Microsoft Word создать ведомость покупных изделий для «модуля 

усилителя», используя спецификации «усилителя» и «модуля усилителя». 

9. На этапе 9 (прил. Р): 

– ознакомиться с обезличенным способом обозначения КД; 

– во всех разработанных КД заменить обозначения, использованные при 

проектировании, на обозначения по обезличенному способу. 

Перечень дополнительных этапов проектирования с указанием баллов за 

их выполнение и основных этапов проектирования, после которых они ста-

новятся доступными, приведен в табл. 2.3 и на блок-схеме с рис. 2.6. На ри-

сунке сплошные черные линии отведены от недель, с которых можно полно-

ценно выполнить соответствующие этапы, а пунктирные красные линии – от 

недель, с которых эти этапы можно начать постепенно делать. 

2.7. Файловая структура проекта 

При разработке проектов важно придерживаться следующих правил: 

1. Удобно и понятно организовать файловую структуру, так как от этого 

напрямую зависит скорость поиска и доступа к нужным файлам. 

Пример файловой структуры проекта, реализованной в пособии для ос-

новных этапов проектирования по варианту «П1», приведен на рис. 2.7 и 2.8. 

Здесь все файлы расположены в двух основных папках, каждая из которых 

представляет собой сборочную единицу: 

– папка …ИДРЭС-П1 («П1» – номер варианта задания), являющаяся 

также папкой проекта, с файлами «модуля усилителя» (рис. 2.7); 

– папка …ИДРЭС-П1\Усилитель с файлами «усилителя» (рис. 2.8). 

Так как «усилитель» входит в состав «модуля усилителя», то и располо-

жение папок соответствующее (первая находится внутри второй). 

Все файлы разделены на основные и вспомогательные. 

Основные файлы находятся непосредственно в папках их сборочных 

единиц и являются составляющими комплекта КД на изделие: 
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– оригиналы КД (например, схема Э8 «модуля усилителя» на рис. 2.7 – 

«УП1.00.01Э3 - Модуль усилителя - v0.1.SchDoc»); 

– файлы, необходимые для разработки и настройки изделия (например, 

файл трассировки на рис. 2.8 – «AMP-П1-v0.2.PcbDoc»). 

 

Вспомогательные файлы (3D-модели деталей и сборочных единиц, фай-

лы моделирования, расчеты, заметки и пр.) размещены в соответствующих 

подпапках, названия у которых начинаются с нижнего подчеркивания, что 

позволяет расположить их в списке файлов и папок при сортировке с одной 

стороны, отметив при этом отсутствие в них основных файлов, например: 

– файл 3D-модели «экрана» («УП1.00.03 - Экран.m3d») находится в пап-

ке …ИДРЭС-П1\_Модели; 

Рис. 2.7 

См. рис. 2.8 

 Раздел Описание 

– – Основная папка проекта 

   

– 23 

КД «модуля усилителя»,  

сохраненные в формате PDF 

– 11 

– 23 

– 8 

– 10 

– 21 

– 20 

   

– См. 2.6 Отчет по проекту и расчеты 

для «основания» и «экрана»,  

а также для схемы Э1 

– 14, 20, 21 

– 3 

   

– 24 3D-модели «модуля  

усилителя» и деталей из его 

состава (*.a3d, *.m3d). 

3D-модель «модуля  

усилителя» в 3D-pdf (*.pdf) 

– 14, 16 

– 15, 16 

– 14, 16 

   

   

– 22 

Оригиналы КД  

«модуля усилителя»,  

выполненные в следующих 

программах:  

Microsoft Word (*.doc), 

КОМПАС-3D (*.cdw),  

Altium Designer (*.SchDoc) 

– 11 

– 23 

– 8 

– 10 

– 21 

– 20 
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 Рис. 2.8 

 Раздел Описание 

– – Из «ИДРЭС-П1» (см. рис. 2.7) 

   

– 19 

КД «усилителя»,  

сохраненные в формате PDF 

– 9 

– 19 

– 8 

– 17 

– 12.6 

   

– 5 Библиотека с конденсатором 

   

– 13 Расчеты для 3D-модели ПП 

и схемы Э3 «усилителя» – 8 

   

– 13 3D-модели «усилителя», ПП  

и ПФ (*.a3d, *.m3d). Файлы  

для создания модели  

«усилителя» из файла  

трассировки (*.brd, *.pro).  

Файл со связями между компо-

нентами и их 3D-моделями 

(*.ini). Библиотека 

с моделью ПП (*.l3d). 

– 13 

– 13 

– 13 

– 13 

– 13 

– 13 

   

– 6 3D-модель конденсатора 

   

– 7 Чертеж установки конденсатора 

   

– 4 Файлы моделирования  

ПФ в Microwave Office 

(основной – *.emp, вспомога-

тельные – *.vin и *.y2p). 

Топология фильтра – *.dxf. 

Расчеты по ПФ – *.xmcd 

– 4 

– 4 

– 4 

– 4 

   

– 12 Проект ПП из Altium Designer: 

файл трассировки – *.PcbDoc; 

схема – *.SchDoc; 

файл и структура проекта ПП – 

*.PrjPcb и *.PrjPcbStructure 

– 8 

– 8 

– 8 

– 19 

Оригиналы КД «усилителя»,  

выполненные в  

Microsoft Word (*.doc) 

и КОМПАС-3D (*.cdw) 

– 9 

– 19 

– 17 

– 12.6 
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– файл с расчетами по схеме Э3 «усилителя» («Расчеты (Э3).xmcd»), со-

зданный в системе компьютерной алгебры Mathcad фирмы PTC, находится в 

папке …ИДРЭС-П1\Усилитель\_Заметки, и т. д. 

 Рис. 2.9 

… … 

… 

… 

Заготовки для создания КД  

в Microsoft Word 

Библиотеки Altium Designer: 

библиотека в виде базы данных 

(*.DbLib), база данных (*.mdb), 

библиотеки посадочных мест  

и УГО (папки pcb и sch) и биб-

лиотека шаблонов КП и пере-

ходных отверстий (*.PvLib) 

Рамки для оформления схем  

в Altium Designer 

Информация в формате PDF 

(datasheet) по используемым  

компонентам, сгруппированная  

по функциональному  

назначению 

3D-модели компонентов, 

используемых в проекте  

Установочные чертежи 

компонентов, используемых 

в проекте  

Системные шрифты,  

используемые 

при проектировании 

Настройки для Altium Designer  

и КОМПАС-3D 
… 

Программа для корректировки 

DXF-файлов 
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Файлы, используемые во всех проектах, рекомендуется размещать в от-

дельной папке, не относящейся к какой-либо конкретной разработке. Напри-

мер, при проектировании такой папкой будет …\ИДРЭС (см. рис. 2.9). Здесь 

находятся 3D-модели, установочные чертежи и библиотеки компонентов 

(конденсаторов, микросхем, разъемов и др.), заготовки для КД, оформляемых 

в Microsoft Word, и другие общие для всех вариантов задания файлы. 

 Если редактируется готовый файл или создается новый только под кон-

кретный проект, то его следует размещать в одной из папок проекта для 

вспомогательных файлов. Например, 3D-модель танталового конденсатора с 

номером варианта задания на корпусе («CASE-C-293D-П1.m3d») расположе-

на в папке …ИДРЭС-П1\Усилитель\_Модели элементов (см. рис. 2.8). 

2. Присваивать осмысленные имена файлам и папкам, в особенности при 

совместной работе над проектом группы людей. 

Названия вида «1111» хороши только в одном – скорость присвоения в 

момент сохранения. Однако через некоторое время (порой хватает несколь-

ких десятков минут) возникнут следующие трудности: 

– затруднено понимание того, что находится в файле; 

– затруднено отслеживание последней удачной версии файла; 

– затруднен поиск необходимых файлов; 

– практически невозможна работа с файлами других соисполнителей. 

Поэтому при проектировании рекомендуется придерживаться формы 

названия, предлагаемой для каждого сохраняемого файла в соответствующих 

разделах учебного пособия. Например, название КД будет складываться из 

его обозначения, наименования изделия и номера версии (см. рис. 2.7 и 2.8).  

Примечание. Номера версий используются для возможности возврата к 

промежуточному результату и при работе с соисполнителями. 

3. Сохранять результаты в ходе работы и уделять внимание настройкам 

по автосохранению файлов (периодическое сохранение, выполняемое про-

граммой автоматически) и созданию их резервной копии (backup-файл, яв-

ляющийся копией файла с предыдущим сохранением пользователя). 

Примечания: 

– в Altium Designer настройки автосохранения задаются в окне Prefer-

ences (команда DXP ⇒ Preferences) в подразделе Data Management ⇒ Backup. 

При включении опции Auto save every указываются периодичность сохране-

ния, максимальное количество сохраненных версий документа (от 1 до 10) и 

путь сохранения. Сохранение происходит только при наличии в документе 
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ранее несохраненного изменения. Процесс осуществляется циклически в пре-

делах заданного количества версий с постепенной их перезаписью. 

При каждом ручном сохранении документа в папке History (по умолча-

нию располагается в директории документа) создается его резервная копия 

в виде архива. Настройки резервных копий задаются в подразделе Data Man-

agement ⇒ Local History окна Preferences. Здесь можно указать число дней их 

хранения (после этого начнется перезапись устаревших сохранений), вклю-

чить копирование автосохранений в папку с резервными копиями (ограниче-

ний по количеству хранимых версий нет) и задать их сохранение в общую 

папку (в этом случае в папку History ничего добавляться не будет). Для ра-

боты с резервными копиями служит панель Storage Manager (см. Г.50); 

– в КОМПАС-3D настройки автосохранения задаются в окне «Пара-

метры» (команда Сервис ⇒ Параметры) на вкладке «Система» в группе 

Файлы ⇒ Автосохранение. По умолчанию оно включено с периодом 1 мин. 

Настройки создания резервной копии задаются на той же вкладке в 

группе Файлы ⇒ Резервное копирование. По умолчанию сохранение осу-

ществляется в директорию текущего файла. Файл резервной копии имеет 

расширение «.bak» и перезаписывается после каждого сохранения; 

– в Microsoft Word настройки автосохранения задаются в окне «Пара-

метры Word» (команда Файл ⇒ Параметры) в группе Сохранение ⇒ Сохра-

нение документов. По умолчанию оно включено с периодом 40 мин. 

Включить создание резервной копии позволяет опция «Всегда создавать 

резервную копию» в том же окне в группе Дополнительно ⇒ Сохранение. 

Файл резервной копии имеет расширение «.wbk», сохраняется в директорию 

текущего файла и перезаписывается после каждого сохранения. 

2.8. Содержание отчета 

По 2-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Перечень разрабатываемых КД для основных этапов проектирования 

с указанием обозначений КД, их наименований и наименований изделий. 

2. Краткое описание использованной при проектировании структуры 

обозначений. 

При желании можно выполнить 1-й дополнительный этап проектирова-

ния (см. табл. 2.3 и прил. Е) первым способом, т. е. вручную без использова-

ния 3D-модели «модуля усилителя». 
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3. СХЕМА ЭЛЕКТРИЧЕСКАЯ СТРУКТУРНАЯ 

3.1. Общие сведения 

При разработке радиоэлектронной аппаратуры в любой системе проек-

тирования в первую очередь необходимо определиться с функциями будуще-

го устройства. Для этого служат структурные схемы. 

Основные определения и правила оформления схем содержатся в 

ГОСТ 2.701–2008 [10] и ГОСТ 2.702–2011 [11]. 

Схема – это документ, на котором показаны в виде условных изображе-

ний или обозначений составные части изделия и связи между ними. 

Схема электрическая – один из видов схем наряду со схемой гидравли-

ческой, схемой пневматической, схемой оптической, схемой деления и др. 

Это документ, содержащий в виде условных изображений или обозначений 

составные части изделия, действующие при помощи электрической энергии, 

и их взаимосвязи. Код схемы электрической – Э. 

Схема структурная – один из типов схем наряду со схемой функцио-

нальной, схемой принципиальной, схемой соединений, схемой подключения 

и др. Это документ, определяющий основные функциональные части изде-

лия, их назначения и взаимосвязи. Код схемы структурной – 1. Такие схемы 

разрабатывают при проектировании изделий на стадиях, предшествующих 

разработке схем других типов, и пользуются ими для общего ознакомления с 

изделием. 

Код документа схемы должен состоять из буквенной части, определяю-

щей вид схемы, и цифровой части, определяющей тип схемы. Поэтому схема 

электрическая структурная имеет код Э1. 

К правилам выполнения схем Э1 относятся следующие: 

1. На схеме изображают все основные функциональные части изделия 

(элементы, устройства и функциональные группы) и основные взаимосвязи 

между ними. 

2. Функциональные части на схеме изображают в виде прямоугольника 

или УГО. 

3. Графическое построение схемы должно давать наиболее наглядное 

представление о последовательности взаимодействия функциональных ча-

стей в изделии. 

На линиях взаимосвязей рекомендуется стрелками обозначать направле-

ние хода процессов, происходящих в изделии. 
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4. На схеме должны быть указаны наименования каждой функциональ-

ной части изделия, если для ее обозначения применен прямоугольник. На 

схеме допускается указывать тип элемента (устройства) и (или) обозначение 

документа (основной КД, государственный стандарт, технические условия), 

на основании которого этот элемент (устройство) применен. При изображе-

нии функциональных частей в виде прямоугольников наименования, типы и 

обозначения рекомендуется вписывать внутрь прямоугольников. 

5. При большом количестве функциональных частей допускается взамен 

наименований, типов и обозначений проставлять порядковые номера справа 

от изображения или над ним, как правило, сверху вниз в направлении слева 

направо. Вэтом случае наименования, типы и обозначения указывают в таб-

лице, помещаемой на поле схемы. 

6. Допускается помещать на схеме поясняющие надписи, диаграммы или 

таблицы, определяющие последовательность процессов во времени, а также 

указывать параметры в характерных точках (величины токов, напряжений, 

формы и величины импульсов, математические зависимости и т. п.). 

3.2. Подготовка к созданию схемы 

3.2.1. Начальное окно Altium Designer 

Для создания схем, библиотек компонентов и ПП в данном учебном по-

собии будет использоваться САПР Altium Designer, начальное окно которой 

показано на рис. 3.1. 

 Рис. 3.1 

ПИ Основное меню 

Вспомогательная 

панель 

Рабочее поле 

Строка состояний 

Фиксация панели 

Дополнительное меню 
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В верхней части размещаются строка основного меню и горизонтальные 

панели инструментов (ПИ), содержащие пиктограммы системных команд. 

Состав команд основного меню и ПИ зависит от типа документа, с которым в 

данный момент осуществляется работа. 

Подключение, отключение и создание собственных ПИ производится из 

контекстного меню, вызываемого нажатием правой кнопки мыши (ПКМ) в 

любом месте верхней части окна. 

В центре находится рабочее поле, в котором располагаются необходи-

мые для работы документы с вкладками в верхней его части. Через кон-

текстное меню, вызываемое щелчком ПКМ по области с вкладками, можно 

закрыть (или скрыть) документы, расположить их в рабочем поле рядом друг 

с другом или открыть в новом окне (рис. 3.2). 

 

В нижней левой части располагается строка состояний, в которой отоб-

ражаются координаты курсора мышки, текущий шаг сетки и различные под-

сказки по выполнению команд. 

В нижней правой части находится дополнительное меню для запуска 

вспомогательных панелей (например, панели Projects для работы со структу-

рой проекта). Такую панель можно встроить с какой-нибудь стороны рабоче-

го поля, для чего необходимо переместить ее за заголовок зажатой левой 

кнопкой мыши (ЛКМ) на одну из появляющихся в нем пиктограмм (рис. 3.3). 

Рис. 3.2 
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Встроенную вспомогательную панель можно за-

фиксировать (постоянно отображается как панель Pro-

jects) или сделать скрытой (автоматически сворачива-

ется после использования и отображается в виде кноп-

ки как панель Libraries) с помощью пиктограммы бу-

лавки в ее заголовке (см. рис. 3.1). 

Существует два режима группировки встроенных 

фиксированных вспомогательных панелей: 

– режим вкладок, при котором с одной стороны рабочего поля полно-

стью видна только активная в данный момент панель; 

– смешанный режим, при котором одновременно могут отображаться 

сразу несколько панелей с одной стороны рабочего поля. 

Перегруппировать вспомогательные панели можно путем перетаскива-

ния зажатой ЛКМ их вкладок (в режиме вкладок) или заголовков (смешан-

ный режим) внутри требуемой группы. 

3.2.2. Предварительная настройка Altium Designer 

Все настройки в Altium Designer делятся на несколько групп:  

– системные настройки; 

– настройки редакторов; 

– настройки документов; 

– настройки проектов. 

Под предварительной настройкой в данном учебном пособии понимает-

ся задание общих системных настроек и настроек для редакторов схем и ПП, 

а для экономии времени это будет сделано загрузкой заранее подготовленно-

го файла (профиля с настройками). Для этого запустить команду DXP ⇒ 

Preferences и в открывшемся окне Preferences выполнить следующее: 

– внизу окна нажать кнопку Load и из папки …\ИДРЭС\Профили (см. 

рис. 2.9) выбрать файл ИДРЭС-AltiumPreferences.DXPPrf; 

– в окне Load preferences from file нажать ссылку Show options page list, 

отметить только первые четыре раздела (рис. 3.4) и нажать кнопку OK; 

– применить изменения в окне Preferences кнопкой OK; 

– перезапустить Altium Designer; 

– снова открыть окно Preferences и в подразделе System ⇒ View отклю-

чить опцию Autosave desktop; 

– применить изменения в окне Preferences кнопкой OK. 

Рис. 3.3 
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Примечания: 

– описание изменений, произошедших в результате загрузки профиля, 

приведено в Г.1; 

– настройки документов и проектов будут задаваться во время рабо-

ты с ними, однако их заготовки можно подготовить заранее и автомати-

чески загружать при создании новых документов и проектов; 

– кнопка Set To Defaults возвращает настройки по умолчанию. 

3.2.3. Подключение рамок и заполнение полей 

КД размещают на форматах листов, приведенных в ГОСТ 2.301–68 [13], 

и с оформлением в рамках по ГОСТ Р 2.104–2023 [14]. В рамках выделяют 

основную надпись и дополнительные графы к ней, упрощенный вид и распо-

ложение которых показано: 

– для формата А4 – на рис. 3.5, а; 

– для форматов больше А4 при расположении основной надписи вдоль 

длинной стороны листа – на рис. 3.5, б; 

 

Рис. 3.4 

1 – основная надпись; 2–4 – дополнительные графы 

а б 

2 
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4 

Рис. 3.5 
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– для формата больше А4 при расположении основной надписи вдоль 

короткой стороны листа – на рис. 3.5, в. 

Дополнительные графы, отмеченные номером 3 (пунктирный контур) на 

рис. 3.5, есть только на первом листе. 

 Рис. 3.6 

а 

б 

в 
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Оформление основной надписи и дополнительных граф различается: 

– между схемой (или чертежом) и текстовым документом; 

– между первым и последующими листами; 

– в зависимости от назначения (некоторые графы, выделенные специ-

ально в ГОСТ Р 2.104–2023, вводят при необходимости). В данном учебном 

пособии рамки для всех КД будут содержать только обязательные графы. 

Оформление основной надписи для схем и чертежей на первом листе 

показано на рис. 3.6, а, а на последующих листах – на рис. 3.6, б. 

Оформление дополнительных граф показано на рис. 3.6, в. 

В круглых скобках на рис. 3.6 отмечены номера граф в соответствии с 

ГОСТ Р 2.104–2023. Содержание граф указано в табл. 3.1. 

Таблица 3.1 

Содержание граф основной надписи и дополнительных граф 

Номер 

графы 
Данные в графе 

1 

Наименование изделия, а также наименование документа, если у него есть код.  

Наименование изделия должно соответствовать принятой терминологии и быть 

по возможности кратким. Его записывают в именительном падеже единствен-

ного числа. Если оно состоит из нескольких слов, то на первом месте помещают 

имя существительное (например, «Плата печатная»). В наименование изделия 

не включают, как правило, сведения о назначении изделия и его местоположе-

нии 

2 Обозначение документа 

3 Обозначение материала детали. Графу заполняют только на чертежах деталей 

4 

Литера, присвоенная данному документу (см. 2.2). На документе в бумажной 

форме графу заполняют последовательно, начиная с крайней левой клетки. 

Для всех разработанных КД по данному учебному пособию необходимо при-

своить литеру У, что означает «учебный проект» 

5 

Масса изделия по ГОСТ Р 2.109–2023 [15]. В килограммах записывается без 

указания единицы измерения, а в граммах и тоннах – с указанием. 

Принято массу до 100 г указывать в граммах (г), от 100 г до 1000 кг – в кило-

граммах, от 1000 кг и свыше – в тоннах (т) 

6 Масштаб 

7 Порядковый номер листа. Допускается не заполнять для КД из одного листа 

8 Общее количество листов документа 

9 
Наименование организации, разработавшей (выпустившей) КД. Допускается 

указывать код организации, краткое наименование, код и (или) эмблему 

10 

Характер работы, выполняемой лицом, подписывающим документ. Здесь при-

няты следующие сокращения по ГОСТ Р 2.316–2023 [16]: разраб. – разработал; 

пров. – проверил; т. контр. – технологический контроль; н. контр. – нормо-

контроль; утв. – утвердил. 

Свободную строку заполняют по усмотрению разработчика, например: 

«Начальник отдела», «Начальник лаборатории» и пр. 
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Окончание таблицы 3.1 

Номер 

графы 
Данные в графе 

11 Фамилии и (при необходимости) инициалы лиц, подписавших документ 

12 Собственноручные подписи лиц, фамилии которых указаны в графе 11 

13 
Дата подписания документа. В бумажных КД год может быть указан двумя по-

следними цифрами 

14–18 Сведения об изменениях 

19 Инвентарный номер подлинника 

20 
Сведения о приемке подлинника в службу технической документации (подпись 

и дата приемки) 

21 Инвентарный номер подлинника, взамен которого выпущен данный подлинник 

22 Инвентарный номер дубликата 

23 
Сведения о приемке дубликата в службу технической документации (подпись и 

дата приемки) 

24 
Обозначение документа, взамен или на основании которого выпущен данный 

документ. Допускаются обозначения, установленные в стандарте организации 

25 Обозначение КД, в котором впервые записан данный документ 

26 

Обозначение документа, повернутое на 180° для формата A4 и для форматов 

больше A4 при расположении основной надписи вдоль длинной стороны листа 

и на 90° для форматов больше A4 при расположении основной надписи вдоль 

короткой стороны листа 

31 
Дата и подпись лица, копировавшего бумажный КД или распечатавшего элек-

тронный КД 

32 Обозначение формата листа 

Рамки в Altium Designer представляют собой отдельные файлы с расши-

рением «.SchDot», которые подключаются отдельно к каждому листу схемы. 

После подключения в них заполняются значения параметров, которые соот-

ветствуют графам, описанным ранее. Особенности создания рамок и их ис-

пользования приведены в Г.51. 

Основным понятием в Altium Designer является проект (Project) – струк-

тура, которая объединяет группу документов для одного разрабатываемого 

объекта. Например, для создания ПП минимальный набор таких документов 

включает в себя файлы схемы и трассировки. 

В данном пособии рассматриваются 2 типа проектов: 

– PCB Project – проект ПП; 

– Integrated Library – проект интегрированной библиотеки. 

Файл проекта представляет собой текстовый файл, в котором перечис-

лены использующиеся в проекте документы и параметры формирования вы-

ходных данных (например, для печати). Каждый проект (как и каждый доку-

мент) может иметь особые настройки. 
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Однако документы могут быть созданы и без привязки к каким-то про-

ектам. В этом случае они называются свободными (Free Documents). 

Схема Э1 «модуля усилителя» будет разработана на одном листе форма-

та А4 в виде свободного документа. Для этого требуется: 

1. Создать новый документ схемы командой File ⇒ New ⇒ Schematic. 

В результате выполнения команды в панели Projects появится группа 

Free Documents с документом схемы (Sheet1.SchDoc), а в рабочем поле – 

вкладка с листом схемы с оформлением, заданным по умолчанию (рис. 3.7).  

 

Примечания: 

– белая иконка справа от документа в панели Projects означает, что он 

открыт в рабочем поле. Изменение ее цвета на красный и появление символа 

«*» в конце названия документа означает несохраненные изменения; 

– способы управления изображением документа описаны в Г.3. 

2. Сохранить схему с расширением «.SchDoc», запустив в панели Pro-

jects на ее названии команду ПКМ ⇒ Save As. Имя файла в варианте «П1» – 

«УП1.00.01Э1 - Модуль усилителя - v0.1», а путь сохранения – …\ИДРЭС-

П1 (см. рис. 2.7). 

3. Изменить рамку и формат листа схемы: 

– запустить команду Design ⇒ Templates ⇒ Project Templates ⇒ 

Choose a File и выбрать файл рамки для первого листа формата А4 – A4-1-

ИДРЭС-AD.SchDot из папки …\ИДРЭС\AD рамки (см. рис. 2.9); 

– в появившемся окне Update Template выбрать опции Just this Docu-

ment (загрузить шаблон рамки только в текущий документ) и Replace all 

matching parameters (заменить все совпадающие параметры) и нажать OK. 

Рис. 3.7 
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4. Запустить команду Design ⇒ Document Options и перейти на вкладку 

Parameters, на которой в соответствии с табл. 3.2 заполнить значения (стол-

бец Value) для тех параметров, чьи имена в столбце Name начинаются с 

цифр (номера граф рамки). 

Пояснения к графам даны в табл. 3.1 и на рис. 3.6, а и в. 

Таблица 3.2 

Параметры рамки для схемы Э1 «модуля усилителя» 

Название параметра Значение Комментарий к заполнению 

01.1_Наименов. изд. Модуль усилителя 
Наименование изделия определено в 

табл. 2.1  

01.2_Наименов. изд. Отсутствует 

Зарезервированная вторая строка для 

наименования изделия. 

«Отсутствует» здесь и долее означает не-

заполненное значение параметра  

01.3_Наименов. док. 
Схема электрическая 

структурная 
– 

02_Обознач. док. УП1.00.01Э1 
Обозначение документа определено в 

табл. 2.1 и указано для варианта «П1» 

04_Литера У – 

07_Номер листа Отсутствует – 

08_Кол. листов 1 – 

09_Наименов. орг. СПбГЭТУ «ЛЭТИ» – 

11.1_Разраб. Сидоров 

Указывается фамилия студента, разрабо-

тавшего КД.  

Если вариант задания выполняется сту-

дентами в паре, то фамилия второго сту-

дента записывается в поле «11.2_Пров.» 

11.2_Пров. Петров 

Указывается фамилия преподавателя.  

Если вариант задания выполняется сту-

дентами в паре, то фамилия преподавате-

ля указывается в поле «11.6_Утв.», а в 

данном поле записывается фамилия вто-

рого студента 

11.3_Т. контр. Отсутствует – 

11.5_Н. контр. Отсутствует – 

11.6_Утв. См. комментарий 

Если вариант задания выполняется сту-

дентами в паре, то в данном поле записы-

вается фамилия преподавателя. В против-

ном случае значение отсутствует 

25_Перв. примен. УП1.00.01 

Обозначение спецификации, в которой 

записан КД, определено в табл. 2.1 и ука-

зано для варианта «П1» 
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Примечания: 

– графа 26 заполняется автоматически в соответствии со значением 

параметра «02_Обознач. док.»; 

– альтернативные способы заполнения граф 2, 7 и 8 в проектах для 

многолистовых схем описаны в п. 5 из 8.2. 

 

 Рис. 3.9 

Рис. 3.8 
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Результат на вкладке Parameters окна Document Options в варианте 

«П1» показан на рис. 3.8, а в рабочем поле – на рис. 3.9. 

5. Убедиться в том, что в ячейках рамки не содержится посторонней ин-

формации. 

6. Сохранить изменения в схеме, выполнив в панели Projects на ее назва-

нии команду ПКМ ⇒ Save (или нажать комбинацию клавиш Ctrl+S). 

3.3. Создание схемы Э1 

«Модуль усилителя» по общему заданию на проектирование состоит из 

печатного узла («усилитель»), помещенного между двумя деталями («осно-

ванием» и «экраном»), и двух СВЧ-разъемов (см. рис. 2.4). 

Для выполнения указанных в задании функций (ослабление помех, уси-

ление полезного сигнала и регулировка уровня выходной мощности) «усили-

тель» содержит ПФ, усилитель и управляемый аттенюатор. 

Сигнал через входной СВЧ-разъем поступает на ПФ, в котором проис-

ходит ослабление помех в соответствии с данными индивидуального задания 

на проектирование. Далее он усиливается в усилителе и через аттенюатор с 

цифровым параллельным управлением, в котором осуществляется регули-

ровка его уровня мощности, поступает на выходной СВЧ-разъем. СВЧ-разъ-

емы, ПФ, усилитель и аттенюатор образуют СВЧ-тракт. 

В зависимости от варианта задания управление аттенюатором происхо-

дит одним из двух способов: 

– подача управляющих сигналов извне через разъем (ВУ); 

– формирование управляющих сигналов в ручном режиме (РУ) в узле 

управления, который состоит из переключателя или тактовых кнопок. 

Для работы микросхемы усилителя во всех вариантах задания на ее вы-

ход подается стабильное значение тока, в качестве источника которого ис-

пользуется схема, называемая «токовое зеркало». 

Для работы всего «усилителя» необходимо внешнее питание, которое 

через двухконтактный разъем подается на узел вторичного питания, пред-

ставляющий собой набор различных функциональных частей: 

– во всех вариантах задания он содержит схему ЗП, а также микросхему 

стабилизатора для формирования и стабилизации требуемого уровня напря-

жения; 

– в некоторых вариантах задания в нем могут быть реализованы ИПС и 

параметрический стабилизатор напряжения. 
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Напряжения с узла вторичного питания поступают на «токовое зеркало» 

и управляемый аттенюатор. Их значения зависят от информации, указанной в 

документации на микросхемы аттенюатора и усилителя. Кроме того, там же 

указывается способ подачи питания на микросхему аттенюатора. 

Пути прохождения сигналов в «модуле усилителя» для варианта «П1» 

без соблюдения требований ЕСКД и выделения «усилителя» как составной 

части изделия показаны на рис. 3.10. 

 

УГО ПФ (рис. 3.11, а), усилителя (рис. 3.11, б) и управляемого аттенюа-

тора (рис. 3.11, в), а также размеры общего обозначения устройства (рис. 

3.11, г) приведены в ГОСТ 2.737–68 [17]. 

Обозначение распространения тока, сигнала, информации и потока 

энергии в одном направлении с указанием размеров (см. рис. 3.11, д), а также 

обозначение электрического соединения с корпусом с размерами в модуль-

ной сетке (см. рис. 3.11, е) приведены в ГОСТ 2.721–74 [18]. 

 

Рис. 3.10 

ПФ 

Усилитель Аттенюатор 

Стабилизатор 

напряжения 

Узел вторичного питания 

ЗП 

СВЧ-тракт 

Разъем  

управления 

«Токовое 

зеркало» 

Выходной 

СВЧ-

разъем 

Входной 

СВЧ-

разъем 

Разъем  

питания 

 

Рис. 3.11 [17], [18] 

а б в г д е 
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Модульная сетка – виртуальная сетка, образованная вертикальными и 

горизонтальными линиями. Ее шаг для каждой схемы может быть любым, но 

одинаковым для всех элементов и устройств данной схемы. 

Для создания описанной выше структуры «модуля усилителя» выпол-

нить следующие действия: 

1. Перейти в сетку 1 мм. 

Переключение между установленными шагами сетки осуществляется 

клавишей G (перебор значений в сторону увеличения) или комбинацией кла-

виш Shift+G (перебор значений в сторону 

уменьшения). 

Значение текущего шага сетки отобража-

ется в строке состояний (рис. 3.12). 

2. Нарисовать три квадрата с размерами, указанными на рис. 3.11, г, для 

чего выполнить следующие действия: 

2.1. Последовательно нажать клавиши P ⇒ D ⇒ R или запустить коман-

ду Place ⇒ Drawing Tools ⇒ Rectangle (создание прямоугольника). 

Следует обратить внимание на то, что здесь и далее по тексту клавиши 

нажимаются при включенной английской раскладке клавиатуры. 

2.2. После появления фантома фигуры нажать клавишу Tab и в открыв-

шемся окне свойств с помощью значений координат задать требуемые раз-

меры (рис. 3.13). Затем применить изменения кнопкой OK. 

 

2.3. Переместить курсор мышки в место рабочего поля, куда планирует-

ся установить фигуру, и дважды нажать клавишу Enter. 

2.4. Дважды выполнить п. 2.3, разместив недалеко друг от друга еще два 

квадрата. После чего завершить команду клавишей Esc (или ПКМ). 

Рис. 3.13 

Рис. 3.12 
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3. В первом квадрате нарисовать обозначение ПФ (рис. 3.11, а), для чего 

выполнить следующие действия: 

3.1. Перейти в сетку 0.5 мм. 

3.2. Последовательно нажать клавиши P ⇒ D ⇒ B или запустить коман-

ду Place ⇒ Drawing Tools ⇒ Bezier (создание кривой Безье), после чего 

щелчками ЛКМ последовательно указать четыре опорные точки и завершить 

команду двойным нажатием клавиши Esc (или ПКМ).  

При необходимости отредактировать положение опорных точек, пред-

варительно щелкнув ЛКМ по нарисованной кривой (рис. 3.14, а). 

 

3.3. Для добавления второй части волнистой кривой выполнить следу-

ющие действия: 

– выбрать ЛКМ нарисованный сегмент кривой Безье и скопировать его в 

буфер обмена (комбинация клавиш Ctrl+C); 

– добавить скопированный сегмент из буфера обмена без установки в 

рабочем поле (комбинация клавиш Ctrl+V); 

– повернуть фантом сегмента на угол 180º двойным нажатием клавиши 

Space и зафиксировать его в рабочем поле щелчком ЛКМ так, чтобы крайние 

точки двух сегментов совпали (рис. 3.14, б). 

Примечания: 

– вторую половину кривой можно было нарисовать заново; 

– вместо поворота клавишей Space копию сегмента можно было пере-

вернуть вдоль оси Y клавишей Y (переворот вдоль оси X производится кла-

вишей X); 

– объекты из буфера обмена находятся в скрытой панели Clipboard, 

расположенной с правой стороны рабочего поля (рис. 3.15, а); 

– список доступных действий при работе с командой вызывается кла-

вишей F1 или «~». В контекстном меню, появляющемся при нажатии кла-

виши «~», можно сразу же выбрать требуемое действие (рис. 3.15, б). 

3.4. Скопировать созданную волнистую кривую (Ctrl+C) и вставить две 

ее копии (Ctrl+V) внутри квадратного контура. 

Рис. 3.14 

а б 
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3.5. Последовательно нажать клавиши P ⇒ D ⇒ L или запустить коман-

ду Place ⇒ Drawing Tools ⇒ Line (создание линии), после чего нарисовать 

два косых отрезка под углом 45º, проходящих через середины верхней и 

нижней волнистых линий. 

Примечание. Дополнительные сведения к отдельным используемым при 

проектировании в Altium Designer командам даны в прилож. Г. 

3.6. Выделить все графические примитивы получившегося УГО ПФ и 

выполнить команду ПКМ ⇒ Unions ⇒ Create Union from selected objects 

(сгруппировать выделенные объекты).  

Примечания: 

– при массовом выделении мышкой слева напра-

во выделенными окажутся только полностью по-

павшие в контур выделения объекты;  

– при массовом выделении мышкой справа нале-

во выделенными окажутся полностью и частично 

попавшие в контур выделения обекты. 

Результат проделанных действий в варианте 

«П1» показан на рис. 3.16. 

4. В центре второго квадрата последовательным 

нажатием клавиш P ⇒ D ⇒ L (создание линии) нари-

совать обозначение усилителя (рис. 3.11, б) в виде 

равностороннего треугольника. 

Затем сгруппировать все графические примити-

вы УГО усилителя. 

Результат проделанных действий в варианте 

«П1» показан на рис. 3.17. 

Рис. 3.15 

а б 

Рис. 3.16 

Рис. 3.17 
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5. В третьем квадрате создать обозначение управляемого аттенюатора: 

5.1. Перейти в сетку 1 мм. 

5.2. Последовательно нажать клавиши P ⇒ T или запустить команду 

Place ⇒ Text String (создание надписи). 

5.3. После появления в рабочем поле фантома надписи нажать клавишу 

Tab и в открывшемся окне его свойств выполнить следующее (рис. 3.18): 

– задать вертикальное и горизонтальное выравнивание по центру; 

– в поле Text ввести дБ; 

– в поле Font задать шрифт с параметрами GOST type B, 22, Italic и за-

крыть окно свойств кнопкой OK. 

 

5.4. Поместить надпись в центр третьего квадрата и завершить команду. 

5.5. Последовательно нажать клавиши P ⇒ D ⇒ L (создание линии), по-

сле чего клавишей Tab открыть окно свойств, в ко-

тором в поле End Line Shape выбрать опцию Ar-

row, а в поле Line Shape Size – опцию Medium. 

Затем закрыть окно свойств кнопкой OK и в 

левом верхнем углу третьего квадрата снизу вверх 

нарисовать наклонную линию под углом 45º. 

При необходимости после завершения коман-

ды отредактировать положение линий. 

5.6. Сгруппировать все графические примити-

вы УГО управляемого аттенюатора. 

Результат показан на рис. 3.19. 

6. Добавить на рабочее поле следующие надписи: 

– Токовое зеркало; 

– Узел вторичного питания; 

– Узел управления (только для вариантов задания с РУ). 

Для этого последовательно нажать клавиши P ⇒ F или запустить коман-

ду Place ⇒ Text Frame (создание текстового блока). 

Рис. 3.18 

Рис. 3.19 
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Затем нажать клавишу Tab и в окне свойств текстового блока с помо-

щью кнопки Change ввести требуемую надпись. После этого закрыть окно 

свойств кнопкой OK и в рабочем поле указать границы объекта. 

Аналогичным образом добавить оставшиеся текстовые блоки. 

Если требуется, то после завершения команды произвести необходимые 

корректировки (например, изменить положение текста по вертикали). 

Примечание. Параметры шрифта (GOST type B, 16, Italic) в текстовых 

блоках установлены при загрузке профиля в 3.2.2. 

7. Последовательно нажать клавиши P ⇒ W или запустить команду 

Place ⇒ Wire (создание линии электрической связи) и показать взаимосвязи 

между нарисованными функциональными частями «модуля усилителя», а 

также все входные и выходные сигналы. 

Возможный вариант расположения функциональных частей и взаимо-

связей между ними для вариантов задания с ВУ показан на рис. 3.20, а, а для 

вариантов задания с РУ – на рис. 3.20, б. 

 

Примечания: 

– обозначение электрического соединения (контакта) на рис. 3.20, б по-

является автоматически при соединении двух линий электрической связи. 

Размер точки задан в настройках в подразделе Compiler (см. табл. Г.3); 

– в дальнейшем возможны корректировки расположения нарисованных 

объектов из-за размещения необходимой текстовой информации. 

8. Показать пути распространения сигналов (см. рис. 3.10): 

– перейти в сетку 0.5 мм; 

– последовательно нажать клавиши P ⇒ D ⇒ L (создание линии) и нари-

совать в любом месте рабочего поля стрелку с размерами по рис. 3.11, д; 

Рис. 3.20 
б а 
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– перейти в сетку 1 мм; 

– выделить стрелку и вырезать ее (комбинация клавиш Ctrl+X); 

– добавить стрелку (Ctrl+V) на все линии электрической связи. В мо-

мент установки ее можно повернуть клавишей Space 

Участок схемы между ПФ и усилителем на данном этапе показан на 

рис. 3.21. Точки на рисунке соответствуют узлам сетки 1 мм. 

 

9. Добавить на схему текстовую информацию (надписи или текстовые 

блоки без контура) с параметрами шрифта по умолчанию (GOST type B, 16, 

Italic), которые были установлены при загрузке профиля в 3.2.2. 

Для этого выполнить следующие действия: 

9.1. Указать названия входных и выходных сигналов: Вход, Выход и 

Питание. 

Для вариантов задания с ВУ также показать сигнал Управление. 

9.2. До ПФ записать в децибел-милливаттах уровень мощности входного 

сигнала из варианта индивидуального задания. 

Величина децибел-милливатт (дБм, dBm, dBmW) – единица измерения 

абсолютного уровня мощности в децибелах относительно опорного уровня в 

1 мВт. Другими словами, она показывает на сколько в децибелах данный 

уровень мощности больше или меньше опорного значения в 1 мВт. 

Децибел (дБ, dB) – отношение двух величин в логарифмическом мас-

штабе. Показывает на сколько одна величина больше или меньше другой.  

После создания схемы Э1 в отчете потребуется привести все указанные 

на ней значения мощности в милливаттах. Перевести милливатты в децибел-

милливатты и обратно можно по следующим формулам: 

( )опмд lg10 PPP = , 

10
опм

д10
P

PP = , 

где дP  – уровень мощности, дБм; мP  – уровень мощности, мВт; опP  – опор-

ный уровень мощности, 1оп =P  мВт. 

Рис. 3.21 
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Поясняющие примеры соответствия некоторых уровней мощности в 

упомянутых единицах измерения приведены в табл. 3.3. 

Таблица 3.3 

Соответствие некоторых уровней мощности в разных единицах измерения 

Pд, дБм Пояснение Pм, мВт 

+10 
Текущая мощность на 10 дБ больше (или в 10 раз 

больше), чем 1 мВт 
10 

+2 
Текущая мощность на 2 дБ больше (или в 1,58 раза 

больше), чем 1 мВт 
1,58 

0 
Текущая мощность на 0 дБ больше (или в 1 раз 

больше), чем 1 мВт 
1 

–6 
Текущая мощность на 6 дБ меньше (или в 3,98 раза 

меньше), чем 1 мВт 
0,25 

–20 
Текущая мощность на 20 дБ меньше (или в 100 раз 

меньше), чем 1 мВт 
0,01 

Также следует обратить внимание на то, что дальше будет выполняться 

сложение и вычитание уровней мощности в децибел-милливаттах и коэффи-

циентов усиления (или ослабления) в децибелах. В этом нет ошибки, так как 

фактически работа осуществляется только с децибелами (при постоянном 

опорном уровне 1 мВт). 

Логарифмический масштаб удобен тем, что позволяет заменить опера-

ции умножения и деления сложением и вычитанием соответственно, что зна-

чительно упрощает вычисления и исключает ошибку от округления при каж-

дом действии. Например, если сигнал мощностью минус 10 дБм ослабить на 

2 дБ, то получится значение минус 12 дБм (или 0,063 мВт). При работе с 

милливаттами пришлось бы 0,1 мВт разделить на 1,5848 раза. 

Примечание. В варианте «П1» по данным столбца 3 из табл. 1.1 запи-

сано «-10 дБм». 

9.3. Под ПФ указать диапазон частот пропускания из варианта индиви-

дуального задания. 

Примечание. В варианте «П1» по данным столбца 4 из табл. 1.1 запи-

сано «2,35…2,55 ГГц». 

9.4. Вычислить значение центральной частоты полосы пропускания ( 0F ) 

по следующей формуле: 

 ( ) 20 −+ += CC FFF , (3.1) 

где +CF  и −CF  – верхняя и нижняя частоты полосы пропускания соответ-

ственно, указанные в варианте индивидуального задания, ГГц. 
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В варианте «П1» по данным столбца 4 из табл. 1.1: 

( ) 45,2235,255,20 =+=F  ГГц. 

Все расчеты с пояснениями, а также величины, для которых в тексте 

данного пособия будет дано указание об их сохранении, необходимо сразу 

же заносить в отчет или отдельный файл. Например, в варианте «П1» вычис-

ления и записи по схеме Э1 сохранялись в Mathcad в файле «Расчеты 

(Э1).xmcd» в папке …\ИДРЭС-П1\_Заметки (см. рис. 2.7). 

9.5. Задать коэффициент передачи по мощности в децибелах для ПФ 

( пфG ) на частоте 0F  и сохранить его. 

Так как ПФ еще нет, то эту величину следует выбрать из диапазона от 

минус 1,5 до минус 3 дБ. Это наиболее вероятные значения, которые полу-

чатся после моделирования в вариантах задания. 

Примечание. В варианте «П1» 2пф −=G  дБ. 

9.6. Указать уровень мощности сигнала на входе усилителя. 

Примечания. В варианте «П1» с учетом результатов из пп. 9.2 и 9.5 за-

писано «-12 дБм». 

9.7. Под усилителем записать ток и напряжение, требуемые для работы 

указанной в варианте индивидуального задания микросхемы. Документация 

на микросхемы усилителей находится в папке …\ИДРЭС\Компоненты\Уси-

лители Mini-Circuits (см. рис. 2.9). 

Необходимые данные переписать из условий, помещаемых перед табли-

цей с результатами работы микросхемы при температуре +25 °C. 

Примечания: 

– для микросхемы GALI-3+ из варианта «П1» (столбец 8 из табл. 1.1) 

фрагмент указанной таблицы приведен на рис. 3.22. Как видно, ток (величи-

на Icc) составляет 35 мА, а напряжение (величина Vd) – 3,42 В; 

 

– при отсутствии тока над таблицей взять его номинальное значение в 

общих характеристиках на микросхему (таблица Electrical Specifications); 

Рис. 3.22 
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– ток и напряжение в варианте «П1» специально выбраны для темпе-

ратуры +85 °C для отличия от других вариантов задания. 

9.8. Проверить, что уровень сигнала на входе микросхемы усилителя не 

превышает предельно допустимого значения, и сохранить результат. 

Предельно допустимые значения параметров обычно указываются в до-

кументации в таблице Absolute Maximum Ratings, которая для микросхемы 

GALI-3+ приведена на рис. 3.23. 

 

Требуемая величина – параметр Input Power. 

Примечание. В варианте «П1» превышения нет: –12 дБм < 13 дБм. 

9.9. Определить коэффициент передачи по мощности в децибелах мик-

росхемы усилителя ( уG ) на частоте 0F  и сохранить его. 

Требуемая величина – параметр Gain в таблице из п. 9.7. 

Примечания: 

– в варианте «П1» 74,17у =G  дБ (так как частоты 2,45 ГГц в таблице 

нет, то значение определено по двум ближайшим частотам); 

– так как ток и напряжение микросхемы GALI-3+ выбраны для темпе-

ратуры +85 °C, то на практике при температуре +25 °C следует ожидать 

увеличения коэффициента усиления примерно на 0,5 дБ (рис. 3.24). 

 Рис. 3.24 

2,45 ГГц 

0
,5

 д
Б

 

Рис. 3.23 



 

 67 

9.10. Записать уровень сигнала на выходе усилителя. 

Примечание. В варианте «П1» с учетом результатов из пп. 9.6 и 9.9 за-

писано «+5,74 дБм». 

9.11. Проверить, что уровень сигнала на выходе микросхемы усилителя 

на частоте 0F  не превышает значения однодецибельной точки компрессии, и 

сохранить результат. 

Однодецибельная точка компрессии (1dB compression output point) – 

точка, где отклонение амплитудной характеристики устройства от идеальной 

составляет 1 дБ. Характеризуется соответствующей величиной сигнала (вы-

ходного или входного) и является верхней границей линейного участка ам-

плитудной характеристики. 

Требуемая величина – параметр 1dB Comp. Output в таблице из п. 9.7. 

Примечание. В варианте «П1» превышения нет: 5,74 дБм < 10,82 дБм 

(значение определено по двум ближайшим частотам, как и для Gain). 

9.12. Под аттенюатором записать напряжение питания, требуемое для 

работы указанной в варианте индивидуального задания микросхемы. Доку-

ментация на микросхемы аттенюаторов находится в папке …\ИДРЭС\Ком-

поненты\Аттенюаторы (см. рис. 2.9). 

О подаче питания зачастую свидетельствует наличие вывода VDD, пока-

занного на рисунке с условным изображением корпуса микросхемы. Напри-

мер, в микросхеме HMC467LP3 из варианта «П1» (столбец 9 из табл. 1.1) та-

ким выводом является вывод 3 на рис. 3.25, а. 

 

Однако питание может требоваться и микросхеме, у которой нет такого 

отдельного вывода, как например SKY12328-350LF с рис. 3.25, б. 

Рис. 3.25 

а б 
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Величина напряжения питания (Supply Voltage), его диапазон и необхо-

димость подачи приводятся в документации на микросхему в разделах Fea-

tures и General Description и в таблицах Electrical Specifications, Operating 

Characteristics, Pin Descriptions, Bias Voltage & Current. 

Пример таблицы Bias Voltage & Current для микросхемы HMC467LP3 

показан на рис. 3.26. Здесь указано номинальное напряжение питания +5 В с 

допустимым диапазоном ±10 %, а также номинальное и максимальное значе-

ния тока потребления на выводе VDD (0,7 и 1,2 мА соответственно). 

 

На рис. 3.27, а для микросхемы SKY12328-350LF показан фрагмент таб-

лицы с описанием назначения выводов, из которой следует, что напряжение 

питания в диапазоне от 2,7 до 5,5 В должно быть подано на вывод 2 (обозна-

чен как RF1) через резистор номиналом 10 кОм по схеме с отделного рисун-

ка. Также этот вывод требует установки разделительного конденсатора и мо-

жет использоваться как вход, так и выход аттенюатора. Кроме того, из фраг-

мента таблицы Electrical Specifications (рис. 3.27, б) следует, что напряжение 

питания не должно отличаться от высокого уровня напряжения управления 

(High Control voltage с диапазоном от 2,7 до 5,5 В) более чем на 0,2 В. 

 Рис. 3.27 

а 

б 

Рис. 3.26 
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Примечания: 

– все микросхемы аттенюаторов из вариантов задания требуют пода-

чи напряжения питания; 

– при наличии диапазона значений желательно подавать на микросхему 

уровень напряжения питания выше среднего; 

– в варианте «П1» по рис. 3.26 напряжение задано равным +5 В. 

9.13. Проверить, что уровень сигнала на входе аттенюатора не превыша-

ет предельно допустимого значения, и сохранить результат. 

Таблица с предельно допустимыми значениями параметров для микро-

схемы HMC467LP3 показана на рис. 3.28. 

 

Требуемая величина – параметр RF Input Power. 

Примечание. В варианте «П1» превышения нет: 5,74 дБм < 30 дБм. 

9.14. После аттенюатора с использованием документации на соответ-

ствующую микросхему указать уровни выходного сигнала с учетом всех 

возможных ослаблений: 

9.14.1. Определить количество выводов управления микросхемы атте-

нюатора ( упрN ) и сохранить значение. 

Необходимую информацию можно найти на функциональной схеме, в 

таблице Pin Descriptions и в головке таблицы Truth Table. Вид последней для 

микросхемы HMC467LP3 показан на рис. 3.29, а. 

Примечание. В варианте «П1» по рис. 3.25, а таких выводов два: № 5 

(обозначен как V2) и № 8 (обозначен как V1). 

9.14.2. Вычислить количество возможных уровней ослабления ( аттN ) по 

следующей формуле, сохранив полученное значение: 

упр2атт
N

N = , 

где 2 – число уровней напряжения управления, значения которых обычно 

приводятся в таблицах Control Voltages, Electrical Specifications или около 

таблицы Truth Table. 

Рис. 3.28 
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Примечания: 

– для микросхемы HMC467LP3 по рис. 3.29, б уровни напряжения управ-

ления составляют: высокий уровень (High или HU ) – от плюс 2 до плюс 5 В, 

низкий уровень (Low или LU ) – от 0 до плюс 0,8 В. Например, при подаче 

уровня Low на вывод V1 и уровня High на вывод V2 будет получено ослабле-

ние 4 дБ без учета опорных вносимых потерь (см. пп. 9.14.3 и 9.14.4); 

– уровни управляющих напряжений вместо Low и High могут быть обо-

значены как «0» и «1»; 

– в варианте «П1» существует 4 уровня ослабления. 

9.14.3. Записать в отчет все уровни ослабления микросхемы аттенюатора 

на основании таблицы Truth Table, обратив внимание на следующее: 

– минимальный уровень ослабления на данном этапе записать равным 

нулю. Приведенные в таблице значения ослаблений указаны без учета опор-

ных вносимых потерь, т. е. нормированы к этому параметру (см. п. 9.14.4). 

Зависимости нормированных уровней ослабления от частоты для микросхе-

мы HMC467LP3 показаны на рис. 3.30. Как видно из рисунка, они практиче-

ски не изменяются в рабочем диапазоне частот микросхемы; 

– если управляющих выводов много, то в таблице Truth Table будут пе-

речислены не все возможные уровни ослабления. Например, для микросхемы 

SKY12328-350LF в таблице на рис. 3.31 для пяти выводов управления приве-

дено лишь семь уровней ослабления из возможных 32: 

а) минимальный (на все выводы управления подан уровень High); 

б) максимальный (на все выводы управления подан уровень Low); 

в) уровни ослабления отдельно по каждому выводу управления (на соот-

ветствующий вывод подан уровень Low, а на все остальные – уровень High). 

а 

Рис. 3.29 

б 
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Неуказанные уровни ослабления определяются суммой уровней ослаб-

ления по каждому выводу управления. Например, для получения ослабления 

6,5 дБ необходимо подать уровень Low на выводы V1, V3 и V4 (0,5, 2 и 4 дБ 

соответственно) и уровень High на выводы V2 и V5; 

– при большом количестве значений запись осуществить в виде «А; Б; В; 

…; Ж», где А, Б, В и Ж – первое, второе, третье и последнее значение соот-

ветственно (между А и Б, Б и В будет одинаковый шаг). 

Примечание. В варианте «П1» по рис. 3.29, а: 0; 2; 4; 6 дБ. 

9.14.4. Определить значение опорных вносимых потерь на частоте 0F  и 

зафиксировать результат в отчете вместе с графиком. 

Опорные вносимые потери (Reference Insertion Loss) – это дополнитель-

ное ослабление, которое микросхема вносит в проходящий через нее сигнал 

Рис. 3.30 

Рис. 3.31 
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вне зависимости от установленной комбинации напряжений управления на 

управляющих выводах. Данные потери зависят от рабочей температуры и ча-

стоты сигнала и приводятся на соответствующем графике, который для мик-

росхемы HMC467LP3 показан на рис. 3.32. 

 

Примечание. При температуре +25 ºС на частоте 0F  в варианте «П1» 

опорные вносимые потери составили 0,5 дБ (см. рис. 3.32). 

9.14.5. Добавить к каждому уровню ослабления из п. 9.14.3 модуль опор-

ных вносимых потерь и записать значения в отчет. 

Примечание. В варианте «П1»: 0,5; 2,5; 4,5; 6,5 дБ. 

9.14.6. Вычесть из уровня мощности на выходе усилителя (см. п. 9.10) 

значения из п. 9.14.5, записав результат на схеме после аттенюатора.  

Примечание. Запись в варианте «П1»: «+5,24; +3,24; +1,24; -0,24 дБм». 

10. Обозначить «усилитель», для чего выполнить следующие действия: 

– последовательным нажатием клавиш P ⇒ D ⇒ R нарисовать прямо-

угольный контур, охватывающий все функциональные части, обратив вни-

мание на то, что от надписей и границ функциональных частей до нарисо-

ванного контура должен быть оставлен зазор не менее 3 мм; 

– последовательным нажатием клавиш P ⇒ T внутри прямоугольного 

контура сверху справа записать название и обозначение «усилителя». 

Примечание. В варианте «П1» записано «Усилитель УП1.01.01». 

11. Обозначить «экран» вокруг функциональных узлов СВЧ-тракта. 

Экранирование по ГОСТ 2.721–74 обозначается замкнутым контуром 

(рекомендуется прямоугольной формой) из штриховых линий, которые со-

Рис. 3.32 

2,45 ГГц 
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стоят по ГОСТ 2.303–68 из штрихов длиной 2–8 мм, расположенных на рас-

стоянии 1–2 мм друг от друга [19]. Размеры штриховой линии должны быть 

одинаковы на всей схеме. 

Для создания «экрана» последовательным нажатием клавиш P ⇒ D ⇒ L 

отдельными штрихами нарисовать замкнутый контур вокруг ПФ, усилителя 

и аттенюатора, при этом он должен находится за пределами контура, обозна-

чающего «усилитель» (так как «экран» входит в состав «модуля усилителя»). 

Используются отдельные штрихи, так как стиль линии Dashed не соответ-

ствует указанным выше параметрам. 

Расстояние до других объектов должно быть не менее 3 мм. 

12. Под один из штрихов на нижней стороне контура «экрана» последо-

вательным нажатием клавиш P ⇒ O (или командой Place ⇒ Power Port) до-

бавить символ земли – идентификатор цепи GND Power Port. 

Примечание. Подробнее об идентификаторах цепей см. в Г.27. 

13. В месте соединения символа земли и контура «экрана» последова-

тельным нажатием клавиш P ⇒ J или командой Place ⇒ Manual Junction 

добавить обозначение электрического соединения, выбрав в его свойствах 

размер Small. 

14. Сохранить изменения в схеме (Ctrl+S). 

Результат в варианте «П1» на данном этапе показан на рис. 3.33. 

 Рис. 3.33 
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15. При желании выполнить 2-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. Ж). 

В дальнейшем по результатам расчетов, произведенных в схеме Э3 

«усилителя» из разд. 8, в схему Э1 будут внесены следующие изменения: 

– добавлены значения диапазона входного напряжения питания и тока 

потребления устройства; 

– добавлено значение напряжения, поступающего на «токовое зеркало», 

или скорректировано количество уровней напряжений, формируемых узлом 

вторичного питания. 

На рис. 3.34 показано содержание файла «Расчеты (Э1).xmcd». 

 

Для составления выражений использовалась ПИ Calculator, вызываемая 

командой View ⇒ Toolbars ⇒ Calculator (рис. 3.35). 

Левый нижний оператор в данной ПИ (:=) – оператор присваивания 

(значение или выражение справа от него задается переменной, записанной 

слева), а правый нижний оператор (=) – оператор вычисления (выводит зна-

чение переменной). 

Рис. 3.34 
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Текстовые надписи выполнены стилем Normal. В 

окне Text Styles (команда Format ⇒ Style) для него были 

заданы следующие параметры: Font – Times New Roman, 

Font style – обычный, Size – 12, Script – Кириллица. 

Редактирование стилей выражений производится в 

окне Equation Format (команда Format ⇒ Equation). Для 

стилей Variables (выражения) и Constants (константы) 

были заданы такие же параметры, как и для стиля Normal. 

В начале документа командой Insert ⇒ Area добавле-

на область, щелкнув по границам которой ЛКМ можно скрыть находящуюся 

внутри нее информацию. Например, это может пригодиться для защиты ин-

формации паролем (ПКМ ⇒ Lock, где ПКМ – правая кнопка мышки) или для 

разбиения расчетов на части (в свойствах области можно изменить цвет гра-

ниц и задать наименование). В данном файле в нее помещено выражение для 

смены единиц измерения (с английских названий на русские). 

Пользовательские единицы измерения записываются при редактирова-

нии выражений переменных после их значений.  

Для изменения наименования еди-

ницы измерения результата выражения 

на пользовательское необходимо ввести 

его перед черным квадратом (рис. 3.36). 

Запись индекса начинается с ввода символа «точка» с клавиатуры сразу 

после буквенного обозначения переменной. 

Чтобы заменить знак умножения, отображающийся между числом и 

единицей измерения (например, на пробел), необходимо выполнить на нем 

команду ПКМ ⇒ View Multiplication As ⇒ Thin Space. 

Заменить обозначение «:=» на «=» можно как отдельно в каждой форму-

ле, выполнив на нем команду ПКМ ⇒ View Definition As ⇒ Equal, так и для 

всего документа, выполнив последовательность команд Tools ⇒ Worksheet 

Options ⇒ Display ⇒ Definition ⇒ Equal ⇒ OK. 

В Mathcad существует средство автоматической подстановки значений 

переменных в формулу – функция (ключевое слово) explicit из ПИ Symbolic 

(команда View ⇒ Toolbars ⇒ Symbolic). Функция добавляется сразу после 

выражения (если последним элементом является дробь, то курсор должен 

находиться или в конце числителя, или в конце знаменателя), а далее после 

запятой записываются переменные, значения которых должны быть подстав-

Рис. 3.35 

Рис. 3.36 
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лены (разделитель – также запятая). Для указания всех переменных служит 

слово ALL (рис. 3.37). 

 

Для скрытия названия функции служит команда ПКМ ⇒ Hide 

keywords, а для замены стрелки на знак равенства – команда ПКМ ⇒ View 

Evaluation As ⇒ Equal sign (также это можно сделать сразу во всем доку-

менте последовательностью команд Tools ⇒ Worksheet Options ⇒ Display ⇒ 

Symbolic Evaluation ⇒ Equal ⇒ OK). 

Недостатки указанной подстановки: 

– единицы измерения всегда записываются после соответствующих зна-

чений и без учета пользовательской смены их названий; 

– десятичные дробные значения необходимо предварительно округлять 

(вручную или с помощью функции round с указанием в скобках через запя-

тую округляемого числа и количества знаков после запятой). 

3.4. Содержание отчета 

По 3-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Краткое описание назначения изображенных на схеме Э1 функцио-

нальных частей и путей распространения сигналов. 

2. Расчет центральной частоты полосы пропускания ПФ. 

3. Уровни СВЧ-сигнала, указанные на схеме Э1, в милливаттах и деци-

бел-милливаттах. 

4. Результаты проверок по пп. 9.8, 9.11 и 9.13 из 3.3 с соответствующими 

рисунками из документаций на микросхемы. 

5. Уровни ослабления микросхемы аттенюатора без учета опорных вно-

симых потерь на частоте 0F  и с их учетом, а также график, по которому про-

изводилось определение указанных потерь. 

6. Рисунок схемы Э1 без рамки. Рисунок сделать или клавишей Prt Sc с 

последующей обрезкой лишней информации, или с помощью приложения 

Ножницы. 

 

Рис. 3.37 
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4. ПРОЕКТИРОВАНИЕ СВЧ-ФИЛЬТРОВ 

4.1. Общие сведения о фильтрах 

Фильтром называется устройство, устанавливаемое между выводами 

электрической цепи с целью изменения соотношения между частотными со-

ставляющими спектра проходящего через него сигнала. 

В зависимости от формы амплитудно-частотной характеристики 

(АЧХ, кривая зависимости затухания от частоты) имеется четыре основных 

класса фильтров [20]: 

1. Фильтр нижних частот (ФНЧ). Фильтры этого класса пропускают 

только низкочастотные составляющие спектра сигнала обычно от постоян-

ной составляющей и до частоты, называемой частотой среза. Все спектраль-

ные составляющие сигнала выше этой частоты ФНЧ подавляет. 

2. Фильтр верхних частот (ФВЧ). Фильтры этого класса подавляют 

в спектре сигнала все компоненты с частотой от 0 до частоты среза. Спек-

тральные составляющие сигнала выше этой частоты пропускаются ФВЧ без 

искажений. 

3. Полосовой фильтр (ПФ). Фильтры этого класса пропускают без ис-

кажений все спектральные компоненты сигнала только в пределах заданной 

полосы частот (полоса пропускания) и подавляют все компоненты вне ее 

(полоса задерживания). 

4. Режекторный фильтр (РФ). Фильтры этого класса подавляют ком-

поненты спектра внутри заданной полосы и пропускают без искажений ча-

стоты вне этой полосы. 

Данные выше определения характеризуют идеальные фильтры и приме-

нимы для фильтров на любых частотах. 

В реальных фильтрах между полосой пропускания и полосой задержи-

вания всегда существует некоторая переходная область, поэтому вводится 

понятие граничная частота полосы задерживания ( SF ). Это частота, выше 

или ниже которой фильтр начинает подавлять спектральные составляющие 

на величину, превышающую заданный уровень ослабления Sa . 

Кроме того, реальные фильтры ослабляют сигнал и в полосе пропуска-

ния, поэтому в данном пособии под частотой среза ( CF ) будет пониматься 

частота, выше или ниже которой фильтр подавляет спектральные составля-

ющие на величину, не превышающую заданного уровня ослабления Ca . 
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На следующих рисунках приведены формы ФЧХ реальных фильтров: 

ФНЧ – рис. 4.1, а; ФВЧ – рис. 4.1, б; ПФ – рис. 4.1, в; РФ – рис. 4.1, г. 

 

 

Среди наиболее характерных видов АЧХ на примере ФНЧ в сравнении 

с его идеальной характеристикой (рис. 4.2, а) различают следующие группы 

фильтров: 

1. Фильтр Баттерворта. Этот фильтр (рис. 4.2, б) имеет АЧХ, форма 

которой в середине полосы пропускания очень близка к плоской и несколько 

закругляется в окрестности частоты среза. За пределами полосы пропускания 

скорость затухания увеличивается и в некоторых случаях достигает ф6n  дБ 

ПП – полоса пропускания; ПЗ – полоса задерживания;  

ШПП – ширина полосы пропускания; ШПЗ – ширина полосы задерживания 

Рис. 4.1 

а б 

в г 

а б в 

Рис. 4.2 
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на октаву, где фn  – порядок фильтра. Порядок для фильтра Баттерворта рас-

считывается по формуле [21]: 
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= , (4.1) 

где SL  и CL  – функции рабочего затухания, соответствующие уровням зату-

хания Sa  и Ca  в полосе задерживания и пропускания соответственно.  

Указанные параметры можно найти по следующим формулам: 

 
10

10 Sa
SL = , (4.2) 

 
10

10 Ca
CL = . (4.3) 

Фильтры Баттерворта очень просты в изготовлении, так как к парамет-

рам элементов схемы не предъявляется никаких особых требований. 

2. Фильтр Чебышева. Этот фильтр (см. рис. 4.2, в) точнее воспроизво-

дит АЧХ идеального ФНЧ. В области частоты среза форма его АЧХ является 

почти прямоугольной, а скорость ее спуска к полосе задерживания более 

крутой, чем у фильтра Баттерворта. Однако в полосе пропускания присут-

ствует неравномерность в виде пульсаций. Чем их больше, тем круче АЧХ в 

области частоты среза для данного порядка и тем чувствительнее к измене-

нию параметров элементов становится схема. 

В первой октаве затухание превосходит ф6n  дБ. 

3. Эллиптический фильтр. Фильтры 

Чебышева и Баттерворта полностью подавля-

ют лишь спектральные составляющие с беско-

нечными частотами, а эллиптические фильтры 

позволяют получить форму АЧХ (рис. 4.3), 

обеспечивающую полное подавление опреде-

ленных компонентов спектра в полосе задер-

живания вблизи частоты среза. 

В полосе пропускания эллиптических 

фильтров имеются пульсации, а в полосе за-

держивания – дополнительные участки с оди-

наковой амплитудой. Для заданного порядка 

фильтра данная группа фильтров обладает АЧХ с самым крутым из теорети-

чески возможных спуском к полосе задерживания. 

1 – идеальный ФНЧ;  

2 – ФНЧ Баттерворта;  

3 – ФНЧ Чебышева;  

4 – эллиптический ФНЧ 

Рис. 4.3 
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4.2. Типовые топологии основных классов СВЧ-фильтров 

С повышением частоты физические размеры сосредоточенных элемен-

тов уменьшаются и на частотах выше нескольких сотен мегагерц становятся 

настолько малыми, что их изготовление и применение вызывает серьезные 

трудности. Например, изготовить пригодные для практического применения 

сосредоточенные индуктивности в диапазоне выше 200 МГц и сосредоточен-

ные емкости в диапазоне выше 2 ГГц становится затруднительно, так как 

межвитковая емкость катушек индуктивности и индуктивность выводов кон-

денсаторов приводит к возникновению резонансов. 

Кроме того, по мере повышения частоты на параметры сосредоточенных 

элементов все большее влияние начинают оказывать излучение и тепловые 

потери в них. Поэтому на достаточно высоких частотах предпочтение часто 

отдается отрезкам линии передачи, используемым в качестве элементов 

фильтров. 

Таким образом, СВЧ-фильтр представляет собой линию передачи, кото-

рая включает неоднородности, согласованные в определенной полосе частот 

и резко рассогласованные вне этой полосы. В этом смысле работа фильтра 

похожа на работу широкополосного согласующего устройства. 

Подбором длин и волновых сопротивлений отрезков линий передачи 

стараются смоделировать поведение сосредоточенных элементов в схеме со-

ответствующего фильтра-прототипа. Однако такой подход к синтезу филь-

тров – это лишь начальное и весьма грубое приближение, так как в этом слу-

чае не учитывается ряд важных факторов, влияющих на АЧХ, например: 

– реактивности в месте стыка отрезков линий передачи; 

– дисперсия в линиях передачи; 

– периодичность частотных характеристик элементов с распределенны-

ми параметрами. 

Действительная АЧХ фильтров на резонаторах обычно оказывается 

смещена вниз по частоте. Основной вклад в это вносят краевые емкости на 

концах разомкнутых отрезков линии, которые приводят к тому, что длина ре-

зонаторов оказывается завышенной. Поэтому часто расчетные значения длин 

резонаторов необходимо уменьшать [22]–[24]. 

Топологии ФНЧ СВЧ-диапазона. Наиболее простая топология ФНЧ 

представлена на рис. 4.4, а. Она состоит из каскадного соединения коротких 

отрезков линии с высоким и низким волновыми сопротивлениями. Отрезки 

линии с высоким волновым сопротивлением эквивалентны индуктивностям 
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фильтра-прототипа, а отрезки с низким волновым сопротивлением – емко-

стям фильтра-прототипа. 

 

На рис. 4.4, б показан еще один вариант ФНЧ, в котором две индуктив-

но-емкостные ветви дают пики затухания на частотах, расположенных выше 

частоты среза фильтра и достаточно близко к ней, что приводит к увеличе-

нию крутизны характеристики – эллиптический фильтр [25]. 

Топологии ФВЧ СВЧ-диапазона. В топологии ФВЧ на рис. 4.5, а ин-

дуктивности выполнены в виде короткозамкнутых отрезков линии передачи 

с разрывами в основной линии, представляющими собой последовательные 

емкости. 

 

Как и во втором варианте ФНЧ, на рис. 4.5, б показан вариант с индук-

тивно-емкостными ветвями. 

Следует отметить, что для получения требуемых значений последова-

тельных емкостей могут потребоваться очень малые зазоры, воспроизвести 

Рис. 4.4 

а б 

Рис. 4.5 

б а 

г 

в 
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которые при изготовлении будет весьма трудно. К тому же зазор в токонесу-

щем проводнике линии ведет себя не как чистая сосредоточенная емкость, 

так как его эквивалентная схема представляет собой П-образную цепь, состо-

ящую из последовательно и параллельно включенных емкостей. 

Помимо разрывов, при большой величине емкости (порядка 2–6 пФ), 

могут быть использованы соединения типа «ласточкин хвост» (см. рис. 4.5, в) 

или перекрытия одной части центральной жилы полосковой линии другой с 

диэлектрической прокладкой между ними [24]. 

В СВЧ-диапазоне трудно или вообще невозможно построить ФВЧ с хо-

рошей характеристикой в полосе пропускания (вплоть до частот, во много 

раз превышающих граничную частоту), поэтому в качестве ФВЧ часто ис-

пользуют фильтры псевдоверхних частот – ПФ с широкой полосой пропус-

кания. Примером (см. рис. 4.5, г) может служить фильтр на замкнутых шлей-

фах со связью через отрезки линий [25]. 

Топологии ПФ СВЧ-диапазона. ФВЧ с топологией на рис. 4.5, г, как 

отмечалось выше, – это ПФ с широкой полосой пропускания. 

 

Другой топологией ПФ служит фильтр с боковыми электромагнитными 

связями или фильтр на параллельно связанных резонаторах (рис. 4.6, а). Он 

состоит из полуволновых отрезков МПЛ, разомкнутых на обоих концах и 

расположенных параллельно друг другу со сдвигом на четверть длины вол-

ны. Особенности такого фильтра: 

– разомкнутые на концах резонаторы технологически удобны в печат-

ном исполнении; 

– габариты фильтров – наименьшие в классе планарных полосковых 

фильтров; 

Рис. 4.6 

а 

б 

в 
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– при незначительной расстройке могут появиться узкие паразитные по-

лосы вблизи частоты 02 , где 0  – средняя частота первой полосы пропус-

кания; 

– паразитная полоса пропускания – на частоте 03 ; 

– ограничение широких полос, которое связано с трудностями реализа-

ции малых зазоров между резонаторами; 

– ограничение узких полос, которое вызвано ростом тепловых потерь. 

Габариты по ширине у данной топологии фильтра можно дополнительно 

уменьшить, повернув ее таким образом, чтобы вход и выход были на одной 

линии (см. рис. 4.6, б). 

Еще одна топология ПФ – встречно-штыревой фильтр (см. рис. 4.6, в). 

Он состоит из четвертьволновых отрезков полосковых линий, короткоза-

мкнутых на одном конце, разомкнутых на другом и расположенных парал-

лельно друг другу так, что их короткозамкнутые и разомкнутые концы чере-

дуются. Тепловые потери и габариты у такого фильтра находятся в области 

минимальных достижимых значений, а полоса пропускания может быть реа-

лизована в широких пределах. Расстояния между резонаторами относительно 

велики, что снижает требования к допускам изготовления, а паразитная по-

лоса пропускания находится на частоте 03  [25]–[27]. 

Топологии РФ СВЧ-диапазона. Нежелательные частоты достаточно 

хорошо подавляются ПФ обычного типа, но если на какой-то определенной 

частоте помеха особенно велика, то эффективность использования одного 

или нескольких РФ, подавляющих только определенные частоты, оказывает-

ся выше ПФ, рассчитанного на подавление широкого диапазона частот вне 

требуемой полосы пропускания. 

 

Топология РФ, показанного на рис. 4.7, а, подходит для узких полос за-

держивания. Такой фильтр состоит из полоснозадерживающих резонаторов в 

виде шлейфов с емкостной связью, отстоящих друг от друга на расстоянии 

четверти длины волны на средней частоте полосы задерживания. 

Рис. 4.7 

а б 
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РФ, показанный на рис. 4.7, б, может быть рассчитан на довольно широ-

кие полосы задерживания. Средними частотами полос задерживания служат 

те, на которых длина разомкнутых шлейфов становится равной одной чет-

верти длины волны или нечетному числу четвертей длины волны. Этот 

фильтр можно использовать и в случае узких полос задерживания, однако то-

гда требуемые сопротивления шлейфов могут стать слишком большими [28]. 

4.3. Линейное моделирование ПФ в Microwave Office 

4.3.1. Интерфейс Microwave Office 

Линейное моделирование (2D-анализ) в Microwave Office для определе-

ния характеристик электрической цепи использует метод узловых напряже-

ний. Оно может применяться для цепей типа усилителей в линейном режиме, 

фильтров, направленных ответвителей, делителей мощности и других, чьи 

элементы описываются матрицей полных проводимостей. Для такого моде-

лирования характерно определение измеряемых величин типа усиления, 

устойчивости, коэффициента отражения, коэффициента передачи. 

При линейном моделировании есть возможность выполнять оптимиза-

цию, а также производить статистический анализ для оценки влияния раз-

броса параметров элементов схемы на разброс характеристик. Кроме того, 

моделирование происходит в реальном масштабе времени, что позволяет 

настраивать элементы схемы и сразу наблюдать результаты [29]. 

 Рис. 4.8 
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В верхней части главного окна Microwave Office (рис. 4.8) располагается 

строка меню и ПИ с часто используемыми командами. 

Слева находится окно просмотра проекта – древовидная структура групп 

и модулей, которая определяет активный проект, включая схемы, электро-

магнитные структуры, частоты моделирования и выходные графики. По 

умолчанию под ним располагаются три вкладки: 

– Project (состав проекта); 

– Elements (набор элементов для формирования схем); 

– Layout (параметры для просмотра и рисования топологии и создания 

новых элементов топологии). 

Внизу по умолчанию помещено окно системных сообщений (Status 

Window). 

Оставшаяся область – рабочее поле, представляющее собой зону для со-

здания схем и электромагнитных структур. Также здесь отображаются ре-

зультаты проектирования в виде графиков [29]. 

4.3.2. Предварительные расчеты 

Перед выполнением дальнейших действий кроме информации по филь-

трам из 4.1 и 4.2 следует ознакомиться с информацией по ПП из прил. Б. 

В зависимости от варианта индивидуального задания на проектирование 

необходимо создать и промоделировать одну из двух структур ПФ на МПЛ: 

– СЛ – ПФ на параллельно связанных резонаторах (рис. 4.6, а и б); 

– ШТ – встречно-штыревой ПФ (рис. 4.6, в). 

Параметры МПЛ можно определить в программе TXLine из состава Mi-

crowave Office (команда Tools ⇒ TXLine), а синтезировать фильтры – в про-

грамме Nuhertz Filter, устанавливаемой отдельно. В вариантах задания все 

действия необходимо осуществить вручную. 

В варианте «П1» вычисления выполнялись в Mathcad в файле Расчеты 

(фильтр).xmcd. Этот файл и все файлы, полученные при проектировании 

ПФ, сохранялись в папку …\ИДРЭС-П1\Усилитель\_Фильтр (см. рис. 2.8). 

Порядок выполнения предварительных расчетов следующий: 

1. Записать по табл. Б.2 значения параметров материала из варианта ин-

дивидуального задания и сохранить их. 

В варианте «П1» для AD1000-0,508-18/18 (столбец 1 из табл. 1.1): 

– базовая толщина диэлектрика – 508,0=h  мм; 

– толщина меди (с каждой стороны) – 18=t  мкм; 
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– тангенс угла диэлектрических потерь – 0023,0tan = ; 

– относительная диэлектрическая проницаемость – 10=r ; 

– допуск r  – 35,0= r  (плюс-минус). 

2. Определить по (Б.4)–(Б.7) ширину полоскового элемента МПЛ для 

волнового сопротивления 500 =Z  Ом. 

В варианте «П1» параметр A : 

152,2
10

11,0
23,0

110

110

2

110

60

50
=








+

+

−
+

+
=A . 

Так как 52,1A , то ширина плоского элемента: 

 
( )

( )
5,0486,0

2152,22exp

152,2exp508,08
=

−


=W  мм. (4.4) 

Округление размеров (ширин и длин полосковых элементов, зазоров 

между ними) по общему заданию на проектирование необходимо произво-

дить с точностью до десятых долей миллиметра. Большая точность приведет 

к увеличению времени электромагнитного моделирования из-за уменьшения 

шага сетки. 

При выполнении расчетов в Mathcad следует обратить внимание на 

необходимость принудительной установки знака умножения между числом и 

переменной h в (Б.5) и (Б.6), так как от этого зависит правильность результа-

та вычисления (рис. 4.9). 

 

3. Записать и сохранить значения параметров из варианта индивидуаль-

ного задания, определяющих форму АЧХ ПФ. 

В варианте «П1» по табл. 1.1: 

– 35,2=−CF  ГГц – нижняя частота полосы пропускания (столбец 4); 

– 55,2=+CF  ГГц – верхняя частота полосы пропускания (столбец 4); 

– 8,1=−SF  ГГц – нижняя частота помехи (столбец 5); 

– 85,2=+SF  ГГц – верхняя частота помехи (столбец 5); 

– 30=−Sa  дБ – ослабление нижней частоты помехи (столбец 6); 

– 35=+Sa  дБ – ослабление верхней частоты помехи (столбец 6). 

Рис. 4.9 
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Кроме того, записать и сохранить значение частоты 0F , определенной в 

п. 9.4 из 3.3 (в варианте «П1» – 45,20 =F  ГГц), а также вычислить затухание 

в полосе пропускания ПФ ( Ca ) по следующей формуле: 

 пфGaC = .  

Коэффициент пфG  выбран в п. 9.5 из 3.3, поэтому в варианте «П1»: 

 22 =−=Ca  дБ. 

4. Определить порядок ПФ. 

На рис. 4.10 приведены две АЧХ ПФ, имеющие симметричные относи-

тельно частоты 0F  формы. У них одинаковая ширина полосы пропускания 

( CW ), ограниченная точками 2 и 3 и определяемая по формуле: 

 −+ −= CCC FFW . (4.5) 

 

АЧХ с номером 1 проходит через точку 1, в которой действует левая 

помеха, и имеет ширину полосы задерживания по уровню ее ослабления 

( −SW ): 

 ( )−− −= SS FFW 02 . (4.6) 

АЧХ с номером 2 проходит через точку 4, в которой действует правая 

помеха, и имеет ширину полосы задерживания по уровню ее ослабления 

( +SW ): 

 ( )02 FFW SS −= ++ . (4.7) 

Для определения порядка ПФ необходимо вычислить порядки фильтров 

с 1-й и 2-й АЧХ, сравнить их друг с другом, выбрать большее значение и 

округлить его в соответствии с заданной структурой ПФ: 

Рис. 4.10 
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4.1. По (4.5)–(4.7) вычислить CW , −SW  и +SW : 

В варианте «П1»: 

2,035,255,2 =−=CW  ГГц; 

( ) 3,18,145,22 =−=−SW  ГГц; 

( ) 8,045,285,22 =−=+SW  ГГц. 

4.2. По (4.2) и (4.3) определить функции рабочего затухания, соответ-

ствующие уровням затухания Ca , −Sa  и +Sa . 

В варианте «П1»: 

585,110 102 ==CL ; 

100010 1030 ==−SL ; 

3,316210 1035 ==+SL . 

4.3. В (4.1) заменить частоты SF  и CF  на ширины полос SW  и CW  соот-

ветственно и вычислить порядки ПФ −фn  и +фn . 

В варианте «П1»: 
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4.4. Определить большее значение порядка фильтра из п. 4.3 и округлить 

его в большую сторону: 

– для ШТ – до ближайшего нечетного целого числа; 

– для СЛ – до ближайшего целого числа. 

В варианте «П1» −+  фф nn  и задан ШТ, поэтому 5ф =n . 

Чем выше порядок фильтра, тем больше крутизна спада АЧХ и тем 

сложнее его структура (больше звеньев, из которых он образован), например: 

– ШТ состоит из фn  резонаторов; 

– СЛ состоит из ( 1ф +n ) каскадно-соединенных звеньев. 

Примечание. В выполненном расчете не учитывается вид АЧХ кон-

кретной топологии ПФ, поэтому вычисления носят оценочный характер. 
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4.3.3. Создание схемы встречно-штыревого ПФ 

Необходимо обратить внимание на то, что последовательность действий 

по разработке схемы СЛ приведена в 4.3.4. 

Для создания схемы ШТ 5-го порядка выполнить следующее: 

1. Создать новую схему, для чего на элементе 

Circuit Schematics из вкладки Project запустить ко-

манду ПКМ ⇒ New Schematic (рис. 4.11) и в от-

крывшемся окне задать имя схемы – BPF (Band-Pass 

Filter). После этого в рабочем поле откроется пустое 

окно схемы. 

2. Задать единицы измерения и частотный диапазон моделирования, для 

чего запустить команду Options ⇒ Project Options и в открывшемся окне 

Project Options выполнить следующее: 

2.1. На вкладке Global Units:  

– в поле Frequency выбрать GHz; 

– включить опцию Metric units; 

– в поле Length type выбрать mm. 

2.2. На вкладке Frequencies установить начальное и конечное значения 

частот моделирования примерно на 0,5 ГГц меньше и больше частот левой и 

правой помехи из варианта задания соответственно, а также шаг изменения в 

заданном диапазоне – 0,05 ГГц. 

В варианте «П1» с учетом данных столбца 5 из 

табл. 1.1 записано: 

– в поле Start – 1.3 ГГц; 

– в поле Stop – 3.3 ГГц; 

– в поле Step – 0.05 ГГц. 

После этого выбрать опцию Replace и нажать 

Apply (рис. 4.12), а затем закрыть окно кнопкой OK. 

3. Сохранить проект командой File ⇒ Save Project As с расширением 

«.emp». Имя файла в варианте «П1» – «BPF–П1», а путь сохранения – 

…\ИДРЭС-П1\Усилитель\_Фильтр (см. рис. 2.8). 

4. Добавить в схему необходимые элементы, для чего выполнить следу-

ющие действия: 

4.1. Сделать активной вкладку Elements. 

4.2. Щелкнуть ЛКМ по группе Substrates. Затем в нижней части окна 

просмотра элементов найти элемент MSUB (рис. 4.13) и перетащить его за-

Рис. 4.12 

Рис. 4.11 
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жатой ЛКМ на свободное поле схемы, после чего 

щелчком ЛКМ зафиксировать. MSUB – модель 

МПЛ с общими для всей схемы параметрами. 

Перемещение элемента по полю схемы осу-

ществляется зажатой ЛКМ. 

4.3. Войти в свойства элемента MSUB (ко-

манда ПКМ ⇒ Properties, выполненная на нем) и 

в появившемся окне на вкладке Parameters в 

столбце Value ввести значения параметров МПЛ, 

после чего нажать OK. 

В варианте «П1» записано (рис. 4.14): 

– 10 в поле Er – относительная диэлектриче-

ская проницаемость ( r ); 

– 0.508 в поле H – толщина подложки (h); 

– 0.018 в поле T – толщина проводника (t); 

– 0.783 в поле Rho – удельное сопротивление металла проводника, нор-

мированное к золоту. Так как используется медная фольга, то указанное зна-

чение во всех вариантах задания будет одинаковым (удельное сопротивление 

меди – 0,018 Ом·мм2/м, а золота – 0,023 Ом·мм2/м); 

– 0.0023 в поле Tand – тангенс угла диэлектрических потерь ( tan ); 

– 10.2 в поле ErNom – номинальная диэлектрическая проницаемость, 

используемая в элементах с X-моделями. Эти элементы в конце названий 

имеют символ X, а их параметры определены с помощью электромагнитного 

моделирования и сохранены в таблицах. Значение ErNom должно быть вы-

брано ближайшим к Er из ряда – 2,2; 2,33; 2,45; 2,5; 2,94; 3; 3,2; 3,25; 3,38; 

3,4; 3,48; 3,66; 4,5; 4,99; 6; 6,15; 9,2; 9,7; 9,8; 10,2; 10,8; 11,2; 12,4; 12,9; 

– SUB1 в поле Name – имя подложки. 

 

4.4. Раскрыть группу Microstrip. 

Рис. 4.14 

Рис. 4.13 
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4.5. Щелкнуть ЛКМ по подгруппе Coupled Lines. Найти и перетащить 

на поле схемы элемент M5CLIN, при этом до его фиксации нажать один раз 

ПКМ, чтобы он повернулся так, как показано на рис. 4.15. M5CLIN – модель 

связанной линии с пятью связанными полосковыми элементами. 

 

Если элемент уже размещен, то повернуть его можно командой ПКМ ⇒ 

Rotate, выполненной на нем. 

Примечание. Первый вывод всех элементов в Microsoft Office отмечает-

ся косой чертой. 

4.6. Щелкнуть ЛКМ по подгруппе Lines. Найти и перетащить на свобод-

ное поле схемы три элемента MLSC, после чего подключить их к выводам 3, 

7 и 9 элемента M5CLIN. MLSC – модель полоскового элемента, подключен-

ного с одной стороны к земле. 

Соединить выводы элементов можно одним из двух способов: 

– совместить концы выводов элементов друг с другом, в результате чего 

в месте соединения появится зеленый квадрат. Если к одной точке подклю-

чено больше двух цепей, то вместо зеленого квадрата отображается зеленый 

круг. При перемещении элемента между соеди-

ненными выводами будет появляться красная ли-

ния, свидетельствующая о наличии связи; 

– подвести курсор мышки к концу одного 

вывода и щелкнуть ЛКМ. Затем подвести курсор 

мышки к концу другого вывода и снова щелкнуть 

ЛКМ. Ведя связь от одного вывода к другому 

ЛКМ, можно фиксировать изгибы линии связи. 

Удаление выделенной линии связи осу-

ществляется клавишей Delete. 

Результат подключения одного из MLSC к выводу 3 элемента M5CLIN 

показан на рис. 4.16. 

Рис. 4.15 
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4.7. Щелкнуть ЛКМ по подгруппе Other. Найти и перетащить на сво-

бодное поле схемы пять элементов MOPENX$, после чего подключить их к 

выводам 2, 4, 6, 8 и 10 элемента M5CLIN. MOPENX$ – модель открытого 

(разомкнутого) конца полоскового элемента. 

4.8. Щелкнуть ЛКМ по подгруппе Junctions. Найти и перетащить на 

свободное поле схемы два элемента MTEE. MTEE – модель места соедине-

ния трех полосковых элементов. 

Первый элемент MTEE подключить первым выводом к выводу 1 эле-

мента M5CLIN, при этом третий вывод будет направлен влево. 

Второй элемент MTEE подключить вторым выводом к выводу 5 элемен-

та M5CLIN, при этом третий вывод будет направлен вправо. 

Результат подключения показан на рис. 4.17. 

 

4.9. Щелкнуть ЛКМ по подгруппе Lines. Найти и перетащить на свобод-

ное поле схемы два элемента MLIN, после чего подключить их к выводам 3 

элементов MTEE. MLIN – модель полоскового элемента. 

В свойствах элементов MLIN для параметра L установить значение дли-

ны полоскового элемента 2 мм. 

4.10. Выделить на схеме элемент MOPENX$, подключенный к выводу 2 

элемента M5CLIN, и последовательно нажать комбинации клавиш Ctrl+C 

(копировать) и Ctrl+V (вставить). Появившийся фантом совместить с выво-

дом 2 левого элемента MTEE и зафиксировать. 

Нажать еще раз комбинацию клавиш Ctrl+V (вставить) и подключить 

вторую копию элемента MOPENX$ к выводу 1 правого элемента MTEE. 

Примечание. Копирование происходит со всеми свойствами исходного 

элемента. 

Рис. 4.17 
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4.11. Командой Draw ⇒ Add Port добавить в схему два порта и подклю-

чить их к свободным выводам элементов MLIN (порт 1 должен быть подсо-

единен к левому элементу). 

Убедиться в том, что волновое сопротивление (параметр Z) в добавлен-

ных портах составляет 50 Ом. 

Результат в варианте «П1» на данном этапе показан на рис. 4.18. 

 

5. Чтобы получить при расчете симметричную структуру ПФ и сокра-

тить тем самым количество подборных величин, необходимо ввести соб-

ственные переменные. 

Для этого выполнить следующие действия: 

5.1. В свойствах элемента M5CLIN заменить числовые значения ширин 

и длин полосковых элементов, а также зазоров между ними на буквенные: 

– W1 (ширина полосковых элементов 1 и 5); 

– W2 (ширина полосковых элементов 2 и 4); 

– W3 (ширина полоскового элемента 3); 

– S1 (зазор между полосковыми элементами 1 и 2, 4 и 5); 

Рис. 4.18 

MSUB
Er=10
H=0.508 mm
T=0.018 mm
Rho=0.783
Tand=0.0023
ErNom=10.2
Name=SUB1

W
1

W
2

W
3

W
4

W
5

1 2 3 4 5

6 7 8 9 10

M5CLIN
ID=TL1
W1=1 mm
W2=1 mm
W3=1 mm
W4=1 mm
W5=1 mm
S1=1 mm
S2=1 mm
S3=1 mm
S4=1 mm
L=10 mm
Acc=1

MLSC
ID=TL2
W=1 mm
L=10 mm

MLSC
ID=TL3
W=1 mm
L=10 mm

MLSC
ID=TL4
W=1 mm
L=10 mm

MOPENX$
ID=MO1

MOPENX$
ID=MO2

MOPENX$
ID=MO3

MOPENX$
ID=MO4

MOPENX$
ID=MO5

1

2

3

MTEE
ID=TL5
W1=1 mm
W2=1 mm
W3=1 mm

1

2

3

MTEE
ID=TL6
W1=1 mm
W2=1 mm
W3=1 mm

MLIN
ID=TL7
W=1 mm
L=2 mm

MLIN
ID=TL8
W=1 mm
L=2 mm

MOPENX$
ID=MO6

MOPENX$
ID=MO7

PORT
P=1
Z=50 Ohm

PORT
P=2
Z=50 Ohm



 

 94 

– S2 (зазор между полосковыми элементами 2 и 3, 3 и 4); 

– L (длина полосковых элементов). 

Результат показан на рис. 4.19. 

5.2. В свойствах каждого элемента MLSC заменить 

числовые значения ширины и длины на буквенные: 

– для элементов MLSC, соединенных с выводами 7 и 9 

элемента M5CLIN: W2 – для ширины, L1 – для длины; 

– для элемента MLSC, соединенного с выводом 3 эле-

мента M5CLIN: W3 – для ширины, L2 – для длины. 

5.3. В свойствах элементов MLIN для параметра W за-

писать переменную W50, которая будет определять ширину 

полоскового элемента с волновым сопротивлением 50 Ом. 

5.4. В свойствах каждого элемента MOPENX$ для па-

раметра W записать переменную, соответствующую ши-

рине полоскового элемента, к которому он 

подключен. При отсутствии в свойствах ука-

занного параметра следует нажать кнопку 

Show Secondary. 

Так, в свойствах элементов MOPENX$, 

подключенных к выводам 6 и 10 элемента 

M5CLIN и к выводам элементов MTEE, 

необходимо ввести W1 (рис. 4.20). 

5.5. В свойствах каждого элемента MTEE для параметров W1, W2 и W3 

записать переменные, соответствующие ширине полосковых элементов, к 

которым они подключены. 

Таким образом, для параметров W1 и W2 необходимо записать W1, а 

для параметра W3 – W50. 

6. Задать диапазоны, в которых могут изменяться добавленные перемен-

ные, для чего выполнить следующие действия: 

6.1. Определить границы изменения ширин полосковых элементов и со-

хранить результаты. 

Минимальную ширину полоскового элемента для незаземленных резо-

наторов ( minNZW ) принять равной 0,2 мм. Такое значение обусловлено тре-

бованиями общего задания на проектирование: 

– точность элементов топологии ПП – десятые доли миллиметра; 

– класс точности ПП – 4-й по ГОСТ Р 53429-2009 (табл. Б.6). 

Рис. 4.19 

Рис. 4.20 
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Минимальную ширину полоскового элемента для заземленных резона-

торов из середины топологии ШТ ( minZW ) принять равной 0,9 мм. Такое 

значение обусловлено диаметром металлизации вокруг отверстий для зазем-

ления, показанного соответствующими УГО на рис. 4.6, в. 

Максимальную ширину полоскового элемента ( maxW ) условно принять 

равной 2 мм. Такое значение обеспечивает одномодовый режим работы МПЛ 

по (Б.1), и при этом полосковые элементы не будут слишком широкими. 

6.2. Определить минимальное и максимальное значения зазоров между 

полосковыми элементами ( minS  и maxS ) и сохранить результаты. 

Указанные величины выбрать равными minNZW  и maxW  соответствен-

но. Таким образом: 

2,0minmin == NZWS  мм; 2maxmax ==WS  мм. 

6.3. Определить минимальное и максимальное значения длины полоско-

вых элементов в элементе M5CLIN ( minL  и maxL ) и сохранить результаты. 

Указанные величины выбрать примерно на границах диапазона 

( 5,24   мм) для эффективной диэлектрической проницаемости ( эф r ) на 

частоте 0F . 

В варианте «П1» эф r  по (Б.2):  

847,6
5,0

508,010
1

2

110

2

110
21

эф =






 
+

−
+

+
=

−

r . 

Четверть длины волны квази-TEM ( 4 ) определяется выражением: 

 44 = . (4.8) 

В варианте «П1» по (4.8) и (Б.3): 

 ( ) 7,11)847,61045,24(1034103 911
эф 0

11
4 === rF  мм.  

Полученный результат, как отмечалось ранее, необходимо округлить до 

десятых долей миллиметра. 

Таким образом: 

2,95,24min =−=L  мм; 2,145,24max =+=L  мм. 

6.4. Определить минимальное и максимальное значения длин полоско-

вых элементов в элементах MLSC ( min1L  и max1L  – для подключенных к вы-

водам 7 и 9 элемента M5CLIN; min2L  и max2L  – для подключенного к выво-

ду 3 элемента M5CLIN) и сохранить результаты. 
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Указанные величины выбрать следующими: 

1,021 minmin == LL  мм; 3,121 maxmax == LL  мм. 

6.5. Так как округление элементов топологии ПФ по требованию общего 

задания на проектирование должно производиться с точностью до десятых 

долей миллиметра, то переменным необходимо присвоить наборы дискрет-

ных значений с шагом 0,1 мм. 

Для этого сначала требуется в виде уравнений создать векторы значе-

ний, указав их имена, диапазоны изменений и шаг. 

Так, в варианте «П1» с помощью команды Draw ⇒ Add Equation было 

создано пять уравнений отдельными записями: 

– WidthNZ=stepped(0.2,2,0.1) – ширины полосковых элементов для не-

заземленных резонаторов; 

– WidthZ=stepped(0.9,2,0.1) – ширины полосковых элементов для за-

земленных резонаторов; 

– Gap=stepped(0.2,2,0.1) – зазоры между полосковыми элементами; 

– Len=stepped(9.2,14.2,0.1) – длины полосковых элементов в M5CLIN; 

– LenM=stepped(0.1,1.3,0.1) – длины полосковых элементов в MLSC. 

Например, запись WidthNZ=stepped(0.2,2,0.1) означает, что ширина по-

лоскового элемента принимает значения от 0,2 до 2 мм с шагом 0,1 мм. 

7. С помощью команды Draw ⇒ Add Equation присвоить всем перемен-

ным начальные значения: 

– переменной W50 задать значение, полученное по (4.4), и расположить 

равенство под элементом MSUB; 

– для остальных переменных задать начальные значения примерно из 

середины соответствующих векторов значений. Выражения расположить 

обязательно ниже указанных векторов. 

В варианте «П1» были записаны следующие выражения: 

– W50=0.5; 

– W1=WidthNZ[9]; 

– W2=WidthZ[6]; 

– W3=WidthZ[6]; 

– S1=Gap[9]; 

– S2=Gap[9]; 

– L=Len[26]; 

– L1=LenM[7]; 

– L2=LenM[7]. 
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Например, запись W1=WidthNZ[9] означает, что переменной W1 (ши-

рина 1-го и 5-го полоскового элемента в M5CLIN) присваивается значение 

9-го элемента из вектора WidthNZ, которое равно 1 мм (появится автомати-

чески после записанного выражения). 

Убедиться в том, что после определения переменных на схеме не оста-

лось надписей с красным цветом шрифта. 

8. В свойствах выражений для каж-

дой переменной, кроме W50, включить 

следующие опции (рис. 4.21): 

– Tune (разрешение ручной под-

стройки переменной); 

– Optimize (разрешение использования переменной в оптимизации). 

 

Примечание. Опцию Tune в выражениях также можно включать и от-

ключать командой Simulate ⇒ Tune Tool или клавишей F10. Ее включение ви-

зуально сопровождается изменением цвета выражения с черного на синий. 

Результат проделанных операций по созданию схемы ШТ в варианте 

«П1» показан на рис. 4.22. 

Рис. 4.22 
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4.3.4. Создание схемы ПФ на параллельно связанных резонаторах 

Для создания схемы СЛ необходимо проделать следующее: 

1. Выполнить п. 1 из 4.3.3, т. е. создать новую схему и задать ей имя. 

2. Выполнить п. 2 из 4.3.3, т. е. задать единицы измерения по умолчанию 

и частотный диапазон моделирования. 

3. Выполнить п. 3 из 4.3.3, т. е. сохранить проект. 

4. Добавить в схему необходимые элементы, для чего выполнить следу-

ющие действия: 

4.1. Сделать активной вкладку Elements. 

4.2. По п. 4.2 из 4.3.3 добавить элемент MSUB. 

4.3. По п. 4.3 из 4.3.3 в свойствах элемента MSUB ввести значения пара-

метров МПЛ. 

4.4. Раскрыть группу Microstrip. 

4.5. Щелкнуть ЛКМ по подгруппе Coupled Lines. Найти и перетащить 

на поле схемы элементы MCFIL ( 1ф +n  шт.). Расположить их «лесенкой» в 

соответствии с рис. 4.6, а, но не соединять друг с другом, оставив зазоры. 

MCFIL – модель двух связанных полосковых элементов с разомкнутыми 

концами с одной стороны каждого полоскового элемента (в схеме ШТ такой 

эффект моделировался элементом MOPENX$). 

4.6. Щелкнуть ЛКМ по подгруппе Junctions. Найти и перетащить на по-

ле схемы элементы MSTEPX$ ( 2ф +n  шт.). Поместить их в зазоры между 

элементами MCFIL, перед первым элементом MCFIL и после последнего. 

MSTEPX$ – модель перехода между двумя полосковыми элементами. 

4.7. Соединить соседние выводы элементов MSTEPX$ и MCFIL. 

Способы осуществления соединений описаны в п. 4.6 из 4.3.3. 

В результате на схеме останется по одному свободному выводу на край-

них элементах MSTEPX$. 

4.8. Щелкнуть ЛКМ по подгруппе Lines. Найти и перетащить на свобод-

ное поле схемы два элемента MLIN (модель полоскового элемента), после 

чего подключить их к свободным выводам элементов MSTEPX$. 

В свойствах элементов MLIN для параметра L установить значение дли-

ны полоскового элемента 2 мм. 

4.9. Выполнить п. 4.11 из 4.3.3, т. е. добавить и подключить два порта, а 

также проверить значение их волнового сопротивления. 

При необходимости повернуть порт по п. 4.5 из 4.3.3. 
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5. Для получения при расчете симметричной структуры ПФ и сокраще-

ния количества подборных величин ввести собственные переменные, выпол-

нив следующие действия: 

5.1. В свойствах элементов MLIN для параметра W записать перемен-

ную W50, которая будет определять ширину полоскового элемента с волно-

вым сопротивлением 50 Ом. 

5.2. В свойствах каждого элемента MCFIL заменить 

числовые значения ширины (параметров W) и длины (па-

раметров L) полосковых элементов, а также зазора (пара-

метров S) между ними на буквенные. 

Например, для 4-го порядка фильтра при расположе-

нии элементов слева направо: 

– W=W1, S=S1, L=L (для 1-го и 5-го элементов MCFIL); 

– W=W2, S=S2, L=L (для 2-го и 4-го элементов MCFIL); 

– W=W3, S=S3, L=L (для 3-го элемента MCFIL). 

Результат замены для 1-го элемента MCFIL показан на рис. 4.23. 

6. В свойствах каждого элемента MSTEPX$ для параметра Offset запи-

сать следующее выражение (рис. 4.24, а): 

-abs(W@2-W@1)/2, 

где abs – функция, возвращающая модуль числа; W@1 и W@2 – ширина по-

лоскового элемента 1-го и 2-го портов элемента MSTEPX$. 

Примечание. Это выражение задает смещение полосковых элементов 

друг относительно друга так, чтобы они имели общую сторону. При этом 

осуществляется сдвиг полоскового элемента, подключенного ко 2-му порту 

элемента MSTEPX$, вниз относительно его осевой линии. Результаты его 

работы в сравнении с нулевым смещением показаны на рис. 4.24, б. 

 Рис. 4.24 

а 

б 

Offset = -abs(W@2-W@1)/2 

W@1 < W@2 W@1 > W@2 

Offset = 0 

Рис. 4.23 
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7. Задать диапазоны, в которых могут изменяться добавленные перемен-

ные, для чего проделать следующее: 

7.1. Выполнить пп. 6.1–6.3 из 4.3.3 для определения значений перемен-

ных в элементах MCFIL: 

– для ширин полосковых элементов – minNZW  и maxW ; 

– для зазоров между полосковыми элементами – minS  и maxS ; 

– для длин полосковых элементов – minL  и maxL . 

7.2. Выполнить п. 6.5 из 4.3.3, т. е. записать три выражения для векторов 

значений с именами WidthNZ, Gap и Len. 

8. Выполнить п. 7 из 4.3.3, т. е. присвоить начальные значения всем со-

зданным в п. 5 переменным. 

Убедиться в том, что после определения переменных на схеме не оста-

лось надписей с красным цветом шрифта. 

 

9. Выполнить п. 8 из 4.3.3, т. е. включить опции Tune и Optimize в свой-

ствах выражений для каждой переменной, кроме W50. 

На рис. 4.25 показана схема СЛ 4-го порядка с данными варианта «П1». 

Рис. 4.25 
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4.3.5. Создание графика измеряемой величины 

Для создания графика и добавления в него измеряемой величины необ-

ходимо проделать следующее: 

1. Перейти на вкладку Project и на группе Graphs запустить команду 

ПКМ ⇒ New Graph. 

2. В появившемся окне New Graph выполнить следующее: 

– задать название графика c указанием аббревиатуры структуры ПФ и 

номера варианта задания (например, в варианте «П1» – АЧХ ШТ П1); 

– выбрать тип графика Rectangular (прямоугольный); 

– применить изменения кнопкой Create. 

В результате в рабочем поле откроется пустое окно графика, а на вклад-

ке Project в группе Graph появится иконка с его названием. 

Следует отметить, что название в окне графика может отображаться не-

корректно. Для исправления этого следует на графике в рабочем поле запу-

стить команду ПКМ ⇒ Properties, затем в открывшемся окне Rectangular 

Plot Properties перейти на вкладку Fonts и нажать кнопку Titie, после чего в 

появившемся окне Шрифт из выпадающего списка Набор символов вы-

брать Кириллица. 

3. Для построения АЧХ ПФ потребуется добавить величину 21S : 

 Рис. 4.26 
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3.1. На вкладке Project на названии созданного графика запустить ко-

манду ПКМ ⇒ Add Measurement. 

3.2. В открывшемся окне выполнить следующее (см. рис. 4.26): 

– в списке Measurement Type выбрать Linear ⇒ Port Parameters; 

– в списке Measurement выбрать S (S-параметры); 

– в списке Data Source Name выбрать название схемы – BPF; 

– в поле To Port Index выбрать 2; 

– в поле From Port Index выбрать 1; 

– в группе Complex Modifier отметить dB (деци-

белы) и Mag (модуль); 

– применить изменения нажатием кнопок Apply и 

OK. 

В результате на вкладке Project под названием 

графика появится надпись BPF:DB(|S(2,1)|), характе-

ризующая измеряемую величину: модуль параметра S21 в децибелах для схе-

мы BPF (рис. 4.27). 

Примечание. Надпись аналогичного содержания появится и в окне гра-

фика в правом верхнем углу. 

4.3.6. Оптимизация 

Оптимизация – это процесс, в котором Microwave Office автоматически 

корректирует назначенные для оптимизации параметры электрической цепи 

(например, значение схемного элемента, отрезка линии передачи и др.) для 

достижения заданных целей оптимизации (например, уменьшение шумов, 

уменьшение неравномерности усиления и др.). 

Под целью оптимизации (goal) подразумевается некоторая граница из-

менения какой-либо характеристики анализируемой схемы, к которой дол-

жен стремиться выбранный метод оптимизации при изменении определен-

ных параметров элементов. Параметры электрической цепи, назначенные для 

оптимизации, должны быть или изменяемыми параметрами элементов схе-

мы, или независимыми переменными, заданными на схеме. 

Процесс оптимизации заключается в попытке найти минимум или мак-

симум целевой функции (error function), определяющей разницу между рас-

четной и желательной характеристикой. Оптимизация – итерационный про-

цесс. Microwave Office вычисляет целевую функцию, затем изменяет значе-

ние параметров и вычисляет ее снова. Алгоритмы оптимизации стремятся 

Рис. 4.27 
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изменить параметры и переменные так, чтобы характеристика приближалась 

к установленным целям после каждой итерации, т. е. уменьшалась ошибка. 

Каждому параметру можно присвоить свой вес (weight). 

Под весом параметра понимается то, какой вклад вносится ошибкой 

этого параметра в изменение целевой функции. Чем больше вес у параметра, 

тем больше оптимизатор будет стремиться уменьшить ошибку в нем по 

сравнению с другими параметрами, у которых вес меньше. 

Дискретную оптимизацию, при которой параметры элементов схемы 

могут принимать конечное число значений, в Microwave Office поддержива-

ют только методы оптимизации, приведенные в табл. 4.1 [30]. 

Таблица 4.1 

Методы дискретной оптимизации 

Метод  

оптимизации 
Краткое описание 

Random 

(Global) 

Значения каждой переменной выбираются произвольно во всем доступ-

ном для нее диапазоне 

Random  

(Local) 

Значения переменных изменяются произвольно около их начальных зна-

чений 

Pointer –  

Robust  

Optimization 

В простейшем виде используются подобно градиентной или случайной 

(random) оптимизации. 

Методы группы Pointer сочетают в себе широко используемые методы 

поиска (генетические алгоритмы, симплекс скоростного спуска, последо-

вательное квадратичное программирование и линейные методы) и обла-

дают возможностью к самообучению, что позволяет автоматически опре-

делять наилучшую стратегию поиска для конкретной задачи. 

Значения переменных должны быть ограничены 

Pointer – 

Gradient  

Optimization 

Discrete  

Local Search 

Локальный метод по дискретной сетке значений переменных (для непре-

рывных переменных указывается размер шага их значений в графе Step 

на вкладке Parameters в свойствах компонентов) с двумя параметрами: 

– number grid levels – количество уровней уточнения сетки с соотноше-

нием 4. Например, при значении «3» решение для каждой переменной 

сначала ищется в грубой сетке с каждым 16-м ее значением, затем – в 

сетке с каждым 4-м значением, а после – в сетке с каждым 1-м значением; 

– allow increase – фактор, определяющий возможность поиска решения в 

области увеличения ошибки: «0» – поиск прекращается, если в данной 

точке ошибка меньше, чем в ближайших; от «0» до «1» включительно – 

область поиска увеличивается, что позволяет выходить из локальных не-

глубоких минимумов целевой функции. По умолчанию равен 0,5. 

Значения дискретных переменных должны быть упорядочены 

 Для создания целей оптимизации выполнить следующее: 

1. Запустить анализ командой Simulate ⇒ Analyze (или клавишей F8) и 

убедиться в том, что в окне Status Window нет ошибок (рис. 4.28). 
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Часто встречающиеся ошибки и предупреждения при анализе и способы 

их устранения приведены в табл. 4.2. 

Таблица 4.2 

Некоторые ошибки и предупреждения при запуске анализа 

Ошибка или  

предупреждение 
Возможная причина Способ устранения 

N.P: The X-Model Da-

tabase has not been 

filled 

В электромагнитной модели компонен-

та с названием N и позиционным обо-

значением P не может быть заполнена 

таблица с данными. 

Например, в элементе MSUB задано 

нестандартное значение параметра 

ErNom или неудачное сочетание значе-

ний ErNom и Er 

Наиболее быстрый 

способ – изменить в 

элементе MSUB зна-

чение параметра 

ErNom на другое бли-

жайшее к Er по п. 4.3 

из 4.3.3 

N.P: SEVERE 

WARNING – MSUB 

|Er – Er(Nominal)|/ 

Er(Nominal)=… 

В элементе MSUB значения парамет-

ров ErNom и Er сильно отличаются, что 

может привести к большим погрешно-

стям моделирования для компонента с 

названием N и позиционным обозначе-

нием P 

Изменить в элементе 

MSUB значение пара-

метра ErNom на бли-

жайшее к Er по п. 4.3 

из 4.3.3 

N.P: Error evaluating 

parameter ‘Y’ … 

(Equation Error: Varia-

ble ‘Z’ is not valid) 

или (Equation Error: 

Variable not found ‘Z’) 

В компоненте с названием N и позици-

онным обозначением P возникла ошиб-

ка в параметре Y, так как указанная в 

нем переменная Z содержит ошибку 

(not valid) или не найдена (не задана) на 

схеме (not found) 

Внести корректировки 

в надписи зеленого 

цвета (синтаксические 

ошибки), внимательно 

просмотрев соответ-

ствующие пункты раз-

делов пособия. 

Обратить внимание на 

определение значений 

переменных как на по-

ле схемы, так и в свой-

ствах компонентов, 

указанных в тексте 

ошибки 

N.P: Error evaluating 

parameter ‘Y’ (Parse 

Error: syntax ‘,’) 

В компоненте с названием N и позици-

онным обозначением P возникла ошиб-

ка в параметре Y синтаксического ха-

рактера (запятая вместо точки в разде-

лителе целой и дробной части числа) 

X – Equation Error: 

Variable ‘Z’ is not valid 

Ошибка в уравнении для переменной 

X, так как переменная Z содержит 

ошибку 

X – Parse Error:… Ошибка обработки в переменной X. 

Например, синтаксическая ошибка ис-

пользования функции 

Рис. 4.28 
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2. Приступить к созданию новой цели оптимизации, для чего на элемен-

те Optimizer Goals из вкладки Project запустить команду ПКМ ⇒ Add Op-

timizer Goal. 

Примечание. В окне Old Optimization Goal в списке Measurement будет 

выделена только одна созданная ранее величина – BPF:DB(|S(2,1)|). 

2.1. Ввести диапазон частот и ослабление для задания полосы пропуска-

ния ПФ, для чего выполнить следующее (рис. 4.29): 

– в группе Goal Type выбрать опцию Meas > Goal; 

– в группе Range отключить опции Min и Max; 

– в поле Start ввести значение частоты −CF  (в варианте «П1» – 2.35); 

– в поле Stop ввести значение частоты +CF  (в варианте «П1» – 2.55); 

– в поле Goal start ввести отрицательное значение уровня затухания Ca  

(в варианте «П1» – «-2») и нажать OK. 

 

2.2. Ввести диапазон частот и ослабление для задания полосы задержи-

вания ПФ в области низких частот, для чего выполнить следующее: 

– создать новую цель оптимизации; 

– в группе Goal Type выбрать опцию Meas < Goal; 

– в группе Range отключить опцию Max; 

– в поле Stop ввести значение частоты −SF  (в варианте «П1» – 1.8); 

– в поле Goal ввести отрицательное значение уровня затухания −Sa  (в 

варианте «П1» – «-30») и нажать OK. 

2.3. Ввести диапазон частот и ослабление для задания полосы задержи-

вания ПФ в области высоких частот, для чего выполнить следующее: 

– создать новую цель оптимизации; 

– в группе Goal Type выбрать опцию Meas < Goal; 

– в группе Range отключить опцию Min; 

– в поле Start ввести значение частоты +SF  (в варианте «П1» – 2.85); 

Рис. 4.29 
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– в поле Goal ввести отрицательное значение уровня затухания +Sa  (в 

варианте «П1» – «-35») и нажать OK. 

3. При необходимости изменения введенных выше данных следует запу-

стить команду ПКМ ⇒ Properties на требуемой цели оптимизации во вклад-

ке Project. 

Результат на вкладке Project на данном этапе в варианте «П1» показан 

на рис. 4.30, а вид АЧХ – на рис. 4.31. 

 

 

Примечание. Штриховкой показаны цели оптимизации из пп. 2.2 и 2.3. 

Цель оптимизации из п. 2.1 находится за пределами видимой области. 

Вид АЧХ до проведения оптимизации может сильно отличаться от 

требуемого результата и представлять собой линию без локальных мини-

мумов и максимумов. Все зависит от начальных значений переменных, за-

данных на схеме. 

Рис. 4.31 

1.3 1.8 2.3 2.8 3.3

Frequency (GHz)

АЧХ ШТ П1

-60

-50

-40

-30

-20

-10

DB(|S(2,1)|)
BPF

Рис. 4.30 
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4. Настроить вид графика, для чего на нем в рабочем поле запустить ко-

манду ПКМ ⇒ Properties и в появившемся окне Rectangular Plot Properties 

выполнить следующие действия: 

– на вкладке Axes для оси Left 1 отключить опцию Auto limits, в поле 

Min ввести «-50», а в поле Max – «0»; 

– на вкладке Traces в группе Style для 1-й кривой в соответствующих 

выпадающих списках установить: Color – черный, Symbol – none, Line – 

сплошная, Weight – вторая сверху; 

– на вкладке Format в группе Border отключить опцию Shadow; 

– на вкладке Labels для оси x отключить опции Show units и Auto label, 

в поле Selected Axis Label ввести «f, ГГц», а для оси Left 1 в этом же поле 

записать «-a, дБ»; 

– на вкладке Fonts для всех стилей (Title, Labels, Axis numbers, Legend, 

Markers) установить размер шрифта 20. Также нажать кнопку Labels и из вы-

падающего списка Набор символов выбрать Кириллица; 

– на вкладке Markers выбрать: Symbol – круг, Size – 2; 

– применить изменения нажатием кнопок Apply и OK. 

5. Добавить маркеры (поля с координатами выбранных точек характери-

стики) на частотах −SF , −CF , +CF  и +SF . 

Для этого для каждого значения частоты выполнить следующее: 

– на графике в рабочем поле запустить команду ПКМ ⇒ Add Marker; 

– щелкнуть ЛКМ в любом месте кривой; 

– запустить на появившемся маркере команду ПКМ ⇒ Marker Search; 

– в появившемся окне в группе Data выбрать опцию Find x value, за-

полнить поле Value и нажать кнопку Search (рис. 4.32). 

 Рис. 4.32 
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6. Произвести оптимизацию в ручном режиме, т. е. попытаться получить 

требуемый вид АЧХ, изменяя значения каждой переменной вручную. 

Примечание. Данный режим позволяет оценить влияние параметров 

схемы на поведение оптимизируемых характеристик, что может оказаться 

полезным при настройке опытного образца, и подобрать для них начальные 

значения, что облегчит режим автоматической оптимизации (при необхо-

димости последующего ее выполнения). 

Ручной режим запускается командой Simulate ⇒ Tune. В открывшемся 

окне Variable Tuner (рис. 4.33) будут перечислены все переменные, для ко-

торых в их свойствах на схеме включена опция Tune (см. п. 8 из 4.3.3). Так 

как переменные заданы дискретными значениями, то здесь отображаются не 

значения параметров, а номера их позиций в соответствующих векторах. 

Например, на рисунке для переменной L1 в векторе значений содержится 13 

значений (поле Max), а в данный момент выбрано седьмое (поле Nom). 

 

При перемещении ползунков зажатой ЛКМ (или колесиком мышки) или 

вводе номеров позиции в поле Nom сразу же происходят соответствующие 

изменения в характеристике на графике и в значениях параметров на схеме. 

При оптимизации диапазона изменения некоторых переменных может 

не хватить (например, ползунок находится на последнем номере из вектора 

значений, а форма характеристики немного не доходит до желаемой). В этом 

случае на схеме допускается в соответствующих векторах изменить значения 

их границ, кроме минимальных значений ширин полосковых элементов и за-

зоров между ними ( minNZW , minZW , minS ). 

Рис. 4.33 
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Назначение некоторых кнопок на рис. 4.33: 

– Reset – сброс значений переменных в их начальные значения, которые 

были на момент открытия окна Variable Tuner; 

– Save – сохранение текущего состояния значений переменных под за-

данным именем (не запоминаются после закрытия окна Variable Tuner); 

– Revert – возврат к одному из сохраненных состояний; 

– Freeze – фиксация характеристики на графике; 

– Clear – очистка зафиксированных графиков. 

 Рис. 4.34 
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На рис. 4.34 показаны результаты проведения оптимизации в ручном 

режиме в варианте «П1» (окно Variable Tuner и АЧХ). 

7. Произвести оптимизацию в автоматическом режиме, т. е. попытаться 

получить требуемый вид АЧХ с помощью автоматических методов оптими-

зации. 

Следует обратить внимание на то, что если вид АЧХ после проведения 

оптимизации в ручном режиме полностью удовлетворяет требованиям целей 

оптимизации, то выполнение автоматической оптимизации не требуется. В 

варианте «П1» автоматическая оптимизация необходима, так как на рис. 4.34 

желательно увеличить затухание в полосах задерживания. 

Автоматическая оптимизация запускается командой Simulate ⇒ Opti-

mize (или клавишей F7), в результате чего открывается окно Optimizer, по-

казанное на рис. 4.35. 

 

В группе Optimization Methods из выпадающего списка выбираеться 

один из методов оптимизации, описанных в табл. 4.1, а в полях под ним за-

даются соответствующие параметры. Общим для всех методов оптимизации 

является параметр Maximum Iterations, в котором устанавливается макси-

мальное количество итераций работы выбранного метода до его остановки. 

В группе Relative Goal Cost отображается гистограмма со столбцами, 

показывающими относительную «стоимость» каждой цели оптимизации. По-

рядок столбцов соответствует порядку записи целей оптимизации на вкладке 

Project (см. рис. 4.30). 

Рис. 4.35 
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Просмотреть подробности целей оптимизации и при необходимости 

внести корректировки позволяет вкладка Goals (рис. 4.36). 

 

Под «стоимостью» (cost) понимается значение, используемое для изме-

рения сходимости целевой функции (мера близости к желаемому результату). 

Так, при нуле характеристика полностью удовлетворяет целям оптимизации. 

Видно, что в варианте «П1» АЧХ наиболее удалена от цели оптимиза-

ции в области верхней полосы задерживания (Cost = 0,5098), тогда как в по-

лосе пропускания все хорошо (Cost = 0). 

При необходимости кнопкой Equalize Goals на рис. 4.35 можно автома-

тически выбрать вес целей оптимизации со «стоимостью» не равной нулю 

так, чтобы их «стоимости» стали одинаковыми. При этом общая «стоимость» 

остается постоянной и отображается под группой Relative Goal Cost. 

В группе Cost History на рис. 4.35 в процессе работы оптимизатора по-

казывается график зависимости общей «стоимости» от номера итерации. 

Опция Show all iterations позволяет в процессе работы оптимизатора 

отображать на графике каждое изменение в реальном времени. 

Назначение некоторых кнопок на рис. 4.35: 

– Start – запуск оптимизации; 

– Stop – остановка оптимизации на текущей итерации; 

– Reset, Save, Revert – аналогичны по функциям кнопкам из окна Varia-

ble Tuner, описанным в п. 6. 

Перед каждым последующим запуском автоматической дискретной оп-

тимизации следует обращать внимание на начальные значения оптимизируе-

мых переменных на схеме, которые не должны быть первым и последним 

элементом в заданных векторах значений. Если это не так, то необходимо 

вручную изменить номер элемента вектора значений на любой другой. 

Оптимизация ШТ и СЛ происходит одинаково. Различие будет заклю-

чаться только в форме оптимизированной АЧХ. 

Результат оптимизации в варианте «П1» показан на рис. 4.37. 

Рис. 4.36 
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Значения переменных в варианте «П1»: 

– W1 = 0,3 мм; W2 = W3 = 1,2 мм; 

– S1 = 0,2 мм; S2 = 0,9 мм; 

– L = 9,9 мм; L1 = 1 мм; L2 = 1,1 мм. 

Аналогичные значения в других вариантах задания необходимо сохра-

нить в отчет. 

4.3.7. Статистический анализ 

Статистический анализ позволяет оценить влияние разброса значе-

ний параметров элементов схемы на вид характеристик. В Microwave Office 

можно выполнять также и технологическую оптимизацию [30]. 

Статистический анализ будет произведен в следующем порядке: 

1. Чтобы в статистическом анализе участвовали значения переменных, а 

не номера их позиций в соответствующих векторах, необходимо осуществить 

подготовительные действия: 

1.1. Временно скопировать выражения для всех переменных на схеме в 

текстовые надписи, добавляемые командой Draw ⇒ Add Text (или комбина-

цией клавиш Ctrl+T). 

При копировании выражений только в одну текстовую надпись новые 

строки добавляются комбинацией клавиш Ctrl+Enter. 

Рис. 4.37 
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1.2. Заменить в выражениях для переменых названия векторов значений 

с номерами позиций в квадратных скобках на их числовые значения, полу-

ченные после оптимизации. 

Результат произведенных действий в сравнении с исходными выражени-

ями переменных в варианте «П1» показан на рис. 4.38. 

 

2. Оценить влияние разброса параметров материала (относительной ди-

электрической проницаемости и толщины диэлектрика): 

2.1. В свойствах элемента MSUB перейти на вкладку Statistics. 

2.2. Напротив параметра Er выполнить следующее: 

– поставить галочку в столбце Use (использовать); 

– в столбце Distribution (распределение) выбрать Uniform (равномер-

ное); 

– в поле Tol ввести значение величины r . 

2.3. Напротив параметра H выполнить следующее: 

– поставить галочки в столбцах Use и In%; 

– в столбце Distribution выбрать Uniform; 

– в поле Tol ввести 10, что означает ±10 % (см. Б.5). 

Результат в варианте «П1» показан на рис. 4.39. 

 Рис. 4.39 

Рис. 4.38 
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2.4. Запустить команду Simulate ⇒ Yield Analysis. 

В появившемся окне в группе Analysis Methods из выпадающего списка 

выбрать Yield Analysis, в поле Maximum Iterations ввести 500 и нажать 

Start. 

Для ускорения процесса анализа можно отключить опцию Show all trace 

updates (при каждой итерации происходит обновление графика). 

2.5. После завершения статистического анализа в свойствах графика на 

вкладке Yield Data отключить опцию Show traces, включить опцию Show 

Range и в выпадающем списке выбрать Max/Min. Это приведет к отображе-

нию результатов анализа в виде двух кривых, соответствующих максималь-

ным отклонениям от исходной характеристики в обе стороны. 

Полученный график сохранить в отчет. 

3. Оценить влияние разброса размеров проводящего рисунка (ширин, 

длин полосковых элементов и зазоров между ними): 

3.1. В свойствах элемента MSUB на вкладке Statistics для параметров H 

и Er убрать галочки в столбце Use. 

3.2. В свойствах всех выражений для переменных на схеме выполнить 

следующее (рис. 4.40): 

– в группе Statistics включить опцию Use statistics;  

– в выпадающем списке для Distribution Type выбрать Uniform; 

– в поле «+/–» установить величину разброса 0.05, что соответствует 

предельному отклонению размеров (±0,05 мм) проводящего рисунка с по-

крытием для 4-го класса точности (табл. Б.7). 

 

3.3. Выполнить п. 2.4 и сохранить полученный график в отчет. 

4. Оценить суммарное влияние разброса параметров материала и прово-

дящего рисунка: 

4.1. В свойствах элемента MSUB на вкладке Statistics для параметров H 

и Er поставить галочки в поле Use. 

4.2. Выполнить п. 2.4 и сохранить полученный график в отчет. 

Рис. 4.40 
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Результат статистического анализа, учитывающий разброс параметров 

материала и проводящего рисунка в варианте «П1», показан на рис. 4.41. 

 

5. Восстановить исходные выражения для переменных, воспользовав-

шись данными из текстовой надписи, созданной в п. 1.1. Затем указанную 

надпись удалить. 

4.4. Электромагнитное моделирование ПФ в Microwave Office 

Электромагнитное моделирование использует уравнения Максвелла 

для определения характеристик устройства по его заданной физической гео-

метрии, поэтому оно свободно от ограничений, имеющихся в моделях элек-

трических цепей в линейном моделировании. С помощью этого моделирова-

ния можно анализировать произвольные структуры и обеспечивать очень 

точные результаты.  

Недостатком электромагнитного моделирования является увеличение 

необходимого объема оперативной памяти и времени моделирования с уве-

личением сложности структуры. 

Моделирование ПФ будет производиться в EMSight-симуляторе, осу-

ществляющем 2.5D-анализ. Это анализ плоскопараллельных многослойных 

планарных структур, которые могут содержать множество металлических и 

диэлектрических слоев с межслойными переходами или заземлениями, в 

Рис. 4.41 
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прямоугольном корпусе с боковыми проводящими стенками и автоматически 

созданной электрической сеткой с ячейками прямоугольной формы. 

Существует два наиболее значимых ограничения данного симулятора. 

Во-первых, проводники моделируются бесконечно тонкими, а задавае-

мая в проекте толщина учитывается только при расчете потерь. В результате 

возникает погрешность в связях между резонаторами, что приводит к суже-

нию полосы пропускания и смещению частоты 0F  вниз. Погрешность может 

стать существенной, если зазор в связанных линиях мал и соизмерим с тол-

щиной проводников. 

Несмотря на то что проводники могут быть сделаны условно объемными 

с помощью дополнительного слоя и вертикальных перемычек, такая моди-

фикация не является полноценной заменой и, кроме того, приводит к силь-

ному увеличению времени расчета. 

Во-вторых, необходимо внимательно относиться к выбору размеров яче-

ек геометрической сетки и к положению элементов топологии относительно 

ее узлов: 

– слишком маленький шаг сетки значительно увеличит необходимый 

объем оперативной памяти и время моделирования; 

– если шаг сетки будет превышать самое узкое место в топологии (на-

пример, узкий проводник), то программа может аппроксимировать его в эле-

мент нулевой ширины, т. е. в разрыв (отсутствие соединения); 

– если разместить элементы топологии под углом к линиям сетки 

(например, при моделировании повернутой структуры ПФ, показанной на 

рис. 4.6, б), то программа все наклонные элементы аппроксимирует ступень-

ками. В результате этого полученная характеристика может быть сдвинута 

вниз по частоте относительно аналогичной топологии без поворота и иметь 

отличную от последней ширину полосы пропускания за счет увеличения 

длины проводников. 

Следует отметить, что кроме EMSight-симулятора в Microwave Office 

есть AXIEM-симулятор, осуществляющий 3D-анализ планарных СВЧ-струк-

тур и обладающий следующими основными особенностями: 

– используется смешанная электрическая сетка с прямоугольными и 

треугольными ячейками, что позволяет осуществлять моделирование струк-

тур с криволинейными контурами; 

– проводники могут иметь толщину в направлении оси Z, при этом на 

нее не накладывается ограничений; 
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– диэлектрические слои имеют бесконечную протяженность в плоскости 

X0Y (то есть нет боковых металлизированных стенок); 

– нет ограничений на встраивание проводников в геометрическую сетку; 

– для анализа используется сетка на всех поверхностях проводника 

включая боковые стороны [29]. 

Применение EMSight-симулятора в данном учебном пособии объясняет-

ся простотой использования для рассматриваемых структур ПФ. Работа с 

AXIEM-симулятором кратко приведена в А.3. 

Моделирование в вариантах задания необходимо произвести в следую-

щем порядке: 

1. Получить топологию ПФ из результатов линейного моделирования: 

1.1. Сделать активным окно схемы (BPF), дважды щелкнув ЛКМ по ее 

имени в группе Circuit Schematics на вкладке Project. 

1.2. Запустить команду View ⇒ View Layout. 

1.3. Топология ПФ на данном этапе состоит из полосковых элементов с 

разрывами. Для группировки элементов выполнить команду Edit ⇒ Select All 

(или нажать комбинацию клавиш Ctrl+A), а затем Edit ⇒ Snap Together. 

Результат в варианте «П1» на данном этапе показан на рис. 4.42, а. 

 

1.4. Командой Draw ⇒ Measure произвести измерения габаритных раз-

меров топологии ПФ и временно сохранить результат. 

Рис. 4.42 

а в 

б 
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Для этого необходимо щелкнуть ЛКМ по точке начала измерения и пе-

реместить курсор мышки с зажатой ЛКМ в конечную точку измерения. Ре-

зультат измерения (переменная dx или dy) отобразится около курсора. 

В варианте «П1» размер топологии ПФ по оси X (между входом и выхо-

дом) составил 10,4 мм, а по оси Y – 12 мм (см. рис. 4.42, б и в). 

2. Задать параметры корпуса МПЛ и окружающей обстановки: 

2.1. На элементе EM Structures из вкладки Project запустить команду 

ПКМ ⇒ New EM Structure. В открывшемся окне ввести имя модели 

(BPFem), отметить симулятор AWR EMSight Simulator и нажать Create. 

В результате в рабочем поле откроется пустое окно 

электромагнитной модели, а в группе EM Structures по-

явится подгруппа с его названием (рис. 4.43). 

2.2. На элементе Enclosure из созданной подгруппы 

BPFem запустить команду ПКМ ⇒ Edit, в результате 

чего откроется окно свойств электромагнитной модели. 

Важный момент – все значения далее должны вво-

диться с точкой в качестве десятичного разделителя. 

2.3. На вкладке Enclosure ввести размеры сетки и габаритные размеры 

подложки для размещения топологии ПФ, при этом учесть следующее: 

– по требованию общего задания на проектирование шаг геометриче-

ской сетки (параметры Grid_X и Grid_Y) должен составлять 0.1 мм; 

– параметр X_Dim – размер между входом и выходом ПФ; 

– параметр Y_Dim должен быть задан на 4–6 мм больше, чем второй га-

баритный размер топологии ПФ. Добавка нужна для получения двух зазоров 

от топологии ПФ до заземленных границ корпуса, в котором она находится. 

Значения X_Dim и Y_Dim необходимо сохранить в отчет, так как они 

понадобятся при разработке ПП. 

Примечание. Если ввести значения 

с запятой в качестве десятичного раз-

делителя, то в X_Dim и Y_Dim будет 

учитываться только целая часть, а 

сетка сбросится к 0,01 мм. 

Результат в варианте «П1» показан 

на рис. 4.44. 

2.4. На вкладке Materials кнопкой Delete удалить все строки, кроме пер-

вой (Perfect Conductor). 

Рис. 4.43 

Рис. 4.44 
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2.5. На вкладке Material Defs выполнить следующее: 

– в разделе Dielectric Definitions в столбцах Er и TanD ввести значения 

относительной диэлектрической проницаемости ( r ) и тангенса угла диэлек-

трических потерь ( tan ) соответственно; 

– в разделе Conductor Definitions удалить существующую запись кноп-

кой Remove. Затем нажать кнопку Add и в появившемся окне в списке Pre-

sets выбрать Copper. 

Результат в варианте «П1» показан на рис. 4.45. 

 

2.6. Определить толщину воздушного заполнения над основанием по-

лосковой платы ( взэh ) по следующей формуле: 

 ( ) кэоснфпгммуэвзэ hhhhthhh −−+++−= , (4.9) 

где муэh  – толщина «модуля усилителя» в области размещения «экрана», за-

данная в общем задании на проектирование, 10муэ =h  мм; гмh  – толщина 

гальванической меди (см. п. 8 из Б.4), мм; фпh  – толщина финишного покры-

тия ImmAg (см. п. 3 из Б.6), мм; оснh  – 

толщина «основания» в месте располо-

жения ПП, 3осн =h  мм; кэh  – толщина 

верхней стенки «экрана», 1кэ =h  мм. 

На рис. 4.46 рассматриваемая вели-

чина соответствует полости в «экране». 

В варианте «П1»: 

 ( ) 454,5130004,002,0018,0508,010взэ −−+++−=h  мм.  

Рис. 4.45 

Рис. 4.46 
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2.7. На вкладке Dielectric Layers в столбце Thickness ввести: 

– для слоя № 1 – толщину воздушного заполнения ( взэh ); 

– для слоя № 2 – базовую толщину диэлектрика (h ). 

Результат в варианте «П1» показан на рис. 4.47. 

 

Примечания: 

– параметр Draw Scale определяет масштаб отображения слоев при 

просмотре топологии в 3D-режиме; 

– на вкладке каждое записанное число отображается с запятой в каче-

стве десятичного разделителя. Однако если изначально ввести значение с 

запятой, то после закрытия данного окна вместо одного слоя появятся два 

с толщинами, равными целой и дробной части исходного числа. 

2.8. На вкладке Materials нажать кнопку Insert и в появившейся строке 

выполнить следующее: 

– в столбце Name ввести название материала полоскового элемента 

(например, StripElement); 

– в столбце Thickness ввести толщину меди ( t ); 

– в столбце Material Definition выбрать материал Copper. 

Результат в варианте «П1» показан на рис. 4.48. 

 

Примечание. Если ввести значение с запятой в качестве десятичного 

разделителя, то будет учитываться только его целая часть. 

2.9. Закрыть окно свойств элемента Enclosure кнопкой OK. 

3. Добавить топологию ПФ в корпус, созданный ранее: 

3.1. Сделать активным окно с топологией ПФ (см. рис. 4.42, а). 

3.2. Выделить всю топологию ПФ (Ctrl+A) и скопировать ее (Ctrl+C). 

Рис. 4.48 

Рис. 4.47 
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3.3. Сделать активным окно электромагнитной модели и выполнить сле-

дующие действия: 

– без фиксации вставить топологию ПФ (Ctrl+V); 

– сориентировать и расположить топологию симметрично границам кор-

пуса (при необходимости поворота щелкнуть ПКМ); 

– зафиксировать топологию ЛКМ; 

– при необходимости скорректировать положение топологии; 

– убедиться в том, что края входной и выходной МПЛ точно совпадают 

с краями корпуса, а сама топология находится в сетке. 

Результат в варианте «П1» на данном этапе показан на рис. 4.49. 

Если топология ПФ не попала в сетку, то 

выполнить следующее: 

– выделить все объекты (Ctrl+A); 

– подвести курсор мышки к любому углу 

проводника и зажать клавишу Ctrl (при этом 

курсор «прилипнет» к этой точке проводника); 

– не отпуская клавишу Ctrl, зажать ЛКМ и 

передвинуть выделенные объекты до ближайше-

го узла сетки. 

3.4. Выделить все объекты (Ctrl+A) и на лю-

бом элементе топологии ПФ запустить команду 

ПКМ ⇒ Shape Properties. 

В открывшемся окне в списке Material вы-

брать StripElement и нажать OK. 

3.5. Щелкнуть ЛКМ по входной МПЛ для ее выделения и запустить ко-

манду Draw ⇒ Add Edge Port. Затем поместить курсор мышки на ее левый 

край так, чтобы он подсветился, и щелкнуть ЛКМ для закрепления порта. 

Щелкнуть по добавленному порту ЛКМ для его выделения. Поместить 

курсор мышки на черную линию так, чтобы он отобразился в виде двойной 

стрелки, а затем щелкнуть ЛКМ и, не отпуская ее, сместить референсную 

плоскость порта на 1 мм вправо (рис. 4.50). После чего отпустить ЛКМ. 

Примечание. Так как порт помеща-

ется на край проводника, совпадающий с 

краем корпуса, где действуют граничные 

условия для стенки из идеального провод-

ника, то в области порта присутствует 

Рис. 4.49 

Рис. 4.50 
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неоднородность, приводящая к возникновению высших запредельных типов 

волн, искажающих реальные характеристики. Для исключения этого и слу-

жит референсная плоскость. В результате порт находится не на краю мо-

делируемой структуры, а смещен от него. При этом запредельные типы 

волн успевают затухнуть и не оказывают суще-

ственного влияния на характеристики [29]. 

Обычно расстояние от порта до референс-

ной плоскости рекомендуется выбирать при-

мерно равным двум толщинам основания полос-

ковой платы, что и было сделано в рассматри-

ваемом примере. 

3.6. По п. 3.5 установить второй порт на 

правой кромке выходной МПЛ топологии ПФ. 

3.7. В вариантах задания с ШТ, добавить ме-

таллизированные переходные отверстия для свя-

зи между слоями модели, для чего выполнить 

следующие действия: 

– сделать активной вкладку Layout и рас-

крыть группу EM Layers; 

– в списке EM Layer выбрать 2, в списке 

Material – StripElement, а также включить оп-

цию Via (рис. 4.51); 

– запустить команду Draw ⇒ Rectangle и в 

окне с электромагнитной моделью в любом месте 

ЛКМ нарисовать прямоугольную перемычку с 

размерами 0,2 × 0,4 мм; 

– скопировать (Ctrl+C) нарисованную пере-

мычку и вставить копию (Ctrl+V) в центр исход-

ной перемычки, предварительно повернув ее на 

90º однократным щелчком ПКМ (в результате 

получится перекрестие); 

– выделить две созданные перемычки и объ-

единить их в одну командой Draw ⇒ Modify 

Shapes ⇒ Union; 

– передвинуть созданный крестообразный 

полигон на край полоскового элемента, который 

Рис. 4.51 

Рис. 4.52 
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должен быть заземлен (см. рис. 4.52). Этот полигон и будет отверстием в бу-

дущей КП; 

– скопировать крестообразный полигон и поместить копии на все зазем-

ленные края полосковых элементов. 

Примечание. Не обязательно использовать круглые полигоны или мел-

кую сетку, чтобы аппроксимировать круглое отверстие межслойного пере-

хода. Точность моделирования будет достаточной, если цилиндрическое 

отверстие межслойного перехода представить призмой в виде двух вписан-

ных в окружность пересекающихся прямоугольников, как и было сделано 

выше. Центр призмы должен совпадать с центром отверстия [29]. 

Результат в варианте «П1» на данном этапе показан на рис. 4.53, а, а 

возможный вид топологии СЛ 3-го порядка – на рис. 4.53, б. 

 Рис. 4.53 

а 

б 
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4. Добавить к графику АЧХ, полученному в ре-

зультате линейного моделирования, график АЧХ 

электромагнитной модели. 

Для этого выполнить пп. 3.1 и 3.2 из 4.3.5, вы-

брав в поле Data Source Name название электромаг-

нитной модели – BPFem. 

Изменения на вкладке Project в варианте «П1» показаны на рис. 4.54. 

5. Выполнить моделирование командой Simulate ⇒ Analyze.  

6. Удалить с графика результаты статистического анализа, для чего за-

пустить команду Simulate ⇒ Yield Analysis и в появившемся окне нажать 

кнопку Close. 

7. Настроить вид второй кривой, для чего в свойствах графика перейти 

на вкладку Traces, в группе Style выбрать ЛКМ вторую строку и в выпадаю-

щих списках установить: Color – черный, Symbol – none, Line – пунктир-

ная, Weight – вторая сверху. 

8. По п. 5 из 4.3.6 добавить маркеры на указанных частотах на графике 

АЧХ для электромагнитной модели. 

Результат в варианте «П1» показан на рис. 4.55. 

 

Как видно из рисунка, полоса пропускания АЧХ для электромагнитной 

модели получилась уже, чем для линейного моделирования. Похожий ре-

Рис. 4.55 

Рис. 4.54 
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зультат следует ожидать и в готовом устройстве. Поэтому топологию ПФ 

необходимо скорректировать, изменив положение и (или) размеры полоско-

вых элементов. 

Следует обратить внимание на то, что в других вариантах задания ре-

зультат может отличаться от варианта «П1»: 

– полоса пропускания АЧХ может быть не только уже, но и шире; 

– АЧХ может быть сдвинута вверх или вниз по частоте; 

– АЧХ может полностью удовлетворять целям оптимизации (в этом слу-

чае дальнейшая корректировка не требуется). 

9. Чтобы произвести правильные корректировки в топологии ПФ, необ-

ходимо понять влияние на вид АЧХ переменных, заданных при линейном 

моделировании, для чего выполнить следующие действия: 

– в рабочем поле оставить только вкладки со схемой ПФ и графиком; 

– выполнить команду Window ⇒ Tile Horizontal, в результате чего каж-

дое окно займет по половине площади рабочего поля; 

– запустить команду Simulate ⇒ Tune и в окне Variable Tuner с помо-

щью ползунков определить переменную (или переменные), которая позволит 

правильно скорректировать вид АЧХ электромагнитной модели. Исследовать 

влияние переменных нужно по отдельности, каждый раз возвращаясь к ис-

ходным значениям кнопкой Reset. 

Например, в варианте «П1» понадобится переменная S2 (зазор между 

резонаторами 2 и 3, 3 и 4). При ее увеличении полоса пропускания АЧХ 

сужается, а при уменьшении – расширяется. Также может понадобиться пе-

ременная L (длина резонаторов), при увеличении которой полоса пропуска-

ния АЧХ сдвигается вниз по частоте с небольшим сужением, а при уменьше-

нии – сдвигается вверх по частоте с небольшим расширением. Влияние ука-

занных переменных на АЧХ показано на рис. 4.58; 

– вернуть исходные значения переменным в схеме кнопкой Reset и за-

крыть окно Variable Tuner. 

10. Открыть окно электромагнитной модели, произвести корректировки 

в топологии ПФ и сохранить график АЧХ в отчет. 

В варианте «П1» для расширения полосы пропускания АЧХ потребова-

лось уменьшить зазоры между резонаторами 2 и 3, 3 и 4 (переменная S2). Для 

этого были выполнены следующие действия: 

– выделены элементы, находящиеся слева от центрального резонатора, 

за исключением входного полоскового элемента (см. рис. 4.57, а); 
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Рис. 4.56 

L=12 

S2=0.9 

L=8.3 

S2=0.9 

L=9.9 

S2=0.9 

L=9.9 

S2=0.7 

L=9.9 

S2=1.2 

Рис. 4.57 

а б 

в 

S2 
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– выделенные объекты перемещены с зажатой ЛКМ по горизонтали 

вправо. Рекомендуется изменять размеры (ширины, длины, зазоры) на не-

большие величины. Так, на рис. 4.57, б сдвиг был осуществлен на 0,2 мм, т. е. 

переменная S2 уменьшена с 0,9 мм до 0,7 мм; 

– увеличена длина входного полоскового элемента до касания с резона-

тором. Для этого по нему был сделан двойной щелчок ЛКМ и перемещена 

характерная точка, отмеченная синим ромбом (см. рис. 4.57, в); 

– проделаны описанные выше действия с элементами топологии, нахо-

дящимися справа от центрального резонатора, при этом сдвиг производился 

влево на 0,2 мм (для сохранения симметричности топологии); 

– выполнено моделирование командой Simulate ⇒ Analyze. 

Результат в варианте «П1» показан на рис. 4.58. 

 

Как видно из рисунка, теперь АЧХ электромагнитной модели полностью 

удовлетворяет целям оптимизации. Следует отметить, что приемлемый ре-

зультат в вариантах задания не обязательно получится сразу, поэтому может 

потребоваться проведение дополнительных корректировок. 

Скорректированные параметры топологии ШТ в варианте «П1»: 

– W1 = 0,3 мм; W2 = W3 = 1,2 мм; 

– S1 = 0,2 мм; S2 = 0,7 мм; 

– L = 9,9 мм; L1 = 1 мм; L2 = 1,1 мм. 

Рис. 4.58 
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Аналогичные значения в других вариантах задания необходимо сохра-

нить в отчет. 

11. Открыть окно электромагнитной модели, после чего выделить все 

объекты (Ctrl+A) и выполнить команду Draw ⇒ Modify Shapes ⇒ Union. 

В результате полигоны на одном слое с общими сторонами или пересе-

чениями будут объединены (полигоны под металлизированные переходные 

отверстия в ШТ останутся в виде отдельных объектов). 

12. Сохранить в отчет 3D-вид полученной топологии ПФ, для чего вы-

полнить команду View ⇒ View 3D EM Layout при активном окне электро-

магнитной модели. 

Результат в варианте «П1» показан на рис. 4.59, а, а возможный 3D-вид 

для ШТ 3-го порядка – на рис. 4.59, б. 

 Рис. 4.59 

а 

б 
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13. Сохранить скорректированную топологию ПФ в формате DXF для 

последующего импорта в редактор ПП Altium Designer. 

Для этого на вкладке Project на названии электромагнитной модели 

(BPFem) запустить команду ПКМ ⇒ Export Layout, после чего в появив-

шемся окне Export Layout выполнить следующее: 

– в списке Тип файла выбрать DXF (DXF Flat, *.dxf); 

– в поле Имя файла оставить имя по умолчанию – BPFem.dxf; 

– выбрать папку для сохранения. Путь сохранения в варианте «П1» – 

…\ИДРЭС-П1\Усилитель\_Фильтр (см. рис. 2.8). 

На рис. 4.60 показан фрагмент файла «Расчеты (фильтр).xmcd», в ко-

тором производились расчеты в варианте «П1». 

 

Для временного скрытия предупреждений (подчеркивание зеленой ло-

маной линией) следует запустить команду Tools ⇒ Preferences, а затем в от-

крывшемся окне перейти на вкладку Warnings и отключить опцию Show 

warnings on redefinitions of. 

Рис. 4.60 
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4.5. Содержание отчета 

По 4-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Расчет ширины полоскового элемента. 

2. Расчет порядка ПФ. 

3. Расчет эффективной диэлектрической проницаемости. 

4. Расчет четверти длины волны. 

5. Рисунок схемы ПФ. 

6. Результаты статистического анализа в виде трех графиков. 

7. Выводы по результатам статистического анализа (не менее трех). 

Примечание. Под выводами понимаются любые пояснения к полученным 

графикам, в том числе и их взаимное сравнение. 

8. Предложения по уменьшению разброса в АЧХ с последнего графика с 

результатами статистического анализа (не менее двух). 

Проимечания:  

– материал замене не подлежит; 

– одно из предложений практически полностью описано в тексте посо-

бия и легко находится по ключевому слову. 

9. Результат электромагнитного моделирования после корректировки 

топологии ПФ в сравнении с результатом линейного моделирования на од-

ном графике. 

10. Параметры топологии ПФ, полученные после оптимизации при ли-

нейном моделировании и после их корректировки при электромагнитном мо-

делировании, в виде одной сравнительной таблицы. 

11. Рисунок 3D-модели ПФ. 
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5. БИБЛИОТЕЧНЫЙ КОМПОНЕНТ В ALTIUM DESIGNER 

5.1. Общие сведения 

Для разработки схемы Э3 «усилителя», а затем и ПП, необходима база 

компонентов – библиотека. У разработчиков обычно есть свои библиотеки, 

но при работе над проектом могут появиться компоненты, которые ранее не 

использовались (например, микросхема в новом корпусе). Можно попытать-

ся найти такие компоненты в сети Интернет, но в этом случае придется осу-

ществить проверку, чтобы исключить возможные ошибки, и, вероятно, при-

вести их в соответствие с требованиями ЕСКД и стилем уже используемых 

библиотек. Надежнее нарисовать компонент вручную, да и с приобретенным 

опытом это не составит труда. 

Библиотечный компонент в Altium Designer (конденсатор, резистор, 

микросхема и др.) представляет собой составной объект, включающий в себя 

следующие части: 

– УГО (symbol) – для изображения на схеме; 

– посадочное место (footprint, pattern) – КП и вспомогательная информа-

ция для размещения корпуса на ПП (шелкография, внешние очертания и пр.); 

– SPICE-модель – для схемотехнического моделирования; 

– IBIS-модель – для анализа целостности сигналов; 

– 3D-модель – для отображения внешнего вида корпуса (3D-модель ре-

комендуется включать в состав посадочного места). 

Следует отметить, что библиотечный компонент не обязательно должен 

содержать все перечисленные части. Например, в данном курсе во все ком-

понентах не будут использоваться SPICE- и IBIS-модели, а в некоторых – 

еще и посадочные места. 

В качестве примера на рис. 5.1 показаны УГО, 3D-модель и посадочное 

место для одного из используемых при проектировании резисторов. 

 Рис. 5.1 

Вывод УГО (пин) КП Вывод компонента 

Шелкография Очертание корпуса Оси системы координат 
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Библиотеки компонентов в Altium Designer можно создать несколькими 

способами, но в основе каждого из них находятся два типа файлов: 

– с расширением «.SchLib» – для хранения УГО; 

– с расширением «.PcbLib» – для хранения посадочных мест. 

На рис. 5.2 показаны фрагменты составов таких файлов с выбранными 

УГО и посадочным местом для микросхемы аттенюатора HMC273AMS10GE 

фирмы Analog Devices. 

 

Основные способы организации библиотек в Altium Designer: 

1. В виде отдельных файлов с расширениями «.SchLib» и «.PcbLib».   

В этом способе возможны три варианта: 

1.1. Рекомендуемый вариант, в котором каждое УГО в файле с расшире-

нием «.SchLib» рассматривается как отдельный компонент. На этапе его со-

здания к нему подключаются файлы для моделирования, посадочные места 

из файлов с расширением «.PcbLib», устанавливаются взаимосвязи между 

номерами выводов в УГО и КП в посадочном месте, а также задаются требу-

емые системные и пользовательские параметры (атрибуты). 

Рис. 5.2 
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Возможный фрагмент окна свойств библиотечного компонента для кон-

денсатора фирмы Murata с заполненными параметрами и подключенным по-

садочным местом 0603-C-080 показан на рис. 5.3. 

 

Недостатки данного варианта: 

– для каждого компонента требуется отдельное УГО. Например, если в 

библиотеке находится 100 керамических конденсаторов с разными номина-

лами, то в ней будет и 100 отдельных одинаковых УГО (на рис. 5.4 показана 

библиотека с тремя конденсаторами); 

 

– подключение к проекту ПП нескольких отдельных файлов с расшире-

ниями «.SchLib» и «.PcbLib» (рис. 5.5). Таких файлов может быть достаточно 

много, если УГО и посадочные места хранятся в разных библиотеках. Это 

общий недостаток для всех вариантов рассматриваемого способа организа-

ции библиотек компонентов. 

1.2. Нерекомендуемый вариант, при котором каждое УГО в файле с 

расширением «.SchLib» рассматривается только как УГО. 

Рис. 5.3 

Рис. 5.4 
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Например, в библиотеке с рис. 5.4 для всех керамических конденсаторов 

можно создать всего лишь одно УГО с наименованием C_Ceramic без поль-

зовательских параметров и подключенных посадочных мест. Добавление па-

раметров и подключение необходимых файлов в этом случае придется осу-

ществлять вручную в каждом размещенном на схеме УГО. 

Данный вариант позволяет избавиться от второго недостатка первого 

варианта ценой сильного увеличения времени на создание схемы и большой 

вероятности допустить ошибку. 

1.3. Комбинации первых двух вариантов. 

2. В виде интегрированной библиотеки, представляющей собой один 

файл с расширением «.IntLib» и содержащей всю информацию о хранящихся 

в ней компонентах.  

Интегрированная библиотека – это усовершенствование первого вариан-

та первого способа организации библиотек компонентов с получением пре-

имущества в компактности и удобстве перемещения библиотеки, так как ее 

размер меньше суммарного размера файлов с расширениями «.SchLib» и 

«.PcbLib», из которых она создается.  

Пример подключения библиотеки к проекту ПП показан на рис. 5.6. 

 

Недостатком способа являются дополнительные временные затраты, так 

как для редактирования, добавления и удаления компонентов интегрирован-

ную библиотеку необходимо сначала распаковать, а после внесения всех тре-

буемых изменений заново собрать. 

Рис. 5.8 

Название проекта ПП 

Файлы схемы электрической  

принципиальной и разработанной ПП 

Интегрированная библиотека 

Рис. 5.5 

Название проекта ПП 

Файлы схемы электрической  

принципиальной и разработанной ПП 

Библиотека УГО 

Библиотека посадочных мест 
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3. В виде базы данных, которую, например, можно подготовить в Mi-

crosoft Excel или Microsoft Access. Каждая строка в ней представляет собой 

отдельный компонент с указанием в столбцах всех необходимых данных 

(УГО, посадочные места, параметры и др.). 

Подключение базы данных в Altium Designer осуществляется с помо-

щью файла с расширением «.DBLib», который описывает соответствие меж-

ду столбцами базы данных и параметрами компонентов. 

Достоинства способа: 

– каждое УГО в файлах с расширением «.SchLib» может быть использо-

вано в разных компонентах; 

– удобство создания новых однотипных компонентов и заполнения па-

раметров; 

– возможность совместного использования базы данных с другими под-

разделениями предприятия (например, с отделом складского учета). 

Недостатки способа: 

– несмотря на подключение в Altium Designer только одного файла, для 

работы библиотеки необходимы все остальные файлы (с УГО, с посадочны-

ми местами и т. д.), которые должны храниться в заранее заданном месте; 

– нельзя установить произвольные взаимосвязи между номерами выво-

дов в УГО и КП в посадочном месте, т. е. первый вывод в УГО будет автома-

тически соответствовать первой КП в посадочном месте, второй вывод в 

УГО – второй КП в посадочном месте и т. д. 

Структура и особенности создания используемой при проектировании 

библиотеки в виде базы рассмотрены в Г.34. 

Общие особенности всех способов организации библиотеки: 

– каждый размещенный на схеме компонент можно отредактировать 

вручную (например, удалить или добавить посадочное место); 

– можно осуществить автоматическое преобразование библиотеки ком-

понентов из одного рассмотренного способа в другой (в первом способе ис-

пользуется первый вариант). 

Для возможности создания схемы электрической принципиальной «уси-

лителя» не хватает библиотечного компонента танталового конденсатора с 

типоразмером из индивидуального задания на проектирование (остальные 

компоненты находятся в библиотеке из папки …\ИДРЭС\AD library). В те-

кущем разделе будут приведены действия по разработке интегрированной 

библиотеки такого компонента. 
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5.2. Посадочное место компонента 

5.2.1. Подготовительные действия 

Перед созданием посадочного места необходимо произвести некоторые 

подготовительные действия: 

1. Создать новую библиотеку посадочных мест (файл с расширением 

«.PcbLib»), для чего выполнить команду File ⇒ New ⇒ Library ⇒ PCB Li-

brary.  

Примечание. В рассмотренных в 5.1 способах организации библиотек 

компонентов необязательно каждое посадочное место хранить в отдель-

ном файле. На данном же этапе проектирования рассматривается процесс 

разработки библиотеки посадочных мест с нуля. 

В результате выполнения команды произойдет следующее: 

1.1. В панели Projects появится группа Free Documents с документом 

библиотеки посадочных мест с наименованием по умолчанию (PcbLib1), а в 

рабочем поле откроется вкладка для создания посадочного места (рис. 5.7). 

 

Внизу рабочего поля располагаются вкладки с названиями слоев и пик-

тограмма для работы с их наборами. Текущий в данный момент слой отмечен 

серым цветом. Назначение слоев и управление ими описано в Г.38. 

При отсутствии выделенных объектов в информационном поле (особен-

ности работы с ним приведены в Г.37) отображаются следующие данные: 

– текущие координаты курсора мышки (x и y); 

– смещение курсора мышки от места обнуления его координат (dx и dy); 

– текущий слой; 

– шаг сетки, к которой осуществляется привязка курсора мышки (Snap); 

Рис. 5.7 

Точка привязки 

(начало координат) 

Текущий слой Наборы слоев Слои 

Информационное 

поле 



 

 137 

– наличие привязки к объектам и размер области вокруг курсора для ее 

срабатывания (Hotspot Snap). 

Примечание. Способы управления изображением в рабочем поле описа-

ны в Г.3. 

1.2. Автоматически откроется панель PCB Library с заготовкой поса-

дочного места с наименованием PCBCOMPONENT_1. 

Если данная панель не открылась, то необходимо выбрать ее из группы 

PCB в дополнительном меню (см. рис. 3.1). 

Примечание. Назначение частей панели приведено в Г.7. 

2. Сохранить библиотеку посадочных мест. 

Для этого в панели Projects на библиотеке запустить команду ПКМ ⇒ 

Save As и в появившемся окне выполнить следующее: 

– задать имя библиотеки с указанием номера варианта задания через де-

фис (в варианте «П1» – Footprint-П1); 

– тип файла оставить по умолчанию – PCB Library File (*.PcbLib); 

– выбрать папку для сохранения и нажать Сохранить. Путь сохранения 

в варианте «П1» – …\ИДРЭС-П1\Усилитель\_Библиотека (см. рис. 2.8). 

3. Перейти в метрическую систему измерения, для чего щелкнуть ЛКМ в 

рабочем поле и нажать клавишу Q. Успешность действия можно проконтро-

лировать по единицам измерения в строке состояний. 

Примечание. Изменить систему измерений также можно в окне Board 

Options в поле Unit. Для его открытия последовательно нажимаются кла-

виши T ⇒ O или запускается команда Tools ⇒ Library Options. 

4. Установить шаг сетки 0,1 мм. 

Для этого нажать клавишу G и в контекстном меню выбрать требуемое 

значение. Шаг сетки отображается в строке состояний после слова Grid. 

Следует обратить внимание на следующее: 

– если требуется установить шаг сетки, значение которого отсутствует в 

списке доступных, то необходимо последовательно нажать клавиши G ⇒ G и 

в открывшемся окне Snap Grid ввести требуемое значение (данное окно мож-

но открыть разными способами: комбинацией клавиш Shift+Ctrl+G, коман-

дой View ⇒ Grids ⇒ Set Global Snap Grid и др.); 

– светлые вертикальные и горизонтальные линии на рис. 5.7 в рабочем 

поле по умолчанию проведены с пятикратным шагом сетки. При увеличении 

масштаба появятся темные линии, которые расположены на растоянии уста-

новленного шага сетки (рис. 5.8, а). Настроить отображение линий можно в 
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окне Cartesian Grid Editor (комбинация клавиш Ctrl+G) в группе Display 

(рис. 5.8, б). 

 

5. Включить привязку к сетке. 

Для этого включить опцию Snap To Grids в 

окне Board Options (клавиши T ⇒ O). 

Примечание. Управлять привязками можно из меню Snap в нижнем 

правом углу рабочего поля (рис. 5.9). Подробнее об особенностях и видах 

привязок см. в Г.36. 

6. Задать цветовые настройки, для чего вы-

полнить следующее: 

– запустить команду DXP ⇒ Preferences и в 

появившемся окне Preferences выбрать подраз-

дел PCB Editor ⇒ Layer Colors; 

– с помощью команды Load color profile за-

грузить из папки …ИДРЭС\Профили профиль 

ИДРЭС-AltiumPCB.PCBSysColors; 

– для применения профиля выбрать его в 

группе Saved Color Profiles (рис. 5.10) и закрыть 

окно кнопкой OK. 

7. Выбрать слои, необходимые для создания 

посадочного места.  

Для этого нажать клавишу L и в появив-

шемся окне View Configurations на вкладке 

Board Layers And Colors проделать следующее: 

– в группах Signal Layers, Mask Layers и Silkscreen Layers включить 

отображение слоев с верхней стороны ПП (опция Show для названий, содер-

жащих слово «Top»); 

– в группе Other Layers отключить отображение всех слоев; 

– в группе Mechanical отключить отображение 1-го слоя; 

Рис. 5.8 

а б 

Рис. 5.9 

Рис. 5.10 
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– в группе Mechanical отключить опцию Only show enabled mechanical 

Layers для отображения в списке всех доступных слоев, после чего добавить 

3-й и 5-й слои (опция Enable), включить их отображение и с использованием 

клавиши F2 задать названия в соответствии с табл. Г.15; 

– применить изменения кнопкой Apply и закрыть окно. 

Результаты проделанных действий в окне View Configurations показаны 

на рис. 5.11, а, а вид вкладок внизу рабочего поля – на рис. 5.11, б. 

 

8. Сохранить изменения в библиотеке. 

Для этого в панели Projects на библиотеке выполнить команду ПКМ ⇒ 

Save или в рабочем поле нажать комбинацию клавиш Ctrl+S. 

Остальные настройки для редактора ПП были загружены в 3.2.2. 

5.2.2. Внешний вид посадочного места 

В варианте «П1» необходимо создать библиотечный компонент для тан-

талового конденсатора типоразмера С серии 293D фирмы Vishay (столбец 7 

из табл. 1.1), внешний вид которого показан на рис. 5.12. 

 Рис. 5.12 

а б 

Метка  

полярности 

Выводы  

компонента 

Рис. 5.11 

а 

б 
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Конденсаторы указанной серии представлены шестью типоразмерами, 

размеры которых приведены на рис. 5.13 в двух единицах измерения:  

– в дюймах в первой строке; 

– в миллиметрах во второй строке в квадратных скобках. 

 

Типоразмер записан в двух вариантах: 

– буквенным кодом (столбец CASE CODE); 

– цифровым обозначением (столбец EIA SIZE), принятым в стандарте 

EIA (Electronic Industries Alliance) и состоящим из габаритных размеров кор-

пуса (длина, ширина и максимальная высота). 

Примечание. В последней версии документации фирмы Vishay на кон-

денсаторы данной серии типоразмер V отсутствует. 

Элемент Glue Pad, показанный на рис. 5.13, представляет собой неболь-

шой выступ с нижней стороны корпуса и предназначен для приклеивания 

компонента к ПП при автоматическом монтаже. 

Из рис. 5.12 видно, что конденсатор является SMD-компонентом (Sur-

face Mounted Device – компонент, монтируемый на поверхность) с двумя вы-

водами, уходящими под корпус. Компонент является полярным, поэтому со 

стороны расположения положительного вывода на верхней стороне корпуса 

нанесена метка в виде белой полосы. 

Также на корпусе конденсатора размещается дополнительная информа-

ция (рис. 5.14): емкость в пикофарадах для типоразмера А (104 – 0,1 мкФ) и в 

Рис. 5.13 
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микрофарадах для остальных типоразмеров (22 – 22 мкФ), номинальное 

напряжение буквой для типоразмера А (V – 35 В) и цифрами для остальных 

типоразмеров (10 – 10 В), отметка об отсутствии свинца (L), код даты выпус-

ка и логотип компании.  

 

Остальная информация находится в документации в папке …\ИДРЭС\ 

Компоненты\Конденсаторы\Конденсаторы Vishay. 

Внешний вид посадочного места конденсатора из варианта «П1», кото-

рое будет создано в данном учебном пособии в Altium Designer, в 2D-режиме 

просмотра представлен на рис. 5.15, а, а в 3D-режиме – на рис. 5.15, б. 

 

Содержание каждого слоя посадочного места с рис. 5.15, а приведено на 

рис. 5.16: 

– на слое Top Layer расположены две КП для пайки выводов конденса-

тора и пунктирный контур, используемый при трассировке ПП для создания 

в этом месте участка без металлизации; 

– на слое M3 Top Assy (цвет слоя временно изменен на зеленый) изоб-

ражен контур корпуса с отметкой стороны положительного вывода, а также 

размещена надпись со ссылкой на позиционное обозначение компонента; 

Рис. 5.15 

а б 

Рис. 5.14 
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– на слое M5 Top 3D расположен контур подключенной 3D-модели в 

формате STEP; 

– на слое Top Overlay линиями показаны длинные стороны корпуса, а 

кругом обозначен положительный вывод; 

– на слоях Top Paste и Top Solder объекты для КП создаются автомати-

чески, но при необходимости их можно изменить или добавить собственные. 

Перечеркнутая окружность – точка привязки (начало координат). Отно-

сительно нее осуществляется перемещение и вращение посадочного места. 

Иногда в посадочном месте предусматривают еще один механический 

слой с наименованием Courtyard, в котором вычерчивается контур вокруг 

корпуса компонента и его КП (обычно на расстоянии 0,1, 0,25 или 0,5 мм). 

Используется он для обеспечения гарантированного зазора между компонен-

тами при их расстановке на ПП. 

Посадочные места в САПР всегда создаются на верхних слоях, незави-

симо от того, на какой стороне ПП окажется компонент после ее разработки. 

В Altium Designer сигнальные слои Top Layer и Bottom Layer, а также 

слои паяльной пасты, защитной паяльной маски и шелкографии, в названиях 

которых содержатся Top и Bottom, являются парными по умолчанию. Пары 

для механических слоев задаются отдельно и только при создании ПП. 

Таким образом, при переносе компонента на противоположную сторону 

ПП при ее разработке автоматически будут перенесены на парные слои и со-

ответствующие объекты посадочного места (например, графика шелкогра-

фии со слоя Top Overlay перейдет на слой Bottom Overlay и наоборот). 

Рис. 5.16 

Top Layer M3 Top Assy M5 Top 3D 

Top Overlay Top Paste Top Solder 
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На рис. 5.17, а изображены две КП на диэлектрическом основании без 

шелкографии, защитной паяльной маски и финишного покрытия. В таком 

виде посадочное место на ПП не используется, так как КП, являясь участка-

ми металлизации, не подключены к печатным проводникам. Следовательно, 

сигналы можно подать только подпайкой проводов. 

 

На рис. 5.17, б добавлены подключения: 

– КП для установки положительного вывода конденсатора соединена с 

печатным проводником; 

– КП для установки отрицательного вывода конденсатора соединена с 

земляным полигоном в виде большого участка металлизации. 

Подключение к земляному полигону может быть двух видов:  

– прямое (рис. 5.17, б); 

– с тепловым барьером (через узкие перемычки как на рис. 5.18). 

Область с отсутствующей металлизацией между КП на рис. 5.17, б свя-

зана с наличием на слое Top Layer пунктирного контура (см. рис. 5.16). Такие 

области можно задавать вручную при разработке ПП или редактировать уже 

созданные в посадочных местах. 

а б 

в г 

Рис. 5.17 
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На рис. 5.17, в добавлены: 

– защитная паяльная маска зелено-

го цвета (слой Top Solder на рис. 5.16); 

– шелкография белого цвета (слой 

Top Overlay на рис. 5.16). 

На рис. 5.17, г показан конденсатор 

на посадочном месте с разрезом в обла-

сти положительного вывода. 

Примечания: 

– цвет объекта в САПР не определяет его цвет в готовой ПП; 

– на рисунках не показаны позиционное обозначение компонента (по 

умолчанию расположено в слое шелкографии и не отображается при про-

смотре посадочного места), финишное покрытие и переходные отверстия; 

– информация со слоев M3 Top Assy и M5 Top 3D (см. рис. 5.16) на ПП 

отсутствует, так как это вспомогательные слои; 

– зазоры в проводящем рисунке ПП задаются на этапе ее трассировки.  

5.2.3. Создание посадочного места 

Для создания посадочного места выполнить следующее: 

1. Сохранить в отчет все размеры корпуса, указанные на рис. 5.13 для 

типоразмера из варианта индивидуального задания на проектирование. 

2. Задать имя посадочному месту. 

Для этого в панели PCB Library в группе Components дважды щелкнуть 

ЛКМ по заготовке посадочного места и в появившемся окне PCB Library 

Component в поле Name ввести имя, характеризующее типоразмер корпуса 

танталового конденсатора с указанием серии (рис. 5.19, а).  

Вид панели PCB Library в варианте «П1» показан на рис. 5.19, б. 

 Рис. 5.19 

а б 

Рис. 5.18 
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Примечания по рис. 5.19, а: 

– в поле Height можно указать высоту корпуса для создания правил по 

размещению компонентов на ПП (если в посадочном месте используется 

3D-модель, то значение из этого поля игнорируется); 

– в поле Description можно дать краткое описание посадочного места; 

– опции из поля Type подробно описаны в Г.33. 

3. Сделать текущим слой M3 Top Assy. 

Для этого щелкнуть ЛКМ по соответствующей вкладке с названием слоя 

внизу рабочего поля. Для циклического перехода между вкладками слоев 

также можно использовать клавиши Plus (перебор слева направо) и Minus 

(перебор справа налево) на цифровой клавиатуре (Numpad). 

4. Последовательным нажатием кла-

виш P ⇒ L (создание линии) нарисовать 

прямоугольный контур с размерами L (по 

горизонтали) и W (по вертикали) по 

рис. 5.13. Ширину линии задать 0,1 мм. 

Примечания: 

– задать ширину линии можно в про-

цессе рисования клавишей Tab; 

– рисовать контур удобнее из начала 

координат, а размеры контролировать в 

информационном поле (см. рис. 5.7); 

– координаты точек можно вводить 

после последовательного нажатия кла-

виш J ⇒ L или запуска команды Edit ⇒ 

Jump ⇒ New Location. 

В варианте «П1» размеры контура со-

ставили 6 × 3,2 мм (рис. 5.20). 

5. Внутри прямоугольного контура с его левой стороны нарисовать за-

крашенную прямоугольную область произвольного размера, тем самым обо-

значив положение полярного вывода на чертеже. 

Для этого последовательно нажать клавиши P ⇒ F или запустить коман-

ду Place ⇒ Fill (создание полигона Fill). 

В варианте «П1» размеры области составили 1,5 × 3,2 мм (рис. 5.21). 

6. Убедиться в том, что начало координат находится точно в нижнем ле-

вом углу нарисованного ранее прямоугольного контура. 

Рис. 5.20 

Рис. 5.21 
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Изменить положение начала координат можно после последовательного 

нажатия клавиш E ⇒ F ⇒ L (или запуска команды Edit ⇒ Set Reference ⇒ 

Location) и щелчка ЛКМ в требуемой точке рабочего поля. 

7. Добавить первую КП со сторо-

ны полярного вывода. 

КП – это металлизированный уча-

сток на ПП для организации контакта с 

выводом компонента или другим объ-

ектом (например, с проводом). Число 

КП в посадочном месте компонента 

обычно равно числу его выводов. 

Различают два типа КП: 

– плоские (планарные) – для мон-

тажа SMD-компонентов (рис. 5.17, г); 

– с отверстием – для монтажа вы-

водных компонентов. На рис. 5.22, а 

показаны КП для установки выводного 

компонента, а на рис. 5.22, б – диод в 

корпусе DO-41 на посадочном месте c 

шелкографией, защитной паяльной 

маской и финишным покрытием. 

Первая КП будет иметь форму скругленного прямоугольника для обо-

значения расположения положительного вывода компонента на проводящем 

рисунке ПП. Индикация КП не обязательна, но желательна. 

Для добавления КП выполнить следующее: 

7.1. Последовательно нажать клавиши P ⇒ P или запустить команду 

Place ⇒ Pad, после чего открыть свойства КП клавишей Tab (окно Pad). 

 Рис. 5.23 

а б 

а 

б 

Рис. 5.22 
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7.2. В группе Properties выбрать слой расположения Top Layer и убе-

диться в том, что в поле Designator указан первый номер КП (рис. 5.23, а). 

7.3. В группе Size and Shape выбрать форму КП – Rounded Rectangle 

(скругленный прямоугольник). 

7.4. В группе Size and Shape задать размеры КП и сохранить их в отчет: 

– по горизонтали (поле X-Size) – размер P c рис. 5.13 плюс выступ за 

пределы корпуса ( 5,03,0 =X  мм) для возможности ручного монтажа; 

– по вертикали (поле Y-Size) – размер Tw с рис. 5.13. 

В варианте «П1»: 

25,05,1 =+=+= XPXSize  мм; 

2,2==TwYSize  мм. 

Необходимо обратить внимание на следующее: 

– значения размеров Tw и P следует выбрать ближе к их максимумам; 

– записанные размеры КП в варианте «П1» показаны на рис. 5.23, б; 

– располжение КП относительно выводов корпуса конденсатора типо-

размера C показано на рис. 5.24. 

 

7.5. Применить изменения, после чего щелчком ЛКМ разместить КП в 

любом удобном месте рабочего поля и завершить команду. 

7.6. Зайти в свойства добавленной КП (дважды щелкнуть по ней ЛКМ 

или запустить команду ПКМ ⇒ Properties) и в группе Location указать ко-

ординаты расположения центра КП: 

– по оси X – половина размера КП по горизонтали минус выбранный 

размер X ; 

Рис. 5.24 
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– по оси Y – половина короткой стороны прямоугольного контура (по-

ловина размера W по рис. 5.13). 

В варианте «П1»: 

5,05,0222 =−=−= XXSizeX  мм; 

6,122,32к ===WY  мм. 

Примечание. Для размера W добавлен 

индекс «к», чтобы исключить путаницу с 

шириной МПЛ при расчете ПФ. 

Записанные в варианте «П1» значе-

ния для первой КП показаны на рис. 5.25. 

Полученное значение координаты X для первой КП необходимо сохра-

нить в отчет, так как оно понадобится при создании 3D-модели в разд. 6. 

8. Добавить вторую КП со стороны неполярного вывода. 

Она будет иметь форму прямоугольника без скруглений, и ее удобнее 

получить копированием ранее размещенной КП: 

8.1. Скопировать первую КП (Ctrl+C), указав базовую точку, относи-

тельно которой будет произведено копирование (например, в центре КП). 

8.2. Вставить КП (Ctrl+V) в любое удобное место рабочего поля, зайти в 

ее свойства и выполнить следующие действия: 

– в группе Properties в поле Designator указать второй номер КП; 

– в группе Size and Shape выбрать форму КП – Rectangular (прямо-

угольник); 

– в группе Location для координаты X указать значение, равное размеру 

длинной стороны прямоугольного контура (размер L по рис. 5.13) плюс вы-

бранный размер X  и минус половина размера КП по горизонтали. 

В варианте «П1»: 

5,5225,062к =−+=−+= XSizeXLX  мм. 

Примечание. Для размера L добавлен индекс «к», чтобы исключить пу-

таницу с длинами резонаторов при расчете ПФ; 

– в группе Location для координаты Y записать значение, полученное 

для первой КП. 

Записанные в варианте «П1» значения для второй КП показаны на 

рис. 5.26, а, а вид посадочного места на данном этапе – на рис. 5.26, б. 

Примечание. Позиционирование КП по координатам исключает неточ-

ности, которые могли бы возникнуть при ручной расстановке. 

9. Убедиться в том, что текущим является слой Top Layer. 

Рис. 5.25 
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10. Нарисовать прямоугольный контур, проходящий примерно по гра-

ницам КП и выходящий за пределы контура конденсатора на 0,3–0,4 мм. 

Внутри этого контура при трассировке ПП не будет земляного полигона. 

Для этого выполнить следующее: 

– последовательно нажать клавиши P ⇒ R или запустить команду 

Place ⇒ Solid Region (создание полигона Solid Region); 

– в рабочем поле ЛКМ указать четыре вершины контура; 

– нажать клавишу Tab и в появив-

шемся окне Region для параметра Kind 

выбрать опцию Polygon cutout; 

– применить изменения в окне Re-

gion и нажать клавишу Esc для завер-

шения команды.  

Результат в варианте «П1» на дан-

ном этапе показан на рис. 5.27. 

11. Сделать текущим слой Top Overlay. 

12. Добавить элементы шелкографии: 

– последовательным нажатием клавиш P ⇒ L (создание линии) обозна-

чить границы корпуса конденсатора линиями толщиной 0,2 мм; 

– последовательным нажатием клавиш P ⇒ U или командой Place ⇒ 

Full Circle (создание окружности) добавить обозначение полярности окруж-

ностью радиусом 0,1 мм и толщиной линии 0,4 мм. 

Необходимо обратить внимание на то, что между границами графики 

шелкографии и КП должны остаться зазоры не менее 0,15 мм. 

Результат в варианте «П1» на данном этапе показан на рис. 5.28, а. 

Примечания: 

– ореол вокруг КП – информация со слоя Top Solder (см. табл. Г.14); 

Рис. 5.26 

а 

б 

Рис. 5.27 
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– для создания окружности с требуемыми параметрами достаточно 

нарисовать любую окружность и в ее свойствах (рис. 5.28, б) указать ради-

ус (поле Radius), толщину линии (поле Width), положение центра (группа 

Center), начальный и конечный углы ду-

ги (поля Start и End Angle); 

– шелкографию из состава любого 

посадочного места можно отредак-

тировать на этапе разработки ПП; 

– один из возможных вариантов 

шелкографии показан на рис. 5.29 (на 

ПП – см. рис. Г.185 и Г.188). 

13. Установить начало координат в центр первой КП. 

Для этого последовательно нажать клавиши E ⇒ F ⇒ P или выполнить 

команду Edit ⇒ Set Reference ⇒ Pin 1. 

Примечание. Начало координат можно поставить в центр компонента 

и использовать при генерации файла «Pick and Place» (параметры Ref-X и 

Ref-Y) из файла трассировки для автоматического монтажа. 

Команда Edit ⇒ Set Reference ⇒ Center устанавливает начало коорди-

нат в точку, равноудаленную от центров всех КП посадочного места, а ко-

манда Edit ⇒ Set Reference ⇒ Location – в точку, указанную пользователем. 

14. Сделать текущим слой M3 Top Assy. 

15. У каждого посадочного места есть два системных параметра, кото-

рые в рабочем поле при его создании не отображаются: 

– Designator (позиционное обозначение); 

– Comment (комментарий). 

При добавлении посадочных мест на ПП значения этим параметрам 

присваиваются автоматически из схемы. Настройки для них были загружены 

Рис. 5.28 

а б 

Рис. 5.29 
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в 3.2.2 (примитив Component в табл. Г.6). Параметр Designator по умолчанию 

располагается в верхнем слое шелкографии (Top Overlay), но для создания 

сборочных чертежей позиционное обозначение необходимо и на слое с кон-

турами компонентов (M3 Top Assy). Для этого требуется добавить надпись со 

ссылкой на параметр: 

15.1. Последовательно нажать клавиши P ⇒ S или запустить команду 

Place ⇒ String (создание надписи). 

15.2. Нажать клавишу Tab для открытия окна свойств. 

15.3. В группе Properties вместо слова String записать «.Designator». 

Ссылку можно выбрать из списка, появляющегося после ввода первого сим-

вола – точки. Одинарные кавычки при этом можно не удалять (рис. 5.30, а). 

15.4. Настроить шрифт надписи: 

– Font – TrueType; 

– Font Name – GOST type B; 

– Height – 1mm.  

15.5. Применить настройки в окне 

String, после чего щелчком ЛКМ ука-

зать положение надписи внутри конту-

ра компонента. 

Затем завершить команду клави-

шей Esc (рис. 5.30, б). 

15.6. При необходимости скоррек-

тировать положение надписи, после 

чего в ее свойствах включить опцию Locked (блокировка объекта). 

16. Проверить посадочное место. 

Для этого запустить команду Reports ⇒ Component Rule Check, вклю-

чить проверку правил в соответствии с рис. 5.31 и нажать OK. 

 

В результате проверки в новой вкладке рабочего поля откроется отчет, в 

котором при наличии ошибок будут даны соответствующие пояснения с ко-

Рис. 5.31 

Рис. 5.30 

а 

б 
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ординатами их расположения. Отчет необходимо внимательно проанализи-

ровать и исправить обнаруженные ошибки в соответствии с табл. 5.1. 

Таблица 5.1 

Некоторые ошибки при проверке посадочного места 

Правило Описание Способ устранения 

Duplicate Pads КП с одинаковыми номерами В свойствах КП отредактировать 

числа для параметра Designator 

(номер КП) 
Missing Pad Names КП без номеров 

Duplicate Primitives Наложение примитивов на од-

ном слое (например, линий) 

Удалить повторяющиеся прими-

тивы 

Offset Component 

Reference 

Начало координат находится за 

пределами посадочного места 

Выполнить п. 13 

Shorted Copper Разные КП, соединенные в по-

садочном месте участками ме-

таллизации 

Проверить значение параметра 

Kind для объекта Solid Region из 

п. 10, а также слой графики кон-

тура компонента из пп. 4 и 5 

После анализа закрыть вкладку с отчетом, например выполнив на ней 

команду ПКМ ⇒ Close Text Documents. 

17. Сохранить в отчет два рисунка посадочного места в серых тонах: 

17.1. Применить профиль ИДРЭС-AltiumFootprintGray.PCBSysColors 

из папки …ИДРЭС\Профили (см. п. 6 из 5.2.1). 

17.2. Сохранить один рисунок по-

садочного места при текущем слое M3 

Top Assy, а другой – при текущем слое 

Top Layer. 

Масштаб выбрать таким, чтобы на 

экране были видны только линии с пя-

тикратным шагом сетки.  

Результат второго изображения в 

варианте «П1» показан на рис. 5.32. 

17.3. Вернуть цветовые настройки, заданные в п. 6 из 5.2.1. 

18. Перейти в 3D-режим просмотра, для чего нажать клавишу 3 или вы-

полнить команду View ⇒ 3D Layout Mode. 

Включить вид на верхнюю сторону ПП (см. Г.3) и сохранить рисунок. 

19. Вернуться в 2D-режим просмотра, для чего нажать клавишу 2 или 

выполнить команду View ⇒ 2D Layout Mode. 

20. Сохранить изменения в посадочном месте (Ctrl+S). 

3D-модель будет добавлена к посадочному месту в 6.6. 

Рис. 5.32 
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5.3. УГО компонента 

5.3.1. Подготовительные действия 

Перед созданием УГО необходимо произвести некоторые подготови-

тельные действия: 

1. Создать новую библиотеку УГО (файл с расширением «.SchLib»), для 

чего выполнить команду File ⇒ New ⇒ Library ⇒ Schematic Library. Как и 

в случае с посадочным местом в рассмотренных в 5.1 способах организации 

библиотек компонентов необязательно каждое УГО хранить в отдельном 

файле. На данном же этапе проектирования рассматривается процесс разра-

ботки библиотеки УГО с нуля. 

В результате выполнения команды произойдет следующее: 

1.1. В панели Projects в группе Free Documents появится документ биб-

лиотеки УГО с наименованием по умолчанию (Schlib1), а в рабочем поле от-

кроется соответствующая вкладка, состоящая из трех областей (рис. 5.33): 

– область разработки УГО; 

– область подключения моделей (посадочных мест, моделей для схемо-

технического моделирования и для анализа целостности сигналов); 

– область просмотра посадочных мест и 3D-моделей. 

 

Примечание. Способы управления изображением в рабочем поле описа-

ны в Г.3. В области просмотра посадочных мест и 3D-моделей доступен как 

2D-режим просмотра, так и 3D-режим. 

1.2. Автоматически откроется панель SCH Library с заготовкой УГО с 

наименованием Component_1. 

Рис. 5.33 

Точка привязки 

(начало координат) 

Область подключения 

моделей 

Область просмотра 

посадочных мест и 

3D-моделей 

Область 

разработки УГО 
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Если данная панель не открылась, то необходимо выбрать ее из группы 

SCH в дополнительном меню (см. рис. 3.1). 

Примечание. Описание работы с панелью приведено в Г.8. 

2. Сохранить библиотеку УГО. 

Для этого в панели Projects на библиотеке запустить команду ПКМ ⇒ 

Save As и в появившемся окне выполнить следующее: 

– задать имя библиотеки с указанием номера варианта задания через де-

фис (в варианте «П1» – Symbol-П1); 

– тип файла оставить по умолчанию – Advanced Schematic binary li-

brary (*.SchLib); 

– выбрать папку для сохранения и нажать Сохранить. Путь сохранения 

в варианте «П1» – …\ИДРЭС-П1\Усилитель\_Библиотека (см. рис. 2.8). 

3. При необходимости изменить цвет рабочего поля с цветочного белого 

на белый, для чего запустить команду Tools ⇒ Document Options и в от-

крывшемся окне Schematic Library Options на вкладке Library Editor Options в 

поле Workspace задать желаемую настройку. 

4. Перейти в сетку 0,5 мм. 

5. Сохранить изменения в библиотеке (Ctrl+S). 

Остальные настройки для редактора УГО были загружены в 3.2.2. 

5.3.2. Общие сведения об УГО 

УГО – условные знаки, которыми изображают компоненты (резисторы, 

микросхемы и др.) на схемах. Общие требования к их оформлению даны в 

ГОСТ 2.701–2008. 

При выполнении схем применяют следующие типы УГО: 

– установленные в стандартах ЕСКД или построенные на их основе; 

– прямоугольники; 

– упрощенные внешние очертания (в том числе аксонометрические); 

– нестандартизованные УГО (при необходимости). 

Для двух последних типов УГО на схеме дают пояснения.  

Если для УГО установлено несколько допустимых (альтернативных) ва-

риантов выполнения, то на всех схемах одного типа, входящих в комплект 

документации, должен быть применен только один вариант обозначения. 

УГО в стандартах ЕСКД приводятся в следующих вариантах: 

– с указанием диапазона размеров; 

– на модульной сетке; 



 

 155 

– без размеров и без модульной сетки (в этом случае УГО изображают 

в размерах, в которых они выполнены в соответствующих стандартах). 

Все размеры УГО допускается пропорционально изменять. Предел 

уменьшения определяется минимальным расстоянием (просветом) между 

двумя соседними линиями УГО, который по ГОСТ 2.701–2008 не должен 

быть менее 1,0 мм. Аналогичное требование по зазору между линиями дано и 

в ГОСТ 13.1.002–2003 [31], где это расстояние должно быть не менее 0,8 мм 

(в этом случае при печати на листе линии не сольются). 

УГО на схемах следует выполнять линиями той же толщины, что и ли-

нии взаимосвязи (при проектировании в Altium Designer – Small). 

Размеры УГО, а также толщины их линий должны быть одинаковыми на 

всех схемах для данного изделия (установки). 

УГО допускается изображать повернутыми на угол, кратный 45°, или 

изображать зеркально повернутым, если в соответствующих стандартах от-

сутствуют специальные указания. Если при повороте может нарушиться 

смысл или удобочитаемость обозначений, то их изображают так, как они 

приведены в соответствующих стандартах. УГО, содержащие цифровые или 

буквенно-цифровые обозначения, допускается поворачивать против часовой 

стрелки только на угол 90° или 45°. 

По ГОСТ 2.702–2011 на схеме следует указывать обозначения выводов 

(контактов) элементов (устройств), нанесенные на изделие или установлен-

ные в их документации. 

Стандарты ЕСКД для наиболее часто встречающихся элементов: 

– ГОСТ 2.721–74 (обозначения общего применения). Здесь можно найти 

примеры обозначений линий электрической связи; 

– ГОСТ 2.722–68 (машины электрические) [32]. Здесь можно найти раз-

меры дуг для УГО индуктивностей; 

– ГОСТ 2.723–68 (катушки индуктивности, дроссели, трансформаторы, 

автотрансформаторы и магнитные усилители) [33]; 

– ГОСТ 2.728–74 (резисторы и конденсаторы) [34]; 

– ГОСТ 2.788–73 (приборы полупроводниковые) [35]; 

– ГОСТ 2.734–68 (линии сверхвысокой частоты и их элементы) [36]; 

– ГОСТ 2.743–91 (элементы цифровой техники) [37]; 

– ГОСТ 2.755–87 (устройства коммутационные и контактные соедине-

ния) [38]; 

– ГОСТ 2.759–82 (элементы аналоговой техники) [39]. 
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5.3.3. Создание УГО 

УГО поляризованного (полярного) конденсатора по ГОСТ 2.728–74 в 

вертикальном виде приведено на рис. 5.34, а, а в горизонтальном виде – на 

рис. 5.34, б. Размеры УГО показаны на рис. 5.34, в. 

УГО будет создаваться в верти-

кальном виде, так как именно так оно 

используется наиболее часто. Для по-

лучения на схеме горизонтального ви-

да его можно будет отразить относи-

тельно оси Y, а затем повернуть.  

Для создания УГО выполнить следующее: 

1. Задать имя УГО. 

Для этого в панели SCH Library в списке 

Components дважды щелкнуть ЛКМ по заготов-

ке УГО и в появившемся окне Library Compo-

nent Properties в группе Library Link в поле 

Symbol Reference ввести имя C_Polar, где С – 

буквенное обозначение конденсаторов в схемах; 

Polar – полярный конденсатор (рис. 5.35, а).  

Вид панели SCH Library в варианте «П1» 

показан на рис. 5.35, б. 

2. Последовательным нажатием клавиш P ⇒ L (создание линии) нарисо-

вать две горизонтальные линии произвольной длины, обозначающие обклад-

ки конденсатора (например, как на рис. 5.36, а). 

 

3. Отдельно для каждой линии открыть ее свойства, перейти на вкладку 

Vertices и задать координаты вершин в соответствии с рис. 5.36, б и в. 

Рис. 5.36 

а 

б 

в г 

Рис. 5.34 [34] 

а б в 

Рис. 5.35 

а 

б 
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Результат корректировки координат показан на рис. 5.36, г. 

Примечание. Способ рисования линий по координатам связан с тем, что 

схемный редактор и редактор УГО в Altium Designer позволяют задать шаг 

сетки менее 0,254 мм только последовательным нажатием клавиш V ⇒ 

G ⇒ S или командой View ⇒ Grids ⇒ Set Snap Grid, при этом узлы сетки 

отображаются в старом шаге, а сама сетка сбрасывается на 0,254 мм, ес-

ли в процессе рисования будет изменен масштаб. Если для сложных УГО 

это оказывается неудобным, то есть альтернативный вариант: 

– УГО рисуется в любом чертежном САПР 

(например, КОМПАС-3D); 

– УГО сохраняется в формате DWG или DXF; 

– результат импортируется в Altium Designer с 

масштабирующим коэффициентом 0,03937 (в 25,4 

раза меньше, чем предлагается по умолчанию). 

4. Двумя линиями длиной по 2 мм каждая нари-

совать знак «+». 

Результат в варианте «П1» показан на рис. 5.37. 

5. Перейти в сетку 3 мм. 

6. Добавить первый пин, который будет располагаться над двумя гори-

зонтальными линиями (со стороны знака «+»). 

Пин (pin, вывод) – объект, предназначенный для осуществления связи с 

КП в посадочном месте и подключения линий связи к УГО на схеме. 

Для добавления первого пина выполнить следующее: 

6.1. Последовательно нажать клавиши P ⇒ P или запустить команду 

Place ⇒ Pin, после чего щелчком ЛКМ установить пин в начало координат и 

завершить команду (рис. 5.38, а). 

 Рис. 5.38 

а 

б 

в 

Рис. 5.37 
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6.2. Зайти в свойства пина и задать настройки: 

– в поле Display Name указать функциональное назначение пина (Plus) 

и отключить отображение поля (рис. 5.38, б); 

– в поле Designator указать номер пина (1) и отключить отображение 

поля (рис. 5.38, б); 

– в группе Graphical задать длину, расположение 

и угол поворота пина в соответствии с рис. 5.38, в. 

Результат размещения первого пина показан на 

рис. 5.39. 

7. Добавить второй пин, который будет распола-

гаться под двумя горизонтальными линиями. 

Это удобнее сделать копированием первого пина: 

7.1. Скопировать первый пин (Ctrl+C). 

7.2. Сначала нажать комбинацию клавиш Ctrl+V, а затем дважды кла-

вишу Пробел для поворота фантома. После этого зафиксировать пин ЛКМ 

так, чтобы верхний его конец касался нижней горизонтальной линии. 

7.3. Зайти в свойства пина и внести следующие изменения: 

– в поле Display Name записать Minus; 

– в поле Designator указать 2. 

8. Проконтролировать правильность установки пинов: 

– сверху должен быть первый пин, а снизу – второй. При выборе ЛКМ 

пина в рабочем поле подсвечивается соответствующая строка в панели SCH 

Library (рис. 5.40, а). Также верно и обратное; 

– конец первого пина, к которому будет подключаться линия электриче-

ской связи на схеме (содержит четыре светлые точки как на рис. 5.40, б), 

должен находиться сверху, а такой же конец второго пина – снизу. 

 

Примечания: 

– отображение информации из полей Display Name и Designator у пинов 

используется в основном в УГО микросхем, например в усилителе GALI-3+ 

из варианта «П1» (рис. 8.22); 

Рис. 5.40 

а б 

Рис. 5.39 
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– функциональные назначения выводов конденсатора были указаны для 

контроля правильности организации связей с КП посадочного места. В этих 

полях можно было записать номера выводов или оставить их пустыми; 

– начало первого вывода находится в начале координат, так как отно-

сительно этой точки осуществляется перемещение и вращение УГО на схе-

ме при добавлении компонента из библиотеки. 

9. Настроить системные параметры Designator и Comment. 

Если в посадочном месте (см. п. 15 из 5.2.3) на их 

расположение не накладывается строгих ограниче-

ний, то в УГО они должны располагаться в соответ-

ствии с ГОСТ 2.702–2011 (рис. 5.41). Для настройки 

параметров выполнить следующее: 

9.1. В панели SCH Library в списке Components 

дважды щелкнуть ЛКМ по строке с УГО или выде-

лить ее ЛКМ и нажать кнопку Edit (см. рис. 5.35, б). 

В появившемся окне Library Component Proper-

ties в разделе Properties внести корректировки: 

– в поле Default Comment записать Comment. Поле будет отредактиро-

вано в следующем подразделе, а на данном этапе эта запись гарантирует пе-

реход на латинскую раскладку клавиатуры; 

– в поле Default Designator записать C?, где латинская буква C – бук-

венный код конденсатора по ГОСТ 2.710–81 [40], знак «?» – место для про-

становки порядкового номера компонента с указанным кодом при автомати-

ческой перенумерации схемы. 

Примечание. Опции Visible около си-

стемных параметров позволяют управ-

лять их видимостью на схеме (рис. 5.42). 

9.2. Отобразить системные параметры в редакторе УГО. 

Для этого запустить команду Tools ⇒ Document Options и в появив-

шемся окне Schematic Library Options на вкладке Library Editor Options 

включить опцию Always Show Comment/Designator. 

По умолчанию в свойствах системных параметров включена опция Au-

toposition (например, как для параметра Designator на рис. 5.43, а), которая 

означает следующее: 

– при добавлении УГО на схему параметр Designator всегда будет нахо-

диться над параметром Comment; 

Рис. 5.41 [11] 

Рис. 5.42 
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– на схеме при повороте УГО данные параметры будут располагаться 

относительно него или по верхнему левому варианту с рис. 5.41, или по ниж-

нему правому варианту с этого рисунка; 

– любые действия, произведенные с изменением положения, угла пово-

рота или точки привязки данных параметров в редакторе УГО, будут про-

игнорированы. 

Опцию Autoposition рекомендуется включать для системных параметров 

в УГО дискретных компонентов (конденсаторов, резисторов и др.) и отклю-

чать в УГО для всех остальных компонентов (например, микросхем), настра-

ивая их расположение в библиотеке. При этом положение этих параметров 

можно изменить для любых УГО после размещения на схеме. 

В варианте «П1» системные параметры для удобства были расположены 

справа от УГО (рис. 5.43, б), но опции Autoposition остались включенными. 

10. Сохранить изменения в УГО (Ctrl+S). 

Примечание. Проверку УГО можно осуществить с помощью команды 

Reports ⇒ Component Rule Check, но делать это имеет смысл при большом 

количестве выводов. Тогда рекомендуется проверять наличие пинов с одина-

ковыми номерами (duplicate pins), пинов с отсутствующими именами (miss-

ing pin name) и номерами (missing pin number), пропущенных пинов (missing 

pins in sequence). 

5.4. Библиотечный компонент 

На данном этапе файлы с посадочным местом и УГО дают возможность 

пользоваться вторым вариантом первого способа организации библиотек 

компонентов (см. п. 1.2 из 5.1). Следующий шаг к созданию интегрированной 

библиотеки – организация 1-го или 3-го варианта (см. п. 1.1 или 1.3 из 5.1). 

Рис. 5.43 

а б 
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Для этого необходимо выполнить следующее: 

1. Если библиотеки с посадочным местом и УГО были закрыты, то от-

крыть их командой File ⇒ Open (расположение файлов указано в п. 2 из 5.2.1 

и в п. 2 из 5.3.1). 

2. Подключить к УГО посадочное место: 

2.1. В рабочем поле перейти на вкладку с библиотекой УГО. 

Примечание. При наличии в библиотеке нескольких УГО для дальнейших 

действий требуется выбрать нужный в панели SCH Library. 

2.2. В области подключения моделей (см. рис. 5.33) нажать кнопку Add 

Footprint. Если кнопка имеет другое название, то необходимо нажать на об-

ласть с треугольником и из выпадающего списка выбрать опцию Footprint. 

2.3. В открывшемся окне PCB Model выполнить следующее: 

– в группе PCB Library выбрать опцию Library name; 

– в группе Footprint Model нажать кнопку Browse (рис. 5.44); 

 

– если список Libraries пустой, то нажать пиктограмму с тремя точками 

и в появившемся окне Available Libraries на вкладке Installed добавить тре-

буемую библиотеку посадочных мест с расширением «.PcbLib» по аналогии с 

п. 6 из 10.1. Результат в варианте «П1» показан на рис. 5.45; 

 Рис. 5.45 

Рис. 5.44 
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– в окне Browse Libraries в поле Libraries выбрать необходимую биб-

лиотеку, а в таблице ниже – требуемое посадочное место (рис. 5.46); 

– закрыть окна Browse Libraries и PCB Model кнопками OK. 

 

Примечания: 

– назначение вкладок окна Available Libraries приведено в п. 2 из Г.9; 

– опция Library name гарантирует, что посадочное место будет вы-

брано только из указанной библиотеки. Это отличает ее от опции Any, при 

которой посадочное место при совпадении наименований может быть ав-

томатически подключено и из другой доступной в данный момент библио-

теки посадочных мест; 

– при использовании опции Library path посадочное место будет выбра-

но только из библиотеки посадочных мест, расположенной по указанному 

пути. Это не всегда удобно, так как при изменении ее расположения потре-

буется заново указать к ней путь. При использовании этой опции не обяза-

тельно подключать библиотеку посадочных мест. Ее можно выбрать кноп-

кой Choose, а наименование посадочного места ввести в поле Name группы 

Footprint Model. 

2.4. Проконтролировать правильность установки связей между вывода-

ми УГО и КП в посадочном месте. Для этого щелкнуть ЛКМ или по КП в об-

ласти просмотра посадочных мест и 3D-моделей, или по пину в области раз-

работки УГО, или по соответствующей строке в панели SCH Library. 

Примечание. Переход между режимами просмотра в области про-

смотра посадочных мест и 3D-моделей осуществляется соответствующей 

пиктограммой (2D – переход в 2D-режим, 3D – переход в 3D-режим). 

Рис. 5.46 
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Например, в варианте «П1» на рис. 5.47 связи установлены правильно, 

так как первая КП, расположенная в посадочном месте слева под положи-

тельным выводом, соединена с первым пином, расположенным в УГО сверху 

около знака «+». 

Если связи установлены неправильно, то поменять их можно в окне 

Model Map, для вызова которого выполняется следующее: 

– осуществляется двойной щелчок ЛКМ по строке с посадочным местом 

в области подключения моделей (или ЛКМ выделяется строка с подключен-

ным посадочным местом в панели SCH Library и нажимается кнопка Edit); 

– в открывшемся окне PCB Mobel в группе Footprint Model нажимается 

кнопка Pin Map (см. рис. 5.46). 

С этого момента УГО с подключенным посадочным местом будет назы-

ваться компонентом. 

3. Отредактировать свойства компонента. 

3.1. По п. 9.1 из 5.3.3 открыть окно Library Component Properties. 

3.2. В разделе Parameters с помощью кнопки Add добавить девять поль-

зовательских параметров и присвоить им значения по табл. 5.2.  

Примечание. Префиксы CI_ (component information) и PI_ (package in-

formation) используются для удобства сортировки параметров. Значения 

параметров, для которых в таблице записан символ «*», будут редактиро-

ваться после добавления компонента на схему. 

Пример добавления параметра PartNumber показан на рис. 5.48. 

Рис. 5.47 
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Таблица 5.2 

Пользовательские параметры для конденсатора из варианта «П1» 

Параметр (Name) Значение (Value) Назначение 

CI_BOM * 
Для формирования перечня элементов (BOM – 

Bill of Materials) 

CI_Manufacturer Vishay Производитель 

CI_Temperature -55…+125 °С Рабочий диапазон температур 

CI_Tolerance * Допуск номинала 

CI_Value * Номинал 

CI_Voltage * Рабочее напряжение 

PartNumber * 
Уникальный номер, присваиваемый компоненту 

его производителем (пример приведен в В.2) 

PI_Mounting Style SMD Тип монтажа 

PI_Package Case C 
Типоразмер корпуса из варианта индивидуаль-

ного задания 

 

3.3. Сохранить в отчет изображение группы Parameters с параметрами. 

3.4. Внести корректировки в раздел Properties: 

– в поле Default Comment записать или выбрать из выпадающего списка 

«=CI_Value». В результате в этом системном параметре будет отображаться 

информация пользовательского параметра CI_Value; 

– в поле Description дать краткое описание компонента с указанием но-

мера варианта задания по аналогии с рис. 5.49, а. 

 Рис. 5.49 

а 

б 

Рис. 5.48 
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3.5. Скорректировать название компонента, для чего в разделе Library 

Link в поле Symbol Reference добавить к записанному тексту название ти-

поразмера корпуса и номер варианта задания по аналогии с рис. 5.49, б. 

3.6. Применить изменения в окне Library Component Properties, после 

чего сохранить в отчет рисунок УГО компонента. 

4. Сохранить изменения в компоненте (Ctrl+S). 

Примечания: 

– в результате была создана заготовка компонента. Таким образом за-

частую поступают с дискретными компонентами, которые имеют для од-

ного типоразмера корпуса много номиналов, при организации библиотек по 

первому и второму способам (см. пп. 1 и 2 из 5.1), тем самым уменьшая ко-

личество одинаковых УГО. В этом случае параметры компонентов конкре-

тизируют уже на схеме; 

– разработка компонентов под отдельные номиналы обычно произво-

дится или при наличии библиотеки в виде базы данных (см. п. 3 из 5.1), где 

можно указать их количество на складе, или при частом их использовании; 

– к одному УГО можно подключить несколько посадочных мест, но де-

лать это рекомендуется только в том случае, если один корпус допускает 

установку на ПП разными способами (см. рис. 12.67 и 19.37). Делать заго-

товку компонента для нескольких разных корпусов не стоит, так как чем 

больше параметров у компонента придется корректировать на схеме, тем 

больше вероятность допустить ошибку. 

5.5. Интегрированная библиотека 

Действия для создания интегрированной библиотеки: 

1. Создать проект интегрированной библиотеки. 

Для этого запустить команду File ⇒ New ⇒ Project и в открывшемся 

окне New Project (рис. 5.50, а): 

– в группе Project Types выбрать Integrated Library; 

– в поле Name присвоить имя библиотеке в виде Capacitors-ХХ, где 

вместо XX указать номер варианта; 

– отключить опцию Create Project Folder (в этом случае для проекта 

интегрированной библиотеки не будет создаваться отдельная папка); 

– в поле Location с помощью кнопки Browse Location указать папку с 

созданными файлами библиотек УГО и посадочного места (см. п. 2 из 5.2.1). 

Затем применить изменения кнопкой OK. 
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В результате в панели Projects появится группа с названием файла про-

екта интегрированной библиотеки и расширением «.LibPkg» (рис. 5.50, б), в 

которой не будет ни одного документа. 

2. В панели Projects перетащить зажатой ЛКМ библиотеки УГО и поса-

дочного места в группу проекта интегрированной библиотеки. 

Результат в варианте «П1» показан на рис. 5.51. 

Если библиотеки в панели отсутствуют, то 

выполнить следующее: 

– на названии проекта интегрированной биб-

лиотеки запустить команду ПКМ ⇒ Add Existing 

to Project (команда также доступна из меню Project); 

– в появившемся окне выбрать тип файлов All files (*.*); 

– выделить файлы с расширением «.PcbLib» и «.SchLib»;  

– нажать кнопку Открыть. 

3. Запустить команду Project ⇒ Project Options и в открывшемся окне 

на вкладке Options в поле Output Path удалить название последней папки по 

указанному пути вместе с бэкслешем, чтобы интегрированная библиотека 

сохранилась в папку с библиотеками УГО и посадочным местом (рис. 5.52). 

 Рис. 5.52 

Рис. 5.50 

а 

б 

Рис. 5.51 
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Примечание. На вкладке Error Reporting перечислены параметры, по 

которым осуществляется проверка интегрированной библиотеки и кото-

рым можно задать различные уровни серьезности. При проектировании по 

данному учебному пособию настройки этой вкладки не меняются. 

Применить настройки проекта кнопкой OK. 

4. Сохранить изменения в проекте, выполнив на нем в панели Projects 

команду ПКМ ⇒ Save Project. 

5. Скомпилировать проект интегрированной библиотеки, выполнив на 

нем команду ПКМ ⇒ Compile Integrated Library (команда также доступна 

из меню Project). 

В результате компиляции будет создан файл интегрированной библио-

теки с расширением «.IntLib», который автоматически добавится в список 

установленных библиотек и станет доступен в панели Libraries (см. Г.9). 

6. В панели Libraries выбрать инте-

грированную библиотеку, после чего со-

хранить изображение панели в отчет. На 

картинке должны быть видны показан-

ные на рис. 5.53 части панели. 

Примечание. Библиотека УГО бу-

дет также в списке доступных библио-

тек, так как она находится в текущем 

проекте. 

7. Удалить все библиотеки из спис-

ка установленных библиотек: 

– в верхней части панели Libraries 

нажать одноименную кнопку; 

– в открывшемся окне Available Li-

braries на вкладке Installed выбрать все 

библиотеки и нажать кнопку Remove; 

– закрыть окно Available Libraries 

кнопкой Close. 

8. В панели Projects закрыть проект, выполнив на нем команду ПКМ ⇒ 

Close Project. 

9. В проводнике Windows открыть папку, в которую производилось со-

хранение библиотек и файлов проекта, и удалить из нее все файлы и папки, 

кроме файла интегрированной библиотеки с расширением «.IntLib». 

Рис. 5.53 
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Следует обратить внимание на то, что иконки файлов интегрированной 

библиотеки и проекта интегрированной библиотеки совпадают. Поэтому 

необходимо дополнительно проконтролировать правильность удаления по 

описанию типа файла (рис. 5.54). 

5.6. Содержание отчета 

По 5-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Размеры корпуса конденсатора из варианта индивидуального задания, 

для которого разрабатывался библиотечный компонент. 

2. Размеры созданных КП с указанием причины различия в их форме. 

3. Значение координаты X для первой КП (расстояние от центра КП до 

короткой стороны корпуса конденсатора). 

4. Два рисунка посадочного места в 2D-режиме просмотра (один – при 

текущем слое M3 Top Assy, а другой – при текущем слое Top Layer). 

5. Рисунок посадочного места в 3D-режиме просмотра. 

6. Рисунок группы Parameters из окна свойств компонента со всеми до-

бавленными пользовательскими параметрами. 

7. Рисунок УГО после добавления и корректировок параметров. 

8. Изображение панели Libraries с выбранной интегрированной библио-

текой. 

 

 

 

Рис. 5.54 
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6. 3D-МОДЕЛЬ КОМПОНЕНТА 

6.1. Начальное окно КОМПАС-3D 

Для создания 3D-модели «усилителя» необходимы 3D-модели корпусов 

компонентов, размещаемых на ПП. В папке …\ИДРЭС\Модели элементов 

(см. рис. 2.9) находятся все используемые при проектировании 3D-модели, 

кроме корпуса танталового конденсатора с типоразмером, указанным в вари-

анте индивидуального задания на проектирование, для которого в разд. 5 был 

создан библиотечный компонент. 

В данном разделе разбирается пример создания недостающей 3D-модели 

в САПР КОМПАС-3D, начальное окно которой показано на рис. 6.1. 

 

Сверху располагаются пункты главного меню, под которым размещены 

ПИ с пиктограммами системных команд. В зависимости от настроек про-

граммы в начальном окне может присутствовать разное число ПИ в разном 

составе, например в виде заготовок без отображения или с неполным набо-

ром пиктограмм команд. Подключать и отключать ПИ можно командой 

Вид ⇒ Панели инструментов в любой момент. 

В левой части окна по умолчанию зарезервировано место для Компакт-

ной панели, которая представляет собой составную ПИ, состоящую из набо-

ра панелей. 

В середине окна располагается рабочее поле – область, в которой раз-

мещаются по мере надобности те или иные документы: эскиз, модель (дета-

ли, сборки), графический документ (чертеж, фрагмент) и др. В рабочем поле 

одновременно могут находиться разные документы, при этом они распола-

гаются либо в виде отдельных окон, либо в виде окон в полный размер рабо-

чего поля с вкладками в верхней его части. 

Рис. 6.1 

Компактная панель Панель свойств 

Строка сообщений 

Рабочее поле 
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Ниже рабочего поля зарезервировано место для Панели свойств, кото-

рая служит для управления параметрами активной в данный момент коман-

ды. 

Самая нижняя строка экрана – Строка сообщений, в которой выводится 

информация, помогающая правильно реагировать на запросы и сообщения 

системы, а также избегать ошибок при выполнении тех или иных действий, 

например: информация по текущему действию, выполняемому системой, или 

информация об элементе экрана, к которому подведен курсор мышки [43]. 

6.2. Настройки КОМПАС-3D 

Перед началом работы в КОМПАС-3D необходимо произвести настрой-

ку. Это можно сделать двумя способами: 

– задать все настройки вручную; 

– загрузить профиль с уже заданными настройками. 

Вручную настройки задаются в окне Параметры, которое вызывается 

командой Сервис ⇒ Параметры. 

Профили удобны для быстрого восстановления настроек, например по-

сле нештатных ситуаций в виде сбоя в работе программы или неудачного 

внесения изменений. Их можно разделить на две группы: 

– пользовательские, в которые можно сохранять настройки, заданные в 

любой момент работы; 

– стандартные, находящиеся в папке Profiles каталога, в котором уста-

новлена текущая версия КОМПАС-3D. Например, загрузка профиля mcad.pfl 

восстановит исходные настройки для машиностроительной конфигурации. 

Сохранение и загрузка профилей осуществляются командой Сервис ⇒ 

Профили, при этом доступны следующие группы настроек: 

– настройки рабочего окна (размеры окна и его вид, размещение и со-

став ПИ, настройки интерфейса и др.); 

– настройки параметров системы (все настройки, сделанные на вкладке 

Система окна Параметры); 

– настройки параметров новых документов (все настройки, сделанные 

на вкладке Новые документы окна Параметры). 

С целью экономии времени предлагается воспользоваться вторым спо-

собом, загрузив пользовательский профиль. Для этого следует выполнить 

указанную выше команду и в появившемся окне Профили пользователя, 

показанном на рис. 6.2, произвести следующие действия: 
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– в списке Профили выбрать пункт Другие и в появившемся окне ука-

зать профиль ИДРЭС-КОМПАС-3D.pfl, расположенный в папке …\ИДРЭС\ 

Профили (см. рис. 2.9); 

– в группе Использовать включить все опции и нажать Применить. 

В результате произойдут следующие изменения: 

– в окне Параметры применятся настройки, указанные в табл. 8.1; 

– внешний вид поменяется на стиль приложения Microsoft Office 2010 с 

цветовой схемой Dark (изменяется командой Сервис ⇒ Вид приложения); 

– на ПИ Вид в моделях отключится пиктограмма Упрощенное отобра-

жение; 

– на ПИ Режимы в моделях отключится пиктограмма Перспектива. 

Таблица 6.1 

Изменения в окне Параметры по профилю ИДРЭС-КОМПАС-3D.pfl 

Вкладка Группа Настройка 

Новые 

докумен-

ты 

Модель ⇒ Размеры ⇒ Надпись 
Шрифт – GOST type A 

Высота шрифта – 3.5 

Модель ⇒ Размеры ⇒ Допуски 

и предельные значения ⇒ Параметры 

Опция Предельные отклонения 

или значения в группе Отображать 

в надписи – отключена 

Модель ⇒ Размеры ⇒ Допуски  

и предельные значения ⇒ Допуски  

по умолчанию 

Опции в группе Назначать допуски 

в размерах – отключены 

Модель ⇒ Эскиз ⇒ Параметризация Опция Запретить все – включена 

Графический документ ⇒ Размеры ⇒ 

Допуски и предельные значения ⇒ 

Параметры 

Опция Предельные отклонения 

или значения в группе Отображать 

в надписи – отключена 

Графический документ ⇒ 

Размеры ⇒ Надпись 

Высота шрифта – 3.5 

Шаг строк – 5.5 

Рис. 6.2 
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Продолжение таблицы 6.1 

Вкладка Группа Настройка 

Новые 

докумен-

ты 

Графический документ ⇒ 

Размеры ⇒ Параметры 

Угол стрелки – 20 

Длина стрелки – 2.5 

Графический документ ⇒ 

Линия-выноска ⇒ Параметры 

Угол стрелки – 20 

Длина стрелки – 3.5 

Графический документ ⇒ Линия-

выноска ⇒ Текст над/под/за полкой 

Высота шрифта – 3.5 

Шаг строк – 5.5 

Графический документ ⇒ 

Линия-выноска ⇒ Наклонный текст 
Высота шрифта – 3.5 

Графический документ ⇒ 

Обозначения для машиностроения ⇒ 

Обозначение позиции ⇒ Параметры 

Угол стрелки – 20 

Длина стрелки – 2.5 

Графический документ ⇒ Обозначения 

для машиностроения ⇒ Обозначение 

позиции ⇒ Текст обозначения позиций 

Высота шрифта – 5.0 

Шаг строк – 8 

Графический документ ⇒ 

Обозначения для машиностроения ⇒ 

Отклонения формы и база 

Высота шрифта – 3.5 

Графический документ ⇒  

Обозначения для машиностроения ⇒ 

(Линия разреза/сечения ⇒ Параметры, 

Стрелка взгляда ⇒ Параметры) 

Высота шрифта – 7.00 

Длина штриха – 10.00 

Опция Курсив – включена 

Графический документ ⇒ 

(Текст на чертеже,  

Параметры таблицы (все подгруппы), 

Параметры документа ⇒  

Технические требования ⇒ Текст) 

Шаг строк – 5.5 

Высота шрифта – 3.5 (параметры 

шрифта по кнопке Шрифт) 

Графический документ ⇒ 

Параметры документа ⇒ Вид 

На вкладке Параметры включена 

опция Создавать ссылку на мас-

штаб вида в основной надписи 

Графический документ ⇒ 

Параметризация 

Опция Фиксировать размеры –  

отключена 

Система 

Графический редактор ⇒ Курсор Опция Округление – отключена 

Графический редактор ⇒ 

Системные линии 

Тонкая линия – 0.17 мм 

Основная линия – 0.5 мм 

Утолщенная линия – 0.75 мм 

Графический редактор ⇒ Привязки 
Опции По сетке и Только к види-

мым точкам сетки – включены 

Графический редактор ⇒ Виды 
Опция Отображать имена видов – 

включена 

Графический редактор ⇒ Сетка Шаг по оси X и Y – 0.1 мм 

Тип сетки – второй в первом ряду Редактор моделей ⇒ Сетка 
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Окончание таблицы 6.1 

Вкладка Группа Настройка 

Система 

Экран ⇒ Фон рабочего поля моделей 
Опция Использовать градиентный 

переход – отключена 

Экран ⇒ Настройка интерфейса ⇒ 
Панели инструментов 

Глобальные привязки – включено 

Настройки высоты шрифта, формы и размеров стрелок и других пара-

метров обозначений относятся по большей части к чертежам и соответствуют 

ГОСТ Р 2.109–2023, ГОСТ 2.303–68, ГОСТ 2.304–81, ГОСТ 2.305–2008 [44], 

ГОСТ 2.307–2011 [45], ГОСТ Р 2.308–2023 [46] и ГОСТ Р 2.316–2023. 

6.3. Основные понятия при создании 3D-моделей в КОМПАС-3D 

Эскиз – контур из основных линий, на основе которого образуется объ-

емный объект. Различают следующие виды контуров: 

– замкнутые (эскизу можно придать объем) – рис. 6.3, а, г, и; 

– разомкнутые (эскизу придать объем нельзя, но его можно использо-

вать как траекторию для перемещения других эскизов) – рис. 6.3, з. 

 Рис. 6.3 
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Фантом – изображение, временно появляющееся на экране при выпол-

нении какой-либо операции и показывающее текущее состояние создаваемых 

или редактируемых объектов (рис. 6.3, б, д, к). 

Основание – первый формообразующий элемент детали. Основание есть 

у любой детали, и оно всегда одно. Например, для детали на рис. 6.3, л осно-

ванием является эскиз с рис. 6.3, и. 

Деталь – 3D-модель (расширение «.m3d»), созданная с помощью одного 

действия (рис. 6.3, в, е, л) или комбинации нескольких действий (например, 

вращение, выдавливание, перемещение по направляющей и по сечениям со-

ответствующих эскизов). В целом процесс создания детали заключается в 

операциях над эскизами, которые могут создаваться как на произвольных 

плоскостях, так и на гранях уже созданных частей детали. 

Деталь на рис. 6.3, в можно было получить и двумя действиями: сначала 

выдавить эскиз с прямоугольным контуром, получив параллелепипед, а затем 

вырезать выдавливанием из него на всю толщину эскиз с круглым контуром.  

Элемент вращения – деталь или элемент детали, полученный методом 

вращения эскиза вокруг оси (рис. 6.3, е). 

Элемент выдавливания – деталь или элемент детали, полученный ме-

тодом выдавливания эскиза перпендикулярно плоскости эскиза (рис. 6.3, в). 

Элемент перемещения эскиза по направляющей – деталь или элемент 

детали, полученный методом перемещения эскиза по траектории (направля-

ющей). Например, деталь на рис. 6.3, л получена перемещением эскиза с 

рис. 6.3, и по эскизу с рис. 6.3, з, т. е. последний эскиз – траектория. 

Сборка – 3D-модель (расширение «.a3d»), объединяющая модели дета-

лей, подсборок и стандартных изделий, а также информацию о взаимном по-

ложении компонентов и связи между параметрами их элементов. Например, 

сборка на рис. 6.3, ж, полученная соединением деталей с рис. 6.3, в и е. 

Привязка – механизм, позволяющий точно задать положение курсора, 

выбрав условие его позиционирования (например, в узлах сетки, на пересе-

чении объектов и т. д.) [43]. 

6.4. Главное окно КОМПАС-3D в режиме создания детали 

Для перехода в режим создания детали необходимо выполнить команду 

Файл ⇒ Создать ⇒ Деталь. Главное окно КОМПАС-3D в этом режиме по-

казано на рис. 6.4. На рисунке в центре рабочего поля находится исходная 

система координат: 
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– ось X и перпендикулярная ей плоскость Z0Y – красные; 

– ось Y и перпендикулярная ей плоскость Z0X – зеленые; 

– ось Z и перпендикулярная ей плоскость X0Y – синие. 

 

Все элементы построения детали и составные части сборки отображают-

ся в Дереве модели, которое включается командой Вид ⇒ Дерево модели. 

В отличие от главного окна, приведенного на рис. 6.1, в этом окне рас-

крыты ПИ, для которых было зарезервировано место. 

6.5. Создание 3D-модели конденсатора 

Так как цель создания 3D-модели – использование ее для получения 

сборки «усилителя», то для автоматического расположения на поверхности 

(плоскости) монтажа ПП необходимо выполнить следующие условия: 

– 3D-модель должна создаваться в положительном направлении оси Z 

с учетом установки ее на плоскость ПП, лежащую параллельно плоскости 

X0Y (для определенности плоскости будут совпадать); 

– направление осей X и Y в плоскости X0Y должно совпадать с направ-

лением соответствующих осей координат в файле посадочного места; 

– в 3D-модели должна быть создана локальная система координат с 

именем MTG, а ее положение должно соответствовать положению начала 

координат в посадочном месте компонента. 

Рис. 6.4 
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На рис. 6.5 приведено посадочное 

место для конденсатора типоразмера C, 

созданное в 5.2. Также здесь показано 

направление осей в Altium Designer и по-

ложение начала координат относительно 

короткой стороны его корпуса в варианте 

«П1» (координата X из п. 7.6 из 5.2.3). 

3D-модель конденсатора будет пред-

ставлять собой деталь, созданную спо-

мощью комбинации нескольких действий и состоящую из двух функцио-

нальных частей: корпуса и выводов. Схематично процесс создания показан 

на рис. 6.6. 

 Рис. 6.6 
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Создание эскиза 
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корпуса 

Добавление метки поляр-
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Для создания 3D-модели корпуса конденсатора необходимо: 

1. Чтобы при добавлении 3D-модели в сборку у нее было уникальное 

имя, в Дереве модели выбрать ЛКМ первую строку, нажать клавишу F2 и 

заменить название Деталь на название посадочного места с номером вариан-

та через дефис (рис. 6.7). 

Примечание. Надпись вида (Тел-0) рядом с 

названием детали к ее имени не относится, при-

сутствует всегда и показывает число тел, из ко-

торых состоит 3D-модель. Так как на данном 

этапе ничего не нарисовано, то и тел пока нет. 

2. Сохранить 3D-модель командой Файл ⇒ Сохранить как с расшире-

нием «.m3d». Имя файла в варианте «П1» – CASE-C-293D-П1 (название бу-

дет предложено автоматически), а путь сохранения – …\ИДРЭС-П1\Усили-

тель\_Модели элементов (см. рис. 2.8). 

3. В Дереве модели раскрыть группу (т)Начало координат и выбрать 

Плоскость ZX, щелкнув по ней ЛКМ.  

Затем нажать пиктограмму Эскиз на ПИ Текущее состояние (рис. 6.8) 

или выполнить команду Операции ⇒ Эскиз. 

 

Примечания: 

– буква «т» в скобках перед названием группы «Начало координат» 

означает, что эта система координат текущая; 

– плоскость ZX можно было вы-

делить ЛКМ в рабочем поле, а команду 

«Эскиз» запустить из меню, появив-

шемся над курсором (рис. 6.9); 

– для масштабирования изобра-

жения используется колесо мышки или 

команды из меню Вид ⇒ Масштаб; 

Рис. 6.8 

Эскиз Привязки 

Сетка 

Параметры сетки 

Ортогональное черчение 

Управление слоями 

Текущий слой 

Параметрический режим (отключен) 

Рис. 6.7 

Рис. 6.9 
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– в отдельных случаях эскиз может не оказаться в плоскости экрана 

(например, если он был случайно повернут). Для возврата в исходное состоя-

ние служит команда ПКМ ⇒ Нормально к. 

4. Убедиться в том, что на ПИ Текущее состояние (рис. 6.8) включена 

пиктограмма Привязки. 

Эта пиктограмма подсветится также и на ПИ Глобальные привязки 

(рис. 6.10), которая предназначена для управления привязками курсора мыш-

ки (включенные привязки отображаются на оранжевом фоне). 

 

На данном этапе ПИ должна выглядеть так, как показано на рис. 6.10. 

Примечание. Подсказки появляются при наведении курсора мышки на 

пиктограммы, а также в «Строке сообщений» внизу экрана. 

5. На ПИ Текущее состояние (рис. 6.8) настроить сетку: 

– включить отображение сетки, щелкнув ЛКМ по соответствующей пик-

тограмме; 

– нажать на треугольник рядом с пиктограммой сетки (Параметры сет-

ки на рис. 6.8) и в выпадающем меню убедиться в том, что включена опция 

Отображать параметры (отображение видимого на экране шага сетки); 

– в этом же выпадающем меню выбрать опцию Настроить параметры 

и убедиться в том, что в настройках сетки на вкладке Параметры шаг сетки 

по осям X и Y равен 0.1 мм. 

Примечания:  

– включить отображение сетки также можно комбинацией клавиш 

Ctrl+G; 

– в ПИ «Текущее состояние» отображается значение видимого на 

экране шага сетки, которое зависит от масштаба изображения в рабочем 

поле (чем он меньше, тем крупнее шаг). Заданное значение шага в настрой-

ках на вкладке «Параметры» – минимальное значение. Шаг, с которым бу-

дет осуществляться ее прореживание, задается в настройках сетки на 

вкладке «Отрисовка». 

Рис. 6.10 
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6. На Компактной панели (рис. 6.11) активизировать панель Геомет-

рия, в результате чего в нижней ее части отобразятся характерные для вы-

бранной панели команды (в данном случае – для рисования).  

Примечание. Серый треугольник око-

ло пиктограммы означает, что в этой 

группе можно выбрать дополнительные 

команды. 

Например, если нажать ЛКМ на пик-

тограмму «Отрезок» и подержать не-

сколько секунд, то откроется дополни-

тельное меню (рис. 6.11), в котором на 

данный момент будет доступен вариант 

создания отрезка не только по двум точ-

кам, но и по двум точкам параллельно дру-

гому отрезку («Параллельный отрезок»). 

Последняя использованная команда из 

группы команд после ее использования 

остается в виде пиктограммы группы. 

7. Нарисовать контур продольного сечения корпуса конденсатора. 

На рис. 6.12 показано расположение будущей 3D-модели в текущем эс-

кизе (Эскиз:1) с указанием переменных с рис. 5.13. 

 Рис. 6.12 

Рис. 6.11 

П
ан

ел
и

 и
з 

со
ст

ав
а 

П
И

 

К
о
м

п
а
к

т
н

а
я

 п
а
н

ел
ь

 

Группа команд 

Отрезок 

Параллельный отрезок 

Поверхности 

Геометрия 

Редактирование  

детали 

Размеры 

Обозначения 

Редактирование 

Измерения (2D) 



 

 180 

Примечания: 

– в скобках приведены размеры для корпуса типоразмера С; 

– на рисунке ось Z направлена вниз, т. е. основание конденсатора будет 

сверху, а его верх – снизу. 

Последовательность действий для со-

здания контура: 

7.1. На ПИ Компактная панель ⇒ 

Геометрия в группе «Вспомогательная 

прямая» выбрать команду Горизонталь-

ная прямая (рис. 6.13). 

Затем щелчком ЛКМ установить 

прямую в точку начала координат в эскизе 

и завершить команду клавишей Esc. 

Примечание. При наведении курсора мышки на эту точку будет сраба-

тывать привязка «Ближайшая точка» с указанием об этом в сообщении под 

курсором (рис. 6.14). 

 

7.2. Из этой же группы команд (пиктограммой группы теперь будет ко-

манда «Горизонтальная прямая») выбрать команду Вертикальная прямая 

(рис. 6.13).  

Затем снова установить прямую в точку начала координат (рис. 6.15), 

после чего завершить команду клавишей Esc. 

7.3. Из этой же группы команд (пиктограммой группы теперь будет ко-

манда «Вертикальная прямая») выбрать команду Параллельная прямая (см. 

Рис. 6.14 
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рис. 6.13) и провести параллельную прямую на 

расстоянии H от уже размещенной горизонталь-

ной прямой в отрицательном направлении оси Y, 

для чего проделать следующие действия: 

– в рабочем поле щелкнуть ЛКМ по горизон-

тальной прямой; 

– в Панели свойств в поле Расстояние 

(рис. 6.16) ввести значение размера H по рис. 5.13 

(высота корпуса) и нажать клавишу Enter. 

Примечание. В варианте «П1» значение размера равно 2,5 мм; 

 

– убедиться в том, что в Панели свойств активна пиктограмма Две 

прямые; 

– в Панели свойств с помощью пиктограммы Следующий объект (или 

Предыдущий объект) выбрать в рабочем поле нижнюю из двух параллель-

ных прямых, после чего нажать пиктограмму Создать объект.  

Примечание. Выбор нужного варианта прямой можно осуществлять в 

рабочем поле щелчком по нему ЛКМ; 

– в Панели свойств нажать пикограмму Ука-

зать заново для использования команды без повтор-

ного запуска ее из ПИ. 

Результат в варианте «П1» на данном этапе по-

казан на рис. 6.17. 

7.4. При необходимости переместить изображе-

ние в рабочем поле. Для этого запустить команду 

Вид ⇒ Сдвинуть или зажать ЛКМ и клавиши Ctrl и Shift. 

7.5. В соответствии с п. 7.3 добавить еще две прямые, параллельные го-

ризонтальной прямой, проходящей через начало координат, на расстояниях 

0,2 мм и Th в отрицательном направлении оси Y. 

Рис. 6.16 

Панель свойств 
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(следующий) объект Указать заново 

Создать объект Две прямые Прервать команду 

Рис. 6.15 

Рис. 6.17 
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7.6. В соответствии с п. 7.3 добавить три прямые, параллельные верти-

кальной прямой, проходящей через начало координат, на расстояниях P, L/2 

и L в положительном направлении оси X. 

После этого завершить команду клавишей Esc. 

Примечание. Завершение команд также можно осуществлять пикто-

граммой «Прервать команду» из «Панели свойств» (рис. 6.16). 

Результат на данном этапе в варианте «П1» показан на рис. 6.18. 

 

7.7. Нарисовать левую половину контура продольного сечения конден-

сатора (рис. 6.19) командой Отрезок (ПИ Компактная панель ⇒ Геомет-

рия), при этом убедиться в том, что в Панели свойств нажата пиктограмма 

Автосоздание объекта и установлен стиль линии Основная. 

 

Численные значения углов наклона боковых плоскостей и размеры ниж-

него выступа в корпусе конденсатора между его выводами (Glue Pad) в до-

Рис. 6.18 

Рис. 6.19 
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кументации не указаны, поэтому их следует нарисовать примерно похожими 

на приведенные на рис. 5.13 и 6.19. 

После создания отрезков для завершения команды нажать пиктограмму 

Прервать команду на Панели свойств (или клавишу Esc). 

Примечание. Менять параметры объекта можно в «Панели свойств» 

как в процессе рисования, так и уже после его создания. Для запуска режима 

редактирования следует дважды щелкнуть по объекту ЛКМ (или щелкнуть 

по нему ЛКМ, а затем выполнить команду ПКМ ⇒ Редактировать).  

Другой способ редактирования объекта – щелкнуть по нему ЛКМ, а за-

тем тянуть за характерные точки (черные квадраты и ромбы). 

Полезными при создании контура могут быть 

следующие команды: 

– «Ортогональное черчение» (ПИ «Текущее Со-

стояние») – рисование только под углом к оси коор-

динат, кратным 90º (см. рис. 6.8); 

– «Сдвиг» (ПИ Компактная панель ⇒ Редакти-

рование) – перемещение выделенных объектов отно-

сительно указанной точки (рис. 6.20); 

– «Усечь кривую» (ПИ Компактная панель ⇒ 

Редактирование) – удаление участка кривой между 

двумя объектами (рис. 6.20); 

– «Удлинить до ближайшего объекта» (ПИ 

Компактная панель ⇒ Редактирование) – удлинение участка кривой до пе-

ресечения с ближайшим объектом (рис. 6.20). 

7.8. Создать правую половину контура зеркальным копированием левой: 

– массовым выделением мышкой слева направо выделить нарисованные 

отрезки; 

– запустить команду Симметрия из ПИ Компактная панель ⇒ Редак-

тирование (рис. 6.20); 

– убедиться в том, что в Панели свойств на вкладке Симметрия вклю-

чен режим Оставлять исходные объекты; 

– последовательно указать щелчками ЛКМ две точки в любом месте на 

вертикальной прямой, расположенной на расстоянии L/2 от вертикальной 

прямой, проходящей через начало координат (она будет осью симметрии); 

– завершить команду нажатием клавиши Esc. 

Результат создания контура в варианте «П1» показан на рис. 6.21. 

Рис. 6.20 
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8. Проверить замкнутость контура и отсутствие наложения элементов 

друг на друга с помощью подключаемых библиотек: 

8.1. Для проверки отсутствия наложений выполнить следующее: 

– запустить команду Сервис ⇒ Менеджер библиотек; 

– в появившемся внизу экрана окне Менеджер библиотек открыть пап-

ку Прочие и поставить галочку рядом с пунктом Проверка документа; 

– на вкладке Проверка документа дважды щелкнуть ЛКМ по пункту 

Проверка наложения элементов; 

– в открывшемся окне включить опции Все и Анализировать частич-

ные перекрытия. Затем нажать OK и следовать указаниям системы до пол-

ного удаления всех перекрытий. 

8.2. Для проверки замкнутости контура выполнить следующее: 

– в окне Менеджер библиотек перейти на вкладку Библиотеки 

КОМПАС и в папке Прочие поставить галочку рядом с пунктом Сервисные 

инструменты. В результате появятся ПИ Сервисные инструменты (рис. 

6.22) и вкладка Сервисные инструменты в окне Менеджер библиотек; 

 

– на ПИ Сервисные инструменты ⇒ Операции с контурами нажать 

пиктограмму Проверка замкнутости для всех объектов (рис. 6.22); 

Рис. 6.21 
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– если контур в каких-то местах разомкнут, то система предложит оста-

вить вспомогательные точки (в этом случае нажать Да); 

– отмеченные места исправить вручную. 

9. Выйти из режима редактирования эскиза одним из способов: 

– отжать пиктограмму Эскиз на ПИ Текущее состояние (см. рис. 6.8); 

– в рабочем поле выполнить команду ПКМ ⇒ Эскиз; 

– нажать на иконку режима эскиза в правом верхнем углу рабочего поля 

(см. рис. 6.14). 

10. Если объекту в Дереве модели требуется изменить наименование, то 

на нем необходимо запустить команду ПКМ ⇒ Свойства и в Панели 

свойств ввести его в поле Наименование.  

Примечание. Также изменить наименование можно прямо в «Дереве 

модели», дважды щелкнув по объекту ЛКМ. 

11. Если эскиз требуется отредактировать, то в Дереве модели на нем 

необходимо запустить команду ПКМ ⇒ Редактировать. 

Примечание. Аналогично можно скорректировать любой этап создания 

модели (эскиз, операцию выдавливания и т. д.). 

12. Сохранить 3D-модель (Ctrl+S), после чего убедиться в том, что со-

хранение произведено успешно. Для этого проверить обновление даты изме-

нения файла в папке сохранения 3D-модели (см. п. 2), а также наличие в этой 

папке файла с расширением «.bak» (backup-файл). 

Примечание. Сохранять файлы рекомендуется регулярно, во избежание 

потери информации при нештатных ситуациях. 

13. Чтобы оси и дополнительные плоскости (группа Начало координат) 

в дальнейших действиях не мешались их следует скрыть. 

Для этого в Дереве модели на требуемом объекте выполнить команду 

ПКМ ⇒ Скрыть. 

14. Придать объем корпусу конденсатора: 

– в Дереве модели выбрать ЛКМ Эскиз:1; 

– запустить команду Операция выдавливания 

из ПИ Компактная панель ⇒ Редактирование де-

тали (рис. 6.23); 

– в Панели свойств на вкладке Параметры в списке Направление вы-

брать Средняя плоскость, а в поле Расстояние 1 ввести значение размера W 

по рис. 5.13 (ширина корпуса) и нажать клавишу Enter. 

Примечание. В варианте «П1» значение размера равно 3,2 мм; 

Рис. 6.23 
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– в Панели свойств на вкладке 

Свойства установить: Назначить Цвет – 

Вручную; Цвет – Серый 80% (рис. 6.24); 

– в Панели свойств нажать пикто-

грамму Создать объект. 

В результате в Дереве модели по-

явится Операция выдавливания:1. 

15. Создать эскиз с замкнутыми кон-

турами для придания формы боковым сто-

ронам в поперечном сечении корпуса: 

15.1. Чтобы наклон боковых сторон совпадал в поперечном и продоль-

ном сечениях, выполнить следующее: 

– войти в режим редактирования эскиза Эскиз:1; 

– с зажатой клавишей Ctrl выделить ЛКМ два наклонных отрезка с ле-

вой стороны контура и скопировать их (Ctrl+C), указав в качестве базы точ-

ку на конце одного из отрезков, показанную на рис. 6.25, а; 

 

– выйти из режима редактирования эскиза Эскиз:1; 

– в Дереве модели выбрать ЛКМ плоскость ZY и создать новый эскиз 

(Эскиз:2); 

– нажать комбинацию клавиш Ctrl+V (вставить); 

– на ПИ Глобальные привязки раскрыть группу Локальные привязки 

и выбрать Ближайшая точка (или в рабочем поле выполнить команду 

ПКМ ⇒ Привязка ⇒ Ближайшая точка); 

Рис. 6.25 

а б 
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– указать ЛКМ в качестве базы точку, показанную на рис. 6.25, б, и 

нажать клавишу Esc для завершения вставки. 

Примечание. Локальная привязка обладает большим приоритетом, чем 

любая глобальная, т. е. она позволяет в данный момент использовать толь-

ко выбранную привязку без необходимости подключения или отключения 

глобальных привязок. Так, при вставке отрезков их необходимо было привя-

зать к конкретной точке. Наличие же большого числа активных глобальных 

привязок могло этому помешать. Локальная привязка действует однократ-

но, т. е. после завершения операции она автоматически отключается, и 

снова начинают действовать глобальные привязки; 

– включить режим Ортогональное черчение, для чего нажать либо со-

ответствующую пиктограмму на ПИ Текущее Состояние (см. рис. 6.8), либо 

клавишу F8; 

– выделить вставленные отрезки и запустить команду Поворот из ПИ 

Компактная панель ⇒ Редактирование (см. рис. 6.20); 

– убедиться в том, что в Панели свойств на вкладке Поворот включен 

режим Удалять исходные объекты; 

– в рабочем поле указать ЛКМ сначала точку центра поворота (точка, за 

которую были вставлены отрезки), а затем базовую точку на конце нижнего 

отрезка; 

– повернуть выделенные отрезки по часовой стрелке на 90°, передвинув 

курсор мышки влево (рис. 6.26, а), и зафиксировать их щелчком ЛКМ; 

– завершить команду нажатием клавиши Esc; 

 Рис. 6.26 

а б 

Точка центра 

поворота 

Базовая точка 

Фантом 

Фантом 

Базовая 

точка 



 

 188 

– отключить режим Ортогональное черчение; 

– снять выделение с отрезков, а затем выделить только правый из них; 

– запустить команду Сдвиг из ПИ Компактная панель ⇒ Редактиро-

вание (см. рис. 6.20); 

– указать ЛКМ базовую точку на левом конце выделенного отрезка, а за-

тем щелкнуть ЛКМ на правом конце невыделенного отрезка (рис. 6.26, б); 

– завершить команду нажатием клавиши Esc. 

Примечание. Временное включение режима «Ортогональное черчение» 

доступно с помощью зажатой клавиши Shift. 

15.2. Завершить создание замкнутых контуров, для чего выполнить сле-

дующие действия: 

– командой Отрезок закончить верхний контур (рис. 6.27); 

– выделить нарисованный контур; 

– включить режим Ортогональное черчение; 

– запустить команду Симметрия (см. рис. 6.20); 

 

 

Рис. 6.27 
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– убедиться в том, что в Панели свойств включена пиктограмма 

Оставлять исходные объекты; 

– в качестве 1-й точки указать ЛКМ точку начала координат. Вторую 

точку указать в любом месте слева или справа от 1-й так, чтобы пунктирная 

линия, показывающая ось симметрии, была горизонтальна; 

– завершить команду клавишей Esc (см. рис. 6.28); 

– отключить режим Ортогональное черчение. 

16. Придать форму боковым сторонам корпуса конденсатора: 

– выйти из режима редактирования эскиза Эскиз:2; 

– в Дереве модели выбрать ЛКМ Эскиз:2; 

– запустить команду Вырезать выдавливанием 

на ПИ Компактная панель ⇒ Редактирование де-

тали (рис. 6.29); 

– при появлении ошибки выполнения команды проверить Эскиз:2 по 

пп. 8.1 и 8.2, после чего повторить команду вырезания эскиза; 

– в Панели свойств на вкладке Параметры в списке Направление вы-

брать направление фантома в сторону корпуса, в поле Расстояние 1 ввести 

значение размера L по рис. 5.13 (длина корпуса) и нажать клавишу Enter. 

Примечание. В варианте «П1» значение размера равно 6 мм; 

– в Панели свойств на вкладке Свойства установить: Назначить цвет – 

Вручную; Цвет – Серый 80% (см. рис. 6.24); 

– в Панели свойств нажать пиктограмму Создать объект. 

17. Для завершения корпуса конденсатора добавить метку полярности 

как на рис. 5.12, а, для чего выполнить следующее: 

– в рабочем поле ЛКМ нажать на верхнюю поверхность корпуса конден-

сатора, тем самым выделив ее (рис. 6.30, а); 

– на выделенной поверхности создать новый эскиз (Эскиз:3); 

– запустить команду Прямоугольник (ПИ Компактная панель ⇒ Гео-

метрия) и в рабочем поле со стороны начала координат указать начальную и 

конечную точки (рис. 6.30, б) прямоугольного контура. Контур не должен ка-

саться границ поверхности, на которой был создан эскиз, а по ширине не 

должен быть больше четверти длины корпуса конденсатора; 

– выйти из режима редактирования эскиза Эскиз:3; 

– в Дереве модели выбрать ЛКМ созданный эскиз; 

– запустить команду Вырезать выдавливанием (ПИ Компактная па-

нель ⇒ Редактирование детали); 

Рис. 6.29 
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– в Панели свойств на вкладке Параметры в списке Направление вы-

брать направление фантома внутрь корпуса и в поле Расстояние 1 ввести 

глубину вырезания 0.01; 

– в Панели свойств на вкладке Свойства установить: Назначить цвет – 

Вручную; Цвет – Белый; 

– в Панели свойств нажать пиктограмму Создать объект. 

18. Создать первый вывод конденсатора, который будет получен пере-

мещением эскиза с контуром его поперечного сечения вдоль эскиза с траек-

торией: 

18.1. Для создания эскиза с траекторией выполнить следующее: 

– войти в режим редактирования эскиза с контуром продольного сечения 

корпуса конденсатора (Эскиз:1); 

– с зажатой клавишей Ctrl выделить ЛКМ четыре 

прямые, показанные на рис. 6.31; 

– скопировать выделенные прямые (Ctrl+C), ука-

зав в качестве базы точку начала координат; 

– выйти из режима редактирования эскиза Эс-

киз:1; 

– в Дереве модели выбрать ЛКМ плоскость ZX; 

– на выделенной плоскости создать новый эскиз (Эскиз:4); 

– вставить скопированные прямые (Ctrl+V), указав в качестве базы точ-

ку начала координат (рис. 6.32, а), и завершить вставку клавишей Esc; 

Рис. 6.30 

а б 

Рис. 6.31 
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– командой Отрезок нарисовать три отрезка внутри прямоугольного 

контура, образованного скопированными прямыми, на расстоянии 0,1 мм от 

его границ в соответствии с рис. 6.32, б; 

– запустить команду Скругление (ПИ Компактная панель ⇒ Геомет-

рия); 

– в Панели свойств в поле Радиус ввести 0,2 мм; 

– в рабочем поле ЛКМ последовательно указать отрезки с общими точ-

ками для создания между ними двух скруглений (рис. 6.32, в); 

– завершить команду клавишей Esc; 

– выйти из режима редактирования эскиза. 

18.2. Повернуть 3D-модель так, чтобы была видна нижняя его сторона. 

Это можно сделать одним из следующих способов: 

– командой Вид ⇒ Повернуть; 

– пиктограммой Повернуть (рис. 6.33) на ПИ Вид; 

– зажатой средней кнопкой мышки (СКМ). 

18.3. Для создания эскиза с контуром поперечного сечения вывода вы-

полнить следующее: 

– запустить команду Плоскость через вершину перпендикулярно 

ребру из группы «Смещенная плоскость» на ПИ Компактная панель ⇒ 

Вспомогательная геометрия (рис. 6.34, а); 

– в рабочем поле щелкнуть ЛКМ на открытом конце длинного отрезка 

из эскиза с траекторией (около курсора появится звездочка – рис. 6.34, б), а 

затем по самому отрезку (около курсора появится кривая – рис. 6.34, в); 

– завершить команду клавишей Esc; 

– в Дереве модели выбрать ЛКМ Перпендикулярная плоскость:1; 

– на выделенной плоскости создать новый эскиз (Эскиз:5); 

– запустить команду Прямоугольник; 

Рис. 6.32 

а б в 

Повернуть 
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– в Панели свойств включить опцию По центру и вершине; 

– в рабочем поле в качестве центральной точки прямоугольника указать 

точку начала координат в эскизе; 

– в Панели свойств в поле Высота ввести 0,2 мм, а в поле Ширина – 

значение размера Tw по рис. 5.13 (ширина вывода) и нажать клавишу Enter. 

Примечание. В варианте «П1» значение размера равно 2.2 мм. 

Результат в варианте «П1» показан на рис. 6.35, а; 

 

– завершить команду клавишей Esc; 

– выйти из режима редактирования эскиза Эскиз:5; 

– скрыть объект Перпендикулярная плоскость:1. 

Результат на данном этапе показан на рис. 6.35, б. 

18.4. Создать вывод конденсатора, запустив команду 

Кинематическая операция из группы «Операция выдав-

ливания» на ПИ Компактная панель ⇒ Редактирование 

детали (рис. 6.36). 

Затем выполнить следующие действия: 

– в Панели свойств на вкладке Параметры убедиться в том, что вклю-

чена пиктограмма Сечение; 

Рис. 6.35 
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– в Дереве модели выбрать ЛКМ эскиз с поперечным сечением вывода 

конденсатора (последний созданный эскиз – Эскиз:5). После этого в рабочем 

поле он подсветится красным цветом; 

– в Панели свойств на вкладке Параметры убедиться в том, что вклю-

чилась пиктограмма Траектория; 

– в Дереве модели выбрать ЛКМ эскиз с тра-

екторией для перемещения поперечного сечения 

вывода (предпоследний созданный эскиз – Эс-

киз:4). После этого в рабочем поле он подсветится 

оранжевым цветом, а также появится фантом вы-

вода конденсатора (рис. 6.37); 

– в Панели свойств на вкладке Свойства вы-

брать: Назначить Цвет – Вручную; Цвет – Серый 

25%; 

– в Панели свойств нажать пиктограмму Создать объект; 

– в Дереве модели скрыть эскизы Эскиз:4 и Эскиз:5, если они не скры-

лись автоматически. 

19. Так как второй вывод конденсатора располагается с другой стороны 

корпуса и симметричен первому, то его можно создать в виде зеркальной ко-

пии: 

19.1. Добавить плоскость симметрии, относительно которой будет со-

здана зеркальная копия вывода: 

– в Дереве модели выбрать ЛКМ плоскость ZY; 

– запустить команду Смещенная плоскость (см. рис. 6.34) из группы 

«Плоскость через вершину пепендикулярно ребру» на ПИ Компактная па-

нель ⇒ Вспомогательная геометрия; 

– в Панели свойств в поле Расстояние ввести значение половины раз-

мера L по рис. 5.13 (половина длины 

корпуса) и нажать клавишу Enter. 

Примечание. В варианте «П1» 

значение размера равно 3 мм; 

– в Панели свойств установить 

такое направление смещения, чтобы 

фантом создаваемой плоскости прохо-

дил через 3D-модель. Результат на дан-

ном этапе показан на рис. 6.38; 

Рис. 6.37 

Рис. 6.38 

Исходная плоскость 

(Плоскость ZY) 

Создаваемая 

плоскость  
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– в Панели свойств нажать пиктограмму Создать объект, а затем – 

Прервать команду. 

19.2. Для создания зеркальной копии первого вывода необходимо: 

– запустить команду Зеркальный массив (рис. 6.39) из ПИ Компакт-

ная панель ⇒ Массивы; 

– в Дереве модели выбрать ЛКМ объект Кинема-

тическая операция:1 (1-й вывод конденсатора). В ре-

зультате он добавится в Список объектов на Панели свойств, а в рабочем 

поле окрасится в красный цвет; 

– в Панели свойств включить 

пиктограмму Плоскость симметрии; 

– в Дереве модели выбрать ЛКМ 

объект Смещенная плоскость:1. В ре-

зультате в рабочем поле указанная 

плоскость окрасится в оранжевый цвет, 

а также появится фантом зеркальной 

копии 1-го вывода (рис. 6.40); 

– в Панели свойств на вкладке Свойства в поле Назначить Цвет вы-

брать По источнику. В результате цветовые настройки зеркальной копии 

будут скопированы из настроек, заданных для 1-го вывода; 

– в Панели свойств нажать пиктограмму Создать объект; 

– скрыть объект Смещенная плоскость:1. 

20. Добавить номер варианта задания на верхнюю поверхность корпуса 

конденсатора, отредактировав ранее созданный эскиз: 

– в Дереве модели найти эскиз с нарисованным прямоугольником, обо-

значающим полярность (см. рис. 6.30, б). В данном случае – Эскиз:3. 

Примечание. При выделении объекта в «Дереве модели» он подсвечива-

ется зеленым цветом в рабочем поле; 

– в Дереве модели присвоить эскизу и соответствующей операции вы-

резания наименование «Полярность и вариант X», где вместо «X» указать 

номер варианта задания; 

– войти в режим редактирования переименованного эскиза; 

– запустить команду Ввод текста (рис. 6.41) из ПИ Компактная па-

нель ⇒ Обозначения; 

– в Панели свойств на вкладке Размещение за-

дать: Размещение – По центру; Угол – 0; 

Рис. 6.39 

Зеркальный 

массив 

Рис. 6.40 

Первый вывод 

Плоскость симметрии  

Фантом 

зеркальной 

копии 

Рис. 6.41 

Ввод текста 
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– в рабочем поле указать ЛКМ место размещения текста в эскизе; 

– в Панели свойств на вкладке Формат задать: Шрифт – GOST type B; 

высота символов – 1.4; Курсив и Полужирный – отключить; 

– в рабочем поле ввести номер варианта задания (при необходимости 

изменить высоту символов в Панели свойств, выделив введенный текст); 

– в Панели свойств нажать пиктограмму Создать объект и завершить 

команду клавишей Esc; 

– при необходимости выделить надпись и отредактировать ее положение 

командой Сдвиг (ПИ Компактная панель ⇒ Редактирование); 

– выйти из режима редактирования эскиза. 

Результат показан на рис. 6.42. 

21. Для добавления локальной си-

стемы координат, положение которой 

должно соответствовать положению точ-

ки привязки в посадочном месте компо-

нента, выполнить следующее: 

– запустить команду Операции ⇒ 

Локальная система координат; 

– в Панели свойств на вкладке Параметры в поле для координаты X 

ввести значение расстояния между центром первой КП и короткой стороной 

корпуса конденсатора в его посадочном месте, определенное в п. 7.6 из 5.2.3. 

Если начало координат в посадочном месте было установлено в центре 

корпуса, то вводимое значение будет равно половине размера L по рис. 5.13.  

Примечание. Для варианта «П1» значение равно 0,5 мм (см. рис. 6.5). 

– в Панели свойств на вкладке Свойства в поле Наименование ввести 

MTG; 

– в Панели свойств нажать пиктограмму Создать объект. 

22. Для автоматического расчета массы сборок, в состав которых будет 

входить 3D-модель конденсатора, необходимо задать ее массу. Для этого вы-

полнить следующее: 

Таблица 6.2 

Масса разных типоразмеров конденсаторов серии 293D фирмы Vishay 

Типоразмер Масса, г Типоразмер Масса, г 

A 0,032 D 0,295 

B 0,065 E 0,478 

C 0,150 V 0,239 

Рис. 6.42 
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– в Дереве модели на названии 3D-модели (1-я строка) запустить ко-

манду ПКМ ⇒ Свойства модели; 

– в Панели свойств на вкладке Параметры МЦХ нажать пиктограмму 

Расчет по массе, в поле Масса ввести массу для соответствующего типораз-

мера корпуса из табл. 6.2 и нажать Enter; 

– в Панели свойств нажать пиктограмму Создать объект. 

23. Сохранить изменения в 3D-модели (Ctrl+S). 

Результат проделанных операций показан на рис. 6.43. 

6.6. 3D-модель в посадочном месте компонента 

Для добавления 3D-модели конденсатора к посадочному месту библио-

течного компонента необходимо выполнить следующее: 

1. Сохранить созданную 3D-модель в формате STEP. 

Для этого в КОМПАС-3D запустить команду Файл ⇒ Сохранить как и 

в появившемся окне: 

– в поле Тип файла выбрать формат STEP AP214 (*.stp, *.step); 

– нажать на треугольник около кнопки Сохранить и выбрать команду 

Сохранить с параметрами; 

– в открывшемся окне Параметры экспорта STEP AP214 в поле Си-

стема координат выбрать локальную систему координат – MTG, после чего 

закрыть окно кнопкой OK; 

Рис. 6.43 
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– в появившемся окне Запись файла формата STEP AP214 оставить 

настройки по умолчанию и нажать кнопку Начать запись. 

2. Последним действием после создания библиотечного компонента в 

п. 9 из 5.5 было удаление всех файлов из папки с библиотекой, кроме файла 

интегрированной библиотеки. Это понадобилось, чтобы показать последова-

тельность действий для редактирования такого файла: 

– в Altium Designer командой File ⇒ Open открыть файл интегрирован-

ной библиотеки (расположение указано в п. 2 из 5.2.1); 

– в появившемся окне Extract Sources or Install нажать кнопку Extract 

Sources (рис. 6.44, а). 

 

В результате на вкладке Projects появится проект интегрированной биб-

лиотеки с включенными в него двумя библиотеками (как на рис. 5.51), а в 

папке с интегрированной библиотекой будет создана папка с файлами распа-

кованных библиотек (рис. 6.44, б). 

Примечание. Если бы проект не был удален ранее, то для его открытия 

необходимо было бы воспользоваться командой File ⇒ Open Project. 

3. Сохранить проект интегрированной библиотеки в папку с библиоте-

ками УГО и посадочного места (см. п. 4 из 5.5). 

4. Открыть библиотеку посадочных мест. 

Для этого дважды щелкнуть ЛКМ по ней в панели Projects (или выпол-

нить на ней команду ПКМ ⇒ Open). 

5. Добавить к посадочному месту 3D-модель: 

5.1. Сделать текущим слой M5 Top 3D. 

5.2. Последовательно нажать клавиши P ⇒ B или запустить команду 

Place ⇒ 3D Body. 

Рис. 6.44 

а 

б 
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5.3. В открывшемся окне 3D Body: 

– в группе 3D Model Type выбрать опцию Generic 3D Model; 

– убедиться в том, что в группе Properties в поле Body Side выбрана оп-

ция Top Side (размещение на верхней стороне ПП), а в поле Layer указан 

слой M5 Top 3D; 

– в группе Generic 3D Model выбрать опцию Embedded (встраивание 

модели в состав посадочного места), после чего кнопкой Load from file под-

ключить сохраненную в п. 1 3D-модель в формате STEP. 

Примечание. Как видно по рис. 6.45, в 2D-режиме просмотра 3D-модель 

представляет собой заштрихованную прямоугольную область, размеры ко-

торой соответствуют габаритам модели. При желании можно включить 

3D-режим просмотра, нажав на соответствующую иконку. 

 

После совершенных в окне 3D Body действий нажать кнопку OK. 

5.4. Разместить 3D-модель на посадочном месте. 

Так как 3D-модель была создана с учетом условий из 6.5, то для пра-

вильного ее размещения достаточно совместить точку, за которую 3D-модель 

привязана к курсору мышки (начало локальной системы координат MTG), с 

началом координат в рабочем поле. 

Сделать это можно одним из следующих способов: 

– увеличить масштаб изображения в рабочем поле, после чего щелкнуть 

ЛКМ в начале координат; 

– задать крупный шаг сетки (например, 1 мм), после чего щелкнуть ЛКМ 

в начале координат; 

– сначала последовательно нажать клавиши J ⇒ L, затем в появившемся 

окне задать требуемые координаты точки, в которую будет перемещен кур-

сор мышки (в данном случае – нулевые), после чего дважды нажать клавишу 

Рис. 6.45 
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Enter (первое нажатие применит изменения в окне с координатами, а второе 

нажатие зафиксирует 3D-модель в рабочем поле); 

– сначала нажать комбинацию кла-

виш Shift+E, чтобы в строке состояний 

(или в информационном поле) появи-

лась надпись Hotspot Snap (All Layers), 

т. е. включить привязку курсора мышки 

к характерным точкам объектов на всех 

слоях (рис. 6.46). Затем подвести курсор 

мышки к центру первой КП (при сраба-

тывании привязки появится окружность) 

и щелкнуть ЛКМ. 

После добавления 3D-модели автоматически откроется окно 3D Body, 

которое нужно закрыть кнопкой Cancel, так как других 3D-моделей разме-

щать в посадочном месте не нужно. 

Примечание. Если 3D-модель была сделана без учета условий из 6.5 

(например, скачана из сети Интернет), то для ее размещения на посадочном 

месте потребуется потратить больше времени: 

– в окне 3D Body в группе Generic 3D Model (см. рис. 6.45) можно повер-

нуть 3D-модель по любой оси на любой угол (поля Rotation), а также изме-

нить ее положение относительно поверхности ПП (поле Standoff Height). 

Данное окно открывается в 3D-режиме просмотра двойным щелчком ЛКМ 

по 3D-модели, а в 2D-режиме просмотра – командой ПКМ ⇒ Properties; 

– поворот 3D-модели в плоскости ПП как в 2D-режиме просмотра, так 

и в 3D-режиме после ее выбора ЛКМ возможен клавишей Space или комби-

нацией клавиш Shift+Space; 

– в окне 3D Body в группе Snap Points 

(рис. 6.47) можно задать собственные харак-

терные точки в 3D-модели (точка с нулевыми 

координатами находится в месте расположения 

системы координат 3D-модели). Кнопка Average 

позволяет заменить две выбранные характерные 

точки одной, расположенной в середине между 

ними.  Каждая характерная точка обозначается тремя белыми отрезками; 

– в 3D-режиме просмотра можно воспользоваться командами из меню 

Tools ⇒ 3D Body Placement (рис. 6.48). Например, команда Add Snap Points 

Рис. 6.46 

Рис. 6.47 
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From Vertices позволяет вручную указать ха-

рактерные точки на 3D-модели, команда Posi-

tion 3D Body – переместить 3D-модель за ха-

рактерную точку в указанное место на плоско-

сти ПП, команда Align Face For Board – совме-

стить указанную поверхность 3D-модели с по-

верхностью ПП. 

6. Сохранить в отчет изображения поса-

дочного места: 

6.1. Загрузить и применить профиль с цве-

товыми настройками ИДРЭС-AltiumFootprintGray.PCBSysColors по п. 6 из 

5.2.1, после чего сохранить рисунок посадочного места при текущем слое M5 

Top 3D (обратить внимание на указание о масштабе из п. 17.2 из 5.2.3). 

Затем вернуть цветовые настройки, заданные в п. 6 из 5.2.1. 

6.2. Перейти в 3D-режим просмотра, повернуть посадочное место произ-

вольным образом (например, как на рис. 5.15, б) и сохранить изображение. 

Примечания: 

– при необходимости цвет фона можно поменять в окне View Configu-

rations (клавиша L) на вкладке Physical Materials в группе General в поле 

Workspace Color; 

– способы управления в 3D-режиме описаны в Г.3. 

7. Сохранить изменения в посадочном месте (Ctrl+S). 

8. Открыть библиотеку УГО по аналогии с п. 4. 

9. В панели SCH Library в списке Components дважды щелкнуть ЛКМ 

по строке с УГО (или выделить ее ЛКМ и нажать кнопку Edit). 

Затем в открывшемся окне Library Component Properties в разделе Pa-

rameters с помощью кнопки Add добавить параметр PI_3D-model и присво-

ить ему значение в соответствии с названием 3D-модели конденсатора (см. 

п. 2 из 6.5). 

Результат в варианте «П1» показан на рис. 6.49. 

 

10. Сохранить изменения в УГО (Ctrl+S). 

Рис. 6.49 

Рис. 6.48 
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Примечание. Интегрированная библиотека будет скомпилирована в 

п. 30 из 7.3 после создания установочного чертежа. 

11. Удалить вспомогательную информацию из папки …ИДРЭС\Усили-

тель\_Модели элементов: 

– «CASE-C-293D-П1.stp» – файл 3D-модели в формате STEP, создан-

ный в п. 1 для добавления в посадочное место; 

– «CASE-C-293D-П1.m3d.bak» – backup-файл 3D-модели. 

6.7. Содержание отчета 

По 6-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Рисунок из КОМПАС-3D, на котором будут изображены: 

– 3D-модель танталового конденсатора с номером варианта; 

– Дерево модели со всеми этапами создания 3D-модели. 

Примечание. Перемещение изображения в рабочем поле осуществляет-

ся в соответствии с информацией п. 7.4 из 6.5. 

2. Рисунки посадочного места с подключенной 3D-моделью: 

– в 2D-режиме просмотра при текущем слое M5 Top 3D; 

– в 3D-режиме просмотра. 
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7. ЧЕРТЕЖ УСТАНОВКИ КОМПОНЕНТА 

7.1. Главное окно КОМПАС-3D в режиме создания чертежа 

Чтобы упростить процесс создания сборочного чертежа «усилителя», 

необходимо для всех используемых компонентов подготовить чертежи их 

установки – чертежи-заготовки, на которых показаны применяемые варианты 

монтажа компонентов на ПП. 

Процесс создания чертежа установки компонента с 3D-моделью доста-

точно прост и заключается в выборе необходимых видов из его 3D-модели и 

простановке размеров с указанием способа монтажа (пайка, клей и пр.). 

В папке …\ИДРЭС\Монтаж элементов (см. рис. 2.9) находятся чертежи 

установок всех необходимых для выполнения проектирования компонентов, 

кроме чертежа танталового конденсатора, для которого ранее были разрабо-

таны библиотечный компонент и 3D-модель. В данном разделе разбирается 

пример создания недостающего чертежа установки. 

Начальное окно КОМПАС-3D и настройки описаны в 6.1 и 6.2. 

Для перехода в режим создания чертежа необходимо выполнить коман-

ду Файл ⇒ Создать ⇒ Чертеж. Главное окно КОМПАС-3D в этом режиме 

показано на рис. 7.1. 

 

 Значительных отличий от окна режима создания детали (см. рис. 6.4) 

нет: на ПИ теперь присутствуют пиктограммы команд, необходимые для со-

здания чертежа, а в рабочей области – заготовка рамки для формата А4. 

Рис. 7.1 

Менеджер 

документа 
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На текущем этапе изменение настроек листов не потребуется, однако 

при создании чертежей подобные действия (в том числе и добавление новых 

листов) совершаются практически в каждом документе. 

Для изменения настроек листов документа выполняется следующее: 

– запускается команда Сервис ⇒ Менеджер документа или нажимается 

пиктограмма Менеджер документа на ПИ Стандартная (см. рис. 7.1); 

– в левой части появившегося окна Менеджер документа (рис. 7.2) вы-

деляется пункт Листы, при этом в правой части появляется список листов, 

задействованных в данном чертеже, с их настройками; 

 

– для добавления листа нажимается пиктограмма Создать лист; 

– для удаления добавленного листа нажимается пиктограмма Удалить; 

– изменение настроек конкретного листа производится после выбора со-

ответствующей строки в списке ЛКМ и нажатия на пиктограммы Формат и 

Оформление. Все настройки, кроме произвольных размеров листа, можно 

задать непосредственно в ячейках соответствующей строки. 

7.2. Виды и масштабы изображений на чертеже 

Правила изображения предметов на чертежах (виды, разрезы, сечения) 

устанавливает ГОСТ 2.305–2008. К интересующим на данном этапе понятиям 

относятся: 

– вид предмета (вид) – ортогональная проекция обращенной к наблю-

дателю видимой части поверхности предмета, расположенного между ним и 

плоскостью проецирования; 

– главный вид предмета (главный вид) – основной вид предмета на 

фронтальной плоскости проекции, который дает наиболее полное представ-

ление о форме и размерах предмета, относительно которого располагают 

остальные основные виды; 

Рис. 7.2 

Оформление Формат Создать лист 

Ориентация листа 

Удалить 
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– дополнительный вид предмета (дополнительный вид) – изображе-

ние предмета на плоскости, не параллельной ни одной из основных плоско-

стей проекций, применяемое для неискаженного изображения поверхности, 

если ее нельзя получить на основном виде; 

– местный вид предмета (местный вид) – изображение отдельного 

ограниченного участка поверхности предмета; 

– ортогональная (прямоугольная) проекция – параллельная проекция 

предмета или его части на плоскость, перпендикулярную к направлению 

проецирующих лучей, представляющую совмещенную с чертежом одну из 

граней пустотелого куба, внутри которого мысленно помещен предмет; 

– основной вид предмета (основной вид) – вид предмета, который по-

лучен путем совмещения предмета и его изображения на одной из граней пу-

стотелого куба, внутри которого мысленно помещен предмет, с плоскостью 

чертежа. 

Приведенные выше определения можно пояснить рисунками. Изобра-

жения предметов на чертеже следует выполнять по методу прямоугольного 

проецирования, при этом предмет располагается между наблюдателем и со-

ответствующей плоскостью проекций (рис. 7.3, а). 

 

За основные плоскости проекций принимают шесть граней куба, кото-

рые совмещают с плоскостью так, как показано на рис. 7.3, б. Изображение 

на фронтальной плоскости проекций принимается на чертеже в качестве 

главного вида. К основным видам (видам, получаемых на основных плоско-

стях проекций) по рис. 7.3 относятся: 1 – вид спереди, 2 – вид сверху, 3 – вид 

слева, 4 – вид справа, 5 – вид снизу, 6 – вид сзади. Вид спереди, как отмеча-

лось выше, является главным видом. 

Рис. 7.3 [44] 

а б 
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Масштабы изображений и их обозначение на чертежах устанавливает 

ГОСТ 2.302–68 [47]. К основным определениям относятся: 

– масштаб – отношение линейного размера отрезка на чертеже к соот-

ветствующему линейному размеру того же отрезка в натуре; 

– масштаб натуральной величины – масштаб с отношением 1:1; 

– масштаб увеличения – масштаб с отношением большим, чем 1:1 (2:1; 

2,5:1; 4:1; 5:1; 10:1; 20:1; 40:1; 50:1; 100:1); 

– масштаб уменьшения – масштаб с отношением меньшим, чем 1:1 

(1:2; 1:2,5; 1:4; 1:5; 1:10; 1:15; 1:20; 1:25; 1:40; 1:50; 1:75; 1:100 и т. д.). 

Стоит отметить примечание из ГОСТ 2.004–88 [48], в котором допуска-

ется применять масштабы уменьшения 1:x и увеличения x:1, где x – рацио-

нальное число. Однако пользоваться этой возможностью не рекомендуется. 

7.3. Создание чертежа установки конденсатора 

Для создания чертежа установки конденсатора выполнить следующее: 

1. В КОМПАС-3D открыть 3D-модель конденсатора из разд. 6. 

Для этого дважды щелкнуть ЛКМ по названию файла в проводнике 

Windows или запустить команду Файл ⇒ Открыть (расположение файла 

указано в п. 2 из 6.5). 

2. Задать положение главного вида: 

– СКМ повернуть 3D-модель так, как показано на рис. 7.4, а; 

 

– изменить масштаб изображения и навести курсор мышки на боковую 

поверхность вывода конденсатора со стороны локальной системы координат 

(рис. 7.4, б), после чего щелкнуть ЛКМ для ее выбора; 

– в появившейся над курсором ПИ нажать пиктограмму Нормально к 

(рис. 7.4, в), в результате чего 3D-модель повернется так, что выбранная по-

верхность окажется параллельна плоскости экрана; 

Рис. 7.4 

а б в 
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– запустить команду Вид ⇒ Ориентация или 

нажать пиктограмму Ориентация на ПИ Вид 

(рис. 7.5), после чего в появившемся окне Ориента-

ция вида нажать пиктограмму Добавить; 

– добавленному виду присвоить имя (например, Главный), а затем по-

следовательно нажать кнопки Применить и Выход; 

– сохранить 3D-модель (Ctrl+S). 

3. Если вкладка с рис. 7.1 (Чертеж БЕЗ ИМЕНИ1) не была закрыта, то 

перейти в нее. В противном случае перейти в режим создания чертежа, ис-

пользуя команду из 7.1. 

4. Сохранить чертеж командой Файл ⇒ Сохранить как c расширением 

«.cdw» и названием 3D-модели. Имя файла в варианте «П1» – CASE-C-293D-

П1, а путь сохранения – …\ИДРЭС-П1\Усилитель\_Установочные черте-

жи (см. рис. 2.8). 

5. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

6. Запустить команду Стандартные виды (рис. 7.8) из ПИ Компактная 

панель ⇒ Виды. 

В появившемся окне Открытые докумен-

ты выбрать 3D-модель конденсатора и нажать 

OK. Если вкладка с 3D-моделью была закрыта, 

то воспользоваться кнопкой Из файла и указать 

к ней путь. 

В Панели свойств на вкладке Параметры 

выполнить следующее: 

– в поле Ориентация главного вида выбрать Главный (задан в п. 2); 

– в поле Схема видов отключить вид слева (для этого нажать по соот-

ветствующей картинке), оставив только вид спереди и вид сверху, и нажать 

OK (расположение видов показано на рис. 7.3); 

– нажать кнопку Подобрать для автоматического подбора масштаба; 

– при необходимости в поле Масштаб вида изменить масштаб так, что-

бы изображение занимало не более 1/8 рабочего поля листа формата А4.  

Примечание. В варианте «П1» предложенный масштаб 10:1 уменьшен 

до 5:1. Масштаб можно поменять в любой момент (см. примечание к п. 8). 

После произведенных настроек указать ЛКМ произвольное место на 

чертеже, в которое будут установлены виды. 

Рис. 7.5 

Ориентация 

Рис. 7.6 

ПИ Виды 

Создать новый вид 

Стандартные виды 

Произвольный вид 
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7. Перейти в режим редактирования основной надписи чертежа, для чего 

дважды щелкнуть по ней ЛКМ, и выполнить следующие действия: 

– в Панели свойств на вкладке Параметры отжать пиктограмму Син-

хронизация данных (рис. 7.7); 

 

– в основной надписи чертежа в рабочем поле удалить информацию о 

материале, наименовании детали и массе; 

– применить изменения пиктограммой Создать объект. 

8. Выполнить команду Вид ⇒ Дерево чер-

тежа, в результате чего откроется Дерево черте-

жа, в котором на данном этапе будет три вида с 

указанием масштаба: Системный вид, Главный 

1 и Проекционный вид 2 (рис. 7.8). 

Примечания: 

– системный вид есть всегда, а два послед-

них – добавленные виды из 3D-модели; 

– как видно из рис. 7.9, а, рамки видов обозначены пунктирным конту-

ром. Такие виды называются ассоциативными, т. е. они имеют связи с 3D-

моделью (любое изменение в 3D-модели приведет к появлению запроса на их 

автоматическое перестроение). Объекты в ассоциативных видах нельзя 

удалить, но можно скрыть, переместив на погашенный (невидимый) слой; 

 

– буква «т» в скобках перед названием вида на рис. 7.8 означает, что 

это текущий вид, т. е. с ним в данный момент осуществляется работа; 

– объекты текущего вида отображаются с заданными цветовыми 

настройками, а объекты остальных видов – черным цветом (рис. 7.9, а); 

Рис. 7.9 

а 

б 

Текущий 

вид 

Рамка  

ассоциа-

тивного 

вида 

в 

Рис. 7.7 

Рис. 7.8 
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– сделать вид текущим можно несколькими способами: 

а) выбором вида в списке на ПИ «Текущее состояние» (см. рис. 7.9, б); 

б) выполнением на виде в «Дереве чертежа» команды ПКМ ⇒ Текущий; 

в) двойным щелчком ЛКМ по рамке вида в рабочем поле или одним 

щелчком ЛКМ по ней с последующим выбором пиктограммы «Сделать вид 

текущим» в появившейся над курсором ПИ (см. рис. 7.9, в); 

– после названия вида в скобках указан его масштаб (см. рис. 7.8); 

– изменение масштаба вида осуществляется командой ПКМ ⇒ Мас-

штаб, выполненной на нем в «Дереве чертежа». 

9. Разрушить ассоциативные виды, т. е. превратить их в обычные (без 

связей с 3D-моделью). 

Для этого выполнить команду ПКМ ⇒ Разрушить вид на требуемых 

видах в Дереве чертежа. 

Примечание. Как видно из рис. 7.10, рамка обычного вида имеет сплош-

ной контур серого цвета. 

 

10. Скопировать все объекты из вида Проекционный вид 2 в вид Глав-

ный 1 и расположить их ниже там присутствующих: 

– убедиться в том, что вид Главный 1 является текущим; 

– массовым выделением мышкой выбрать все объекты из вида Проек-

ционный вид 2; 

– скопировать объекты (Ctrl+C), указав базовую точку; 

– вставить объекты (Ctrl+V) недалеко от объектов вида Главный 1;  

– завершить команду клавишей Esc. 

Примечание. Объединение двух видов в один сделано для удобства раз-

мещения чертежа установки компонента на сборочном чертеже. 

11. Удалить вид Проекционный вид 2, для чего в Дереве чертежа вы-

полнить на нем команду ПКМ ⇒ Удалить вид. 

12. Изменить название вида Главный 1 на название файла. 

Рис. 7.10 

Рамка обычного 

вида 
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Для этого в Дереве чертежа выполнить на виде команду ПКМ ⇒ Па-

раметры вида и в Панели свойств в поле Имя ввести требуемое название. 

Результат в варианте «П1» на данном этапе показан на рис. 7.11. 

 

Примечание. Так как на одном виде теперь находятся изображения с 

двух видов, то далее по тексту объекты из ассоциативного вида «Главный 

1» будут называться «видом спереди», а объекты из ассоциативного вида 

«Проекционный вид 2» – «видом сверху». 

13. Сохранить чертеж (Ctrl+S) и проверить успешность сохранения по 

п. 12 из 6.5 (расположение чертежа указано в п. 4). 

14. Расположить вид сверху строго под видом спереди, т. е. так, чтобы 

виды находились на одной вертикали. 

Сделать это можно разными способами, но далее приведен наиболее ав-

томатизированный: 

– массовым выделением мышкой выделить необходимые объекты; 

– запустить команду Сдвиг (см. рис. 6.20); 

– ЛКМ указать на выделенных объектах базо-

вую точку для сдвига. 

Примечание. В варианте «П1» выравнивание 

осуществляется по левой стороне, поэтому вы-

бран левый верхний угол контура (рис. 7.12); 

– для указания нового положения базовой 

точки в рабочем поле запустить команду ПКМ ⇒ Геометрический кальку-

лятор ⇒ Выровнять по двум точкам; 

– ЛКМ последовательно указать две базовые точки на условных гори-

зонтальной и вертикальной прямых, в месте пересечения которых окажутся 

сдвигаемые объекты (порядок указывания значения не имеет). 

Примечание. В варианте «П1» сначала была произвольно указана базо-

вая точка под «видом спереди» (рис. 7.13, а), после чего выполнена команда 

Рис. 7.11 

Вид спереди  

Вид сверху  

Рис. 7.12 
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ПКМ ⇒ Ближайшая точка (включение локальной привязки) и указана базовая 

точка с левого края на «виде спереди» (рис. 7.13, б); 

– курсором мышки в рабочем поле выбрать одну из двух точек, в кото-

рую будут перемещены объекты (фантом точки пересечения показан розо-

вым квадратом на рис. 7.13, в), и принять нужный вариант щелчком ЛКМ; 

– завершить команду клавишей Esc (рис. 7.13, г). 

 

 

15. Командой Отрезок на виде спереди нарисовать горизонтальную ли-

нию (поверхность монтажа) со стилем Основная (рис. 7.14, а).  

Рис. 7.14 

а б 

Рис. 7.13 

а б 

в г 

Фантом пере-

мещаемых 

объектов 

Курсор 

мышки 

Фантом точки пересечения 

Базовая точка 

для сдвига 



 

 211 

16. Командой Сплайн по точкам из группы «Лома-

ная» на ПИ Компактная панель ⇒ Геометрия (рис. 7.15) 

на виде спереди около выводов для обозначения мест пай-

ки изобразить две кривые по трем точкам со следующими 

настройками в Панели свойств: 

– стиль линии – Для линии обрыва; 

– тип кривой – Кривая Безье. 

Кривая с одной стороны должна касаться вывода конденсатора, а с дру-

гой стороны – поверхности монтажа. В месте касания с поверхностью мон-

тажа она должна отстоять от вывода на 0,3 мм (рис. 7.14, б). 

Примечание. Вторую кривую можно нарисовать командой «Симмет-

рия» (см. рис. 6.20), зеркально отразив первую относительно середины кор-

пуса конденсатора. 

17. На виде сверху командой Прямоугольник (ПИ Компактная па-

нель ⇒ Геометрия) нарисовать с двух сторон от коротких сторон корпуса 

два прямоугольных контура со следующими настройками в Панели свойств: 

– стиль линии – Для линии обрыва; 

– высота – размер Tw по рис. 5.13 (ширина вывода). 

Примечание. В варианте «П1» значение размера равно 2,2 мм; 

– ширина – 0.3 мм. 

Каждый прямоугольник должен быть расположен вне корпуса симмет-

рично его длинным сторонам и иметь общую сторону с короткой стороной. 

Примечание. В варианте «П1» сначала был нарисован прямоугольник с 

заданными размерами в стороне от корпуса (рис. 7.16, а), затем он скопиро-

ван (Ctrl+C) с указанием базовой точки на середине его левой стороны 

(рис. 7.16, б), после чего вставлен (Ctrl+V) с указанием базовой точки на се-

редине правой стороны корпуса (рис. 7.16, в). 

 Рис. 7.16 

а в б 

Рис. 7.15 

Сплайн  

по точкам 
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Добавление прямоугольника с левой стороны 

корпуса произведено аналогично, но с использова-

нием операции вырезания (Ctrl+X) для одновре-

менного удаления исходного прямоугольника. 

Результат показан на рис. 7.17. 

18. На виде сверху выделить прямоугольник, 

обозначающий полярность, щелкнуть ПКМ и в появившейся над курсором 

ПИ выбрать стиль линии Для линии обрыва (рис. 7.18). 

После этого снять выделение с объектов. 

 

19. Запустить команду Заливка из группы «Штриховка» на ПИ Ком-

пактная панель ⇒ Геометрия (рис. 7.19) и в Панели свойств установить: 

– тип – Одноцветная;  

– цвет – Черный. 

Затем ЛКМ указать любую точку внутри прямо-

угольника, обозначающего полярность конденсатора, и 

нажать комбинацию клавиш Ctrl+Enter (аналогично нажатию пиктограммы 

Создать объект на Панели свойств). 

Таким же образом залить следующие области (после каждой заливки 

обязательно нажимать комбинацию клавиш Ctrl+Enter): 

– на виде сверху – два прямоугольника вне контура конденсатора 

(рис. 7.17); 

– на виде спереди – две замкнутые области, ограниченные сплайнами 

(см. рис. 7.14, б). 

Завершить команду клавишей Esc. 

20. Командой Сплайн по точкам (см. рис. 7.15) нарисовать: 

Рис. 7.18 

Рис. 7.17 

Рис. 7.19 

Заливка Штриховка 
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– замкнутый контур вокруг вида 

сверху со следующими настройками на 

Панели свойств: тип кривой – Кривая 

Безье; режим – Замкнутый объект; 

стиль – Для линии обрыва; 

– кривую на виде спереди, указы-

вающую линию обрыва ПП, изменив 

режим в Панели свойств на Разо-

мкнутый объект. 

Результат в варианте «П1» на дан-

ном этапе показан на рис. 7.20. 

21. Командой Линейный размер 

или Авторазмер из ПИ Компактная 

панель ⇒ Размеры (рис. 7.21) указать 

ширину, высоту и длину компонента. 

Добавление линейного размера в 

общем случае состоит из указания трех 

точек (рис. 7.22): 

– первые две определяют места, от 

которых будут отведены выносные ли-

нии размера; 

– третья точка определяет положе-

ние размерной линии. 

Необходимо обратить внимание на 

то, что минимальное расстояние между 

размерной линией и линией контура по 

ГОСТ 2.307–2011 – 10 мм. Так как чер-

теж установки в варианте «П1» созда-

ется на виде с масштабом 5:1, то это 

расстояние составит 2 мм. 

Если размерная надпись размеща-

ется на полке, то должна быть указана 

четвертая точка, определяющая ее по-

ложение. 

Значение размера по умолчанию отображается автоматически с учетом 

масштаба вида и не требует пересчета. 

Рис. 7.20 

Рис. 7.21 

Авторазмер 

Линейный размер 

Диаметральный размер 

Радиальный размер 

Выносные линии Размерная линия 

Рис. 7.22 
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Кроме указания точек, от которых отводятся выносные линии, перед 

началом добавления линейного размера можно указать базовый объект, ко-

торый подсвечивается в рабочем поле красным цветом (рис. 7.23, а). 

При использовании команды Линейный размер для указания базового 

объекта в Панели свойств предварительно необходимо нажать пиктограмму 

Выбор базового объекта (рис. 7.23, б). Кроме того, перед выбором третьей 

точки рекомендуется заранее выбрать тип ориентации размера (рис. 7.23, в). 

 

Команда Авторазмер автоматически 

определяет тип создаваемого размера (ли-

нейный, диаметральный или радиальный), и 

при ее использовании тип ориентации и вы-

бор базового объекта (при необходимости) 

осуществляется курсором мышки в рабочем 

поле без вызова дополнительных команд и 

задания настроек в Панели свойств. 

Результат добавления размеров показан 

на рис. 7.24. 

22. Выделить все размеры командой 

Выделить ⇒ По типу ⇒ Линейные разме-

ры и войти в их свойства, запустив команду 

ПКМ ⇒ Свойства на любом размере. 

В появившемся слева от рабочего поля окне Свойства в группе Текст 

для параметра Текст после поставить знак «*» (рис. 7.25) и после этого за-

крыть окно Свойства. 

Примечание. На сборочном чертеже звездочкой будут указаны спра-

вочные размеры (см. п. 2 из Д.5). 

Рис. 7.23 

а в 

б 

Параллельно объекту 

Горизонтальный 

Вертикальный 

Рис. 7.24 
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23. Добавить указание о пайке, для чего запу-

стить команду Линия-выноска из ПИ Компакт-

ная панель ⇒ Обозначения (рис. 7.26). 

В Панели свойств на вкладке Параметры в 

списке Тип выбрать Для пайки. Затем перейти на 

вкладку Знак и щелкнуть ЛКМ в поле Текст. 

В открывшемся окне Введите текст выпол-

нить следующее (рис. 7.27): 

– в 1-й строке ввести п. 2. Это заготовка ссыл-

ки на 2-й пункт технических требований (ТТ) сбо-

рочного чертежа «усилителя», который будет со-

здан в разд. 19; 

– во 2-й строке ввести 2 места, выделить 

надпись и в Панели свойств установить высоту 

символов 2.5. Данная надпись означает, что пайку 

необходимо произвести в двух местах; 

– закрыть окно кнопкой OK. 

В рабочем поле на виде спереди разместить линию-выноску, для чего 

проделать следующее: 

– запустить команду ПКМ ⇒ Привязка ⇒ Точка на кривой (включе-

ние локальной привязки); 

– ЛКМ указать точку на сплайне, ограничивающем заливку около выво-

да конденсатора (рис. 7.28, а). Это точка, на которую будет указывать ли-

ния-выноска; 

– ЛКМ указать точку начала полки (рис. 7.28, б); 

– в Панели свойств нажать пиктограмму Создать объект и завершить 

команду клавишей Esc; 

 Рис. 7.28 

а в б 

Рис. 7.25 

Рис. 7.26 

Рис. 7.27 

Линия-выноска 
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– щелкнуть ЛКМ по созданной линии-выноске для ее выделения; 

– при необходимости отредактировать положение полки и значка пайки, 

потянув за характерные точки, отмеченные черными квадратами; 

– на линии-выноске выполнить команду ПКМ ⇒ Очистить фон, тем 

самым отключив эту опцию (за линией-выноской не будет белого фона, пе-

рекрывающего попадающие под него объекты). 

Результат добавления линии-выноски показан на рис. 7.28, в. 

Примечания: 

– все настройки линии-выноски при необходимости можно поменять, 

запустив на ней команду ПКМ ⇒ Редактировать; 

– подробная информация об условном изображении пайки содержится в 

ГОСТ 2.313–82 [49]. 

24. Запустить команду Линия-выноска (см. рис. 7.26). 

В Панели свойств на вкладке 

Знак щелкнуть ЛКМ в поле Текст и в 

открывшемся окне Введите текст в 1-й 

строке ввести Метка вывода “+”. 

После этого на виде сверху отве-

сти линию-выноски от закрашенного 

прямоугольника, обозначающего по-

лярность (рис. 7.29). 

Если случайно было поставлено лишнее ответвление, то для его удале-

ния выполнить следующие действия: 

– войти в режим редактирования, запустив на объекте команду ПКМ ⇒ 

Редактировать; 

– щелкнуть ЛКМ по точке на конце ненужного ответвления, в результа-

те чего она изменит цвет с черного на зеленый; 

– нажать клавишу Delete; 

– в Панели свойств нажать пиктограмму Создать объект. 

25. Запустить команду Ввод текста (см. рис. 6.41) из ПИ Компактная 

панель ⇒ Обозначения. 

В панели свойств в группе Раз-

мещение выбрать По центру, а затем 

над видом спереди добавить надпись 

Установка дет. С_ (5:1), как показано 

на рис. 7.30. 

Рис. 7.29 

Рис. 7.30 
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Примечание. В надписи содержится следующая информация: 

– дет. – сокращение слова «деталь» по ГОСТ Р 2.316–2023; 

– С_ – буквенный код по ГОСТ 2.710–81, характеризующий вид элемен-

та (конденсатор), и нижнее подчеркивание для указания номера элемента; 

– (5:1) – масштаб чертежа установки для варианта «П1». 

26. На виде сверху удалить номер варианта. 

Затем командой Ввод текста (ПИ Компактная панель ⇒ Обозначе-

ния) добавить на этом месте номер варианта текстом с параметрами по п. 20 

из 6.5. Размер шрифта увеличить в соответствии с масштабом изображения. 

Примечание. В варианте «П1» параметры шрифта: Шрифт – GOST 

type B; высота символов – 7; Курсив и Полужирный – отключено. 

27. Командой Усечь кривую (см. рис. 6.20) максимально упростить 

изображения, убрав малоинформативные линии, что соответствует требова-

ниям ГОСТ Р 2.109–2023 для сборочных чертежей и необходимо для умень-

шения их загруженности (см. п. 1.5 из 19.1). 

28. Подвинуть при необходимости объекты с вида сверху к объектам 

вида спереди, используя команду Сдвиг (см. рис. 6.20) и зажатую клавишу 

Shift (ортогональный режим), а также выравнять по горизонтали размерные 

линии размеров, показывающих высоту и ширину компонента. 

 Рис. 7.31 
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29. Сохранить изменения в чертеже установки компонента (Ctrl+S). 

Результат в варианте «П1» с отключенным отображением сетки (см. п. 5 

из 6.5) показан на рис. 7.31. 

30. В Altium Designer выполнить следующие действия: 

30.1. Командой File ⇒ Open Project открыть проект интегрированной 

библиотеки с танталовым конденсатором, если он был закрыт. 

Примечание. В варианте «П1» проект расположен в папке …\ИДРЭС-

П1\Усилитель\_Библиотека\Capacitors-П1. 

30.2. Открыть библиотеку УГО по аналогии с п. 4 из 6.6. 

30.3. В панели SCH Library в списке Components дважды щелкнуть 

ЛКМ по строке с УГО (или выделить ее ЛКМ и нажать кнопку Edit). 

Затем в открывшемся окне Library Component Properties в разделе Pa-

rameters с помощью кнопки Add добавить параметр PI_Drawing и присво-

ить ему значение в соответствии с названием установочного чертежа конден-

сатора (см. п. 4). 

Результат в варианте «П1» показан на рис. 7.32. 

 

30.4. Сохранить изменения в УГО (Ctrl+S). 

30.5. Перекомпилировать проект интегрированной библиотеки: 

– указать путь для сохранения файла интегрированной библиотеки в ту 

же папку, где он находится в данный момент (см. п. 3 из 5.5); 

– сохранить изменения в проекте (см. п. 4 из 5.5); 

– скомпилировать или перекомпилировать проект, выполнив на нем ко-

манду ПКМ ⇒ Compile Integrated Library или ПКМ ⇒ Recompile Integrat-

ed Library (команды также доступны из меню Project). 

Примечание. Разница в этих командах заключается в скорости работы, 

так как при перекомпиляции обновляются только те элементы проекта, 

которые были изменены (при компиляции обновляются все объекты); 

– закрыть проект интегрированной библиотеки. 

30.6. Удалить интегрированную библиотеку из списка установленных 

библиотек (см. п. 7 из 5.5). 

Рис. 7.32 
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Примечание. В результате работы, проделанной в разд. 5–7, для тан-

талового конденсатора были созданы: 

– библиотечный компонент, состоящий из УГО для обозначения на схе-

мах и посадочного места для разработки топологии ПП; 

– 3D-модель для создания 3D-модели печатного узла; 

– чертеж установки для создания сборочного чертежа печатного узла. 

Со временем у разработчика появляется достаточно большой объем 

подобных материалов и возникает потребность в их систематизации, 

например для быстрого поиска данных на необходимые компоненты или их 

составные части, на основе которых можно сделать другие компоненты. 

Решить проблему помогает хранение такой информации в базе данных, а 

при использовании библиотеки в виде базы данных (см. п. 3 из 5.1) создание 

дополнительных файлов не требуется. 

База данных от использованной при проектировании библиотеки в виде 

базы данных выполнена в Microsoft Access и хранится в файле ИДРЭС-

ADLibrary.mdb из папки …\ИДРЭС\AD library (см. рис. 2.9). 

31. Удалить вспомогательную информацию: 

– из папки …\ИДРЭС-П1\Усилитель\_Установочные чертежи – файл 

«CASE-C-293D-П1.cdw.bak» (backup-файл установочного чертежа);  

– всю папку …ИДРЭС-П1\Усилитель\_Библиотека\Capacitors-П1, в 

результате чего останется только файл интегрированной библиотеки. 

7.4. Содержание отчета 

По 7-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести рисунок установочного чертежа танталового кон-

денсатора без рамки и с отключенным отображением сетки (см. п. 5 из 6.5). 

Примечание. Перемещение изображения в рабочем поле осуществляет-

ся в соответствии с информацией п. 7.4 из 6.5. 
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8. СХЕМА ЭЛЕКТРИЧЕСКАЯ ПРИНЦИПИАЛЬНАЯ 

«УСИЛИТЕЛЯ» 

8.1. Общие сведения 

Определения терминам схема и схема электрическая были даны в 3.1. 

Схема принципиальная (полная) – документ, определяющий полный 

состав элементов и взаимосвязи между ними и, как правило, дающий полное 

(детальное) представление о принципах работы изделия (установки). Код 

этого типа схемы – 3. 

Принципиальными схемами пользуются для изучения принципов рабо-

ты изделий (установок), а также при их наладке, контроле и ремонте. Они 

служат основанием для разработки других КД, например схем соединений 

(монтажных) и чертежей. 

Общий код для схемы электрической принципиальной – Э3. 

К основным правилам оформления схем Э3 относятся следующие: 

1. Обозначение устройств: 

1.1. Схемы выполняют без соблюдения масштаба, действительное про-

странственное расположение составных частей изделия (установки) не учи-

тывают или учитывают приближенно. 

1.2. УГО элементов, устройств, функциональных групп и соединяющие 

их линии электрической связи располагают на схеме так, чтобы обеспечить 

наилучшее представление о структуре изделия и взаимодействии его частей. 

1.3. Функциональную группу или устройство, не имеющее самостоя-

тельной схемы Э3, выполняют на схемах в виде фигуры из контурных 

штрихпунктирных линий, равных по толщине линиям электрической связи. 

1.4. На принципиальной схеме изображают все электрические элементы 

или устройства, необходимые для осуществления и контроля в изделии за-

данных электрических процессов, все электрические связи между ними, а 

также электрические элементы (соединители и т. п.), которыми заканчивают-

ся входные и выходные цепи. 

1.5. Схемы выполняют для изделий в отключенном состоянии. 

1.6. Устройства, имеющие самостоятельную принципиальную схему, 

выполняют на схемах в виде фигуры сплошной линией, равной по толщине 

линиям электрической связи. 

Допускается выполнять устройства в виде фигуры линией в два раза 

толще линии электрической связи. 
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2. Линии электрической связи: 

2.1. Линии электрической связи выполняют толщиной от 0,2 до 1,0 мм в 

зависимости от форматов схемы и размеров УГО. Рекомендуемая толщина 

линий – от 0,3 до 0,4 мм. 

В Altium Designer в схемном редакторе предусмотрено всего четыре 

толщины линий: 

– smallest (очень тонкая) – 0,016 мм; 

– small (тонкая) – 0,254 мм; 

– medium (средняя) – 0,762 мм; 

– large (толстая) – 1,27 мм. 

При проектировании толщина линий электрической связи и линий в 

УГО выбрана равной small и задана в настройках из 3.2.2. 

2.2. Расстояние между соседними параллельными линиями электриче-

ской связи должно быть не менее 3 мм. 

Чтобы это правило автоматически выполнялось при проектировании, 

выводы всех УГО расположены в сетке 3 мм. 

2.3. Для упрощения схемы допускается слияние нескольких электриче-

ски не связанных линий электрической связи в линию групповой связи, но 

при подходе к контактам (элементам) каждую линию электрической связи 

изображают отдельной линией. Через дробную 

черту на рис. 8.1 после порядковых номеров 

линий указано число их разветвлений в линии 

групповой связи. 

При необходимости линии групповой свя-

зи делаются утолщенными (ГОСТ 2.721–74). 

В данном учебном пособии толщина ли-

ний групповой связи выбрана равной medium и задана в настройках из 3.2.2. 

Пример ее использования приведен в п. 3.3.4 из Г.48 и показан на рис. Г.181. 

2.4. На поле схемы допускается помещать указания о марках, сечениях и 

расцветках проводов и кабелей (многожильных проводов, электрических 

шнуров), которыми должны быть выполнены соединения элементов, а также 

указания о специфических требованиях к электрическому монтажу данного 

изделия. 

2.5. Линии электрической связи должны состоять из горизонтальных и 

вертикальных отрезков и иметь наименьшее количество изломов и взаимных 

пересечений. 

Рис. 8.1 [11] 
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В отдельных случаях допускается применять наклонные отрезки линий 

электрической связи, длину которых следует по возможности ограничивать. 

2.6. Линии электрической связи, переходящие с одного листа или одного 

документа на другой, следует обрывать за пределами изображения схемы без 

стрелок. Рядом с обрывом должно быть указано обозначение или наименова-

ние, присвоенное этой линии (например, номер провода, наименование сиг-

нала или его сокращенное обозначение и т. п.), и в круглых скобках номер 

листа схемы (и зоны при ее наличии) при выполнении схемы на нескольких 

листах, например лист 5 зона А6 (5, А6), или обозначение документа при вы-

полнении схем самостоятельными документами, на который переходит ли-

ния электрической связи. 

Для таких обрывов можно использовать идентификаторы цепей Port 

(см. п. 1.3 из Г.27), но рекомендуются Net Label (см. п. 1.1 из Г.27 и Г.48). 

2.7. Линии электрической связи должны быть показаны, как правило, 

полностью. Если они затрудняют чтение схемы, то в пределах одного листа 

их допускается обрывать, заканчивая стрелками. Около стрелок указывают 

места обозначений прерванных линий, например подключения, и (или) необ-

ходимые характеристики цепей (например, полярность, потенциал и т. п.). 

Для таких обрывов используются идентификаторы цепей Power Port 

(см. п. 1.2 из Г.27) и (или) Net Label совместно с УГО стрелки из соответ-

ствующей библиотеки (см. Г.48). 

3. Позиционные обозначения и номиналы: 

3.1. Каждый элемент и (или) устройство, имеющее самостоятельную 

принципиальную схему и рассматриваемое как элемент, входящие в изделие 

и изображенные на схеме, должны иметь обозначение (позиционное обозна-

чение) в соответствии с ГОСТ 2.710–81. 

Например, общее обозначение устройства – А. 

3.2. Позиционные обозначения элементам (устройствам) следует при-

сваивать в пределах изделия (установки). 

3.3. Порядковые номера элементам (устройствам) следует присваивать, 

начиная с единицы, в пределах группы элементов (устройств), которым на 

схеме присвоено одинаковое буквенное позиционное обозначение, например: 

R1, R2, R3 и т. д. 

3.4. Порядковые номера должны быть присвоены в соответствии с по-

следовательностью расположения элементов или устройств на схеме сверху 

вниз в направлении слева направо. 
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3.5. Позиционные обозначения проставляют на схеме рядом с УГО эле-

ментов и (или) устройств с правой стороны или над ними (см. рис. 5.41). 

3.6. На принципиальной схеме должны быть однозначно определены все 

элементы и устройства, входящие в состав изделия и изображенные на схеме. 

Данные о них должны быть записаны в перечень элементов. При этом связь 

перечня с УГО элементов осуществляется через позиционные обозначения. 

3.7. При указании около УГО номиналов резисторов и конденсаторов 

допускается применять упрощенный способ обозначения единиц измерений: 

а) для резисторов: 

– от 0 до 999 Ом – без указания единиц измерения; 

– от 1·103 до 999·103 Ом – в килоомах с обозначением единицы измере-

ния строчной буквой к;  

– от 1·106 до 999·106 Ом – в мегаомах с обозначением единицы измере-

ния прописной буквой М; 

– свыше 1·109 Ом – в гигаомах с обозначением единицы измерения про-

писной буквой Г; 

б) для конденсаторов: 

– от 0 до 9999·12–12 Ф – в пикофарадах без указания единицы измере-

ния; 

– от 1·10–8 до 9999·10–6 Ф – в микрофарадах с обозначением единицы 

измерения строчными буквами мк. 

По ГОСТ 2.004–88 допускается использовать прописные буквы: 

– К – единица измерения сопротивления (килоом); 

– МК – единица измерения емкости (микрофарад). 

3.8. При выполнении принципиальной схемы на нескольких листах: 

– при присвоении элементам позиционных обозначений соблюдают 

сквозную нумерацию в пределах изделия (установки); 

– перечень элементов должен быть общим; 

– отдельные элементы допускается повторно изображать на других ли-

стах схемы, сохраняя позиционные обозначения, присвоенные им на одном 

из листов схемы. 

3.9. Если на схеме изделия есть функциональные группы, то вначале 

присваивают позиционные обозначения элементам, не входящим в функцио-

нальные группы, а затем элементам, входящим в функциональные группы. 

При наличии в изделии нескольких одинаковых функциональных групп 

позиционные обозначения элементов, присвоенные в одной из этих групп, 
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следует повторять во всех последующих группах. Обозначение функцио-

нальной группы, присвоенное по ГОСТ 2.710–81, указывают около изобра-

жения функциональной группы (сверху или справа). 

3.10. При изображении на схеме элемента или устройства разнесенным 

способом позиционное обозначение элемента или устройства проставляют 

около каждой составной части. 

Пример изображения устройства совмещенным и разнесенным способа-

ми показан на рис. 8.2. 

 

3.11. На схеме изделия, в состав которого входят устройства, не имею-

щие самостоятельных принципиальных схем, допускается позиционные обо-

значения элементам присваивать в пределах каждого устройства. Если в со-

став изделия входит несколько одинаковых устройств, то позиционные обо-

значения элементам следует присваивать в пределах этих устройств. 

3.12. При изображении на схеме элементов, параметры которых подби-

рают при регулировании, около позиционных обозначений этих элементов на 

схеме и в перечне элементов проставляют звездочки (например, R1*), а на 

поле схемы помещают сноску: «* Подбирают при регулировании». 

4. Надписи на схеме: 

4.1. На схеме рекомендуется указывать характеристики входных и вы-

ходных цепей изделия (частоту, напряжение, силу тока, сопротивление, ин-

дуктивность и т. п.), а также параметры, подлежащие измерению на кон-

трольных контактах, гнездах и т. п. 

4.2. На схемах допускается помещать различные технические данные, 

характер которых определяется назначением схемы. Их указывают либо око-

ло УГО (по возможности справа или сверху), либо на свободном поле схемы. 

Около УГО элементов и устройств помещают, например, номинальные 

значения их параметров, а на свободном поле схемы – диаграммы, таблицы, 

текстовые указания (диаграммы последовательности временных процессов, 

Рис. 8.2 [11] 
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циклограммы, таблицы замыкания контактов коммутирующих устройств, 

указания о специфических требованиях к монтажу и т. п.). 

4.3. Текстовые данные приводят на схеме в тех случаях, когда содержа-

щиеся в них сведения нецелесообразно или невозможно выразить графически 

или в виде УГО. Содержание текста должно быть кратким и точным. В 

надписях не должны применяться сокращения слов, за исключением обще-

принятых или установленных в стандартах. 

УГО, надписи или знаки, предназначенные для нанесения на изделие, 

заключают в кавычки. 

4.4. Над основной надписью допускается помещать необходимые техни-

ческие указания, например: требования о недопустимости совместной про-

кладки некоторых проводов, жгутов, кабелей; минимально допустимые раз-

меры между проводами, жгутами, жгутами и кабелями и т. п. 

При выполнении схемы на нескольких листах технические указания, яв-

ляющиеся общими для всей схемы, располагают на свободном поле (по воз-

можности над основной надписью) первого листа схемы, а технические ука-

зания, относящиеся к отдельным элементам, располагают или в непосред-

ственной близости от изображения элемента, или на свободном поле того ли-

ста, где они являются наиболее необходимыми для удобства чтения схемы. 

8.2. Подготовительные действия 

Так как схема Э3 «усилителя» впоследствии будет использоваться для 

создания ПП, то она должна находиться в составе проекта ПП (PCB Project). 

Поэтому подготовительные действия к созданию схемы будут следующими: 

1. Создать проект ПП. 

Для этого запустить команду File ⇒ New ⇒ Project и в открывшемся 

окне New Project (рис. 8.3, а): 

– в группе Project Types выбрать PCB Project; 

– в группе Project Templates выбрать <Default>; 

– в поле Name присвоить имя проекту в виде PCB_Project-ХХ, где вме-

сто XX указать номер варианта; 

– включить опцию Create Project Folder (в этом случае для проекта ПП 

будет создана отдельная папка с его названием); 

– в поле Location с помощью кнопки Browse Location указать путь рас-

положения проекта. В варианте «П1» – …\ИДРЭС-П1\Усилитель. 

Затем применить изменения кнопкой OK. 
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В результате в панели Projects появится пустая группа с названием фай-

ла проекта ПП и расширением «.PrjPcb» (рис. 8.3, б). 

Примечание. В группе Project Templates (рис. 8.3, а) перечислены заго-

товки проектов для типовых конструктивов ПП, которые также можно 

создавать самостоятельно. Например, ПП стандарта евромеханика (euro-

card), устанавливаемая в блочный каркас высотой 3U (U – величина, равная 

44,45 мм или 1,75 дюйма) для телекоммуникационной стайки (рис. 8.4). 

 Рис. 8.4 

Стойка телекоммуникационная 

Каркас блочный с направляющими, 

высота – 3U, ширина – 19 дюймов 

ПП с передней панелью и ручками 

Рис. 8.3 

а 

б 
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2. Схема Э3 «усилителя» будет разработана на одном листе, поэтому 

необходимо создать один документ схемы внутри проекта. 

Для этого в панели Projects на названии проекта выполнить команду 

ПКМ ⇒ Add New to Project ⇒ Schematic. 

Примечания: 

– новый документ схемы также можно создать из панели Files, щелк-

нув ЛКМ по пункту Schematic Sheet в группе New; 

– в Altium Designer во многолистовых проектах каждый лист схемы 

представляет собой отдельный документ (см. Г.48). 

3. Сохранить схему с расширением «.SchDoc» в папку проекта, запустив 

в панели Projects на ее названии команду ПКМ ⇒ Save As. Имя файла в ва-

рианте «П1» – «УП1.01.01Э3 - Усилитель - v0.1» (см. рис. 2.8). 

Примечание. Во многолистовых проектах каждый лист схемы реко-

мендуется называть по функциональному назначению изображенных на нем 

групп компонентов (например, питание или СВЧ-тракт как в Г.48). 

4. Подключить рамку листа формата А3 – A3-1-ИДРЭС-AD.SchDot (см. 

п. 3 из 3.2.3). 

5. В графах 2, 7 и 8 основной надписи вместо ручного редактирования 

информации указать ссылки на параметры (особенно актуально для многоли-

стовых проектов), для чего выполнить следующие действия: 

5.1. Запустить команду Tools ⇒ Annotation ⇒ Number Schematic Sheets 

и в открывшемся окне нажать кнопки (рис. 8.5): 

– Auto Sheet Number с параметрами Display Order (в порядке отобра-

жения) и Increasing (нумерация с увеличением) для автоматического присво-

ения порядковых номеров листам проекта в столбце SheetNumber; 

– Update Sheet Count для подсчета общего количества листов в проекте 

и заполнения ячеек столбца SheetTotal каждого листа; 

– OK для применения изменений. 

 Рис. 8.5 
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Примечания: 

– порядок листов можно менять кнопками Move Up и Move Down; 

– номера листов можно записывать самостоятельно в соответству-

ющие ячейки столбца SheetNumber; 

– во многолистовых проектах номера листов используются для их ав-

томатического указания около объектов Port в соответствии с п. 2.6 из 8.1. 

5.2. Запустить команду Project ⇒ Project Options 

и в открывшемся окне перейти на вкладку Parameters. 

Затем нажать кнопку Add и в появившемся окне Pa-

rameters Properties записать (рис. 8.6): 

– в поле Name – имя параметра DrawingNumber 

(можно задать произвольное); 

– в поле Value – обозначение документа схемы (на рисунке указано 

УП1.01.01Э3 для варианта «П1» по табл. 2.1). 

После этого применить изменения в двух окнах кнопкой OK. 

6. Заполнить значения параметров в основной надписи рамки и ее до-

полнительных графах в соответствии с табл. 8.1 (вкладка Parameters в окне, 

вызываемом командой Design ⇒ Document Options). Содержание остальных 

параметров должно соответствовать данным табл. 3.2. 

Пояснения к графам даны в табл. 3.1 и на рис. 3.6, а и в. 

Таблица 8.1 

Параметры рамки для схемы Э3 «усилителя»,  

отличающихся от схемы Э1 «модуля усилителя» 

Название параметра Значение Комментарий к заполнению 

01.1_Наименов. изд. Усилитель 
Наименование изделия определено в 

табл. 2.1 

01.3_Наименов. док. 
Схема электрическая 

принципиальная 
– 

02_Обознач. док. =DrawingNumber Указана ссылка на параметр из п. 5.2 

07_Номер листа См. комментарий 

Для проекта из одного листа значение от-

сутствует. 

Во многолистовом проекте для отобра-

жения текущего номера листа необходи-

мо дать ссылку на параметр из п. 5.1 

(=SheetNumber) 

08_Кол. листов =SheetTotal Указана ссылка на параметр из п. 5.1 

25_Перв. примен. УП1.01.01 

Обозначение спецификации, в которой 

записан КД, определено в табл. 2.1 и ука-

зано для варианта «П1» 

Рис. 8.6 
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7. Скорректировать предварительные настройки проекта, для чего запу-

стить команду Project ⇒ Project Options и в открывшемся окне выполнить 

следующее: 

7.1. На вкладке Class Generation в группе Automatically Generated 

Classes (автоматическое создание классов) для листа схемы отключить оп-

цию Component Classes (опция Generate Rooms также отключится). 

Примечания: 

– класс цепей (Net Class) и класс компонентов (Component Class) – груп-

па объектов (цепей или компонентов), объединенных по заданному признаку. 

Классы используются для быстрого выбора входящих в них объектов, а 

также для задания правил проектирования как общих для всех объектов в 

данном классе, так и между различными классами (например, минимальные 

зазоры на ПП до других объектов); 

– комната (Room) – область, ограничивающая на ПП расположение 

находящихся в ней компонентов. Для нее при необходимости можно задать 

отличающиеся от всего проекта правила проектирования (например, нали-

чие переходных отверстий уменьшенных размеров). 

7.2. На вкладке Class Generation в группе User-Defined Classes (пользо-

вательские классы) включить опцию Generate Component Classes. 

Примечание. В этом случае в схеме можно создавать классы компо-

нентов (таким компонентам вручную присваивается параметр ClassName с 

указанием имени класса), которые будут передаваться в редактор ПП.  

7.3. На вкладке Options: 

– в группе Netlist Options включить опции Allow Ports to Name Nets и 

Power Port Names Take Priority (опцию Allow Sheet Entries to Name Nets 

можно отключить); 

– в группе Net Identifier Scope выбрать опцию Global (Netlabels and 

ports global). 

После этого применить изменения в открытом окне кнопкой OK. 

Примечание. Описание указанных опций приведено в табл. Г.11 и Г.12. 

8. Подключить к проекту ПП библиотеки компонентов. 

Для этого сначала убедиться в том, что в панели Projects выбран со-

зданный проект, после чего открыть панель Libraries и в верхней ее части 

нажать одноименную кнопку.  

Затем в открывшемся окне Available Libraries выполнить следующее: 

– перейти на вкладку Project; 
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– кнопкой Add Library добавить интегрированную библиотеку для тан-

талового конденсатора с расширением «.IntLib» (расположение указано в п. 2 

из 5.2.1). Результат в варианте «П1» показан на рис. 8.7; 

 

– перейти на вкладку Search Path 

и нажать кнопку Paths; 

– в открывшемся окне на вкладке 

Search Paths нажать кнопку Add; 

– в появившемся окне Edit 

Search Path в поле Path с помощью 

соответствующей пиктограммы ука-

зать путь к папке с библиотекой ком-

понентов в виде базы данных (папка 

…\ИДРЭС\AD library с рис. 2.9); 

– отключить опции Store Path as 

Relative (отображение пути относи-

тельно папки проекта) и Include sub-

folders in search (поиск во всех пап-

ках внутри указанной папки); 

– нажать кнопку Refresh List и 

убедиться в том, что в списке найден-

ных файлов появилась библиотека с 

расширением «.DbLib» (рис. 8.8); 

– закрыть два открытых окна 

кнопками OK, а окно Available Li-

braries кнопкой Close. 

Результат подключения библио-

тек компонентов в панели Libraries в варианте «П1» показан на рис. 8.9. 

Рис. 8.7 

Рис. 8.8 

Рис. 8.9 
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Примечания: 

– библиотеки компонентов подключались не на вкладке Installed окна 

Available Libraries, чтобы они загружались только в конкретном проекте; 

– библиотеку компонентов в виде базы данных можно было также 

подключить на вкладке Project окна Available Libraries; 

– описание работы с панелью Libraries приведено в Г.9; 

– создание библиотеки компонентов в виде базы данных описано в Г.34. 

9. Запустить команду DXP ⇒ Preferences и в окне Preferences: 

– для удобства размещения УГО на схеме отключить выделение пинов, 

для чего в подразделе Schematic ⇒ Graphical Editing включить опцию Shift 

Click To Select (см. табл. Г.3); 

– включить отображение предупреждений в реальном времени, для чего 

в подразделе Schematic ⇒ Compiler включить опцию Warning (подробнее 

см. в табл. Г.3). 

Затем закрыть окно кнопкой OK. 

10. Сохранить изменения в схеме 

(Ctrl+S). 

11. Сохранить изменения в проек-

те (см. п. 4 из 5.5). 

Остальные настройки для редактора схем были загружены в 3.2.2. 

Состав проекта из панели Projects в варианте «П1» на данном этапе по-

казан на рис. 8.10. Черная стрелка в нижнем правом углу иконки документа 

означает, что он не находится в папке проекта. 

8.3. Создание схемы Э3 

Для создания схемы Э3 «усилителя» выполнить следующее: 

1. Освежить в памяти назначение применяемых при проектировании 

компонентов по В.1–В.10. 

2. Если проект был закрыт, то открыть его командой File ⇒ Open Pro-

ject (расположение указано в п. 1 из 8.2). 

3. Если схема была закрыта, то открыть ее одним из двух способов: 

– сделать двойной щелчок ЛКМ по ее названию в панели Projects; 

– выполнить команду ПКМ ⇒ Open на ее названии в панели Projects. 

4. Создать участок схемы с ПФ: 

4.1. Освежить в памяти внешний вид структуры ПФ из разд. 4 по рисун-

кам его схемы и 3D-модели, сохраненным в отчете. 

Рис. 8.10 
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4.2. Перейти в сетку 3 мм. 

4.3. В рабочем поле схематично изобразить структуру ПФ без подводя-

щих линий, т. е. без элементов MLIN: 

4.3.1. Добавить отрезки МПЛ (компонент MICROSTRIP из библиотеки 

«ИДРЭС-ADLibrary.DbLib - Symbol»): 

– в вариантах задания с ШТ – с вертикальной ориентацией УГО по чис-

лу полосковых элементов из элемента M5CLIN; 

– в вариантах задания с СЛ – с горизонтальной ориентацией УГО по две 

штуки на каждый элемент MCFIL. 

Примечания: 

– способы добавления компонентов описаны в Г.28, действия при их пе-

ремещении – в Г.29, а возможности выравнивания – в Г.30; 

– далее в тексте при добавлении компонента из библиотеки в виде базы 

данных будет указываться только подраздел без полного названия (напри-

мер, компонент MICROSTRIP из библиотеки Symbol). 

4.3.2. В вариантах задания с ШТ последовательным нажатием клавиш 

P ⇒ O добавить символы земли (идентификаторы цепи GND Power Port) по 

числу элементов MLSC. 

4.3.3. Последовательным нажатием клавиш P ⇒ W (создание линии 

электрической связи) осуществить необходимые соединения. 

Возможный результат для ШТ 5-го порядка показан на рис. 8.11, а, а для 

СЛ 3-го порядка – на рис. 8.11, б. 

 

Оранжевая фигурная линия у МПЛ означает, что системой обнаружены 

нарушения при создании схемы. Их список можно посмотреть, задержав кур-

сор мышки на компоненте (рис. 8.12). В данном случае это два нарушения: 

– предупреждение с требованием назначить позиционные обозначения; 

Рис. 8.11 

а б 
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– ошибка, связанная с наличием не-

скольких компонентов с одинаковым 

позиционным обозначением (W?). 

Перенумерация компонентов будет 

выполнена в конце создания схемы, по-

этому на данном этапе на такие наруше-

ния не следует обращать внимания. 

Примечание. Подробнее об отоб-

ражении нарушений описано в подразделе Compiler из табл. Г.3. 

4.4. Перейти в сетку 1 мм. 

4.5. Последовательным нажатием клавиш P ⇒ D ⇒ L (создание линии) 

нарисовать замкнутый прямоугольный контур из штрихпунктирных линий в 

соответствии с п. 1.3 из 8.1 вокруг ПФ. Линии должны быть нарисованы от-

дельными штрихами, так как стиль линии Dash Dotted не соответствует ука-

занным в ГОСТ 2.303–68 параметрам: штрихпунктирная линия должна со-

стоять из штрихов длиной 5–30 мм, находящихся друг от друга на расстоя-

нии 3–5 мм, в промежутке между которыми расположены короткие штрихи. 

Расстояние до других объектов от нарисованного контура должно быть 

не менее 3 мм. 

Примечание. В варианте «П1» длина длинных штрихов выбрана 10 мм, 

длина коротких штрихов – 1 мм, а размер зазоров – 2 мм. 

4.6. В верхнем правом углу над нарисованным контуром последователь-

ным нажатием клавиш P ⇒ T поместить надпись А1 в соответствии с пп. 3.1 

и 3.9 из 8.1. 

В свойствах надписи изменить размер шрифта на 12. 

 Рис. 8.13 

Рис. 8.12 
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4.7. Перейти в сетку 3 мм. 

Результат в варианте «П1» на данном этапе показан на рис. 8.13. 

4.8. Сгруппировать все нарисованные объекты. 

Примечания:  

– переместить группу можно за любую часть штрихпунктирного кон-

тура или текстовую надпись, но если потянуть за УГО или линию электри-

ческой связи, то они будут перемещаться отдельно от группы. Для предот-

вращения подобного можно включить блокировку: массовым выделением 

мышкой выбираются УГО и линии электрической связи, а затем в панели 

SCH Inspector в разделе Graphical включается опция Lock (рис. 8.14); 

 

– на выделение заблокированных объектов влияет опция Protect Locked 

Objects (см. табл. Г.3); 

– особенности работы с панелью SCH Inspector приведены в Г.10. 

4.9. Добавить и подключить входные КП: 

– слева от ПФ добавить три компонента PAD_r150_300 (планарные КП 

прямоугольной формы и размером 1,5 × 3,0 мм) из библиотеки PAD, распо-

ложив их друг под другом пинами к ПФ; 

– около верхней и нижней КП последователь-

ным нажатием клавиш P ⇒ O добавить символы 

земли (идентификаторы цепи GND Power Port); 

– последовательным нажатием клавиш P ⇒ W 

(создание линии электрической связи) соединить 

верхнюю и нижнюю КП с символами земли, а сред-

нюю КП – с отрезком МПЛ на входе ПФ. 

Результат в варианте «П1» показан на рис. 8.15. 

4.10. Сохранить изменения в схеме (Ctrl+S). 

Рис. 8.14 

Рис. 8.15 
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5. Создать участок схемы с усилителем: 

5.1. Добавить керамический разделительный 

конденсатор фирмы ATC серии 600 в корпусе ти-

поразмера 0805 (600F) или 0603 (600S) с горизон-

тальной ориентацией УГО. Их заготовки (компо-

ненты C0603-600S и C0805-600F соответственно) 

находятся в библиотеке C. После этого соединить 

его с отрезком МПЛ на выходе ПФ. 

В варианте «П1» добавлен компонент C0805-600F (рис. 8.16). Подчер-

кивание синей фигурной линией означает наличие предупреждения, связан-

ного с требованием назначить позиционное обозначение компоненту. 

5.2. Чтобы на центральной частоте, вычисленной по (3.1), модуль импе-

данса разделительного конденсатора был мал (см. В.2), определить его ем-

кость по кривой Fsr с графика Resonant Frequency Data из документации.  

Нахождение емкости в варианте «П1» показано на рис. 8.17, а. 

График и соответствующие пояснения привести в отчете. 

 Рис. 8.17 

2,45 ГГц 

25 пФ 

а 

б 
в 

Рис. 8.16 



 

 236 

5.3. Для найденного значения емкости выбрать ближайший стандартный 

номинал по таблице Capacitance Values, приведенной в документации. Ее 

фрагмент для значения из варианта «П1» показан на рис. 8.17, б. 

5.4. В окне свойств разделительного конденсатора (двойной щелчок 

ЛКМ или запуск команды ПКМ ⇒ Properties) в группе Parameters запол-

нить значения параметров, содержащих символ «*». 

Значения параметров в варианте «П1» приведены в табл. 8.2. 

Таблица 8.2 

Значения параметров разделительного конденсатора из варианта «П1» 

Параметр Значение Особенность записи значения 

CI_Value 24 Номинал указать с учетом п. 3.7 из 8.1 

CI_Tolerance ±10 % 

Допуск выбрать любой из ряда, указанного для вы-

бранного номинала в таблице Capacitance Values из 

документации. 

Расшифровка кодов допуска содержится в таблице 

Tolerance Code Table, также приведенной в докумен-

тации. Ее фрагмент для кода K показан на 

рис. 8.17, в 

CI_BOM 

600F240KT250XT 

24 пФ ±10 % 250 В 

C0G 0805 

Указать Part Number, номинал, допуск, рабочее 

напряжение, температурный коэффициент емкости 

(ТКЕ) и типоразмер корпуса. 

Part Number составляется по системе обозначений, 

приведенной в документации. Также пример Part 

Number конденсатора фирмы ATC разобран в В.2 

Примечание. Значения параметров также можно заполнить в панели 

SCH Inspector в разделе Parameters (рис. 8.18). 

 

5.5. Добавить указанную в варианте индивидуального задания микро-

схему усилителя из библиотеки DA, после чего ее вход соединить со свобод-

ным выводом разделительного конденсатора. 

В варианте «П1» добавлена микросхема GALI-3+ фирмы Mini-Circuits в 

корпусе SOT-89-3 (столбец 8 из табл. 1.1).  

Рис. 8.18 
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Примечание. Названия корпусов других микросхем усилителей, использу-

емых при проектировании, указаны в значении параметра PI_Package, а их 

внешние виды показаны на рис. 8.19. Также вид корпуса можно посмотреть 

для каждого компонента в панели Libraries (см. Г.9). 

 

5.6. Все выводы GND микросхемы усилителя подключить к земле. 

Примечание. Здесь и далее по тексту «подключение к земле» означает 

соединение соответствующих выводов с одним или несколькими символами 

земли (идентификаторы цепей GND Power Port). 

5.7. Скопировать (Ctrl+C) разделитель-

ный конденсатор с выхода ПФ, а затем вста-

вить его (Ctrl+V) справа от микросхемы уси-

лителя и соединить с ее выходом.  

Примечания: 

– при копировании все настройки компо-

нента также копируются; 

– вставку компонента также можно 

производить из панели Clipboard щелчком 

ЛКМ по нему (рис. 8.20). 

5.8. Между выходом микросхемы усилителя и разделительным конден-

сатором подключить отрезок МПЛ с вертикальной ориентацией УГО (ком-

понент MICROSTRIP из библиотеки Symbol). 

Затем выбрать компонент щелчком ЛКМ и в панели SCH Inspector в 

разделе Parameters для параметра CI_Value указать значение четверти дли-

ны волны, вычисленное по (4.8). 

Примечание. Пример записи зна-

чения в варианте «П1» показан на 

рис. 8.21. 

Рис. 8.19 

SOT-89-3 SOT-363-6 SOT-86 VV105 

Рис. 8.21 

Рис. 8.20 
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5.9. Добавить на схему два конденсатора из панели Clipboard, и распо-

ложить их над отрезком МПЛ слева и справа. 

Затем выполнить следующие действия: 

– соединить свободный вывод отрезка МПЛ с ближайшими выводами 

конденсаторов; 

– свободные выводы конденсаторов подключить к земле. 

Результат в варианте «П1» на данном этапе показан на рис. 8.22. 

 

Примечание. Отрезок МПЛ и два блокировочных конденсатора обеспе-

чивают развязку по питанию, которое будет подаваться от схемы «токо-

вого зеркала» в точку их соединения. 

По переменному току сопротивление конденсаторов мало. Отрезок 

МПЛ с заданной выше длиной представляет собой четвертьволновый 

трансформатор, и его входное сопротивление обратно пропорционально со-

противлению нагрузки. В результате для СВЧ-сигнала на центральной ча-

стоте со стороны микросхемы усилителя входное сопротивление отрезка 

МПЛ будет достаточно большим, поэтому он пойдет только через разде-

лительный конденсатор на вход микросхемы аттенюатора. 

По постоянному току сопротивление конденсаторов бесконечно боль-

шое, а отрезок МПЛ представляет собой обычный проводник. Поэтому пи-

тание от «токового зеркала» беспрепятственно пройдет на выход микро-

схемы усилителя в соответствии с требованиями ее включения по докумен-

тации и не поступит на вход микросхемы аттенюатора. 

5.10. Сохранить изменения в схеме (Ctrl+S). 

Рис. 8.22 

Сигнал 

СВЧ 

от ПФ 

Сигнал СВЧ 

к микросхеме 

аттенюатора 

Питание от «токового зеркала» 
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6. Создать участок схемы с аттенюатором: 

6.1. Добавить указанную в варианте индивидуального задания микро-

схему аттенюатора из библиотеки DA. 

В варианте «П1» добавлена микросхема HMC467LP3 фирмы Hittite в 

корпусе QFN-16 с размерами 3 × 3 мм (столбец 9 из табл. 1.1). 

Некоторые корпуса микросхем аттенюаторов показаны на рис. 8.23. 

 

6.2. Изучить по документации, которая находится в папке …\ИДРЭС\ 

Компоненты\Аттенюаторы (см. рис. 2.9), назначение и особенность под-

ключения каждого вывода добавленной микросхемы аттенюатора. 

Необходимая информация содер-

жится на функциональной схеме 

(Functional Diagram), на примере 

включения микросхемы (Application 

Circuit), на примере расположения 

микросхемы на плате (Evaluation PCB) 

и в таблице с описанием выводов (Pin 

Descriptions). Названия могут отли-

чаться от приведенных выше в зави-

симости от производителя. 

Условное изображение корпуса 

микросхемы HMC467LP3 с обозначе-

нием выводов показано на рис. 3.25, а, 

а пример ее включения – на рис. 8.24. 

У нее есть следующие выводы: 

– N/C (выводы 1, 2, 4, 9–12, 14, 15), которые внутри корпуса обычно ни-

куда не подключены (no connection). Их наличие связано с тем, что в исполь-

Рис. 8.23 

MSOP-10 TSSOP-16 QFN-16 PDFN-8 

Рис. 8.24 
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зованном стандартном корпусе количество выводов больше, чем требуется 

для работы данной микросхемы. Иногда производитель рекомендует под-

ключать их к земле; 

– VDD (вывод 3), предназначенный для подачи питания (supply voltage). 

Около этого вывода требуется установка блокировочного конденсатора; 

– V1 (вывод 8) и V2 (вывод 5), предназначенные для подачи управляю-

щих напряжений (control voltage) и изменения вносимого ослабления в соот-

ветствии с таблицей Truth Table, рассмотренной в п. 9.14 из 3.3. Иногда про-

изводитель рекомендует подавать управляющие сигналы через токоограни-

чивающие резисторы номиналом 100 Ом; 

– ACG1 (вывод 6) и ACG2 (вывод 7), предназначенные для подключе-

ния к земле через внешние конденсаторы. На ПП располагать такие конден-

саторы необходимо как можно ближе к соответствующим выводам; 

– RF1 (вывод 16) и RF2 (вывод 13), предназначенные для подачи и сня-

тия полезного сигнала через разделительные конденсаторы (вход и выход 

микросхемы). Зачастую они равнозначны; 

– Exposed Pad, находящийся под корпусом микросхемы и предназна-

ченный для соединения с металлическим полигоном (земля). 

При отсутствии отдельного вывода пи-

тания следует освежить в памяти информа-

цию, приведенную в п. 9.12 из 3.3. Напри-

мер, питание для микросхемы SKY12328-

350LF подается в соответствии со схемой, 

фрагмент которой показан на рис. 8.25. 

6.3. Подключить вход микросхемы аттенюатора к свободному выводу 

разделительного конденсатора, установленного на выходе микросхемы уси-

лителя. 

6.4. Добавить разделительный конденсатор из панели Clipboard, а затем 

подключить его к выходу микросхемы аттенюатора. 

Если в панели Clipboard компонента нет (например, Altium Designer за-

крывался), то скопировать его (Ctrl+C) с выхода микросхемы усилителя. 

6.5. Добавить и подключить выходные КП: 

– за последним разделительным конденсатором добавить три компонен-

та PAD_r150_300 из библиотеки PAD, расположив их друг под другом пи-

нами к микросхеме аттенюатора; 

– верхнюю и нижнюю КП подключить к земле; 

Рис. 8.25 
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– среднюю КП подключить к сво-

бодному выводу разделительного кон-

денсатора. 

Результат в варианте «П1» на дан-

ном этапе показан на рис. 8.26. 

6.6. Посчитать количество конденса-

торов (кроме уже расположенных на 

входе и выходе), необходимых для рабо-

ты микросхемы аттенюатора по данным 

из ее документации. После этого по 

табл. 8.3 определить их типоразмер и соответствующие ему первые символы 

из Part Number для серии GRM фирмы Murata. 

Таблица 8.3 

Выбор типоразмера конденсаторов для микросхемы аттенюатора 

Кол. Типоразмер Первые символы Part Number 

1 0805 GRM21 

2 или 3 0603 GRM18 

4 и более 0402 GRM15 

В варианте «П1» по схеме с рис. 8.24 требуется установить два конден-

сатора (1000 и 3300 пФ), но для отличия от других вариантов задания выбран 

типоразмер 0805 (Part Number будет начинаться с символов GRM21). 

Обратить внимание на следующее: 

– у отдельного вывода питания должен быть блокировочный конденса-

тор (если в документации его нет, то руководствоваться рис. 8.24); 

– зависимость типоразмера конденсаторов от количества обусловлена 

возможностью их размещения вокруг корпуса микросхемы на ПП; 

– если установка конденсаторов не требуется, то перейти к п. 6.8. 

6.7. Добавить на схему конденсаторы выбранного типоразмера и требу-

емых номиналов из библиотеки C. 

Если в библиотеке нет нужного конденсатора фирмы Murata, то выпол-

нить следующие действия: 

– по табл. В.1 определить габаритные размеры выбранного типоразмера; 

– в документации на конденсаторы по таблице GRM Series Temperature 

Compensating Type найти номер страницы с Part Number требуемого конден-

сатора для ТКЕ C0G, X7R или X5R. Если в указанной таблице компонента 

нет, то проверить таблицу GRM Series High Dielectric Constant Type; 

Рис. 8.26 
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– в документации перейти на страницу с найденным номером и опреде-

лить Part Number конденсатора с наибольшим допуском номинала; 

– добавить на схему из библиотеки C заготовку конденсатора с шестью 

первыми символами из найденного Part Number; 

– в свойствах добавленного конденсатора заполнить значения парамет-

ров, содержащих символ «*». 

Особенности заполнения параметров: 

– для параметра CI_BOM указать Part Number (вместо символа «#» за-

писать код упаковки D), номинал, допуск, рабочее напряжение, температур-

ный коэффициент емкости (ТКЕ) и типоразмер корпуса. Расшифровка Part 

Number конденсаторов фирмы Murata кроме документации также дана в В.2;  

– диапазон рабочих температур записать из столбца Operating Tempera-

ture Range таблицы Temperature Characteristics Table для выбранного ТКЕ. 

Пример описанных действий для конденсатора типоразмера 0402 с но-

миналом 680 пФ показан на рис. 8.27. 

 Рис. 8.27 

Габаритные размеры  

ТКЕ 
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6.8. По документации на микросхему аттенюатора определить необхо-

димость установки резисторов (например, они могут понадобиться при пода-

че напряжения питания в соответствии с рис. 8.25 или для ограничения тока 

по выводам управления). Если указание об их размещении есть, то добавить 

на схему резисторы фирмы Yageo серии RC любого доступного типоразмера 

(0402, 0603 или 0805) из библиотеки R с требуемыми номиналами. 

Если в библиотеке нет нужного резистора, то выполнить следующее: 

– добавить заготовку резистора с выбранным типоразмером; 

– заполнить значения параметров, содержащих символ «*». Для пара-

метра CI_BOM указать Part Number, номинал, допуск, типоразмер корпуса и 

максимальную рассеиваемую мощность. Расшифровка Part Number резисто-

ров фирмы Yageo содержится в В.1. 

Пример описанных действий для резистора типоразмера 0402 с номина-

лом 4,7 кОм показан на рис. 8.28. 

 

В варианте «П1» по схеме с рис. 8.24 установка резисторов не требуется. 

6.9. Все выводы GND микросхемы аттенюатора подключить к земле. 

Также обратить внимание на рекомендации производителя относительно 

выводов NC. Например, у микросхемы HMC467LP3 их тоже следует под-

ключить к земле (рис. 8.29, а), однако в варианте «П1» для отличия от других 

вариантов задания они были оставлены свободными.  

 

Если к земле подключается несколько близко расположенных выводов, 

то следует соединить их только с одним символом земли (рис. 8.29, б). 

Рис. 8.29 

а б 

Рис. 8.28 
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6.10. Осуществить необходимые соединения добавленных компонентов 

(конденсаторов и резисторов) с выводами микросхемы аттенюатора и землей. 

Результат в варианте «П1» на данном этапе показан на рис. 8.30. 

 

6.11. Добавить идентификатор цепи VCC Power Port и подключить его 

к линии электрической связи, по которой будет поступать напряжение пита-

ния на микросхему аттенюатора. 

Для этого выполнить следующее: 

– на ПИ Wiring (рис. Г.77, а) или Utilities (рис. Г.77, в) щелкнуть ЛКМ 

по требуемому идентификатору; 

– до размещения идентификатора в рабочем поле нажать кнопку Tab; 

– в открывшемся окне свойств выбрать стиль GOST Arrow, включить 

опцию Show Net Name и в поле Net ввести осмысленное имя цепи в соответ-

ствии со значением напряжения питания, поступающим на микросхему атте-

нюатора (оно было указано на схеме Э1 по п. 9.12 из 3.3); 

– применить изменения в окне свойств кнопкой OK; 

– клавишей Space или комбинацией клавиш Shift+Space задать иденти-

фикатору цепи желаемую ориентацию; 

– щелчком ЛКМ установить идентификатор цепи в рабочее поле и за-

вершить команду клавишей Esc или щелчком ПКМ; 

– осуществить необходимое соединение; 

– подвести курсор мышки к линии электрической связи, подключенной 

к идентификатору цепи, и убедиться в правильности переименования цепи.  

Следует отметить, что идентификатор цепи можно сразу установить на 

линию электрической связи, после чего скорректировать его положение. 

Рис. 8.30 
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В варианте «П1» на микросхему аттенюатора 

необходимо подать напряжение питания 5атт +=U  В, 

поэтому цепи присвоено имя +5В (рис. 8.31). 

Указанную величину необходимо сохранить.  

В варианте «П1» вычисления и записи по схеме 

Э3 «усилителя» сохранялись в Matcad в файле Расче-

ты (Э3).xmcd в папке …\ИДРЭС-П1\Усилитель\_За-

метки (см. рис. 2.8). 

6.12. По п. 6.11 добавить и подключить идентифи-

каторы цепей VCC Power Port к выводам управления микросхемы аттенюа-

тора (или к выводам токоограничивающих резисторов при их наличии), задав 

им имена по названиям соответствующих выводов.  

Результат в варианте «П1» показан на рис. 8.32, а, а возможное подклю-

чение к токоограничивающим резисторам – на рис. 8.32, б. 

 

Примечание. Для подобных цепей рекомендуется использовать вариан-

ты оформления с идентификаторами Net Label (см. пп. 3.3 и 3.4 из Г.48). 

6.13. В вариантах задания с ВУ в соответствии с п. 11 из 1.2 добавить в 

любое удобное место схемы разъем управления из библиотеки X. 

В варианте «П1» добавлен разъем IDC-10MS фирмы Connfly.  

Внешние виды некоторых разъемов, используемых при проектировании 

для подачи управляющих сигналов и питания, показаны на рис. 8.33. 

 

MW-2MR CWF-4R-B WF-2R 171856-0003 

Рис. 8.33 Начало (окончание см. на с. 246) 

Рис. 8.32 

а 
б 

Рис. 8.31 
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После этого выполнить следующее: 

– добавить и подключить к выводам разъема идентификаторы цепей 

VCC Power Port с именами, заданными в п. 6.12 (последовательность добав-

ления идентификаторов описана в п. 6.11); 

– один из выводов разъема подключить к земле. 

Примечание. В варианте «П1» подключение разъема произведено в со-

ответствии с рис. 8.34 для отличия от других вариантов задания. 

PWL-2R MPW-2 PWL-2 MPW-2R 

DG300-5.0-02P-12-00A(H) IDC-10MS MF-2MA 

Рис. 8.33 Продолжение (начало см. на с. 245) 

MF-2MR TLPH-200R-02P MF-2MRA IDC-06MR 

MW-5M CWF-6 WF-2 1729128 
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Примечание. Подключение цепей к выводам разъемов 

зачастую должно быть согласовано с другими устрой-

ствами, с которыми предстоит соединение. Например, как 

в интерфейсе USB (Universal Serial Bus – универсальная по-

следовательная шина). В данном проекте на подключение не 

накладывается ограничений. 

6.14. В вариантах задания с РУ в соответствии с 

табл. 1.2 добавить в любое удобное место схемы требуемое 

количество коммутационных устройств из библиотеки S 

(некоторые из них приведены на рис. 8.35). 

При необходимости использования кно-

пок вне зависимости от их количества вы-

брать только один вариант из предлагаемых в 

таблице и указать причину решения в отчете. 

После этого выполнить следующее: 

– добавить и подключить ко всем выво-

дам коммутационных устройств, располо-

женных на одной стороне их УГО (например, 

слева), идентификаторы цепей VCC Power 

Port с именами, заданными в п. 6.12 (после-

довательность действий описана в п. 6.11); 

– если свободных выводов коммутаци-

онных устройств осталось больше одного, то 

объединить их линией электрической связи; 

– добавить и подключить к выводам 

коммутационных устройств без идентификаторов 

цепей идентификатор VCC Power Port с именем 

цепи из п. 6.11; 

– по документации на микросхему аттенюа-

тора проверить, что напряжение, поступающее на 

выводы управления при замыкании контактов в 

коммутационных устройствах, находится в диа-

пазоне значений высокого уровня управляющего напряжения (см. п. 9.14 из 

3.3). Результат проверки сохранить в отчет. 

Возможный результат проделанных действий показан на рис. 8.36. 

6.15. Сохранить изменения в схеме (Ctrl+S). 

Рис. 8.34 

Рис. 8.36 

Рис. 8.35 

DTSM-32N-

V-T/R 

SWD4-4 

MPS-580D-G 
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6.16. Определить максимальный ток потребления микросхемы аттенюа-

тора по питанию ( апI ) и сохранить его. 

При отдельном выводе VDD значение такого тока обычно указывается в 

документации в таблице Bias Voltage & Current или Electrical Specifications. 

Если данные о токе отсутствуют (или подача питания осуществляется в соот-

ветствии с рис. 8.25), то условно принять его равным 0,4 мА. 

В варианте «П1» по рис. 3.26: 

2,1ап =I  мА. 

6.17. В вариантах задания с РУ определить максимальный ток потребле-

ния микросхемы аттенюатора по управляющим выводам ( ауI ): 

упрупрау NII = , 

где упрI  – максимальный ток потребления по одному управляющему выво-

ду, мА; упрN  – количество управляющих выводов, шт. 

Значение тока упрI  обычно указывается в документации в таблице Elec-

trical Specifications или TTL/CMOS Control Voltages или в примечаниях к таб-

лице Truth Table. Если данные о токе отсутствуют, то условно принять его 

равным 10 мкА. 

7. Создать участок схемы с «токовым зеркалом»: 

7.1. Добавить транзисторную сборку BCV62A,215 фирмы Nexperia из 

библиотеки VT и подключить вывод 2 (коллектор правого транзистора) к ме-

сту соединения двух блокировочных конденсаторов и отрезка МПЛ на выхо-

де микросхемы усилителя. 

Внешний вид и УГО транзисторной сборки показаны на рис. В.24. 

7.2. Добавить три заготовки резистора типоразмера 0805 с вертикальной 

ориентацией УГО (компонент R0805 из библиотеки R) и подключить их к 

выводам 1, 3 и 4 транзисторной сборки. 

Внешний вид таких резисторов показан на рис. В.1, а. 

7.3. Свободный вывод резистора у коллектора левого транзистора тран-

зисторной сборки подключить к земле. 

7.4. Свободные выводы резисторов в цепях эмиттеров транзисторов 

транзисторной сборки соединить друг с другом с отводом линии электриче-

ской связи (например, вправо). 

7.5. Около цепи коллектора правого транзистора транзисторной сборки 

последовательным нажатием клавиш P ⇒ F (создание текстового блока) по-
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местить надпись со значением тока КпI  и напряжения КпU  на этом выводе 

(они были указаны на схеме Э1 по п. 9.7 из 3.3). 

В свойствах текстового блока изменить размер шрифта на 12 и отклю-

чить опцию Show Border. 

Примечание. Размещение подобной информации 

не соответствует п. 4.1 из 8.1. 

7.6. Для определенности в дальнейших действи-

ях в свойствах каждого резистора, подключенного к 

транзисторной сборке, вручную заменить знак во-

проса в позиционном обозначении порядковым но-

мером в соответствии с рис. 8.37. 

7.7. Рассчитать сопротивления резисторов в схе-

ме «токового зеркала», являющегося генератором 

тока, который управляется током. 

Название «токовое зеркало» связано с тем, что 

ток КпI  пропорционален току на резисторе R3 в це-

пи коллектора левого транзистора ( R3I ) и может 

быть приближенно вычислен по формуле: 

 R2R1II R3 Кп . (8.1) 

Последовательность расчетов следующая: 

7.7.1. Задать падение напряжения на резисторе R2 ( R2U ) по нижней гра-

нице условия: 

 КпКпmax9,0 IdUIP R2  , (8.2) 

где maxP  – максимальная рассеиваемая мощность резистора, Вт (см. В.1); 

d  – коэффициент пропорциональности, 13=d  Ом.  

В варианте «П1»: 

455,0035,013 ==R2U  В. 

7.7.2. Обеспечить активный режим работы правого транзистора транзи-

сторной сборки (см. В.8), для чего выбрать напряжение коллектор–эмиттер 

этого транзистора из условия КЭнасКЭп UU  . 

По документации на транзисторную сборку BCV62A,215 при макси-

мальном токе коллектора 100 мА максимальное значение КЭнасU  составляет 

0,65 В. Фрагмент таблицы Characteristics показан на рис. 8.38. 

Во всех вариантах задания принять 7,0КЭп =U  В. 

Рис. 8.37 
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7.7.3. Определить минимальную величину напряжения питания, требуе-

мую для подачи на «токовое зеркало» ( тзU ), по формуле: 

 R2UUUU ++= КЭпКптз . (8.3) 

В варианте «П1»: 

575,4455,07,042,3тз =++=U  В. 

7.7.4. Сравнить значения напряжений тзU  и аттU  и выполнить действия, 

указанные в табл. 8.4. 

Таблица 8.4 

Сравнение напряжений, поступающих на схему «токового зеркала» 

и на вывод питания микросхемы аттенюатора 

Условие Действие 

атттз UU   
Напряжение тзU  принять равным аттU  и пересчитать R2U , 

используя (8.3) 

атттз UU   

Напряжение R2U  выбрать из середины диапазона по (8.2), 

после чего пересчитать тзU  по (8.3), округлив результат до 

десятых долей вольта 

Так как в варианте «П1» атттз UU  , то тзU  принимается равным 5 В и 

R2U  вычисляется следующим образом: 

88,07,042,35КЭпКптз =−−=−−= UUUUR2  В. 

7.7.5. Определить сопротивление резистора R2 и округлить его к бли-

жайшему номиналу в большую сторону из ряда E24 по табл. В.2.  

В пренебрежении током базы правого транзистора в транзисторной 

сборке требуемое сопротивление вычисляется по формуле: 

КпIUIUR2 R2R2R2 == , 

где R2I  – ток, протекающий через резистор R2, мА.  

В варианте «П1»: 

1,25035,088,0 ==R2  Ом 27  Ом. 

7.7.6. Определить ток, протекающий через резистор R3 ( 3RI ).  

Рис. 8.38 
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Для уменьшения тока потребления «токовым зеркалом» данный ток в 

вариантах задания выбирается в десять раз меньше, чем КпI : 

 10КпIIR3 = . (8.4) 

В варианте «П1»: 

 5,310035,0 ==R3I  мА.  

7.7.7. Определить сопротивление резистора R1 и убедиться в том, что 

его значение соответствует номиналу из ряда E24 по табл. В.2. 

Сопротивление резистора R1 можно найти по (8.1) и (8.4): 

R2IR2IR1 R3 == 10Кп . 

В варианте «П1»: 

2702710 ==R1  Ом. 

7.7.8. Определить сопротивление резистора R3 и выбрать ближайший 

номинал из ряда E24 по табл. В.2. 

Для левого транзистора в транзисторной сборке между напряжениями 

коллектор–эмиттер ( КЭлU ) и база–эмиттер ( БЭлU ) выполняется равенство: 

7,0БЭлКЭл ==UU  В. 

В результате требуемое сопротивление вычисляется по формуле: 

R3

R3

R3

R3

I

UIR1U

I

U
R3 КЭлтз −−

== , 

где R3U  – напряжение на резисторе R3, В. 

В варианте «П1»: 

6,958
105,3

7,0105,32705

3

3

=


−−
=

−

−

R3  Ом 1  кОм. 

7.7.9. При желании выполнить 3-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. И). 

7.8. Заменить каждую заготовку резистора, подключенную к транзи-

сторной сборке, на резистор фирмы Yageo серии RC с типоразмером 0805 и 

требуемым номиналом из библиотеки R: 

– открыть окно свойств заготовки резистора; 

– в группе Link to Library Component напротив поля Design Item ID 

нажать кнопку Choose; 

– в открывшемся окне Browse Libraries выбрать требуемый компонент 

(пример выбора резистора с номиналом 27 Ом показан на рис. 8.39); 

– применить изменения в двух окнах кнопкой OK. 
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Если в библиотеке нет нужного резистора, то в заготовке заполнить зна-

чения параметров, содержащих символ «*», по аналогии с рис. 8.28. 

Расшифровка Part Number резисторов фирмы Yageo содержится в В.1. 

Выбранные в варианте «П1» резисторы: 

– RC0805JR-0727RL; 

– RC0805JR-07270RL; 

– RC0805JR-071KL. 

7.9. Добавить и подключить к линии электриче-

ской связи, соединяющей верхние выводы резисто-

ров, которые подключены к эмиттерам транзисторов 

транзисторной сборки, идентификатор цепи VCC 

Power Port (последовательность добавления иден-

тификаторов описана в п. 6.11), при этом: 

– если атттз UU = , то выбрать имя цепи, задан-

ное в п. 6.11; 

– если атттз UU  , то ввести осмысленное имя 

цепи в соответствии со значением тзU . 

Результат в варианте «П1» на данном этапе показан на рис. 8.40. 

7.10. Сохранить изменения в схеме (Ctrl+S). 

7.11. Определить ток, потребляемый «токовым зеркалом» ( тзI ). 

В пренебрежении токами баз транзисторов в транзисторной сборке тре-

буемое значение тока вычисляется следующим образом: 

 Кптз IIIII R3R2R1 +=+= ,  

где R1I  – ток, протекающий через резистор R1, мА. 

Рис. 8.39 

Рис. 8.40 
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В варианте «П1»: 

 5,381035105,3 33
тз =+= −−I  мА.  

7.12. Определить температуру кристалла транзисторной сборки без теп-

лоотвода для комнатной температуры по (В.7), сравнить с границами рабоче-

го диапазона температур, а результат сравнения привести в отчете. 

Необходимые параметры находятся в документации на транзисторную 

сборку в таблицах Limiting values и Thermal characteristics. 

Так как в произведенных выше расчетах 7,0КЭлКЭп ==UU  В, то в ва-

рианте «П1»: 

°C5,38255007,00385,0КЭптз =+=+=  AJAj TRUIT . 

8. Создать участок схемы с узлом вторичного питания: 

8.1. В соответствии с табл. 8.5 определить вариант организации питания 

и необходимые для этого компоненты. 

Таблица 8.5 

Варианты организации питания 

№ Условие Организация питания 

1 атттз UU =  

Напряжение тзU  сформировать с помощью микросхемы стабилизато-

ра напряжения MIC5209-X.XYS (корпус SOT-223) фирмы Microchip с 

фиксированным выходным напряжением, где Х.Х – его уровень 

2 атттз UU   

Напряжение тзU  сформировать с помощью микросхемы стабилизато-

ра напряжения MIC5209YM (корпус SOIC-8-150) фирмы Microchip с 

подстраиваемым выходным напряжением (adjustable). 

Напряжение аттU  получить из тзU  с использованием параметриче-

ского стабилизатора напряжения 

Документация на указанные в таблице микросхемы находится в папке 

…\ИДРЭС\Компоненты\Стабилизаторы. Фрагмент раздела Product Identi-

fication System с расшифровкой обозначений показан на рис. 8.41. 

 Рис. 8.41 



 

 254 

Примечание. В варианте «П1» питание будет организовано по вариан-

ту № 1, а так как 5тз =U  В, то используется микросхема MIC5209-5.0YS. 

Корпуса SOT-223 и SOIC-8-150 показаны на рис. 8.42. 

 

8.2. Добавить из библиотеки DA указанную в табл. 8.5 микросхему и 

расположить в любом удобном месте схемы с учетом того, что справа и слева 

от нее будут устанавливаться компоненты. 

8.3. Все выводы GND микросхемы стабилизатора напряжения подклю-

чить к земле. 

8.4. В варианте № 2 организации питания (см. табл. 8.5) добавить две за-

готовки резистора с вертикальной ориентацией УГО типоразмера 0603 или 

0805 (компонент R0603 или R0805 из библиотеки R соответственно), после 

чего осуществить необходимые соединения в соответствии со схемой из до-

кументации на микросхему стабили-

затора напряжения, приведенной на 

рис. 8.43. Также для определенности в 

дальнейших действиях в соответствии 

с рисунком в свойствах этих двух ре-

зисторов вручную заменить знаки во-

проса в позиционных обозначениях 

порядковыми номерами 1 и 2. 

Номиналы резисторов выбрать из ряда E24 по табл. В.2 (они должны 

быть не менее 10 кОм, а для резистора R2 – еще и не более 470 кОм), обес-

печив требуемое выходное напряжение, определяемое по формуле: 

 







+==

R1

R2
UUout 1242,1тз . (8.5) 

В отчете показать, что найденные номиналы резисторов обеспечивают 

необходимое напряжение. Для этого подставить их в (8.5). 

Рис. 8.42 

SOT-223 SOIC-8-150 

Рис. 8.43 
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После этого заменить обе заготовки на резисторы фирмы Yageo серии 

RC с соответствующими типоразмером и номиналом из библиотеки R (по-

следовательность действий приведена в п. 7.8).  

Если в библиотеке нет нужного резистора, то в заготовке заполнить зна-

чения параметров, содержащих символ «*», по аналогии с рис. 8.28. 

Расшифровка Part Number резисторов фирмы Yageo содержится в В.1. 

Примечание. В схеме из документации на микросхему стабилизатора 

кроме резисторов присутствуют блокировочные конденсаторы, но на 

рис. 8.43 они не показаны и будут добавлены далее. 

8.5. В варианте № 2 организации питания (см. табл. 8.5) для схемы с 

рис. 8.43, пренебрегая током на выводе ADJ, определить протекающий через 

резистивный делитель ток ( дI ): 

)(тзд R2R1UI += . 

8.6. Добавить и подключить на вход и выход микросхемы стабилизатора 

напряжения по одному блокировочному конденсатору (назначение см. в В.2 

и В.10) фирмы Murata с параметрами: 

– типоразмер – 0805; 

– ТКЕ – U2J; 

– номинал – 0,1 мкФ; 

– рабочее напряжение – 10 В; 

– код упаковки – L. 

Так как в библиотеке C такого компонента нет, то выполнить последо-

вательность действий по аналогии с п. 6.7. Результаты сохранить в отчет. 

8.7. Параллельно каждому блокировочному конденсатору добавить и 

подключить по одному танталовому конденсатору фирмы Vishay серии 293D 

из библиотеки, созданной в разд. 5 (в варианте «П1» – Capacitors-П1.IntLib), 

после чего выполнить следующие действия с сохранением в отчет: 

 

– по таблице Ratings and case codes из документации на эти конденсато-

ры (ее фрагмент показан на рис. 8.44) для типоразмера из варианта индиви-

дуального задания на проектирование и номинала 10–33 мкФ выбрать значе-

Рис. 8.44 
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ние максимального постоянного напряжения, которое должно быть как ми-

нимум в 2 раза больше выходного напряжения стабилизатора ( тзU ). 

Примечание. В варианте «П1» для типоразмера С номинал выбран рав-

ным 22 мкФ, а напряжение – 10 В; 

– по таблице Standard Ratings из документации (ее фрагмент показан на 

рис. 8.45) для известных типоразмера, номинала и напряжения определить 

Part Number, задав допуск ±10 % (код X9) и код упаковки и выводов 2TE3; 

 

– в свойствах добавленных конденсаторов заполнить значения парамет-

ров с символом «*». Для параметра CI_BOM указать Part Number, номинал, 

допуск, рабочее напряжение и типоразмер корпуса. Расшифровка Part Num-

ber конденсаторов фирмы Vishay кроме документации также дана в В.2. 

Пример заполненных параметров в варианте «П1» показан на рис. 8.46. 

 

8.8. Добавить и подключить к линии электрической связи, отходящей от 

выхода микросхемы стабилизатора напряжения, идентификатор цепи VCC 

Power Part с именем цепи, заданным при создании схемы «токового зерка-

ла» в п. 7.9 (соответствует значению напряжения тзU ). 

Рис. 8.46 

Рис. 8.45 
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Последовательность добавления идентификаторов описана в п. 6.11. 

Результат в варианте «П1» на данном этапе показан на рис. 8.47. 

 

8.9. При наличии ИПС (см. столбец 14 из индивидуального задания на 

проектирование) подключить к выходу микросхемы стабилизатора напряже-

ния светодиод с токоограничивающим резистором (см. В.7): 

– добавить светодиод фирмы FYLS типоразмера 0805 или 0603 с любым 

доступным цветом свечения из библиотеки VD и заготовку резистора типо-

размера 0805 или 0603 из библиотеки R; 

– в соответствии с рис. В.21 осуществить требуемые подключения.  

Получение нужного вида УГО светодиода (стрелки, обозначающие из-

лучение, должны быть направлены слева направо и снизу вверх) показано на 

рис. 8.48 (над УГО приведены фрагменты панели SCH Inspector). 

 Рис. 8.48 

Рис. 8.47 
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Примечание. Подробнее об альтернативных видах УГО см. в Г.32. 

Также ИПС можно подключить к микросхеме логически, т. е. с помо-

щью идентификатора цепи VCC Power Port с соответствующим именем, при 

этом расположив сами компоненты в любом месте схемы; 

– по документации на добавленный светодиод найти значения прямого 

напряжения ( свU ) и тока ( свI ) для относительной силы света, равной 0,5; 

– рассчитать сопротивление резистора по (В.4); 

– выбрать номинал резистора округленным в большую сторону из ряда 

E24 по табл. В.2; 

– заменить заготовку резистора на резистор фирмы Yageo серии RC с 

соответствующими типоразмером и номиналом из библиотеки R (последова-

тельность действий приведена в п. 7.8). 

Если в библиотеке нет нужного резистора, то в заготовке заполнить зна-

чения параметров, содержащих символ «*», по аналогии с рис. 8.28. 

Расшифровка Part Number резисторов фирмы Yageo содержится в В.1. 

8.10. В варианте № 2 организации питания (см. табл. 8.5) подключить к 

выходу микросхемы стабилизатора напряжения параметрический стабилиза-

тор напряжения, выполненный на стабилитроне (см. В.6): 

– в соответствии со значением аттU  по документации на стабилитроны 

серии BZX84 фирмы Nexperia выбрать номинальное напряжение стабилиза-

ции и его допуск (расшифровка Part Number приведена в В.6); 

– добавить стабилитрон с выбранными параметрами из библиотеки VD 

и заготовку резистора типоразмера 0805 или 0603 из библиотеки R; 

– в соответствии с рис. В.18 осуществить требуемые подключения. 

Параметрический стабилизатор напряжения можно подключить к мик-

росхемам стабилизатора напряжения и аттенюатора логически, т. е. с помо-

щью идентификаторов цепей VCC Power Port с соответствующими имена-

ми, при этом расположив сами компоненты в любом месте схемы; 

– определить потребляемый нагрузкой ток по формуле: 

ауапН III += . 

Следует отметить, что в вариантах задания с ВУ ток ауI  отсутствует; 

– задать номинальный ток стабилизации стабилитрона в соответствии с 

рекомендациями по расчету параметрического стабилизатора напряжения; 

– рассчитать сопротивление резистора по (В.3); 

– выбрать ближайший номинал резистора из ряда E24 по табл. В.2; 
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– заменить заготовку резистора на резистор фирмы Yageo серии RC с 

соответствующими типоразмером и номиналом из библиотеки R (последова-

тельность действий приведена в п. 7.8). 

Если в библиотеке нет нужного резистора, то в заготовке заполнить зна-

чения параметров, содержащих символ «*», по аналогии с рис. 8.28. 

Расшифровка Part Number резисторов фирмы Yageo содержится в В.1; 

– при отдельном расположении параметрического стабилизатора напря-

жения убедиться в правильности имен у добавленных идентификаторов це-

пей. Входное напряжение должно поступать с выхода микросхемы стабили-

затора напряжения, а выходное напряжение должно уходить на микросхему 

аттенюатора и коммутационные устройства (при наличии). 

8.11. Определить суммарный ток на выходе микросхемы стабилизатора 

напряжения ( outI ) по формуле: 

дсвСТауаптз IIIIIIIout +++++= . 

Следует отметить, что отдельные слагаемые могут отсутствовать.  

В варианте «П1»: 

7,39102,1105,38 33
аптз =+=+= −−IIIout  мА. 

8.12. Определить по документации на 

микросхему стабилизатора напряжения зна-

чение тока потерь (Ground Pin Current, 

GNDI ) и сохранить его. 

Необходимая информация обычно при-

водится в таблице Electrical Characteristics и 

на графике зависимости тока потерь от вы-

ходного тока, показанном для микросхем се-

рии MIC5209 на рис. 8.49. 

В варианте «П1» при выходном токе 

микросхемы 7,39=outI  мА значение тока 

потерь составит примерно 0,4 мА. 

8.13. Определить ток на входе микросхемы стабилизатора напряжения 

( inI ) по формуле: 

GNDoutin III += . 

В варианте «П1»: 

1,40104,0107,39 33 =+= −−
inI  мА. 

Рис. 8.49 
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8.14. Определить диапазон значений входного напряжения ( inU ) для по-

дачи на вход микросхемы стабилизатора напряжения. 

Стабилизаторы серии MIC5209 обладают малым падением напряжения 

(Low Dropout Voltage, LDO). Величина Dropout Voltage ( DOU ) определяется 

как разность между входным и выходным напряжением, при котором выход-

ное напряжение падает на 2 % ниже его 

номинального значения, измеренного при 

разности напряжений в 1 В. 

Значения DOU  обычно приводятся в 

документации на микросхему в таблице 

Electrical Characteristics и на графике его 

зависимости от выходного тока, показан-

ном для микросхем серии MIC5209 на 

рис. 8.50. 

Для нормальной работы используе-

мых при проектировании микросхем 

должно выполняться условие: 

 DOoutin UUU + . (8.6) 

Порядок выполнения расчета: 

– по рис. 8.50 для тока outI  найти значение DOU  и сохранить его. 

В варианте «П1» оно примерно равно 0,1 В; 

– определить минимальное значение входного напряжения ( mininU ) по 

формуле: 

 1,0min ++= DOoutin UUU .  

В варианте «П1»: 

2,51,01,05min =++=inU  В; 

– определить максимальное значение входного напряжения ( maxinU ) по 

формуле: 

 minmax 5,1 inin UU = .  

В варианте «П1»: 

8,72,55,1max ==inU  В. 

8.15. Если maxinU  превышает 8 В, то заменить заготовку керамического 

конденсатора на входе микросхемы стабилизатора напряжения на керамиче-

ский конденсатор GRM31C5C1H104JA01L с таким же номиналом (0,1 мкФ) 

Рис. 8.50 
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в корпусе типоразмера 1206 и номинальным напряжением 500 В (последова-

тельность действий приведена в п. 7.8). 

8.16. Определить температуру кристалла микросхемы стабилизатора 

напряжения без теплоотвода для комнатной температуры и для наихудшего 

случая падения напряжения. 

Порядок выполнения расчета: 

– найти минимальное значение выходного напряжения ( minoutU ). 

По таблице Electrical Characteristics из документации на рассматривае-

мые микросхемы, фрагмент которой показан на рис. 8.51, отклонение от но-

минального значения в общем случае составляет ±2 %. 

 

В варианте «П1»: 

 9,498,0598,0min === outout UU  В;  

– определить рассеиваемую кристаллом мощность ( сP ) по формуле: 

 ( ) GNDinoutoutin IUIUUP +−= maxminmaxс .  

В варианте «П1»: 

 ( ) 118,0104,08,7107,399,48,7 33
с =+−= −−P  Вт;  

– определить температуру кристалла по (В.7). 

В варианте «П1»: 

 °C3,322562118,0с =+=+=  AJAj TRPT .  

Значения JAR  для используемых корпусов находятся в документации 

на микросхему в таблице MIC5209 Thermal Resistance; 

– сравнить полученное значение температуры кристалла с границами 

рабочего диапазона температур, приведенными в документации в разделе 

Temperature Specifications (результат сравнения привести в отчете). 

8.17. Добавить и подключить ко входу микросхемы стабилизатора 

напряжения перед блокировочными конденсаторами дроссель SDR0604-

220YL фирмы Bourns из библиотеки L. 

Назначение дросселя и расшифровка его Part Number приведены в В.3. 

Рис. 8.51 
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8.18. По В.11 ознакомиться со структурой и принципом работы схемы 

ЗП, указанной в столбце 14 из индивидуального задания на проектирование. 

8.19. Добавить требуемый в схеме ЗП компонент и подключить его к 

свободному выводу дросселя. 

Также выполнить следующее: 

– в схемах ЗП-1, ЗП-2 и ЗП-5 определить падение напряжения ( зпU ) на 

полупроводниковых компонентах для протекающего через них тока inI . В 

схемах ЗП-3 и ЗП-4 оно отсутствует, а в схеме ЗП-6 пренебрежимо мало; 

– в схеме ЗП-6 проверить выполнение условия: 

2maxЗИmax − UUin . 

Если оно не выполняется, то maxinU  уменьшить до верхней границы 

условия. 

8.20. В соответствии с информацией п. 11 из 1.2 добавить разъем пита-

ния из библиотеки X и подключить его к схеме ЗП (клеммы «+» и «–» на ри-

сунках из В.11). 

При необходимости можно выбрать дополнительный вид УГО (Alter-

nate 1). Подробнее о видах УГО и их использовании см. в Г.32. 

Примечание. В варианте «П1» добавлен разъем MW-2MR фирмы 

Connfly. Внешние виды некоторых используемых при проектировании разъ-

емов показаны на рис. 8.33. 

8.21. Около разъема питания над линией электрической связи последо-

вательным нажатием клавиш P ⇒ F (создание текстового блока) поместить 

надпись с указанием диапазона входного напряжения питания и током по-

требления «усилителя». 

В свойствах текстового блока изменить размер шрифта на 12 и отклю-

чить опцию Show Border. 

Минимальное ( minXU ) и максимальное ( maxXU ) значения входного 

напряжения в вариантах задания рассчитываются по формулам: 

зпminmin UUU inX += ,  

зпmaxmax UUU inX += . 

Следует обратить внимание на следующее: 

– падением напряжения на дросселе можно пренебречь из-за малого 

значения сопротивления по постоянному току (0,19 Ом). Фрагмент таблицы 

Electrical Specifications из документации на дроссель показан на рис. 8.52; 

– напряжение maxinU  в схеме ЗП-6 по п. 8.19 могло быть пересчитано. 
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В варианте «П1»:  

2,5minmin == inX UU  В, 

8,7maxmax == inX UU  В. 

Ток потребления во всех вариантах задания – inI  (в схемах ЗП-3, ЗП-4 и 

ЗП-5 обратными токами диодов можно пренебречь). 

Участок схемы с разъемом питания, схемой ЗП-3 и дросселем в варианте 

«П1» показан на рис. 8.53. 

 

8.22. Сохранить изменения в схеме (Ctrl+S). 

9. Завершить оформление схемы: 

9.1. Так как в УГО микросхемы аттенюатора указана функция, не уста-

новленная в ГОСТ 2.743–91 и ГОСТ 2.759–82, то на поле схемы необходимо 

дать соответствующее пояснение. 

Для этого над основной надписью рамки на расстоянии не менее 10 мм 

от нее последовательным нажатием клавиш P ⇒ T (создание надписи) поме-

стить текст вида: «Дополнительное обозначение функции микросхемы: dB – 

аттенюатор». 

Примечание. Микросхем с разными нестандартными функциями в схе-

мах может быть несколько. Чтобы ничего не пропустить, в подобных биб-

лиотечных компонентах введено два параметра с префиксом «SI_» (symbol 

information): SI_Function – обозначение функции, которое отображается в 

УГО; SI_Function Description – расшифровка функции. Получить список не-

стандартных функций в текущей схеме можно следующими способами: 

Рис. 8.52 

Рис. 8.53 
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– командой Reports ⇒ Bill of Materials (см. п. 5 из 9.2) с группировкой по 

параметру SI_Function Description (рис. 8.54). В этом способе информацию 

можно скопировать только после экспорта в файл; 

 

– командой Tools ⇒ Parameter Manager с включенными опциями Parts, 

Objects with existing used parameters и Exclude System Parameters. В появив-

шемся окне сосписком параметров компонентов данные сортируются по 

столбцу SI_Function Description (рис. 8.55). В этом способе нет группировки, 

но можно сразу же скопировать информацию из требуемых ячеек; 

 

– в панели SCH List (см. Г.11) с включенными в верхней ее части опциями 

Edit, all objects, open documents of the same project и Parameters. Данные сор-

тируются по столбцу Parameter Name (рис. 8.56). В этом способе также 

нет группировки, но можно сразу же скопировать информацию из требуе-

мых ячеек столбца Value. 

 

9.2. Объединить в класс цепей с именем Power цепь GND и цепи пита-

ния с установленными идентификаторами цепей VCC Power Port. 

Для этого выполнить следующее: 

– запустить команду Place ⇒ Directives ⇒ Net Class; 

– до размещения условного знака класса цепей (один из видов директив) 

на схеме нажать кнопку Tab; 

Рис. 8.54 

Рис. 8.56 

Рис. 8.55 
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– в открывшемся окне свойств в полях Name (текст, который будет 

отображатся около знака директивы на схеме) и Value (название класса це-

пей, которое будет передано на ПП) записать Power (рис. 8.57); 

 

– применить изменения в окне свойств кнопкой OK; 

– щелчком ЛКМ установить знак директивы на линию электрической 

связи, отходящей от выхода микросхемы стабилизатора напряжения, предва-

рительно повернув его клавишей Space нужным образом; 

– не выходя из команды, установить такой же знак директивы на любой 

участок линии электрической связи цепи GND, а также на линию электриче-

ской связи, отходящую от катода стабилитрона в параметрическом стабили-

заторе напряжения (при наличии); 

– завершить команду клавишей Esc или ПКМ. 

Результат создания класса цепей в варианте «П1» показан на рис. 8.58.  

 

Примечание. В свойствах директивы класса цепей с помощью кнопки 

Add as Rule можно задавать правила проектирования, которые также бу-

дут переданы на ПП. Однако работать с ними удобнее в редакторе ПП. 

9.3. С помощью идентификаторов цепей Net Label (метка цепи) присво-

ить цепям линий электрической связи, по которым проходит СВЧ-сигнал, 

новые имена вида MW-X, где X – порядковый номер. 

Для этого выполнить следующее: 

– последовательно нажать клавиши P ⇒ N; 

– до размещения идентификатора цепи нажать кнопку Tab; 

– в открывшемся окне свойств в поле Net записать MW-1 и применить 

изменения кнопкой OK; 

Рис. 8.58 

Рис. 8.57 
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– щелчками ЛКМ последовательно установить метки цепей на любые 

сегменты линий электрической связи в соответствии с табл. 8.6. Следует об-

ратить внимание на то, что в имени каждой следующей метки цепи цифра 

будет увеличиваться автоматически; 

– завершить команду клавишей Esc или ПКМ. 

Таблица 8.6 

Расположение меток цепей на линиях электрической связи из СВЧ-тракта 

Имя метки цепи Линия электрической связи 

MW-1 От входной КП до первого отрезка МПЛ в ПФ 

MW-2 От последнего отрезка МПЛ в ПФ до разделительного конденсатора 

MW-3 От разделительного конденсатора до входа микросхемы усилителя 

MW-4 От выхода микросхемы усилителя до разделительного конденсатора 

MW-5 От разделительного конденсатора до входа микросхемы аттенюатора 

MW-6 От выхода микросхемы аттенюатора до разделительного конденсатора 

MW-7 От разделительного конденсатора до выходной КП 

Фрагмент схемы около микросхемы усилителя с установленными мет-

ками цепей в варианте «П1» показан на рис. 8.59.  

 

Примечание. Класс цепей для СВЧ-тракта будет создан в редакторе 

ПП, чтобы не загромождать схему большим количеством директив. 

9.4. Объединить в класс компонентов с именем ТоковоеЗеркало компо-

ненты из «токового зеркала». 

Для этого выполнить следующее: 

– в панели SCH Inspector установить отображение свойств только объ-

ектов Part (см. Г.10); 

– в схеме массовым выделением мышкой выбрать «токовое зеркало»; 

– в панели SCH Inspector в группе Parameters в последней строке напро-

тив Add User Parameter ввести название класса компонентов и нажать кла-

вишу Enter; 

– в появившемся окне ввести имя параметра ClassName и нажать OK. 

 Результат на данном этапе в варианте «П1» показан на рис. 8.60; 

Рис. 8.59 
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– в панели SCH Inspector установить отображение свойств всех объек-

тов (см. Г.10).  

9.5. Из-за наличия знака «+» в УГО полярных конденсаторов системные 

параметры Designator и Comment автоматически расположились выше анало-

гичных параметров в УГО обычных конденсаторов (см. рис. 8.47). 

Для корректировки положения параметров выполнить следующее: 

– перейти в сетку 0,5 мм; 

– перейти в панель SCH Filter и убедиться в том, что в группе Limit 

search to выбрана опция All Objects, а в группах Objects passing the filter и 

Objects not passing the filter все опции включены. 

Примечание. Особенности работы с панелью SCH Filter см. в Г.12; 

– в панели SCH Filter в поле для записи условия фильтрации записать 

выражение (IsDesignator Or IsComment) and (Object_Orientation(Parent) = 

'0 Degrees') and (Object_DesignItemID(Parent) Like '*Polar*'), после чего 

нажать кнопку Apply. 

В результате будут выбраны параметры Designator и Comment в компо-

нентах с УГО, повернутым на 0°, и названием, содержащим Polar; 

– запустить команду Edit ⇒ Align ⇒ Align To Grid для выравнивания 

выбранных параметров по сетке; 

Рис. 8.60 
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– запустить команду Edit ⇒ Move ⇒ Move Selection by X, Y; 

– в открывшемся окне в поле X ввести сдвиг 0.5mm по горизонтали, в 

поле Y – сдвиг 1.5mm со знаком минус по вертикали и применить изменения 

кнопкой OK; 

– в панели SCH Filter в поле для записи условия фильтрации записать 

выражение (IsDesignator Or IsComment) and (Object_Designator(Parent) 

like 'C*') and Not (Object_DesignItemID(Parent) Like '*Polar*') and  

((Object_Orientation(Parent) = '90 Degrees') or (Object_Orientation(Parent) 

= '270 Degrees')), после чего нажать кнопку Apply. 

В результате будут выбраны параметры Designator и Comment в компо-

нентах с позиционным обозначением, начинающимся с С, и с УГО, поверну-

тым на 90° или 270°, и названием, которое не содержит Polar; 

– запустить команду Edit ⇒ Align ⇒ Align To Grid для выравнивания 

выбранных параметров по сетке; 

– запустить команду Edit ⇒ Move ⇒ Move Selection; 

– вручную зажатой ЛКМ скорректировать положение выбранных пара-

метров в соответствии с их расположением в УГО полярных конденсаторов; 

– снять маску фильтра комбинацией клавиш Shift+C; 

– перейти в сетку 3 мм. 

Результат корректировки положения параметров около микросхемы ста-

билизатора напряжения в варианте «П1» показан на рис. 8.61. 

 

9.6. Убедиться в том, что на схеме нет пересечений между различными 

объектами (за исключением директив). При обнаружении таких мест (напри-

мер, параметры налезают на графику УГО) исправить их вручную. 

9.7. Выполнить автоматическое присвоение порядковых номеров в по-

зиционных обозначениях (перенумерацию): 

– для соблюдения п. 3.9 из 8.1 в свойствах отрезка МПЛ, расположенно-

го на выходе микросхемы усилителя, вручную в позиционном обозначении 

заменить знак вопроса числом 1 и включить опцию Locked (рис. 8.62); 

Рис. 8.61 
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– запустить команду Tools ⇒ Annotation ⇒ Annotate Schematics; 

– в открывшемся окне Annotate в группе Order of Processing выбрать оп-

цию Down Then Across, а в группе Process Location of – опцию Part; 

– убедиться в том, что в группе Proposed Change List слева от позицион-

ного обозначения W1 стоит галочка; 

– нажать кнопку Reset All и в появившемся окне Information согласить-

ся с изменениями (будут сброшены порядковые номера во всех незаблокиро-

ванных позиционных обозначениях); 

– нажать кнопку Update Changes List и в появившемся окне Infor-

mation согласиться с изменениями; 

– нажать кнопку Accept Changes (Create ECO); 

– в появившемся окне Engineering Change Order нажать кнопку Execute 

Changes для внесения предлагаемых изменений в схему; 

– закрыть окна Engineering Change Order и Annotate кнопками Close. 

Примечание. Подробнее о настройках окна Annotate см. в Г.31. 

9.8. Скомпилировать проект ПП, выполнив на нем команду ПКМ ⇒ 

Compile PCB Project (на текущем этапе проверяется только схема). 

После этого открыть окно Messages (если оно не открылось автоматиче-

ски), выбрав его из группы System в дополнительном меню (см. рис. 3.1), и 

убедиться в том, что отсутствуют нарушения (рис. 8.63). 

 

Если в списке есть обнаруженные ошибки и предупреждения, то все их 

необходимо внимательно проанализировать и исправить, при этом стоит об-

ратить внимание на следующее: 

– часто встречающиеся ошибки и предупреждения, а также способы их 

устранения, приведены в табл. 8.7; 

– если по строке с нарушением в окне Messages сделать двойной щелчок 

ЛКМ, то оно будет выделено в рабочем поле. Чтобы очистить выделение, 

необходимо нажать комбинацию клавиш Shift+C; 

Рис. 8.63 

Рис. 8.62 
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Таблица 8.7 

Некоторые ошибки и предупреждения после компиляции проекта в схеме  

Ошибка или  

предупреждение 
Причина Способ устранения 

Floating N at (X,Y) Отсутствует подключение к 

идентификатору цепи N, рас-

положенному в координатах 

(X, Y) 

Удалить идентификатор цепи (если 

он лишний) или подключить его к 

требуемому участку линии элек-

трической связи 

Net N has only one 

pin (Pin Z-X) 

Цепь N подключена только к 

одному пину (пин номер X в 

компоненте Z) 

Удалить линии электрической свя-

зи указанной цепи (если они лиш-

ние) или осуществить требуемые 

подключения (например, с помо-

щью идентификатора цепи)  

Unconnected line 

(X,Y) To (X1,Y1) 

Неподключенная линия элек-

трической связи, проходящая 

между точками с координа-

тами (X, Y) и (X1, Y1)   

Удалить указанную линию элек-

трической связи 

Un-Designated Part 

N? 

В позиционном обозначении 

компонента с буквенным ко-

дом N вместо порядкового 

номера остался знак «?» Выполнить перенумерацию схемы 

(см. п. 9.7) или задать порядковый 

номер вручную Duplicate Component 

Designators N at 

(X,Y) and (X1,Y1) 

Обнаружено два компонента 

с одинаковым позиционным 

обозначением N в координа-

тах (X, Y) и (X1, Y1) 

Net Wire N has  

multiple names 

(X,Y,Z,…) 

На линии электрической свя-

зи размещено несколько 

идентификаторов цепей, ко-

торые задают цепи N разные 

имена (например, две метки 

цепей с разными именами) 

Удалить лишние идентификаторы 

цепей. 

В редких случаях – изменить 

настройки в окне свойств проекта 

на вкладке Options в группах 

Netlist Options и Net Identifier Scope 

– для обновления списка нарушений в окне Messages необходимо вы-

полнить компиляцию проекта заново; 

– иногда отдельные нарушения требуется пропустить. В этом случае в 

окне Messages на строке с нарушением запускается команда ПКМ ⇒ Place 

Specific No ERC for this violation, после чего на схеме в требуемом месте 

размещается директива в виде перекрестия; 

– параметры, по которым осуществляется проверка при компиляции, 

можно настроить на вкладке Error Reporting окна свойств проекта (команда 

Project ⇒ Project Options). 

9.9. Запустить команду DXP ⇒ Preferences и в окне Preferences в под-

разделе Schematic ⇒ Compiler отключить опцию Warning. 
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9.10. Проверить правильность соединений сегментов линий электриче-

ской связи, организованных с помощью идентификаторов цепей. 

Цепи питания проверить с использованием панели Navigator: 

– перейти в панель Navigator и в группе со списком цепей в столбце 

Net / Bus раскрыть подгруппу класса цепей Power; 

– ЛКМ выбрать одну из цепей данного класса (кроме GND); 

– убедиться в том, что линии графа на схеме соединяют требуемые ком-

поненты, после чего сохранить изображение рабочего поля в отчет. Если бы-

ли обнаружены ошибки, то их необходимо исправить (например, скорректи-

ровать имена в идентификаторах цепей). 

Результат в варианте «П1» показан на рис. 8.64; 

 

– если в классе цепей Power есть еще одна цепь (за исключением GND), 

то выбрать ее ЛКМ, проверить правильность соединений и сохранить изоб-

ражение рабочего поля в отчет. Обнаруженные ошибки также необходимо 

исправить; 

– очистить линии графа в рабочем поле комбинацией клавиш Shift+C. 

Примечание. Особенности работы с панелью Navigator см. в Г.13. 

Цепи управления микросхемой аттенюатора проверить подсвечиванием: 

Рис. 8.64 
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– убедиться в том, что в группе команд Net Colors на ПИ Wiring вклю-

чена опция Show Net Color Override (рис. 8.65, а). Команды по окрашива-

нию цепей также доступны через меню View; 

 – в группе команд Net Colors на ПИ Wiring выбрать любой цвет и 

щелкнуть ЛКМ по любому участку одной из цепей управления; 

– завершить команду клавишей Esc; 

– аналогичным образом другими цветами подсветить остальные цепи 

управления (при наличии). Обнаруженные ошибки необходимо исправить. 

Результат в варианте «П1» показан на рис. 8.65, б; 

– отменить цветовую маркировку, выполнив команду Clear All Net Col-

ors (рис. 8.65, а). 

9.11. Сохранить изменения в проекте (см. п. 4 из 5.5). 

9.12. Сохранить изменения в схеме Э3 (Ctrl+S). 

Результат в варианте «П1» показан на рис. 8.66. Пример схемы Э3 для 

еще одного варианта задания приведен на рис. Г.181. 

10. Внести корректировки в схему Э1 из разд. 3: 

– открыть схему Э1 командой File ⇒ Open (расположение указано в п. 2 

из 3.2.3). Следует обратить внимание на то, что схема появится в панели Pro-

jects в группе Free Documents, и переносить ее оттуда никуда не нужно; 

– на входе узла вторичного питания указать диапазон входного напря-

жения питания и ток потребления устройства. Для этого удобно использовать 

текстовый блок без контура (последовательное нажатие клавиш P ⇒ F); 

Рис. 8.65 

а б 
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 Рис. 8.66 
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 Рис. 8.67 
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– в варианте № 1 организации питания (см. табл. 8.5) на выходе узла 

вторичного питания две линии электрической связи объединить в одну; 

– в варианте № 2 организации питания (см. табл. 8.5) на выходе узла 

вторичного питания у линии электрической связи, идущей к «токовому зер-

калу», указать значение напряжения тзU ; 

– сохранить схему командой File ⇒ Save As в ту же папку и с тем же 

расширением, но с номером версии v0.2 (см. рис. 2.7). 

– удалить файл «УП1.00.01Э1 - Модуль усилителя - v0.1.SchDoc». 

Результат в варианте «П1» показан на рис. 8.67. 

Рис. 8.68 
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11. Сохранить схемы Э3 и Э1 в формате PDF по 8.4. 

У схемы Э3 в варианте «П1» имя файла – «УП1.01.01Э3 - Усилитель - 

v0.1», а путь сохранения – …\ИДРЭС-П1\Усилитель\_pdf (см. рис. 2.8). 

У схемы Э1 в варианте «П1» имя файла – «УП1.00.01Э1 - Модуль уси-

лителя - v0.2», а путь сохранения – …\ИДРЭС-П1\_pdf (см. рис. 2.7). 

12. При желании выполнить 4-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. К). 

На рис. 8.68 показан фрагмент файла «Расчеты (Э3).xmcd», в котором 

производились расчеты в варианте «П1». 

Добавление греческой буквы в записи смены единиц измерения для ома 

производилось из ПИ Greek (команда View ⇒ Toolbars ⇒ Greek). 

Рисунок сделан с помощью приложения Ножницы при выключенном 

отображении сетки (опция Visible на вкладке Sheet Options в окне, вызывае-

мом командой Design ⇒ Document Options) и вставлен из буфера обмена. 

8.4. Сохранение схем из Altium Designer в формате PDF 

Последовательность действий по сохранению схемы в формате PDF: 

1. На вкладке Projects на требуемом листе схемы запустить команду 

ПКМ ⇒ Print Preview для открытия окна просмотра перед печатью. 

2. Для настройки параметров листа в окне просмотра перед печатью за-

пустить команду ПКМ ⇒ Page Setup и в появившемся окне Schematic Print 

Properties выполнить следующее: 

– в группе Printer Paper выбрать формат листа и его ориентацию (для 

схем на листе формата А4 – Portrait, для А3 – Landscape); 

– в группе Scaling выбрать опцию Scaled Print и в поле Scale ввести 

масштабирующий коэффициент 0,9999; 

– в группе Color Set выбрать опцию Mono (вывод на печать в черно-

белом цвете); 

– закрыть окно кнопкой Close. 

Пример настроек для листа формата А3 показан на рис. 8.69. 

3. Для настройки выводимых на печать объектов в окне просмотра перед 

печатью запустить команду ПКМ ⇒ Configuration и в появившемся окне 

Schematic Print Properties выполнить следующее (рис. 8.70): 

– в группе Drawings отключить первые опции в каждой строке (все 

остальные опции будут отключены автоматически). В этом случае на распе-

чатанном листе не будет вспомогательных объектов (например, директив); 
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– в группе Physical Name Expansion выбрать опцию Entire Sheet для 

печати информации со всего листа и закрыть окно кнопкой OK. 

Примечание. При включении опции Specific Area можно задать область 

печати прямоугольной формы либо непосредственно вводом координат, ли-

бо указанием ее мышкой в рабочем поле после нажатия кнопки Define. 

4. Убедиться в том, что в окне просмотра перед печатью лист схемы 

отображается правильно, после чего нажать кнопку Print. 

5. В открывшемся окне Printer Configuration в поле Name выбрать вирту-

альный pdf-принтер (например, Adobe PDF) и нажать кнопку OK. 

Затем задать имя файлу по названию схемы (если проект состоит из не-

скольких листов, то добавить номер листа) и указать путь для сохранения. 

Рис. 8.70 

Рис. 8.69 
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6. Чтобы объединить несколько листов схемы (каждый лист печатается 

отдельно), необходимо выделить требуемые файлы в папке, в которую они 

были сохранены, и выполнить команду ПКМ ⇒ Combine supported files in 

Acrobat (требуется Adobe Acrobat Pro или Adobe Acrobat 3D). 

Примечания: 

– если в полученном документе нет названий некоторых идентифика-

торов цепей, номеров выводов УГО или их функциональных назначений, то 

проблема решается отключением опции Render Text with GDI+ в окне Prefer-

ences (команда DXP ⇒ Preferences) в подразделе Schematic ⇒ General; 

– если полученный документ представляет собой белый лист, то следу-

ет отказаться от использования окна просмотра перед печатью. В этом 

случае команда из п. 2 запускается на требуемом листе схемы на вкладке 

Projects, а окна из пп. 3 и 5 открываются соответственно кнопками Ad-

vanced и Print в окне Schematic Print Properties (см. рис. 8.69); 

– командой File ⇒ Smart PDF можно создать документ формата PDF 

с результатами двухмерного проектирования (листы схем, информация с 

ПП, перечень компонентов) и встроенными ссылками; 

– для проекта ПП можно создать файл формата OUTJOB, в котором 

один раз задать все необходимые настройки по сохранению результатов 

проектирования (например, печать схем или формирование Gerber-файлов), 

после чего использовать его в разных проектах. Подробнее см. в [50].  

8.5. Содержание отчета 

По 3-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести схему Э1 «модуля усилителя» с внесенными из-

менениями, распечатанную на отдельном листе. 

По 8-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Графические пояснения по выбору конденсатора в п. 5.2 из 8.3. 

2. Обоснование выбора кнопки по п. 6.14 из 8.3 (при наличии в варианте 

задания). 

3. Результат проверки по п. 6.14 из 8.3 (для вариантов задания с РУ). 

4. Расчет номиналов резисторов в «токовом зеркале». 

Если после перенумерации схемы изменились позиционные обозначения 

резисторов, то около результатов с их номиналами в этом и последующих 

пунктах должны быть даны соответствующие пояснения (см. рис. 8.68). 
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5. Расчет номиналов резисторов для микросхемы стабилизатора с под-

страиваемым выходным напряжением (при наличии в варианте задания). 

6. Графические пояснения по выбору конденсатора в п. 8.6 из 8.3. 

7. Пояснения по выбору конденсатора в п. 8.7 из 8.3. 

8. Расчет параметрического стабилизатора напряжения на стабилитроне 

(при наличии в варианте задания). 

9. Расчет ИПС и графические пояснения по нахождению прямого 

напряжения и тока (при наличии в варианте задания). 

10. Расчет тока потребления «усилителя» и графическое пояснение по 

нахождению тока потерь для микросхемы стабилизатора напряжения. 

11. Расчет диапазона входных напряжений «усилителя» и графическое 

пояснение по нахождению величины Dropout Voltage для микросхемы стаби-

лизатора напряжения. Во всех вариантах задания указать значение падения 

напряжения на компоненте в схеме ЗП с графическим пояснением.  

12. Расчет температур кристаллов транзисторной сборки и микросхемы 

стабилизатора напряжения и сравнение их с границами рабочих диапазонов. 

13. Один или два рисунка (в зависимости от варианта организации пита-

ния) с проверкой правильности соединения сегментов линий электрической 

связи для цепей питания. 

14. Схему Э3 «усилителя», распечатанную на отдельном листе. 

Следует отметить, что при выполнении 12-го основного этапа проекти-

рования в схему Э3 «усилителя» могут быть внесены изменения. 

КД на листах формата A3 для размещения в отчете необходимо сложить 

на формат A4. Правила складывания КД описаны в ГОСТ 2.501–2013 [51]: 

– листы чертежей всех форматов следует складывать сначала вдоль ли-

ний, перпендикулярных (продольных) к основной надписи, а затем вдоль ли-

ний, параллельных (поперечных) к основной надписи; 

– листы чертежей после складывания 

должны иметь основную надпись на лице-

вой стороне сложенного листа; 

– листы складывают в последова-

тельности цифр на линиях сгибов, указан-

ных на соответствующих изображениях.  

Пример складывания листа формата A3 при расположении основной 

надписи вдоль длинной стороны листа для непосредственного брошюрова-

ния показан на рис. 8.71. 

Рис. 8.71 [51] 
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9. ПЕРЕЧЕНЬ ЭЛЕМЕНТОВ К СХЕМЕ Э3 «УСИЛИТЕЛЯ» 

9.1. Правила оформления перечня элементов 

Необходимой принадлежностью разрабатываемых в вариантах задания 

схем Э3 является перечень элементов, в который записывают данные об 

изображенных на ней элементах и устройствах. Как отмечалось в п. 3.6 из 

8.1, связь между УГО и перечнем элементов осуществляется через позицион-

ные обозначения. 

Правила оформления перечня элементов содержатся в ГОСТ 2.701–2008 

и ГОСТ 2.702–2011, основными из которых являются следующие: 

1. Перечень элементов помещают на первом листе схемы или выполня-

ют в виде самостоятельного документа. 

Для электронных документов перечень элементов выполняют только в 

виде самостоятельного документа. 

2. При выпуске перечня элементов в виде самостоятельного документа 

его код должен состоять из буквы «П» и кода схемы, к которой он относится. 

Например, код перечня элементов к схеме Э3 – ПЭЗ. 

3. Перечень элементов в виде самостоятельного документа выполняют 

на листах формата А4 с оформлением в рамках по ГОСТ Р 2.104–2023, кото-

рое упрощенно показано на рис. 3.5, а. 

Оформление основной надписи для текстовых документов на первом 

листе показано на рис. 9.1. 

 

Для текстовых документов оформление основной надписи на последу-

ющих листах (рис. 3.6, б) и дополнительных граф (рис. 3.6, в) не отличается 

от их оформления для схем и чертежей, за исключением отсутствия графы 

26. Содержание граф указано в табл. 3.1. 

4. Перечень элементов оформляют в виде таблицы (рис. 9.2), заполняе-

мой сверху вниз, с фиксированными размерами столбцов и строк: 

Рис. 9.1 
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– в графе «Поз. обозначение» указывают позиционные обозначения 

элементов, устройств и функциональных групп;  

– в графе «Наименование» указывают для элемента (устройства) его 

наименование в соответствии с документом, на основании которого этот 

элемент (устройство) применен, и обозначение этого документа (основной 

КД, межгосударственный стандарт, стандарт Российской Федерации, стан-

дарт организации, технические условия), а для функциональной группы – 

наименование; 

– в графе «Примечание» рекомендуется указывать технические данные 

элемента (устройства), не содержащиеся в его наименовании (фирму и пр.). 

 

5. Элементы в перечень записывают группами в алфавитном порядке 

буквенных позиционных обозначений. В пределах каждой группы, имеющей 

одинаковые буквенные позиционные обозначения, элементы располагают по 

возрастанию порядковых номеров. 

6. Для облегчения внесения изменений допускается оставлять несколько 

незаполненных строк между отдельными группами элементов, а при боль-

шом количестве элементов внутри групп – и между элементами. 

7. Элементы одного типа с одинаковыми параметрами, имеющие на 

схеме последовательные порядковые номера, допускается записывать в пере-

чень в одну строку. В этом случае в графу «Поз. обозначение» вписывают 

только позиционные обозначения с наименьшим и наибольшим порядковы-

ми номерами, например: R3, R4, С8–С12, а в графу «Кол.» – общее количе-

ство таких элементов. 

8. При записи элементов одинакового наименования, отличающихся 

техническими характеристиками и другими данными и имеющих одинаковое 

буквенное позиционное обозначение, допускается в графе «Наименование» 

записывать наименование этих элементов в виде общего наименования, а в 

общем наименовании – наименование, тип и обозначение документа (межго-

сударственный стандарт, технические условия или основной КД), на основа-

нии которого эти элементы применены. 

Рис. 9.2 
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 Рис. 9.3 
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При выполнении перечня элементов на нескольких страницах, рекомен-

дуется общее наименование для группы элементов повторять вверху каждой 

страницы. Подобное требование есть в ГОСТ 2.704–2011 [52], а также в пра-

вилах оформления спецификации в ГОСТ Р 2.106–2019 [53]. 

9. Если в изделии имеются элементы, не являющиеся самостоятельными 

конструкциями, то при записи их в перечень графу «Наименование» не за-

полняют, а в графе «Примечание» помещают поясняющую надпись или 

ссылку на поясняющую надпись на поле схемы. 

10. Элементы, относящиеся к устройствам и функциональным группам, 

записывают в перечень элементов отдельно. При этом запись таких элемен-

тов начинают с наименования устройства или функциональной группы, ко-

торое записывают в графе «Наименование» и подчеркивают (при автомати-

зированном проектировании допускается не подчеркивать). Ниже наимено-

вания устройства (функциональной группы) должна быть оставлена одна 

свободная строка, выше – не менее одной свободной строки. 

11. Если на схеме изделия имеются элементы, не входящие в устройства 

(функциональные группы), то при заполнении перечня элементов вначале за-

писывают эти элементы без заголовка, а затем устройства, не имеющие само-

стоятельных принципиальных схем, и функциональные группы с элемента-

ми, входящими в них. 

12. Если в изделии есть несколько одинаковых устройств (функциональ-

ных групп), то в перечне указывают количество элементов, входящих в одно 

устройство (функциональную группу). Число одинаковых устройств (функ-

циональных групп) указывают в графе «Кол.» на одной строке с заголовком. 

13. По ГОСТ Р 2.105–2019 [54] к текстовым документам выпускается 

лист регистрации изменений (ЛР) в соответствии с ГОСТ Р 2.503–2023 [55]. 

По старой редакции (ГОСТ 2.503–74 [56]) ЛР предусматривают в тек-

стовых документах из трех и более листов, включают в общее количество 

листов и помещают последним листом (см. рис. 9.3). 

9.2. Создание перечня элементов ПЭ3 

Перечень элементов будет оформлен в Microsoft Word на заранее под-

готовленной заготовке «Перечень элементов, вариант А.doc» из папки 

…\ИДРЭС\MSWord заготовки (см. рис. 2.9). 

Заготовка состоит из рамок (основные надписи и дополнительные графы 

по п. 3 из 9.1), выполненных в виде таблиц и помещенных в нижние колонти-
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тулы страниц, а также из таблицы по п. 4 из 9.1, размещенной в рабочем поле 

листа, с автоматически повторяющимся на каждой странице заголовком. 

Для создания перечня элементов ПЭ3 «усилителя» необходимо: 

1. Открыть указанную выше заготовку. 

2. Сохранить заготовку командой Файл ⇒ Сохранить как с расшире-

нием «.doc». Имя файла в варианте «П1» – «УП1.01.01ПЭ3 - Усилитель - 

v0.1», а путь сохранения – …\ИДРЭС-П1\Усилитель (см. рис. 2.8). 

3. Войти в режим редактирования нижних колонтитулов, выполнив на 

основной надписи команду ПКМ ⇒ Изменить нижний колонтитул, и за-

полнить без копирования графы рамок в соответствии с табл. 9.1. Вход в ре-

жим редактирования двойным щелчком ЛКМ не допускается, так как может 

привести к появлению лишних пустых строк в таблице. 

Пояснения к графам даны в табл. 3.1, на рис. 9.1 и на рис. 3.6, б и в. 

Таблица 9.1 

Содержание граф рамки для перечня элементов ПЭ3 «усилителя» 

Номер 

графы 
Содержание Комментарий к заполнению 

1 
Усилитель 

Перечень элементов 

Наименование изделия определено в табл. 2.1. 

Наименование документа присутствует в используе-

мой заготовке по умолчанию 

2  

(на первом  

и втором  

листе) 

УП1.01.01ПЭ3 

Обозначение документа определено в табл. 2.1 и ука-

зано для варианта «П1». 

Обозначение со второго листа при увеличении числа 

листов повторяется на каждом последующем 

4 У – 

7 и 8 См. комментарий Графы заполняются автоматически 

9 СПбГЭТУ «ЛЭТИ» – 

11  

(напротив 

«Разраб.») 

Сидоров 

Указывается фамилия студента, разработавшего КД. 

Если вариант задания выполняется студентами в паре, 

то фамилия второго студента записывается в графе 11 

напротив «Пров.» 

11  

(напротив 

«Пров.») 

Петров 

Указывается фамилия преподавателя. 

Если вариант задания выполняется студентами в паре, 

то фамилия преподавателя указывается в графе 11 

напротив «Утв.», а в данной графе записывается фами-

лия второго студента 

11  

(напротив 

«Утв.») 

См. комментарий 

Если вариант задания выполняется студентами в паре, 

то в данной графе записывается фамилия преподавате-

ля. В противном случае графа не заполняется 

25 УП1.01.01 
Обозначение спецификации, в которой записан КД, 

определено в табл. 2.1 и указано для варианта «П1» 
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4. Выйти из режима редактирования колонтитулов кнопкой Закрыть на 

ПИ Колонтитулы (или несколькими нажатиями клавиши Esc). 

5. Сформировать список компонентов из схемы Э3 «усилителя» в по-

рядке возрастания их позиционных обозначений: 

– в Altium Designer командой File ⇒ Open Project открыть проект ПП 

(расположение указано в п. 1 из 8.2); 

– в проекте открыть схему Э3 «усилителя» (см. п. 3 из 8.3); 

– запустить команду Reports ⇒ Bill of Materials; 

– в открывшемся окне удалить группировку информации по всем пара-

метрам, для чего перетащить их названия зажатой ЛКМ из столбца Grouped 

Columns в столбец All Columns. Пример перетас-

кивания параметра Footprint показан на рис. 9.4; 

– два раза щелкнуть ЛКМ по названию столбца 

Show, расположенному около столбца All Columns. 

В результате сверху окажутся параметры, отобра-

жаемые в данный момент в заголовках столбцов 

таблицы из правой части окна Bill of Material; 

– оставить видимыми только параметры Designator (позиционное обо-

значение) и Quantity (количество), для чего снять галочки напротив осталь-

ных параметров в столбце Show; 

– включить отображение параметров CI_BOM и CI_Manufacturer; 

– перетаскиванием зажатой ЛКМ за заголовки столбцов в правой части 

окна Bill of Materials расставить их в следующем порядке слева направо: Des-

ignator, CI_BOM, Quantity, CI_Manufacturer; 

– убедиться в том, что включена сортировка в порядке увеличения пози-

ционных обозначений, и сохранить рисунок таблицы со всеми позиционны-

ми обозначениями в отчет. 

 Фрагмент таблицы в варианте «П1» показан на рис. 9.5; 

 Рис. 9.5 

Рис. 9.4 



 

 286 

– в группе Export Options в поле File Format выбрать опцию Microsoft 

Excel Worksheet (*.xls) и включить опцию Open Exported (открытие экспор-

тированного файла); 

– в группе Excel Options в поле Template выбрать <none> (экспорт в 

Microsoft Excel без специальной заготовки); 

– нажать кнопку Export; 

– в появившемся окне убедиться в том, что сохранение файла произво-

дится в папку Project Outputs из папки с проектом ПП, и нажать кнопку Со-

хранить. Если открылся блокнот с информацией, то закрыть его. 

В результате откроется книга Microsoft Excel со списком компонентов; 

– закрыть окно Bill of Materials кнопкой OK; 

– сохранить изменения в проекте (см. п. 4 из 5.5). При этом в проекте 

будут сохранены настройки окна Bill of Materials. 

Примечание. В списке компонентов отсутствуют КП, так как в их 

свойствах задан тип Standard (No BOM). Подробнее см. в Г.33. 

6. Заполнить графы таблицы из рабочего поля перечня элементов, ис-

пользуя список компонентов из книги Microsoft Excel и правила из 9.1. 

Возможная последовательность действий: 

6.1. В соответствии с п. 7 из 9.1 в книге Microsoft Excel вручную объ-

единить идущие подряд строки с одинаковыми данными в столбце CI_BOM, 

скорректировав значения в столбце Quantity и записи в столбце Designator. 

Исключением при проектировании станут отрезки МПЛ, так как второй 

и все последующие образуют функциональную группу. Поэтому строка с по-

зиционным обозначением W1 должна остаться без изменений. 

6.2. Выделить ячейки с данными строки, относящейся к отрезкам МПЛ 

из функциональной группы, и зажатой ЛКМ переместить их в конец списка. 

6.3. Удалить пустые строки (команда ПКМ ⇒ Удалить на их номерах). 

В варианте «П1» были сгруппированы строки с конденсаторами C7 и 

C8, а также с отрезками МПЛ от W2 до W6 (рис. 9.6). 

 Рис. 9.6 
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6.4. Выделить все ячейки, оказавшиеся на пересечении четырех первых 

столбцов и строк с позиционными обозначениями (заголовки столбцов не 

должны быть выделены), и скопировать их в буфер обмена (Ctrl+C). 

6.5. Перейти в Microsoft Word в перечень элементов и на первом листе в 

любой ячейке второй пустой строки выполнить команду ПКМ ⇒ Парамет-

ры вставки ⇒ Объединить в таблицу (рис. 9.7). 

 

Примечание. При отсутствии указанной команды следует проверить 

включение следующей настройки: Файл ⇒ Параметры ⇒ Дополнительно ⇒ 

Вырезание, копирование и вставка ⇒ Настройка ⇒ Использовать для: Word 

2002-2010. 

6.6. Удалить одну пустую строку перед конденсаторами (см. п. 8) и в 

оставшейся пустой строке в столбце «Наименование» в соответствии с п. 8 из 

9.1 записать их общее наименование – Конденсаторы. 

6.7. Добавить по несколько пустых строк (см. п. 7) между каждой парой 

компонентов с разными буквенными кодами в позиционных обозначениях 

(между конденсаторами и микросхемами, микросхемами и дросселем и т. д.). 

Примечание. Назначение пустых строк кроме визуального разделения 

групп компонентов с разной функцией указано в п. 6 из 9.1.  

6.8. В столбце «Наименование» над строкой с резисторами записать их 

общее наименование – Резисторы. 

Если резисторы находятся на разных страницах перечня элементов, то в 

соответствии с п. 8 из 9.1 общее наименование записать на каждой. Если на 

странице оказалась только одна строка с резистором, то наименование «Рези-

стор» записать перед его Part Number. 

Рис. 9.7 



 

 288 

6.9. В соответствии с п. 10 из 9.1 добавить наименование функциональ-

ной группы, в которую входят отрезки МПЛ, – Фильтр полосовой. 

После этого для указанной функциональной группы внести необходи-

мые данные в графы «Поз. обозначение» и «Кол.». 

6.10. Для отрезков МПЛ заполнить графу «Примечание» (см. п. 9 из 9.1). 

В варианте «П1» записано Линия СВЧ. 

6.11. При необходимости в графе «Примечание» для отдельных компо-

нентов записать дополнительную информацию. 

В варианте «П1» было указано количество контактов в разъемах. 

7. При необходимости добавления в таблицу новой строки следует уста-

новить курсор мышки в любую ячейку строки, относительно которой будет 

производиться вставка, и выполнить команду ПКМ ⇒ Вставить ⇒ Вста-

вить строки сверху (или Вставить строки снизу). 

Команду можно повторить комбинацией клавиш Ctrl+Y, при этом уста-

новив курсор мышки в ячейку любой другой строки. 

Если предварительно выделить ЛКМ несколько строк, то будет добавле-

но такое же количество новых строк. 

8. При необходимости удаления из таблицы строк следует выделить 

ЛКМ требуемое их количество и запустить команду ПКМ ⇒ Удалить ячей-

ки (или нажать клавишу Backspace), после чего в появившемся окне выбрать 

опцию Удалить всю строку и нажать OK. 

9. Если вся информация в перечне элементов поместилась на двух пер-

вых листах, то в соответствии с п. 13 из 9.1 скрыть ЛР: 

– нажать пиктограмму Отобразить все знаки на ПИ Главная (или ком-

бинацию клавиш Ctrl+Shift+8) для отображения всех скрытых знаков; 

– под таблицей в рабочем поле на листе, предшествующем ЛР, щелкнуть 

ЛКМ перед знаком абзаца на строке с разрывом раздела (рис. 9.8); 

 

– с зажатой клавишей Shift щелкнуть ЛКМ в рабочем поле под таблицей 

на ЛР, в результате чего выделится разрыв раздела и вся таблица на ЛР; 

Рис. 9.8 

Разрыв раздела 
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 Рис. 9.9 Начало (окончание см. на с. 290) 
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 Рис. 9.9 Окончание (начало см. на с. 289) 
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– нажать комбинацию клавиш Ctrl+D и в появившемся окне Шрифт на 

одноименной вкладке включить опцию скрытый; 

– нажать комбинацию клавиш Ctrl+Shift+8, в результате чего ЛР скро-

ется, а количество листов в документе станет равно двум. 

10. Сохранить изменения в перечне элементов (Ctrl+S). 

Результат в варианте «П1» показан на рис. 9.9. Пример перечня элемен-

тов ПЭ3 для еще одного варианта задания приведен на рис. Г.184. 

11. Сохранить перечень элементов в формате PDF. 

Для этого выполнить следующие действия: 

– запустить команду Файл ⇒ Печать; 

– выбрать виртуальный pdf-принтер (например, Adobe PDF); 

– нажать пиктограмму Печать (или кнопку OK в старых версиях Mi-

crosoft Word) и в появившемся окне задать имя файла и путь сохранения. 

Примечание. Сохранение в формате PDF возможно также с помощью 

команды Файл ⇒ Сохранить как. В этом случае в поле «Тип файла» выбира-

ется PDF (*.pdf). 

Имя файла в варианте «П1» – «УП1.01.01ПЭ3 - Усилитель - v0.1», а 

путь сохранения – …\ИДРЭС-П1\Усилитель\_pdf (см. рис. 2.8). 

12. Сохранить изменения в книге Microsoft Excel (Ctrl+S). 

9.3. Содержание отчета 

По 9-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Рисунок таблицы из правой части окна Bill of Materials со всеми пози-

ционными обозначениями. 

2. Перечень элементов к схеме Э3 «усилителя», распечатанный на от-

дельных листах. 

Стоит обратить внимание на то, что при выполнении 12-го основного 

этапа проектирования в данный КД могут быть внесены изменения. 
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10. СХЕМА ЭЛЕКТРИЧЕСКАЯ ПРИНЦИПИАЛЬНАЯ 

«МОДУЛЯ УСИЛИТЕЛЯ» 

10.1. Создание схемы Э3 

Схема Э3 «модуля усилителя» будет создана в Altium Designer на листе 

формата A4 в виде свободного документа, поэтому рекомендуется следую-

щий порядок действий: 

1. Сделать копию файла схемы Э1 из разд. 3 и скорректировать ее имя. 

В варианте «П1» в папке …\ИДРЭС-П1 (см. рис. 2.7) копии файла было 

присвоено имя «УП1.00.01Э3 - Модуль усилителя - v0.1». 

2. Открыть в Altium Designer схему Э3 «модуля усилителя». 

Для этого либо дважды щелкнуть ЛКМ по файлу схемы в проводнике 

Windows, либо запустить Altium Designer и выполнить команду File ⇒ Open. 

3. Скорректировать значения параметров в основной надписи рамки и ее 

дополнительных графах в соответствии с табл. 10.1 (вкладка Parameters в 

окне, вызываемом командой Design ⇒ Document Options). Содержание 

остальных параметров должно соответствовать данным табл. 3.2. 

Пояснения к графам даны в табл. 3.1 и на рис. 3.6, а и в. 

Таблица 10.1 

Содержание полей рамки для схемы Э8 «модуля усилителя»,  

отличающихся от схемы Э1 

Название поля Значение поля Комментарий к заполнению 

01.3_Наименов. док. 
Схема электрическая 

принципиальная 
– 

02_Обознач. док. УП1.00.01Э3 
Обозначение документа определено в 

табл. 2.1 и указано для варианта «П1» 

4. Удалить все объекты из рабочего поля схемы внутри рамки. 

5. Перейти в сетку 3 мм. 

6. Добавить библиотеку компонентов в виде базы данных, сделав ее до-

ступной для любого проекта: 

– в верхней части панели Libraries нажать одноименную кнопку; 

– в открывшемся окне Available Libraries на вкладке Installed нажать 

кнопку Install и выбрать опцию Install from file; 

– в появившемся окне задать расширение файла Database Libraries 

(*.DBLIB) и выбрать библиотеку ИДРЭС-ADLibrary.DbLib из папки 

…\ИДРЭС\AD library (см. рис. 2.9); 

– закрыть окно Available Libraries кнопкой Close. 
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7. Изобразить «усилитель», для чего выполнить следующее: 

– последовательным нажатием клавиш P ⇒ F (создание текстового бло-

ка) создать надпись, в которой в две строки указать наименование и обозна-

чение «усилителя». 

Примечание. Размеры текстового блока в варианте «П1» – 21 × 9 мм; 

– в свойствах текстового блока отключить опцию Show Border; 

– с каждой стороны от текстового блока добавить по одной КП (компо-

нент PAD_r150_300 из библиотеки PAD), при этом их пины должны быть 

направлены в стороны от надписи;  

– вручную назначить позиционные обозначения КП в соответствии с 

входной и выходной КП из схемы Э3 «усилителя»; 

– последовательным нажатием клавиш P ⇒ D ⇒ R (создание прямо-

угольника) заключить надписи и две КП в прямоугольный контур. 

Примечание. Размеры контура в варианте «П1» – 54 × 24 мм; 

– выделить прямоугольный контур и текстовый блок, после его выпол-

нить команды ПКМ ⇒ Align ⇒ Align Horizontal Centers (выравнивание по 

горизонтали) и ПКМ ⇒ Align ⇒ Align Vertical Centers (выравнивание по 

вертикали). 

Примечание. Способы выделения объектов мышкой приведены в Г.5; 

– перейти в сетку 1 мм; 

– в верхнем правом углу над нарисованным контуром последовательным 

нажатием клавиш P ⇒ T (создание надписи) поместить надпись А1. 

В свойствах надписи изменить размер шрифта на 12. 

8. Нарисовать вокруг «усилителя» контур «экрана» с параметрами, ука-

занными в п. 11 из 3.3. 

9. Перейти в сетку 3 мм. 

Результат в варианте «П1» на данном этапе показан на рис. 10.1. 

 Рис. 10.1 
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10. Слева и справа от созданного контура «экрана» 

добавить по одной приборной фланцевой розетке SMA-

KFD5A (рис. 10.2) фирмы-поставщика ООО «Амитрон 

Электроникс» из библиотеки X, при этом левую необ-

ходимо перевернуть вдоль оси X клавишей X так, что-

бы пин, обозначающий центральную жилу, был направ-

лен в сторону «усилителя». 

Рабочие частоты указанных разъемов – до 18 ГГц; 

волновое сопротивление – 50 Ом. Документация на них 

находится в папке …\ИДРЭС\Компоненты\Разъемы. 

Требование об установке именно таких разъемов содержится в общем 

задании на проектирование. 

11. Вручную присвоить левому СВЧ разъему позиционное обозначение 

XW1, а правому СВЧ-разъему – XW2. 

12. Перейти в сетку 1 мм. 

13. Последовательным нажатием клавиш P ⇒ W (создание линии элек-

трической связи) осуществить соединения: 

– центральной жилы левого СВЧ-разъема и левой КП «усилителя»; 

– центральной жилы правого СВЧ-разъема и правой КП «усилителя»; 

– корпусов СВЧ-разъемов (места соеди-

нения горизонтальной линии и окружности в 

УГО) и контура «экрана». 

Результат для левого СВЧ-разъема в ва-

рианте «П1» показан на рис. 10.3. 

14. Под один из штрихов на нижней сто-

роне контура «экрана» последовательным 

нажатием клавиш P ⇒ O добавить символ земли (идентификатор цепи GND 

Power Port). 

15. В местах соединений символа земли и линий электрической связи с 

контуром «экрана» последовательным нажатием клавиш P ⇒ J добавить обо-

значения электрических соединений, выбрав в их свойствах размер Small. 

16. Перейти в сетку 3 мм. 

17. Последовательным нажатием клавиш P ⇒ T (создание надписи) до-

бавить две надписи в кавычках («ВХОД» и «ВЫХОД») и разместить их око-

ло СВЧ-разъемов. 

Назначение кавычек см. в п. 4.3 из 8.1. 

Рис. 10.2 

Рис. 10.3 
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 Рис. 10.4 
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18. Сохранить изменения в схеме Э3 (Ctrl+S). 

Результат в варианте «П1» показан на рис. 10.4. 

19. Сохранить схему в формате PDF по 8.4. 

Имя файла в варианте «П1» – «УП1.00.01Э3 - Модуль усилителя - 

v0.1», а путь сохранения – …\ИДРЭС-П1\_pdf (см. рис. 2.7). 

20. Удалить библиотеку в виде базы данных из списка установленных 

библиотек (см. п. 7 из 5.5). 

21. Удалить из папки …\ИДРЭС-П1 папку History с резервными копия-

ми файла схемы Э3. 

10.2. Содержание отчета 

По 10-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести схему Э3 «модуля усилителя», распечатанную на 

отдельном листе. 
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11. ПЕРЕЧЕНЬ ЭЛЕМЕНТОВ К СХЕМЕ Э3 

«МОДУЛЯ УСИЛИТЕЛЯ» 

11.1. Создание перечня элементов 

Правила оформления перечней элементов приведены в 9.1. 

Для создания перечня элементов ПЭ3 «модуля усилителя» необходимо: 

1. Открыть заготовку перечня элементов, указанную в 9.2. 

2. Сохранить заготовку командой Файл ⇒ Сохранить как с расшире-

нием «.doc». Имя файла в варианте «П1» – «УП1.00.01ПЭ3 - Модуль усили-

теля - v0.1», а путь сохранения – …\ИДРЭС-П1 (см. рис. 2.7). 

3. Так как на схеме Э3 «модуля усилителя» всего три изделия, то в пе-

речне элементов необходимо исключить второй лист и ЛР: 

– удалить все строки таблицы из рабочего поля 2-го листа по п. 8 из 9.2; 

– скрыть ЛР по п. 9 из 9.2. 

4. Войти в режим редактирования нижних колонтитулов по п. 3 из 9.2 и 

заполнить без копирования графы рамки в соответствии с табл. 11.1. Содер-

жание остальных граф должно соответствовать данным табл. 9.1. 

Пояснения к графам даны в табл. 3.1, на рис. 9.1 и на рис. 3.6, в. 

Таблица 11.1 

Содержание граф рамки для перечня элементов ПЭ3 «модуля усилителя»,  

отличающихся от перечня элементов ПЭ3 «усилителя» 

Номер  

графы 
Содержание  Комментарий к заполнению 

1 
Модуль усилителя 

Перечень элементов 

Наименование изделия определено в табл. 2.1. 

Наименование документа присутствует в используе-

мой заготовке по умолчанию 

2 УП1.00.01ПЭ3 
Обозначение документа определено в табл. 2.1 и ука-

зано для варианта «П1» 

7 См. комментарий 
Так как в КД всего один лист, то номер листа скрыва-

ется путем установки белого цвета шрифта 

25 УП1.00.01 
Обозначение спецификации, в которой записан КД, 

определено в табл. 2.1 и указано для варианта «П1» 

5. Выйти из режима редактирования колонтитулов по п. 4 из 9.2. 

6. Заполнить графы таблицы из рабочего поля перечня элементов, запи-

сав изделия из схемы Э3 «модуля усилителя»: «усилитель» и СВЧ-разъемы. 

Для размещения названия фирмы СВЧ-разъемов в одной ячейке столбца 

«Примечание» на ней необходимо выполнить команду ПКМ ⇒ Свойства 

таблицы ⇒ Ячейка ⇒ Параметры ⇒ Вписать текст. 



 

 298 

 Рис. 11.1 
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7. Сохранить изменения в перечне элментов (Ctrl+S). 

Результат в варианте «П1» показан на рис. 11.1. 

8. Сохранить перечень элементов в формате PDF по п. 11 из 9.2. 

Имя файла в варианте «П1» – «УП1.00.01ПЭ3 - Модуль усилителя - 

v0.1», а путь сохранения – …\ИДРЭС-П1\_pdf (см. рис. 2.7). 

11.2. Содержание отчета 

По 11-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести перечень элементов к схеме Э3 «модуля усилите-

ля», распечатанный на отдельном листе. 
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12. КОМПОНОВКА И ТРАССИРОВКА ПП 

12.1. Подготовительные действия 

Чтобы приступить к разработке ПП, необходимо выполнить ряд подго-

товительных действий: 

1. Командой File ⇒ Open Project открыть проект ПП для «усилителя» 

(расположение указано в п. 1 из 8.2). 

Примечание. Закрытые ранее проекты также можно открыть коман-

дой File ⇒ Recent Projects или через панель Files в группе Open a project. 

2. Создать один документ ПП внутри проекта. 

Для этого в панели Projects на названии проекта выполнить команду 

ПКМ ⇒ Add New to Project ⇒ PCB. 

Примечание. Новый документ ПП также можно создать из панели 

Files, щелкнув ЛКМ по пункту PCB File в группе New. 

3. Сохранить файл трассировки с расширением «.PcbDoc» в папку про-

екта, запустив в панели Projects на его названии команду ПКМ ⇒ Save As. 

Имя файлу присвоить в виде «AMP-

XX-v0.1», где AMP – сокращение от 

англ. amplifier, а XX – номер варианта. 

Состав проекта из панели Projects 

в варианте «П1» на данном этапе пока-

зан на рис. 12.1. 

4. Перейти в метрическую систему измерения (см. п. 3 из 5.2.1). 

Примечание. Окно Board Options, в отличие от редактора посадочных 

мест, открывается последовательным нажатием клавиш D ⇒ O или ко-

мандой Design ⇒ Board Options. 

5. Настроить структуру ПП (стек). 

Для этого последовательно нажать клавиши D ⇒ K (или запустить ко-

манду Design ⇒ Layer Stack Manager) и в появившемся окне Layer Stack 

Manager выполнить следующее: 

– нажать кнопку Load с опцией Load from File и из папки …ИДРЭС\ 

Профили (см. рис. 2.9) открыть файл ИДРЭС-AltiumPCBStack.stackup; 

– в появившемся окне Merge Layer Stacks нажать кнопку OK; 

– подтвердить удаление слоев в следующем окне; 

– в соответствии с материалом из варианта индивидуального задания по 

табл. Б.2 в столбцах Thickness (базовая толщина диэлектрика), Dielectric Ma-

Рис. 12.1 
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terial (название материала) и Dielectric Constant (относительная диэлектри-

ческая проницаемость) ввести соответствующие данные для диэлектрика; 

– в столбце Thickness для проводящих слоев с точностью до микрона 

ввести их толщину ( псh ), вычисленную по формуле: 

 фпгмпс hhth ++= . (12.1) 

Примечание. Используемые переменные участвовали в расчете по (4.9).  

В варианте «П1» (рис. 12.2, а): 

0384,00004,002,0018,0пс =++=h  мм. 

Следует обратить внимание на то, что само полученное значение долж-

но остаться неокргуленным для использования в дальнейших расчетах; 

 

– нажать пиктограмму Copy Image to Clipboard и вставить изображение 

из буфера обмена в отчет (пример для варианта «П1» показан на рис. 12.2, б); 

– применить изменения в окне Layer Stack Manager кнопкой OK. 

Примечания: 

– отсутствие слоев Bottom Solder и Bottom Overlay обусловлено необхо-

димостью контакта слоя Bottom Layer с «основанием»; 

– параметры шелкографии обычно не учитывают, так как графические 

объекты из этого слоя имеют пренебрежимо малые размеры, в отличие от 

защитной паяльной маски, покрывающей значительные области ПП; 

Рис. 12.2 

а 

б 

Copy Image to Clipboard 
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– толщины сигнальных слоев заданы с учетом особенностей производ-

ства ПП (см. Б.4). При отправке ПП в изготовление должна быть указана 

только исходная толщина меди (величина t); 

– параметры слоя Top Solder заданы в соответствии с Б.7; 

– стек ПП в основном используется для управления сигнальными слоями 

и изменения их названий (например, в МПП), а также для хранения инфор-

мации о конкретной ПП. Толщины материалов учитываются в 3D-режиме 

просмотра ПП и при экспорте информации в другие САПР (например, через 

формат IDF); 

– параметры материалов могут использоваться для расчета волнового 

сопротивления относительно слоев типа Plane. Формулы можно посмот-

реть и отредактировать с помощью кнопки Impedance Calculation; 

– любому слою в столбце Layer Name можно задать произвольное имя; 

– дополнительные столбцы имеют следующие назначения: Pullback – 

для указания зазора между медью и контуром ПП в слоях типа Plane, Orien-

tation – для указания направления встраиваемых в ПП компонентов, Coverlay 

Expansion – для указания величины, на которую покрывной слой гибкой части 

в МПП на гибко-жестком основании заходит в жесткую часть; 

– кнопка Advanced позволяет открыть дополнительные настройки для 

формирования сложных стеков ПП (например, для МПП на гибко-жестком 

основании) и переименования отдельных их частей; 

– кнопка Presets позволяет выбрать заготовку стека ПП (например, для 

четырехслойной ПП); 

– слои удаляются кнопкой Delete Layer и перемещаются по стеку кноп-

ками Move Up и Move Down; 

– добавление слоя осуществляется кнопкой Add Layer. В режиме стека 

Custom (выпадающий список в правом верхнем углу окна) можно добавить в 

любое место и в любом порядке сигнальные слои (Add Layer), слои сплошной 

металлизации (Add Internal Plane), диэлектрические слои (Add Dielectric), 

слои маски и шелкографии (Add Overlays); 

– режим стека Layer Pairs позволяет упростить создание структуры 

МПП с рис. Б.7 (метод попарного прессования); 

– режим стека Internal Layer Pairs облегчает разработку структуры 

МПП с рис. Б.6 (метод металлизации сквозных отверстий); 

– режим стека Build-Up упрощает получение структуры МПП, кото-

рая похожа на рис. Б.10 (метод послойного наращивания); 
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– у диэлектрического слоя в столбце Material можно выбрать его тип, 

например: Core – ядро, Prepreg – препрег, Surface Material – поверхностный 

материал (слой маски). Кроме того, эти данные будут автоматически об-

новлены при смене режима стека; 

– в новых версиях Altium Designer функционал окна Layer Stack Manager 

существенно переработан и улучшен. 

6. Настроить механические слои. 

Для этого нажать клавишу L и в появившемся окне View Configurations 

на вкладке Board Layers And Colors выполнить следующее: 

– к существующему 1-му механическому слою добавить слои со 2-го по 

7-й включительно и включить их отображение (отключить опцию Only show 

enabled mechanical Layers и включить опции Enable и Show); 

– задать названия механическим слоям в соответствии с табл. Г.15; 

– нажать кнопку Layer Pairs и в открывшемся окне Mechanical Layer 

Pairs кнопкой Add задать парные механические слои: 3-й и 4-й, 5-й и 6-й; 

– применить изменения в окне Mechanical Layer Pairs (рис. 12.3, а); 

– в окне View Configurations удалить 2, 4 и 6-й механические слои, от-

ключив опцию Enable (рис. 12.3, б); 

– применить изменения кнопкой Apply. 

 

Примечание. Назначение парных слоев рассмотрено в 5.2.2. В данном 

учебном пособии 2, 4 и 6-й механические слои и использование пар слоев мо-

жет потребоваться в исключительных случаях. 

Рис. 12.3 

а 

б 
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7. В окне View Configurations (клавиша L, если оно было закрыто) на 

вкладке View Options в группе Display Options включить опцию Convert 

Special Strings.  

После этого закрыть окно клавишей OK. 

Примечание. Включение указанной опции приведет к тому, что в рабо-

чем поле надписи со ссылками на параметры отобразятся в том виде, в ко-

тором они выводятся на печать. В данном случае надписи '.Designator', 

находящиеся в посадочных местах компонентов на слое M3 Top Assy, будут 

преобразованы в соответствующие позиционные обозначения. 

8. Загрузить наборы слоев. 

Для этого выполнить следующее: 

– запустить команду Design ⇒ Manage Layer Sets ⇒ Board Layer Sets; 

– в появившемся окне Layer Sets Manager нажать кнопку Import Layer 

Sets From File и из папки …ИДРЭС\Профили (см. рис. 2.9) открыть файл 

ИДРЭС-AltiumPCBLayerSet.layerset; 

– отключить опцию Show / Hide Default Layer Sets; 

– закрыть окно Layer Sets Manager кнопкой Close. 

Примечание. Информация о наборах слоев приведена в п. 8 из Г.38. 

9. Добавить к проекту шаблоны 

переходных отверстий и КП. 

Для этого выполнить следующее: 

– из группы PCB в дополнитель-

ном меню (см. рис. 3.1) открыть па-

нель PCB Pad Via Templates; 

– в верхней части панели нажать 

пиктограмму с тремя точками; 

– в открывшемся окне Available 

Libraries на вкладке Project кнопкой 

Add Library добавить библиотеку 

ИДРЭС-PAV.PvLib с переходными 

отверстиями и КП из папки 

…\ИДРЭС\AD library (рис. 2.9); 

– закрыть окно Available Libraries кнопкой Close; 

– в панели PCB Pad Via Templates в списке библиотечных шаблонов с 

зажатой клавишей Ctrl щелкнуть ЛКМ по шаблонам КП и переходных от-

верстий с именами c500h290, v90h40 и v120h60; 

Рис. 12.4 
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– на любом выделенном шаблоне выполнить команду ПКМ ⇒ Add To 

Internal Library, в результате чего выбранные переходные отверстия и КП 

окажутся в группе Local Pad & Via Library (рис. 12.4); 

– закрыть панель, нажав на крестик в ее заголовке. 

Примечания: 

– переходное отверстие (Via) используется для соединения проводящих 

рисунков на разных слоях ПП и зачастую закрывается защитной паяльной 

маской. В готовой ПП переходное отверстие, открытое от защитной па-

яльной маски, и КП с отверстием для монтажа выводных компонентов с 

аналогичными параметрами выглядят одинаково; 

– шаблон КП будет использоваться как крепежное отверстие под винт 

М2,5 по общему заданию на проектирование. Диаметр отверстия задан в 

соответствии с ГОСТ 11284–75 [57] по второму ряду, а диаметр КП – по 

внешнему диаметру шайбы уменьшенной ГОСТ 10450–78 [58]; 

– шаблоны переходных отверстий будут использоваться для соедине-

ния земляных полигонов на верхнем и нижнем слое ПП; 

– особенности работы с панелью PCB Pad Via Templates см. в Г.16; 

– особенности создания библиотеки шаблонов переходных отверстий и 

КП приведены в Г.23, а расшифровка их наименований – в Г.22. 

10. Задать общие правила проектирования ПП. 

Для этого выполнить следующее: 

– запустить команду Design ⇒ Rules; 

– в открывшемся окне PCB Rules and Constraints Editor в любом месте 

левой его части запустить команду ПКМ ⇒ Import Rules; 

– в появившемся окне Choose Design Rule Type выделить все типы пра-

вил (щелкнуть ЛКМ на первой строке, а затем с зажатой клавишей Shift – на 

последней строке) и нажать кнопку OK; 

– в окне Import File открыть файл с общими правилами проектирования 

ПП ИДРЭС-AltiumPCBRules.RUL из папки …\ИДРЭС\Профили (рис. 2.9); 

– согласиться с предупреждением об очистке существующих правил; 

– в окне PCB Rules and Constraints Editor щелкнуть ЛКМ по правилу 

RVS для отображения его параметров (правило находится по следующему 

пути – Design Rules ⇒ Routing ⇒ Routing Via Style); 

– в правой части окна в группе Constraints выбрать опцию Template 

Preferred и в появившейся таблице поставить галочки в столбце Enabled для 

двух подключенных шаблонов переходных отверстий (рис. 12.5); 
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– применить изменения, последовательно нажав в нижней части окна 

кнопки Apply и OK. 

Примечания: 

– описание загруженных из файла ИДРЭС-AltiumPCBRules.RUL общих 

правил проектирования ПП приведено в Г.2. Остальные правила проектиро-

вания ПП будут добавляться в процессе ее разработки; 

– в правиле RVS были заданы только те переходные отверстия, кото-

рые можно использовать при разработке ПП по данному учебному пособию. 

11. Обновить настройки примитивов для редактора ПП и задать пере-

ходным отверстиям, создаваемым по умолчанию, шаблон из подключенной 

ранее библиотеки. 

Для этого выполнить следующее: 

– запустить команду DXP ⇒ Preferences; 

– в окне Preferences перейти в подраздел PCB Editor ⇒ Defaults; 

– нажать кнопку Load и из папки …\ИДРЭС\Профили загрузить про-

филь ИДРЭС-AltiumPCBPrimitives.dft; 

– в списке примитивов дважды щелкнуть ЛКМ по примитиву Via; 

– в открывшемся окне свойств раскрыть список Template и выбрать 

шаблон v120h60. При этом в поле Library отобразится название подключен-

ной библиотеки с шаблонами КП и переходных отверстий (рис. 12.6); 

– применить изменения в окне Via кнопкой OK.  

 

12. Для удобства перемещения посадочных мест в рабочем поле отклю-

чить выделение КП. Для этого в окне Preferences в подразделе PCB Editor ⇒ 

General включить опцию Shift Click To Select, после чего нажать кнопку 

Primitives и в открывшемся окне включить только опцию Pad. 

Рис. 12.6 

Рис. 12.5 
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Затем закрыть окно Shift Click To Select кнопкой OK. 

13. Применить профиль ИДРЭС-AltiumPCB.PCBSysColors из папки 

…ИДРЭС\Профили (см. п. 6 из 5.2.1). 

Применить изменения в окне Preferences кнопкой OK. 

Примечание. Стоит отметить, что данный профиль также меняет 

цвет связывающих линий (connections) на желтый. По умолчанию он совпа-

дает с цветом сетки, что неудобно. 

14. Настроить способы проверки правил проектирования ПП. 

Для этого запустить команду Tools ⇒ Design Rule Check и в открыв-

шемся окне в каждой категории из группы Rules To Check в соответствии с 

рис. 12.7 скорректировать настройки для отдельных типов правил в столбцах 

Online (проверка в режиме реального времени) и Batch (пакетная проверка в 

отчете после нажатия кнопки Run Design Rule Check). 

В категориях SMT, Testpoint, High Speed и Signal Integrity все галочки 

должны быть сняты. 

 Рис. 12.7 
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Примечания: 

– отключение проверок в основном связано с тем, что многие правила 

не используются при разработке ПП по данному учебному пособию. Кроме 

того, отключение проверок в столбце Online уменьшает нагрузку на компь-

ютер, поэтому здесь рекомендуется выбирать только самые необходимые; 

– в категории Electrical находятся правила, связанные с электрическим 

соединением компонентов (например, зазоры в проводящем рисунке); 

– в категории Routing находятся правила, используемые при трассиров-

ке (например, ширина трасс); 

– в категории Manufacturing находятся правила, связанные с производ-

ством ПП (например, зазор между двумя отверстиями); 

– в категории Placement находятся правила, связанные с размещением 

компонентов (например, расстояние между компонентами); 

– в категории SMT находятся правила для планарных КП (например, 

разрешение подведения трасс к КП через ее углы); 

– в категории Testpoint находятся правила, связанные с использованием 

контрольных точек (см. п. 7 из Г.17); 

– в категории High Speed находятся правила, задаваемые для высоко-

скоростных применений (например, максимальное количество переходных 

отверстий для выбранной трассы или выравнивание длин трасс);  

– в категории Signal Integrity находятся правила, связанные с анализом 

целостности сигналов (например, диапазон волнового сопротивления вы-

бранной трассы). 

15. Загрузить настройки отображения ПП в 3D-режиме просмотра в со-

ответствии с используемыми при проектировании материалами. 

Для этого выполнить следующее: 

– нажать клавишу 3 для перехода в 3D-режим просмотра; 

– нажать клавишу L и в нижней левой части открывшегося окна View 

Configurations нажать ссылку Load view configuration; 

– в окне Load View Configuration File выбрать тип файла 3D Configura-

tion (*.config_3d) и открыть файл ИДРЭС-AltiumPCB3DConfig.config_3d из 

папки …ИДРЭС\Профили; 

– выбрать загруженный профиль в списке Select PCB View Configura-

tion и применить изменения в окне View Configurations последовательным 

нажатием кнопок Apply и OK; 

– нажать клавишу 2 для перехода в 2D-режим просмотра. 
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Примечание. Для 3D-режима про-

смотра профиль с настройками по 

умолчанию находится в файле ИДРЭС-

AltiumPCB3DConfigDefault.config_3d из 

папки …ИДРЭС\Профили. 

16. Сохранить изменения в файле 

трассировки (Ctrl+S). 

17. Сохранить изменения в проекте (см. п. 4 из 5.5). 

Остальные настройки для редактора ПП были загружены в 3.2.2. 

Состав проекта из панели Projects в варианте «П1» на данном этапе по-

казан на рис. 12.8. 

12.2. Пример компоновки и трассировки ПП 

Для лучшего понимания последовательности действий при компоновке 

и трассировке ПП из вариантов задания предварительно следует ознакомить-

ся с общими особенностями разработки ПП на примере небольшого устрой-

ства, схема Э3 которого показана на рис. 12.9. 

Любая схема Э3 представляет собой 

совокупность УГО компонентов, пины 

которых соединены линиями электриче-

ской связи. Так, в схеме из приведенного 

примера есть следующие компоненты: 

– светодиод VD1 с токоограничива-

ющим резистором R1 (см. рис. В.21) для 

световой индикации наличия входного 

напряжения питания; 

– параметрический стабилизатор напряжения на стабилитроне VD2 и ре-

зисторе R2 (см. рис. В.18); 

– КП № 1 для подачи входного напряжения; 

– КП № 2 для заземления по входу; 

– КП № 3 для снятия входного напряжения (КП № 1 и 3 соединены); 

– КП № 4 для заземления по выходу; 

– КП № 5 для снятия напряжения стабилизации со стабилитрона. 

На ПП каждому УГО соответствует набор КП из посадочного места, 

расставленных таким образом, чтобы на них можно было установить корпус 

соответствующего компонента (каждый пин УГО соответствует одной или 

Рис. 12.9 

Рис. 12.8 
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нескольким КП), а каждой линии электрической связи – печатный проводник 

или другой элемент электрического соединения (например, отрезок провода).  

Если в ECAD при создании схемы Э3 используются библиотечные ком-

поненты (в них установлены точные соответствия между пинами УГО и КП 

посадочных мест), то процесс перехода от схемы Э3 к ПП происходит быст-

ро и полностью автоматически. Тем самым исключается появление ошибок, 

которые могли бы возникнуть при ручном способе перехода в случае отказа 

от работы с библиотеками. 

В результате процесса перехода к ПП в рабочем поле вне контура ПП 

(по умолчанию эта область окрашена в серый цвет) появятся посадочные ме-

ста компонентов. Пространство внутри ПП имеет черный цвет и ограничено 

пунктирной линией (рис. 12.10). 

 

Примечание. В рассматриваемом примере приводятся результаты, по-

лученные в Altium Designer. Однако в целом процесс разработки ПП в других 

подобных САПР практически ничем не отличается. 

Кроме посадочных мест в рабочем поле также будут находиться тонкие 

связывающие линии (connection) желтого цвета, расположенные между цен-

трами КП в соответствии с осуществленными на схеме Э3 соединениями пи-

нов УГО линиями электрической связи (wire). На этапе трассировки ПП они 

будут заменены на печатные проводники или другие элементы электрическо-

го соединения. 

Форму и размеры контура ПП можно изменить на требуемые в любой 

момент проектирования (по умолчанию он имеет прямоугольную форму с 

размерами 101,6 × 152,4 мм). Зачастую параметры контура заранее определе-

ны (в вариантах задания приведены на рис. 1.1) или ограничены сторонними 

факторами (например, конструкцией более высокого уровня или рядом уни-

фицированных решений, применяемым данным предприятием).  

Требования к контуру ПП в данном примере – прямоугольная форма и 

минимальные габариты, позволяющие разместить компоненты, шелкогра-

фию и одно монтажное отверстие под винт М20. 

Рис. 12.10 
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После завершения процесса перехода от схемы Э3 к ПП начинается этап 

компоновки ПП. 

Компоновка ПП – это группирование компонентов и примерное распо-

ложение их на поверхности ПП. Группирование компонентов определяется 

их функциональным назначением, а также требованиями к целостности сиг-

налов, электромагнитной совместимости, тепловому режиму и прочим физи-

ческим характеристикам. Например, при компоновке обеспечиваются мини-

мальные расстояния между основными и вспомогательными элементами, ча-

сто называемыми «обвязкой» [59]. 

Сначала компоненты расставляются по функциональным группам в со-

ответствии со схемой Э3. В данном примере получилось четыре группы 

(рис. 12.11): КП № 1 и 2; R1 и VD1; R2 и VD2; КП № 3, 4 и 5. 

 

Можно заметить, что при определенном масштабе изображения около 

центров КП появляются их порядковые номера в посадочных местах и имена 

цепей, к которым они подключены. Отображение этой информации при 

необходимости отключается. 

Рис. 12.11 
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Редактор ПП на этапе компоновки ПП позволяет поворачивать и вырав-

нивать посадочные места, переносить их на другую сторону ПП, двигать от-

дельные объекты из их состава (например, элементы шелкографии), изменять 

видимость слоев и цепей, менять цветовое оформление цепей и др. Напри-

мер, на рис. 12.11 для уменьшения объема отображаемой информации была 

отключена видимость слоев с шелкографией, защитной паяльной маской и 

3D-моделями, а для цепи GND задан желтый цвет и отключено отображение 

связывающей линии. 

Примечание. В большинстве случаев при создании рисунков видимость 

сетки будет отключаться для уменьшения количества информации на них. 

После группировки компонентов по функциональным группам они рас-

ставляются внутри контура ПП примерно так, как будут размещаться на го-

товой ПП (сам контур ПП и взаимное положение компонентов в группах при 

этом также претерпевают необходимые изменения). Это важный процесс, так 

как происходит определение общей конструкции ПП, оказывающей суще-

ственное влияние на стоимость изделия и его технологичность (см. Б.9). 

По общему заданию на проектирование компоненты и печатные про-

водники должны располагаться только на одной стороне ПП, поэтому при 

расстановке необходимо следить за следующим: 

– связывающие линии не должны пересекаться друг с другом; 

– компоненты не должны соприкасаться корпусами (контуры в слое M3 

Top Assy) и накладываться друг на друга, а также между ними должно быть 

оставлено место для возможности ручного монтажа; 

– для печатных проводников должно быть оставлено свободное место; 

– так как на этом этапе добавляются и размещаются монтажные отвер-

стия для крепления ПП, то диаметры их КП должны быть не меньше, чем 

диаметры головок крепежных винтов или шайб (при наличии). 

На рис. 12.12, а приведен возможный вариант хорошей компоновки, а на 

рис. 12.12, б – внешний вид ПП с полупрозрачным основанием без шелко-

графии, защитной паяльной маски и финишного покрытия. 

Примечания: 

– в таком виде ПП не используется, так как КП соединены печатными 

проводниками;  

– планарные КП в данном примере расположены только с верхней сто-

роны ПП, тогда как у монтажного отверстия металлизация есть еще и на 

нижней стороне ПП, а также в самом отверстии; 
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– перечеркнутая окружность в нижнем левом углу ПП является точкой 

начала координат (как в посадочном месте конденсатора). Ее расположе-

ние может быть изменено в любой момент. 

 

На рис. 12.13, а показан возможный вариант плохой компоновки, а на 

рис. 12.13, б – внешний вид ПП с полупрозрачным основанием без шелко-

графии, защитной паяльной маски и финишного покрытия. 

 

Примечание. На самом деле при заданных в п. 14 из 12.1 настройках в 

рабочем поле отдельные объекты будут отображаться с текстурами в ви-

де зеленых кругов с крестиками, что означает нарушение правил проектиро-

вания, обнаруженных программой в реальном времени (рис. 12.14). В этом 

подразделе видимость таких нарушений отключена для уменьшения количе-

ства информации на рисунках. 

Рис. 12.13 

б а 

1 

2 
3 

4, 5 

6, 7 

Рис. 12.12 

б а 
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На рис. 12.13, а отмечены следую-

щие проблемные места: 

– 1-я проблема – КП № 4 и 5 распо-

ложены близко друг к другу с зазором 

0,1 мм. В результате по Б.8 вся ПП бу-

дет изготовлена по 5-му классу точно-

сти. При автоматической проверке будет 

выдано предупреждение о нарушении 

правила С из табл. Г.7; 

– 2-я проблема – КП № 2 находится 

на границе контура ПП (см. Б.9). При 

автоматической проверке будет выдано предупреждение о нарушении прави-

ла BOС из табл. Г.7; 

– 3-я проблема – резистор R2 и светодиод VD2 расположены рядом в со-

ответствии со схемой, но пересекаются корпусами. Если оставить в таком 

виде, то монтаж SMD-компонентов будет затруднен или невозможен. При 

автоматической проверке будет выдано предупреждение о нарушении прави-

ла CС из табл. Г.7; 

– 4-я проблема – 2-я КП резистора R1 соприкасается с монтажным от-

верстием. Так как такие отверстия обычно подключают к цепи GND и винта-

ми обеспечивают крепление ПП к несущей конструкции (например, к метал-

лическому корпусу), то и нижний вывод резистора R1 по схеме с рис. 12.9 

будет подключен к цепи GND. В результате при подаче питания светодиод 

VD1 работать не будет, а все входное напряжение окажется приложенным к 

резистору R1, и он может выйти из строя (максимальная рассеиваемая мощ-

ность корпуса 0603 – 0,1 Вт). При автоматической проверке будут выданы 

предупреждения об общей точке двух разных цепей (правило ShortCircuit) и 

о нарушении правила С из табл. Г.7 между двумя КП; 

– 5-я проблема – у монтажного отверстия, предназначенного в данном 

примере для крепления ПП винтом М2 с диаметром головки 3,8 мм, диаметр 

КП составляет 3,2 мм. Близкое расположение КП компонента (или печатного 

проводника) к такому отверстию может привести к тому, что даже при нали-

чии зазора, головка винта создаст контакт с цепью GND; 

– 6-я проблема – светодиод VD1 расположен далеко от резистора R1, хо-

тя они в паре выполняют одну функцию. Расположение компонентов из од-

ной функциональной группы на большом расстоянии друг от друга во мно-

Рис. 12.14 
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гих случаях влияет на правильную работу устройства, а также замедляет по-

иск компонентов на ПП для настройки и ремонта. В данном случае эта про-

блема не является критичной; 

– 7-я проблема – связывающие линии между резистором R1 и светодио-

дом VD1 и между резистором R2 и КП № 3 пересекаются. Так как это разные 

сигналы (см. рис. 12.9), то или печатные проводники придется размещать на 

разных слоях ПП, или одну из связей вести проводом. Необоснованное уве-

личение количества слоев ПП приводит к удлинению печатных проводников, 

необходимости использования большого количества переходных отверстий, 

часто к увеличению габаритных размеров и стоимости ПП (см. Б.9). На ПП с 

большим числом компонентов и сложной схемой соединений пересечения 

связей неизбежны, но желательно их количество делать минимальным. 

На рис. 12.15 показан внешний вид ПП для рассматриваемого варианта 

плохой компоновки с размещенными на посадочных местах компонентами и 

крепежным винтом (основание ПП и винт показаны полупрозрачными). 

 

После завершения этапа компоновки начинается этап трассировки ПП. 

Трассировка ПП – разработка топологии электрических соединений 

между посадочными местами электронных компонентов, устанавливаемых 

на ПП [60]. Этап состоит в окончательной расстановке компонентов и замене 

связывающих линий линями заданной ширины (печатными проводниками 

или трассами) на сигнальных слоях ПП. На этих слоях могут быть размеще-

ны также тексты и различные полигоны. 

Рис. 12.15 

Корпуса резистора R2  

и стабилитрона VD2  

пересекаются 

КП резистора R1 соединена 

с КП монтажного отверстия 

Головка винта М2 

заходит на КП  

резистора R1 

Недостаточный диаметр 

КП монтажного  

отверстия (головка  

винта М2 выходит за КП) 

КП № 2 находится  

на краю ПП 

Зазор между КП № 4  

и 5 составляет 0,1 мм 
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При трассировке ПП необходимо следить за следующим: 

– на одном слое должны отсутствовать пересечения между печатными 

проводниками, относящимися к разным цепям; 

– между печатными проводниками должны быть необходимые зазоры; 

– все соединения должны соответствовать схеме Э3. 

Сначала на этом этапе трассируются сигнальные цепи, а затем цепи пи-

тания (в МПП для питания часто выделяются отдельные слои). 

Результат замены видимых связывающих линий на печатные проводни-

ки для приведенного варианта хорошей компоновки (см. рис. 12.12) показан 

на рис. 12.16, а, а внешний вид ПП с полупрозрачным основанием без шелко-

графии, защитной паяльной маски и финишного покрытия – на рис. 12.16, б. 

 

Из рисунка видно, что без защитной паяльной маски отдельные КП уже 

не различить – они стали частью печатных проводников. 

После этого осуществляется трассировка цепи GND (в основном с по-

мощью полигона Polygon Pour). 

Примечания: 

– металлизацией обычно покрываются все свободные места ПП, кроме 

отдельных ни к чему не подключенных участков («островков»); 

– под цепь GND часто выделяется отдельный слой (в вариантах зада-

ния таким слоем будет нижняя сторона ПП). 

Результат добавления земляных полигонов на нижнюю и верхнюю сто-

роны ПП показан на рис. 12.17, а, а внешний вид ПП с полупрозрачным ос-

нованием без шелкографии, защитной паяльной маски и финишного покры-

тия – на рис. 12.17, б. 

Рис. 12.16 

б а 
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Примечания: 

– красный цвет – металлизация на верхнем сигнальном слое ПП; 

– синий цвет – видимые участки металлизации на нижнем сигнальном 

слое в тех местах, где отсутствует металлизация на верхнем сигнальном 

слое (земляной полигон на нижнем слое имеет форму прямоугольника); 

– КП с отверстием отображаются отдельным цветом, так как они 

расположены одновременно на разных слоях (слой Multi-Layer).  

В отличие от нескольких предыдущих рисунков, здесь включено отоб-

ражение связывающих линий для цепи GND и отменено цветовое оформле-

ние для нее. Видно, что земляной полигон на нижней стороне ПП соединен 

через монтажное отверстие с участком металлизации около него на верхней 

стороне ПП, но не соединен с металлизацией у КП № 4 и с металлизацией, 

объединяющей КП № 2 и соответствующие выводы компонентов VD7 и VD2. 

Для их соединения используются переходные отверстия. 

После установки переходных отверстий и проверки отсутствия связы-

вающих линий выполняются завершающие действия этапа трассировки ПП: 

– с помощью полигонов Solid Region с назначением Polygon cutout кор-

ректируются области металлизации, выполненные полигонами Polygon Pour; 

– при необходимости в слоях с защитной паяльной маской указываются 

области ПП, в которых она будет отсутствовать (КП по умолчанию открыты 

от маски); 

– корректируется положение графической информации в слоях шелко-

графии (при ее использовании); 

– осуществляется автоматическая проверка ПП, в результате которой 

можно обнаружить практически все ошибки. 

Рис. 12.17 

б а 
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Примечание. В вариантах задания защитной паяльной маски не должно 

быть с верхней стороны ПП в области расположения СВЧ-тракта и полно-

стью с ее нижней стороны. Это необходимо для обеспечения контакта 

земляных полигонов с корпусом («основание» и «экран»), а также для исклю-

чения влияния ее параметров на СВЧ-тракт. 

Результат этапа трассировки ПП с включенным слоем шелкографии для 

рассматриваемого варианта хорошей компоновки (см. рис. 12.12) показан на 

рис. 12.18, а, а внешний вид ПП с полупрозрачным основанием без шелко-

графии, защитной паяльной маски и финишного покрытия – на рис. 12.18, б. 

 

На рис. 12.19 показан вид ПП с шелкографией белого цвета, защитной 

паяльной маской зеленого цвета и финишным покрытием ENIG в 3D-режиме 

просмотра для варианта хорошей компоновки. По рисунку видно, что объек-

ты шелкографии расставлены таким образом, что не попадают на КП. 

 

Рис. 12.18 

б а 

Рис. 12.19 
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На рис. 12.20 показана та же ПП в 

3D-режиме просмотра, но с установ-

ленными компонентами и винтом М2. 

Результат этапа трассировки ПП с 

ошибками для приведенного ранее ва-

рианта плохой компоновки (см. 

рис. 12.13) показан на рис. 12.21, а, а 

внешний вид ПП с полупрозрачным 

основанием без шелкографии, защит-

ной паяльной маски и финишного по-

крытия – на рис. 12.21, б. 

Примечание. В приведенном на рисунке результате этапа трассировки 

ПП специально были проигнорированы сообщения программы о нарушениях 

правил проектирования, чтобы рассмотреть их последствия. 

 

На рис. 12.21, а отмечены следующие проблемные места: 

– 1-я проблема – переходное отверстие для соединения металлизации на 

нижней стороне ПП с участком металлизации между КП № 4 и правым вы-

водом светодиода VD1 задевает печатный проводник, проходящий от стаби-

литрона VD2 к КП № 5. В результате при подаче питания напряжение на КП 

№ 5 будет нулевым, а все входное напряжение окажется приложенным к ре-

зистору R2, и он может выйти из строя. Данная ситуация аналогична 4-й про-

блеме, описанной для резистора R1 по рис. 12.13, а; 

– 2-я проблема – зазор между правой КП светодиода VD1, подключен-

ной к цепи GND, и печатным проводником, проходящим от стабилитрона 

Рис. 12.21 

б а 

2 

1 
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Рис. 12.20 
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VD2 к КП № 5, составляет 0,06 мм. Ситуация аналогична 1-й проблеме по 

рис. 12.13, а с уточнением, что это 7-й класс точности (см. табл. Б.6); 

– 3-я проблема – 2-я КП резистора R4 находится близко к монтажному 

отверстию (зазор – 0,125 мм), диаметр КП которого меньше диаметра голов-

ки винта М2. Ситуация аналогична 1-й и 5-й проблемам по рис. 12.13, а; 

– 4-я проблема – КП № 1 соединена с первой КП резистора R1 узким пе-

чатным проводником шириной 0,1 мм, что может повлечь к следующему: 

а) необоснованное увеличение класса точности ПП (см. Б.8); 

б) увеличение влияния бокового подтрава (см. рис. Б.24); 

в) разрушение печатного проводника из-за невозможности пропустить 

через себя требуемый ток (см. п. 7 из 12.4 и табл. 12.2); 

– 5-я проблема – печатные проводники между резистором R1 и светоди-

одом VD1 и между резистором R2 и КП № 3 пересекаются на одном слое. Это 

соответствует подключению светодиода без токоограничивающего резистора 

(см. рис. 12.9), что при подаче питания приведет к выходу первого из строя. 

12.3. Компоновка ПП 

Этап компоновки ПП следует выполнить в приведенной ниже последо-

вательности: 

1. Если проект был закрыт, то открыть его по п. 1 из 12.1. 

2. Если файл трассировки был закрыт, то открыть его по п. 3 из 8.3. 

3. Перейти в сетку 1 мм. 

4. Включить набор слоев All. 

Для этого нажать на пиктограмму LS внизу ра-

бочего поля и выбрать набор из списка (рис. 12.22). 

5. Отредактировать форму ПП по данным из 

столбцов 12 и 13 варианта индивидуального задания на проектирование: 

5.1. Перейти в режим работы с формой ПП, для чего нажать клавишу 1 

или выполнить команду View ⇒ Board Planning Mode. 

5.2. Запустить команду Design ⇒ Edit Board Shape. 

 Рис. 12.23 

Рис. 12.22 
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5.3. Изменить габаритные размеры ПП (суммарные размеры по горизон-

тали и вертикали) перемещением ее границ зажатой ЛКМ (см. рис. 12.23). 

Если на рис. 1.1 один или оба габаритных размера отсутствуют, то для 

определенности задать их следующими: 

– по горизонтали – 80 мм (16 серых квадратов сетки); 

– по вертикали – 50 мм (10 серых квадратов сетки).  

Необходимо обратить внимание на то, что перемещения требуют все че-

тыре границы ПП до совпадения с серыми линиями сетки, так как изначально 

они были расположены в дюймовой сетке. 

Примечание. Так как в варианте «П1» на рис. 1.1, б задана только ши-

рина «экрана», а габаритные размеры ПП являются произвольными, то раз-

меры ПП составили 80 × 50 мм. 

5.4. Если в варианте задания ПП имеет угловую форму (например, ПП 

на рис. 1.1, а), то запустить команду Design ⇒ Modify Board Shape и нарисо-

вать контур выреза внутри ПП: 

– на требуемой границе ПП щелчком ЛКМ 

указать точку начала контура выреза; 

– комбинацией клавиш Shift+Space вклю-

чить режим рисования линии под углом 90 (ре-

жим Line 90/90); 

– клавишей Space выбрать желаемый путь 

прохождения контура выреза; 

– на требуемой стороне контура ПП щелч-

ком ЛКМ указать точку конца контура выреза 

(рис. 12.24); 

– при необходимости отредактировать по-

ложение контура выреза с помощью команды Design ⇒ Edit Board Shape. 

5.5. Нажать клавишу 2 для перехода в 2D-режим просмотра. 

5.6. Поместить начало координат точно в угол ПП, отмеченный точкой 

на подходящем для варианта задания схематичном изображении с рис. 12.25. 

Для этого последовательно нажать клавиши E ⇒ O ⇒ S (или запустить 

команду Edit ⇒ Origin ⇒ Set) и щелкнуть ЛКМ в требуемой точке. 

5.7. Сделать текущим слой M3 Top Assy. 

5.8. Последовательным нажатием клавиш P ⇒ D ⇒ L или командой 

Place ⇒ Dimension ⇒ Linear добавить линейные размеры ПП по подходя-

щему для варианта задания схематичному изображению с рис. 12.25. 

Рис. 12.24 
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Примечания: 

– первым щелчком ЛКМ указывается положение первой выносной линии 

размера, вторым щелчком ЛКМ – положение второй выносной линии разме-

ра, третьим щелчком ЛКМ задается положение размерной линии. Перед по-

следним щелчком можно поменять ориентацию размера клавишей Space; 

– для привязки размера к ПП выносные линии указываются на ее грани-

цах или вершинах. Если в этих местах есть и другие объекты, то сперва 

включается привязка к объектам на всех слоях (комбинация клавиш Shift+E 

до появления надписи Hotspot Snap (All Layers) в информационном поле), а 

затем осуществляется размещение (или корректировка) требуемой вынос-

ной линии с последующим выбором объекта привязки в появляющемся окне; 

– размеры ПП в процессе проектирования будут корректироваться; 

– контур ПП на слое M1 Board будет получен после этапа трассировки; 

– способы создания контура ПП описаны в Г.39. 

Результат в варианте «П1» на данном этапе показан на рис. 12.26, а, а 

возможный вариант для ПП с вырезом – на рис. 12.26, б. 

Рис. 12.25 
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6. Добавить посадочные места компонентов и связи из схемы Э3: 

6.1. Открыть схему (см. п. 3 из 8.3). 

6.2. Запустить команду Design ⇒ Update PCB Document. 

Примечание. Если в проекте есть несколько файлов трассировки, то 

необходимо обратить внимание на название файла в этой команде.  

6.3. В появившемся окне Engineering Change Order нажать кнопку Val-

idate Changes для проверки возможности внесения изменений. 

Если в столбце Check отображаются зеленые галочки, то последова-

тельно нажать кнопки Execute Changes (применение изменений) и Close. 

Примечания: 

– фрагменты окна Engineering Change Order из варианта «П1» показа-

ны на рис. 12.27; 

 Рис. 12.27 

Рис. 12.26 

б а 
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– все изменения в окне автоматически разбиваются по группам (напри-

мер, на рис. 12.27 их четыре: добавление 28 компонентов, 18 цепей, одного 

класса компонентов и одного класса цепей); 

– каждое изменение может быть разрешено или отменено в столбце 

Enable; 

– в столбце Action указывается тип изменения (Add – добавление, Re-

move – удаление, Modify – изменение), в столбце Affected Object – объект из-

менения, а в столбце Affected Document – документ, в котором производится 

изменение; 

– доступны различные команды из контекстного меню, вызываемого 

щелчком ПКМ в любом месте данного окна; 

– виды различий между схемой и файлом трассировки, по которым вы-

полняется проверка перед формированием списка изменений в окне Engineer-

ing Change Order, настраиваются на вкладке Comparator окна свойств про-

екта (команда Project ⇒ Project Options), а сами действия по обнаруженным 

различиям, вносимым в этот список, – на вкладке ECO Generation; 

– если изменение не проходит проверку, то напротив него в столбце 

Check появится красный крест, а в столбце Message – описание причины. 

Например, на рис. 12.28 показана ситуация, возникшая из-за отсутствия у 

компонента посадочного места (специально была отключена библиотека 

компонентов). Подобные сообщения требуют исправлений; 

 

– не всегда наличие красного креста в столбце Check напротив измене-

ния свидетельствует о наличии ошибок. В отдельных случаях это может 

означать, что изменение не может быть применено, так как пока в файле 

трассировки нет каких-то объектов, которые будут добавлены изменения-

ми, располагающимися в списке раньше. После нажатия кнопки Execute 

Changes такие проблемные места пропадут; 

– в данном учебном пособии используются компоненты (отрезки МПЛ), 

в свойствах которых выбран тип Mechanical (см. Г.33). При последующем 

запуске команды Design ⇒ Update PCB Document (например, для переноса 

каких-либо корректировок, сделанных в схеме) в группе изменений Add Pins 

To Nets (подключение выводов компонентов к цепям) изменения, связанные с 

Рис. 12.28 
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отрезками МПЛ, не будут проходить проверку (рис. 12.29), так как поса-

дочных мест для таких компонентов в файле трассировки нет и подклю-

чить цепи не к чему. Подобные сообщения можно пропустить. 

 

Стоит отметить, что аналогичная ситуация возникнет и при переносе 

изменений из файла трассировки в схему. В этом случае будут появляться 

сообщения о невозможности отсоединить цепи от пинов УГО. На них 

также обращать внимание не нужно, так как Altium Designer в редакторе 

схем не может автоматически подключать и отключать цепи, а также 

удалять и добавлять компоненты. 

В результате внесения изменений справа от контура ПП появятся поса-

дочные места компонентов со связями между ними. 

Результат в варианте «П1» на данном этапе показан на рис. 12.30. 

 

7. Задать желтый цвет всем объектам, которые подключены к цепи GND, 

и отключить видимость связывающих линий этой цепи. 

Это удобно сделать с использованием панели PCB: 

– перейти в панель PCB и в верхней части выбрать режим работы с це-

пями (Nets); 

– в группе с классами цепей выбрать класс Power; 

– в группе с цепями слева от GND поставить галочку (рис. 12.31, а); 

– на этой же строке выполнить команду ПКМ ⇒ Connections ⇒ Hide. 

Изменения, произошедшие в результате выполненных действий в обла-

сти нескольких компонентов, в варианте «П1» показаны на рис. 12.31, б. 

Рис. 12.29 

Рис. 12.30 
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Примечания: 

– аналогичные действия обычно выполняют и с цепями питания; 

– произвольный цвет цепи можно задать в окне ее свойств (команда 

ПКМ ⇒ Properties) в поле Connection Color. Также можно воспользоваться 

командой ПКМ ⇒ Change Net Color; 

– отключить видимость связывающих линий также можно в окне 

свойств цепи с помощью опции Hide Connections или командой View ⇒ Con-

nections ⇒ Hide Net с последующим указанием цепи в рабочем поле; 

– особенности работы с панелью PCB приведены в Г.14. 

8. Импортировать и настроить топологию ПФ: 

8.1. Запустить команду File ⇒ Import ⇒ DXF/DWG и открыть файл то-

пологии ПФ, сохраненный в формате DXF в п. 13 из 4.4. 

8.2. В открывшемся окне Import from AutoCAD выполнить следующее: 

– в группе Blocks выбрать опцию Import as primitives; 

– в группе Drawing Space выбрать опцию Model; 

– в группе Default Line Width задать толщину линий 0.1mm; 

– в группе Scale выбрать опцию mm; 

– в группе Locate AutoCAD (0,0) at нажать кнопку Select, после чего в 

рабочем поле щелкнуть ЛКМ в точке начала координат; 

– в столбце PCB Layer для слоя, заканчивающегося на _COND (полос-

ковые элементы), выбрать слой проекта Top Layer;  

– в вариантах задания с ШТ в столбце PCB Layer для слоя, заканчива-

ющегося на _VIA (переходные отверстия), выбрать слой проекта M7 Shield;  

Рис. 12.31 

б а 
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– если в столбце Source Layer Name присутствуют другие слои, то в 

столбце PCB Layer выбрать для них Not Imported; 

– применить изменения кнопкой OK. 

Примечание. Настройки окна Import from AutoCAD для варианта «П1» 

показаны на рис. 12.32. 

 

8.3. В появившемся окне с информацией о за-

вершении импорта нажать кнопку OK, в результате 

чего справа от начала координат появится топология 

ПФ в виде контуров из линий в масштабе 1:1. 

Результат в варианте «П1» на данном этапе по-

казан на рис. 12.33. 

Примечание. Линии в слое Top Layer будут под-

свечены как нарушающие правило проектирования. 

На это не стоит обращать внимания. 

8.4. Сделать текущим слой Top Layer. 

После этого преобразовать замкнутые контуры 

из топологии ПФ, находящиеся на слое Top Layer, в полигоны Solid Region, 

выполнив для каждого такого контура следующие действия: 

– щелчком ЛКМ выбрать любой примитив из требуемого контура; 

– нажать клавишу Tab для выделения всех примитивов, которые сопри-

касаются или пересекаются с выбранным примитивом; 

Рис. 12.32 

Рис. 12.33 
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– выполнить команду Tools ⇒ Convert ⇒ Create Region from Selected 

Primitives; 

– нажать клавишу Delete для удаления выделенных линий. 

Примечание. Если какие-то линии контура не были удалены, то их 

можно выделить и удалить описанным выше способом (полигоны при этом 

выделены не будут). 

8.5. В вариантах задания с ШТ выполнить следующее: 

– подключить все полигоны в топологии ПФ, за исключением крайних, к 

цепи GND, для чего в их свойствах в списке Net выбрать требуемую цепь. 

Примечание. Подключение можно выполнить сразу для нескольких вы-

деленных полигонов в панели PCB Inspector; 

– сделать текущим слой M7 Shield; 

– нажать комбинацию клавиш Ctrl+D и на открывшейся 

вкладке Show / Hide окна View Configurations в группе Vias 

выбрать опцию Draft (рис. 12.34), в результате чего переход-

ные отверстия будут представлены внешними очертаниями; 

– применить изменения кнопкой OK; 

– перейти в сетку 0.1 мм; 

– последовательно нажать клавиши P ⇒ V; 

– нажать клавишу Tab для открытия окна свойств, в котором в списке 

Template выбрать шаблон v90h40, а в списке Net – цепь GND; 

– в рабочем поле поместить по одному пере-

ходному отверстию в центр каждого крестообраз-

ного контура из слоя M7 Shield (рис. 12.35). 

Примечание. При необходимости отключить 

привязку к характерным точкам можно комбина-

цией клавиш Shift+E до исчезновения надписи 

Hotspot Snap в информационном поле (или в строке 

состояний); 

– включить режим одного слоя комбинацией клавиш Shift+S; 

– выделить и удалить крестообразные контуры из слоя M7 Shield; 

– выйти из режима одного слоя комбинацией клавиш Shift+S; 

– нажать комбинацию клавиш Ctrl+D и в группе Vias выбрать опцию 

Final, т. е. нормальное отображение переходных отверстий; 

– сделать текущим слой Top Layer; 

– перейти в сетку 1 мм. 

Рис. 12.34 

Рис. 12.35 
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8.6. С помощью полигона Solid Region нарисовать область, в которой 

будет отсутствовать металлизация, создаваемая полигоном Polygon Pour. 

Для этого выполнить следующее: 

– последовательно нажать клавиши P ⇒ R; 

– нажать клавишу Tab для открытия окна свойств; 

– на вкладке Graphical окна свойств в списке Kind выбрать опцию Poly-

gon cutout; 

– на вкладке Outline Vertices кнопкой Add создать 

четыре вершины с координатами: (0; 0), (X_Dim; 0), 

(X_Dim; Y_Dim), (0; Y_Dim).  

Примечание. Величины X_Dim и Y_Dim были со-

хранены в отчете в п. 2.3 из 4.4. Результат в варианте 

«П1» показан на рис. 12.36; 

– применить изменения в окне свойств и щелкнуть ЛКМ в точке начала 

координат для размещения прямоугольного контура полигона; 

– дважды нажать клавишу Esc для завершения создания текущего поли-

гона и выхода из команды. 

Результат в варианте «П1» на данном этапе показан на рис. 12.37, а, а 

возможный результат в вариантах задания с СЛ – на рис. 12.37, б. 

 

Примечание. Изображения с рис. 12.37 получены в режиме одного слоя. 

8.7. В вариантах задания с СЛ выполнить следующее: 

– в окне Preferences (команда DXP ⇒ Preferences) в подразделе PCB Edi-

tor ⇒ General в поле Rotation Step задать шаг угла поворота 1 градус, а в 

списке Cursor Type выбрать опцию Large 90; 

Рис. 12.37 

б а 

Рис. 12.36 
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– комбинацией клавиш Shift+E включить привязку к ближайшим объек-

там до появления надписи Hotspot Snap или Hotspot Snap (All Layers) в ин-

формационном поле (или в строке состояний); 

– выделить все полигоны из топологии ПФ, кроме пунктирного контура 

из п. 8.6, и подвести курсор мышки к любой характерной точке на левой сто-

роне крайнего левого полигона; 

– зажать ЛКМ и клавишей Space или комбинацией клавиш Shift+Space 

повернуть выделенные объекты так, чтобы середины левой стороны крайнего 

левого полигона и правой стороны крайнего правого полигона находились 

примерно на одной линии (рис. 12.38), после чего отпустить ЛКМ; 

 

– если топология ПФ находилась за пределами ПП, то выделить все ее 

объекты (полигоны и пунктирный контур из п. 8.6) и переместить их за точку 

начала координат внутрь контура ПП в любое удобное место; 

– перейти в сетку 0.1 мм; 

– отредактировать положение верхней и нижней границ пунктирного 

контура из п. 8.6 так, чтобы расстояние до полигонов стало около 2 мм, а 

также правой его границы, сдвинув ее вправо до первой встретившейся вер-

шины правой стороны крайнего правого полигона (рис. 12.39). 

 

Примечание. Способы редактирования сторон полигона Solid Region 

описаны в пп. 2.4 и 2.7 из Г.26; 

– в окне Preferences (команда DXP ⇒ Preferences) в подразделе PCB Edi-

tor ⇒ General в поле Rotation Step задать шаг угла поворота 90 градусов, а в 

списке Cursor Type выбрать опцию Small 90. 

Рис. 12.39 

Рис. 12.38 
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8.8. Подключить крайний левый полигон в топологии ПФ (на который 

поступает СВЧ-сигнал) к цепи MW-1, а крайний правый (с которого выходит 

СВЧ-сигнал) – к цепи MW-2. 

Для этого в свойствах полигонов в списке Net выбрать требуемые цепи. 

8.9. Сгруппировать все объекты топологии ПФ (полигоны, переходные 

отверстия в вариантах с ШТ и пунктирный контур из п. 8.6), для чего выде-

лить их, выполнить на них команду ПКМ ⇒ Unions ⇒ Create Union from se-

lected objects и в появившемся окне сообщений нажать OK. 

Примечание. В редакторе ПП в группу также можно добавлять и дру-

гие объекты (например, посадочные места компонентов и трассы), при 

этом при перемещении любого объекта группы будет перемещаться вся 

группа целиком, в отличие от редактора схем. 

8.10. Изменить имя объединенных объек-

тов топологии ПФ: 

– в верхней части панели PCB выбрать 

режим работы с группами объектов (Unions); 

– выбрать любую строку с типами групп; 

– в списке групп на единственной строке 

выполнить команду ПКМ ⇒ Rename; 

– в появившемся окне ввести имя BPF и 

нажать OK. 

Результат в варианте «П1» показан на 

рис. 12.40. 

9. Сохранить изменения (Ctrl+S). 

10. Выполнить подготовительные действия перед расстановкой поса-

дочных мест компонентов: 

10.1. Перейти в сетку 0.1 мм. 

10.2. Включить набор слоев Shield. 

10.3. Сделать текущим слой M3 Top Assy. 

10.4. Зажатой ЛКМ переместить вкладку с файлом трассировки так, что-

бы она находилась правее вкладки со схемой, после чего выполнить команду 

Window ⇒ Tile Horizontally для одновременного отображения двух вкладок. 

Примечания: 

– открыть схему, если она была закрыта, можно по п. 3 из 8.3; 

– крайняя правая вкладка после выполнения указанной команды оказыва-

ется в верхней части рабочего поля; 

Рис. 12.40 
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– для возврата в режим отображения только одного документа необ-

ходимо либо вручную перетащить зажатой ЛКМ одну вкладку к другой, ли-

бо на любой вкладке выполнить команду ПКМ ⇒ Merge All. 

10.5. Убедиться в том, что включен режим Cross Select Mode (см. Г.35). 

10.6. При активной вкладке с файлом трасировки в верхней части панели 

PCB выбрать режим работы с компонентами (Components), а в группе с 

классами компонентов – <All Components> (все компоненты). 

11. Разместить посадочные места компонентов и топологию ПФ в лю-

бом удобном месте за пределами контура ПП в соответствии с их расположе-

нием на схеме Э3 «усилителя» одним из способов, описанных в табл. 12.1. 

Таблица 12.1 

Основные способы расстановки посадочных мест 

№ Описание Примечание 

1 

Посадочные места по одному перетаскиваются из спис-

ка компонентов в панели PCB. При перетаскивании не-

скольких посадочных мест они будут появляться под 

курсором мышки по очереди. 

Схема используется только для просмотра подключений 

компонентов 

Для выделения выбирае-

мых компонентов в схеме 

(режим Cross Select Mode) 

требуется включение оп-

ции Select в панели PCB  

2 

Сначала в схеме выделяются требуемые компоненты. 

Затем в редакторе ПП запускается команда Tools ⇒ 

Component Placement ⇒ Arrange Within Rectangle и в 

рабочем поле курсором мышки рисуется прямоугольный 

контур, в который автоматически будут перемещены 

выбранные посадочные места. 

Далее посадочные места расставляются вручную 

Способ подходит для 

быстрого формирования 

областей с функциональ-

ными группами компонен-

тов 

3 

Сначала в схеме выделяются требуемые компоненты. 

Затем в редакторе ПП запускается команда Tools ⇒ 

Component Placement ⇒ Reposition Selected Compo-

nents, в результате чего в рабочем поле под курсором 

мышки выбранные посадочные места будут появляться 

по очереди  

Если в схеме выделять 

компоненты в определен-

ном порядке, то их поса-

дочные места появятся под 

курсором мышки в таком 

же порядке 

4 

С включенной опцией Reposition selected component in 

PCB (Hotkey: Ctrl+Shift+Y) в окне Preferences (см. 

Г.35) после выделения компонента в схеме его посадоч-

ное место автоматически привяжется к курсору мышки 

для размещения  

При массовом выделении 

нескольких компонентов 

их посадочные места будут 

появляться под курсором 

мышки по очереди 

Примечания: 

– рекомендуется опробовать все способы; 

– в способах № 2 и 3 через панель PCB можно выделить все компонен-

ты из заранее созданного в п. 9.4 из 8.3 класса «ТоковоеЗеркало»; 
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– в процессе размещения посадочные места можно поворачивать кла-

вишей Space или комбинацией клавиш Shift+Space; 

– перенос посадочного места на другую сторону ПП осуществляется 

клавишей L (возможность может быть использована только в обоснован-

ных случаях, так как противоречит общему заданию на проектирование); 

– спрятать связывающие линии от перемещаемого в данный момент 

посадочного места позволяет клавиша N; 

– при перемещении посадочных мест доступно три режима разрешения 

конфликтов, циклически изменяющихся при нажатии клавиши R: Ignore (ре-

комендуемый режим) – игнорировать, т. е. посадочные места можно раз-

местить как угодно, при этом зазоры проверяются по 3D-моделям или по 

границам примитивов (при отсутствии 3D-моделей); Avoid – избегать, т. е. 

посадочные места нельзя приблизить друг к другу на расстояние, нарушаю-

щее заданное правило проектирования (зазоры проверяются по границам 

примитивов); Push – расталкивать, т. е. при приближении к другому поса-

дочному месту на расстояние, нарушающее заданное правило проектирова-

ния, последнее будет автоматически изменять свое положение даже при 

нахождении в составе группы других объектов (зазоры проверяются по гра-

ницам примитивов). Текущий режим также можно изменить в окне Prefer-

ences (команда DXP ⇒ Preferences) в списке Component pushing из подраздела 

PCB Editor ⇒ Interactive Routing; 

– снятие выделения осуществляется комбинацией клавиш Shift+C или 

кнопкой Clear из нижнего правого угла рабочего поля (см. рис. 5.9). 

Результат размещения посадочных мест компонентов узла вторичного 

питания в варианте «П1» показан на рис. 12.41.  

 Рис. 12.41 
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Результат размещения посадочных мест компонентов СВЧ-тракта (рас-

положены на одной линии от входных до выходных КП), «токового зеркала» 

и узла управления (разъем) в варианте «П1» показан на рис. 12.42.  

 Рис. 12.42 

к V1 
к C5 и C7 
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Примечания: 

– размещение посадочных мест компонентов можно контролировать и 

производить в 3D-режиме просмотра (клавиша 3). Например, 3D-вид рас-

ставленных посадочных мест с рис. 12.41 показан на рис. 12.43; 

 

– так как посадочного места для компонента W1 нет, то и пара блоки-

ровочных конденсаторов оказалась не связана с выходом микросхемы усили-

теля (см. рис. 12.42). Соединение будет создано на этапе трассировки. 

12. После использования 4-го способа расстановки посадочных мест из 

табл. 12.1 отключить указанную в нем опцию. 

13. Перейти в режим работы только с файлом трассировки (см. п. 10.4). 

14. Обозначить контуры «экрана»: 

14.1. Ознакомиться с формой «экрана» по рис. 1.1 в соответствии с ин-

дивидуальным заданием на проектирование и его внешним видом на одном 

из примеров, показанных на рис. 12.44. 

 

Рис. 12.43 

Рис. 12.44 

Внутренняя полость 

Прорезь в стенке Тонкая стенка Толстая стенка 
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В собранном изделии «экран» располагается на верхней стороне ПП и 

закрывает СВЧ-тракт (ПФ, усилитель и аттенюатор), оказывающийся в его 

внутренней полости. 

Прорези в толстых стенках «экрана» нужны для подсоединения цен-

тральных жил СВЧ-разъемов к входной и выходной КП, а в тонких стенках – 

для подведения питания и управляющих сигналов к соответствующим функ-

циональным узлам «усилителя», так как все печатные проводники по требо-

ванию общего задания на проектирование находятся на верхней стороне ПП. 

14.2. Временно записать размеры следующих элементов «экрана», кото-

рые будут одинаковы для всех вариантов задания: 

– толщина толстых стенок – 6 мм; 

– толщина тонких стенок – 2 мм; 

– радиусы скруглений внутренней полости – 3 мм. 

14.3. Выбрать и временно записать значение ширины «экрана» в области 

расположения надписей «ВХОД» и «ВЫХОД» на рис. 1.1. 

Примечание. На данном этапе в вариантах задания с угловым «экра-

ном» значения ширины около каждой надписи считаются одинаковыми, но в 

процессе компоновки ПП они могут изменяться независимо друг от друга. 

Минимальное значение ограничено большим из двух размеров: 

– длиной фланца СВЧ-разъема SMA-KFD5A, равной 16 мм. При мень-

шей ширине для принятой на рис. 2.4 конструкции СВЧ-разъем нельзя будет 

закрепить (вариант его установки показан на рис. 12.45); 

– наибольшим размером компонента или функциональной группы из 

СВЧ-трактата с учетом двух толщин тонких стенок. 

 Рис. 12.45 
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Максимальное значение ограничено размером A на рис. 1.1. 

Примечание. В варианте «П1» минимальное значение составило 20 мм 

(размер Y_Dim из топологии ПФ, равный 16 мм, и две толщины тонких сте-

нок по 2 мм каждая), а максимальное значение – 25 мм. В результате из 

диапазона 20–25 мм ширина «экрана» выбрана равной 21 мм. 

14.4. Перейти в сетку 0.5 мм. 

14.5. Сделать текущим слой M7 Shield. 

14.6. Последовательным нажатием клавиш P ⇒ L (создание линии) 

нарисовать внешний контур «экрана» с шириной линии 0,2 мм, проходящий 

по контуру ПП в тех местах, где на рис. 1.1 имеет с ним общие стороны. 

Примечания: 

– окно свойств линии во время рисования открывается клавишей Tab; 

– для создания контура потребуется размер, определенный в п. 14.3; 

– данный контур удобно рисовать в режимах Line 90 Start и Line 90 End 

с отключенным режимом Toggle Lookahead Mode. 

14.7. Последовательным нажатием клавиш P ⇒ L нарисовать контур 

внутренней полости «экрана» с шириной линии 0,2 мм. 

В вариантах задания с угловым «экраном» угол 

контура внутренней полости, рядом с которым будет 

размещено отверстие для крепежа по рис. 12.44, 

оформить в соответствии с рис. 12.46. 

Примечания: 

– для создания контура потребуются размеры 

из п. 14.2; 

– данный контур удобно рисовать в режимах 

Line 90 Start with Arc и Line 90 End With Arc с вклю-

ченным режимом Toggle Lookahead Mode. Радиус скруглений можно отре-

дактировать после выхода из команды рисования линии, при этом прямоли-

нейные отрезки подстроятся автоматически. 

Результат в варианте «П1» на данном этапе показан на рис. 12.47. 

 Рис. 12.47 

Рис. 12.46 
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15. Добавить КП, которые будут использоваться для крепления ПП. 

Для этого выполнить следующие действия: 

– последовательно нажать клавиши P ⇒ P (создание КП); 

– открыть окно свойств клавишей Tab; 

– в окне свойств в списке Template выбрать шаблон c500h290 (шаблон 

был добавлен к проекту в п. 9 из 12.1), а в списке Net – цепь GND; 

– после применения изменений в окне свойств добавить необходимое 

количество КП в соответствии с подходящим для варианта задания схема-

тичным изображением с рис. 12.48, при этом расстояние от края каждой КП 

до ближайших границ ПП и контуров «экрана» должно быть 0,5 мм. 

 

Результат добавления КП в варианте «П1» в 

левый верхний угол ПП показан на рис. 12.49. 

Примечание. Так как в п. 12 из 12.1 была вклю-

чена опция Shift Click To Select, то выделение КП 

щелчком ЛКМ (см. Г.5) осуществляется с зажатой 

клавишей Shift.  

16. Сохранить изменения (Ctrl+S). 

17. Переместить расставленные за пределами контура ПП посадочные 

места компонентов и топологию ПФ внутрь ПП: 

17.1. Заблокировать размеры, контуры «экрана» и КП для крепления ПП, 

чтобы их нельзя было случайно сдвинуть. 

Рис. 12.48 

Рис. 12.49 
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Для этого массовым выделением мышкой выделить их все и в панели 

PCB Inspector в группе Graphical включить опцию Locked. 

Примечания: 

– за возможность выделения мышкой заблокированных объектов отве-

чает опция Protect Locked Objects (см. подраздел General из табл. Г.4); 

– у заблокированных объектов можно включить отоб-

ражение текстуры в виде ключей (рис. 12.50). Настраивается 

это в окне Preferences (команда DXP ⇒ Preferences) в группе 

Show Locked Texture on Objects из подраздела PCB Editor ⇒ 

Board Insight Display. По умолчанию включена опция Only 

When Live Highlighting, т. е. текстура появляется только у 

объектов, подключенных к какой-нибудь цепи, при действии подсветки в ре-

альном времени (см. п. 8.1 из Г.42). 

17.2. Скомпоновать три входные КП, для чего выполнить следующее: 

– включить набор слоев All; 

– расположить КП в области надписи «ВХОД» с рис. 1.1 симметрично 

тонким стенкам «экрана» в соответствии с рис. 12.51, а; 

 

– повернуть КП таким образом, чтобы линии из слоя шелкографии рас-

полагались со стороны контура внутренней прорези «экрана» (рис. 12.51, б); 

– объединить КП в группу с именем InputPads (см. пп. 8.9 и 8.10). 

Примечания: 

– в соответствии с загруженными в 3.2.2 настройками (примитив 

Component из табл. Г.6) позиционные обозначения из слоя шелкографии ав-

томатически располагаются над посадочными местами. Их корректировка 

будет произведена в конце этапа трассировки ПП; 

Рис. 12.51 

а в б 

Рис. 12.50 
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– заданное расположение КП связано с требованием общего задания на 

проектирование по установке СВЧ-разъемов EMPCB.SMAFSTJ.B.HT фирмы 

Taoglas, внешний вид которых показан на рис. 12.51, в; 

– при попытке переместить группу будет появляться запрос на под-

тверждение действия. Связано это с тем, что в посадочных местах компо-

нентов из использованных библиотек есть заблокированные текстовые 

надписи с позиционными обозначениями компонентов в слое M3 Top Assy (см. 

п. 15.6 из 5.2.3). Блокировка обусловлена облегчением расстановки посадоч-

ных мест (надписи не выделяются при пере-

мещении). 

При необходимости отмены блокировки у 

таких надписей требуемые компоненты сна-

чала выделяются, затем в панели PCB Filter в 

поле Filter формируется соответствующий 

запрос, устанавливаются указанные на 

рис. 12.52 опции и нажимается кнопка Apply 

to All. После этого в панели PCB Inspector в 

группе Graphical отключается опция Locked и 

в рабочем поле снимается выделение. 

17.3. По аналогии с п. 17.2 расположить три выходные КП в области 

надписи «ВЫХОД» с рис. 1.1 и объединить их в группу OutputPads. 

17.4. Включить набор слоев Shield. 

17.5. Последовательным нажатием клавиш P ⇒ L 

обозначить прорези в толстых стенках «экрана» с ши-

риной линии 0,2 мм (см. рис. 12.44), после чего забло-

кировать их. 

Прорези должны быть расположены симметрич-

но тонким стенкам «экрана», а их линии допускается 

проводить по входным и выходным КП, подключен-

ным к цепи GND. 

Результат в варианте «П1» в области входных КП 

показан на рис. 12.53. 

17.6. Сделать текущим слой M3 Top Assy. 

17.7. Перейти в сетку 0.1 мм. 

17.8. Расположить топологию ПФ полностью 

внутри контура внутренней полости «экрана» недале-

Рис. 12.52 

Рис. 12.53 
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ко от входных КП на расстоянии, достаточном для проведения трассы от 

центральной КП этой группы. 

Результат в варианте «П1» на данном этапе показан на рис. 12.54, а (зе-

леным цветом условно обозначен путь, по которому на этапе трассировки ПП 

планируется провести трассу цепи MW-1), а возможный результат в вариан-

тах задания с СЛ – на рис. 12.54, б. 

 

17.9. Расставить оставшиеся компоненты СВЧ-тракта (разделительные 

конденсаторы, микросхему усилителя, микросхему аттенюатора с располо-

женными около него резисторами и конденсаторами) внутри внутреннего 

контура «экрана», при этом обратить внимание на следующее: 

– разделительный конденсатор перед выходной КП может располагаться 

под прорезью толстой стенки «экрана»; 

– блокировочный конденсатор у микросхемы аттенюатора (при наличии) 

необходимо расположить как можно ближе к соответствующему выводу, при 

этом питание должно сначала попасть на него, а уже затем на вывод;  

– расположение компонентов должно обеспечивать беспрепятственное 

проведение трассы от входа устройства к его выходу; 

– к выводам управления и питания в микросхеме аттенюатора должен 

быть обеспечен доступ со стороны не закрытой «экраном» области ПП. 

Если возникает конфликт в последних двух требованиях, то необходимо 

выполнить связанное с микросхемой аттенюатора, после чего временно от-

метить этот момент и перейти к выполнению следующего пункта. 

Результат в варианте «П1» на данном этапе показан на рис. 12.55. 

Примечание. На данном этапе на избыточные размеры ПП не стоит 

обращать внимание. Они будут скорректированы позднее. 

Рис. 12.54 

б а 

MW-1 
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17.10. Расставить компоненты, обеспечивающие подачу питания на мик-

росхему усилителя («токовое зеркало» и два блокировочных конденсатора), 

при этом обратить внимание на следующее: 

– расстояние от выхода микросхемы усилителя до двух блокировочных 

конденсаторов фиксировано, определено по (4.8) и указано на схеме Э3 

«усилителя» в свойствах отрезка МПЛ. 

Примечание. Измерить расстояние можно командой Reports ⇒ Measure 

Distance (или комбинацией клавиш Ctrl+M). После запуска команды щелчка-

ми ЛКМ последовательно указываются точки, между которыми требуется 

выполнить измерение (вторую точку можно не нажимать, а контролиро-

вать результат по информационному полю, нажав потом для отмены кла-

вишу Esc). При указании двух точек результат измерения появится в ин-

формационном окне, а также останется в рабочем поле до перемещения ка-

кого-либо посадочного места или до очистки фильтра (Shift+C); 

– блокировочные конденсаторы с учетом длины отрезка МПЛ должны 

быть расположены в пределах внешнего контура «экрана» (допускается раз-

мещение прямо в тонкой стенке «экрана») с доступом к ним от «токового 

зеркала» со стороны незакрытой «экраном» области ПП; 

– компоненты «токового зеркала» должны быть расположены вне кон-

тура «экрана» и рядом друг с другом таким образом, чтобы к КП соответ-

ствующих резисторов можно было подвести питание одной трассой. 

Рис. 12.55 
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Результат в варианте «П1» с выполненным измерением и условным обо-

значением «токового зеркала» показан на рис. 12.56, а. 

 

17.11. Вне «экрана» со стороны микросхемы аттенюатора расположить в 

зависимости от варианта задания разъем управления или узел управления 

(коммутационные устройства), при этом обратить внимание на следующее: 

– размещение углового разъема управления должно обеспечивать воз-

можность подключения к нему ответной части; 

– у связывающих линий между выводами управления микросхемы атте-

нюатора и выводами разъема (или коммутационных устройств) не должно 

быть взаимных пересечений. Если это выполнить невозможно, то временно 

отметить данный момент и перейти к выполнению следующего пункта. 

Результат в варианте «П1» показан на рис. 12.56, б. На рисунке серым 

цветом условно обозначены пути, по которым планируется на этапе трасси-

ровки ПП провести трассы цепей управления V1 и V2. 

Примечание. Некоторые разъемы показаны на рис. 8.33, а особенности 

их размещения приведены в установочных чертежах из папки …\ИДРЭС\ 

Монтаж элементов (см. рис. 2.9). Также их удобно смотреть в 3D-режиме 

просмотра (клавиша 3), при этом для отображения связывающих линий сле-

дует ПП сделать прозрачной или включить режим одного слоя (Shift+S). 

17.12. Вне «экрана» расположить посадочные места компонентов узла 

вторичного питания: 

Рис. 12.56 

б а 

«Токовое 

зеркало» 

V1 

V2 
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– разъем питания; 

– ЗП; 

– микросхема стабилизатора напряжения с конденсаторами по входу и 

выходу, катушкой индуктивности и резистивным делителем (при наличии); 

– ИПС (при наличии); 

– параметрический стабилизатор напряжения (при наличии). 

При размещении необходимо учесть следующее: 

– размещение углового разъема питания должно обеспечивать возмож-

ность подключения к нему ответной части (см. примечание к п. 17.11); 

– блокировочные конденсаторы по входу и выходу микросхемы стаби-

лизатора должны находиться около ее выводов, при этом керамические кон-

денсаторы – как можно ближе; 

– компоненты внутри функциональных групп должны располагаться ря-

дом друг с другом; 

– расположение компонентов должно обеспечивать беспрепятственное 

проведение трасс питания как до микросхемы стабилизатора, так и от нее до 

потребителей. 

После выполнения данного пункта все посадочные места компонентов 

должны оказаться на ПП.  

Результат в варианте «П1» на данном этапе показан на рис. 12.57. На ри-

сунке также обозначены пути, по которым на этапе трассировки ПП плани-

руется провести трассы для СВЧ-сигнала (зеленый цвет) и питаний (оранже-

вый и красный цвета). 

 Рис. 12.57 

+5 В +5,2…+7,8 В 

СВЧ 
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18. Сохранить изменения (Ctrl+S). 

19. Чтобы при возможных дальнейших переносах изменений из схемы 

на ПП (и обратно) не сбились цвета цепей, запустить команду Project ⇒ Pro-

ject Options и в появившемся окне на вкладке Comparator в группе Differ-

ences Associated with Nets (различия, связанные с цепями) отключить опцию 

Changed Net Colors (рис. 12.58). 

 

20. Сохранить изменения в проекте (см. п. 4 из 5.5). 

21. Если в пп. 17.9 и 17.11 были отмечены нарушения приведенных в 

них требований или в процессе размещения компонентов были обнаружены 

ошибки в схеме Э3 «усилителя», то осуществить необходимые корректиров-

ки и исправления в проекте по аналогии с разобранным в Г.46 примером. 

При осуществлении эквивалентной замены выводов следует обратить 

внимание на следующее: 

– предварительно необходимо выполнить п. 2 из Г.45, т. е. поставить не-

обходимые галочки у компонентов в окне, открываемом командой Tools ⇒ 

Pin/Part Swapping ⇒ Configure; 

– рекомендуется использовать интерактивную замену выводов, а не ав-

томатическую (см. пп. 3.1 и 3.2 из Г.45). 

22. Если в п. 21 были произведены корректировки, то сохранить схему 

Э3 «усилителя» с новым номером версии в основном формате (см. п. 3 из 8.2)  

и в формате PDF (см. 8.4). 

При изменении позиционных обозначений компонентов или их данных 

скорректировать потребуется и перечень элементов ПЭ3 «усилителя». В этом 

случае его также необходимо сохранить с новым номером версии в основном 

формате и в формате PDF (см. пп. 2 и 11 из 9.2 соответственно). 

23. Как уже отмечалось ранее, в варианте «П1» изначально выбранные 

размеры ПП оказались избыточными, так как после размещения всех поса-

дочных мест компонентов осталось много свободного места (см. рис. 12.57), 

а по общему заданию на проектирование ПП должна получиться в мини-

мальных габаритах. 

Уплотнение выполнить в следующей последовательности: 

Рис. 12.58 
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23.1. Снять блокировку с КП, используемых для крепления ПП. 

Для этого в панели PCB Filter в поле Filter сформировать соответству-

ющий запрос, установить опции с рис. 12.59 и 

нажать кнопку Apply to All. После этого в па-

нели PCB Inspector в группе Graphical от-

ключить опцию Locked и в рабочем поле 

снять выделение. 

Примечание. Для быстрого ввода указан-

ного запроса в группе Select objects to highlight 

следует поставить галочку на пересечении 

строки Pad и столбца Comp, после чего в поле 

Filter добавить оператор отрицания Not. 

23.2. Снять блокировку с примитивов, которыми нарисован «экран». 

Для этого выполнить следующие действия: 

– сделать текущим слой M7 Shield; 

– в окне Preferences (команда DXP ⇒ Pleferences) в подразделе PCB Ed-

itor ⇒ General отключить опцию Protect Locked Objects; 

– в рабочем поле последовательным нажатием клавиш S ⇒ Y выделить 

все объекты на текущем слое (см. Г.5); 

– в панели PCB Inspector в группе Graphical отключить опцию Locked; 

– в рабочем поле снять выделение. 

Примечание. Снять блокировку также можно было с помощью запроса, 

сделанного в панели PCB Filter (см. Г.12). 

23.3. Сделать текущим слой Top Layer. 

23.4. В окне Preferences (команда DXP ⇒ Preferences) в подразделе PCB 

Editor ⇒ Board Insight Display отключить режим Hide Other Layers и 

включить режим Gray Scale Other Layers (см. п. 9 из Г.38). 

23.5. Перейти в режим одного слоя (Shift+S). 

23.6. Продумать стратегию дальнейших действий по уплотнению. 

В варианте «П1» первый возможный вариант заключается в том, чтобы 

подвинуть нижнюю границу ПП вплотную к посадочным местам компонен-

тов, уменьшив вертикальный размер с 50 до 34 мм (рис. 12.60). Однако он не 

является оптимальным, так как остается много свободного места под «экра-

ном» и по горизонтали ПП уже практически не уменьшить. 

Поэтому в варианте «П1» сначала будут произведены действия по 

уменьшению горизонтального размера, а затем вертикального. 

Рис. 12.59 
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Примечание. В других вариантах задания последовательность дальней-

ших действий может отличаться от приведенной, а сам процесс уплотне-

ния может быть итерационным с постепенным изменением габаритов ПП 

и положения посадочных мест компонентов в сформированных группах.  

23.7. Уплотнить посадочные места компонентов, находящихся во внут-

ренней полости «экрана». 

Следует обратить внимание на то, что по периметру топологии ПФ 

должно остаться небольшое пространство, достаточное для осуществления 

заземления с помощью переходных отверстий (минимум 0,9 мм). 

Результат в варианте «П1» показан на рис. 12.61. 

 

23.8. Перейти в сетку 0.5 мм. 

23.9. Изменить положение КП для крепления ПП и выходных КП. 

Следует обратить внимание на то, что изменение положения КП для 

крепления ПП, входных и выходных КП, изменение размеров ПП и коррек-

тировка примитивов «экрана» должны производиться только в сетке 0,5 мм. 

Результат в варианте «П1» показан на рис. 12.62. 

Рис. 12.61 

Рис. 12.60 
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23.10. Изменить положение границы ПП: 

– перейти в режим работы с формой ПП (клавиша 1); 

– запустить команду Design ⇒ Edit Board Shape и передвинуть требуе-

мую границу; 

– перейти в 2D-режим просмотра (клавиша 2). 

Результат в варианте «П1» показан на рис. 12.63. 

 

Примечание. Так как размеры были привязаны к границам ПП, то они 

скорректируются автоматически. 

23.11. Сделать текущим слой M7 Shield, после чего отредактировать 

контуры «экрана» и положение прорези в толстой стенке. 

Результат в варианте «П1» показан на рис. 12.64. 

Примечание. При перемещении любой стороны внешнего контура свя-

занные с ним стороны будут автоматически изменяться, тогда как контур 

внутренней полости со скруглениями придется корректировать вручную. 

Рис. 12.63 

Рис. 12.62 
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23.12. Сделать текущим слой Top Layer. 

23.13. Перейти в сетку 0.1 мм. 

23.14. Скорректировать положение посадочных мест компонентов из 

следующих функциональных групп: 

– «токовое зеркало»; 

– узел управления микросхемой аттенюатора; 

– параметрический стабилизатор напряжения (при наличии). 

Результат в варианте «П1» показан на рис. 12.65. На рисунке красным 

цветом условно обозначен путь, по которому планируется провести трассу 

цепи питания +5В на этапе трассировки ПП. 

 

Примечание. Остальные посадочные места компонентов могут быть 

временно перемещены за пределы контура ПП. 

23.15. Скорректировать положение остальных посадочных мест компо-

нентов, кроме ИПС (при наличии). 

Рис. 12.65 

+5В 

Рис. 12.64 
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При размещении должны быть 

выполнены требования п. 17.12. Кроме 

того, необходимо обратить внимание 

на то, что внешнее питание должно 

сначала пройти через КП посадочных 

мест входных блокировочных конден-

саторов микросхемы стабилизатора 

напряжения, и только после этого по-

пасть на ее вход. 

Результат в варианте «П1» пока-

зан на рис. 12.66. 

23.16. Если размеры посадочного 

места для горизонтального варианта 

установки диода 1N4007 (рис. 12.67, а), использованного в отдельных вари-

антах задания, являются определяющими в габаритах ПП, то можно осуще-

ствить его замену на вертикальный вариант установки (рис. 12.67, б). 

 

Для этого выполнить следующие действия: 

– открыть схему Э3 «усилителя», если она была закрыта (см. п. 3 из 8.3); 

– в окне свойств диода 1N4007 в группе Models в 

столбце Name выбрать посадочное место DO-

41_010V025 – корпус DO-41 с вертикальным вариан-

том установки, высотой над платой 1 мм и расстояни-

ем между выводами 2,5 мм (рис. 12.68); 

– сохранить изменения в схеме Э3 (Ctrl+S); 

– запустить команду Design ⇒ Update PCB Document; 

Рис. 12.67 

б а 

Рис. 12.66 

Рис. 12.68 
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– в появившемся окне Engineering Change Order убедиться в наличии 

требуемого изменения (рис. 12.69), после чего последовательно нажать кноп-

ки Execute Changes и Close. 

 

Примечания: 

– комментарии к окну Engineering Change Order даны в п. 6.3; 

– заменить посадочное место можно и в файле трассировки, выбрав 

его в свойствах компонента в поле Name группы Footprint, но для этого тре-

буется подключить библиотеку посадочных мест. 

23.17. Разместить посадочные места компонентов ИПС (при наличии). 

23.18. Перейти в сетку 0.5 мм. 

23.19. Изменить положение гра-

ницы ПП по п. 23.10. 

23.20. Изменить положение КП 

для крепления ПП. 

Результат в варианте «П1» пока-

зан на рис. 12.70. 

24. Добавить обозначение ПП на 

слой Top Layer: 

– перейти в сетку 0.1 мм; 

– последовательно нажать клави-

ши P ⇒ S или запустить команду Place ⇒ String (создание надписи); 

– нажать клавишу Tab для открытия окна свойств; 

– в поле Properties ввести обозначение ПП по табл. 2.1; 

– в группе Font выбрать опцию TrueType; 

– в списке Font Name выбрать GOST type B; 

– в поле Height ввести 2mm; 

– применить изменения в окне свойств и разместить надпись в любом 

свободном месте ПП за пределами внешнего контура «экрана». 

Примечания: 

– в варианте «П1» для отличия от других вариантов задания использо-

ван шрифт Times New Roman (рис. 12.71); 

Рис. 12.69 

Рис. 12.70 
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– высота заглавных букв при задан-

ных настройках составит около 1,2 мм 

(значение в поле Height из окна свойств 

совпадает со значением в рабочем поле 

только для шрифтов типа Stroke); 

– при недостатке места для разме-

щения надписи текст в поле Properties можно ввести в две строки (переход 

на новую строку осуществляется комбинацией клавиш Shift+Enter). 

25. Сохранить изменения (Ctrl+S). 

26. Проверить выполнение следующих требований: 

– компоненты должны располагаться функциональными группами в со-

ответствии со схемой Э3 (для этого необходимо внимательно просмотреть 

все размещенные компоненты с открытой схемой); 

– должна быть обеспечена возможность беспрепятственного проведения 

трасс только на слое Top Layer (для этого необходимо мысленно пройтись 

по путям прохождения трасс сигналов по аналогии с рис. 12.57); 

– размещение угловых разъемов (при наличии) должно быть таким, что-

бы можно было подключить ответные части (этому не должны мешать дру-

гие компоненты, «экран» и головки винтов, которыми будет крепиться ПП); 

– блокировочные конденсаторы по входам питания микросхем должны 

располагаться перед ними и как можно ближе к ним; 

– между корпусами компонентов должны быть оставлены зазоры (также 

необходимо проверить наличие зазоров между КП разных цепей); 

– ПП должна получиться в минимальных габаритах; 

– размещение КП № 1–6 должно соответствовать рис. 12.51, б. 

Если что-то из указанного не выполняется, то это необходимо испра-

вить, вплоть до выполнения компоновки и (или) ее уплотнения сначала (см. 

пп. 11, 17, 21–23). Промежуточные варианты в этом случае рекомендуется 

сохранять в виде отдельных файлов, что удобно делать в проводнике Win-

dows в папке проекта, копируя и переименовывая текущий файл трассировки. 

Корректировку в контурах ПП, примитивах «экрана» и в расположении 

КП для крепления ПП необходимо производить только в сетке 0,5 мм. 

Примечания:  

– ранее сохраненный файл трассировки можно добавить в проект ко-

мандой ПКМ ⇒ Add Existing to Project, выполненной на названии проекта в 

панели Projects, или просто перетянуть открытый документ в проект; 

Рис. 12.71 
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– для удаления ненужного файла из проекта на нем выполняется коман-

да ПКМ ⇒ Remove from Project; 

– не нужно бояться искать лучшие варианты размещения компонентов 

(в пределах разумного), так как продуманная компоновка значительно облег-

чает как этап трассировки ПП, так и работу с изготовленной ПП; 

– выбранный в п. 23.6 путь уплотнения в варианте «П1» привел к хоро-

шему результату: площадь ПП (см. рис. 12.70) удалось увеличить в 2 раза по 

сравнению с исходными размерами (см. рис. 12.57), и на четверть по сравне-

нию с вариантом, предложенным на рис. 12.60. 

27. Выполнить завершающие действия этапа компоновки ПП: 

27.1. Перейти в сетку 0.5 мм. 

27.2. Проверить размещение КП для крепления ПП: 

– их центры должны быть расположены в сетке 0,5 мм и по возможности 

на одних осевых линиях;  

– от края каждой КП до ближайших границ ПП и контуров «экрана» 

должно быть 0,5 мм. 

Примечание. Для проверки расположения КП на осевых линиях можно 

временно изменить вид курсора на Large 90 (см. п. 8.7) или воспользоваться 

режимом измерений (Ctrl+M) с включенными привязками (Shift+E). 

27.3. Заблокировать КП для крепления ПП. 

Для этого выполнить п. 23.1 с включением опции Locked. 

27.4. В окне Preferences (команда DXP ⇒ Preferences) в подразделе PCB 

Editor ⇒ General включить опцию Protect Locked Objects. 

27.5. Сделать текущим слой M7 Shield. 

27.6. Последовательным нажатием клавиш P ⇒ L с шириной линии 

0,2 мм обозначить прорезь в тонкой стенке «экрана» в месте прохождения 

будущих трасс и находящихся в ней компонентов (при наличии). 

 

Результат в варианте «П1» показан на рис. 12.72. На рисунке также обо-

значены пути, по которым на этапе трассировки ПП планируется провести 

трассы цепи питания +5В (красный цвет), цепей управления V1 и V2 (серый 

Рис. 12.72 

V1 V2 

+5В 
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цвет) и цепи, соединяющей транзисторную сборку с парой блокировочных 

конденсаторов (синий цвет). 

27.7. Выйти из режима одного слоя (Shift+S). 

27.8. Сделать текущим слой M3 Top Assy. 

27.9. Сохранить в отчет результат этапа компоновки ПП в 2D-режиме 

просмотра, для чего выполнить следующее: 

– применить профиль ИДРЭС-AltiumPCBGray.PCBSysColors из папки 

…ИДРЭС\Профили (см. п. 6 из 5.2.1); 

– в верхней части панели PCB выбрать режим работы с цепями (Nets) и 

отключить опцию Select; 

– в панели PCB в группе с классами цепей щелкнуть ЛКМ по классу 

<All Nets>, а затем выполнить на нем команду ПКМ ⇒ Connections ⇒ Show; 

– в панели PCB в группе с цепями слева от GND убрать галочку, а затем 

выполнить для этой цепи команду ПКМ ⇒ Connections ⇒ Hide; 

– в панели PCB на классе цепей <All Nets> выполнить команду ПКМ ⇒ 

Change Net Color;  

– в появившемся окне Choose Color 

(рис. 12.73, а) на вкладке Basic выбрать 

цвет № 3 (черный) и нажать кнопку OK; 

– развернуть окно Altium Designer на 

весь экран и выполнить команду View ⇒ 

Fit Document; 

– нажать клавишу L и в открывшемся 

окне View Configurations на вкладке 

Board Layers And Colors в группе System 

Colors убрать галочки в столбце Show для 

сеток Default Grid Color (рис. 12.73, б); 

– в окне View Configurations на 

вкладке View Options отключить опции 

Show Pad Nets и Show Pad Numbers (отображение на КП названий цепей и 

их номеров соответственно), после чего закрыть окно кнопкой OK; 

– отключить информационное поле комбинацией клавиш Shift+H; 

– клавишей Prt Sc с последующей обрезкой лишней информации или с 

помощью приложения Ножницы сохранить рисунок рабочего поля в отчет; 

– нажать клавишу L и в открывшемся окне View Configurations на 

вкладке Board Layers And Colors в группе System Colors включить опции 

Рис. 12.73 

а 

б 
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Show для сеток Default Grid Color, на вкладке View Options включить оп-

ции Show Pad Nets и Show Pad Numbers, а затем закрыть окно кнопкой OK; 

– в панели PCB в группе с классами цепей выбрать класс <All Nets>, по-

сле чего выполнить на нем команду ПКМ ⇒ Change Net Color; 

– в появившемся окне Choose Color на вкладке Basic выбрать цвет с но-

мером 230 (желтый) и нажать кнопку OK; 

– в панели PCB в группе с цепями слева от GND поставить галочку; 

– если требуется, то отключить видимость и задать цветовое оформле-

ние цепям, для которых это было сделано ранее (например, для цепей пита-

ния); 

– вернуть цветовые настройки, заданные в п. 6 из 5.2.1. 

Результат в варианте «П1» показан на рис. 12.74. 

 

Примечание. В варианте «П1» для отличия от других вариантов зада-

ния в панели PCB в режиме Pad & Via Templates с включенной опцией Select 

были выбраны прямоугольные КП со скруглениями, после чего в панели PCB 

Рис. 12.74 
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Inspector уменьшен их радиус до 1 % (параметр Pad Corner Radius (%) (All 

Layers) из группы Object Specific). 

27.10. Сохранить в отчет результат этапа компоновки ПП в 3D-режиме 

просмотра, для чего выполнить следующее: 

– перейти в 3D-режим просмотра (клавиша 3); 

– в верхней части панели PCB выбрать 

режим работы с 3D-моделями (3D Models) и 

отключить опцию Select; 

– в панели PCB в группе с классами ком-

понентов выбрать класс <All Components>; 

– в панели PCB в группе с компонентами 

отсортировать данные по столбцу Designator, 

выделить строки с КП № 1–6 и скрыть 3D-мо-

дели КП, выбрав из выпадающего списка под 

этой группой опцию Hide (рис. 12.75); 

– нажать клавишу L и в открывшемся 

окне View Configurations на вкладке Physical Materials в группе General за-

дать белый цвет рабочего поля, нажав на цветную ячейку напротив парамет-

ра Workspace Color; 

– в появившемся окне Choose Color на вкладке Basic выбрать цвет 

№ 233 (также можно выбрать белый шестиугольник на вкладке Standard) и 

нажать кнопку OK; 

– в окне View Configurations на вкладке Physical Materials в группе 

Colors and Visibility отключить отображение слоев шелкографии и защитной 

паяльной маски, после чего закрыть окно кнопкой OK; 

– повернуть 3D-модель в рабочем поле произвольным образом (см. Г.3), 

но при этом все посадочные места должны остаться видны; 

– клавишей Prt Sc с последующей обрезкой лишней информации или с 

помощью приложения Ножницы сохранить рисунок рабочего поля в отчет; 

– включить информационное поле (Shift+H); 

– нажать клавишу L и в открывшемся окне в списке Select PCB View 

Configuration выбрать профиль ИДРЭС-AltiumPCB3DConfig.config_3d (за-

гружен в п. 15 из 12.1), после чего закрыть окно кнопкой OK; 

– нажать клавишу 0 для возврата исходной ориентации 3D-модели; 

– перейти в 2D-режим просмотра (клавиша 2). 

Результат в варианте «П1» показан на рис. 12.76. 

Рис. 12.75 
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Примечания: 

– 3D-модели в КП № 1–6 используются для корректного определения их 

габаритов при автоматической проверке правил проектирования; 

– управление отображением начала координат осуществляется с по-

мощью опции Show Origin Marker в группе General окна View Configurations; 

– для управления отображением 3D-модели служат опции из группы 

Display Options в подразделе PCB Editor ⇒ Display окна Preferences (команда 

DXP ⇒ Preferences). Например, опция Draw Shadows in 3D включает или от-

ключает тень под 3D-моделью при виде на нее со стороны слоя Top Layer. 

28. Сохранить изменения (Ctrl+S). 

12.4. Особенности трассировки ПП 

Кроме технологических особенностей, связанных с изготовлением ПП и 

описанных в Б.9, следует выделить некоторые особенности выполнения трас-

сировки ПП [61]–[63]: 

1. Определение лучшего пути сигнала. Перед трассировкой ПП необхо-

димо продумать пути прохождения высокочастотных сигналов, что предпо-

лагает следующее: 

Рис. 12.76 
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– минимизацию длины высокочастотных трасс; 

– уменьшение взаимовлияния сигналов, кроме особых случаев; 

– разнесение входных и выходных трасс усилителей и фильтров. 

2. Тепловое рассеяние и распределение. В любых типах дизайна ПП 

необходимо помнить о равномерном (по возможности) тепловом распределе-

нии и стараться не располагать рядом тепловыделяющие компоненты во из-

бежание проблем, связанных с перегревом. 

3. Разделение трасс. Параллельные трассы высокочастотных сигналов не 

должны проходить близко друг к другу (исключая случаи, например, трасси-

ровки дифференциальных линий) и пересекаться на соседних слоях, так как 

между ними образуется емкостная и индуктивная связь. Зазор между про-

водниками должен быть минимум в три раза больше ширины проводников. 

Если же пересечение трасс происходит, то необходимо осуществлять его 

под прямым углом для минимизации связи между ними. В идеальном случае 

пересечение должно быть разделено слоем с земляным полигоном. 

Полигон земли, к сожалению, не всегда имеет нулевой потенциал во 

всех точках, так как он тоже обладает индуктивностью и емкостью, что мо-

жет быть причиной снижения качественных характеристик точных схем. Вы-

сокочастотные трассы на каждом слое должны быть в достаточной мере 

окружены земляными шинами, которые, в свою очередь, должны иметь хо-

рошее соединение с земляным полигоном (для этого увеличивают количе-

ство переходных отверстий). Краевые и угловые эффекты этих земляных 

шин и самих высокочастотных трасс должны быть минимизированы. 

4. Контроль импеданса. При трассировке для получения приемлемых ре-

зультатов необходимо следить за обеспечением требуемой ширины провод-

ников на внешних и внутренних слоях. 

Не рекомендуется использование прямых углов, так как в этих местах 

могут возникнуть отражения сигнала. В вершине угла ширина трассы увели-

чивается в 1,414 раза (нарушение однородности импеданса), что приводит к 

изменению характеристик линии передачи, 

особенно распределенной емкости и соб-

ственной индуктивности трассы. 

На рис. 12.77 показаны два шага улучше-

ния формы угла. Только последний пример 

поддерживает постоянной ширину трассы и 

минимизирует отражения.  

W 

1W min 

Плохой 

вариант 

Хороший 

вариант 

2W 

Лучший 

вариант 

Рис. 12.77 
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В МПП необходимо минимизировать количество межслойных перехо-

дов для каждого высокочастотного сигнала, так как переходные отверстия 

добавляют паразитную индуктивность к уже и без того имеющейся. Кроме 

того, они могут передавать высокочастотную энергию на противоположную 

сторону с возможными пагубными последствиями. 

Наилучшая аналоговая трассировка – все сигнальные проводники рас-

полагаются на одном слое ПП. 

5. Разделение выходных и входных трасс. Усилители могут начать рабо-

тать нестабильно или даже стать генераторами неконтролируемых колебаний 

при возникновении положительной обратной связи с выхода на вход. В 

большей мере это касается усилителей с большим коэффициентом усиления. 

Фильтры также могут ухудшать свои частотные характеристики при влиянии 

выходного сигнала на входные элементы. 

6. Подключение питания. При подключении трасс питания к выводам 

микросхем необходимо следить за выполнением следующих требований: 

– блокировочные конденсаторы должны располагаться как можно ближе 

к выводу питания микросхемы, при этом сначала питание должно попасть на 

конденсаторы и только после этого на микросхему; 

– при использовании нескольких блокировочных конденсаторов (напри-

мер, керамических и танталовых) высококачественные керамические конден-

саторы должны располагаться ближе к выводам питания микросхем; 

– выводы конденсаторов, подключенные к цепи GND, должны непо-

средственно и кратчайшим путем соединяться с земляным полигоном. 

7. Трассировка цепей питания. Если позволяют условия, то наилучшим 

вариантом является такой, в котором все потребители подсоединяются к ис-

точнику питания независимыми проводниками, имеющими только одну об-

щую точку около разъема питания (соединение «звездой»). 

Допустимую токовую нагрузку на элементы проводящего рисунка ПП в 

зависимости от допустимого превышения температуры проводника относи-

тельно температуры окружающей среды можно выбрать, основываясь на ре-

комендациях ГОСТ Р 53429–2009: 

– от 60 до 100 А/мм2 – для гальванической меди; 

– от 100 до 250 А/мм2 – для фольги (рекомендованные ширины для слу-

чая с превышением температуры на 200 ºС приведены в табл. 12.2). 

8. Аналоговые, цифровые и высокочастотные сигналы. Большое внима-

ние должно быть уделено разделению аналоговых, цифровых и высокоча-
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стотных сигналов. Особенно важно хорошо разнести цифровые сигналы от 

чувствительных высокочастотных компонентов и низкоуровневые аналого-

вые сигналы от высокочастотных сигналов любых уровней. Кроме того, важ-

но обеспечить разделение путей возвратных токов этих сигналов. О взаимо-

влиянии возвратных токов часто забывается, что приводит к серьезным пере-

крестным помехам. 

Таблица 12.2 

Рекомендованная ширина печатного проводника в зависимости 

от допустимого тока при повышении температуры на 20 ºС 

Допустимый ток, А 

Ширина печатного проводника, мм, при толщине  

печатного проводника, мкм 

18 35 70 

1 0,38 0,18 0,1 

2 0,91 0,46 0,23 

4 2,54 1,27 0,64 

6 4,06 2,03 1,02 

8 6,35 3,18 1,65 

10 9,14 4,57 2,29 

9. Заливка свободных областей. Области на всех слоях, свободные от 

компонентов и проводников, должны быть залиты полигоном из металлиза-

ции, подключенным через множество переходных отверстий к единому по-

лигону земляного слоя. Земляные полигоны, расположенные на нескольких 

слоях, должны соединяться переходными отверстиями по краям ПП, вокруг 

всех вырезов и крепежных (неметаллизированных) отверстий. Это благопри-

ятно влияет на увеличение эффективной площади полигона земли и приводит 

к уменьшению излучения и наводок. 

Необходимо внимательно следить за возможностью появления любых 

неподсоединенных областей металлизации или протяженных узких областей 

земляных полигонов. Их необходимо либо удалять, либо соединять дополни-

тельными переходными отверстиями с полигоном слоя земли. В противном 

случае они могут выступить в качестве антенн высокочастотного излучения. 

10. Разделение аналоговой и цифровой земли. В системах со смешанны-

ми сигналами рекомендуется физически отделять чувствительные аналого-

вые компоненты от шумных цифровых и использовать для них отдельные 

неперекрывающиеся земляные полигоны. Однако к разделению земель стоит 

относиться очень аккуратно, так как при их неудачной разводке можно полу-

чить петлевые или щелевые антенны, что может привести к значительному 

ухудшению результатов при сравнении с неразделенной землей. 
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Во многих случаях оптимально использование одной земли и с таким 

размещением компонентов, при котором пути протекания возвратных циф-

ровых токов не будут пересекаться с аналоговыми. Кроме того, разделенная 

земля может ухудшить температурный режим работы устройства. 

12.5. Трассировка ПП 

Этап трассировки ПП следует выполнить в приведенной ниже последо-

вательности: 

1. Освежить в памяти общую последовательность действий при трасси-

ровке ПП и примеры возможных ошибок (см. 12.2). 

2. Сохранить файл трассировки с новым номером версии в основном 

формате (см. п. 3 из 12.1) и сохранить изменения в проекте (см. п. 4 из 5.5). 

Примечания: 

– при каждом сохранении документа или проекта в папке History, рас-

полагающейся в папке проекта, автоматически создается архив с его копи-

ей, к которой можно быстро вернуться с помощью панели Storage Manager 

(см. Г.50). Кроме того, при трассировке ПП рекомендуется сохранять про-

межуточные результаты в виде отдельных файлов; 

– добавить файлы в проект (или удалить их) можно в соответствии с 

информацией, приведенной в примечаниях к п. 26 из 12.3. 

3. Перед началом процесса трассировки ПП выполнить подготовитель-

ные действия: 

3.1. Настроить привязки, для чего из меню Snap в нижнем правом углу 

рабочего поля выполнить команду Advanced Snap Options для открытия ок-

на Board Options. 

В группе Snap Options включить только опции Snap To Grids, Snap To 

Object Axis и Snap To Object Hotspots. 

В группе Advanced Options - Snap to Object Axis выполнить следую-

щие действия: 

– в поле Near Range ввести расстояние 10mm; 

– под опцией Near Objects включить только Pads и Regions; 

– отключить опцию Far Objects. 

Примечание. Соответствующие пояснения даны в п. 2 из Г.36. 

3.2. Задать правило проектирования, в котором указать для всех цепей 

возможные варианты подведения трассы к планарной КП: 

– запустить команду Design ⇒ Rules; 
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– в открывшемся окне PCB Rules and Constraints Editor на подразделе 

Design Rules ⇒ SMT ⇒ SMD Entry выполнить команду ПКМ ⇒ New Rule; 

– в указанном подразделе выбрать ЛКМ созданное правило SMDEntry; 

– в правой части окна отключить все опции (рис. 12.78); 

 

– в поле Name изменить имя правила на SMDE_ShortSide; 

– в нижней части окна нажать кнопку Apply. 

Примечания: 

– опция Any Angle позволяет подводить трассы под любым углом; 

– опция Corner позволяет подводить трассы через углы КП; 

– опция Side позволяет подводить трассы в длинную сторону КП. От-

ключенная опция начинает работать в том случае, если длинная сторона 

КП будет строго в два раза больше короткой; 

– после отключения всех опций подведение трасс возможно только в 

короткую сторону КП (с оговоркой для опции Side); 

– данное правило не будет проверяться в режиме реального времени и 

при формировании отчета об обнаруженных нарушениях, так как соответ-

ствующие галочки в п. 14 из 12.1 были сняты, но будет работать в процессе 

интерактивной трассировки. Созданные же трассы в этом случае можно 

отредактировать так, чтобы они подводились к КП как угодно. 

3.3. Задать правило проектирования, в котором указать для всех цепей 

автоматическое уменьшение ширины трассы в месте подключения к планар-

ной КП до минимального размера последней: 

– в окне PCB Rules and Constraints Editor в подразделе Design Rules ⇒ 

SMT ⇒ SMD Neck-Down создать новое правило (SMDNeckDown), после че-

го выбрать его ЛКМ; 

– в правой части окна для параметра Neck-Down указать значение 100% 

(рис. 12.79); 

– в поле Name изменить имя правила на SMDND_100%; 

– в нижней части окна последовательно нажать кнопки Apply и OK. 

Рис. 12.78 



 

 363 

 

Примечание. Данное правило также не будет проверяться в режиме 

реального времени и при формировании отчета об обнаруженных нарушени-

ях, но будет работать в процессе интерактивной трассировки. Особен-

ность использования правила см. в п. 4.3. 

3.4. Перейти в сетку 0.1 мм. 

3.5. Включить набор слоев Shield. 

3.6. Сделать текущим слой Top Layer. 

3.7. Включить режим одного слоя (Shift+S). 

Примечание. Желательно, чтобы данный режим был включен с опцией 

Gray Scale Other Layers, а не Hide Other Layers (см. п. 9 из Г.38). 

3.8. Рекомендуется ознакомиться с возможностями интерактивной трас-

сировки одиночных цепей по Г.42 и потренироваться в создании трасс между 

парой любых КП одной цепи. После тренировки созданные трассы и (или) 

переходные отверстия необходимо аккуратно удалить. 

Примечание. Выделение созданных трасс можно осуществить из меню 

Edit ⇒ Select командами Select Next, Physical Connection и Component Connec-

tions (см. п. 3.3 из Г.5). 

4. С помощью интерактивной трассировки одиночных цепей создать 

трассу для прохождения СВЧ-сигнала (цепи от MW-1 до MW-7 включитель-

но) со значением ширины, полученным по (4.4). 

Примечание. Если поиск объектов цепи затруднен, то можно использо-

вать возможности панели PCB. Для этого в верхней части выбираются 

режим работы с цепями (Nets) и опция Dim или Mask, а также включается 

опция Zoom. Затем осуществляется щелчок ЛКМ по названию требуемой 

цепи в предварительно выбранном классе цепей. 

Также можно воспользоваться режимом Cross Select Mode с соответ-

ствующими настройками (см. Г.35) или панелью Navigator (см. Г.13), но для 

этого нужна открытая вкладка со схемой. 

Примеры создания трасс в варианте «П1» и особенности интерактивной 

трассировки в других вариантах задания: 

Рис. 12.79 



 

 364 

4.1. Действия по созданию трассы для цепи MW-1 в варианте «П1»: 

– запущена команда интерактивной трассировки одиночных цепей 

(ПКМ ⇒ Interactive Routing); 

– щелчком ЛКМ в группе из трех входных КП указана центральная. 

Примечание. При отводе трассы от КП (или подводе к ней) необяза-

тельно указывать ее центр, чтобы сработала привязка курсора мышки. До-

статочно щелкнуть ЛКМ в любом месте внутри нее; 

– нажата комбинация клавиш Shift+W и в окне Choose Width выбрано 

значение ширины трассы (рис. 12.80); 

 

– включен режим Look Ahead Mode (клавиша 1); 

– комбинацией клавиш Shift+Space и клавишей Space выбран режим 

рисования под углом 45° у курсора мышки (см. рис. Г.56); 

– курсор мышки перемещен к месту около топологии ПФ, в которое 

планируется подвести трассу на следующем шаге (рис. 12.81, а), после чего 

осуществлен щелчок ЛКМ для размещения заштрихованного участка трассы, 

выходящего из КП; 

– отключен режим Look Ahead Mode (клавиша 1); 

– курсор мышки перемещен к середине левой стороны крайнего левого 

полигона в топологии ПФ и после срабатывания привязки (рис. 12.81, б) 

щелчком ЛКМ размещены наклонный и горизонтальный сегменты; 

– щелчком ПКМ осуществлен выход из команды. 

Примечания: 

– на рис. 12.81, б в информационном поле во второй строке снизу указа-

ны текущие настройки интерактивной трассировки: режим создания угла 

между двумя точками (Track 45), режим по разрешению конфликтов 

(HugNPush Obstacles), источник значения для ширины трассы (Width From: 

User Choice), шаблон переходного отверстия по умолчанию (Via[v90h40]) и 

степень сглаживания (Gloss: Weak); 

Рис. 12.80 
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– на рис. 12.81, б в информационном поле в нижней строке указана ин-

формация о текущей цепи: название (MW-1), общая длина трассы с учетом 

размещенных и неразмещенных сегментов (11.316mm), текущее значение 

ширины трассы (0.5mm) и длина неразмещенных и размещенных сегментов 

от момента запуска команды интерактивной трассировки (11.316mm), ко-

торая в данном случае равна общей длине трассы; 

– на рис. 12.81, б можно заметить, что включенные привязки позволя-

ют подвести трассу к точке, которая не находится в узле текущей сетки 

(по оси Y указаны сотые доли миллиметра); 

– если все объекты цепи соединены друг с другом трассами, то видимых 

связывающих линий у нее уже не будет (рис. 12.87, в). Исключением является 

случай, когда для цепи специально скрыто ее отображение (например, как 

для цепи GND в п. 7 из 12.3); 

– в варианте «П1» при трассировке все остальные режимы и опции 

здесь и далее при создании трасс каждой новой цепи, если не указано особо, 

соответствуют приведенным на рис. Г.123, Г.124, Г.126 и Г.131. 

4.2. Действия по созданию трассы для цепи MW-2 в варианте «П1»: 

– запущена команда интерактивной трассировки одиночных цепей; 

Рис. 12.81 

б 

а в 
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– курсор мышки подведен к середине правой стороны крайнего правого 

полигона в топологии ПФ, и после срабатывания привязки щелчком ЛКМ за-

пущен процесс создания трассы; 

– курсор мышки подведен к центру нижней КП разделительного кон-

денсатора и щелчком ЛКМ завершено создание трассы; 

– щелчком ПКМ осуществлен выход из команды; 

– зажатой ЛКМ отредактировано положение диагонального сегмента. 

Последовательность действий показана на рис. 12.82. 

 

Примечания: 

– в отдельных случаях при отведении от границы полигона трасса мо-

жет не подключиться к цепи, поэтому ее потребуется отвести из глубины 

полигона (привязка – выравнивание по характерным точкам полигона); 

– заданные ранее режимы интерактивной трассировки и значение ши-

рины трассы сохраняются и не требуют повторной настройки. 

4.3. Если в процессе интерактивной трассировки ширина трассы в месте 

подключения к планарной КП окажется больше ее минимального размера, то 

в соответствии с заданным в п. 3.3 правилом проектирования она будет авто-

матически уменьшена до этого размера. Само же изменение будет происхо-

дить прямо на границе КП (рис. 12.83, а). 

 

Примечание. Положение места автоматической смены ширины можно 

изменить правилом из подраздела Design Rules ⇒ SMT ⇒ SMD To Corner 

(определяет длину прямолинейного участка до первой вершины трассы). 

Рис. 12.83 

а б в 

Рис. 12.82 
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Если ширина трассы окажется значительной, то она все же может выйти 

за пределы КП (рис. 12.83, б). В этом случае после ее создания потребуется 

вручную скорректировать положение вершины (рис. 12.83, в). 

Автоматическая смена ширины трассы не будет происходить, если это 

сопровождается нарушением правил проектирования. На рис. 12.84, а пока-

зана такая ситуация в варианте «П1» для цепи MW-5 при подведении трассы 

шириной 0,5 мм от КП разделительного конденсатора к КП микросхемы ат-

тенюатора. При попытке же отвести такую трассу непосредственно от КП 

микросхемы у курсора мышки появляется символ нарушения правил проек-

тирования (рис. 12.84, б). 

 

В варианте «П1» при создании трассы для цепи MW-5 сначала были 

размещены сегменты с шириной 0,5 мм в непосредственной близости от КП 

микросхемы, затем вручную значение ширины уменьшено до 0,25 мм, и по-

сле этого трасса подведена к КП (рис. 12.84, в). 

4.4. В местах изменения ширины трассы следует создавать плавные пе-

реходы одним из двух способов: 

– автоматически с помощью команды Tools ⇒ Teardrops для предвари-

тельно выделенных двух соседних сегментов трассы (см. Г.44); 

– вручную с помощью полигона Solid Region (см. п. 2 из Г.26). 

Пример добавления полигона в варианте «П1» по второму способу око-

ло входной КП микросхемы аттенюатора показан на рис. 12.85. По аналогии 

Рис. 12.84 

а 

в б 
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был добавлен полигон и у выходной КП микросхемы, при этом в двух случа-

ях понадобилось временно изменить шаг сетки на 0,05 мм. 

 

Примечания: 

– полигоны в обоих способах автоматически подключаются к цепи объ-

ектов, на которых они создаются; 

– ручной способ по времени уступает автоматическому, но позволяет 

нарисовать и расположить полигон так, как задумал разработчик; 

– при ручном способе также может понадобиться временно отклю-

чить привязки к характерным точкам (комбинация клавиш Shift+E до исчез-

новения надписи Hotspot Snap в информационном поле). 

4.5. Не обязательно делать так, чтобы трасса 

соединилась с центром КП (по умолчанию доста-

точно только касания). Однако в этом случае можно 

пропустить такие места, как на рис. 12.86. 

Примечание. Настроить проверку подключе-

ния трасс к центрам КП позволяет правило из под-

раздела Design Rules ⇒ Electrical ⇒ Un-Routed Net. 

4.6. Если возникает необходимость переместить посадочное место, то 

при обычном перетаскивании зажатой ЛКМ подключенные к нему трассы 

останутся на своих местах, т. е. оторвутся от КП. 

Для перемещения посадочного места без отрывов трасс необходимо 

предварительно включить режим Drag для компонентов (команда Edit ⇒ 

Move ⇒ Component или последовательное нажатие клавиш M ⇒ C), после 

чего указать посадочное место и переместить его. 

Примечания: 

– режимом Drag для компонентов пользоваться не рекомендуется, так 

как после этого трассы оказываются проведены под произвольными углами 

и их сложно редактировать; 

Рис. 12.85 

Рис. 12.86 
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– основной прием работы – переместить посадочное место с отрывом 

трасс, после чего проложить их заново. Для автоматического удаления не-

нужных сегментов после повторного прокладывания трасс требуется 

включение опции Remove Net Antennas (см. п. 2.2 из Г.42); 

– в новых версиях Altium Designer функционал улучшен добавлением оп-

ции Component re-route, позволяющей автоматически прокладывать трассы 

заново до мест отрывов от КП. 

Результат создания трассы для прохождения СВЧ-сигнала в варианте 

«П1» показан на рис. 12.87. 

 

5. Добавить трассу, представляющую собой отрезок МПЛ с позицион-

ным обозначением W1 и проходящую от выходного вывода микросхемы уси-

лителя к двум блокировочным конденсаторам. 

Для этого выполнить следующее: 

5.1. Создать новую цепь: 

– запустить команду Design ⇒ Netlist ⇒ Edit Nets; 

– в появившемся окне Netlist Manager нажать кнопку Add; 

– в открывшемся окне Edit Net в поле Net Name за-

писать наименование цепи Net_W1 (рис. 12.88) и при-

менить изменения кнопкой OK; 

– закрыть окно Netlist Manager кнопкой Close. 

5.2. Задать правило проектирования, в котором ука-

зать минимальную и максимальную длину трассы для цепи Net_W1: 

– запустить команду Design ⇒ Rules и в открывшемся окне PCB Rules 

and Constraints Editor на подразделе Design Rules ⇒ High Speed ⇒ Length 

выполнить команду ПКМ ⇒ New Rule; 

Рис. 12.87 

Рис. 12.88 
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– в указанном подразделе выбрать ЛКМ созданное правило Length; 

– в правой части окна в группе Where The Object Matches (объекты, на 

которые распространяется правило) в единственном списке выбрать опцию 

Net, после чего в появившемся списке рядом – цепь Net_W1; 

– в группе Constraints в полях Minimum и Maximum указать допусти-

мый диапазон изменения длины отрезка МПЛ W1 со схемы Э3 «усилителя» с 

учетом допуска ±0,1 мм; 

– в поле Name изменить имя правила на L_Net_W1 (рис. 12.89); 

– в нижней части окна нажать кнопку Apply. 

 

Примечание. Рекомендуется проверить записанное на схеме значение 

длины отрезка МПЛ по результату расчета по (4.8) из отчета. 

5.3. Временно отключить правила проектирования, отвечающие за зазо-

ры в проводящем рисунке и наличие общих точек разных цепей. 

Для этого в окне PCB Rules and Constraints Editor щелкнуть ЛКМ по 

подразделу Design Rules ⇒ Electrical и в правой части окна в столбце Ena-

bled убрать галочки для правила C и ShortCircuit (рис. 12.90). 

Затем в нижней части окна последовательно нажать кнопки Apply и OK. 

 

5.4. Назначить цепи Net_W1 уникальный цвет, для чего в панели PCB 

выполнить следующие действия: 

– выбрать режим работы с цепями (Nets) и отключить опцию Select; 

– выбрать класс <All Nets>; 

Рис. 12.90 

Рис. 12.89 
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– в группе с цепями слева от Net_W1 поставить галочку; 

– на цепи Net_W1 выполнить команду ПКМ ⇒ Change Net Color; 

– в появившемся окне Choose Color на вкладке Basic выбрать цвет 

№ 224 (оливковый) и нажать кнопку OK; 

– в группе с цепями командой ПКМ ⇒ Col-

umns отключить отображение столбцов Node 

Count и Total Pin/Package Length, после чего 

расширить столбец Routed Length (рис. 12.91). 

Примечание. Назначение столбцов приведе-

но в описании панели PCB в п. 4.1.2 из Г.14. 

5.5. Перейти в сетку 0.1 мм. 

5.6. Убедиться в том, что включена привязка к характерным точкам на 

текущем слое (Hotspot Snap). 

Примечание. Привязка к характерным точкам циклически переключа-

ется комбинацией клавиш Shift+E (см. п. 2 из Г.36). 

5.7. Добавить в рабочее поле две планарные КП: 

– последовательно нажать клавиши P ⇒ P (см. Г.17); 

– нажать клавишу Tab для открытия окна свойств; 

– в группе Size and Shape в полях X-Size и Y-Size записать 0.5mm и в 

списке Shape выбрать форму Rectangular; 

– в группе Properties в списке Layer выбрать слой Top Layer, а в списке 

Net – цепь Net_W1; 

– закрыть окно свойств и добавить две КП в любое свободное место ра-

бочего поля недалеко от микросхемы усилителя. 

5.8. Первую КП переместить в любое место, которое расположено на оси 

любого сегмента трассы цепи MW-4 и не занято другими КП (рис. 12.92, а), а 

вторую КП – в середину пространства между КП двух блокировочных кон-

денсаторов (рис. 12.92, б). 

 Рис. 12.92 

а б 

Рис. 12.91 
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Примечание. Значения в столбцах Signal 

Length и Unrouted (Manhattan) на данном этапе 

для цепи Net_W1 равны (рис. 12.93) и показывают 

манхэттенское расстояние между двумя КП 

(сумма модулей разностей их координат). 

В варианте «П1» оно меньше номинального значения, которое равно 

11,7 мм. Это также видно по цветовой маркировке: желтый цвет означа-

ет, что текущая длина трассы меньше минимального значения из заданного 

правила проектирования; красный цвет показывает превышение максималь-

ного значения. Цветовая маркировка отображается в столбце Signal 

Length, если значение в нем может быть определено (цепь содержит только 

две КП), и в столбце Routed Length, если в столбце Signal Length значение не 

может быть определено (указано n/a). Кроме того, цвета будут отобра-

жаться в столбцах Min и Max, если их включить. 

Меньшее значение на данном этапе означает, что трассу далее можно 

провести либо с изломами (что и будет сделано), либо попытаться ее вы-

ровнять, но при этом отодвинув пару блокировочных конденсаторов. 

5.9. Соединить добавленные КП трассой: 

– желательно в панели PCB выделить строку с соседней цепью, чтобы 

видеть цветовую маркировку в столбце Signal Length; 

– запустить команду интерактивной трассировки одиночных цепей; 

– щелкнуть ЛКМ по КП, размещенной на цепи MW-4; 

– задать ширину трассы 0,5 мм (Shift+W) при ширине трасс СВЧ-тракта 

от 0,5 мм. В иных случаях задать значение, равное ширине трасс СВЧ-тракта;  

– нажать клавишу Tab и в открывшемся окне в списке Current Mode 

выбрать текущий режим разрешения конфликтов Ignore Obstacles; 

– отключить отображение индикатора длины комбинацией клавиш 

Shift+G (все необходимые данные отображаются в панели PCB); 

– провести трассу до второй КП у блокировочных конденсаторов; 

– завершить команду щелчком ПКМ; 

– при необходимости отредактировать трассу перемещением ее сегмен-

тов зажатой ЛКМ, контролируя длину по столбцу Routed Length. 

Последовательность действий в варианте «П1» показана на рис. 12.94. 

5.10. Удалить КП, подключенные к цепи Net_W1, следующим способом: 

– в панели PCB выбрать цепь Net_W1 (при этом в нижней области па-

нели отобразятся примитивы, подключенные к ней); 

Рис. 12.93 
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– в верхней части панели PCB включить опцию Select; 

– в нижней области панели с зажатой клавишей Ctrl выбрать две КП; 

– один раз щелкнуть ЛКМ в любом месте рабочего поля; 

– нажать клавишу Delete. 

Примечание. Выделить КП можно курсором мышки в рабочем поле, ко-

мандой Find Similar Object, запросом в панели PCB Filter и в панели PCB в 

режиме работы с КП и переходными отверстиями (Pad & Via Templates). 

5.11. Объединить созданные сегменты трассы для цепи Net_W1: 

– в панели PCB с включенной опцией Select выбрать цепь Net_W1; 

– один раз щелкнуть ЛКМ в любом месте рабочего поля; 

– объединить выделенные сегменты в группу с именем W1 (см. пп. 8.9 и 

8.10 из 12.3). 

Примечание. Объединение сегментов трассы в группу защитит их от 

дальнейших случайных корректировок. 

5.12. Изменить цепь для сегментов трассы группы W1: 

– в панели PCB выбрать группу W1; 

– открыть панель PCB Inspector и в группе Object Specific для парамет-

ра Net выбрать цепь MW-4; 

– в панели PCB отключить опцию Select; 

– в рабочем поле снять выделение с объектов щелчком ЛКМ, выполнен-

ным в любом свободном месте. 

Рис. 12.94 
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5.13. Удалить цепь Net_W1: 

– запустить команду Design ⇒ Netlist ⇒ Edit Nets; 

– в появившемся окне Netlist Manager в списке Nets In Board выбрать 

требуемую цепь и нажать кнопку Delete; 

– подтвердить операцию и закрыть окно Netlist Manager кнопкой Close. 

5.14. Командой Design ⇒ Rules открыть окно PCB Rules and Constraints 

Editor и включить отключенные в п. 5.3 правила проектирования, поставив 

соответствующие галочки в столбце Enabled, после чего применить измене-

ния последовательным нажатием кнопок Apply и OK. 

В результате включения правил проектирования в рабочем поле в месте 

расположения двух блокировочных конденсаторов появятся обозначения об-

наруженных нарушений (рис. 12.95): на объектах, вызвавших их, будет нане-

сена текстура в виде зеленых кругов с крестиками, а сами нарушения будут 

отмечены белыми окружностями с краткой информацией, которая станет 

видна при увеличении масштаба данной области. 

 

Подробности нарушений приводятся в информационном поле при наве-

дении курсора мышки на место их обнаружения. В данном случае их причи-

на – наличие общей точки у линии и КП со слоя Top Layer, которые принад-

лежат двум разным цепям (Short-Circuit). Следствием этого нарушения явля-

ются найденные ошибки по зазорам (Clearance).  

Примечания: 

– вид обозначения нарушений правил проектирования задается в окне 

Preferences (команда DXP ⇒ Preferences) в подразделе PCB Editor ⇒ DRC Vi-

olations Display; 

Рис. 12.95 
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– для просмотра нарушений можно воспользоваться специально пред-

назначенной для этого панелью PCB Rules And Violations со списком обна-

руженных нарушений во всем файле трассировки или командой ПКМ ⇒ Vio-

lations со списком обнаруженных нарушений под курсором мышки. В обоих 

случаях каждое нарушение можно просмотреть в окне Violation Details, в 

котором также можно пометить его как просмотренное с комментарием 

или перейти в соответствующее правило, вызвавшее его (см. п. 26.4). 

5.15. Задать правило проектирования, в котором указать возможность 

наличия общих точек у объектов цепи MW-4 и цепи, объединяющей сосед-

ние выводы пары блокировочных конденсаторов: 

– запомнить имя цепи, указанное в информационном поле при наведе-

нии курсора мышки на соответствующую КП блокировочного конденсатора 

в месте обнаружения нарушения (см. рис. 12.95);  

– запустить команду Design ⇒ Rules и в открывшемся окне PCB Rules 

and Constraints Editor на подразделе Design Rules ⇒ Electrical ⇒ Short-

Circuits выполнить команду ПКМ ⇒ New Rule. 

Примечание. Также можно выполнить команду ПКМ ⇒ Duplicate Rule 

на правиле, которое уже существует в этом подразделе; 

– в указанном подразделе выбрать ЛКМ правило ShortCircuit_1; 

– в правой части окна в группе Where The First Object Matches (первая 

группа объектов, на которую распространяется правило) в списках последо-

вательно выбрать Net и цепь MW-4; 

– в группе Where The Second Object Matches (вторая группа объектов, 

на которую распространяется правило) в списках последовательно выбрать 

Net и цепь блокировочных конденсаторов; 

– в группе Constraints включить опцию Allow Short Circuit; 

– в поле Name изменить имя правила на SC с указанием имен цепей 

(рис. 12.96, а); 

– в нижней части окна последовательно нажать кнопки Apply и OK; 

– убедиться в том, что в рабочем поле исчезли нарушения. 

Примечание. При наличии в одном подразделе нескольких правил каж-

дому из них присваивается приоритет (чем выше правило в списке, тем вы-

ше и его приоритет). Правило с более высоким приоритетом просматрива-

ется программой в первую очередь. Если проверяемые объекты попали под 

его условие, то правила с более низкими приоритетами для них будут про-

пущены. 
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Приоритеты правил можно менять в окне Edit Rule Priorities, открыва-

емом кнопкой Priorities из нижней части окна PCB Rules and Constraints Edi-

tor. Создаваемым вновь правилам автоматически присваивается высший 

приоритет (рис. 12.96, б). 

6. Сохранить изменения (Ctrl+S). 

7. Провести трассу от транзисторной сборки до двух блокировочных 

конденсаторов: 

– запустить команду интерактивной трассировки одиночных цепей; 

– щелкнуть ЛКМ по соответствующей КП транзисторной сборки; 

– выбрать ширину трассы 0,5 мм (Shift+W); 

– убедиться в том, что установлен режим разрешения конфликтов Ignore 

Obstacles (комбинация клавиш Shift+R); 

– довести трассу до характерной точки, которая располагается в вер-

шине сегмента трассы W1 между двумя блокировочными конденсаторами 

(рис. 12.97, а); 

Рис. 12.96 

а 

б 
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– завершить команду щелчком ПКМ; 

– запустить команду интерактивной трассировки одиночных цепей и со-

единить трассой центры соседних КП двух блокировочных конденсаторов 

(рис. 12.97, б). 

 

Примечание. Появляющиеся в процессе создания трасс обозначения 

нарушений, связанные с наличием общих точек у примитивов разных цепей, 

пропадут после выхода из команды интерактивной трассировки.  

8. Соединить трассами соответствующие КП компонентов в «токовом 

зеркале», при этом обратив внимание на следующее: 

– после запуска интерактивной трассировки оди-

ночных цепей комбинацией клавиш Shift+R выбрать 

любой удобный режим разрешения конфликтов, кро-

ме Ignore Obstacles (в варианте «П1» выбран HugN-

Push Obstacles); 

– оптимальная ширина трасс – 0,5 мм. 

Результат в варианте «П1» показан на рис. 12.98. 

9. Соединить трассами соответствующие КП микросхемы аттенюатора и 

близкорасположенных конденсаторов (при наличии), при этом комбинацией 

клавиш Shift+W выбрать их ширину равной ширине КП микросхемы атте-

нюатора (в варианте «П1» – 0,25 мм). 

Результат в варианте «П1» показан на рис. 12.99, а. 

Примечание. Трассы при подведении к КП могут оказаться выполнены с 

изломами, которые следует вручную скорректировать уже после выхода из 

команды интерактивной трассировки. Кроме того, отдельные трассы 

можно попытаться сгладить автоматически. Для этого выделяется сег-

мент трассы, затем нажимается клавиша Tab, а после этого – комбинация 

Рис. 12.97 

а б 

Рис. 12.98 
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клавиш Ctrl+Alt+G (команда Gloss Selected в п. 10 из Г.42). Результат рабо-

ты команды в варианте «П1» показан на рис. 12.99, б. 

 

10. Создать трассы цепей управления микросхемой аттенюатора, оста-

вив значение их ширины из предыдущего пункта. 

Результат в варианте «П1» показан на рис. 12.99, в. 

Примечание. Зачастую удобно пользоваться автоматическим заверше-

нием трассы (щелчок ЛКМ при зажатой клавише Ctrl) с последующей кор-

ректировкой получившейся трассы (при необходимости). 

11. Осуществить все необходимые соединения для прохождения пита-

ния от разъема питания до входа микросхемы стабилизатора напряжения, 

при этом обратив внимание на следующее: 

– соединения можно выполнить трассами шириной около 1 мм (или 

больше) и (или) полигонами Solid Region (см. п. 2 из Г.26); 

– полигоны необходимо рисовать поверх КП (они автоматически под-

ключаются к их цепям); 

Рис. 12.99 

а 

в б 
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– питание должно сначала пройти через КП посадочных мест блокиро-

вочных конденсаторов, и только после этого попасть на вход микросхемы 

стабилизатора напряжения; 

– обеспечить зазоры до объектов других цепей не менее 0,4 мм. 

В варианте «П1» соединения выполнены двумя полигонами, один из ко-

торых на рис. 12.100 выделен с подсвеченными КП (курсор мышки на КП с 

зажатой клавишей Shift). 

 

12. Осуществить все необходимые соединения для прохождения пита-

ния от выхода микросхемы стабилизатора напряжения до потребителей, а 

также соединения внутри ИПС и параметрического стабилизатора напряже-

ния (при их наличии). 

Обратить внимание на следующее: 

– соединения выполнить трассами шириной 0,5–1 мм; 

– если блокировочные конденсаторы не расположены в ряд, то их со-

единение с выходом микросхемы стабилизатора 

напряжения осуществить полигоном Solid Region 

(см. п. 2 из Г.26); 

– обеспечить зазоры до объектов других це-

пей не менее 0,4 мм. 

В варианте «П1» (рис. 12.101) сначала был 

добавлен полигон на выходе микросхемы стаби-

лизатора напряжения, а после этого созданы две 

отходящие от него трассы: одна – к резисторам 

Рис. 12.100 

Рис. 12.101 
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«токового зеркала» шириной 0,8 мм, а вторая – к блокировочному конденса-

тору около вывода питания микросхемы аттенюатора с шириной 1 и 0,8 мм. 

Примечание. Если при отведении от границы полигона трасса не под-

ключается к цепи, то ее необходимо либо отвести из глубины полигона, либо 

подвести со стороны КП компонентов. 

13. При необходимости изменить положение и размеры прорези в тон-

кой стенке «экрана», для чего выполнить следующее: 

– перейти в сетку 0.5 мм; 

– сделать текущим слой M7 Shield; 

– произвести коррекцию; 

– сделать текущим слой Top Layer; 

– перейти в сетку 0.1 мм. 

14. Убедиться в том, что в файле трасси-

ровки на данном этапе не осталось участков 

цепей, которые бы не были заменены трасса-

ми (кроме цепи GND). 

Для этого в панели PCB отсортировать 

все цепи из класса цепей <All Nets> по столб-

цу Unrouted (Manhattan). Если для каких-то 

цепей значение будет отлично от нуля, то с 

помощью опций из верхней части панели (см. 

Г.14) найти такие цепи в рабочем поле, вни-

мательно их просмотреть и создать недоста-

ющие сегменты трасс. 

Результат сортировки цепей в варианте 

«П1» показан на рис. 12.102. На рисунке для цепи GND указано, что в дан-

ный момент ее связывающие линии скрыты, а в рабочем поле нет ни одной 

трассы (в столбце Routed Length записан ноль). 

15. Сохранить изменения (Ctrl+S). 

Результат в варианте «П1» на данном этапе показан на рис. 12.103. 

16. Осуществить трассировку цепи GND: 

16.1. Внутри контура ПП расставить переходные отверстия, подключен-

ные к цепи GND, для чего выполнить следующие действия: 

– последовательно нажать клавиши P ⇒ V (см. Г.21); 

– клавишей Tab открыть окно свойств, в котором в списке Template вы-

брать шаблон v120h60, в списке Net – цепь GND и применить изменения; 

Рис. 12.102 



 

 381 

 

– добавить переходные отверстия около каждой планарной КП, подклю-

ченной к цепи GND. Если КП имеет большие размеры (например, средняя 

КП в посадочном месте микросхемы усилителя на рис. 12.103), то переход-

ных отверстий около нее должно быть несколько; 

– добавить переходные отверстия под стенками «экрана», вдоль тракта 

СВЧ и вокруг топологии ПФ с примерным шагом 1,5–2 мм. Внутри пунктир-

ного контура топологии переходных отверстий, кроме установленных ранее 

для ШТ, быть не должно; 

– добавить переходные отверстия в остальных не указанных выше сво-

бодных областях под «экраном» с примерным шагом 2–3 мм; 

– добавить переходные отверстия вне контура «экрана» с примерным 

шагом 4–8 мм. 

Необходимо обратить внимание на следующее: 

– при расстановке можно использовать сетку с шагом более 0,1 мм; 

– расстояние от края любого переходного отверстия до контура ПП 

должно быть не менее 0,5 мм; 

– если требуется вставить скопированную группу переходных отверстий 

вместе с подключением к цепи, то необходимо запустить команду Edit ⇒ 

Paste Special, в появившемся окне включить опцию Keep net name и нажать 

кнопку Paste (команда однократная); 

Рис. 12.103 
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– если были добавлены переходные отверстия без подключения к цепи, 

то сначала они выделяются через панель PCB Filter (нужный запрос форми-

руется в группе Select objects to highlight при установке галочки на пересече-

нии строки Via и столбца Free) или с помощью команды Find Similar Objects 

(см. Г.6), после чего подключаются в панели PCB Inspector. 

Результат в варианте «П1» на данном этапе показан на рис. 12.104. 

 

Примечание. Команда Edit ⇒ Paste Special также позволяет вставить 

скопированные из другого слоя объекты в текущий слой при включении опции 

Paste on current layer и вставить массив объектов, параметры которого 

настраиваются в следующем окне при нажатии кнопки Paste Array. 

16.2. Если в центре посадочного места микросхемы аттенюатора есть 

желтая КП (соединение с цепью GND), то прямо на нее 

последовательным нажатием клавиш P ⇒ V добавить не-

сколько переходных отверстий v90h40 с цепью GND. 

Результат в варианте «П1» показан на рис. 12.105. 

Примечание. Если КП имеет небольшие размеры, 

то можно разместить одно переходное отверстие 

v90h40 или v120h60. 

16.3. Включить видимость связывающих линий це-

пи GND и убрать отображение их желтым цветом. 

Рис. 12.104 

Рис. 12.105 
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Для этого в панели PCB в режиме работы с цепями (Nets) выбрать класс 

цепей Power, после чего в группе с цепями слева от GND убрать галочку и на 

этой же строке выполнить ПКМ ⇒ Connections ⇒ Show. 

Примечание. Включить отображение связывающих линий всех цепей 

можно командой View ⇒ Connections ⇒ Show All. 

16.4. Перейти в сетку 0.5 мм. 

16.5. Добавить на слой Top Layer полигон Polygon Pour (см. п. 3 из Г.26), 

подключенный к цепи GND: 

– последовательно нажать клавиши P ⇒ G; 

– в появившемся окне свойств на вкладке Graphical в списке Connect to 

Net выбрать цепь GND, а в поле Name записать имя полигона TopGND; 

– остальные настройки оставить по умолчанию (см. рис. Г.72) и приме-

нить изменения; 

– в рабочем поле нарисовать контур полигона, последовательно указав 

все вершины контура ПП; 

– завершить команду щелчком ПКМ. 

Результат в варианте «П1» на данном этапе показан на рис. 12.106. 

 

Примечание. Автоматически созданные зазоры от полигона до объек-

тов других цепей определяются правилом проектирования C, а зазоры до 

контура ПП – правилом проектирования BOC (см. табл. Г.7). 

Рис. 12.106 
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16.6. Добавить на слой Bottom Layer полигон Polygon Pour, подключен-

ный к цепи GND. 

Это можно сделать по аналогии с полигоном на слое Top Layer, но для 

этого полигона рекомендуется воспользоваться альтернативным способом: 

– запустить команду Tools ⇒ Polygon Pours ⇒ Polygon Manager; 

– в открывшемся окне Polygon Pour Manager в группе View/Edit выбрать 

строку с полигоном TopGND, после чего нажать кнопку Create New Polygon 

from с опцией Selected Polygon; 

– в появившемся окне Polygon Pour в поле Name записать имя полигона 

BottomGND, в списке Layer выбрать слой Bottom Layer и убедиться в том, 

что в списке Connect to Net выбрана цепь GND. Остальные настройки оста-

вить по умолчанию (см. рис. Г.72) и применить изменения; 

– в окне Polygon Pour Manager нажать кнопку Apply и в открывшемся 

окне подтвердить изменения; 

– убедиться в успешности создания полигона, выбрав его в группе Pour 

Order (рис. 12.107), и закрыть окно Polygon Pour Manager кнопкой OK. 

 

Примечание. Назначение элементов окна Polygon Pour Manager приве-

дено в п. 3.5 из Г.26. 

16.7. Увеличить зазоры от заполнений полигонов TopGND и Bot-

tomGND (цепь GND) до объектов других цепей с 0,2 до 0,5 мм, для чего со-

здать новое правило: 

– запустить команду Design ⇒ Rules и в открывшемся окне PCB Rules 

and Constraints Editor на подразделе Design Rules ⇒ Electrical ⇒ Clearance 

выполнить команду ПКМ ⇒ New Rule; 

Рис. 12.107 
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– в указанном подразделе выбрать ЛКМ правило Clearance; 

– в правой части окна в группе Where The First Object Matches в един-

ственном списке выбрать опцию Custom Query, после чего нажать появив-

шуюся кнопку Query Builder; 

– в появившемся окне построить запрос, в котором описать два создан-

ных полигона Polygon Pour (рис. 12.108), после чего нажать кнопку OK. 

 

Примечания: 

– для построения указанного запроса сначала в столбце Condition Type / 

Operator выбирается опция Belongs to Polygon (объект принадлежит поли-

гону), после чего в столбце Condition Value – имя полигона. Для добавления 

нового условия нажимается ссылка Remove another condition. После указания 

двух полигонов в первом столбце выбирается оператор OR; 

– также можно было построить запрос, показанный на рис. 12.109. В 

этом случае правило будет распространяться на любые полигоны Polygon 

Pour, подключенные к цепи GND; 

 

– в группе Constraints в поле Minimum Clearance записать 0.5mm; 

– в поле Name изменить имя правила на C_PolyGND_0.5mm; 

– в нижней части окна нажать кнопку Apply; 

– убедиться в том, что у созданного правила 

установлен более высокий приоритет, чем у прави-

ла С (рис. 12.110), т. е. оно находится в списке пра-

вил данного подраздела выше; 

– в нижней части окна нажать кнопку OK. 

Рис. 12.109 

Рис. 12.108 

Рис. 12.110 
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В результате в рабочем поле практически на всех объектах ПП появится 

текстура, обозначающая обнаруженные нарушения, которые связаны с тем, 

что полигоны не были автоматически перестроены. Полигоны будут обнов-

лены далее. 

Примечание. Информация о приоритетах правил приведена в п. 5.15. 

16.8. Для обеспечения волнового сопротивления 50 Ом полосковых эле-

ментов в СВЧ-тракте необходимо обеспечить между краем трассы и бли-

жайшей металлизацией зазор величиной в 2–3 раза большей базовой толщи-

ны диэлектрика (параметр h). 

Для этого выполнить следующие действия: 

– запустить команду Design ⇒ Classes; 

– в появившемся окне Object Class Explorer на подразделе Object Clas-

ses ⇒ Net Classes выполнить команду ПКМ ⇒ Add Class; 

– созданному классу задать имя MWPath. 

Примечание. Изменить имя классу цепей также можно клавишей F2 

или командой ПКМ ⇒ Rename Class; 

– выбрать созданный класс цепей и в правой части окна Object Class Ex-

plorer в поле под заголовком Non-Members (объекты вне класса) записать 

маску MW, в результате чего в списке окажутся только цепи СВЧ-тракта; 

– в любом месте области с цепями, которые не входят в данный класс, 

выполнить команду ПКМ ⇒ Add All, в результате чего они окажутся в спис-

ке Members (объекты в классе); 

– применить изменения в окне Object Class Explorer (рис. 12.111). 

 

Примечания: 

– перемещать объекты также можно с помощью пиктограмм, распо-

ложенных между списками Non-Members и Members; 

– класс цепей MW_Path необходим, чтобы в дальнейшем при создании 

правила не перечислять каждую входящую в него цепь по отдельности; 

Рис. 12.111 



 

 387 

– запустить команду Design ⇒ Rules и в открывшемся окне PCB Rules 

and Constraints Editor на подразделе Design Rules ⇒ Electrical ⇒ Clearance 

выполнить команду ПКМ ⇒ New Rule; 

– в указанном подразделе выбрать ЛКМ правило Clearance; 

– в правой части окна в группе Where The First Object Matches в един-

ственном списке выбрать опцию Custom Query, после чего нажать появив-

шуюся кнопку Query Builder; 

– в появившемся окне построить запрос, в котором описать линии, 

скругления и полигоны Solid Region, принадлежащие любым цепям из класса 

цепей MWPath (рис. 12.112, а), после чего нажать кнопку OK; 

 

– в группе Where The First Object Matches для автоматического со-

зданного запроса скорректировать положение скобок (рис. 12.112, б); 

– в группе Where The Second Object Matches после выбора опции Cus-

tom Query создать (или скопировать) запрос с рис. 12.108 или 12.109; 

– определить величину зазора, указанного в начале данного пункта, по-

сле чего записать ее в группе Constraints в поле Minimum Clearance. 

Примечание. В варианте «П1» зазор составил 1,2 мм; 

– в поле Name изменить имя правила на C_MWPath-PolyGND с указа-

нием величины зазора; 

– применить изменения кнопкой Apply; 

– убедиться в том, что у созданного пра-

вила установлен более высокий приоритет, 

чем у двух других правил (рис. 12.113); 

– в нижней части окна нажать кнопку OK. 

Рис. 12.112 

а 

б 

Рис. 12.113 
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16.9. Перестроить полигоны Polygon Pour с нарушениями правил проек-

тирования, для чего запустить команду Tools ⇒ Polygon Pours ⇒ Repour Vi-

olating Polygons. 

 Рис. 12.114 

а 

б 
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Результат в варианте «П1» на данном этапе для слоя Bottom Layer пока-

зан на рис. 12.114, а, а для слоя Top Layer – на рис. 12.114, б. 

Примечание. Переход на слой Bottom Layer осуществлен сменой набора 

слоев на Bottom. 

16.10. Убедиться в том, что включен набор слоев Shield и сделан теку-

щим слой Top Layer. 

16.11. Убедиться в том, что в файле трас-

сировки на данном этапе не осталось участков 

цепи GND, которые не соединены друг с дру-

гом металлизацией. 

Для этого в панели PCB посмотреть зна-

чение в столбце Unrouted (Manhattan) для 

данной цепи (рис. 12.115, а). 

Если указанное значение отлично от ну-

ля, то выполнить следующие действия: 

– перейти в сетку 0.1 мм; 

– найти связывающие линии, для чего в 

панели PCB Filter в поле Filter написать за-

прос IsConnection, установить опции как на 

рис. 12.115, б и нажать кнопку Apply to All; 

– соединить требуемые КП с ближайши-

ми полигонами, подключенными к цепи GND, 

с помощью трасс. Также для соединения мож-

но использовать полигоны Solid Region с 

уменьшением сетки и временным отключени-

ем привязки к характерным точкам (комбинация клавиш Shift+E до исчезно-

вения надписи Hotspot Snap в информационном поле); 

– повторить действия по поиску связывающих линий и соединению об-

наруженных мест до получения нуля в столбце Unrouted (Manhattan) в па-

нели PCB (рис. 12.115, а); 

– снять фильтрацию комбинацией клавиш Shift+C или кнопкой Clear из 

нижнего правого угла рабочего поля (см. рис. 5.9) или из панели PCB Filter. 

16.12. Перейти в сетку 0.1 мм. 

16.13. Отредактировать положение переходных отверстий так, чтобы 

они полностью находились внутри областей заполнения полигона TopGND 

(неудачно расположенные переходные отверстия в варианте «П1» показаны 

Рис. 12.115 

а 

б 
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на рис. 12.114, б желтыми стрелками). Также можно удалить лишние пере-

ходные отверстия или добавить новые, подключенные к цепи GND. 

Чтобы при корректировке не выделялись другие объекты со слоя Top 

Layer и были видны планарные КП, необходимо выполнить следующие под-

готовительные действия: 

– в панели PCB Filter сформировать запрос, установив в группе Select 

objects to highlight галочки на пересечении строк Via и Pad со столбцом Net, 

включить опции как на рис. 12.116, а и нажать кнопку Apply to All; 

– отключить режим одного слоя (Shift+S); 

– сделать текущим слой M7 Shield. 

Фрагмент рабочего поля в варианте «П1» с примененной фильтрацией 

до корректировок показан на рис. 12.116, б. 

 

16.14. Выполнить следующие действия: 

– снять фильтрацию (Shift+C); 

– сделать текущим слой Top Layer; 

– включить режим одного слоя (Shift+S). 

16.15. Заблокировать полигон TopGND. 

Для этого запустить команду Tools ⇒ Polygon Pours ⇒ Polygon Manag-

er и в открывшемся окне в группе View/Edit поставить галочку в столбце 

Locked. Затем нажать кнопку Apply, в открывшемся окне подтвердить изме-

нения, после чего закрыть окно кнопкой OK. 

Примечание. Заблокированный полигон не будет попадать под выделе-

ние. Также это можно сделать в его свойствах или в панели PCB Inspector. 

16.16. Отредактировать заполнение полигона TopGND, удалив все его 

протяженные участки и большие неровности. 

Рис. 12.116 

а б 
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Необходимо обратить внимание на следующее: 

– создавать вырезы удобно командой Place ⇒ Polygon Pour Cutout. Для 

завершения текущего выреза нажимается ПКМ, но это не приводит к выходу 

из команды, т. е. можно продолжать работу без повторного его запуска; 

– можно корректировать контуры вырезов из состава посадочного места 

компонента. Для этого предварительно у выделенного компонента в панели 

PCB Inspector или в его свойствах отключается опция Lock Primitives; 

– в отдельных случаях можно использовать сетку менее 0,1 мм; 

– можно временно отключать привязку к характерным точкам (комби-

нация клавиш Shift+E до исчезновения надписи Hotspot Snap в информаци-

онном поле); 

– для просмотра только одного полигона полезно в панели PCB Filter 

создать запрос InPoly (в группе Select objects to highlight можно поставить 

галочку на пересечении строки Polygon и столбца Free) и включить опции 

как на рис. 12.116, а. Для просмотра нажимается кнопка Apply to All, а для 

снятия выделения – кнопка Clear (или комбинация клавиш Shift+C); 

– примеры редактирования в варианте «П1» показаны на рис. 12.117. 

 

16.17. При необходимости отредактировать места подключения полиго-

на TopGND к переходным отверстиям и КП с помощью трасс. 

Пример корректировки в варианте «П1» показан на рис. 12.118. 

Рис. 12.117 
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17. Сохранить изменения (Ctrl+S). 

Результат в варианте «П1» на данном этапе показан на рис. 12.119. 

 

18. Удалить защитную паяльную маску под «экраном» для обеспечения 

контакта с ним и исключения влияния ее на параметры СВЧ-тракта: 

– перейти в сетку 0.5 мм; 

– включить набор слоев TopSolder; 

– для отображения границ «экрана» на 

вкладках со слоями выполнить команду ПКМ ⇒ 

Show Layers ⇒ M7 Shield; 

– с помощью полигона Solid Region (см. п. 2 

из Г.26) нарисовать область по контуру «экрана», 

после чего расширить ее на 0,5 мм в направлении 

ПП (рис. 12.120). 

Рис. 12.119 

Рис. 12.118 

Рис. 12.120 
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Результат в варианте «П1» показан на рис. 12.121. 

Примечания: 

– изображения КП и переходных отверстий в слое Top Solder больше их 

габаритов со слоя Top Layer со всех сторон на величину, которая определена 

в правиле SME (см. табл. Г.7); 

– при необходимости закрытия переходных отверстий защитной па-

яльной маской в их свойствах используются опции из раздела Solder Mask 

Expansions, которые аналогичны КП (см. п. 6 из Г.17). 

19. Задать вскрытие защитной паяльной маски по контуру ПП со значе-

нием 0,25 мм, для чего выполнить следующее: 

– перейти в сетку 0.25 мм; 

– с помощью полигонов Fill (см. п. 1 из Г.26) нарисовать три узкие пря-

моугольные области шириной в один шаг сетки по контуру ПП в тех местах, 

которые в данный момент отображаются черным цветом. 

Размещенные полигоны в варианте «П1» показаны на рис. 12.122 и от-

мечены стрелками. 

Примечания: 

– полигоны могут накладываться на другие объекты этого слоя; 

– места вскрытия маски по контуру ПП, как и отступы металла от 

него, требуются при фрезеровке. 

Рис. 12.121 
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20. Добавить таблицу со списком отверстий проекта, для чего выполнить 

следующие действия: 

– включить набор слоев All; 

– отключить режим одного слоя (Shift+S); 

– запустить команду Place ⇒ Drill Table и ЛКМ указать положение таб-

лицы в любом свободном месте рабочего поля за пределами контура ПП; 

– открыть окно свойств таблицы (команда ПКМ ⇒ Properties); 

– в открывшемся окне Drill Table в таблице оставить только столбцы 

Symbol (условное обозначение отверстия), Count (количество), Hole Size 

(диаметр отверстия), Plated (наличие металлизации в отверстии), Hole Type 

(форма отверстия), Via/Pad (отношение отверстия к переходному отверстию 

или КП), Pad Shape (форма металлизации на сигнальных слоях), Template 

(наименование шаблона). Остальные столбцы удалить по отдельности: сна-

чала щелкнуть ЛКМ в любой ячейке удаляемого столбца, после чего нажать 

кнопку Remove Column; 

– зажать ЛКМ на заголовке столбца Hole Size и переместить его на гра-

ницу между столбцами Symbol и Count; 

– сделать сортировку данных в порядке увеличения диаметра отверстия, 

для чего осуществить необходимое количество щелчков ЛКМ по заголовку 

столбца Hole Size; 

– в группе Font Kind выбрать тип шрифта TrueType; 

Рис. 12.122 
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– в группе Units отключить опцию Add secondary units (данные будут 

представлены только в одной системе измерения) и в списке Precision напро-

тив опции Metric выбрать точность отображения данных – 1; 

– нажать кнопку Configure Drill Symbols, после чего в открывшемся 

окне Drill Symbols нажать кнопку Grouping и в выпадающем списке выбрать 

опцию Template (присвоение условных обозначений с учетом разных назва-

ний шаблонов). Также в группе Draw Symbols включить опцию Show Drill 

Symbols (отображать условные обозначения отверстий на слое Drill Drawing 

в рабочем поле), после чего применить изменения кнопкой OK;  

– применить изменения в окне Drill Table кнопкой OK; 

– при необходимости скорректировать положение таблицы и ее размеры. 

Результат в варианте «П1» показан на рис. 12.123 (рисунок сделан в ре-

жиме одного слоя, так как красные буквы на сером фоне плохо различимы). 

 

Примечания: 

– таблица создается на слое Drill Drawing, а данные в ней обновляются 

автоматически без запуска каких-либо дополнительных команд; 

– в окне Drill Table кнопкой Change header можно изменять названия за-

головков столбцов. Кнопка Add Column служит для добавления столбцов; 

– в столбце Plated металлизированные отверстия обозначаются PTH, а 

неметаллизированные – NPTH; 

– в панели PCB Inspector можно поменять положение таблицы, указав 

координаты ее нижнего или верхнего левого угла (зависит от значения в 

списке Alignment в окне Drill Table), и ее размеры, изменив высоту шрифта; 

– окно Drill Symbols также можно открыть командой ПКМ ⇒ Config-

ure Drill Symbols, выполненной на вкладках со слоями. 

Рис. 12.123 
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21. Добавить таблицу со структурой ПП, для чего выполнить следующие 

действия: 

– запустить команду Place ⇒ Layer Stack Table; 

– нажать клавишу Tab для открытия окна свойств таблицы; 

– в открывшемся окне Layer Stack Table в группе Options в списке Layer 

выбрать слой M3 Top Assy; 

– в группе Units выбрать опцию Metric; 

– в группе Board Map Options отключить опцию Draw Board Map; 

– в группе Font Kind выбрать тип шрифта TrueType; 

– применить изменения кнопкой OK и ЛКМ указать положение таблицы 

в любом свободном месте рабочего поля за пределами контура ПП. 

Результат в варианте «П1» показан на рис. 12.124. 

 

Примечания: 

– данные в таблице обновляются автоматически в соответствии с ин-

формацией из окна Layer Stack Manager (см. п. 5 из 12.1); 

– название последнего столбца на рис. 12.124 соответствует названию 

стека из окна Layer Stack Manager (кнопка Advanced). Количество подобных 

столбцов определяется количеством стеков в файле трассировки. 

Наличие штриховки для слоя в столбце стека означает, что он входит 

в его состав. Расположение стеков обозначается соответствующей им 

штриховкой на эскизе ПП, который автоматически формируется под таб-

лицей при включении опции Draw Board Map в окне ее свойств (опцией Scale 

можно настроить масштаб эскиза). 

Так как в вариантах задания используется только один стек, то необ-

ходимости в добавлении эскиза ПП нет. 

22. Скорректировать шелкографию: 

22.1. Удалить шелкографию под «экраном» (в этой области также отсут-

ствует защитная паяльная маска). 

Рис. 12.124 
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Для этого выполнить следующие действия: 

– включить набор слоев Shield; 

– убедиться в том, что включена привязка к характерным точкам на те-

кущем слое (Hotspot Snap) и отключен режим одного слоя (Shift+S); 

– последовательно нажать клавиши S ⇒ U (или запустить команду 

Edit ⇒ Select ⇒ Touching Rectangle) и в 

рабочем поле по двум точкам нарисовать 

прямоугольный контур, совпадающий с 

внешним контуром «экрана». 

В результате выделенными окажутся 

все объекты из видимых слоев, полностью 

и частично попавших в контур «экрана» 

(рис. 12.125). 

В вариантах задания с угловым «экра-

ном» выделить объекты за два раза, мыс-

ленно разбив «экран» на прямоугольники, при этом непосредственно перед 

указанием второй точки второго прямоугольного контура необходимо зажать 

клавишу Shift; 

– запустить команду Design ⇒ Classes; 

– в появившемся окне Object Class Explorer на подразделе Object Clas-

ses ⇒ Component Classes выполнить команду ПКМ ⇒ Add Class и присво-

ить созданному классу имя CompShield; 

– выбрать созданный класс компонентов и в правой части окна Object 

Class Explorer между двумя столбцами нажать единственную активную пик-

тограмму для добавления в класс выделенных в рабочем поле компонентов; 

– применить изменения в окне Object Class Explorer; 

– включить набор слоев All; 

– в панели PCB перейти в режим работы с компонентами (Components), 

включить опцию Select и выбрать класс CompShield, в результате чего в ра-

бочем поле выделятся только компоненты из указанного класса; 

– в панели PCB Inspector в группе Graphical для опции Lock Primitives 

выставить значение False (может потребоваться несколько щелчков ЛКМ); 

– в панели PCB Filter создать запрос для выбора линий и дуг со слоя 

Top Overlay из состава посадочных мест компонентов класса CompShield. 

Для этого в группе Select objects to highlight поставить галочки на пере-

сечении строк Track и Arc со столбцом Comp, в группе Layer поставить га-

Рис. 12.125 
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лочку для слоя Top Overlay и в поле Filter в 

конце дописать выражение And InCompo-

nentClass('CompShield'); 

– включить опции как на рис. 12.126 и 

нажать кнопку Apply to All. 

Примечание. Показанный на рисунке за-

прос отличается от сформированного авто-

матически тем, что из него удалено два усло-

вия. Тем не менее по своему действию он 

идентичен исходному; 

– убедиться в том, что выделены нужные 

объекты, и нажать клавишу Delete; 

– в панели PCB с включенной опцией Select выбрать класс CompShield; 

– в панели PCB Inspector в группе Graphical для опции Show Name вы-

ставить значение False, а для опции Lock Primitives – значение True (может 

потребоваться несколько щелчков ЛКМ); 

– снять выделение с объектов в рабочем поле щелчком ЛКМ в любом 

пустом месте или нажатием комбинации клавиш Shift+C. 

22.2. Выполнить подготовительные действия для корректировки поло-

жения позиционных обозначений: 

– перейти в 3D-режим просмотра (клавиша 3); 

– перейти в сетку 0.1 мм; 

– включить набор слоев TopOverlay; 

– открыть окно View Configurations 

(клавиша L) и в группе General в списке Pro-

jection выбрать опцию Orthographic, после 

чего применить изменения кнопкой OK; 

– в панели PCB Filter создать запрос для 

выбора переходных отверстий и надписей со 

слоя Top Overlay из состава посадочных мест. 

Для этого в группе Select objects to high-

light поставить галочки на пересечении стро-

ки Text со столбцом Comp и на пересечении 

строки Via со столбцом Net, в группе Layer поставить галочку для слоя Top 

Overlay и в поле Filter скорректировать скобки; 

– включить опции как на рис. 12.127 и нажать кнопку Apply to All. 

Рис. 12.126 

Рис. 12.127 
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22.3. Скорректировать положения позиционных обозначений так, чтобы 

они располагались следующим образом: 

– за пределами 3D-моделей компонентов; 

– целиком на защитной паяльной маске с минимальным зазором до мест 

ее отсутствия в 0,15 мм (можно ориентироваться по ширине линий в надпи-

си, которая тоже составляет 0,15 мм); 

– с минимальным зазором до края ПП в 0,5 мм (можно ориентироваться 

по отступу полигона TopGND от края ПП). 

Некоторые особенности корректировки: 

– при перемещении позионного обозначения подсвечивается тот компо-

нент, к которому оно принадлежит (рис. 12.128); 

 

– желательно ориентировать позиционное обозначение так же, как и 

корпус компонента (например, C1 и C6 на рис. 12.129). 

Примечание. Поворот позиционных обозначений (клавиша Space или 

комбинация клавиш Shift+Space) рекомендуется делать на угол 0° для гори-

зонтальной ориентации и на угол 90° для вертикальной ориентации. Сов-

местное использование с углами поворота 180° и 270° нежелательно; 

 

– если для позиционного обозначения не хватает места, то его можно 

разместить на расстоянии от компонента, сопроводив поясняющей графикой 

(например, линия у DA1 на рис. 12.129). Графика создается в 2D-режиме про-

смотра (клавиша 2) с включенным набором слоев TopOverlay. После этого 

Рис. 12.129 

Рис. 12.128 
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необходимо вернуться в 3D-режим просмотра (клавиша 3), снова включить 

набор слоев TopOverlay и убедиться в том, что соблюдены необходимые за-

зоры до областей отсутствия защитной паяльной маски. 

Примечание. Подобным образом можно оформить группу плотно рас-

положенных компонентов. Для этого они обводятся общим контуром, ко-

торый соединяется линией с таким же контуром на свободном месте ПП. 

Внутри последнего расставляются позиционные обозначения с ориентацией 

и положением, соответствующим ориентации и положению компонентов; 

– для группы компонентов, расположенных в ряд, позиционные обозна-

чения можно ставить рядом в такой же последовательности без пояснитель-

ной графики (например, R3 и R1 на рис. 12.129); 

– для освобождения места при необходимости можно корректировать 

положение переходных отверстий или удалять лишние. 

22.4. Выполнить подготовительные действия для корректировки шелко-

графии из состава посадочных мест компонентов: 

– в 3D-режиме просмотра открыть окно View Configurations (клавиша 

L) и в группе General в списке Projection выбрать опцию Perspective, после 

чего применить изменения кнопкой OK; 

– снять фильтрацию (например, кнопкой Clear в панели PCB Filter); 

– перейти в 2D-режим просмотра (клавиша 2); 

– включить набор слоев TopOverlay; 

– включить режим одного слоя (Shift+S); 

– запустить команду Tools ⇒ Design Rule Check и в открывшемся окне в 

категории правил Rules To Check ⇒ Manufacturing для правил Silk To Sol-

der Mask Clearance и Board Outline Clearance поставить галочки в столбце 

Online (рис. 12.130), после чего применить изменения кнопкой OK; 

 

– в окне Preferences (команда DXP ⇒ Preferences) в подразделе PCB Edi-

tor ⇒ DRC Violations Display в группе Choose DRC Violations Display Style 

для правил Silk To Solder Mask Clearance и Board Outline Clearance поста-

вить галочки в столбце Violation Overlay для отображения объектов, вы-

звавших нарушение, с текстурой в виде зеленых кругов с крестиками 

(рис. 12.131, а), после чего применить изменения кнопкой OK; 

Рис. 12.130 
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– чтобы нарушения отобразились в рабочем поле, необходимо внести 

изменения в какое-нибудь правило. Для этого запустить команду Design ⇒ 

Rules и в окне PCB Rules and Constraints Editor щелкнуть ЛКМ по самой 

верхней строке в списке правил (Design Rules). Затем в правой части окна 

для любого правила в столбце Enabled убрать галочку и нажать кнопку Ap-

ply. После этого вернуть галочку (рис. 12.131, б) и нажать кнопку OK. 

22.5. Исправить каждое обнаруженное нарушение, связанное с шелко-

графией, следующими способами: 

– редактированием шелкографии. Для этого необходимо отключить ре-

жим одного слоя, выбрать требуемые компоненты с зажатой клавишей Shift, 

в панели PCB Inspector в группе Graphical для опции Lock Primitives вы-

ставить значение False, после чего включить режим одного слоя и осуще-

ствить необходимые корректировки; 

– перемещением переходных отверстий (или удалением, если они лиш-

ние). Для корректировок необходимо отключить режим одного слоя. 

Результаты исправлений в варианте «П1» показаны на рис. 12.132. 

Примечания: 

– команда создания разрывов в линиях описана в Г.41; 

– в отдельных случаях перемещение объектов возможно только коман-

дами из меню Edit ⇒ Move (например, Edit ⇒ Move ⇒ Move); 

– в данном пункте отображаются нарушения, возникшие при проверке 

правил StSMC и BOC (см. табл. Г.7). Они также были бы отмечены при па-

кетной проверке правил проектирования, которая будет осуществлена да-

лее, но лучше их просматривать и исправлять заранее. 

Рис. 12.131 

а 

б 
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22.6. Если были обнаружены нарушения расположения объектов с сиг-

нальных слоев относительно контура ПП (например, переходных отверстий), 

то скорректировать положения таких объектов. 

22.7. Восстановить исходные настройки: 

– включить набор слоев All; 

– отключить режим одного слоя (Shift+S); 

– запустить команду Tools ⇒ Design Rule Check и в открывшемся окне в 

категории правил Rules To Check ⇒ Manufacturing для правил Silk To Sol-

der Mask Clearance и Board Outline Clearance снять галочки в столбце 

Online, после чего применить изменения кнопкой OK; 

– в окне Preferences (команда DXP ⇒ 

Preferences) в подразделе PCB Editor ⇒ DRC 

Violations Display для правил Silk To Solder 

Mask Clearance и Board Outline Clearance 

снять галочки в столбце Violation Overlay, 

после чего нажать кнопку OK. 

23. Проверить, что все переходные отвер-

стия в файле трассировки библиотечные. 

Для этого в панели PCB перейти в режим 

работы с шаблонами КП и переходных отвер-

стий (Pad & Via Templates) и в группе с биб-

лиотеками выбрать <Vias> (рис. 12.133). 

Рис. 12.132 

Рис. 12.133 
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Если в группе с шаблонами в столбце Library Name есть значения <Lo-

cal>, то выполнить следующие действия: 

– открыть панель PCB Pad Via Templates (см. Г.16); 

– в таблице Local Pad & Via Library отсортировать данные по столбцу 

Name и найти шаблон требуемого переходного отверстия со значением <Lo-

cal> в столбце Library; 

– в верхней таблице найти такой же шаблон переходного отверстия и 

перетащить его на найденный в таблице Local Pad & Via Library; 

– согласиться с перезаписью шаблона и нажать кнопку OK в окне с со-

общением о том, что в файл трассировки не потребовалось вносить измене-

ния (так как параметры шаблонов идентичные); 

– закрыть панель PCB Pad Via Templates крестиком в ее заголовке. 

Примечание. Шаблоны переходных отверстий не из библиотеки появ-

ляются в том числе и при отмене произведенных с ними действий. 

24. Создать контур ПП в слое M1 Board. 

Для этого запустить команду Design ⇒ Board Shape ⇒ Create Primitives 

From Board Shape, в появившемся окне задать настройки как на рис. Г.118 и 

применить изменения. 

Примечание. Внутренние углы в прорезях и во внешнем контуре ПП бу-

дут изготовлены со скруглениями, радиусы которых определяются диамет-

ром использованной фрезы (см. рис. Д.28, г). 

Способы устранения скруглений: 

– ручная доработка ПП; 

– создание в контуре паза для захода фрезы 

на половину ее диаметра (рис. 12.134, а). На ри-

сунке вскрытие маски сделано дугой с шириной 

линии 0,5 мм, расположенной на контуре ПП; 

– добавление неметаллизированного отвер-

стия диаметром 1–2 мм (см. Г.19), что техно-

логичнее других способов (рис. 12.134, б и в). На 

рисунках в свойствах отверстий задано значе-

ние вскрытия маски 0,25 мм. 

В вариантах задания с угловой формой ПП 

никаких действий предпринимать не нужно.  

25. Сохранить изменения (Ctrl+S). 

26. Осуществить пакетную проверку правил проектирования: 

Рис. 12.134 

а 

б в 
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26.1. Запустить команду Tools ⇒ Design Rule Check и в открывшемся 

окне нажать кнопку Run Design Rule Check. 

В результате в новой вкладке откроется отчет о проведенной проверке 

(Design Rule Verification Report) и окно Messages со списком обнаруженных 

нарушений, которое следует закрыть. 

Примечание. Создание отчета определяется опцией Create Report File 

окна Design Rule Checker. 

26.2. В общих чертах проанализировать данные отчета. 

Количество обнаруженных нарушений указывается в его верхней части. 

Так, в варианте «П1» было обнаружено одно нарушение (рис. 12.135, а). 

 

Перечень правил, по которым проведена проверка, с их описанием и ко-

личеством обнаруженных по ним нарушений содержится в таблице Rule Vio-

lations. Как видно из ее фрагмента, показанного для варианта «П1» на 

рис. 12.135, б, строки оформлены в виде гиперссылок, при нажатии на кото-

рые осуществляется переход к части отчета с детальной информацией по 

каждому нарушению этого правила. 

В варианте «П1» обнаруженное нарушение связано с нарушением ми-

нимальной ширины масочного мостика между переходным отверстием, рас-

положенным между слоями Top Layer и Bottom Layer, и КП со слоя Top Lay-

er по указанным координатам. Текущая ширина составляет 0,05 мм при ми-

нимально допустимом значении 0,15 мм (рис. 12.135, в). 

Рис. 12.135 

а 

б 

в 
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26.3. Перейти на вкладку с файлом трассировки. 

26.4. Из группы PCB в дополнительном меню (см. рис. 3.1) открыть па-

нель PCB Rules And Violations, которая для варианта «П1» показана на  

рис. 12.136. 

Примечание. Опции в ее верхней части 

совпадают с опциями панели PCB (см. Г.14). 

Далее расположены три области со сле-

дующей информацией: 

– в первой – группы правил, для которых 

в проекте заданы какие-либо правила (даже 

если они не участвуют в проверке); 

– во второй – перечень всех правил вы-

бранной выше группы правил; 

– в третьей – обнаруженные нарушения 

для выбранной выше группы правил или како-

го-то конкретного правила. 

Для каждой выбранной группы или от-

дельного правила можно принудительно запустить процесс проверки правил 

проектирования соответственно командами ПКМ ⇒ Run DRC Rule Class и 

ПКМ ⇒ Run DRC Rule. 

Для выбранного правила двойной щелчок ЛКМ или команда ПКМ ⇒ 

Properties открывает окно его свойств для просмотра и редактирования. 

Для выбранного нарушения двойной 

щелчок ЛКМ или команда ПКМ ⇒ Prop-

erties открывает окно Violation Details с 

подробной информацией о нем (для 

нарушения из варианта «П1» фрагмент 

окна показан на рис. 12.137). Основные 

особенности данного окна: 

– в группе Violated Rule приводится 

описание правила, которое нарушается 

(по ссылке можно перейти к окну его 

свойств); 

– в группе Violating Primitives ука-

зываются примитивы, между которы-

ми обнаружено данное нарушение; 

Рис. 12.136 

Рис. 12.137 
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– опция Waive this violation позволяет пометить нарушение как про-

смотренное с указанием автора и причины. Такое нарушение при следующем 

запуске пакетной проверки правил проектирования окажется в отчете в 

списке Waived Violations, но будет отображаться в панели PCB Rules And 

Violations и в рабочем поле. За цвет просмотренных нарушений отвечает 

параметр Waived Violation Markers; 

– кнопка Highlight позволяет кратковременно подсветить примитивы, 

между которыми обнаружено данное нарушение. 

26.5. Исправить все обнаруженные нарушения. 

Действия по устранению нарушения из варианта «П1»: 

– в панели PCB Rules And Violations включена опция Zoom и с помо-

щью кнопки Zoom Level уровень масштабирования установлен в значение 

Close (очень близко); 

– в панели PCB Rules And Violations выбрано нарушение, в результате 

чего автоматически осуществлен переход на слой Top Solder с масштабиро-

ванием объектов, между которыми оно возникло, и появлением пояснения. 

Примечание. Если пояснение не появляется, то требуется либо увели-

чить масштаб в рабочем поле, либо сдвинуть влево ползунок в группе Show 

Violation Detail подраздела PCB Editor ⇒ DRC Violations Display из окна Pref-

erences (команда DXP ⇒ Preferences);  

– включен режим одного слоя; 

– добавлен прямоугольный полигон Fill (см. п. 1 из Г.26), чтобы убрать 

из этого места узкий перешеек защитной паяльной маски (рис. 12.138); 

 

– в панели PCB Rules And Violations на группе правил Minimum Solder 

Mask Sliver Constraint запущена команда ПКМ ⇒ Run DRC Rule Class, в 

результате чего отметка о нарушении пропала и в данной группе не было об-

наружено других нарушений. 

Рис. 12.138 
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Результат произведенных действий в 3D-

режиме просмотра показан на рис. 12.139. 

26.6. Запустить пакетную проверку правил 

проектирования (см. п. 26.1) и убедиться в том, 

что в верхней части отчета в строке Rule Viola-

tions нет ошибок, а иначе – вернуться к п. 26.2. 

27. Сохранить изменения в проекте (см. 

п. 4 из 5.5). 

Они связаны с тем, что в структуру проекта 

в раздел Generated добавился отчет о проверке правил проектирования. 

28. Сохранить изменения (Ctrl+S). 

Результат трассировки ПП в варианте «П1» с набором слоев All и теку-

щим слоем Top Layer в 2D-режиме просмотра показан на рис. 12.140, а ре-

зультаты в 3D-режиме просмотра – на рис. 12.141. Пример трассировки ПП 

для еще одного варианта задания приведен на рис. Г.185–Г.188. 

 Рис. 12.140 

Рис. 12.139 
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 Рис. 12.141 
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29. Сохранить в отчет результаты этапа трассировки ПП в 2D-режиме 

просмотра, для чего выполнить следующее: 

– применить профиль ИДРЭС-AltiumPCBGray.PCBSysColors из папки 

…ИДРЭС\Профили (см. п. 6 из 5.2.1); 

– нажать клавишу L и в открывшемся окне View Configurations на 

вкладке Board Layers And Colors для механического слоя M1 Board поста-

вить галочку в столбце Single и в группе System Colors убрать галочки в 

столбце Show для сеток Default Grid Color (см. рис. 12.73, б); 

– в окне View Configurations на вкладке View Options в группе Show от-

ключить опции Show Pad Nets, Show Pad Numbers и Show Via Nets, в груп-

пе Other Options в списке Net Names on Tracks Display (отображение имен 

цепей на трассах) выбрать опцию Do Not Display, а в группе Single Layer 

Mode выбрать режим Hide Other Layers. Затем закрыть окно кнопкой OK; 

– развернуть окно Altium Designer на полный экран; 

– выполнить команду View ⇒ Fit Board, после чего зажать клавишу Ctrl 

и уменьшить масштаб на один шаг при повороте колесика мышки; 

– отключить информационное поле (Shift+H); 

– клавишей Prt Sc с последующей обрезкой лишней информации или с 

помощью приложения Ножницы сохранить в отчет рисунки рабочего поля 

для текущих слоев Top Layer, Bottom Layer, M3 Top Assy (без размеров и 

таблицы со слоями), Top Overlay и Top Solder. Затем сохранить таблицы со 

слоев M3 Top Assy и Drill Drawing; 

– включить набор слоев Shield, отключить слой M3 Top Assy (на вклад-

ке с названием слоя выполнить команду ПКМ ⇒ Hide), отключить режим 

одного слоя (Shift+S), убедиться в том, что слой M7 Shield текущий, и со-

хранить изображение; 

– нажать клавишу L и в открывшемся окне View Configurations на 

вкладке Board Layers And Colors для механического слоя M1 Board снять 

галочку в столбце Single, а в группе System Colors поставить галочки в 

столбце Show для сеток Default Grid Color; 

– в окне View Configurations на вкладке View Options в группе Show 

включить опции Show Pad Nets, Show Pad Numbers и Show Via Nets, в 

группе Other Options в списке Net Names on Tracks Display выбрать опцию 

Single and Centered, а в группе Single Layer Mode выбрать режим Not In 

Single Layer Mode, после чего закрыть окно кнопкой OK; 

– вернуть цветовые настройки, заданные в п. 6 из 5.2.1. 



 

 410 

30. Сохранить в отчет результаты этапа трассировки ПП в 3D-режиме 

просмотра, для чего выполнить следующее: 

– перейти в 3D-режим просмотра (клавиша 3); 

– при необходимости в окне View Configurations (клавиша L) на вкладке 

Physical Materials изменить цвет рабочего поля (параметр Workspace Color) 

и отключить начало координат (опция Show Origin Marker); 

– сохранить 2 рисунка рабочего поля при произвольном угле поворота 

3D-модели (см. Г.3) с видами на верхнюю и нижнюю стороны ПП; 

– включить информационное поле (Shift+H); 

– если производились изменения в окне View Configurations, то в списке 

Select PCB View Configuration выбрать профиль ИДРЭС-AltiumPCB3D 

Config.config_3d (был загружен в п. 15 из 12.1) и закрыть окно кнопкой OK; 

– нажать клавишу 0 для возврата исходной ориентации 3D-модели; 

– перейти в 2D-режим просмотра (клавиша 2). 

31. Сохранить изменения (Ctrl+S). 

Состав проекта из панели Projects 

в варианте «П1» показан на рис. 12.142. 

32. Удалить вспомогательную ин-

формацию из папки с проектом ПП: 

– папку History с резервными ко-

пиями файлов проекта, создаваемых 

при каждом их сохранении;  

– папку Project Logs с файлами, 

содержащими информацию о передаче 

изменений из схемы в файл трассировки (и наоборот); 

– все промежуточные сохраненные версии файла трассировки. В вари-

антах задания в папке должна остаться только последняя версия (в варианте 

«П1» – «AMP-П1-v0.2.PcbDoc»). 

33. При желании выполнить 5-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. Л). 

12.6. Удостоверяющий лист 

12.6.1. Данные проектирования 

По РД 107.460640.020–88 [64] комплект КД на ПП допускается выпус-

кать в виде одного документа «Данные проектирования», обеспечивающего 

получение на предприятии-изготовителе полного комплекта КД или его ча-

Рис. 12.142 



 

 411 

сти. Ему присваивается обозначение ПП с кодом Д33, и он включается в спе-

цификацию изделия с ПП. Так как отраслевой руководящий документ доста-

точно старый, то в нем предусмотрено только два вида носителя данных для 

этого документа: магнитная лента (МЛ) и магнитный диск (МД). При записи 

в спецификацию используется код МД. 

В варианте «П1» документ «Данные проектирования» состоит из файла 

трассировки «AMP-П1-v0.2.PcbDoc», а самому документу присвоено обо-

значение УП1.01.02Д33, где УП1.01.02 – обозначение чертежа ПП, которое 

было определено в табл. 2.1. 

Примечание. При наличии подготовленных файлов форматов Gerber и 

Excellon (см. прил. Л) вместо файла трассировки записывается архив, со-

став которого описан в примечании к п. 8 из Л.4, но в вариантах задания в 

случае выполнения дополнительного этапа проектирования из указанного 

приложения такую замену можно не осуществлять. 

12.6.2. Правила оформления удостоверяющего листа 

Порядок выполнения и обращения с документами на магнитных носите-

лях данных устанавливает ГОСТ 28388–89 [65], согласно которому удостове-

ряющий лист служит для простановки подлинных подписей лиц, ответствен-

ных за разработку, изготовление, согласование и утверждение таких доку-

ментов. Также указанные подписи допускается проставлять в листе утвер-

ждения. 

Удостоверяющему листу на один документ на магнитном носителе при-

сваивают обозначение этого документа с добавлением через дефис кода УД 

(например, в варианте «П1»: УП1.01.02Д33-УД). 

Удостоверяющий лист выполняют по форме с рис. 12.143, при этом ос-

новную надпись и поля выполняют в соответствии с той системой докумен-

тации, в рамках которой его выпускают. Размеры граф допускается изменять 

в зависимости от способа его выполнения. 

В графах удостоверяющего листа указывают: 

– в графе «Обозначение» – обозначение документов (документа), на ко-

торые распространяется удостоверяющий лист; 

– в графе «Разработал» – фамилии и подписи лиц (лица), разработав-

ших документ (группу документов), указанный в графе «Обозначение», и не-

сущих ответственность за правильность технического решения в этих доку-

ментах (исходных данных), и дату подписания; 
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– в графе «Изготовил» – фамилию и подпись лица, изготовившего (по-

лучение и контроль) оригинал документа (группу документов) на носителе 

данных для передачи в СТД, и дату подписания; 

– в графе «Согласовано» – предприятие или подразделение, согласую-

щее документ (группу документов), указанный в графе «Обозначение», фа-

милию и подпись лица, согласовавшего документ (группу документов), дату 

подписания; 

– в графе «Утвердил» – фамилию и подпись лица, утвердившего доку-

мент (группу документов), и дату подписания. 

Если один документ на магнитронном носителе разработан и (или) со-

гласован несколькими лицами, то их фамилии, подписи и даты подписания 

проставляют в соответствующих графах «Разработал» и «Согласовано», а 

обозначение документа указывают в графе «Обозначение» один раз. 

Если несколько документов на магнитном носителе разработаны, изго-

товлены, согласованы и утверждены одними и теми же лицами, то фамилии и 

подписи этих лиц и даты подписания проставляют один раз на группу доку-

ментов. Группы документов должны быть отделены разделительной чертой. 

Рис. 12.143 [65] 
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12.6.3. Создание удостоверяющего листа 

Удостоверяющий лист будет оформлен в Microsoft Word на заранее 

подготовленной заготовке «Удостоверяющий лист, один док.doc» из папки 

…\ИДРЭС\MSWord заготовки (см. рис. 2.9).  

Отличие данной заготовки от заготовки для перечня элементов (см. 9.2) 

только в форме заполняемой таблицы в рабочем поле листа. 

Для создания удостоверяющего листа необходимо: 

1. Открыть указанную выше заготовку. 

2. Сохранить заготовку командой Файл ⇒ Сохранить как с расшире-

нием «.doc». Имя файла в варианте «П1» – «УП1.01.02Д33-УД - Плата пе-

чатная - v0.1», а путь сохранения – …\ИДРЭС-П1\Усилитель (см. рис. 2.8). 

3. Войти в режим редактирования нижних колонтитулов по п. 3 из 9.2 и 

заполнить без копирования графы рамки в соответствии с табл. 12.3. Содер-

жание остальных граф должно соответствовать данным табл. 9.1.  

Пояснения к графам даны в табл. 3.1, на рис. 9.1 и на рис. 3.6, в. 

Таблица 12.3 

Содержание граф рамки для удостоверяющего листа,  

отличающихся от перечня элементов ПЭ3 «усилителя» 

Номер  

графы 
Содержание Комментарий к заполнению 

1 

Плата печатная 

Данные проектирования 

Удостоверяющий лист 

Наименование изделия определено в табл. 2.1. 

Наименование документа присутствует в используе-

мой заготовке по умолчанию 

2 УП1.01.02Д33-УД 
Обозначение документа определено в табл. 2.1 и ука-

зано для варианта «П1» 

7 См. комментарий 
Так как в КД по умолчанию всего один лист, то но-

мер листа уже скрыт 

Таблица 12.4 

Содержание граф таблицы из рабочего поля удостоверяющего листа 

Графа Содержание  Комментарий к заполнению 

«Обозначение» 
УП1.01.02Д33 

AMP-П1-v0.2.PcbDoc 

Указывается обозначение документа «Данные 

проектирования» (определено в табл. 2.1) и 

название файла трассировки. 

Содержание графы указано для варианта «П1» 

«Разработал»  

и «Изготовил» 
Сидоров 

Указывается фамилия студента.  

Если вариант задания выполняется студентами в 

паре, то фамилия первого записывается в графе 

«Разработал», а второго – в графе «Изготовил» 

«Утвердил» Петров Указывается фамилия преподавателя 
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 Рис. 12.144 
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4. Выйти из режима редактирования колонтитулов по п. 4 из 9.2. 

5. В графах таблицы из рабочего поля удостоверяющего листа ввести 

данные в соответствии с табл. 12.4. 

6. Сохранить изменения в удостоверяющем листе (Ctrl+S). 

Результат в варианте «П1» показан на рис. 12.144. 

7. Сохранить удостоверяющий лист в формате PDF по п. 11 из 9.2. 

Имя файла в варианте «П1» – «УП1.01.02Д33-УД - Плата печатная - 

v0.1», а путь сохранения – …\ИДРЭС-П1\Усилитель\_pdf (см. рис. 2.8). 

12.7. Содержание отчета 

По 12-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Рисунок структуры ПП, полученный в п. 5 из 12.1. 

2. Расчет толщины слоя меди из стека ПП (см. п. 5 из 12.1). 

3. Результаты этапа компоновки ПП в виде двух рисунков: 

– в 2D-режиме просмотра; 

– в 3D-режиме просмотра (вид на сторону ПП с компонентами). 

4. Результаты этапа трассировки ПП в виде следующих рисунков: 

– в 2D-режиме просмотра отдельно для слоев Top Layer, Bottom Layer, 

M3 Top Assy (без размеров и таблицы со слоями), Top Overlay и Top Solder; 

– в 2D-режиме просмотра одновременно для слоев Top Layer и M7 

Shield (слой с «экраном» должен быть текущим); 

– две таблицы со слоев M3 Top Assy и Drill Drawing; 

– в 3D-режиме просмотра с видами на верхнюю и нижнюю стороны ПП. 

5. Удостоверяющий лист на данные проектирования, распечатанный на 

отдельном листе. 

6. Схему Э3 «усилителя» и перечень элементов к ней, распечатанные на 

отдельных листах взамен уже существующих, если в процессе выполнения 

данного этапа проектирования в них были внесены корректировки. 
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13. 3D-МОДЕЛЬ «УСИЛИТЕЛЯ» 

13.1. Создание 3D-модели «усилителя» 

3D-модели «модуля усилителя» и его составных частей («усилитель», 

«основание» и «экран») будут создаваться в КОМПАС-3D. Начальное окно 

данной САПР было рассмотрено в 6.1, особенности настройки – в 6.2, а ос-

новные понятия, используемые при создании деталей и сборок, – в 6.3. 

«Усилитель» представляет собой сборочную единицу – печатный узел 

(ПП с размещенными на ней компонентами). В разд. 12 в Altium Designer 

был разработан файл трассировки, в котором кроме необходимой для произ-

водства информации содержатся данные о расположении посадочных мест 

компонентов. А так как у каждого компонента есть своя 3D-модель, для ко-

торой выполняются условия из 6.5, то 3D-модель «усилителя» будет получе-

на в автоматическом режиме. 

Для создания 3D-модели «усилителя» выполнить следующие действия: 

1. Рассчитать толщину ПП под «экраном» ( ппэh ), округлив результат до 

ближайших десятых долей миллиметра ( ппэоh ), по формуле: 

 псппэ 2hhh += . (13.1) 

Примечание. Величина псh  была вычислена по (12.1). 

В варианте «П1»: 

 5848,00384,02508,0ппэ =+=h  мм; 6,0ппэо =h  мм. 

Следует обратить внимание на то, что сохранить необходимо оба полу-

ченных значения (неокругленное и округленное). 

В варианте «П1» вычисления и записи для данной 3D-модели сохраня-

лись в Mathcad в файле Расчеты (3D-модель).xmcd в папке …\ИДРЭС-П1\ 

Усилитель\_Заметки (см. рис. 2.8). 

2. В Altium Designer создать файлы формата IDF: 

2.1. Если проект ПП был закрыт, то открыть его по п. 1 из 12.1. 

2.2. Если файл трассировки был закрыт, то открыть его по п. 3 из 8.3. 

2.3. Запустить команду File ⇒ Export ⇒ IDF Board и в появившемся 

окне Export File задать имя и путь для сохранения файлов формата IDF. Имя 

файла в варианте «П1» – «AMP-П1-v0.2», а путь сохранения – …\ИДРЭС-

П1\Усилитель\_Модели (см. рис. 2.8). 

Примечание. В данной папке впоследствии будут автоматически со-

зданы 3D-модели «усилителя» и ПП. 
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После нажатия кнопки Сохранить окно Export File закроется, и появит-

ся окно File Export IDF, в котором необходимо задать настройки, показан-

ные на рис. 13.1. 

 

Примечания: 

– в группе Exported Sections производится настройка экспортируемой 

информации (DrilledHolesCheck – отверстия в ПП, Board Outline – контур 

ПП, Placement – компоненты на ПП); 

– символы XXX (или любые другие) из поля Replace Blank Component 

Fields With необходимы для заполнения значений пустых параметров компо-

нентов для корректного экспорта и последующего импорта (например, у ис-

пользованных входных и выходных КП пустой параметр – Comment); 

– опция Override Part Number With позволяет задать параметр, значе-

ние которого будет записано при экспорте вместо параметра Comment. На 

рисунке в качестве замены указан параметр PI_Package (корпус). 

Использование параметра Comment не рекомендуется, так так компо-

ненты в одинаковых корпусах и разной информацией в нем будут считаться 

разными. Для каждого из них в дальнейшем придется задавать связь с одной 

и той же 3D-моделью (проблема для резисторов и конденсаторов, которых 

на ПП может быть очень много). Кроме того, если значение параметра од-

ного компонента является началом значения параметра другого компонен-

та, то при импорте его нельзя будет загрузить в виде 3D-модели. Например, 

в варианте «П1» так будет с резистором R3, имеющим в параметре Com-

ment значение 27 (у резистора R1 значение – 270). 

Рис. 13.1 
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После нажатия кнопки OK запустится процесс экспорта, который дол-

жен завершиться сообщением о его успешном выполнении в информацион-

ном окне. В результате в указанной папке будет создано два файла: 

– с расширением «.brd», в котором содержится информация о толщине и 

контуре ПП, отверстиях и положении компонентов; 

– с расширением «.pro», в котором содержится информация о контурах 

компонентов и их высоте. 

2.4. Открыть в блокноте файл «.brd» и в секции BOARD_OUTLINE из-

менить значение толщины на ппэоh , проверить, что координаты вершин кон-

тура ПП правильные (при необходимости обнулить соответствующие знаки 

после запятой), и закрыть файл с сохранением изменений. 

Результат в варианте «П1» показан на рис. 13.2. 

 

3. Импортировать файлы формата IDF в КОМПАС-3D: 

3.1. Запустить конвертер: 

– запустить команду Сервис ⇒ Менеджер библиотек; 

– в появившемся внизу экрана окне Менеджер библиотек открыть пап-

ку Электрика и электроника и выбрать Конвертер eCAD-КОМПАС; 

– на открывшейся вкладке раскрыть папку Конвертер eCAD-КОМПАС 

(3D) и запустить 3D-конвертер Altium Designer-КОМПАС (рис. 13.3). 

 

3.2. В открывшемся окне Конвертер eCAD-КОМПАС (3D) выполнить 

следующие действия (рис. 13.4): 

– кнопкой Файл около поля Исходные данные выбрать ранее создан-

ный файл с расширением «.brd»; 

Рис. 13.2 

Рис. 13.3 
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– появившийся путь в поле Модель платы оставить по умолчанию; 

– отключить опцию Только монтажные отверстия (в 3D-модели ПП 

будут отображены все отверстия из файла трассировки); 

– выбрать опцию Реалистичная модель платы (для компонентов ПП 

можно будет использовать созданные 3D-модели) и нажать кнопку Создать. 

 

Примечание. Если для компонента не задана 3D-модель и в поле Height 

не ноль (см. рис. 5.19, а), то автоматически создается модель в виде парал-

лелепипеда с контуром сечения, охватывающим все объекты в его посадоч-

ном месте на ПП, и высотой из этого поля. Если в поле Height ноль, то бу-

дет предложено пропустить компонент или задать высоту вручную. 

3.3. В открывшемся окне Соответствие компонентов для каждого по-

садочного места установить связь с 3D-моделью компонента: 

– выбрать строчку с посадочным местом;  

– нажать кнопку Выбрать модель для связи; 

– в открывшемся окне указать путь к 3D-модели компонента из папки 

…\ИДРЭС\Модели элементов (см. рис. 2.9) или из …\ИДРЭС-П1\Усили-

тель\_Модели элементов (для конденсатора из разд. 6). 

Таблица связей в варианте «П1» показана на рис. 13.5. 

Примечания: 

– в столбце «Компонент ECAD-системы» указано название посадочного 

места компонента (Footprint) и через пробел – значение параметра PI_Pack-

age. В каждой строке находится группа компонентов из проекта ПП, для 

которых эти данные являются одинаковыми; 

– 3D-модель КП необходима для позиционирования СВЧ-разъемов. 

Рис. 13.4 
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Затем сохранить таблицу связей кнопкой Сохранить таблицу связей с 

расширением «.ini». Имя файла в варианте «П1» – «AMP-П1-v0.2», а путь 

сохранения – …\ИДРЭС-П1\Усилитель\_Модели (см. рис. 2.8). 

3.4. Запустить процесс конвертации, нажав в окне Соответствие ком-

понентов кнопку OK. 

 

В результате в рабочем поле появится 3D-модель «усилителя», располо-

женная и сориентированная в пространстве в соответствии с данными файла 

трассировки (рис. 13.6). 

3.5. Закрыть окно Менеджер библиотек. 

Рис. 13.5 

Рис. 13.6 
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4. В Дереве модели выполнить следующее: 

– зафиксировать группу Компоненты (ПКМ ⇒ Включить фиксацию); 

– скрыть Начало координат; 

– раскрыть группу Компоненты и удалить Панель (ПКМ ⇒ Удалить). 

5. В Дереве модели на названии сборочной единицы (Сборка) запу-

стить команду ПКМ ⇒ Свойства модели (рис. 13.7, а). 

 

Затем в Панели свойств на вкладке Свойства в окне Список свойств 

заполнить поля Обозначение и Наименование согласно информации из 

табл. 2.1, после чего нажать пиктограмму Создать объект. 

Примечания: 

– в варианте «П1» записано «УП1.01.01» и «Усилитель» (рис. 13.7, б); 

– для 3D-модели можно задать и другие свойства, которые будут 

вставлены при оформлении КД в соответствующие графы рамки (например, 

фамилия разработчика). Изменение списка свойств осуществляется коман-

дой Сервис ⇒ Параметры ⇒ Текущая сборка ⇒ Настройка списка свойств 

(или пиктограммой «Настройка списка свойств» на рис. 13.7, б). 

6. В проводнике Windows открыть папку …\ИДРЭС-П1\Усилитель\ 

_Модели (см. рис. 2.8) и изменить имя автоматически созданного файла 

3D-модели ПП, заканчивающегося на _board, на имя с наименованием и обо-

значением ПП согласно информации из табл. 2.1. 

Примечание. В варианте «П1» записано «УП1.01.02 - Плата печатная». 

7. В КОМПАС-3D открыть 3D-модель ПП и задать ей по п. 5 обозначе-

ние и наименование по названию ее файла, указанному на вкладке. 

Результат в варианте «П1» на данном этапе показан на рис. 13.8. 

8. Используя данные табл. Б.2, рассчитать массу ПП по формуле: 

 ( )( ) ппгммпппп 2 Shthm ++= , (13.2) 

Рис. 13.7 

а б 

Настройка списка свойств 
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где пп  – плотность материала основания ПП, г/мм3; м  – плотность меди, 

3
м 1093,8 −=  г/мм3; ппS  – площадь любого сигнального слоя ПП (в вариан-

те «П1» – произведение ширины ПП на ее длину), мм2. 

В варианте «П1»: 

( )( ) 6,4405002,0018,01093,82508,0102,3 33
пп ++= −−m  г. 

9. На вкладке с ПП выполнить следующее: 

– задать ПП полученное значение массы (см. п. 22 из 6.5); 

– скрыть Начало координат; 

– сохранить изменения (Ctrl+S). 

10. Добавить 3D-модель ПП в «усилитель», для чего на вкладке с «уси-

лителем» выполнить следующие действия: 

– запустить команду Добавить из файла (рис. 13.9) 

на ПИ Компактная панель ⇒ Редактирование сборки; 

– в открывшемся окне Открытые документы вы-

брать 3D-модель ПП и нажать OK; 

– на Панели свойств в поле Опорная точка задать нулевые координа-

ты и нажать клавишу Enter (или поставить крестик около указанного поля); 

– нажать пиктограмму Создать объект; 

– в Дереве модели зафиксировать ПП; 

– сохранить изменения (Ctrl+S) и закрыть обе вкладки. 

11. Открыть папку …\ИДРЭС-П1\Усилитель\_Модели (см. рис. 2.8) и 

переименовать файл сборки по имени сборки. 

Примечание. В варианте «П1» записано «УП1.01.01 - Усилитель». 

12. Создать на поверхности ПП топологию ПФ, для чего выполнить сле-

дующие действия: 

Рис. 13.8 

Добавить 

из файла 

Рис. 13.9 
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12.1. В Altium Designer в файле трассировки задать видимость слоев: 

– включить набор слоев Shield; 

– скрыть слои M3 Top Assy и M7 Shield, выполнив на вкладках с их 

названиями команды ПКМ ⇒ Hide; 

– показать слой M1 Board, выполнив на строке с вкладками слоев ко-

манду ПКМ ⇒ Show Layers ⇒ M1 Board. 

12.2. Запустить команду File ⇒ Export ⇒ DXF/DWG и в появившемся 

окне Export File задать имя и путь для сохранения файлов формата DXF. Имя 

файла в варианте «П1» – «BPF», а путь сохранения – …\ИДРЭС-П1\Усили-

тель\_Модели. 

После нажатия кнопки Сохранить окно Export File закроется, и появит-

ся окно Export to AutoCAD, в котором необходимо задать настройки, пока-

занные на рис. 13.10. 

 

Примечания: 

– в группе Holes включена опция экспорта отверстий (Export pads and 

via holes) с размещением их на отдельных слоях (On dedicated hole layers), 

т. е. в результате отверстия для Via окажутся на слое ViaHoleLayer, а от-

верстия для Pad – на слое PadHoleLayer; 

Рис. 13.10 
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– в группе Components включена опция Export as primitives, в результате 

чего компоненты будут разрушены и представлены в виде примитивов (на 

данном этапе можно выбрать любую опцию из этой группы); 

– в группе Tracks and Arcs с опцией Export with rounded ends на концах 

линий (с дугами опция не работает), нарисованных в редакторе ПП, будут 

созданы окружности с диаметром, равным половине их ширины. Чтобы их 

не было, выбрана опция Export with square ends; 

– в группе Layers выбрана опция Currently Visible Layers, чтобы экспор-

тировалась информация только с видимых в данный момент слоев.   

Запустить процесс экспорта кнопкой OK и дождаться появления сооб-

щения о его успешном выполнении в информационном окне. 

После этого закрыть файл трассировки без сохранения изменений. 

12.3. К сожалению, в полученном файле DXF координаты практически 

всех объектов будут иметь большое количество знаков в дробной части. Ве-

роятно, это связано с тем, что Altium Designer хранит все в дюймовой систе-

ме измерения, а при экспорте объектов, нарисованных в метрической систе-

ме, должного округления не осуществляется. 

Полигоны переносятся в DXF объектами LINE (линия), при этом даже 

без округления координаты общей вершины двух соседних линий совпадают. 

Для остальной графики, которая переносится объектами LWPOLYLINE (по-

лилиния, дуга), это может оказаться неверным, что приведет к невозможно-

сти построения 3D-моделей. 

Для автоматического округления координат вершин служит программа 

ИДРЭС-DXFfix из папки …\ИДРЭС\Программы. После ее запуска необхо-

димо выполнить следующее (рис. 13.11, а): 

 

– включить корректировку объектов LWPOLYLINE и LINE с точностью 

0,001 мм; 

Рис. 13.11 

а б 
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– отключить удаление окружностей; 

– нажать кнопку Исправить; 

– в появившемся окне выбрать требуемый файл DXF и нажать кнопку 

Открыть. 

В результате успешного исправления в окне программы появится соот-

ветствующая надпись, а в папке с выбранным файлом DXF – скорректиро-

ванный файл с добавкой в названии «_fix» (в варианте «П1» – BPF_fix.dxf). 

Примечание. Пример обработки координат двух вершин полилинии (10 – 

X, 20 – Y) показан на рис. 13.11, б. 

12.4. В КОМПАС-3D открыть файл BPF_fix.dxf: 

– запустить команду Файл ⇒ Открыть; 

– в окне Выберите файлы для открытия в поле Тип файлов выбрать 

Все файлы (*.*), указать путь к требуемому файлу и нажать Открыть; 

– в появившемся окне Чтение файла в формате DXF оставить настрой-

ки по умолчанию и нажать кнопку Начать чтение. 

В результате в новой вкладке рабочего поля появится фрагмент 

(BPF_fix.frw), в котором будет представлена информация со слоев Top Layer, 

M1 Board и двух слоев с отверстиями (рис. 13.12). 

 

Примечания: 

– фрагмент (файл с расширением «.frw») представляет собой документ 

для хранения 2D-графики. Отличается от чертежа отсутствием объектов 

оформления и наличием всего одного вида в масштабе 1:1; 

– управление слоями осуществляется в выпадающем списке ПИ «Теку-

щее состояние», показанном на рисунке, или в окне «Менеджер документа», 

в которое можно перейти, нажав пиктограмму слева от указанного списка; 

Рис. 13.12 
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– каждый вид (при использовании чертежей) может содержать произ-

вольное количество слоев; 

– иконка замка позволяет сделать слой фоновым (все его объекты 

отображаются пунктирными линиями и не доступны для выделения), икон-

ка лампочки – скрыть слой; иконка с цветом – задать цвет объектов слоя; 

иконка принтера – запретить вывод на печать объектов слоя. 

12.5. Удалить все объекты, кроме контура ПП, очертаний полигонов и 

переходных отверстий (для вариантов с ШТ) из топологии ПФ. 

Для этого выполнить следующие действия: 

– выделить все объекты (Ctrl+A); 

– запустить команду Выделить ⇒ Исключить ⇒ Слой ⇒ Выбором и в 

появившемся окне выбрать слой Mechanical1, после чего нажать кнопку OK; 

– запустить команду Выделить ⇒ Исключить ⇒ Рамкой и в рабочем 

поле нарисовать прямоугольный контур по границе прямоугольника, ограни-

чивающего топологию ПФ, после чего нажать клавишу Esc (рис. 13.13); 

 

– нажать клавишу Delete; 

– удалить прямоугольный контур, ограничивающий топологию ПФ, и 

оставшиеся объекты, не относящиеся к ней (рис. 13.14). 

 

12.6. Выделить все объекты (Ctrl+A), щелкнуть ПКМ в рабочем поле и в 

появившейся над курсором ПИ выбрать стиль линии Основная (рис. 13.15), 

после чего снять выделение. 

Рис. 13.14 

Рис. 13.13 
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12.7. В вариантах задания с ШТ 

выполнить следующие действия: 

– выделить все объекты (Ctrl+A); 

– на выделенных объектах выпол-

нить команду ПКМ ⇒ Разрушить (или 

команду Редактор ⇒ Разрушить), в 

результате чего импортированные объ-

екты в виде окружностей превратятся в дуги, которые можно редактировать; 

– запустить команду Выделить ⇒ По свойствам; 

– в появившемся окне в группе Геометрия выбрать Дуги, задать слой 

ViaHoleLayer (рис. 13.16) и нажать OK; 

 

– выполнить команду ПКМ ⇒ Свойства; 

– в появившемся окне Свойства в поле Диаметр задать значение диа-

метра отверстия 0.4 (рис. 13.17), так как были использованы переходные от-

верстия с шаблоном v90h40; 

 

– снять выделение с объектов в рабочем поле; 

– запустить команду Выделить ⇒ По свойствам и в появившемся окне 

в группе Геометрия выбрать Дуги, задать слой TopLayer и нажать OK; 

– в окне Свойства в поле Диаметр задать значение диаметра металли-

зации на переходном отверстии 0.9 (рис. 13.18), так как были использованы 

переходные отверстия с шаблоном v90h40; 

– закрыть окно Свойства; 

Рис. 13.16 

Рис. 13.17 

Рис. 13.15 
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– командой Усечь кривую (см. рис. 6.20) из ПИ 

Компактная панель ⇒ Редактирование детали 

удалить линии и дуги так, чтобы для каждого резо-

натора получился замкнутый контур (рис. 13.19). 

12.8. Проверить отсутствие наложения элемен-

тов и замкнутость контуров по пп. 8.1 и 8.2 из 6.5. 

При возникновении ошибок устранить их ко-

мандами Усечь кривую или Удлинить до ближай-

шего объекта (см. рис. 6.20) из ПИ Компактная 

панель ⇒ Редактирование. 

12.9. Открыть 3D-модель «усилителя». 

12.10. В рабочем поле выбрать поверхность ПП со стороны установки 

компонентов для последующего создания на ней 3D-модели ПФ. 

Для этого подвести курсор мышки на поверхность, обратив внимание на 

его вид, и щелкнуть по ней ЛКМ (рис. 13.20, а). 

 

12.11. Запустить команду Создать деталь (рис. 13.21) на ПИ Компакт-

ная панель ⇒ Редактирование сборки. 

Рис. 13.20 

а б 

Режим контекстного 

редактирования 

Рис. 13.18 

Рис. 13.19 
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В открывшемся окне указать путь и имя создаваемого 

файла детали, а также выбрать расширение «.m3d». Имя 

файла в варианте «П1» – «Полосовой фильтр», а путь со-

хранения – …\ИДРЭС-П1\Усилитель\_Модели (см. рис. 2.8). 

Примечание. Построение любой детали начинается с создания ее осно-

вания, поэтому после сохранения файла 3D-модели будет запущен режим 

создания эскиза ее основания (рис. 13.20, б), который расположится на ука-

занной ранее плоскости на ПП. 

Режим создания и редактирования 3D-модели в составе сборки называ-

ется контекстным редактированием, при этом визуально происходят сле-

дующие изменения: 

– вся сборка в рабочем поле окра-

шивается в голубой цвет; 

– в правом верхнем углу рабочего 

поля появляется соответствующая 

иконка (рис. 13.20, б); 

– в «Дереве модели» редактируе-

мая 3D-модель окрашивается в корич-

невый цвет (рис. 13.22). 

12.12. Убедиться в том, что включены глобальные привязки, задан шаг 

сетки 0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

12.13. Если эскиз оказался не в плоскости рабочего окна, то выполнить 

команду ПКМ ⇒ Нормально к. 

12.14. Перенести контуры топологии ПФ в текущий эскиз: 

– перейти на вкладку с BPF_fix.frw; 

– выделить только элементы топологии ПФ без контура ПП; 

– скопировать (Ctrl+C) выделенные элементы, указав в качестве базовой 

точки угол контура ПП, в котором в файле трассировки располагалась точка 

начала координат (см. рис. 12.25); 

– перейти на вкладку с «усилителем»; 

– вставить (Ctrl+V) скопированные объекты, указав базовую точку в 

точке начала координат и завершить команду клавишей Esc; 

– закрыть вкладку с BPF_fix.frw с сохранением изменений; 

– выйти из режима редактирования эскиза. 

Примечание. Если был осуществлен выход из режима контекстного ре-

дактирования, то вернуться в него можно по п. 18.12 из разд. 15. 

Рис. 13.21 

Создать 

деталь 

Рис. 13.22 
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12.15. Отключить группировку состав-

ных частей сборки и основных элементов 

деталей по общему признаку, для чего в Де-

реве модели отжать пиктограмму Отобра-

жение структуры модели (рис. 13.23). 

12.16. В Дереве модели раскрыть под-

группу Деталь, выбрать ЛКМ созданный 

эскиз (Эскиз:1) и запустить команду Операция выдавливания из группы 

«Кинематическая операция» (см. рис. 6.23 и 6.36). 

На Панели свойств задать направление 

выдавливания от ПП с расстоянием 0.02 мм и 

дважды нажать пиктограму Создать объект. 

12.17. В Дереве модели по п. 5 изменить 

наименование 3D-модели ПФ на имя файла – 

Полосовой фильтр. 

Фрагмент Дерева модели с ПФ на данном 

этапе показан на рис. 13.24. 

12.18. Выйти из режима контекстного редактирования одним из следу-

ющих способов: 

– отжать пиктограмму Редактировать на месте на ПИ Текущее состо-

яние (рис. 13.25); 

 

– нажать на иконку режима контекстного редактирования в правом 

верхнем углу рабочего поля (рис. 13.20, б и 13.25); 

– в Дереве модели на редактируемой 3D-модели выполнить команду 

ПКМ ⇒ Редактировать на месте. 

12.19. В Дереве модели нажать пиктограмму Отображение структуры 

модели (см. рис. 13.23). 

12.20. Зафиксировать ПФ. 

13. Сохранить изменения в 3D-модели «усилителя» (Ctrl+S). 

Результат в варианте «П1» показан на рис. 13.26. 

Рис. 13.25 

Рис. 13.23 

Рис. 13.24 
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Примечание. При использовании файлов в промежуточных форматах 

PARASOLID или STEP 3D, экспортированных из Altium Designer, в MCAD 

сразу же после их импорта будет сформирована полная 3D-модель печатно-

го узла (ПП и компоненты). Однако при этом способе невозможно вручную 

изменить толщину ПП, 3D-модели компонентов и ПП будут представлены в 

виде цельных тел и для отдельных компонентов может быть потеряна ин-

формация об их цвете (актуально для формата STEP 3D). 

На рис. 13.27 показан фрагмент файла «Расчеты (3D-модель).xmcd», в 

котором производились расчеты в варианте «П1».  

 

Рис. 13.26 

Рис. 13.27 
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Для изменения формата вывода результатов вычисления служит коман-

да Format ⇒ Result. Окно Result Format показано на рис. 13.28. 

 

В Mathcad доступны пять форматов: 

а) General – десятичная дробь со следующими настройками: 

– Number of decimal places – количество знаков после запятой; 

– Show trailing zeroes – дробь дополняется нулями до указанного коли-

чества знаков после запятой; 

– Show exponents in engineering format – в экспоненциальной форме 

используются порядки, кратные трем; 

– Exponential threshold – граница перехода к экспоненциальной форме. 

б) Decimal – десятичная дробь без экспоненты; 

в) Scientific – экспоненциальная форма; 

г) Engineering – экспоненциальная форма с порядками, кратными трем; 

д) Fraction – простая дробь. 

Для изменения формата вывода только выбранного результата необхо-

димо по нему дважды щелкнуть ЛКМ или один раз щелкнуть ЛКМ и запу-

стить указанную выше команду. 

13.2. Содержание отчета 

По 13-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Расчет толщины ПП под «экраном». 

2. Расчет массы ПП. 

3. Рисунок 3D-модели «усилителя» с размещенной топологией фильтра. 

 

Рис. 13.28 
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14. 3D-МОДЕЛЬ «ЭКРАНА» 

«Экран» представляет собой деталь. Его 3D-модель будет разрабаты-

ваться в составе «модуля усилителя» на уже созданной 3D-модели «усилите-

ля» с использованием информации со слоя Shield из файла трассировки. 

Для создания 3D-модели «экрана» выполнить следующие действия: 

1. В КОМПАС-3D командой Файл ⇒ Создать ⇒ Новые документы ⇒ 

Сборка ⇒ OK создать новую сборку, которая станет в дальнейшем 3D-мо-

делью «модуля усилителя». 

2. В Дереве модели созданной сборке задать обозначение и наименова-

ние «модуля усилителя» согласно информации из табл. 2.1 (см. п. 5 из 13.1). 

Примечание. В варианте «П1» записано «УП1.00.01» и «Модуль усили-

теля». 

3. Сохранить 3D-модель командой Файл ⇒ Сохранить как с расшире-

нием «.a3d» и именем, состоящим из указанных ранее наименования и обо-

значения. Имя файла в варианте «П1» – «УП1.00.01 - Модуль усилителя», а 

путь сохранения – …\ИДРЭС-П1\_Модели (см. рис. 2.7). 

4. Запустить команду Добавить из файла (см. рис. 13.9) из ПИ Ком-

пактная панель ⇒ Редактирование сборки и выполнить следующее: 

– в открывшемся окне выбрать 3D-модель «усилителя» и нажать OK 

(если вкладка с «усилителем» была закрыта, то указать путь к 3D-модели и 

нажать кнопку Открыть); 

– на Панели свойств в поле Опорная точка задать нулевые координа-

ты и нажать клавишу Enter (или поставить крестик около указанного поля); 

– нажать пиктограмму Создать объект. 

5. Скрыть Начало координат и отжать пиктограмму Отображение 

структуры модели (см. рис. 13.23). 

6. Сохранить сборку (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

7. В составе сборки создать деталь, которая станет в дальнейшем 3D-мо-

делью «экрана». Для этого выполнить следующее: 

– в рабочем поле выбрать поверхность ПП «усилителя» со стороны уста-

новки компонентов, щелкнув по ней ЛКМ (см. рис. 13.20, а); 

– запустить команду Создать деталь (см. рис. 13.21) на ПИ Компакт-

ная панель ⇒ Редактирование сборки; 

– в открывшемся окне указать путь и имя создаваемого файла с обозна-

чением и наименованием согласно информации из табл. 2.1, а также выбрать 
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расширение «.m3d». Имя файла в варианте «П1» – «УП1.00.03 - Экран», а 

путь сохранения – …\ИДРЭС-П1\_Модели (см. рис. 2.7). 

8. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее бражение (см. пп. 4 и 5 из 6.5). 

Также проверить, что на ПИ Режимы отключена пик-

тограмма Перспектива (рис. 14.1). 

Результат в варианте «П1» на данном этапе показан на рис. 14.2. 

 

9. Экспортировать из Altium Designer информацию об «экране», для че-

го выполнить следующие действия: 

– если проект ПП был закрыт, то открыть его по п. 1 из 12.1; 

– если файл трассировки был закрыт, то открыть его по п. 3 из 8.3; 

– включить набор слоев Shield; 

– скрыть слои M3 Top Assy и Top Layer, выполнив на вкладках с их 

названиями команды ПКМ ⇒ Hide; 

– запустить команду File ⇒ Export ⇒ DXF/DWG; 

– в открывшемся окне Export File задать путь и имя для сохранения фай-

ла c контурами «экрана» в формате DXF. Имя файла в варианте «П1» – 

«Shield», а путь сохранения – …\ИДРЭС-П1\_Модели. Затем нажать кнопку 

Сохранить; 

– в появившемся окне Export to AutoCAD задать настройки с рис. 13.10, 

но с отключенной опцией Export pads and via holes, после чего запустить 

процесс экспорта кнопкой OK; 

– после появления сообщения об успешном завершении процесса за-

крыть файл трассировки без сохранения изменений; 

Рис. 14.2 

Рис. 14.1 

Перспектива 
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– запустить программу ИДРЭС-DXFfix из папки …\ИДРЭС\Програм-

мы и нажать кнопку Исправить. 

Примечание. Выставленные при запуске про-

граммы настройки (включены опции корректи-

ровки объектов LWPOLYLINE с точностью 0,01 

мм и удаление окружностей) не требуют изме-

нений. С опцией «Удалить окружности» будут 

удалены окружности, расположенные на концах 

скруглений в контуре внутренней полости «экра-

на» (рис. 14.3); 

– в появившемся окне выбрать требуемый 

файл DXF с контурами «экрана» и нажать кнопку Открыть. 

10. В КОМПАС-3D открыть файл Shield_fix.dxf (см. п. 12.4 из 13.1). 

Результат в варианте «П1» на данном этапе показан на рис. 14.4. 

 

11. На вкладке с контуром «экрана» выполнить следующие действия: 

– выделить все объекты (Ctrl+A); 

– на выделенных объектах выполнить команду ПКМ ⇒ Разрушить (или 

команду Редактор ⇒ Разрушить); 

– назначить всем объектам стиль линии Основная (см. п. 12.6 из 13.1); 

– выделить и скопировать все объекты (Ctrl+C), указав в качестве базо-

вой точки угол контура ПП, в котором в файле трассировки располагалась 

точка начала координат (см. рис. 12.25). 

12. Перейти на вкладку с «модулем усилителя» и вставить скопирован-

ные объекты (Ctrl+V), указав базовую точку в точке начала координат. 

13. Оставить в эскизе только внешний контур «экрана». 

Для этого выделить все остальные объекты и вырезать их (Ctrl+X), ука-

зав базовую точку в точке начала координат (рис. 14.5). 

Примечания: 

– при массовом выделении мышкой слева направо выделенными ока-

жутся только полностью попавшие в контур выделения объекты; 

Рис. 14.4 

Рис. 14.3 
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– при массовом выделении мышкой справа налево выделенными ока-

жутся полностью и частично попавшие в контур выделения объекты; 

– добавление объектов к уже выделенным осуществляется с зажатой 

клавишей Ctrl. 

14. Выйти из режима редактирования эскиза. 

Примечание. Если был осуществлен выход из режима контекстного ре-

дактирования, то вернуться в нее можно по п. 18.12 из разд. 15. 

15. Определить толщину «экрана» по формуле: 

 ппэооснмуээ hhhh −−= . (14.1) 

Расшифровка муэh  и оснh  дана в описании к (4.9). 

В варианте «П1»: 

 4,66,0310э =−−=h  мм. 

В варианте «П1» вычисления и записи для 3D-модели «экрана» и черте-

жей «экрана» и «основания» сохранялись в Mathcad в файле Расчеты (дета-

ли).xmcd в папке …\ИДРЭС-П1\_Заметки (см. рис. 2.7). 

16. В Дереве модели выбрать ЛКМ созданный эскиз (Эскиз:1) и запу-

стить команду Операция выдавливания (см. рис. 6.23). 

На Панели свойств задать направление выдавливания в сторону от по-

верхности ПП на расстояние, полученное по (14.1), и нажать пиктограмму 

Создать объект. 

При появлении ошибки проверить эскиз по пп. 8.1 и 8.2 из 6.5. 

Результат в варианте «П1» на данном этапе показан на рис. 14.6. 

17. На поверхности ПП «усилителя» со стороны установки компонентов 

(рис. 14.7), не выходя из режима контекстного редактирования детали, со-

здать новый эскиз (Эскиз:2) и вставить из буфера обмена (Ctrl+V) вырезан-

ные ранее объекты, указав базовую точку в точке начала координат. 

Рис. 14.5 
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18. Вырезать все объекты (Ctrl+X), относящиеся к прорезям в стенках 

«экрана», относительно точки начала координат. 

Результат в варианте «П1» на данном этапе показан на рис. 14.8. 

 

19. Определить высоту внутренней полости «экрана» по формуле: 

 кэээп hhh −= . (14.2) 

Рис. 14.7 

Рис. 14.6 

Рис. 14.8 
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Расшифровка кэh  дана в описании к (4.9). 

В варианте «П1»: 

 4,514,6эп =−=h  мм. 

20. Выйти из режима редактирования эскиза (Эскиз:2). 

21. Сохранить изменения в 3D-модели (Ctrl+S) и осуществить проверку 

по п. 12 из 6.5. 

22. В Дереве модели выбрать ЛКМ эскиз (Эскиз:2) и запустить команду 

Вырезать выдавливанием (см. рис. 6.29) из ПИ Компактная панель ⇒ Ре-

дактирование детали. 

На Панели свойств задать направление вырезания внутрь «экрана» на 

расстояние, полученное по (14.2), и нажать пиктограмму Создать объект. 

При появлении ошибки проверить эскиз по пп. 8.1 и 8.2 из 6.5. 

23. На поверхности ПП «усилителя» со стороны установки компонентов 

(см. рис. 14.7), не выходя из режима контекстного редактирования детали, 

создать новый эскиз (Эскиз:3) и вставить из буфера обмена (Ctrl+V) выре-

занные ранее объекты, указав базовую точку в точке начала координат. 

24. Относительно точки начала координат вырезать все линии (Ctrl+X), 

относящиеся к прорези в тонкой стенке «экрана». 

25. Командой Отрезок (см. рис. 6.11) нарисовать четыре линии для со-

здания замкнутых контуров прорезей в толстых стенках «экрана». 

Результат в варианте «П1» на данном этапе показан на рис. 14.9. 

 Рис. 14.9 
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26. Выйти из режима редактирования эскиза (Эскиз:3). 

27. В Дереве модели выбрать ЛКМ эскиз (Эскиз:3) и запустить команду 

Вырезать выдавливанием. 

На Панели свойств задать направление вырезания внутрь «экрана» на 

расстояние 1 мм и нажать пиктограмму Создать объект. 

28. На поверхности ПП «усилителя» со стороны установки компонентов 

(см. рис. 14.7), не выходя из режима контекстного редактирования детали, 

создать новый эскиз (Эскиз:4) и вставить из буфера обмена (Ctrl+V) выре-

занные ранее объекты, указав базовую точку в точке начала координат. 

29. Нарисовать линии для создания замкнутого контура прорези в тон-

кой стенке «экрана» с временным включением режима Ортогональное чер-

чение зажатой клавишей Shift. 

Результат в варианте «П1» на данном этапе показан на рис. 14.10. 

 

30. Выйти из режима редактирования эскиза (Эскиз:4). 

31. В Дереве модели выбрать ЛКМ эскиз (Эскиз:4) и запустить команду 

Вырезать выдавливанием. 

На Панели свойств задать направление вырезания внутрь «экрана» на 

расстояние 1 мм и нажать пиктограмму Создать объект. 

При появлении ошибки проверить эскиз по пп. 8.1 и 8.2 из 6.5. 

Рис. 14.10 
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32. Создать опорные поверхности под установку винтов М2,5 с потай-

ной головкой (метрическая резьба с диаметром 2,5 мм) согласно требованиям 

ГОСТ 12876–67 [66] со следующими размерами (рис. 14.11): 

)18,0(
1 13H7,5 +=D  мм;  

)14,0(13H1,3 +=hd  мм, 

где H13 – поле допуска для 13-го квалитета (см. Д.6). 

Для получения опорных поверхностей выполнить 

следующие действия: 

32.1. На поверхности ПП «усилителя» со стороны 

установки компонентов (см. рис. 14.7), не выходя из 

режима контекстного редактирования детали, создать 

новый эскиз (Эскиз:5). 

32.2. Выполнить команду Вид ⇒ Отображение ⇒ Каркас или нажать 

соответствующую пиктограмму на ПИ Вид (рис. 14.12). 

 

32.3. Запустить команду Окружность (ПИ Компактная панель ⇒ Гео-

метрия). Затем на Панели свойств в поле Диаметр задать значение 3.1 мм и 

нажать пиктограмму Запомнить состояние (рис. 14.13). 

32.4. На ПИ Глобальные привязки в 

группе Локальные привязки выбрать 

Центр (или в рабочем поле выполнить 

команду ПКМ ⇒ Привязка ⇒ Центр). 

Затем подвести курсор мышки к кон-

туру одного из крепежных отверстий на 

ПП под «экраном» (рис. 14.14) и нажать 

ЛКМ для добавления окружности. 

Добавить остальные крепежные от-

верстия под «экраном», после чего выйти 

из команды создания окружностей. 

32.5. Выполнить команду Вид ⇒ 

Отображение ⇒ Полутоновое с каркасом или нажать соответствующую 

пиктограмму на ПИ Вид (см. рис. 14.12). 

Рис. 14.12 

Каркас 

Невидимые линии тонкие 

Полутоновое с каркасом 

Без невидимых линий Полутоновое 

Рис. 14.11 [66] 

Рис. 14.13 

Рис. 14.14 
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32.6. Выйти из режима редактирования эскиза (Эскиз:5). 

32.7. В Дереве модели выбрать ЛКМ эскиз (Эскиз:5) и запустить ко-

манду Вырезать выдавливанием. 

На Панели свойств задать направле-

ние вырезания внутрь «экрана» в режиме 

До ближайшей поверхности (рис. 14.15) 

и нажать пиктограмму Создать объект. 

32.8. Запустить команду Фаска из группы «Скругление» на ПИ Ком-

пактная панель ⇒ Редактирование детали (рис. 14.16), после чего в Пане-

ли свойств в поле Длина 1 записать 1.3, а в поле Угол – 45. 

Затем в рабочем поле на верхней стороне «экрана» 

последовательно щелкнуть ЛКМ на все ребра отверстий, 

после чего в Панели свойств нажать пиктограмму Со-

здать объект. 

33. Для 3D-модели «экрана» указать его обозначение и наименование, а 

также в соответствии с общим заданием на проектирование задать материал 

Д16 ГОСТ 4784–97: 

– в Дереве модели на «экране» запустить команду ПКМ ⇒ Свойства 

компонента; 

 Рис. 14.17 

Выбрать материал 

из списка 

Рис. 14.15 

Рис. 14.16 

Фаска Скругление 
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– на вкладке Свойства в окне Список свойств заполнить поля Обозна-

чение и Наименование согласно информации из табл. 2.1. 

Примечание. В варианте «П1» записано «УП1.00.03» и «Экран»; 

– на вкладке Параметры МЦХ в окне Материал нажать пиктограмму 

Выбрать материал из списка; 

– в появившемся окне Плотность материалов в группе Алюминиевые 

сплавы выбрать Д16 ГОСТ 4784-97 (см. рис. 14.17) и нажать OK; 

– применить изменения пиктограммой Создать объект. 

34. Выйти из режима контекстного редактирования «экрана». 

35. Закрыть вкладку с фрагмен-

том «экрана» (Shield_fix.frw) с сохра-

нением изменений. 

36. В Дереве модели зафиксиро-

вать «экран». 

37. Сохранить изменения в 3D-

модели (Ctrl+S). 

Результат создания 3D-модели 

«экрана» в варианте «П1» со скрытым «усилителем» показан на рис. 14.18. 

3D-модель «экрана» будет доработана в разд. 16. 

Требования к содержанию отчета по данному этапу приведены в 16.2. 

Примечание. Создание эскиза «экрана» в файле трассировки позволяет 

корректно расположить его контуры относительно проводящего рисунка 

ПП. Однако это не означает, что при создании модели ничего менять нель-

зя. Так, в варианте «П1» на рис. 14.9 размеры прорезей в толстых стенках 

были уменьшены с 8 до 7 мм. 

 

Рис. 14.18 
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15. 3D-МОДЕЛЬ «ОСНОВАНИЯ» 

«Основание», как и «экран», представляет собой деталь. Его 3D-модель 

будет разрабатываться в составе «модуля усилителя» с использованием ре-

зультатов, полученных в разд. 13 и 14, а также с использованием 3D-модели 

СВЧ-разъема. 

«Основание» во всех вариантах задания будет двухуровневым: 

– первый уровень толщиной 3 мм ( оснh ) с резьбовыми отверстиями под 

винты М2,5 и контуром, который в сечении соответствует контуру ПП «уси-

лителя»; 

– второй уровень толщиной 10 мм ( муэh ) для крепления СВЧ-разъемов и 

контуром, который в сечении представляет собой два одинаковых прямо-

угольника за пределами контура первого уровня около входа и выхода изде-

лия с длиной, равной ширине «экрана». 

Такая двухуровневая структура позволяет снимать «экран» для настрой-

ки «усилителя» без извлечения СВЧ-разъемов, при этом ПП «усилителя» 

остается прикрепленной к «основанию». 

На рис. 15.11 показаны некоторые возможные формы «основания» из 

вариантов задания. 

 

Для создания 3D-модели «основания» выполнить следующие действия: 

1. В КОМПАС-3D командой Файл ⇒ Открыть открыть 3D-модель 

«модуля усилителя», если она была закрыта. 

2. Убедиться в том, что в Дереве модели отжата пиктограмма Отобра-

жение структуры модели (см. рис. 13.23). 

3. Если какая-нибудь 3D-модель была скрыта, то в Дереве модели вы-

полнить на ней команду ПКМ ⇒ Показать. 

Рис. 15.1 
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4. В составе сборки создать деталь, которая станет в дальнейшем 3D-мо-

делью «основания», для чего выполнить следующее: 

– СКМ повернуть «модуль усилителя» в рабочем поле так, чтобы была 

видна поверхность ПП «усилителя» без компонентов, после чего выбрать ее, 

щелкнув ЛКМ (рис. 15.2); 

 

– запустить команду Создать деталь (см. рис. 13.21) на ПИ Компакт-

ная панель ⇒ Редактирование сборки; 

– в открывшемся окне указать путь и имя создаваемого файла с обозна-

чением и наименованием согласно информации из табл. 2.1, а также выбрать 

расширение «.m3d». Имя файла в варианте «П1» – «УП1.00.02 - Основание», 

а путь сохранения – …\ИДРЭС-П1\_Модели (см. рис. 2.7). 

5. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). Также проверить, 

что на ПИ Режимы отключена пиктограмма Перспектива (см. рис. 14.1). 

Результат в варианте «П1» на данном этапе показан на рис. 15.3. 

 

6. Запустить команду Спроецировать объект из ПИ Компактная па-

нель ⇒ Геометрия (рис. 15.4, а), после чего по одному разу щелкнуть ЛКМ 

по каждому ребру ПП (рис. 15.4, б). 

Рис. 15.2 

Рис. 15.3 
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Результат в варианте «П1» на данном этапе с включенным отображени-

ем ограничений (голубые перечеркнутые точки) показан на рис. 15.5. 

 

Примечание. При выполнении указанной команды на созданные в эскизе 

проекции автоматически накладывается параметрическая связь – проекци-

онная связь. Это означает, что созданные в эскизе проекции ассоциативно 

связаны со своими исходными объектами, т. е. в данном случае при измене-

нии контура ПП в ее 3D-модели произойдет автоматическое перестроение 

данного эскиза. 

Также стоит отметить следующее: 

– в настройках профиля, загруженного в 6.2, параметрический режим 

по умолчанию отключен, но он будет использоваться в чертежах при про-

становке размеров и различных объектов на ассо-

циативных видах; 

– отобразить и скрыть наложенные ограни-

чения позволяет команда «Отображать ограни-

чения» (рис. 15.6) из ПИ Компактная панель ⇒ 

Параметризация; 

– удалить наложенные ограничения для выделенных объектов позволя-

ет пиктограмма «Удалить все ограничения» из этой же ПИ (рис. 15.6). 

Рис. 15.5 

Рис. 15.4 

Спроецировать 

объект 

а б 

Рис. 15.6 

Удалить все 

ограничения 

Отображать 

ограничения 
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7. По пп. 32.3 и 32.4 из разд. 14 добавить окружности диаметром 2.05 мм 

в центры всех крепежных отверстий на ПП. 

Примечание. Указанное значение выбрано согласно ГОСТ 19257–73 [67] 

для отверстий под резьбу М2,5. 

8. Выйти из режима редактирования эскиза (Эскиз:1), после чего в Де-

реве модели на нем запустить команду Операция выдавливания. 

На Панели свойств задать направление выдавливания в сторону от ПП 

на расстояние 3 мм и нажать пиктограмму Создать объект. 

9. Сохранить изменения (Ctrl+S) и осу-

ществить проверку по п. 12 из 6.5. 

10. На нижней поверхности «основания» 

(рис. 15.7), не выходя из режима контекстного 

редактирования детали, создать новый эскиз 

(Эскиз:2). 

11. Выполнить команду Вид ⇒ Отобра-

жение ⇒ Каркас или нажать соответствую-

щую пиктограмму на ПИ Вид (см. рис. 14.12). 

12. В Дереве модели щелкнуть ЛКМ на «экране», в результате чего его 

внешний контур подсветится зеленым цветом. 

13. Командой Прямоугольник (ПИ Компактная панель ⇒ Геометрия) 

нарисовать контур сечения второго уровня «основания», состоящий из двух 

одинаковых прямоугольников, с учетом следующих требований: 

 Рис. 15.8 

Рис. 15.7 
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– они должны размещаться снаружи контура ПП «усилителя»; 

– длинной стороной они должны касаться контура ПП «усилителя» и по 

положению совпадать с «экраном» со стороны входа или выхода устройства; 

– их длина должна равняться ширине «экрана», а ширина – 4,5 мм. 

Результат в варианте «П1» на данном этапе показан на рис. 15.8. 

14. Выполнить команду Вид ⇒ Отображение ⇒ Полутоновое с карка-

сом или нажать соответствующую пиктограмму на ПИ Вид (см. рис. 14.12). 

15. Выйти из режима редактирования эскиза (Эскиз:2), после чего в Де-

реве модели на нем запустить команду Операция выдавливания. 

На Панели свойств задать направление выдавливания в сторону к ПП 

на расстояние 10 мм и нажать пиктограмму Создать объект. 

16. Запустить команду Условное изобра-

жение резьбы из ПИ Компактная панель ⇒ 

Элементы оформления (рис. 15.9). 

В Панели свойств на вкладке Параметры 

выполнить следующее: 

– убедиться в том, что в поле Выберите стандарт резьбы выбрана оп-

ция Метрическая резьба с крупным шагом ГОСТ 8724-2002; 

– включить опцию До конечной границы; 

– отключить опцию Подгонка. 

Затем отдельно для каждого отверстия в «основании» ЛКМ указать его 

внутреннюю поверхность и нажать комбинацию клавиш Ctrl+Enter. 

Завершить команду клавишей Esc. 

Примечание. При добавлении каждого условного изображения резьбы в 

«Панели свойств» будут отображаться номинальный диаметр резьбы 2.5 и 

шаг резьбы 0.45. 

17. В Дереве модели по п. 33 из разд. 14 указать обозначение и наиме-

нование 3D-модели «основания» согласно информации из табл. 2.1, а также в 

соответствии с общим заданием на проектирование задать материал Д16 

ГОСТ 4784–97. 

Примечание. В варианте «П1» записано «УП1.00.02» и «Основание». 

Результат в варианте «П1» на данном этапе показан на рис. 15.10. 

18. В боковых выступах «основания» добавить отверстия для установки 

СВЧ-разъемов, для чего проделать следующее: 

18.1. Выйти из режима контекстного редактирования «основания» и со-

хранить изменения (Ctrl+S). 

Рис. 15.9 

Условное изображение 

резьбы 

ПИ Элементы  

оформления 
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18.2. Скрыть «экран». 

18.3. Зафиксировать «основание». 

18.4. Скрыть условное изображение резьбы командой Вид ⇒ Скрыть в 

компонентах ⇒ Условные изображения резьбы. 

18.5. Запустить команду Добавить из файла (см. рис. 13.9) на ПИ Ком-

пактная панель ⇒ Редактирование сборки и выбрать 3D-модель SMA-

KFD5A.m3d из папки …\ИДРЭС\Модели элементов. 

Затем проделать следующее: 

– около любого бокового выступа 

«основания» мышкой обозначить поло-

жение СВЧ-разъема (рис. 15.11), при 

необходимости повернув «модуль уси-

лителя» зажатой СКМ; 

– щелкнуть ЛКМ для добавления 

СВЧ-разъема; 

– завершить команду пиктограммой 

Создать объект на Панели свойств. 

18.6. Скорректировать положение и ориентацию СВЧ-разъема в рабочем 

поле так, чтобы он находился в непосредственной близости от боковой стен-

ки того выступа «основания», на которую будет установлен, а его централь-

ная жила была направлена в сторону ПП 

«усилителя». 

Перемещение и поворот 3D-модели в 

рабочем поле осуществляется соответствен-

но командами Переместить компонент и Повернуть компонент с ПИ 

Компактная панель ⇒ Редактирование сборки (рис. 15.12). 

Рис. 15.10 

Рис. 15.12 

Повернуть компонент 

Переместить компонент 

Рис. 15.11 
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Результат в варианте «П1» на данном этапе показан на рис. 15.13. 

 

Примечания: 

– перемещение и поворот 3D-модели возможны, если она не зафиксиро-

вана, или этому не препятствуют наложенные сопряжения; 

– указанные выше команды не следует путать с командами Вид ⇒ 

Сдвинуть и Вид ⇒ Повернуть (см. пп. 7.4 и 18.2 из 6.5), с помощью которых 

перемещается и поворачивается система координат со всеми объектами. 

18.7. Основными командами при создании 

сборок являются команды из ПИ Компактная 

панель ⇒ Сопряжения (рис. 15.14). 

Сопряжение – это параметрическая связь 

между гранями, ребрами или вершинами раз-

ных незафиксированных компонентов сборки 

(например, параллельность граней, совпадение 

вершин и т. д.). 

Запустить команду Параллельность и в 

рабочем поле щелчками ЛКМ последовательно 

указать две грани: на боковой части фланца 

СВЧ-разъема и на верхней стороне выступа 

«основания» (рис. 15.15). 

18.8. Запустить команду Совпадение объ-

ектов (рис. 15.14) и в рабочем поле щелчками 

ЛКМ последовательно указать две грани: на 

фланце СВЧ-разъема со стороны центральной 

Рис. 15.13 

Рис. 15.14 

Рис. 15.15 

Параллельность 

На расстоянии 

Касание 

Соосность 

Совпадение объектов 

Перпендикулярность 
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жилы (рис. 15.16, а) и на боковой поверхности выступа «основания», на ко-

торую будет установлен фланец (рис. 15.16, б). 

 

18.9. Скорректировать положение СВЧ-разъема командой Переместить 

компонент (см. рис. 15.12) так, чтобы его центральная жила расположилась 

над средней КП на входе или выходе ПП «усилителя» (в зависимости от вы-

ступа «основания», на который устанавливается СВЧ-разъем). 

Расположение СВЧ-разъема на данном этапе показано на рис. 15.17. 

 

18.10. Запустить команду Касание (см. рис. 15.14) и в рабочем поле 

щелчками ЛКМ указать два объекта: цилиндрическую поверхность цен-

тральной жилы СВЧ-разъема и верхнюю поверхность ПП (рис. 15.18, а). 

18.11. Запустить команду На расстоянии (см. рис. 15.14) и в рабочем 

поле щелчками ЛКМ указать два объекта: цилиндрическую поверхность цен-

тральной жилы СВЧ-разъема и боковую грань средней КП. 

Рис. 15.16 

а б 

Рис. 15.17 

Крепежные отверстия СВЧ-разъема 

Фланец 

СВЧ-разъема 

Средняя КП на входе 

ПП «усилителя» 

Центральная жила СВЧ-разъема Боковая поверхность 

выступа «основания» 
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Затем в Панели свойств на вкладке Параметры в поле Расстояние 

ввести 0.05 и выбрать такое направление действия команды, чтобы жила сме-

стилась в середину средней КП (рис. 15.18, б). 

Завершить команду последовательным нажатием пиктограмм Создать 

объект и Прервать команду. 

Примечания: 

– было задано расстояние 0,05 мм, так как ширина КП составляет 

1,5 мм, а диаметр центральной жилы – 1,4 мм; 

– в результате СВЧ-разъем отцентрирован относительно средней КП, 

располагается фланцем на боковой поверхности выступа «основания», цен-

тральной жилой касается поверхности ПП, а центры крепежных отвер-

стий на его фланце находятся на одной горизонтальной прямой; 

– центральная жила СВЧ-разъема касается поверхности ПП, а не по-

верхности КП, так как КП является участком металлизации, который уже 

учтен в толщине ПП при расчете по (13.1). Сами же 3D-модели КП после 

позиционирования СВЧ-разъемов будут исключены из расчета. 

18.12. Войти в режим контекстного редактирования «основания». 

Для этого в Дереве модели на требуемой 3D-

модели выполнить команду ПКМ ⇒ Редактиро-

вать на месте. 

Примечание. Команду также можно запу-

стить или из меню, которое появляется над кур-

сором мышки в «Дереве модели» (рис. 15.19), или 

из ПИ «Текущее состояние» (см. рис. 13.25). 

18.13. На боковой поверхности выступа «основания», на которую был 

установлен СВЧ-разъем, создать новый эскиз (Эскиз:3). 

Рис. 15.18 

а б 

Боковая грань 

средней КП 

Рис. 15.19 
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18.14. В созданном эскизе с использованием локальной привязки Центр 

(см. п. 32.4 из разд. 14) добавить следующие окружности: 

– две окружности диаметром 1.6 мм в центрах крепежных отверстий на 

фланце разъема; 

– одну окружность диаметром 4.5 мм в центре СВЧ-разъема. 

Примечание. Значение 1,6 мм выбрано по ГОСТ 19257–73 для диаметра 

отверстия под резьбу М2. 

Результат в варианте «П1» на данном этапе показан на рис. 15.20. 

 

18.15. Выйти из режима редактирования эскиза (Эскиз:3), после чего в 

Дереве модели на нем запустить команду Вырезать выдавливанием. 

На Панели свойств задать направление вырезания внутрь «основания» 

в режиме На расстояние на величину 

4,5 мм и нажать пиктограмму Создать 

объект. 

18.16. В вариантах задания с па-

раллельными боковыми выступами 

«основания» отверстия на втором бо-

ковом выступе получить следующим 

образом: 

– запустить команду Средняя 

плоскость (см. рис. 6.34, а) из группы 

«Смещенная плоскость» из ПИ Ком-

пактная панель ⇒ Вспомогательная геометрия и в рабочем поле щелчка-

ми ЛКМ указать боковые поверхности выступов «основания» (рис. 15.21); 

Рис. 15.20 

Окружность 

диаметром 

4,5 мм 

Окружности 

диаметром 

1,6 мм 

Рис. 15.21 

Фантом средней 

плоскости 
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– завершить команду клавишей Esc; 

– запустить команду Зеркальный массив (см. рис. 6.39) из ПИ Ком-

пактная панель ⇒ Массивы; 

– в Панели свойств на вкладке Выбор объектов выбрать в группе Тип 

объектов опцию Операции; 

– в Дереве модели выбрать ЛКМ последний элемент вырезания, в ре-

зультате чего он добавится в Список объектов на Панели свойств, а в рабо-

чем поле окрасится в красный цвет;  

– в Панели свойств включить пиктограмму Плоскость симметрии; 

– в Дереве модели выбрать ЛКМ последнюю созданную плоскость; 

– в Панели свойств нажать пиктограмму Создать объект. 

18.17. В вариантах задания с перпендикулярными боковыми выступами 

«основания» проделать следующие действия: 

– выйти из режима контекстного редактирования «основания»; 

– выполнить пп. 18.5–18.15 на втором боковом выступе «основания». 

18.18. Показать условное изображение резьбы командой Вид ⇒ Скрыть 

в компонентах ⇒ Условные изображения резьбы. 

18.19. Для отверстий диаметром 1,6 мм, расположенных на боковых вы-

ступах «основания», по п. 16 добавить условное изображение резьбы. 

Примечание. В «Панели свойств» при этом будут отображаться но-

минальный диаметр резьбы 2 и шаг резьбы 0.4. 

Результат в варианте «П1» на данном этапе показан на рис. 15.22. 

 Рис. 15.22 
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19. Выйти из режима контекстного редактирования «основания» и со-

хранить изменения (Ctrl+S). 

20. В вариантах задания с параллельными боковыми выступами «осно-

вания» выполнить следующие действия: 

– добавить 3D-модель СВЧ-разъема у второго бокового выступа «осно-

вания» по пп. 18.5 и 18.6; 

– установить сопряжения Параллельность и Совпадение объектов по 

пп. 18.7 и 18.8; 

– запустить команду Соосность (см. рис. 15.14) и в рабочем поле щелч-

ками ЛКМ последовательно указать две 

цилиндрические поверхности: в крепеж-

ном отверстии на фланце СВЧ-разъема и 

в соответствующем крепежном отвер-

стии на боковой стенке «основания» 

(рис. 15.23); 

– завершить команду клавишей Esc. 

21. В Дереве модели нажать пиктограмму Отображение структуры 

модели (см. рис. 13.23) и зафиксировать СВЧ-разъемы. 

22. В Дереве модели в «усилителе» раскрыть группу Компоненты, 

найти группу КП (PAD_r150_300) и исключить их из расчета. 

Для этого выполнить на ней команду ПКМ ⇒ Исключить из расчета. 

23. Сохранить изменения (Ctrl+S). 

 

Результат создания 3D-модели «основания» в варианте «П1» со скры-

тыми «усилителем», «экраном» и СВЧ-разъемами показан на рис. 15.24. 

3D-модель «основания» будет доработана в разд. 16. 

Требования к содержанию отчета по данному этапу приведены в 16.2. 

 

Рис. 15.24 

Рис. 15.23 
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16. 3D-МОДЕЛЬ «МОДУЛЯ УСИЛИТЕЛЯ» 

16.1. Создание 3D-модели «модуля усилителя» 

Фактически разработка 3D-модели «модуля усилителя» выполняется с 

этапа создания 3D-модели «экрана» (см. разд. 14). На данном этапе будут 

произведены завершающие действия, такие как корректировка 3D-моделей 

«экрана» и «основания», проверка пересечений 3D-моделей, добавление кре-

пежных деталей и размещение на поверхностях ПП рисунков с информацией 

слоев из файла трассировки. 

Последовательность действий: 

1. В КОМПАС-3D командой Файл ⇒ Открыть открыть 3D-модель 

«модуля усилителя», если она была закрыта. 

2. Убедиться в том, что в Дереве модели отжата пиктограмма Отобра-

жение структуры модели (см. рис. 13.23). 

3. В Дереве модели изменить види-

мость составных частей: 

– включить видимость «усилителя», 

«экрана» и СВЧ-разъемов; 

– скрыть «основание» и ПП из соста-

ва «усилителя». 

По рис. 16.1 видно, что центральная 

жила СВЧ-разъема и корпус конденсатора 

находятся в «экране», поэтому необходи-

мо увеличить размер прорезей в его толстых стенках. 

4. Войти в режим контекстного редактирования «экрана». 

5. В Дереве модели найти операцию, отвечающую за создание прорезей 

в толстых стенках «экрана» (рис. 16.2). 

 Рис. 16.2 

Рис. 16.1 



 

 456 

После этого войти в режим редактирования операции и задать глубину 

вырезания 3 мм. 

6. На верхней поверхности «экрана», не выходя из режима контекстного 

редактирования детали, создать новый эскиз (Эскиз:6). 

7. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). Также проверить, 

что на ПИ Режимы отключена пиктограмма Перспектива (см. рис. 14.1). 

8. Командой Ввод текста (см. рис. 6.41) из ПИ Компактная панель ⇒ 

Обозначения добавить три надписи: 

– ВХОД – около входного разъема; 

– ВЫХОД – около выходного разъема; 

– номер варианта (в варианте «П1» – П1) – в центре «экрана». 

После этого завершить команду клавишей Esc. 

9. Выделить добавленные надписи и 

запустить команду ПКМ ⇒ Свойства. В 

появившемся окне Свойства задать сле-

дующие настройки (рис. 16.3): 

– в поле Шрифт – GOST 26.008–85; 

– в поле Высота символов – 3; 

– в полях Курсив, Полужирный, 

Подчеркнутый – Нет. 

При отсутствии указанного шрифта в 

системе необходимо установить файл 

шрифта GOST_PR3.ttf из папки …\ИДРЭС\Шрифты (см. рис. 2.9), для чего 

выполнить на нем команду ПКМ ⇒ Установить. 

10. Снять выделение с надписей, щелкнув ЛКМ в любом свободном ме-

сте рабочего поля, и отдельно для каждой надписи в окне Свойства в поле 

Размещение текста установить следующие опции: 

– для надписи ВХОД – Справа; 

– для номера варианта – По центру; 

– для надписи ВЫХОД – Слева или По центру (в зависимости от фор-

мы «экрана»). 

После этого закрыть окно Свойства. 

11. В рабочем поле передвинуть надписи за характерные точки, отме-

ченные черными квадратами, так, чтобы они оказались в сетке. 

Результат в варианте «П1» на данном этапе показан на рис. 16.4. 

Рис. 16.3 
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12. Выйти из режима редактирования эскиза (Эскиз:6), после чего в Де-

реве модели на нем запустить команду Вырезать выдавливанием. 

На Панели свойств задать направление вырезания внутрь «экрана» на 

расстояние 0.2 мм и нажать пиктограмму Создать объект. 

Примечание. Впоследствии в ТТ чертежа «экрана» будет дано указание 

выполнить эти надписи методом гравирования с заполнением черной крас-

кой. Заданные параметры шрифта соответствуют требованиям ГОСТ 

26.008–85 [68] для шрифта приборной гарнитуры начертания Пр3 (прямого 

нормального полужирного) по ГОСТ 26.020–80 [69]. 

13. Выйти из режима контекстного редактирования «экрана» и сохра-

нить изменения (Ctrl+S). 

14. В Дереве модели включить видимость «основания» и ПП из состава 

«усилителя». 

15. Войти в режим редактирования «экрана» в отдельном окне. 

Для этого в Дереве модели на требуемой 3D-модели выполнить коман-

ду ПКМ ⇒ Редактировать в окне. 

16. В появившейся вкладке с «экраном» в Дереве модели выполнить 

следующие действия: 

– скрыть Начало координат; 

Рис. 16.4 
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– в свойствах «экрана» установить цвет Серый 25% (рис. 16.5); 

– в свойствах последней операции, предназначенной для вырезания 

надписей, установить цвет Серый 80%. 

 

Отредактированная 3D-модель «экрана» в варианте «П1» показана на 

рис. 16.6. 

 

17. Закрыть вкладку с «экраном» с сохранением изменений. 

18. Запустить команду Сервис ⇒ Проверка пересечений и проверить 

отсутствие пересечений между компонентами: 

18.1. На Панели свойств в окно Список объектов добавить все компо-

ненты сборки, для чего в Дереве модели выполнить следующее: 

– раскрыть группу «усилителя», выбрать ЛКМ первый его компонент, 

сместить ползунок вниз, зажать клавишу Shift и выбрать ЛКМ последний его 

компонент; 

– зажать клавишу Ctrl и поочередно ЛКМ выбрать «экран», «основание» 

и два СВЧ-разъема. 

Примечание. Выбранные объекты подсвечиваются в рабочем поле и 

«Дереве модели» красным цветом. 

Рис. 16.5 

Рис. 16.6 
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18.2. На Панели свойств отключить опцию Считать касания пересе-

чениями и нажать пиктограмму Проверить пересечения. 

18.3. В результате выполнения команды обнаруженные пересечения по-

явятся в соответствующем окне на Панели свойств, а в рабочем поле выде-

лятся голубым цветом. 

Например, в варианте «П1» компоненты со штыревыми выводами (разъ-

ем питания, защитный диод и разъем управления) пересекаются с «основани-

ем» (рис. 16.7). 

 

После этого завершить команду кла-

вишей Esc. 

19. Устранить обнаруженные пересе-

чения, отредактировав 2D-модели «осно-

вания» и (или) «экрана». 

В варианте «П1» для этого потребо-

валось сделать следующее: 

19.1. Войти в режим контекстного ре-

дактирования «основания» и создать но-

вый эскиз (Эскиз:4) на его нижней поверхности (рис. 16.8). 

19.2. Выполнить команду Вид ⇒ Отображение ⇒ Каркас или нажать 

соответствующую пиктограмму на ПИ Вид (см. рис. 14.12). 

19.3. Нарисовать контуры прорезей для компонентов со штыревыми вы-

водами, при этом прорези должны удовлетворять следующим требованиям: 

Рис. 16.7 

Рис. 16.8 
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– радиусы скруглений должны быть не меньше 1,5 мм; 

– в прорези должны свободно входить соответствующие выводы; 

– должен быть оставлен зазор (0,5–1 мм) от контура прорези до границ 

КП из файла трассировки, которые предназначены для монтажа этих выводов 

и не соединены с цепью GND (см. рис. 12.141). 

Так, в варианте «П1» использованы следующие шаблоны КП: 

– в разъеме управления и диоде – c180h120 и s180h120r1; 

– в разъеме питания – c140h80 и s140h80r1. 

Содержание эскиза в варианте «П1» с видимым шагом сетки 0,5 мм по-

казано на рис. 16.9.  

 

Примечания: 

– КП в файле трассировки выбираются с зажатой клавишей Shift; 

– расшифровка обозначений КП приведена на рис. Г.48; 

– на рис. 16.9 прорези сложной формы были нарисованы командой «От-

резок» с временным включением режима «Ортогональное черчение» зажа-

той клавишей Shift с последующим скруглением углов командой «Скругление» 

с радиусом 1,5 мм. Третий контур нарисован командой «Окружность». 

19.4. Выполнить команду Вид ⇒ Отображение ⇒ Полутоновое с кар-

касом или нажать соответствующую пиктограмму на ПИ Вид. 

19.5. Выйти из режима редактирования эскиза (Эскиз:4), после чего в 

Дереве модели на нем запустить команду Вырезать выдавливанием. 

На Панели свойств задать направление вырезания внутрь «основания» 

на расстояние 3 мм и нажать пиктограмму Создать объект. 

При появлении ошибки проверить эскиз по пп. 8.1 и 8.2 из 6.5. 

Результат в варианте «П1» на данном этапе показан на рис. 16.10. 

Рис. 16.9 

Корпус разъема 

питания 

Корпус  

защитного диода 

Корпус разъема 

управления 
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19.6. Выйти из режима контекстного редактирования «основания» и со-

хранить изменения (Ctrl+S). 

20. Выполнить еще раз проверку пересечений по п. 18 и при их обнару-

жении произвести соответствующие корректировки. 

21. Войти в режим редактирования «основания» в отдельном окне. 

22. В появившейся вкладке с «основанием» в Дереве модели выполнить 

следующие действия: 

– скрыть Начало координат и видимые вспомогательные плоскости; 

– в свойствах «основания» установить цвет Серый 25%. 

Отредактированная 3D-модель «основания» в варианте «П1» показана 

на рис. 16.11. 

 

23. Закрыть вкладку с «основанием» с сохранением изменений. 

Рис. 16.11 

Рис. 16.10 
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24. Добавить крепежные изделия. 

Так как добавление крепежа однотипно, то в качестве примера далее 

приведены действия по установке только винта ГОСТ 17475-80 с потайной 

головкой и прямым шлицем класса точности А длиной 9 мм и резьбой М2,5 

для крепления «экрана»: 

24.1. Запустить команду Библиотеки ⇒ Стандартные изделия ⇒ Вста-

вить элемент, в открывшемся окне Библиотека Стандартные Изделия вы-

полнить команду Сервис ⇒ Найти и задать следующие настройки: 

– в группе Тип поиска выбрать опцию По названию; 

– в поле Область поиска выбрать Все папки; 

– в поле Строка поиска вести 17475-80 и нажать кнопку Начать поиск. 

Результаты поиска показаны на рис. 16.12. Представление их в виде таб-

лицы включается командой Вид ⇒ Вид отображения ⇒ Таблица. 

 

24.2. В найденных изделиях дважды щелкнуть ЛКМ по варианту Винт 

ГОСТ 17475-80 (исп 1 А). 

24.3. На вкладке Все размеры выполнить следующее (рис. 16.13): 

– дважды щелкнуть ЛКМ по любой строке в группе Конструкция и 

размеры; 

– в открывшемся окне Выбор типоразмеров и параметров в столбце 

Диаметр резьбы выбрать 2,5, а в столбце Длина винта – 9 (доступный шаг 

резьбы при этом установится автоматически); 

– закрыть окно Выбор типоразмеров и параметров кнопкой OK; 

– дважды щелкнуть ЛКМ по любой строке в группе Покрытия; 

Рис. 16.12 
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– в открывшемся окне Выбор типоразмеров и параметров в столбце 

Толщина покрытия выбрать – 6, а в столбце Вид покрытия – цинковое, 

хроматированное; 

– закрыть окно Выбор типоразмеров и параметров кнопкой OK. 

 

Примечание. Покрытие необходимо для предотвращения контактной 

коррозии между металлами по ГОСТ 9.005–72 [70]: сталь (материал винта) 

и дюраль (материал «основания» и «экрана»). Толщина покрытия в микронах 

выбрана по ГОСТ 9.303–84 [71] для климатического исполнения УХЛ (с уме-

ренным и холодным климатом) по ГОСТ 15150–69 [72]. 

24.4. В окне Библиотека Стандартные Изделия нажать Применить и 

в появившемся окне нажать Да. 

24.5. На Панели свойств включить опцию Задать совпадение по кону-

су (рис. 16.14) и отключить опцию Создавать объект спецификации. 

 

24.6. В рабочем поле ЛКМ указать коническую 

поверхность, которой является фаска в отверстиях 

«экрана» (рис. 16.15). 

Если положение фантома винта показано непра-

вильно, то на Панели свойств выбрать направление 

установки: прямое или обратное. 

Для установки винта нажать комбинацию клавиш Ctrl+Enter. 

Рис. 16.14 

Рис. 16.13 

Рис. 16.15 
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25. После установки крепежного изделия система переходит в режим 

добавления следующей аналогичной детали. 

Установить оставшиеся винты ГОСТ 17475-80 (исп 1 А) с резьбой М2,5 

и длиной 9 мм для крепления «экрана» (аналоги – DIN 963, ISO 2009). 

Для завершения установки винтов нажать клавишу Esc. 

Примечание. Аналоги – стандарты DIN (Deutsches Institut für Normung – 

Немецкий институт по стандартизации) и ISO (International Organization 

for Standardization – Международная организация по стандартизации). 

26. В соответствии с п. 24 добавить шайбы диаметром 2,5 мм по ГОСТ 

10450-78 (класс C) для установки на ПП в области, где нет «экрана» (анало-

ги – DIN 433, ISO 7092). 

На вкладке Все размеры в группе Материалы в поле Наименование 

выбрать Без указания материала, а в группе Покрытия в поле Вид покры-

тия – Без покрытия. 

При установке в рабочем поле сначала указать ЛКМ поверхность, на ко-

торой будет лежать шайба (рис. 16.16, а), а затем цилиндрическую поверх-

ность отверстия, с которой она будет соосна (рис. 16.16, б). Фантом установ-

ленной шайбы показан на рис. 16.16, в. 

 

Примечание. Основные назначения плоских шайб: 

– создание большей площади опорной поверхности; 

– предохранение поверхности скрепляемых деталей (в данном случае – 

ПП) от повреждений при закручивании крепежных изделий. 

27. В соответствии с п. 24 добавить: 

– винты М2,5 длиной 3 мм ГОСТ 1491-80 (класс А) для крепления ПП 

«усилителя» (аналоги – DIN 84, ISO 1207); 

– винты М2 длиной 4 мм ГОСТ 1491-80 (класс А) для крепления 

СВЧ-разъемов (аналоги – DIN 84, ISO 1207). 

Настройки в группах Конструкция и размеры +Материалы и Покры-

тия аналогичны показанным на рис. 16.13. 

Последовательность установки винтов аналогична установке шайб. 

Рис. 16.16 

а б в 
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После завершения установки всех необходимых крепежных изделий за-

крыть окно Библиотека Стандартные Изделия кнопкой Отмена. 

28. Скрыть условное изображение резьбы командой Вид ⇒ Скрыть в 

компонентах ⇒ Условные изображения резьбы. 

29. В Дереве модели нажать пиктограмму Отображение структуры 

модели (см. рис. 13.23) и зафиксировать все крепежные изделия. 

Сохранить изменения в 3D-модели «модуля усилителя» (Ctrl+S). 

Результат в варианте «П1» на данном этапе показан на рис. 16.17. 

 

30. Для придания 3D-модели реалистичности создать рисунки (тексту-

ры) с видом на верхнюю и нижнюю стороны ПП: 

30.1. В Altium Designer получить изображение верхней стороны ПП: 

– если проект ПП был закрыт, то открыть его по п. 1 из 12.1; 

– если файл трассировки был закрыт, то открыть его по п. 3 из 8.3; 

– перейти в 3D-режим просмотра (клавиша 3); 

– нажать клавишу 0 для установки исходной орентации 3D-модели; 

– нажать клавишу L и в открывшемся окне View Configurations на 

вкладке Physical Materials в группе General отключить опцию Show Origin 

Marker (отображение начала координат) и в списке Projection выбрать оп-

цию Orthographic; 

– в окне View Configurations в группе 3D Bodies в списке Show Generic 

Models выбрать опцию No, после чего применить изменения кнопкой OK; 

Рис. 16.17 

Винт М2,5×9 

ГОСТ 17475-80  

Винт М2×4 

ГОСТ 1491-80  

Винт М2,5×3 

ГОСТ 1491-80  

Шайба 2,5  

ГОСТ 10450-78 
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– отключить информационное поле комбинацией клавиш Shift+H; 

– развернуть окно Altium Designer на полный экран; 

– выполнить команду View ⇒ Fit Board, после чего зажать клавишу Ctrl 

и уменьшить масштаб на один шаг при повороте колесика мышки; 

– переместить курсор мышки в любое место рабочего поля, находящееся 

за пределами ПП; 

– нажать комбинацию клавиш Ctrl+C; 

– в появившемся окне 3D Snapshot Resolution выбрать опцию 300 DPI и 

запустить процесс копирования кнопкой OK. 

Примечание. DPI (Dots Per Inch) – разрешающая способность, опреде-

ляемая количеством точек на дюйм. 

30.2. Открыть редактор изображений Paint.NET и получить рисунок 

верхней стороны ПП: 

– выполнить команду Правка ⇒ Вставить как новое изображение 

(или нажать комбинацию клавиш Ctrl+Alt+V); 

– визуально проверить изображение. При наличии дефектов у объектов 

из слоя шелкографии перезапустить Altium Designer и выполнить п. 30.1 за-

ново. Если проблема не решается, то получить изображение из Altium De-

signer клавишей Prt Sc или с помощью приложения Ножницы; 

– в группе команд Инструмент выбрать команду Выбор прямоуголь-

ной области (рис. 16.18) или нажать клавишу S; 

 

– в рабочем поле нарисовать прямоугольную область, примерно охваты-

вающую контур ПП; 

– в группе команд Инструмент выбрать команду Перемещение обла-

сти выделения (рис. 16.18) или дважды нажать клавишу M до появления со-

ответствующей пиктограммы команды в этой группе; 

Рис. 16.18 
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– в рабочем поле скорректировать положение углов и (или) сторон пря-

моугольной области так, чтобы она проходила точно по контуру ПП. 

Примечания: 

– в вариантах задания с угловой формой ПП внутри прямоугольной об-

ласти также попадет участок, в котором ПП нет; 

– редактирование области осуществляется за характерные точки, при 

этом вид курсора мышки меняется со стрелки на руку; 

– выполнить команду Изображение ⇒ Обрезать по выделению (или 

нажать комбинацию клавиш Ctrl+Shift+X); 

– сохранить рисунок командой Файл ⇒ Сохранить как с расширением 

«.png» и именем Top. Путь сохранения в варианте «П1» – …\ИДРЭС-П1\ 

_Модели;  

– после нажатия кнопки Сохранить в появившемся окне Параметры 

сохранения оставить настройки по умолчанию (Автоопределение). 

30.3. В Altium Designer получить изображение нижней стороны ПП: 

– если изменялись размеры окна, то развернуть его на полный экран; 

– нажать клавишу 0 для установки исходной ориентации 3D-модели; 

– последовательно нажать клавиши V ⇒ B (или выполнить команду 

View ⇒ Flip Board); 

– зажатой ПКМ переместить изображение ПП в центр экрана; 

– если изменялись размеры изображения, то выполнить команду View ⇒ 

Fit Board, после чего зажать клавишу Ctrl и уменьшить масштаб на один 

шаг при повороте колесика мышки; 

– переместить курсор мышки в любое место рабочего поля, находящееся 

за пределами ПП; 

– нажать комбинацию клавиш Ctrl+C и запустить процесс копирования 

изображения в буфер обмена с опцией 300 DPI. 

30.4. В Paint.NET выполнить п. 30.2 и сохранить рисунок нижней сто-

роны ПП с именем Bottom. 

Затем выполнить команду Изображение ⇒ Перевернуть горизонталь-

но и сохранить полученное изображение с расширением «.png» и именем 

BottomMirror в ту же папку (оно понадобится в разд. 24). 

30.5. Закрыть редактор Paint.NET. 

30.6. В Altium Designer включить информационное поле (Shift+H) и за-

крыть файл трассировки без сохранения изменений. 

Текстуры Top и Bottom из варианта «П1» показаны на рис. 16.19. 
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Примечание. В отличие от других вариантов задания в варианте «П1» 

для уменьшения стоимости изготовления опытного образца шелкография не 

использовалась (см. прил. А). Поэтому перед созданием изображения верхней 

стороны ПП в окне View Configurations в группе Colors and Visibility была 

отключена видимость слоя Top Silkscreen.  

31. В КОМПАС-3D в 3D-модели 

«модуля усилителя» на поверхности ПП 

«усилителя» со стороны установки ком-

понентов (рис. 16.20) создать новый эс-

киз (Эскиз:1). 

32. Выполнить команду Вид ⇒ 

Отображение ⇒ Каркас или нажать со-

ответствующую пиктограмму на ПИ Вид. 

33. Добавить текстуру Top: 

– запустить команду Вставка ⇒ Рисунок и открыть текстуру Top; 

– в Панели свойств в поле Способ вставки выбрать опцию Взять в 

документ (рисунок будет храниться внутри документа), вставить текстуру в 

любое место рабочего поля и завершить команду клавишей Esc; 

– щелкнуть ЛКМ по текстуре и запустить команду Сдвиг из ПИ Ком-

пактная панель ⇒ Редактирование (см. рис. 6.20); 

– указать в качестве базовой точки угол контура ПП, в котором в файле 

трассировки располагалась точка начала координат (см. рис. 12.25), переме-

стить текстуру в точку начала координат и завершить команду клавишей Esc; 

– изменить размер текстуры до размеров ПП. Для этого необходимо по-

тянуть за характерную точку, находящуюся на второй по счету стороне при 

Рис. 16.19 

Рис. 16.20 
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обходе контура изображения против часовой стрелки от точки начала коор-

динат. 

Примечания: 

– если начало координат находится в левом нижнем углу, то тянуть 

надо за точку, расположенную на середине правой стороны текстуры; 

– если начало координат находится в левом верхнем углу, то тянуть 

надо за точку, расположенную на середине нижней стороны текстуры. 

Результат в варианте «П1» на данном этапе показан на рис. 16.21. 

 

34. В вариантах задания с угловой формой ПП обрезать текстуру, для 

чего выполнить следующие действия: 

– на ПИ Глобальные привязки оставить включенной только привязку 

Ближайшая точка (см. рис. 6.10); 

– в рабочем поле выбрать текстуру и запу-

стить на ней команду ПКМ ⇒ Обрезать; 

– на Панели свойств нажать пиктограмму 

Ручное рисование границ (рис. 16.22); 

– последовательно указать ЛКМ шесть уг-

лов контура ПП, при этом будет срабатывать привязка Ближайшая точка; 

– если на Панели свойств в окне Координаты вершин значения не 

кратны 0,5 мм, то исправить их в этом же окне; 

– дважды нажать пиктограмму Создать объект и завершить команду 

клавишей Esc; 

– на ПИ Глобальные привязки включить все привязки с рис. 6.10. 

Рис. 16.21 

Рис. 16.22 
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35. Выйти из режима редактирова-

ния эскиза (Эскиз:1). 

36. Выполнить команду Вид ⇒ 

Отображение ⇒ Полутоновое с карка-

сом или нажать соответствующую пик-

тограмму на ПИ Вид. 

37. Скрыть «основание». 

38. На поверхности ПП «усилителя» 

без компонентов (рис. 16.23) создать новый эскиз (Эскиз:2). 

39. Добавить текстуру Bottom по пп. 33 и 34. 

Результат в варианте «П1» на данном этапе показан на рис. 16.24. 

 

40. Выйти из режима редактирования эскиза (Эскиз:2). 

41. В Дереве модели включить видимость «основания». 

 

Рис. 16.24 

Рис. 16.25 

Рис. 16.23 
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42. Визуально проконтролировать отсутствие следующих пересечений: 

– между «экраном» и печатными проводниками на слое Top Layer; 

– между «основанием» и КП на слое Bottom Layer (см. рис. 16.25). 

Устранить все обнаруженные ошибки редактированием соответствую-

щих деталей («экран» и «основание»). 

43. Изменить цвет ПП «усилителя», для чего выполнить следующее: 

– войти в режим редактирования «усилителя» в отдельном окне; 

– в появившейся вкладке с «усилителем» в Дереве модели в свойствах 

ПП установить цвет хаки (195, 177, 141); 

– закрыть вкладку с «усилителем» с сохранением изменений. 

Примечание. В скобках указана кодировка цвета в формате RGB, кото-

рая устанавливается в окне «Цвет», открываемом после нажатия команды 

«Другие цвета» при выборе цвета в «Панели свойств» (рис. 16.5). 

44. Сохранить изменения в 3D-модели «модуля усилителя» (Ctrl+S). 

Результат в варианте «П1» показан на рис. 16.26. 

 

Примечание. При создании рисунка в свойствах «экрана» на «Панели 

свойств» была задана прозрачность 80 %, а после этого она была убрана 

включением опции «По источнику» в группе «Назначить цвет». 

Рис. 16.26 
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45. Удалить вспомогательную информацию: 

– из папки …\ИДРЭС-П1\Усилитель\_Модели – файлы BPF.dxf, 

BPF_fix.dxf и BPF_fix.frw (файлы с информацией о топологии ПФ); 

– из папки …\ИДРЭС-П1\_Модели – файлы Shield.dxf, Shield_fix.dxf и 

Shield_fix.frw (файлы с информацией о контуре «экрана»); 

– все backup-файлы из указанных папок. 

46. При желании выполнить 1-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. Е) вторым способом, т. е. с использованием 3D-модели 

«модуля усилителя», при условии, что указанный этап не был выполнен 

вручную ранее. 

16.2. Содержание отчета 

По 14-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Расчет толщины «экрана» и высоты его внутренней полости. 

2. Рисунки 3D-модели «экрана» с надписями на верхней стороне и отре-

дактированными размерами прорезей в боковых стенках (также должны быть 

видны все контуры внутренней полости). 

По 15-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести рисунок 3D-модели «основания» с прорезями под 

штыревые выводы компонентов и с условными изображениями резьбы. 

По 16-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Рисунок 3D-модели «модуля усилителя» с размещенными на поверх-

ностях ПП рисунками слоев и прозрачным «экраном». 

2. Рисунок 3D-модели «модуля усилителя» снизу, на котором будет ви-

ден нижний слой ПП через прорези «основания» под штыревые выводы ком-

понентов. Для этого следует выбрать ЛКМ нижнюю сторону «основания» и 

выполнить команду ПКМ ⇒ Нормально к. 
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17. ЧЕРТЕЖ ПП 

17.1. Правила выполнения чертежей ПП 

К основным правилам выполнения чертежей ПП и ГПК относятся сле-

дующие: 

1. Чертежи ПП должны быть выполнены в соответствии с требованиями 

ГОСТ 2.417–91 [73] и стандартов ЕСКД. 

2. Чертежи односторонних ПП (ОПП), ДПП и МПП должны иметь 

наименование «Плата печатная». 

3. На МПП выпускается сборочный чертеж. 

ОПП и ДПП считаются деталями, поэтому на них должен быть выпущен 

чертеж детали. 

4. Материалы МПП следует записывать в спецификацию в раздел «Ма-

териалы» с указанием их размеров и количества слоев или в раздел «Детали» 

как детали без чертежа. 

Материалы ОПП и ДПП записывают в основную надпись чертежа в 

графу 3 (см. рис. 3.6, а и табл. 3.1). 

5. На чертеже ПП размеры указываются одним из следующих способов: 

– в соответствии с требованиями ГОСТ 2.307–2011 (см. Д.5); 

– нанесением координатной сетки в прямоугольной системе координат; 

– нанесением координатной сетки в полярной системе координат; 

– комбинированным способом с помощью размерных и выносных линий 

и координатной сетки в прямоугольной или полярной системе координат; 

– в виде таблицы координат элементов проводящего рисунка (проводни-

ков и т. п.). 

По ГОСТ Р 51040–97 [74] координатная сетка – ортогональная сетка 

из двух равноудаленных линий, определяющих места расположения соеди-

нений на ПП. Шаг координатной сетки – расстояние между двумя сосед-

ними параллельными линиями координатной сетки. 

Основным шагом координатной сетки является шаг 0,5 мм (допускаются 

шаги 0,05 мм и 0,625 мм). Также существуют предпочтительные и допусти-

мые шаги координатной сетки. 

6. При автоматизированном и полуавтоматизированном методах кон-

струирования допускается чертежи ПП выпускать без изображения проводя-

щего рисунка, включая в комплект КД документы на носителях данных, 

определяющих конструкцию и способ изготовления ПП. 
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В качестве второго и последующих листов чертежа допускается исполь-

зовать изображения слоев ПП на фотопленке, фотобумаге или других мате-

риалах. 

Документы на носителях данных записывают в спецификацию сбороч-

ной единицы. 

7. Маркировку ПП располагают на любом свободном месте. 

При маркировке способом, которым выполняется проводящий рисунок, 

допускается применять любой шрифт. В этом случае в ТТ чертежа способ 

маркировки не указывают. 

8. Диаметры отверстий, диаметры КП, наличие металлизации в отвер-

стиях и количество отверстий следует объединять в таблицу. 

9. При необходимости изображения проводящего рисунка ПП следует 

пользоваться рекомендациями ГОСТ 2.417–91 и ОСТ4 ГО.010.011 [75]. 

Общие правила выполнения чертежей деталей из-за их большого объема 

приведены в прил. Д. 

17.2. Создание чертежа ПП 

Спроектированная ДПП считается деталью, поэтому на нее необходимо 

разработать чертеж. КД будет создаваться с использованием данных файла 

трассировки из разд. 12 и 3D-модели ПП из 13.1. 

Последовательность действий для создания чертежа ПП: 

1. В КОМПАС-3D командой Файл ⇒ Открыть открыть 3D-модель ПП 

(расположение указано в п. 6 из 13.1). 

2. СКМ повернуть ПП в рабочем поле так, чтобы спереди оказалась по-

верхность, соответствующая слою Top Layer в файле трассировки (см. 

рис. 12.141), после чего щелкнуть по ней ЛКМ и в появившейся над курсо-

ром ПИ нажать пиктограмму Нормально к (рис. 17.1). 

Сохранить ориентацию 3D-моде-

ли, добавив новый вид с помощью 

команды Вид ⇒ Ориентация и при-

своив ему имя (например, Главный). 

Сохранить изменения (Ctrl+S) и 

закрыть вкладку с 3D-моделью. 

3. По информации из 7.1 создать 

новый чертеж и задать следующие 

настройки листа: Рис. 17.1 
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– формат – A3; 

– ориентация – горизонтальная; 

– оформление – Чертеж констр. Первый лист. ГОСТ 2.104-2006. 

4. Сохранить чертеж командой Файл ⇒ Сохранить как с расширением 

«.cdw». Имя файла в варианте «П1» – «УП1.01.02 - Плата печатная - v0.1», 

а путь сохранения – …\ИДРЭС-П1\Усилитель (см. рис. 2.8). 

5. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

6. Запустить команду Стандартные виды (рис. 7.6) из ПИ Компактная 

панель ⇒ Виды и указать путь к 3D-модели ПП. 

В Панели свойств на вкладке Параметры выполнить следующее: 

– в поле Ориентация главного вида выбрать Главный (задан в п. 2); 

– в поле Схема видов указать только вид спереди и вид слева (распо-

ложение видов см. на рис. 7.3); 

– в поле Масштаб вида выбрать масштаб 2,5:1. 

Результат в варианте «П1» с обозначением видов показан на рис. 17.2, а. 

 

7. Выполнить команду Вид ⇒ Дерево чертежа. 

В открывшемся Дереве чертежа для определенности в дальнейших дей-

ствиях выбрать ЛКМ вид Главный 1, нажать клавишу F2 и изменить его 

название на Вид спереди. 

Аналогичным образом изменить название вида Проекционный вид 2 на 

Вид слева (рис. 17.2, б). 

8. Заполнить графы рамки в соответствии с табл. 17.1, при этом обратив 

внимание на следующее: 

– графы рамки заполняются отдельно для основной надписи и дополни-

тельных граф; 

Вид 

спереди 

Вид 

слева 

Рис. 17.2 

а 

б 
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– для перехода в режим редактирования граф рамки необходимо дважды 

щелкнуть по ним ЛКМ (или выполнить команду ПКМ ⇒ Заполнить основ-

ную надпись); 

– для сохранения введенных данных на Панели свойств нажимается 

пиктограмма Создать объект; 

– если производится копирование информации из указанной таблицы, то 

необходимо выбрать шрифт COST type A с начертанием Курсив. 

Пояснения к графам даны в табл. 3.1 и на рис. 3.6. 

Таблица 17.1 

Содержание граф рамки для чертежа ПП 

Номер  

графы 
Содержание Комментарий к заполнению 

1 Плата печатная 

Наименование изделия определено в табл. 2.1 и запи-

сывается автоматически, так как было задано в свой-

ствах 3D-модели. 

Параметры шрифта в Панели свойств на вкладке 

Формат: высота символов – 7, шаг строк – 11 

2 УП1.01.02 

Обозначение документа определено в табл. 2.1, указа-

но для варианта «П1» и записывается автоматически, 

так как было задано в свойствах 3D-модели. 

Данные этой графы повторяются на каждом новом ли-

сте 

3 

Диэлектрик  

фольгированный  

AD1000-0,508-18/18 

«Arlon» 

Обозначение материала указано для варианта «П1». 

Текст записывается вручную вместо автоматически 

добавленного материала по данным варианта индиви-

дуального задания на проектирование и табл. Б.2. 

Параметры шрифта в Панели свойств на вкладке 

Формат: высота символов – 3.5, шаг строк – 5.5 

4 У – 

5 4,6 г 

Заполняется автоматически при выборе в Панели 

свойств на вкладке Параметры в поле Единицы из-

мерения массы опции граммы, а в поле Точность 

представления значения 1 (0 – при отсутствии деся-

тых долей) 

6 2,5:1 
Заполняется автоматически в соответствии с масшта-

бом главного вида  

7 и 8 См. комментарий Заполняются автоматически 

9 СПбГЭТУ «ЛЭТИ» 
Параметры шрифта в Панели свойств на вкладке 

Формат: высота символов – 5, шаг строк – 8 

11  

(напротив 

«Разраб.») 

Сидоров 

Указывается фамилия студента, разработавшего КД. 

Если вариант задания выполняется студентами в паре, 

то фамилия второго студента записывается в графе 11 

напротив «Пров.» 
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Окончание таблицы 17.1 

Номер  

графы 

Содержание  

графы 
Комментарий к заполнению 

11  

(напротив 

«Пров.») 

Петров 

Указывается фамилия преподавателя. 

Если вариант задания выполняется студентами в паре, 

то фамилия преподавателя указывается в графе 11 

напротив «Утв.», а в данной графе записывается фа-

милия второго студента 

11  

(напротив 

«Утв.») 

См. комментарий 

Если вариант задания выполняется студентами в паре, 

то в данной графе записывается фамилия преподава-

теля. В противном случае графа не заполняется 

25 УП1.01.01 
Обозначение спецификации, в которой записан КД, 

определено в табл. 2.1 и указано для варианта «П1» 

26 УП1.01.02 

Заполняется автоматически и полностью соответству-

ет содержанию графы 2. 

Данные этой графы повторяются на каждом новом ли-

сте 

Результат заполнения граф основной надписи в варианте «П1» показан 

на рис. 17.3. 

 

9. Запустить режим редактирования основной надписи и в Панели 

свойств на вкладке Параметры отжать пиктограмму Синхронизация дан-

ных (рис. 7.7), тем самым отключив передачу данных между 3D-моделью и 

основной надписью чертежа. 

10. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

11. Убрать с Вида спереди все отверстия, кроме крепежных. 

Так как данный вид является ассоциативным, то графические объекты с 

него удалить нельзя, не разрушив вид. Чтобы не разрушать вид, интересую-

щие объекты можно скрыть, переместив на вспомогательный невидимый 

слой, для чего выполнить следующее: 

– сделать текущим Вид спереди; 

Рис. 17.3 
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– запустить команду Вставка ⇒ Слой или нажать пиктограмму Управ-

ление слоями (см. рис. 6.8) на ПИ Текущее состояние; 

– в открывшемся окне Менеджер документа убедиться в том, что выде-

лен Вид спереди, после чего нажать пиктограмму Создать слой и в столбце 

Видимость для созданного слоя выбрать Погашенный (рис. 17.4); 

 

– закрыть Менеджер документа клавишей OK; 

– на Виде спереди выделить необходимые отверстия (добавление объек-

тов к уже выделенным осуществляется с зажатой клавишей Ctrl) и на них за-

пустить команду ПКМ ⇒ Изменить слой; 

– в открывшемся окне Выберите слой выбрать только что созданный 

погашенный вспомогательный слой и нажать OK. 

12. Включить режим Ортогональное черчение клавишей F8. 

13. Нажать пиктограмму Параметрический режим (см. рис. 6.8) на ПИ 

Текущее состояние.  

Примечание. Как отмечалось ранее, параметрический режим будет ис-

пользоваться в чертежах при простановке размеров и различных объектов 

на ассоциативных видах. Так как в этом режиме добавленные размеры и 

объекты оказываются привязанными к элементам ассоциативных видов, то 

при обновлении 3D-модели произойдет и их изменение тоже. 

14. Командой Обозначение центра (рис. 

17.5) из ПИ Компактная панель ⇒ Обозначе-

ния обозначить центры всех крепежных отвер-

стий. 

Завершить команду клавишей Esc. 

15. Командой Осевая линия по двум точ-

кам (рис. 17.5) из ПИ Компактная панель ⇒ Обозначения соединить цен-

тры крайних крепежных отверстий, находящихся на одной оси. 

Завершить команду клавишей Esc. 

Погашенный Создать слой 

Рис. 17.4 

Обозначение центра 

Осевая линия 

по двум точкам 

Выносной элемент 

Рис. 17.5 
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Результат в варианте «П1» на 

данном этапе показан на рис. 17.6. 

16. Ознакомиться с правилами на-

несения размеров по Д.5. 

17. Командой Линейный размер 

или Авторазмер (см. рис. 7.21) из ПИ 

Компактная панель ⇒ Размеры про-

ставить следующие размеры на Виде 

спереди: 

– размеры контура ПП в соответ-

ствии с подходящим для варианта задания схематичным изображением, при-

веденным на рис. 12.25; 

– размеры положения осей крепежных отверстий цепочкой от угла ПП, 

отмеченного на рис. 12.25 точкой, при этом размерные линии можно разме-

стить со сторон ПП, оставшихся на данный момент свободными от размеров. 

Обратить внимание на следующее: 

– общая последовательность действий простановки размеров описана в 

п. 21 из 7.3; 

– для выполнения п. 15 из Д.5 указанные в нем расстояния необходимо 

уменьшить на величину масштаба вида (например, для масштаба 2,5:1 вели-

чина 10 мм соответствует 4 мм, а 7 мм – 2,8 мм); 

– для перемещения вида следует потянуть зажатой ЛКМ за его рамку 

(виды с проекционными связями будут перемещены автоматически); 

– для выравнивания положения размерных линий необходимо выделить 

требуемые размеры, запустить команду Инструменты ⇒ Выровнять раз-

мерные линии (или нажать в рабочем поле ПКМ 

и в появившейся над курсором ПИ нажать анало-

гичную пиктограмму) и в рабочем поле ЛКМ 

указать ту размерную линию, по которой будет 

осуществлено выравнивание; 

– вариант простановки размеров для ПП с 

угловой формой показан на рис. 17.7. 

Результат в варианте «П1» на данном этапе 

показан на рис. 17.8. 

Примечание. В КОМПАС-3D размеры, устанавливаемые в параметри-

ческом режиме (ассоциативные размеры), могут быть двух типов: 

Рис. 17.6 

Рис. 17.7 
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– управляющие (размеры, которые управляют геометрическим объек-

том). У таких размеров после изменения пользователем размерного числа 

объект, к которому проставлен размер, будет автоматически перестроен; 

– информационные (размеры, которые управляются геометрическим 

объектом). В этом случае после изменения пользователем габаритов объек-

та, к которому проставлен размер, происходит автоматическое перестро-

ение размера и пересчет его размерного числа. 

В соответствии с настройками профиля, загруженного в 6.2, все ассо-

циативные размеры по умолчанию являются информационными. 

18. Ознакомиться с предельными отклонениями размеров по Д.6. 

19. Для размеров контура ПП установить предельные отклонения с по-

лем допуска h12 и отобразить их числовые значения. 

Для этого выполнить следующее: 

– выделить размеры контура ПП и войти в их свойства, запустив коман-

ду ПКМ ⇒ Свойства на любом из них; 

– в появившемся слева от рабочего поля окне Свойства щелкнуть ЛКМ 

напротив параметра Квалитет; 

– в открывшемся окне Выбор квалитета (рис. 17.9, а) в группе Пока-

зать квалитеты для выбрать требуемую опцию, после чего указать поле до-

пуска и закрыть окно кнопкой OK. 

Примечание. В поле «Значение» отображается значение одного из вы-

бранных размеров, а в полях «Верхнее» и «Нижнее» – отклонения для него 

согласно выбранному полю допуска; 

Рис. 17.8 
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– в окне Свойства для параметра Отобразить отклонения/пределы 

выбрать опцию Да (рис. 17.9, б) и закрыть окно Свойства. 

Примечание. Параметры из группы «Текст» окна «Свойства» также 

можно настроить отдельно для каждого размера в окне «Задание размер-

ной надписи» (для размера 40 мм окно показано на рис. 17.10), что в некото-

рых случаях более наглядно. 

Для открытия этого окна выполняются следующие действия: 

– в рабочем поле ЛКМ выбирается требуемый размер; 

– выполняется команда ПКМ ⇒ Редактировать (или производится 

двойной щелчок ЛКМ по размерной или выносной линии размера); 

– в «Панели свойств» на вкладке «Размер» осуществляется щелчок 

ЛКМ в поле «Текст». 

20. Командой Авторазмер или Диаметральный размер из ПИ Ком-

пактная панель ⇒ Размеры (рис. 7.21) указать количество крепежных от-

верстий и их диаметр, для чего после ее запуска выполнить следующее: 

Рис. 17.9 

б а 
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– в рабочем поле ЛКМ указать на окружность, для которой будет добав-

лен размер; 

– в Панели свойств на вкладке Размер в поле Размещение размерной 

надписи выбрать опцию На полке, влево или На полке, вправо; 

– в Панели свойств нажать ЛКМ на поле Текст; 

– в открывшемся окне Задание размерной надписи дважды щелкнуть 

ЛКМ в поле Текст до и в появившемся списке выбрать 2 отв., после чего 

скорректировать количество отверстий и закрыть окно кнопкой OK; 

– в Панели свойств на вкладке Параметры выбрать опцию Стрелки 

снаружи; 

– в рабочем поле ЛКМ указать точку начала выносной линии для полки 

и выйти из команды клавишей Esc. 

Результат в варианте «П1» на данном этапе показан на рис. 17.11. 

Примечание. Отверстия в ПП по ГОСТ 53386–2009 [76] относятся к 

элементам ее конструкции. Предельные отклонения для диаметров и разме-

ров положения осей будут указаны в ТТ в виде соответствующего класса 

точности ПП.  

Предельные отклонения диаметров отверстий для 4-го класса точно-

сти ПП по ГОСТ Р 53429–2009 приведены в табл. Г.10. 

Позиционный допуск расположения осей отверстий в диаметральном 

выражении для ПП с размером большей стороны до 180 мм включительно 

Рис. 17.10 
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для 4-го класса точности ПП по ГОСТ Р 53429–2009 составляет 0,05 мм 

(см. табл. Б.1). Предельные отклонения расстояний между осями двух лю-

бых отверстий по горизонтали и вертикали (Д.4) составят ±0,018 мм. 

 

21. Отжать пиктограмму Параметрический режим (см. рис. 6.8) на ПИ 

Текущее состояние. 

22. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

23. Создать выносной элемент (см. п. 7.1 из Д.3), на котором показать 

структуру ПП. 

Для этого проделать следующее: 

23.1. Сделать текущим Вид слева. 

23.2. Запустить команду Выносной элемент из ПИ Компактная па-

нель ⇒ Обозначения (см. рис. 17.5) и выполнить следующее: 

– в рабочем поле ЛКМ указать центр области, которая станет выносным 

элементом; 

– в Панели свойств на вкладке Параметры в поле Форма выбрать 

форму области Окружность; 

– в Панели свойств на вкладке Знак включить опцию Автосортировка 

(ее параметры при необходимости устанавливаются командой Сервис ⇒ 

Параметры ⇒ Текущий чертеж ⇒ Обозначение для машиностроения ⇒ 

Автосортировка); 

– в рабочем поле ЛКМ указать точку на контуре области, тем самым за-

фиксировав ее на чертеже; 

Рис. 17.11 
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– в рабочем поле ЛКМ указать точку начала 

полки (рис. 17.12); 

– в Панели свойств на вкладке Параметры за-

дать масштаб 50:1; 

– в Панели свойств на вкладке Надпись вида 

включить опцию Масштаб (остальные опции оста-

вить по умолчанию); 

– в рабочем поле ЛКМ указать произвольное 

место для размещения вида. 

23.3. Разрушить вид с выносным элементом. 

23.4. Удалить в выносном элементе все линии и кривые. 

23.5. Убедиться в том, что вид с выносным элементом текущий. 

23.6. Задать шаг сетки по осям X и Y – 0.01 мм (см. п. 5 из 6.5). 

23.7. Командой Отрезок со стилем линии Основная нарисовать струк-

туру ПП, состоящую из следующих составных частей: 

– в центре – диэлектрическое основание толщиной h; 

– слева и справа от диэлектрического основания – металлизация толщи-

ной псh ; 

– над металлизацией со стороны верхнего слоя – защитная паяльная 

маска (см. Б.7). 

Примечание. Значения следует взять с рисунка или таблицы структуры 

ПП (см. рис. 12.2, б и 12.124), сохраненных в отчете. 

Результат в варианте «П1» показан на рис. 17.13. 

 

23.8. Отключить режим Ортогональное черчение клавишей F8. 

23.9. Командой Сплайн по точкам из ПИ Компактная панель ⇒ Гео-

метрия (см. рис. 7.15) ограничить нарисованные отрезки с нижней стороны, 

Рис. 17.13 

Диэлектрическое 

основание 

Металлизация 

слоя Bottom 

Металлизация 

слоя Top 

Защитная  

паяльная маска 

Рис. 17.12 
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при этом в Панели свойств выбрать в поле Тип кривой – Кривая Безье, а в 

поле Стиль – Для линии обрыва (рис. 17.14, а). 

23.10. Командами Удлинить до 

ближайшего объекта и Усечь кривую 

из ПИ Компактная панель ⇒ Редак-

тирование (см. рис. 6.20) продлить от-

резки до пересечения со сплайном и от-

резать лишние участки сплайна соот-

ветственно (рис. 17.14, б). 

23.11. Командой Штрихофка из 

группы «Заливка» на ПИ Компактная 

панель ⇒ Геометрия (см. рис. 7.19) заштриховать области структуры ПП, 

при этом для диэлектрического основания и защитной паяльной маски вы-

брать стиль Неметалл, для металлизации – Металл. В свойствах штриховок 

также задать необходимые шаг и угол. 

23.12. Командой Авторазмер или Линейный размер указать толщину 

ПП, отдалив размерную линию от линии контура на 0,2 мм. 

Затем в режиме редактирования размера задать симмет-

ричные отклонения по данным из Б.5, т. е. ±10 % от полу-

чившейся толщины ПП. Для этого в окне Задание размер-

ной надписи выполнить следующее: 

– включить опцию Допуск; 

– выбрать опцию Отклонения и в верхнем поле этой 

группы ввести требуемое значение; 

– нажать кнопку «±»; 

– включить опцию Отобразить и нажать OK. 

Результат в варианте «П1» на данном этапе показан на рис. 17.15. 

23.13. Запустить команду Линия-выноска (см. рис. 7.26) из ПИ Ком-

пактная панель ⇒ Обозначения. 

В Панели свойств на вкладке Параметры в поле Стрелка выбрать 

Вспомогательная точка, после чего в рабочем поле, следуя подсказкам в 

строке сообщений, обозначить слои ПП и защитную паяльную маску. Лиш-

ние ответвления линий-выносок (при наличии) удалить по п. 24 из 7.3. 

23.14. Задать шаг сетки по осям X и Y – 0.1 мм (см. п. 5 из 6.5). 

Результат в варианте «П1» на данном этапе показан на рис. 17.16.  

Примечание. Названия слоев ПП взяты из файла трассировки. 

Рис. 17.14 

б а 

Рис. 17.15 
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24. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

25. Добавить ТТ, для чего выполнить следующие действия: 

25.1. Запустить команду Вставка ⇒ Технические требования ⇒ Ввод, 

в результате чего откроется новая вкладка для ввода ТТ. 

25.2. В Панели свойств на вкладке 

Формат: 

– нажать пиктограмму Параметры 

абзаца (рис. 17.17) и в открывшемся 

окне в поле Красная строка ввести 15; 

– нажать пиктограмму Параметры 

списка (рис. 17.17) и в открывшемся окне убедиться, что в поле Текст после 

ничего нет (согласно ГОСТ Р 2.105–2019 после номера пункта никаких зна-

ков быть не должно). 

25.3. Ввести текст следующего вида: 

1 Плату изготовить комбинированным позитивным методом. 

2 Плата должна соответствовать требованиям ГОСТ 23752-79, груп-

па жесткости 1. 

3 Данные для изготовления фотошаблонов, шелкографии и программы 

сверления содержатся в УП1.01.02Д33 (AMP-П1-v0.2.PcbDoc). Формат фай-

ла проектирования - Altium Designer. Назначение задействованных слоев 

приведено в таблице 1. 

4 Параметры элементов конструкции печатной платы приведены в 

таблицах 2 и 3. 

5 Параметры элементов конструкции печатной платы должны отве-

чать 4-му классу точности по ГОСТ Р 53429-2009. 

6 Печатные проводники, переходные отверстия и контактные площад-

ки не показаны. 

Рис. 17.16 

Параметры списка 

Рис. 17.17 

Параметры 

абзаца 

Установить 

нумерацию 
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7 Нанести на верхний слой печатной платы (Слой 1 «Top Layer») за-

щитную паяльную маску зеленого цвета марки Fotochem FSR 8000-8G89 (или 

аналог), кроме мест, указанных на слое Top Solder из AMP-П1-v0.2.PcbDoc. 

Переходные отверстия должны быть открыты от маски. 

8 Припуск паяльной маски (Solder Mask Swell) - 0,05 мм. Допускаемое 

значение смещения рисунка защитной паяльной маски относительно основ-

ного рисунка печатной платы - не более 0,05 мм. 

9 Шелкографию выполнить краской белого цвета Fotochem FSR 8000-

10W (или аналог). Минимальная ширина линии - 0,15 мм, минимальная высо-

та шрифта - 1 мм. 

10 Покрытие мест, не закрытых защитной паяльной маской, - иммер-

сионное серебрение (ImmAg). 

11 Шероховатость обрабатываемых поверхностей - . 

12 Маркировать краской ТНПФ-01 черной ТУ 29-02-889-79 (или аналог). 

Шрифт 2,5 - Пр3 ГОСТ 26.008-85. 

13 Остальные технические требования по ОСТ4 ГО.070.014. 

Для добавления знака шероховатости, указанного в п. 11 ТТ, в Панели 

свойств на вкладке Вставка нажать пиктограмму Спецзнак, после чего в 

открывшемся окне в группе Шероховатость выбрать элемент Верхний. 

Изм. №3 ГОСТ 2.309-73. 

Примечание. Если текст ТТ был скопирован и вставлен, то потребует-

ся выполнить следующее: 

– выделяется весь текст (Ctrl+A); 

– в «Панели свойств» на вкладке «Формат» в поле «Стиль текста» вы-

бирается опция «Техтребования», настраивается значение красной строки 

(см. выше) и включается опция «Установить нумерацию» (см. рис. 17.17); 

– снимается выделение; 

– удаляются скопированные номера пунктов и знаки переносов; 

– заменяются номера вариантов и названия файла трассировки; 

– добавляется обозначение шероховатости. 

25.4. Нажать пиктограмму Сохранить на ПИ Стандартная (или комби-

нацию клавиш Ctrl+S). 

Затем выйти из режима редактирования ТТ, закрыв соответствующую 

вкладку или нажав иконку в правом верхнем углу рабочего поля (рис. 17.18). 

25.5. Убедиться в том, что расстояние между нижней строкой ТТ и рам-

кой основной надписи не менее 10 мм. 
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Если это не так, то изменить положение ТТ, выполнив в рабочем поле на 

них команду ПКМ ⇒ Ручное размещение технических требований и потя-

нув за характерные точки, отмеченные черными квадратами. 

Для сброса настроек размещения ТТ служит команда ПКМ ⇒ Автораз-

мещение технических требований. 

Если добавленные виды занимают много места, в результате чего ТТ не 

помещаются в одну колонку над основной надписью, то есть несколько спо-

собов решения проблемы: 

– пересмотреть компоновку видов (например, вместо вида с непосред-

ственной проекционной связью сделать вид по стрелке и перенести его в дру-

гое место – см. п. 23 из 20.1) и их масштабы; 

– разместить ТТ в две колонки (см. пп. 8 и 9 из Д.8 и рис. 17.19); 

– использовать разрывы (см. п. 5 из Д.4). 

 

Для создания разрыва выполняется следующее: 

– делается текущим требуемый вид; 

– запускается команда Разрыв вида из ПИ Ком-

пактная панель ⇒ Виды (рис. 17.20); 

– в рабочем поле указывается положение двух появившихся вертикаль-

ных прямых, между которыми будет разрыв; 

– в Панели свойств задаются требуемые параметры оформления: угол 

наклона прямых; зазор разрыва; тип разрыва (любой, кроме типа Прямая); 

амплитуда для типов С изломом и Волнистая. Затем включается опция По-

казать разрывы и нажимается пиктограмма Создать объект. 

Рис. 17.19 

Рис. 17.18 

Режим редактирования ТТ 

Рис. 17.20 

Разрыв вида 



 

 489 

Возможный результат показан на рис. 17.21. 

Примечания: 

– на одном виде можно создать несколько 

разрывов, а также удалить уже существующие. 

Для этого служат соответствующие пикто-

граммы в «Панели свойств» в окне «Разрывы»; 

– отключение и включение разрывов осу-

ществляется опцией «Показать разрывы» в «Па-

нели свойств» или выполнением на выделенном 

виде команды ПКМ ⇒ Показать разрывы. 

25.6. Комментарии к отдельным пунктам ТТ 

из п. 25.3: 

– методы изготовления ПП рассмотрены в Б.3 и Б.4; 

– в зависимости от условий эксплуатации по ГОСТ 23752–79 [77] опре-

деляют группу жесткости (табл. 17.2), предъявляющую соответствующие 

требования к конструкции ПП, к используемому материалу основания и 

необходимости применения дополнительной защиты от климатических, ме-

ханических и других воздействий.  

Таблица 17.2 

Климатические факторы групп жесткости 

Наименование  

воздействующего фактора 

Допускаемые значения воздействующего фактора 

по группам жесткости 

1 2 3 4 

Температура 

окружающей 

среды, C 

Верхнее значение 55 85 100 120 

Нижнее значение –25 –40 –60 

Относительная влажность  

воздуха, % 

75–98 

при температуре до 35 C 

98 

при температуре до 40 C 

Смена температур, C 
От –25 

до +55 

От –40 

до +85 

От –60 

до +100 

От –60 

до +120 

Атмосферное давление, Па  

(мм рт. ст.) 
Нормальное 

53600 

(400) 

666 

(5) 

Так как никаких особых требований к ПП не предъявляется, то записана 

1-я группа; 

– классы точности ПП рассмотрены в Б.8. С учетом значений для 4-го 

класса точности производилось моделирование ПФ, а также трассировка ПП 

(правила проектирования были загружены в п. 10 из 12.1); 

Рис. 17.21 
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– защитная паяльная маска рассмотрена в Б.7 (также см. п. 13 из Б.4); 

– пояснение к допускаемому смещению рисунка защитной паяльной 

маски дано в Б.9; 

– способы нанесения шелкографии приведены в п. 16 из Б.4; 

– виды покрытий рассмотрены в Б.6; 

– шероховатость поверхности рассмотрена в Д.9; 

– маркировочная краска ТНПФ-01 выбрана по ОСТ1 90210–85 [79]. Она 

обладает механической прочностью; хорошей адгезией к маркируемой по-

верхности; стойкостью во всеклиматических условиях эксплуатации; выдер-

живает циклическое воздействие температур от минус 60 до плюс 180 C; 

устойчива к периодическому обливу топливом, бензином, минеральным мас-

лом; кислото-, водо- и спирто-стойка; 

– параметры шрифта для маркировки описаны в п. 12 из 16.1; 

– информация по ОСТ4 ГО.070.014 [78] содержится в Д.6. 

26. Показать место маркировки. 

Примечание. В соответствии с ГОСТ 2.314–68 [80] место нанесения 

маркировки отмечают точкой и соединяют ее линией-выноской со знаком 

маркирования, который представляет собой окружность диаметром 10–15 

мм, выполненную сплошной основной линией. Внутри окружности помеща-

ют номер соответствующего пункта ТТ, в котором приведены указания о 

маркировании. С целью сокращения объема надписей на чертеже допуска-

ется указания о содержании (например, для заводского номера – Н) и спосо-

бе нанесения (например, краской – к) маркировки приводить буквенными 

обозначениями. Эти буквы помещаются на линии-выноске. 

Для добавления знака маркировки выполнить следующее: 

26.1. Сделать текущим Вид спереди. 

26.2. Запустить команду Знак маркировки из группы «Линия-выноска» 

на ПИ Компактная панель ⇒ Обозначения (рис. 17.22). 

В Панели свойств задать следующие настройки: 

– на вкладке Параметры в поле Стрелка выбрать оп-

цию Вспомогательная точка; 

– на вкладке Знак около поля Текст нажать пикто-

грамму Вставить ссылку; 

– в открывшемся окне Ссылка в поле Список источников выбрать 

строку с указанием о маркировке из ТТ и нажать OK; 

– на вкладке Знак щелкнуть ЛКМ по полю Текст; 

Знак  

маркировки 

Рис. 17.22 
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– в открывшемся окне Введите текст дважды щелкнуть ЛКМ в поле 

напротив второй строки; 

– в открывшемся окне Обозначение маркировки в поле Содержание 

выбрать Заводской номер, а в поле Способ нанесения – Краской. После 

этого нажать OK; 

– в окне Введите текст перед добавленным обозначением Нк вставить 

несколько пробелов (для его сдвига) и нажать OK (рис. 17.23, а). 

 

Примечание. Как отмечалось в п. 30.5 из 16.1, в варианте «П1» не будет 

шелкографии, поэтому в ТТ нет п. 9, а пункт с маркировкой имеет номер 11.  

26.3. В рабочем поле ЛКМ внутри контура ПП указать место, в котором 

будет размещаться маркировка. 

Затем ЛКМ указать точку размещения знака за пределами контура ПП и 

в Панели свойств нажать пиктограмму Создать объект. 

Примечание. В варианте «П1» было выбрано свободное место на слое 

Top Layer около диода VD1 (см. рис. 12.141). 

26.4. В рабочем поле на знаке маркировки выполнить команду ПКМ ⇒ 

Очистить фон, тем самым отключив эту опцию. При необходимости скор-

ректировать положение обозначения Нк на линии-выноске пробелами. 

Результат в варианте «П1» показан на рис. 17.23, б.  

27. Добавить над записанными ТТ таблицу из их 3-го пункта (см. п. 25.3) 

с информацией о слоях из файла трассировки. 

Для этого выполнить следующее: 

27.1. Запустить команду Создать новый вид из ПИ Компактная па-

нель ⇒ Виды (см. рис. 7.6) и щелкнуть ЛКМ в рабочем поле над ТТ. 

27.2. Запустить команду Ввод таблицы из ПИ Компактная панель ⇒ 

Обозначения (рис. 17.24) и указать ЛКМ положение левого верхнего угла 

таблицы над ТТ. 

Рис. 17.23 

б а 
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В появившемся окне Создать таблицу задать 

следующие настройки: 

– число столбцов – 2; 

– число строк – 6; 

– высота строки – 8. 

Затем закрыть окно кнопкой OK. 

27.3. Заполнить таблицу по образцу табл. 17.3. 

Таблица 17.3 

Назначение задействованных слоев ПП 

Название слоя Назначение 

Top Overlay Шелкография на верхней стороне платы 

Top Solder Маска на верхней стороне платы 

Top Layer Проводящий рисунок на верхней стороне платы 

Bottom Layer Проводящий рисунок на нижней стороне платы 

M1 Board Контур платы 

При необходимости отредактировать ширину столбцов, потянув ЛКМ за 

их вертикальные границы влево или вправо. 

Для сохранения введенных данных в Панели свойств нажать пикто-

грамму Создать объект, после чего завершить команду клавишей Esc. 

Примечание. В варианте «П1» слоя Top Overlay в таблице нет. 

27.4. Задать автоматическую нумерацию таблицы, для чего запустить 

команду Вид ⇒ Нумерация (или нажать пиктограмму Нумерация на ПИ 

Стандартная) и проделать следующее: 

– в верхней части появившегося окна Нумерация в раскрывающемся 

списке выбрать опцию #Нумерация таблиц; 

– нажать пиктограмму Параметры групп нумерации (рис. 17.25, а) и в 

открывшемся окне в группе #Нумерация таблиц удалить текст из поля 

Текст перед номером (рис. 17.25, б), после чего нажать OK; 

 Рис. 17.25 

б а 

Добавить  

выделенные объекты 

Параметры 

групп нумерации 

Рис. 17.24 

Ввод таблицы 
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– в рабочем поле щелкнуть ЛКМ по таблице; 

– в окне Нумерация нажать пиктограмму Добавить выделенные объ-

екты, в результате чего будет добавлена в список (рис. 17.25, а); 

– в рабочем поле щелкнуть ЛКМ по таблице и запустить команду 

ПКМ ⇒ Название; 

– в появившемся окне в поле перед автоматически 

добавленным номером ввести слово Таблица и поста-

вить пробел (рис. 17.26); 

– закрыть окно кнопкой OK и снять выделение с 

таблицы. 

28. Добавить в чертеж по 7.1 вто-

рой лист (рис. 17.27) со следующими 

настройками: 

– формат – A4; 

– ориентация – вертикальная; 

– оформление – Чертеж констр. 

Посл. листы. ГОСТ 2.104-2006. 

29. Добавить на второй лист таблицу из 4-го пункта ТТ (см. п. 25.3) с 

информацией об отверстиях на ПП. 

Для этого выполнить следующее: 

29.1. По пп. 27.1 и 27.2 создать новый вид на втором листе чертежа и 

добавить таблицу с шестью столбцами и восьмью строками. 

29.2. Заполнить таблицу по образцу табл. 17.4 с использованием табли-

цы со списком отверстий (см. рис. 12.123), сохраненной в отчете. 

Таблица 17.4 

Перечень отверстий ПП 

Диаметр 

отв., мм 

Форма  

контактной 

площадки 

Размер  

контактной 

площадки, мм 

Наличие  

металлизации 
Кол. Примечание 

0,4 круг Ø0,9 есть 5 
Переходные отв. 

0,6 круг Ø1,2 есть 151 

0,8 круг Ø1,4 есть 1 

Отв. для установки ком-

понентов 

0,8 квадрат 1,4×1,4 есть 1 

1,2 круг Ø1,8 есть 10 

1,2 квадрат 1,8×1,8 есть 2 

2,9 круг Ø5,0 есть 6 Крепежные отв. 

Рис. 17.26 

Рис. 17.27 
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Для добавления в таблицу знаков диаметра и умножения в Панели 

свойств на вкладке Вставка необходимо нажать пиктограмму Спецзнак, 

после чего в открывшемся окне раскрыть группу Простановка размеров, 

выбрать необходимый знак и нажать OK. 

Для редактирования строк, столбцов и ячеек используются пиктограммы 

на вкладке Таблица в Панели свойств (рис. 17.28) со следующими особен-

ностями: 

– перед объединением ячеек необходимо их выделить; 

– перед добавлением строки (столбца) необходимо установить курсор 

мышки внутри ячейки строки (столбца), относительно которой будет произ-

водиться вставка; 

– для изменения стиля границ ячеек необходимо их выделить (или уста-

новить внутрь курсор мышки), выбрать стиль линии в списке Стиль и в 

списке Границы отметить нужные. 

 

Примечания: 

– расшифровка обозначений КП и переходных отверстий содержится в 

Г.22; 

– посмотреть перечень КП и переходных отверстий также можно в 

файле трассировки с использованием панели PCB, находящейся в режиме 

Pad & Via Templates. С включенной опцией Select свойства выбранных шаб-

лонов доступны для просмотра в панели PCB Inspector; 

– так как в варианте «П1» у прямоугольных КП со скруглениями их ра-

диус уменьшен до 1 %, то в табл. 17.4 в столбце с формой КП было записано 

не «скругленный квадрат», а просто «квадрат». 

29.3. По п. 27.4 добавить созданную таблицу в список с автоматической 

нумерацией и присвоить ей название Таблица с автоматически добавленным 

порядковым номером 2. 

30. Добавить на второй лист таблицу из 4-го пункта ТТ (см. п. 25.3) с 

информацией о минимальных значениях параметров конструкции ПП. 

Для этого выполнить следующее: 

Рис. 17.28 

Объединить 

ячейки 

Вставить строку сверху 

Удалить строку 

Вставить строку снизу Разбить 

ячейки 
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30.1. По пп. 27.1 и 27.2 создать новый вид на втором листе чертежа и 

добавить таблицу с двумя столбцами и семью строками. 

30.2. Заполнить таблицу по образцу табл. 17.5 с использованием файла 

трассировки, обратив внимание на положение числовых значений показате-

лей в графах (см. п. 4 из 18.1). 

Таблица 17.5 

Минимальные значения параметров конструкции ПП 

Параметр конструкции печатной платы Минимальное значение 

Ширина печатного проводника, мм 0,25 

Зазор между печатными проводниками, мм 0,20 

Зазор между контактными площадками разных электрических 

цепей, мм 

 

0,25 

Зазор между печатным проводником и полигоном, мм 0,50 

Отступ проводящего рисунка от контура платы, мм 0,50 

Отношение диаметра минимального металлизированного отв. 

к толщине платы 

 

0,65 

Перед заполнением таблицы в Altium Designer выполнить следующие 

предварительные действия: 

– если проект ПП был закрыт, то открыть его по п. 1 из 12.1; 

– если файл трассировки был закрыт, то открыть его по п. 3 из 8.3; 

– перейти в сетку 0.025 мм; 

– включить набор слоев Shield; 

– сделать текущим слой Top Layer; 

– включить режим одного слоя (Shift+S). 

Используя при необходимости команду Reports ⇒ Measure Distance 

(или комбинацию клавиш Ctrl+M) из п. 17.10 из 12.3, осуществить поиск и 

измерение указанных в таблице параметров (примеры мест их расположения 

в файле трассировки показаны цифрами на рис. 17.29): 

– печатный проводник с минимальной шириной будет либо в цепи 

управления аттенюатором (0,25 мм), либо в топологии ПФ (места № 1 и 2). 

Примечание. Узнать ширину печатного проводника можно в его свой-

ствах (команда ПКМ ⇒ Properties), в панели PCB Inspector или в панели PCB 

List, в которой можно отсортировать по ширине все дуги и линии; 

– минимальный зазор между печатными проводниками в проекте, скорее 

всего, будет либо между цепями управления аттенюатора, либо между резо-

наторами в ПФ (места № 3 и 4); 
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– минимальный зазор между КП разных цепей, скорее всего, будет в по-

садочном месте под микросхему аттенюатора (место № 3). Также следует об-

ратить внимание на зазоры между КП у близко расположенных компонентов 

и между КП в разъемах (места № 5 и 6); 

– минимальный зазор между печатным проводником и полигоном для 

всех вариантов задания будет 0,5 мм (место № 7), так как такое правило про-

ектирования было задано при трассировке ПП в п. 16.7 из 12.5; 

– минимальный отступ проводящего рисунка от контура ПП для всех 

вариантов задания будет 0,5 мм (место № 8), так как было загружено правило 

BOC (см. табл. Г.7); 

– отношение диаметра минимального металлизированного отверстия к 

толщине ПП необходимо рассчитать, воспользовавшись данными табл. 17.4 и 

размером на выносном элементе (см. рис. 17.16). Полученное значение округ-

лить до сотых долей в меньшую сторону. 

Примечание. В табл. 17.5 указаны не все параметры конструкции ПП, 

так как для их определения потребовались бы более сложные действия. 

30.3. По п. 27.4 добавить созданную таблицу в список с автоматической 

нумерацией и присвоить ей название Таблица с автоматически добавленным 

порядковым номером 3. 

30.4. Закрыть файл трассировки без сохранения изменений. 

Рис. 17.29 
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 Рис. 17.30 Начало (окончание см. на с. 498) 
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 Рис. 17.30 Окончание (начало см. на с. 497) 
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31. В КОМПАС-3D в ТТ добавить ссылки на номера таблиц (при изме-

нениях в рабочем поле номера автоматически обновятся в ТТ). 

Для этого выполнить следующее: 

31.1. Войти в режим редактирования (ввода) ТТ командой из п. 25.1 (или 

командой ПКМ ⇒ Редактировать технические требования, выполненной 

на ТТ в рабочем поле). 

31.2. В пп. 3 и 4 из ТТ удалить номера таблиц, после чего отдельно для 

каждого места, где стоял номер, запустить команду ПКМ ⇒ Вставить ссыл-

ку и в появившемся окне Ссылка выбрать следующее:  

– в поле Тип источника – Группа нумерации; 

– в поле Ссылка на – #Нумерация таблиц; 

– в поле Список источников – требуемый номер таблицы. 

31.3. Выйти из режима редактирования ТТ. 

32. Сохранить изменения в чертеже (Ctrl+S). 

Результат в варианте «П1» показан на рис. 17.30. 

33. Сохранить чертеж в формате PDF по 17.3. 

Имя файла в варианте «П1» – «УП1.01.02 - Плата печатная - v0.1», а 

путь сохранения – …\ИДРЭС-П1\Усилитель\_pdf (см. рис. 2.8). 

17.3. Сохранение чертежа КОМПАС-3D в формате PDF 

Первый способ сохранения чертежа в формате PDF осуществляется за-

пуском команды Файл ⇒ Сохранить как и выбором в открывшемся окне в 

поле Тип файла опции Portable Document Format (*.pdf). Кроме того, 

кнопкой Параметры в этом окне можно задать некоторые дополнительные 

опции сохранения: 

– номера выводимых листов; 

– вывод всех листов в один файл или каждый лист в отдельный файл; 

– фильтры вывода на печать объектов чертежа и др. 

Второй способ сохранения чертежа в формате PDF позволяет более де-

тально произвести настройки и осуществляется запуском команды Файл ⇒ 

Предварительный просмотр, в результате чего рабочее поле принимает 

вид, показанный на рис. 17.31. 

Выбранный в рабочем поле лист (вокруг него появляется контур зелено-

го цвета) можно переместить на страницах для печати (зажатая ЛКМ), по-

вернуть (клавиши Z и X), разместить в узлах страниц (клавиша H), изменить 

масштаб вывода на печать (клавиша F) и удалить из печати (клавиша Delete). 
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К печати можно добавлять листы других чертежей, задавать настройки 

параметров вывода на печать (например, порядок вывода страниц или цвет 

вывода) и фильтры вывода на печать объектов чертежа. 

Кроме того, клавишей E можно войти в режим указания только опреде-

ленной области изображения рабочего поля для вывода на печать. 

Настройка печати (например, форматы листов и принтер) осуществляет-

ся пиктограммой Настройка плоттера/принтера, а начало печати – пикто-

граммой Печать. 

17.4. Содержание отчета 

По 17-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести чертеж «платы печатной», распечатанный на от-

дельных листах. 

Схема складывания листа формата A3 при расположении основной 

надписи вдоль длинной стороны листа для непосредственного брошюрова-

ния показана на рис. 8.71. 

 

Рис. 17.31 

Настройка  

плоттера/принтера 

Предварительный 

просмотр перед  

печатью 

Печать 

Режим указания 

выводимых  

областей листов 

Фильтры вывода  

на печать 
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18. СПЕЦИФИКАЦИЯ НА «УСИЛИТЕЛЬ» 

18.1. Правила выполнения спецификаций 

Спецификация по ГОСТ Р 2.102–2023 – текстовый КД, определяющий 

состав сборочной единицы, комплекса или комплекта. 

Правила оформления спецификации можно разделить на основные, при-

веденные в ГОСТ Р 2.106–2019, и дополнительные: 

1. Основные правила оформления спецификации. 

1.1. Спецификацию составляют на каждую сборочную единицу, ком-

плекс и комплект на отдельных листах формата А4 с оформлением в рамках 

по ГОСТ Р 2.104–2023, которое упрощенно показано на рис. 3.5, а. 

Оформление основной надписи и дополнительных граф для текстовых 

документов описано в п. 3 из 9.1. 

Спецификацию оформляют в виде таблицы (рис. 18.1), заполняемой 

сверху вниз, с фиксированными размерами столбцов и строк. 

 

1.2. В спецификацию вносят составные части, входящие в специфициру-

емое изделие, а также КД, относящиеся к этому изделию и к его неспецифи-

цируемым составным частям. 

1.3. Спецификация в общем случае состоит из разделов, которые распо-

лагают в следующей последовательности: 

– документация; 

– комплексы; 

– сборочные единицы; 

– детали; 

– стандартные изделия; 

– прочие изделия; 

– материалы; 

– комплекты. 

Рис. 18.1 
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Наличие тех или иных разделов определяется составом специфицируе-

мого изделия. Наименование каждого раздела указывают в виде заголовка в 

графе «Наименование» и подчеркивают. 

1.4. В раздел «Документация» вносят следующие документы: 

– документы, составляющие основной комплект КД специфицируемого 

изделия, кроме его спецификации; 

– ведомости эксплуатационных документов; 

– ведомости документов для ремонта; 

– документы основного комплекта записываемых в спецификацию не-

специфицируемых составных частей (деталей), кроме их рабочих чертежей. 

КД внутри раздела записывают в следующей последовательности: 

– документы на специфицируемое изделие; 

– документы на неспецифицируемые составные части. 

В каждой части раздела документы записывают в порядке, изложенном 

в п. 1.5, а в пределах обозначения изделия – в последовательности, в которой 

они перечислены в ГОСТ Р 2.102–2023. Например: 

– сборочный чертеж (СБ); 

– схемы по ГОСТ 2.701–2008 (Э1, Э2, Э3, …, Э9, Э0, Г1, Г2 и т. д.). Пе-

речень элементов записывают после схемы, к которой он выпущен; 

– ведомость покупных изделий (ВП). 

1.5. В разделы «Комплексы», «Сборочные единицы» и «Детали» вно-

сят комплексы, сборочные единицы и детали, непосредственно входящие в 

специфицируемое изделие. Запись указанных изделий производится в алфа-

витном порядке сочетания букв кодов организаций-разработчиков. В преде-

лах этих кодов – в порядке возрастания классификационной характеристики. 

При одинаковой классификационной характеристике – по возрастанию по-

рядкового регистрационного номера. 

1.6. В разделе «Стандартные изделия» записывают изделия, применен-

ные по международным, межгосударственным и национальным стандартам, 

стандартам организаций (например, для вспомогательного производства) и 

отраслевым стандартам (для ранее разработанных изделий). 

В пределах каждой категории стандартов запись рекомендуется произ-

водить по группам изделий, объединенных по их функциональному назначе-

нию (например, подшипники, крепежные изделия, электротехнические изде-

лия и т. п.); в пределах каждой группы – в алфавитном порядке наименова-

ний изделий; в пределах каждого наименования – в порядке возрастания обо-
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значений стандартов; в пределах каждого обозначения стандарта – в порядке 

возрастания основных параметров или размеров изделия. 

1.7. В раздел «Прочие изделия» вносят изделия, примененные по тех-

ническим условиям, выбираемые по каталогам, применяемые без техниче-

ских условий (с указанием в графе «Примечание» возможного изготовителя), 

и импортные покупные изделия, примененные по сопроводительной техни-

ческой документации (каталогам) зарубежных изготовителей (поставщиков). 

Запись изделий рекомендуется производить по группам, объединенным по их 

функциональному назначению, в пределах каждой группы – в алфавитном 

порядке наименований изделий, а в пределах каждого наименования – в по-

рядке возрастания основных параметров или размеров изделия. 

Импортные покупные изделия вносят с обозначениями и наименования-

ми, содержащимися в сопроводительной технической документации (катало-

гах) зарубежных изготовителей (поставщиков). Рекомендуется одновременно 

указывать аутентичные обозначения и наименования на русском языке. 

1.8. В раздел «Материалы» вносят все материалы, непосредственно 

входящие в специфицируемое изделие (например, металлы, кабели, провода, 

шнуры, пластмассы, резиновые материалы и т. п.). В этот раздел не записы-

вают материалы, необходимое количество которых не может быть определе-

но конструктором по размерам элементов изделия и вследствие этого уста-

навливается технологом (например, лаки, краски, клей, смазки). Указание о 

применении таких материалов дают в ТТ на поле чертежа. 

1.9. В раздел «Комплекты» вносят ведомость эксплуатационных доку-

ментов, ведомость документов для ремонта и применяемые по КД комплек-

ты, которые непосредственно входят в специфицируемое изделие и постав-

ляются вместе с ним, а также упаковку, предназначенную для изделия. 

1.10. После каждого раздела спецификации допускается оставлять не-

сколько свободных строк для дополнительных записей (в зависимости от 

стадии разработки, объема записей и т. п.).  

Допускается резервировать и номера позиций, которые проставляют в 

спецификации при заполнении резервных строк. 

1.11. В графе «Формат» указывают форматы документов, обозначения 

которых записывают в графе «Обозначение». Если документ выполнен на 

нескольких листах различных форматов, то в графе «Формат» проставляют 

знак звездочки со скобкой, а в графе «Примечание» перечисляют все форма-

ты в порядке их увеличения (также см. п. 1.18).  



 

 504 

Для документов из разделов «Стандартные изделия», «Прочие изделия» 

и «Материалы» графу не заполняют. 

Для деталей, на которые не выпущены чертежи, в графе указывают БЧ. 

Для документов, изданных на форматах, предусмотренных соответ-

ствующими государственными стандартами для типографских изданий, в 

графе ставят прочерк. 

1.12. В графе «Зона» указывают обозначение зоны, в которой находится 

номер позиции записываемой составной части (если поле чертежа разбито на 

зоны). 

1.13. В графе «Поз.» указывают порядковые номера составных частей, 

непосредственно входящих в специфицируемое изделие, в порядке записи их 

в спецификации. 

Для разделов «Документация», «Комплекты» эту графу не заполняют. 

1.14. В графе «Обозначение» указывают: 

– в разделе «Документация» – обозначение записываемых документов; 

– в разделах «Комплексы», «Сборочные единицы», «Детали», «Ком-

плекты» – обозначение основных КД на записываемые в эти разделы изде-

лия. Для деталей, на которые не выпущены чертежи, – присвоенное им обо-

значение; 

– в разделах «Стандартные изделия», «Прочие изделия» и «Материалы» 

графу «Обозначение» не заполняют. Если для изготовления стандартного из-

делия выпущен КД, в графе «Обозначение» указывают обозначение выпу-

щенного основного КД. 

1.15. В графе «Наименование» указывают: 

– в разделе «Документация» для документов, входящих в основной ком-

плект документов специфицируемого изделия и составляемых на данное из-

делие, – наименование документа (например, «Сборочный чертеж»). Для до-

кументов на неспецифицированные части – наименование изделия и наиме-

нование документа; 

– в разделах «Комплексы», «Сборочные единицы», «Детали», «Ком-

плекты» – наименования изделий в соответствии с основной надписью на ос-

новных КД этих изделий. Для деталей, на которые не выпущены чертежи, 

указывают наименование, материал и другие данные, необходимые для изго-

товления; 

– в разделе «Стандартные изделия» – наименования и обозначения изде-

лий в соответствии со стандартами на эти изделия; 
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– в разделе «Прочие изделия» – наименования и условные обозначения 

изделий в соответствии с документами на их поставку с указанием обозначе-

ний этих документов; 

– в разделе «Материалы» – обозначения материалов, установленные в 

стандартах или технических условиях на эти материалы. 

1.16. Для записи ряда изделий и материалов, отличающихся размерами и 

другими данными и примененных по одному и тому же документу (и запи-

сываемых в спецификацию за обозначением этого же документа), допускает-

ся общую часть наименования этих изделий или материалов с обозначением 

указанного документа записывать на каждом листе спецификации один раз в 

виде общего наименования (заголовка). 

Под общим наименованием записывают для каждого из указанных изде-

лий и материалов только их параметры и размеры. 

Если основные параметры или размеры изделия обозначают только од-

ним числом или буквой, то запись производят следующим образом: 

Шайбы ГОСТ 18123 

Шайба 3 

Шайба 4 

Шайба 6. 

1.17. В графе «Кол.» указывают: 

– для составных частей изделия, записываемых в спецификацию, коли-

чество их на одно специфицируемое изделие; 

– в разделе «Документация» графу не заполняют; 

– в разделе «Материалы» – общее количество материалов с указанием 

единиц измерения на одно специфицируемое изделие. Допускается единицы 

измерения записывать в графе «Примечание» в непосредственной близости 

от графы «Кол.». 

1.18. В графе «Примечание» указывают дополнительные сведения для 

планирования и организации производства, а также другие сведения, отно-

сящиеся к записанным в спецификацию изделиям, материалам и документам, 

например для деталей, на которые не выпущены чертежи, – массу. 

Для документов, выпущенных на двух и более листах различных форма-

тов, указывают обозначение форматов, перед перечислением которых про-

ставляют знак звездочки со скобкой, например: *) А4, А3. 

2. К дополнительным правилам оформления спецификации можно отне-

сти правила из ГОСТ 2.413–72 [81] для изделий с электромонтажом. 
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2.1. При записи в спецификацию составной части, являющейся элемен-

том схемы Э3 изделия, в графе «Примечание» указывают позиционное обо-

значение, присвоенное этому элементу в схеме. 

2.2. Если в специфицируемое изделие входят составные части, являю-

щиеся различными элементами схемы (например, резистор МЛТ-0,5 – 100 

Ом ±5 % ТУ 11-85 ОЖО.467.180 является сопротивлениями R2, R3, R4, R9 и 

R12), то в графе «Примечание» их позиционные обозначения перечисляют в 

возрастающем порядке, например: R2–R4, R9, R12 (позиционные обозначе-

ния с последовательными порядковыми номерами указывают через тире). 

2.3. Составные части, являющиеся элементами схемы Э3 и примененные 

по стандартам или техническим условиям, записывают в спецификацию по 

ГОСТ Р 2.106–2019 со следующими дополнениями и изменениями: 

– их записывают в начале соответствующего раздела группами в поряд-

ке расположения буквенных позиционных обозначений, приведенных в при-

ложении 1 в ГОСТ 2.710–81; 

– внутри группы составные части записывают в порядке возрастания ос-

новных параметров. 

2.4. Если при регулировании изделия с электромонтажом должен быть 

осуществлен подбор какой-либо составной части, являющейся элементом 

схемы Э3, то все изделия, участвующие в подборе, вносят в спецификацию 

изделия, на которое выпущена данная схема, после изделий того же функци-

онального назначения (например, резисторы после резисторов) и перечисля-

ют в порядке возрастания основных параметров. 

В графе «Примечание» при этом указывают позиционные обозначения 

элементов, для подбора которых применяется данное изделие. Графу «Поз.» 

не заполняют, а графу «Кол.» заполняют по указаниям отраслевой организа-

ции по стандартизации. 

3. Также дополнительные правила оформления спецификации можно 

найти в ГОСТ Р 2.109–2023. Например, для изделий, изготовляемых в раз-

личных производственно-технологических вариантах. 

4. Некоторые требования оформления по ГОСТ Р 2.105–2019 (как КД, 

содержащий текст, разбитый на графы) и ОСТ4.000.030–85 [82]: 

– ниже каждого заголовка должна быть оставлена одна свободная стро-

ка, выше – не менее одной свободной строки; 

– если в графе документа записан текст в несколько строк, то в после-

дующих графах записи начинают на уровне первой строки; 
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– если в последующих графах запись размещается на одной строке, то 

при машинописном способе выполнения ее допускается помещать на уровне 

последней строки; 

– в случае записи текста в графе «Наименование» в несколько строк до-

пускается графу «Кол.» заполнять на уровне последней строки, а в графе 

«Примечание» текст в несколько строк записывать на уровне первой строки; 

– в текстовых КД в бумажной форме, имеющих строки, все записи про-

водят на каждой строке в один ряд; 

– ЛР (см. рис. 9.3) рекомендуется предусматривать в спецификациях, со-

стоящих из пяти и более листов. 

18.2. Создание спецификации на «усилитель» 

Спецификация будет оформлена в Microsoft Word на заранее подготов-

ленной заготовке «Спецификация, вариант А.doc» из папки …\ИДРЭС\ 

MSWord заготовки (см. рис. 2.9). 

Отличие данной заготовки от заготовки для перечня элементов (см. 9.2) 

только в форме заполняемой таблицы в рабочем поле листа. 

Для создания спецификации на «усилитель» необходимо: 

1. Открыть указанную выше заготовку. 

2. Сохранить заготовку командой Файл ⇒ Сохранить как с расшире-

нием «.doc». Имя файла в варианте «П1» – «УП1.01.01 - Усилитель - v0.1», а 

путь сохранения – …\ИДРЭС-П1\Усилитель (см. рис. 2.8). 

3. Войти в режим редактирования нижних колонтитулов по п. 3 из 9.2 и 

заполнить без копирования графы рамки в соответствии с табл. 18.1. Содер-

жание остальных граф должно соответствовать данным табл. 9.1. 

Пояснения к графам даны в табл. 3.1, на рис. 9.1 и на рис. 3.6, б и в. 

Таблица 18.1 

Содержание граф рамки для спецификации на «усилитель»,  

отличающихся от перечня элементов ПЭ3 «усилителя» 

Номер  

графы 
Содержание Комментарий к заполнению 

1 Усилитель Наименование изделия определено в табл. 2.1 

2  

(на первом  

и втором 

листе) 

УП1.01.01 

Обозначение документа определено в табл. 2.1 и ука-

зано для варианта «П1». 

Обозначение со второго листа при увеличении числа 

листов повторяется на каждом последующем 

25 УП1.00.01 
Обозначение спецификации, в которой записан КД, 

определено в табл. 2.1 и указано для варианта «П1» 
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4. Выйти из режима редактирования колонтитулов по п. 4 из 9.2. 

5. В соответствии с информацией из 18.1, заполнить графы таблицы из 

рабочего поля спецификации: 

5.1. Начиная со второй строки, заполнить раздел «Документация». 

Здесь будет пять документов, расположенных согласно п. 1.4 из 18.1 в 

следующем порядке: 

– сборочный чертеж «усилителя» (см. рис. 19.40); 

– схема Э3 «усилителя» (см. рис. 8.66); 

– перечень элементов ПЭ3 «усилителя» (см. рис. 9.9); 

– данные проектирования на ПП (см. 12.6.1); 

– удостоверяющий лист к данным проектирования (см. рис. 12.144). 

Первые три КД – документы на специфицируемое изделие (их обозначе-

ния отличаются от спецификации только кодами документа – СБ, Э3, ПЭ3), а 

оставшиеся – документы на неспецифицируемую составную часть.  

Примечание. Если бы ПП была многослойной, то на нее следовало бы 

выпустить свою спецификацию, в которую и вошли бы последние два доку-

мента вместе со сборочным чертежом ПП. Но так как разработанная ПП 

является деталью (см. п. 3 из 17.1), то они записываются в спецификацию 

того изделия, в которое входит ПП. 

Так как на данном этапе сборочного чертежа «усилителя» еще нет, то 

для него в графе «Формат» временно записать формат A3. Если потребуется, 

он будет скорректирован в разд. 19. 

Под данными проектирования в графе «Обозначение» записать название 

файла проектирования (в варианте «П1» – «AMP-П1-v0.2.PcbDoc»). 

Удостоверяющий лист по ГОСТ 28388–89 записывается после докумен-

та, к которому он выполнен, а в графе «Примечание» указывается «Размно-

жать по особому указанию». 

5.2. Раздела «Сборочные единицы» в этой спецификации нет, так как 

«усилитель» состоит из ДПП и покупных изделий (компоненты на ПП). 

5.3. В разделе «Детали» будет одна позиция – Плата печатная. Основ-

ной КД для нее показан на рис. 17.30. 

Следует обратить внимание на запись формата листа, так как в варианте 

«П1» чертеж выполнен на форматах А4 и А3 (см. пп. 1.11 и 1.18 из 18.1). 

5.4. В разделе «Прочие изделия» будут перечислены установленные на 

ПП компоненты. 

Для заполнения этого раздела выполнить следующее: 
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5.4.1. Сделать копию файла перечня элементов ПЭ3 «усилителя» (рас-

положение указано в п. 2 из 9.2) и открыть ее. 

5.4.2. Отсортировать компоненты из перечня элементов по возрастанию 

их наименований для каждой функциональной группы: 

– выделить все строчки с компонентами одного функционального назна-

чения, в которых есть позиционные обозначения и наименования; 

– в разделе Работа с таблицами на 

вкладке Макет в группе Данные нажать 

пиктограмму Сортировка (рис. 18.2); 

– в открывшемся окне Сортировка 

(рис. 18.3) в группе Список выбрать оп-

цию без строки заголовка (в этом случае 

сортировка будет производиться вместе с 

первой выделенной строкой), в группе Сначала по – опцию по столбцам 2 

(столбцы с наименованием компонентов). После этого выбрать опцию по 

возрастанию и нажать OK. 

 

5.4.3. Резисторы дополнительно вручную отсортировать по возрастанию 

номиналов в пределах типоразмеров их корпусов. 

Рис. 18.3 

Рис. 18.2 
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5.4.4. В соответствии с информацией из 18.1 записать компоненты из 

перечня элементов ПЭ3 «усилителя» в спецификацию, при этом необходимо 

обратить внимание на следующее: 

– наименование компонента в перечне элементов и спецификации долж-

но быть одинаковым;  

– в графе «Примечание» для каждой позиции должны быть указаны по-

зиционные обозначения компонентов (см. пп. 2.1 и 2.2 из 18.1) и данные из 

графы «Примечание» перечня элементов (при наличии); 

– если слово не помещается в ячейку, то необходимо либо перенести его 

часть в ячейку ниже, либо вписать в ячейку по п. 6 из 11.1 (размещать текст в 

одной ячейке в две строки нельзя); 

– добавление новых строк осуществляется по п. 7 из 9.2; 

– удаление лишних строк осуществляется по п. 8 из 9.2. 

5.4.5. Удалить копию файла перечня элементов, созданного в п. 5.4.1. 

5.4.6. Проверить правильность заполнения графы «Кол.» и записи пози-

ционных обозначений, для чего в Altium Designer выполнить следующее: 

– если проект ПП был закрыт, то открыть его по п. 1 из 12.1; 

– открыть схему Э3 «усилителя» (см. п. 3 из 8.3); 

– запустить команду Reports ⇒ Bill of Materials; 

– в открывшемся окне осуществить группировку информации по пара-

метру CI_BOM, для чего перетащить его название зажатой ЛКМ из столбца 

All Columns в столбец Grouped Columns; 

– в правой части окна Bill of Materials перетащить зажатой ЛКМ стол-

бец Designator за столбец Quantity (рис. 18.4); 

 

– после проверки закрыть окно Bill of Materials кнопкой Cancel; 

– закрыть проект ПП без сохранения изменений. 

6. Проставить номера позиций. 

Рис. 18.4 
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 Рис. 18.5 Начало (продолжение и окончание см. на с. 512 и 513) 
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 Рис. 18.5 Продолжение (начало см. на с. 511, окончание – на с. 513) 
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 Рис. 18.5 Окончание (начало см. на с. 511 и 512) 
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7. Если вся информация в спецификации поместилась на четырех листах 

и менее, то в соответствии с п. 4 из 18.1 необходимо скрыть ЛР. 

Для этого выполнить п. 9 из 9.2. 

8. Сохранить изменения в спецификации (Ctrl+S). 

9. При желании выполнить 6-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. М). 

Результат в варианте «П1» показан на рис. 18.5. 

Примечание. По п. 4 из 18.1 допускается несколько возможных вариан-

тов записи позиций (примеры показаны на рис. 18.6), однако в документе 

следует придерживаться единообразия и использовать только один из них. 

 

Сохранение в формате PDF будет произведено после уточнения форма-

тов листов сборочного чертежа «усилителя» в разд. 19. 

Требования к содержанию отчета по данному этапу приведены в 19.4. 

 

 

Рис. 18.6 
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19. СБОРОЧНЫЙ ЧЕРТЕЖ «УСИЛИТЕЛЯ» 

19.1. Правила выполнения сборочных чертежей 

Сборочный чертеж по ГОСТ Р 2.102–2023 – графический КД, содер-

жащий изображение сборочной единицы и другие данные, необходимые для 

ее сборки (изготовления) и контроля. Код сборочного чертежа – СБ. 

Правила оформления сборочных чертежей можно разделить на две 

группы: 

1. Общие требования к сборочным чертежам по ГОСТ Р 2.109–2023. 

1.1. Количество сборочных чертежей должно быть минимальным, но до-

статочным для рациональной организации производства (сборки и контроля) 

изделий. При необходимости на сборочных чертежах приводят данные о ра-

боте изделия и о взаимодействии его составных частей. 

1.2. Сборочный чертеж должен содержать: 

– изображение сборочной единицы, дающее представление о располо-

жении и взаимной связи составных частей, соединяемых по данному черте-

жу, и обеспечивающее возможность осуществления сборки и контроля сбо-

рочной единицы. Допускается помещать дополнительные схематические 

изображения соединения и расположения составных частей изделия; 

– размеры, предельные отклонения и другие парамерты и требования, 

которые должны быть выполнены или проконтролированы по данному сбо-

рочному чертежу. Допускается указывать в качестве справочных размеры де-

талей, определяющие характер сопряжения; 

– указания о характере сопряжения и методах его осуществления (если 

точность сопряжения обеспечивается не заданными предельными отклонени-

ями размеров, а подбором, пригонкой и т. п.), а также указания о выполнении 

неразъемных соединений (сварных, паяных и др.); 

– номера позиций составных частей, входящих в изделие; 

– габаритные размеры изделия; 

– установочные, присоединительные и другие необходимые справочные 

размеры; 

– техническую характеристику изделия (при необходимости); 

– координаты центра масс (при необходимости). 

1.3. Если при сборке изделия для его регулировки, настройки, компенса-

ции составные части подбирают, то на сборочном чертеже их изображают в 

одном из возможных вариантов применения. 
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1.4. На поле сборочного чертежа допускается помещать отдельные изоб-

ражения нескольких деталей, на которые допускается не выпускать рабочие 

чертежи, при условии сохранения ясности чертежа. 

Над изображением детали наносят надпись, содержащую номер позиции 

и масштаб изображения, если он отличается от масштаба, указанного в ос-

новной надписи чертежа. 

1.5. Сборочные чертежи следует выполнять, как правило, с упрощения-

ми по требованиям стандартов ЕСКД. Допускается не показывать: 

– фаски, скругления, проточки, углубления, выступы и другие мелкие 

элементы; 

– зазоры между стержнем и отверстием; 

– крышки, перегородки и т. п., если необходимо показать закрытые ими 

составные части изделия (при этом над изображением делают соответствую-

щую надпись, например: «Крышка поз. 3 не показана»); 

– видимые составные части изделий и их элементы, частично закрытые 

впереди расположенными составными частями; 

– надписи на табличках, шкалах и т. п., изображая только их контур. 

Примеры упрощений показаны на рис. 19.1. 

 

1.6. На сборочном чертеже все составные части сборочной единицы ну-

меруют в соответствии с номерами позиций, указанными в спецификации 

Рис. 19.1 [15] 
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этой сборочной единицы. Номера пози-

ций наносят на полках линий-выносок, 

проводимых от изображений составных 

частей (рис. 19.2). 

1.7. Номера позиций указывают на 

тех изображениях, на которых соответ-

ствующие составные части проецируют-

ся как видимые, как правило, на основ-

ных видах и заменяющих их разрезах. 

1.8. Номера позиций располагают параллельно основной надписи чер-

тежа вне контура изображения и группируют в колонку или строчку, по воз-

можности на одной линии. 

1.9. Номер позиции наносят на чертеже, как правило, один раз. Допуска-

ется повторно указывать номера позиций одинаковых составных частей. 

1.10. Размер шрифта номеров позиций должен быть на 1–2 номера 

больше, чем размер шрифта размерных чисел на том же чертеже. 

1.11. Допускается делать общую линию-выноску с вертикальным распо-

ложением номеров позиций (в порядке возрастания сверху вниз): 

– для группы крепежных деталей, относящихся к одному и тому же ме-

сту крепления. Если крепежных деталей две и более и при этом разные со-

ставные части крепятся одинаковыми крепежными деталями, то количество 

их допускается проставлять в скобках после номера соответствующей пози-

ции и указывать только для одной единицы закрепляемой составной части, 

независимо от количества этих составных частей в изделии; 

– для группы деталей с отчетливо выраженной взаимосвязью, исключа-

ющей различное понимание, при невозможности подвести линию-выноску к 

каждой составной части. В этих случаях линию-выноску отводят от закреп-

ляемой составной части; 

– для отдельных составных частей изделия, если графически изобразить 

их затруднительно. В этом случае допускается на чертеже эти составные ча-

сти не показывать, а местонахождение их определять при помощи линии-

выноски от видимой составной части и на поле чертежа, в ТТ помещать со-

ответствующее указание, например: «Жгуты поз. 12 под скобками обернуть 

прессшпаном поз. 22». 

2. Правила выполнения сборочных чертежей изделий, изготовляемых с 

применением электрического монтажа, по ГОСТ 2.413–72. 

Рис. 19.2 



 

 518 

2.1. КД изделия с электромонтажом выполняют в одном из четырех ва-

риантов: 

– А – для изготовления изделия, механическую сборку и электромонтаж 

которого целесообразно производить по одному и тому же чертежу, выпус-

кают сборочный чертеж по ГОСТ Р 2.109–2023 и ГОСТ 2.413–72 и специфи-

кацию в соответствии с ГОСТ Р 2.106–2019 и ГОСТ 2.413–72. Такой вариант 

обычно используется для ПП с элементами; 

– Б – для изготовления изделия, механическую сборку и электромонтаж 

которого производить по одному и тому же чертежу нецелесообразно, вы-

пускают: на изделие механической сборки – сборочный чертеж в соответ-

ствии с ГОСТ Р 2.109–2023 и спецификацию по ГОСТ Р 2.106–2019; на изде-

лие с электромонтажом – сборочный чертеж в соответствии с ГОСТ 2.413–72 

и спецификацию по ГОСТ Р 2.106–2019; 

– В – для изготовления изделия, механическую сборку и электромонтаж 

которого производить по одному и тому же чертежу нецелесообразно и чер-

теж для электромонтажа выполнять как сборочный нерационально, выпус-

кают: для механической сборки – сборочный чертеж в соответствии с ГОСТ 

Р 2.109–2023 и спецификацию по ГОСТ Р 2.106–2019; для электромонтажа – 

электромонтажный чертеж в соответствии с ГОСТ 2.413–72 с присвоением 

обозначения монтируемого изделия. Составные части, устанавливаемые по 

электромонтажному чертежу, вносят в спецификацию монтируемого изделия 

в дополнительных разделах; 

– Г – для изготовления изделия, механическую сборку и электромонтаж 

которого производить по одному и тому же чертежу нецелесообразно и вы-

пуск чертежа для электромонтажа затруднителен или нерационален, выпус-

кают для механической сборки сборочный чертеж по ГОСТ Р 2.109–2023 и 

спецификацию по ГОСТ Р 2.106–2019, а в ТТ чертежа приводят ссылку на 

документ, которым следует руководствоваться при электромонтаже – либо на 

схему соединений (код – Э4) или принципиальную (для изделия индивиду-

ального производства или опытного образца), либо на таблицу соединений 

(для изделия серийного производства, в котором при электромонтаже уста-

навливают только соединительные проводники, прокладка и крепление кото-

рых определены конструкцией изделия). 

2.2. Если составная часть является элементом схемы Э3 изделия, то на ее 

изображении или около него (предпочтительно над ним или справа) наносят 

позиционное обозначение, присвоенное этому элементу в схеме. 
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2.3. Элементам, не указанным в схеме принципиальной или соединений, 

но участвующим в электрических соединениях (например, переходным стой-

кам, лепесткам заземления и т. п.), для указания адресов присоединения про-

водников присваивают очередные позиционные обозначения после элемен-

тов того же функционального назначения, изображенных на схеме. 

2.4. Если составная часть, являющаяся элементом схемы Э3 изделия, 

должна быть подобрана при его регулировании, то на чертеже позиционное 

обозначение этого элемента наносят со знаком звездочки (например, R16*), а 

в ТТ чертежа помещают указание: «* Подбирают при регулировании». 

2.5. Проводник (провод, кабель, жгут, шину) изображают в соответствии 

с требованиями ГОСТ 2.414–75 [83]. 

2.6. Допускается не наносить на чертеже номера позиций, под которыми 

записаны в спецификации: 

– устанавливаемые при электромонтаже составные части, являющиеся 

элементами схемы Э3 изделия и внесенные в его спецификацию в разделах 

«Стандартные изделия» и «Прочие изделия»; 

– провода и кабели, внесенные в спецификацию в разделе «Материалы». 

19.2. Особенности монтажа компонентов 

После изготовления ПП наступает очередь сборки печатного узла, т. е. 

процесс установки компонентов на их посадочные места [84]–[88]. 

Печатный узел (printed board assembly) по ГОСТ Р 53386–2009 – ПП с 

подсоединенными к ней в соответствии с чертежом электрическими и меха-

ническими элементами и (или) другими ПП. 

Соединение деталей легкоплавким сплавом называют пайкой, при этом 

их расплавления, в отличие от сварки, не происходит. Процесс пайки больше 

похож на склеивание, где в качестве клея выступает разогретый припой – 

сплав с достаточно низкой температурой плавления. Пайка – основной спо-

соб создания неразъемного соединения компонентов с проводниками ПП. 

Припои обладают различными свойствами в зависимости от комбинации 

олова, свинца, висмута, меди, цинка, кадмия, серебра и других компонентов. 

Выпускаются они в виде литых чушек, прутков, проволоки или тонкой труб-

ки, содержащей для облегчения пайки наполнитель аналогичный флюсу (рис. 

19.3). В расплавленном состоянии припой должен обеспечивать хорошее 

смачивание соединяемых поверхностей, тягучесть и достаточно прочное ме-

ханическое соединение деталей после остывания. 
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Припои делятся на две группы: 

– традиционные (оловянно-свинцовые 

сплавы или близкие к ним по составу); 

– бессвинцовые (не содержащие свинца 

сплавы). 

Из традиционных припоев для монтажа 

компонентов на ПП можно выделить сле-

дующие марки по ГОСТ 21930–76 [89]: 

– ПОС 61 (содержание олова – 61 %, 

свинца – 39 %; температура полного рас-

плавления – 190 °C). Применяется для лу-

жения и пайки электро- и радиоаппаратуры, печатных схем, точных прибо-

ров с высокогерметичными швами, где недопустим перегрев; 

– ПОСК 50-18 (содержание олова – 50 %, кадмия – 18 %, свинца – 32 %; 

температура полного расплавления – 145 °C). Применяется для пайки дета-

лей, чувствительных к перегреву, металлизированной керамики и для сту-

пенчатой пайки конденсаторов. 

Пример бессвинцового сплава – Sn95,5/Ag3,8/Cu0,7 (температура пол-

ного расплавления – 217 °C). Главные недостатки бессвинцовых припоев по 

сравнению с традиционными – матовость паяных соединений, высокая цена, 

зачастую меньшая смачиваемость и высокая температура плавления. 

Поверхности деталей для хорошего соединения пайкой обрабатываются 

флюсом – неметаллическим материалом, применяемым 

для химической очистки соединяемых поверхностей и 

обеспечивающим прочность связи в области пайки. Во 

время пайки флюс растворяет оксиды и сульфиды на со-

единяемых поверхностях, образуя защитную пленку от 

воздействия кислорода. 

Остатки флюса не должны изменять электрические 

характеристики материалов и вызывать коррозию, при 

этом они должны легко удаляться после монтажа. 

Для монтажа радиоэлементов на ПП применяются 

бескислотные флюсы, созданные на основе легколетучих 

компонентов. Примером может служить флюс ЛТИ-120 

(рис. 19.4), выполненный на основе канифоли и этилового 

спирта. 

Рис. 19.3 

Рис. 19.4 
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Технологии сборки ПП зависят от устанавливаемых электронных ком-

понентов и бывают следующих типов: 

– выводной монтаж (монтаж компонентов, выводы которых устанавли-

ваются в КП с отверстиями); 

– поверхностный монтаж (монтаж SMD-компонентов, контакты которых 

устанавливаются на планарные КП); 

– смешанный монтаж (выводной и поверхностный монтаж). 

Несмотря на повсеместное использование SMD-компонентов, позволя-

ющих достичь высокой плотности монтажа, снизить объем, вес и размеры 

изделия, остаются категории электронных 

приборов, где выводной монтаж доминиру-

ет над другими технологиями – силовая 

электроника, источники питания, высоко-

вольтные модули и другие. Также суще-

ствуют компоненты, в большинстве своем 

не имеющие аналогов в планарном испол-

нении – разъемы (см. рис. 8.33 и 19.5), реле, 

трансформаторы. 

Зачастую перед монтажом выводного компонента производится фор-

мовка выводов (рис. 19.6), обеспечивающая требуемый вариант его установ-

ки (заданные расстояния между концами выводов и между ПП и компонен-

том, положение компонента относительно поверхности ПП). 

При этом существует ряд ограничений: 

– формовка не должна повреждать выводы и нарушать 

нанесенные на них покрытия; 

– не допускается изгиб вывода в точке его соединения с 

корпусом (изгиб должен производиться только на расстоя-

нии не менее допустимого); 

– должен быть исключен поворот вывода относительно 

корпуса компонента; 

– длина вывода от корпуса компонента до области пайки должна пре-

вышать 2,5 мм; 

– запрещается формовать выводы компонентов в корпусах, имеющих 

множество выводов, например микросхем в DIP корпусе, и др. 

Формовку выводов проводят с использованием ручных приспособлений 

и полуавтоматических установок (рис. 19.7). 

Рис. 19.5 [84] 

Рис. 19.6 [84] 



 

 522 

Поверхностный монтаж на произ-

водстве состоит из следующих этапов: 

– перенос паяльной пасты; 

– установка компонентов; 

– расплавление пасты; 

– контроль. 

Паяльная паста – густая смесь 

из размельченного припоя и жидкого 

флюса. Ее нанесение на КП может 

выполняться дозатором (для макетно-

го образца ПП при автоматическом 

монтаже) или через трафарет. 

Трафарет (рис. 19.8) применяется 

обычно при серийном производстве 

из-за относительно высокой стоимо-

сти изготовления и представляет со-

бой металлическую пластину толщи-

ной от 0,075 до 0,2 км с прорезями 

прямоугольной, трапециевидной или 

круглой формы. Для обеспечения по-

стоянства объема наносимой пасты и 

ее легкого выхода на ПП прорези вы-

полняют с закругленными углами. 

Паяльная паста продавливается 

через прорези в трафарете с помощью 

ракеля (рис. 19.9), изготовленного из 

резины, пластика или металла. 

Установка планарных компонен-

тов на ПП с нанесенной паяльной пас-

той (рис. 19.10) может выполняться 

вручную или с помощью средств ав-

томатизации. 

Расплавление паяльной пасты 

может осуществляться с помощью го-

рячего воздуха, инфракрасного излу-

чения, кварцевого нагрева и их комбинацией, а также лазерным лучом. 

Рис. 19.8 [84] 

Рис. 19.9 [84] 

Рис. 19.10 [84] 

Рис. 19.7 [84] 
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Монтаж компонентов на ПП можно разделить на три вида: 

– ручной монтаж (сборка осуществляется вручную); 

– автоматический монтаж (установкой и запайкой всех компонентов за-

нимается непосредственно станок); 

– полуавтоматический монтаж (часть работы выполняется в автоматиче-

ском режиме, а часть – в ручном). 

Ручной монтаж используется в следующих случаях: 

– если применение автоматического оборудования невыгодно из-за ма-

лого объема заказа или из-за сборки нескольких макетных образцов; 

– если ПП не подходят для автоматического монтажа; 

– при установке компонентов после автоматического монтажа. 

При ручном монтаже монтажник про-

веряет внешний вид каждого компонента 

перед установкой, при необходимости вы-

полняя очистку выводов от окислов и их 

лужение.  

Лужение – процесс покрытия поверх-

ностей металлических изделий тонким сло-

ем припоя (металл, наносимый на поверх-

ность изделия, называется полудой). 

Для установки компонентов при руч-

ном виде монтажа используются: 

– паяльник (рис. 19.11), включенный 

через регулятор мощности. Без такого 

устройства температура на жале большин-

ства обычных паяльников может достигать 

350–400 ºC, что зачастую оказывается не-

приемлемо; 

– паяльная станция со стабилизиро-

ванной температурой; 

– паяльный фен – термовоздушная па-

яльная станция (рис. 19.12). 

Пайка феном, как следует из названия прибора, осуществляется потоком 

горячего воздуха (рис. 19.13), скорость и температуру которого можно регу-

лировать. Такой способ незаменим для монтажа микросхем в корпусах типа 

QFN (Quad flat no-leads) и подобных (см. рис. 8.23). 

Рис. 19.11 [84] 

Рис. 19.12 
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Компоненты при пайке обычно 

удерживают пинцетом. 

К дефектам, возникающим при 

ручном монтаже, можно отнести сле-

дующие: 

– образование перемычек между 

выводами компонентов (рис. 19.14). 

Для их удаления используют оплетку 

из экранированного провода, на кото-

рую собирают весь лишний припой 

(рис. 19.15); 

 

– «холодная» пайка (см. рис. Б.21 и 19.16), 

возникающая при недостаточном прогреве 

(например, при пайке выводов к большим по-

лигонам металлизации), при плохой обработке 

поверхностей (некачественный или неподхо-

дящий флюс) и плохой их фиксации в процес-

се остывания; 

– образование бугров и оголение КП 

(рис. 19.17), возникающее из-за плохой смачиваемости поверхностей (плохие 

свойства флюса, неправильный выбор температуры пайки, загрязнение по-

верхностей или выделение паров растворителя флюса). 

Автоматический монтаж незаменим при серийном производстве и обла-

дает следующими достоинствами – надежность, снижение себестоимости, 

высокая точность, скорость, монтаж миниатюрных элементов и автоматиче-

ский контроль. 

Рис. 19.15 Рис. 19.14 [88] 

Рис. 19.16 [84] 

Рис. 19.13 
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Выполняется такой монтаж с помощью 

специального оборудования – установщиков 

компонентов и автоматов для пайки. 

Паспортная производительность совре-

менного монтажного оборудования достигает 

20000–40000 компонентов в час (при монтаже 

компонентов сложной формы – меньше). 

Монтажные автоматы оснащаются различны-

ми загрузочными устройствами (питателями): 

– ленточные питатели (для подачи компонентов, вклеенных в ленту); 

– питатели из трубчатых кассет (для микросхем в DIP-корпусе и компо-

нентов сложной формы) и др. 

Выбор технологии пайки осуществляется в зависимости от количества 

монтируемых элементов, их местоположения, объема сборки и сложности.  

Автоматический монтаж выводных компонентов выполняется с помо-

щью пайки волной припоя или на линии селективного монтажа. 

Пайка волной припоя применяется как для пайки навесных, так и 

SMD-компонентов. Для фиксации компонентов используется специальный 

клей, который наносится на их нижние поверхности, иногда содержащие 

вспомогательные выступы (Glue Pad на рис. 5.13). 

ПП, установленные на транспортере, подвергаются нанесению флюса 

(способом пенного флюсования или распыления) и предварительному нагре-

ву (в среднем 100 °C), исключающему 

тепловой удар на этапе пайки. Затем 

ПП проходят над волной припоя. Сама 

волна, ее форма и динамические ха-

рактеристики являются наиболее важ-

ными параметрами оборудования для 

пайки. Направление и скорость дви-

жения потока припоя, достигающего 

ПП, а также угол наклона транспорте-

ра для ПП могут варьироваться.  

Упрощенная схема процесса 

групповой пайки волной показана на рис. 19.18. 

Часто установки для пайки оборудуются дешунтирующим «воздушным 

ножом», представляющим собой узкий поток нагретого воздуха, разрушаю-

Рис. 19.18 [87] 

Ванна  
припоя 

Рис. 19.17 [84] 
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щий перемычки из припоя и способствующий удалению его остатков. Нож 

располагается сразу же за участком прохождения волны припоя. 

В ряде случаев используется 

двойная волна (рис. 19.19). Первая 

волна делается турбулентной и узкой. 

Она исходит из сопла под большим 

давлением, что исключает формиро-

вание полостей с газообразными про-

дуктами разложения флюса. Однако 

турбулентная волна все же образует перемычки припоя, которые разрушают-

ся второй, более пологой ламинарной волной с малой скоростью истечения. 

Температура пайки находится в диапазоне 235–260 °C. 

Для качественной и эффективной пайки волной SMD-компонентов тре-

буется правильно выбирать номенклатуру элементной базы, осуществлять 

грамотную компоновку печатного узла, задавая при этом правильную гео-

метрию КП для компонентов на нижней стороне ПП, например: 

– нельзя располагать на нижней стороне SMD-компоненты с малым ша-

гом выводов (менее 0,8 мм) из-за высокой вероятности возникновения корот-

ких замыканий между ними (рис. 19.14). Это же справедливо и для расстоя-

ний между КП соседних компонентов; 

– нельзя располагать на нижней стороне компоненты, которые могут 

разрушиться или частично потерять свои свойства при погружении в рас-

плавленный припой (например, SMD-светодиоды крайне чувствительны к 

перегреву); 

– нельзя располагать на нижней 

стороне SMD-компоненты с высотой 

корпуса более 3,5 мм из-за высокой 

вероятности зацепления за элементы 

конструкции ванны припоя, а также 

из-за низкой эффективности пайки 

вследствие эффекта «затенения», ко-

торый проявляется в том, что припой 

из-за сил отталкивания от поверхности ПП и корпуса компонента не достает 

до КП (рис. 19.20). В результате пайки не происходит (рис. 19.21). Это же 

справедливо и для случая, когда КП очень маленькие, либо расположены в 

труднодоступных областях ПП. 

Рис. 19.19 [87] 

Рис. 19.20 [88] 

Место приклейки 

компонента 
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В отличие от пайки волной, при которой 

происходит групповая пайка компонентов (вся 

ПП проходит через волну припоя), система се-

лективной пайки осуществляет пайку соединений 

выборочно, в соответствии с заданной програм-

мой. Производительность такого способа гораздо 

ниже, однако он менее требователен к дизайну 

ПП. Нанесение флюса в этом случае происходит 

точечно и дозировано. В процессе пайки он вы-

горает, и отмывка его остатков не требуется. 

После завершения монтажа компонентов на ПП проводят завершающие 

этапы: 

– отмывка печатного узла, применяющаяся для ликвидации твердых и 

жидких остатков флюса, так как он может сказаться на параметрах электрон-

ного модуля. Часто ее проводят вручную спирто-бензиновой смесью, но су-

ществуют и более эффективные средства – специальные промывочные жид-

кости. Отмывка обеспечивает не только достойный внешний вид модулей, но 

и хороший контакт ПП с влагозащитным покрытием; 

– проверка изделия на работоспособность; 

– при необходимости покрытие печатного узла несколькими слоями во-

достойкого лака, каждый из которых сушат горячим воздухом. Лак предот-

вращает воздействие влаги, улучшает тепловой режим компонентов печатно-

го узла и повышает вибрационную прочность. 

19.3. Создание сборочного чертежа «усилителя» 

Сборочный чертеж «усилителя» будет создаваться с использованием 

данных файла трассировки из разд. 12, 3D-модели «усилителя» из разд. 13 и 

чертежей установки компонентов, один из которых был сделан для тантало-

вого конденсатора в разд. 7. 

Последовательность действий для сборочного чертежа «усилителя»: 

1. В КОМПАС-3D открыть 3D-модель «усилителя» (расположение ука-

зано в п. 2.3 из 13.1). 

2. СКМ повернуть «усилитель» в рабочем поле так, чтобы спереди ока-

зались компоненты, установленные на ПП, после чего щелкнуть ЛКМ по 

верхней поверхности ПП (рис. 19.22) и в появившейся над курсором ПИ 

нажать пиктограмму Нормально к. 

Рис. 19.21 [88] 
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Сохранить ориентацию 3D-модели, 

добавив новый вид с помощью коман-

ды Вид ⇒ Ориентация и присвоив ему 

имя (например, Главный). 

Сохранить изменения (Ctrl+S) и 

закрыть вкладку с 3D-моделью. 

3. По информации из 7.1 создать 

новый чертеж и задать следующие 

настройки листа:  

– формат – A3; 

– ориентация – горизонтальная; 

– оформление – Чертеж констр. Первый лист. ГОСТ 2.104-2006. 

4. Сохранить чертеж командой Файл ⇒ Сохранить как с расширением 

«.cdw». Имя файла в варианте «П1» – «УП1.01.01СБ - Усилитель - v0.1», а 

путь сохранения – …\ИДРЭС-П1\Усилитель (см. рис. 2.8). 

5. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

6. Запустить команду Стандартные виды (см. рис. 7.6) и указать путь к 

3D-модели «усилителя». 

В Панели свойств на вкладке Параметры выполнить следующее: 

– в поле Ориентация главного вида выбрать Главный (задан в п. 2); 

– в поле Схема видов указать только вид спереди и вид слева (распо-

ложение видов см. на рис. 7.3); 

– в поле Масштаб вида выбрать 

масштаб 2,5:1. 

На рис. 19.23 показан результат в 

варианте «П1» с обозначением видов. 

7. В Дереве чертежа изменить 

название видов: Главный 1 на Вид 

спереди, Проекционный вид 2 на 

Вид слева (см. п. 7 из 17.2). 

8. Заполнить графы рамки в со-

ответствии с табл. 19.1. Содержание остальных граф должно соответствовать 

данным табл. 17.1. 

Пояснения к заполнению приведены в п. 8 из 17.2. 

Пояснения к графам даны в табл. 3.1 и на рис. 3.6. 

Рис. 19.23 

Вид спереди Вид слева 

Рис. 19.22 
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Таблица 19.1 

Содержание граф рамки для сборочного чертежа «усилителя», 

отличающихся от чертежа ПП 

Номер  

графы 
Содержание Комментарий к заполнению 

1 
Усилитель 

Сборочный чертеж 

Наименование изделия определено в табл. 2.1 и записы-

вается автоматически, так как было задано в свойствах 

3D-модели. 

Наименование документа указывается командой ПКМ ⇒ 

Вставить код и наименование. В открывшемся окне 

выбирается строчка с кодом СБ, внизу окна отключается 

опция Код через пробел и нажимается OK. 

Параметры шрифта в Панели свойств на вкладке Фор-

мат: 

– для наименования изделия: высота символов – 7, шаг 

строк – 11; 

– для наименования документа: высота символов – 5, шаг 

строк – 8 

2 УП1.01.01СБ 

Обозначение документа определено в табл. 2.1, указано 

для варианта «П1» и записывается автоматически, так 

как было задано в свойствах 3D-модели, а код докумен-

та – при заполнении графы 1. 

Данные этой графы повторяются на каждом новом листе 

3 См. комментарий Графа должна остаться пустой 

5 7,9 г 

Заполняется автоматически при выборе в Панели 

свойств на вкладке Параметры в поле Единицы изме-

рения массы опции граммы, а в поле Точность пред-

ставления значения 1 (0 – при отсутствии десятых до-

лей) 

26 УП1.01.01СП 

Заполняется автоматически и полностью соответствует 

содержанию графы 2. 

Данные этой графы повторяются на каждом новом листе 

Результат заполнения граф основной надписи в варианте «П1» показан 

на рис. 19.24. 

 Рис. 19.24 
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9. Запустить режим редактирования основной надписи и в Панели 

свойств на вкладке Параметры отжать пиктограмму Синхронизация дан-

ных (см. рис. 7.7), тем самым отключив передачу данных между 3D-моделью 

и основной надписью чертежа. 

10. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

11. Разрушить оба добавленных вида. 

12. На Виде спереди удалить все графические элементы, кроме контура 

ПП и крепежных отверстий. 

13. Командой Обозначение цен-

тра (см. рис. 17.5) из ПИ Компактная 

панель ⇒ Обозначения с зажатой 

клавишей Shift (временное включение 

режима Ортогональное черчение) 

обозначить центры крепежных отвер-

стий. 

Результат на данном этапе в ва-

рианте «П1» показан на рис. 19.25. 

14. Добавить на Вид спереди информацию о контурах компонентов и их 

позиционных обозначениях: 

14.1. В Altium Designer выполнить следующие действия: 

– открыть проект ПП (см. п. 1 из 12.1); 

– открыть файл трассировки по п. 3 из 8.3; 

– включить набор слоев Shield; 

– скрыть слои Top Layer и M7 Shield, выполнив на вкладках с их назва-

ниями команды ПКМ ⇒ Hide; 

– показать слой M1 Board, выполнив на строке с вкладками слоев ко-

манду ПКМ ⇒ Show Layers ⇒ M1 Board; 

– запустить команду File ⇒ Export ⇒ DXF/DWG; 

– в открывшемся окне Export File задать путь и имя для сохранения фай-

ла в формате DXF. Имя файла в варианте «П1» – «TopAssy», а путь сохране-

ния – …\ИДРЭС-П1\Усилитель\_Модели. Затем нажать кнопку Сохранить; 

– в появившемся окне Export to AutoCAD задать настройки с рис. 13.10, 

но с отключенной опцией Export pads and via holes, после чего запустить 

процесс экспорта кнопкой OK; 

– закрыть сообщение об успешном завершении процесса. 

14.2. В КОМПАС-3D открыть файл TopAssy.DXF (см. п. 12.4 из 13.1). 

Рис. 19.25 
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14.3. Удалить размерные линии, таблицу с отверстиями, входные и вы-

ходные КП. 

Результат в варианте «П1» на данном этапе показан на рис. 19.26. 

 

14.4. Выделить все объекты (Ctrl+A) и назначить линиям и дугам стиль 

линии Основная (см. п. 12.6 из 13.1). 

14.5. Скопировать выделенные объекты (Ctrl+C), указав базовую точку 

в любом угле контура ПП. 

14.6. На вкладке со сборочным чертежом «усилителя» убедиться в том, 

что Вид спереди является текущим, после чего вставить (Ctrl+V) скопиро-

ванные объекты в любое свободное место (рис. 19.27). 

 Рис. 19.27 

Рис. 19.26 
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14.7. Закрыть вкладку с TopAssy.dxf с со-

хранением изменений. 

14.8. Выполнить команду Выделить ⇒ По 

типу ⇒ Тексты для выделения всех позицион-

ных обозначений, после чего запустить коман-

ду Редактор ⇒ Свойства (или нажать соответ-

ствующую пиктограмму на ПИ Стандартная) 

и в появившемся окне Свойства задать следу-

ющие настройки (рис. 19.28): 

– в поле Угол наклона – 0; 

– в поле Размещение текста – По центру; 

– в поле Высота символов – 3.5; 

– в поле Цвет текста – черный. 

После этого снять выделение с надписей, 

щелкнув ЛКМ в любом свободном месте рабо-

чего поля. 

14.9. На данном этапе каждая надпись 

находится на белом фоне, который закрывает собой линии. Чтобы его убрать, 

необходимо воспользоваться одним из двух способов: 

– отдельно для каждой надписи отключить опцию Очистить фон (ко-

манда ПКМ ⇒ Очистить фон); 

– отключить опцию Прерывать штриховки и линии в меню Сервис ⇒ 

Параметры ⇒ Текущий чертеж ⇒ Перекрывающиеся объекты. 

Второй способ на текущем шаге 

рациональнее. 

14.10. Выполнить команду Вы-

делить ⇒ По типу ⇒ Заливки для 

выделения всех заливок, обозначаю-

щих положение первых выводов ком-

понентов, полярных выводов и выво-

дов катодов. 

Затем в окне Свойства в поле 

Цвет 1 выбрать черный цвет. 

После этого снять выделение с 

заливок и закрыть окно Свойства. 

Результат в варианте «П1» на данном этапе показан на рис. 19.29. 

Рис. 19.28 

Рис. 19.29 
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14.11. Выделить всю ПП с компонен-

тами, после чего запустить команду Вы-

делить ⇒ Исключить ⇒ Объект и после-

довательными щелчками ЛКМ исключить 

из выделения контур ПП. 

14.12. Запустить команду Сдвиг из 

ПИ Компактная панель ⇒ Редактирова-

ние (см. рис. 6.20), указать в качестве ба-

зовой точки любой угол ограничивающего 

выделенные объекты контура и переме-

стить их внутрь контура ПП на Виде спе-

реди (рис. 19.30). 

14.13. Удалить контур, из которого 

производилось перемещение объектов. 

Примечание. Очертания компонентов 

были взяты из файла трассировки взамен 

очертаний из 3D-модели «усилителя», так 

как они не содержат мелких деталей (см. 

п. 1.5 из 19.1) и в них есть необходимые 

обозначения выводов. 

14.14. Расставить позиционные 

обозначения компонентов ПП в соот-

ветствии с п. 2.2 из 19.1. 

Примечание. Перемещение каж-

дого позиционного обозначения осу-

ществляется зажатой ЛКМ за сред-

нюю характерную точку, появляю-

щуюся после его выбора. 

14.15. Рекомендуется визуально 

проверить по файлу трассировки, что 

позиционные обозначения на сбороч-

ном чертеже расположены около соответствующих им компонентов. 

Результат в варианте «П1» на данном этапе показан на рис. 19.31. 

14.16. Закрыть файл трассировки без сохранения изменений. 

15. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

16. Включить режим Ортогональное черчение клавишей F8. 

Рис. 19.30 

Рис. 19.31 
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17. На каждом из двух видов командой Линейный размер или Авто-

размер (см. рис. 7.21) проставить габаритные размеры, при этом обратив 

внимание на следующее: 

– вид, на котором проставляются размеры, должен быть текущим; 

– добавленные размеры должны удовлетворять требованиям из Д.5; 

– все указанные размеры будут справочными (см. п. 2 из Д.5), поэтому 

по п. 22 из 7.3 после размерных чисел поставить знак «*»; 

– для выравнивания размеров служит команда, указанная в п. 17 из 17.2; 

– при необходимости сдвинуть Вид слева вправо от Вида спереди. 

18. Отключить режим Ортогональное черчение клавишей F8. 

19. Командой Сдвиг (см. рис. 6.20) сдвинуть оба вида в верхний левый 

угол чертежа, при этом виды должны остаться на одной горизонтали. 

20. Сделать текущим Вид спереди, запустить ко-

манду Обозначение позиций из ПИ Компактная па-

нель ⇒ Обозначения (рис. 19.32) и указать номер по-

зиции ПП по спецификации «усилителя» (в варианте «П1» по рис. 18.5 – 1). 

Примечания: 

– правила простановки номеров позиций указаны в пп. 1.6–1.11 из 19.1; 

– номера позиций остальных компонентов по п. 2.6 из 19.1 не ставятся; 

– лишние ответвления (при наличии) можно удалить по п. 24 из 7.3. 

 Рис. 19.33 

Рис. 19.32 

Обозначение 

позиций 
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21. Сделать текущим Вид слева и командой Усечь кривую из ПИ Ком-

пактная панель ⇒ Редактирование (см. рис. 6.20) оставить только внешние 

очертания компонентов (см. п. 1.5 из 19.1). 

При необходимости воспользоваться командой Удлинить до ближай-

шего объекта из той же ПИ. 

Результат в варианте «П1» на данном этапе показан на рис. 19.33. 

22. В Altium Designer выполнить подготовительные действия для раз-

мещения установочных чертежей компонентов: 

– открыть схему Э3 «усилителя» (см. п. 3 из 8.3); 

– запустить команду Reports ⇒ Bill of Materials; 

– два раза щелкнуть ЛКМ по названию столбца Show, расположенному 

около столбца All Columns, и отключить отображение столбцов CI_BOM, 

CI_Manufacturer и Quantity; 

– включить отображение параметров PI_Drawing и Footprint; 

– осуществить группировку информации по параметру PI_Drawing, для 

чего перетащить его название зажатой ЛКМ из столбца All Columns в стол-

бец Grouped Columns; 

– в правой части окна Bill of Materials перетащить зажатой ЛКМ стол-

бец PI_Drawing в крайнее левое положение; 

– убедиться в том, что сортировка данных осуществляется по столбцу 

Designator в порядке следования позиционных обозначений (рис. 19.34). 

 

Примечания: 

– установочные чертежи компонентов для удобства их поиска на сбо-

рочном чертеже рекомендуется размещать в порядке следования позицион-

ных обозначений. Этим и обусловлена сортировка по столбцу Designator; 

Рис. 19.34 
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– в столбце PI_Drawing записаны названия файлов установочных чер-

тежей компонентов и видов с соответствующими изображениями (напри-

мер, в варианте «П1» из файла CAP понадобится два чертежа); 

– в столбце Footprint записаны названия посадочных мест, заданные для 

компонентов в проекте. Эта информация требуется для компонентов с не-

сколькими вариантами установки посадочных мест (например, диод VD1) и 

для контроля. 

23. Добавить установочные чертежи компонентов, используя получен-

ную информацию из Altium Designer. 

Так как добавление установочных чертежей однотипно, то далее приве-

дены действия только для танталового конденсатора в корпусе типоразмера 

C, записанного в варианте «П1» с позиционными обозначениями С1 и C6 

(см. рис. 18.5 и 19.34): 

23.1. Открыть чертеж установки компонента (расположение указано в 

п. 4 из 7.3). 

Примечание. Установочные чертежи остальных компонентов нахо-

дятся в папке …\ИДРЭС\Монтаж элементов (см. рис. 2.9). 

23.2. На вкладке с установочным чертежом открыть Дерево чертежа и 

ЛКМ выбрать требуемый вид (в варианте «П1» – CASE-C-293D-П1), в ре-

зультате чего в рабочем поле он выделится зеленым цветом. 

Результат в варианте «П1» показан на рис. 19.35. 

 

23.3. Скопировать вид (Ctrl+C). 

23.4. Перейти на вкладку со сборочным чертежом «усилителя» и вста-

вить (Ctrl+V) скопированный вид. 

23.5. В Дереве чертежа выделить вставленный вид и в рабочем поле пе-

редвинуть его на свободное место сборочного чертежа. 

Рис. 19.35 



 

 537 

23.6. Отредактировать надпись в добавленном виде (рис. 19.36): 

– указать все позиционные обозна-

чения компонентов для данного вариан-

та установки корпуса; 

– удалить обозначение масштаба 

вида, если он совпадает с масштабом, 

указанным в основной надписи. 

23.7. Закрыть вкладку с чертежом 

установки. 

Примечание. В надписи установочного чертежа указываются не номе-

ра позиций компонентов по спецификации, а их позиционные обозначения по 

схеме, так как под одной позицией могут быть записаны компоненты, 

устанавливаемые на ПП разными способами. 

Например, резистор с двумя осевыми выводами по ГОСТ 29137–91 [90] 

можно установить одним из следующих вариантов: 

– вариант 010 (рис. 19.37, а); 

– вариант 140 (рис. 19.37, б); 

– вариант 070 (рис. 19.37, в); 

– вариант 220 (рис. 19.37, г). 

 

24. Выполнить пп. 23.1–23.7 для всех компонентов из спецификации 

«усилителя», при этом учесть следующее: 

– необходимо оставить свободное место над основной надписью сбо-

рочного чертежа для добавления ТТ; 

– при необходимости по 7.1 добавить второй лист (горизонтальный А3 

или вертикальный А4) с оформлением Чертеж констр. Посл. листы. 

ГОСТ 2.104-2006. 

Рис. 19.37 [90] 

а 

б 

в 

г 

Рис. 19.36 
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25. После размещения всех необходимых установочных чертежей вы-

полнить следующие действия в Altium Designer: 

– закрыть окно Bill of Materials кнопкой Cancel; 

– закрыть проект ПП без сохранения изменений. 

26. В КОМПАС-3D сохранить сборочный чертеж (Ctrl+S). 

27. Добавить ТТ, для чего выполнить следующие действия: 

27.1. Войти в режим редактирования ТТ. 

27.2. По п. 25.2 из 17.2 задать необходимые настройки. 

27.3. Ввести текст следующего вида: 

1 * Размеры для справок. 

2 Паять ПОС 61 ГОСТ 21930-76. 

3 Позиционные обозначения элементов показаны условно. 

4 Элементы устанавливать симметрично контактным площадкам со-

гласно приведенным вариантам установки. 

5 При ручном монтаже перед установкой микросхемы DA3 лудить все 

контактные площадки (снизу и с каждой боковой стороны) на ее корпусе 

(см. п. 2). 

6 Остальные технические требования по ОСТ4 ГО.070.015. 

При копировании необходимо обратить внимание на примечание к 

п. 25.3 из 17.2. 

27.4. Сохранить ТТ (Ctrl+S) и выйти из режима их редактирования. 

27.5. Убедиться в том, что расстояние между нижней строкой ТТ и рам-

кой основной надписи не менее 10 мм. 

При необходимости изменить положение ТТ по п. 25.5 из 17.2. 

27.6. Комментарии к отдельным пунктам ТТ из п. 27.3: 

– справочные размеры рассмотрены в п. 2 из Д.5; 

– термины припой и лужение даны в 19.2; 

– в п. 3 из ТТ указано, что позиционные обозначения на чертеже не под-

лежат маркировке и не нанесены на поверхности ПП и компонентов; 

– п. 5 из ТТ должен присутствовать, если в варианте задания есть мик-

росхемы в корпусах QFN и PDFN (см. рис. 8.23). Подобное указание необхо-

димо дать и для корпуса MSOP c одной КП снизу (exposed pad); 

– в п. 6 из ТТ дана ссылка на отраслевой стандарт ОСТ4 ГО.070.015 [92], 

устанавливающий общие ТТ (не допускается нанесение механических по-

вреждений на применяемые детали и сборочные единицы, недопустимо по-

падание в сборочные единицы посторонних предметов и частиц и др.), пра-
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вила приемки, методы испытаний, маркировку, упаковку, транспортирование 

и хранение для сборочных единиц радиоэлектронной аппаратуры. 

28. Во всех добавленных видах с чертежами установок компонентов до-

бавить ссылку на п. 2 из ТТ: 

28.1. Запустить команду Выделить ⇒ По свойствам, после чего в по-

явившемся окне в группе Обозначения выбрать опцию Линии-выноски, 

выбрать вид значка Для пайки и нажать ОК (рис. 19.38). 

 

28.2. Запустить команду Редактор ⇒ Свойства и в появившемся окне 

Свойства щелкнуть ЛКМ напротив поля Текст над полкой. 

28.3. В открывшемся окне Введите текст ввести текст «п.», затем поста-

вить пробел и после этого запустить команду ПКМ ⇒ Вставить ссылку. 

28.4. В открывшемся окне Ссылка выбрать в поле Тип источника – 

Технические требования, в поле Ссылка на – Номер пункта. 

Затем ЛКМ выбрать вторую строку и нажать OK. 

28.5. Закрыть оно Введите текст (рис. 19.39) кнопкой OK. 

 

29. Войти в режим редактирования ТТ и в пункте № 5 из ТТ заменить 

номер пункта, указанного в скобках, ссылкой с параметрами по п. 28.4. 

Затем выйти из режима редактирования ТТ. 

30. Сохранить изменения в сборочном чертеже «усилителя» (Ctrl+S). 

Результат в варианте «П1» показан на рис. 19.40. 

Рис. 19.39 

Рис. 19.38 
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 Рис. 19.40 Начало (окончание см. на с. 541) 
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 Рис. 19.40 Окончание (начало см. на с. 540) 
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 Рис. 19.41 
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Примечание. На печатный узел обычно наносится маркировка краской 

(например, обозначение основного КД и заводской номер), но в данном учеб-

ном пособии она не предусмотрена. 

31. Сохранить сборочный чертеж в формате PDF по 17.3. 

Имя файла в варианте «П1» – «УП1.01.01СБ - Усилитель - v0.1», а путь 

сохранения – …\ИДРЭС-П1\Усилитель\_pdf (см. рис. 2.8). 

32. При необходимости в спецификации на «усилитель» скорректиро-

вать формат сборочного чертежа согласно пп. 1.11 и 1.18 из 18.1. 

После внесения изменений сохранить спецификацию командой Файл ⇒ 

Сохранить как в ту же папку и с тем же расширением, но с версией v0.2. 

Результат корректировки в варианте «П1» показан на рис. 19.41. 

33. Сохранить спецификацию в формате PDF по п. 11 из 9.2. 

Имя файла в варианте «П1» – «УП1.01.01 - Усилитель - v0.2», а путь 

сохранения – …\ИДРЭС-П1\Усилитель\_pdf (см. рис. 2.8). 

34. Удалить вспомогательную информацию: 

– из папки …\ИДРЭС-П1\Усилитель – файл «УП1.01.01 - Усилитель - 

v0.1.doc» (предыдущая версия спецификации на «усилитель»); 

– из папки …\ИДРЭС-П1\Усилитель\_Модели – файлы TopAssy.dxf и 

TopAssy.frw (файлы с информацией о контурах компонентов, их позицион-

ных обозначениях и контуре ПП); 

– все backup-файлы из папки …\ИДРЭС-П1\Усилитель и ее подпапок. 

35. При желании выполнить 7-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. Н). 

19.4. Содержание отчета 

По 18-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести спецификацию на «усилитель», распечатанную на 

отдельных листах. 

По 19-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести сборочный чертеж «усилителя», распечатанный 

на отдельных листах. 

Схема складывания листа формата A3 при расположении основной 

надписи вдоль длинной стороны листа для непосредственного брошюрова-

ния показана на рис. 8.71. 
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20. ЧЕРТЕЖ «ЭКРАНА» 

20.1. Создание чертежа «экрана» 

Чертеж «экрана» будет создаваться на основе его 3D-модели, и в нем 

будут только ассоциативные виды. 

При отставании от плана (см. рис. 2.5) можно пропустить разделы с со-

зданием чертежей «экрана» и «основания» и перейти к разработке специфи-

кации на «модуль усилителя» по разд. 22. 

Последовательность действий для создания чертежа «экрана»: 

1. В КОМПАС-3D открыть 3D-модель «экрана» (расположение указано 

в п. 7 из разд. 14). 

2. СКМ повернуть «экран» в рабочем поле так, чтобы спереди оказалась 

поверхность с надписями, после чего щелкнуть ЛКМ по ней (рис. 20.1) и в 

появившейся над курсором ПИ нажать 

пиктограмму Нормально к. 

Сохранить полученную ориентацию 

3D-модели, добавив новый вид с помо-

щью команды Вид ⇒ Ориентация и при-

своив ему имя (например, Главный). 

После этого сохранить изменения в 

3D-модели (Ctrl+S). 

3. По информации из 7.1 создать новый чертеж и задать следующие 

настройки листа: 

– формат – A3; 

– ориентация – горизонтальная; 

– оформление – Чертеж констр. Первый лист. ГОСТ 2.104-2006. 

4. Сохранить чертеж командой Файл ⇒ Сохранить как с расширением 

«.cdw». Имя файла в варианте «П1» – «УП1.00.03 - Экран - v0.1», а путь со-

хранения – …\ИДРЭС-П1 (см. рис. 2.7). 

5. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

6. Запустить команду Стандартные виды (см. рис. 7.6) и выбрать 

3D-модель «экрана». 

В Панели свойств на вкладке Параметры выполнить следующее: 

– в поле Ориентация главного вида выбрать Главный (задан в п. 2); 

– в поле Масштаб вида выбрать масштаб 2:1; 

Рис. 20.1 
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– в поле Схема видов указать вид снизу, вид спереди и вид слева (рас-

положение видов см. на рис. 7.3). Следует отметить, что для «экранов» с уг-

ловой формой и расположением выхода изделия в верхней части ПП необхо-

димо вместо вида снизу указать вид сверху. 

Результат в варианте «П1» с обозначением видов показан на рис. 20.2, а. 

 

7. В Дереве чертежа изменить названия видов в соответствии с обозна-

чениями на рис. 20.2, а и уточнением из п. 6 (см. п. 7 из 17.2). 

Результат в варианте «П1» показан на рис. 20.2, б. 

8. Заполнить графы рамки в соответствии с табл. 20.1. Содержание 

остальных граф должно соответствовать данным табл. 17.1. 

Пояснения к заполнению приведены в п. 8 из 17.2. 

Пояснения к графам даны в табл. 3.1 и на рис. 3.6. 

Таблица 20.1 

Содержание граф рамки для чертежа «экрана», 

отличающихся от чертежа ПП 

Номер  

графы 
Содержание Комментарий к заполнению 

1 Экран 

Наименование изделия определено в табл. 2.1 и записы-

вается автоматически, так как было задано в свойствах 

3D-модели. 

Параметры шрифта в Панели свойств на вкладке Фор-

мат: высота символов – 7, шаг строк – 11 

2 УП1.00.03 

Обозначение документа определено в табл. 2.1, указано 

для варианта «П1» и записывается автоматически, так 

как было задано в свойствах 3D-модели. 

Данные этой графы повторяются на каждом новом листе 

3 
Сплав Д16 ГОСТ 

4784-97 

Автоматически добавленное название материала (было 

задано в свойствах 3D-модели) корректируется вручную. 

Параметры шрифта в Панели свойств на вкладке Фор-

мат: высота символов – 5, шаг строк – 8 

Рис. 20.2 

а 
б 

Вид  

спереди 

Вид  

слева 

Вид  

снизу 
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Окончание таблицы 20.1 

Номер  

графы 
Содержание Комментарий к заполнению 

5 7,7 г 

Заполняется автоматически при выборе в Панели 

свойств на вкладке Параметры в поле Единицы изме-

рения массы опции граммы, а в поле Точность пред-

ставления значения 1 (0 – при отсутствии десятых до-

лей) 

6 2:1 
Заполняется автоматически в соответствии с масштабом 

главного вида 

25 УП1.00.01 
Обозначение спецификации, в которой записан КД, 

определено в табл. 2.1 и указано для варианта «П1» 

26 УП1.00.03 

Заполняется автоматически и полностью соответствует 

содержанию графы 2. 

Данные этой графы повторяются на каждом новом листе 

9. Запустить режим редактирования основной надписи и в Панели 

свойств на вкладке Параметры отжать пиктограмму Синхронизация дан-

ных (см. рис. 7.7), тем самым отключив передачу данных между 3D-моделью 

и основной надписью чертежа. 

10. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

11. Сделать текущим Вид спереди и выполнить следующие действия по 

замене контуров надписей текстом: 

– скрыть объекты, относящиеся к надписям, путем перемещения их на 

погашенный слой (см. п. 11 из 17.2);  

– перейти на вкладку с 3D-моделью «экрана» (или открыть 3D-модель, 

если вкладка была закрыта), в Дереве модели найти эскиз, на котором рас-

полагаются надписи и войти в режим его редактирования (рис. 20.3); 

 

– скопировать (Ctrl+C) все надписи, указав базовую точку в точке нача-

ла координат, и выйти из режима редактирования эскиза; 

Рис. 20.3 
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– закрыть вкладку с 3D-моделью «экрана» без сохранения изменений; 

– вставить (Ctrl+V) надписи, указав базовую точку в точке начала коор-

динат; 

– выделить вставленные надписи и изменить высоту их символов на 6 

(корректировка с учетом масштаба вида); 

– у каждой добавленной надписи командой ПКМ ⇒ Очистить фон от-

ключить одноименную опцию. 

12. Включить режим Ортогональное черчение клавишей F8. 

13. Трех основных видов, размещенных на чертеже, не хватит для изго-

товления детали, так как нет информации о глубине и форме внутренней по-

лости «экрана» и недостаточно информации о прорезях в боковых стенках. 

Поэтому необходимо добавить вид сзади и вертикальный разрез: 

13.1. Вид сзади не будет находиться в непосредственной проекционной 

связи с главным видом (Вид спереди), поэтому направление проецирования 

должно быть указано стрелкой (см. п. 4.2 из Д.3). 

Для создания вида сзади необходимо сначала сделать текущим тот вид, с 

которого задняя сторона детали будет видна. В вариантах задания для этого 

подходят Вид снизу (Вид сверху) и Вид слева. 

В варианте «П1» текущим сделан Вид слева. 

Затем запустить команду Стрелка взгляда (рис. 20.4) из ПИ Компакт-

ная панель ⇒ Обозначения и выполнить следующие действия: 

– в Панели свойств на вкладке Знак включить 

опцию Автосортировка; 

– в рабочем поле ЛКМ указать начальную и 

конечную точки стрелки взгляда; 

– в Панели свойств на вкладке Параметры отключить опцию Проек-

ционная связь (следует отметить, что управление этой опцией также воз-

можно после размещения вида в рабочем поле, для чего вид выбирается ЛКМ 

и запускается команда ПКМ ⇒ Проекционная связь); 

– ЛКМ указать произвольное место на чертеже для размещения вида. 

Результат выполнения команды в варианте «П1» показан на рис. 20.5. 

13.2. В Дереве чертежа изменить название вида на Вид сзади. 

13.3. При необходимости передвинуть виды в рабочем поле. 

13.4. Для создания вертикального разреза сделать текущим Вид спере-

ди, запустить команду Линия разреза (см. рис. 20.4) из ПИ Компактная 

панель ⇒ Обозначения и выполнить следующие действия: 

Стрелка взгляда 

Рис. 20.4 

Линия разреза 



 

 548 

 

– в Панели свойств на вкладке Знак включить опцию Автосортиров-

ка; 

– указать начальную и конечную точки разреза, а затем выбрать направ-

ление взгляда, тем самым зафиксировав линию разреза. 

Для создания сложного разреза (см. п. 5.2 из Д.3) после указания его 

начальной точки на Панели свойств нажать пиктограмму Сложный разрез 

и указать в рабочем поле ЛКМ точки изгиба линии разреза, после чего от-

ключить указанную пиктограмму и указать направление взгляда; 

– в Панели свойств на вкладке Параметры отключить опцию Проек-

ционная связь; 

– ЛКМ указать произвольное место на чертеже для размещения вида. 

Результат выполнения команды в варианте «П1» показан на рис. 20.6. 

 

13.5. Если изображения не помещаются на одном листе, то по 7.1 доба-

вить второй лист (горизонтальный А3 или вертикальный А4) с оформле-

нием Чертеж констр. Посл. листы. ГОСТ 2.104-2006. 

Рис. 20.5 

Рис. 20.6 
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13.6. При необходимости передвинуть виды в рабочем поле. 

13.7. На разрезе скрыть объекты, относящиеся к выдавленным в 3D-мо-

дели надписям. Для этого выполнить следующее: 

– сделать текущим разрез; 

– добавить вспомогательный погашенный слой (см. п. 11 из 17.2); 

– массовым выделением мышкой с нижнего правого угла в верхний ле-

вый угол выделить штриховку и все объекты, относящиеся к выдавленным в 

3D-модели надписям (пример выделения показан на рис. 20.7, а); 

 

– перенести выделенные объекты на погашенный вспомогательный слой 

(см. п. 11 из 17.2). 

13.8. Командой Штриховка (см. рис. 7.19) из группы «Заливка» на ПИ 

Компактная панель ⇒ Геометрия добавить на место скрытой штриховки 

новую со стилем Металл и шагом 2. 

Результат создания разреза в варианте «П1» показан на рис. 20.7, б. 

Примечание. Стиль штриховки на ассоциативных разрезах можно по-

менять командой ПКМ ⇒ Изменить стиль. 

14. Нажать пиктограмму Параметрический режим (см. рис. 6.8) на ПИ 

Текущее состояние. 

15. Сделать текущим Вид спереди и командой Обозначение центра 

(см. рис. 17.5) из ПИ Компактная панель ⇒ Обозначения обозначить цен-

тры всех отверстий. 

Затем сделать текущим Вид сзади и проделать аналогичные действия. 

16. Отключить режим Ортогональное черчение клавишей F8. 

Затем сохранить чертеж (Ctrl+S) и выполнить проверку по п. 12 из 6.5. 

Начальная точка выделения Конечная точка выделения 

Рис. 20.7 

а 

б 
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17. В соответствии с информацией из прил. Д нанести размеры и пре-

дельные отклонения, указать допуски формы и расположения поверхностей, 

а также их шероховатость: 

17.1. Сделать текущим Вид спереди и командой Линейный размер или 

Авторазмер (см. рис. 7.21) показать положение надписей с предельными от-

клонениями по 16–17-му квалитету. 

При простановке размеров здесь и далее обратить внимание на следую-

щее: 

– добавленные размеры должны удовлетворять требованиям из Д.5; 

– для выравнивания размеров служит команда, указанная в п. 17 из 17.2; 

– способы указания предельных отклонений описаны в п. 19 из 17.2; 

– иногда информацию о положении надписей указывают в ТТ чертежа, 

например: «Надпись Х расположить симметрично ближайшим стенкам»; 

– виды в рабочем поле при необходимости можно перемещать; 

– если требуется сдвинуть штрих линии разреза, то после начала его пе-

ремещения зажать клавишу Shift. После этого потребуется перестроить чер-

теж командой Вид ⇒ Перестроить (или клавишей F5). 

Результат в варианте «П1» показан на рис. 20.8. 

 

17.2. Показать ширину «экрана» и задать предельные отклонения по 

12-му квалитету для вала (поле допуска – h12). 

В вариантах задания с прямым «экраном» показать размер на Виде сле-

ва, предварительно сделав его текущим (рис. 20.9, а). 

В вариантах задания с угловым «экраном» добавить два размера в соот-

ветствии с рис. 20.9, б, предварительно сделав текущим Вид спереди. 

Рис. 20.8 
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17.3. Показать толщину «экрана» на любом пригодном для этого виде, 

предварительно сделав его текущим (в варианте «П1» выбран Вид слева). 

Задать предельные отклонения размеру, для чего выполнить следующее: 

17.3.1. С учетом того что допуск по толщине ПП составляет ±10 % 

(см. Б.5), определить максимальную толщину ПП под «экраном» ( max ппэh ) 

для неокругленного значения ппэh , вычисленного по (13.1), и округлить по-

лученный результат до ближайших сотых долей миллиметра. 

В варианте «П1»: 

64,01,15848,01,1ппэmax ппэ == hh  мм. 

В варианте «П1» расчеты и записи для чертежей «экрана» и «основания» 

сохранялись в созданном при разработке 3D-модели «экрана» файле Расче-

ты (детали).xmcd из папки …\ИДРЭС-П1\_Заметки (см. рис. 2.7). 

17.3.2. Определить разницу между толщиной «модуля усилителя» в об-

ласти размещения «экрана», заданной по общему заданию на проектирова-

ние, и его толщиной при максимальной толщине ПП по формуле: 

max ппээоснмуэ hhhhh −−−= . 

В варианте «П1»: 

04,064,04,6310 −=−−−=h  мм. 

Получается, что для гарантированного выполнения требования общего 

задания на проектирование верхнее предельное отклонение толщины «экра-

на» должно быть основным отклонением для вала, т. е. находиться ниже ну-

левой линии как минимум на модуль вычисленного значения (см. рис. Д.19). 

17.3.3. По рис. Д.20 для 11-го квалитета выбрать подходящее поле до-

пуска и указать его в размере (в варианте «П1» выбрано поле допуска d11). 

Результат в варианте «П1» показан на рис. 20.10. 

Рис. 20.9 

а б 
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17.4. Показать длину «экрана» с полем допуска d11 

на Виде спереди, предварительно сделав его текущим. 

Результат в варианте «П1» показан на рис. 20.11, а. 

В вариантах задания с угловым «экраном» добавить 

два размера в соответствии с рис. 20.11, б. 

 

Примечание. В варианте «П1» поле допуска d11 обеспечивает рекомен-

дуемую по старой редакции ГОСТ 25347 [91] посадку с зазором в системе 

отверстия H11/d11. Здесь в числителе – поле допуска для отверстия (в ва-

рианте «П1» – расстояние между боковыми стенками в «основании»), а в 

знаменателе – поле допуска для вала (в варианте «П1» – длина «экрана»). 

Любая операция сборки деталей заключается в том, чтобы их соеди-

нить (или «посадить» одну деталь на другую). Поэтому под посадкой пони-

мается степень подвижности собранных деталей. 

Различают следующие виды посадок: 

– посадки с зазором. При такой посадке одна деталь свободно входит в 

другую. Зазором называется разность размеров отверстия и вала, если раз-

мер отверстия больше размера вала; 

– посадки с натягом. При такой посадке для соединения деталей необ-

ходимо применить усилие. Натягом называется разность размеров вала и 

отверстия до сборки, если размер вала больше размера отверстия; 

Рис. 20.11 

а 

б 

Рис. 20.10 
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– переходные посадки. При такой посадке до сборки вала и отверстия 

нельзя точно сказать, что будет в соединении – зазор или натяг (диаметр 

отверстия может быть меньше, больше или равен диаметру вала). 

Указанная посадка H11/d11 относится к посадке низкой точности, ко-

торая предназначена для подвижных соединений, не требующих точности 

перемещения, и для неподвижных грубоцентрированных соединений. В гру-

бых квалитетах (11 и 12) – это предпочтительная посадка с минимальным 

гарантированным зазором, необходимым для компенсации отклонений рас-

положения сопрягаемых поверхностей, защитных покрытий, наносимых на 

поверхности, или обеспечения подвижности соединения в условиях запыле-

ния и загрязнения и т. п. 

Для размера 50 мм: 
)08,0(
)24,0(

)16,0( 11d/11H50
−
−

+ . 

17.5. Показать размеры и положения внутренней полости «экрана» и 

всех прорезей в его стенках, обратив внимание на следующее: 

– вид, на котором проставляются размеры, должен быть текущим; 

– при наличии протяженных участков «экрана» на разрезе и Виде сзади 

можно использовать разрывы (см. п. 25.5 из 17.2 и п. 5 из Д.4); 

– предельные отклонения должны быть заданы по 13–14-му квалитету 

так, чтобы указанные размеры были не меньше, чем в 3D-модели; 

– в варианте «П1» размеры добавлены на разрезе (рис. 20.12, а), на Виде 

снизу (рис. 20.12, б) и на Виде сзади (рис. 20.12, в). Дополнительно были 

указаны габариты внутренней полости в виде справочных размеров, т. к. вме-

сте с шириной и длиной «экрана», проставленными ранее, они образуют за-

мкнутую размерную цепь (см. п. 2 из Д.5); 

– для вариантов задания с угловым «экраном» общая схема простановки 

размеров показана на рис. 20.12, г. 

 Рис. 20.12 Начало (окончание см. на с. 554) 

а 
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17.6. Сделать текущим Вид сзади, после чего командой Авторазмер или 

Радиальный размер из ПИ Компактная панель ⇒ Размеры (см. рис. 7.21) 

в соответствии с п. 22 из Д.5 обозначить радиусы скруглений внутренней по-

Рис. 20.12 Окончание (начало см. на с. 553) 

б 

в 

г 
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лости с предельным отклонением по 17-му 

квалитету. Количество радиусов ввести в поле 

Текст под в окне Задание размерной надпи-

си (см. рис. 17.10). 

Результат в варианте «П1» показан на 

рис. 20.13. 

17.7. Отверстия в «экране» имеют слож-

ную форму. Для их обозначения можно доба-

вить дополнительный местный разрез, на ко-

тором показать все размеры (см. рис. 14.11), а можно 

воспользоваться правилами упрощенного нанесения 

размеров отверстий по ГОСТ 2.318–81 [93], что и будет 

сделано далее. 

Для созданного в п. 32 из разд. 14 отверстия струк-

тура упрощенного обозначения приведена на рис. 20.14, 

где 1d  – диаметр основного отверстия; 2d  – диаметр 

зенковки;   – центральный угол зенковки. 

Упрощенное обозначение отверстий указать с ис-

пользованием линии-выноски: 

– сделать текущим Вид спереди; 

– запустить команду Линия-выноска из группы «Знак маркировки» на 

ПИ Компактная панель ⇒ Обозначения (см. рис. 7.26 и 17.22); 

– в Панели свойств на вкладке Параметры в поле Стрелка выбрать 

опцию Без стрелки; 

– указать ЛКМ на чертеже точку в центре любого удобного для разме-

щения линии-выноски отверстия (сработает привязка Ближайшая точка), а 

затем точку, где будет находиться полка добавляемой линии-выноски (пре-

дупреждение о том, что ассоциирование не 

произведено, проигнорировать); 

– в Панели свойств на вкладке Знак 

щелкнуть ЛКМ в поле Текст и в открыв-

шемся окне в первой строке ввести упро-

щенное обозначение отверстий с указанием 

их количества (рис. 20.15). 

Знаки диаметр, умножить, плюс-минус и градус добавляются в соответ-

ствии с указанием п. 29.2 из 17.2. 

Рис. 20.13 

Рис. 20.14 [93] 

Рис. 20.15 
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Поле допуска диаметров – H13 (числовые значения см. в табл. Д.1). Для 

добавления надстрочных символов в Панели свойств на вкладке Вставка 

нажать пиктограмму Вставить индекс (средней высоты). 

После этого закрыть окно кнопкой OK; 

– нажать пиктограмму Создать объект, а следом – Прервать команду; 

– при необходимости отредактировать положение линии-выноски, раз-

меров и видов; 

– при случайном добавлении лишних ответвлений удалить их в соответ-

ствии с информацией п. 24 из 7.3. 

Результат в варианте «П1» показан на рис. 20.16. 

 

17.8. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

17.9. По материалам Д.7 рассчитать позиционные допуски расположения 

осей отверстий для крепежных изделий. 

На рис. 20.17 схематично показан разрез в области расположения отвер-

стия для соединения ПП, «экрана» и «основания» винтом М2,5. 

Сначала необходимо произвести 

расчет позиционного допуска для со-

единяемых деталей с меньшими диа-

метрами отверстий, т. е. для ПП и 

«основания». Данное соединение – 

соединение типа В (см. рис. Д.38, б). 

Если на чертеже нет особых ука-

заний, то по ОСТ4 ГО.070.014 резьба 

выполняется с полем допуска 6g (для 

наружной резьбы) и 6H (для внутрен-

ней резьбы). Для резьбы М2,5 число-

вые значения указанных полей допус-

ков следующие: 

Рис. 20.16 

Рис. 20.17 
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– для 6g – от минус 0,002 до минус 0,008 мм; 

– для 6H – от 0 до 0,006 мм. 

Позиционный допуск отверстий в ПП для 4-го класса точности состав-

ляет 05,0пп =T  мм (см. табл. Б.1), поэтому позиционный допуск оси отвер-

стия в «основании» ( оснT ) по (Д.2) и (Д.3): 

 3,0498,28,2maxminmin −=−= dDS  мм; (20.1) 

 25,005,03,01ппminосн =−=−= TSKT  мм.  

Для увеличения позиционного допуска значение minD  в (20.1) выбрано 

2,8 мм (а не 2,72 мм по табл. Г.10) из-за следующих предположений: 

– вероятность получения отверстия диаметром 2,72 мм мала, так как на 

производстве обычно корректируют диаметр сверла под металлизированные 

отверстия; 

– можно закрепить винт с небольшим натягом в отверстии ПП. 

На рис. 20.18 показана наихудшая ситуация расположения отверстий в 

ПП и «основании» при минимальном диаметре отверстий и максимальном 

удалении их осей друг от друга для 05,0пп =T  мм и 25,0осн =T  мм. Как вид-

но, соединение осуществимо. 

 

Позиционный допуск оснT  учитывает значение ппT , поэтому для расчета 

позиционного допуска оси отверстия в «экране» ( экрT ) также необходимо 

воспользоваться (Д.2) и (Д.3) для соединения типа В: 

Рис. 20.18 

Центр отверстия в «основании» 

Отверстие  

в ПП 

Отверстие  

в «основании» 

Центр отверстия в ПП 
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 6,05,21,3maxminmin =−=−= dDS  мм; (20.2) 

 35,025,06,01оснminэкр =−=−= TSKT  мм. (20.3) 

В (20.2) и (20.3) отверстием является отверстие в «экране», а крепежной 

деталью – винт М2,5 с позиционным допуском оснT . 

На рис. 20.19 показана наихудшая ситуация расположения отверстий в 

«экране» и «основании» при минимальных диаметрах отверстий и макси-

мальном удалении их осей друг от друга для 35,0экр =T  мм и 25,0осн =T  мм. 

Как видно, соединение осуществимо. 

 

Получившиеся значения позиционных допусков должны соответство-

вать ряду, приведенному в Д.7. Если это не так, то необходимо скорректиро-

вать их, выбрав ближайшее меньшее значение. 

Таким образом, в варианте «П1»: 3,0экр =T  мм, 25,0осн =T  мм. 

17.10. По примеру рис. Д.37 нанести размеры, определяющие номиналь-

ное расположение осей отверстий, ограниченное рассчитанным позицион-

ным допуском. Допуск указать зависимым. 

Для этого выполнить следующие действия: 

17.10.1. Продумать на каких видах будут расположены следующие базо-

вые поверхности (см. Д.7): 

– установочной базой будет та поверхность, которой «экран» контакти-

рует с ПП «усилителя»; 

Рис. 20.19 

Центр отверстия в «основании» 

Отверстие  

в «экране» 

Отверстие  

в «основании» 

Центр отверстия в «экране» 
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– направляющая и опорная базы – боковые поверхности, имеющие об-

щую линию пересечения в том угле контура ПП, в котором в файле трасси-

ровки располагалась точка начала координат (см. рис. 12.25). При этом 

направляющая база – более протяженная из них. 

17.10.2. Сделать текущим вид, на котором будет установ-

лена база и запустить команду База из ПИ Компактная па-

нель ⇒ Обозначения (рис. 20.20). 

В Панели свойств на вкладке Знак в поле Тип выбрать Перпендику-

лярно к опорному элементу и включить опцию Автосортировка. 

Затем на чертеже указать поверхность (линия контура «экрана»), задать 

положение знака и указать конечную точку выноски. 

В варианте «П1» установочная база (В) показана на Виде снизу, а 

направляющая (Г) и опорная (Д) базы – на Виде спереди (рис. 20.21). 

 

17.10.3. Сделать текущим Вид сзади и цепочкой нанести размеры отно-

сительно угла, образованного направляющей и опорной базами. 

Размерные числа поместить в рамку с помощью опции Номинальный 

(в рамке) в окне Задание размерной надписи (см. рис. 17.10) или с помо-

щью опции Размер в рамке в свойствах размеров (см. рис. 17.9, б). 

На этом же изображении командой Осевая линия по двум точкам (см. 

рис. 17.5) из ПИ Компактная панель ⇒ Обозначения соединить центры 

крайних отверстий, находящихся на одной оси. 

Рис. 20.21 

База 

Рис. 20.20 
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Результат в варианте «П1» показан на рис. 20.22. 

 

В вариантах задания с угловым «экраном» схема 

простановки размеров показана на рис. 20.23. 

17.10.4. Сделать текущим Вид спереди. 

Добавить рамку с позиционным допуском, для 

чего запустить команду Допуск формы из ПИ Ком-

пактная панель ⇒ Обозначения (рис. 20.24) и вы-

полнить следующее: 

– в Панели свойств в поле Базовая точка ука-

зать точку привязки рамки Слева вверху и нажать 

ЛКМ в поле Текст; 

– в появившемся окне Введите текст будет 

только одна ячейка. Добавить четыре ячейки справа 

от нее пиктограммой Вставить столбец справа в Панели свойств на вклад-

ке Таблица; 

– дважды щелкнуть ЛКМ в первой ячейке и в появившемся списке вы-

брать Позиционный допуск; 

– дважды щелкнуть ЛКМ во второй ячейке и в появившемся списке вы-

брать вычисленное значение позиционного допуска экрT . Перед ним вставить 

знак диаметра в соответствии с указанием п. 29.2 из 17.2, а после него таким 

Рис. 20.22 

Рис. 20.23 

Допуск формы 

Рис. 20.24 
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же образом – знак зависимого допуска (группа Допуски формы и располо-

жения поверхностей); 

– в каждой из последующих трех ячеек добавить ссылку на соответ-

ствующую базу в следующем порядке: установочная, направляющая и опор-

ная. Для добавления ссылки выполнить команду ПКМ ⇒ Вставить ссылку 

и в появившемся окне Ссылка в поле Тип источника выбрать Обозначение 

базы, в поле Ссылка на – Текст, а в Списке источников – требуемую базу 

(при выделении базы в Списке источников она подсвечивается в рабочем 

поле чертежа); 

– закрыть окно Введите текст (рис. 20.25) кнопкой OK; 

 

– в рабочем поле щелкнуть ЛКМ на изгибе линии-выноски с обозначе-

нием отверстий сложной формы; 

– нажать комбинацию клавиш Ctrl+Enter, а следом – клавишу Esc; 

– у добавленной рамки командой ПКМ ⇒ Очистить фон отключить 

одноименную опцию; 

– при необходимости отредактировать положение рамки, линии-вынос-

ки, размеров и видов. 

Результат в варианте «П1» показан на рис. 20.26. 

 

17.11. Для поверхности «экрана», отмеченной как установочная база, за-

дать более точный допуск плоскостности (см. Д.7), нежели тот, который мо-

жет получиться по допуску размера из п. 17.3. 

Рис. 20.26 

Рис. 20.25 
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Для этого сделать текущим соответствующий вид, запустить команду 

Допуск формы (см. рис. 20.24) и выполнить следующее: 

– в Панели свойств в поле Базовая точка указать точку привязки рам-

ки (например, Слева вверху) и в поле Таблица нажать пиктограмму Созда-

ние таблицы в полуавтоматическом режиме; 

– в открывшемся окне Обозначение допуска в группе Знак выбрать 

знак допуска плоскостности (см. рис. Д.27), а в группе Числовое значение 

ввести значение для 10-й степени точности по табл. Д.2 (или выбрать из 

предлагаемого списка, дважды щелкнув ЛКМ в этом поле); 

– закрыть окно Обозначение допуска (рис. 20.27) кнопкой OK; 

 

– щелкнуть ЛКМ в рабочем поле для установки рамки; 

– по рис. Д.22 выбрать один из вариантов ответвления от рамки; 

– в Панели свойств нажать пиктограмму Ответвление со стрелкой; 

– на чертеже указать ЛКМ точку начала стрелки на рамке, а затем с за-

жатой клавишей Shift – на нужной поверхности; 

– нажать комбинацию клавиш Ctrl+Enter, а следом – клавишу Esc; 

– при случайном добавлении лишних от-

ветвлений удалить их в соответствии с инфор-

мацией п. 24 из 7.3. 

Примечание. Для допуска формы база не 

указывается. 

Результат в варианте «П1» показан на 

рис. 20.28. 

17.12. Для боковых поверхностей «экрана» со стороны входа и выхода 

изделия задать допуск перпендикулярности (см. Д.7) для 10-й степени точно-

сти по табл. Д.3 относительно установочной базы. 

Допуск перпендикулярности добавить по п. 17.11 со следующими изме-

нениями в окне Обозначение допуска (рис. 20.29, а): 

– в группе Знак выбрать знак допуска перпендикулярности; 

– в группе База 1 нажать пиктограмму Укажите обозначение базы и в 

открывшемся окне Ссылка выбрать обозначение требуемой базы. 

Рис. 20.27 

Рис. 20.28 
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Результат установки допуска перпендикулярности для одной из поверх-

ностей в варианте «П1» показан на рис. 20.29, б. 

 

17.13. Для поверхности «экрана», отмеченной как установочная база, 

добавить указание о шероховатости (см. Д.9). 

Для этого сделать текущим соответствующий вид, запустить команду 

Шероховатость из ПИ Компактная панель ⇒ Обозначения (рис. 20.30) и 

выполнить следующее: 

– в Панели свойств на вкладке Знак в поле Тип 

нажать пиктограмму Без указания вида обработки 

(рис. Д.48, а), а затем щелкнуть ЛКМ по полю Текст; 

– в появившемся окне Введите текст в первой строке ввести Ra 1,6 (или 

выбрать из предлагаемого списка, дважды щелкнув ЛКМ в этом поле); 

– закрыть окно Введите текст (рис. 20.31, а) кнопкой OK; 

 

– в Панели свойств на вкладке Параметры в поле Полка выбрать оп-

цию Влево; 

Рис. 20.31 

а б 

Рис. 20.29 

а 

Укажите обозначение базы 

б 

Рис. 20.30 

Шероховатость 
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– на чертеже указать нужную поверхность и отредактировать положение 

добавленного знака; 

– нажать пиктограмму Прервать команду. 

Результат в варианте «П1» показан на рис. 20.31, б. 

17.14. Указать общую шероховатость (см. пп. 8 и 9 из Д.9). 

Для этого запустить команду Вставка ⇒ Неуказанная шерохова-

тость ⇒ Ввод и в открывшемся окне выполнить следующее: 

– в группе Тип знака выбрать левый вариант (рис. Д.48, а); 

– включить опцию Добавить знак 

в скобках;  

– в поле Текст ввести Ra 3,2 (или 

выбрать из предлагаемого списка, два-

жды щелкнув ЛКМ в этом поле). 

Результат показан на рис. 20.32. 

18. Сохранить чертеж (Ctrl+S). 

19. Добавить ТТ, для чего выполнить следующие действия: 

19.1. Войти в режим редактирования ТТ. 

19.2. По п. 25.2 из 17.2 задать необходимые настройки. 

19.3. Ввести текст следующего вида: 

1 * Размеры для справок. 

2 Надписи гравировать. Покрытие гравировки - эмаль ПФ-115 черная 

ГОСТ 6465-76 (или аналог). Шрифт: 3 - Пр3 ГОСТ 26.008-85. 

Допускается гравировка лазером. 

3 Царапины и следы разметки на поверхности Х не допускаются. 

4 Остальные технические требования по ОСТ4 ГО.070.014. 

При копировании обратить внимание на примечание к п. 25.3 из 17.2. 

19.4. Сохранить ТТ (Ctrl+S) и выйти из режима их редактирования. 

19.5. Убедиться в том, что расстояние между нижней строкой ТТ и рам-

кой основной надписи не менее 10 мм. 

При необходимости изменить положение ТТ по п. 25.5 из 17.2. 

19.6. Комментарии к отдельным пунктам ТТ из п. 19.3: 

– эмаль ПФ-115 выбрана по ОСТ1 90210–85. Она обладает механиче-

ской прочностью, хорошей адгезией к маркируемой поверхности, стойко-

стью во всеклиматических условиях эксплуатации, выдерживает цикличе-

ское воздействие температур от минус 60 до +150 C (черного цвета). Пред-

назначена для заполнения гравировки и нанесения пером или рейсфедером; 

Рис. 20.32 
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– параметры шрифта для гравировки были описаны в пп. 9 и 12 из 16.1; 

– царапины и следы разметки могут остаться в результате позициониро-

вания надписей при ручной гравировке. 

20. Показать на чертеже поверхность, условно обозначенную в ТТ бук-

вой X, и изменить ее обозначение. 

Для этого выполнить следующее: 

20.1. Сделать текущим требуемый вид. 

20.2. Запустить команду Линия-выноска (см. рис. 7.26) и в Панели 

свойств проделать следующее: 

– на вкладке Знак включить опцию Автосортировка; 

– на вкладке Знак щелкнуть ЛКМ в поле Текст и в открывшемся окне 

Введите текст для буквы в первой строке установить высоту 7; 

– на вкладке Параметры в поле Стрелка выбрать опцию Стрелка или 

Вспомогательная точка (см. п. 5 из Д.8). 

20.3. Добавить линию-выноску в рабочее поле (рис. 20.33). 

 

При случайном добавлении лишних ответвлений удалить их в соответ-

ствии с информацией п. 24 из 7.3. 

20.4. Войти в режим редактирования ТТ. 

20.5. В пункте № 3 из ТТ удалить букву X и на ее место командой 

ПКМ ⇒ Вставить ссылку добавить букву, автоматически записанную на 

линии-выноске. 

20.6. Сохранить ТТ (Ctrl+S) и выйти из режима их редактирования. 

21. Отжать пиктограмму Параметрический режим (см. рис. 6.8) на ПИ 

Текущее состояние. 

22. Если в чертеже есть второй лист, то в соответствии с п. 16 из Д.8 от-

редактировать надписи перенесенных на него изображений, а также соответ-

ствующие надписи на изображениях, с которых они были получены. 

Для этого запустить на надписи команду ПКМ ⇒ Редактировать и в 

Панели свойств включить опцию Лист (вкладка Надпись вида или Знак). 

Рис. 20.33 
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Возможный результат при расположении Вида сзади на втором листе 

показан на рис. 20.34. 

 

23. Если вид с непосредственной проекционной связью не позволяет 

произвести желаемую компоновку изображений (есть потребность в его пе-

ремещении), то этот вид можно преобразовать в вид по стрелке. 

На примере Вида слева выполняется следующее: 

– делается текущим Вид спереди; 

– запускается команда Стрелка взгляда (рис. 20.4) и в Панели свойств 

на вкладке Знак включается опция Автосортировка. Затем в рабочем поле 

ЛКМ указывается такое положение стрелки взгляда, при котором будет по-

лучен Вид слева, после чего команда завершается клавишей Esc без добав-

ления нового вида; 

– делается текущим Вид слева; 

– отключается опция Проекционная связь; 

– командой Ввод текста (см. рис. 6.41) над изображением вида добавля-

ется ссылка (команда ПКМ ⇒ Вставить ссылку) на букву, автоматически 

записанную на стрелке взгляда на Виде спереди, со следующими параметра-

ми текста: Шрифт – GOST type A; Высота символов – 7; Курсив – включен. 

Добавление номера листа в соответствии с п. 16 из Д.8 в этом случае 

осуществляется с помощью команды ПКМ ⇒ Вставить ссылку. 

Создание гиперссылок для перехода внутри чертежа между стрелкой 

взгляда и буквой на Виде слева осуществляется командой ПКМ ⇒ Гиперс-

сылка, выполненной по отдельности на соответствующих объектах. 

Рис. 20.34 
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Возможный результат преобразования Вида слева показан на рис. 20.35. 

 

24. При необходимости поменять последовательность присвоения букв 

на чертеже (например, для обозначения баз или стрелок взгляда) следует за-

пустить команду Вид ⇒ Нумерация или нажать пиктограмму Нумерация на 

ПИ Стандартная и в верхней части появившегося окна Нумерация в рас-

крывающемся списке выбрать опцию #Автосортировка. 

Изменение порядка объектов производится внутри группы пиктограм-

мами Передвинуть вверх и Передвинуть вниз (рис. 20.36). 

 

25. Проверить полноту простановки размеров, для чего мысленно разде-

лить деталь на элементы (прорези, полости, отверстия и пр.), представить не-

обходимые для них размеры и сверить их с нанесенными на чертеже. Обяза-

тельно обратить внимание на предельные отклонения. 

Например, для разработанного в варианте «П1» чертежа «экрана»: 

Рис. 20.35 

Рис. 20.36 
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25.1. Из листа сплава Д16 по ГОСТ 4784–97 (например, из листа нор-

мальной точности толщиной 7–0,3 мм по ГОСТ 21631–2023 [94]) необходимо 

вырезать параллелепипед с заданной шириной, толщиной и длиной. 

Размеры были заданы в пп. 17.2–17.4 и показаны на Виде спереди и Ви-

де слева (см. рис. 20.9–20.11), а материал указан в основной надписи чертежа 

в п. 8. 

25.2. Внутренняя полость в сечении представляет собой скругленный 

прямоугольник, поэтому необходимо знать ее ширину, длину и радиусы 

скруглений, а также положение относительно сторон «экрана» и глубину. 

Указанные размеры показаны на Виде А и на разрезе Б–Б (см. 

рис. 20.12, а и 20.22). 

25.3. Для прорези в тонкой стенке «экрана» необходимо знать ее длину и 

положение относительно короткой стороны, а также глубину. 

Эти размеры показаны на Виде снизу (см. рис. 20.12, б). Ширина проре-

зи равна толщине тонкой стенки (см. Вид А на рис. 20.12, в). 

25.4. Для прорезей в толстой стенке «экрана» необходимо знать их дли-

ну и положение относительно длинной стороны, а также глубину. Так как 

прорези расположены симметрично, то по п. 27 из Д.5 размеры даны только 

для одной из них на Виде А и на разрезе Б–Б (см. рис. 20.12, а и в). 

25.5. Количество отверстий и их параметры по рис. 20.14 (диаметр для 

прохода винта и параметры зенковки) в виде упрощенного обозначения пока-

заны на Виде спереди (см. рис. 20.26), а положение отверстий относительно 

комплекта баз «экрана» – на Виде А (см. рис. 20.22). 

25.6. Положение каждой надписи относительно сторон «экрана» показа-

но на Виде спереди (см. рис. 20.8), а параметры текста, способ нанесения и 

тип краски – в ТТ из п. 19.3. 

25.7. Для нижней поверхности «экрана», которая будет соприкасаться с 

ПП, заданы допуск плоскостности и шероховатость, а для боковых стенок по 

входу и выходу устройства – допуск перпендикулярности. 

Все эти параметры показаны на Виде снизу (см. рис. 20.29, б и 20.31, б). 

Общая шероховатость показана в правом верхнем углу чертежа. 

26. Сохранить изменения в чертеже (Ctrl+S). 

Результат в варианте «П1» показан на рис. 20.37. 

27. Сохранить чертеж в формате PDF по 17.3. 

Имя файла в варианте «П1» – «УП1.00.03 - Экран - v0.1», а путь сохра-

нения – …\ИДРЭС-П1\_pdf (см. рис. 2.7). 
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 Рис. 20.37 
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28. Как отмечалось ранее, если внести изменения в 3D-модель, то это 

приведет к появлению запроса на перестроение ассоциативных видов черте-

жа. Кроме обновления изображений также будут автоматически изменены и 

все информационные размеры. 

После перестроения видов необходимо визуально проверить правиль-

ность проведенной операции, например: 

– если в ассоциативном виде вручную был изменен стиль линии, то он 

может быть сброшен на стиль по умолчанию; 

– если в ассоциативном виде элементы, полученные в 3D-модели выре-

занием или выдавливанием текста, были перенесены на скрытый слой, то с 

большой вероятностью часть их контуров станет снова видна. 

Так, если понадобится внести изменения в 3D-модель «экрана», то после 

этого потребуется: 

– на Виде спереди скрыть объекты, относящиеся к надписям (см. п. 11); 

– на разрезе выполнить пп. 13.7 и 13.8. 

20.2. Содержание отчета 

По 20-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Расчет позиционных допусков крепежных отверстий в «основании» и 

«экране» с пояснениями. 

2. Выбор поля допуска для толщины «экрана» с пояснениями. 

3. Чертеж «экрана», распечатанный на отдельном листе (листах). 

Схема складывания листа формата A3 при расположении основной 

надписи вдоль длинной стороны листа для непосредственного брошюрова-

ния показана на рис. 8.71. 
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21. ЧЕРТЕЖ «ОСНОВАНИЯ» 

21.1. Создание чертежа «основания» 

Чертеж «основания», как и «экрана», будет создаваться на основе его 

3D-модели, и в нем будут в основном ассоциативные виды. 

При отставании от плана (см. рис. 2.5) можно пропустить данный раздел 

и перейти к разработке спецификации на «модуль усилителя» по разд. 22. 

Последовательность действий для создания чертежа «основания»: 

1. В КОМПАС-3D открыть 3D-модель «основания» (расположение ука-

зано в п. 4 из разд. 15). 

2. СКМ повернуть «основание» в рабочем поле так, чтобы спереди ока-

залась поверхность, контактирующая с ПП «усилителя», после чего щелк-

нуть ЛКМ по ней (рис. 21.1) и в появив-

шейся над курсором ПИ нажать пикто-

грамму Нормально к. 

Сохранить полученную ориентацию 

3D-модели, добавив новый вид с помощью 

команды Вид ⇒ Ориентация и присвоив 

ему имя (например, Главный). 

Сохранить изменения (Ctrl+S) и за-

крыть вкладку с 3D-моделью. 

3. По информации из 7.1 создать новый чертеж и задать следующие 

настройки листа: 

– формат – A3; 

– ориентация – горизонтальная; 

– оформление – Чертеж констр. Первый лист. ГОСТ 2.104-2006. 

4. Сохранить чертеж командой Файл ⇒ Сохранить как с расширением 

«.cdw». Имя файла в варианте «П1» – «УП1.00.02 - Основание - v0.1», а путь 

сохранения – …\ИДРЭС-П1 (см. рис. 2.7). 

5. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

6. Запустить команду Стандартные виды (см. рис. 7.6) и выбрать 

3D-модель «основания». 

В Панели свойств на вкладке Параметры выполнить следующее: 

– в поле Ориентация главного вида выбрать Главный (задан в п. 2); 

– в поле Масштаб вида выбрать масштаб 2:1; 

Рис. 21.1 
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– в поле Схема видов указать вид сверху, вид спереди и вид слева 

(расположение видов см. на рис. 7.3). 

Результат в варианте «П1» с обозначением видов показан на рис. 21.2, а. 

 

7. В Дереве чертежа изменить названия видов в соответствии с обозна-

чениями на рис. 21.2, а (см. п. 7 из 17.2). 

Результат в варианте «П1» показан на рис. 21.2, б. 

8. Заполнить графы рамки в соответствии с табл. 21.1. Содержание 

остальных граф должно соответствовать данным табл. 17.1. 

Пояснения к заполнению приведены в п. 8 из 17.2. 

Пояснения к графам даны в табл. 3.1 и на рис. 3.6. 

Таблица 21.1 

Содержание граф рамки для чертежа «основания», 

отличающихся от чертежа ПП 

Номер  

графы 
Содержание Комментарий к заполнению 

1 Основание 

Наименование изделия определено в табл. 2.1 и записы-

вается автоматически, так как было задано в свойствах 

3D-модели. 

Параметры шрифта в Панели свойств на вкладке Фор-

мат: высота символов – 7, шаг строк – 11 

2 УП1.00.02 

Обозначение документа определено в табл. 2.1, указано 

для варианта «П1» и записывается автоматически, так 

как было задано в свойствах 3D-модели. 

Данные этой графы повторяются на каждом новом листе 

3 
Сплав Д16 ГОСТ 

4784-97 

Автоматически добавленное название материала (было 

задано в свойствах 3D-модели) корректируется вручную. 

Параметры шрифта в Панели свойств на вкладке Фор-

мат: высота символов – 5, шаг строк – 8 

Рис. 21.2 

а 

б 

Вид  

сверху 

Вид  

слева 

Вид  

спереди 
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Окончание таблицы 21.1 

Номер  

графы 
Содержание Комментарий к заполнению 

5 20,3 г 

Заполняется автоматически при выборе в Панели 

свойств на вкладке Параметры в поле Единицы изме-

рения массы опции граммы, а в поле Точность пред-

ставления значения 1 (0 – при отсутствии десятых до-

лей) 

6 2:1 
Заполняется автоматически в соответствии с масштабом 

главного вида 

25 УП1.00.01 
Обозначение спецификации, в которой записан КД, 

определено в табл. 2.1 и указано для варианта «П1» 

26 УП1.00.02 

Заполняется автоматически и полностью соответствует 

содержанию графы 2. 

Данные этой графы повторяются на каждом новом листе 

9. Запустить режим редактирования основной надписи и в Панели 

свойств на вкладке Параметры отжать пиктограмму Синхронизация дан-

ных (см. рис. 7.7), тем самым отключив передачу данных между 3D-моделью 

и основной надписью чертежа. 

10. Сохранить чертеж (Ctrl+S) и выполнить проверку по п. 12 из 6.5. 

11. Включить режим Ортогональное черчение клавишей F8. 

12. Трех добавленных основных видов во многих вариантах задания не 

хватит для изготовления детали, так как отсутствует информации об отвер-

стиях во второй боковой стенке, да и при простановке размеров эти изобра-

жения будут сильно перегружены. Этот момент необходимо обдумать и при 

необходимости создать дополнительный вид и (или) выносные элементы: 

12.1. Сделать текущим Вид спереди и командой Стрелка взгляда (см. 

рис. 20.4 и п. 13.1 из 20.1) из ПИ Компактная панель ⇒ Обозначения доба-

вить вид справа с отключенной проекционной связью. 

В варианте «П1» вид был повернут для удобства расположения на чер-

теже (рис. 21.3). Для этого во время его добавления в Панели свойств на 

вкладке Параметры после отключения опции Проекционная связь в поле 

Угол задано значение 90, а на вкладке Надпись вида включены опции По-

вернуто и Угол. 

Примечание. Повернуть вид можно и после добавления на чертеж, для 

чего его необходимо выбрать ЛКМ, запустить команду ПКМ ⇒ Параметры 

вида и задать требуемые настройки. 

12.2. В Дереве чертежа изменить название вида на Вид справа. 
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12.3. Сделать текущим Вид спереди и командой Выносной элемент 

(см. рис. 17.5 и п. 23.2 из 17.2) из ПИ Компактная панель ⇒ Обозначения 

добавить выносные элементы в увеличенном масштабе для области с распо-

ложением прорезей под выводы компонентов ПП. 

В варианте «П1» добавлено два выносных элемента в масштабе 4:1 (рис. 

21.4). Небольшие изображения позволят разместиться на одном листе. 

 

Рис. 21.3 

Рис. 21.4 
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12.4. Если положения или размеры рамок выносных элементов на Виде 

спереди были изменены, то перестроить изображения командой Вид ⇒ Пе-

рестроить (или клавишей F5). 

12.5. Если изображения не помещаются на одном листе, то по 7.1 доба-

вить второй лист (горизонтальный А3 или вертикальный А4) с оформле-

нием Чертеж констр. Посл. листы. ГОСТ 2.104-2006. 

12.6. При необходимости передвинуть виды в рабочем поле. 

13. Нажать пиктограмму Параметрический режим (см. рис. 6.8) на ПИ 

Текущее состояние. 

14. Сделать текущим Вид спереди и командой Обозначение центра 

(см. рис. 17.5) обозначить центры всех отверстий. Стоит отметить, что для 

резьбовых отверстий в качестве кривой для обозначения центра необходимо 

указывать дугу, нарисованную тонкой линией. 

Затем аналогичным образом обозначить центры отверстий на остальных 

видах, предварительно делая их текущими. 

15. Сохранить чертеж (Ctrl+S) и выполнить проверку по п. 12 из 6.5. 

16. Отключить режим Ортогональное черчение клавишей F8. 

17. В соответствии с информацией из прил. Д и материалами п. 17 из 

20.1 нанести размеры и предельные отклонения, указать допуски формы и 

расположения поверхностей, а также их шероховатость: 

17.1. На Виде спереди и выносных элементах (при наличии), предвари-

тельно делая их текущими, командами с рис. 7.21 проставить размеры проре-

зей с предельными отклонениями по 14-му квалитету. 

Стоит отметить следующее: 

– предельные отклонения размеров можно не показывать, если они соот-

ветствуют указанию из ОСТ4 ГО.070.014 (см. Д.6), ссылка на который будет 

дана в ТТ; 

– размеры радиусов можно указать в ТТ (см. п. 22 из Д.5). 

17.2. На выносном элементе Б (см. рис. 21.4) в варианте «П1» показано 

только два размера, поэтому для уменьшения занимаемого им места на чер-

теже его масштаб был изменен с 4:1 до 2:1: 

– на выбранном виде выполнена команда ПКМ ⇒ Масштаб ⇒ 2:1; 

– в появившемся окне с вопросом о масштабировании выносных линий 

нажата кнопка Нет; 

– отредактировано положение надписи вида и проверено выполнение 

требований п. 15 из Д.5; 
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– так как масштаб вида соответствует масштабу, указанному в основной 

надписи, то на надписи вида запущена команда ПКМ ⇒ Редактировать и в 

Панели свойств на вкладке Надпись вида отключена опция Масштаб. 

Результат в варианте «П1» на данном этапе показан на рис. 21.5. 

 

17.3. При необходимости передвинуть виды в рабочем поле. 

17.4. По примеру рис. Д.37 нанести размеры, определяющие номиналь-

ное расположение осей резьбовых отверстий, ограниченное рассчитанным в 

п. 17.9 из 20.1 позиционным допуском. Допуск указать независимым.  

Для этого выполнить следующие действия: 

17.4.1. Продумать на каких видах будут расположены следующие базо-

вые поверхности (см. Д.7): 

Рис. 21.5 
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– установочной базой будет та поверхность, которой «основание» кон-

тактирует с нижней поверхностью ПП «усилителя»; 

– направляющая и опорная базы – поверхности, имеющие общую линию 

пересечения в том угле контура ПП, в котором в файле трассировки распола-

галась точка начала координат (см. рис. 12.25). При этом эти базы должны 

совпасть с указанными на «экране». 

17.4.2. Предварительно делая текущим требуемый вид, командой База 

(см. рис. 20.20 и п. 17.10.2 из 20.1) добавить соответствующие базы. 

В варианте «П1» установочная база (Г) показана на Виде сверху, а 

направляющая (Д) и опорная (Е) базы – на Виде спереди (рис. 21.6). 

 

17.4.3. Сделать текущим Вид спереди и цепочкой нанести размеры от-

носительно угла, образованного направляющей и опорной базами. 

Размерные числа поместить в рамку (см. п. 17.10.3 из 20.1). 

На этом же изображении командой Осевая линия по двум точкам (см. 

рис. 17.5) соединить центры крайних отверстий, находящихся на одной оси. 

17.4.4. Убедиться в том, что текущим является Вид спереди, и выпол-

нить следующее: 

– командой Диаметральный размер показать количество резьбовых от-

верстий и размер резьбы (см. п. 20 из 17.2), при этом в окне Задание размер-

ной надписи в списке перед кнопкой Значение (см. рис. 17.10) вместо знака 

диаметра выбрать букву М (метрическая резьба); 

– в соответствии с п. 17.10.4 из 20.1 указать позиционный допуск со зна-

чением оснT  без знака зависимого допуска; 

– у добавленной рамки отключить опцию Очистить фон; 

– скорректировать положение добавленных объектов (рис. 21.7). 

Рис. 21.6 
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17.5. Перестроить изображения клавишей F5. 

17.6. Сохранить чертеж (Ctrl+S). 

17.7. Отдельно для каждого выносного элемента, предварительно делая 

его текущим, переместить появившиеся осевые линии на вспомогательный 

погашенный слой (см. п. 11 из 17.2). 

Примечание. Скрыть выделенные 

объекты также можно с помощью пик-

тограммы «Скрытие выделенных объек-

тов» из ПИ Сервисные инструменты ⇒ 

Инструменты (рис. 21.8). Способ запуска ПИ «Сервисные инструменты» 

указан в п. 8.2 из 6.5. 

Если на изображении появился лишний контур из тонкой линии, выхо-

дящий за пределы границ «основания», то его необходимо удалить. 

17.8. Показать размеры контура «основания» и назначить им предельные 

отклонения по 11-му или 12-му квалитету и основному отклонению H или h.  

К таким размерам относятся следующие: 

Рис. 21.7 

Скрытие выделенных  

объектов 

Рис. 21.8 

Инструменты 
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– толщины первого и второго уровней (см. разд. 15) с основным откло-

нением для вала, так как в общем задании на проектирование задано ограни-

чение по высоте изделия. Толщину второго уровня показать на том изобра-

жении, на котором видны оба боковых выступа; 

– размеры по горизонтали и вертикали в соответствии с подходящим для 

варианта задания схематичным изображением с рис. 21.9.  

 

Необходимо учесть следующее: 

– размеры должны удовлетворять требованиям из Д.5; 

– на каждом изображении есть один или два справочных размера; 

– размеры не обязательно должны быть расположены только в приве-

денном положении и только на одном виде; 

– вид, на котором проставляются размеры, обязательно должен быть те-

кущим; 

– для выравнивания размеров служит команда, указанная в п. 17 из 17.2; 

Рис. 21.9 
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– размерам, показывающим ширину боковых выступов, назначить ос-

новное отклонение для вала; 

– размерам, показывающим контур первого уровня (контур ПП), назна-

чить поле допуска H11; 

– размерам, показывающим длины боковых выступов и не совпадающим 

с размерами контура первого уровня, назначить поле допуска h12. 

При необходимости осуществить корректировки положения объектов. 

Размеры в варианте «П1» проставлены на Виде спереди и Виде сверху 

(рис. 21.10). 

 

17.9. Нанести размеры отверстий для установки СВЧ-разъемов на каж-

дом боковом выступе, а также их положение, указав предельные отклонения 

по 12–14-му квалитету и основному отклонению H или h. 

Для этого выполнить следующие действия: 

17.9.1. На любом подходящем виде (видах), предварительно сделав его 

текущим, командой База добавить на боковые поверхности выступов, кон-

тактирующие с фланцами СВЧ-разъемов (см. рис. 15.16, б), обозначения баз. 

Рис. 21.10 
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В варианте «П1» базы добавлены на Виде сверху (рис. 21.11). 

 

17.9.2. Сделать текущим Вид слева и проделать следующее: 

– командой Осевая линия по двум точкам (см. рис. 17.5) соединить 

центры двух резьбовых отверстий; 

– командой Авторазмер или Линейный размер указать положение 

центрального отверстия в соответствии с рис. 21.12, а. Симметричное пре-

дельное отклонение (±0,1) для большего размера указать по п. 23.12 из 17.2. 

Для меньшего размера задать поле допуска h12 или h13; 

 

– командой Авторазмер или Линейный размер указать диаметр цен-

трального отверстия с полем допуска H12, отведя выносные линии от проти-

воположных точек пересечения окружности и осевых линий. Знак диаметра 

поставить также, как и знак метрической резьбы в п. 17.4.4; 

– командой База обозначить в качестве базы ось центрального отверстия 

(рис. 21.12, б). Обратить внимание на то, что в этом случае по ГОСТ Р 2.308–

2023 треугольник базы должен быть расположен на конце размерной линии; 

– показать размер между резьбовыми отверстиями. Размерное число по-

местить в рамку (см. п. 17.10.3 из 20.1); 

Рис. 21.12 

а б 

Рис. 21.11 
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– командой Диаметральный размер показать количество резьбовых от-

верстий и размер резьбы (см. п. 20 из 17.2), при этом в окне Задание размер-

ной надписи вместо знака диаметра выбрать букву М (метрическая резьба); 

– запустить команду Допуск формы (см. рис. 20.24), в Панели свойств 

в поле Базовая точка указать точку привязки рамки Слева вверху, в поле 

Таблица нажать пиктограмму Создание таблицы в полуавтоматическом 

режиме и в открывшемся окне задать настройки в соответствие с рис. 21.13. 

 

Необходимо отметить, что в группе База 1 должна быть указана устано-

вочная база, расположенная на соответствующей боковой поверхности вы-

ступа, контактирующей с фланцем СВЧ-разъема, а в группе База 2 – база на 

оси центрального отверстия с указанием зависимого допуска. 

Примечание. В результате задан позиционный допуск осей двух резьбо-

вых отверстий по отношению друг к другу и относительно базового отвер-

стия, позиционный допуск которого относительно центральной оси сим-

метрии резьбовых отверстий в зависимости от его диаметра может изме-

няться от 0 мм (при диаметре 4,5 мм) до 0,12 мм (при диаметре 4,72 мм). 

При этом этот зависимый допуск не увеличивает позиционные допуски 

резьбовых отверстий относительно друг друга, т. е. независимо от диа-

метра центрального отверстия позиционный допуск каждого резьбового 

отверстия составит 0,3 мм относительно его номинального положения; 

– добавить созданную рамку с позиционным допуском в точку начала 

полки диаметрального размера резьбовых отверстий; 

– у добавленной рамки отключить опцию Очистить фон; 

– скорректировать положение объектов на чертеже. 

Результат в варианте «П1» показан на рис. 21.14, а. 

17.9.3. Сделать текущим один из видов, на котором полностью показаны 

отверстия для крепления второго СВЧ-разъема, и проделать точно такие же 

действия, как в п. 17.9.2. 

В варианте «П1» для этого был использован Вид справа (рис. 21.14, б). 

Рис. 21.13 
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17.10. На любом подходящем виде (видах), предварительно сделав его 

текущим, для внутренних поверхностей боковых выступов добавить указа-

ния о допуске перпендикулярности по п. 17.12 из 20.1. 

В варианте «П1» для этого был использован Вид сверху (рис. 21.15). 

 Рис. 21.15 

а 

Рис. 21.14 

б 
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17.11. На любом подходящем виде (видах), предварительно сделав его 

текущим, для поверхности, контактирующей с нижней поверхностью ПП 

«усилителя», добавить следующие указания: 

– допуск плоскостности по п. 17.11 из 20.1; 

– обозначение шероховатости по п. 17.13 из 20.1. 

В варианте «П1» это сделано на Виде сверху и Виде справа (рис. 21.16). 

 

17.12. Сохранить чертеж (Ctrl+S). 

17.13. В соответствии с ГОСТ 2.311–68 сплошную тонкую линию при 

изображении резьбы наносят на расстоянии не менее 0,8 мм от основной ли-

нии [95]. Как и в УГО на схемах, это необходимо для различения линий по-

сле печати. 

Для корректировки изображений резьбы отдельно для каждого вида, на 

котором есть отверстия с резьбой, выполнить следующее: 

– сделать текущим требуемый вид; 

– выделить окружности со стилем линии Основная в изображениях 

резьбовых отверстий; 

– выполнить команду Скрытие выделенных объектов на ПИ Сервис-

ные инструменты ⇒ Инструменты (см. рис. 21.8); 

– запустить команду Окружность из ПИ Компактная панель ⇒ Гео-

метрия; 

– на Панели свойств в поле Диа-

метр задать требуемое значение с уче-

том масштаба вида (например, в мас-

штабе 2:1 для отверстий М2,5 – 1,7 мм, 

для отверстий М2 – 1,3 мм), нажать 

пиктограмму Запомнить состояние (см. рис. 14.13) и добавить окружности 

на места ранее скрытых. 

В варианте «П1» изменения произведены на Виде спереди, Виде слева 

и Виде справа. Результат для одного из отверстий показан на рис. 21.17. 

Рис. 21.16 

Рис. 21.17 
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17.14. Перестроить изображения клавишей F5. 

Если на выносных элементах появились лишние контуры из тонкой ли-

нии, выходящие за пределы границ «основания», то их необходимо удалить. 

17.15. Для собираемости изделия требуется, чтобы поля позиционных 

допусков соответствующих отверстий в «экране», ПП и «основании» нахо-

дились в одном и том же месте (см. Д.7). При проектировании таким местом 

выбрана область расположения «экрана» и ПП, поэтому для отверстий М2,5 

в «основании» необходимо указать выступающее поле допуска: 

– сделать текущим Вид слева; 

– в области расположения отверстия М2,5 и отсутствия боковых высту-

пов (рис. 21.18, а) командой Выносной элемент (см. рис. 17.5 и п. 23.2 из 

17.2) создать выносной элемент в основном масштабе чертежа; 

 

– разрушить вид с выносным элементом; 

– удалить в выносном элементе все линии и кривые; 

– открыть файл P(М2,5).cdw из папки …\ИДРЭС\Монтаж элементов, 

содержание которого при включенной команде Отображать ограничения 

(см. рис. 15.6) показано на рис. 21.18, б.  

Примечание. Изображение нарисовано в параметрическом режиме, по-

этому на все объекты наложены параметрические связи. Приведенный раз-

мер является управляющим, о чем свидетельствует голубая рамка вокруг 

размерного числа. Символ выступающего поля допуска указан в поле «Текст 

до» окна «Задание размерной надписи»; 

– скопировать все объекты (Ctrl+C) без выделения вида; 

– перейти на вкладку с чертежом «основания»; 

– убедиться в том, что вид с выносным элементом текущий, и вставить 

(Ctrl+V) скопированные объекты; 

а 

Рис. 21.18 

б 



 

 586 

– закрыть вкладку с файлом P(М2,5).cdw; 

– запустить команду Установить значение размера на ПИ Компакт-

ная панель ⇒ Параметризация (рис. 21.19, а) и указать размер на вставлен-

ном изображении (или дважды щелкнуть ЛКМ по размерному числу), после 

чего в появившемся окне (рис. 21.19, б) в поле Выражение ввести число 7 

(разность двух уровней «основания», описанных в разд. 15) и нажать OK. Ре-

зультат показан на рис. 21.19, в; 

 

– войти в режим редактирования рамки с позиционным допуском для 

резьбовых отверстий М2,5 и в Панели свойств нажать ЛКМ в поле Текст; 

– в открывшемся окне во второй ячейке после значения позиционного 

допуска в соответствии с п. 29.2 из 17.2 вставить знак выступающего поля 

допуска (группа Допуски формы и расположения поверхностей). 

Результат в варианте «П1» показан на рис. 21.19, г. 

Примечания: 

– так как включена автосортировка буквенных обозначений, о чем сви-

детельствует их синий цвет, то после добавления выносного элемента на 

чертеже произойдет автоматическая сортировка в соответствии с задан-

ным в настройках порядком; 

Рис. 21.19 

б 

в г 

а 

Установить значение размера 

Зафиксировать размер 
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– показать выступающее поле допуска можно и на самом виде без вы-

носного элемента, и с автоматически созданным местным разрезом, но из-

за разнообразия форм «оснований» в вариантах задания использован один 

подходящий для всех способ; 

– управляющий размер при необходимости можно сделать информаци-

онным, включив соответствующую опцию в окне «Установить значение 

размера» (см. рис. 21.19, б); 

– сделать информационный размер управляющим, если это возможно 

(например, размер не на ассоциативном виде), можно указанной опцией или 

командой «Зафиксировать размер» из группы «Зафиксировать точку» на 

ПИ Компактная панель ⇒ Параметризация (см. рис. 21.19, а). 

17.16. В вариантах задания рассчитать позиционный допуск резьбового 

отверстия для крепления СВЧ-разъема по (Д.2) и (Д.3), полагая, что в 

СВЧ-разъеме позиционный допуск отверстий составляет 0,1 мм, а их 

наименьший предельный диаметр – 2,6 мм. 

Примечание. Для этих отверстий показывать выступающее поле до-

пуска не нужно, так как значение их позиционного допуска было уменьшено. 

17.17. Указать общую шероховатость по п. 17.14 из 20.1. 

18. Сохранить чертеж (Ctrl+S). 

19. Добавить ТТ, для чего выполнить следующие действия: 

19.1. Войти в режим редактирования ТТ. 

19.2. По п. 25.2 из 17.2 задать необходимые настройки. 

19.3. Ввести текст следующего вида: 

1 * Размер для справок. 

2 Радиусы скруглений - 1,5 мм max. 

3 Остальные технические требования по ОСТ4 ГО.070.014. 

При копировании обратить внимание на примечание к п. 25.3 из 17.2. 

19.4. Сохранить ТТ (Ctrl+S) и выйти из режима их редактирования. 

19.5. Убедиться в том, что расстояние между нижней строкой ТТ и рам-

кой основной надписи не менее 10 мм.  

При необходимости изменить положение ТТ по п. 25.5 из 17.2. 

20. Отжать пиктограмму Параметрический режим (см. рис. 6.8) на ПИ 

Текущее состояние. 

21. Если в чертеже есть второй лист, то отредактировать надписи пере-

несенных на него изображений, а также соответствующие надписи на изоб-

ражениях, с которых они были получены (см. п. 22 из 20.1). 
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 Рис. 21.20 
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22. Если вид с непосредственной проекционной связью не позволяет 

произвести желаемую компоновку изображений, то преобразовать его в вид 

по стрелке (см. п. 23 из 20.1). 

23. При необходимости поменять последовательность присвоения букв 

на чертеже (см. п. 24 из 20.1). 

24. Проверить полноту простановки размеров (см. п. 25 из 20.1). 

25. Сохранить изменения в схеме (Ctrl+S). 

Результат в варианте «П1» показан на рис. 21.20. 

26. Сохранить чертеж в формате PDF по 17.3. 

Имя файла в варианте «П1» – «УП1.00.02 - Основание - v0.1», а путь 

сохранения – …\ИДРЭС-П1\_pdf (см. рис. 2.7). 

 Рис. 21.21 
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На рис. 21.21 показано содержание файла «Расчеты (детали).xmcd», в 

котором производились расчеты в варианте «П1». 

Стоит отметить, что в Mathcad внутри текстовой надписи, находясь в 

режиме ее редактирования, командой Insert ⇒ Math Region можно добав-

лять полноценные математические выражения, которые будут участвовать в 

вычислениях. 

21.2. Содержание отчета 

По 21-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести: 

1. Расчет позиционного допуска резьбовых отверстий в выступах «осно-

вания» для крепления СВЧ-разъемов с пояснениями. 

2. Чертеж «основания», распечатанный на отдельном листе (листах). 

Схема складывания листа формата A3 при расположении основной 

надписи вдоль длинной стороны листа для непосредственного брошюрова-

ния показана на рис. 8.71. 
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22. СПЕЦИФИКАЦИЯ НА «МОДУЛЬ УСИЛИТЕЛЯ» 

Правила оформления спецификации были приведены в 18.1. 

Последовательность действий для создания спецификации на «модуль 

усилителя»: 

1. Открыть заготовку спецификации, указанную в 18.2. 

2. Сохранить заготовку командой Файл ⇒ Сохранить как с расшире-

нием «.doc». Имя файла в варианте «П1» – «УП1.00.01 - Модуль усилителя - 

v0.1», а путь сохранения – …\ИДРЭС-П1 (см. рис. 2.7). 

3. Войти в режим редактирования нижних колонтитулов по п. 3 из 9.2 и 

заполнить без копирования графы рамки в соответствии с табл. 22.1. Содер-

жание остальных граф должно соответствовать данным табл. 9.1. 

Пояснения к графам даны в табл. 3.1, на рис. 9.1 и на рис. 3.6, б и в. 

Таблица 22.1 

Содержание граф рамки для спецификации на «модуль усилителя»,  

отличающихся от перечня элементов ПЭ3 «усилителя» 

Номер  

графы 
Содержание Комментарий к заполнению 

1 Модуль усилителя Наименование изделия определено в табл. 2.1 

2  

(на первом  

и втором 

листе) 

УП1.00.01 

Обозначение документа определено в табл. 2.1 и ука-

зано для варианта «П1». 

Обозначение со второго листа при увеличении числа 

листов повторяется на каждом последующем 

25 Символ «–» 
Ставится прочерк, так как спецификация создается на 

изделие, которое не входит в другие изделия 

4. Выйти из режима редактирования колонтитулов по п. 4 из 9.2. 

5. В КОМПАС-3D командой Файл ⇒ Открыть открыть 3D-модель 

«модуля усилителя» (расположение указано в п. 3 из разд. 14). 

В Дереве модели нажать пиктограмму Отображение структуры моде-

ли (см. рис. 13.23), а затем на треугольник около пиктограммы Состав Дере-

ва модели и в выпадающем списке выбрать опцию Группировать компо-

ненты. В результате составные части сборки отсортируются по трем группам 

(Сборочные единицы, Детали и Библиотечные компоненты), внутри ко-

торых изделия будут собраны по общему признаку с указанием количества в 

скобках. 

Результат в варианте «П1» показан на рис. 22.1. 

6. В соответствии с информацией из 18.1 и данными Дерева модели за-

полнить графы таблицы из рабочего поля спецификации: 
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6.1. Начиная со второй строки, заполнить раздел «Документация». 

Здесь будет четыре документа, расположенных согласно п. 1.4 из 18.1 в 

следующем порядке: 

– сборочный чертеж «модуля усилителя» (рис. 23.14); 

– схема Э1 «модуля усилителя» (см. рис. 8.67); 

– схема Э3 «модуля усилителя» (см. рис. 10.4); 

– перечень элементов ПЭ3 «модуля усилителя» (см. рис. 11.1). 

Данные КД – документы на специфицируемое изделие (их обозначения 

отличаются от спецификации только кодами документа – СБ, Э1, Э3, ПЭ3). 

Так как на данном этапе сборочного чертежа «модуля усилителя» еще 

нет, то для него в графе «Формат» временно записать формат A3. Если по-

требуется, он будет скорректирован в разд. 23. 

6.2. В разделе «Сборочные единицы» будет одна позиция – Усилитель. 

Основной КД для него показан на рис. 18.5 и 19.41. В графе «Примечание» 

указать его позиционное обозначение со схемы Э3 «модуля усилителя». 

6.3. В раздел «Детали» записать только те позиции для которых были 

выполнены основные этапы проектирования из разд. 20 и 21. 

Обратить внимание на порядок записи деталей (см. п. 1.5 из 18.1). 

Рис. 22.1 

Состав «Дерева 

модели» 
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В варианте «П1» записаны Экран и Основание. Основные КД на них 

показаны на рис. 20.37 и 21.20. 

Если указанные этапы проектирования не выполнялись, то раздела «Де-

тали» в спецификации не будет. 

6.4. В раздел «Стандартные изделия» записать крепежные изделия по 

ГОСТ, обратив внимание на порядок записи (см. п. 1.6 из 18.1) и на то, что по 

ГОСТ Р 2.106–2019 допускается объединять разделы «Стандартные изделия» 

и «Прочие изделия» в раздел «Прочие изделия». 

6.5. В разделе «Прочие изделия» будут следующие позиции: 

– СВЧ-разъем; 

– «экран» и (или) «основание», если для них не разработаны чертежи; 

– крепежные изделия по зарубежным стандартам (DIN или ISO по пп. 

24–27 из 16.1), если они были использованы в «модуле усилителя»; 

– крепежные изделия по ГОСТ, если раздел «Стандартные изделия» ре-

шено объединить с разделом «Прочие изделия». 

При записи необходимо обратить внимание на следующее: 

– в графе «Примечание» для СВЧ-разъемов должны быть указаны их по-

зиционные обозначения со схемы Э3 «модуля усилителя»; 

– крепежные изделия должны быть записаны в конце раздела; 

– для «экрана» и (или) «основания» (при наличии в этом разделе) в гра-

фе «Наименование» записать наименование и обозначение основного КД по 

основной структуре системы обозначения из прил. Р, заменив код организа-

ции-разработчика на условный АБВГ и добавив в конце номер варианта че-

рез дефис без пробела (см. пример обозначения исполнения изделия в 2.3 и 

Н.1). В графе «Примечание» записать название фирмы-поставщика – ООО 

«Рога и Копыта». Пример для «экрана» показан на рис. 22.2; 

 

– если слово не помещается в ячейку, то необходимо либо перенести его 

часть в ячейку ниже, либо вписать в ячейку по п. 6 из 11.1; 

– добавление новых строк осуществляется по п. 7 из 9.2; 

– удаление лишних строк осуществляется по п. 8 из 9.2. 

Рис. 22.2 
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 Рис. 22.3 Начало (окончание см. на с. 595) 
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 Рис. 22.3 Окончание (начало см. на с. 594) 



 

 596 

7. Проставить номера позиций. 

8. Если спецификация поместилась на одну страницу, то номер листа в 

графе 7 основной надписи необходимо скрыть. 

Для этого выделить его и назначить белый цвет шрифту. 

9. Так как вся информация в спецификации поместится на четырех ли-

стах и менее, то в соответствии с п. 4 из 18.1 необходимо скрыть ЛР. 

Для этого выполнить п. 9 из 9.2. 

10. Закрыть 3D-модель «модуля усилителя» без сохранения изменений. 

11. Сохранить изменения в спецификации (Ctrl+S). 

12. При желании выполнить 8-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. П). 

Результат в варианте «П1» показан на рис. 22.3. 

Сохранение в формате PDF будет произведено после уточнения форма-

тов листов сборочного чертежа «модуля усилителя» из разд. 23. 

Требования к содержанию отчета по данному этапу приведены в 23.2. 

 

 



 

 597 

23. СБОРОЧНЫЙ ЧЕРТЕЖ «МОДУЛЯ УСИЛИТЕЛЯ» 

23.1. Создание сборочного чертежа «модуля усилителя» 

Правила оформления сборочных чертежей были приведены в 19.1. 

Последовательность действий для создания сборочного чертежа «моду-

ля усилителя»: 

1. В КОМПАС-3D открыть 3D-модель «модуля усилителя» (расположе-

ние указано в п. 3 из разд. 14). 

2. СКМ повернуть «модуль усилителя» в рабочем поле так, чтобы спе-

реди оказался «экран», после чего щелкнуть ЛКМ по верхней поверхности 

«экрана» с надписями (рис. 23.1) и в появившейся над курсором ПИ нажать 

пиктограмму Нормально к. 

Сохранить ориентацию 3D-модели, 

добавив новый вид с помощью команды 

Вид ⇒ Ориентация и присвоив ему имя 

(например, Главный). 

Сохранить изменения (Ctrl+S) и за-

крыть вкладку с 3D-моделью. 

3. По информации из 7.1 создать но-

вый чертеж и задать следующие 

настройки листа: 

– формат – A3; 

– ориентация – горизонтальная; 

– оформление – Чертеж констр. Первый лист. ГОСТ 2.104-2006. 

4. Сохранить чертеж командой Файл ⇒ Сохранить как с расширением 

«.cdw». Имя файла в варианте «П1» – «УП1.00.01СБ - Модуль усилителя - 

v0.1», а путь сохранения – …\ИДРЭС-П1 (см. рис. 2.7). 

5. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

6. Запустить команду Стандартные виды (см. рис. 7.6) и указать путь к 

3D-модели «модуля усилителя». 

В Панели свойств на вкладке Параметры выполнить следующее: 

– в поле Ориентация главного вида выбрать Главный (задан в п. 2); 

– в поле Схема видов указать вид спереди, вид снизу и вид слева (рас-

положение видов см. на рис. 7.3); 

– в поле Масштаб вида выбрать масштаб 2:1. 

Рис. 23.1 
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Реультат в варианте «П1» с обозначением видов показан на рис. 23.2, а. 

 

7. В Дереве чертежа изменить названия видов в соответствии с обозна-

чениями на рис. 23.2, а (см. п. 7 из 17.2). 

Результат в варианте «П1» показан на рис. 23.2, б. 

8. Заполнить графы рамки в соответствии с табл. 23.1. Содержание 

остальных граф должно соответствовать данным табл. 17.1. 

Пояснения к заполнению приведены в п. 8 из 17.2. 

Пояснения к графам даны в табл. 3.1 и на рис. 3.6, а и в. 

Таблица 23.1 

Содержание граф рамки для сборочного чертежа «модуля усилителя», 

отличающихся от чертежа ПП 

Номер  

графы 
Содержание Комментарий к заполнению 

1 
Модуль усилителя 

Сборочный чертеж 

Наименование изделия определено в табл. 2.1 и записы-

вается автоматически, так как было задано в свойствах 

3D-модели. 

Наименование документа указывается командой ПКМ ⇒ 

Вставить код и наименование. В открывшемся окне 

выбирается строчка с кодом СБ, внизу окна отключается 

опция Код через пробел и нажимается OK. 

Параметры шрифта в Панели свойств на вкладке Фор-

мат: 

– для наименования изделия: высота символов – 7, шаг 

строк – 11; 

– для наименования документа: высота символов – 5, шаг 

строк – 8 

2 УП1.00.01СБ 

Обозначение документа определено в табл. 2.1, указано 

для варианта «П1» и записывается автоматически, так 

как было задано в свойствах 3D-модели, а код докумен-

та – при заполнении графы 1. 

Данные этой графы повторяются на каждом новом листе 

Рис. 23.2 

Вид  

спереди 

Вид  

слева 

а 

б 

Вид снизу 
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Окончание таблицы 23.1 

Номер  

графы 
Содержание Комментарий к заполнению 

3 См. комментарий Графа должна остаться пустой 

5 43 г 

Заполняется автоматически при выборе в Панели 

свойств на вкладке Параметры в поле Единицы изме-

рения массы опции граммы, а в поле Точность пред-

ставления значения 0 

6 2:1 
Заполняется автоматически в соответствии с масштабом 

главного вида 

25 УП1.00.01 
Обозначение спецификации, в которой записан КД, 

определено в табл. 2.1 и указано для варианта «П1» 

26 УП1.00.01СБ 

Заполняется автоматически и полностью соответствует 

содержанию графы 2. 

Данные этой графы повторяются на каждом новом листе 

9. Запустить режим редактирования основной надписи и в Панели 

свойств на вкладке Параметры отжать пиктограмму Синхронизация дан-

ных (см. рис. 7.7), тем самым отключив передачу данных между 3D-моделью 

и основной надписью чертежа. 

10. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

11. На Виде спереди создать местный разрез, показав расположение 

прорези в боковой стенке «экрана». 

Для этого выполнить следующее: 

11.1. Сделать текущим Вид спереди. 

11.2. Запустить команду Сплайн по точкам (см. рис. 7.15) из ПИ Ком-

пактная панель ⇒ Геометрия и в Панели свойств в поле Тип кривой вы-

брать пункт Кривая Безье, а в поле Режим – Замкнутый объект. 

Стиль линии не имеет значения. 

Затем в рабочем поле в том месте вида, где планируется создать мест-

ный разрез, нарисовать замкнутый контур. 

11.3. Запустить команду Местный разрез из 

ПИ Компактная панель ⇒ Виды (рис. 23.3). 

В рабочем поле сначала ЛКМ указать замкну-

тый контур, в результате чего он изменит цвет на красный, а затем положе-

ние секущей плоскости на любом виде, плоскость расположения которого 

перпендикулярна плоскости Вида спереди, при этом расстояние от секущей 

плоскости до верхней поверхности ПП должно быть менее 1 мм. 

В варианте «П1» секущая плоскость указана на Виде слева (рис. 23.4, а). 

Рис. 23.3 

Местный разрез 
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Результат создания местного разреза показан на рис. 23.4, б. 

11.4. Если разрез оказался в неправильном месте, то отредактировать 

форму его контура и расположение секущей плоскости, для чего в Дереве 

чертежа раскрыть группу Вида спереди и выполнить одну из следующих 

команд (рис. 23.4, в): 

Рис. 23.4 

Замкнутый контур Секущая плоскость 

Верхняя поверхность ПП 

а 

б 

в 
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– ПКМ ⇒ Удалить разрез – для удаления местного разреза; 

– ПКМ ⇒ Местный разрез – для включения и отключения местного 

разреза (например, после его отключения можно поменять контур); 

– ПКМ ⇒ Параметры разреза – для задания параметров местного раз-

реза (например, для изменения положения секущей плоскости в Панели 

свойств необходимо нажать кнопку Секущая плоскость). 

Кроме того, в этой же группе можно выбрать части 3D-модели, которые 

подлежат или не подлежат разрезу. 

После редактирования местного разреза перестроить чертеж командой 

Вид ⇒ Перестроить (или клавишей F5). 

12. Убедиться в том, что местный разрез редактировать больше не нуж-

но, после чего разрушить все виды. 

13. Сохранить чертеж (Ctrl+S) и осуществить проверку по п. 12 из 6.5. 

14. Командой Усечь кривую из ПИ Компактная панель ⇒ Редакти-

рование (см. рис. 6.20) максимально упростить все виды, кроме Вида спере-

ди (см. п. 1.5 из 19.1). 

При необходимости воспользоваться командой Удлинить до ближай-

шего объекта из той же ПИ. 

Результат в варианте «П1» на данном этапе показан на рис. 23.5. 

 Рис. 23.5 
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15. Отредактировать Вид спереди: 

15.1. Сделать вид текущим и удалить контуры надписей с «экрана», а 

также компоненты и переходные отверстия с ПП «усилителя» (рис. 23.6). 

 

15.2. При необходимости изменить шаг штриховки местного разреза. 

15.3. На место удаленных объектов с «экрана» добавить текстовые 

надписи из чертежа «экрана» (расположение указано в п. 4 из 20.1). 

Если чертеж «экрана» не разрабатывался, то надписи скопировать из его 

3D-модели по п. 11 из 20.1. 

15.4. На место удаленных с ПП «усилителя» компонентов добавить со-

ответствующую графику из сборочного чертежа «усилителя» (расположение 

указано в п. 4 из 19.3). 

Затем удалить позиционные обозначения компонентов и информацию о 

положении первых выводов. 

15.5. Упростить изображения СВЧ-разъемов. 

15.6. Удалить фаски отверстий в «экране» и окружности шайб на ПП. 

Результат в варианте «П1» показан на рис. 23.7. 

 

Рис. 23.6 

Рис. 23.7 
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16. Отдельно для каждого вида, предварительно делая его текущим, от-

редактировать изображения винтов: 

16.1. Изменить изображения головок винтов в соответствии с требова-

нием ГОСТ 2.315–68: шлицы на головках следует изображать при виде свер-

ху одной сплошной линией под углом 45º к рамке чертежа, а при виде сбо-

ку – по оси крепежной детали (рис. 23.8). 

 

16.2. Включить режим Ортогональное черчение клавишей F8. 

16.3. В соответствии с рис. 23.8 командами Обозначение центра и Осе-

вая линия по двум точкам из ПИ Компактная панель ⇒ Обозначения 

(см. рис. 17.5) обозначить центры винтов и их оси. 

17. Командой Линейный размер или Авторазмер (см. рис. 7.21) про-

ставить габаритные размеры изделия и размер, показывающий выполнение 

требования общего задания на проектирование по толщине изделия в области 

расположения «экрана». 

Необходимо обратить внимание на следующее: 

– вид, на котором проставляются размеры, должен быть текущим; 

– добавленные размеры должны удовлетворять требованиям из Д.5; 

– так как все размеры справочные, и об этом будет дано указание в ТТ, 

то по п. 2 из Д.5 знак «*» после размерных чисел ставить не нужно; 

– в вариантах задания с параллельным расположением боковых высту-

пов «основания» показать обозначение посадки (см. примечание к п. 17.4 из 

20.1), для чего в режиме редактирования размера в окне Задание размерной 

надписи в поле Текст после дважды щелкнуть ЛКМ и в выпадающем меню 

выбрать Посадки в системе отверстия ⇒ Посадки с зазором ⇒ H11/d11; 

– так как виды были разрушены, а проекционные связи между ними 

удалились, то при необходимости перемещения видов друг относительно 

друга проследить за тем, чтобы они находились на одной горизонтали и вер-

тикали относительно Вида спереди. 

Вид спереди в варианте «П1» на данном этапе показан на рис. 23.9. 

Рис. 23.8 [9] 
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18. Отключить режим Ортогональное черчение клавишей F8. 

19. Командой Обозначение позиций (см. рис. 19.32) из ПИ Компакт-

ная панель ⇒ Обозначения нанести номера позиций всех составных частей 

«модуля усилителя» из его спецификации (расположение указано в п. 2 из 

разд. 22). 

Необходимо обратить внимание на следующее: 

– вид, на котором проставляются позиции, должен быть текущим; 

– если требуется сдвинуть вид, то после начала его перемещения зажать 

клавишу Shift, чтобы он находился на одной горизонтали (вертикали) отно-

сительно Вида спереди; 

– правила простановки номеров позиций указаны в пп. 1.6–1.11 из 19.1; 

– при случайном добавлении лишних ответвлений удалить их в соответ-

ствии с информацией п. 24 из 7.3. 

Результат в варианте «П1» показан на рис. 23.10. 

20. Выровнять обозначения позиций по вертикали или горизонтали, для 

чего выполнить следующее: 

– выделить требуемые обозначения позиций; 

– запустить команду Инструменты ⇒ Выровнять позиции по верти-

кали или Выровнять позиции по горизонтали (или выбрать соответству-

ющую пиктограмму в появившейся над курсором ПИ); 

– указать базовую точку, по которой будет происходить выравнивание. 

Рис. 23.9 
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21. По пп. 23.1–23.7 из 19.3 добавить установочный чертеж СВЧ-разъема 

SMA-KFD5A из папки …\ИДРЭС\Монтаж элементов. 

Следует отметить, что позиционные обозначения СВЧ-разъемов необхо-

димо взять со схемы Э3 «модуля усилителя» (расположение указано в п. 1 из 

10.1). 

Затем в добавленном чертеже установки выполнить следующее: 

– расположить изображения СВЧ-разъема по горизонтали, для чего вос-

пользоваться командой Поворот из ПИ Компактная панель ⇒ Редактиро-

вание (см. рис. 6.20) при зажатой клавише Shift; 

– удалить знаки «*» в размерах, так как все размеры будут справочными; 

– удалить знаки «**» в обозначениях позиций и ввести номера позиций 

согласно спецификации на «модуль усилителя»; 

– отредактировать положения обозначений позиций и линии-выноски; 

– удалить поясняющую текстовую надпись под изображением. 

Результат в варианте «П1» показан на рис. 23.11. 

 

Рис. 23.10 

Краткая расшифровка номеров позиций  

из спецификации на «модуль усилителя» 

УП1.00.01 (см. рис. 22.3): 

– 1 – Усилитель УП1.01.01 (1 шт.); 

– 2 – Основание УП1.00.02 (1 шт.); 

– 3 – Экран УП1.00.03 (1 шт.); 

– 4 – Винт М2,5×9 ГОСТ 17475–80 (4 шт.); 

– 6 – Винт М2×4 ГОСТ 1491–80 (4 шт.); 

– 7 – Винт М2,5×3 ГОСТ 1491–80 (2 шт.); 

– 9 – Шайба 2,5 ГОСТ 10450–78 (2 шт.); 

– 10 – Розетка SMA-KFD5A (2 шт.) 

Рис. 23.11 
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22. Сделать текущим Вид спереди и командой Ввод текста из ПИ Ком-

пактная панель ⇒ Обозначения (см. рис. 6.41) добавить у СВЧ-разъемов и 

«усилителя» их позиционные обозначения со схемы Э3 «модуля усилителя». 

В Панели свойств на вкладке Формат выбрать следующие настройки: 

Шрифт – GOST type A; Высота символов – 3.5; опции Курсив, Полужирный, 

Подчеркнутый – отключено. 

23. Сохранить сборочный чертеж (Ctrl+S). 

24. Добавить ТТ, для чего выполнить следующие действия: 

24.1. Войти в режим редактирования ТТ. 

24.2. По п. 25.2 из 17.2 задать необходимые настройки. 

24.3. Ввести текст следующего вида: 

1 Размеры для справок. 

2 Паять ПОС 61 ГОСТ 21930-76. 

3 Позиционные обозначения элементов показаны условно. 

4 Электромонтаж вести по УП1.00.01Э3. 

5 Установку разъемов поз. X осуществить по приведенному варианту 

установки. Центральные жилы лудить (см. п. 2). 

6 Винты поз. Y стопорить по ОСТ 107.460091.014-2004, вид 25Г. 

7 Остальные технические требования по ОСТ4 ГО.070.015. 

При копировании обратить внимание на примечание к п. 25.3 из 17.2. 

24.4. Сохранить ТТ (Ctrl+S) и выйти из режима их редактирования. 

24.5. Убедиться в том, что расстояние между нижней строкой ТТ и рам-

кой основной надписи не менее 10 мм. 

При необходимости изменить положение ТТ по п. 25.5 из 17.2. 

24.6. Комментарий к 6-му пункту ТТ из п. 24.3. 

В этом пункте дана ссылка на отраслевой стандарт ОСТ 107.460091.014–

2004 [96], в котором устанавливаются способы и виды предохранения (сто-

порения) резьбовых соединений от самоотвинчивания и даются ТТ к ним.  

Среди способов стопорения различают две группы: 

– стопорение с применением механических средств (стопорные шайбы, 

обвязочная проволока, боковое кернение, пружинные шайбы, самоконтрящи-

еся гайки и др.); 

– стопорение с применением анаэробных герметиков и стопорение с 

применением красок, эмалей и грунтовки. 

В зависимости от применяемых средств стопорения каждый способ 

предохранения резьбовых соединений от самоотвинчивания подразделяют на 
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виды. Виды стопорения выбирает конструктор в зависимости от имеющихся 

возможностей при сборке и с учетом особенностей конструкции, условий 

эксплуатации и ремонта изделия. 

Например, указанный в ТТ вид 25Г – сто-

порение краской для резьбовых соединений, 

показанных на рис. 23.12. При таком виде сто-

порения краску наносят на боковую поверх-

ность головки болта (винта) по всему перимет-

ру с переходом на поверхность закрепляемой 

детали. Контроль проводят визуально. 

Буква «Г» – условное обозначение эмали 

ЭП-51 ГОСТ 9640-85. Демонтаж застопоренных 

соединений при ее использовании производится 

стандартным инструментом без затруднений. 

Стопорение красками целесообразно при-

менять для резьбовых соединений диаметром М1–М12 и крепления узлов 

конструкций, расположенных внутри блоков и подвергающихся в процессе 

сборки и настройки частым регулировкам. 

25. Войти в режим редактирования ТТ и выполнить следующее: 

25.1. Подвести курсор мышки к названию вкладки с ТТ, зажать ЛКМ и 

переместить курсор мышки в любое место рабочего поля. В результате оно 

разделится на две части (рис. 23.13). 

 

25.2. Заменить в тексте ТТ буквы Х и Y ссылками (команда ПКМ ⇒ 

Вставить ссылку) на номера позиций. 

Настройки окна Ссылка: 

– в поле Тип источника – Обозначение позиции; 

– в поле Ссылка на – Только номер позиции. 

Рис. 23.13 

Рис. 23.12 
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Проконтролировать правильность замены по вкладке со сборочным чер-

тежом «модуля усилителя» (выбранная позиция будет подсвечена) и по спе-

цификации. 

25.3. Заменить в пятом пункте ТТ номер пункта, указанного в скобках, 

ссылкой с настройками окна Ссылка по п. 28.4 из 19.3. 

25.4. Сохранить ТТ (Ctrl+S) и выйти из режима их редактирования. 

26. На виде с чертежом установки СВЧ-разъемов заменить номер пункта 

на линии-выноске с обозначением пайки ссылкой на 2-й пункт ТТ. Настрой-

ки окна Ссылка задать по п. 28.4 из 19.3. 

27. Убедиться в том, что Вид слева и Вид снизу находятся соответ-

ственно на одной горизонтали и вертикали с Видом спереди. 

Если это не так, то выполнить следующее: 

– выбрать ЛКМ требуемый вид; 

– запустить команду Сдвиг (см. рис. 6.20); 

– указать базовую точку для сдвига на выделенном виде; 

– осуществить выравнивание с помощью команды ПКМ ⇒ Геометри-

ческий калькулятор ⇒ Выровнять по двум точкам (необходимые поясне-

ния даны в п. 14 из 7.3). 

28. Сохранить изменения в сборочном чертеже (Ctrl+S). 

Результат в варианте «П1» показан на рис. 23.14. 

Примечание. На готовое изделие обычно наносится маркировка различ-

ными способами (например, обозначение основного КД и наименование изде-

лия краской). В данном учебном пособии предполагается, что такой марки-

ровкой является номер варианта, нанесенный способом гравирования на 

«экране». 

29. Сохранить сборочный чертеж в формате PDF по 17.3. 

Имя файла в варианте «П1» – «УП1.00.01СБ - Модуль усилителя - 

v0.1», а путь сохранения – …\ИДРЭС-П1\_pdf (см. рис. 2.7). 

30. При необходимости скорректировать формат сборочного чертежа в 

спецификации «модуля усилителя» согласно пп. 1.11 и 1.18 из 18.1. 

После внесения изменений сохранить спецификацию командой Файл ⇒ 

Сохранить как в ту же папку и с тем же расширением, но с версией v0.2. 

Предыдущую версию спецификации удалить. 

Так как в варианте «П1» сборочный чертеж получился на листе формата 

А3, то корректировка не потребовалась. 

31. Сохранить спецификацию в формате PDF по п. 11 из 9.2. 
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 Рис. 23.14 
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Имя файла в варианте «П1» – «УП1.00.01 - Модуль усилителя - v0.1», а 

путь сохранения – …\ИДРЭС-П1\_pdf (см. рис. 2.7). 

32. При желании выполнить 9-й дополнительный этап проектирования 

(см. табл. 2.3 и прил. Р). 

23.2. Содержание отчета 

По 22-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести спецификацию на «модуль усилителя», распеча-

танную на отдельном листе (листах). 

По 23-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести сборочный чертеж «модуля усилителя», распеча-

танный на отдельном листе (листах). 

Схема складывания листа формата A3 при расположении основной 

надписи вдоль длинной стороны листа для непосредственного брошюрова-

ния показана на рис. 8.71. 
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24. 3D-МОДЕЛИ В PDF 

24.1. Общие сведения 

Все КД из прошлых разделов были сохранены как в основном формате 

для того программного продукта, в котором они создавались (например, чер-

тежи КОМПАС-3D в формате CDW), так и в формате PDF. 

Представление КД в формате PDF имеет ряд достоинств: 

– один общий формат файлов для всех созданных КД, вне зависимости 

от программного продукта, в котором они были разработаны, что идеально 

подходит для демонстрации проделанной работы; 

– легкодоступные, малого размера, бесплатные и многочисленные вари-

анты программ, позволяющих прочитать формат PDF (Adobe Reader, Foxit 

PDF Reader и др.) с возможностью не только просматривать, но добавлять 

комментарии и пр.; 

– возможность открыть формат PDF на любом устройстве (компьютер, 

ноутбук, планшет, смартфон и др.); 

– обычно меньший размер файла в сравнении с исходными форматами. 

Кроме того, в формате PDF можно просматривать трехмерную инфор-

мацию, при этом остаются следующие возможности: 

– поворот и масштабирование 3D-модели; 

– скрытие или отображение отдельных частей 3D-модели; 

– нанесение размеров; 

– создание разрезов и др. 

Примерами программных продуктов, которые позволяют просматривать 

3D-модели с указанными возможностями, являются: 

– в Windows – Adobe Reader, Adobe Acrobat (3D и Pro) фирмы Adobe; 

– в Android и iOS – 3D PDF Reader фирмы Tech Soft 3D. 

В профессиональных САПР обычно есть встроенный конвертер 3D-pdf, 

однако в каждой из них он имеет свои особенности, например: 

– в КОМПАС-3D на выходе получается весьма посредственный резуль-

тат (плохое качество поверхностей, потеря цвета, отсутствие текстур); 

– в SolidWorks, в отличие от КОМПАС-3D, есть возможность работы с 

текстурами, но в 3D-pdf модели все же переносятся плохо; 

– в Altium Designer получается хороший результат (переносятся слои и 

металлизация каждой цепи как отдельные модели), но 3D-модели компонен-

тов не являются цельными телами. 
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24.2. Создание 3D-pdf 

Для получения коектного 3D-pdf с текстурами (или без них) необходимо 

выполнить следующие действия: 

1. В КОМПАС-3D подготовить 3D-модель «модуля усилителя» и со-

хранить ее в одном из промежуточных файлов: 

1.1. Открыть 3D-модель «модуля усилителя» (расположение указано в 

п. 3 из разд. 14). 

1.2. Для реалистичности включить отображение резьбы в 3D-моделях 

СВЧ-разъемов с помощью переменной: 

– нажать пиктограмму Переменные на ПИ Стандартная (или запустить 

команду Вид ⇒ Панели инструментов ⇒ Переменные); 

– в открывшемся окне Переменные в группе «модуля усилителя» рас-

крыть две группы для СВЧ-разъемов (SMA-KFD5A); 

– в столбце Выражение напротив переменных Thread поставить цифру 

1 и нажать клавишу Enter; 

– нажать клавишу F5 (или выполнить команду Вид ⇒ Перестроить). 

Результат в варианте «П1» на данном этапе показан на рис. 24.1. 

 

1.3. Запустить команду Файл ⇒ Сохранить как. 

В открывшемся окне выбрать тип промежуточного файла Parasolid Bi-

nary (*.x_b), задать имя и путь сохранения файла, после чего нажать кнопку 

Рис. 24.1 
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Сохранить. Имя файла в варианте «П1» – «УП1.00.01 - Модуль усилите-

ля», а путь сохранения – …\ИДРЭС-П1\_Модели. 

В появившемся окне Запись файла формата XT оставить настройки по 

умолчанию и нажать кнопку Начать запись. 

Примечание. Кроме выбранного типа файла 3D-модель также можно 

сохранить в промежуточном файле с расширением «.stl», «.stp», «.step», 

«.sat», «.igs», «.iges» или «.x_t». Однако лучший результат обычно обеспечи-

вает именно двоичный формат Parasolid («.x_b»). 

2. В полученном промежуточном файле с расширением «.x_b» добавить 

на поверхности ПП текстуры слоев, после чего сконвертировать его в файл с 

расширением «.u3d» (Universal 3D File): 

2.1. Если п. 30 из 16.1 не был выполнен или создается 3D-pdf без тек-

стур, то перейти к п. 3. 

2.2. Открыть программу Adobe Acrobat 3D Toolkit из комплекта Adobe 

Acrobat 3D, предназначенную для просмотра и конвертации файлов разнооб-

разных форматов – двухмерных, трехмерных, анимации, видео и аудио. 

Примечание. Заменой данной программы является Deep Exploration 

CAD Edition фирмы Right Hemisphere, которая обладает идентичным ин-

терфейсом и расширенными возможностями. 

2.3. В проводнике (Folders), находящемся слева от рабочего поля, вы-

брать папку, указанную в п. 1.3. 

2.4. На вкладке Local, находящейся под рабочим полем, выбрать файл с 

расширением «.x_b», щелкнув по нему ЛКМ. 

Примечание. При использовании Deep Exploration CAD Edition в появля-

ющемся при импорте окне для параметра Tessellation Level следует выбрать 

опцию High. При необходимости данное окно можно открыть командой 

ПКМ ⇒ Import Options, выполненной на файле модели. 

В результате в рабочем поле появится 3D-модель и 2 панели (рис. 24.2): 

– Information Bar с информацией об открытом файле; 

– Scene Components, содержащая пять панелей: Scene Tree, Materials, 

Parts, Animation и Layers. По умолчанию будет открыта панель Scene Tree с 

составными частями 3D-модели и материалами, использованными для их 

оформления. 

2.5. Убедиться в том, что в списке панелей (команда View ⇒ Controls 

and Toolbars) подключены следующие ПИ: 3D Editor, Navigation, UV Map-

ping, Surfaces.  
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Примечание. При использовании Deep Exploration CAD Edition понадо-

бятся только две ПИ – 3D Editor Toolbar, Navigation Toolbar. Они присут-

ствуют во всех наборах ПИ, но рекомендуется в меню Tab Options выбрать 

опцию Default и перейти на вкладку View (рис. 24.3). 

 Рис. 24.3 

ПИ Navigation 

Toolbar 

ПИ 3D Editor 

Toolbar 

Select 

Orbit 

Tab Options 

Рис. 24.2 

Show  

Textures 

Settings Map and 

Pack 

ПИ UV mapping 

ПИ Surfaces 

ПИ Navigation ПИ 3D Editor Select Rotate 
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2.6. Убедиться в том, что включены следующие опции (см. рис. 24.2): 

– на ПИ 3D Editor – Select (режим выбора объектов); 

– на ПИ Navigation – Rotate (режим поворота 3D-модели); 

– на ПИ Surfaces – Show Textures (отображение текстур); 

– в нижнем правом углу окна – драйвер DirectX любой версии. 

Примечание. В Deep Exploration CAD Edition на ПИ Navigation Toolbar 

соответствующая опция называется Orbit (см. рис. 24.3). На ПИ Surfaces 

Toolbar все опции по умолчанию будут соответствовать показанным на 

рис. 24.2 (при необходимости ПИ включаются из меню Window ⇒ Toolbars). 

2.7. Выполнить команду Tools ⇒ 3D Tools ⇒ Remove Duplicate Materi-

als для удаления повторяющихся материалов. 

Примечание. При использовании Deep Exploration CAD Edition запуск 

команды не требуется. Если она все же понадобится, то ее можно найти в 

меню Actions ⇒ 3D Actions. 

2.8. Создать новый материал c текстурой слоя Top Layer ПП:  

– в панели Scene Tree раскрыть группу Materials и на названии группы 

выполнить команду ПКМ ⇒ Create Material; 

– командой ПКМ ⇒ Material Properties (или двойным щелчком ЛКМ) 

открыть окно свойств созданного материала (последний в списке); 

– в открывшемся окне на вкладке Basic в поле Name записать имя мате-

риала – Top; 

– на вкладке Basic в поле Specular level задать низкий уровень зеркаль-

ности материала (например, 20); 

– на вкладке Maps для объекта Diffuse нажать кнопку Browse и выбрать 

файл с текстурой Top.png (рис. 24.4); 

– применить изменения и закрыть окно Material Properties. 

2.9. Создать новый материал c текстурой слоя Bottom Layer ПП: 

– в панели Scene Tree в группе Materials на материале Top выполнить 

команду ПКМ ⇒ Duplicate (дублировать материал); 

– зайти в окно свойств созданного материала и заменить его имя с Top 

Copy на Bottom; 

– на вкладке Maps выбрать файл с текстурой BottomMirror.png; 

– применить изменения и закрыть окно Material Properties. 

2.10. Создать материал для обозначения металлизированных отверстий: 

– в панели Scene Tree на названии группы Materials запустить команду 

ПКМ ⇒ Create Material; 
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– в окне свойств созданного материала задать имя Plated Hole; 

– на вкладке Basic для параметра Diffuse (рис. 24.5) задать дымчато-

белый цвет, для чего после открытия окна с выбором цвета нажать кнопку 

Определить цвет и записать его данные в формате RGB – (245, 245, 245); 

 Рис. 24.5 

Рис. 24.4 



 

 617 

– на вкладке Basic в поле Specular level задать 

низкий уровень зеркальности (например, 20); 

– применить изменения и закрыть окно Material 

Properties. 

Панель Scene Tree в варианте «П1» на данном 

этапе показана на рис. 24.6. 

2.11. В панели Scene Tree скрыть «модуль уси-

лителя», убрав галочку рядом с его названием. 

Примечание. В Deep Exploration CAD Edition 

русские буквы в названиях составных частей после 

импорта 3D-модели будут отображаться непра-

вильно, поэтому такие названия следует переимено-

вать (команда ПКМ ⇒ Rename или клавиша F2). 

2.12. В панели Scene Tree в списке составных частей «модуль усилите-

ля» найти ПП и выполнить следующее: 

– включить ее видимость, поставив галочку около названия; 

– на названии ПП выполнить команду ПКМ ⇒ Object Properties; 

– в появившемся окне Properties of Object 3D перейти на вкладку Mate-

rials, выбрать строку с материалом ПП и нажать на ссылку Material Proper-

ties (рис. 24.7); 

 

– в появившемся окне Material Properties на вкладке Basic записать имя 

материала PCB и в поле Specular level задать низкий уровень зеркальности 

(например, 20); 

– применить изменения и закрыть окно Material Properties; 

– закрыть окно Properties of Object 3D кнопкой OK; 

– на названии ПП выполнить команду ПКМ ⇒ Tools ⇒ Separate 

Meshes, в результате чего ПП будет представлена набором поверхностей. 

2.13. Применить материал Plated Hole ко всем металлизированным от-

верстиям ПП: 

Рис. 24.7 

Рис. 24.6 
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– в панели Scene Tree на группе с поверхностями ПП выполнить коман-

ду ПКМ ⇒ Select Sub-Objects, после чего щелкнуть ЛКМ с зажатой клави-

шей Ctrl по самой группе, исключив ее из выделения. В результате окажутся 

выделенными все поверхности ПП (рис. 24.8); 

 

– обратить внимание на то, что перемещение 3D-модели в рабочем поле 

осуществляется СКМ (или одновременно зажатыми ЛКМ и ПКМ), поворот – 

зажатой ЛКМ, изменение масштаба – колесиком мышки (или зажатой ПКМ); 

– в рабочем поле по отдельности с зажатой клавишей Ctrl щелкнуть 

ЛКМ по всем граням ПП и цилиндрическим поверхностям неметаллизиро-

ванных отверстий (если такие присутствуют на ПП), исключив тем самым их 

из выделенных объектов; 

– в рабочем поле выполнить команду ПКМ ⇒ Tools ⇒ Collapse Hierar-

chy, в результате чего все выделенные поверхности станут одним объектом; 

– на панели Scene Tree выбрать ЛКМ созданный объект, при этом в ра-

бочем поле подсветятся поверхности этого объекта (рис. 24.9); 

– перетащить ЛКМ материал Plated Hole из панели Scene Tree в любое 

место рабочего поля, в результате чего все отверстия в ПП поменяют цвет в 

соответствии с настройками материала; 

– снять выделение, щелкнув ЛКМ в любом месте рабочего поля за пре-

делами 3D-модели.  

2.14. Выполнить UV-преобразование для верхней поверхности ПП (при 

использовании Deep Exploration CAD Edition эту процедуру осуществлять не 

требуется): 

– в рабочем поле ЛКМ выбрать требуемую поверхность ПП; 

Рис. 24.8 
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– на ПИ UV Mapping нажать пиктограмму Settings (см. рис. 24.2) и в 

открывшемся окне UV Mapping Settings выбрать опции Cube и Rectangular, 

а также включить опции Fill space и Pack per material (рис. 24.10). Осталь-

ные настройки оставить по умолчанию и нажать OK; 

 

– на ПИ UV Mapping нажать пиктограмму Map and Pack (см. рис. 24.2). 

Примечание. UV-преобразование задает соответствие между коорди-

натами на поверхности 3D-объекта (X, Y, Z) и координатами в текстуре 

(U, V). Координаты U и V соответствуют координатам X и Y и названы 

так, чтобы исключить путаницу с осями X и Y в 3D-модели. 

Рис. 24.10 

Рис. 24.9 
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2.15. Выполнить UV-преобразование для нижней поверхности ПП (при 

использовании Deep Exploration CAD Edition эту процедуру осуществлять не 

требуется). 

2.16. Применить материал Top к верхней поверхности ПП: 

– в рабочем поле ЛКМ выбрать требуемую поверхность; 

– перетащить соответствующий материал из панели Scene Tree в любое 

место рабочего поля и снять выделение.  

Примечание. В варианте «П1» по расположению отверстий (рис. 24.11) 

видно, что текстура добавилась с небольшим увеличением масштаба. При 

использовании Deep Exploration CAD Edition текстура добавится без изме-

нения масштаба, и дальнейшая корректировка не потребуется.  

 

2.17. Если требуется скорректировать размеры текстуры, то выполнить 

следующие действия: 

– в левом верхнем углу рабочего поля на надписи User выполнить ко-

манду ПКМ ⇒ Top; 

– развернуть окно программы на полный экран; 

– максимально увеличить размер рабочего поля и увеличить масштаб 

3D-модели так, чтобы она полностью в него поместилась; 

– на панели Scene Tree зайти в свойства материала Top и перейти на 

вкладку Maps; 

– отключить опции U Tile и V Tile (бесконечное повторение текстуры по 

координатам U и V соответственно); 

– подобрать сдвиг (Offset) и масштаб (Scale) текстуры по горизонтали 

(координата U), нажимая кнопку Применить для отображения изменений; 

Рис. 24.11 
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– продублировать найденные выше значения сдвига и масштаба в соот-

ветствующие поля для координаты V (если текстура была изначально обре-

зана неаккуратно, то для данной координаты могут потребоваться корректи-

ровки введенных чисел); 

– включить опции U Tile и V Tile и закрыть окно свойств. 

Примечания: 

– корректировка в значениях будет осуществляться во втором и тре-

тьем знаках после запятой; 

– при уменьшении значений Offset U и Offset V текстура перемещается 

вправо и вверх соответственно; 

– при увеличении значений Scale U и Scale V текстура сжимается от-

носительно ее левого нижнего угла; 

– результат в варианте «П1» на данном этапе с отключенной видимо-

стью сетки (Display ⇒ Grid ⇒ No Grid) показан на рис. 24.12. 

 

2.18. Применить материал Bottom к нижней поверхности ПП в соответ-

ствии с п. 2.16, после чего в свойствах материала для координат U и V запи-

сать найденные в п. 2.17 значения сдвига и масштаба. 

Если текстура была изначально обрезана неаккуратно и (или) ее размеры 

не совпадают с текстурой Top, то могут потребоваться корректировки запи-

санных значений отдельно по каждой координате. 

Примечание. Результат в варианте «П1» на данном этапе показан на 

рис. 24.13. 

Рис. 24.12 
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2.19. В панели Scene Tree на заголовке группы ПП выполнить команду 

ПКМ ⇒ Tools ⇒ Collapse Hierarchy, в результате чего ПП снова станет од-

ним объектом. 

2.20. В левом верхнем углу рабочего поля на надписи выполнить коман-

ду ПКМ ⇒ Perspective (либо нажать клавишу P). 

2.21. В панели Scene Tree включить видимость всех составных частей 

«модуля усилителя». 

2.22. Визуально проконтролировать правильность отображения цветов 

составных частей «модуля усилителя» (например, при открытии 3D-модели 

некоторые цвета могут не загрузиться). 

Для исправления следует выполнить следующее: 

– создать новый материал; 

– составную часть представить в виде набора поверхностей; 

– необходимым поверхностям назначить созданный материал; 

– собрать поверхности в один объект. 

2.23. В панели Scene Tree проконтролировать правильность присвоения 

названий составных частей (например, они могут загрузиться неправильно 

или частично). 

Изменить названия можно командой ПКМ ⇒ Rename или клавишей F2. 

Примечание. В варианте «П1» в названия разработанных при проекти-

ровании составных частей были добавлены обозначения основных КД из 

табл. 2.1. Результат на данном этапе показан на рис. 24.14. 

Рис. 24.13 
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2.24. Запустить команду File ⇒ Save As и в открывшемся окне выпол-

нить следующее: 

– в поле Тип файла выбрать Universal 3D export (*.u3d); 

– нажать кнопку Settings и в появившемся окне на 

вкладке General отключить опцию JPEG (рис. 24.15) 

и применить изменения кнопкой OK (текстуры будут со-

хранены в 3D-модели без сжатия); 

– задать имя файла и путь сохранения по п. 1.3 и нажать Сохранить. 

Примечание. При использовании Deep Exploration CAD Edition для от-

ключения сжатия текстур при сохранении для параметра Texture compres-

sion type следует выбрать опцию PNG. 

2.25. Закрыть программу Adobe Acrobat 3D Toolkit (или Deep Explora-

tion CAD Edition при ее использовании). 

3. Создать 3D-pdf из промежуточного файла: 

3.1. Открыть программу Adobe Acrobat 3D и запустить команду File ⇒ 

Create PDF ⇒ From File (Файл ⇒ Создать ⇒ PDF из файла). 

В открывшемся окне Открыть в поле Тип файлов выбрать All Sup-

ported Formats (Все поддерживаемые форматы) и указать путь к сохра-

ненному файлу из п. 1.3 (3D-pdf будет без текстур) или из п. 2.24 (3D-pdf бу-

дет с текстурами). 

Примечания: 

Рис. 24.14 

Рис. 24.15 
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– Adobe Acrobat 3D поддерживает множество различных 3D-фор-

матов, поэтому в ней можно создать 3D-pdf как из файла с расширением 

«.x_b», так и с расширением «.u3d»; 

– в Adobe Acrobat Pro создать 3D-pdf можно только из файла с расши-

рением «.u3d», поэтому даже если текстуры не создавались, потребуется 

предварительно выполнить пп. 2.2–2.4, 2.24 и 2.25. 

– в последних версиях Adobe Acrobat Pro для включения возможности 

конвертирования файлов 3D-графики в PDF следует запустить программу 

«Выполнить» (Windows+R), в поле «Открыть» ввести regedit и нажать ОК. 

Затем по пути HKEY_LOCAL_MACHINE\SOFTWARE\(Wow6432Node)\Adobe\ 

Adobe Acrobat\DC создать раздел FeatureState, в который добавить ключ 

типа DWORD с названием Block3DConversion и нулевым значением. 

3.2. При использовании Adobe Acrobat 3D в открывшемся окне Acrobat 

3D Conversion установить следующие настройки: 

3.2.1. На вкладке General (рис. 24.16): 

 Рис. 24.16 
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– в поле Default Background Color (цвет фона) – белый; 

– в поле Default Lighting (параметры освещения) – CAD Optimized 

Lights; 

– в поле Default Rendering Style (параметры отображения модели) – Sol-

id Outline. В этом случае контуры всех составных частей 3D-модели будут 

обведены черными линиями; 

– включить опцию Add Default Views и выбрать создание всех видов; 

– включить опцию Open model tree by default (отображение Дерева 

модели при открытии 3D-pdf); 

– выбрать опцию Retrieve preview from default view (отображение ри-

сунка из вида, установленного по умолчанию, при открытии 3D-pdf). 

3.2.2. На вкладке Import: 

– при загрузке файла с расширением «.x_b» в поле 3D Format in PDF 

выбрать опцию PRC B-rep + Tessellation; 

– при загрузке файла с расширением «.u3d» отключить опцию Pass U3D 

file through unchanged. 

При использовании Adobe Acrobat Pro в открывшемся окне Вставить 

3D включить опцию Показать дополнительные параметры и на вкладке 

3D задать опции, аналогичные указанным в п. 3.2.1 (рис. 24.17). 

 

3.3. Применить изменения кнопкой OK. 

В появляющихся диалоговых окнах с уведомлениями (например, о за-

тратах времени на создание 3D-модели) нажать OK. 

Рис. 24.17 
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3.4. Сохранить файл в формате PDF и закрыть Adobe Acrobat 3D (или 

Adobe Acrobat Pro). 

Имя файла в варианте «П1» – «УП1.00.01 - Модуль усилителя - 3D», а 

путь сохранения – …\ИДРЭС-П1\_Модели (см. рис. 2.7). 

Примечания: 

– поменять вид по умолчанию, создать новые виды, изменить парамет-

ры отображения 3D-модели при открытии и прочие действия можно в 

Adobe Acrobat 3D пиктограммами на ПИ Advanced Editing, которая подклю-

чается командой View ⇒ Toolbars. В Adobe Acrobat Pro аналогичные воз-

можности доступны при включении на вкладке «Инструменты» в разделе 

«Создание и редактирование» режима Rich Media; 

– команда ПКМ ⇒ Edit in 3D Toolkit, выполненная в рабочем поле в Ado-

be Acrobat 3D, позволяет запустить Adobe Acrobat 3D Toolkit и отредакти-

ровать 3D-модель; 

– 3D-pdf также можно получить из Altium Designer командой File ⇒ 

Export ⇒ PDF3D. 

В этом случае составные части «модуля усилителя», которых не было 

в файле трассировки («экран», «основание», СВЧ-разъемы и крепеж), из 

КОМПАС-3D должны быть предварительно сохранены в промежуточный 

формат «.stp», «.step», «.x_t» или «.x_b». Желательно сохранять каждую со-

ставную часть или группы составных частей (например, крепеж) в отдель-

ные промежуточные файлы. Это можно делать прямо из сборки, выполняя 

в «Дереве модели» на ненужных в данный момент частях команду ПКМ ⇒ 

Исключить из расчета. В случае разработки 3D-моделей в SolidWorks сохра-

нение в промежуточные форматы не требуется, так как Altium Designer 

может открывать файлы с расширением «.sldprt». 

Загрузка 3D-моделей в проект выполняется в соответствии с п. 5 из 6.6 

и желательно на отдельный механический слой (или слои). В группе Generic 

3D Model окна 3D Body можно загрузить их в виде ссылок (опция File на 

рис. 6.45) с указанием директории или директорий с файлами. При таком 

способе их не нужно будет загружать заново после возможных корректи-

ровок. 

В окне PDF3D (рис. 24.18), появляющемся после запуска указанной выше 

команды, в группе Geometry задаются настройки, влияющие на передавае-

мую в 3D-pdf информацию: Core – диэлектрические слои, Solder – слои за-

щитной паяльной маски, Silk – слои шелкографии, Copper – слои с металли-
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зацией (опция Hide internal позволяет не передавать внутренние слои с ме-

таллизацией), Text – надписи, 3D Body – 3D-модели, Merge meshes – группи-

рование КП из состава каждого посадочного места в отдельные объекты. 

 

В группе PDF Settings задаются опции по настройке документа 3D-pdf: 

Auto activate – автоматическая активация 3D-режима просмотра без пред-

варительного щелчка ЛКМ, Toolbar и Navigation – автоматическое включе-

ние панели с командами и «Дерева модели» соответственно, View – исход-

ный вид 3D-модели (по умолчанию включена перспектива), Light – парамет-

ры освещения, Color – цвет фона. 

Внизу окна можно выбрать профиль с цветовыми настройками и 

настроить параметры листа. 

Нажатие кнопки Export запускает процесс конвертации. 

24.3. Возможности Adobe Reader по просмотру 3D-pdf 

Открыть созданный 3D-pdf в Adobe Reader и для активации 3D-режима 

щелкнуть ЛКМ в любом месте рабочего поля (при появлении предупрежде-

ния об отключенном 3D-содержимом выбрать опцию Доверять этому доку-

менту только сейчас и снова щелкнуть ЛКМ в рабочем поле). 

В режиме 3D-просмотра (рис. 24.19) слева от рабочего поля располага-

ется Дерево моделей со списком составных частей и видов 3D-модели (вид 

слева, вид справа и др.), а сверху – ПИ со следующими командами: 

Рис. 24.18 
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1. Первая многофункциональная кнопка: 

– Поворот, вращение, панорама, масштаб, обход, вылет, свойства 

камеры – режимы для просмотра модели. 

Примечание. Некоторые функции также можно использовать с помо-

щью клавиатуры и мышки: 

– поворот 3D-модели – зажатая ЛКМ; 

– перемещение 3D-модели – зажатые или ЛКМ и клавиша Ctrl, или ЛКМ 

и ПКМ, или ЛКМ и клавиша Alt; 

– масштаб 3D-модели – колесико мышки (или зажатые ЛКМ и клавиша 

Shift, или зажатая ПКМ); 

– Инструмент измерения 3D – запуск ПИ для нанесения размеров; 

– Добавить 3D-комментарий – добавление комментария на линии-вы-

носке; 

– Развернуть набор инструментов 3D – функции из текущего списка 

будут доступны из ПИ напрямую. 

2. Вид по умолчанию – возвращает отображение 3D-модели в вид, 

установленный по умолчанию. 

3. Виды – поле для выбора одного из основных (или созданных) видов. 

4. Переключить дерево моделей – отображение Дерева моделей. 

5. Воспроизвести анимацию – воспроизводит анимацию (при наличии). 

Рис. 24.19 
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6. Использовать ортогональную проекцию – переключение между ор-

тогональной и перспективной проекциями. 

7. Режим рендеринга модели – выбор способа отображения 3D-модели. 

8. Включить дополнительное освещение – выбор вида освещения. 

9. Фоновый цвет – выбор цвета заднего фона. 

10. Переключить перекрестный раздел – набор опций для создания 

разрезов плоскостью, положение которой можно задавать.  

Примечание. 3D-модели в 3D-pdf образованы поверхностями, поэтому 

по умолчанию при разрезе внутри они будут полыми. Для придания им твер-

дотельного вида в свойствах поперечного сечения следует включить опцию 

«Добавить крышки поперечного сечения». Опция «Показать прозрачные 

объекты» позволяет показать отсеченную часть прозрачной. 

Объект выбирается щелчком ЛКМ или в рабочем поле, или в Дереве 

моделей (установленная галочка напротив него означает, что он отображает-

ся). Выбранный объект окрашивается в рабочем поле в цвет, заданный в за-

головке Дерева моделей (например, на рис. 24.19 – красный). 

При первом щелчке ЛКМ в рабочем поле по объекту выделяется деталь, 

при втором щелчке ЛКМ по этому же объекту – сборка, в которую входит эта 

деталь; далее – сборка, в которую входит выделенная сборка, и т. д. Сброс 

выделения – щелчок ЛКМ по свободному пространству. 

Если по выделенному объекту в рабочем поле щелкнуть ПКМ, то откро-

ется меню с дополнительными командами. Например, в разделе Параметры 

частей есть следующие команды: 

– Показать все части – отображение всех частей модели; 

– По содержимому – автомасштаб модели по объектам, для которых в 

данный момент включена видимость. При этом точка привязки, за которую 

осуществляется вращение модели, сбрасывается в центр этих объектов; 

– Скрыть – выделенные элементы становятся невидимыми; 

– Изолировать – остаются только выделенные элементы; 

– Изолировать часть – остается только та сборочная единица, в состав 

которой входит выбранный объект; 

– Увеличить масштаб – автомасштаб на выделенном объекте, при этом 

точка привязки, за которую осуществляется вращение модели, сбрасывается 

в центр этого объекта; 

– Сделать прозрачным – выделенные элементы станут прозрачными; 

– Режим рендеринга части – выбор способа отображения части модели. 
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24.4. Результаты выполнения этапа проектирования 

В вариантах задания в Adobe Reader клавишей Prt Sc с последующей 

обрезкой лишней информации (или с помощью приложения Ножницы) сде-

лать два рисунка из 3D-pdf «модуля усилителя»: 

 Рис. 24.20 
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– со всеми составными частями; 

– без «экрана» и винтов, которыми он крепится (допускается изображе-

ние с прозрачным «экраном»). 

Результаты в варианте «П1» приведены на рис. 24.20. 

После получения 3D-pdf «модуля усилителя» удалить вспомогательную 

информацию: 

– из папки …\ИДРЭС-П1\_Модели – файлы «УП1.00.01 - Модуль уси-

лителя.x_b», «УП1.00.01 - Модуль усилителя.u3d», «Top.png», «Bot-

tom.png» и «BottomMirror.png» (промежуточные файлы с информацией о 

3D-модели и текстуры слоев); 

– из папки …\ИДРЭС-П1 – папку History с резервными копиями схем 

Э1 и Э3 «модуля усилителя», создаваемых при каждом их сохранении; 

– все backup-файлы из папки …\ИДРЭС-П1 и ее подпапок. 

24.5. Содержание отчета 

По 24-му основному этапу проектирования (см. рис. 2.5 и табл. 2.2) в от-

чете необходимо привести рисунки 3D-модели «модуля усилителя», полу-

ченные в режиме просмотра в Adobe Reader. 
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ПРИЛОЖЕНИЯ 

А. Опытный образец 

А.1. Внешний вид 

В данном подразделе приведены фотографии опытного образца «модуля 

усилителя» и его составных частей, изготовленных по КД для варианта «П1». 

Так как в результате проектирования ПП получилась с небольшими раз-

мерами, а для макетирования было заказано четыре штуки, то производитель 

изготовил их на одной общей заготовке. Для облегчения последующего отде-

ления ПП в такой заготовке делается один из двух вариантов обработки: 

– скрайбирование (см. Б.9); 

– фрезерование несквозных канавок с узкими перемычками и рядом от-

верстий с небольшим шагом (пример создания см. в Г.47). 

Внешний вид общей заготовки со вторым вариантом обработки показан 

на рис. А.1, где одна из ПП уже отделена (для сравнения см. рис. Г.179). 

 Рис. А.1 

Канавка Перемычка 

Перфорация 
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На рис. А.2, а показан вид на верхний слой ПП (слой Top Layer), а на 

рис. А.2, б – вид на нижний слой (слой Bottom Layer). Для сравнения: 

– файл трассировки в Altium Designer (см. рис. 12.140 и 12.141); 

– рисунки слоев с соответствующими цветовыми настройками, разме-

щенные на поверхностях 3D-модели ПП (см. рис. 24.12 и 24.13). 

 Рис. А.2 

а 

б 
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Фольгированный диэлектрик AD1000, на котором была изготовлена ПП 

в варианте «П1», для увеличения механической прочности армирован стек-

лотканью, волокна которой хорошо заметны на торце, показанном в масшта-

бе 60:1 на рис. А.3. 

 

На рис. А.4, а в масштабе 60:1 показано место соединения печатного 

проводника с волновым сопротивлением 50 Ом (ширина в варианте «П1» – 

0,5 мм) и 1-го резонатора ПФ, а на рис. А.4, б в том же масштабе – заземлен-

ный конец 2-го резонатора ПФ. Достаточно хорошо просматриваются шеро-

ховатость поверхности и скругления прямых углов в металлизации. 

 

На рис. А.5 в масштабе 90:1 показан участок ПП с границей нанесения 

защитной паяльной маски в области расположения печатных проводников, 

по которым проходят сигналы управления на микросхему аттенюатора. Ши-

рина их составляет 0,25 мм. 

На рис. А.6 в масштабе 25:1 показан участок ПП в области левой верх-

ней части посадочного места разъема для управления микросхемой аттенюа-

тора (разъем XP2 на рис. 12.140). Здесь видны следующие элементы: 

Рис. А.4 

а б 

Рис. А.3 

Стеклоткань 

Слой Bottom 

Layer 

Диэлектрическое 

основание 

Проводник  

на слое Top Layer 
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– два монтажных отверстия c180h120 (КП с отверстиями); 

– два переходных отверстия v120h60; 

– в правом верхнем углу – два печатных проводника, по которым прохо-

дят сигналы управления на микросхему аттенюатора; 

– в левом верхнем углу – часть печатного проводника, по которому по-

ступает питание на микросхему аттенюатора. 

 

 

Рис. А.5 

Рис. А.6 
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Хорошо различимы два дефекта: 

– ошибка в совмещении защитной паяльной маски с КП (см. Б.9). Как 

видно по рисунку, смещение почти равно значению параметра Solder Mask 

Expansion (0,05 мм) из правила SME (см. табл. Г.7) и для всех четырех ПП 

не превышает его, что соответствует указанию из 8-го пункта ТТ чертежа ПП 

(см. п. 25.3 из 17.2); 

– точечные участки с недотравливанием материала ПП, обнаруженные 

на одной из четырех ПП в ее левом нижнем углу под защитной паяльной 

маской. Наличие подобного дефекта в области ПФ могло бы повлиять на его 

АЧХ. В данном случае на работе устройства это не скажется. 

На рис. А.7 в масштабе 25:1 показан участок ПП с посадочным местом 

под микросхему аттенюатора. 

 

На рис. А.8, а показан внешний вид «экрана», а на рис. А.8, б – внешний 

вид «основания». Для сравнения см. рис. 16.6 и 16.11. 

Рис. А.7 



 

 637 

 

Как на «экране», так и на «основании» хорошо заметны следы фрезер-

ных работ, однако поверхности удовлетворяют требованиям, заданным в 

чертежах (см. рис. 20.37 и 21.20), – они плоские и гладкие. Притупленные 

кромки соответствуют п. 5 из Д.2. 

Что касается дефектов, то здесь он только один и носит косметический 

характер: на «экране» надпись «ВЫХОД» расположена с краю без указанно-

го в чертеже зазора. 

На рис. А.9 показан внешний вид «модуля усилителя». Для сравнения 

см. рис. 16.26 и 24.20. 

Рис. А.8 

а 

б 
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 Рис. А.9 
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На рис. А.10 показан «модуль усилителя» снизу, при этом через прорези 

в «основании» виден проводящий рисунок ПП на нижнем ее слое и штыре-

вые выводы компонентов. Для сравнения см. рис. 16.25. 

А.2. Обмер изделий 

Обмер изделий производился с использованием двух измерительных ин-

струментов: 

– микрометр гладкий МК25 для измерения наружных размеров от 0 до 

25 мм с точностью ±0,005 мм (рис. А.11, а); 

– цифровой штангенциркуль для измерения наружных и внутренних раз-

меров от 0 до 200 мм с точностью ±0,03 мм (рис. А.11, б). 

 

Необходимо отметить следующее: 

– часть указанных далее размеров получена не только напрямую по по-

казаниям инструментов, но и с помощью арифметических вычислений; 

Рис. А.11 

а б 

Рис. А.10 
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– использование штангенциркуля вместо микрометра для измерения не-

которых наружных размеров величиной менее 25 мм обусловлено особенно-

стями конструкции последнего. 

Результаты обмера «экрана» показаны на рис. А.12. 

 

Здесь и далее приняты следующие обозначения: 

– в скобках указаны размеры и допуски, заданные на чертежах; 

– измеренное значение указано перед размером в скобках; 

– подчеркнутые значения получены путем измерения микрометром, а 

остальные – штангенциркулем. 

На рис. А.12 предельные отклонения размеров расположения осей от-

верстий получены в результате пересчета по (Д.4) из указанного на чертеже 

позиционного допуска (0,3 мм), увеличенного на 0,18 мм за счет измеренных 

диаметров отверстий. Данное действие справедливо, так как позиционный 

допуск был указан как зависимый (см. рис. 20.37). 

В целом все измеренные значения попадают в указанные для них поля 

допусков, за исключением толщины «экрана» и глубины его внутренней по-

лости (отклонение составляет 0,01 мм). Эти различия можно отнести к по-

грешностям измерений. 

Рис. А.12 
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Результаты обмера «основания» показаны на рис. А.13. 

Единственным ошибочным размером является длина первого уровня 

«основания» (49,7 мм) со стороны расположения прорезей под штыревые вы-

воды компонентов. 

 Рис. А.13 Начало (окончание см. на с. 642) 
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Предельные отклонения расположения осей резьбовых отверстий М2,5 и 

М2 получены в результате пересчета по (Д.4) из указанных на чертеже пози-

ционных допусков (0,25 мм и 0,3 мм соответственно). 

Несмотря на то что размер 36,9 мм для двух резьбовых отверстий М2,5 

выходит за получившееся предельные отклонения, он все же попадает в поле 

позиционного допуска: центр каждого отверстия находится в нижней части 

между квадратным и круглым полями, показанными на рис. Д.32. 

Расположение осей резьбовых отверстий М2 указано на боковых высту-

пах с учетом реальных расположений и диаметров базовых отверстий. 

Результаты обмера ПП показаны на рис. А.14, а и б. 

 

Приведенные на рис. А.14, б значения рассчитаны на основе измерений 

в следующих местах: 

– на краю заготовки (см. рис. А.1), где присутствуют диэлектрик и слой 

защитной паяльной маски; 

– в области ПФ, где находятся диэлектрик и два слоя металлизации; 

Рис. А.14 

б а 

Рис. А.13 Окончание (начало см. на с. 641) 
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– между выводами защитного диода, где расположены диэлектрик, два 

слоя металлизации и слой защитной паяльной маски. 

Допуски расположения осей отверстий на ПП находятся в рамках пози-

ционного допуска для 4-го класса точности (табл. Б.1). 

При обмере проводящего рисунка ПП установлено, что размеры про-

водников, полигонов и КП увеличены с каждой стороны на 0,015 мм. В соот-

ветствии с этим все зазоры оказались уменьшены на 0,03 мм. Таким образом 

производитель пытался скомпенсировать боковой подтрав (рис. Б.24). 

Особенно хорошо данный факт заметен на рис. А.7: размеры КП в поса-

дочном месте микросхемы аттенюатора составляют 0,28 × 0,83 мм вместо 

0,25 × 0,8 мм, заложенных в файле трассировки; а зазоры между указанными 

КП – 0,22 мм вместо 0,25 мм. 

Тем не менее получившиеся предельные отклонения размеров проводя-

щего рисунка составляют ±0,03 мм, что соответствует 5-му классу точности 

по ГОСТ Р 53429–2009 (табл. Б.6). 

Результаты обмера «модуля усилителя» показаны на рис. А.15. 

 

Толщина устройства в области СВЧ-тракта была измерена в трех местах: 

на боковых выступах «основания» и в месте расположения «экрана». Видно, 

что требование общего задания на проектирование выполняется. 

А.3. Результаты измерения АЧХ ПФ 

Измерение АЧХ ПФ производилось на отдельной ПП с помощью век-

торного анализатора цепей 8720B фирмы Hewlett Packard с диапазоном ча-

стот от 130 МГц до 20 ГГц, внешний вид которого показан на рис. А.16. 

Ко входу и выходу ПФ для подключения к прибору были подпаяны от-

резки полужестких коаксиальных кабелей RG-405 с волновым сопротивлени-

ем 50 Ом и установленными SMA-разъемами (рис. А.17). 

На рис. А.18 показано сравнение результатов эксперимента (HP_554) и 

электромагнитного моделирования в EMSight-симуляторе (BPFem) из разд. 4. 

Рис. А.15 
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 Рис. А.18 

Рис. А.17 

Рис. А.16 
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Примечание. Данные с анализатора получены в формате CSV. Для кор-

ректного отображения на графике в Microwave Office в первой строке был 

записан заголовок с указанием размерности данных в соответствующих 

столбцах (рис. А.19, а). В заголовке перед запятой в скобках может быть 

указан тип переменной (RE, IM и др.) Разделителем между данными в каж-

дой строке может быть запятая. Пробелы могут отсутствовать. 

 

Загрузка данных в Microwave Office производится командой ПКМ ⇒ Im-

port Data File, выполненной на элементе Data Files из вкладки Project. Уча-

сток вкладки с загруженными данными показан на рис. А.19, б. 

График с рис. А.18 был получен копированием уже существующего (ко-

манда ПКМ ⇒ Duplicate Graph) и заменой кривой, полученной для линейного 

моделирования (рис. А.19, в), загруженными данными со следующими 

настройками окна Modify Measurement (команда ПКМ ⇒ Properties): 

– в списке Measurement Type выбрана опция Data; 

– в списке Measurement выбрана опция PlotCol (график по столбцам); 

– в списке Data File Name выбрано название загруженного файла; 

– в поле Column for X Axis выбрано 1 (частоты); 

– в поле Column for Y Axis выбрано 2 (коэффициенты передачи); 

– в группе Complex Modifier включена опция dB (децибелы). 

Границы оптимизации добавлены заново путем копирования (команда 

ПКМ ⇒ Duplicate) с указанием одной из измеряемых на графике величин, по-

сле чего отключены командой ПКМ ⇒ Toggle Enable. 

Переименование графика выполнено командой ПКМ ⇒ Rename Graph. 

Рис. А.19 

б а 

в 
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Из рис. А.18 видно, что полоса пропускания оказалась шире на 100 МГц. 

Это в основном обусловлено двумя причинами: 

– при моделировании в EMSight не учитывалась толщина проводников; 

– в опытном образце геометрические параметры фольгированного ди-

электрика отличаются от заданных при моделировании (см. А.2). 

Для демонстрации влияния указанных параметров проведено моделиро-

вание в AXIEM-симуляторе. 

Примечание. Соответствующая модель получена следующим путем: 

– сделана копия уже существующей электромаг-

нитной модели (команда ПКМ ⇒ Duplicate EM Structure) 

и изменено ее имя (рис. А.20, а); 

– у созданной копии командой ПКМ ⇒ Set Simulator 

изменен тип симулятора на AWR AXIEM - Async; 

– в рабочем поле в свойствах каждого порта в 

группе Explicit Ground Reference выбрана опция Connect 

to lower (установка явной ссылки на землю, которой яв-

ляется нижняя поверхность ПП). В результате у пор-

тов появляются соответствующие значки (рис. А.20, б). 

На рис. А.21 показано сравнение результатов моде-

лирования в симуляторах AXIEM со стандартными настройками и EMSight. 

 Рис. А.21 

Рис. А.20 

а 

б 
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Расхождение на рисунке связано с отсутствием в AXIEM-симуляторе 

боковых стенок из идеального проводника (верхняя и нижняя стенки присут-

ствуют). Однако в реальном устройстве в непосредственной близости от то-

пологии ПФ над поверхностью ПП боковых металлизированных стенок нет. 

Есть металлизация на поверхности ПП и внутри материала основания в виде 

переходных отверстий, но из-за выбранных достаточно больших расстояний 

до нее создание каких-либо металлизированных стенок и земляных полиго-

нов в AXIEM-симуляторе не требуется (ока-

зываемое влияние пренебрежимо мало). 

Примечания: 

– боковые стенки можно промоделиро-

вать, нарисовав окружающие топологию 

ПФ полигоны (рис. А.22) и выбрав в их свой-

ствах опцию Via через все слои (по аналогии 

с металлизированными отверстиями в вари-

антах задания с ШТ). В этом случае резуль-

таты двух симуляторов на рис. А.21 будут 

практически идентичными; 

– для корректной работы AXIEM-симу-

лятора может потребоваться исключение русских букв из названий файла и 

папок. В этом случае достаточно сохранить этот же файл с новым именем 

в подходящую папку и заново запустить процесс моделирования. 

На рис. А.23 пунктирными кривыми показаны результаты моделирова-

ния в AXIEM-симуляторе при отдельном изменении толщины основания ПП, 

толщины проводников и габаритных размеров проводящего рисунка ПП на 

полученные при обмере данные (см. А.2). Сплошной кривой показан исход-

ный результат моделирования в AXIEM-симуляторе с рис. А.21. Шаг сетки 

по оси X при этом составляет 0,05 ГГц, а по оси Y – 1 дБ. 

Примечание. Значение толщин основания ПП и проводников задавалось 

в соответствии с пп. 2.2, 2.7 и 2.8 из 4.4. 

Для включения учета толщины проводников при моделировании на 

названии соответствующей электромагнитной модели в группе EM Struc-

tures из вкладки Project была выполнена команда ПКМ ⇒ Options и в от-

крывшемся окне на вкладке Mesh (сетка) снята галочка с опции Model as Ze-

ro Thickness. Стоит отметить, что на вкладках Mesh и AXIEM этого окна 

задаются основные настройки, влияющие на точность моделирования. 

Рис. А.22 
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Изменение габаритных размеров 

проводящего рисунка ПП (по осям X и 

Y) производилось без изменения шага 

сетки. Для этого сначала осуществ-

лялся двойной щелчок ЛКМ по требу-

емому полигону для появления харак-

терных точек, затем на необходимой 

точке зажималась ЛКМ, после чего 

нажималась клавиша Tab и в появив-

шемся окне вводилось значение сдвига 

(на рис. А.24 показана запись сдвига на 0,015 мм по оси X). 

На рис. А.25, а показано сравнение результатов эксперимента и элек-

тромагнитного моделирования в AXIEM-симуляторе со скорректированными 

в соответствии с рис. А.23 значениями толщины основания ПП, толщины 

проводников и габаритных размеров проводящего рисунка ПП при уменьше-

нии шага сетки с 0,1 мм на 0,01 мм, а на рис. А.25, б – увеличенный участок 

графика в области полосы пропускания. 

Рис. А.23 

h = 0,508 мм 

h = 0,535 мм 

t = 0 мкм 

t = 30 мкм 

Δw = 0 мкм 

Δw = 15 мкм 

Рис. А.24 
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Примечание. При изменении шага сетки с 0,1 на 0,01 мм время модели-

рования увеличилось с 1,3 до 17,5 мин при расчете в 12 частотных точках из 

201 (шаг по частоте задан 0,01 ГГц). Связано это с тем, что в AXIEM-симу-

ляторе моделирование по умолчанию производилось в режиме AFS (Advanced 

Frequency Sweep), при котором вычисления осуществляются совместно с 

операцией интерполяции. Данный режим можно включить и отключить в 

обоих симуляторах в окне Options для каждой электромагнитной модели. 

Оставшиеся различия на рис. А.25 связаны со следующими причинами: 

– погрешности обмера ПП; 

– погрешности измерений (потери в местах перехода от печатных про-

водников к центральным жилам кабелей и в разъемных соединениях, по-

грешность векторного анализатора цепей); 

б 

Рис. А.25 

а 
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– неизвестные истинные значения потерь и относительной диэлектриче-

ской проницаемости материала основания ПП и его анизотропия [97]; 

– неточности моделирования (размер сетки, настройки и др.). 

А.4. Результаты работы «токового зеркала» 

Результаты измерения сопротивлений, напряжений и токов на выводах 

компонентов из «токового зеркала» показаны на рис. А.26 (в скобках приве-

дены значения, полученные при расчете в п. 7 из 8.3). 

Измерение сопротивлений рези-

сторов производилось SMD-тестером 

MS8910 фирмы Mastech, выполненным 

в виде пинцета (рис. А.27, а), перед 

установкой их на ПП. Отклонение зна-

чений от номинальных составляет не 

более 2 % при допустимых 5 %. 

Измерение уровней напряжений 

осуществлялось цифровым мультимет-

ром MAS830L той же фирмы 

(рис. А.27, б) после сборки «модуля 

усилителя» и подаче внешнего напря-

жения питания. 

 

Из рис. А.26 видно, что ток КпI  получился на 13 % меньше расчетного, 

что связано с использованием в вычислениях приближенной формулы (8.1), а 

также с отличием параметров реальной транзисторной сборки от номиналь-

а 

Рис. А.27 

б 

Рис. А.26 
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ных из документации. В работе микросхемы усилителя это приведет к сни-

жению коэффициента усиления. Например, для GALI-3+ в соответствии с 

рис. А.28 на частоте 2,45 ГГц уменьшение составит примерно 0,15 дБ. 

 

Результат моделирования «токового зеркала» в Microwave Office пока-

зан на рис. А.29. 

 Рис. А.29 
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Примечание. Исходными данными на рис. А.29 являются сопротивления 

резисторов и напряжения, сформированные источниками V1 и V2. 

Значения токов и напряжений отображаются после запуска команды 

ПКМ ⇒ Add Annotation на названии схемы во вкладке Project и выбора сле-

дующих параметров в группе Measurement: 

– DCIA с маской DC_V* (отображение токов на всех источниках 

напряжения); 

– DCIA с маской RES* (отображение токов на всех резисторах); 

– DCVA_N (отображение напряжений на всех узлах). 

Транзисторная сборка представлена файлом SPICE-модели в формате 

PRM, который был загружен следующим образом: 

– во вкладке Project на группе Circuit Schematics запущена команда 

ПКМ ⇒ Import Netlist и указано расположение файла SPICE-модели; 

– в появившемся окне выбрана опция PSpice Netlist Files (*.cir) и нажата 

кнопка OK; 

– на вкладке Elements из группы Subcircuits выбран загруженный компо-

нент и размещен в рабочем поле. 

После добавления на поле схемы транзистор-

ная сборка отображается прямоугольником с че-

тырьмя выводами (рис. А.30). 

Для создания УГО, показанного на рис. А.29, 

было выполнено следующее: 

– создана новая схема с названием Double PNP, 

в которую добавлены два УГО p-n-p-транзисторов; 

– после ориентации их нужным образом и со-

здания необходимых соединений запущена подпрограмма AWR Symbol Gener-

ator Wizard из группы Wizards во вкладке Project; 

– в открывшемся окне выбрана схема с двумя p-n-p-транзисторами со 

стилем Picture и отсутствием границ (опция None в поле Border). После чего 

нажата кнопка OK; 

– запущена команда Project ⇒ Circuit Symbols ⇒ Edit Symbol; 

– в появившемся окне Project symbols выбрано созданное изображение и 

нажата кнопка Edit; 

– в открывшемся окне с названием УГО в рабочем поле с помощью ко-

манды Draw ⇒ Add Node добавлены четыре вывода, после чего отредакти-

ровано УГО (добавлены и скорректированы требуемые линии и дуги); 

Рис. А.30 
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– окно с УГО закрыто с сохранением изменений; 

– запущена команда Project ⇒ Circuit Symbols ⇒ Export Symbols и произ-

ведено создание новой библиотеки УГО с расширением «.syf»; 

– в окне Symbol List выбрано созданное УГО и нажата кнопка Export; 

– в рабочем поле в окне с «токовым зеркалом» на транзисторной сборке 

выполнена команда ПКМ ⇒ Properties и в появившемся окне на вкладке Sym-

bol в группе Project выбрано созданное УГО. 

По результатам выполнения 3-го дополнительного этапа проектирова-

ния в варианте «П1» для получения 35Кп =I  мА сопротивление резистора на 

эмиттере правого транзистора транзисторной сборки необходимо было бы 

уменьшить с 27 Ом до 22,1 Ом. 

А.5. Потребление «модуля усилителя» и результаты работы 

микросхемы стабилизатора напряжения 

В варианте «П1» микросхема стабилизатора MIC5209-5.0YS была заме-

нена на аналог MC33275ST-5.0T3G фирмы ON Semiconductor. 

Указанная микросхема по сравнению с MIC5209-5.0YS не содержит в 

своем составе ЗП, рассчитана на меньший выходной ток (300 мА против 

500 мА) и обладает большим током потерь (порядка 1 мА против 0,4 мА). Но 

так как в «модуле усилителя» есть собственная ЗП, ток потребления состав-

ляет менее 50 мА и на него не накладывается ограничений, то указанные не-

достатки несущественны. 

Данный аналог стоит почти в два раза дешевле, чем MIC5209-5.0YS, вы-

полнен в таком же корпусе и с таким же назначением выводов. Кроме этого, 

он обладает меньшим значением DOU  (рис. А.31 против рис. 8.50). 

 Рис. А.31 
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Для подачи внешнего питания 

использовался лабораторный источ-

ник питания постоянного тока GPS-

3030DD фирмы GW Instek с защитой 

от перегрузки. Потребление «модуля 

усилителя» при напряжении 6 В со-

ставило 36 мА (рис. А.32). 

Отличие от расчетного значения, 

определенного в п. 8.13 из 8.3, связа-

но с меньшим током потребления 

«токовым зеркалом» (см. А.4) и 

большим током потерь в установлен-

ном аналоге микросхемы стабилиза-

тора. Ток потребления микросхемы 

аттенюатора составляет порядка 1 мА. 

На рис. А.33, а приведены ре-

зультаты работы микросхемы стаби-

лизатора без нагрузки (только с уста-

новленными компонентами из узла вторичного питания) и с нагрузкой (со 

всеми установленными компонентами), а на рис. А.33, б – аналогичные зави-

симости из документации на микросхему MC33275ST-3.3T3G. 

 

Выходное напряжение микросхемы MC33275ST-5.0T3G в рабочем ре-

жиме, т. е. при выполнении условия (8.6), составляет 5,01 В и находится 

а 

Рис. А.33 

б 

Рис. А.32 
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внутри указанного в документации диапазона (от 4,9 до 5,1 В). Значение 

DOU  при токе нагрузки 35 мА получилось примерно 50 мВ, что соответству-

ет зависимости, приведенной на рис. А.31. 

А.6. Результаты работы СВЧ-тракта 

Исследование работы СВЧ-тракта осуществлялось с помощью двух циф-

ровых анализаторов спектра: 

– GSP-7830 (рис. А.34, а) фирмы GW Instek с диапазоном частот от 

9 кГц до 3 ГГц, чувствительностью минус 110 дБм, погрешностью измерения 

амплитуды ±1,5 дБ и опциональным трекинг-генератором с диапазоном вы-

ходных уровней от минус 50 до 0 дБм; 

– N9020A (рис. А.34, б) фирмы Keysight Technologies Inc. (ex Agilent 

Technologies) c диапазоном частот от 10 Гц до 26,5 ГГц, чувствительностью 

минус 154 дБм и погрешностью измерения амплитуды ±0,3 дБ. 

 Рис. А.34 

а 

б 
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Измерения производились в три этапа: 

1. В соответствии со схемой соединений, показанной на рис. А.35, а, по-

лучена АЧХ трекинг-генератора из состава анализатора спектра GSP-7830 в 

диапазоне частот от 1,8 до 3 ГГц при заданном в варианте индивидуального 

задания на проектирование уровне минус 10 дБм. 

 

Внешний вид кабеля CBL-0.5M-SMNM+ (вилки типов SMA и N, длина 

0,5 м, волновое сопротивление 50 Ом, диапазон частот от 0 до 18 ГГц, вно-

симые потери в диапазоне частот до 3 ГГц – 0,4 дБ) показан на рис. А.35, б, а 

внешний вид коаксиального перехода SMA-KK1 (розетки типа SMA, волно-

вое сопротивление 50 Ом, диапазон частот от 0 до 18 ГГц) – на рис. А.35, в. 

2. Вместо коаксиального перехода подключен «модуль усилителя» и по-

лучены его АЧХ для четырех уровней ослабления, создаваемых комбинацией 

напряжений на управляющих выводах микросхемы аттенюатора. 

Сигналы управления и напряжение питания подавались по соответству-

ющим кабелям от двух источников питания GPS-3030DD. 

Рис. А.35 

а 

б в 

Тип N Тип SMA 
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Внешний вид «модуля усилителя» со снятым «экраном» и осуществлен-

ными подключениями показан на рис. А.36. 

 

3. Полученные АЧХ «модуля усилителя» скорректированы с учетом не-

равномерности АЧХ трекинг-генератора. 

Результаты показаны на рис. А.37. 

 Рис. А.37 

Рис. А.36 
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Сравнение уровней сигнала на центральной частоте 2,45 ГГц по резуль-

татам измерений с рис. А.37 и расчета с рис. 3.33 приведено в табл. А.1. 

Таблица А.1 

Уровни сигнала на выходе «модуля усилителя» на частоте 2,45 ГГц 

Уровень управляющего напряжения, В Уровень сигнала, дБм 

V1 (вывод № 8) V2 (вывод № 5) Измерение Расчет 

+5 +5 +6,00 +5,24 

+5 0 +3,95 +3,24 

0 +5 +1,80 +1,24 

0 0 –0,25 –0,76 

Различия связаны в первую очередь с тем, что коэффициент усиления 

микросхемы «усилителя» в расчетах должен быть больше на 0,35 дБ по двум 

причинам: 

– режим работы микросхемы в варианте «П1» выбран для температуры 

+85 °C (см. пп. 9.7 и 9.9 из 3.3); 

– расчет номиналов резисторов в «токовом зеркале» производился по 

приближенной формуле (см. А.4). 

Также из табл. А.1 следует, что уровни ослабления установленной мик-

росхемы аттенюатора относительно ее опорных вносимых потерь составляют 

2,05, 4,2 и 6,25 дБ вместо использованных при расчетах 2, 4 и 6 дБ. Получен-

ные значения соответствуют приведенным на рис. 3.30. 

Оставшиеся различия порядка 0,5 дБ между измеренными и расчетными 

значениями связаны со следующими причинами: 

– погрешности измерений; 

– потери в использованном материале ПП и в разделительных конденса-

торах, которые в опытном образце для его удешевления были выбраны из се-

рии GRM фирмы Murata; 

– различия в коэффициенте передачи ПФ (см. А.3); 

– неизвестные истинные значения коэффициента усиления микросхемы 

усилителя и опорных вносимых потерь микросхемы аттенюатора. 
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Б. Общие сведения о ПП 

Б.1. Термины и определения 

Термины и определения понятий в области ПП устанавливает ГОСТ Р 

53386–2009. 

К основным понятиям можно отнести следующие: 

– печатная плата (ПП, printed board, printed circuit board, PCB) – изде-

лие, состоящее из одного или двух проводящих рисунков, расположенных на 

поверхности основания, или из системы проводящих рисунков, расположен-

ных в объеме и на поверхности основания, соединенных между собой в соот-

ветствии с электрической схемой печатного узла, предназначенное для элек-

трического соединения и механического крепления устанавливаемых на нем 

изделий электронной техники, квантовой электроники и электротехнических 

изделий; 

– основание ПП (substrate) – элемент конструкции ПП, на поверхности 

или на поверхности и в объеме которого расположен проводящий рисунок 

или система проводящих рисунков ПП; 

– рисунок ПП (pattern) – конфигурация, образованная проводниковым и 

(или) диэлектрическим материалом на ПП; 

– проводящий рисунок ПП (conductive pattern) – рисунок ПП, образо-

ванный проводниковым материалом на основании или в объеме. Проводя-

щий рисунок состоит из печатных проводников, КП, экранов, металлизиро-

ванных отверстий, теплоотводящих и других печатных компонентов; 

– непроводящий рисунок ПП (non-conductive pattern) – рисунок ПП, об-

разованный диэлектрическим материалом основания ПП. 

К часто встречающимся понятиям из области элементов конструкции 

ПП можно отнести следующие: 

– печатный проводник (conductor) – одна полоска в проводящем рисун-

ке ПП; 

– ширина печатного проводника ПП (conductor width) – поперечный 

размер печатного проводника ПП; 

– толщина печатного проводника ПП (conductor thickness) – высота 

печатного проводника в поперечном сечении; 

– расстояние между печатными проводниками ПП (conductor 

spacing) – ширина участка непроводящего рисунка ПП между краями сосед-

них печатных проводников одного проводящего слоя ПП; 
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– проводящий слой ПП (conductor layer) – проводящий рисунок ПП, 

расположенный в одной плоскости; 

– внутренний слой ПП (inner layer) – проводящий рисунок ПП, распо-

ложенный внутри МПП; 

– внешний слой ПП (exteriority connection) – проводящий рисунок ПП, 

расположенный на наружной стороне ПП; 

– расстояние между проводящими слоями ПП (layer-to-layer spacing) – 

толщина диэлектрического материала между соседними проводящими слоя-

ми ПП; 

– сторона монтажа ПП (component side) – сторона ПП, предназначен-

ная для установки на ней изделий (монтаж бывает одно- и двусторонним); 

– металлизированное отверстие ПП (plated hole) – отверстие в ПП с 

проводниковым материалом на его стенке; 

– неметаллизированное отверстие ПП (non-plated through hole) – от-

верстие в ПП без проводникового материала на его стенке; 

– монтажное отверстие ПП (component hole) – отверстие, предназна-

ченное для электрического подсоединения к проводящему рисунку ПП вы-

водов изделий; 

– переходное отверстие ПП (crossing hole) – металлизированное отвер-

стие ПП, предназначенное для электрического соединения проводящих ри-

сунков ПП, находящихся на разных проводящих слоях ПП (часто встречается 

как via); 

– крепежное отверстие ПП (mounting hole) – неметаллизированное от-

верстие ПП, предназначенное для механического крепления ПП к базовой 

несущей конструкции или для механического крепления изделий на ПП; 

– КП ПП (land) – часть проводящего рисунка ПП, используемая для 

электрического подсоединения устанавливаемых изделий (часто встречается 

как pad); 

– гарантийный поясок КП ПП (guarantee bell) – минимально допусти-

мая ширина КП ПП вокруг отверстия ПП (часто встречается как annular ring). 

Б.2. Типы конструкции ПП 

В зависимости от жесткости материала, использованного для основания, 

ПП делятся на три группы: 

– жесткая ПП (rigid printed board) – ПП, выполненная на жестком ос-

новании; 
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– гибкая ПП (flexible printed board) – ПП, выполненная на гибком осно-

вании; 

– гибко-жесткая ПП (flex-rigid printed board) – ПП, выполненная на 

гибком и жестком основаниях, объединенных проводящим рисунком ПП. 

В соответствии РД 50–708–91 [98] по конструктивному исполнению ПП 

разделяют на следующие типы: 

1. Односторонняя печатная плата (ОПП, single-sided printed board) – 

ПП, на одной стороне основания которой выполнен проводящий рисунок. 

 

ОПП (рис. Б.1) характеризуется: 

– возможностью обеспечения повышенных требований к точности вы-

полнения проводящего рисунка; 

– отсутствием металлизированных отверстий; 

– возможностью установки изделий электронной техники на поверх-

ность ПП в основном со стороны, противоположной стороне расположения 

печатных проводников, без дополнительного изоляционного покрытия; 

– самой низкой стоимостью. 

2. Двусторонняя печатная плата (ДПП, double-sided printed board) – 

ПП, на обеих сторонах основания которой выполнены проводящие рисунки. 

ДПП делятся на две группы: 

2.1. ДПП без металлизации монтажных и переходных отверстий (рис. 

Б.2, а), которые характеризуются: 

– возможностью обеспечения высоких требований к точности выполне-

ния проводящего рисунка; 

– возможностью использования объемных металлических элементов 

конструкции (штырей, отрезков проволоки и т. д.) для соединения элементов 

проводящего рисунка, расположенных на противоположных сторонах ПП; 

– низкой стоимостью. 

Рис. Б.1 

Печатный 

проводник 

Основание 

ПП 

Неметаллизированное  

отверстие 

КП ПП 
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2.2. ДПП с металлизированными монтажными и переходными отверсти-

ями (рис. Б.2, б), которые характеризуются: 

– высокими коммутационными возможностями; 

– повышенной прочностью сцепления выводов навесного элемента с 

проводящим рисунком ПП; 

– повышенной стоимостью по сравнению с ПП без гальванического со-

единения слоев. 

3. Многослойная печатная плата (МПП, multilayer printed board) – ПП, 

состоящая из чередующихся проводящих и непроводящих рисунков, соеди-

ненных в соответствии с электрической схемой печатного узла. 

 

МПП (рис. Б.3) характеризуются: 

– предпочтительным использованием двустороннего фольгированного 

диэлектрика для наружных и внутренних слоев; 

Рис. Б.2 

а б 

Металлизированное  
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– межслойными соединениями, осуществляемыми с помощью сквозных 

металлизированных отверстий (в особых случаях также используются пере-

ходные отверстия, соединяющие только внутренние слои); 

– обязательным наличием КП на любом проводящем слое, имеющем 

электрическое соединение с переходными отверстиями; 

– высокими коммутационными свойствами; 

– высокой помехозащищенностью электрических цепей; 

– низкой ремонтопригодностью; 

– относительно высокой стоимостью конструкции. 

МПП на гибко-жестком основании (рис. Б.4) характеризуется дополни-

тельно к описанным особенностям МПП возможностью перемещения одной 

жесткой части МПП относительно другой без нарушения электрических свя-

зей, что позволяет: 

– разместить ПП в корпусе изделия сложной формы; 

– упростить обслуживание при эксплуатации; 

– уменьшить количество соединительных разъемов или вовсе отказаться 

от них. 

 

4. Гибкий печатный кабель (ГПК, flexible printed wiring) – гибкая ПП, 

проводящий рисунок которой состоит из печатных проводников, предназна-

ченная для электрического соединения печатных узлов. 

ГПК (рис. Б.5) характеризуется: 

– высокой гибкостью; 

– малыми толщинами; 

– возможностью подключения к 

ПП без использования соединителей; 

– возможностью использования одно- и двусторонних тонких фольгиро-

ванных диэлектриков с металлизированными отверстиями и отверстиями без 

металлизации. 

Рис. Б.4 

Жесткая часть 

Гибкая часть 

Рис. Б.5 
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Б.3. Методы изготовления ПП 

По ОСТ4 ГО.010.011 при создании новых изделий радиоэлектронной 

аппаратуры рекомендуются следующие методы изготовления ПП: 

– комбинированный (позитивный и негативный) для ОПП и ДПП; 

– химический для ОПП; 

– металлизация сквозных отверстий для МПП. 

В технически и экономически обоснованных случаях допускается для 

изготовления МПП помимо метода металлизации сквозных отверстий при-

менение других конструктивно-технологических вариантов, например: по-

парного прессования, открытых КП, выступающих выводов, послойного 

наращивания [75], [99]–[102]. 

Сущность химического метода заключается в изготовлении ПП путем 

травления фольгированного диэлектрика без последующей металлизации. 

Сначала на поверхность медной фольги наносится стойкий к воздействию 

травильных растворов защитный слой с рисунком, повторяющим проводя-

щий рисунок ПП. Затем следует операция травления, в результате которой 

полностью удаляется медь в местах, не защищенных указанным слоем. 

Кроме химического метода существует электрохимический метод, в 

котором проводящий рисунок создается в результате электрохимического 

осаждения металла на поверхность нефольгированного диэлектрика. В этом 

случае наносимый на поверхность ПП защитный слой обладает рисунком, 

повторяющим непроводящий рисунок ПП. Метод предусматривает получе-

ние металлизированных отверстий одновременно с проводниками и КП. 

Сущность комбинированного метода заключается в травлении фольги-

рованного диэлектрика с металлизацией отверстий. Исходным материалом 

служит фольгированный с двух сторон диэлектрик, поэтому проводящий ри-

сунок получают вытравливанием меди, а металлизация отверстий осуществ-

ляется посредством химического меднения с последующим электрохимиче-

ским наращиванием слоя меди. В зависимости от метода защиты проводяще-

го рисунка при вытравливании меди комбинированный метод подразделяется 

на негативный и позитивный: 

– в комбинированном негативном методе сначала химическим мето-

дом получают проводящий рисунок ПП, затем ПП покрывают лаком и свер-

лят отверстия. После этого осуществляется осаждение меди для получения 

металлизированных отверстий, последующее удаление лака и проведение 

мероприятий по соединению проводников и металла в отверстиях. Метод 
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возник и использовался, когда в производстве отсутствовали сверлильные 

станки с программным управлением, и ПП сверлили вручную по проводяще-

му рисунку ПП (по КП); 

– в комбинированном позитивном методе сначала сверлятся отвер-

стия, затем на поверхность ПП наносится защитный слой с рисунком, повто-

ряющим непроводящий рисунок ПП, и осуществляется осаждение меди. По-

сле этого проводятся мероприятия по травлению, в результате которых оста-

ется проводящий рисунок ПП (подробнее см. в Б.4). 

В методе металлизации сквозных отверстий сначала химическим 

методом на двустороннем фольгированном диэлектрике, который называют 

ядро, изготавливаются внутренние слои (только проводящие рисунки без от-

верстий). Затем на ядро добавляют внешние слои из медной фольги (рис. Б.6) 

путем прессования при высокой температуре с использованием связующего 

смолистого материала (прокладочной стеклоткани, prepreg). После этого в 

созданной монолитной заготовке комбинированным методом получают тре-

буемые проводящие рисунки ПП на внешних слоях и изготавливают и ме-

таллизируют отверстия. 

 

При данном методе изготовления в ПП могут быть только сквозные ме-

таллизированные и неметаллизированные отверстия. 

Следует обратить внимание на то, что толщина металлизации на внеш-

них слоях за счет гальванического осаждения меди при наличии металлизи-

рованных отверстий (см. п. 8 из Б.4) будет больше номинального значения. 

Например, для фольги толщиной 18 мкм – около 40 мкм. 

В методе попарного прессования сначала комбинированным методом 

получают две платы-заготовки (два ядра) с переходными металлизированны-

ми отверстиями и проводящими рисунками только с тех их сторон, которые в 

дальнейшем будут внутренними слоями МПП. Затем ядра прессуются с ис-

пользованием prepreg (рис. Б.7). После этого в созданной монолитной заго-

Рис. Б.6 
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товке комбинированным методом получают проводящие рисунки ПП на 

внешних слоях и изготавливают и металлизируют сквозные отверстия. 

 

При данном методе изготовления в ПП могут быть как сквозные метал-

лизированные и неметаллизированные отверстия, так и переходные отвер-

стия, соединяющие только некоторые слои. 

Следует обратить внимание на то, что толщина металлизации на внеш-

них и внутренних слоях за счет гальванического осаждения меди (см. п. 8 из 

Б.4) будет больше номинального значения. Например, для фольги толщиной 

18 мкм – около 40 мкм на внутренних слоях и около 60 мкм на внешних. 

В методе открытых КП сначала путем травления фольгированного 

диэлектрика создаются отдельные слои с необходимыми перфорированными 

окнами, через которые в готовой ПП будет осуществляться доступ к КП ни-

жележащих слоев. Затем выполняется 

одновременная сборка подготовлен-

ных слоев (рис. Б.8). Основные осо-

бенности таких плат: 

– верхние слои должны иметь 

прорези, обеспечивающие доступ ко 

всем требуемым КП нижних слоев; 

– в самой ПП нет межслойных соединений. Они образуются только при 

пайке компонентов или перемычек к различным слоям ПП через окна; 

– КП должны быть сделаны под все выводы микросхем независимо от 

того, задействованы или нет эти выводы электрически; 

– проводники одной цепи в общем случае должны лежать в одном слое и 

выходить в окна в местах, которые не заняты КП других слоев; 

– большое число слоев (более 5–7) может сделать пайку выводов компо-

нентов ненадежной из-за большой глубины прорезей. 

В методе выступающих выводов происходит одновременное прессо-

вание заготовок с нанесенным проводящим рисунком и перфорированными 

Рис. Б.7 
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окнами, в которых располагаются полоски медной фольги (продолжения пе-

чатных проводников). Выступающие в окна полоски (выводы) отгибаются на 

наружный слой ПП, где закрепляются изоляционными накладками (колодка-

ми) или подпаиваются к КП (рис. Б.9). Основные особенности таких плат: 

– в самой ПП нет межслойных 

соединений; 

– нет ограничения по макси-

мальному количеству слоев; 

– проводники одной цепи в об-

щем случае должны лежать в одном 

слое и выходить в окна или на края 

ПП в местах, которые не заняты вы-

водами других слоев; 

– сосредоточение проводников в 

окнах может создавать большие пере-

крестные помехи; 

– трудности в формовке и закреплении выступающих выводов в преде-

лах периметра окна. 

В методе послойного наращивания на заготовку из фольги напрессо-

вывается слой тонкого диэлектрика, перфорированного в местах будущих 

межслойных соединений. В перфорированные отверстия на поверхность 

фольги гальванически осаждается медь, заполняющая их на толщину диэлек-

трика. На диэлектрик осаждается слой 

меди, на котором выполняется прово-

дящий рисунок. Напрессовывание ди-

электрика, выполнение межслойных 

соединений и проводящего рисунка 

повторяются по количеству слоев 

МПП. На последний слой проводяще-

го рисунка напрессовывается защит-

ный сплошной слой диэлектрика. На обратной стороне ПП, покрытой фоль-

гой, выполняется проводящий рисунок наружного слоя МПП (рис. Б.10). Ос-

новные особенности таких плат: 

– высокая надежность электрических соединений; 

– исключительно высокая плотность монтажа, так как межслойные пе-

реходы можно выполнять в любой точке ПП; 

Рис. Б.9 
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– большая трудоемкость производства из-за невозможности распаралле-

ливания работы и других факторов (например, необходима постоянная тща-

тельная очистка электролитов из-за длительного контакта с диэлектриками); 

– на ПП устанавливаются только SMD-компоненты; 

– количество слоев обычно не более пяти, так как изготовление каждого 

последующего слоя связано с многократными термическими (при прессова-

нии) и химическими воздействиями на уже изготовленные слои. 

Кроме приведенных выше методов изготовления ПП существуют и дру-

гие, а также их комбинации. 

Б.4. Процесс производства ДПП СВЧ-диапазона 

В [103] достаточно подробно описаны последовательности операций при 

производстве различных видов ПП. Так как по общему заданию на проекти-

рование требуется разработать ДПП СВЧ-диапазона, то в данном разделе 

рассмотрен процесс ее производства комбинированным позитивным мето-

дом, состоящим из следующих этапов: 

1. Выбирается исходный материал – диэлектрическое основание, лами-

нированное с двух сторон медной фольгой (рис. Б.11, а). 

 

2. На специализированных станках с числовым программным управле-

нием с помощью твердосплавных сверл в заготовке сверлятся отверстия (рис. 

Б.11, б). Для достижения высокой производительности при сверлении ско-

рость вращения шпинделя достигает 180 тыс. об/мин. 

Это первая операция, влияющая на класс точности ПП (см. Б.8). Точ-

ность сверления зависит от применяемого оборудования и инструментов. 

Значения позиционных допусков осей отверстий в диаметральном вы-

ражении (см. Д.7) по ГОСТ Р 53429–2009 представлены в табл. Б.1. 

а б 

Рис. Б.11 [103] 
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Таблица Б.1 

Значения позиционных допусков расположения осей отверстий  

в диаметральном выражении 

Размер большей стороны ПП 

Позиционный допуск на расположение осей  

отверстий для класса точности, мм 

1 2 3 4 5 6 7 

До 180 включ. 0,20 0,15 0,08 0,05 0,05 0,03 0,03 

Св. 180 до 360 включ. 0,25 0,20 0,10 0,08 0,08 0,05 0,05 

Св. 360 0,30 0,25 0,15 0,10 0,10 0,08 0,08 

3. Производится химическое и предварительное гальваническое осажде-

ние меди (рис. Б.12, а), которое необходимо для придания стенкам отверстий 

проводимости для последующей гальванической металлизации. 

Рыхлый слой химически осажденной меди быстро разрушается, поэтому 

его усиливают тонким слоем гальванической меди (до 5 мкм). 

 

4. Нанесение на заготовку фоточувствительного материала – фоторези-

ста (рис. Б.12, б). Этот этап проходит в чистой комнате с неактивным (жел-

тым) освещением, так как фоторезист светочувствителен к ультрафиолето-

вому спектру. Фоторезист бывает пленочным (наносится на заготовку лами-

нированием) и жидким (наносится валиками). 

5. С заготовкой совмещается фотошаблон (рис. Б.13, а), который пред-

варительно изготавливается на фотоплоттере из специализированной фото-

технической пленки толщиной 100–175 мкм. Черно-белое изображение на 

фотошаблоне – позитивное по отношению к будущей схеме. 

6. Экспонирование фоторезиста – участки поверхности, прозрачные на 

фотошаблоне, засвечиваются на установке с ультрафиолетовыми лампами 

а б 

Рис. Б.12 [103] 

1 – гальваническая затяжка (медь); 2 – диэлектрическое основание;  
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высокой мощности, фотополимеризуются и теряют способность к растворе-

нию в проявителе. Фотошаблоны затем удаляются (рис. Б.13, б). 

 

7. Изображение на фоторезисте проявляется (в слабощелочном растворе 

при температуре 30–32 °C в горизонтальной конвейерной линии с помощью 

форсунок под давлением): незасвеченные участки растворяются, засвечен-

ные – остаются на плате (рис. Б.13, в). В результате фоторезист остается 

только в тех областях, где проводников на плате не будет. 

Назначение оставшегося фоторезиста – обеспечить избирательное галь-

ваническое осаждение меди и в последующем металлорезиста. 

8. Медь осаждается на поверхность стенок отверстий и всех проводни-

ков (рис. Б.13, г). По ГОСТ 23752–79 средняя толщина слоя меди в отверстии 

должна быть не менее 25 мкм для МПП и 20 мкм для ДПП. 

Медная металлизация производится в специальных гальванических ван-

нах с медным электролитом. Для достижения высокой плотности осадка 

а б 

Рис. Б.13 [103] 

1 – фотошаблон; 2 – фоторезист; 3 – диэлектрическое основание;  
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плотность тока не превышает 2,5 А/дм2. В результате скорость осаждения 

меди составляет в среднем 25–30 мкм в час. 

9. Металлорезист осаждается на открытые от фоторезиста участки – на 

проводники и в отверстия (рис. Б.14, а). В качестве него могут выступать 

различные металлы и соединения, имеющие меньшую скорость травления по 

сравнению с медью (например, олово). Обычно гальваническое осаждение 

металлорезиста происходит на одной линии с гальваническим осаждением 

меди. Толщина осаждаемого слоя олова составляет 4–6 мкм. 

 

10. Фоторезист удаляется, обнажая базовую медную фольгу в пробель-

ных местах (рис. Б.14, б). Удаление происходит в погружных или контейнер-

ных линиях с щелочным раствором при температуре 40–45 °C. 

11. Происходит травление меди (рис. Б.14, в). Незащищенная медь рас-

творяется в травящем растворе, оставляя проводящий рисунок ПП. Травле-

ние происходит в специальной конвейерной установке со множеством фор-

сунок для равномерности по всей поверхности заготовки. 

а б 

Рис. Б.14 [103] 

1 – фоторезист; 2 – диэлектрическое основание; 3 – металлорезист;  

4 – медная фольга; 5 – осажденная медь; 6 – гальваническая затяжка (медь) 
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12. Металлорезист удаляется с поверхности меди в специальном раство-

ре, малоактивном по отношению к меди (см. рис. Б.14, г). 

13. Нанесение защитной паяльной маски (см. Б.7). 

Сухая пленочная паяльная маска наносится методом ламинирования, но 

используется редко, так как не подходит для ПП выше 3-го класса точности.  

Жидкая паяльная маска наносится через сетчатый трафарет с размером 

ячейки 150 мкм с помощью полиуретанового ракеля. После ее нанесения на 

каждую сторону ПП происходит предварительная сушка при 75 °C. 

Существует два варианта нанесения жидкой паяльной маски:  

– через трафарет с подготовленными окнами вскрытия (маска наносится 

только на защищаемые участки ПП). Такой вариант имеет невысокое разре-

шение и применяется, как правило, на ОПП ниже 3-го класса точности; 

– сплошным нанесением (рис. Б.15, а) с использованием фотошаблонов 

и последующим проявлением. 

 

а б 

Рис. Б.15 [103] 

1 – защитная паяльная маска; 2 – диэлектрическое основание; 3 – медь;  

4 – фотошаблон; 5 – маркировочная краска 
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14. Заготовки с подсушенной паяльной маской поступают на участок 

фотолитографии, где происходит совмещение заготовки с фотошаблоном 

маски и последующее экспонирование ультрафиолетовыми лампами высокой 

мощности (см. рис. Б.15, б). 

15. После экспонирования заготовки проявляются в слабощелочном рас-

творе при температуре 32–34 °C в горизонтальной конвейерной линии с по-

мощью форсунок под давлением (см. рис. Б.15, в). 

16. Происходит нанесение маркировки (контуров, позиционных обозна-

чений компонентов, логотипов и др.) – шелкографии. 

Маркировка наносится одним из трех методов: 

– маркировочной краской через сетчатый трафарет. Метод применим 

при массовом производстве, так как изготовление трафарета (натяжение сет-

ки на рамку, нанесение, проявление и задубливание жидкого фоторезиста) 

занимает много времени; 

 

а б 

Рис. Б.16 [103] 

1 – фотошаблон; 2 – маркировочная краска; 3 – защитная паяльная маска;  

4 – диэлектрическое основание; 5 – медь; 6 – ImmAg 
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– маркировочной краской специальным принтером. Очень гибкий метод, 

но требует наличие дорогостоящего оборудования и материалов; 

– паяльной маской, контрастной к основному цвету (см. рис. Б.15, г). 

Метод неприменим при массовой серии из-за большого расхода материала, 

но для прототипного производства и мелкой серии – лучший выбор. 

Размер ячейки сетчатого трафарета, при использовании такого варианта, 

составляет 80 мкм, что позволяет создать более тонкий слой по сравнению со 

слоем маски. После этого производится предварительная сушка при 75 °C. 

17. Совмещение фотошаблона и экспонирование маркировочной краски 

(см. рис. Б.16, а). 

18. Проявление маркировочной краски (см. рис. Б.16, б). 

19. На открытые от маски участки меди различными методами наносит-

ся финишное покрытие (см. рис. Б.16, в и Б.6). 

Б.5. Материалы основания ПП 

Основными требованиями, предъявляемыми к материалам основания 

ПП, являются следующие: 

– способность сохранять форму и линейные размеры в различных кли-

матических условиях и в процессе эксплуатации; 

– чистота обработки поверхностей; 

– допуск на размеры по толщине; 

– состав (однородность); 

– теплопроводность; 

– электропроводность; 

– относительная диэлектрическая проницаемость ( r ); 

– тангенс угла диэлектрических потерь ( tan ). 

Типовые конструкции ПП основаны на применении стандартного стек-

лотекстолита типа FR4 с рабочей температурой, как правило, от минус 50 до 

плюс 110 °C, температурой стеклования около 135 °C и относительной ди-

электрической проницаемостью от 3,8 до 4,5 (в зависимости от поставщика и 

вида материала). 

При повышенных требованиях к термостойкости или при монтаже ПП в 

печи по бессвинцовой технологии (до 260 °C) применяется высокотемпера-

турный FR4 High Tg или FR5. 

При требованиях к постоянной работе на высоких температурах или при 

резких перепадах температур применяется полиимид. Кроме того, полиимид 



 

 675 

используют для изготовления ПП повышенной надежности, а также в случа-

ях, когда требуется повышенная электрическая прочность. 

Для основания ПП СВЧ-диапазона диэлектрические материалы класси-

фицируются по химической основе на две группы: 

– органические – неполярные полимеры (фторопласт, полиэтилен, поли-

пропилен) и полярные полимеры (полистирол); 

– неорганические – различные виды керамики (например, поликор). 

Органические диэлектрики подвергаются армированию (обычно стекло-

тканью), наполнению (обычно тонкодисперсными или керамическими по-

рошками) и другим видам модифицирования для направленного изменения 

отдельных физико-технических параметров. Кроме того, они могут быть 

фольгированными и нефольгированными [22]. 

В табл. Б.2–Б.4 приведены параметры некоторых материалов, применя-

емых в производстве ПП. 

Таблица Б.2 

Параметры СВЧ-материалов 

Материал 
Базовая  

толщина (h), мм 

Толщина  

меди (t), мкм 

εr 

(f = 10 ГГц) 
 tan * 

Плотность, 

г/см3 

Лист ФАФ-4Д ГОСТ 21000–81 

ФАФ-4Д–0,035–1,0 1,000 35 2,50 ±0,10 0,0007 3,00 

ФАФ-4Д–0,035–1,5 1,500 35 2,50 ±0,10 0,0007 2,90 

Фирма Arlon 

25FR-0,254-18/18 0,254 18 3,58 ±0,10 0,0035 1,80 

25FR-0,305-18/18 0,305 18 3,58 ±0,10 0,0035 1,80 

25FR-0,508-35/35 0,508 35 3,58 ±0,10 0,0035 1,80 

25N-0,457-35/35 0,457 35 3,38 ±0,05 0,0026 1,70 

AD450-0,508-35/35 0,508 35 4,50 ±0,15 0,0028 2,45 

AD600-0,381-35/35 0,381 35 6,00 ±0,20 0,0037 2,45 

AD600-0,508-18/18 0,508 18 6,15 ±0,20 0,0037 2,45 

AD1000-0,508-18/18 0,508 18 10,0 ±0,35 0,0023 3,20 

AD1000-0,635-18/18 0,635 18 10,20 ±0,35 0,0022 3,20 

AD1000-0,762-18/18 0,762 18 10,35 ±0,35 0,0022 3,20 

AR1000-0,508-18/18 0,508 18 9,60 ±0,35 0,0027 2,84 

AR1000-0,610-18/18 0,610 18 9,70 ±0,35 0,0027 2,84 

CLTE-0,254-18/18 0,254 18 2,94 ±0,06 0,0019 2,38 

CuClad6700-0,076 0,076 – 2,35 ±0,10 0,0025 2,10 
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Окончание таблицы Б.2 

Материал 
Базовая  

толщина (h), мм 

Толщина  

меди (t), мкм 

εr 

(f = 10 ГГц) 
 tan * 

Плотность, 

г/см3 

DICLAD 527-0,381-35/35 0,381 35 2,50 ±0,04 0,0016 2,31 

Фирма Isola 

IS680-280-0,508-18/18 0,508 18 2,80 ±0,05 0,003 2,5** 

IS680-300-0,508-35/35 0,508 35 3,00 ±0,05 0,003 2,5** 

IS680-320-0,508-35/35 0,508 35 3,20 ±0,05 0,0035 2,5** 

IS680-338-0,508-18/18 0,508 18 3,38 ±0,05 0,0035 2,5** 

Фирма Rogers 

RO3003-0,508-35/35 0,508 35 3,00 ±0,04 0,0011 2,10 

RO3006-0,635-18/18 0,635 18 6,15 ±0,15 0,0019 2,60 

RO3010-0,635-35/35 0,635 35 10,20 ±0,30 0,0021 2,80 

RO3035-0,508-35/35 0,508 35 3,50 ±0,05 0,0015 2,10 

RO4003C-0,305-18/18 0,305 18 3,38 ±0,05 0,0024 1,80 

RO4003C-0,406-18/18 0,406 18 3,38 ±0,05 0,0024 1,80 

RO4350B-0,422-35/35 0,422 35 3,48 ±0,05 0,0034 1,90 

RO4350B-0,508-18/18 0,508 18 3,48 ±0,05 0,0034 1,90 

RO4450B-0,102 0,102 – 3,54 ±0,05 0,0040 1,86 

TMM4-0,508-18/18 0,508 18 4,50 ±0,045 0,0018 2,07 

TMM6-0,635-18/18 0,635 18 6,00 ±0,08 0,0021 2,37 

TMM10-0,635-18/18 0,635 18 9,20 ±0,23 0,0020 2,77 

TMM10I-0,381-18/18 0,381 18 9,80 ±0,245 0,0018 2,77 

Фирма Taconic 

Cer-10-0,635-35/35 0,635 35 9,50 ±0,50 0,0025 3,05 

Cer-10-0,762-18/18 0,762 18 9,70 ±0,50 0,0025 3,05 

RF-35-0,254-18/18 0,254 18 3,50 ±0,10 0,0021 2,30 

RF-35-0,508-35/35 0,508 35 3,50 ±0,10 0,0021 2,30 

RF-41-0,508-35/35 0,508 35 4,10 ±0,15 0,0032 2,33 

RF-43-0,635-35/35 0,635 35 4,30 ±0,15 0,0032 2,33 

RF-45-0,635-35/35 0,635 35 4,50 ±0,15 0,0032 2,33 

RF-60A-0,635-35/35 0,635 35 6,15 ±0,25 0,0032 2,79 

TLX-8-0,254-35/35 0,254 35 2,55 ±0,04 0,0014 2,25 

TSM-30-0,254-18/18 0,254 18 3,00 ±0,05 0,0016 2,30 

 ___________________ 

 * Указано среднее значение в диапазоне рабочих частот отдельно для каждого 

СВЧ-материала. 

 ** Значения ориентировочные. 
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Таблица Б.3  

Параметры некоторых применяемых материалов FR-4 (Kingboard Laminates) 

Тип 

материала 
Tg, °C 

εr tan  

f = 1 МГц f = 1 ГГц f = 1 МГц f = 1 ГГц 

KB6160F 135 4,58 4,47 0,013 0,014 

KB6165F 150 4,8 4,6 0,015 0,016 

KB6167F 170 4,8 4,6 0,015 0,016 

Таблица Б.4 

Некоторые типы prepreg (KB6065F) из группы KB6165F 

Prepreg Вес, г/м2 Толщина, мм εr (f = 1 ГГц) tan  (f = 1 ГГц) 

1080 49 0,079 4,2 0,017 

2116 108 0,127 4,5 0,016 

7628 200 0,196 4,6 0,015 

Примечания: 

– температура стеклования (Tg) – температура, при превышении ко-

торой диэлектрик базового материала скачкообразно переходит из твердо-

го состояния в пластичное, что приводит к увеличению коэффициента теп-

лового расширения [104]; 

– препреги могут использоваться в комбинациях друг с другом, напри-

мер: 2116 и 7628 (толщина – 0,32 мм), 1080 и 1080 (толщина – 0,15 мм). 

Примерный вес ПП на FR-4 для некоторых толщин приведен в табл. Б.5.  

Таблица Б.5 

Ориентировочный вес ПП, изготовленных на FR-4 

Тип ПП Толщина, мм Вес, г/мм2 Тип ПП Толщина, мм Вес, г/мм2 

ДПП 0,5 0,0012 ДПП 1,5 0,0032 

ДПП 0,8 0,0017 ДПП 2,0 0,0040 

ДПП 1,0 0,0022 МПП (4 слоя) 1,6 0,0042 

Допуск на толщину материала обычно составляет до ±10 %. 

Примерный вес фольги для 18 мкм – 160 г/м2, для 35 мкм – 312 г/м2.  

Примечание. Зачастую толщина медной фольги записывается в пере-

счете к ее весу в унциях авердюпуа (1 oz – 28,35 г) на квадратный фут (1 ft – 

304,8 мм): 18 мкм – 0,5 oz, 35 мкм – 1 oz, 70 мкм – 2 oz. 

В составе конструкций МПП СВЧ-диапазона возможно применение раз-

личных типов диэлектрика и их комбинаций. Например, четырехслойная ПП 

с СВЧ-диэлектриком между первым и вторым слоями (Rogers RO4450B) и 

стандартным FR-4 между остальными слоями. 
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Б.6. Финишные покрытия 

Для сохранения паяемости ПП, обеспечения плоскостности покрытия и 

для надежного монтажа электронных компонентов и паяных соединений 

необходимо защищать медную поверхность КП ПП финишным покрытием 

(final finish) [105], [106]. Если этого не сделать, то медь со временем окислит-

ся и потеряет свои свойства. 

Паяемость ПП (soldering) по ГОСТ Р 53386–2009 – свойство поверхно-

сти проводящего рисунка ПП смачиваться расплавленным припоем. 

На элементы проводящего рисунка ПП с различным назначением могут 

наноситься разные покрытия или одинаковое покрытие с «компромиссными» 

свойствами для упрощения процесса изготовления. 

Среди основных финишных покрытий различают: 

1. HASL (Hot Air Solder Levelling) или Гор. ПОС-63 (горячее лужение). 

Толщина покрытия: 10–35 мкм (допускаются наплывы до 0,2 мм). 

Внешний вид HASL: КП и переходные отверстия ПП, не закрытые за-

щитной паяльной маской, покрыты припоем (рис. Б.17 и Г.188). 

Покрытие HASL является преобладаю-

щим в промышленности финишным покры-

тием КП и состоит в погружении ПП на огра-

ниченное время в ванну с расплавленным 

припоем с последующим выравниванием рас-

плава струями горячего воздуха, сдувающими 

его излишки. Однако из-за сил поверхностного натяжения, действующих в 

расплавленном припое, он по-разному сдувается с КП, что особенно заметно 

на КП с малым шагом. 

Достоинства HASL: 

– длительный срок хранения (около 12 мес.); 

– отличная паяемость; 

– широкий температурный диапазон при монтаже; 

– возможность неоднократной повторной пайки; 

– широко известное и наиболее часто применяемое покрытие; 

– невысокая стоимость покрытия. 

Недостатки HASL: 

– неровная поверхность, наплывы; 

– плохо подходит для SMD-компонентов с шагом выводов менее 0,5 мм 

и BGA (Ball Grid Array – тип корпуса SMD-компонента, выводы которого 

Рис. Б.17 [105] 
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представляют собой массив шариков из припоя, нанесенных на КП с нижней 

стороны микросхемы), так как облуживание может приводить к образованию 

перемычек и проблемам с толщиной покрытия; 

– содержит свинец – вредный фактор для экологии и персонала, не соот-

ветствует директиве RoHS; 

– в процессе нанесения покрытия ПП получает жесткий термоудар (235–

245 ºС), что может приводить к избыточному короблению (деформации); 

Различают два вида деформации ПП по ГОСТ Р 53386–2009: 

– изгиб ПП (bow) – деформация ПП, характеризующаяся цилиндриче-

ским или сферическим искривлением двух противоположных кромок осно-

вания ПП (при прямоугольной форме ПП четыре угла лежат в одной плоско-

сти, а поверхность ПП является выпуклой или вогнутой); 

– скручивание ПП (twist) – деформация ПП, характеризующаяся спи-

ральным искривлением двух противоположных кромок основания ПП (при 

прямоугольной форме ПП один ее угол находится не в плоскости, в которой 

лежат остальные три угла). 

2. Иммерсионное золочение (ENIG, Electroless Nickel/Immersion Gold). 

Толщина покрытия: подслой Ni – 3–5 мкм, слой Au – 0,05–0,1 мкм. 

Внешний вид ENIG: золотое финишное покрытие на КП и переходных 

отверстиях, не покрытых защитной паяльной маской (рис. Б.18). 

Покрытие ENIG формируется путем 

электролизного осаждения никеля на катали-

зированную медную поверхность с последу-

ющим осаждением из раствора на поверх-

ность никеля тонкого слоя золота. Процесс 

получения покрытия ENIG требует чистой 

медной поверхности, свободной от остатков защитной паяльной маски и ме-

таллорезиста. Функция золота – обеспечивать хорошую паяемость и защи-

щать никель от окисления, а сам никель служит барьером между медью и зо-

лотом, предотвращая их взаимную диффузию и последующее окисление ме-

ди, ведущее к образованию несмачиваемой припоем поверхности. 

Применение ENIG: данное покрытие целесообразно применять для ПП, 

нуждающихся в отладке (в опытных образцах), и ПП, для эксплуатации ко-

торых предъявляются особые требования. Благодаря высокой живучести 

ENIG платы с этим покрытием могут монтироваться через достаточно про-

должительные промежутки времени после изготовления. ENIG идеально 

Рис. Б.18 [105] 
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подходит практически для любых технологий монтажа изделий, как бессвин-

цовых, так и содержащих свинец. 

Достоинства ENIG: 

– высокая планарность поверхности, равномерность толщины покрытия; 

– хорошо подходит для SMD-компонентов с шагом менее 0,5 мм и BGA; 

– хорошая паяемость; 

– длительный срок хранения (около 12 мес.); 

– золото хорошо растворяется в припое, не подвержено быстрому по-

тускнению и окислению; 

– не содержит свинец; 

– ПП обрабатываются при низких температурах (менее 90 °C) и не под-

вергаются излишнему термоудару. 

Недостатки ENIG: 

– требуется применение специальных паст и флюсов при пайке; 

– покрытие содержит никель, считающийся потенциальным канцероге-

ном, а в процессе осаждения применяется цианид и другие нежелательные 

химические вещества; 

– возможен эффект «черной площадки» (Black Pad) – вид коррозии ни-

келя, ослабляющего паяемость ПП. Дефект образу-

ется из-за оголения никеля и выпотевания фосфора 

при использовании тонкого слоя золота, а также при 

передержке процесса пайки и при неправильном вы-

боре флюса, т. е. когда тонкий слой золота растворя-

ется в припое раньше, чем припой смочит никель 

(рис. Б.19); 

– плохо подходит для применений на СВЧ; 

– требуются специальные условия хранения ПП. 

3. Иммерсионное серебрение (Immersion Ag, ImmAg). 

Толщина покрытия: 0,1–0,4 мкм. 

Внешний вид ImmAg: белое серебряное покрытие на КП и переходных 

отверстиях, не покрытых защитной паяльной маской (см. рис. А.2). 

ImmAg – покрытие, при котором на медную поверхность КП из раствора 

осаждается тонкий слой серебра. Серебро наносится совместно с органиче-

ским соединением, которое не только предотвращает миграцию серебра по 

ПП, но и предохраняет его от окисления, являясь консервирующим анти-

окислительным покрытием. В процессе пайки серебряный слой растворяется 

Рис. Б.19 [106] 
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в паяном соединении, образуя сплав олово–свинец–серебро на меди, что 

обеспечивает очень надежные паяные соединения компонентов BGA. 

Применение ImmAg: данное покрытие одинаково пригодно как для бес-

свинцового, так и для обычного техпроцесса. Оно хорошо подходит для мон-

тажа серийных партий и опытных образцов. При правильном хранении ПП 

срок жизни покрытия достигает одного года, что позволяет выполнять отло-

женный монтаж. 

Использование серебрения поверхности медных проводников часто обу-

словлено поверхностным эффектом – скин-эффектом, при котором ток рас-

пределяется не равномерно по сечению проводника, а преимущественно в 

поверхностном слое. На высоких частотах глубина поверхностного слоя про-

водимости имеет толщину, соизмеримую с толщиной финишных покрытий 

(например, на частоте 10 ГГц – менее одного микрона), поэтому электриче-

ская проводимость материалов финишных покрытий является важным пара-

метром. При частоте выше 2 ГГц конструкторы считают, что использование 

покрытия никелем разрушает целостность сигнала. Медь – ненамного худ-

ший проводник, чем серебро. Однако она имеет склонность к окислению, и 

ее окислы обладают повышенным сопротивлением, поэтому на высоких ча-

стотах они вызывают мощное затухание сигналов.  

Достоинства ImmAg: 

– высокая планарность поверхности; 

– хорошо подходит для SMD-компонентов с шагом менее 0,5 мм и BGA; 

– отлично подходит для применений на СВЧ (не содержит подслой Ni); 

– хорошая паяемость; 

– не содержит свинец; 

– ПП обрабатываются при низких температурах (менее 55 °C) и не под-

вергаются излишнему термоудару; 

– самая близкая замена горячему лужению (HASL); 

– средняя стоимость покрытия. 

Недостатки ImmAg: 

– требует осторожного обращения, возможно потускнение металла; 

– чувствительность покрытия к серосодержащей среде (устранено или 

сильно уменьшено в современных процессах); 

– серебро склонно к электромиграции и образованию дендритов; 

– ПП должны храниться в вакуумной упаковке до монтажа; 

– ограниченный срок хранения; 
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– высокий коэффициент трения (не оптимально для монтажа запрессов-

кой); 

– иногда для ImmAg проявляется дефект образования микропустот, 

сходный по результатам своего воздействия – нарушению механической 

прочности паяных соединений – с эффектом «черной площадки». 

4. Иммерсионное олово (Immersion Sn, ImmSn). 

Толщина покрытия: 0,8–1,2 мкм. 

Внешний вид ImmSn: белое оловянное покрытие на КП и переходных 

отверстиях, не покрытых защитной паяльной 

маской (рис. Б.20). 

Процесс нанесения иммерсионного олова 

является еще одной альтернативой HASL и 

включает в себя одинаковые с ImmAg этапы, 

за исключением более длительной выдержки 

в ванне для оловянирования (10–15 мин.), что удлиняет конвейерную линию 

и удорожает процесс. 

Применение ImmSn: из-за ограниченного срока жизни данное покрытие 

не следует применять для ПП, монтаж которых может быть отложен на более 

чем 2–3 месяца. ImmSn также не следует применять 

для монтажа с содержащими свинец припоями, по-

скольку рабочей температуры такого монтажа не 

хватит для активации покрытия и полного его рас-

плавления. На рис. Б.21 показан дефект «холодная 

пайка», возникший при монтаже на бессвинцовое 

покрытие свинцового BGA-компонента. 

Достоинства ImmSn: 

– высокая планарность поверхности; 

– отличная паяемость, совместимость с режимами пайки HASL; 

– хорошо подходит для компонентов с малым шагом выводов; 

– хорошо подходит для применений на СВЧ (не содержит подслой Ni); 

– не содержит свинец; 

– ПП обрабатываются при низких температурах (менее 80 °C) и не под-

вергаются излишнему термоудару. 

Недостатки ImmSn: 

– требует осторожного обращения; 

– ПП должны храниться в вакуумной упаковке до монтажа; 

Рис. Б.20 [105] 

Рис. Б.21 [106] 
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– не пригодно для производства клавиатур и сенсорных панелей; 

– не выдерживает многократный монтаж-демонтаж элементов; 

– ограниченный срок хранения; 

– образование «усов олова» – длинных (до 150 мкм) тонких кристалли-

ческих нитей разнообразной формы, которые могут расти вертикально, изги-

баясь, спиралевидно, в виде крюкообразных или вилкообразных кристаллов 

олова (рис. Б.22). Характерно также для цинка и кадмия. «Усы олова» могут 

вызвать короткие замыкания проводящего рисунка 

ПП как из-за своего роста, так и при обламывании с 

последующим падением на поверхность ПП в про-

цессе изготовления и (или) эксплуатации изделия. 

Точно предсказать образование усов олова невоз-

можно. Они могут появиться как на новых изделиях, 

так и спустя годы после начала эксплуатации, как на 

элементах, так и под ними, а могут не появиться вообще. Известно, что «усы 

олова» обычно растут на покрытиях толщиной свыше 0,5 мкм. 

– возможно образование дендритов, вызывающих короткое замыкание 

проводников. Они представляют собой металлические нити или кристаллы, 

которые растут на поверхности металла (в плоскости X0Y), а не перпендику-

лярно ей (в отличие от «усов олова»), в виде древовидных структур. Меха-

низм образования дендритов носит электролитический характер, т. е. для их 

роста необходимо иметь электролит и напряжение. Следовательно, дендриты 

могут приводить к отказам только в случае наличия условий для образования 

электролита (например, влажность плюс остатки флюса или органических 

кислот), а также только при эксплуатации изделия; 

– в техпроцессе используется тиомочевина – потенциальный канцероген. 

5. Гальваническое золочение ножевых разъемов (Gold Fingers). 

Толщина покрытия: подслой Ni – 5–6 мкм, слой Au – 1,5–3 мкм. 

Гальваническое золочение контактов разъема по подслою никеля нано-

сится электрохимическим осаждением (гальвани-

ка) и может совместно использоваться с другими 

покрытиями. 

Применение Gold Fingers: данное покрытие 

используется в основном для нанесения на конце-

вые контакты и ламели, так же пригодно для про-

изводства клавиатур и сенсорных панелей (рис. Б.23). 

Рис. Б.22 [106] 

Рис. Б.23 [105] 
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Достоинства Gold Fingers: 

– имеет высокую механическую прочность, стойкость к истиранию и 

неблагоприятному воздействию окружающей среды; 

– обеспечивает надежный и долговечный электрический контакт; 

– возможность увеличить толщину в несколько раз. 

Недостатки Gold Fingers: 

– для покрытия обязателен гальванический контакт; 

– ограничения по размеру ПП; 

– высокая стоимость. 

6. Органическое защитное покрытие (OSP). 

Толщина покрытия: 0,2–0,6 мкм. 

Внешний вид OSP (Organic Solder Preservative): на КП нет припоя. ПП 

выглядит так, как будто КП ничем не покрыты. 

Покрытие OSP предназначено для формирования тонкого равномерного 

защитного слоя на медной поверхности ПП. Это покрытие защищает прово-

дящий рисунок ПП от окисления при ее хранении и в процессе выполнения 

сборочных операций. 

Применение OSP: данное покрытие целесообразно использовать только 

при монтаже крупных партий изделий, когда дизайн платы отработан, 

устройство отлажено и не нуждается в дополнительных настройках и пере-

пайках. При таком подходе себестоимость плат с OSP в качестве финишного 

покрытия получается минимальной. 

Достоинства OSP: 

– высокая планарность поверхности; 

– подходит для компонентов с малым шагом выводов; 

– экологически чистый техпроцесс; 

– ПП обрабатываются при низких температурах (менее 45 °C) и не под-

вергаются излишнему термоудару; 

– самое недорогое покрытие. 

Недостатки OSP: 

– требует осторожного обращения (щупы оснастки могут повредить ПП; 

чувствительность к выбору флюсов; содержащие кислоты отпечатки пальцев 

приводят к ухудшению свойств); 

– ограниченное число термических циклов; 

– сложный контроль качества покрытия и электроконтроль; 

– ограниченный срок хранения. 
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Б.7. Паяльная защитная маска 

Паяльная защитная маска ПП (solder mask) по ГОСТ Р 53386–2009 – 

это термостойкое покрытие, наносимое избирательно для защиты отдельных 

участков ПП в процессе пайки. Паяльную маску также используют для защи-

ты от попадания флюсов, влаги и т. д. 

Для гибких ПП или для гибких частей гибко-жестких ПП защитное по-

крытие вместо паяльной маски называется покрывным слоем. Это связано с 

тем, что пайка компонентов на гибкие платы осуществляется редко и такого 

вида ПП, как правило, полностью покрыты специальным защитным слоем, 

который чаще всего состоит из того же материала, что и основание гибкой 

платы [107]. 

Защитная паяльная маска бывает двух видов: жидкая и сухая пленоч-

ная. Полимерный материал маски может наноситься различными методами и 

иметь различную толщину. Для жидкой маски финишная толщина обычно 

лежит в пределах от 0,020 до 0,025 мм, а сухой пленочный фоторезист по-

ставляется, как правило, толщиной 0,04, 0,08 и 0,1 мм. 

Примером жидкой фоточувствительной термоотверждаемой паяльной 

маски является Fotochem FSR 8000-8G фирмы Fotochem Electronics Co., Ltd. 

Она обладает насыщенным зеленым цветом, высокими адгезионными свой-

ствами, слабым запахом, технологична, устойчива к процессам электролити-

ческой металлизации (никелирование, золочение) и горячего лужения. Пара-

метры маски: 

– устойчивость к припою – 30 с при 260 °C; 

– изоляционное сопротивление – не менее 10 ТОм; 

– tan  = 0,03 (при 1=f  МГц); 

– r  = 3,5 (при 1=f  МГц); 

– плотность – 1,3 г/см3. 

Б.8. Классы точности ПП 

Класс точности ПП (accuracy) по ГОСТ Р 53386–2009 – условное циф-

ровое обозначение, характеризующее наименьшие номинальные значения 

размеров элементов рисунка ПП и определяющее значения допусков на раз-

меры этих элементов. 

При определении класса точности ПП учитывают значения ширины пе-

чатного проводника, гарантийного пояска КП, расстояния между печатными 

проводниками и пр. 
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Таблица Б.6 

Наименьшие номинальные размеры элементов проводящего 

рисунка ПП в зависимости от класса точности 

Наименование параметра 

Наименьшие номинальные значения размеров  

для класса точности, мм 

1 2 3 4 5 6 7 

Ширина проводника 0,75 0,45 0,25 0,15 0,100 0,075 0,050 

Расстояние между проводниками 0,75 0,45 0,25 0,15 0,100 0,075 0,050 

Гарантийный поясок КП 0,30 0,20 0,10 0,05 0,025 0,020 0,015 

Таблица Б.7 

Предельные отклонения размеров проводящего рисунка для узкого места  

Наличие металлического 

покрытия 

Предельное отклонение размеров проводящего рисунка для 

класса точности, мм 

1 2 3 4 5 6 7 

Без покрытия ±0,15 ±0,10 ±0,05 ±0,03 
+0 

–0,03 

+0 

–0,02 

+0 

–0,015 

С покрытием 
+0,25 

–0,15 

+0,15 

–0,10 
±0,10 ±0,05 ±0,03 ±0,02 ±0,015 

В табл. Б.6 и Б.7 приведены наименьшие номинальные размеры элемен-

тов проводящего рисунка для ПП и предельные отклонения их размеров по 

ГОСТ Р 53429–2009 для разных классов точности. 

Класс точности конкретной ПП определяется наличием хотя бы одного 

элемента конструкции, соответствующего значениям класса. 

Б.9. Особенности проектирования ПП, 

связанные с производством 

Технологические возможности изготовления ПП у производителей 

обычно делятся на «стандартные» и «продвинутые». Кроме того, для разных 

категорий ПП (ПП СВЧ-диапазона, гибкие ПП) могут быть разные предель-

ные технологические параметры. 

Отличие параметров ПП от стандартных для данного производителя 

влечет за собой ощутимое увеличение цены и затрат по времени либо из-за 

нестандартной последовательности операций изготовления (например, метод 

попарного прессования для МПП вместо метода металлизации сквозных от-

верстий или нестандартная структура слоев МПП), либо из-за повышенной 

точности. 

Несмотря на то что технологические возможности как российских, так и 

зарубежных поставщиков ПП растут с каждым годом, разработчику следует с 
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осторожностью использовать предлагаемые ими «предельные параметры» в 

своих разработках [108]. Дело в том, что эти параметры могут быть приме-

нимы только для определенных условий, не все из которых реализуемы для 

конкретной ПП в рамках определенного срока и объема выполнения заказа. В 

производстве ПП – крайне непростом процессе – многие параметры взаимо-

связаны. Неслучайно в последнее время все активнее продвигается лозунг 

«проектирование для производства». Разработчик ПП должен не просто сле-

по придерживаться тех параметров, которые даны в справочных таблицах 

поставщиков, но и представлять себе, как именно будет изготавливаться ПП, 

какие процессы и этапы она проходит при изготовлении, и как они влияют 

друг на друга. Только в этом случае можно: 

– оптимизировать стоимость изготовления ПП за счет выбора наименее 

дорогостоящей комбинации параметров; 

– уменьшить сроки поставки заказа путем выбора оптимальной структу-

ры и материалов; 

– повысить надежность изделия путем повышения технологичности ПП. 

Ширина проводника и зазор. При создании проекта ПП необходимо 

обращать внимание на число проводников с шириной 0,1 мм и менее. Нали-

чие нескольких узких проводников на ПП не означает, что все остальные 

стоит делать такой же ширины, так как класс точности ПП все равно будет 

определяться самым критичным местом. 

Необоснованное увеличение числа узких проводников приведет к уве-

личению вероятности получить дефектную ПП из-за бокового подтрава в 

процессе производства ПП (рис. Б.24). Глубина бокового подтрава может до-

стигать 50 % от толщины меди, а из-за влияния различных факторов (неод-

нородности материала, дефектов фотошаблона, металлорезиста и пр.) высока 

вероятность появления локальных подтравов большего размера. 

 

Количество слоев. Если планируются серийные заказы и требуется 

снижение стоимости, целесообразно ограничить число слоев, иначе в даль-

Рис. Б.24 

Основание ПП 

Граница идеального  

печатного проводника 

Граница реального  

печатного проводника  

из-за бокового подтрава 

Металлорезист 

Печатный проводник  

после травления 
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нейшем могут возникнуть проблемы с выбором поставщика. Дело в том, что 

для завода среднего уровня (а именно на таких заводах возможно снижение 

цен при выходе на серийность) ограничением на максимальное количество 

слоев является, как правило, 6 или 8. 

Причины возможных проблем: 

– отсутствие оснастки для серийной сборки более чем восьми слоев; 

– неточность совмещения слоев при прессовании (возрастает с увеличе-

нием числа слоев); 

– продольная и диагональная деформация слоев; 

– неточность центровки сверления; 

– отклонение сверла в многослойном пакете; 

– неточность травления и боковой подтрав; 

– проблемы металлизации отверстий и поверхности ПП; 

– повышенное давление при прессовании более восьми слоев. 

Гарантийный поясок КП. Несмотря на значения гарантийного пояска 

КП, указанных для различных классов точности в табл. Б.6 и приводимых в 

перечне технологических возможностей предприятий-изготовителей ПП, ре-

комендуется без крайней необходимости не занижать этот параметр и поль-

зоваться данными табл. Б.8. 

Таблица Б.8 

Рекомендуемые минимальные значения гарантийного пояска КП  

для различных диаметров отверстий 

Диаметр отверстия КП, мм Минимальный гарантийный поясок КП, мм 

0,2 0,2 

0,4–0,7 0,25 

0,8–1,6 0,3 

более 1,6 0,4 

Сдвиг отверстия относительно центра КП (рис. Б.25) может быть обу-

словлен следующими факторами: 

– неточностью фиксации ПП на сверлильном станке; 

– отклонением сверла на волокнах материала; 

– неточностью совмещения слоев МПП. 

При задании слишком маленьких значений гаран-

тийного пояска отверстие может выйти за пределы КП. 

Отношение толщины ПП и диаметра переходного 

отверстия. Типовым соотношением толщины ПП и диа-Рис. Б.25 [109] 
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метра переходного отверстия (aspect ratio) для многих российских заводов 

является 5:1 (например, диаметр готового отверстия не менее 0,3 мм при 

толщине ПП 1,5 мм), а для наиболее современных – от 7:1 до 10:1. Только на 

очень высокотехнологичных производствах за счет применения специальных 

технологий можно достичь уровня 12:1 и выше. 

В случае превышения этого соотношения велик риск получить на ПП 

некоторые отверстия либо со слишком малой толщиной медной стенки (от 5 

до 15 мкм вместо положенных 25 мкм), либо вовсе без металлизации. При-

чем первый вариант гораздо опаснее, так как электроконтроль не обнаружит 

эти дефекты, а с течением времени или при повышенных нагрузках эти от-

верстия, скорее всего, будут разрушены и произойдет отказ устройства. 

Причины таких ограничений заключаются в том, что для металлизации 

отверстий требуется «прокачивание» раствора через отверстия. При большой 

же толщине ПП и малом диаметре отверстий крайне сложно обеспечить рав-

номерное и интенсивное его протекание. 

Толщина и размеры ПП. Минимальный размер ПП может быть огра-

ничен возможностями производства. Если нужны ПП меньших габаритов, то 

их объединяют на групповой панели с фрезеровкой и перемычками, заранее 

предусмотрев места размещения (см. рис. А.1). 

Максимальная толщина ПП может быть ограничена не только соотно-

шением толщины ПП и диаметра переходного отверстия, но и возможностя-

ми конкретного завода-изготовителя по формированию пакета ПП. 

Минимальная толщина ПП может быть ограничена минимальной тол-

щиной материалов и структурой МПП, а также минимальной толщиной ПП, 

которую завод может обрабатывать на всех этапах производства. 

Расстояние от металла до края ПП. Размещать полигоны вплотную к 

краю ПП не рекомендуется, так как при фрезеровке отрывается медь, а мед-

ные заусенцы могут попасть на ПП (рис. Б.26). Поэтому отступ металла от 

края ПП обычно задают не менее 0,5 мм. 

Также важно оставлять зазор между внут-

ренними полигонами питания и краями кре-

пежных отверстий, чтобы не спровоцировать 

замыкание между слоями через металлические 

крепежные элементы. 

Расстояние от края отверстия до края ПП. Минимальное расстояние 

от отверстия до края ПП ограничено опасностью механического разрушения 

Рис. Б.26 [109] 
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слишком узкой полоски стеклотекстолита на краю ПП и опасностью повре-

ждения отверстия либо при «разламывании» панели с перемычками или 

скрайбированием, либо при механических нагрузках на ПП (при установке, 

креплении винтами и т. д.). 

Скрайбирование – нанесение линейных непрерывающихся надрезов 

(рис. Б.27) заданной глубины на поверхности технологической заготовки с 

обеих сторон на специальном станке алмаз-

ными фрезами треугольной формы для упро-

щения производства и облегчения последую-

щего разделения (в частности, после проведе-

ния монтажа на автоматах). Такие ПП остают-

ся соединенными тонким перешейком (Web), толщиной около 0,3 мм. Разме-

ры готовой ПП после разделения будут чуть больше, чем расстояние между 

надрезами, из-за частичного разлохмачивания отламываемого края. Для 

скрайбирования пригодны только прямоугольные и квадратные ПП [110]. 

Зазор между КП и защитной паяльной маской. Зазор между КП и за-

щитной паяльной маской (solder mask swell или solder mask expansion) необ-

ходим по технологическим соображениям, связанным с нанесением паяльной 

маски. Если его не обеспечить, смещение при нанесении паяльной маски 

усложнит монтаж компонентов или даже сделает его невозможным (напри-

мер, она может оказаться на КП). 

Обычно минимальное значение данного зазора у производителей со-

ставляет 0,05 мм. 

Возможные дефекты показаны на рис. Б.28. 

 

Масочный мостик между КП. При проектировании ПП необходимо 

отслеживать узкие перемычки (обычно 0,15 мм и менее) защитной паяльной 

маски (например, между КП микросхем с малым шагом выводов), так как 

они обладают недостаточной адгезией. В результате при монтаже они могут 

оторваться и воспрепятствовать пайке отдельных выводов. 

Рис. Б.28 [107] 

Рис. Б.27 [110] 

Линия реза 

Web 
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Б.10. Линии передачи на ПП 

ПП кроме выполнения функции несущей конструкции для закрепления 

и соединения в соответствии с электрической схемой размещаемых на ней 

компонентов является также основой для линий передачи сигналов. 

Термины и определения понятий в области линий передачи СВЧ уста-

навливает ГОСТ 18238–72 [111], к основным из которых можно отнести сле-

дующие: 

– линия передачи СВЧ (линия передачи) – устройство, ограничивающее 

область распространения электромагнитных колебаний и направляющее по-

ток электромагнитной СВЧ-энергии в заданном направлении; 

– тракт СВЧ (тракт, СВЧ-тракт) – совокупность СВЧ-устройств, со-

члененных определенным образом. К СВЧ-устройствам относятся линии пе-

редачи, преобразователи СВЧ-энергии, ответвители, фильтры и т. д. 

Основными линиями передачи на ПП СВЧ-диапазона являются полос-

ковые линии. 

Термины и определения понятий полосковых линий устанавливает 

ГОСТ 21702–76 [112]: 

– полосковая линия передачи (полосковая линия, strip transmission 

line) – одно-, двух- или трехпроводная линия передачи с поперечным сечени-

ем в виде отрезков прямых, лежащих на одной прямой, или параллельных 

прямых (отрезки прямых – идеализация, так как реальные проводящие слои 

имеют конечную толщину). 

Полосковые линии по конструктивно-технологическому выполнению 

подразделяются на воздушно-полосковые, МПЛ и др.; 

– симметричная полосковая линия передачи (symmetric strip trans-

mission line) – трехпроводная полосковая линия, имеющая две плоскости 

симметрии, линия пересечения которых параллельна направлению распро-

странения энергии (рис. Б.29, а); 

 

– несимметричная полосковая линия передачи (microstrip transmission 

line) – двухпроводная полосковая линия в виде параллельных прямых, име-

Рис. Б.29 

а б в г 
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ющая одну плоскость симметрии, параллельную направлению распростране-

ния электромагнитной энергии (см. рис. Б.29, б); 

– щелевая линия передачи (slot transmission line) – двухпроводная по-

лосковая линия, в которой электромагнитная волна распространяется вдоль 

щели между проводящими поверхностями, находящимися в одной плоскости 

(см. рис. Б.29, в); 

– копланарная линия передачи (coplanar transmission line) – трехпро-

водная полосковая линия, в которой электромагнитная волна распространя-

ется вдоль щелей между проводящими поверхностями, находящимися в од-

ной плоскости (см. рис. Б.29, г). 

Полосковые линии на ПП удобны тем, что используют трассы (дорожки, 

печатные проводники), изготавливаемые в том же технологическом процес-

се, что и трассы другого назначения (цепи питания, цифровые цепи и др.). 

К часто встречающимся понятиям из области устройств и элементов по-

лосковой линии можно отнести следующие: 

– полосковый узел (strip line junction) – устройство на полосковых лини-

ях, выполняющее одну или несколько радиотехнических функций (передача 

электромагнитной энергии, различные преобразования СВЧ-сигнала, генери-

рование электромагнитной энергии) и имеющее законченное конструктивное 

и схемное выполнение; 

– полосковый элемент (strip element) – конструктивно неделимая часть 

полоскового узла, являющаяся элементом с распределенными параметрами 

схемы Э3 полоскового узла; 

– полосковая плата (strip plate) – основание с нанесенными на его по-

верхности и (или) сформированными в его объеме проводящими и непрово-

дящими слоями, реализующими схему с полосковыми линиями; 

– основание полосковой платы (substrate strip plate) – элемент кон-

струкции полосковой платы, представляющий собой слой непроводящего 

материала, на поверхности и (или) в объеме которого формируется рисунок 

полосковой платы; 

– рисунок полосковой платы (pattern of the strip plate) – конфигурация 

проводящего и (или) непроводящего слоев, наносимых на основание полос-

ковой платы; 

– экран полосковой линии передачи (screen of the strip line) – проводя-

щий слой двух- или трехпроводной полосковой линии, ширина которого зна-

чительно превышает ширину других проводящих слоев. 
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Симметричные и несимметричные полосковые линии. Симметрич-

ные полосковые линии обладают следующими особенностями: 

– хорошая экранировка полоскового элемента, так как он заключен меж-

ду двумя экранами; 

– сложности в изготовлении и расчете, так как в конструкции практиче-

ски неизбежно присутствует невоспроизводимый воздушный справа и слева 

от полоскового элемента (искажения будут тем сильнее, чем больше диэлек-

трическая проницаемость материала). Кроме того, требуется соблюдение ме-

ханической симметрии для обеспечения малых потерь на излучение; 

– неудобства в настройке, так как полосковый элемент недоступен для 

регулирования. 

Несимметричные полосковые линии просты в настройке, изготовлении 

и эксплуатации, однако у них отсутствует экранировка и присутствуют по-

вышенные потери по сравнению с симметричными полосковыми линиями. 

Однако если диэлектрическая проницаемость основания высока, то электри-

ческое поле концентрируется в основном в области между полосковым эле-

ментом и экраном, а потому потери на излучение невелики. Такие несиммет-

ричные полосковые линии называют микрополосковыми линиями передачи 

(МПЛ). На практике для экранирования структуры на МПЛ размещают в 

герметизирующих корпусах, изолирующих их от внешних электромагнитных 

полей и климатических воздействий [21]. 

Так как при проектировании разрабатывается ДПП СВЧ-диапазона с вы-

сокими значениями относительной диэлектрической проницаемости, то далее 

будут рассматриваться только МПЛ. 

Основной тип волны в МПЛ. На рис. Б.30, а показано поперечное се-

чение МПЛ со следующими обозначениями: 

 

– W – ширина полоскового элемента, мм; 

– t – толщина полоскового элемента, мм; 

– h – высота основания полосковой платы, мм; 

а б 

Рис. Б.30 

E 

H 
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– 1r  – относительная диэлектрическая проницаемость среды над рисун-

ком полосковой платы; 

– 2r  – относительная диэлектрическая проницаемость основания по-

лосковой платы. 

При передаче энергии по МПЛ электромагнитное поле существует не 

только в основании, но и в воздухе. При этом появляются продольные со-

ставляющие векторов поля, т. е. по МПЛ в общем случае энергия переносит-

ся гибридными волнами. Однако при достаточно малых по сравнению с дли-

ной волны размерах поперечного сечения МПЛ для основной волны величи-

на продольных составляющих векторов поля оказывается на порядок меньше 

величины поперечных составляющих, и ими можно пренебречь. Поэтому 

приближенно можно считать, что структура основной волны в МПЛ (см. 

рис. Б.30, б), получившей название квази-TEM, совпадает со структурой 

TEM-волны. Волна квази-ТЕМ, как и ТЕМ-волна, может распространяться на 

любых частотах. 

Одномодовый режим работы МПЛ обеспечивается выбором поперечных 

размеров линии из условий: 

 2W  и 2h , (Б.1) 

где   – длина волны квази-ТЕМ в МПЛ, мм. 

Так как волна квази-ТЕМ переносит часть энергии в основании, а часть 

в воздухе, то ее фазовая скорость удовлетворяет неравенству: 

01эф02 11  , 

где 2  – диэлектрическая проницаемость среды между экраном и полоско-

вым элементом; 0  – магнитная постоянная, 7
0 104 −=  Гн/м; 1  – ди-

электрическая проницаемость среды над полосковым элементом. 

Чем больше энергии переносится в основании, тем ближе фазовая ско-

рость к скорости света в основании, и наоборот. При определении основных 

характеристик волн в линиях с поперечно неоднородным диэлектрическим 

заполнением вводят эффективную диэлектрическую проницаемость линии 

эф 0эф r=  (здесь 0  – электрическая постоянная, 12
0 1085,8 −=  Ф/м), 

связанную с фазовой скоростью волны следующим соотношением: 

0эфэф 1 = , 

причем 1эф 2 rrr   [26]. 



 

 695 

При rr = 2 , 11 =r  и 0=t  мм эффективная диэлектрическая проница-

емость для волны квази-ТЕМ в МПЛ определяется по формуле [22]: 

 

21

эф 
10

1
2

1

2

1
−









+

−
+

+
=

W

hrr
r . (Б.2) 

Из (Б.2) следует, что фазовая скорость волны квази-ТЕМ в МПЛ зависит 

не только от параметров заполняющего диэлектрика, но и от геометрических 

размеров линии: при увеличении W  и r  или уменьшении h  она уменьшает-

ся, так как увеличивается количество энергии, переносимой волной в основа-

нии полосковой платы. 

Потери в МПЛ. Ослабление сигнала в линии передач происходит в ос-

новном из-за потерь в проводниках и диэлектрике, из-за излучений и диспер-

сии (зависимости параметров волны квази-TEM от частоты). 

В проводниках потери в СВЧ-диапазоне в основном определяются ха-

рактеристиками их поверхностного слоя из-за скин-эффекта. 

Потери в диэлектрике возникают из-за тангенциальных потерь, обуслов-

ленных неспособностью зарядов мгновенно отслеживать изменения электри-

ческого поля. 

Кроме излучения из-за особенности распространения волны квази-TEM 

в МПЛ присутствуют и паразитные излучения вдоль длины линии и на неод-

нородностях (изгибы печатного проводника, разрывы, установленные навес-

ные компоненты и т. п.). 

Диэлектрические потери и потери на излучение в МПЛ могут быть сни-

жены за счет уменьшения толщины диэлектрического слоя, применения вы-

сококачественных диэлектриков и правильного проектирования ПП. 

Длина волны квази-TEM в МПЛ. Длина волны квази-ТЕМ (в милли-

метрах) в МПЛ рассчитывается по формуле для ТЕМ-волны путем замены r  

на эф r  и на частоте f  (в герцах) определяется выражением: 

 ( )эф 
11

эф
3 103101 rff == . (Б.3) 

Ширина полоскового элемента МПЛ. Определение ширины полоско-

вого элемента МПЛ ( 0=t  мм) начинается с расчета следующего параметра: 
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где 0Z  – волновое сопротивление, Ом. 
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В зависимости от полученного значения производится расчет ширины 

полоскового элемента (в миллиметрах): 

1. Если параметр 52,1A , то используется следующая формула: 

 
( )

( ) 22exp

exp8

−


=

A

Ah
W . (Б.5) 

2. Если параметр 52,1A , то используется следующая формула: 
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где параметр B  определяется выражением: 
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В. Используемые при проектировании компоненты 

и некоторые схемные решения 

В.1. Постоянный SMD-резистор 

Резистор по ГОСТ Р 52002–2003 [113] – элемент электрической цепи, 

предназначенный для использования его электрического сопротивления. 

Буквенный код обозначения резистора по ГОСТ 2.710–81 – R. Основная 

характеристика – сопротивление. Единица измерения – ом. 

На рис. В.1, а показан внешний вид SMD-резистора, а на рис. В.1, б – 

УГО резистора по ГОСТ 2.728–74. 

Назначение резистора состоит в оказании 

сопротивления протекающему через него элек-

трическому току, преобразовывая его часть в 

тепло. Аналогия с водой: если проводник с то-

ком представить в виде трубы, по которой течет вода, то резистор можно 

сравнить с сужением трубы, ток – со скоростью движения воды, а напряже-

ние – с разностью давлений в разных точках трубы. 

Некоторые применения постоянного резистора в схемах: 

1. Токоограничивающий резистор (примеры приведены в В.6 и В.7). 

2. Элемент фильтра (например, RC-фильтры верхних и нижних частот). 

3. Задание коэффициента усиления операционного усилителя. 

4. Подтягивание к земле (pull-down) или к питанию (pull-up). Такие ре-

зисторы используют в цифровых схемах для исключения состояния неопре-

деленности на выводах микросхем. 

5. Резистивный делитель напряжения (рис. В.2). В 

этой схеме из двух резисторов (R1 и R2) выходное напря-

жение ( выхU ), получаемое из входного ( вхU ), определя-

ется по формуле: 

R2R1

R2
UU

+
= вхвых . 

Схема обладает следующими особенностями [114]: 

– для корректной работы схемы номиналы резисто-

ров должны быть много меньше (на несколько порядков), 

чем сопротивление подключаемой нагрузки. В противном 

случае из-за параллельного включения с резистором R2 нагрузка уменьшит 

величину выходного напряжения; 

R1 

R2 

Uвх 

Uвых 

Рис. В.2 

Рис. В.1 

а б 
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– чем меньше номиналы резисторов в резистивном делителе, тем больше 

энергии расходуется впустую, так как через них протекают большие токи. 

При этом резисторы необходимо выбирать такими, чтобы они могли рассеять 

необходимую мощность; 

– неравномерность тока нагрузки во времени приводит к неравномерно-

сти выходного напряжения (чем больший ток уходит в нагрузку, тем мень-

ший ток протекает через резистор R2, и тем меньшее напряжение с него сни-

мается). 

 

Упрощенный вид конструкции SMD-резистора показан на рис. В.3. 

Основным несущим элементом SMD-резистора является подложка, из-

готовленная из окиси алюминия. Этот материал обладает хорошими диэлек-

трическими свойствами и высокой теплопроводностью, что необходимо для 

отвода тепла, выделяющегося в резистивном слое. 

Основные электрические характеристики SMD-резистора определяются 

резистивным слоем, в качестве которого чаще всего используется пленка ме-

талла или окисла, например чистого хрома или двуокиси рутения, нанесенная 

на подложку. Состав, технология нанесения и характер обработки этой плен-

ки являются важнейшими элементами, определяющими характеристики ре-

зистора, и чаще всего представляют производственный секрет фирмы произ-

водителя. 

Для соединения резистивного слоя с проводниками на ПП служат не-

сколько слоев контактных элементов. Такая сложная контактная конструкция 

предназначена для обеспечения надежной адгезии слоев. От качества выпол-

нения контактных элементов SMD-резистора зависят такие его характери-

стики, как надежность и токовые шумы. 

Последним элементом конструкции SMD-резистора является защитный 

слой, обеспечивающий предохранение от воздействия факторов окружающей 

среды (например, влаги). Этот слой выполняется из стекла или полимерных 

материалов. 

Керамическая подложка 

Внешний вывод 

Внутренний электрод 

Резистивный слой 

Защитный слой 

Рис. В.3 



 

 699 

Кроме сопротивления резистивного слоя, SMD-резистор обладает рядом 

паразитных параметров: 

– емкости выводов относительно общего провода; 

– емкость между выводами; 

– сопротивление контактов; 

– сопротивление защитного слоя; 

– индуктивность выводов и резистивного слоя. 

Наиболее вредным параметром является паразитная индуктивность. Не-

много меньшее значение играет паразитная емкость. Оба этих параметра 

ограничивают максимальную частоту применения SMD-резистора [115]. 

При проектировании используются резисторы серии RC типоразмеров 

0805 (RC0805), 0603 (RC0603) и 0402 (RC0402) фирмы Yageo с максималь-

ной рассеиваемой мощностью 0,125, 0,1 и 0,0625 Вт соответственно. 

Документация на резисторы находится в папке …\ИДРЭС\Компонен-

ты\Резисторы Yageo. 

В табл. В.1 приведены размеры (длина и ширина) некоторых стандарт-

ных типоразмеров. 

Таблица В.1 

Габаритные размеры некоторых типоразмеров 

Обозначение типоразмера Размеры, дюйм Размеры, мм 

0402 0,04 × 0,02 1,0 × 0,50 

0603 0,06 × 0,03 1,6 × 0,80 

0805 0,08 × 0,05 2,0 × 1,25 

1206 0,12 × 0,06 3,2 × 1,60 

1210 0,12 × 0,10 3,2 × 2,60 

Производителем каждому компоненту для идентификации присваивает-

ся уникальный номер (Part Number, Part No), в котором содержится характер-

ная для этого компонента информация. Например, RC0805JR-07270RL: 

– RC – серия толстопленочных SMD-резисторов фирмы Yageo; 

– 0805 – типоразмер; 

– J – допуск номинала (±5 %); 

– R – резисторы в бумажной ленте; 

– «-» – ТКС. Температурный коэффициент сопротивления (ТКС) – 

величина, равная относительному изменению электрического сопротивления 

при изменении температуры на единицу (градус Цельсия или Кельвина); 

– 07 – диаметр ленточной катушки (7 дюймов); 
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– 270R – номинал резистора (270 Ом). При записи номинала в омах ис-

пользуется символ R, в килоомах – символ K, в мегаомах – символ M. Они 

же используются и для дробных номиналов (например, 5R6 – 5,6 Ом; 56R – 

56 Ом; 560R – 560 Ом; 5K6 – 5,6 кОм; 56K – 56 кОм; 22M – 22 МОм); 

– L – без свинца. 

Фрагмент ленты с SMD-резисторами показан на рис. В.4. 

Международной электротехнической комиссией (МЭК) установлено 

семь предпочтительных рядов для номиналов большинства выпускаемых ра-

диоэлектронной промышленностью элементов (как отечественной, так и за-

рубежной): Е3; Е6; Е12; Е24; Е48; Е96; Е192. Цифра после 

буквы Е – число номиналов в каждом десятичном интервале 

(декаде). 

Каждый ряд имеет свой допуск номиналов, например: 

– ряд Е6 – ±20 %; 

– ряд Е12 – ±10 %; 

– ряд Е24 – ±5 %; 

– ряд E48 – ±2 %; 

– ряд E96 – ±1 %. 

В производстве чаще используются ряды E24 и E96. 

Значения рядов содержатся в ГОСТ 28884–90 [116] и для Е3, Е6, Е12 и 

Е24 приведены в табл. В.2, а для Е48 и Е96 – в табл. И.1. 

Таблица В.2 

Значения номинальных рядов Е3, Е6, Е12 и Е24 

E3 E6 E12 E24 E3 E6 E12 E24 E3 E6 E12 E24 E3 E6 E12 E24 

1,0 1,0 1,0 1,0 – – 1,8 1,8 – 3,3 3,3 3,3 – – 5,6 5,6 

– – – 1,1 – – – 2,0 – – – 3,6 – – – 6,2 

– – 1,2 1,2 2,2 2,2 2,2 2,2 – – 3,9 3,9 – 6,8 6,8 6,8 

– – – 1,3 – – – 2,4 – – – 4,3 – – – 7,8 

– 1,5 1,5 1,5 – – 2,7 2,7 4,7 4,7 4,7 4,7 – – 8,2 8,2 

– – – 1,6 – – – 3,0 – – – 5,1 – – – 9,1 

Существующие номиналы компонентов получаются путем умножения 

или деления указанных в рядах значений на i10 , где i – целое число. Напри-

мер, для значения 1,0 есть следующие номиналы резисторов: 0,1 Ом; 1 Ом; 

10 Ом; 100 Ом; 1 кОм; 10 кОм и т. д. 

Номинал резистора часто указывается в виде маркировки на его корпусе. 

К примерам вариантов маркировки можно отнести следующие: 

Рис. В.4 
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– без маркировки. Не маркируются резисторы в корпусах типоразмеров 

0402 и меньше, но не только. Например, фирма Yageo с целью повышения 

экологичности выпускаемой продукции (снижение использования химиче-

ских веществ на производстве) с середины 2013 г. убрала маркировку с 

SMD-резисторов серий RC и AC типоразмеров 0603, 0805 и 1206; 

– три цифры, где первые две – значащие, а последняя – количество ну-

лей после первых двух (например, маркировка 102 на рис. В.1, а означает 

1000 Ом, т. е. 1 кОм). Таким образом обычно маркируются резисторы с до-

пуском ±2 % и больше. В качестве разделителя в дробном значении сопро-

тивления менее 10 Ом используется символ R (например, 2R2 – 2,2 Ом); 

– четыре цифры, где первые три – значащие, а последняя – количество 

нулей после первых трех (например, 1002 – 10 кОм). Таким образом обычно 

маркируются резисторы с допуском ±1 % типоразмеров 0805 и больше. Сим-

вол R также может использоваться; 

– две цифры и буква, где цифры указывают на код номинала по стандар-

ту EIA-96, а буква определяет множитель. Например, 12C – 13 кОм (12 – 12-й 

номинал в ряде E96, C – множитель, равный 100). Таким образом обычно 

маркируются резисторы с допуском ±1 % типоразмера 0603. 

Также возможны и другие варианты маркировки, которые определяются 

конкретным производителем и указываются им в документации на изделие. 

В.2. Постоянный SMD-конденсатор 

Конденсатор по ГОСТ Р 52002–2003 – элемент электрической цепи, 

предназначенный для использования его электрической емкости. 

Буквенный код обозначения конденсатора по ГОСТ 2.710–81 – С. Ос-

новная характеристика – емкость. Единица измерения – фарад. 

Конденсаторы – это радиоэлементы, способные накапливать электриче-

ский заряд. К тому же они способны пропускать переменный ток, одновре-

менно не пропуская постоянный. В цепи постоянного тока конденсатор не 

проводит ток, так как его обкладки разделены диэлектриком; а в цепи пере-

менного тока он проводит колебания переменного тока посредством цикли-

ческой перезарядки [117]. Аналогия с водой: конденсатор можно представить 

полостью в трубе, которая перегорожена гибкой мембраной. 

Простейший плоский конденсатор представляет собой параллельные 

металлические пластины (обкладки), разделенные диэлектриком, емкость ко-

торого определяется по формуле: 
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dSC r= 0 , 

где S  – площадь пластины, м2, d  – расстояние между пластинами, м. 

Например, до моделирования различных структур на МПЛ при наличии 

фольгированного диэлектрика, на котором они будут изготавливаться, по 

указанной формуле можно уточнить значение относительной диэлектриче-

ской проницаемости материала, тем самым значительно уменьшив влияние 

разброса данного параметра на их характеристики в готовом изделии. 

Самые распространенные типы SMD-конденсаторов: керамический и 

электролитический. 

На рис. В.5, а показан внешний вид керамического SMD-конденсатора, а 

на рис. В.5, б – УГО для такого конденсатора по ГОСТ 2.728–74. 

Керамические конденсаторы меньше 

электролитических по размеру и обычно 

имеют емкость до единиц микрофарад. 

Конструктивно они представляют собой 

параллельное соединение плоских конден-

саторов, нанесенных на керамическую 

подложку (рис. В.5, в), что позволяет уве-

личивать емкость, не увеличивая при этом 

площадь, занимаемую на ПП. 

Увеличение емкости в заданных раз-

мерах корпуса (по габаритам, кроме высо-

ты, они совпадают с типоразмерами рези-

сторов, приведенными в табл. В.1) в виде 

параллельного соединения конденсаторов приводит к технологическому пре-

делу уменьшения толщины диэлектрика и увеличения площади обкладок. 

Дальнейшее увеличение емкости (до величины порядка нескольких тысяч 

пикофарад) возможно только увеличением диэлектрической проницаемости 

диэлектрика [118]. 

Электролитические SMD-конденсаторы имеют емкости от 100 пФ. По 

размерам они больше керамических и к тому же работают только при соблю-

дении полярности подаваемого напряжения. Обусловлено это химическими 

особенностями взаимодействия электролита с диэлектриком. При обратной 

полярности напряжения происходит химическое разрушение диэлектрика, 

увеличение тока, вскипание электролита и вероятный разрыв корпуса [117]. 

В основном электролитические SMD-конденсаторы реализуются как танта-

Рис. В.5 

а б 

Контактный 

электрод 

Внутренний 

электрод 

Керамический 

диэлектрик 

в 
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ловые конденсаторы, немного реже – как полимерные. Внешний вид танта-

лового SMD-конденсатора показан на рис. 5.12, а УГО такого конденсатора – 

на рис. 5.34, а и б. 

Твердотельные танталовые конденсаторы состоят из четырех основных 

частей: анода, диэлектрика, электролита (жидкого или твердого) и катода 

(рис. В.6). В качестве диэлектрика выступает пленка, сформированная на по-

верхности анода при помощи электрохимического окисления. Только при 

использовании тантала (или алюминия) в качестве анода удается технологи-

чески контролировать ее толщину (как правило, от нескольких сотен до не-

скольких тысяч ангстрем) [119]. 

 

Некоторые применения конденсаторов в схемах: 

1. Элемент фильтра. 

2. Блокировочный конденсатор (bypass cap). Такой конденсатор сглажи-

вает пульсации питания, а также кратковременно выполняет функцию ре-

зервного источника питания в те моменты времени, когда напряжение на ли-

нии падает. Устанавливается как можно ближе к выводам микросхем между 

цепью питания и землей. Для сглаживания высокочастотных помех обычно 

используются керамические конденсаторы номиналом 0,01 или 0,1 мкФ, а 

для низкочастотных (до десятков килогерц) – танталовые конденсаторы 

большой емкости (во внутренних цепях питания – около 10–100 мкФ, для 

входного питания – из расчета 1000 мкФ на 1 А) [120]. 

3. Разделительный конденсатор. Предназначен для отделения перемен-

ной составляющих сигнала от постоянной. Устанавливается в разрыв линии. 

Подробнее стоит остановиться на паразитных параметрах конденсатора 

и их влиянии на его рабочие характеристики [121]. Упрощенная эквивалент-

ная схема реального конденсатора показана на рис. В.7. 

Рис. В.6 

Метка анода 

Вывод анода  

для пайки 

Вывод катода 

для пайки 

Серебряный 

адгезив 

Электролит, покрытый 

графитом и серебром 

Компаунд 

Гранулированный танталовый 

анод, покрытый диэлектриком 

(оксид тантала) 
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На рисунке отмечены следующие элементы: 

– 0C  – идеальный конденсатор без по-

терь, потребляющий от сети только реак-

тивную мощность; 

– SR  – эквивалентное последователь-

ное сопротивление (Equivalent Serial Resistor, ESR) реального конденсатора, 

потребляющего из сети активную мощность. Обусловлено потерями в ди-

электрике и сопротивлением выводов. На частотах до нескольких сотен ки-

логерц преобладает первый фактор, а на частотах свыше 1 МГц – второй. Эта 

величина также зависит от типоразмера и емкости и обычно лежит в диапа-

зоне от 0,02 Ом на низких частотах до 0,5 Ом на высоких; 

– SL  – эквивалентная последовательная индуктивность (Equivalent Serial 

Inductance, ESI) реального конденсатора. В основном определяется индук-

тивностью его выводов и зависит от типоразмера. Например, для типоразме-

ра 0603 эта величина обычно принимает значения от 0,54 до 1,95 нГн, для 

типоразмера 0805 – от 0,7 до 1,94 нГн. 

В результате величина полного сопротивления реального конденсатора 

(модуль импеданса) определяется из соотношения: 

 ( ) 2
0

222 )212()( fCfLRXXRfZ SSCLSC −+=−+= ,  

где LX  – реактивное индуктивное сопротивление, Ом; CX  – реактивное ем-

костное сопротивление, Ом; f – частота, Гц. 

При равенстве LX  и CX  наступает последовательный резонанс. Частота 

SRF , при которой это происходит, вычисляется по формуле: 

 021 CLF SSR = . (В.1) 

График зависимости модуля импеданса реального конденсатора от ча-

стоты в логарифмическом масштабе по двум осям показан на рис. В.8. 

Отличия реального конденсатора от идеального накладывают опреде-

ленные ограничения на его применение. В особенности это касается филь-

тров и LC-контуров на высоких частотах, где необходимо учитывать влияние 

паразитных параметров (например, на частотах, превышающих резонансную 

частоту SRF , конденсатор ведет себя как индуктивность). 

В разделительных цепях главной задачей является минимизация модуля 

импеданса конденсатора в полосе рабочих частот. Если исходить из свойств 

идеального конденсатора, модуль импеданса которого определяется выраже-

Рис. В.7 

С0 LS RS 
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нием 021 fC , то для его уменьшения необходимо использовать конденсатор 

с большой емкостью. Однако при увеличении емкости в соответствии с (В.1) 

уменьшается резонансная частота, и если она окажется меньше рабочей ча-

стоты, то это приведет к увеличению модуля импеданса конденсатора и 

ухудшению частотных характеристик устройства. 

 

При параллельном включении нескольких конденсаторов одинаковой 

емкости ширина области минимального значения модуля импеданса увели-

чится в область низких частот с незначительным уменьшением резонансной 

частоты, так как в таком случае из-за способа включения конденсаторов эк-

вивалентная емкость увеличивается, а паразитные сопротивления и индук-

тивности уменьшаются, но в меньшее количество раз (конденсаторы не 

находятся в одной точке на ПП, и поэтому паразитные индуктивности за счет 

разных длин печатных проводников оказываются разными). 

Применение параллельного включения разделительных конденсаторов в 

линиях на ПП не совсем удобно, поэтому обычно стараются выбрать конден-

сатор с такой емкостью, чтобы на рабочих частотах величина его модуля им-

педанса была не слишком большой (до единиц ом). 

При параллельном включении нескольких конденсаторов с емкостями, 

отличающимися на порядки (такое решение обычно применяется при под-

ключении блокировочных конденсаторах по питанию), происходит расшире-

ние области минимального значения модуля импеданса, но с появлением в 

ней локальных мест с относительно высокими его значениями, что связано с 

возникновением параллельных резонансов между резонансными частотами 

отдельных конденсаторов [122]. 

При проектировании используются керамические конденсаторы фирм 

Murata и ATC и танталовые фирмы Vishay. 

Рис. В.8 
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Документация на конденсаторы находится в папке …\ИДРЭС\Компо-

ненты\Конденсаторы. 

В качестве примера керамического конденсатора фирмы Murata можно 

рассмотреть GRM2165C2A102JA01D: 

– GRM – компонент общего назначения; 

– 21 – типоразмер 0805 (см. табл. В.1); 

– 6 – высота корпуса компонента (0,6 мм); 

– 5С – группа ТКЕ (C0G). Температурный коэффициент емкости 

(ТКЕ) – величина, равная относительному изменению емкости при измене-

нии температуры окружающей среды на один градус Цельсия. C0G – самая 

высокая температурная стабильность, практически полное отсутствие зави-

симости емкости от частоты и приложенного напряжения; 

– 2A – номинальное напряжение (100 В); 

– 102 – емкость в пикофарадах (1000 пФ). Первые две цифры – знача-

щие, а третья – количество нулей после первых двух. В качестве символа 

разделителя в дробном значении используется символ R. Например: R50 – 

0,5 пФ, 1R0 – 1 пФ, 100 – 10 пФ, 103 – 10000 пФ; 

– J – допуск номинала (±5 %); 

– A01 – дополнительные данные; 

– D – тип упаковки (бумажная лента диаметром 180 мм); 

В качестве примера керамического конденсатора фирмы ATC можно 

рассмотреть 600F240KT250XT: 

– 600F – серия конденсаторов фирмы ATC; 

– F – типоразмер 0805 (см. табл. В.1); 

– 240 – емкость в пикофарадах (24 пФ). Расшифровка кода производится 

так же, как и для рассмотренного выше керамического конденсатора; 

– K – допуск номинала (±10 %); 

– T – покрытие контактов (стандартное); 

– 250 – номинальное напряжение (250 В); 

– X – указание о маркировке; 

– T – упаковка (стандартная). 

В качестве примера танталового конденсатора фирмы Vishay можно 

рассмотреть 293D226X9010C2TE3: 

– 293D – серия конденсатора; 

– 226 – емкость в пикофарадах (22 мкФ). Расшифровка кода производит-

ся так же, как и для керамических конденсаторов; 
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– X9 – допуск номинала (±10 %); 

– 010 – величина постоянного напряжения в вольтах (+10 В). Для записи 

дробных значений используется символ R (например, 6R3 – 6,3 В); 

– C – типоразмер (размеры корпусов см. на рис. 5.13); 

– 2TE3 – код упаковки (катушка диаметром 7 дюймов) и выводов (мато-

вое олово). Внешний вид упаковки показан на рис. В.9. 

В.3. SMD-катушки индуктивности 

Индуктивная катушка по ГОСТ Р 52002–2003 – элемент электриче-

ской цепи, предназначенный для использования его собственной индуктив-

ности и/или его магнитного поля. 

Буквенный код обозначения катушки индуктивности по ГОСТ 2.710–

81 – L. Основная характеристика – индуктивность. Единица измерения – ген-

ри. 

Катушки индуктивности – это радиоэлементы, способные формировать 

магнитное поле. К тому же они способны пропускать постоянный ток, одно-

временно не пропуская переменный. В цепи постоянного тока катушка ин-

дуктивности проводит ток, так как является проводом, намотанным на кар-

кас; а в цепи переменного тока она не пропускает колебания переменного то-

ка из-за явления самоиндукции, так как ЭДС (электродвижущая сила) само-

индукции компенсирует внешнее переменное магнитное поле, которое ее вы-

зывает. Гидромоделью катушки индуктивности может служить турбина с 

инерцией, расположенная в трубе с водой. 

Некоторые применения катушек индуктивности в схемах: 

1. Элемент фильтра. 

Рис. В.9 
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2. Элемент колебательного контура. 

3. Фильтрация помех напряжения питания. 

Простейшая индуктивность представляет собой несколько витков изо-

лированного провода, расположенных в непосредственной близости друг от 

друга. На рис. В.10, а показан внешний вид такой катушки индуктивности, а 

на рис. В.10, б – ее УГО по ГОСТ 2.723–68. 

Для многократного увеличения индук-

тивности внутрь катушки индуктивности 

помещают сердечник из ферромагнитного 

материала (трансформаторная сталь, перм-

аллой и др.). На рис. В.10, в показан внеш-

ний вид такой катушки индуктивности, а на 

рис. В.10, г – ее УГО по ГОСТ 2.723–68. 

Катушка индуктивности, обладающая 

высоким сопротивлением переменному то-

ку и малым сопротивлением постоянному, 

называется дросселем и используется для 

3-го применения, указанного выше. 

Упрощенная эквивалентная схема реальной катушки индуктивности со-

стоит из двух ветвей, в одной из которых находится паразитная емкость, обу-

словленная межвитковой емкостной связью, а в другой – последовательное 

соединение индуктивности идеальной катушки и сопротивления потерь в 

проводе [123]. 

При равенстве реактивных индуктивного и емкостного сопротивлений 

наступает параллельный резонанс, и наблюдается максимальная величина 

модуля импеданса. Как только рабочая частота превысит резонансную по 

(В.1), катушка индуктивности начнет проявлять свойства конденсатора. 

При проектировании используется дроссель SDR0604-220YL фирмы 

Bourns, документация на который находится в папке …\ИДРЭС\Компо-

ненты\Индуктивности. 

Содержание указанного Part Number следующее: 

– SDR0604 – серия силовых SMD-индуктивностей (дросселей, рассчи-

танных на большие токи) с диаметром корпуса 5,8 мм и высотой 4,8 мм; 

– 220 – индуктивность в микрогенри (22 мкГн). Расшифровка кода про-

изводится так же, как и для керамических конденсаторов; 

– Y – допуск номинала (±15 %); 

Рис. В.10 

а б 

в г 
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– L – материал выводов не содержит свинца (Lead-free terminations). Та-

кое требование связано с директивой Европейского союза по экологической 

безопасности RoHS (Restriction of Hazardous Substance), ограничивающей ис-

пользование опасных веществ. 

В.4. Полупроводниковый диод 

Полупроводниковый диод (диод, semiconductor diode) по ГОСТ Р 57436–

2017 [124] – полупроводниковый прибор (устройство, основные электриче-

ские характеристики которого обусловлены потоком носителей зарядов 

внутри одного или более полупроводниковых материалов) с двумя выводами, 

имеющий несимметричную вольт-амперную характеристику (ВАХ). 

Буквенный код обозначения диода по ГОСТ 2.710–81 – VD. 

Гидромоделью диода служит обратный клапан. 

На рис. В.11, а показан внешний вид выводного диода в корпусе DO-41 

(также диод может быть выполнен и в SMD-варианте), на рис. В.11, б – 

упрощенный вид конструкции диода в таком корпусе, а на рис. В.11, в – его 

УГО по ГОСТ 2.730–73 с обозначением названий выводов. 

 

В отличие от металлов появление носителей заряда в полупроводниках 

определяется многими факторами, но наиболее важные – чистота и темпера-

тура. Типичными полупроводниками являются германий и кремний. 

Полупроводники делятся на химически чистые (собственные) и примес-

ные (легированные). 

В собственных полупроводниках при температурах выше абсолютного 

нуля из-за теплового возбуждения есть свободные электроны (носители от-

рицательного заряда) и дырки (носители положительного заряда) в одинако-

вом количестве, т. е. кристалл остается электрически нейтральным. С повы-

шением температуры собственная проводимость увеличивается. 

Рис. В.11 

а в 

Катод 

Анод 

б 

Вывод Припой 

Корпус Кристалл Маркировка 

катода 
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Проводимость собственного полупроводника можно значительно увели-

чить, введя в него примеси, которые бывают донорные и акцепторные. 

Донорная примесь – это примесь, у которой валентность больше, чем у 

исходного кристалла. Например, при добавлении мышьяка (валентность – 5) 

в кремний (валентность – 4) от каждого атома примеси образуется дополни-

тельный подвижный электрон и неподвижный положительный заряд (иони-

зированный атом). То есть донорная примесь создает подвижные электроны 

без дырок. Такой полупроводник называется полупроводником n-типа. 

Акцепторная примесь – это примесь, у которой валентность меньше, 

чем у исходного кристалла. Например, при добавлении индия (валентность – 

3) в кремний от каждого атома примеси образуется дополнительная подвиж-

ная дырка и неподвижный отрицательный заряд. Такой полупроводник назы-

вается полупроводником p-типа. 

Число подвижных носителей тока, создаваемых примесями даже при 

малых концентрациях, значительно превосходит число собственных носите-

лей. Преобладающий тип носителей называют основным, а другой – неос-

новным. Примесные полупроводники также электрически нейтральны. 

При контакте полупроводников p- и n-типа образуется p-n-переход. В 

результате диффузионного тока основных носителей заряда (переход дырок 

из p-области в n-область, а электронов – из n-области в p-область), вызванно-

го разностью их концентраций, электроны и дырки рекомбинируют на гра-

нице полупроводников, образуя обедненный основными носителями запира-

ющий электрический слой с нескомпенсированными зарядами ионов приме-

сей: плюс – в n-области, минус – в p-области. Между разноименно заряжен-

ными областями запирающего слоя возникает контактная разность потенциа-

лов и электрическое поле, вызываю-

щее появление дрейфового тока неос-

новных носителей заряда в направле-

нии, противоположном диффузион-

ному току. В результате величина по-

тока основных носителей заряда 

уменьшается до величины потока не-

основных носителей и устанавливает-

ся состояние динамического равнове-

сия p-n-перехода, схематично пока-

занное на рис. В.12 [125], [126]. Рис. В.12 

Электрическое поле 

запирающего слоя 

Запирающий слой 

– ионизированные атомы примесей 

– свободные электроны 

– свободные дырки 
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В диоде используется один p-n-переход, к противоположным областям 

которого привариваются или припаиваются металлические выводы, и вся си-

стема заключается в металлический, металлокерамический, стеклянный или 

пластмассовый корпус [127]. Вывод диода, соединенный с p-областью, назы-

вается анодом, а вывод, соединенный с n-областью, – катодом. Обычно ка-

тод маркируется на корпусе белой полосой, хотя бывают и исключения. 

Если к диоду приложено прямое напряжение (на аноде потенциал боль-

ше, чем на катоде), то внешнее электрическое поле оказывается направлено 

противоположно электрическому полю запирающего слоя p-n-перехода, что 

приводит к уменьшению его толщины и сопротивления. В результате число 

основных носителей, способных преодолеть p-n-переход увеличивается. Ко-

гда напряжение смещения превысит контактную разность потенциалов (для 

кремниевого диода – 0,6–0,7 В), запирающий слой исчезнет (его сопротивле-

ние станет равным нулю), приложенная разность потенциалов окажется рас-

пределенной по всей длине кристалла, а так как его сопротивление мало, то 

суммарный ток, протекающий через диод и обусловленный в основном диф-

фузионным током, начнет резко возрастать. 

Если к диоду приложено обратное напряжение, то внешнее электриче-

ское поле оказывается сонаправлено с электрическим полем запирающего 

слоя p-n-перехода, что приводит к увеличению его толщины и сопротивления 

(основные носители заряда отходят от границы полупроводников). При этом 

через p-n-переход будет протекать обратный ток, который с незначительных 

значений обратного напряжения обу-

славливается только неосновными но-

сителями заряда (дрейфовый ток). Он 

достаточно мал, почти не зависит от 

приложенного обратного напряжения 

(до некоторого предела), определяется 

в основном условиями перехода неос-

новных носителей из объема полу-

проводника к границе раздела и про-

цессом их тепловой генерации и 

называется обратным током насы-

щения [126]. 

На рис. В.13 показана ВАХ диода 

со следующими обозначениями: Рис. В.13 
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– 1 – прямая ветвь ВАХ; 

– 2 – обратная ветвь ВАХ; 

– 3 – область пробоя; 

– 4 – прямолинейная аппроксимация прямой ветви ВАХ; 

– прI  и обрI  – постоянный прямой и обратный ток диода; 

– прU  и обрU  – постоянное прямое и обратное напряжение диода; 

– порU  – пороговое напряжение (прямое напряжения в точке пересече-

ния с осью напряжений линии, аппроксимирующей прямую ветвь ВАХ в об-

ласти больших токов); 

– динr  – динамическое сопротивление (сопротивление, определяемое 

наклоном прямой, аппроксимирующей прямую ветвь ВАХ диода); 

– пробU  – пробивное напряжение (обратное напряжение, вызывающее 

пробой перехода диода, при котором обратный ток достигает заданного зна-

чения) [128]. 

Математическая модель p-n-перехода описывается уравнением: 

 












−










−
= 1exp

тUm

rIU
II s
S , (В.2) 

где I  – суммарный ток, протекающий через p-n-переход, А; SI  – обратный 

ток насыщенного p-n-перехода, А; U  – напряжение, приложенное к p-n-

переходу, В; sr  – последовательное сопротивление потерь диода (суммарное 

объемное сопротивление p- и n-области, сопротивление контактных соедине-

ний и выводов p-n-перехода), Ом; m  – коэффициент неидеальности ВАХ; 

тU  – температурный потенциал при температуре 25 °C, 026,0т U  В [129]. 

Параметры математической модели диода (m , sr , SI ) могут быть 

найдены по экспериментальной ВАХ [130]. 

Пример диода и необходимые при проектировании схемные решения 

приведены в В.11. 

В.5. Диод Шоттки 

Диод Шоттки (Schottky barrier diode) по ГОСТ Р 57436–2017 – полу-

проводниковый диод, выпрямительные свойства которого обоснованы созда-

нием выпрямляющего слоя (барьера) на границе металла и полупроводника. 

На рис. В.14, а показан внешний вид диода Шоттки в корпусе SMB (DO-

214AA), а на рис. В.14, б – его УГО по ГОСТ 2.730–73. 
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 Потенциальный барьер, возникающий 

между металлом и полупроводником p- или 

n-типа называется барьером Шоттки в честь 

немецкого физика Вальтера Шоттки. 

Процессы, протекающие на границе раз-

дела данных материалов, схожи с описанны-

ми для p-n-перехода в В.4. Например, при 

контакте металла и полупроводника p-типа со стороны полупроводника ока-

жется область с отрицательно заряженными ионами акцепторной примеси 

(они будут нескомпенсированы зарядами дырок, которые рекомбинировали с 

электронами, пришедшими из металла), а со стороны металла – тонкий слой, 

заряженный положительно (из-за ухода из него электронов) [131]. 

Достоинства диодов Шоттки: 

– низкое падение напряжения при прямом включении (0,2–0,4 В против 

0,7 В у кремниевых диодов). Однако такие значения достигаются у диодов 

Шоттки с максимальным обратным напряжением порядка десятка вольт. При 

больших обратных напряжениях прямое падение напряжения становится 

сравнимым с аналогичным параметром кремниевых диодов, что ограничива-

ет применение диодов Шоттки низковольтными цепями; 

– барьер Шоттки имеет меньшую электрическую емкость перехода, что 

позволяет заметно повысить рабочую частоту. Это свойство используется в 

интегральных микросхемах, где диодами Шоттки шунтируются переходы 

транзисторов, которые применяются в качестве логических элементов; 

– низкий уровень помех, поэтому они предпочтительны в аналоговых 

вторичных источниках питания. 

Недостатки диодов Шоттки: 

– при кратковременном превышении максимального обратного напря-

жения диод Шоттки необратимо выходит из строя, в отличие от кремниевых 

диодов, переходящих в режим обратимого пробоя (при условии, что рассеи-

ваемая кристаллом диода мощность не превышает допустимых значений); 

– повышенные (относительно кремниевых диодов) обратные токи, воз-

растающие с ростом температуры кристалла. Неудовлетворительные условия 

теплоотвода при работе диода Шоттки с высокими токами приводят к его 

тепловому пробою [132]. 

Пример диода Шоттки и необходимые при проектировании схемные 

решения приведены в В.11.  

Рис. В.14 

а б 
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В.6. Стабилитрон 

Полупроводниковый стабилитрон (стабилитрон, voltage reference 

diode) по ГОСТ Р 57436–2017 – полупроводниковый диод, напряжение на ко-

тором сохраняется с определенной точностью при протекании через него то-

ка в заданном диапазоне, и предназначенный для стабилизации напряжения. 

Стабилитрон работает на обратной ветви ВАХ в режиме электрического 

пробоя, поэтому к нему должно быть приложено обратное напряжение. 

Пробой бывает электрический (лавинный и туннельный) и тепловой. 

Электрический пробой не приводит к разрушению p-n-перехода и, если за 

ним не последует теплового пробоя, свойства p-n-перехода после снятия об-

ратного напряжения восстанавливаются. 

Лавинный пробой обычно наблюдается при обратных напряжениях 

смещения порядка десятков или сотен вольт и связан с тем, что неосновные 

носители, ускоряясь в поле p-n-перехода, приобретают энергию, достаточ-

ную для ионизации нейтральных атомов полупроводника в p-n-переходе. 

Туннельный пробой наблюдается в тонких p-n-переходах (могут быть 

созданы только на границе раздела высоколегированных областей) при об-

ратных напряжениях всего в несколько вольт и связан с тем, что под дей-

ствием сильного электрического поля на атомы кристаллической решетки 

полупроводника в p-n-переходе происходит образование электронно-дыроч-

ных пар. Нарастание тока при туннельном пробое происходит быстрее, чем 

при лавинном пробое. 

Тепловой пробой возникает в случае, когда количество тепла, выделя-

ющееся в p-n-переходе, превышает количество тепла, отводимого от него. 

Разогрев p-n-перехода приводит к росту процесса 

генерации носителей и, следовательно, к увеличе-

нию силы тока, что в свою очередь ведет к даль-

нейшему повышению температуры и так далее. В 

результате наступает разрушение материала полу-

проводника [126]. 

Участок на ВАХ (рис. В.15) от точки 1 до точ-

ки 2 является рабочим участком стабилизации, при 

этом напряжение на стабилитроне, называемое 

напряжением стабилизации (UСТ), можно счи-

тать постоянным (его изменения незначительны). Рис. В.15 
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Минимальный ток стабилизации (IСТmin) – наименьший ток через 

стабилитрон, при котором начинается устойчивая работа в режиме пробоя. 

Максимальный ток стабилизации (IСТmax) – наибольший ток через 

стабилитрон, при котором температура его p-n-перехода не превышает допу-

стимой. Превышение этого значения ведет к тепловому пробою и выходу 

стабилитрона из строя [133]. 

Для стабилитронов одного и того же типа напряжение стабилизации 

различается, поэтому в документации обычно приводится или минимальная 

и максимальная границы этого напряжения, или указывается номинальное 

напряжение стабилизации и его допустимый разброс. 

При проектировании используются стабилитроны серии BZX84 фирмы 

Nexperia. Документация на них находится в папке …\ИДРЭС\Компонен-

ты\Диоды. 

В качестве примера можно рассмотреть BZX84-C4V7: 

– BZX84 – серия стабилитрона; 

– C – допуск по напряжению (±5 %); 

– 4V7 – номинальное напряжение стабилизации (4,7 В). Символ V ис-

пользуется в качестве разделителя для дробных значений. 

Фрагмент таблицы с его параметрами приведен на рис. В.16. 

 

 Рис. В.17 

а б в 

Рис. В.16 
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На рис. В.17, а показан внешний вид указанного стабилитрона в корпусе 

SOT-23-3, а на рис. В.17, б – его УГО по ГОСТ 2.730–73. Видно, что вывод 2 

корпуса не используется (см. рис. В.17, в). 

Стабилитрон при проектировании будет использоваться в качестве со-

ставной части параметрического стабилизатора напряжения – устрой-

ства, в котором стабилизация выходного напряжения достигается за счет 

сильной нелинейности ВАХ использованного компонента. Из-за низкого 

КПД такой стабилизатор применяется в основном в слаботочных схемах (до 

нескольких десятков миллиампер) [134]. 

Схема параметрического стабилизатора напряжения 

показана на рис. В.18. Она свободна от ряда недостатков 

резистивного делителя напряжения (см. рис. В.2). 

Резистор R1 называется гасящим (или балластным), 

так как все изменения входного напряжения в процессе 

работы при неизменном напряжении на стабилитроне 

VD1 будут гаситься на нем. Кроме того, резистор R1 явля-

ется токоограничивающим для стабилитрона. 

Расчет параметрического стабилизатора напряжения 

выполняется в следующей последовательности: 

– задается номинальное напряжение стабилизации стабилитрона UСТ, 

т. е. снимаемое со стабилизатора напряжение (на рис. В.18 – это выхU , а на 

рис. В.16 – ZV ). Индекс Z указывает на фамилию американского физика 

Кларенса Зенера – первооткрывателя туннельного пробоя; 

– определяется потребляемый нагрузкой ток (IН); 

– для выбранного стабилитрона задается номинальный ток стабилизации 

(IСТ по рис. В.15). Обычно это значение лежит в диапазоне от 1 до 20 мА и 

при проектировании в вариантах задания принимается равным 5–7 мА; 

– рассчитывается номинал резистора R1 по формуле: 

 
НСТ

выхвх

II

UU
R1

+

−
= . (В.3) 

Следует отметить, что при выборе номинального тока стабилизации ру-

ководствуются следующими соображениями: 

– если нагрузка перестанет потреблять ток (IН = 0), то он пойдет в до-

полнение к IСТ через стабилитрон. Следовательно, если IСТ был выбран 

большим, то стабилитрон может выйти из строя; 

R1 

VD1 

Uвх 

Uвых 

Рис. В.18 
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– если IН увеличится, то через стабилитрон потечет меньший ток. Сле-

довательно, если IСТ был выбран небольшим, то будет падать напряжение 

стабилизации. 

В.7. Светодиод 

Светоизлучающий диод (СИД, light-emitted diode, LED) по ГОСТ Р 

57436–2017 – полупроводниковый диод, излучающий энергию в видимой об-

ласти спектра в результате электрической стимуляции и рекомбинации элек-

тронов и дырок. 

Светодиод выполняет свою функцию при приложенном прямом напря-

жении. В отличие от обычного диода он имеет большую площадь соприкос-

новения в месте контакта двух полупроводников, из-за чего площадь реком-

бинации больше, и, следовательно, интенсивнее свечение. Однако не каждый 

p-n-переход может высвобождать энергию фотонов видимого спектра света. 

Это зависит от ширины запрещенной зоны, энергия преодоления которой 

должна быть соизмерима с энергией кванта видимого спектра света [135]. 

На рис. В.19, а показан внешний вид SMD-светодиода, а на рис. В.19, б – 

его УГО по ГОСТ 2.730–73. 

 

Конструктивно SMD-светодиод представляет подложку с контактами 

для монтажа на ПП, на поверхности которой располагается полупроводнико-

вый кристалл, покрытый сверху прозрачным термостойким полимером. Анод 

кристалла соединяется с соответствующим контактом на подложке прово-

лочной перемычкой. Катод обычно обозначается зеленым цветом на верхней 

стороне подложки, однако может присутствовать маркировка в виде значков 

и на нижней ее стороне (рис. В.19, в). 

При проектировании используются SMD-светодиоды серии FYLS типо-

размеров 0805 (FYLS-0805) и 0603 (FYLS-0603) фирмы Foryard Optoelectron-

Рис. В.19 

а 

б 

в 

Катод 

Анод 

Подложка Кристалл 

Контакт 

(анод) 

Проволочная 

перемычка 

Маркировка 

катода 
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ics, документация на которые находится в папке …\ИДРЭС\Компоненты\ 

Диоды\Светодиоды. 

В качестве примера светодиода можно рассмотреть FYLS-0805UGC: 

– FYLS – серия SMD-светодиодов; 

– 0805 – типоразмер 0805 (см. табл. В.1); 

– UGC – желто-зеленый цвет свечения (длина волны – 570 нм). Расшиф-

ровка других кодов приведена в табл. В.3. 

Таблица В.3 

Расшифровка кодов цветности SMD-светодиодов серии FYLS 

Код Значение 

SRC Ярко-красный (длина волны – 643 нм) 

URC Красный (длина волны – 631 нм) 

UYC Желтый (длина волны – 592 нм) 

PGC Зеленый чистый (длина волны – 525 нм) 

UBC Синий (длина волны – 468 нм) 

UWC Белый холодный (цветовая температура – 7000 К) 

На рис. В.20, а приведена прямая ветвь ВАХ указанного светодиода, а на 

рис. В.20, б – зависимость относительной силы света от прямого тока. 

 Рис. В.20 

а б 

в 
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Из приведенных графиков видно, что номинальная сила света, значение 

которой по рис. В.20, в для указанного светодиода составляет 40 мкд (милли-

кандела), достигается при номинальном прямом токе порядка 20 мА (относи-

тельная сила света на рис. В.20, б в этой точке равна единице). На практике 

для повышения срока службы компонента и для уменьшения суммарного то-

ка потребления устройства светодиод включают в об-

легченном режиме, т. е. при меньшем прямом токе. 

Следует отметить, что зависимости, приведенные 

на рис. В.20, для разных светодиодов разные. 

Типичная схема включения светодиода показана на 

рис. В.21. Резистор R1 ограничивает ток, протекающий 

через светодиод VD1. Сопротивление этого резистора 

рассчитывается по следующей формуле: 

 
F

F

I

UU
R1

−
= вх , (В.4) 

где вхU  – входное напряжение, В; FU  – номинальное значение прямого 

напряжения светодиода, В; FI  – номинальное значение прямого тока свето-

диода, А. 

В.8. Биполярный транзистор 

Биполярный транзистор (bipolar junction transistor) по ГОСТ Р 57436–

2017 – полупроводниковый прибор с двумя взаимодействующими перехода-

ми и тремя или более выводами, усилительные свойства которого обусловле-

ны явлениями инжекции и экстракции неосновных носителей заряда. Работа 

биполярного транзистора зависит от носителей обеих полярностей. 

Буквенный код обозначения транзистора по ГОСТ 2.710–81 – VT.  

Гидромоделью транзистора может служить водопроводный кран, в ко-

тором поворотом ручки регулируется поток воды. 

Биполярный транзистор состоит из трех слоев полупроводника. В зави-

симости от типа их проводимости различают p-n-p- и n-p-n-транзисторы. 

Принцип действия у них одинаковый, но на практике из-за большей подвиж-

ности электронов чаще используют n-p-n-транзисторы. 

УГО n-p-n-транзистора по ГОСТ 2.730–73 показано на рис. В.22, а, а 

p-n-p-транзистора – на рис. В.22, б. На рисунках также дополнительно отме-

чены названия выводов (в схемах они не указываются): Б – база, К – коллек-

тор, Э – эмиттер. 

R1 

VD1 

Uвх 

Рис. В.21 
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Стрелка на УГО находится со стороны 

эмиттера и указывает направление протекания 

тока, т. е. от p-области к n-области (как стрелка 

компаса). 

На рис. В.22, в приведена схематичная 

структура p-n-p-транзистора с обозначением 

выводов от слоев. Переход между базой и 

эмиттером называется эмиттерным, а между 

базой и коллектором – коллекторным. 

Выделяют следующие особенности струк-

туры транзистора: 

– толщина базы мала и не превышает не-

скольких микрон;  

– база выполняется из слаболегированного полупроводника (концентра-

ция основных носителей заряда мала);  

– площадь коллекторного перехода значительно больше эмиттерного; 

– концентрация основных носителей заряда в эмиттере больше, чем в 

коллекторе (на рис. В.22, в это различие отмечено знаком «+»). 

Каждый из переходов транзистора может быть смещен либо в прямом 

направлении, либо в обратном. В зависимости от этого различают четыре 

режима работы. На примере p-n-p-транзистора: 

1. Если эмиттерный переход смещен в прямом направлении, а коллек-

торный – в обратном, то это активный режим работы транзистора. 

За счет прямого смещения эмиттерного перехода происходит инжекция 

носителей заряда из эмиттера в базу, что создает ток эмиттера ( ЭI ). Так как 

область эмиттера легирована сильнее области базы, то поток дырок преобла-

дает над потоком электронов. Инжектированные в базу дырки являются там 

неосновными носителями заряда. 

Из-за малой толщины базы почти все дырки, пройдя ее в процессе диф-

фузии, достигают коллекторного перехода. Лишь малая их часть успевает 

прорекомбинировать с электронами, вызывая приток электронов из внешней 

цепи источника питания и создавая ток базы ( БI ). 

Коллекторный переход смещен в обратном направлении, поэтому до-

стигшие его дырки подхватываются электрическим полем и втягиваются в 

область коллектора (процесс экстракции). Здесь они являются основными 

носителями заряда, поэтому легко доходят до коллекторного вывода, где ре-

а 

К 

Э 

Б 

б 

К 

Э 

Б 

Рис. В.22 

в 
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комбинируют со свободными электронами, что приводит к возникновению 

тока коллектора ( КI ) во внешней цепи. 

Токи биполярного транзистора, работающего в активном режиме, связа-

ны следующими соотношениями: 

 БКЭ III += , (В.5) 

 БК II = , (В.6) 

где   – коэффициент усиления транзистора по току в схеме с общим эмитте-

ром (в литературе также можно встретить обозначения 21Эh  и FEh ). 

Включение p-n-p-транзистора по схеме с общим эмиттером показано на 

рис. В.23, а. Здесь входной источник питания подключается между базой и 

эмиттером ( БЭU ), а выходной – между коллектором и эмиттером ( КЭU ). 

 

Эмиттерный и коллекторный переходы биполярного транзистора на 

рис. В.23, а дополнительно показаны в виде УГО диодов. 

На рис. В.23, б показаны входные статические ВАХ (семейство зависи-

мостей БI  от БЭU  при различных постоянных КЭU ) транзистора, включен-

ного по схеме с рис. В.23, а. 

На рис. В.23, в показаны выходные статические ВАХ (семейство зави-

симостей КI  от КЭU  при различных постоянных БI ) транзистора, включен-

ного по схеме с рис. В.23, а. Пунктирными линиями на рисунке показаны 

следующие предельные параметры: 

– maxКI  – максимально допустимый ток коллектора; 

– maxКЭU  – максимально допустимое напряжение коллектор–эмиттер; 

– maxКP  – максимально допустимая мощность рассеяния (в основном на 

коллекторном переходе, так как только он смещен в обратном направлении). 

Рис. В.23 

а б в 
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Так как коллекторный переход расположен близко к эмиттерному, то он 

оказывает влияние на него. Так, при увеличении обратного напряжения на 

коллекторном переходе увеличивается ширина его обедненного слоя и тол-

щина базы становится меньше (эффект Эрли, модуляции толщины базы, base 

thickness modulation), что приводит к более быстрому прохождению дырок 

через нее и уменьшению вероятности рекомбинации. Этим объясняется соот-

ветствующий сдвиг зависимостей на входных ВАХ и увеличение КI  при 

увеличении КЭU  и постоянном значении БI  на выходных ВАХ. 

Активный режим является основным, если биполярный транзистор ис-

пользуется для усиления сигналов. 

2. Если оба перехода смещены в обратном направлении, то это режим 

отсечки. Токи, за исключением небольших обратных токов, через транзи-

стор не протекают. В этот режим транзистор начинает переходить при таких 

напряжениях на эмиттерном переходе, при которых существует запирающий 

слой и заметной инжекции носителей в базу не наблюдается.  

3. Если оба перехода смещены в прямом направлении, то это режим 

насыщения. В этом режим транзистор переходит тогда, когда БI  становится 

настолько большим, что КI  перестает зависеть от него и определяется в ос-

новном сопротивлением внешней цепи, т. е. выражение (В.6) не выполняется. 

В документации напряжение коллектор–эмиттер для некоторых значе-

ний БI  и КI , ниже которого транзистор будет находиться в режиме насыще-

ния, обозначается как КЭнасU  (см. рис. В.23, в) или CEsatV  (collector-emitter 

saturation voltage). Пример показан на рис. 8.38. 

Режимы насыщения и отсечки являются основными, когда биполярные 

транзисторы работают в ключевых и логических схемах. 

4. Если коллекторный переход смещен в прямом направлении, а эмит-

терный – в обратном, то это инверсный режим работы. Такой режим ис-

пользуют редко, так как из-за несимметричной структуры транзистора коэф-

фициент усиления в нем меньше, чем в активном режиме [136]–[138]. 

При проектировании для создания схемы «токового зеркала» биполяр-

ный транзистор используется в составе транзисторной сборки BCV62A,215 

фирмы Nexperia со следующими максимальными параметрами: 

– 100maxК −=I  мА; 

– 30maxКЭ −=U  В; 

– 25,0maxК =P  Вт. 
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Документация на транзисторную сборку находится в папке …\ИДРЭС\ 

Компоненты\Транзисторы. 

Внешний вид корпуса SOT-143B, в котором она выполнена, показан на 

рис. В.24, а; а ее УГО, изображенное по ГОСТ 2.730–73, – на рис. В.24, б. 

Указанная транзисторная сборка 

представляет собой два одинаковых 

p-n-p-транзистора с объединенной ба-

зой, подключенной к коллектору од-

ного из них. По ГОСТ Р 57436–2017 

ее можно отнести к понятию полу-

проводниковый блок (semiconductor 

assembly) – совокупность полупро-

водниковых приборов, соединенных по определенной электрической схеме и 

собранных в единую конструкцию, имеющую более двух выводов. 

Буквенный код обозначения полупроводникового блока по ГОСТ 2.710–

81 – V. 

В.9. Полевой транзистор 

Полевой транзистор (field-effect transistor) по ГОСТ Р 57436–2017 – 

полупроводниковый прибор, усилительные свойства которого обусловлены 

переносом основных носителей заряда, протекающим через канал и управля-

емый электрическим полем. Действие полевого транзистора обусловлено но-

сителями заряда одной полярности. 

У полевого транзистора в общем случае есть три вывода: 

– исток (И) или source (S). От этого вывода в канале движутся основные 

носители заряда; 

– сток (С) или drain (D). К этому выводу в канале движутся основные 

носители заряда; 

– затвор (З) или gate (G). На этот вывод подается управляющий сигнал. 

Полевые транзисторы делятся на две группы: 

– с управляющим p-n-переходом (JFET, Junction FET). В этих транзисто-

рах управление потоком основных носителей происходит с помощью вы-

прямляющего электрического перехода (например, p-n-перехода), смещенно-

го в обратном направлении; 

– с изолированным затвором. В этих транзисторах затвор электрически 

изолирован от канала с помощью диэлектрика. Примером являются транзи-

Рис. В.24 

а б 
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сторы типа металл-окисел-полупроводник (МОП-транзисторы), также назы-

ваемые MOSFET (Metal-Oxide-Semiconductor FET). 

Полевые транзисторы с изолированным затвором в свою очередь также 

делятся на две группы: 

– со встроенным каналом; 

– с индуцированным каналом. 

Полевой транзистор из каждой приведенной выше группы может быть 

как с n-каналом, так и с p-каналом. 

При проектировании используется MOSFET с индуцированным p-кана-

лом, схематичная структура которого показана на рис. В.25. 

На рисунке изображен кристалл полу-

проводника n-типа с относительно высоким 

удельным сопротивлением, называемый под-

ложкой (П), в котором созданы две сильноле-

гированные p-области (расстояние между 

ними может составлять несколько микромет-

ров). От них отходят выводы истока и стока. 

Поверхность подложки между истоком и стоком покрыта тонким (порядка 

0,1 мкм) слоем диэлектрика (диоксид кремния), на который нанесен метал-

лический вывод – затвор. 

В рассмотренной структуре есть паразитные элементы, негативно влия-

ющие на характеристики транзистора. Один из них – биполярный транзи-

стор, для устранения влияния которого подложку и исток обычно соединяют 

технологической перемычкой, т. е. замыкают его базу и эмиттер. Оставшийся 

коллекторный переход (между подложкой и стоком) образует диод (body di-

ode), не оказывающий существенного влияния на работу полевого транзисто-

ра и иногда используемый в некоторых схемных решениях [138]. 

На рис. В.26, а показано УГО MOSFET с индуцированным p-каналом и с 

внутренним соединением подложки и истока по ГОСТ 2.730–73, а на 

рис. В.26, б – УГО такого же транзистора с обозначением внутреннего диода, 

обычно приводимого в зарубежной документа-

ции. На рисунках также отмечены названия 

выводов (в схемах они не указываются). 

Принцип работы p-канального MOSFET 

состоит в следующем. При нулевом напряже-

нии затвор–исток ( ЗИU ) и ненулевом напря-

Рис. В.25 

Рис. В.26 
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жении сток–исток ( СИU ) один из p-n-переходов оказывается смещен в об-

ратном направлении, поэтому ток стока ( СI ) пренебрежимо мал. 

При подаче на затвор отрицательного напряжения ЗИU  основные носи-

тели заряда (электроны) от поверхности подложки под затвором начинают 

двигаться внутрь полупроводника. В обратном направлении движутся дырки 

из подложки и из областей стока и истока. В результате под затвором возни-

кает тонкий инверсный слой с дырочной проводимостью, который и является 

проводящим каналом между истоком и стоком. С изменением ЗИU  изменя-

ется концентрация носителей заряда в проводящем канале, а также его тол-

щина, т. е. происходит модуляция его сопротивления. При изменении сопро-

тивления канала изменяется величина СI  при приложенном СИU . 

На рис. В.27, а показано включение полевого транзистора по схеме с 

общим истоком. Здесь входной источник питания подключается между за-

твором и истоком, а выходной – между стоком и истоком. 

 

Напряжение ЗИU , при котором индуцируется канал, называется порого-

вым и обозначается ЗИпорU  или GS(th)V  (gate threshold voltage). Так как канал 

возникает постепенно, то для исключения неоднозначности в его определе-

нии обычно задается определенное значение СI , при превышении которого 

считается, что потенциал затвора достиг порогового значения. 

На рис. В.27, б приведена передаточная (стоко-затворная) характеристи-

ка (зависимость СI  от ЗИU  при постоянном СИU ). По этой характеристике 

определяется количественная оценка управляющего действия затвора. 

На рис. В.27, в приведены выходные статические ВАХ (семейство зави-

симостей СI  от СИU  при различных постоянных ЗИU ) транзистора, вклю-

Рис. В.27 

а б в 
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ченного по схеме с рис. В.27, а. При увеличении СИU  ширина канала около 

стока уменьшается. При напряжении насыщения СИнасU  происходит пере-

крытие канала и при дальнейшем увеличении СИU  увеличивается длина пе-

рекрытой его части и, следовательно, растет сопротивление. В итоге СI  по-

чти не изменяется. При превышении некоторого значения СИU , которое 

называется пробивным напряжением и обозначается как СИпробU  или 

(BR)DSSV  (drain-to-source breakdown voltage), наступает лавинный пробой пе-

рехода около стока [131]. 

Входные статические ВАХ для полевых транзисторов обычно не рас-

сматриваются из-за пренебрежимо малого тока затвора. 

К некоторым неуказанным выше параметрам также относятся: 

– СИоткR  или DS(on)R  (static drain-to-source on-resistance) – сопротивле-

ние открытого канала между стоком и истоком при заданных СI  и ЗИU ; 

– maxСI  – максимально допустимый ток стока; 

– maxЗИU  – максимально допустимое напряжение затвор–исток, после 

которого происходит повреждение изолирующего оксидного слоя под затво-

ром (например, от статического электричества); 

– maxP  – максимально допустимая мощность рассеяния. 

Пример MOSFET с индуцированным p-каналом и используемое при 

проектировании схемное решение приведены в В.11. 

В.10. Микросхемы 

Некоторые определения по ГОСТ Р 57435–2017 [140]: 

– интегральная микросхема (микросхема, integrated circuit) – микро-

электронное изделие, состоящее из совокупности элементов (компонентов), 

электрически соединенных или не соединенных между собой в объеме и 

(или) на поверхности подложки (кристалла), и предназначенное для выпол-

нения заданной функции; 

– аналоговая микросхема (linear integrated circuit) – микросхема, пред-

назначенная для преобразования и (или) обработки сигналов, изменяющихся 

по закону непрерывной или прерывистой функции. 

– цифровая микросхема (digital integrated circuit) – микросхема, предна-

значенная для преобразования и (или) обработки сигналов, изменяющихся по 

закону дискретной функции. 
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При проектировании будут использоваться только аналоговые микро-

схемы, буквенный код обозначения которых по ГОСТ 2.710–81 – DA. 

УГО аналоговых микросхем выполняются по ГОСТ 2.759–82. В каждом 

УГО указывается функция микросхемы. В случае использования обозначе-

ния функции, не установленного в стандарте, его необходимо пояснять на 

поле схемы. При проектировании таким обозначением будет dB из УГО мик-

росхем аттенюаторов. 

Каждая микросхема представляет собой законченное устройство, вы-

полняющее одну или несколько функций (например, усиление сигнала, ста-

билизация напряжения питания, и др.), но практически всегда требующее 

подключения внешних компонентов: 

– около выводов питания необходимы блокировочные конденсаторы; 

– в микросхемах стабилизаторов напряжения блокировочные конденса-

торы по выходу ко всему прочему предотвращают самовозбуждение; 

– в микросхемах стабилизаторов напряжения с регулируемым выходом 

необходим резистивный делитель напряжения; 

– для работы микросхем усилителей, применяемых при проектировании, 

необходимо обеспечить заданный уровень тока и др. 

Обычно рекомендации по внешним подключениям микросхем приво-

дятся производителями в документации. 

 Рис. В.28 [141] 

а 

б 

1 2 3 4 5 

1 – корпус (формовочная смола); 2 – разварочный (соединительный) провод;  

3 – кристалл интегральной микросхемы; 4 – посадочный материал;  

5 – посадочная площадка (основание); 6 – рамка выводов 

6 

1 2 3 4 5 6 
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Корпус интегральной микросхемы является несущей конструкцией, 

предназначенной для защиты кристалла от воздействий внешней среды и для 

соединения с внешними цепями с помощью выводов. 

По конструктивным решениям проблемы отвода тепла все корпуса для 

полупроводниковых приборов и микросхем делятся на три группы [142]: 

– корпуса, не предусматривающие посадку прибора на теплоотвод (ра-

диатор). Такие решения обычно применяются для маломощных приборов, не 

требующих специальных мер охлаждения. Это пластмассовые корпуса типа 

DIP, SO (SOIC), TO-92, MSOP (см. рис. В.28, а, 8.23 и 8.42), металлокерами-

ческие корпуса с планарным расположением выводов и др.; 

– корпуса, использующие в каче-

стве радиатора металлизацию на ПП. К 

этой группе относятся SOT-223, QFN 

(см. рис. В.28, б, 8.23 и 8.42), SO (с «от-

крытым» кристаллодержателем) и др.; 

– корпуса, предусматривающие по-

садку прибора на теплоотвод (радиа-

тор). Применяются для мощных сило-

вых приборов, для которых необходимы 

специальные меры охлаждения. Обычно 

это пластмассовые корпуса типа TO-

218, TO-220, TO-3, TO-258, SIL-9 и др. 

На рис. В.29 показано внутреннее устройство корпуса TO-220-3 и один 

из возможных радиаторов для него. Крепление осуществляется с помощью 

винтового соединения напрямую или через изоляционную прокладку. 

В.11. Схемы защиты от переполюсовки 

Подача напряжения питания обратной полярности на изделие может 

привести к необратимому выходу из строя его составных компонентов: элек-

тролитических конденсаторов, полупроводниковых приборов, микросхем. 

Для предотвращения этого зачастую предусматривают специальную защиту. 

В столбце 14 индивидуального задания на проектирование указана одна 

из следующих схем ЗП: 

1. ЗП-1. Данная схема, показанная на рис. В.30, представляет собой диод 

VD1, включенный последовательно с нагрузкой нR  (под нагрузкой понима-

ется защищаемая схемой часть устройства). При неправильной полярности 

Рис. В.29 
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входного напряжения питания p-n-переход диода 

оказывается смещен в обратном направлении, т. е. 

обладает большим сопротивлением, и ток, протека-

ющий через него, пренебрежимо мал. 

При проектировании используется диод 

1N4007 (см. рис. В.11, а) фирмы Diodes Incorporated 

с наибольшим мгновенным значением обратного 

напряжения 1000 В и действующим обратным напряжением 700 В. Прямая 

ветвь ВАХ этого диода приведена на рис. В.31. 

Указанный диод находится в 

библиотеке VD, а документация на 

него – в папке …\ИДРЭС\Компонен-

ты\Диоды. 

Недостатки схемы ЗП-1: 

– потеря части входного напря-

жения, что при низковольтном огра-

ниченном питании может оказаться 

неприемлемым. Так, по рис. В.31 при 

токе потребления устройства 150 мА 

и температуре кристалла 25 °C (пара-

метр jT ) падение напряжения на дио-

де составит 0,8 В; 

– при больших токах, потребляемых устройством, на диоде будет рассе-

иваться большая мощность, т. е. он будет сильно греться. Температура кри-

сталла без теплоотвода (радиатора) рассчитывается по формуле: 

 AJAj TRPT +=  , (В.7) 

где P  – мощность, рассеиваемая кристаллом, Вт; JAR  – тепловое сопротив-

ление между кристаллом и окружающей средой, приводимое в документа-

ции, °C/Вт; AT  – температура окружающей среды, °C [143]. 

Например, по рис. В.31 при токе потребления устройства 1 А (макси-

мальный средневыпрямленный прямой ток) и падении напряжения на диоде 

0,92 В для комнатной температуры (25 °C) температура кристалла составит: 

°C1172510092,01 =+=jT . 

Полученный результат находится близко к верхней границе рабочего 

диапазона температур кристалла, составляющего по документации от минус 

Рис. В.30 

Рис. В.31 
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65 до плюс 150 °C. Продолжительная работа в таком режиме может плохо 

сказаться на сроке службы диода. 

2. ЗП-2. В данной схеме, показанной на рис. В.32, а, вместо включенно-

го последовательно с нагрузкой диода, как было в схеме ЗП-1, устанавлива-

ется диод Шоттки. 

 

При проектировании используется диод Шоттки MBR0520LT1G фирмы 

ON Semiconductor в корпусе SOD-123 (рис. В.32, б) с наибольшим значением 

обратного напряжения 20 В, максимальным средневыпрямленным прямым 

током 0,5 А и максимальным рабочим диапазоном температур кристалла от 

минус 65 до плюс 125 °C. Прямая ветвь ВАХ этого диода Шоттки приведена 

на рис. В.32, в. 

Указанный диод Шоттки находится в библиотеке VD, а документация на 

него – в папке …\ИДРЭС\Компоненты\Диоды. 

Достоинства схемы ЗП-2 в сравнении со схемой ЗП-1: 

– меньшие потери входного напряжения питания. Так, по рис. В.32, в 

при токе потребления нагрузки 150 мА и температуре кристалла 25 °C паде-

ние напряжения на диоде Шоттки составит 0,29 В. Однако в некоторых слу-

чаях и оно может оказаться неприемлемым; 

– меньшая рассеиваемая мощность. 

Недостаток схемы ЗП-2 – малое максимальное обратное напряжение. 

3. ЗП-3. В данной схеме, показанной на рис. В.33, используется диод из 

схемы ЗП-1, но установленный параллельно нагрузке. Предполагается, что 

Рис. В.32 

б 

в 

а 
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при использовании схем ЗП-3 и ЗП-4 со стороны источника питания после-

довательно с нагрузкой установлен плавкий предохранитель. 

Принцип работы схемы следующий. При правильной полярности вход-

ного напряжения питания диод VD1 не оказывает 

влияния на работу нагрузки, за исключением прене-

брежимо малого обратного тока, протекающего че-

рез него. При неправильной полярности входного 

напряжения питания p-n-переход диода VD1 оказы-

вается смещен в прямом направлении и через него 

начнет протекать большой прямой ток, который выведет из строя плавкий 

предохранитель. 

Для правильной работы схемы должны выполняться следующие усло-

вия: 

– номинальный ток плавкого предохранителя должен быть больше по-

требляемого нагрузкой тока. В этом случае в рабочем режиме он не выйдет 

из строя; 

– предельный импульсный ток плавкого предохранителя и время такого 

импульса должны быть меньше, чем аналогичные параметры у диода VD1. В 

этом случае плавкий предохранитель выйдет из строя раньше диода. 

Достоинство схемы ЗП-3 – отсутствие влияния диода на нагрузку при 

правильной полярности входного напряжения. 

Недостатки схемы ЗП-3 проявляются при подаче неправильной поляр-

ности входного напряжения питания: 

– требуется замена плавкого предохранителя, а после каждой замены – 

проверка работоспособности диода; 

– к нагрузке будет приложено небольшое напряжение обратной поляр-

ности, равное падению напряжения на диоде при прямом смещении (см. 

рис. В.31). В некоторых случаях это может оказаться неприемлемым. 

4. ЗП-4. Данная схема, показанная на рис. В.34, отличается от схемы 

ЗП-3 установкой параллельно нагрузке диода Шоттки из схемы ЗП-2. 

Достоинство схемы ЗП-4 в сравнении со схемой 

ЗП-3 – меньшее напряжение обратной полярности, 

приложенное к нагрузке при подаче неправильной 

полярности входного напряжения питания, из-за 

меньшего падения напряжения на диоде Шоттки 

при его прямом смещении (см. рис. В.32, в). 

Рис. В.33 

Рис. В.34 
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Недостаток схемы ЗП-4 по сравнению со схемой ЗП-3 – меньшее допу-

стимое значение входного напряжения питания, обусловленное меньшим 

максимальным обратным напряжением диода Шоттки. 

5. ЗП-5. Данная схема, показанная на рис. В.35, представляет собой од-

нофазную мостовую выпрямительную схему V1 (диодный мост).  

При проектировании используется диод-

ный мост DF06S фирмы ON Semiconductor в 

корпусе SDIP-4 (внешний вид с обозначением 

номеров выводов показан на рис. В.36, а) с 

максимальным постоянным обратным напря-

жением 600 В, максимальным средневыпрям-

ленным прямым током 1 А и максимальным 

рабочим диапазоном температур кристалла от 

минус 55 до плюс 150 °C. Прямая ветвь ВАХ 

каждого диода из этого диодного моста приведена на рис. В.36, б. 

 Рис. В.36 

б 

а 

2 

1 

3 
4 

д г в 

Рис. В.35 
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Указанный диодный мост находится в библиотеке VD, а документация 

на него – в папке …\ИДРЭС\Компоненты\Диоды. 

Возможные варианты УГО диодного моста по ГОСТ 2.730-73 показаны 

на рис. В.36, в, г, д. На рис. В.36, г диодам внутри диодного моста условно 

присвоены позиционные обозначения для пояснения принципа работы. 

Достоинство схемы ЗП-5 – при любой полярности входного напряжения 

питания, поданного на выводы 3 и 4, на нагрузку поступит напряжение пра-

вильной полярности, т. е. на выводе 1 всегда будет «плюс», а на выводе 2 – 

«минус» (ток по рис. В.36, г потечет либо через диоды VD1 и VD4, либо через 

диоды VD2 и VD3). 

Недостатки схемы ЗП-5:  

– потеря большой части входного напряжения питания, так как последо-

вательно оказываются включены два диода. В случае низковольтного огра-

ниченного питания это, скорее всего, окажется неприемлемым. Например, по 

рис. В.36, б при токе потребления устройства 150 мА и температуре кристал-

ла 25 °C падение напряжения составит порядка 1,6 В; 

– большая рассеиваемая мощность при больших токах. 

6. ЗП-6. Данная схема, показанная на рис. В.37, представляет собой 

MOSFET с индуцированным p-каналом и с внутренним соединением под-

ложки и истока. Входное напряжение питания 

подается между стоком и затвором, а нагрузка 

подключается между истоком и затвором. 

На рис. В.37 у транзистора VT1 условно от-

мечено расположение внутреннего диода между 

стоком и истоком. 

При проектировании используется полевой 

транзистор IRLML2244TRPbF фирмы International Rectifier в корпусе SOT-

23-3 (см. рис. В.17, а). Он находится в библиотеке VT, а документация на не-

го – в папке …\ИДРЭС\Компоненты\Транзисторы. 

Принцип работы схемы следующий. При правильной полярности вход-

ного напряжения питания внутренний диод транзистора VT1 оказывается под 

прямым смещением (по документации при токе 200 мА падение напряжения 

на нем составит около 0,6 В). Остальная часть входного напряжения окажет-

ся приложенной между истоком и затвором транзистора, причем потенциал 

на затворе будет меньше, чем на истоке. Если это напряжение окажется 

больше ЗИпорU  (для заданного транзистора максимальное значение – 1,1 В), 

Рис. В.37 
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то между стоком и истоком индуцируется канал, сопротивление которого 

резко падает с увеличением этого напряжения (зависимость для заданного 

транзистора приведена на рис. В.38) и 

шунтирует внутренний диод. 

При неправильной полярности 

входного напряжения питания внут-

ренний диод транзистора VT1 нахо-

дится под обратным смещением, и все 

напряжение приложено к нему. В ре-

зультате ток в нагрузку не поступает. 

Достоинства схемы ЗП-6: 

– практически отсутствуют поте-

ри входного напряжения питания при 

его правильной полярности. Так, по 

рис. В.38 при токе стока 150 мА (кри-

вые на рисунке при токах менее 4,3 А почти не меняются) и напряжении 

между затвором и истоком 3 В для температуры кристалла +25 °C сопротив-

ление канала составит 60 мОм, а напряжение сток–исток – 9 мВ; 

– небольшая рассеиваемая мощ-

ность (например, для приведенных вы-

ше данных – 1,3 мВт). 

Недостатки схемы ЗП-6: 

– небольшое максимальное обрат-

ное напряжение сток–исток (для ука-

занного транзистора – минус 20 В); 

– небольшое максимальное значе-

ние напряжения затвор–исток (для ука-

занного транзистора – ±12 В). 

Последний недостаток устраняется добавлением стабилитрона VD1 с 

напряжением стабилизации, меньшим maxЗИU , и токоограничивающего ре-

зистора R1 (рис. В.39). 

 

Рис. В.38 

Рис. В.39 
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Г. Справочная информация по Altium Designer 

Г.1. Настройки окна Preferences 

В табл. Г.1–Г.4 приведено описание изменений в настройках из окна 

Preferences (команда DXP ⇒ Preferences), происходящих в результате за-

грузки профиля ИДРЭС-AltiumPreferences.DXPPrf из 3.2.2. Кроме того, да-

ны комментарии и для некоторых неизмененных настроек. 

Таблица Г.1 

Настройки раздела System 

Подраздел Настройка Примечание 

General 

Опция Reopen Last Workspace 

отключена 

При запуске САПР последние группы 

проектов не будут автоматически откры-

ваться 

Опция Open Home Page if no 

documents open отключена 

При запуске САПР не открывается до-

машняя страница 

View 

Опция Autosave desktop вклю-

чена (по умолчанию) 

Автоматическое сохранение расположе-

ния панелей (см. подраздел Desktop Lay-

outs) 

Опция Restore open documents 

отключена 

При запуске САПР не будут восстанавли-

ваться документы, оставшиеся открыты-

ми при последнем завершении работы 

Опция Use animation отключена 
Отключение анимации сворачивания 

плавающих вспомогательных панелей 

Navigation 

В группе Highlight Methods 

включена опция Connective 

Graph и ползунок масштабиро-

вания установлен в среднее по-

ложение 

См. п. 6 из Г.13 

В группе Cross Select Mode оп-

ции Cross Selection и Masking 

включены, а опция Nets отклю-

чена 

См. Г.35 

File Types 

Отключено использование фай-

лов с расширениями «.lib», 

«.pcb» и «.sch» 

Отключены файлы САПР P-CAD, кото-

рые в Altium Designer можно открыть 

только командой File ⇒ Import Wizard 

New  

Document 

Defaults 

– 

Задаются шаблоны документов и (или) 

проектов, используемых по умолчанию 

при создании новых документов и (или) 

проектов. Например, можно создать пу-

стой лист схемы с рамкой и указать его в 

качестве заготовки для всех новых схем 

(Schematic) из проектов ПП (PCB Project) 

и вне проектов (Free Documents) 
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Окончание таблицы Г.1 

Подраздел Настройка Примечание 

Desktop 

Layouts 
– 

Настраивается расположение панелей: 

– Apply the default layout – сброс распо-

ложения панелей на установленные в 

САПР по умолчанию; 

– Apply the startup layout – сброс распо-

ложения панелей к виду, который был 

при загрузке САПР; 

– Load a saved layout – загрузить сохра-

ненное расположение панелей (например, 

при проектировании расположение пане-

лей сохранено в файле «ИДРЭС-

AltiumDesktopLayouts.TLT» из папки 

…\ИДРЭС\Профили); 

– Save the current layout – сохранить те-

кущее расположение панелей в файл. 

Настройки подразделов General и View (см. табл. Г.1 и 3.2.2) связаны с 

возможной работой на одном компьютере нескольких студентов, в результа-

те чего при открытии Altium Designer не потребуется закрывать чужие доку-

менты, а сам запуск станет быстрее.  

Кроме того, в дополнение к стандартным панелям в каждом редакторе 

будет запускаться панель Inspector справа от рабочего поля (см. Г.10). 

Таблица Г.2 

Настройки раздела Data Management 

Подраздел Настройка Примечание 

Backup – 
См. п. 3 из 2.7 

Local History – 

Templates – 

Указывается путь к папке с шаблонами 

рамок. Рамки из этой папки отображают-

ся в списках Design ⇒ Templates ⇒ Gen-

eral Templates и Design ⇒ Document Op-

tions ⇒ Template 

Installed  

Libraries 

Из списка удалены библиотеки 

Miscellaneous Connect-

ors.IntLib и Miscellaneous De-

vices.IntLib 

УГО компонентов в указанных библиоте-

ках не соответствуют требованиям ЕСКД. 

Описание настроек приведено в примеча-

нии к п. 2 из Г.9 

Таблица Г.3 

Настройки раздела Schematic 

Подраздел Настройка Примечание 

Default 

Units 

Опция Use Metric Unit System 

включена 

Включение метрической системы единиц 

измерения (миллиметры)  
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Продолжение таблицы Г.3 

Подраздел Настройка Примечание 

General 

Опция Break Wires At Autojunc-

tions включена (по умолчанию) 

Автоматическое создание вершины ли-

нии электрической связи в месте добав-

ления ответвления 

Опция Components Cut Wires 

включена (по умолчанию) 

Если при добавлении компонента оба его 

пина попадают на один сегмент линии 

электрической связи, то кроме автомати-

ческого подключения пинов к цепи будет 

удален участок линии между пинами 

Опция Convert Cross-Junctions 

отключена (по умолчанию) 

С включенной опцией место с двумя от-

ветвлениями из одной точки будет авто-

матически преобразовано в два с углами 

45° (см. п. 6 из табл. 6в в ГОСТ 2.721-74). 

Опция Display Cross-Overs от-

ключена (по умолчанию) 

С включенной опцией места пересечений 

линий электрической связи отображаются 

в виде U-образной перемычки. Не преду-

смотрено в ЕСКД 

Опция Pin Direction отключена 

Отключение отображения меток, показы-

вающих электрический тип пинов в УГО 

(например, метка двунаправленного вы-

вода). Настройка отключена, так как вид 

автоматически добавляемых меток не со-

ответствует требованиям ЕСКД  

В группе Alpha Numeric Suffix  

выбрана опция Numeric, separat-

ed by a dot '.' 

Позиционные обозначения УГО, выпол-

ненного разнесенным способом, имеют 

числовой индекс, который по ЕСКД дол-

жен быть отделен точкой от общего по-

зиционного обозначения (см. рис. 8.2) 

В группе Pin Margin в поле 

Name задано 0.5mm, а в поле 

Number – 1.5mm 

Общий отступ имени и номера вывода в 

УГО компонентов. 

Для каждого вывода данные значения 

можно задать индивидуально в его свой-

ствах, включив опции Customize Position 

Graphical 

Editing 

Опция Convert Special Strings 

включена 

Отображение содержимого специальных 

строк в том виде, в котором они выводят-

ся на печать. Например, содержание па-

раметра Comment, в котором обычно ука-

зывается ссылка на другой параметр 

(CI_Value или PartNumber) 

Опция Single '\' Negation вклю-

чена 

Если указанный символ поставить пер-

вым в имени цепи, то над всем именем 

появится горизонтальная черта (обозна-

чение инверсии). Для инверсии отдельно-

го символа указанный знак необходимо 

ставить сразу после него  
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Продолжение таблицы Г.3 

Подраздел Настройка Примечание 

Graphical 

Editing 

Опция Mark Manual Parame-

ters отключена (по умолчанию) 

Используется для визуальной индикации 

(в виде точки) параметров, в свойствах 

которых отключена опция Autoposition 

(автоматическое размещение). 

Опция Click Clears Selection 

включена (по умолчанию) 

Используется для снятия выделения со 

всех объектов щелчком ЛКМ в любом 

свободном от выделенных объектов ме-

сте рабочего поля  

Опция Shift Click To Select 

включена только для примитива 

Pin (кнопка Primitives) 

Пины будут выделяться с зажатой кла-

вишей Shift. 

Опция включена для удобства рисования 

схем, так как возможное выделение пи-

нов из состава УГО компонентов при их 

расстановке мешается и замедляет работу 

Опция Always Drag включена 

(по умолчанию) 

УГО перемещается с линями электриче-

ской связи, подключенными к его пинам. 

Перемещение УГО без линий электриче-

ской связи осуществляется с зажатой кла-

вишей Ctrl. 

С отключенной опцией описанные дей-

ствия производятся наоборот 

Опция Display Strings As Rotat-

ed включена (по умолчанию) 

Позволяет корректно отобразить повер-

нутый текст (например, в графе 26 рамки) 

Опция Protect Locked Objects 

отключена (по умолчанию) 

Если опция отключена, то заблокирован-

ные объекты попадают под выделение 

мышкой, но при попытке их перемеще-

ния появляется окно с предупреждением. 

Если опция включена, то заблокирован-

ные объекты не попадают под выделение 

мышкой (ни под групповое, ни под оди-

нарное). Свойства заблокированного объ-

екта можно открыть двойным щелчком 

ЛКМ по нему 

Опция Reset Parts Designators 

On Paste включена (по умолча-

нию) 

При вставке скопированного компонента 

его позиционное обозначение (Designator) 

будет сброшено. 

Отключение данной опции полезно при 

вырезании и вставке участка схемы с од-

ного листа на другой, когда необходимо 

сохранить позиционные обозначения 

вставленных компонентов 

В группе Auto Pan Options для 

опции Style выбрано значение 

Auto Pan Off 

Отключение автоматического панорами-

рования при приближении курсора мыш-

ки к границе рабочей области во время 

выполнения какой-либо команды 
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Продолжение таблицы Г.3 

Подраздел Настройка Примечание 

Compiler 

В группе Errors & Warnings 

включены опции Fatal Error и 

Error и отключена опция Warn-

ing (по умолчанию) 

Отображение результатов проверки в ре-

альном времени (подчеркивание фигур-

ной линией) при нарушении правил со 

следующими степенями серьезности: 

– Fatal Error – критическая ошибка; 

– Error – ошибка; 

– Warning – предупреждение. 

Цвет подчеркивания определяется нару-

шением с наибольшей степенью серьез-

ности. 

Правила настраиваются на вкладке Error 

Reporting окна свойств проекта (команда 

Project ⇒ Project Options) 

В группе Auto-Junctions отклю-

чена опция Display On Buses 

Отключено отображение автоматическо-

го обозначения электрического соедине-

ния (точка) на шинах 

В группе Auto-Junctions для 

столбца On Wires для опции Size 

выбрано значение Small 

Задан размер автоматического обозначе-

ния электрического соединения (точка) 

на линиях электрической связи 

В группе Manual Junctions Con-

nection status для опции Size вы-

брано значение Small 

Задан размер ручного допустимого обо-

значения электрического соединения 

(точка) на линиях электрической связи. 

Под «допустимым» понимается установ-

ка обозначения в точку, от которой отхо-

дит три или четыре участка линии элек-

трической связи. В противном случае 

размер обозначения определяется 

настройкой элемента Junction из подраз-

дела Default Primitives 

Grids 

В группе Grid Options в списке 

Visible Grid выбрана опция Dot 

Grid, а в поле Grid Color выбран 

черный цвет 

Сетка в рабочем поле отображается в ви-

де точек черного цвета 

В группе Metric Grid Presets 

установлены значения шагов 

сетки 0.5, 1 и 3 мм (для удобства 

работы для Electrical Grid значе-

ния уменьшены на треть) 

Snap Grid – сетка для привязки курсора 

мышки при рисовании графических объ-

ектов; Electrical Grid – сетка, в которой 

осуществляются подключения выводов 

компонентов; Visible Grid – видимая в 

рабочем поле сетка. 

В списке, открываемом при щелчке ПКМ, 

доступны различные команды, например:  

– Remove (удаление выбранной сетки); 

– Add Grid Setting (добавление сетки); 

– Move Up и Move Down (изменение по-

ложения выбранной сетки в списке). 
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Окончание таблицы Г.3 

Подраздел Настройка Примечание 

Break Wire 

В группе Cutting Length для оп-

ции Snap Grid Size Multiple вы-

брано значение 2 

При использовании команды Edit ⇒ 

Break Wire будет удален участок линии 

электрической связи размером с два узла 

активной в данный момент сетки 

Default 

Primitives 

Опция Permanent включена 

Заданные настройки примитивов не из-

меняются при изменении их параметров в 

редакторе 

Настройки примитивов в метри-

ческой системе измерения при-

ведены в табл. Г.5 

Настройки для каждого примитива могут 

задаваться на вкладке Mils (дюймовая 

система измерения) и на вкладке MMs 

(метрическая система измерений).  

Назначение кнопок на вкладках: 

– Edit Values – изменение настроек вы-

бранного примитива; 

– Reset – сброс настроек примитива в вы-

бранной системе измерения; 

– Reset All – сброс настроек всех прими-

тивов в выбранной системе измерения. 

Назначение остальных кнопок: 

– Save As – сохранение настроек прими-

тивов в файл; 

– Load – загрузка настроек примитивов 

из файла; 

– Reset All – сброс настроек примитивов 

для двух систем измерения 

Таблица Г.4 

Настройки раздела PCB Editor 

Подраздел Настройка Примечание 

General 

Опция Smart Component Snap 

включена (по умолчанию) 

При выборе компонента курсор мышки 

привязывается к центру ближайшей КП. 

При отключенной опции привязка осу-

ществляется к точке начала координат 

посадочного места 

Опция Protect Locked Objects 

включена 

См. аналогичную опцию из подраздела 

Graphical Editing в табл. Г.3 

Опция Display popup selection 

dialog включена 

Если под курсором мышки оказывается 

несколько разных объектов, то выбор 

нужного осуществляется во всплываю-

щем окне. 

При отключенной опции объекты можно 

циклически перебирать последователь-

ными щелчками ЛКМ. Всплывающее ок-

но выбора объектов в этом случае откры-

вается двойным щелчком ЛКМ 
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Продолжение таблицы Г.4 

Подраздел Настройка Примечание 

General 

Опция Click Clears Selection 

включена (по умолчанию) 

См. аналогичную опцию из подраздела 

Graphical Editing в табл. Г.3 

Опция Smart Track Ends вклю-

чена (по умолчанию) 

Связывающие линии выходят из свобод-

ных вершин размещенных трасс, а не от 

ближайших объектов (КП, переходных 

отверстий или вершин, находящихся 

внутри трасс). 

При смене опции для обновления линий 

соединения в рабочем поле необходимо 

зажать ЛКМ на каком-нибудь объекте 

или передвинуть его 

В группе Others в списке Comp 

Drag выбрано значение Connect-

ed Tracks 

При перемещении компонента команда-

ми Edit ⇒ Move ⇒ Drag или Edit ⇒ 

Move ⇒ Component (или последователь-

ным нажатием клавиш M ⇒ D или M ⇒ 

C) подключенные к его КП трассы пере-

мещаются вместе с ним 

В группе Autopan Options в 

списке Style выбрано значение 

Disable 

Отключение автоматического панорами-

рования при приближении курсора мыш-

ки к границе рабочей области во время 

выполнения какой-либо команды 

Опция Repour Polygons After 

Modification включена 

Автоматическое перестроение полигонов 

Polygon Pour после их изменения 

Board  

Insight  

Display 

Опция Gray Scale Other Layers 

отключена 
См. п. 9 из Г.38 

Board  

Insight  

Color  

Overrides 

В группе Base Pattern выбрана 

опция Solid (Override Color) 

Все объекты, подключенные к цепи, бу-

дут полностью окрашиваться в цвет, за-

данный для этой цепи. 

По умолчанию была включена опция 

Checker Board (чередование цвета цепи и 

цвета слоя как на шахматной доске) 

Interactive 

Routing 

В разделе Favorites с помощью 

кнопки Favorite Interactive 

Routing Widths удалены все зна-

чения ширин трасс в дюймах и 

заданы значения от 0,2 до 1,6 мм 

с шагом 0,1 мм, а также значение 

0,25 мм. Кроме того, скрыт стол-

бец с переводом значений из 

миллиметров в дюймы 

Значения из этого списка выбираются 

при интерактивной трассировке комби-

нацией клавиш Shift+W 

Для опции Track Width Mode 

выбрано значение Rule Mini-

mum 

См. п. 2.4 из Г.42 
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Окончание таблицы Г.4 

Подраздел Настройка Примечание 

Interactive 

Routing 

В группе Routing Conflict Reso-

lution отключены опции Stop At 

First Obstacle, AutoRoute On 

Current Layer и AutoRoute On 

Multiple Layers См. Г.42 

В группе Interactive Routing Op-

tions включена опция Display 

Clearance Boundaries 

True Type 

Fonts 

Опция Embed TrueType fonts 

inside PCB documents включена 

Использованные шрифты типа TrueType 

будут встроены в документ, что позволит 

просматривать его на других компьюте-

рах в таком же виде. 

Если опция отключена, то шрифт типа 

TrueType, использованный в документе и 

отсутствующий в системе, будет заменен 

на указанный в списке Substitution font 

Defaults 

Опция Permanent включена 
См. аналогичные настройки из подразде-

ла Default Primitives в табл. Г.3 Настройки примитивов приведе-

ны в табл. Г.6 

Layer  

Colors 

По умолчанию выбран набор 

цветов Default 

Сохранение настроек в отдельный файл 

осуществляется командой Save As color 

profile, а порядок подключения такого 

файла указан в п. 6 из 5.2.1. 

Назначение используемых профилей из 

папки …ИДРЭС\Профили: 

– ИДРЭС-AltiumFootprintGray – для 

рисунка посадочного места в оттенках 

серого цвета (см. п. 17.1 из 5.2.3); 

– ИДРЭС-AltiumPCB – для работы с ПП 

и посадочным местом (см. п. 13 из 12.1); 

– ИДРЭС-AltiumPCBGray – для рисун-

ков ПП в оттенках серого цвета 

(см. п. 27.9 из 12.3 и п. 29 из 12.5) 

Таблица Г.5 

Настройки примитивов для редакторов схем и УГО 

Примитив Назначение Настройка 

Arc Дуга Color (цвет) – черный 

Bezier Кривая Безье Color (цвет) – темно-синий цвет 

Bus Entry Вход в шину 
Координаты начальной и конечной точек: Loca-

tion X1 и Y1 – 0mm; Location X2 и Y2 – 3mm 

Comment Системный параметр 

компонента 
Font (шрифт) – GOST type B, 12, Italic 

Designator 
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Окончание таблицы Г.5 

Примитив Назначение Настройка 

Ellipse Эллипс 

Border Width (ширина линии контура) – Small; 

Border Color (цвет контура) – черный; опция 

Draw Solid (заполнение цветом) отключена 

Elliptical Arc Дуга эллипса Color – черный 

Net Label Метка цепи Font – GOST type B, 12 

Parameter Параметр Font – GOST type B, 12, Italic 

Pin Вывод 

Line Width (ширина линии) – Small. В группах 

Name Position and Font и Designator Position and 

Font включены опции Use local font setting и за-

даны настройки шрифта – GOST type B, 12 

Polygon Полигон Border Width – Small 

Port Порт 
Fill Color (цвет заполнения) – белый; Border Col-

or – белый; Font – GOST type B, 12 

Power Object Порт питания 

Style (стиль) – GOST Bar; Net (цепь) – GND; опция 

Show Net Name отключена; Orientation (ориента-

ция) – 270 Degrees; Font – GOST type B, 12 

Rectangle Прямоугольник 
Border Width – Small; опция Draw Solid отключе-

на Round  

Rectangle 

Скругленный  

прямоугольник 

Text Frame Текстовый блок 

Border Width – Small; Alignment (выравнивание 

текста по горизонтали) – Center; Font – GOST type 

B, 16, Italic; опция Draw Solid отключена; опция 

Show Border (показать границу) включена 

Text String Текстовая надпись Font – GOST type B, 16, Italic 

Wire 
Линия электрической 

связи 
Color – красный 

Таблица Г.6 

Настройки примитивов для редакторов ПП и посадочных мест 

Примитив Назначение Настройка 

Arc Дуга Width (ширина) – 0.1mm 

Component Компонент 

В группе Designator: Height (высота буквы) – 

1mm; Width (ширина линии буквы) – 0.15mm; Au-

toposition (положение) – Center-Above. 

В группе Component Properties опция Lock Prim-

itives (запрет выделения примитивов из посадоч-

ного места на ПП) включена по умолчанию 

Coordinate 

Перекрестие с указа-

нием координат его 

центра 

Line width (ширина линии перекрестия) – 0.15mm; 

Size (размер перекрестия) – 1mm; Text Height (вы-

сота буквы) – 1mm; Text Width (ширина линии 

буквы) – 0.15mm; Layer (слой расположения) – 

Top Overlay 
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Продолжение таблицы Г.6 

Примитив Назначение Настройка 

Linear  

Dimension 
Линейный размер 

Pick Gap – 0mm; Arrow Size – 2.5mm; Arrow 

Length – 5mm; Extension Width – 0.15mm; Line 

Width – 0.15mm; Offset – 1mm; Text Height – 

1.6mm; Text Width – 0.15mm; Text Gap – 0.5mm; 

Unit – Millimeters; Precision – 1 

Angular  

Dimension 
Угловой размер 

Pick Gap – 0mm; Arrow Size – 2.5mm; Length – 

5mm; Extension Width – 0.15mm; Line Width – 

0.15mm; Offset – 1mm; Text Height – 1.6mm; Text 

Width – 0.15mm; Text Gap – 0.5mm 

Radial  

Dimension 
Радиальный размер 

Arrow Size – 2.5mm; Line Width – 0.15mm; Text 

Height – 1.6mm; Text Width – 0.15mm; Text Gap – 

0.5mm; Unit – Millimeters; Precision – 1 

Leader  

Dimension 
Линия-выноска 

Pick Gap – 0mm; Arrow Size – 2.5mm; Line 

Width – 0.15mm; Text Gap – 0.5mm; Text Height – 

1.6mm; Text Width – 0.15mm 

Datum  

Dimension 

Размер от общей базы 

без размерной линии 

Pick Gap – 0mm; Extension Width – 0.15mm; Text 

Height – 1.6mm; Text Width – 0.15mm; Text Gap – 

0.5mm; Unit – Millimeters; Precision – 1 

Baseline  

Dimension 

Линейный размер 

от общей базы 

Pick Gap – 0mm; Arrow Size – 2.5mm; Length – 

5mm; Extension Width – 0.15mm; Line Width – 

0.15mm; Offset – 1mm; Text Height – 1.6mm; Text 

Width – 0.15mm; Text Gap – 0.5mm; Unit – Milli-

meters; Precision – 1 

Original  

Dimension 

Обычный размер, 

ориентируемый под 

произвольным углом 

Line Width – 0.15mm; Height – 1mm; Text 

Height – 1.6mm; Text Width – 0.15mm; Unit 

Style – None 

Linear  

Diameter  

Dimension 

Линейный размер  

для указания  

диаметра 

Pick Gap – 0mm; Arrow Size – 2.5mm; Arrow 

Length – 5mm; Extension Width – 0.15mm; Line 

Width – 0.15mm; Offset – 1mm; Text Height – 

1.6mm; Text Width – 0.15mm; Text Gap – 0.5mm; 

Unit – Millimeters; Precision – 1 

Radial  

Diameter  

Dimension 

Диаметральный  

размер 

Arrow Size – 2.5mm; Arrow Length – 5mm; Line 

Width – 0.15mm; Text Height – 1.6mm; Text 

Width – 0.15mm; Text Gap – 0.5mm; Unit – Milli-

meters; Precision – 1 

Polygon Полигон Polygon Pour 

Remove Necks When Copper Width Less Than – 

0.2mm. Также в группе Net Options включены оп-

ции Remove Dead Copper и Pour Over All Same 

Net Objects. 

Назначение опций см. в п. 3 из Г.26 

String Надпись 
Height (высота буквы) – 1mm; Width (ширина ли-

нии буквы) – 0.15mm. 

Track Линия Width – 0.1mm 
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Окончание таблицы Г.6 

Примитив Назначение Настройка 

Via Переходное отверстие 
Hole Size (диаметр отверстия) – 0.6mm; Diameter 

(диаметр площадки) – 1.2mm 

Track Keepout 
Граница зоны запрета 

в виде линии 
Width – 0.1mm 

Arc Keepout 
Граница зоны запрета 

в виде дуги 

Примечание. Настройки примитивов из табл. Г.5 и Г.6 дополнительно 

сохранены в папке …\ИДРЭС\Профили: 

– «ИДРЭС-AltiumSchPrimitives.dft» – для редакторов схем и УГО; 

– «ИДРЭС-AltiumPCBPrimitives.dft» – для редакторов ПП и посадочных 

мест. 

Г.2. Правила проектирования ПП 

В табл. Г.7 приведено описание правил проектирования ПП, загружае-

мых по профилю ИДРЭС-AltiumPCBRules.RUL в п. 10 из 12.1. 

Следует обратить внимание на то, что загружать правила можно как сра-

зу для всех подразделов, так и по отдельности, но после импорта все суще-

ствовавшие в нем ранее правила будут удалены или заменены. 

Таблица Г.7 

Загружаемые правила проектирования ПП 

Подраздел 
Название 

правила 
Описание 

Electrical ⇒  

Clearance 
C 

Зазор между объектами разных цепей – 0,2 мм, а зазор 

от металлизации до отверстий – 0,254 мм 

Routing ⇒ Width W 
Диапазон ширин трасс – от 0,2 до 2 мм с предпочти-

тельным значением 0,5 мм 

Routing ⇒ Routing 

Via Style 
RVS 

Для переходных отверстий задан допустимый диаметр 

отверстия от 0,4 до 6 мм с предпочтительным значени-

ем 0,6 мм и диаметр металлизации от 0,9 до 8 мм с 

предпочтительным значением 1,2 мм 

Mask ⇒ Solder 

Mask Expansion 
SME 

Зазор между КП и защитной паяльной маской – 

0,05 мм 

Plane ⇒ Polygon 

Connect Style 
PCS 

Задано прямое подключение КП и переходных отвер-

стий к полигонам Polygon Pour (опция Direct Connect)  

Manufacturing ⇒ 

Minimum Annular 

Ring 

MAR_Pad 
Минимальный гарантийный поясок для КП с отвер-

стием – 0,2 мм 

MAR_Via 
Минимальный гарантийный поясок для переходного 

отверстия – 0,15 мм 
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Продолжение таблицы Г.7 

Подраздел 
Название 

правила 
Описание 

Manufacturing ⇒ 

Hole Size 

HS_UP 
Диапазон значений диаметров неметаллизированных 

отверстий – от 0,5 до 6,0 мм 

HS_P 
Диапазон значений диаметров металлизированных от-

верстий – от 0,3 до 6,0 мм 

Manufacturing ⇒ 

Hole To Hole 

Clearance 

HtHC 
Минимальное расстояние между краями двух отвер-

стий – 0,2 мм 

Manufacturing ⇒ 

Minimum Solder 

Mask Sliver 

MSMS Минимальная ширина масочного мостика – 0,15 мм 

Manufacturing ⇒ 

Silk To Solder Mask 

Clearance 

StSMC 

Зазор между краем меди в КП и переходных отверсти-

ях и объектами шелкографии – 0,15 мм (опция Check 

Clearance To Exposed Copper). Размер вскрытия за-

щитной паяльной маски при этом не учитывается 

Manufacturing ⇒ 

Silk To Silk  

Clearance 

StSC 
Зазор между любыми объектами в слоях шелкогра-

фии – 0 мм 

Manufacturing ⇒ 

Board Outline 

Clearance 

BOC 

Для всех объектов задан фиксированный зазор в 0,5 мм 

до следующих границ: 

– Outline Edge (контур ПП); 

– Cavity Edge (контуры полостей внутри ПП для 

встраивания компонентов, задаваемые в посадочных 

местах); 

– Cutout Edge (контуры вырезов в ПП); 

– Split Barrier (разделительная линия, определяющая 

границу для слоев, которые не переходят из одного со-

седнего стека в другой). 

До границ Split Continuation (разделительная линия, 

определяющая границу для слоев, которые переходят 

из одного соседнего стека в другой) зазор равен 0 мм 

Placement ⇒  

Component  

Clearance 

CC 

Минимальный зазор между компонентами – 0,49 мм. 

Правило проверяет зазоры до 3D-моделей из состава 

посадочных мест. 

Если 3D-моделей нет, то компонентом считается па-

раллелепипед с высотой, заданной в свойствах поса-

дочного места, и прямоугольным сечением, очерчен-

ным по внешним сторонам наиболее отдаленных гра-

фических примитивов (системные параметры не учи-

тываются, слои расположения примитивов не ограни-

чены). При этом прямоугольное сечение всегда имеет 

стороны параллельные осям X и Y из рабочего поля, 

т. е. при повороте посадочного места сечение не пово-

рачивается, а изменяет свои размеры 
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Окончание таблицы Г.7 

Подраздел 
Название 

правила 
Описание 

Placement ⇒  

Permitted Layers 
PL 

Задано расположение компонентов только на верхней 

стороне ПП (опция Top Layer), при этом проверка пра-

вила в режиме реального времени невозможна 

Численные значения параметров указаны в соответствии с общим зада-

нием на проектирование по 4-му классу точности (см. табл. Б.6) с поправкой 

на стандартные технологические возможности изготовления ПП у отдельных 

производителей и подходят для толщин медной фольги 18 и 35 мкм. 

Примечания: 

– производители обычно рекомендуют не занижать зазоры между не-

большими участками металлизации и огибающим их полигоном, так как при 

травлении раствор в таких местах плохо обновляется и в результате могут 

остаться недотравленные участки. Кроме того, на этапе осаждении меди 

при металлизации отверстий полигон вытягивает ее на себя, в результате 

чего расположенные очень близко небольшие области металлизации могут 

соединиться с ним поверх фоторезиста, приводя к замыканию; 

– в правилах из подраздела Routing ⇒ Width опция Characteristic Imped-

ance Driven Width позволяет задать не ширину, а значение волнового сопро-

тивления, которое будет рассчитываться по данным из окна Layer Stack 

Manager (в этом же окне с помощью кнопки Impedance Calculation можно 

посмотреть и изменить формулы). Расчет в используемой версии Altium De-

signer производится только в МПП относительно слоев типа Plane; 

– в правилах из подраздела Routing ⇒ Routing Via Style также можно 

выбирать шаблоны переходных отверстий из библиотеки (см. п. 10 из 12.1); 

– в правилах из подраздела Manufacturing ⇒ Hole To Hole Clearance оп-

ция Allow Stacked Micro Vias позволяет располагать глухие и скрытые пере-

ходные отверстия друг под другом для повышения плотности соединений в 

МПП; 

– настройка способов проверки правил проектирования рассмотрена в 

п. 14 из 12.1. 

Г.3. Управление изображением в рабочем поле 

В редакторах схем и УГО, а также в редакторах ПП и посадочных мест в 

2D-режиме просмотра доступны следующие часто используемые возможно-

сти управления изображением в рабочем поле: 
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– перемещение изображения по горизонтали – поворот колесика мышки 

с зажатой клавишей Shift; 

– перемещение изображения по вертикали – поворот колесика мышки; 

– перемещение изображения в любом направлении – зажатая ПКМ; 

– изменение масштаба – поворот колесика мышки с зажатой клавишей 

Ctrl. Также используются клавиши PgUp (увеличение) и PgDn (уменьшение) 

или перемещением мышки с зажатой СКМ или ПКМ; 

– автомасштабирование по всем размещенным объектам – комбинация 

клавиш Ctrl+PgDn (команда View ⇒ Fit Document в редакторе ПП или ко-

манда View ⇒ Fit All Objects в остальных редакторах). 

Примечание. Другие команды содержатся в меню View. 

В редакторах ПП и посадочных мест в 3D-режиме просмотра в основном 

используются следующие действия: 

– поворот 3D-модели – зажатая клавиша Shift с по-

следующим перемещением мышки с зажатой ПКМ.  

Примечания: 

– если ПКМ нажать за пределами появившейся 

сферы (рис. Г.1), то поворот можно осуществлять в 

любом направлении; 

– если ПКМ нажать на элементах управления 

сферы (стрелки и дуги), то поворот можно осуществ-

лять только в соответствующих направлениях; 

– включение вида на нижнюю сторону ПП – последовательное нажатие 

клавиш V ⇒ B или команда View ⇒ Flip Board; 

– включение вида на верхнюю сторону ПП (возврат в исходное состоя-

ние) – клавиша 0 или команда View ⇒ Zero Rotation. 

Примечание. В 3D-режиме просмотра доступны действия, описанные 

для 2D-режима просмотра. Кроме того, предопределенные виды можно вы-

брать из списка на ПИ PCB Lib Standard, а отдельные возможности кроме 

меню View содержатся в окне View Configurations (клавиша L). 

Г.4. Сочетания клавиш 

При работе в САПР для увеличения производительности используются 

различные сочетания клавиш (комбинации клавиш и отдельные клавиши).  

Для просмотра доступных действий в режиме работы со сложной ко-

мандой в рабочем поле предусмотрены две возможности: 

Рис. Г.1 
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– комбинацией клавиш Shift+F1 или клавишей «~» открывается меню 

команд, в котором можно не только посмотреть возможные действия и соче-

тания клавиш к ним, но и щелчком ЛКМ сразу их выполнить; 

– клавишей F1 открывается окно, предназначенное только для просмот-

ра доступных команд и сочетаний клавиш. Однако из него кнопкой Current 

Process Help можно вызвать справку по текущей команде с переходом на 

сайт www.altium.com. 

При необходимости командам можно назначить собственные сочетания 

клавиш или отредактировать существующие. Для этого предназначена груп-

па Shortcuts из окна Edit Command (рис. Г.2), которое открывается при 

щелчке ЛКМ с зажатой клавишей Ctrl по требуемой команде. 

 

Желаемое сочетание клавиш вводится в поле Primary или выбирается из 

выпадающего списка. Если оно уже используется в какой-нибудь команде, то 

ее название появится в списке Currently in use by. 

Альтернативой непосредственного назначения сочетаний клавиш в ме-

ню редакторов является окно, вызываемое командой DXP ⇒ Customize, в ко-

тором осуществляется поиск требуемой команды с последующим переходом 

в окно Edit Command. 

Кроме сочетаний клавиш в Altium Designer доступно использование 

клавиш быстрого вызова (подчеркнутые буквы в названиях), что позволяет 

переходить по пунктам меню без использования мышки. Назначение коман-

дам таких клавиш осуществляется в окне Edit Command, в котором в поле 

Caption перед желаемой буквой ставится символ «&». 

 Рис. Г.3 

Рис. Г.2 
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При щелчке ЛКМ с зажатой клавишей Ctrl по названию меню появляет-

ся окно Edit Drop Down Menu (см. рис. Г.3), в котором в поле Popup Key 

можно выбрать клавишу, при нажатии на которую меню откроется около 

курсора мышки. Само меню при этом открывается с зажатой клавишей Alt. 

Примечание. Например, комбинация клавиш Alt+C откроет меню Pro-

ject в ПИ, а клавиша C – меню Project около курсора. 

Окно Edit Drop Down Menu доступно не только для видимых пунктов 

меню в верхней части окна Altium Designer, но и для всех групповых команд, 

расположенных в этих меню. 

Г.5. Выделение объектов 

Выделение объектов в рабочем поле и снятие с них выделения осу-

ществляется следующими основными способами: 

1. Выделение щелчком ЛКМ. 

Примечания: 

– повторный щелчок ЛКМ по выделенному объекту снимает выделение; 

– при зажатой кнопке Shift к выделению можно добавить отдельные 

объекты, а также исключить по отдельности уже выделенные; 

– зажатая клавиша Shift также используется при включении опции Shift 

Click To Select (подразделы Schematic ⇒ Graphical Editing и PCB Editor ⇒ 

General из окна Preferences) для выделения примитивов, отмеченных в спис-

ке, появляющемся при нажатии кнопки Primitives; 

– снять выделение со всех объектов можно щелчком ЛКМ в любом сво-

бодном месте рабочего поля (требуется включение опции Click Clears Selec-

tion из табл. Г.3 и Г.4). Также можно воспользоваться комбинацией клавиш 

Shift+C (очистка объектов в фильтре) или кнопкой Clear в нижнем правом 

углу рабочего поля (см. рис. 5.9). 

2. Массовое выделение мышкой. 

При выделении слева направо выделенными окажутся 

только полностью попавшие в контур выделения объекты, 

при этом контур имеет синий цвет как на рис. Г.4, а (в ре-

дакторах ПП и посадочных мест синим цветом также за-

крашена и вся область внутри контура). 

При выделении справа налево выделенными окажутся 

полностью и частично попавшие в контур выделения объ-

екты, а контур имеет зеленый цвет как на рис. Г.4, б (в ре-Рис. Г.4 

а 

б 
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дакторах ПП и посадочных мест зеленым цветом также закрашена и вся об-

ласть внутри контура). 

Примечание. Способы снятия выделения см. в п. 1. 

3. Командами из меню Edit ⇒ Select. 

Примечания: 

– указанное меню также доступно при нажатии клавиши S; 

– для выделения рекомендуется пользоваться именно этим меню (в осо-

бенности в редакторе ПП), так как в этом случае исключаются случайные 

сдвиги объектов; 

– для снятия выделения используются команды из меню Edit ⇒ DeSelect 

(также доступно при нажатии клавиши X). 

3.1. Команды выделения в редакторах схем и УГО (рис. Г.5, а): 

 

– Lasso Select – выделение объектов, полностью попавших в нарисован-

ный зажатой ЛКМ контур произвольной формы и размеров; 

– Inside Area и Outside Area – выделение объектов, полностью попав-

ших и не попавших в прямоугольный контур соответственно; 

– Touching Rectangle – выделение объектов, полностью и частично по-

павших в прямоугольный контур; 

– Touching Line – выделение объектов, пересекающихся с проведенной 

зажатой ЛКМ линией; 

– All – выделение всех объектов; 

– Connection – выделение всех объектов, электрически связанных с ука-

занным объектом (пины, все сегменты линий электрической связи, подклю-

ченных к пинам, и идентификаторы цепей), с их маскированием.  

Примечание. Команда недоступна в редакторе УГО; 

– Toggle Selection – режим одиночного выделения щелчками ЛКМ. 

Рис. Г.5 

а б 
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Примечание. В рассмотренных командах заблокированные объекты бу-

дут выделены при отключенной опции Protect Locked Objects (см. табл. Г.3). 

3.2. Команды снятия выделения в редакторах схем и УГО аналогичны по 

действию описанным в п. 3.1, кроме двух (см. рис. Г.5, б): 

– All On Current Document – снятие выделения со всех объектов в те-

кущем документе; 

– All Open Documents – снятие выделения со всех объектов во всех от-

крытых документах. 

3.3. Команды выделения в редакторе ПП (рис. Г.6, а) и редакторе поса-

дочных мест (рис. Г.6, б): 

 

– Select Overlapped – выделение одиночного объекта из множества объ-

ектов, находящихся под курсором мышки, путем их циклического перебора 

(требуется отключение опции Display popup selection dialog из табл. Г.4); 

Рис. Г.6 

а 

б 

в 

г 
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– Select Next – циклическое добавление к предварительно выделенному 

объекту связанных с ним. 

Примечание. Например, если изначально был выделен сегмент трассы, 

то запуск данной команды приведет к следующему циклическому выделению: 

сегмент трассы, все соединенные с ним сегменты трассы на одном слое, все 

соединенные с ним участки металлизации (сегменты трассы, КП и др.), все 

объекты данной цепи, сегмент трассы; 

– Board – выделение всех объектов, находящихся внутри контура ПП 

или пересекающего его. 

Примечание. Заблокированные объекты будут выделены при отключен-

ной опции Protect Locked Objects (см. табл. Г.4); 

– Net – выделение всех (в том числе заблокированных) объектов ука-

занной цепи, кроме полигонов Polygon Pour. 

Примечание. Если щелкнуть ЛКМ в области рабочего поля, в которой 

отсутствуют цепи, то появится окно, в котором можно ввести требуемое 

имя цепи для выделения; 

– Connected Copper – выделение всех (в том числе заблокированных) 

участков металлизации, соединенных с указанным объектом; 

– Physical Connection – выделение всех (в том числе заблокированных) 

сегментов трассы, переходных отверстий и свободных КП (КП посадочных 

мест под выделение не попадают), располагающихся между двумя ближай-

шими КП посадочных мест и соединенных с указанным объектом; 

– Physical Connection Single Layer – команда аналогична команде Phys-

ical Connection, но выделение происходит только на текущем слое и без пере-

ходных отверстий; 

– Component Connections – выделение всех (в том числе заблокиро-

ванных) сегментов трасс, переходных отверстий и свободных КП (КП поса-

дочных мест под выделение не попадают), располагающихся между двумя 

ближайшими КП посадочных мест и соединенных с КП указанного компо-

нента. 

Примечание. Если щелкнуть ЛКМ в области рабочего поля, в которой 

отсутствует компонент, то появится окно, в котором можно ввести тре-

буемое позиционное обозначение; 

– Component Nets – выделение всех (в том числе заблокированных) 

участков металлизации (сегменты трасс, КП и др., кроме полигонов Polygon 

Pour), соединенных с указанным компонентом; 
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– Room Connections – выделение всех (в том числе заблокированных) 

сегментов трасс и связанных с ними переходных отверстий, располагающих-

ся полностью внутри указанной комнаты, при условии непосредственного 

подключения их к КП компонентов. 

Примечание. Если щелкнуть ЛКМ в области рабочего поля, в которой 

отсутствует комната, то появится окно, в котором можно выбрать одну 

из существующих комнат; 

– All on Layer – выделение всех объектов, полностью располагающихся 

на текущем слое (КП посадочных мест под выделение не попадают). 

Примечание. Заблокированные объекты будут выделены при отключен-

ной опции Protect Locked Objects (см. табл. Г.4); 

– Free Objects – выделение всех свободных объектов. 

Примечания: 

– под выделение не попадают компоненты, координаты, размеры, поли-

гоны Polygon Pour, объекты с подстройкой длины; 

– заблокированные объекты будут выделены при отключенной опции 

Protect Locked Objects (см. табл. Г.4); 

– All Locked – выделение всех заблокированных объектов при условии 

отключенной опции Protect Locked Objects (см. табл. Г.4); 

– Off Grid Pads – выделение всех КП, расположенных не в узлах сетки с 

текущим в данный момент шагом. 

Примечание. Команда работает с дюймовой системой координат; 

– Lasso Select, Inside Area, Outside Area, Touching Rectangle, Touching 

Line, All, Toggle Selection – описание см. в п. 3.1. 

Примечания: 

– во всех командах последней группы заблокированные объекты будут 

выделены при отключенной опции Protect Locked Objects (см. табл. Г.4); 

– с зажатой клавишей Shift можно добавлять новые объекты (или 

группы объектов) к уже выделенным; 

– если требуется выделить сразу несколько КП из состава посадочных 

мест, то команды массового выделения необходимо выполнять с зажатой 

клавишей Ctrl. Следует отметить, что если в посадочных местах отклю-

чить опцию Lock Primitives, то также будут выделяться и прочие примити-

вы из их состава (например, линии). 

3.4. Команды снятия выделения в редакторе ПП (рис. Г.6, в) и редакторе 

посадочных мест (рис. Г.6, г) аналогичны по действию описанным в п. 3.3. 
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4. Поиском подобных объектов командой Find Similar Objects (см. Г.6). 

5. По запросу в панели Filter (см. Г.12). 

6. При выборе объектов в некоторых панелях с включенной опцией Se-

lect в верхней их части (например, в панели PCB). 

Примечания: 

– свойства выделенных объектов можно изменить в панели Inspector 

(см. Г.10) или List (см. Г.11); 

– существуют также отдельные нерассмотренные в данном подразде-

ле команды выделения. Например, командой Unions ⇒ Select All In Union в 

редакторе схем можно выделить все объекты, которые находятся в группе 

с указанным объектом. 

Г.6. Команда Find Similar Objects 

Команда Find Similar Objects предназначена для поиска объектов, об-

ладающих набором похожих свойств. На рис. Г.7 приведено окно Find Similar 

Objects с настройками для выбора в схеме Э3 «усилителя» из варианта «П1» 

идентификаторов цепей Power Object с именем +5В. 

 Рис. Г.7 



 

 756 

Особенности работы с окном Find Similar Objects: 

1. Открыть окно можно одним из двух способов: 

– нажать комбинацию клавиш Shift+F (или в любом свободном от ка-

ких-либо объектов месте рабочего поля запустить команду ПКМ ⇒ Find 

Similar Objects), после чего в рабочем поле щелкнуть ЛКМ по объекту, ко-

торый станет заготовкой для задания критериев поиска; 

– на объекте, который станет заготовкой для задания критериев поиска, 

запустить команду ПКМ ⇒ Find Similar Objects (при этом предварительно 

выделять объект не обязательно). 

2. В верхней части окна находится таблица с тремя столбцами со следу-

ющей информацией: 

– левый – имена параметров объекта, который был выбран заготовкой; 

– средний – значения параметров объекта, который был выбран заготов-

кой. Значения можно изменять. Кроме того, поддерживается символ «*»; 

– правый – критерий поиска по значению каждого параметра (Any – лю-

бое, т. е. значение параметра при поиске не учитывается; Same – только сов-

падающее с указанным; Different – любое, кроме указанного).  

Например, если заготовкой был компонент, то запись в значении пара-

метра Component Designator символов C* с включенным критерием Same 

позволит выбрать все конденсаторы. 

3. В нижней части окна доступны следующие опции: 

– Zoom Matching – автоматическое масштабирование рабочего поля для 

отображения найденных объектов; 

– Clear Existing – снятие выделения со всех объектов, не попавших под 

заданные критерии поиска; 

– группа опций Normal, Mask и Dim (рис. Г.8), доступных только для 

редакторов ПП и посадочных мест: Normal – обычное отображение объектов 

(их цвет не изменяется, они все доступны для выделения), Mask – маскиро-

вание выбранных объектов (невыбранные объекты окрашиваются в серый 

цвет и оказываются недоступны для выделения), Dim – затенение невыбран-

ных объектов (все объекты доступны для выделения). 

 Рис. Г.8 
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Примечание. Настройки для опций Mask и Dim задаются из меню Mask 

Level в нижнем правом углу рабочего поля; 

– Mask Matching (доступно только в редакторах схем и УГО) – маски-

рование найденных объектов.  

Примечание. Отличие от опции Mask для редакторов ПП и посадочных 

мест состоит только в том, что невыбранные объекты становятся туск-

лыми, а не серыми; 

– Select Matching – выделение найденных объектов; 

– Create Expression – автоматическое создание запроса по заданным 

критериям, которое будет вставлено в панель Filter (см. Г.12); 

– Run Inspector – запуск панели Inspector (см. Г.10); 

– группа опций с заданием области поиска объектов в редакторе схем: 

Current Document – в текущей схеме, Open Documents – во всех открытых 

схемах (в скрытых схемах поиск не работает), Project Documents – во всех 

схемах проекта (открытых, закрытых и скрытых); 

– группа опций с заданием области поиска объектов в редакторе УГО: 

Current Component – в текущем УГО, All Components – во всех УГО теку-

щей библиотеки; 

– With Same Scope (только в редакторах схем и УГО) – копирование об-

ласти поиска объектов в панель Inspector (см. п. 2.2 из Г.10); 

– Whole Library (только в редакторе посадочных мест) – поиск не толь-

ко в текущем посадочном месте, но и во всей библиотеке (см. рис. Г.8). 

4. Для тестирования правильности выбора объектов в рабочем поле без 

закрытия рассматриваемого окна используется кнопка Apply. 

Г.7. Панель PCB Library 

Панель PCB Library предназначена для работы с библиотекой посадоч-

ных мест.  

Внешний вид панели с подключенной библиотекой посадочных мест 

Others.PcbLib из папки …ИДРЭС\AD library\pcb показан на рис. Г.9. 

Особенности панели: 

1. Доступ к панели осуществляется из группы PCB в дополнительном 

меню (см. рис. 3.1). 

2. В группе Components приводится перечень посадочных мест откры-

той библиотеки с указанием количества КП (Pads) и общего количества гра-

фических примитивов в них (Primitives). 
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Из контекстного меню, вызывае-

мого щелчком ПКМ в любой области 

этой группы, можно запустить различ-

ные команды, например: 

– New Blank Component – созда-

ние нового посадочного места; 

– Copy – копирование выбранного 

посадочного места; 

– Copy Name – копирование име-

ни выбранного посадочного места; 

– Delete – удаление выбранного 

посадочного места; 

– Component Properties – редак-

тирование свойств выбранного компо-

нента; 

– Place – добавить посадочное ме-

сто в файл трассировки (команда ак-

тивна при наличии любого открытого 

файла с расширением «.PcbDoc»). 

Примечания: 

– некоторые команды также доступны из меню Tools; 

– поиск нужного посадочного места можно осуществить одним из 

трех способов: перемещением ползунка, с использованием поля Mask (см. 

п. 3) или с помощью ввода символов с 

клавиатуры прямо в этой группе. 

3. Для фильтрации посадочных 

мест в группе Components предназна-

чено поле Mask из верхней области 

панели. Доступен символ «*». 

Например, для маски «*08» в 

списке останутся посадочные места, в 

любом месте названия которых есть 

цифры 08 (рис. Г.10). 

4. В группе Components Primitives приводятся графические примитивы 

в выбранном посадочном месте с указанием типа (Type), имени (Name), раз-

меров по горизонтали (X-Size) и вертикали (Y-Size), а также слоя расположе-

Рис. Г.9 

Рис. Г.10 
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ния (Layer). По умолчанию здесь приводятся только КП (Pads), переходные 

отверстия (Vias), линии (Tracks) и дуги (Arcs).  

Из контекстного меню, вызываемого щелчком ПКМ в любой области 

этой группы, можно включить отображение других типов примитивов, а 

также перейти в свойства выбранного примитива. 

Примечание. Данные столбцов можно сортировать. 

5. В верхней области панели собраны опции, влияющие на отображение 

в рабочем поле выбранных объектов из группы Components Primitives: 

– группа опций Normal, Dim и Mask (см. п. 3 из Г.6); 

– Select – выделение выбранных примитивов в рабочем поле; 

– Zoom – автоматическое масштабирование рабочего поля для отобра-

жения выбранных примитивов; 

– Clear Existing – снятие выделения со всех примитивов из предыдущих 

выделений; 

– Apply – применение настроек при их изменении; 

– Clear – снятие выделения со всех объектов и очистка фильтрации (все 

объекты отображаются как при опции Normal). 

Примечание. Также это действие можно выполнить комбинацией кла-

виш Shift+C и кнопкой Clear в нижнем правом углу рабочего поля; 

– Magnify – режим увеличения (см. п. 6.2). 

6. В нижней области панели располагается окно мини-просмотра, в ко-

тором отображается графика выбранного посадочного места. 

Данное окно может работать в двух режимах: 

6.1. Стандартный. В этом режиме приводится изображение посадочного 

места без механических слоев.  

Прямоугольным контуром показан размер рабочего поля и положение 

посадочного места относительно него. При изменении масштаба в рабочем 

поле или перемещении посадочного места будут происходить и соответ-

ствующие изменения в данном окне. Также верно и обратное: контур можно 

перемещать или изменять его размеры за характерные точки. 

6.2. Детальный просмотр. 

Для перехода в этот режим необходимо нажать кнопку Magnify из верх-

ней области панели и подвести курсор мышки к интересующему месту в ра-

бочем поле. В окне мини-просмотра при этом будет показано изображение 

посадочного места с механическими слоями в измененном масштабе, управ-

ление которым осуществляется кнопками PgUp (увеличение) и PgDn 
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(уменьшение) при расположении курсора мышки в этом окне. Возвращение в 

стандартный режим – клавиша Esc или щелчок ПКМ. 

7. Данные столбцов панели можно сортировать. Порядок сортировки 

(прямой или обратный) выбирается щелчком ЛКМ по названию требуемого 

столбца. Индикацией служит серый треугольник. 

8. При необходимости окно мини-просмотра и группу Component Primi-

tives можно скрыть, щелкнув ЛКМ по галочкам справа от них. 

Г.8. Панель SCH Library 

Панель SCH Library предназначена для работы с библиотекой УГО.  

Внешний вид панели с подключенной библиотекой УГО IntegratedCir-

cuits.SchLib из папки …ИДРЭС\AD library\sch показан на рис. Г.11, при 

этом для выбранного УГО микросхемы HMC291SE подключено посадочное 

место и добавлен поставщик. В оригинальной библиотеке информация о по-

ставщиках не используется, а посадочные места не добавляются, так как она 

является частью библиотеки в виде базы данных (см. Г.34). 

 

Особенности панели: 

1. Доступ к панели осуществляется из группы SCH в дополнительном 

меню (см. рис. 3.1). 

2. В группе Components приводится перечень УГО открытой библиоте-

ки с их описанием в столбце Description (при наличии). 

Назначение кнопок под группой: 

Рис. Г.11 
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– Place – добавление выбранного УГО компонента на схему (если нет 

открытых схем, то автоматически будет создан пустой лист схемы); 

– Add – создание нового УГО; 

– Delete – удаление выбранного УГО; 

– Edit – редактирование свойств выбранного УГО. 

Примечания:  

– при создании УГО также следует обратить внимание на команды из 

меню Tools и из контекстного меню, вызываемого щелчком ПКМ в любой об-

ласти этой группы; 

– способы поиска нужного УГО аналогичны описанным в примечании к 

п. 2 из Г.7. 

3. Для фильтрации УГО в группе Components предназначено поле в 

верхней области панели (см. п. 3 из Г.7). 

4. Пиктограмма с троеточием позволяет настроить масштабирование 

выбираемых УГО в группе Components (рис. Г.12): 

– Do Not Change Zoom Between Components – не изменять масштаб в 

рабочем поле при выборе УГО; 

– Remember Last Zoom For Each Component – запоминать масштаб в 

рабочем поле для каждого УГО; 

– Center Each Component In Editor – расположение каждого выбранно-

го УГО в центре рабочего поля с изменением масштаба в рабочем поле в со-

ответствии с настройкой Zoom Precision. 

 

Примечание. Настройки являются системными и также могут быть 

заданы в подразделе Schematic ⇒ Library AutoZoom окна Preferences (команда 

DXP ⇒ Preferences). 

5. В группе Aliases можно указать аналоги компонентов (например, от 

других производителей). 

Примечание. Добавленный в эту группу аналог появится в виде отдель-

ного компонента в подключенной библиотеке в панели Libraries. Однако 

пользоваться этой возможностью не рекомендуется, так как нельзя зара-

Рис. Г.12 
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нее присвоить уникальные значения параметрам компонента. Поэтому дан-

ную группу обычно скрывают (см. п. 8 из Г.7). 

6. В группе Pins содержится список пинов выбранного УГО (их номера, 

имена и типы) и соответствующие номера КП из подключенного посадочно-

го места. 

7. В группе Model приводятся все подключенные к выбранному УГО 

модели (посадочные места, модели для схемотехнического моделирования и 

для анализа целостности сигналов). 

8. В группе Supplier приводятся выбранные пользователем поставщики 

данного компонента. 

Примечания: 

– из контекстного меню, вызываемого щелчком ПКМ в любой области 

этой группы, можно выбрать отображаемые столбцы; 

– настройки поиска поставщиков осуществляется в подразделе Data 

Management ⇒ Suppliers окна Preferences (команда DXP ⇒ Preferences). 

Например, для поиска компонентов у поставщиков Mouser и Digi-Key по-

требуется указать данные личного аккаунта. 

9. В нижней области панели располагается окно просмотра информации 

о компоненте от выбранного поставщика в виде таблицы. 

Примечание. При работе с группой Supplier и указанным окном про-

смотра сильно замедляется работа при переключении между компонента-

ми. Также требуется подключение к сети Интернет. Поэтому обычно дан-

ные группы не используют и скрывают (см. п. 8 из Г.7). 

10. Данные столбцов панели можно сортировать (см. п. 7 из Г.7). 

Г.9. Панель Libraries 

Панель Libraries предназначена для работы с библиотеками компонен-

тов в редакторах схем и ПП.  

Внешний вид панели с открытой библиотекой диодов (VD) из состава 

библиотеки компонентов в виде базы данных ИДРЭС-ADLibrary.DbLib из 

папки …ИДРЭС\AD library показан на рис. Г.13. 

Особенности панели: 

1. Доступ к панели осуществляется из групп SCH и PCB (в зависимости 

от используемого редактора) в дополнительном меню (см. рис. 3.1). 

2. Кнопка Libraries позволяет управлять подключениями библиотек 

компонентов. 
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После ее нажатия появляется окно Available Libraries с тремя вкладка-

ми (см. рис. 8.7): 

 – Project – библиотеки, подключенные к активному в данный момент 

проекту; 

– Installed – библиотеки, доступные для любого проекта; 

– Search Path – библиотеки, подключенные к активному в данный мо-

мент проекту из указанных директорий.  

Примечания:  

– на вкладке Search Path нельзя добавить интегрированные библиотеки 

(расширение «.IntLib») и библиотеки УГО (расширение «.SchLib»); 

– поиск библиотек компонентов в окне Available Libraries происходит 

сначала в порядке расположения вкладок, а затем в порядке отображения 

их на этих вкладках (на вкладках Project и Installed порядок можно поменять 

кнопками Move Up и Move Down); 

– примеры подключения библиотек на вкладках Project и Search Path 

приведены в п. 8 из 8.2; 

– пример подключенной библиотеки на вкладке Installed показан на 

рис. Г.14 (добавление библиотеки в список установленных осуществляется 

кнопкой Install и удаление из него кнопкой Remove). 

Каждая установленная библиотека может быть подключена и отклю-

чена (опция Activated), что позволяет использовать требуемый в данный 

момент набор библиотек без повторного их добавления и удаления. 

Рис. Г.13 
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В столбце Path можно указать как полный путь к библиотеке, так и 

относительный (например, только название файла библиотеки). В послед-

нем случае изменением директории в поле Library Path Relative To можно 

оперативно управлять доступными в данный момент библиотеками, распо-

ложенными по указанному пути (отсутствующие библиотеки будут под-

свечены красным цветом); 

– настройки на вкладке Installed являются системными и также могут 

быть заданы в подразделе Data Management ⇒ Installed Libraries окна Prefer-

ences (команда DXP ⇒ Preferences). 

3. Кнопка Search позволяет осуществлять поиск компонентов в добав-

ленных библиотеках. 

4. Кнопка Place служит для добавления вы-

бранного компонента в схему (см. Г.28). 

5. Под кнопками располагается список со 

всеми доступными библиотеками. Выбранная в 

нем библиотека является текущей, и именно с 

ней осуществляется работа. 

Пиктограмма с тремя точками служит для 

указания типов библиотек, которые отобража-

ются в списке доступных библиотек (рис. Г.15): 

– Components – библиотеки компонентов; 

– Footprints – библиотеки посадочных мест; 

– 3D Models – библиотеки 3D-моделей корпусов компонентов с расши-

рением «.PCB3D» (устаревшие библиотеки). 

6. Под списком с доступными библиотеками находится поле для филь-

трации компонентов в текущей библиотеке. 

Например, при записи цифр «06» в списке компонентов останутся толь-

ко те, у которых в любом месте текстовых данных из отображаемых в дан-

ный момент столбцов есть группа из этих цифр (рис. Г.16, а). 

Рис. Г.14 

Рис. Г.15 
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7. Под списком с доступными библиотеками и полем для фильтрации 

находится область со списком компонентов из текущей библиотеки. 

Из контекстного меню, вызываемого щелчком ПКМ внутри этой обла-

сти, можно запустить различные команды, например: 

– Refresh Library – обновление информации из текущей библиотеки; 

– Refresh All – обновление информации из всех доступных библиотек; 

– Select Columns – управление списком отображаемых столбцов. 

Примечания: 

– данные столбцов можно сортировать (см. п. 7 из Г.7); 

– для библиотек компонентов в виде базы данных можно осуществить 

дополнительную сортировку по информации из любого отображаемого 

столбца. Для этого требуемый заголовок перетаскивается в темно-серое 

поле над списком компонентов. Например, на рис. Г.16, б осуществлена сор-

тировка по данным параметра Description. 

8. Под списком с компонентами текущей библиотеки находятся следу-

ющие области, которые можно скрыть: 

– окно просмотра УГО выбранного компонента; 

– список моделей выбранного компонента (посадочные места, модели 

для схемотехнического моделирования и для анализа целостности сигналов). 

Примечание. В этой области можно управлять списком отображае-

мых столбцов и осуществлять сортировку данных в них; 

– окно просмотра посадочных мест и 3D-моделей. 

Примечание. В этом окне доступны два режима просмотра (2D и 3D), 

переключение между которыми осуществляется с помощью соответству-

ющей пиктограммы. Управление изображением в 3D-режиме просмотра 

описано в Г.3 (сфера управления не отображается); 

Рис. Г.16 

а б 
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– области с поставщиками выбранного компонента и информацией от 

поставщиков (см. пп. 8 и 9 из Г.8). 

Примечание. Данные области скрыты, так как не используются (см. 

примечание к п. 9 из Г.8). 

Г.10. Панель Inspector 

Панель Inspector используется для просмотра и редактирования свойств 

одного или нескольких выделенных в рабочем поле объектов. 

В зависимости от редактора, с которым производится работа, панель 

имеет следующие названия: 

– в редакторе схем – SCH Inspector; 

– в редакторе УГО – SCHLIB Inspector; 

– в редакторе ПП – PCB Inspector; 

– в редакторе посадочных мест – PCBLIB Inspector. 

Внешний вид панели для выбранного позиционного обозначения C5 в 

схеме Э3 «усилителя» из варианта «П1» показан на рис. Г.17, а. 

 

Особенности панели: 

1. Доступ к панели осуществляется из групп SCH и PCB (в зависимости 

от используемого редактора) в дополнительном меню (см. рис. 3.1). 

2. В верхней области панели задаются настройки фильтрации объектов: 

Рис. Г.17 

а 

б 

в 

г 
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2.1. Параметр Include определяет объекты, свойства которых отобража-

ются в панели: 

– Display all objects – все выделенные в рабочем поле объекты; 

– Display only – только выбранные в списке типы объектов среди выде-

ленных в рабочем поле (рис. Г.17, б). 

2.2. Параметр from определяет область расположения объектов: 

– в панели SCH Inspector (рис. Г.17, в): current document, open docu-

ments или open documents of the same project; 

– в панели SCHLIB Inspector (рис. Г.17, г): Current Component или All 

Components. 

Примечания: 

– описание указанных опций приведено в п. 3 из Г.6; 

– данный параметр можно изменить автоматически при использова-

нии команды Find Similar Objects с опцией With Same Scope (см. п. 3 из Г.6); 

– в панелях PCB Inspector и PCBLIB Inspector параметр отсутствует. 

3. В средней области панели приводится список свойств выделенных в 

рабочем поле объектов с учетом настроек фильтрации из п. 2:  

– левый столбец – наименования параметров; 

– правый столбец – значения параметров, которые можно изменять. 

Примечания: 

– если параметры выделенных объектов 

имеют различающиеся значения, то в правом 

столбце приводится обозначение как на 

рис. Г.18 для параметра Object Kind (тип объ-

екта); 

– для выделенной группы объектов в па-

нели отображаются только общие для них 

свойства. Например, на рис. Г.18 показан вид 

панели PCB Inspector после выделения на ПП 

из варианта «П1» всех объектов, подключен-

ных к цепи +5В (трассы, полигоны и КП); 

– отдельные параметры в списке могут отображаться в виде ссылок 

(например, параметр Net на рис. Г.18), что означает возможность про-

смотра и редактирования их свойств после щелчка ЛКМ.  

Во многих случаях можно вернуться обратно, нажав на соответству-

ющую ссылку. Например, ссылка Owner (владелец) на рис. Г.17, а приведет к 

Рис. Г.18 
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отображению свойств конденсатора с указанным позиционным обозначени-

ем, а ссылка Component Designator из свойств конденсатора позволит вер-

нуться к свойствам объекта Designator. 

4. В нижней области панели приводится информация о количестве вы-

бранных объектов и области их нахождения (см. рис. Г.17, а и Г.18). 

Г.11. Панель List 

Панель List используется для просмотра и редактирования свойств од-

ного или нескольких объектов, при этом сами объекты не обязательно пред-

варительно выбирать в рабочем поле, а свойства можно изменять как сразу 

для всех интересующих объектов, так и по отдельности.  

В зависимости от редактора, с которым производится работа, панель 

имеет следующие названия: 

– в редакторе схем – SCH List; 

– в редакторе УГО – SCHLIB List; 

– в редакторе ПП – PCB List; 

– в редакторе посадочных мест – PCBLIB List. 

Внешний вид панели в режиме просмотра пинов для УГО с наименова-

нием GALI_ из библиотеки IntegratedCircuits.SchLib из папки …ИДРЭС\ 

AD library\sch показан на рис. Г.19. 

 

Особенности панели: 

1. Доступ к панели осуществляется из групп SCH и PCB (в зависимости 

от используемого редактора) в дополнительном меню (см. рис. 3.1). 

2. В верхней области панели первая опция определяет режим работы: 

– View – только просмотр; 

– Edit – просмотр и редактирование. 

3. Следующие за режимом работы опции задают настройки фильтрации 

объектов: 

Рис. Г.19 
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3.1. Вид объектов: 

– all objects – все объекты; 

– selected objects – только предварительно выделенные в рабочем поле; 

– non-masked objects – только незамаскированные объекты, т. е. пред-

варительно отфильтрованные с помощью запроса из панели Filter (см. Г.12) 

или найденные командой Find Similar Objects (см. Г.6). 

3.2. Область расположения объектов (параметр from): 

– в панели SCH List: current document, open documents или open docu-

ments of the same project; 

– в панели SCHLIB List: current component или all components; 

– в панели PCBLIB List: current component (в текущем посадочном ме-

сте) или whole library (во всех посадочных местах текущей библиотеки). 

Примечания: 

– описание опций для панелей SCH List и SCHLIB List дано в п. 3 из Г.6; 

– в панели PCB List параметр отсутствует. 

3.3. Типы объектов, для которых отображаются свойства в панели (па-

раметр Include).  

Примечание. Опции данного параметра описаны в п. 2.1 из Г.10. 

4. В средней области панели содержится таблица со свойствами выбран-

ных объектов с учетом настроек фильтрации из п. 3. 

Особенности работы с таблицей: 

– при щелчке ЛКМ по строке, относящейся к интересующему объекту, 

он будет выделен в рабочем поле. 

Примечание. Поддерживается выбор нескольких объектов с клавишами 

Ctrl (добавление указанного объекта к уже выбранным) и Shift (добавление 

всех объектов между исходным и указанным); 

– при двойном щелчке ЛКМ по строке, относящейся к интересующему 

объекту, открывается окно его свойств; 

– данные в каждом столбце могут быть отсортированы (см. п. 7 из Г.7); 

– данные столбцов можно копировать в MS Excel и вставлять из него, 

что удобно при заполнении функциональных назначений пинов в УГО мно-

говыводных микросхем; 

– доступны дополнительные команды из контекстного меню, вызывае-

мого щелчком ПКМ в любом месте таблицы. Например, командой ПКМ ⇒ 

Choose Columns в группе Visible Columns окна Columns Setup кнопками Up 

и Down можно изменить порядок расположения столбцов. 
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5. В нижней области панели приводится следующая информация: 

– количество объектов, отображаемых в таблице (количество строк); 

– общее количество объектов выбранного вида (см. п. 3.1); 

– количество выделенных объектов.  

Г.12. Панель Filter 

Панель Filter используется для создания запросов на выбор объектов 

для последующего их редактирования.  

В зависимости от редактора, с которым производится работа, панель 

имеет следующие названия: 

– в редакторе схем – SCH Filter; 

– в редакторе УГО – SCHLIB Filter; 

– в редакторе ПП – PCB Filter; 

– в редакторе посадочных мест – PCBLIB Filter. 

Особенности панели: 

1. Доступ к панели осуществляется из групп SCH и PCB (в зависимости 

от используемого редактора) в дополнительном меню (см. рис. 3.1). 

2. Панели SCH Filter и SCHLIB Filter. 

2.1. Внешний вид панели SCH Filter показан на рис. Г.20. 

 

2.2. В группе Limit search to задаются объекты, на которые будет дей-

ствовать запрос: 

– All Objects – все; 

– Selected Objects – только предварительно выделенные; 

– Non Selected Objects – только предварительно невыделенные. 

2.3. В списке Consider objects in задается область действия запроса: 

Current Document, Open Documents или Project Documents (см. п. 3 из Г.6). 

Рис. Г.20 



 

 771 

В панели SCHLIB Filter вместо этого списка присутствует опция Whole 

Library (действие запроса на все компоненты библиотеки). 

2.4. В группах Objects passing the filter и Objects not passing the filter 

задаются опции, применяемые соответственно к объектам, которые попали и 

не попали под действие запроса: 

– Select – выделение; 

– Zoom – автоматическое масштабирование рабочего поля для отобра-

жения выбранных объектов; 

– Deselect – снятие выделения; 

– Mask out – маскирование (невыбранные объекты становятся тусклыми 

и оказываются недоступны для выделения). 

2.5. Кнопка Apply запускает работу фильтра. 

Примечание. Сбросить результаты действия запроса можно комбина-

цией клавиш Shift+C и кнопкой Clear в нижнем правом углу рабочего поля. 

2.6. Поле Find items matching these criteria служит для написания тек-

ста запроса, который можно создать следующими способами: 

– вручную (при вводе появляется список предлагаемых команд); 

– автоматически на основе критериев поиска, указанных в окне Find 

Similar Objects с включенной опцией Create Expression (см. п. 3 из Г.6); 

– с помощью кнопки Helper (см. п. 2.7). 

Примечание. Некоторые предустановленные запросы можно выбрать 

из списка, открываемого командой ПКМ ⇒ Examples. 

Любой запрос можно сохранить в список предпочтительных для после-

дующего использования командой ПКМ ⇒ Add to Favorites. Просмотреть 

список таких запросов позволяет кнопка Favorites, при этом в открываю-

щемся окне на одноименной вкладке доступны следующие кнопки: 

– Remove – удаление запроса; 

– Rename – переименование запроса; 

– Edit – корректировка текста запроса; 

– Apply Expression – использование запроса. 

Примененные запросы сохраняются в истории, которую можно посмот-

реть с помощью кнопки History, при этом в открывающемся окне на одно-

именной вкладке доступны следующие кнопки: 

– Add To Favorites – добавление запроса в список предпочтительных; 

– Clear History – очистка истории; 

– Apply Expression – использование запроса. 
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2.7. Окно Query Helper, открываемое после нажатия кнопки Helper, по-

казано на рис. Г.21. 

 

Особенности окна Query Helper: 

– поле Query предназначено для ввода текста запроса (при вводе появ-

ляется список предлагаемых команд); 

– кнопки под полем Query – различные операторы, которые можно ис-

пользовать при составлении сложных запросов между командами; 

– в группе Categories содержатся доступные категории команд, полный 

список которых для каждой категории приводится в таблице справа.  

Примечание. Добавление команды из таблицы в поле Query осуществля-

ется двойным щелчком ЛКМ по ней; 

– поле Mask позволяет осуществить поиск команды в выбранной кате-

гории (доступен символ «*»); 

– кнопка Check Syntax позволяет проверить правильность написания 

введенного запроса (но не правильность его работы). 

Примечание. По каждой команде из поля Query можно получить справ-

ку, нажав на ней клавишу F1, однако для этого требуется подключение к 

сети Интернет. Описание команд также доступно в [144]. 

2.8. Примеры некоторых запросов, используемых в редакторах схем и 

УГО, приведены в табл. Г.8. 

Рис. Г.21 
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Таблица Г.8 

Примеры запросов в редакторах схем и УГО 

Запрос Выбираемый объект 

IsWire Линии электрической связи 

IsPart Компоненты 

IsPolyline Линии 

PartDesignator = 'DA2' Компонент DA2 

IsPowerObject And (StringText = '+5В') 
Идентификаторы цепей Power Port  

с именем +5В 

PowerObjectStyle = 'GOST Arrow' 
Идентификаторы цепей Power Port  

с символом стрелки 

(IsDesignator Or IsComment)  

And (Object_Orientation(Parent) = '0 Degrees')  

And (Object_DesignItemID(Parent) Like '*Polar*') 

См. п. 9.5 из 8.3 
(IsDesignator Or IsComment)  

And (Object_Designator(Parent) like 'C*') And Not 

(Object_DesignItemID(Parent) Like '*Polar*') And  

((Object_Orientation(Parent) = '90 Degrees') Or (Ob-

ject_Orientation(Parent) = '270 Degrees')) 

3. Панели PCB Filter и PCBLIB Filter. 

3.1. Внешний вид панели PCB Filter показан на рис. Г.22. 

 

3.2. В верхней области панели PCBLIB Filter есть опция Filter The 

Whole Library (действие запроса на все компоненты библиотеки). 

3.3. Группа Select objects to highlight предназначена для оперативного 

выбора объектов и их принадлежности (Net – подключены к цепям, Comp – 

Рис. Г.22 
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находятся в составе компонентов, Free – не принадлежат компонентам) пу-

тем установки галочек в соответствующих ячейках. 

В панели PCBLIB Filter из этой группы исключены столбцы Net и Comp, 

а также объекты Component и Room. 

3.4. Группа Layer предназначена для оперативного выбора слоев распо-

ложения объектов. 

Общими для панелей являются слои, указанные в структуре ПП, и слои 

паяльной пасты (см. табл. Г.14). Кроме того, в панели PCB Filter также до-

ступны системные классы слоев и пользовательские классы. 

3.5. В группах Matching и Non-matching задаются опции, применяемые 

соответственно к объектам, которые попали и не попали под действие запро-

са. Они соответствуют рассмотренным в п. 2.4. 

Дополнительно для объектов Non-matching можно выбрать режим Nor-

mal, Mask или Dim (см. п. 3 из Г.6). 

Таблица Г.9 

Примеры запросов в редакторах ПП и посадочных мест 

Запрос Выбираемый объект 

All Все (см. п. 1 из Г.47) 

IsTrack And OnLayer('Top Layer') Линии на слое Top Layer 

InNamedPolygon('TopGND') Полигон с именем TopGND (см. п. 3.2.4 из Г.26) 

IsText And IsComponentSelected  

And OnLayer('M3 Top Assy') 
См. примечание к п. 17.2 из 12.3 

IsPad And Not InAnyComponent 
Любые КП, которые не принадлежат компонен-

там (см. п. 23.1 из 12.3) 

Locked 
Заблокированные объекты (см. примечание к 

п. 23.2 из 12.3) 

IsPad And InNet('Net_W1') 
КП, подключенные к цепи Net_W1 (см. приме-

чание к п. 5.10 из 12.5) 

IsVia And IsFree 
Свободные переходные отверстия без подклю-

чения к цепи (см. п. 16.1 из 12.5) 

IsConnection Связывающие линии (см. п. 16.11 из 12.5) 

(IsVia Or IsPad) And InAnyNet 
КП и переходные отверстия, подключенные к 

любой цепи (см. п. 16.13 из 12.5) 

InPoly Полигоны Polygon Pour (см. п. 16.16 из 12.5) 

(IsArc Or IsTrack)  

And OnLayer('Top Overlay')  

And InComponentClass('CompShield') 

См. п. 22.1 из 12.5 

(IsVia And InAnyNet)  

Or ((IsText And InAnyComponent) 

And OnLayer('Top Overlay')) 

См. п. 22.2 из 12.5 
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3.6. Кнопки в нижней области панели имеют следующее назначение: 

– Clear – сброс результат действия запроса. 

Примечание. Также это действие можно выполнить комбинацией кла-

виш Shift+C и кнопкой Clear в нижнем правом углу рабочего поля; 

– Apply to Selected – применение запроса только к предварительно вы-

деленным объектам; 

– Apply to All – применение запроса ко всем объектам. 

3.7. Поле Filter служит для написания текста запроса, и оно аналогично 

по работе рассмотренному в п. 2.6 полю Find items matching these criteria. 

Кроме того, дополнительно к описанным способам создания запросов 

добавляются еще два: 

– с помощью групп из пп. 3.2 и 3.3; 

– с помощью кнопки Builder в окне Building Query from Board. 

Примечания: 

– пример построения запроса в окне Building Query from Board с ком-

ментариями приведен в п. 16.7 из 12.5; 

– в более сложных запросах (см. рис. 12.112) вместо последующей руч-

ной расстановки скобок можно изменить уровень вхождения с помощью 

пиктограмм стрелок влево и вправо. 

3.8. Примеры запросов, используемых в редакторах ПП и посадочных 

мест, приведены в табл. Г.9. 

Г.13. Панель Navigator 

Панель Navigator используется в редакторе схем для просмотра списка 

электрических объектов схемы (компонентов и их классов, цепей и их клас-

сов, шин и т. д.) и их взаимосвязей. 

Внешний вид панели для проекта из варианта «П1» показан на рис. Г.23. 

Особенности панели: 

1. Доступ к панели осуществляется из группы Design Compiler в допол-

нительном меню (см. рис. 3.1). 

2. Для появления информации в панели требуется компиляция проекта. 

3. Панель состоит из четырех областей: 

– область Documents со списком листов схем проекта. В обычных одно-

листовых и многолистовых проектах здесь находится строка Flattened Hier-

archy (плоская иерархия проекта, т. е. сразу все его листы) и строки с от-

дельными листами проекта; 
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– область Instance со списком компонентов и их классов. В группе каж-

дого компонента всегда содержатся значения пользовательских параметров и 

наименование посадочного места. Наличие информации о пинах определяет-

ся опцией Pins из п. 4; 

– область Net / Bus со списком цепей, их классов и шин. Содержание 

информации в группе каждой цепи полностью определяется опциями из п. 4; 

– область Net Pins, которая содержит данные, полностью определяемые 

опциями из п. 4, о любой выбранной строке из трех остальных областей. 

4. Данные, которые дополнительно отображаются в группе каждого объ-

екта из областей Instance, Net / Bus и Net Pins задаются в группе Objects To 

Display (рис. Г.24) из подраздела System ⇒ Navigation окна Preferences (ко-

манда DXP ⇒ Preferences). 

 

Здесь можно включить отображение пинов (Pins), линий электрической 

связи (Graphical Lines) и идентификаторов (Ports, Sheet Connectors, Net 

Labels, Sheet Entries и Sheet Symbols из Г.27). 

Примечание. Доступ к указанном подразделу также осуществляется 

кнопкой с троеточием в верхней части панели (рис. Г.23). 

Рис. Г.24 

Рис. Г.23 
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5. Объекты можно выбирать как в панели щелчком ЛКМ, так и в рабо-

чем поле, предварительно запустив интерактивный режим кнопкой Interac-

tive Navigation в верхней части панели. Перемещаться по истории выбора 

можно с помощью пиктограмм с треугольником, расположенных слева и 

справа от указанной кнопки. 

Выбор строки в верхней области панели определяет объекты, которые 

будут отображаться в трех оставшихся областях (для всех листов проекта или 

для какого-то отдельного). 

Информация в трех нижних областях меняется в зависимости от вы-

бранного объекта, например: 

– при выборе компонента в рабочем поле будет раскрыта его группа в 

области Instance и отобразятся его пины в области Net Pins (при условии 

включения опция Pins на рис. Г.24); 

– при выборе цепи в рабочем поле будет раскрыта ее группа в области 

Net / Bus и в области Net Pins отобразятся пины компонентов, подключен-

ные к ней, и метка цепи, если она была размещена на этой цепи (при условии 

включения опций Pins и Net Labels на рис. Г.24); 

– если выбрать пин компонента в области Net Pins, то он будет выделен 

в соответствующих группах в областях Instance и Net / Bus. 

Кроме того, выбранные объекты в областях Instance, Net / Bus и Net 

Pins автоматически подсвечиваются в рабочем поле (см. п. 6). 

6. Подсветка объектов в рабочем поле как при их выборе в панели, так и 

при выборе в интерактивном режиме определяется опциями группы High-

light Methods (рис. Г.25) из подраздела System ⇒ Navigation окна Prefer-

ences (команда DXP ⇒ Preferences): 

 

– Selecting – выделение выбранного объекта (и связанных с ним при 

включенной опции Connective Graph), что позволяет настроить его свойства в 

панелях SCH List и SCH Inspector. Однако это не приводит к выделению объ-

екта на ПП даже при включенном режиме Cross Select Mode (см. Г.35); 

Рис. Г.25 
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– Masking – затенение объектов, не относящихся к выбранному (и свя-

занных с ним при включенной опции Connective Graph); 

– Zooming – масштабирование на выделенном объекте (и связанных с 

ним при включенной опции Connective Graph). Настройка масштаба осу-

ществляется перемещением ползунка от Far (далеко) до Close (вписать объ-

екты в рабочее поле); 

– Connective Graph – отображение объектов, связанных с выбранным, с 

добавлением соединяющих линий (граф связности) зеленого цвета при рабо-

те с компонентами и красного цвета при работе с цепями. 

Примечание. Если линия электрической связи нарисована с разрывом, то 

соединяющая линия будет изображена с пунктиром (см. рис. 8.64); 

– Include Power Parts – отображать компоненты, которые связаны с вы-

бранным с помощью идентификаторов цепей Power Port. 

Примечания: 

– во многолистовых проектах рекомендуется включить одновременное 

отображение вкладок с листами схемы (см. п. 10.4 из 12.3); 

– очистка подсветки осуществляется комбинацией клавиш Shift+C или 

кнопкой Clear в нижнем правом углу рабочего поля (см. рис. 5.9). 

7. Выбор объекта в панели (или в рабочем поле при интерактивном ре-

жиме) с зажатой клавишей Alt приведет к его подсветке также и в открытом 

файле трассировки, даже если режим Cross Select Mode выключен (см. Г.35). 

Примечания: 

– подобную возможность удобно использовать при одновременном 

отображении вкладок со схемой и файлом трассировки (см. п. 10.4 из 12.3); 

– включенная опция Connective Graph (см. п. 6) не приводит к подсветке 

связанных объектов в файле трассировки. 

8. Опция Show Signals в верхней части панели (см. рис. Г.23) преобразу-

ет область Net / Bus в область Signal для просмотра сигналов. 

Примечание. С библиотечными компонентами из данного учебного по-

собия данная опция не представляет интереса. 

9. После компиляции проекта в дополнение к вкладке Editor, в которой 

осуществлялось создание текущего листа схемы, появится вкладка с наиме-

нованием этого листа, предназначенная только для его просмотра.  

Примечание. Перейти на нее можно либо выбрав ее в рабочем поле, ли-

бо дважды щелкнув ЛКМ по строке с соответствующим листом в области 

Documents. 
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Г.14. Панель PCB 

Панель PCB используется для просмотра объектов с ПП. 

Особенности панели: 

1. Доступ к панели осуществляется из группы PCB в дополнительном 

меню (см. рис. 3.1). 

2. В верхней области панели собраны опции, влияющие на отображение 

выбранных в ней объектов в рабочем поле (рис. Г.26, а): 

 

– группа опций Normal, Dim и Mask (см. п. 3 из Г.6); 

– опции Select, Zoom, Clear Existing, Apply и Clear аналогичны опи-

санным в п. 5 из Г.7; 

– Zoom Level – настройка уровня для опции Zoom перемещением пол-

зунка от Far (далеко) до Close (вписать объекты в рабочее поле).  

Примечание. Настройка является системной и также может быть 

задана в группе Highlight Methods (см. рис. Г.25) из подраздела System ⇒ Nav-

igation окна Preferences (команда DXP ⇒ Preferences). 

3. В нижней области панели находится окно мини-просмотра с изобра-

жением ПП без механических слоев (рис. Г.26, б). 

Примечание. Особенности данного окна описаны в п. 6.1 из Г.7. 

4. Остальная область панели образована тремя частями, информация в 

которых зависит от выбранного режима работы панели из списка, располо-

женного в верхней части панели (рис. Г.26, а). 

Часто используемые режимы работы: 

4.1. Nets (цепи). В этом режиме в средней области панели приводится 

следующая информация (рис. Г.27): 

– классы цепей; 

– цепи выбранных классов; 

– примитивы выбранных цепей. 

Рис. Г.26 

а б 
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 В каждой части можно осуще-

ствить сортировку информации и от-

крыть свойства выбранного объекта 

для его редактирования. 

Особенности режима: 

4.1.1. В списке классов цепей ко-

мандами Add Class и Delete Class из 

контекстного меню (щелчок ПКМ) 

можно создать новый класс или уда-

лить выбранный соответственно. 

Класс All Nets присутствует все-

гда и включает в себя все цепи. 

4.1.2. В списке с цепями можно 

изменить количество столбцов с информацией командой ПКМ ⇒ Columns. 

Назначение столбцов: 

– «*» – цветной ореол в ячейке показывает цвет, заданный для данной 

цепи. Этим цветом обозначаются связывающие линии, и его можно поменять 

в свойствах цепи. При установке галочки в ячейке в цвет цепи окрасятся все 

объекты, которые к ней подключены. 

Примечание. Настройки окраски задаются в подразделе PCB Editor ⇒ 

Board Insight Color Overrides окна Preferences (команда DXP ⇒ Preferences); 

– Name – имя цепи; 

– Node Count – количество КП в данной цепи; 

– Total Pin/Package Length – сумма значений всех параметров Pin/Pkg 

Length, заданных в КП для учета длин выводов компонентов; 

– Routed Length – сумма длин всех трасс (линии и дуги) с учетом высот 

переходных отверстий, расположенных на них; 

– Unrouted (Manhattan) – манхэттенское расстояние всех участков це-

пей со связывающими линиями (сумма модулей разностей их координат); 

– Signal Length – суммарная длина прохождения сигнала: Unrouted 

(Manhattan), Total Pin/Package Length, длины прохождения сигнала по объек-

там, отличным от линий и дуг (например, по полигонам), и Routed Length, но 

за вычетом тупиковых участков трасс и петель. 

Примечание. Значение указывается только для цепей, содержащих две 

КП. В противном случае записывается n/a. Для вычисления длин сигналов це-

пей с большим количеством КП требуется создание объекта xSignals; 

Рис. Г.27 
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– Min и Max – соответственно минимальное и максимальное значения, 

заданные в правилах проектирования (подразделы Length и Matched Lengths 

группы High Speed); 

– Estimated Length – оцениваемая длина (Routed Length и длины связы-

вающих линий, определенных по кратчайшему расстоянию между узлами). 

При наличии заданных правил проектирования в ячейках может присут-

ствовать цветовая индикация (см. примечание к п. 5.8 из 12.5). 

4.1.3. В списке с примитивами по умолчанию приведены не все возмож-

ные объекты. Настроить их отображение можно из контекстного меню, вы-

зываемого щелчком ПКМ. 

4.2. Components (компоненты). В этом режиме в средней области пане-

ли приводится следующая информация (рис. Г.28, а): 

– классы компонентов; 

– компоненты выбранных классов; 

– примитивы выбранных компонентов. 

 

 В каждой части можно осуществить сортировку информации и открыть 

свойства выбранного объекта для его редактирования. 

Особенности режима: 

4.2.1. В списке с классами компонентов можно создать новый класс или 

удалить выбранный (см. п. 4.1.1). 

Кроме пользовательских классов здесь присутствует пять системных: 

– All Components – все компоненты; 

– Bottom Side Components – компоненты с нижней стороны ПП; 

Рис. Г.28 

а б 
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– Inside Board Components – компоненты внутри контура ПП; 

– Outside Board Components – компоненты вне контура ПП; 

– Top Side Components – компоненты с верхней стороны ПП. 

4.2.2. В списке с компонентами командой ПКМ ⇒ Reposition Compo-

nent включается режим размещения выбранного компонента. 

Крайний правый столбец без названия позволяет оперативно управлять 

блокировкой выбранных компонентов. 

4.2.3. Особенности списка с примитивами см. в п. 4.1.3. 

4.3. Unions (группы). В этом режиме в средней области панели приво-

дится следующая информация (см. рис. Г.28, б): 

– категории групп; 

– группы выбранной категории; 

– примитивы выбранных групп. 

В каждой части можно осуществить сортировку информации. 

Особенности режима: 

4.3.1. Примеры категорий: 

– все группы (All Union Types); 

– пользовательские группы (Unions); 

– отдельные системные группы (таблицы отверстий, таблицы структуры 

слоев, меандры для подстройки длины и др.). 

4.3.2. В списке групп полезными могут оказаться следующие команды 

из контекстного меню, вызываемого щелчком ПКМ: 

– Select All In Union – выделить все объекты группы; 

– Deselect All In Union – снять выделение со всех объектов группы; 

– Break objects from Union – исключение объектов из группы. Если в 

открывшемся окне убрать галочки в столбце Keep in Union со всех объектов, 

то группа удалится; 

– Rename – переименование группы. 

4.3.3. В списке примитивов можно открыть свойства выбранного объек-

та для его редактирования. 

4.4. 3D Models (3D-модели). В этом режиме в средней области панели 

приводится следующая информация (рис. Г.29): 

– классы компонентов; 

– компоненты выбранных классов; 

– 3D-модели выбранных компонентов. 

В каждой части можно осуществить сортировку информации. 
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Особенности режима: 

4.4.1. В списке классов компонен-

тов можно только выбрать требуемый. 

4.4.2. В списке с компонентами 

кроме компонентов выбранного класса 

всегда присутствует строка Free Mod-

els. Здесь собраны 3D-модели, которые 

были добавлены в файл трассировки 

пользователем, т. е. они не принадле-

жат никаким компонентам. 

Крайний правый столбец без 

названия позволяет последовательно 

переключать режимы прозрачности 

3D-модели выбранного компонента от 

0 % (Hide, невидимый) до 100 % 

(Solid, полностью видимый) с шагом 25 %. Кроме того, требуемый режим 

можно выбрать сразу из списка. 

Для выбранного компонента доступен переход в окно его свойств. 

4.4.3. При наличии у компонента нескольких 3D-моделей каждой из них 

можно задать разный режим прозрачности (например, так сделано в посадоч-

ных местах применяемых при проектировании SMD-светодиодов). 

В группе 3D Bodies Display Options задаются настройки из подраздела 

PCB Editor ⇒ Display окна Preferences (команда DXP ⇒ Preferences): 

– Show Simple 3D Bodies – видимость 3D-моделей, созданных средства-

ми Altium Designer; 

– Show Generic Models – видимость загруженных 3D-моделей. 

Примечание. Отключение отображения 3D-моделей только в текущей 

ПП производится в группе 3D Bodies окна View Configurations (клавиша L). 

4.5. Pad & Via Templates (шаблоны КП и переходных отверстий). В 

этом режиме в средней области панели приводится следующая информация 

(рис. Г.30): 

– библиотеки; 

– шаблоны выбранных библиотек; 

– КП и переходные отверстия выбранных шаблонов. 

В каждой части можно осуществить сортировку информации. 

Особенности режима: 

Рис. Г.29 
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4.5.1. В списке библиотек всегда 

присутствуют следующие: 

– All – все шаблоны; 

– Pads – только шаблоны КП; 

– Vias – только шаблоны переход-

ных отверстий; 

– Local – шаблоны КП и переход-

ных отверстий из файла трассировки, 

т. е. не из сторонних библиотек. 

Все остальные библиотеки – под-

ключенные. 

4.5.2. В списке шаблонов доступно 

две кнопки: 

– Save as Library – создание новой библиотеки шаблонов КП и пере-

ходных отверстий на основе выбранных шаблонов; 

– Place – добавление в файл трассировки выбранного шаблона из под-

ключенной библиотеки. 

4.5.3. Для каждого объекта из списка КП и переходных отверстий досту-

пен переход в окно его свойств. 

Столбец Changed служит индикацией изменений. В нем автоматически 

появляются галочки у тех КП и переходных отверстий из подключенных 

библиотек, шаблоны которых были изменены в проекте. Внести изменения 

можно кнопкой Update в панели PCB Pad Via Templates (см. Г.16). 

Г.15. Панель PCB Rules And Violations 

Панель PCB Rules And Violations используется в редакторе ПП для ра-

боты c нарушениями правил проектирования, обнаруженных как в режиме 

реального времени, так и после пакетной проверки. 

Описание панели приведено в п. 26.4 из 12.5. 

Г.16. Панель PCB Pad Via Templates 

Панель PCB Pad Via Templates используется в редакторах ПП и поса-

дочных мест в основном для работы с библиотеками шаблонов КП и пере-

ходных отверстий.  

Внешний вид панели для открытого файла трассировки из варианта 

«П1» с подключенной библиотекой шаблонов ИДРЭС-PAV.PvLib из папки 

…ИДРЭС\AD library показан на рис. Г.31. 

Рис. Г.30 
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Особенности панели: 

1. Доступ к панели осуществляется из группы PCB в дополнительном 

меню (см. рис. 3.1). 

2. В группе Available Pad/Via template Libraries содержатся следующие 

элементы: 

2.1. Поле с текущей библиотекой шаблонов КП и переходных отверстий, 

с которой в данный момент осуществляется работа. Подключение библиотек 

осуществляется в окне Available Libraries на вкладках Project и Installed после 

нажатия на пиктограмму с тремя точками. 

Примечание. В используемой версии Altium Designer в списке отобража-

ется только одна библиотека, находящаяся в данный момент на первом ме-

сте на вкладке Project. Если указанная вкладка пуста, то будет отобра-

жаться библиотека с вкладки Installed;   

– назначение вкладок окна Available Libraries описано в п. 2 из Г.9. 

2.2. Поле для поиска шаблона в текущей библиотеке. 

Примечание. Поиск по маске не поддерживается. 

2.3. Таблица с шаблонами КП и переходных отверстий в текущей биб-

лиотеке со следующими столбцами. 

– Type – тип шаблона (Pad – КП, Via – переходное отверстие); 

– Name – имя шаблона (см. Г.22); 

– Description – описание шаблона. 

Примечание. Данные столбцов можно сортировать (см. п. 7 из Г.7). 

Из контекстного меню, вызываемого щелчком ПКМ в любом месте дан-

ной таблицы, доступны две команды: 

– Add To Internal Library – добавление выбранного шаблона в таблицу 

Local Pad & Via Library без размещения в рабочем поле; 

Рис. Г.31 
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– Place – добавление выбранного шаблона на рабочее поле (такой шаб-

лон будет также добавлен в таблицу Local Pad & Via Library). 

Вместо указанных команд можно воспользоваться перетаскиванием 

шаблонов зажатой ЛКМ, при этом: 

– если перетащить шаблон в свободное место таблицы Local Pad & Via 

Library или в рабочее поле, то он будет добавлен в новую строку; 

– если перетащить шаблон на уже существующий в таблице Local Pad & 

Via Library, то последний будет заменен перетаскиваемым. 

3. В группе Local Pad & Via Library содержатся следующие элементы: 

3.1. Таблица с шаблонами КП и переходных отверстий, которые суще-

ствуют в данном файле: добавленные из библиотеки (в столбце Library ука-

зывается название библиотеки) и локальные, которые были созданы только в 

текущем файле (в столбце Library указывается <Local>). 

Добавление шаблона в рабочее поле осуществляется перетаскиванием 

зажатой ЛКМ или командой ПКМ ⇒ Place. 

Примечания: 

– данные столбцов можно сортировать (см. п. 7 из Г.7); 

– добавленные шаблоны из библиотек можно использовать в файле 

трассировки, в правилах проектирования, в настройках примитивов по 

умолчанию и в некоторых командах. 

3.2. Кнопка Remove Unused Pad/Via, позволяющая удалить из таблицы 

Local Pad & Via Library неиспользуемые шаблоны из библиотеки. 

Примечание. Локальные шаблоны удаляются из таблицы автоматиче-

ски, если они отсутствуют в файле (например, были удалены). 

3.3. Кнопка Update, позволяющая обновить шаблоны из библиотек, если 

с ними в библиотеке или в рабочем поле были сделаны какие-то изменения. 

В появляющихся при этом окнах можно конкретизировать область обновле-

ния (например, запретить обновление заблокированных КП). 

3.4. Окно мини-просмотра с изображением выбранного в таблице Local 

Pad & Via Library шаблона КП. 

Г.17. КП со стандартными параметрами 

Добавление КП (назначение см. в п. 7 из 5.2.3) производится командой 

Place ⇒ Pad (или последовательным нажатием клавиш P ⇒ P).  

В окне свойств КП доступны следующие опции: 

1. Группа Properties (рис. Г.32): 
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– Designator – номер или обозначе-

ние КП; 

– Layer – слой расположения (для 

планарных КП в основном используются 

слои Top Layer или Bottom Layer, а для 

КП с отверстием выбирается слой Multi-

Layer); 

– Net – название цепи, к которой 

подключена КП (опция No Net означает отсут-

ствие подключения к цепи); 

– Electrical Type – электрический тип КП, 

который учитывается в правилах ПП в подраз-

деле Routing ⇒ Routing Topology. Например, ес-

ли КП задать тип Source, а в правилах выбрать 

вид топологии Starburst (топология «звезда»), то 

все связывающие линии данной цепи будут 

сходиться в этой КП (рис. Г.33); 

– Pin/Pkg Length – длина вывода компонента, устанавливаемого на дан-

ную КП (учитывается в параметре Signal Length по п. 4.1.2 из Г.14); 

– Jumper ID – идентификатор перемычки; 

– Locked – блокировка КП. 

Примечания: 

– если КП создается в составе посадочного места и будет подключена 

к УГО, то для правильного автоматического установления связей необходи-

мо, чтобы соответствующие КП и пины имели одинаковые номера (наиме-

нования) в полях Designator. Также связи можно установить вручную для 

каждого компонента с использованием окна Model Map (см. п. 2.4 из 5.4); 

– КП посадочного места с одинаковыми номерами (обозначениями) в 

поле Designator будут связаны с одним пином в УГО компонента, а на ПП 

автоматически подключатся к цепи этого пина. При трассировке ПП все 

такие КП должны быть соединены с металлизацией (трассами, полигонами 

и т. п.) соответствующей цепи (рис. Г.34, а); 

– КП посадочного места с одинаковыми номерами (обозначениями) в 

поле Designator и номерами в поле Jumper ID считаются физически объеди-

ненными внутри компонента (например, выводы от металлического корпуса 

разъема). При трассировке ПП с металлизацией соответствующей цепи 

Рис. Г.32 

Рис. Г.33 
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(трассами, полигонами и т. п.) должна быть соединена хотя бы одна такая 

КП (рис. Г.34, б). Перемычки обозначаются дугой с цветом, установленным 

для данной цепи; 

– нулевые идентификаторы перемычек означают, что КП внутри ком-

понента физически не объединены (значение по умолчанию). 

 

2. Группа Hole Information (рис. Г.35): 

– Hole Size – диаметр отверстия; 

– Tolerance – предельные отклонения диаметра отверстия (используют-

ся только как справочная информация);  

– Round – круглое отверстие; 

– Rect – прямоугольное отверстие с 

шириной из поля Hole Size (в появляю-

щемся при выборе этой опции поле 

Length задается длина прямоугольника, а 

в поле Rotation – угол поворота); 

– Slot – прямоугольное отверстие со 

скруглениями коротких сторон, диаметр которых равен значению из поля 

Hole Size (также доступны указанные выше опции Length и Rotation). Пара-

метры подобных отверстий приведены в табл. Л.6 для команды G85; 

– Plated – наличие внутренней металлизации отверстия. 

Примечание. Настройки данной группы доступны только для КП с от-

верстием. 

3. Группа Location (рис. Г.36): 

– X и Y – координаты расположения 

центра КП; 

– Rotation – угол поворота КП. 

Рис. Г.34 

а б 

Рис. Г.35 

Рис. Г.36 
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4. Группа Size and Shape (рис. Г.37): 

 

– X-Size – размер КП по горизонтали; 

– Y-Size – размер КП по вертикали; 

– Shape – форма КП: round – круг, rectangular – прямоугольник, octag-

onal – прямоугольник со скошенными под углом 45° углами (все фаски име-

ют одинаковые размеры, равные 50 % от половины короткой стороны); 

rounded rectangle – прямоугольник со скругленными углами; 

– Corner Radius (%) – радиус скругления углов в процентах от полови-

ны короткой стороны КП (доступно только для формы rounded rectangle); 

– Simple – простая КП (для КП с отверстием означает одинаковую фор-

му КП на всех слоях ПП); 

– Top-Middle-Bottom – сложная КП, для которой можно задать разные 

размеры и формы отдельно на слоях Top Layer, Bottom Layer и сразу всех 

внутренних слоях ПП; 

– Full Stack – сложная КП, для которой можно задать разные размеры и 

формы отдельно на каждом сигнальном слое. После выбора этой опции ста-

новится доступной кнопка Edit Full Pad Layer Definition, по нажатию которой 

открывается окно для редактирования параметров КП; 

– Offset From Hole Center (X/Y) – сдвиг по горизонтали и вертикали 

центра отверстия относительно центра КП.  

5. Группа Paste Mask Expansion (рис. Г.38): 

– Expansion value from rule – вели-

чина, на которую соответствующие обла-

сти в слоях паяльной пасты выступают за 

границы КП заданной формы (определя-

ется в правилах ПП в подразделе Mask ⇒ 

Paste Mask Expansion и по умолчанию равна 0 мм); 

Рис. Г.37 

Рис. Г.38 
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– Specify expansion value – величина, на которую соответствующие об-

ласти в слоях паяльной пасты выступают за границы КП заданной формы 

(определяется для конкретной КП и не зависит от общих правил ПП). 

6. Группа Solder Mask Expansions (рис. Г.39): 

– Expansion value from rules – величина, 

на которую соответствующие области в слоях 

защитной паяльной маски выступают за грани-

цы КП заданной формы (определяется в прави-

лах ПП в подразделе Mask ⇒ Solder Mask Ex-

pansion); 

– Specify expansion values – величина, на 

которую соответствующие области в слоях за-

щитной паяльной маски выступают за границы 

КП заданной формы (определяется для кон-

кретной КП и не зависит от общих правил ПП).  

Примечание. Пиктограмма цепи позволяет задать значения отдельно 

для слоя Top Layer (поле Top) и Bottom Layer (поле Bottom); 

– Solder Mask From The Hole Edge – величины из полей Top и Bottom 

будут отсчитываться не от границ формы КП, а от края отверстия; 

– Force complete tenting on top и Force complete tenting on bottom – 

опции, позволяющие закрыть маской КП на слоях Top Layer и Bottom Layer 

соответственно (при включении данных опций все настройки, заданные в 

этой группе ранее, будут проигнорированы). 

7. Группа Testpoint Settings (рис. Г.40): 

– Fabrication – КП на слое Top Layer 

и (или) Bottom Layer назначаются свой-

ства тестовой площадки (контрольной 

точки) для возможности тестирования ПП 

без установленных на нее компонентов; 

– Assembly – аналогично Fabrication, но такие контрольные точки ис-

пользуется для тестирования ПП с установленными компонентами.  

Примечания: 

– контрольной точкой также может быть переходное отверстие; 

– контрольным точкам могут быть назначены правила ПП в разделе 

Testpoint: подраздел Usage – для каких цепей и в каком количестве они нуж-

ны; подраздел Style – правила, которым они должны удовлетворять; 

Рис. Г.40 

Рис. Г.39 
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– примером использования контрольных точек со свойством Fabrication 

является обнаружение замыканий между различными цепями или обрывов в 

заданной цепи; 

– в общем случае любая КП и переходное отверстие без защитной па-

яльной маски до установки компонентов на ПП может использоваться как 

контрольная точка. Однако контрольные точки со свойством Fabrication 

могут потребоваться в случаях, если используются компоненты с малым 

шагом выводов (сложно попасть зондом в КП; нежелательно соприкоснове-

ние зонда с КП, чтобы ее не повредить) или из-за особенностей оборудова-

ния, применяемого для тестирования (например, зонд перемещается с опре-

деленным шагом, т. е. контрольные точки должны быть размещены в узлах 

сетки с определенным шагом); 

– примером использования контрольных точек со свойством Assembly 

является тестирование правильной работы компонентов (например, про-

верка заданных напряжений при включении устройства); 

– для контрольных точек со свойством Assembly обычно задаются тре-

бования по размещению в сетке с определенным шагом (из-за особенностей 

работы оборудования для тестирования), на некотором минимальном рас-

стоянии от корпусов компонентов (зонд имеет конечные размеры) и др.; 

– управление контрольными точками в редакторе ПП осуществляется 

командой Tools ⇒ Testpoint Manager; 

– информацию о контрольных точках, расположенных на ПП, можно 

вывести в отчет командами File ⇒ Fabrication Outputs ⇒ Test Point Report 

или File ⇒ Assembly Outputs ⇒ Test Point Report. 

8. Группа с вкладками в верхней части окна. 

Здесь можно посмотреть вид КП на относящихся к ней и доступных в 

данный момент слоях. 

Например, для планарной КП со слоя Top Layer будут отображаться 

вкладки со слоями Top Layer, Top Paste и Top Solder, если все они отобража-

ются в данный момент в проекте. Для КП с отверстием добавятся три таких 

же слоя на нижней стороне ПП (Bottom) и слой Multi-Layer. 

Примечание. У КП с отверстием на слоях Top Paste и Bottom Paste не 

будет никакой информации, кроме рисунка отверстия, так как такие КП не 

предназначены для нанесения паяльной пасты.  

9. В группе Pad Template (рис. Г.41) в списке Template можно выбрать 

шаблон КП, которая уже есть в текущем файле трассировки или в текущем 
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посадочном месте в библиотеке. В этом случае все настройки соответствую-

щего шаблона будут загружены в рассмотренные ранее группы. 

 

Примечания: 

– после корректировки настроек выбранного шаблона КП создается но-

вый шаблон без изменения исходного; 

– шаблоны КП можно добавлять из библиотеки КП и переходных от-

верстий (см. Г.16 и Г.23); 

– если шаблон КП взят из библиотеки КП и переходных отверстий, то 

в поле Library (рис. Г.41) будет указано ее название. Кроме того, большин-

ство загруженных настроек будет недоступно для редактирования. Чтобы 

получить к ним доступ, необходимо разорвать связь с библиотекой с помо-

щью ссылки Unlink; 

– шаблонам КП, создаваемым в файле трассировки или посадочном ме-

сте, автоматически присваиваются имена (см. Г.22). 

Г.18. КП с нестандартными параметрами 

Под КП с нестандартными параметрами в данном пособии понимается 

КП со сложной графикой на отдельных слоях, которую невозможно получить 

только с использованием возможностей окна ее свойств. 

Например, нестандартную форму на слое Top Layer имеет КП для сред-

него вывода корпуса SOT-89-3 (см. рис. 8.19) в одноименном посадочном ме-

сте в библиотеке Others.PcbLib из папки …ИДРЭС\AD library\pcb. Она об-

разована двумя частями: 

– КП со стандартными параметрами (рис. Г.42, а). Именно через нее 

осуществляется связь с соответствующим пином в УГО; 

– полигон Solid Region в слое Top Layer, полностью закрывающий КП со 

стандартными параметрами. Чтобы для него автоматически создавалась гра-

фика в слоях Top Solder и Top Paste в соответствии с правилами ПП, в его 

свойствах для параметров Solder Mask Expansion и Paste Mask Expansion вы-

браны опции From Rule (рис. Г.42, б). 

Примечания: 

– если на схеме к пину УГО, связанному с такой КП, будет подключена 

цепь, то после переноса на ПП полигон также подключится к этой цепи; 

Рис. Г.41 
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– если на схеме к пину УГО, связанному с такой КП, не будет подключе-

на цепь, то после переноса на ПП в месте контакта КП и полигона появит-

ся ошибка, связанная с нарушением правила Short-Circuit. Оперативно соеди-

нить КП и полигон с новой цепью в редакторе ПП позволяет команда 

Design ⇒ Netlist ⇒ Configure Physical Nets. В появившемся после этого окне 

достаточно нажать кнопку Execute. Кроме того, в столбцах группы Action 

этого окна можно конкретизировать места, которые необходимо испра-

вить, и поменять имена цепей. Также можно воспользоваться командой 

Update Free Primitives from Component Pads из этого же меню; 

 – в посадочном месте для создания произвольной формы КП можно ис-

пользовать и другие примитивы (например, линии); 

– кроме металлизации можно создавать различные области в слоях ти-

па Solder и Paste. В этих случаях зачастую отключают автоматическое со-

здание аналогичных областей в КП со стандартными параметрами. 

Г.19. Неметаллизированное отверстие 

Неметаллизированное отверстие создается на основе КП (см. Г.17), в 

свойствах которой задаются следующие параметры: 

1. В группе Hole Information: 

Рис. Г.42 

а б 
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– Hole Size – требуемый диаметр отверстия; 

– Plated – отключена. 

2. В группе Properties: 

– Layer – Multi-Layer; 

– Net – No Net. 

3. В группе Size and Shape: 

– X-Size и Y-Size – нули; 

– Shape – любая опция (например, Round). 

Примечание. Преимущество указания 

нулевых размеров КП – отсутствие в Ger-

ber-файле (см. прил. Л) соответствующей 

апертуры. 

4. В группе Solder Mask Expansions 

при выбранной опции Specify expansion 

values включается опция Solder Mask 

From The Hole Edge и в поле Top задается 

значение 0.05 мм. 

Примечание. Значение задано по правилу SME (см. табл. Г.7). 

Сравнение неметаллизированного отверстия с монтажным (обычная КП 

с отверстием) показано на рис. Г.43. 

Г.20. Особенности использования монтажных отверстий 

Часто встречающиеся ошибки, связанные с использованием монтажных 

отверстий (КП с отверстиями): 

– не учитывается допуск на диаметр отверстия или выбирается заведомо 

недостаточный диаметр отверстия. Например, под квадратные в сечении вы-

воды разъемов (0,64 × 0,64 мм) задаются отверстия диаметром 0,7 мм; 

– осуществляется округление расстояний между осями отверстий в по-

садочном месте при переходе от дюймов к миллиметрам без последующей 

корректировки. Например, при шаге штыревых выводов 2,54 мм монтажные 

отверстия ставятся с шагом 2,5 мм.  

Чтобы избежать ошибок с неправильным выбором диаметра, необходи-

мо руководствоваться требованиями ГОСТ Р 53429–2009 и РД 50–708–91, по 

которым его номинальное значение устанавливают в соответствии со следу-

ющим соотношением: 

 rddd +− эно
, (Г.1) 

Рис. Г.43 
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где 
но

d  – нижнее предельное отклонение диаметра отверстия (для 4-го 

класса точности ПП см. табл. Г.10), мм; эd  – максимальный диаметр вывода 

(для прямоугольного вывода за диаметр берется диагональ его сечения), мм; 

r  – разность между минимальным значением диаметра отверстия и макси-

мальным значением диаметра вывода устанавливаемого компонента (при 

ручной установке значение r  выбирают в диапазоне 0,1–0,4 мм), мм. 

Таблица Г.10 

Предельные отклонения диаметров отверстий для 4-го класса точности ПП  

Наличие металлизации 

Предельное отклонение диаметра отверстия, мм, 

при диаметре отверстия, мм 

До 0,3 включ. Св. 0,3 до 1,0 включ. Св. 1,0 

Без металлизации ±0,02 ±0,05 ±0,10 

С металлизацией без 

оплавления 

–0,03 

–0,07 

+0,00 

–0,10 

+0,05 

–0,15 

С металлизацией и с 

оплавлением 
– 

+0,00 

–0,13 

+0,05 

–0,18 

Расчетное значение диаметра отверстия по (Г.1) следует округлять в 

сторону увеличения до десятых долей миллиметра. Например, для квадрат-

ных в сечении выводов 0,64 × 0,64 мм диаметр отверстий на ПП, выполняе-

мой по 4-му классу точности, составит: 

2,114,113,01,091,0 =++d  мм. 

На практике такое значение все же оказывается большим, поэтому часто 

его выбирают без учета r  и с незначительным уменьшением 
н.о

d , т. е. 

приемлемый диаметр отверстия в данном примере составит 1 мм. 

Примечание. Ограничения, накладываемые на диаметр металлизации 

КП в зависимости от диаметра отверстия, рассмотрены в Б.9. 

Г.21. Переходное отверстие 

Добавление переходного отверстия (назначение см. в примечании к п. 9 

из 12.1) производится командой Place ⇒ Via (или последовательным нажати-

ем клавиш P ⇒ V). 

В окне свойств переходного отверстия доступны следующие опции: 

1. В верхней части окна (рис. Г.44): 

– Hole Size – диаметр отверстия; 

– Tolerance – предельные отклонения диаметра отверстия (используют-

ся только как справочная информация); 
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– Location – координаты расположения центра переходного отверстия; 

– Diameter – диаметр площадки переходного отверстия. 

 

2. Группа Via Template (рис. Г.45) полностью аналогична группе Pad 

Template из окна свойств КП (см. п. 9 из Г.17). 

 

3. Группа Diameters (рис. Г.46): 

 

– Simple – простое переходное отверстие (одинаковый диаметр площад-

ки на всех слоях ПП); 

– Top-Middle-Bottom – сложное переходное отверстие, для которого 

можно задать разные диаметры площадок на слоях Top Layer, Bottom Layer и 

сразу всех внутренних слоях ПП; 

– Full Stack – сложное переходное отверстие, для которого можно за-

дать разные диаметры площадок отдельно на каждом сигнальном слое. После 

выбора этой опции вместо поля Diameter с рис. Г.44 появляется кнопка Edit 

Full Stack Via Sizes, открывающая окно для редактирования диаметров. 

4. Группа Properties (рис. Г.47): 

– Drill Pair – выбор начального и конечно-

го слоя, между которыми будет создано пере-

ходное отверстие.  

По умолчанию переходные отверстия со-

здаются сквозными (через всю ПП), но в редак-

торе ПП кнопкой Drill Pairs в нижней части ок-

Рис. Г.46 

Рис. Г.45 

Рис. Г.44 

Рис. Г.47 
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на свойств можно установить пары сигнальных слоев, чтобы задать глухие 

(от внешнего до любого внутреннего сигнального слоя ПП) и скрытые (толь-

ко между внутренними сигнальными слоями ПП) переходные отверстия; 

– Net – название цепи, к которой подключено переходное отверстие (оп-

ция No Net означает отсутствие подключение к цепи); 

– Locked – блокировка переходного отверстия. 

5. Группа Testpoint Settings полностью аналогична такой же группе из 

окна свойств КП (см. п. 7 из Г.17). 

6. Группа Solder Mask Expansions полностью аналогична такой же 

группе из окна свойств КП (см. п. 6 из Г.17). 

Г.22. Имена шаблонов КП и переходных отверстий 

Имена шаблонам КП и переходных отверстий по умолчанию присваи-

ваются в соответствии с соглашением IPC-7251 & 7351 Padstack Naming Con-

vention и содержат их параметры. 

Система построения имен шаблонов простых КП (Simple) с часто ис-

пользуемыми параметрами показана на рис. Г.48.  

 

Форма КП: 

– r – прямоугольник; 

– s – квадрат; 

– c – круг 

Для КП с отверстием – диаметр отверстия в формате 

X,YY мм. 

Для некруглых отверстий через нижнее подчеркивание 

указываются размеры по горизонтали и вертикали 

Для КП с отверстием: 

– h – металлизированное отверстие; 

– hn – отверстие без металлизации 

Размер по горизонтали (X Size) в формате X,YY мм 

Для КП с фасками и скруглениями углов: 

– c50 – фаски; 

– rYY – скругления с процентом YY (Corner Radius) 

x  XYY_XYY  x  XYY  xYY 

Размер по вертикали (Y Size) в формате X,YY мм через 

нижнее подчеркивание. Если X Size и Y Size равны, то 

размер по вертикали не указывается 

Рис. Г.48 



 

 798 

Примеры имен шаблонов КП: 

– c500h290 – круглая КП (диаметр – 5 мм) с металлизированным отвер-

стием (диаметр – 2,9 мм); 

– r150_200 – прямоугольная планарная КП (размеры – 1,5 × 2,0 мм); 

– s180h120r50 – квадратная КП (размеры – 1,8 × 1,8 мм) со скругления-

ми углов (50 %) и металлизированным отверстием (диаметр – 1,2 мм); 

– c0hn260 – неметаллизированное отверстие (диаметр – 2,6 мм). 

Система построения имен шаблонов простых переходных отверстий 

(Simple) с часто используемыми параметрами показана на рис. Г.49. 

 

Примеры имен шаблонов переходных отверстий: 

– v60h30m0mx0 – переходное отверстие (диаметр площадки – 0,6 мм), 

закрытое защитной паяльной маской с двух сторон ПП, с диаметром отвер-

стия 0,3 мм; 

– v120h60 – переходное отверстие (диаметр площадки – 1,2 мм) с диа-

метром отверстия 0,6 мм. 

Примечание. Ведущие нули (leading) в именах шаблонов КП и переход-

ных отверстий в формате XYY не записываются. 

Г.23. Библиотека КП и переходных отверстий 

Шаблоны КП и переходных отверстий можно хранить в специальной 

библиотеке, загружая их оттуда по мере необходимости.  

Особенности работы с такой библиотекой: 

1. Подключение библиотеки осуществляется через панель PCB Pad Via 

Templates (см. п. 9 из 12.1 и Г.16). 

2. После создания новой библиотеки (команда File ⇒ New ⇒ Library ⇒ 

Pad Via Library) или открытия уже существующей (команда File ⇒ Open) 

Рис. Г.49 

v – переходное отверстие 

h – металлизированное отверстие 

Диаметр площадки в формате X,YY мм 

v  XYY  h  XYY  m0  mx0 

Диаметр отверстия в формате X,YY мм 

 
m0 – опция Force complete tenting on top 

mx0 – опция Force complete tenting on bottom 
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будет автоматически запущена панель Pad Via Library и в рабочем поле по-

явится окно редактора шаблонов КП (Pad Template Editor) или переходных 

отверстий (Via Template Editor). 

3. На рис. Г.50 показана панель Pad Via 

Library для библиотеки ИДРЭС-PAV.PvLib 

из папки …\ИДРЭС\AD library (см. рис. 2.9). 

В списке Display Units выбирается си-

стема единиц, в которой отображаются пара-

метры в окне редакторов шаблонов КП и пе-

реходных отверстий. 

В таблице, расположенной ниже, приво-

дятся все существующие в библиотеке шабло-

ны КП и переходных отверстий (назначение 

столбцов описаны в п. 2.3 из Г.16). Из кон-

текстного меню, вызываемого щелчком ПКМ 

в любом ее месте, доступны три команды: 

– Add Pad Template – создание шаблона КП; 

– Add Via Template – создание шаблона переходного отверстия;  

– Delete – удаление выбранного шаблона. 

3. На рис. Г.51 показано окно редактора шаблонов переходных отвер-

стий для выбранного в панели Pad Via Library шаблона v120h60. 

 Рис. Г.51 

Рис. Г.50 
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Опции редактора практически полностью соответствуют опциям из окна 

свойств переходного отверстия (см. Г.21), но есть следующие особенности: 

– опции из группы Diameters окна свойств (см. рис. Г.46) представлены в 

виде списка Mode в группе Size and Shape; 

– диаметр площадки (поле Diameter на рис. Г.44) настраивается в табли-

це в столбце Diameter отдельно для каждого сигнального слоя (группы сиг-

нальных слоев) в зависимости от выбранной опции в списке Mode; 

– при выборе в списке Mode опции Full Stack в таблице появляется воз-

можность добавлять и удалять сигнальные слои (кроме присутствующих по 

умолчанию) соответствующими командами из контекстного меню, вызывае-

мого щелчком ПКМ в любом месте таблицы, и выбирать их названия в 

столбце Layer Name; 

– в шаблонах создаются только сквозные переходные отверстия; 

– в поле Description можно записать комментарий к шаблону; 

– в поле Name можно задать собственное имя шаблону (для возврата к 

стандартному значению нажимается кнопка R). 

4. На рис. Г.52 показано окно редактора шаблонов КП для выбранной в 

панели Pad Via Library шаблона c500h290.  

Отличия от опций из окна свойств КП (см. Г.17) состоят в следующем: 

 Рис. Г.52 Начало (окончание см. на с. 801) 
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– назначение и использование полей Name и Description аналогично ре-

дактору шаблонов переходных отверстий; 

– опция Pad Type позволяет выбрать тип КП: SMT – планарная КП, 

Through hole – КП с отверстием; 

– опции Simple, Top-Middle-Bottom и Full Stack из окна свойств КП 

выбираются в списке Mode; 

– геометрические параметры КП задаются в таблице отдельно для каж-

дого сигнального слоя (группы сигнальных слоев) в зависимости от выбран-

ной опции в списке Mode; 

– при выборе в списке Mode опции Full Stack по аналогии с редактором 

шаблонов переходных отверстий появляется возможность добавлять и уда-

лять сигнальные слои. 

Г.24. Линии 

Особенности работы с линиями: 

1. Режим создания линии запускается следующими способами: 

– в редакторе схем – командой Place ⇒ Drawing Tools ⇒ Line или по-

следовательным нажатием клавиш P ⇒ D ⇒ L; 

– в редакторах УГО, ПП и посадочных мест – командой Place ⇒ Line 

или последовательным нажатием клавиш P ⇒ L. 

2. Линия создается как полилиния, т. е. единый объект, состоящий из не-

скольких связанных между собой прямолинейных сегментов.  

В режиме создания линии доступны следующие общие для всех редак-

торов возможности: 

– рисование – последовательные щелчки ЛКМ в рабочем поле для ука-

зания ее вершин; 

– отмена последней вершины – клавиши BackSpace или Delete; 

– завершение построения – щелчок ПКМ или клавиша Esc;  

– выход из команды – повторный щелчок ПКМ или повторное нажатие 

клавиши Esc. 

Рис. Г.52 Окончание (начало см. на с. 800) 
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3. Особенности создания линии в редакторах схем и УГО: 

3.1. Клавишей Space осуществляется циклическое переключение пяти 

режимов создания угла между двумя точками (рис. Г.53): 

– Any Angle – произвольный угол; 

– 90 Degree Up – угол 90° у курсора мышки; 

– 90 Degree Down – угол 90° у исходной точки; 

– 45 Degree Up – угол 45° у курсора мышки; 

– 45 Degree Down – угол 45° у исходной точки. 

 

3.2. Во всех режимах создания угла, кроме Any Angle, работает режим с 

предсказанием (Look Ahead Mode).  

В этом режиме после щелчка ЛКМ размещается сегмент, предшествую-

щий сегменту, непосредственно соединенному с курсором мышки. 

3.3. На вкладке Graphical окна свойств (рис. Г.54) можно задать следу-

ющие настройки: 

 Рис. Г.54 

Рис. Г.53 

Any Angle 

90 Degree Up 90 Degree Down 45 Degree Up 45 Degree Down 



 

 803 

– Start Line Shape и End Line Shape – значок (например, стрелка) на 

конце первого и последнего сегмента соответственно (опция None означает 

отсутствие значка); 

– Line Shape Size – один из четырех вариантов размера значка; 

– Line Width – один из четырех вариантов ширины всех сегментов (раз-

меры в миллиметрах приведены в п. 2.1 из 8.1); 

– Line Style – один из четырех вариантов стиля. Требованиям ЕСКД со-

ответствует только стиль Solid (сплошная); 

– Color – цвет; 

– Locked – блокировка. 

3.4. На вкладке Vertices окна свойств можно управлять настройками 

вершин полилинии: добавлять новые кнопкой Add, удалять существующие 

кнопкой Remove, изменять координаты и выполнять другие команды из 

списка, появляющегося при нажатии кнопки Menu. 

4. Особенности редактирования линии в редакторах схем и УГО: 

– при щелчке ЛКМ по созданной полилинии ее вершины подсвечивают-

ся зелеными квадратами (рис. Г.55, а); 

 

– на выделенной полилинии зажатой ЛКМ можно изменить положение 

каждой вершины, при этом при перемещении крайних вершин клавишей 

Space циклически переключаются режимы создания угла (см. рис. Г.53); 

– на выделенной полилинии зажатой ЛКМ можно переместить каждый 

сегмент (требуется отключение опции Always Drag). 

Примечание. Назначение опции Always Drag приведено в табл. Г.3, а ее 

включение обусловлено удобством создания схем с использованием библио-

течных компонентов; 

– перемещение всей полилинии осуществляется зажатой ЛКМ без пред-

варительного ее выделения (с опцией Always Drag также справедливо и для 

выделенной полилинии); 

– на выделенной полилинии после запуска команды ПКМ ⇒ Edit Line 

Vertex N (N – номер вершины) на любой вершине будет открыта вкладка 

Vertices окна свойств для редактирования координат вершин; 

Рис. Г.55 

а б 
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– на выделенной полилинии для удаления вершины необходимо зажать 

на требуемой вершине ЛКМ, после чего нажать клавишу Delete; 

– на выделенной полилинии для добавления новой вершины необходимо 

зажать ЛКМ в требуемом месте сегмента, после чего нажать клавишу Insert 

и передвинуть курсор мышки (требуется отключение опции Always Drag); 

– если на выделенной полилинии щелкнуть ЛКМ по сегменту, то его 

вершины подсветятся красными квадратами (см. рис. Г.55, б). В этом случае 

в панели Inspector или List можно отредактировать их координаты. 

5. Особенности создания линии в редакторах ПП и посадочных мест: 

5.1. Линия создается на текущем в данный момент слое. 

Примечание. Слой можно изменить в окне свойств линии или в панели 

Inspector или List уже после ее создания. 

5.2. Комбинацией клавиш Shift+Space осуществляется циклическое пе-

реключение пяти режимов создания угла между двумя точками (рис. Г.56): 

– Any Angle – произвольный угол; 

– Line 45 End – угол 45° у курсора мышки; 

 Рис. Г.56 

Line 45 End - 

Rounded Corner 

Line 45 Start 

With Arc 

Any Angle 

Line 45 End 

Line 45 Start 

Line 90 End 

Line 90 Start 

Line 90 End 

With Arc 

Line 90 Start 

with Arc 

Shift+Space 

Space 
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– Line 45 End - Rounded Corner – угол 45° у курсора мышки со скруг-

лением; 

– Line 90 End – угол 90° у курсора мышки; 

– Line 90 End With Arc – угол 90° у курсора мышки со скруглением. 

5.3. Клавишей Space, кроме режима Any Angle, выбирается один из двух 

путей прохождения от исходной точки до курсора мышки (см. рис. Г.56); 

5.4. Клавишей 1 осуществляется включение и отключение режима рисо-

вания с предсказанием (Toggle Lookahead Mode). 

В этом режиме после щелчка ЛКМ размещается сегмент, предшествую-

щий сегменту, непосредственно соединенному с курсором мышки. Послед-

ний сегмент отображается внешними очертаниями. 

5.5. В окне свойств линии (рис. Г.57) можно задать следующие настрой-

ки для выбранного ее сегмента: 

 

– Start и End – координаты начала и конца сегмента соответственно; 

– Width – ширина сегмента; 

– Locked – блокировка сегмента; 

– Layer – слой расположения сегмента; 

– Net – название цепи, к которой подключен сегмент (опция No Net 

означает отсутствие подключения к цепи); 

– Solder Mask Expansion и Paste Mask Expansion – соответственно ве-

личины, на которые области в слоях защитной паяльной маски и паяльной 

пасты больше границ сегмента (опция No Mask означает отсутствие такой 

Рис. Г.57 
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области, опции Expansion value from rules и Specify expansion value анало-

гичны описанным в пп. 5 и 6 из Г.17). 

6. Особенности редактирования линии в редакторах 

ПП и посадочных мест: 

– при щелчке ЛКМ по отдельному сегменту поли-

линии он будет подсвечен, а также на нем появятся не-

сколько характерных точек (рис. Г.58); 

– выделенные сегменты можно удалять клавишей 

Delete и на их месте рисовать новые (например, для за-

мены прямого угла скруглением); 

– отдельные вершины полилинии не удаляются; 

– при перемещении зажатой ЛКМ любой характерной точки скруглен-

ного сегмента (или любого его участка) будет изменяться его радиус с авто-

матической корректировкой длин соединенных с ним прямолинейных сег-

ментов. Также при уменьшении радиуса одного из двух соединенных скруг-

ленных сегментов между ними будет создан прямолинейный сегмент; 

– внутренние прямолинейные сегменты можно перемещать параллельно 

самим себе зажатой ЛКМ. 

Примечание. В окне Preferences (команда DXP ⇒ Preferences) в разделе 

PCB Editor ⇒ Interactive Routing в группе Dragging (рис. Г.59) доступны сле-

дующие влияющие на редактирование линии опции: 

– Preserve Angle When Dragging – со-

хранение углов смежных сегментов поли-

линии при перетаскивании текущего; 

– Selected via/track и Unselected via/ 

track – соответственно действия с пред-

варительно выделенными и невыделенными 

переходными отверстиями и прямолиней-

ными сегментами (назначение опций Drag 

и Move см. в Г.29); 

– перемещение зажатой ЛКМ за цен-

тральную характерную точку прямолинейного сегмента приводит к созданию 

соединенного с ним параллельного участка (рис. Г.60); 

 Рис. Г.60 

Рис. Г.58 

Рис. Г.59 
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– в режиме Drag (см. Г.29 и рис. 

Г.59) при перемещении общей вершины 

двух прямолинейных сегментов создается 

новый сегмент под углом 45° (рис. Г.61); 

– для выделения всей полилинии 

сложной конфигурации имеет смысл выделить один ее сегмент и нажать кла-

вишу Tab (см. команду Select next в п. 3.3 из Г.5); 

– выделенную линию можно перемещать зажатой ЛКМ; 

– для разделения полилинии на две можно воспользоваться командой 

Edit ⇒ Slice Tracks (см. Г.41). 

Г.25. Линия электрической связи 

Особенности работы с линией электрической связи: 

1. Режим создания линии электрической связи запускается командой 

Place ⇒ Wire или последовательным нажатием клавиш P ⇒ W. 

2. Линия электрической связи является полилинией, и для нее характер-

ны возможности, описанные в п. 2 из Г.24. 

3. Особенности рисования: 

3.1. Если линия электрической связи отводится 

от пина компонента, сегмента другой линии электри-

ческой связи или идентификатора цепи, то около 

курсора мышки появляется красное перекрестие 

(рис. Г.62). 

3.2. Линия электрической связи автоматически 

создается при соприкосновении двух пинов компонентов (в этом месте также 

появляется красное перекрестие). 

3.3. Построение линии электрической связи автоматически завершается, 

если осуществляется щелчок ЛКМ по пину компонента, сегменту другой ли-

нии электрической связи или идентификатору цепи. 

3.4. Комбинацией клавиш Shift+Space осуществляется циклическое пе-

реключение пяти режимов создания угла между двумя точками (рис. Г.63): 

– 90 Degree Start – угол 90° около курсора мышки; 

– 45 Degree Start – угол 45° около курсора мышки; 

– Any Angle – произвольный угол; 

– Auto Wire – автоматическое проведение линии электрической связи от 

исходной точки до курсора мышки с обхождением препятствий. 

Рис. Г.61 

Рис. Г.62 
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3.4. Клавишей Space, кроме режимов создания угла Any Angle и Auto 

Wire, выбирается один из двух путей прохождения от исходной точки до 

курсора мышки (рис. Г.63). 

3.5. В режимах создания угла, кроме Any Angle и Auto Wire, работает 

режим с предсказанием (Look Ahead Mode).  

В этом режиме после щелчка ЛКМ размещается сегмент, предшествую-

щий сегменту, непосредственно соединенному с курсором мышки. Послед-

ний сегмент отображается пунктиром (рис. Г.63), а размещаемый сегмент – 

тонкой линией. 

4. Редактирование в окне свойств: 

4.1. На вкладке Graphical (рис. Г.64) задаются следующие настройки: 

– Color – цвет; 

 Рис. Г.64 

Рис. Г.63 

90 Degree Start 

Shift+Space 

Space 

90 Degree End 

Any Angle 

Auto Wire 

45 Degree Start 45 Degree End 
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– Wire Width – один из четырех вариантов ширины всех сегментов 

(размеры в миллиметрах приведены в п. 2.1 из 8.1); 

– Locked – блокировка. 

4.2. Вкладка Vertices аналогична рассмотренной в п. 3.4 из Г.24. 

5. Редактирование в рабочем поле: 

– при щелчке ЛКМ по созданной линии электрической связи ее верши-

ны подсвечиваются зелеными квадратами (рис. Г.65, а); 

 

– на выделенной линии электрической связи зажатой ЛКМ можно изме-

нить положение каждой вершины, при этом при перемещении крайних 

неподключенных вершин комбинацией клавиш Shift+Space и клавишей 

Space циклически переключаются режимы создания угла (см. рис. Г.63); 

– для продления линии электрической связи в направлении последнего 

сегмента необходимо перемещать курсор мышки с зажатой клавишей Alt; 

– на выделенной линии электрической связи зажатой ЛКМ можно неза-

висимо перемещать каждый сегмент (требуется отключение опции Always 

Drag). Если к сегменту были подключены сегменты других линий электриче-

ской связи, пины компонентов или идентификаторы цепей, то при переме-

щении они будут отсоединены. 

Примечание. Назначение опции Always Drag приведено в табл. Г.3, а ее 

включение обусловлено удобством создания схем с использованием библио-

течных компонентов; 

– с включенной опцией Always Drag также можно перемещать сегменты 

линии электрической связи, но не всегда только требуемые, а в основном 

находящиеся на одной горизонтали или вертикали (предварительное выделе-

ние линии электрической связи не требуется). В этом случае отсоединения 

других подключений от этого сегмента не происходит, а идентификаторы 

цепей перемещаются вместе с сегментом; 

– на выделенной полилинии после запуска команды ПКМ ⇒ Edit Line 

Vertex N (N – номер вершины) на любой вершине будет открыта вкладка 

Vertices окна свойств для редактирования ее координат; 

– на выделенной полилинии для удаления вершины необходимо зажать 

на требуемой вершине ЛКМ, после чего нажать клавишу Delete; 

Рис. Г.65 

а б 
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– на выделенной полилинии для добавления новой вершины необходимо 

зажать ЛКМ в требуемом месте сегмента, после чего нажать клавишу Insert 

и передвинуть курсор мышки (требуется отключение опции Always Drag); 

– если на выделенной полилинии щелкнуть ЛКМ по сегменту, то его 

вершины подсветятся красными квадратами (см. рис. Г.65, б). В этом случае 

в панели Inspector или List можно отредактировать их координаты, а сам сег-

мент удалить кнопкой Delete; 

– каждой линии электрической связи автоматически присваивается имя 

цепи, которое можно поменять с помощью идентификаторов цепи; 

– для удаления участка линии электрической связи можно воспользо-

ваться последовательным нажатием клавиш E ⇒ W или командой Edit ⇒ 

Break Wire (ширина удаляемой области циклически меняется клавишей 

Space или задается в окне свойств, открываемом клавишей Tab). 

Г.26. Полигоны 

В Altium Designer существует три вида полигонов: 

1. Fill (полигон прямоугольной формы), создаваемый командой Place ⇒ 

Fill или последовательным нажатием клавиш P ⇒ F. 

Особенности работы с полигоном: 

1.1. После запуска команды в рабочем поле щелчком ЛКМ указываются 

две вершины прямоугольника, расположенные по диагонали. 

 Рис. Г.66 
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1.2. В окне свойств можно задать следующие настройки (см. рис. Г.66): 

– Corner 1 и Corner 2 – координаты двух вершин; 

– Rotation – угол поворота; 

– Locked – блокировка полигона; 

– Layer – слой расположения полигона; 

– Net – название цепи, к которой подключен полигон (опция No Net 

означает отсутствие подключения к цепи); 

– Solder Mask Expansion и Paste Mask Expansion – соответственно ве-

личины, на которые области в слоях защитной паяльной маски и паяльной 

пасты больше границ полигона (опция No Mask означает отсутствие такой 

области, опции Expansion value from rules и Specify expansion value анало-

гичны описанным в пп. 5 и 6 из Г.17). 

1.3. В рабочем поле можно отредактировать положение границ полиго-

на, его вершин (форма остается только прямоугольной) и угол поворота. 

2. Solid Region (полигон произвольной формы), создаваемый командой 

Place ⇒ Solid Region или последовательным нажатием клавиш P ⇒ R. 

Особенности работы с полигоном: 

2.1. После запуска команды в рабочем поле щелчками ЛКМ указывают-

ся вершины многоугольника. 

2.2. В контекстном меню, появляющемся при нажатии комбинации кла-

виш Shift+F1 или клавиши «~» в процессе создания полигона, приведены 

следующие часто используемые команды (рис. Г.67): 

– Cycle Placement Mode – циклическое 

переключение пяти режимов создания угла 

между двумя точками (см. рис. Г.56); 

– Toggle Elbow Side – выбор одного из 

двух путей прохождения от начальной точ-

ки к курсору мышки (см. рис. Г.56); 

– Remove Last Vertex – удаление по-

следней размещенной вершины; 

– Toggle Lookahead Mode – режим ри-

сования с предсказанием. В этом режиме 

после щелчка ЛКМ размещается сегмент, 

предшествующий сегменту, непосредствен-

но соединенному с курсором мышки. По-

следний сегмент отображается пунктиром; Рис. Г.67 
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– Increase Arc SetBack и Decrease Arc SetBack – соответственно увели-

чение и уменьшение радиуса в режимах создания угла со скруглением (x 1 – 

с шагом 0,0254 мм, x 10 – с шагом 0,254 мм). 

Примечание. Названия режимов создания угла между двумя точками в 

большинстве своем отличаются от указанных на рис. Г.56: 

– произвольный угол – Any Angle; 

– угол 45° – Line 45/90 и Line 90/45; 

– угол 45° со скруглением – Line 45/90 With Arc и Line 90/45 With Arc;  

– угол 90° – Line 90/90 Vertical Start и Line 90/90 Horizontal Start;  

– угол 90° со скруглением – Line 90/90 Vertical Start With Arc и Line 90/90 

Horizontal Start With Arc. 

2.3. На вкладке Graphical окна свойств доступны 

настройки, рассмотренные для полигона Fill в п. 1.2: 

Locked, Layer, Net, Solder Mask Expansion и Paste 

Mask Expansion.  

Дополнительно в списке Kind приведены опции, 

определяющими назначение полигона (рис. Г.68): 

– Copper – обычный полигон; 

– Polygon cutout – полигон, используемый для создания вырезов в поли-

гоне Polygon Pour. В рабочем поле отображается пунктирным контуром с 

цветом слоя, на котором расположен; 

– Board cutout – полигон, используемый для создания внутренних выре-

зов в ПП. В рабочем поле отображается пунктирным контуром, внутри кото-

рого область окрашивается в цвет фона вокруг ПП (по умолчанию – серый).  

Примечания: 

– альтернативным способом создания полигона со свойством Polygon 

cutout является команда Place ⇒ Polygon Pour Cutout; 

– альтернативным способом создания полигона со свойством Board 

cutout является команда Design ⇒ Board Shape ⇒ Define Board Cutout; 

– в редакторе посадочных мест в списке Kind есть еще опция Cavity def-

inition. Такой полигон используется для указания в одном из механических 

слоев области, необходимой для расположения компонента внутри ПП (за-

даются размеры в плоскости и высота). 

2.4. На вкладке Outline Vertices окна свойств можно в табличном виде 

отредактировать координаты вершин, добавить новые (кнопка Add) и уда-

лить существующие вершины (кнопка Remove), экспортировать или импор-

Рис. Г.68 
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тировать данные (Menu ⇒ Export To CSV и Menu ⇒ Import From CSV со-

ответственно) и выполнить другие действия. 

2.5. Полигон с назначениями Copper, Polygon cutout и Board cutout 

кроме команды Place ⇒ Solid Region также можно создать на текущем в дан-

ный момент слое из предварительно нарисованного графическими примити-

вами (линиями и дугами) замкнутого контура, расположенного на любом 

слое, командами Tools ⇒ Convert ⇒ Create Region from Selected Primitives, 

Tools ⇒ Convert ⇒ Create Cutout from Selected Primitives и Tools ⇒ Con-

vert ⇒ Create Board Cutout from Selected Primitives соответственно. 

2.6. Полигон Solid Region может выполнять функцию зоны запрета раз-

мещения различных объектов (keepout). Для его добавления используется 

команда Place ⇒ Keepout ⇒ Solid Region. 

В окне свойств на вкладке Graphical 

(рис. Г.69) доступны следующие опции: 

– Locked – блокировка полигона;  

– список Restricted for Layer – слой 

расположения (любой отдельный сигналь-

ный слой или все сигнальные слои сразу); 

– группа Keepout Restrictions – типы 

объектов, которые запрещено размещать 

внутри зоны запрета и на расстоянии, за-

данном в правилах проектирования ПП. 

Если зона запрета задана на всех слоях, то полигон отображается с цве-

том слоя Keep-Out Layer (по умолчанию – розовый). Если выбран только 

один сигнальный слой, то полигон отображается с цветом этого слоя, а его 

контур – с цветом слоя Keep-Out Layer. 

Примечания: 

– с помощью команд из меню Place ⇒ Keepout можно создать зоны за-

прета в виде дуг, окружностей, линий и полигонов Fill; 

– осуществить переход от полигона Solid Region с назначением Copper 

в полигон в виде зоны запрета и наоборот можно командами Tools ⇒ Con-

vert ⇒ Convert Selected Primitives to Keepouts и Tools ⇒ Convert ⇒ Convert Se-

lected Keepouts to Primitives соответственно. 

2.7. Способы редактирования полигона Solid Region: 

2.7.1. Изменение положения вершины зажатой ЛКМ, при этом комбина-

цией клавиш Shift+Space можно выбрать один из трех режимов (рис. Г.70): 

Рис. Г.69 



 

 814 

 

– Moving Vertex – перемещение вершины; 

– Mitering to segment – перемещение вершины с созданием фаски; 

– Mitering to arc – перемещение вершины с созданием скругления. 

Примечания: 

– последний выбранный режим в этом пункте и п. 2.7.2 запоминается и 

используется при работе с аналогичными характерными точками как на 

текущем, так и на других полигонах; 

– текущий режим в этом пункте и п. 2.7.2 можно определить как по 

виду курсора мышки, так и по информации из информационного поля. 

2.7.2. Изменение положения зажатой ЛКМ характерной точки, отмечен-

ной белым пустым квадратом, при этом комбинацией клавиш Shift+Space 

можно выбрать один из трех режимов (рис. Г.71): 

– Sliding Edge – перемещение стороны; 

– Breaking edge – создание новой вершины; 

– Incurvating edge – сторона становится дугой. 

 

2.7.3. Добавление новой вершины (альтернатива режиму Breaking edge 

из п. 2.7.2 в следующем порядке: 

Moving Vertex Mitering to segment Mitering to arc 

Рис. Г.70 

Рис. Г.71 

Sliding Edge Breaking edge Incurvating edge 
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– зажимается клавиша Ctrl; 

– в месте расположения новой вершины зажимается ЛКМ;  

– осуществляется перемещение курсора мышки, после чего отпускается 

клавиша Ctrl; 

– указывается положение вершины, а затем отпускается ЛКМ. 

2.7.4. Удаление существующей вершины одним из двух способов: 

– удаляемая вершина совмещается с ближайшей вершиной; 

– сначала зажимается ЛКМ на удаляемой вершине, после чего осу-

ществляется перемещение курсора мышки. Затем нажимается клавиша Delete 

и ЛКМ отпускается. 

2.7.5. Изменение положения стороны зажатой ЛКМ (альтернатива ре-

жиму Sliding Edge из п. 2.7.2). Для этого курсор мышки наводится на любое 

ее место, кроме характерных точек.  

2.7.6. Объединение перекрывающихся или соприкасающихся полигонов 

командой ПКМ ⇒ Polygon Actions ⇒ Combine Selected Polygons. 

3. Polygon Pour (полигон с заполнением), создаваемый последователь-

ным нажатием клавиш P ⇒ G или командой Place ⇒ Polygon Pour. 

Особенности работы с полигоном: 

3.1. При расположении полигона на сигнальном слое происходит авто-

матическая корректировка внутреннего заполнения в соответствии с прави-

лами проектирования в группах Electrical ⇒ Clearance и Plane ⇒ Polygon 

Connect Style, т. е. используются заданные зазоры до других объектов и 

применяются установленные стили подключения к требуемым КП и пере-

ходным отверстиям (прямое, с термобарьером или без подключения). 

3.2. После запуска команды открывается окно свойств (рис. Г.72), в ко-

тором можно задать следующие настройки: 

3.2.1. В группе Fill Mode определяется способ заполнения полигона:  

– Solid (Copper Regions) – сплошное заполнение; 

– Hatched (Tracks/Arcs) – заполнение штриховкой в виде линий и дуг; 

– None (Outlines Only) – без заполнения (только внешний контур). 

Примечание. Способы Hatched и None используются редко, поэтому оп-

ции для них в данном разделе не рассматриваются. 

3.2.2. Для способа заполнения Solid доступны следующие опции: 

– Remove Islands Less Than – значение площади отдельных участков 

заполнения (как подключенных, так и неподключенных к другим объектам), 

меньше которой они будут автоматически удаляться; 
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– Arc Approximation – максимальное отклонение от скруглений (окруж-

ности при заполнении аппроксимируются отрезками); 

– Remove Necks When Copper Width Less Than – значение ширины уз-

ких перемычек, меньше которой они будут автоматически удаляться (обычно 

задается минимальное значение по выбранному классу точности ПП). 

3.2.3. В группе Net Options задаются настройки, связанные с цепями: 

– список Connect to Net – название цепи, к которой подключен полигон 

(опция No Net означает отсутствие подключения к цепи); 

– опции заполнения в местах расположения объектов той же цепи, кроме 

КП и переходных отверстий: Don’t Pour Over Same Net Objects – отсутствие 

заполнения, Pour Over All Same Net Objects – заполнение поверх любых 

объектов, Pour Over Same Net Polygons Only – заполнение только поверх 

других полигонов; 

– Remove Dead Copper – автоматическое удаление участков заполнения 

(«островков»), не соединенных с другими объектами той же цепи. 

Примечание. Способы подключения к КП и переходным отверстиям той 

же цепи определяются в правилах проектирования (см. п. 3.1). 

Рис. Г.72 
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3.2.4. В группе Properties задаются следующие настройки: 

– Name – имя полигона; 

– Auto Naming – при включенной опции полигону будет присвоено ав-

томатическое имя по шаблону, определяемому в группе Polygon Auto Naming 

Template окна Board Options (команда Design ⇒ Board Options); 

– Layer – слой расположения полигона; 

– Locked – блокировка полигона; 

– Ignore On-Line Violations – при включенной опции для данного поли-

гона будет отключена проверка нарушений в режиме реального времени. 

Примечания: 

– имя полигона может участвовать при составлении правила проекти-

рования. Примеры обращения к полигону с именем TopGND – InNamedPoly-

gon('TopGND') или (ObjectKind = 'Poly') And (Name = 'TopGND'); 

– полигоны могут иметь одинаковые имена. Тогда правило, созданное 

для данного имени, будет применено ко всем одноименным полигонам; 

– автоматически создаваемые имена отслеживаются и изменяются 

программой, в том числе и в созданных правилах проектирования. 

3.2.5. Настройки вкладка Outline Vertices окна свойств аналогичны рас-

смотренным для полигона Solid Region в п. 2.4. 

3.3. После задания в окне свойств настроек происходит переход в режим 

рисования контура и последующего автоматического заполнения полигона. 

Рисование контура и способы его корректировки ничем не отличаются от 

описанных для полигона Solid Region (см. пп. 2.1, 2.2 и 2.7). 

Примечания: 

– полигон Polygon Pour также можно создать на текущем в данный 

момент слое из предварительно нарисованного графическими примитивами 

(линиями и дугами) замкнутого контура, расположенного на любом слое, 

командой Tools ⇒ Convert ⇒ Create Polygon from Selected Primitives (у со-

зданного полигона будет по умолчанию включен способ заполнения None);  

– автоматическое перестроение полигона после его модификации опре-

деляется опцией Repour Polygons After Modification (см. табл. Г.4). 

3.4. Дополнительные возможности работы с полигоном: 

– с помощью полигона Solid Region с назначением Polygon cutout в по-

лигоне Polygon Pour можно создавать области без заполнения (рис. Г.73); 

– командой Place ⇒ Slice Polygon Pour рисуется кривая, которая в ре-

зультате разделит выбранный полигон на несколько разных полигонов; 
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– принудительное обновление заполнения полигона осуществляется ко-

мандами из меню Tools ⇒ Polygon Pours: Repour Selected – для выделенного 

полигона, Repour All – для всех полигонов, Repour Violating Polygons – для 

полигонов с нарушениями правил проектирования, Repour Modified – для 

измененных полигонов; 

– выбранный полигон можно временно скрыть, выполнив на нем коман-

ду ПКМ ⇒ Polygon Actions ⇒ Shelve Selected; 

– восстановить скрытые полигоны позволяет команда Tools ⇒ Polygon 

Pours ⇒ Restore N Shelved polygon(s), где N – число скрытых полигонов; 

– изменить приоритет заполнения выбранного полигона при пересече-

нии его границ с другим аналогичным полигоном можно командой ПКМ ⇒ 

Polygon Actions ⇒ Bring to front (повысить) или ПКМ ⇒ Polygon Actions ⇒ 

Send to back (понизить), выполненной на нем (рис. Г.74). 

 

3.5. Управление полигонами Polygon Pour осуществляется в окне, запус-

каемом командой Tools ⇒ Polygon Pours ⇒ Polygon Manager (рис. Г.75). 

В группе View/Edit содержатся все существующие в проекте полигоны 

Polygon Pour в виде таблицы со следующими возможностями: 

– в ячейках таблицы (кроме столбцов Net и IsModified) можно изменять 

данные (например, имя полигона); 

– для каждого выбранного полигона доступны рассмотренные ранее ко-

манды из контекстного меню, вызываемого щелчком ПКМ по строке с ним 

(например, полигон можно удалить, скрыть или сделать снова видимым); 

Рис. Г.73 

Рис. Г.74 

Bring to front Send to back 
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– команды также представлены в виде кнопок (например, кнопка Create 

Clearance Rule позволяет создать правило по зазорам, при этом запрос с 

именем выбранного полигона уже будет введен в необходимом поле). 

В группе Pour Order перечисляются полигоны с указанием цвета слоя, 

на котором они расположены, в порядке их приоритета (сверху – наивысший) 

со следующими возможностями: 

– кнопки Move Up и Move Down позволяют изменить порядок полиго-

нов в списке (также можно менять порядок перетаскиванием зажатой ЛКМ); 

– кнопка Auto Generate автоматически проставляет приоритеты по их 

площади (от наименьшей к наибольшей) в пределах каждого слоя; 

– кнопка Animate Pour Order запускает автоматическую анимацию с 

перебором полигонов в порядке уменьшения их приоритета. 

В окне справа от группы Pour Order отображается ПП с выбранными в 

данный момент полигонами. 

Г.27. Идентификаторы цепей 

Соединение на схеме с помощью линии электрической связи осуществ-

ляется не только графически в виде полилинии из Г.25, но одновременно и 

электрически, т. е. с помощью цепи (Net). 

Название цепи присваивается автоматически и по умолчанию содержит 

обозначение пина одного из подключенных к линии электрической связи 

компонентов. Например, на рис. Г.76 название цепи NetC3_2 означает, что 

линия подключена ко 2-му выводу компонента C3.  

Примечание. Если подключение к пинам отсутствует, то имя цепи со-

держит произвольное уникальное число. 

Рис. Г.75 
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Соединение пинов компонентов на схеме может быть выполнено двумя 

способами: 

– физически – непрерывной линей электрической связи как на рис. Г.76. 

Очевидно, что таким способом можно соединить пины компонентов только 

на одном листе схемы; 

– логически – разорванной линией электрической связи, при этом от-

дельные ее участки должны иметь одинаковые имена цепи (например, цепи 

+5В, V1, V2 и GND на рис. 8.66). Такой способ зачастую облегчает чтение 

схемы (например, значительное сокращение графики линий электрической 

связи для цепей GND и питания) и позволяет соединить выводы компонентов 

на разных листах схемы. 

Примечание. В Altium Designer существует два вида многолистового 

проекта: 

– обычный, в котором схема устройства из-за ее большого размера со-

здается на нескольких равноправных листах. Для удобства пользования та-

кими схемами и для уменьшения количества линий электрической связи, пе-

реходящих между листами, на каждом листе стараются разместить ин-

формацию об отдельных функциональных группах (например, на одном ли-

сте – узел вторичного питания, а на другом – СВЧ-тракт); 

– иерархический, в котором каждый функциональный узел изобража-

ется на отдельном листе (листы нижнего уровня), а все взаимосвязи между 

узлами показываются на главном листе (лист верхнего уровня). Другими сло-

вами, данный вид проекта напоминает структурную схему на листе верхне-

го уровня и принципиальные схемы функциональных узлов на листах нижнего 

уровня. Иерархичные проекты могут быть многоуровневыми (отдельные ли-

сты нижнего уровня являются локальными листами верхнего уровня) и мно-

гоканальными (отдельный функциональный узел входит в лист верхнего 

уровня несколько раз). 

Рис. Г.76 
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Для логического соединения применяются идентификаторы цепей со 

следующими особенностями: 

1. Типы идентификаторов цепей: 

1.1. Net Label (метка цепи), добавляемый командой Place ⇒ Net Label 

или последовательным нажатием клавиш P ⇒ N. 

Примечание. Также идентификатор 

может быть добавлен соответствующей 

пиктограммой на ПИ Wiring (рис. Г.77, а). 

Зачастую метки цепи используются 

только для принудительной смены имени 

цепи с целью облегчения чтения схемы и 

создания ПП (рис. Г.77, б). Также без них 

невозможно объединить разные линии элек-

трической связи в линию групповой связи 

(см. п. 2.3 из 8.1). 

1.2. Power Port (порт питания), добав-

ляемый командой Place ⇒ Power Port или 

последовательным нажатием клавиш P ⇒ O.  

Примечание. Также идентификатор 

может быть добавлен соответствующими 

пиктограммами на ПИ Wiring (рис. Г.77, а) 

или Utilities (рис. Г.77, в). 

Идентификаторы, в названии которых 

содержится «power port», отличаются только 

предустановленными названием цепи и сти-

лем значка. Настройки можно поменять 

вручную после размещения. 

Для создания цепи земли (при проекти-

ровании используется цепь GND) рекомен-

дуется добавлять символ земли (рис. Г.77, г) 

указанной командой или клавишами, так как 

в этом случае в нем будут заданы настрой-

ки, соответствующие ЕСКД (см. примитив Power Object из табл. Г.5). 

Для создания цепей питания, а также цепей, для которых необходимо 

выполнить п. 2.7 из 8.1, в свойствах любого идентификатора Power Port 

должны быть заданы следующие настройки: 

Рис. Г.77 

а 

б 

в 

GND Power Port VCC Power Port 

Net Label 

г д 



 

 822 

– стиль – GOST Arrow; 

– опция Show Net Name – включена; 

– в поле Net – требуемое имя цепи. 

Внешний вид идентификатора для цепи «+5В» показан на рис. Г.77, д. 

1.3. Port (порт), добавляемый командой Place ⇒ Port или последова-

тельным нажатием клавиш P ⇒ R. 

Обозначение по умолчанию (текст в рамке) не соответствует требовани-

ям ЕСКД, однако данный идентификатор в обычных многолистовых проек-

тах можно использовать для выполнения п. 2.6 из 8.1: 

– во время создания схемы на концы требуемых линий электрической 

связи устанавливаются порты, в свойствах которых задаются необходимые 

имена цепей, а цвет рамок делается белым; 

– после создания схемы проверяется, что всем листам заданы правиль-

ные номера (при необходимости нумерация изменяется по п. 5.1 из 8.2); 

– запускается команда Reports ⇒ Port Cross Reference ⇒ Add To Pro-

ject, после чего у каждого порта появляется ссылка на номер страницы; 

– поиском похожих объектов (команда Find Similar Objects из Г.6) во 

всем проекте выбираются все параметры с именем CrossRef, после чего в 

свойствах шрифта меняется начертание с курсива на обычный; 

– выполняется команда Tools ⇒ Parameter Manager и в появившемся 

окне выбираются только порты; 

– в следующем открывшемся окне (с таблицей параметров) осуществля-

ется сортировка по столбцу CrossRef, после чего для каждой группы одина-

ковых номеров выбираются все ячейки, нажимается клавиша F2, и номер 

страницы меняется на такой же, но в круглых скобках; 

– в схеме вручную производится коррекция положения параметров. 

1.4. Редко используемые: 

– Sheet Entry (вход листа). С помощью пары идентификаторов Sheet En-

try и Port организуется связь в иерархических проектах. Устанавливается на 

листе верхнего уровня внутри объекта Sheet Symbol, обозначающего один из 

листов нижнего уровня; 

– Off Sheet Connector (соединитель между листами). Предназначен для 

работы в обычных многолистовых проектах, но на практике не используется, 

так как значок не соответствует требованиям ЕСКД; 

– Hidden Pin (скрытый пин в УГО). Применять не рекомендуется, так 

как сложно проследить за корректностью их подключения. 
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2. Опции, связанные с областью действия идентификаторов цепей, нахо-

дятся в окне свойств проекта (команда Project ⇒ Project Options) на вкладке 

Options в группе Net Identifier Scope (табл. Г.11). 

Таблица Г.11 

Опция группы Net Identifier Scope (область действия 

идентификаторов цепей) 

Опция Назначение 

Automatic (Based 

on project contents) 

Автоматическая. Область действия устанавливается автоматически в 

зависимости от содержания проекта: 

– если на верхнем листе проекта есть идентификаторы Sheet Entry, 

то используется опция Hierarchical; 

– если в проекте нет идентификаторов Sheet Entry, но есть иденти-

фикаторы Port, то используется опция Flat; 

– если в проекте нет идентификаторов Sheet Entry и Port, то исполь-

зуется опция Global 

Flat (Only ports 

global) 

Плоская. Идентификаторы Port и Power Port являются глобальными, 

а идентификаторы Net Label – локальными 

Hierarchical (Sheet 

entry <–> port con-

nections, power 

ports global) 

Иерархическая. Предназначена для иерархических проектов. 

Соединения между листами осуществляются только с помощью па-

ры идентификаторов Sheet Entry и Port. Идентификаторы Port без 

связи с соответствующими идентификаторами Sheet Entry не будут 

соединять цепи, даже если они имеют одинаковые имена на разных 

листах. 

Идентификаторы Net Label являются локальными, а идентификато-

ры Power Port – глобальными 

Strict Hierarchical 

(Sheet entry <–> 

port connections, 

power ports local) 

Строгая иерархическая. Предназначена для иерархических проектов. 

Опция аналогична Hierarchical, но идентификаторы Power Port яв-

ляются локальными 

Global (Netlabels 

and ports global) 

Глобальная. Идентификаторы Port, Power Port и Net Label являются 

глобальными.  

Примечание. Локальные идентификаторы имеют область действия в 

пределах одного листа, а глобальные – в пределах нескольких листов. 

3. Опции, связанные с влиянием идентификаторов на имена цепей, 

находятся в окне свойств проекта (команда Project ⇒ Project Options) на 

вкладке Options в группе Netlist Options (табл. Г.12) 

Таблица Г.12 

Опции группы Netlist Options (влияние идентификаторов цепей 

на имена цепей) 

Опция Назначение 

Allow Ports to 

Name Nets 

При подключении к идентификатору Port цепь автоматически пере-

именовывается по имени из его настроек 
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Окончание таблицы Г.12 

Опция Назначение 

Allow Sheet Entries 

to Name Nets 

При подключении к идентификатору Sheet Entry цепь автоматически 

переименовывается по имени из его настроек 

Allow Single Pin 

Nets 

В проекте допускается наличие цепей, подключенных только к од-

ному выводу 

Append Sheet Num-

bers to Local Net 

В проекте допускается существование локальных цепей с одинако-

выми именами меток цепи (Net Label), расположенных на разных 

листах. При этом такие цепи считаются разными и не соединяются 

друг с другом, а при переходе на ПП к их именам добавляются но-

мера листов. Опция работает в случае, если листам присвоены номе-

ра, а в группе Net Identifier Scope (см. п. 2) не используется опция 

Global (при опции Global все цепи с одинаковыми именами будут 

считаться одинаковыми) 

Higher Level Names 

Take Priority 

При наличии нескольких меток цепи (Net Label) с разными именами, 

расположенных на линии электрической связи на разных листах 

схемы, итоговое имя будет взято с листа с более высоким приорите-

том (с листа верхнего уровня). Приоритет идентификаторов цепей от 

высшего к низшему следующий: Net Label, Power Port, Port 

Power Port Names 

Take Priority 

При установке на линию электрической связи идентификатора Pow-

er Port цепь будет автоматически переименована по имени, заданно-

му в его настройках, даже если к этой линии были подключены объ-

екты Port или Net Label 

Примечание. Разные типы идентификаторов с одинаковым именем це-

пи, установленные на разных участках линии электрической связи, не обес-

печивают их логического соединения. 

Г.28. Добавление компонента на схему 

Добавить компонент на схему можно двумя способами: 

1. Из панели Libraries (см. Г.9) одним из двух вариантов: 

1.1. Выбрать требуемый компонент в списке компонентов текущей биб-

лиотеки и нажать кнопку Place в верхней части панели или дважды щелкнуть 

ЛКМ по компоненту в списке. 

В результате фантом добавляемого компонента окажется привязанным к 

курсору мышки до тех пор, пока не будет произведен щелчок ЛКМ в месте 

желаемого его размещения. После этого под курсором мышки появится сле-

дующий такой же компонент для продолжения добавления, завершить кото-

рое можно щелчком ПКМ или клавишей Esc. 

Некоторые доступные до размещения компонента команды: 

– клавиша Tab – открытие окна свойств компонента; 

– клавиша Space – поворот компонента по часовой стрелке на 90º; 
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– комбинация клавиш Shift+Space – поворот компонента против часовой 

стрелки на 90º; 

– клавиша X – перевернуть вдоль оси X; 

– клавиша Y – перевернуть вдоль оси Y. 

Примечание. Список доступных команд и комбинаций клавиш вызыва-

ется клавишей F1 или «~» (см. Г.4). 

1.2. Перетащить требуемый компонент из списка компонентов текущей 

библиотеки зажатой ЛКМ. 

В результате фантом добавляемого компонента также окажется привя-

занным к курсору мышки, но для его размещения в рабочем поле необходимо 

отпустить зажатую ЛКМ, а последующего автоматического перехода к до-

бавлению такого же компонента не происходит. 

Примечание. До размещения компонента доступны описанные в п. 1.1 

команды, кроме клавиш F1 или «~». 

2. Из окна Place Part, открываемого командой Place ⇒ Part или после-

довательным нажатием клавиш P ⇒ P (рис. Г.78). 

 

Выбор компонента осуществляется в окне Browse Libraries (открывает-

ся кнопкой Choose) по аналогии с панелью Libraries. 

Примечание. В окне Browse Libraries нельзя изменить количество отоб-

ражаемых столбцов. 

Рис. Г.78 
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Размещение выбранного компонента после нажатия кнопки OK в окне 

Place Part аналогично п. 1.1. После завершения размещения окно Place Part 

будет открыто автоматически. 

Добавленные ранее в схему компоненты сохраняются в истории и могут 

быть выбраны в списке Physical Component или в окне Placed Parts History, 

открываемом кнопкой History. 

Г.29. Действия при перемещении объектов 

В Altium Designer существует два режима перемещения объектов: 

– Move – перемещение только выбранного объекта; 

– Drag – перемещение выбранного объекта с сохранением соединений (в 

редакторе схем – с линиями электрической связи, в редакторах ПП и поса-

дочных мест – с линиями и трассами). 

Принудительный выбор режима, а также некоторые команды, связанные 

с перемещениями объектов, находятся меню Edit ⇒ Move. 

Примечание. Настройки режимов перемещения по умолчанию распо-

ложены в окне Preferences (команда DXP ⇒ Preferences): 

– для редактора схем – опция Always Drag (см. табл. Г.3); 

– для редакторов ПП и посадочных мест – опции Selected via/track и Un-

selected via/track из группы Dragging подраздела PCB Editor ⇒ Interactive 

Routing (см. рис. Г.59) и опция Comp Drag (см. табл. Г.4). 

Часто используемые действия при изменении положения: 

– открытие окна свойств – клавиша Tab; 

– поворот по часовой стрелке и против нее в редакторах ПП, посадоч-

ных мест и УГО – клавиша Space и комбинация клавиш Shift+Space соответ-

ственно. В редакторе схем – соответственно комбинации клавиш Ctrl+Space 

и Ctrl+Shift+Space. 

Примечания: 

– угол поворота в редакторах схем и УГО кратен 90º, а в редакторах 

ПП и посадочных мест его можно изменить по п. 8.7 из 12.3; 

– в редакторе схем клавишей Space и комбинацией клавиш Shift+Space 

можно повернуть выделенные объекты, которые не находятся в режиме 

перемещения; 

– перемещение на другую сторону ПП в редакторах ПП и посадочных 

мест – клавиша L; 

– переворот вдоль оси X и Y – клавиши X и Y соответственно. 
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Примечание. В редакторе ПП при выполнении переворота посадочного 

места компонента вдоль осей будет выдано предупреждение, так как для 

перемещения на другую сторону ПП используется клавиша L; 

– перемещение в ортогональном режиме – зажатая клавиша Alt. 

Примечание. В редакторах ПП и посадочных мест кроме перемещения 

по вертикали и горизонтали добавляется перемещение по диагоналям; 

– перемещение с десятикратным увеличением шага 

при использовании клавиш Up, Down, Left и Right – за-

жатая клавиша Shift; 

– динамическое выравнивание в редакторе ПП при 

перемещении посадочного места компонента относи-

тельно контуров ближайших компонентов – зажатая кла-

виша Ctrl, а относительно ближайших КП компонен-

тов – зажатая клавиша Shift. 

Примечание. Выравнивание происходит в текущей 

сетке, а индикацией служат зеленые вспомогательные линии (рис. Г.79); 

– перемещение в указанные координаты – команда Edit ⇒ Move Selec-

tion by X, Y. 

Г.30. Выравнивание объектов 

Выравнивание применяется для нескольких предварительно выделенных 

объектов командами из меню Edit ⇒ Align: 

– Align Left и Align Right – выравнивание по левому и правому краю 

соответственно; 

– Align Horizontal Centers и Align Vertical Centers – выравнивание 

объектов по их общему центру, расположенному на горизонтали и вертикали 

соответственно; 

– Distribute Horizontally и Distribute Vertically – выравнивание рассто-

яния между объектами по горизонтали и вертикали соответственно; 

– Increase Horizontal Spacing и Decrease Horizontal Spacing – соответ-

ственно увеличение и уменьшение расстояния между объектами по горизон-

тали на значение текущего шага сетки по оси X. Аналогичные команды из-

менения расстояния по вертикали на значение текущего шага по оси Y – In-

crease Vertical Spacing и Decrease Vertical Spacing. 

Примечание. Команды доступны в редакторах ПП и посадочных мест; 

– Align To Grid – перемещение объектов в узлы текущей сетки. 

Рис. Г.79 
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Примечание. Команда в редакторе посадочных мест не работает, а в 

редакторе ПП работает только с посадочными местами компонентов; 

– Align – выбор действий по выравниванию одновременно по горизон-

тали и вертикали. 

Г.31. Перенумерация компонентов в схеме 

Все настройки для перенумерации компонентов в схеме определяются в 

окне Annotate (команда Tools ⇒ Annotation ⇒ Annotate Schematics): 

1. В группе Order of Processing задается направление перенумерации 

(рисунок под списком опций динамически изменяет-

ся в соответствии со сделанным выбором). 

В соответствии с требованием ЕСКД (см. п. 3.4 

из 8.1) должна быть выбрана опция Down Then 

Across (рис. Г.80). 

2. В группе Process Location of (рис. Г.80) ука-

зывается объект, относительно которого осуществ-

ляется перенумерация: 

– Designator – по положению параметров Des-

ignator относительно точек их привязки (поле Justifi-

cation в свойствах). При данной опции получаются 

плохие результаты для компонентов одного функционального назначения, 

для которых выполнялся поворот УГО (резисторы, конденсаторы и пр.) и 

(или) перемещение параметров; 

– Part – по положению компонентов относительно их центров. При дан-

ной опции получаются плохие результаты для компонентов одного функцио-

нального назначения, УГО которых имеют разную протяженность по гори-

зонтали. Однако в большинстве случаев рекомендуется выбирать именно ее. 

3. В группе Matching Options задаются настройки при работе с компо-

нентами, УГО которых изображено разнесенным способом (см. рис. 8.2), т. е. 

состоит из нескольких секций: 

– в списке Complete Existing Package выбирается область, в которой 

производится упаковка секций для достижения минимального количества 

компонентов: None – не производится, Per Sheet – на каждом отдельном ли-

сте, Whole Project – во всем проекте; 

– в таблице определяются параметры, по которым производится упаков-

ка и принадлежность секций отдельным компонентам. 

Рис. Г.80 
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Примечание. Например, если на схеме есть два одинаковых многосекци-

онных компонента, то для определения принадлежности секций выполняет-

ся следующее: 

– в свойствах всех секций создается пользовательский параметр с оди-

наковым названием (например, Part); 

– параметру из секций, которые относятся к первому компоненту, 

присваивается одно значение, а параметру из секций, которые относятся 

ко второму компоненту, – другое;  

– в таблице из группы Matching Options окна Annotate устанавливается 

галочка слева от созданного параметра. 

4. В таблице Schematic Sheets To Annotate (рис. Г.81) перечислены все 

листы проекта со следующими опциями: 

 

– галочка слева от листа позволяет разрешить перенумерацию для ком-

понентов, расположенных на нем;  

– в столбце Annotation Scope указывается область для перенумерации 

на листе: All – все компоненты, Ignore Selected Parts – все компоненты, кро-

ме предварительно выделенных, Only Selected Parts – только предваритель-

но выделенные компоненты; 

– в столбце Order каждому листу задается номер для определения по-

рядка, в котором он будет включен в перенумерацию; 

– в столбце Designator Index Control можно записать начальное число, с 

которого будет осуществляться присвоение порядковых номеров в позици-

онных обозначениях на данном листе, и разрешить такую возможность уста-

новкой галочки слева от него; 

– в столбце Add Suffix можно задать дополнительные символы, которые 

будут добавляться для компонентов на данном листе. 

Примечание. В контекстном меню, вызываемом щелчком ПКМ в любом 

месте этой таблицы, полезными являются две команды: 

– Order Alphabetically – листы будут записаны в алфавитном порядке их 

наименований; 

– Order By Project Order – листы будут записаны в том порядке, в ко-

тором они находятся в проекте в панели Projects. 

Рис. Г.81 
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5. В таблице Proposed Change List (рис. Г.82) отображаются те компо-

ненты, которые были включены в перенумерацию настройками из таблицы 

Schematic Sheets To Annotate. 

 

Здесь доступны следующие возможности: 

– в столбце Current Designator приводятся текущие позиционные обо-

значения компонентов (в столбце с иконкой замка слева от позиционного 

обозначения наличие галочки означает запрет на его изменение при перену-

мерации); 

– в столбце Current Sub приводятся номера секций для многосекцион-

ных компонентов (в столбце с иконкой замка слева от номера секции наличие 

галочки означает запрет на перенумерацию секций); 

– в столбцах Proposed Designator и Proposed Sub приводятся позици-

онные обозначения и номера секций, которые будут у компонентов после пе-

ренумерации (информация обновляется после нажатия соответствующих 

кнопок внизу окна Annotate); 

– в столбце Location Part для каждого компонента записано название 

листа, на котором он находится. 

Примечания: 

– защитить позиционное обозначение компонента от изменений при 

перенумерации также можно опцией Locked, которая находится напротив 

параметра Designator в свойствах компонента (см. рис. 8.62); 

– защитить номера секций от изменений при перенумерации также 

можно опцией Locked, которая находится напротив надписи Part в свой-

ствах компонента (при создании компонентов рекомендуется включать эту 

опцию); 

– ячейки с защищенными данными окрашиваются в серый цвет. 

Рис. Г.82 
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6. Кнопка Update Changes List позволяет обновить данные в столбцах 

Proposed Designator и Proposed Sub. 

Примечание. Обновление будет произведено только для тех компонен-

тов, которые ранее не были перенумерованы, поэтому для обновления всех 

позиционных обозначений может понадобиться нажатие кнопки Reset All. 

7. Кнопка Reset с двумя опциями: 

– Reset All – приводит все незащищенные позиционные обозначения в 

исходное состояние (то есть вместо порядковых номеров будет знак «?») и 

обновляет данные в столбцах Proposed Designator и Proposed Sub; 

– Reset Duplicates – приводит повторяющиеся незащищенные позици-

онные обозначения в исходное состояние (одно позиционное обозначение в 

каждой такой группе остается неизменным). 

8. Кнопка Back Annotate позволяет загрузить изменения из файла ECO 

или WAS-IS. 

Примечание. В файле ECO в каждой строке сначала записывается те-

кущее позиционное обозначение, а после через пробел – новое позиционное 

обозначение. 

9. Кнопка Accept Changes (Create ECO) после всех заданных настроек в 

окне Annotate открывает окно Engineering Change Order (рис. Г.83), предна-

значенное для просмотра и внесения изменений в схему: 

 

– все изменения, происходящие при перенумерации, находятся в группе 

Annotate Component; 

– каждое изменение описывается в столбце Affected Object; 

– для отмены выбранного изменения необходимо убрать соответствую-

щую галочку в столбце Enable; 

Рис. Г.83 
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– для внесения изменений в схему служит кнопка Execute Changes; 

– успешно внесенные изменения отмечаются зелеными галочками в 

столбцах Check и Done. 

Г.32. Альтернативные виды УГО 

В библиотеке УГО для каждого УГО можно создать дополнительные 

(альтернативные) виды его отображения. Делается это с помощью команд из 

меню Tools ⇒ Mode или пиктограмм на ПИ Mode (рис. Г.84). 

 

Примером УГО с тремя альтернативными видами является диодный 

мост из библиотеки Discretes_Assemblies.SchLib из папки …ИДРЭС\AD li-

brary\sch (рис. Г.85). 

 

Особенности создания УГО с альтернативными видами: 

– названия видов изменить нельзя (первый всегда называется Normal, 

второй – Alternate 1, третий – Alternate 2 и т. д.); 

– количество пинов во всех видах должно быть одинаковым; 

– связь между пинами и КП посадочного места для всех альтернативных 

видов получается одинаковой; 

Рис. Г.85 

Рис. Г.84 

Add a display mode 

(Добавить альтернативный вид) 

Remove the current display mode 

(Удалить текущий альтернативный вид) 

Toggle to previous display mode 

(Перейти к предыдущему альтернатив-

ному виду) 

Toggle to next display mode 

(Перейти к следующему 

альтернативному виду) 

Выбор текущего альтерна-

тивного вида из списка 
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– положение системных параметров является общим для всех видов, по-

этому в их свойствах имеет смысл включать опцию Autoposition.  

Особенности добавления УГО с альтернативными видами на схему: 

– компонент добавляется из библиотеки с тем альтернативным видом 

УГО, который был выбран текущим в 

библиотеке (остался в рабочем поле при 

последнем сохранении); 

– изменить вид УГО компонента 

можно после его размещения на схеме 

через панель SCH Inspector в поле Dis-

play Mode (рис. Г.86).  

Примечание. Также это можно 

сделать в окне свойств компонента и в панели SCH List (см. Г.11); 

– после изменения вида УГО зачастую требуется обновить положение 

системных параметров. Для этого удобнее включить и отключить опцию 

Mirrored в панели SCH Inspector (рис. Г.86). 

Примечание. В используемой при проектировании библиотеке компо-

нентов у некоторых компонентов добавлен пользовательский параметр 

SI_Mode, в котором записано количество видов УГО. Он является справоч-

ным и ни на что не влияет. 

Г.33. Типы компонентов 

В Altium Designer любому УГО и посадочному месту можно присвоить 

один из семи типов, описание которых приведено в табл. Г.13. 

Примечание. Если в библиотечном компоненте заданы разные типы для 

УГО и посадочного места, то приоритет будет за типом УГО. 

Таблица Г.13 

Типы компонентов 

Тип (Type) Описание 

Standard 

Стандартный электрический компонент (например, резистор или 

микросхема). 

Отображается при формировании списка компонентов и синхро-

низируется в проекте между схемой и ПП 

Mechanical 

Механический компонент (например, радиатор или монтажный 

лепесток). 

Отображается при формировании списка компонентов. Синхро-

низируется в проекте между схемой и ПП, если присутствует и на 

схеме, и на ПП 

Рис. Г.86 
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Окончание таблицы Г.13 

Тип (Type) Описание 

Graphical 

Графический компонент (например, логотип). 

Не отображается при формировании списка компонентов и не 

синхронизируется в проекте между схемой и ПП 

Net Tie (In BOM) 

Компонент для объединения нескольких цепей (например, про-

водная перемычка, соединяющая КП с разными цепями). 

Отображается при формировании списка компонентов и синхро-

низируется в проекте между схемой и ПП 

Net Tie 

Компонент для объединения нескольких цепей (например, две 

или более КП, соединенные трассой). 

Не отображается при формировании списка компонентов, но син-

хронизируется в проекте между схемой и ПП 

Standard (No BOM) 

Стандартный электрический компонент. 

Не отображается при формировании списка компонентов, но син-

хронизируется в проекте между схемой и ПП 

Jumper 

Компонент для обозначения проводной связи между участками 

одной цепи, расположенными в разных местах. Обычно исполь-

зуется на ОПП в виде проводной перемычки. 

На схеме такие компоненты не подключаются и нужны для фор-

мирования списка компонентов и материалов. На ПП использу-

ются, чтобы установить связь между КП по воздуху, которая учи-

тывается при проверке правил проектирования 

Особенности компонентов типа Net Tie и Jumper: 

1. Создание компонента типа Net Tie: 

– в редакторе посадочных мест добавляются КП и осуществляется их 

соединение (например, на рис. Г.87, а две КП соединены линией). 

Примечание. Настройки КП – обычные, т. е. уникальные номера в поле 

Designator и нулевое значение в поле Jumper ID (см. п. 1 из Г.17); 

– в редакторе УГО добавляются пины в количестве КП из посадочного 

места и при необходимости соединяются линиями (например, на рис. Г.87, б 

два пина просто расположены стык в стык); 

– в редакторе УГО в свойствах компонента в поле Type выбирается оп-

ция Net Tie, отключается видимость системных параметров (опция Visible 

напротив полей Default Designator и Default Comment), в поле Default Desig-

nator записывается «NetTie?» (без кавычек) и при создании интегрированной 

библиотеки подключается посадочное место. 

2. Использование компонента типа Net Tie. В редакторе схем к пинам 

УГО компонента подключаются разные цепи (рис. Г.87, в), а после перехода 

в редактор ПП к КП подводятся трассы этих цепей, при этом ошибки соеди-

нения разных цепей в этом месте не возникает (рис. Г.87, г). 
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Примечания: 

– на рис. Г.87, а в свойствах линии для параметра Solder Mask Expansion 

выбрана опция From Rule для автоматического создания соответствующей 

графики в слое Top Solder (делать это не обязательно); 

– соединить КП можно и другими объектами (например, полигоном); 

– ширину области соединения КП можно выбрать любой; 

– в поле Default Designator записано «NetTie?», чтобы позиционное обо-

значение компонента не влияло на другие позиционные обозначения; 

– при подведении трасс к такому посадочному месту в редакторе ПП 

потребуется использовать режим Ignore Obstacles (см. п. 2.1 из Г.42). 

3. Создание компонента типа Jumper: 

– в редакторе посадочных мест добавляются две несвязанные друг с 

другом КП с уникальными номерами в поле Designator и одинаковым нену-

левым значением в поле Jumper ID (см. п. 1 из Г.17); 

– в редакторе УГО добавляются два пина и при необходимости соеди-

няются графическим объектом (например, кривой Безье); 

– в редакторе УГО в свойствах компонента в поле Type выбирается оп-

ция Jumper, в поле Default Designator записывается «Jump?» (без кавычек) и 

при создании интегрированной библиотеки подключается посадочное место. 

4. Использование компонента типа Jumper. В редакторе схем подобные 

компоненты размещаются на отдельном листе, при этом их пины не обяза-

Рис. Г.87 

а б 

в 

г 

Пин № 1 Пин № 2 
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тельно подключать к линиям электрической связи, так как после перехода в 

редактор ПП их КП в любом случае не будут подключены к цепям.  

В редакторе ПП любая КП из состава такого компонента вручную под-

ключается к цепи, в которой необходимо осуществить связь проводом. В ре-

зультате КП окажутся соединены дугой с цветом цепи (см. рис. Г.34, б). 

Примечания: 

– в поле Default Designator записано «Jump?», чтобы позиционное обо-

значение компонента не влияло на другие позиционные обозначения; 

– недостатком добавления компонента типа Jumper на схему является 

использование дополнительного листа, который не нужно выводить на пе-

чать (потребуется вручную корректировать количество листов проекта в 

столбце SheetTotal на рис. 8.5). Также компонент будет отображаться в 

списке компонентов, что для перечня элементов не нужно; 

– можно не делать полноценный компонент, ограничившись созданием 

только посадочного места с опцией Jumper в поле Type (см. рис. 5.19, а). В 

этом случае посадочное место добавляется из библиотеки посадочных мест 

в редактор ПП. Недостаток этого способа заключается в том, что при об-

новлении ПП из схемы будет появляться запрос на удаление компонента; 

– КП из состава посадочного места можно переместить в рабочем по-

ле редактора ПП, предварительно отключив опцию Lock Primitives. 

Г.34. Библиотека компонентов в виде базы данных 

Компоненты, необходимые в вариантах задания для разработки проекта 

ПП, содержатся в библиотеке в виде базы данных из папки …\ИДРЭС\AD 

library (см. рис. 2.9). Ее достоинства и недостатки указаны в п. 3 из 5.1, а 

пример подключения к проекту – в п. 8 из 8.2. 

Особенности разработки указанной библиотеки в виде базы данных: 

1. В соответствии с информацией из 5.2 и 6.6 создаются библиотеки по-

садочных мест. 

В рассматриваемой библиотеке для удобства посадочные места пред-

ставлены в двух библиотеках в папке pcb (см. рис. 2.9): 

– Connectors_Switches.PcbLib – разъемы и переключатели; 

– Others.PcbLib – дискретные компоненты и микросхемы. 

Примечания: 

– как и с танталовым конденсатором, посадочные места и 3D-модели 

компонентов (см. разд. 5 и 6) создаются на основе информации, приведенной 
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в их документации. Например, для микросхемы HMC291SE посадочное ме-

сто в сетке 0,5 мм показано на рис. Г.88, а, а чертеж корпуса SOT-23-6 из 

документации и его 3D-модель – на рис. Г.88, б; 

 

– подразумевается, что одно посадочное место может использоваться 

в разных компонентах, выполненных в соответствующем корпусе; 

– кроме рисования вручную можно воспользоваться командой Tools ⇒ 

IPC Compliant Footprint Wizard, позволяющей не только автоматически со-

здавать посадочные места широко используемых корпусов, но и генериро-

вать для них приличные 3D-модели. Сильно упрощенный вариант такой под-

программы запускается командой Tools ⇒ Component Wizard. 

Следует обратить внимание на то, что в отдельных случаях автома-

тически созданные места требуют ручной корректировки. 

Рис. Г.88 

а 

б 
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2. В соответствии с информацией из 5.3 создаются библиотеки УГО. 

В рассматриваемой библиотеке для удобства УГО представлены в трех 

библиотеках в папке sch (см. рис. 2.9): 

– Connectors_Switches.SchLib – разъемы и переключатели; 

– Discretes_Assemblies.SchLib – дискретные компоненты и их сборки; 

– IntegratedCircuits.SchLib – микросхемы. 

Пример УГО микросхемы HMC291SE показан на рис. Г.89, а. 

 Рис. Г.89 

а 

б 
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Примечания: 

– заполнение функциональных назначений пинов (поля Display Name в их 

свойствах) удобно осуществлять в панели SCHLIB List (см. Г.11); 

– в свойствах УГО для дальнейших действий не нужно создавать поль-

зовательские параметры, заполнять параметр Description и подключать 

посадочные места. Исключением в данной библиотеке являются параметры, 

которые используются для указания нестандартной функции микросхемы 

(см. рис. Г.89, б и примечание к п. 9.1 из 8.3); 

– для разных компонентов, имеющих одинаковые номера выводов и их 

функциональные назначения, рекомендуется создавать одно общее УГО. 

Например, для микросхем GVA-62+, GVA-63+, GVA-83+ и GVA-123+, исполь-

зуемых при проектировании, используется одно УГО с названием GVA_ (см. 

рис. Г.89, а); 

– для каждого компонента следует проверять совпадение номеров пи-

нов в УГО и номеров КП в посадочном месте. Если это не так (у некоторых 

производителей последовательность присвоения номеров выводов для одного 

и того же корпуса может быть разной), то необходимо создать копию по-

садочного места и скорректировать в нем нумерацию. 

3. Создается файл базы данных. 

В рассматриваемой библиотеке такой файл подготовлен в Microsoft Ac-

cess (ИДРЭС-ADLibrary.mdb на рис. 2.9).  

Примечание. Выбор Microsoft Access вместо Microsoft Excel обусловлен 

следующими причинами: 

– вносить изменения в базу данных можно даже в том случае, если она 

уже используется в Altium Designer (для базы данных в Microsoft Excel файл 

будет доступен только для чтения, если он не был открыт раньше, чем за-

пущен Altium Designer); 

– дальнейшее создание библиотеки осуществляется без внесения допол-

нительных корректировок.  

В базе данных есть два типа объектов: таблицы и запросы. 

3.1. Таблицы используются для хранения информации о компонентах:  

– обычные таблицы, в каждой из которых содержатся данные компонен-

тов одного функционального назначения (диоды, конденсаторы и т. д.), при 

этом каждая строка представляет собой отдельный компонент (рис. Г.90, а); 

– таблица «_Корпуса» с данными о корпусах, которые могут использо-

ваться в разных компонентах (рис. Г.90, б). 
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 Рис. Г.90 

а 

б 
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в 
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Примечания: 

– информация о корпусах разъемов и переключателей содержится в со-

ответствующих таблицах для этих компонентов; 

– таблицы создаются командой Создание ⇒ Таблица; 

– редактирование столбцов (добавление или удаление, изменение их по-

рядка и др.) производится в режиме «Конструктор» (команда ПКМ ⇒ Кон-

структор, выполненная на названии соответствующей таблицы), в кото-

ром они называются «полями». 

Столбцы (поля) таблиц условно делятся на три группы:  

– столбец-идентификатор; 

– столбцы с системными данными; 

– столбцы с пользовательскими данными. 

В столбце-идентификаторе для каждого компонента должна быть запи-

сана уникальная информация, по которой его можно отличить от любых дру-

гих. Это может быть и Part Number, но в данной базе данных в таблицах с 

компонентами используется порядковый номер (столбец Number), т. к. Part 

Number у разных фирм может быть одинаковым, а в таблице с корпусами 

компонентов – столбец с системными данными Footprint Ref. 

Минимальный набор обязательных столбцов с системными данными (то 

есть данными для получения полноценного компонента) следующий:  

– Library Ref и Footprint Ref – названия УГО и посадочных мест в биб-

лиотеках соответственно; 

– Library Path и Footprint Path – названия библиотек УГО и посадоч-

ных мест соответственно (здесь также прописываются пути к библиотекам, 

если они находятся не в папке или подпапках с базой данных). 

Примечание. Если к компоненту подключается два и более посадочных 

места (например, для диода 1N4007), то для каждого следующего создается 

отдельная пара столбцов, начиная с Footprint Ref 2 и Footprint Path 2. 

Необязательным столбцом с системными данными является столбец De-

scription (служит для заполнения соответствующего параметра компонента). 

Количество столбцов с пользовательскими данными может быть любым 

и определяется удобством пользования базой данных и конкретизацией па-

раметров при поиске нужного компонента, например: 

– PI_3D-model – название 3D-модели; 

– CI_BOM – запись для последующего получения перечня элементов; 

– CI_Temperature – температурный диапазон работы компонента. 
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Примечания: 

– столбцы с системными данными могут иметь произвольные названия, 

но для существенного упрощения последующих действий следует использо-

вать указанные стандартные имена; 

– столбцам с данными одного назначения в разных таблицах следует 

давать одинаковые названия; 

– порядок записи столбцов влияет только на удобство внесения данных. 

Связь таблиц с компонентами и таблицы «_Корпуса» осуществляется на 

вкладке Схема данных (команда Работа с базами данных ⇒ Схема дан-

ных) по столбцу Footprint Ref (см. рис. Г.90, в). 

Примечания: 

– предварительно для столбца Footprint Ref в таблице «_Корпуса» в 

режиме «Конструктор» требуется включение опции «Ключевое поле»; 

– связь осуществляется перетаскиванием зажатой ЛКМ столбца из 

таблицы «_Корпуса» на аналогичные столбцы в таблицах с компонентами и 

заданием опций в появляющемся окне (см. рис. Г.90, в). 

3.2. Запросы на выборку используются для последующей работы с ними 

в Altium Designer как с библиотеками компонентов и имеют следующие пре-

имущества перед таблицами: 

– компоненты в Altium Designer будут изначально отображаться в том 

порядке, в котором они отсортированы в запросах, а при использовании таб-

лиц – в порядке их добавления вне зависимости от примененных сортировок; 

– в запросах можно уже на уровне базы данных отключить ненужные 

вспомогательные столбцы, а не выполнять эти действия в Altium Designer. 

Каждому запросу присваивается то название, которое будет отображать-

ся в названии библиотеки. В данном случае в основном использованы бук-

венные коды позиционных обозначений компонентов (см. рис. Г.90, г). 

При изменении данных в таблицах информация в запросах обновляется 

автоматически. Исключением являются действия с переименованием, удале-

нием и добавлением столбцов. 

Примечание. Запрос на выборку создается командой Создание ⇒ Кон-

структор запросов. В появляющемся окне «Добавление таблицы» на вкладке 

«Таблицы» добавляются следующие таблицы: или таблица «_Корпуса» и 

требуемая таблица с компонентами, для которых корпуса указаны в первой 

таблице, или таблица с компонентами, для которых корпуса не указаны в 

таблице «_Корпуса» («Переключатели», «Разъемы» и др.).  
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Затем поля из добавленных таблиц перетаскиваются в нижнюю часть 

рабочей области экрана (можно перетаскивать сразу группу выделенных 

полей), кроме следующих вспомогательных: 

– Number – используется для нумерации строк и позволяет отсортиро-

вать данные в порядке их добавления; 

– Type – используется для сортировки корпусов по их принадлежности к 

функциональным группам компонентов; 

– Footprint Ref из таблицы «_Корпуса» – полностью повторяет соот-

ветствующее поле в таблице с компонентами. 

Следует обратить внимание на две настройки полей (см. рис. Г.90, г): 

– для поля «Add» отключена галочка «Вывод на экран», а также задано 

условие отбора по знаку «+», что позволяет управлять количеством отобра-

жаемых в библиотеке Altium Designer компонентов (при большом их числе 

сильно увеличивается время первого открытия библиотек и наблюдаются 

подвисания при работе); 

– для поля «PartNumber» включена сортировка «по возрастанию». 

4. В Altium Designer командой File ⇒ New ⇒ Library ⇒ Database Li-

brary создается файл библиотеки с расширением «.DBLib», после чего он со-

храняется в папку с базой данных (ИДРЭС-ADLibrary.DbLib на рис. 2.9). 

Примечания: 

– данный файл устанавливает соответствия между столбцами базы 

данных и параметрами компонентов в САПР; 

– открытие уже существующей библиотеки в виде базы данных осу-

ществляется командой File ⇒ Open. 

5. Подключается база данных, для чего выполняется следующее: 

– запускается команда Tools ⇒ Options и в открывшемся окне Database 

Library Options на вкладке Symbol & Model Search Paths включается опция 

Search Subdirectories для автоматического поиска библиотек УГО и поса-

дочных мест во всех подпапках папки с базой данных; 

– в рабочем поле в группе Source of Connection выбирается тип базы 

данных Microsoft Access и кнопкой Browse указывается путь к ней. Для воз-

можности перемещения папки с библиотекой необходимо включить опцию 

Store Path Relative to Database Library (относительный путь к базе данных); 

– нажимается кнопка Connect, в результате чего в рабочем поле слева от 

нее появляется список всех таблиц и запросов базы данных с галочками в 

столбце Enable (разрешение использования в библиотеке); 
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– оставляются галочки в столбце Enable только для 

запросов (рис. Г.91); 

– для каждого запроса, выбранного щелчком ЛКМ 

(рис. Г.91), в группе Field Settings в поле Database field 

выбирается название столбца-идентификатора; 

– сохраняются изменения в библиотеке. 

Примечания: 

– чтобы переподключить базу данных в случае 

корректировок в ее столбцах, в рабочем поле следует 

сначала дважды щелкнуть по опции Store Path Relative to Database Library, 

после чего нажать кнопку Reconnect; 

– на вкладке Field Mappings (рис. Г.92) можно настроить соответ-

ствия между полями базы данных (Database Field Name) и параметрами 

компонентов в САПР (Design Parameter) отдельно для каждого запроса с 

рис. Г.91. Параметры в квадратных скобках – системные; 

 

– при необходимости отключения любого поля из базы данных в столб-

це Design Parameter напротив него выбирается опция [None]; 

– на вкладке Field Mappings также задаются настройки для пользова-

тельских параметров: Update Values – обновление параметра, который уже 

есть в проекте (Update – обновлять, Do not update – не обновлять); Add To 

Design – добавление параметра, отсутствующего в проекте (Add – добав-

лять, Do not add – не добавлять, Add only if not blank in database – добавлять, 

если в базе данных ему присвоено какое-то значение); Visible On Add – управ-

ление видимостью параметра; Remove From Design – удаление параметра из 

проекта, если он отсутствует в базе данных или в ней ему не присвоено зна-

чения (Do not remove – не удалять, Remove only if blank in database – удалять, 

если в базе данных ему не присвоено значение).  

По умолчанию все настройки имеют значения Default, т. е. определяет-

ся на вкладке Default Actions окна Database Library Options (команда Tools ⇒ 

Options); 

Рис. Г.92 

Рис. Г.91 
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– на вкладке Table Browser приводится состав базы данных для выбран-

ного запроса с рис. Г.91. Кроме того, командами из контекстного меню, вы-

зываемого щелчком ПКМ в любом месте таблицы, можно отредактиро-

вать или удалить любой компонент, а также создать новый. Все изменения 

автоматически передаются в файл базы данных. 

Г.35. Режим Cross Select Mode 

В режиме Cross Select Mode (режим перекрестного выделения) при вы-

делении объектов в редакторе схем осуществляется автоматическое выделе-

ние их в редакторе ПП (и наоборот). 

Включение и выключение режима производится в редакторах схем и ПП 

командой Tools ⇒ Cross Select Mode. 

В группе Cross Select Mode из подраздела System ⇒ Navigation окна 

Preferences (команда DXP ⇒ Preferences) доступны следующие настройки 

режима (рис. Г.93): 

 

– Cross Selection – включение режима; 

– Masking – затенение невыбранных объектов в редакторе, в котором не 

осуществлялся текущий выбор объектов; 

– Zooming – автомасштабирование выбранных объектов в редакторе, в 

котором не осуществлялся текущий выбор объектов.  

Примечание. Настройка уровня масштаба задается в этом же подраз-

деле в группе Highlight Methods (рис. Г.25) перемещением ползунка от Far 

(далеко) до Close (вписать объекты в рабочее поле); 

– Reposition selected component in PCB (Hotkey: Ctrl+Shift+Y) – вклю-

чение режима переразмещения посадочных мест для предварительно вы-

бранных в схеме компонентов. В основном используется для переразмеще-

ния компонентов по отдельности и работает только при одновременно отоб-

ражаемых вкладках со схемой и файлом трассировки; 

Рис. Г.93 
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– Focus document containing selection if visible – при одновременном 

отображении схемы и файла трассировки после выбора объекта в одном ре-

дакторе автоматически активируется вкладка с другим редактором; 

– Components – режим работает с компонентами; 

– Nets – режим работает с цепями; 

– Pins – режим работает с пинами. 

Г.36. Система привязок в редакторах ПП и посадочных мест 

Под системой привязок понимается набор возможностей для размеще-

ния объектов в требуемых координатах рабочего поля. Достаточно удобный 

доступ к ним осуществляется из меню Snap в нижнем правом углу рабочего 

поля (рис. Г.94). 

В редакторах ПП и посадочных мест 

есть три категории привязок: 

1. Сетки. 

Предусмотрены следующие особенности 

их использования: 

1.1. Привязка к сеткам включается ко-

мандой Snap ⇒ Snap To Grids. 

1.2. В рабочем поле одновременно мо-

жет существовать несколько разных сеток. 

1.3. Для просмотра и управления сетка-

ми служит окно Grid Manager (рис. Г.95), 

открываемое командами Snap ⇒ Grids или 

Tools ⇒ Grid Manager. 

 Рис. Г.95 

а 

б в 

Рис. Г.94 
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На рис. Г.95, а показаны столбцы, общие для редакторов ПП и посадоч-

ных мест: 

– Priority – приоритет сетки. Сетка, расположенная в списке выше дру-

гих, будет отображаться поверх всех остальных, и именно с ней в этой обла-

сти рабочего поля будет осуществляться работа. Изменить приоритет выде-

ленной сетки можно командами Increment Priority (увеличить) и Decrement 

Priority (уменьшить) из контекстного меню, вызываемого щелчком ПКМ в 

любом месте таблицы из этого окна (команды также можно выполнить ком-

бинациями клавиш Ctrl+Up и Ctrl+Down соответственно); 

– столбец без названия – вид сетки (P – полярная, C – декартовая). Вы-

бор вида осуществляется только при создании сетки командами ПКМ ⇒ Add 

Polar Grid и ПКМ ⇒ Add Cartesian Grid; 

– Name – наименование сетки (можно изменить в свойствах сетки); 

– Description – описание сетки (формируется автоматически в соответ-

ствии с настройками сетки); 

– Fine – цвет объектов сетки (точек или линий), идущих с основным ша-

гом сетки (настраивается в свойствах сетки); 

– Coarse – цвет объектов сетки (точек или линий), идущих с увеличен-

ным шагом сетки (настраивается в свойствах сетки). 

На рис. Г.95, б показаны столбцы из окна Grid Manager для редактора 

посадочных мест (параметры в ячейках можно изменять): 

– Scope – область действия сетки (Component – только в текущем поса-

дочном месте, Whole Library – во всей библиотеке); 

– Enabled – включение и отключение сетки. 

На рис. Г.95, в показаны столбцы из окна Grid Manager для редактора 

ПП (параметры в ячейках можно изменять): 

– Non Comp – сетка предназначена для всех объектов, кроме посадоч-

ных мест компонентов (при перемещении посадочных мест такая сетка в ра-

бочем поле будет временно скрываться); 

– Comp – сетка предназначена только для посадочных мест компонен-

тов (при редактировании других объектов такая сетка в рабочем поле будет 

временно скрываться). 

Примечания: 

– опции в столбцах Non Comp и Comp работают независимо друг от 

друга, т. е. можно сделать сетку для всех объектов, поставив обе галочки, 

или временно отключить ее, сняв обе галочки; 
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– вид сеток в рабочем поле с рис. Г.95 пока-

зан на рис. Г.96; 

– доступны различные команды как из кон-

текстного меню, вызываемого щелчком ПКМ, 

так и при нажатии на кнопку Menu в нижней ча-

сти окна. Например, сетки можно удалить или 

сохранить в отдельный файл; 

– сетка Default – декартовая сетка по умол-

чанию. Ее приоритет всегда самый последний, а 

из настроек доступно только изменение шага по осям X и Y, цвета и оформ-

ления (точки или линии). 

1.4. Параметры сетки можно настроить в окне Grid Manager (см. 

рис. Г.95), дважды щелкнув по требуемой строке ЛКМ (или запустив на ней 

команду ПКМ ⇒ Properties), или в рабочем поле, подведя курсор мышки на 

требуемую сетку и нажав комбинацию клавиш Ctrl+G. 

Для декартовой сетки в окне свойств (рис. Г.97) доступны следующие 

опции: 

 

– в группе Settings – наименование сетки (поле Name), система единиц 

измерения (список Units) и угол поворота (поле Rotation) относительно точ-

ки начала отсчета сетки из группы Origin; 

– в группе Steps – шаг сетки по осям X и Y (поля Step X и Step Y соот-

ветственно), которые по умолчанию задаются одинаковыми (их можно задать 

Рис. Г.97 

Рис. Г.96 
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разными, если отключить пиктограмму с цепочкой). Опция Set Step X in 

PCB View и аналогичная для оси Y позволяет ввести в поле шага сетки авто-

матически полученное расстояние между двумя указанными в рабочем поле 

точками, а опция Set Step X from Delta X и аналогичные для оси Y и одно-

временно для двух осей – расстояние между двумя указанными в рабочем 

поле точками по соответствующим осям; 

– в группе Origin – координаты точки начала отсчета сетки (с помощью 

опции Set Origin in PCB View точку можно указать в рабочем поле); 

– в группе Display – цвет и вид объектов сетки (точки, линии или отсут-

ствие отображения), идущих с основным шагом сетки (поле Fine) и с увели-

ченным шагом сетки (поле Coarse). В поле Multiplier задается множитель 

для сетки с увеличенным шагом; 

– в группе Extents – размеры одного квадранта сетки. Их можно сделать 

разными по двум осям, отключив пиктограмму с цепочкой, и автоматически 

записать полученное расстояние между двумя указанными в рабочем поле 

точками по соответствующим осям; 

– в группе Quadrants – квадранты относительно точки начала отсчета из 

группы Origin, в которых располагается сетка. 

Для полярной сетки в окне свойств (рис. Г.98) доступны следующие оп-

ции, которые не были описаны для декартовой сетки: 

– в группе Steps – шаг по углу (в градусах в поле Angular Step) и по ра-

диусу (поле Radial Step); 

 Рис. Г.98 
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– в группе Angular Range – диапазон изменения угла; 

– в группе Radial Range – диапазон изменения радиуса. 

1.5. Шаг сетки Default кроме окна свойств можно быстро изменить из 

рабочего поля, нажав клавишу G и выбрав в появившемся меню нужное зна-

чение (рис. Г.99). Также можно задать раз-

ные шаги по осям и списков Snap Grid X и 

Snap Grid Y. 

Произвольное значение шага сетки за-

дается следующими способами: 

– если значение не будет часто ис-

пользоваться, то следует выбрать команду 

Set Global Snap Grid и ввести его в по-

явившемся окне (рис. Г.100). 

Примечание. Окно Snap Grid также 

можно вызвать из рабочего поля комбина-

цией клавиш Shift+Ctrl+G или последова-

тельным нажатием клавиш G ⇒ G; 

– если значение планируется исполь-

зовать часто, то имеет смысл добавить его 

в список с рис. Г.99. Для этого с зажатой клавишей Ctrl осуществляется щел-

чок по любому ненужному значению, после чего оно корректируется в поле 

Parameters появившегося окна Edit Command с указанием в поле Caption 

названия для отображения в списке. Кроме того, в названии можно восполь-

зоваться символом «&» (см. Г.4). 

2. Характерные точки объектов. 

Настройка привязок к характерным точкам объектов осуществляется в 

окне Board Options (команды Snap ⇒ Advanced Snap Options или Design ⇒ 

Board Options), фрагмент которого показан на рис. Г.101. 

В группе Snap Options доступны следующие общие опции привязок: 

– Snap To Object Hotspots – привязка к характерным точкам объектов, 

расположенных только на текущем слое; 

– Range – радиус окружности вокруг характерной точки, при попадании 

внутрь которой курсор мышки будет привязываться к ней; 

– Snap On All Layers – привязка к характерным точкам объектов, рас-

положенных на всех слоях; 

– Snap To Board Outline – привязка к границам ПП; 

Рис. Г.100 

Рис. Г.99 
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– Snap To Arc Centers – привязка к центрам дуг и окружностей; 

– Snap To Object Axis – привязка к осям объектов (к их центральным 

точкам). 

Примечания: 

– в группе Snap Options также доступны опции по управлению привяз-

кой к сеткам из п. 1 (Snap To Grids) и привязками к направляющим из п. 3 

(Snap To Linear Guides и Snap To Point Guides); 

– циклическое переключение между отключением привязок к характер-

ным точкам, включением таких привязок на текущем слое и включением на 

всех слоях в рабочем поле осуществляется комбинацией клавиш Shift+E.  

В группе Advanced Options - Snap to Object Axis при включении опции 

Snap To Object Axis доступны следующие дополнительные опции: 

– Near Range – радиус окружности от курсора мышки до осей объектов 

(до их центральных точек), по которым будет осуществляться выравнивание 

с появлением выравнивающих линий (рис. Г.102); 

– Near Objects – включение выравнивания по осям (по их центральным 

точкам) отмеченных под этой опцией объектов, которые расположены в пре-

делах значения из поля Near Range (близкие объекты); 

Рис. Г.101 
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– Far Objects – включение выравнивания по 

осям (по их центральным точкам) отмеченных под 

этой опцией объектов, которые расположены за 

пределами значения из поля Near Range (дальние 

объекты). 

Примечание. Опции по привязке к характер-

ным точкам объектов с текущего слоя и по при-

вязке к осям дальних и ближних объектов доступ-

ны также в меню Snap (см. рис. Г.94).  

3. Направляющие (вспомогательные линии и точки). 

Предусмотрены следующие особенности их использования: 

3.1. Для добавления направляющих мышкой в рабочем поле использу-

ются команды из меню Place ⇒ Work Guides (рис. Г.103): 

– Place Point Guide – вспомогательная точка; 

– Place Vertical Guide и Place Horizontal Guide – 

вспомогательная вертикальная и горизонтальная пря-

мая соответственно; 

– Place +45 Degree Guide и Place –45 Degree 

Guide – вспомогательная прямая с углом наклона к 

оси X плюс 45° и минус 45° соответственно. 

3.2. Для просмотра и управления направляющими служит окно Snap 

Guide Manager (рис. Г.104, а), открываемое командами Snap ⇒ Guides или 

Tools ⇒ Guide Manager, со следующими элементами: 

 

– столбец Guide Type – тип направляющей; 

– столбцы X и Y – координаты расположения вспомогательной точки 

или точки рабочего поля, через которую проходит вспомогательная прямая 

(для горизонтальной и вертикальной вспомогательных прямых указывается 

только одна координата); 

Рис. Г.104 

а б 

Рис. Г.102 

Рис. Г.103 
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– столбец Color – цвет направляющей; 

– столбец Enabled – включение или отключение направляющей; 

– кнопка Add – добавление направляющих; 

– контекстное меню, вызываемое щелчком ПКМ в любом месте данного 

окна, или кнопка Menu – дополнительные команды. Например, направляю-

щие можно удалить или сохранить в файл. 

3.3. Привязки к направляющим включаются командами Snap ⇒ Snap To 

Linear Guides (для вспомогательных линий) и Snap ⇒ Snap To Point Guides 

(для вспомогательных точек), а также соответствующими опциями в окне 

Board Options (см. п. 2). 

Примечания: 

– чем больше текущий шаг сетки, тем больше размеры области, в ко-

торой начинает срабатывает привязка к направляющим (даже если привяз-

ка к сеткам отключена); 

– если из всех привязок включены только привязки к направляющим, то 

курсор мышки будет привязываться к местам пересечений вспомогательных 

линий (см. рис. Г.104, б) или к вспомогательным точкам. При включении при-

вязки к сеткам появится дополнительное привязывание к местам пересече-

ния вспомогательных линий с линиями сетки. При включении привязки к осям 

объектов появится дополнительное привязывание к местам пересечения вы-

равнивающих линий (и объектов) со вспомогательными линиями. 

Г.37. Информационное поле 

Информационное поле по умолчанию отображается в левом верхнем уг-

лу рабочего поля в редакторах ПП и посадочных мест (см. рис. 5.7).  

В подразделе PCB Editor ⇒ Board Insight Modes окна Preferences (ко-

манда DXP ⇒ Preferences) содержатся следующие его настройки: 

1. В группе Display (рис. Г.105): 

– Display Heads Up Information – отображение информационного поля. 

 Рис. Г.105 
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Примечание. В рабочем поле данная опция управляется комбинацией 

клавиш Ctrl+H; 

– Use Background Color – отображение фона прямоугольной формы за 

надписями информационного поля, настройки цветов которого задаются с 

помощью соответствующих пиктограмм; 

– Insert Key Resets Heads Up Delta Origin – клавиша Insert сбрасывает 

в ноль параметр Last Click Delta (см. п. 2); 

– Mouse Click Resets Heads Up Delta Origin – щелчок ЛКМ сбрасывает 

в ноль параметр Last Click Delta (см. п. 2); 

– Hover Mode Delay – задержка до появления данных в информацион-

ном поле в режиме его работы при остановке курсора на объекте; 

– Heads Up Opacity и Hover Opacity – прозрачность информационного 

поля в режиме его работы при перемещении курсора мышки и при его оста-

новке на объекте соответственно. 

2. В группе Insight Modes представлена таблица, в которой определяет-

ся содержание информационного поля и внешний вид данных (рис. Г.106). 

 

Столбец Description содержит доступные для отображения параметры: 

– Cursor Location – текущие координаты курсора мышки (x и y); 

– Last Click Delta – смещение курсора мышки от места обнуления его 

координат (dx и dy). 

Примечание. В рабочем поле включить и отключить данный параметр 

можно комбинацией клавиш Shift+D; 

– Current Layer – текущий слой. 

Примечание. В режиме просмотра только одного слоя (комбинация 

клавиш Shift+S) справа от его названия в скобках будет указано Single; 

Рис. Г.106 
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– Snap Grid – текущий шаг сетки; 

– Summary – количество компонентов и цепей под курсором мышки; 

– Heads Up Shortcuts – сочетания клавиш; 

– Violation Details – информация об обнаруженных нарушениях правил 

проектирования под курсором мышки; 

– Net Details – информация о цепи под курсором мышки; 

– Component Details – информация о компоненте под курсором мышки; 

– Primitive Details – информация о примитиве под курсором мышки. 

В столбцах Heads Up и Hover отмечаются параметры, которые будут 

отображаться в режиме работы информационного поля при перемещении 

курсора мышки и при его остановке на объекте соответственно. 

В столбце Popup отмечаются параметры, которые по умолчанию будут 

отображаться во всплывающих окнах Board Insight с информацией по объ-

ектам и обнаруженным нарушениям правил проектирования, находящимся 

под курсором. 

Примечание. Указанные окна запускаются из рабочего поля комбинаци-

ями клавиш Shift+X и Shift+V соответственно. 

В столбце Panel указываются параметры, которые по умолчанию будут 

отображаться в панели Board Insight. 

Примечание. Данная панель запускается из группы PCB в дополнитель-

ном меню и содержит всю информацию из всплывающих окон Board Insight. 

В группе столбцов Font задаются параметры шрифта для каждого пара-

метра (шрифт, размер, стиль и цвет). 

3. В нижней части подраздела приведены динамически изменяющиеся в 

соответствии с заданными настройками виды информационного поля в ре-

жимах Heads Up Preview и Hover Preview на фоне рабочего поля, заполнен-

ного цветными кругами (рис. Г.107). 

 Рис. Г.107 
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Кроме настроек из подраздела PCB Editor ⇒ Board Insight Modes также 

доступны следующие возможности управления информационным полем из 

группы команд View ⇒ Board Insight (рис. Г.108): 

 

– Toggle Heads Up Display – отображение информационного поля; 

– Toggle Heads Up Tracking – режим перемещения информационного 

поля за курсором мышки; 

– Resets Heads Up Delta Origin и Toggle Heads Up Delta Origin – соот-

ветственно обнуление и отображение параметра Last Click Delta (см. п. 2). 

Примечания: 

– список команд с рис. Г.108 также можно открыть клавишей F2; 

– в нижней части рис. Г.108 приведены команды для работы с лупой – 

прямоугольной областью с увеличенным изображением рабочего поля. Ее 

включение и отключение производится командой Toggle Insight Lens, а изме-

нение масштаба изображения в этой области – поворотом колесика мышки 

с зажатой клавишей Alt. Дополнительные настройки при работе с ней до-

ступны в подразделе PCB Editor ⇒ Board Insight Lens окна Preferences. 

Г.38. Слои 

Слой (layer) в Altium Designer – составная часть общего изображения, 

совпадающая с ним по размеру и содержащая информацию только опреде-

ленного функционального назначения (см. рис. 5.15 и 5.16). 

Просмотр существующих слоев и управление их отображением осу-

ществляется в окне View Configurations (клавиша L).  

Примечание. В редакторе посадочных мест данное окно также можно 

открыть командой Tools ⇒ Layers & Colors, а в редакторе ПП – командой 

Design ⇒ Board Layers & Colors. 

Рис. Г.108 
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Особенности работы со слоями в Altium Designer: 

1. Все слои разделены на шесть групп и представлены на вкладке Board 

Layers And Colors окна View Configurations (вид пяти групп показан на 

рис. 5.11, а и 12.3, б). 

Назначение слоев приведено в табл. Г.14. 

Таблица Г.14 

Слои в Altium Designer 

Группа Назначение 

Signal Layers 

Сигнальные слои.  

В этих слоях располагается информация о трассах, КП, переходных 

отверстиях и других элементах проводящего рисунка ПП (см. Б.1). 

Все, что на них изображено, в итоге останется на ПП в виде металли-

зации (например, трассы и переходные отверстия на рис. Б.1 и Б.2). 

По умолчанию в этой группе присутствует два слоя: 

– Top – проводящий рисунок на верхней стороне ПП; 

– Bottom – проводящий рисунок на нижней стороне ПП. 

Кроме того, также доступно еще 30 сигнальных слоев, которые ис-

пользуются как внутренние слои в МПП (их можно увидеть, отключив 

опцию Only show layers in layer stack). 

Переименовать, добавить и удалить данные слои можно только в окне 

Layer Stack Manager (команда Design ⇒ Layer Stack Manager в редак-

торе ПП и Tools ⇒ Layer Stack Manager в редакторе посадочных 

мест). Возможности по работе со стеком ПП описаны в п. 5 из 12.1 

Internal Planes 

Специальные слои для расположения сплошной металлизации. 

В основном они используются в качестве внутренних слоев в МПП для 

цепей питания и земли. 

Информация в этих слоях отображается инверсно, т. е. любой разме-

щенный объект означает отсутствие металлизации. 

Доступно 32 слоя (их можно увидеть, отключив опцию Only show 

planes in layer stack). 

Переименовать, добавить и удалить данные слои можно только при 

определении структуры ПП в окне Layer Stack Manager (см. группу 

Signal Layers) 

Mask Layers 

Группа из четырех слоев двух видов: 

1. Слои паяльной пасты.  

Используются для изготовления трафарета для последующего нанесе-

ния паяльной пасты: 

– Top Paste – на верхней стороне ПП; 

– Bottom Paste – на нижней стороне ПП. 

2. Слои защитной паяльной маски. 

Здесь размещаются области, которые будут открыты от защитной па-

яльной маски (вырезы в маске на рис. Б.15, в): 

– Top Solder – на верхней стороне ПП; 

– Bottom Solder – на нижней стороне ПП. 

Переименовать слои этой группы можно только при определении 

структуры ПП в окне Layer Stack Manager (см. группу Signal Layers) 
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Окончание таблицы Г.14 

Группа Назначение 

Silkscreen Layers 

Слои шелкографии (silk-screen – шелкография, трафаретная печать).  

Информация из них наносится краской поверх защитной паяльной 

маски (см. рис. 12.141 и Б.16, в) и используется в основном для пра-

вильной установки компонентов при монтаже и поиска их на ПП. 

В группе только два слоя: 

– Top Overlay – шелкография на верхней стороне ПП; 

– Bottom Overlay – шелкография на нижней стороне ПП. 

Переименовать данные слои можно только при определении структу-

ры ПП в окне Layer Stack Manager (см. группу Signal Layers) 

Other Layers 

Группа из четырех дополнительных слоев: 

– Drill Guide – автоматическое отображение центров отверстий; 

– Keep-Out Layer – области запрета расположения различных элемен-

тов проводящего рисунка ПП на всех слоях (см. п. 2.6 из Г.26); 

– Drill Drawing – автоматическое отображение условных обозначений 

отверстий и таблицы отверстий (см. п. 20 из 12.5); 

– Multi-Layer – автоматическое расположение элементов, относящих-

ся к нескольким слоям (переходные отверстия и КП с отверстиями). 

Mechanical 

Механические слои. 

Предназначены для размещения любой вспомогательной информации, 

которую пользователь определяет самостоятельно. В данном учебном 

пособии назначение использованных слоев приведено в табл. Г.15. 

Доступно 32 слоя (их можно увидеть, отключив опцию Only show en-

abled mechanical Layers). 

Для переименования слоя используется клавиша F2. 

Для каждого слоя доступны уникальные опции: 

– Enable – добавление или удаление слоя (если на ПП в слое есть при-

митивы из состава компонента, то он не может быть удален); 

– Single – включение отображения данного слоя даже при работе в ре-

жиме Single Layer Mode (см. п. 9); 

– Linked To – связь с листом проекта ПП (например, с рамкой). Такие 

слои скрываются при отключении опции Display Sheet в окне Board 

Options (команда Design ⇒ Board Options в редакторе ПП и команда 

Tools ⇒ Library Options в редакторе посадочных мест). 

Пары слоев задаются в редакторе ПП по п. 6 из 12.1 

Таблица Г.15 

Механические слои, используемые в учебном пособии 

Слой Измененное имя Назначение 

Mechanical 1 M1 Board Графика контура ПП для отправки в производство 

Mechanical 2 M2 Inner Line Контуры прорезей внутри ПП 

Mechanical 3 M3 Top Assy 
Контуры корпусов компонентов, расположенных на 

верхней стороне ПП (assy – сборка) 

Mechanical 4 M4 Bottom Assy 
Контуры корпусов компонентов, расположенных на 

нижней стороне ПП 
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Окончание таблицы Г.15 

Слой Измененное имя Назначение 

Mechanical 5 M5 Top 3D 
3D-модели корпусов компонентов, расположенных 

на верхней стороне ПП 

Mechanical 6 M6 Bottom 3D 
3D-модели корпусов компонентов, расположенных 

на нижней стороне ПП 

Mechanical 7 M7 Shield Контур «экрана» 

Каждому слою можно назначить цвет, щелкнув по соответствующей 

цветной ячейке рядом с ним, а также включить или отключить его отображе-

ние в рабочем поле (опция Show). 

Группа System Colors предназначена для корректировки цвета различ-

ных системных объектов и управления их отображением. 

Примечание. Цвета слоев и системных объектов также можно изме-

нить в окне Preferences (команда DXP ⇒ Preferences) в разделе PCB Editor ⇒ 

Layer Colors (см. табл. Г.4). 

2. На вкладке Transparency окна View Configurations осуществляется 

управление прозрачностью (ее можно изменить как для каждого типа объек-

тов, так и для всех типов объектов сразу как на отдельном слое, так и на всех 

слоях сразу). Фрагмент вкладки показан на рис. Г.109. 

 

3. На вкладке View Options окна View Configurations в группе Solder 

Masks опциями Show Top Positive и Show Bottom Positive можно изменить 

отображение слоев защитной паяльной маски в 2D-режиме просмотра с ин-

версного на обычное и задать уровень их общей прозрачности (Opacity) для 

верхней и нижней стороны ПП соответственно (рис. Г.110). 

 Рис. Г.110 

Рис. Г.109 
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4. Выбор текущего слоя осуществляется щелчком ЛКМ по соответству-

ющей вкладке с названием слоя внизу рабочего поля (см. рис. 5.7). 

Смена текущего слоя также возможна следующими способами: 

– для циклического переключения только между сигнальными слоями 

используется клавиша «*» на цифровой клавиатуре (Numpad). Для переклю-

чения в обратном направлении используется комбинация клавиш Shift+*; 

– для циклического переключения между всеми доступными в данный 

момент слоями используются клавиши Plus и Minus на цифровой клавиатуре 

или поворот колесика мышки при зажатых клавишах Ctrl и Shift. 

Примечание. Текущий слой – слой, с которым в данный момент осу-

ществляется работа. 

5. Для вкладок со слоями в нижней 

части рабочего поля из контекстного 

меню, вызываемого щелчком ПКМ по 

ним, можно выбрать один из трех спо-

собов отображения имен (рис. Г.111): 

Use Short Layer Names – короткие име-

на (из двух символов), Use Medium Layer Names – средние имена, Use Long 

Layer Names – длинные (полные) имена. 

 6. Порядок отрисовки графики со слоев в рабочем поле настраивается в 

окне Layer Drawing Order (рис. Г.112), которое открывается одноименной 

кнопкой из раздела PCB Editor ⇒ Dis-

play окна Preferences (команда DXP ⇒ 

Preferences). Например, по умолчанию 

информация со слоя Multi Layer распо-

лагается поверх данных со всех осталь-

ных слоев, в том числе и текущего в 

данный момент слоя (Current Layer). 

Кнопки Promote и Demote позво-

ляют изменить положение выбранного 

слоя, а кнопка Default – установить по-

рядок по умолчанию. 

Примечание. Настройки не влияют 

на режим Single Layer Mode (см. п. 9). 

7. Чтобы различные объекты и по-

садочные места компонентов правильно 

Рис. Г.111 

Рис. Г.112 
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переносились с верхней стороны ПП на нижнюю (и наоборот), устанавлива-

ются парные слои (см. 5.2.2 и п. 6 из 12.1). 

8. При работе в редакторах ПП и посадочных мест зачастую требуется 

наличие в рабочем поле информации только из некоторых слоев. 

Управлять видимостью слоев можно вручную на вкладке Board Layers 

And Colors окна View Configurations, однако удобнее это делать с помощью 

наборов слоев, работа с которыми осуществляется в окне Layer Sets Manag-

er (команда Manage Layer Sets ⇒ Board Layer Sets из меню Design в редак-

торе ПП и из меню Tools в редакторе посадочных мест): 

– в группе Layer Sets (рис. Г.113, а) приводится список всех доступных 

наборов слоев с указанием имени набора (столбец Name), текущего слоя в 

наборе (столбец Active Layer) и возможности просмотра набора с нижней 

стороны ПП (столбец View From Bottom Side). 

Примечание. Столбец View From Bottom Side по своему действию анало-

гичен команде View ⇒ Flip Board; 

 

– кнопка New Set – добавление набора; 

– кнопка Remove Set – удаление выбранного набора; 

– кнопка Switch To – переключение в выбранный набор; 

– наборы слоев с рис. Г.113, а присутствуют по умолчанию (их описание 

приведено в табл. Г.16). Они не могут быть удалены, но могут быть скрыты 

опцией Show / Hide Default Layer Sets; 

Рис. Г.113 

а 

б 
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Таблица Г.16 

Наборы слоев по умолчанию 

Набор слоев Слои в наборе 

&All Layers Все слои проекта 

&Signal Layers Multi-Layer и группа Signal Layers 

&Plane Layers Группа Internal Plane 

&NonSignal Layers Все слои, кроме групп Signal Layers, Internal Plane и Mechanical 

&Mechanical Layers Группа Mechanical 

– каждому набору слоев, кроме присутствующих по умолчанию, можно 

изменить имя, предварительно нажав в требуемой ячейке клавишу F2; 

– назначение символа «&» приведено в Г.4 (букву набора для его выбора 

можно нажать после последовательного нажатия клавиш D ⇒ T); 

– для изменения текущего слоя на любой из содержащихся в этом набо-

ре необходимо нажать клавишу F2 в соответствующей ячейке; 

– в группе Layers (рис. Г.113, б) приводится список со всеми слоями 

проекта с указанием их имен (столбец Name), типа (столбец Type) и инфор-

мации о вхождении в выбранный набор слоев (столбец Include In Set); 

– кнопки Export Layer Sets To File и Import Layer Sets From File поз-

воляют экспортировать и импортировать информацию о наборах слоев соот-

ветственно. 

Описание наборов слоев, загружаемых по профилю в п. 8 из 12.1 и ис-

пользуемых в учебном пособии, приведено в табл. Г.17. 

Таблица Г.17 

Наборы слоев, используемые в учебном пособии 

Набор слоев Текущий слой Слои в наборе 

All Top Layer Все слое проекта, кроме Bottom Overlay 

Shield M7 Shield Top Layer, M3 Top Assy, M7 Shield 

Bottom Bottom Layer Bottom Layer 

TopSolder Top Solder Top Solder 

TopOverlay Top Overlay Top Layer, Top Solder, Top Overlay 

Выбор требуемого в данный момент набора слоев осуществляется из 

списка Design ⇒ Manage Layer Sets, однако зачастую это удобнее делать с 

помощью пиктограммы LS внизу рабочего поля (см. рис. 5.7). 

9. Комбинацией клавиш Shift+S можно войти в режим работы только с 

текущим в данный момент слоем (Single Layer Mode). Предусмотрено три ва-

рианта отображения информации из других слоев, которые задаются в груп-
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пе Available Single Layer Modes (рис. Г.114) из раздела PCB Editor ⇒ Board 

Insight Display окна Preferences (команда DXP ⇒ Preferences): 

– Hide Other Layers – информация из других 

слоев оказывается скрыта; 

– Gray Scale Other Layers – информация из дру-

гих слоев отображается в оттенках серого цвета, кото-

рые зависят от их исходных цветов; 

– Monochrome Other Layers – информация из других слоев отобража-

ется одинаковым серым цветом. 

Примечания: 

– выбрать любой из описанных вариантов режима Single Layer Mode 

(или отключить его) также можно в группе Single Layer Mode на вкладке 

View Options окна View Configurations (рис. Г.115); 

 

– если на рис. Г.114 включить несколько опций, то при нажатии комби-

нации клавиш Shift+S они будут циклически переключаться (на рис. Г.116 по-

казаны виды посадочного места при текущем слое Top Layer); 

 Рис. Г.116 

Hide Other Layers 

Gray Scale Other Layers Monochrome Other Layers 

Not In Single Layer Mode 

Рис. Г.115 

Рис. Г.114 
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– в режиме Single Layer Mode также будут отображаться механиче-

ские слои, в свойствах которых включена опция Single (см. табл. Г.14). 

10. Все команды по управлению слоями доступны из контекстного ме-

ню, вызываемого щелчком ПКМ по вкладкам со слоями внизу рабочего поля. 

Г.39. Контур ПП 

Контур ПП можно создать одним из следующих способов: 

1. С использованием специально предназначенного для этого режима 

работы с формой ПП, в который можно перейти с помощью клавиши 1 или 

команды View ⇒ Board Planning Mode. 

Особенности способа: 

1.1. Используемые команды по редактированию 

границ ПП расположены в меню Design (рис. Г.117): 

– Redefine Board Shape – режим рисования контура 

ПП с нуля (см. пп. 2.1 и 2.2 из Г.26); 

– Edit Board Shape – редактирование уже суще-

ствующего контура ПП (см. пп. 2.7.1–2.7.5 из Г.26); 

– Modify Board Shape – изменение формы ПП пу-

тем рисования кривой в рабочем поле. Кривая может 

быть нарисована как внутри существующего контура 

ПП (нарисованная область будет вырезана из контура), 

так и вне его (нарисованная область будет добавлена к контуру), но она обя-

зательно должна начинаться и заканчиваться на этом контуре; 

– Move Board Shape и Move Board – соответственно перемещение в ра-

бочем поле только ПП и ПП вместе со всеми объектами, размещенными на 

ней. Поворот по часовой стрелке (или против нее) и переворот вдоль осей X 

и Y не дают положительного результата; 

– Define Split Line и Delete Split Line – добавление и удаление границы 

между разными стеками ПП соответственно; 

– Define Bending Line – добавление линии, по которой будет осуществ-

ляться сгиб гибкой части ПП (стек с опцией Flex). 

1.2. Для автоматического получения контура ПП на механическом слое 

M1 Board в конце этапа трассировки, когда форма и размеры ПП меняться 

больше не будут, в 2D-режиме просмотра запускается команда Design ⇒ 

Board Shape ⇒ Create Primitives From Board Shape и в открывшемся окне 

производится настройка (рис. Г.118): 

Рис. Г.117 
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– поле Width – ширина линии кон-

тура; 

– список Layer – слой, на котором 

будет создан контур; 

– Include Cutouts – кроме внешне-

го контура ПП будут созданы контуры 

внутренних прорезей ПП (см. Г.40); 

– Include layer stack regions – включение информации о стеках ПП; 

– Route Tool Outline – если данная опция отключена, то центры линий и 

дуг в создаваемом контуре ПП будут проходить по границам ПП, иначе – ли-

нии и дуги будут касаться границ ПП с внешней их стороны; 

– Delete Existing Non-Net Lines/Arcs On Layer – удаление всех суще-

ствующих на выбранном слое линий и дуг, которые не подключены к цепям. 

Примечания: 

– данный способ удобен, если форма и точные габариты ПП заранее 

неизвестны и будут редактироваться в процессе проектирования; 

– пример работы в этом режиме приведен в п. 5 из 12.3. 

2. С помощью создания замкнутого контура ПП в механическом слое 

M1 Board вручную из графических примитивов (линий и дуг) или путем 

экспорта его из чертежной САПР в формате DXF или DWG. 

После этого все объекты контура выделяются и запускается команда De-

sign ⇒ Board Shape ⇒ Define from selected objects. 

Примечание. Данный способ удобен, если контур ПП либо заранее опре-

делен, либо используется заготовка ПП с фиксированными формами и габа-

ритами, которые не будут корректироваться в процессе проектирования. 

3. С помощью 3D-модели ПП в формате STEP, полученной из MCAD. В 

этом способе выполняются следующие действия: 

– создается отдельный механический слой, в котором будет храниться 

проекция 3D-модели ПП (например, M10 PCB Projection); 

– в папке с проектом ПП создается папка Models, в которую помещается 

файл 3D-модели ПП в одном из форматов: STEP («.step» или «.stp»), Parasolid 

(«.x_t» или «.x_b») или Solidworks Part («.sldprt»). 

Примечание. Можно не создавать отдельную папку в проекте, а хра-

нить 3D-модель ПП в указанном формате в любой другой директории, но 

тогда придется указать к ней путь; 

– запускается команда добавления 3D-модели (Place ⇒ 3D Body); 

Рис. Г.118 
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– в открывшемся окне 3D Body в группе 3D Model Type выбирается оп-

ция Generic 3D Model, в группе Properties указывается слой, на котором бу-

дет храниться проекция ПП, а в группе Generic 3D Model включается опция 

File и нажимается кнопка Select. 

Примечание. Если выбрана опция File, то 3D-модель ПП подключается 

к проекту в виде ссылки, в результате чего при обновлении файла 3D-модели 

автоматически будет обновлен и создаваемый контур ПП. Если выбрана 

опция Embedded, то 3D-модель ПП будет встроена в проект без возможно-

сти автоматического обновления; 

– в открывшемся окне Choose Model выбирается файл 3D-модели ПП из 

папки Models и нажимается кнопка OK. 

Примечание. Если 3D-модель ПП хранится в отдельной директории, то 

к ней необходимо указать путь кнопкой Add Directories, расположенной в 

нижней части окна; 

– окно 3D Body закрывается кнопкой OK (настройки окна перед закры-

тием показаны на рис. Г.119), после чего 3D-модель ПП размещается в рабо-

чем поле и появившееся вновь окно 3D Body закрывается кнопкой Cancel; 

 Рис. Г.119 
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– клавишей 3 осуществляется переход в 3D-режим просмотра ПП; 

– запускается команда Design ⇒ Board Shape ⇒ Define from 3D body; 

– щелчком ЛКМ последовательно указывается 3D-модель ПП и ее по-

верхность для создания проекции контура; 

– в появившемся окне Board Outline Creation Successful оставляются оп-

ции по умолчанию (рис. Г.120) и нажимается кнопка Close; 

 

– клавишей 2 осуществляется переход в 2D-режим просмотра ПП; 

– при необходимости скрывается механический слой с проекцией ПП; 

– после окончания этапа трассировки ПП по п. 1.2 создается контур ПП. 

Примечание. При обновлении файла 3D-модели ПП потребуется перей-

ти в 3D-режим просмотра ПП и заново указать поверхность 3D-модели для 

создания проекции контура. 

Г.40. Внутренние вырезы в ПП 

Внутренний вырез в ПП можно создать одним из следующих способов: 

1. Сначала вручную из графических примитивов (линий и дуг) рисуется 

замкнутый контур на требуемом механическом слое (например, на M2 Inner 

Line), после чего все объекты контура выделяются и запускается команда 

Tools ⇒ Convert ⇒ Create Board Cutout from Selected Primitives. 

Примечания: 

– данный способ удобен, если контур прорези ПП заранее определен и не 

будет корректироваться в процессе проектирования; 

– располагать ли контур прорези в отдельном механическом слое (M2 

Inner Line) или прямо в слое с контуром ПП (M1 Board) зависит от конкрет-

ного производителя ПП. 

2. С помощью полигона Solid Region с назначением Board cutout (см. 

п. 2.3 из Г.26), нарисованного в любом слое. 

Рис. Г.120 
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После окончания этапа трассировки ПП в требуемом механическом слое 

по п. 1.2 из Г.39 создаются контуры прорези. 

Примечание. Комментарий к выбору слоя расположения контуров про-

рези см. в примечании к п. 1. 

Г.41. Разделение линий и трасс 

Для разделения прямолинейного сегмента линии или трассы в редакторе 

ПП и посадочных мест на две части служит команда Edit ⇒ Slice Tracks или 

последовательное нажатие клавиш E ⇒ K. 

После запуска команды необходимо провести линию в месте располо-

жения будущего разреза. В окне свойств (рис. Г.121), открываемом во время 

проведения линии разреза клавишей Tab, доступны следующие опции: 

 

– Blade Width – ширина разреза; 

– Snap Blade Width To Grid – ширина разреза округляется до значения 

текущего шага сетки; 

– Cut Current Layer Only – разрез только на текущем слое; 

– Blade Side – положение разреза относительно линии разреза: Left – 

только слева, Right – только справа, Both – с двух сторон (при этом с каждой 

стороны будет ширина, равная половине значения из поля Blade Width). 

В рабочем поле удобными являются следующие клавиши: 

– B – включение и отключение опции Cut Current Layer Only; 

– N – циклическое переключение опций группы Blade Size; 

– Space – переключение между произвольным углом проведения линии 

разреза и углом, кратным 45°. 

Рис. Г.121 
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Г.42. Интерактивная трассировка одиночных цепей 

Интерактивная трассировка одиночных цепей запускается командой 

Route ⇒ Interactive Routing или ПКМ ⇒ Interactive Routing. Процесс такой 

трассировки напоминает рисование обычных линий, но при этом обладает 

гораздо большими возможностями. 

Трасса – это такая же полилиния с прямолинейными и скругленными 

сегментами (см. Г.24), но подключенная к выбранной цепи. Ее создание 

начинается с объекта, подключенного к какой-нибудь цепи (например, от КП 

или от сегмента другой трассы). 

Примечание. Рисовать можно и с произвольного места рабочего поля, 

но в этом случае после создания полилинии придется вручную подключить 

все ее сегменты к требуемой цепи. 

Настройки и особенности выполнения интерактивной трассировки: 

1. Размещенные сегменты трассы отображаются закрашенными с цветом 

того слоя, на котором они находятся, а сегменты, которые будут размещены 

при щелчке ЛКМ, – штриховкой (рис. Г.122). 

 

Примечание. Исключением являются неразмещенные скругления в соот-

ветствующих режимах создания угла между исходной точкой и курсором 

мышки (они также отображаются закрашенными). 

2. После начала ведения трассы клавишей Tab можно открыть окно 

настроек со следующими возможностями: 

2.1. В группе Routing Conflict Reso-

lution (рис. Г.123) задаются режимы по 

разрешению конфликтов, когда при веде-

нии трассы на ее пути встречаются какие-

нибудь препятствия: 

– Ignore Obstacles – игнорирование 

препятствий (трассу можно провести как 

угодно с любыми нарушениями, тем не 

менее нарушения будут подсвечиваться в 

режиме реального времени); 

Рис. Г.122 

Рис. Г.123 
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– Push Obstacles – расталкивание препятствий (трассы и переходные от-

верстия с включенной опцией Allow Via Pushing из п. 2.2 будут автоматиче-

ски изменять свое положение для создания текущей трассы); 

– Walkaround Obstacles – обход препятствий (создаваемая трасса будет 

автоматически корректироваться, чтобы найти обходной путь вокруг препят-

ствий до курсора мышки); 

– Stop At First Obstacle – остановка на первом препятствии (при первом 

встреченном препятствии дальнейший автоматический поиск пути до курсо-

ра мышки будет прекращен); 

– Hug And Push Obstacles – обход и расталкивание препятствий (трасса 

проходит как можно ближе к существующим препятствиям и расталкивает 

другие трассы и переходные отверстия с включенной опцией Allow Via Push-

ing из п. 2.2 в том случае, если становится недостаточно места); 

– AutoRoute On Current Layer – автоматический выбор между растал-

киванием и обходом препятствий на текущем слое для достижения наимень-

шей длины трассы; 

– AutoRoute On Multiple Layers – автоматический выбор между рас-

талкиванием препятствий, их обходом и изменением слоя для достижения 

наименьшей длины трассы; 

– Current Mode – действующая в данный момент опция по разрешению 

конфликтов. 

Примечания. Опции, у которых стоят галочки, можно циклически пере-

ключать комбинацией клавиш Shift+R в режиме интерактивной трассиров-

ки без открытия окна настроек. 

2.2. В группе Interactive Routing Options 

(рис. Г.124) можно задать следующие настройки: 

– Restrict To 90/45 – уменьшение количества 

режимов создания угла между двумя точками до 

двух (только под углами 45° и 90°); 

– Follow Mouse Trail – при наличии препят-

ствий трасса будет проходить по пути перемеще-

ния курсора мышки, даже если от начальной точ-

ки до конечного положения курсора есть более 

короткий альтернативный путь; 

– Automatically Terminate Routing – автоматический выход из режима 

создания текущей трассы, если сделан щелчок ЛКМ по объекту, подключен-

Рис. Г.124 
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ному к ее цепи (то есть не нужно завершать создание каждой трассы щелч-

ками ПКМ или клавишей Esc). 

Примечание. После завершения создания одной трассы можно сразу же 

рисовать следующую, т. е. выхода из режима интерактивной трассировки 

не происходит; 

– Automatically Remove Loops – автоматическое удаление старого пути, 

если между двумя произвольными точками трассы провести новый путь. 

Примечание. Опция назначается сразу для всех цепей, однако ее можно 

изменить для каждой цепи отдельно в окне свойств (опция Remove Loops); 

– Remove Net Antennas – автоматическое удаление ни к чему не под-

ключенных ответвлений трассы. 

Примечание. Опция доступна при включенной 

опции Automatically Remove Loops; 

– Allow Via Pushing – расталкивание пере-

ходных отверстий в режимах Push Obstacles и Hug 

And Push Obstacles из п. 2.1; 

– Display Clearance Boundaries – включение 

отображения области (рис. Г.125), которая не до-

ступна для создания трассы, в соответствии с рас-

положенными объектами и правилами проектиро-

вания из подраздела Electrical ⇒ Clearance; 

– Reduce Clearance Display Area – область, которая не доступна для со-

здания трассы, показывается не во всем файле трассировки, а только около 

курсора мышки, что уменьшает нагрузку на компьютер. 

Примечание. Опция доступна при включенной опции Display Clearance 

Boundaries. 

2.3. В группе Routing Gloss Effort (рис. Г.126) задается степень сглажи-

вания (количество изгибов и получающаяся длина) трассы 

при обходе препятствий: 

– Off – сглаживание отсутствует; 

– Weak – слабое сглаживание; 

– Strong – максимальное сглаживание. 

2.4. В группе Interactive Routing Width Sources (рис. Г.127) задаются 

опции, связанные с шириной трасс и размерами переходных отверстий: 

– Pickup Track Width From Existing Routes – при использовании опции 

User Choice для параметра Track Width Mode позволяет продолжить трасси-

Рис. Г.125 

Рис. Г.126 
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ровку с шириной текущего сегмента (ес-

ли трасса отводится от участка сегмента) 

или с шириной, которая использовалась в 

данной цепи последней (если трасса от-

водится от объекта цепи, к которому еще 

не подведены трассы); 

– Track Width Mode и Via Size Mode – первоначальная ширина трассы 

и размер переходного отверстия соответственно: User Choice – значение 

пользователя, Rule Minimum, Rule Preffered и Rule Maximum – соответ-

ственно минимальное, предпочтительное и максимальное значение, заданное 

в правилах проектирования. 

Примечание. На рис. Г.127 параметр Via Size Mode неактивен, так как в 

п. 10 из 12.1 для правила проектирования RVS вместо размеров были заданы 

шаблоны переходных отверстий из библиотеки. 

2.5. В группе Favorites кнопкой Fa-

vorite Interactive Routing Widths можно 

скорректировать набор предпочтительных 

значений ширин трасс (рис. Г.128). 

Примечание. Набор предпочтительных значений был задан в подгруппе 

Interactive Routing (см. табл. Г.4). 

2.6. В группе Properties (рис. Г.129) задаются следующие настройки: 

 

– текущая ширина сегмента трассы (может быть выбрана из списка 

предпочтительных значений или задана произвольно) на всех слоях (опция 

Apply to all layers) или отдельно для каждого (список Layer). 

Примечание. Чтобы задать разную пользовательскую ширину трассы 

на разных слоях, необходимо отключить опцию Apply to all layers и после пе-

рехода трассы на нужный слой в рабочем поле изменить значение ширины 

Рис. Г.129 

Рис. Г.127 

Рис. Г.128 
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на требуемое. При возврате на этот слой автоматически будет установ-

лено заданное ранее значение. Настройки запоминаются для каждой цепи; 

– пользовательские размеры текущего переходного отверстия, использу-

емого при трассировке (Via Hole Size – диаметр отверстия, Via Diameter – 

диаметр площадки), если в правилах проектирования для текущей цепи не 

были выбраны шаблоны переходных отверстий; 

– шаблон текущего переходного отверстия (список Template), использу-

емого при трассировке, если в правилах проектирования для текущей цепи 

были выбраны шаблоны переходных отверстий. 

2.7. В группе Routing Width Constraints (рис. Г.130) приводится описа-

ние правила проектирования для ширины текущей цепи (название правила и 

крайние значения), которое можно изменить кнопкой Edit Width Rule. 

 

2.8. В группе Via Style Constraints (рис. Г.130) приводится описание 

правила проектирования для размеров текущего переходного отверстия цепи 

(название правила, размеры или шаблоны), которое можно изменить кнопкой 

Edit Via Rule. 

2.9. Группа Pin Swapping содержит настройки по эквивалентной замене 

выводов компонентов (см. Г.45): разрешение замены и предпочтительная 

длина сегмента трассы, создаваемая при замене (объект subnet jumper). 

3. В контекстном меню, вызываемом нажатием комбинации клавиш 

Shift+F1 или клавиши «~» в процессе создания трассы, перечислены следу-

ющие часто используемые команды (рис. Г.131): 

– Edit Trace Properties – открытие окна настроек из п. 2; 

– Suspend – выход из режима создания текущей трассы с сохранением 

результатов ее создания. 

Примечание. Кроме клавиши Esc также используется щелчок ПКМ; 

– Commit – размещение сегментов трассы до курсора мышки. 

Примечания: 

– кроме клавиши Enter также используется щелчок ЛКМ; 

– исключением является режим Look Ahead Mode; 

Рис. Г.130 
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– Undo Commit – отмена последней размещенной вершины; 

– Autocomplete Segments To Target – автоматическое создание трассы 

до конечной точки цепи, при этом начальная и конечная точки должны быть 

расположены на одном слое; 

– Look Ahead Mode – режим рисования с пред-

сказанием. Режим аналогичен описанному в п. 5.4 из 

Г.24 и показан на рис. Г.132; 

– Cycle Corner Style – циклическое переключе-

ние пяти режимов создания угла между двумя точка-

ми (см. рис. Г.56), при этом на количество режимов влияет опция Restrict To 

90/45 из п. 2.2; 

– Toggle Elbow Side – выбор одного из двух путей прохождения от ис-

ходной точки до курсора мышки (см. рис. Г.56); 

– Toggle Routing Mode – циклическое переключение между включен-

ными режимами по разрешению конфликтов из п. 2.1; 

– Toggle Follow Mouse Trail Mode – включение или отключение опции 

Follow Mouse Trail из п. 2.2; 

– Toggle Loop Removal – включение или отключение опции Automati-

cally Remove Loops из п. 2.2; 

Рис. Г.131 

Рис. Г.132 
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– Show Clearance Boundaries – включение или отключение опции Au-

tomatically Remove Loops из п. 2.2; 

– Choose Favorite Width – выбор 

значения ширины сегмента из списка 

предпочтительных значений в появля-

ющемся окне Choose Width (см. п. 2.5 и 

рис. Г.133); 

– Choose Favorite Via Size – выбор 

шаблона переходного отверстия в по-

являющемся окне Choose Via Size для 

использования по умолчанию в процессе создания трассы из подходящих под 

правило проектирования, заданного для данной цепи, и существующих в 

файле трассировки (к существующим в файле трассировки шаблонам также 

относятся и те, которые создавались в процессе работы, но были удалены, 

однако в списке они будут присутствовать только до закрытия файла). 

Примечания: 

– так как в п. 10 из 12.1 для правила проектирования RVS были заданы 

два шаблона переходных отверстий из библиотеки, то и в окне Choose Via 

Size будут доступны только они (рис. Г.134); 

– окно Choose Via Size предназначено только для выбора шаблона пере-

ходного отверстия, а не для редактирования его параметров; 

 

– Cycle Track-Width Source и Cycle Via-Size Source – соответственно 

циклическое переключение ширины размещаемого сегмента трассы и разме-

ра переходного отверстия между четырьмя значениями из п. 2.4 (User Choice, 

Rule Minimum, Rule Preffered и Rule Maximum). 

Примечание. Так как в п. 10 из 12.1 для правила проектирования RVS 

были заданы два шаблона переходных отверстий из библиотеки, то пере-

ключение будет осуществляться только между ними; 

– Next Layer и Previous Layer – соответственно переключение на сле-

дующий и предыдущий сигнальный слой с появлением у курсора мышки пе-

реходного отверстия с размером по умолчанию (рис. Г.135). 

Рис. Г.134 

Рис. Г.133 
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Примечания: 

– сегменты трассы и само переходное отверстие после использования 

команды не размещаются и могут корректироваться (рис. Г.135); 

– при возврате на исходный сигнальный слой до размещения сегментов 

трассы переходное отверстие автоматически исчезает; 

– если было произведено размещение сегментов трассы и переходного 

отверстия, то следующие сегменты будут создаваться на выбранном сиг-

нальном слое (рис. Г.135); 

– если используется режим Look Ahead Mode, то переходное отверстие 

появляется на конце предпоследнего размещаемого сегмента трассы; 

– Switch Layer For Current Trace – если неразмещенные сегменты 

трассы отводятся непосредственно от переходного отверстия или КП с от-

верстием, то эта команда позволяет циклически изменять текущий сигналь-

ный слой без добавления переходного отверстия (рис. Г.136); 

 

– Add Fanout Via and Suspend – по аналогии с командами Next Layer и 

Previous Layer появится переходное отверстие, но после размещения сегмен-

тов трассы и переходного отверстия произойдет выход из режима создания 

текущей трассы с сохранением результатов ее создания (команда Suspend). 

Примечание. Fanout в общем случае – короткая трасса, отходящая от 

КП и заканчивающаяся переходным отверстием (часто используется в 

МПП с корпусами типа BGA). Расстановка таких отводов может быть 

произведена автоматически командами из меню Route ⇒ Fanout в соответ-

ствии с правилами проектирования из подраздела Routing ⇒ Fanout Control; 

– Add Via (No Layer Change) – по аналогии с командами Next Layer и 

Previous Layer появится переходное отверстие, но после размещения сегмен-

тов трассы и переходного отверстия следующие сегменты будут создаваться 

Рис. Г.136 

Рис. Г.135 
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на текущем сигнальном слое (то есть происходит добавление переходного 

отверстия без изменения сигнального слоя); 

– Change routing Via Start/End layers – в МПП при наличии неразме-

щенного переходного отверстия производится циклическое переключение 

между заданными от текущего сигнального слоя парами слоев для переход-

ных отверстий. 

Примечание. Пары слоев настраиваются кнопками Drill Pair в свой-

ствах переходных отверстий или в окне Layer Stack Manager; 

– Next Routing Target – если от данного объекта отводится несколько 

линии соединений, то данная команда осуществляет циклическое переклю-

чение между ними для выбора той, по которой в данный момент будет осу-

ществляться создание трассы;  

– Swap To Opposite Route Point – продолжение создания трассы с дру-

гого конца данной линии соединения.  

Примечания: 

– неразмещенные сегменты трассы будут отменены; 

– если конечная точка находится за переделами видимости, то рабочее 

поле подстроиться таким образом, чтобы курсор мышки оказался в центре; 

– Decrease Arc Setback (Shift x10) и Increase Arc Setback (Shift x10) – 

соответственно уменьшение и увеличение радиуса в режимах создания угла 

со скруглением с шагом 0,0254 мм (если при этом будет зажата клавиша 

Shift, то шаг увеличивается в 10 раз и станет равным 0,254 мм); 

– Add Accordions – переход в режим подстройки длины трассы путем 

автоматического добавления сегментов в виде меандра с прямыми, скошен-

ными или скругленными углами (рис. Г.137). 

Примечания: 

– команда считается устаревшей, так как 

меандр после его создания представляет собой 

отдельные сегменты, которые неудобно редак-

тировать; 

– в этом режиме можно менять параметры меандра в окне настроек 

(клавиша Tab) и различными командами из контекстного меню, вызываемого 

нажатием комбинации клавиш Shift+F1 или клавиши «~»; 

– если в окне настроек указать значение параметра Target Length (целе-

вая длина) и включить опцию Clip to target length, то при достижении этого 

значения меандр будет автоматически менять свои параметры для его со-

Рис. Г.137 
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хранения. Данная возможность работает только до размещения меандра в 

рабочем поле; 

– подстраивать длину рекомендуется после завершения интерактивной 

трассировки командой Route ⇒ Interactive Length Tuning. В этом случае ме-

андр представляет собой единый объект (группу), контур которого можно 

редактировать подобно границам полигона Solid Region (см. пп. 2.7.1–2.7.5 

из Г.26). Кроме того, описанная ранее возможность с опцией Clip to target 

length будет работать и после размещения меандра при изменении его кон-

тура. При необходимости меандр можно разрушить командой Tools ⇒ Con-

vert ⇒ Explode Length Tuning To Free Primitives; 

– Toggle Length Gauge – отображение индикатора длины. 

Примечания: 

– если правило проектирования для длины данной цепи не задано, то в 

индикаторе отображается только текущая длина трассы с размещенными 

и неразмещенными сегментами (рис. Г.138); 

 

 Рис. Г.139 

Рис. Г.138 
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– если правило проектирования для длины данной цепи задано, то жел-

тыми линиями отображаются границы длины из правила, цифрой – теку-

щая длина трассы с размещенными и неразмещенными сегментами, полос-

ка – предполагаемая длина, равная сумме текущей длины трассы с разме-

щенными и неразмещенными сегментами и длины оставшейся связывающей 

линии до цели (см. рис. Г.139). Зеленая полоска – длина удовлетворяет прави-

лу, красная полоска – длина больше максимального значения из правила; 

– если в окне настроек режима подстройки длины трассы значение па-

раметра Target Length задать между границами из правила проектирования, 

то он будет показан в индикаторе длины зеленой линией; 

– Cycle Glossing Effort – циклическое переключение между степенями 

сглаживания трассы из п. 2.3; 

– Enable Subnet Swapping – проверка возможности осуществления эк-

вивалентной замены при создании текущей трассы. С включенным окном 

Messages при отсутствии такой возможности будет выдано соответствующее 

предупреждение; 

– Swap Target Subnet – режим выбора доступных трасс других цепей, 

отходящих от КП посадочного места с разрешенной эквивалентной заменой 

выводов, к которым можно подключить данную трассу (см. Г.45). При этом 

объекты subnet jumpers не образуются. 

4. После создания трассы можно настроить свойства каждого выделен-

ного сегмента через окно его свойств, которое полностью совпадает с опи-

санным для линии (см. рис. Г.57). 

5. Возможности ручного редактирования трассы схожи с редактирова-

нием обычных линий: 

– при щелчке ЛКМ по отдельному сегменту трассы он будет подсвечен, 

а также на нем появятся несколько характерных точек (см. рис. Г.58); 

– выделенные сегменты можно удалять клавишей Delete и на их месте 

рисовать новые, при этом в месте удаленного сегмента образуется соединя-

ющая линия соответствующей цепи; 

– в режиме Drag (см. Г.29 и рис. Г.59) при перемещении общей вершины 

двух прямолинейных сегментов создается новый сегмент под углом 45° (см. 

рис. Г.61);  

– перемещение зажатой ЛКМ за центральную характерную точку пря-

молинейного сегмента приводит к созданию соединенного с ним параллель-

ного участка (см. рис. Г.60). 
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Примечание. Если такой участок переместить обратно, чтобы он ока-

зался на одной оси с первоначальным сегментом, то лишние вершины авто-

матически будут удалены. Для точного совмещения может потребоваться 

изменение привязок (см. Г.36); 

– с включенной опцией Automatically Remove Loops можно заменять 

угол соединения двух соседних сегментов скруглением (рис. Г.140); 

 

– отдельные вершины трассы не удаляются; 

– при перемещении зажатой ЛКМ любой характерной точки скруглен-

ного сегмента (или любого его участка) будет изменяться его радиус с авто-

матической корректировкой длин соединенных с ним прямолинейных сег-

ментов; 

– при уменьшении радиуса одного из двух соединенных скругленных 

сегментов между ними будет создан прямолинейный сегмент; 

– внутренние прямолинейные сегменты можно перемещать параллельно 

самим себе зажатой ЛКМ. 

Примечание. Как и для линий влияние оказывают опции Preserve Angle 

When Dragging, Selected via/track и Unselected via/track (см. рис. Г.59); 

– при перемещении сегментов трассы сочетанием клавиш Shift+R мож-

но выбрать один из трех режимов разрешения конфликтов: Ignore Obstacles, 

Push Obstacles и Hug and Push Obstacles (см. п. 2.1). 

Примечание. При необходимости изменить набор режимов можно в 

окне настроек (клавиша Tab); 

– для разделения прямолинейных сегментов трасс служит команда 

Edit ⇒ Slice Tracks (см. Г.41). 

6. Отсутствующие сегменты трасс на всей ПП можно создать автомати-

чески командой Route ⇒ Add Subnet Jumpers. 

После ее запуска в открывшемся окне Subnet Connector в поле Maximum 

Subnet Separation указывается максимальная длина соединяющих линий, 

которые будут заменены объектами Subnet Jumpers. 

Рис. Г.140 
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Примечания: 

– объекты Subnet Jumpers имеют ширину ближайшего слева сегмента 

трассы и обозначаются штриховкой (рис. Г.141); 

– удалить все объекты Subnet Jumpers позволяет команда Route ⇒ Re-

move Subnet Jumpers. 

 

7. Кроме ручного удаления размещенных сегментов трасс в меню 

Route ⇒ Un-Route доступны следующие команды (рис. Г.142): 

– All – удаление трасс, переходных отверстий и сво-

бодных КП всех цепей на ПП; 

– Net – удаление всех трасс, переходных отверстий и 

свободных КП указанной цепи. 

Примечание. Если ЛКМ указать свободное от цепей 

место рабочего поля, то в появившемся окне можно ввести 

требуемое имя цепи; 

– Connection – удаление трасс, переходных отверстий и свободных КП 

указанной цепи между ближайшими КП компонентов; 

– Component – удаление трасс, переходных отверстий и свободных КП 

всех цепей, расположенных между КП указанного компонента и КП бли-

жайших компонентов. 

Примечание. Если ЛКМ указать свободное от компонентов место ра-

бочего поля, то в появившемся окне можно ввести требуемое позиционное 

обозначение; 

– Room – удаление трасс, переходных отверстий и свободных КП внут-

ри указанной комнаты. 

Примечания. 

– если ЛКМ указать свободное от комнаты место рабочего поля, то в 

появившемся окне можно выбрать требуемую комнату; 

– в появляющемся после указания или выбора комнаты окне можно 

уточнить будут ли удалены все трассы, переходные отверстия и свободные 

КП только полностью расположенные внутри комнаты (кнопка No) или еще 

и выходящие за пределы границ комнаты до ближайших КП компонентов 

(кнопка Yes). 

Рис. Г.141 

Рис. Г.142 
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8. Для подсветки всех объектов цепи существует три возможности: 

8.1. Подсветка в реальном времени, осуществляемая при подведении 

курсора мышки к любому объекту цепи с зажатой клавишей Shift. 

Примечание. Настройки такой подсветки находятся в подразделе PCB 

Editor ⇒ Board Insight Display окна Preferences (команда DXP ⇒ Preferences).  

Например, отключение опции Live Highlighting only when Shift Key Down 

(рис. Г.143) приведет к подсветке цепей при наведении на них курсора мыш-

ки без зажатой клавиши Shift. 

 

8.2. Постоянная подсветка с затенением, осуществляемая при щелчке 

ЛКМ по любому объекту цепи с зажатой клавишей Ctrl. 

Примечания: 

– при дополнительно зажатой клавише Shift можно подсвечивать не-

сколько разных цепей; 

– для снятия такой подсветки необходимо нажать комбинацию клавиш 

Shift+C (очистка объектов в фильтре) или кнопку Clear в нижнем правом уг-

лу рабочего поля (см. рис. 5.9). 

8.3. Постоянная подсветка с затенением (опция Dim) или с маскирова-

нием (опция Mask) при выборе цепи в панели PCB (см. Г.14). 

Примечание. В режиме одного слоя оп-

ция Show All Primitives In Highlighted Nets из 

группы Highlighting Options (рис. Г.144) под-

раздела PCB Editor ⇒ Display окна Prefer-

ences (команда DXP ⇒ Preferences) позволя-

ет в пп. 8.2 и 8.3 подсветить и все объекты 

указанной цепи со скрытых слоев. 

9. Во время интерактивной трассировки на отображение объектов в ра-

бочем поле влияют две опции, расположенные в группе Highlighting Options 

Рис. Г.143 

Рис. Г.144 
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(см. рис. Г.144) из подраздела PCB Editor ⇒ Display окна Preferences (ко-

манда DXP ⇒ Preferences): 

– Apply Mask During Interactive Editing – затенение объектов, не отно-

сящихся к текущей цепи; 

– Apply Highlight During Interactive Editing – подсветка объектов те-

кущий цепи. 

10. Для автоматического сглаживания предварительно выделенных сег-

ментов одной или нескольких трасс используется команда Route ⇒ Gloss Se-

lected (пример сглаживания показан на рис. Г.145). 

 

Примечания: 

– для сглаживания участка трассы можно выделить только его 

начальный и конечный сегменты; 

– при автоматическом сглаживании программа стремится максималь-

но уменьшить длину трассы и количество ее изломов, при этом параметры 

сегментов не изменяются; 

– расположение переходных отверстий (при наличии) не изменяется; 

– сегменты трассы, расположенные под произвольным углом, остают-

ся нетронутыми. 

11. Для автоматической корректировки выполненной трассировки пред-

варительно выделенных сегментов одной или нескольких трасс используется 

команда Route ⇒ Retrace Selected. 

Примечание. Основные отличия команды от автоматического сглажи-

вания из п. 10 состоят в следующем: 

– для выделенных участков трасс происходит обновление их парамет-

ров до предпочтительных (Preffered), указанных в правилах проектирования; 

– изменение первоначального вида трассы в общем случае происходит 

не так сильно.  

Например, на рис. Г.145 видно, что ширина трассы была увеличена. 

Рис. Г.145 

Gloss 

Retrace 
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12. Полезные настройки по отображению связывающих линий и инфор-

мации на объектах находятся на вкладке View Options окна View Configura-

tions (клавиша L): 

– список Net Names on Tracks Display позволяет настроить отображе-

ние имен цепей на трассах: Do Not Display – без отображения, Single and 

Centered – один раз в центре каждого сегмента, Repeated – с некоторым ша-

гом на каждом сегменте; 

– опции Show Pad Nets и Show Via Net отвечают за отображение имен 

цепей на КП и переходных отверстий соответственно; 

– опция Show Pad Numbers управляет отображением номеров КП; 

– опция Show All Connections In Single Layer Mode при отключении 

позволяет отобразить в режиме одного слоя только те связывающие линии, 

которые целиком находятся на этом слое; 

 

– опция Use Layer Colors For Connection Drawing позволяет отобразить 

связывающую линию для соседних объектов, расположенных на разных сиг-

нальных слоях, в виде пунктирной линии с цветами этих слоев (рис. Г.146). 

Г.43. Интерактивная трассировка группы цепей 

Интерактивную трассировку сразу нескольких цепей, идущих в одном 

направлении удобно осуществлять совместно командой Route ⇒ Interactive 

Multi-Routing или ПКМ ⇒ Interactive Multi-Routing. 

Особенности выполнения интерактивной трассировки: 

1. Сначала необходимо выделить требуемые КП или уже существующие 

сегменты трасс, при этом эти объекты обязательно должны находиться на 

одном слое. После этого запускается указанная команда и для начала трасси-

ровки выполняется щелчок ЛКМ недалеко от объектов. 

Примечание. Для массового выделения нескольких КП из состава поса-

дочных мест используются команды массового выделения мышкой с зажа-

той клавишей Ctrl (см. Г.5). 

2. В целом процесс создания группы трасс аналогичен интерактивной 

трассировке одиночных цепей. Некоторое описанные в Г.42 команды отсут-

ствуют, но есть и дополнительные возможности: 

Рис. Г.146 
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2.1. В окне свойств (клавиша Tab после начала трас-

сировки) в группе Bus Routing доступны следующие 

настройки (рис. Г.147): 

– в поле Spacing указывается зазор между соседними 

трассами в группе; 

– кнопкой From Rule в поле Spacing вставляется значение зазора, задан-

ного в правилах проектирования. 

Примечание. По умолчанию зазор между соседними проводниками со-

ответствует расстоянию между КП или трассами, от которых начинает-

ся трассировка. 

2.2. В контекстном меню, появляющемся при нажатии комбинации кла-

виш Shift+F1 или клавиши «~» в процессе трассировки, доступны следую-

щие дополнительные настройки (рис. Г.148): 

 

– Cycle Via-Pattern – при наличии переходных отверстий осуществляет-

ся циклическое изменение способа их расположения (рис. Г.149); 

 

– Converge Bus Spacing To Rule – зазор между трассами становится 

равным заданному в правилах проектирования; 

– Decrease Bus Spacing и Increase Bus Spacing – уменьшение и увели-

чение зазора между трассами соответственно. 

3. Для каждой отдельной созданной трассы доступны все возможности, 

описанные в пп. 4–11 из Г.42. 

4. Действия с группой трасс при включенной опции Preserve Angle 

When Dragging в режиме Drag (см. рис. Г.59): 

– для продления сразу нескольких трасс сначала необходимо выделить 

крайние сегменты, а затем потянуть зажатой ЛКМ за любую из свободных 

Рис. Г.149 

Рис. Г.148 

Рис. Г.147 
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вершин. Кроме того, при перемещении курсора могут быть получены сег-

менты под углом 45° (рис. Г.150). 

 

Примечание. При продлении трасс будет произведено их автоматиче-

ское выравнивание, если они заканчивались не на одной линии; 

– при перемещении сегментов нескольких трасс комбинацией клавиш 

Shift+R можно циклически изменять режимы разрешения конфликтов, пока-

занные на рис. Г.59: Ignore Obstacles – игнорирование препятствий, Avoid 

Obstacles (Snap Grid) и Avoid Obstacles – остановка у препятствий на осно-

ве текущего шага сетки и без учета сетки соответственно. 

Примечание. Режимы также доступны в окне свойств, открываемом 

клавишей Tab при перемещении; 

– для одинакового изменения радиусов скруглений (при наличии сег-

ментов со скруглениями) сначала их необходимо выделить, а затем потянуть 

зажатой ЛКМ за любой их участок. 

Г.44. Каплевидности (Teardrops) 

Каплевидность (teardrop) – это плавное изменение ширины трассы в ме-

стах ее соединения с объектами больших размеров. 

Основные области использования: 

– в месте соединения трассы с переходным отверстием (или КП с отвер-

стием), выполненным с минимальным гарантийным пояском, при риске воз-

никновения дефекта, показанного на рис. Б.25; 

– в месте соединения трассы с большой КП или в месте вынужденного 

изменения ширины трассы (например, при подходе к узкой КП) для умень-

шения скачка волнового сопротивления и отражений; 

– в отдельных случаях в месте соединения узкой трассы с КП для луч-

шего отвода тепла при пайке. 

Каплевидности в Altium Designer создаются автоматически в виде поли-

гонов Solid Region, но делать это рекомендуется в самом конце этапа трасси-

ровки ПП. Управление их настройками осуществляется в окне Teardrops 

Рис. Г.150 
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(рис. Г.151), которое открывается командой Tools ⇒ Teardrops или последо-

вательным нажатием клавиш T ⇒ E. 

 

Назначение элементов окна Teardrops: 

– группа Working Mode – режим работы (Add – добавление, Remove – 

удаление); 

– группа Objects – объекты, с которыми осуществляется работа (All – 

все объекты, Selected Only – только предварительно выделенные); 

– группа Scope – виды соединений трасс, с которыми осуществляется 

работа: Via/TH Pad – соединения с переходными и монтажными отверстия-

ми, SMD Pad – соединения с планарными КП, Tracks – соединения с други-

ми сегментами трассы, T-Junction – ответвления. Для каждого вида соедине-

ния можно настроить параметры каплевидности в процентах от указанного 

на рисунке размера; 

Рис. Г.151 
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– список Teardrop style – два стиля каплевидности: Curved – изогнутые 

границы (рекомендуемый стиль), Line – прямые границы; 

– опция Force teardrops – каплевидности создаются даже в тех случаях, 

когда это приводит к нарушению правил проектирования; 

– опция Adjust teardrop size – автоматическое уменьшение размеров 

каплевидности, если для их размещения не хватает места; 

– опция Generate report – создание отчета со списком мест, в которых 

получилось и не получилось добавить каплевидности.  

 

Пример создания каплевидности для случая подведения широкой трассы 

к узкой КП показан на рис. Г.152 (ее длина задана равной 50 % от ширины 

широкого сегмента трассы). 

Следует отметить, что при любых изменениях объектов, между которы-

ми была создана каплевидность, она автоматически удаляется. 

Г.45. Эквивалентная замена выводов 

Эквивалентная замена выводов (pin swapping) – изменение подключения 

цепей к выводам компонента с одинаковыми функциями для уменьшения ко-

личества пересечений трасс на ПП. Примерами эквивалентных выводов яв-

ляются выводы SMD-резисторов и некоторые выводы микроконтроллеров с 

функцией I/O (вход/выход). 

Примечание. В Altium Designer также можно настроить эквивалент-

ную замену выводов для дифференциальных пар (Differential Pair Swapping) и 

секций в многосекционных УГО (Part Swapping). 

Особенности эквивалентной замены выводов: 

1. Данные об эквивалентных выводах находятся в окне Configure Swap-

ping Information In Components, которое открывается командами: 

– в редакторах УГО и схем – Tools ⇒ Configure Pin Swapping; 

– в редакторе ПП – Tools ⇒ Pin/Part Swapping ⇒ Configure. 

В редакторе УГО для библиотеки Discretes_Assemblies.SchLib из папки 

…ИДРЭС\AD library\sch указанное окно показано на рис. Г.153, а, а в ре-

дакторе ПП для варианта «П1» – на рис. Г.153, б. 

Рис. Г.152 



 

 889 

 

Примечание. На ошибки, появляющиеся в окне Messages при открытии 

данного окна в редакторе УГО, обращать внимание не следует. 

Назначение элементов окон с рис. Г.153: 

– группа Component Information – информация о компонентах; 

– группа Configure in Schematic – информация об эквивалентных выво-

дах и секциях УГО. Здесь до дробной черты указывается количество выводов 

(или секций), для которых настроена эквивалентность, а после нее – общее 

количество выводов (или секций); 

– группа Enable in PCB – опции по разрешению эквивалентной замены 

для тех компонентов, у которых она задана (для разрешения необходимо по-

ставить галочку); 

– опция Only Show Components with Swap Information – отображение 

только компонентов с информацией об эквивалентности; 

– кнопка Configure Component – открытие окна Configure Pin Swap-

ping For для настройки информации об эквивалентности для выбранного в 

таблице компонента.  

Окно Configure Pin Swapping For для резистора R2 со схемы Э3 «уси-

лителя» из варианта «П1» показано на рис. Г.154. 

Рис. Г.153 

а 

б 
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На вкладке Pin Swapping, предназначенной для настройки эквивалент-

ности выводов, находятся следующие элементы: 

– группа Pin Status – информация о пинах компонента; 

– столбец Pin Group в группе Swap Data – редактируемый столбец, в 

котором для эквивалентных пинов указываются одинаковые данные (под-

держиваются цифры и буквы); 

– окно просмотра посадочного места, поддерживающее выбор КП. 

Примечания: 

– выполнить настройку эквивалентности выводов можно в редакторах 

схем, УГО и ПП для любого компонента в любой момент времени. Преиму-

щество выполнения таких действий в редакторе УГО состоит в том, что 

добавляемые в проект ПП компоненты будут уже настроены; 

– открыть окно Configure Pin Swapping For также можно в окне Con-

figure Swapping Information In Components двойным щелчком ЛКМ по строке 

с компонентом или в рабочем поле на выделенном компоненте командой 

ПКМ ⇒ Part Actions ⇒ Configure Pin Swapping в редакторе схем и командой 

ПКМ ⇒ Component Actions ⇒ Configure Pin/Part Swapping в редакторе ПП. 

2. Для возможности эквивалентной замены выводов у конкретного ком-

понента кроме наличия данных в столбце Pin Group окна Configure Pin 

Swapping For также должна быть поставлена галочка в столбце Pin Swap 

окна Configure Swapping Information In Components (см. п. 1). 

3. Эквивалентная замена выводов производится в редакторе ПП (с со-

храненными изменениями в файле трассировки и проекте) и только для КП, 

которые полностью не соединены трассами с КП ближайших компонентов.  

Примечание. Способ разделения трасс см. в Г.41. 

Способы эквивалентной замены выводов в редакторе ПП: 

3.1. Интерактивная замена командой Tools ⇒ Pin/Part Swapping ⇒ In-

teractive Pin/Net Swapping. 

Рис. Г.154 
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После запуска команды в рабочем поле автоматически подсветятся КП с 

возможностью эквивалентной замены. Например, на рис. Г.155, а – КП № 6 и 

10 в микросхеме DA1, все КП в разъеме XP1 и в конденсаторах C1 и C2.  

Далее последовательными щелчками ЛКМ указываются КП, которые 

должны быть заменены (замена происходит в каждой паре). Например, на 

рис. Г.155, б были заменены подключения к КП № 1 и 5 в разъеме XP1. 

 

3.2. Автоматическая замена командой Tools ⇒ Pin/Part Swapping ⇒ Au-

tomatic Net/Pin Optimizer. 

Это двухэтапная команда. Первый этап осуществляется сразу же после 

ее запуска, при этом выполняется однопроходная оптимизация по минимиза-

ции длин связывающих линий и их пересечений. Однако результат может 

получиться не очень хорошим. После этого появляется окно с запросом на 

запуск второго этапа – многопроходной оптимизации. Ее можно запустить 

кнопкой Yes или отказаться кнопкой No. В последнем случае будет оставлен 

результат первого этапа. 

Пример выполнения данной команды показан на рис. Г.155, в. Видно, 

что была выполнена эквивалентная замена всех КП в разъеме XP1, а также 

КП № 6 и 10 в микросхеме DA1. 

3.3. Интерактивная замена в процессе интерактивной трассировки оди-

ночных цепей. 

В этом способе необходимо, чтобы предварительно от заменяемых КП 

были отведены сегменты трасс (рис. Г.156), что в большинстве случаев удоб-

но сделать интерактивной трассировкой группы цепей (см. Г.43). 

Рис. Г.155 

а 

б 

в 
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Существует два варианта выполнения эквивалентной замены: 

– трасса щелчком ЛКМ непосредственно подключается к желаемому 

сегменту, отведенному от заменяемой КП другой цепи. При этом создается 

объект subnet jumper в виде заштрихованного сегмента, длина которого 

определяется в группе Pin Swapping окна настроек интерактивной трасси-

ровки одиночной цепи (см. п. 2.9 из Г.42), а также происходит обновление 

подключения связывающей линии, которая была заменена (рис. Г.157). 

Примечание. Вариант не работает в режиме Ignore Obstacles; 

 

– в процессе создания трассы нажимается комбинация клавиш Shift+T 

(команда Swap Target Subnet с рис. Г.131) для включения режима выбора 

доступных трасс других цепей и осуществляется требуемый выбор щелчком 

ЛКМ, после чего продолжается процесс интерактивной трассировки. При 

этом происходит обновление подключения связывающей линии, которая бы-

ла заменена, но объект subnet jumper не создается (рис. Г.158). 

 

Примечания:  

– на рис. Г.155–Г.158 приведена ПП из примера, рассмотренного в Г.46; 

Рис. Г.157 

Рис. Г.158 

Shift+T 

Рис. Г.156 
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– зачастую требуется согласование эквивалентной замены выводов на 

разъемах с другими устройствами, с которыми предстоит соединение; 

– приведенные способы эквивалентной замены выводов можно исполь-

зовать в любой момент работы с проектом и неограниченное количество 

раз как по отдельности, так и в различных комбинациях. 

4. Информация об эквивалентной замене 

выводов с ПП в схему переносится методами, 

задаваемыми в группе Allow Pin-Swapping Us-

ing These Methods (рис. Г.159) на вкладке Op-

tions из окна настроек проекта (команда Project ⇒ Project Options): 

4.1. Changing Schematic Pins – изменение информации в пинах УГО 

компонента (поля Name и Designator). 

Примечание. Опция Adding / Removing Net-Labels может быть как вклю-

чена, так и отключена. 

Недостатком метода является внесение изменений в УГО компонента, 

что может затруднить чтение схемы при наличии многосекционных компо-

нентов (пин из одной секции может оказаться в другой секции) или при 

наличии нескольких компонентов на схеме (расположение пинов у одинако-

вых компонентов будет разным). Кроме того, обновление УГО из библиотеки 

повлечет за собой запуск повторного переноса изменений. 

Работа метода при переносе результатов эквивалентной замены выводов 

разъема XP1 с рис. Г.155, а и в, показана на рис. Г.160, а. 

 

Необходимо отметить, что эквивалентная замена выводов компонентов 

на ПП возможна только при включении данной опции. 

4.2. Adding / Removing Net-Labels – замена меток цепи. 

Условия работы метода: 

– соединение с пинами УГО компонента, у которого производилась эк-

вивалентная замена выводов, должно осуществляться линиями электриче-

ской связи, выполненными с разрывом; 

Рис. Г.160 

а б 

Рис. Г.159 
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– на линиях электрической связи должны быть установлены идентифи-

каторы цепи Net label; 

– в группе Allow Pin-Swapping Using These Methods (см. рис. Г.159) 

должна быть включена только опция Adding / Removing Net-Labels (или от-

ключены обе опции).  

Достоинством метода является неизменность УГО компонента, который 

может быть обновлен из библиотеки без повторного переноса изменений. 

Для соблюдения требования п. 2.7 из 8.1 при использовании меток цепей 

также потребуется установка стрелок, которые можно либо рисовать из при-

митивов в рабочем поле (линий или одной линией со значком стрелки разме-

ра Small), либо предварительно сделать библиотечный компонент с типом 

Graphical (см. Г.33). 

Работа метода при переносе результатов эквивалентной замены выводов 

разъема с рис. Г.163 показана на рис. Г.160, б. 

Примечание. В этом методе изменения с рис. Г.155, а и в не удалось бы 

полностью перенести в схему, так как для цепи GND использован иденти-

фикатор цепи Power Port. 

Г.46. Пример внесения изменений в схему и файл трассировки 

При разработке изделия довольно часто возникает необходимость вне-

сения изменений в проект: 

– при неправильно установленных компонентах; 

– при добавлении новых компонентов; 

– при корректировке содержания параметров компонентов; 

– при изменении подключений компонентов (изменение порядка под-

ключения к портам ввода-вывода микроконтроллера, к управляющим выво-

дам аттенюатора и др.). 

Примечание. В Altium Designer корректировки в компонентах и цепях, 

кроме эквивалентной замены выводов (см. Г.45), следует делать в схеме Э3, 

так как автоматически перенести их из файла трассировки невозможно. 

В качестве примера работы с внесением корректировок рассматривается 

участок разрабатываемого «усилителя» из вариантов задания в области мик-

росхемы аттенюатора, который выполнен в виде отдельного изделия со схе-

мой Э3, показанной на рис. Г.161.  

Примечание. На данном этапе на схеме не хватает высокоомного рези-

стора по питанию микросхемы аттенюатора. 
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Компоновка ПП выполнена в предположении, что компоненты, через 

которые проходит СВЧ-сигнал, должны быть расположены в нижней ее ча-

сти (рис. Г.162). 

 

Видно, что провести трассы в одном сигнальном слое не получится, так 

как есть взаимные пересечения связывающих линий между выводами микро-

Рис. Г.161 

Рис. Г.162 
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схемы аттенюатора: между выводами управ-

ления (№ 1–5) и между входом и выходом (№ 

6 и 10). 

Для корректировки пересечений в редак-

торе ПП были использованы возможности по 

эквивалентной замене выводов (см. Г.45): в 

разъеме XP1 поменяны местами подключения 

между КП в паре № 1 и 5 и в паре № 2 и 3, а в 

микросхеме аттенюатора DA1 – между КП № 6 и № 10 (рис. Г.163). 

Примечание. Следует внимательно относиться к эквивалентной замене 

выводов, проверяя такую возможность по документации на компоненты 

(рис. Г.164). Также зачастую следует согласовывать замену подключений на 

разъемах с другими устройствами, с которыми предстоит соединение. 

 

Для переноса изменений в схему выполняется следующее: 

– в настройках проекта включаются требуемые опции по п. 4 из Г.45. 

Примечание. В данном примере и в вариантах задания используется 

метод Changing Schematic Pins; 

– из редактора ПП запускается команда Design ⇒ Update Schematic; 

– в появившемся окне с информацией об обнаруженных различиях меж-

ду схемой и файлом трассировки нажимается кнопка Yes для продолжения 

автоматического формирования ECO-файла. 

Примечание. При нажатии кнопки No откроется окно для интерактив-

ной работы со списком обнаруженных различий; 

– в открывшемся окне Engineering Change Order нажимается кнопка Val-

idate Changes для проверки возможности внесения изменений в схему. Если 

в столбце Check отображаются зеленые галочки, то последовательно нажи-

маются кнопки Execute Changes для применения изменений (рис. Г.165) и 

Close для выхода. 

Результаты автоматического внесения изменений в схему Э3 показаны 

на рис. Г.166 и отмечены синими контурами. Кроме отсутствия высокоомно-

го резистора по питанию микросхемы аттенюатора на данном этапе появи-

Рис. Г.164 

Рис. Г.163 
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лась еще одна проблема, связанная с тем, что по документации на микросхе-

му питание должно поступать на вывод № 6 (см. рис. Г.164). 

 

 

Как отмечалось ранее, добавление компонентов и переподключение це-

пей следует делать в редакторе схем для их автоматического переноса в файл 

трассировки. Результат после ручной корректировки и перенумерации (при-

своено позиционное обозначение резистору) показан на рис. Г.167. 

 Рис. Г.167 

Рис. Г.166 

Рис. Г.165 



 

 898 

Примечание. Корректировки желательно вносить так, чтобы не изме-

нились позиционные обозначения размещенных компонентов, иначе потребу-

ется делать правки в других документах (например, в перечне элементов). 

Для переноса изменений в файл трассировки выполняются действия, 

аналогичные описанным в п. 6 из 12.3, т. е. с помощью команды Design ⇒ 

Update PCB Document из редактора схем. Результат показан на рис. Г.168. 

 

Как видно, резистор добавился за пределами контура ПП.  

Примечание. Ошибка на рисунке связана с тем, что корпуса компонен-

тов в данный момент пересекаются. 

Результат трассировки для рассмотренного примера в 2D-режиме про-

смотра показан на рис. Г.169, а в 3D-режиме просмотра – на рис. Г.170. 

 Рис. Г.169 

Рис. Г.168 



 

 899 

 

Примечание. Для получения металлизации под микросхемой DA1 сначала 

был удален полигон Solid Region с назначением Polygon cutout из ее посадоч-

ного места (в свойствах компонента была отключена опция Lock Primitives), 

а после автоматического перестроения полигона Polygon Pour на слое Top 

поверх КП № 7–9 добавлен полигон Fill с подключением к цепи GND. 

Г.47. Групповая заготовка ПП 

Объединение нескольких ПП в одну групповую заготовку (процесс ча-

сто называется панелизацией или мультиплицированием) увеличивает техно-

логичность производства. Например, снижаются временные затраты на нане-

сение паяльной пасты и отмывку. 

Также в групповую заготовку можно объединить несколько разных ПП 

(комплект ПП), обладающих одинаковыми конструктивными параметрами 

(количество слоев, толщина диэлектрического основания и т. д.). Заказ изго-

товления комплекта ПП у ряда производителей позволяет значительно сэко-

номить денежные средства, так как при этом затраты на подготовку к произ-

водству остаются на уровне одной отдельной ПП. 

У разных производителей требования к формированию групповой заго-

товки ПП и возможности могут различаться: 

– размеры комплекта ПП (например, не более 160 × 190 мм); 

– количество ПП в одном комплекте (например, не более 5); 

– размеры и наличие технологических полей – свободных от металлиза-

ции и компонентов областей ПП, необходимых для крепления групповой за-

готовки и осуществления автоматического монтажа; 

Рис. Г.170 
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– наличие возможностей по облегчению отделения ПП от групповой за-

готовки (скрайбирование или фрезерование несквозных канавок с узкими пе-

ремычками и перфорацией); 

– повышающий коэффициент к стоимости при условии недопустимости 

наличия бракованных ПП в групповой заготовке (No X-out) и др. 

Групповую заготовку на производстве обычно формируют из файлов в 

форматах Gerber и Excellon (см. прил. Л), однако при работе в Altium Design-

er ее также можно создать в редакторе ПП. Достоинством последнего спосо-

ба является автоматический перенос в заготовку всех изменений, сделанных 

в составляющих ее ПП. 

Последовательность действий для создания групповой заготовки (пане-

ли) из четырех ПП из варианта «П1» с фрезерованием несквозных канавок: 

1. Создать новый документ ПП, сохранить его в выбранную папку и вы-

полнить настройку по 12.1. 

Примечания: 

– документ можно создать как в существующем проекте, так и вне 

проекта (Free Document); 

– чтобы заново не задавать настройки, можно использовать шаблон 

или сделать копию существующего файла трассировки с новым именем; 

– при использовании копии файла в панели PCB Filter с включенной опци-

ей Select применяется запрос All, после чего клавишей Delete удаляются вы-

деленные объекты с подтверждением «Locked and Unlocked».  

2. Перейти в сетку 0,5 или 1 мм (в зависимости от кратности габаритных 

размеров ПП). 

3. Запустить команду Place ⇒ Embedded Board Array/Panelize и в от-

крывшемся окне Embedded Board Array выполнить следующее: 

– в поле PCB Document выбрать файл трассировки; 

– в полях Column Count и Row Count задать количество ПП в заготовке 

по горизонтали и вертикали соответственно; 

– если в поле Column Count или Row Count указано 2 и более, то в пра-

вом верхнем углу задать зазоры между ПП. 

После этого нажать кнопку OK, добавить ПП в рабочее поле и отказать-

ся от размещения других ПП. 

Примечания: 

– настройки окна Embedded Board Array в варианте «П1» при добавле-

нии четырех ПП показаны на рис. Г.171; 



 

 901 

 

– зазоры между ПП в варианте «П1» заданы равными 2 мм (типичный 

диаметр фрезы, используемый на производстве); 

– при включенной опции Link Location To Embedded Board Origin базовой 

точкой добавляемых объектов будет точка начала координат исходной ПП. 

С отключенной опцией базовая точка – нижний левый угол, от которого 

отведено поле Location на рис. Г.171; 

– если добавляется сразу несколько копий ПП (как на рис. Г.171), то в 

рабочем поле они будут считаться единым объектом; 

– ПП, добавляемые по одной штуке, можно размещать в рабочем поле 

независимо друг от друга; 

– в момент размещения объектов зачастую полезно запустить команду 

Edit ⇒ Jump ⇒ New Location (или последовательно нажать клавиши J ⇒ L), 

задать требуемые координаты и дважды нажать клавишу Enter; 

– после размещения ПП можно открыть окно Embedded Board Array 

(двойной щелчок ЛКМ по добавленным объектам или команда ПКМ ⇒ Prop-

erties), в котором при необходимости скорректировать зазоры между ПП 

(если за раз было создано несколько копий ПП), изменить координаты рас-

положения в поле Location и базовую точку. 

Рис. Г.171 
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3. Войти в режим работы с формой заготовки ПП (клавиша 1) и коман-

дой Design ⇒ Edit Board Shape изменить ее так, чтобы границы располага-

лись за пределами контуров добавленных ПП на расстоянии 7 мм (5 мм – 

технологическое поле, 2 мм – зазор между ПП и технологическим полем). 

Результат на данном этапе в варианте «П1» показан на рис. Г.172. 

 

4. Заблокировать добавленные ПП, для чего открыть окно их свойств и 

включить опцию Locked (см. рис. Г.171). 

5. Создать канавки для фрезерования: 

5.1. Сделать текущим слой M1 Board. 

Примечание. В этом слое также отображаются контуры добавленных 

ПП, но они никак не влияют на контуры групповой заготовки.  

5.2. В любом свободном месте рабочего поля обозначить две перемычки 

в виде пары скругленных краев и отверстий: 

– первую – с перфорацией только с одной стороны; 

– вторую – с перфорацией с двух сторон. 

Рекомендуемый вид перемычек приведен в стандарте IPC-7351 [145] и 

показан на рис. Г.173, где штриховкой отмечена область ПП, а заливкой – 

область технологического поля. 

Перфорация может располагаться как внутри ПП (она отнимает полез-

ное место, но после отделения ПП зачастую не требуется доработка ее кон-

тура), так и вне ПП (топология ПП не затрагивается, но после ее отделения 

необходимо убрать остатки перемычек).  

Рис. Г.172 
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В варианте «П1» (рис. Г.174) в 

сетке 0,1 мм нарисованы полуокруж-

ности радиусом 1 мм и добавлены от-

верстия так, чтобы они располагались 

на перемычках, но впритык к контуру 

ПП. Затем объекты каждой перемыч-

ки объединены в группы командой 

ПКМ ⇒ Unions ⇒ Create Union from 

selected objects. 

Примечания: 

– на рисунке добавлены неметал-

лизированные отверстия диаметром 

0,8 мм с настройками окна свойств КП, указанными в Г.19. Дополнительно в 

поле Designator для них записано значение PH (perforation hole); 

– радиус обусловлен выбранным ранее диаметром фрезы; 

– можно нарисовать одну полуокружность и добавить одно отвер-

стие, а все остальное получить копированием с указанием базовой точки, 

относительно которой оно производится; 

– для создания полуокружности оптимальной командой в данном случае 

является Place ⇒ Arc (Edge) или последовательное нажатие клавиш A ⇒ E. 

Порядок действий показан на рис. Г.175. 

 Рис. Г.175 

Рис. Г.173 [145] 

Рис. Г.174 
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5.3. Перейти в сетку 0,5 или 1 мм (в зависимости от кратности габарит-

ных размеров ПП). 

5.4. Последовательным нажатием клавиш P ⇒ L (создание линии) обри-

совать контуры ПП с шириной линии 0,4 мм. 

Примечания: 

– ширина выбрана равной 0,4 мм, чтобы отличить нарисованную линию 

от существующей на ПП; 

– контур ПП можно скопировать из файла трассировки, выбрав в нем 

текущим слой M1 Board и выполнив команду Edit ⇒ Select ⇒ All on Layer 

(особенно это актуально при сложном контуре). 

5.5. Расставить перемычки: 

– с двумя рядами перфорации – в зазорах между ПП; 

– с одним рядом перфорации – в зазорах между технологическими по-

лями и контурами ПП, при этом отверстия должны располагаться со стороны 

последних. 

При расстановке перемычек кроме размеров с рис. Г.173 зачастую дей-

ствует следующее правило в зависимости от длины стороны ПП: 

– до 50 мм – одна перемычка по центру; 

– от 50 до 100 мм – две перемычки на расстоянии порядка 50 мм друг от 

друга; 

– от 100 до 200 мм – одна перемычка в центре, и по одной на расстоянии 

порядка 20 мм от углов. 

Примечание. Перемычки можно расставить вокруг одной ПП, а затем 

копировать их в другие места, выбирая в качестве базовых точек углы ПП. 

5.6. Задать область срабатывания привязки к характерным точкам 1 мм 

(поле Range в п. 2 из Г.36). 

5.7. Командой разделения линий и трасс (см. 

Г.41) разорвать линии контуров ПП в местах распо-

ложения перемычек, после чего довести их вершины 

до соответствующих полуокружностей. 

Фрагмент перемычки в зазоре между ПП в ва-

рианте «П1» показан на рис. Г.176. 

5.8. Последовательным нажатием клавиш P ⇒ 

L (создание линии) с шириной линии 0,4 мм в ре-

жиме Line 90 со скруглением (см. рис. Г.56) соеди-

нить свободные вершины полуокружностей. 

Рис. Г.176 
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Если ПП имеет области с отклонением от прямоугольника, описанного 

вокруг нее, с размером по одной из оси более 20 мм, то части заготовки 

должны их закрывать (рис. Г.177). 

 

5.9. Задать область срабатывания привязки к характерным точкам 

0.25 мм (поле Range в п. 2 из Г.36) и отключить привязки. 

5.10. Отредактировать автоматически созданные в 

п. 5.8 скругления, сделав радиус равным 1 мм, для чего 

зажатой ЛКМ потянуть за их крайние характерные 

точки (рис. Г.178). 

После этого желательно проверить, что в заготов-

ке не осталось скруглений с другими радиусами. Для 

этого на любой дуге запустить команду ПКМ ⇒ Find 

Similar Objects (см. Г.6), в открывшемся окне напро-

тив поля Radius выбрать опцию Different и с включенной опцией Zoom 

Matching нажать кнопку Apply. 

5.11. Превратить контуры фрезерованных канавок в прорези, выполнив 

для каждого нарисованного контура следующие действия: 

– выделить любой элемент контура; 

– нажать клавишу Tab (в результате выделится весь контур);  

– последовательно нажать клавиши T ⇒ V ⇒ B или выполнить команду 

Tools ⇒ Convert ⇒ Create Board Cutout from Selected Primitives. 

6. Сделать одинаковыми ширины линий и дуг в слое M1 Board, а также 

добавить внешний контур групповой заготовки. 

Для этого запустить команду Design ⇒ Board Shape ⇒ Create Primitives 

From Board Shape, в появившемся окне задать настройки как на рис. Г.118 и 

применить изменения. 

7. Сохранить изменения (Ctrl+S). 

Рис. Г.177 

Рис. Г.178 
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Результат в варианте «П1» показан на рис. Г.179, а вариант для сравне-

ния – на рис. А.1. 

 

Примечания: 

– если защитная паяльная маска на КП отображается некорректно, 

то следует уменьшить ее толщину до 0,01 мм в стеке ПП (см. п. 5 из 12.1); 

– панель можно сохранить в форматах Gerber и Excellon (см. прил. Л), 

но с редактированием файла с расширением «.gm1»: файл открывается в 

Altium Designer, запускается команда Edit ⇒ Cut (комбинация клавиш 

Ctrl+X), в рабочем поле выделением справа налево последовательно выделя-

ются объекты, пересекающие все перемычки (зажимать клавишу Shift не 

нужно), и нажимается ПКМ. Затем изменения соханяются командой File ⇒ 

Export ⇒ Gerber: проверка настроек, OK, проверка пути сохранения, OK. 

После этого вкладка с файлом закрывается без сохранения измнений. 

Г.48. Обычный многолистовой проект 

При увеличении количества используемых в устройстве компонентов 

возникает задача размещения их на схеме Э3. Она может быть решена не-

сколькими способами: 

Рис. Г.179 
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– увеличением формата листа, что не совсем удобно, так как листы фор-

матов более А3 занимают много места на столе, да и не везде есть плоттер; 

– размещением компонентов на нескольких листах, т. е. использованием 

многолистового проекта (см. Г.27). 

Особенности обычного многолистового проекта: 

1. Каждый лист представляет собой отдельный схемный документ, кото-

рый добавляется к проекту по п. 2 из 8.2 и сохраняется по п. 3 из 8.2. 

На каждом листе схемы рекомендуется 

размещать компоненты, относящиеся к какой-

нибудь функциональной группе (или группам), 

в соответствии с чем и присваивать им наиме-

нования. Например, на рис. Г.180 показана 

структура проекта с двумя листами для услов-

ного варианта с обозначением «П2»: 

– Power.SchDoc – лист с компонентами, 

обеспечивающими формирование требуемых 

уровней напряжений; 

– MW-Path.SchDoc – лист с компонентами СВЧ-тракта. 

2. Подключение рамок и заполнение полей осуществляется отдельно для 

каждого листа (см. пп. 3 и 4 из 3.2.3). 

Примечания: 

– в папке …\ИДРЭС\AD рамки (см. рис. 2.9) для второго и последующих 

листов предназначены следующие рамки: для формата A4 – A4-2-ИДРЭС-

AD.SchDot, для формата А3 – A3-2-ИДРЭС-AD.SchDot; 

– для подключения одной рамки сразу к нескольким листам следует их 

открыть (при этом все остальные листы должны быть закрытыми), после 

чего при загрузке рамки в появляющемся окне Update Template выбрать оп-

цию All open schematic documents (ко всем открытым документам схем); 

– для заполнения граф 2, 7 и 8 в основных надписях листов рекомендует-

ся пользоваться информацией пп. 5 и 6 из 8.2. В окне Sheet Numbering (см. 

рис. 8.5) листы автоматически выстраиваются в порядке расположения их 

в структуре проекта, что можно поменять в панели Projects перетаскива-

нием файлов схем зажатой ЛКМ. 

3. Оформление разрывов линий электрической связи осуществляется в 

соответствии с пп. 2.6 и 2.7 из 8.1 и для многолистовой схемы из варианта 

«П2» показано на рис. Г.181. 

Рис. Г.180 
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 Рис. Г.181 Начало (окончание см. на с. 909) 
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 Рис. Г.181 Окончание (начало см. на с. 908) 
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Особенности схемы с приведенного рисунка: 

3.1. Для цепи GND используется идентификатор Power Port со стилем 

GOST Bar (см. п. 1.2 из Г.27) без обозначения перехода между листами. 

3.2. Для цепей питания с числовыми значениями напряжений (цепи +5В 

и +7,2В) использованы идентификаторы Power Port со стилем GOST Arrow.  

Так как данные цепи переходят с листа на лист, то для выполнения п. 2.6 

из 8.1 в верхней части каждого листа для каждой цепи добавлен небольшой 

отрезок линии электрической связи. Слева к нему подключен соответствую-

щий идентификатор Power Port, а справа – идентификатор Net Label (см. 

п. 1.1 из Г.27), рядом с которым вручную размещена текстовая надпись с ука-

занием в скобках номера листа с продолжением цепи. 

Примечания: 

– описанный способ позволяет сразу же увидеть все напряжения, при-

ходящие или уходящие с текущего листа; 

– для данной группы цепей можно использовать варианты оформления 

из п. 3.3, т. е. с использованием идентификаторов Net Label и стрелок (при 

необходимости) вместо идентификаторов Power Port. 

3.3. Для всех остальных цепей, выполненных с разрывами и не относя-

щихся к указанным в пп. 3.1 и 3.2, использованы идентификаторы Net Label 

со следующими вариантами оформления: 

3.3.1. Если цепь существует только на одном листе (цепь MW-3 на вто-

ром листе), то к местам разрывов добавляется стрелка (компонент Arrow из 

библиотеки Symbol). 

Примечание. Наличие подключенных стрелок препятствует использо-

ванию варианта эквивалентной замены выводов по п. 4.2 из Г.45. Если при 

создании схемы предполагается использование такой замены (например, при 

наличии микроконтроллера), то стрелки расставляются уже после разра-

ботки ПП. 

3.3.2. Если цепь переходит на другой лист, но при этом на данном листе 

в ней нет разрывов (цепь EN_STU на первом листе и цепи EN_STU и U_IN 

на втором листе), то после идентификатора вручную размещается текстовая 

надпись по аналогии с п. 3.2. 

Примечание. Цепь EN_STU используется для управления микросхемой 

стабилизатора DA1 через пятый коммутатор переключателя S1: при замы-

кании коммутатора на вход EN подается напряжение с цепи U_IN (проис-

ходит включение микросхемы), при размыкании коммутатора вход EN через 
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подтягивающий к земле резистор R1 подключается к нулю (происходит вы-

ключение микросхемы). При разомкнутом коммутаторе и без резистора R1 

вход EN будет в неопределенном состоянии, что может привести к само-

произвольному включению или отключению микросхемы. Номинал резистора 

выбирается таким, чтобы протекающий через него ток был мал (например, 

при напряжении в цепи U_IN, равном +7,5 В, ток составит 75 мкА). 

3.3.3. Если цепь переходит на другой лист, но при этом на данном листе 

в ней есть разрывы (цепь U_IN на первом листе), то у мест разрывов ставятся 

стрелки по п. 3.3.1, а переход на другой лист оформляется по аналогии с 

п. 3.2 (при этом вместо идентификатора Power Port используется стрелка). 

3.3.4. Группу цепей обычно одного функционального назначения (цепи 

V1–V4 на втором листе) в соответствии с п. 2.3 из 8.1 можно объединить в 

линию групповой связи. Так получается нагляднее, чем с использованием 

стрелок (рис. Г.182, а), в особенности если места подключения находятся в 

разных местах схемы. Сама же схема воспринимается легче, чем вообще без 

использования разрывов (рис. Г.182, б). 

 

Примечания: 

– линия групповой связи создается командой Place ⇒ Bus (последова-

тельное нажатие клавиш P ⇒ B) и в данном проекте используется только 

как графический объект; 

– линия групповой связи не препятствует использованию варианта эк-

вивалентной замены выводов по п. 4.2 из Г.45; 

– число разветвлений каждой линии электрической связи, при их нали-

чии в линии групповой связи, указывается текстовой надписью после соот-

ветствующего идентификатора Net Label (см. рис. 8.1); 

– если группа цепей переходит на другой лист, то их также можно 

объединить в линию групповой связи. Последняя обрывается за пределами 

Рис. Г.182 

а б 



 

 912 

изображения схемы без стрелки, а у этого места добавляется текстовая 

надпись с названием такой линии и указанием в скобках номера листа (или 

номеров листов через запятую) с ее продолжением. Например, BUS_CTL(1). 

3.4. Применение идентификаторов Net Label позволяет кроме получения 

возможности использования варианта эквивалентной замены выводов по 

п. 4.2 из Г.45 также лучше использовать панель Navigator (см. Г.13) для про-

смотра компонентов на текущем листе, связанных с выбранным. 

Например, в варианте «П1» на рис. 8.66 разъем XP2 связан с микросхе-

мой DA3 цепями V1 и V2, при этом разрывы оформлены идентификаторами 

Power Port. Если в панели Navigator с включенной опцией Connective Graph 

(см. п. 6 из Г.13) выбрать разъем XP2, то в рабочем поле соединяющих линий 

до других компонентов не появится (рис. Г.183, а). С включенной опцией In-

clude Power Parts соединяющие линии будут проведены ко всем компонен-

там, имеющим подключение к цепям GND, V1 и V2. Однако если оформить 

цепи управления по п. 3.3.1, то при выборе разъема XP2 с выключенной оп-

цией Include Power Parts будет проведена соединяющая линия к микросхеме 

DA3 (рис. Г.183, б). 

 

4. Перечень элементов для подобных схем является общим (см. п. 3.8 из 

8.1). Результат в варианте «П2» показан на рис. Г.184.  

5. Процесс добавления посадочных мест со связями на ПП со всех ли-

стов схемы Э3 осуществляется по п. 6 из 12.3 после открытия любого листа. 

Результаты трассировки ПП «усилителя» в варианте «П2» показаны на 

следующих рисунках: 

Рис. Г.183 

а б 
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 Рис. Г.184 Начало (окончание см. на с. 914) 
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 Рис. Г.184 Окончание (начало см. на с. 913) 
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 Рис. Г.186 

Рис. Г.185 
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– на рис. Г.185 и Г.186 – 2D-режимы просмотра с наборами слоев All и 

Shield соответственно (текущие слои – Top Layer и M7 Shield); 

– на рис. Г.187 – 3D-режим просмотра. 

Примечания: 

– области увеличения на рис. Г.185 получены после применения в панели 

PCB Filter запроса IsPad or IsVia в режиме Dim (см. п. 3 из Г.12); 

– рис. Г.186 получен после расположения объектов с механических слоев 

(Mechanical Layers) над объектами с сигнальных слоев (Signal Layers) в окне 

Layer Drawing Order (см. п. 6 из Г.38); 

– внутренний угол ПП оформлен по примечанию к п. 24 из 12.5; 

– обозначение ПП расположено в слое шелкографии; 

– справа от переключателя S1 в слое шелкографии добавлена справоч-

ная информация с назначением каждого коммутатора из его состава; 

– полоса пропускания ПФ – от 5,5 до 5,7 ГГц; 

– материал ПП – RF-35-0,254-18/18 фирмы Taconic (см. табл. Б.2). 

На рис. Г.188 показан внешний вид макета ПП для варианта «П2». Он 

был бесплатно изготовлен по акции в Китае на диэлектрике KB-6165F (см. 

табл. Б.3). Финишная толщина ПП составила 1 мм, финишная толщина меди 

(с учетом гальванической меди) – 35 мкм. Финишное покрытие – HASL. 

Примечание. Для СВЧ-структур (например, фильтры) материал FR-4 

не подходит, так как обладает большими потерями и заметным снижением 

Рис. Г.187 
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относительной диэлектрической проницаемости с ростом частоты, а ее 

значения разнятся в зависимости от производителя. Однако при использо-

вании устройства в узком диапазоне частот можно попробовать заранее 

произвести соответствующие измерения для листа материала, на котором 

впоследствии будет изготавливаться ПП. 

 

Данный макет ПП не подходит для работы (толщина и относительная 

диэлектрическая проницаемость не соответствуют расчетным значениям), 

однако он позволяет убедиться в универсальности форматов Gerber и Excel-

lon (см. разд. Л): при соблюдении требований с сайтов конкретных произво-

дителей ПП проблем с пониманием данных форматов не возникает даже в 

других странах. Это касается и надписи на русском языке (в формате Ger-

ber тексты представлены в виде линий и дуг). 

Под переключателем S1 в слое шелкографии можно заметить номер, 

которого не было в файле трассировки ПП. Если говорить о производстве в 

Китае, то он используется для идентификации заказов. Фирмы могут пред-

ложить отказаться от него за дополнительную плату или выбрать распо-

ложение самостоятельно (например, под корпусом компонента). Наши про-

изводители его не ставят, но и ПП получаются в разы дороже. 

Г.49. Обновление компонентов 

В процессе проектирования в уже разработанных библиотечных компо-

нентах могут произойти изменения (например, добавлены параметры или об-

новлены старые, исправлены функциональные назначения выводов в УГО, 

скорректирована информация в слоях посадочного места), для переноса ко-

Рис. Г.188 
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торых в ранее разработанные документы схем и печатных плат предусмотре-

ны следующие возможности: 

1. Обновление схемных документов: 

1.1. Применение изменений непосредственно из библиотеки УГО ко-

мандой ПКМ ⇒ Update Schematic Sheets, выполненной на интересующем 

компоненте в панели SCH Library. 

Пользоваться данным вариантом не рекомендуется, так как в этом слу-

чае происходит полное обновление компонента во всех открытых докумен-

тах схем. При этом в свойствах компонента ссылка на исходную библиотеку 

заменяется ссылкой на библиотеку, из которой производился запуск коман-

ды, что неприемлемо при работе с интегрированной библиотекой или биб-

лиотекой в виде базы данных. 

Примечание. Также для обновления открытого в редакторе компонен-

та можно воспользоваться командой Tools ⇒ Update Schematics. 

1.2. Применение изменений из документа схемы командой Tools ⇒ 

Update From Libraries со следующими возможностями настройки результа-

та обновления на двух страницах окна Update From Library (на рис. Г.189 

приведен вид окна для проекта из Г.48): 

1.2.1. В группе Schematic Sheet (рис. Г.189) отмечаются листы, на кото-

рых требуется обновить компоненты. 

В списке может быть как один лист (если команда запущена для свобод-

ного документа или листа схемы однолистового проекта), так и несколько 

листов (все листы многолистового проекта без необходимости их предвари-

тельного открытия в рабочем поле редактора). 

Примечание. В зависимости от количества выбранных листов меняет-

ся информация в группе Component Types (см. п. 1.2.5). 

1.2.2. Вариант Fully replace symbols on sheet with those from library из 

группы Settings (рис. Г.189) – полная замена компонентов компонентами из 

библиотеки со следующими настройками: 

– Update designator lock field и Update part ID lock field – обновление 

настроек блокировки (опции Locked в свойствах компонентов) параметров 

Designator и номера части составного УГО соответственно (в текущей версии 

программы при отключенных опциях все равно происходит обновление); 

– Preserve Parameter locations и Preserve Parameter Visibility – сохра-

нение заданных в схеме настроек размещения и видимости параметров соот-

ветственно. 
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1.2.3. Вариант Replace selected attributes of symbols on sheets из группы 

Settings (рис. Г.189) – детальная замена выбранных параметров компонентов 

на листах со следующими настройками: 

– Update graphical attributes – обновление графики; 

– Update parameters – обновление параметров; 

– Update models – обновление ссылок на посадочные места и другие 

модели. 

С двумя последними вариантами становится доступна кнопка Advanced, 

с помощью которой открывается окно Library Update Settings (рис. Г.190) с 

возможностью дополнительных настроек для обновления параметров, поса-

дочных мест и других моделей. 

Группа Parameter Settings: 

– Library parameters not in sheet (параметры, отсутствующие на листе, 

но присутствующие в библиотеке): Add (добавить), Do not add (не добавить), 

Add if not blank (добавить, если параметр не пустой); 

Рис. Г.189 
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– Sheet parameters not in library (параметры, присутствующие на листе, 

но отсутствующие в библиотеке): Remove (удалить), Do not remove (не уда-

лять), Remove if not blank (удалить, если параметр пустой); 

– Parameters to update – список параметров, которые можно включить 

для выполнения обновления (устанавливается галочка в столбце Update). 

Примечание. На второй странице окна Update From Library можно де-

тально настроить обновление каждого параметра в каждом компоненте 

выбранного типа. 

Группа Model Settings: 

– Add models found in library but not in sheet – добавить модели, при-

сутствующие в библиотеке, но отсутствующие на листе; 

– Remove models found in sheet but not in library – удалить модели, 

присутствующие на листе, но отсутствующие в библиотеке; 

– Update which models are the current models – обновить текущие мо-

дели у размещенных на схеме компонентов (то есть в УГО компонента будет 

Рис. Г.190 
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установлена связь с теми моделями, которые были установлены по умолча-

нию в библиотеке); 

– Models to update – список моделей, сгруппированных по типу, кото-

рые можно включить для выполнения обновления (устанавливается галочка в 

столбце Update). 

1.2.4. Опции из группы Settings (см. рис. Г.189): 

– Selected Parts Only – обновление только предварительно выделенных 

на схеме компонентов; 

– Include Variants – включить в обновление исполнения; 

– Show (показать): All Components (все компоненты), Database Compo-

nents (только компоненты из библиотек в виде базы данных), Standard Com-

ponents (только компоненты из интегрированных библиотек или библиотек с 

расширением «.SchLib»). 

Примечание. Указанные опции влияют на информацию из группы Com-

ponent Types (см. п. 1.2.5). 

1.2.5. В группе Component Types (см. рис. Г.189) приводится информа-

ция для типов компонентов в соответствии с настройками пп. 1.2.1 и 1.2.4: 

– Physical Component – название компонента; 

– Logical Symbol – название УГО; 

– Library – библиотека компонента; 

– Count – количество. 

Галочками в первом столбце отмечаются те типы компонентов, которые 

требуется обновить. 

1.2.6. Кнопки Next и Back позволяют переходить между страницами ок-

на Update From Library. 

Примечание. Настройки на первой странице окна Update From Library 

сохраняются в проекте, а на второй странице – не сохраняются. 

1.2.7. Кнопка Finish позволяет приступить к обновлению компонентов 

как с общими настройками с первой страницы окна Update From Library, так 

и с детальными настройками со второй страницы. 

1.2.8. На второй странице окна Update From Library (рис. Г.191) приво-

дится таблица со списком всех компонентов, включенных в процесс обнов-

ления, и следующими разделами: 

– Schematic Parts – информация о размещенных на схеме компонентах 

(параметры Designator и Comment, названия компонентов и их УГО). Галоч-

ками в столбце Update выбираются компоненты, требующие обновления; 
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– Library Components – информация о компонентах из библиотек, ко-

торые будут использоваться для обновления (названия компонентов, их УГО 

и библиотек); 

– Actions – действия для обновления компонентов по настройкам, за-

данным в пп. 1.2.2 и 1.2.3. При необходимости их можно изменить: Full Re-

place (полное обновление компонентов), Graphical (обновление графики), Pa-

rameters (обновление параметров), Models (обновление ссылок на посадочные 

места и другие модели). 

1.2.9. Кнопка Choose Component на рис. Г.191 позволяет для выбранно-

го компонента указать компонент из произвольной библиотеки, которым он 

будет заменен. 

1.2.10. Кнопка Return Selected to Default на рис. Г.191 позволяет для 

выбранного компонента сбросить настройки, сделанные в п. 1.2.9. 

1.2.11. Кнопка Parameters Changes на рис. Г.191 доступна при наличии 

хотя бы одного компонента с установленной галочкой в столбце Parameters 

из раздела Actions и предназначена для открытия окна Select Parameter 

Changes, в котором будут перечислены все такие компоненты со всеми пара-

метрами: как системными, так и пользовательскими (рис. Г.192). 

 

Варианты индикации ячеек с параметрами показаны на рис. Г.193. 

Рис. Г.192 

Рис. Г.191 
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Доступны следующие основные команды (как с помощью соответству-

ющих кнопок в нижней части окна, так и из контекстного меню, вызываемо-

го щелчком ПКМ): 

– Reject Selected и Reject All – отклонить обновление предварительно 

выбранного параметра или сразу всех параметров во всех компонентах соот-

ветственно; 

– Update Selected и Update All – включить обновление предварительно 

выбранного параметра или сразу всех параметров во всех компонентах соот-

ветственно. 

Примечание. Пример обновления только графики УГО в заготовках ре-

зисторов типоразмера 0805 на первом листе проекта из Г.48 с сохранением 

всех параметров, заданных в схеме: 

Параметр есть у компонента в схеме и библиотеке и имеет одинаковое 

значение. Никаких изменений не произойдет 

Параметр есть у компонента в схеме и библиотеке и имеет одинаковое 

пустое значение. Никаких изменений не произойдет 

Параметр отсутствует у компонента в схеме и библиотеке. Никаких из-

менений не произойдет 

Параметр есть у компонента в схеме и библиотеке, но значение различа-

ется. Значение параметра будет взято из библиотеки 

Параметр есть у компонента в схеме и библиотеке. В схеме ему присвое-

но какое-то значение, а в библиотеке – нет. В результате обновления зна-

чение параметра будет удалено 

Рис. Г.193 

Параметр есть у компонента в схеме и библиотеке, но значение различа-

ется. Никаких изменений не произойдет 

Параметр отсутствует у компонента в схеме, но есть в библиотеке (со 

значением). Будет добавлен параметр из библиотеки 

Параметр есть у компонента в схеме, но отсутствует в библиотеке. Дан-

ный параметр будет удален 

Параметр есть у компонента в схеме, но отсутствует в библиотеке. Ника-

ких изменений не произойдет 

Параметр отсутствует у компонента в схеме, но есть в библиотеке (без 

значения). Будет добавлен параметр из библиотеки 

Параметр отсутствует у компонента в схеме, но есть в библиотеке. Ника-

ких изменений не произойдет 
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– в библиотеке УГО в соответствии с ГОСТ 2.728–74 внутри УГО ре-

зистора добавляются две наклонные черточки, обозначающие номинальную 

рассеиваемую мощность 0,125 Вт (рис. Г.194); 

 

– в схеме запускается команда из п. 1.2; 

– выбирается только первый лист (см. п. 1.2.1); 

– выбирается вариант обновления по п. 1.2.3, при этом включенной 

оставляется только опция для обновления графики; 

– по п. 1.2.5 отмечается только тип компонента R0805; 

– нажимается кнопка Next для просмотра обновляемых компонентов на 

второй странице окна Update From Library (рис. Г.195); 

 

– нажимается кнопка Finish; 

– в окне Engineering Change Order последовательно нажимаются кноп-

ки Validate Changes, Execute Changes и Close. 

Результат показан на рис. Г.196 (исходный вариант данного участка 

схемы приведен на рис. Г.181). 

 Рис. Г.196 

Рис. Г.195 

Рис. Г.194 
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2. Обновление файлов трассировок: 

2.1. Применение изменений непосредственно из библиотеки посадочных 

мест следующими командами, выполненными в панели PCB Library: 

– ПКМ ⇒ Update PCB With [наименование посадочного места] – для 

обновления выбранного посадочного места; 

– ПКМ ⇒ Update PCB With All – для обновления всех посадочных мест 

из данной библиотеки. 

Рассматриваемый вариант обновления приводит к полному обновлению 

выбранных посадочных мест во всех открытых файлах трассировок. 

После запуска любой из указанных команд появляется окно Compo-

nent(s) Update Options со следующими опциями (рис. Г.197): 

– On Any Layer из группы Text – обновление 

текстовой информации в выбранных посадочных 

местах на всех слоях ПП; 

– On SilkScreen Layers, On Mechanical Layers, 

On Other Layers из группы Other – обновление ин-

формации (кроме текстовой) в выбранных посадоч-

ных местах соответственно со слоев шелкографии, 

механических слоев и других слоев, не относящихся 

к первым двум категориям; 

– Solder Mask Expansion и Paste Mask Expan-

sion из группы Pad(s) Attributes – обновление ин-

формации в выбранных посадочных местах для со-

ответствующих параметров из свойств КП и пере-

ходных отверстий (см. Г.17 и Г.21). 

Для работы опций из группы Pad(s) Attributes требуется включение оп-

ции On Other Layers из группы Other, при этом: если опции отключены, то 

обновление произойдет только в тех КП и переходных отверстиях, в свой-

ствах которых в файле трассировки была включена опция Expansion value 

from rule(s); если опции включены, то происходит полное обновление. 

Примечание. Также для обновления посадочных мест можно воспользо-

ваться соответствующими командами из меню Tools: Update PCB With Cur-

rent Footprint и Update PCB With All Footprints. 

2.2. Применение изменений из файла трассировки командой Tools ⇒ 

Update From PCB Libraries с возможностью детальной настройки результа-

та обновления в нескольких окнах: 

Рис. Г.197 



 

 926 

2.2.1. В окне Update From PCB Libraries - Options (рис. Г.198) путем 

установки галочек в столбце Include выбираются слои, которые будут срав-

ниваться с аналогичными слоями посадочных мест компонентов. 

 

По умолчанию включены все слои. Быстрое управление настройками 

доступно с помощью многофункциональной кнопки: 

– Include All и Include None – включить и отключить все слои соответ-

ственно; 

– Include Selected и Don't Include Selected – включить и отключить вы-

бранные в списке слои соответственно. 

Кнопка OK позволяет перейти к окну Update From PCB Libraries 

[наименование файла трассировки] (см. п. 2.2.2), а кнопка Update All Foot-

prints (Create ECO) – сразу к окну Engineering Change Order (см. п. 2.2.3). 

2.2.2. В окне Update From PCB Libraries [наименование файла трас-

сировки] отображаются результаты сравнения посадочных мест (вид окна 

для проекта из Г.48 приведен на рис. Г.199). 

Рис. Г.198 
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В таблице в верхней части окна приводятся следующие данные: 

– в группе PCB Components (компоненты на ПП) – индикация предва-

рительного выделения компонента на ПП (Selected), позиционное обозначе-

ние (Designator), название посадочного места (Footprint); 

– в группе Library Footprints To Compare Against (посадочные места 

из библиотеки для сравнения) – название посадочного места (Footprint), путь 

к библиотеке (Path); 

– в столбце Match – индикация соответствия: посадочные места иден-

тичны (зеленая галочка) или различаются (красный крестик); 

– в столбце Update – указание об обновлении посадочного места (по-

ставленная галочка). 

Быстрое управление опциями в столбце Update доступно с помощью 

многофункциональной кнопки: 

– Update All и Update None – включить и отключить обновление для 

всех посадочных мест с различиями соответственно; 

– Update Selected и Don't Update Selected – включить и отключить об-

новление для посадочных мест с различиями, предварительно выбранных в 

таблице, соответственно. 

Рис. Г.199 
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В заголовке таблицы указывается количество найденных посадочных 

мест с различиями. 

Примечание. На рис. Г.199 такое большое число связано в основном с 

удалением шелкографии из посадочных мест под «экраном». 

В нижней части окна можно детально ознакомиться со всеми найденны-

ми различиями в каждом посадочном месте либо сразу на всех слоях (вклад-

ка All layers), либо отдельно на каждом слое. В таблице отображается ин-

формация по каждому различающемуся объекту с указанием координат и 

слоя его расположения, а на рисунке показывается место расположения этих 

объектов, при этом: 

– ползунок Highlight Cell Density изменяет размеры ячеек сетки для 

подсветки объектов; 

– при выборе объекта в таблице изображение на рисунке масштабирует-

ся под этот объект; 

– объект из библиотеки отображается тусклым цветом, а объект в поса-

дочном месте на ПП – ярким цветом (например, на рис. Г.200 показано обна-

руженное различие из-за изменения длины линии в слое шелкографии); 

 

– перемещение изображения осуществляется зажатой ПКМ, а изменение 

масштаба – зажатой СКМ (кроме того, доступны некоторые команды из кон-

текстного меню, вызываемого щелчком ПКМ). 

Примечание. На рис. Г.199 в посадочном месте микросхемы усилителя 

отсутствует шелкография, так как она была расположена под «экраном», 

и полигон Polygon сutout, который был удален для возможности организации 

соединения с полигоном GND (см. рис. Г.185). 

Кнопка Accept Changes (Create ECO) позволяет перейти к окну Engi-

neering Change Order (см. п. 2.2.3). 

2.2.3. Окно Engineering Change Order служит для просмотра и приня-

тия изменений либо по всем компонентам из файла трассировки (если была 

Рис. Г.200 
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нажата соответствующая кнопка в окне из п. 2.2.1), либо только по заранее 

выбранным (если была нажата соответствующая кнопка в окне из п. 2.2.2). 

После нажатия кнопки Execute Changes появится окно Component(s) 

Update Options (см. п. 2.1) со следующими особенностями: 

– кнопка OK приводит к обновлению посадочных мест с учетом теку-

щих выбранных настроек; 

– кнопка Cancel приводит к обновлению посадочных мест с учетом 

настроек, которые были в этом окне в момент его открытия. 

Примечание. Пример восстановления случайно удаленной 3D-модели ре-

зистора R4 из проекта, рассмотренного в Г.48 (рис. Г.201): 

– запускается команда из п. 2.2; 

– в окне из п. 2.2.1 выбирается только 

слой M5 Top 3D и нажимается кнопка ОК; 

– в окне из п. 2.2.2 контролируется 

обнаружение различий в посадочном ме-

сте только у необходимого компонента 

(рис. Г.202); 

 

– нажимается кнопка Accept Changes (Create ECO); 

– в окне Engineering Change Order последовательно нажимаются кноп-

ки Validate Changes и Execute Changes; 

– в появившемся окне из п. 2.1 выбирается только опция On Mechanical 

Layers и нажимается кнопка OK; 

– в окне Engineering Change Order нажимается кнопка Close.  

Рис. Г.202 

Рис. Г.201 
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Г.50. Панель Storage Manager 

Панель Storage Manager позволяет управлять файлами активного проек-

та и работать с резервными копиями документов из папки History или из за-

данной общей папки (см. примечание к п. 3 из 2.7). 

Внешний вид панели для проекта из Г.48 показан на рис. Г.203. 

 

Особенности панели: 

1. Доступ к панели осуществляется из группы System в дополнительном 

меню (см. рис. 3.1). 

2. В разделе Folders отображается структура папок активного проекта, а 

его название указывается в заголовке раздела. 

В контекстном меню, вызываемом щелчком ПКМ, доступны следующие 

команды: 

– Refresh – обновить содержимое раздела; 

– Copy, Paste, Delete и Rename – копирование, вставка, удаление и пе-

реименование выбранной папки соответственно. 

Примечание. Запись самого проекта удалить и переименовать нельзя; 

– New – создание новой папки. 

3. В разделе Project Files приводятся все документы, которые находятся 

в выбранной папке из раздела Folders, со следующей информацией: имя фай-

ла с расширением (File), размер файла на диске в байтах (Size), тип файла 

(Kind), дата и время последнего сохранения (Date Modified), текущее состоя-

ние документа при работе с контролем версий (Status). 

Примечание. Контроль версий в данном пособии не рассматривается. 

Рис. Г.203 
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Включение опции Only Show Files in Current Project позволяет скрыть 

все документы в выбранной папке, которые не добавлены в активный проект. 

Основные виды индикации записей: 

– жирный текст – активный документ; 

– красный текст – документ с несохраненными изменениями; 

– серый текст – документ не добавлен в состав активного проекта.  

В контекстном меню, вызываемом щелчком ПКМ, доступны следующие 

команды: 

– Open – открыть выбранный документ; 

– Refresh – обновить содержимое раздела; 

– Copy, Paste, Delete и Rename – копирование, вставка, удаление и пе-

реименование выбранного документа соответственно. 

Примечание. Документ проекта удалить нельзя; 

– Add Project Folder to Version Control и Add to Version Control – до-

бавление в контроль версий. 

4. В разделе Time line приводятся резервные копии выбранного файла, 

при этом доступна разделенная (ПКМ ⇒ Switch to Classic View) и комбини-

рованная форма представления (ПКМ ⇒ Switch to Combined View). 

При комбинированной форме представления (см. рис. Г.203) отобража-

ется следующая информация: 

– Event – описание события из истории работы с документом (например, 

Modify document – открытый документ с несохраненными изменениями, 

Open document – открытый документ без изменений, Save to file – сохранение 

в файл, Save to history – сохранение в папку History); 

– Time – дата и время события; 

– Version – пояснение к событию (например, Modified open document – 

открытый документ с несохраненными изменениями, Unchanged open docu-

ment – открытый документ без изменений, Latest saved version – последняя 

сохраненная версия, Version N – версия с порядковым номером N); 

– Author – имя пользователя, сохранившего документ; 

– Comment – комментарий к версии. 

Основные команды из контекстного меню, вызываемом щелчком ПКМ: 

4.1. Show Autobackups – отображение в списке истории автоматически 

сохраненных версий файлов. 

Примечание. Автосохранения добавляются в папку History при включе-

нии опций Auto save every и Add autosaved documents to history в окне Prefer-
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ences (команда DXP ⇒ Preferences) в подразделах Data Management ⇒ Backup 

и Data Management ⇒ Local History соответственно. 

4.2. Apply label – добавление комментария к выбранной версии длиной 

до 64 символов. 

Примечания: 

– для автосохранений добавляется автоматический комментарий, со-

стоящий из слова AutoSave, даты и отметки времени; 

– резервные копии в папке History хранятся в виде архивов формата ZIP. 

В названии каждого архива содержится имя исходного файла и его расши-

рение, между которыми вставляются символы «.~(N)», где N – порядковый 

номер версии. При наличии комментария после указанных символов допол-

нительно записывается конструкция вида «.#(X)», где X – комментарий. 

4.3. Open – открыть выбранную версию документа. 

Примечание. Команда неактивна при выборе нескольких документов. 

4.4. Delete – удаление выбранной версии документа. 

Примечания. Команда работает только в разделенной форме пред-

ставления раздела Time line (группа Local History), при этом удалить записи 

Document и Last Saved Contents нельзя. 

4.5. Revert to – откат до выбранной версии, т. е. выбранная версия доку-

мента заменяет текущую версию в проекте. 

Примечание. При выполнении команды в разделенной форме представ-

ления раздела Time line (группа Local History) создается резервная копия по-

следней сохраненной версии с добавлением комментария вида «[Reverted to 

Z]», где Z – номер версии, до которой был произведен откат. 

4.6. Purge History – очистка истории путем удаления резервных копий 

для выделенного документа. В появляющемся после запуска команды окне 

Confirm purge document history (рис. Г.204) доступны следующие опции: 

– Keep at least specified number of versions – сохранять при удалении 

указанное количество последних резервных копий; 

– Include labeled versions as well – удалять резервные копии, для кото-

рых добавлены комментарии; 

– Purge all history – удаление всех резервных копий с учетом первых 

двух опций; 

– Purge versions older than specified number of days – удаление резерв-

ных копий, которые хранятся дольше, чем указанное количество дней, при 

этом учитываются первые две опции; 
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– Purge versions older than specified date – удаление резервных копий, 

сделанных раньше указанной даты (учитываются первые две опции). 

4.7. Compare – сравнение двух выбранных резервных копий документа 

(выбор осуществляется щелчком ЛКМ с зажатой клавишей Ctrl). 

После запуска команды обе версии откроются в рабочем поле, а список 

различий появится в панели Differences. При щелчке по интересующей стро-

ке списка различия подсветятся одновременно в двух документах. 

Примечание. Сравнить два документа можно с помощью команд Pro-

ject ⇒ Show Differences (результат появится в окне Engineering Change 

Order) и Project ⇒ Show Physical Differences (результат появится в панели 

Differences). При использовании этих команд оба документа должны при-

сутствовать в панели Projects (файл может быть и как свободный доку-

мент). После запуска указанных команд для выбора второго документа не из 

текущего проекта в появляющемся окне включается опция Advanced Mode. 

Г.51. Рамки для схем 

Листы КД должны быть оформлены по ГОСТ Р 2.104–2023 (см. 3.2.3). В 

Altium Designer в схемах для этого используются отдельные файлы с рамка-

ми (шаблоны) с расширением «.SchDot». 

Рис. Г.204 
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Шаблон с рамкой может быть подключен или заменен на какой-нибудь 

другой на любом этапе работы со схемой, при этом в самом схемном доку-

менте выделение и редактирование отдельных его элементов невозможно (за 

исключением значений заранее созданных параметров). Фактически рамка 

является фоновым изображением схемы. 

Созданный один раз шаблон может быть подключен к любым схемным 

документам неограниченное число раз. Используемые при проектировании 

файлы содержатся в папке …\ИДРЭС\AD рамки (см. рис. 2.9): 

– A3-1-ИДРЭС-AD.SchDot – рамка для первого листа формата A3; 

– A3-2-ИДРЭС-AD.SchDot – рамка для второго и последующих листов 

формата A3; 

– A4-1-ИДРЭС-AD.SchDot – рамка для первого листа формата A4; 

– A4-2-ИДРЭС-AD.SchDot – рамка для второго и последующих листов 

формата A4. 

Файл с рамкой для редактирования или создания на ее основе других 

файлов рамок открывается командой File ⇒ Open. 

Описание процесса создания файла с рамкой: 

1. Командой File ⇒ New ⇒ Schematic создается новый документ схемы. 

2. Запускается команда Design ⇒ Document Options и на вкладке Sheet 

Options выполняется следующее: 

– в группе Options отключаются все опции (Title Block, Show Reference 

Zones и Show Border), так как результаты их действия не соответствуют тре-

бованиям ЕСКД; 

– в группе Options для параметра Orientation выбирается ориентация 

листа (Landscape – горизонтальный, Portrait – вертикальный); 

– в группе Options в поле Sheet Color задается белый цвет, который 

можно выбрать на вкладке Standard окна Choose Color (рис. Г.205). 

Примечание. Цвет по умолчанию является цветочным белым, в чем 

можно убедиться на вкладке Custom окна Choose Color. Для белого цвета 

кодировка в формате RGB – (255, 255, 255); 

– кнопкой Change System Font задаются системные настройки шрифта 

(шрифт – GOST type B, начертание – обычный, размер – 12, набор симво-

лов – Кириллица); 

– в группе Custom Style выбирается опция Use Custom style и в соответ-

ствии с ГОСТ 2.301–68 (табл. Г.18) задаются размеры листа в полях Custom 

Width (ширина) и Custom Height (высота). 
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Таблица Г.18 

Размеры основных форматов листов 

Обозначение формата Размеры сторон формата, мм 

A0 841 × 1189 

A1 594 × 841 

A2 420 × 594 

A3 297 × 420 

A4 210 × 297 

Важно отметить, что под шириной листа понимается горизонтальный 

размер листа с горизонтальной ориентацией. Например, для вертикальной 

ориентации листа формата A4 в поле Custom Width должно быть записано 

297mm, а в поле Custom Height – 210mm. 

Примечания: 

– размеры листов из группы Standard Style не соответствуют ЕСКД; 

– значения остальных параметров в группе Custom Style можно оста-

вить без изменений (или обнулить), так как они предназначены для отклю-

ченных опций из группы Options. 

3. В рабочем поле осуществляется переход в сетку 1 мм. 

Рис. Г.205 
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4. Последовательным нажатием клавиш P ⇒ D ⇒ L или с помощью ко-

манды Place ⇒ Drawing Tools ⇒ Line (создание линии) рисуются все грани-

цы в соответствии с размерами из ГОСТ Р 2.104–2023. Рекомендуется ис-

пользовать режим рисования под углом 90°. 

В окне свойств (например, клавиша Tab в режиме рисования) для шири-

ны толстых линий выбирается опция Medium, для тонких – Small. 

5. Последовательным нажатием клавиш P ⇒ T или с помощью команды 

Place ⇒ Text String (создание надписи) добавляются текстовые надписи, 

указанные в ГОСТ Р 2.104–2023.  

В качестве примера на данном этапе на рис. Г.206 показан фрагмент 

нижней части листа формата A4 с вертикальной ориентацией. Использован-

ный параметр шрифта: GOST type A, 16, Italic. 

 

6. Запускается команда Design ⇒ Document Options и на вкладке Param-

eters с помощью кнопки Add создаются параметры для заполняемых в схеме 

граф рамки, например: наименование документа, фамилия разработчика. 

 

На рис. Г.207 приведен пример создания параметра для обозначения до-

кумента в графе 2. Необходимо отметить следующее: 

– опция Visible в группе Name должна быть отключена, иначе впослед-

ствии имя параметра будет отображаться рядом с его значением; 

– имена параметров для удобства работы со списком рекомендуется 

начинать с цифр (системные параметры удалить нельзя). Так, в используе-

мых рамках они содержат номера граф по ГОСТ Р 2.104–2023 (см. рис. 3.6); 

Рис. Г.207 

Рис. Г.206 
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– в поле из группы Value рекомендуется записывать осмысленный текст, 

который на следующем шаге поможет спозиционировать параметр в рамке и 

будет являться подсказкой по его заполнению на схеме. Звездочка не позво-

лит перепутать подсказку с введенным пользователем значением; 

– остальные настройки не требуют изменений. 

7. Последовательным нажатием клавиш P ⇒ T или с помощью команды 

Place ⇒ Text String добавляются текстовые надписи, в свойствах которых в 

поле Text выбираются ранее созданные параметры (рис. Г.208). 

 

В качестве примера на рис. Г.209 показан фрагмент нижней части листа 

формата A4 с вертикальной ориентацией и добавленными параметрами. Ис-

пользованные параметры шрифта: GOST type A, 31, Italic – обозначение до-

кумента; GOST type A, 22, Italic – наименования изделия и организации; 

GOST type A, 16, Italic – все остальные надписи. 

 

В графу 26 добавлена надпись с параметром «=02_Обознач. док.» и вы-

бранным в поле Orientation значением 180 Degrees.  

Важно отметить, что на отображение надписей влияют настройки Con-

vert Special Strings и Display Strings As Rotated (см. табл. Г.3). 

8. Командой File ⇒ Save As файл сохраняется с расширением «.SchDoc». 

Основные особенности использования шаблонов с рамками: 

Рис. Г.208 

Рис. Г.209 
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– подключение шаблона к схеме осуществляется по п. 3 из 3.2.3; 

– в окне Update Template, появляющемся при подключении рамки, сле-

дует также обратить внимание на следующие две опции: Do not update any 

parameters (не обновлять никакие параметры) и Add new parameters that 

exist in the template only (добавить в схему только те параметры, которые в 

ней отсутствуют); 

– обновление и удаление текущего шаблона выполняется соответствен-

но командами Update Current Template и Remove Current Template из ме-

ню Design ⇒ Templates; 

– результат подключения в подразделе Templates (см. табл. Г.2) папки 

…\ИДРЭС\AD рамки с собственными шаблонами показан на рис. Г.210. 

Также попасть в указанный подраздел можно с помощью команды Design ⇒ 

Templates ⇒ General Templates ⇒ Manage General Template Folder; 

 

 

– пример подключения шаблонов в подразделе New Document Defaults 

(см. табл. Г.1), которые будут загружаться каждый раз при создании новых 

документов схем из проектов и вне проектов, показан на рис. Г.211. 

 

Рис. Г.211 

Рис. Г.210 
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Д. Правила выполнения чертежей деталей 

Д.1. Общие сведения 

Определение термину «деталь» было дано в 2.1. 

Чертеж детали по ГОСТ Р 2.102–2023 – графический КД, содержащий 

сведения о форме и размерах детали, требования к ее изготовлению и кон-

тролю. 

Следует отметить, что общие правила выполнения чертежей деталей из 

данного приложения относятся как к «экрану» и «основанию», так и к ДПП. 

Д.2. Общие требования к чертежам 

В ГОСТ Р 2.109–2023 даны основные требования к выполнению черте-

жей, среди которых можно выделить следующие: 

1. Для изделий основного единичного и вспомогательного производства 

на чертежах, предназначенных для использования на конкретном предприя-

тии, допускается помещать различные указания по технологии изготовления 

и контролю изделий. 

2. На чертеже изделия указывают размеры, предельные отклонения, тре-

бования к шероховатости поверхностей и другие данные по ГОСТ 2.307–

2011, ГОСТ Р 2.308–2023, ГОСТ 2.309–73. Текстовую информацию в виде 

надписей, таблиц и ТТ выполняют по ГОСТ Р 2.316–2008. 

3. На каждое изделие выполняют отдельный чертеж. Исключения: 

– группа изделий, обладающих общими конструктивными признаками, 

на которые выполняют групповой чертеж по ГОСТ 2.113–75 (см. прил. Н); 

– составные части изделия, не являющиеся предметом разработки в рам-

ках данного комплекта КД, например стандартные и покупные изделия; 

– детали в особых случаях (например, при изготовлении из фасонного 

или сортового материала отрезкой под прямым углом). 

4. На чертежах для изготовления опытных образцов указывают расчет-

ную массу (графа 5 на рис. 3.6, а и в табл. 3.1), а на чертежах, начиная с ли-

теры О1, – фактическую, т. е. определенную взвешиванием изделия. 

5. Если ребро (кромку) необходимо изготовить острым или скруглить, то 

на чертеже помещают соответствующее указание. Отсутствие таких указаний 

подразумевает необходимость притупления ребра (кромки). 

6. Материал детали должен быть указан в графе 3 основной надписи в 

соответствии с обозначением, установленным стандартами на материал или 

техническими условиями. Допускается указание только одного материала.  
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Структура обозначения материала должна соответствовать стандарту 

(техническим условиям) на материал или стандартам организации. Допуска-

ется в условном обозначении материала не указывать группу точности, плос-

костность, вытяжку, обрезку кромок, длину и ширину листа, ширину ленты и 

другие параметры, не влияющие на характеристики изделия, если в стандарте 

на сортамент и (или) материал не оговорена обязательность их указания. 

7. Если предусматривается возможность использования заменителей ма-

териала, то их указывают в технических требованиях чертежа или техниче-

ских условиях на изделие. 

Д.3. Масштабы, виды, разрезы и сечения 

Масштабы изображений и их обозначения по ГОСТ 2.302–68 рассмот-

рены в 7.2. 

К основным правилам изображения предметов на чертежах по ГОСТ 

2.305–2008 можно отнести следующие: 

1. В зависимости от содержания изображения разделяют на виды, разре-

зы и сечения. 

Масштаб изображений, расположенных в непосредственной проекцион-

ной связи друг с другом на основных плоскостях проекций (см. рис. 7.3), 

принимают за масштаб выполнения документа и записывают в графе 6 (см. 

рис. 3.6, а и табл. 3.1). Все иные изображения, выполненные на чертеже в 

ином масштабе, должны иметь о нем указание. 

2. Для уменьшения количества изоб-

ражений допускается на видах показывать 

необходимые невидимые части поверхно-

сти предмета с помощью штриховых ли-

ний. Пример для рис. 7.3 показан на 

рис. Д.1. 

3. Количество изображений на чер-

теже должно быть наименьшим, но обес-

печивающим полное представление о 

предмете при применении установленных 

в соответствующих стандартах условных обозначений, знаков и надписей. 

4. Виды. 

4.1. Основные определения видам и схема расположения видов с непо-

средственной проекционной связью были даны в 7.2. 

Рис. Д.1 [44] 
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4.2. Если виды сверху, слева, справа, снизу, сзади не находятся в непо-

средственной проекционной связи с главным изображением (видом или раз-

резом, изображенным на фронтальной плоскости проекции), то направление 

проецирования должно быть указано стрелкой около соответствующего 

изображения. Над стрелкой и над полученным изображением (видом) необ-

ходимо нанести одну и ту же прописную букву (вид Б на рис. Д.2). 

 

Когда отсутствует изображение, на котором может быть показано 

направление взгляда, название вида подписывают. 

4.3. Если какую-либо часть предмета на чертеже невозможно показать 

на перечисленных видах без искажения формы и размеров, то применяют до-

полнительные виды, получаемые на плоскостях, не параллельных основным 

плоскостям проекций. 

4.4. Дополнительный вид должен быть отмечен на чертеже прописной 

буквой, а у связанного с дополнительным видом изображения предмета 

должна быть поставлена стрелка, указывающая направление взгляда, с соот-

ветствующим буквенным обозначением. 

4.5. Дополнительный вид допускается повертывать, при этом обозначе-

ние вида должно быть дополнено специальным обозначением. При необхо-

димости указывают угол поворота (рис. Д.2). 

4.6. Местный вид должен быть отмечен на чертеже подобно дополни-

тельному виду (виды Г и Д на рис. Д.3). 

5. Разрезы. 

5.1. Разрез – ортогональная проекция предмета, мысленно рассеченного 

полностью или частично одной или несколькими плоскостями для выявления 

Рис. Д.2 [44] 
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его невидимых поверхностей. При выполнении разреза мысленное рассече-

ние предмета относится только к данному разрезу и не влечет за собой изме-

нения других изображений того же предмета. 

 

На разрезе показывают то, что получается в секу-

щей плоскости и что расположено за ней (рис. Д.4). 

5.2. В зависимости от числа секущих плоскостей 

разрезы разделяют на две группы: 

– простые – разрезы, выполненные одной секущей 

плоскостью (разрезы Б–Б и В–В на рис. Д.3); 

– сложные – разрезы, выполненные двумя и более 

секущими плоскостями (разрез А–А на рис. Д.2 и Д.3). 

5.3. Положение секущей плоскости указывают на 

чертеже линией сечения, для которой применяют разомкнутую линию. При 

сложном разрезе штрихи проводят также у мест пересечения этих плоскостей 

между собой. 

На начальном и конечном штрихах ставят стрелки, расположенные на 

расстоянии 2–3 мм от концов штрихов и показывающие направление взгляда. 

Указанные штрихи не должны пересекать контур соответствующего изобра-

жения. 

5.4. У начала и конца линии сечения (при необходимости и у мест пере-

сечения секущих плоскостей) ставят одну и ту же прописную букву. Буквы 

наносят около стрелок, указывающих направление взгляда, и в местах пере-

Рис. Д.3 [44] 

Рис. Д.4 [44] 
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сечения со стороны внешнего угла. Разрез должен быть отмечен надписью 

вида «А–А» (всегда двумя буквами через тире). 

5.5. Когда секущая плоскость совпадает с плоскостью симметрии пред-

мета в целом, а соответствующие изображения расположены на одном листе 

чертежа в непосредственной проекционной связи и не разделены каки-

ми-либо другими изображениями для многих видов разрезов не отмечают 

положение секущей плоскости и разрез надписью не 

сопровождают (например, разрез на месте главного 

вида на рис. Д.4). 

5.6. Местный разрез – разрез, выполненный се-

кущей плоскостью только в отдельном, ограничен-

ном месте предмета (рис. Д.3 и Д.5). 

Местный разрез выделяют на виде сплошной 

волнистой линией или сплошной тонкой линией с 

изломом. Эти линии не должны совпадать с какими-

либо другими линиями изображения. 

6. Сечения. 

6.1. Сечение – ортогональная проекция фигуры, получающейся в одной 

или нескольких секущих плоскостях или поверхностях при мысленном рас-

сечении проецируемого предмета. На сечении показывают только то, что по-

лучается непосредственно в секущей плоскости. 

6.2. Сечения, не входящие в состав разреза, разделяют на две группы: 

– вынесенные (рис. Д.6, а); 

– наложенные (рис. Д.6, б). 

 

Вынесенные сечения являются предпочтительными. 

На чертежах контур вынесенного сечения, а также сечения, входящего в 

состав разреза, изображают сплошными основными линиями, а контур нало-

Рис. Д.6 [44] 

а б 

Рис. Д.5 [44] 
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женного сечения – сплошными тонкими линиями, причем контур изображе-

ния в месте расположения наложенного сечения не прерывают. 

6.3. Ось симметрии вынесенного или наложенного сечения указывают 

штрихпунктирной тонкой линией без обозначения буквами и стрелками и 

линию сечения не проводят. 

Также линию сечения не прово-

дят в случае симметричной фигуры 

вынесенного сечения, расположенно-

го в разрыве между частями одного и 

того же вида (рис. Д.7). 

Во всех остальных случаях линия сечения обозначается подобно разре-

зу, а само сечение сопровождается надписью по типу «А–А». 

7. Выносные элементы. 

7.1. Выносной элемент (рис. Д.8) – дополни-

тельное, обычно увеличенное, отдельное изображе-

ние части предмета. Его используют, как правило, 

для размещения какой-либо части предмета, требу-

ющей графического и других пояснений в отноше-

нии формы, размеров и иных данных. 

Он может содержать подробности, не указан-

ные на соответствующем изображении, и может от-

личаться от него по содержанию (например, изоб-

ражение может быть видом, а выносной элемент – разрезом). 

7.2. При применении выносного элемента соответствующее место отме-

чают на виде, разрезе или сечении замкнутой сплошной тонкой линией 

(окружностью, овалом и т. п.) и обозначают прописной буквой на полке ли-

нии-выноски. Над изображением выносного элемента указывают его обозна-

чение и масштаб (если он отличается от масштаба, указанного в основной 

надписи чертежа). 

7.3. Выносной элемент располагают недалеко от соответствующего ме-

ста на изображении предмета, с которого он был получен. 

Д.4. Упрощения изображений на чертежах 

Подробность выполнения изображения предмета устанавливает разра-

ботчик исходя из требований к содержанию документа в зависимости от ста-

дии разработки. 

Рис. Д.8 [44] 

Рис. Д.7 [44] 
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Некоторые условности и упрощения из ГОСТ 2.305–2008: 

1. Если вид, разрез или сечение представляют собой симметричную фи-

гуру, допускается вычерчивать половину изображения (рис. Д.9, а) или не-

много более половины изображения с проведением в последнем случае ли-

нии обрыва (рис. Д.9, б). 

 

2. Детали, такие как винты, заклепки, шпонки, непустотелые валы и 

шпиндели, шатуны, рукоятки и т. п., при продольном разрезе показывают не-

рассеченными. Как правило, показывают нерассеченными на сборочных чер-

тежах гайки и шайбы. Шарики всегда показывают нерассеченными. 

3. Пластины, а также элементы деталей (отверстия, фаски, пазы, углуб-

ления и т. п.) размером (или разницей в размерах) не более 2 мм изображают 

на чертеже с отступлением от масштаба, принятого для всего изображения, в 

сторону увеличения. 

4. Если предмет имеет несколько одинако-

вых, равномерно расположенных элементов, то 

на изображении этого предмета полностью по-

казывают один-два таких элемента (например, 

отверстия на рис. Д.2 и Д.3), а остальные эле-

менты показывают упрощенно или условно 

(рис. Д.10). 

5. Предметы или элементы, имеющие постоянное или закономерно из-

меняющееся поперечное сечение (валы, цепи, прутки, фасонный прокат, ша-

туны и т. п.), допускается изображать с разрывами. 

Частичные изображения и изображения с разрывами ограничивают од-

ним из следующих способов: 

– сплошной тонкой линией с изломом, которая может выходить за кон-

тур изображения на длину 2–4 мм. Эта линия может быть наклонной относи-

тельно линии контура (рис. Д.11, а); 

Рис. Д.9 [44] 

а б 

Рис. Д.10 [44] 
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– сплошной волнистой линией, соединяющей соответствующие линии 

контура (рис. Д.11, б); 

– линиями штриховки (рис. Д.11, в). 

 

6. Условности и упрощения, допускаемые в неразъемных соединениях, в 

чертежах электротехнических и радиотехнических устройств, зубчатых за-

цепления и т. д. устанавливаются соответствующими стандартами. 

Д.5. Нанесение размеров 

Размер – числовое значение линейной величины (диаметра, длины и 

т. п.) в выбранных единицах измерения. 

Правила нанесения размеров и предельных отклонений в графических 

документах устанавливает ГОСТ 2.307–2011. Предельные отклонения рас-

смотрены отдельно в Д.6. 

К основным правилам нанесения размеров можно отнести следующие: 

1. Общее количество размеров должно быть минимальным, но достаточ-

ным для изготовления и контроля изделия. 

2. Справочные размеры, т. е. размеры, не подлежащие выполнению по 

данному графическому документу и указываемые для большего удобства 

пользования этим документом, отмечают знаком «*» (рис. Д.12), а в ТТ запи-

сывают: «* Размеры для справок». 

Рис. Д.11 [44] 

б 

в 

а 
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Если все размеры справочные, их знаком «*» не отмечают, а в ТТ запи-

сывают: «Размеры для справок». 

К справочным относят следующие размеры: 

– один из размеров замкнутой размерной цепи (предельные отклонения 

таких размеров на чертеже не указывают); 

– размеры, перенесенные с графических документов изделий-заготовок; 

– размеры на сборочном чертеже, перенесенные с чертежей деталей и 

используемые в качестве установочных и присоединительных; 

– габаритные размеры на сборочном чертеже, перенесенные с чертежей 

деталей или являющиеся суммой размеров нескольких деталей; 

– размеры деталей (элементов) из сортового, фасонного, листового и 

другого проката, если они полностью определяются обозначением материала, 

приведенным в графе 3 основной надписи (см. рис. 3.6, а) и др. 

3. Не допускается повторять размеры одного и того же элемента на раз-

ных изображениях, в ТТ, основной надписи и спецификации. 

4. Линейные размеры и их предельные отклонения в графических доку-

ментах и в спецификациях указывают в миллиметрах без обозначения еди-

ницы измерения. 

В размерах и предельных отклонениях, приводимых в ТТ и пояснитель-

ных надписях на поле чертежа, обязательно указывают единицы измерения. 

Если в графических документах размеры необходимо указать не в мил-

лиметрах, а в других единицах измерения (сантиметрах, метрах и т. д.), то 

соответствующие размерные числа записывают с обозначением единицы из-

мерения или указывают их в ТТ. 

5. Для размерных чисел применять простые дроби не допускается, за ис-

ключением размеров в дюймах. 

Рис. Д.12 [45] 
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6. Для всех размеров, нанесенных на рабочих графических документах, 

указывают предельные отклонения. 

7. Размеры в графических документах указывают размерными числами и 

размерными линиями. 

8. При нанесении размера прямолинейного отрезка размерную линию 

проводят параллельно этому отрезку, а выносные линии – перпендикулярно к 

размерным (рис. Д.13, а). Размерную линию заканчивают стрелками, упира-

ющимися в соответствующие выносные линии. 

 

При нанесении размера угла размерную линию проводят в виде дуги с 

центром в его вершине, а выносные линии – радиально (рис. Д.13, б). 

Выносные линии должны выходить за концы стрелок размерной линии 

на 1–5 мм. 

9. Допускается проводить размерные линии непосредственно к линиям 

видимого контура, осевым, центровым и другим линиям (рис. Д.13, в и г). 

10. Не допускается использовать линии контура, осевые, центровые и 

выносные линии в качестве размерных. 

11. Необходимо избегать пересечения размерных и выносных линий. 

12. Размерные линии рекомендуется наносить вне контура предмета. 

13. Выносные линии проводят от линий видимого контура, за исключе-

нием следующих случаев: 

Рис. Д.13 [45] 

б 
а 

в 

г д 
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– при простановке размеров криволинейного контура (см. рис. Д.13, в); 

– если надо показать координаты вершины скругляемого угла или цен-

тра дуги скругления, то выносные линии проводят от точки пересечения сто-

рон скругляемого угла или центра дуги скругления (см. рис. Д.13, г); 

– когда при нанесении размеров на невидимом контуре отпадает необ-

ходимость в вычерчивании дополнительного изображения. 

14. При изображении изделия с разрывом размерную линию не преры-

вают (см. рис. Д.13, д). 

15. Минимальные расстояния между параллельными размерными лини-

ями должны быть 7 мм, а между размерной и линией контура – 10 мм, и вы-

браны в зависимости от размеров изображения и насыщенности чертежа. 

16. Если длина размерной линии недостаточна для размещения на ней 

стрелок, то ее продолжают за выносные линии (или соответственно за кон-

турные, осевые, центровые и т. д.) и стрелки наносят так, как показано на 

рис. Д.14, а. 

 

При недостатке места для стрелок на размерных линиях, расположенных 

цепочкой, стрелки допускается заменять засечками, наносимыми под углом 

45° к размерным линиям (рис. Д.14, б), или точками (рис. Д.14, в). 

При недостатке места для стрелки из-за близко расположенной контур-

ной или выносной линии последние допускается прерывать (рис. Д.14, г). 

17. Размерные числа наносят над размерной линией возможно ближе к 

ее середине. 

При нанесении размера диаметра внутри окружности размерные числа 

смещают относительно середины размерных линий. 

18. Размерные числа линейных размеров при различных наклонах раз-

мерных линий располагают в соответствии с рис. Д.15, а. 

Если необходимо нанести размер в заштрихованной зоне, соответству-

ющее размерное число наносят на полке линии-выноски (рис. Д.15, б). 

Рис. Д.14 [45] 

б а в г 



 

 950 

 

19. Размерные числа и предельные отклонения не допускается разделять 

или пересекать какими бы то ни было линиями изображения. 

Не допускается разрывать линию контура для нанесения размерного 

числа и наносить размерные числа в местах пересечения размерных, осевых 

или центровых линий. 

В месте нанесения размерного числа осевые, центровые линии и линии 

штриховки прерывают (рис. Д.15, в). 

20. Если для размерного числа недостаточно места над размерной лини-

ей, то размер наносят в соответствии с рис. Д.15, г. Если недостаточно места 

для нанесения стрелок, то их наносят в соответствии с рис. Д.15, д. 

21. Размеры, относящиеся к одному и тому же конструктивному элемен-

ту (пазу, выступу, отверстию и т. д.), рекомендуется группировать в одном 

Рис. Д.15 [45] 

б 

а 

в 

д 

г е 
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месте, располагая их на изображении, где геометрическая форма данного 

элемента показана наиболее полно (см. рис. Д.15, е). 

22. При нанесении размера радиуса перед размерным числом помещают 

прописную букву R. 

Если радиусы скруглений, сгибов и т. д. во всем графическом документе 

одинаковы или какой-либо радиус является преобладающим, то вместо нане-

сения размеров этих радиусов непосредственно на изображении рекоменду-

ется в ТТ делать записи: «Радиусы скруглений 4 мм»; «Внутренние радиусы 

сгибов 10 мм»; «Неуказанные радиусы 8 мм» и т. д. 

23. При указании размера диаметра (во всех случаях) перед размерным 

числом наносят знак «Ø». 

24. Размеры нескольких одинаковых элементов изделия, как правило, 

наносят один раз с указанием на полке линии-выноски количества этих эле-

ментов (рис. Д.16). 

 

Количество одинаковых отверстий всегда указывают полностью, а их 

размеры – только один раз. 

25. Количество одинаковых элементов изделия (например, отверстий), 

расположенных на разных поверхностях и показанных на разных изображе-

ниях, записывают отдельно для каждой поверхности (рис. Д.17). 

 

Рис. Д.16 [45] 

Рис. Д.17 [45] 
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Допускается повторять размеры одина-

ковых элементов изделия или их групп (в том 

числе отверстий), лежащих на одной поверх-

ности, только в том случае, когда они значи-

тельно удалены друг от друга и не увязаны 

между собой размерами. 

26. Допускается не наносить размеры радиуса дуги окружности сопря-

гающихся параллельных линий (рис. Д.18). 

27. Размеры двух симметрично расположенных элементов изделия (кро-

ме отверстий) наносят один раз без указания их количества, группируя, как 

правило, в одном месте все размеры (см. рис. Д.12). 

Д.6. Предельные отклонения размеров 

Некоторые термины и определения, связанные с предельными отклоне-

ниями даны из старой редакции ГОСТ 25346 [146]: 

– номинальный размер – размер, относительно которого определяются 

отклонения (рис. Д.19); 

 

– отклонение – алгебраическая разность между размером (действитель-

ным или предельным) и соответствующим номинальным размерами; 

– предельное отклонение – алгебраическая разность между предельным 

и соответствующим номинальным размерами. Различают верхнее и нижнее 

предельные отклонения; 

– верхнее отклонение – алгебраическая разность между наибольшим 

предельным и соответствующим номинальным размерами (рис. Д.19); 

– нижнее отклонение – алгебраическая разность между наименьшим 

предельным и соответствующим номинальным размерами (рис. Д.19); 

– нулевая линия – линия, соответствующая номинальному размеру, от 

которого откладываются отклонения размеров при графическом изображе-

нии полей допусков и посадок (рис. Д.19); 

Рис. Д.19 

Рис. Д.18 [45] 
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– основное отклонение – верхнее или нижнее предельное отклонение, 

определяющее положение поля допуска относительно нулевой линии. В при-

нятой системе допусков и посадок основным является отклонение, ближай-

шее к нулевой линии. Их обозначают буквами латинского алфавита: пропис-

ными для отверстий (A…ZC) и строчными для валов (a…zc); 

– отверстие – термин, условно применяемый для обозначения внут-

ренних элементов деталей, включая и нецилиндрические элементы; 

– вал – термин, условно применяемый для обозначения наружных эле-

ментов деталей, включая и нецилиндрические элементы; 

– допуск – разность между наибольшим и наименьшим предельными 

размерами или алгебраическая разность между верхним и нижним отклоне-

ниями. Допуск – это абсолютная величина без знака (см. рис. Д.19); 

– квалитет (степень точности) – совокупность допусков, рассматри-

ваемых как соответствующие одному уровню точности для всех номиналь-

ных размеров. В стандарте установлено 20 квалитетов: 01, 0, 1, 2…18. Квали-

теты от 01 до 5 предназначены преимущественно для калибров, 6 и 7 – раз-

меры повышенной и особой точности, 8–11 – достаточно точные размеры, 12 

и выше – размеры, которые обычно нетрудно обеспечить. Числовые значения 

допусков для некоторых квалитетов приведены в табл. Д.1; 

Таблица Д.1 

Числовые значения допусков 

Квалитет 

Числовое значение допуска, мм, для интервалов номинальных размеров, мм 

От 1  

до 3 

включ. 

Св. 3  

до 6 

включ. 

Св. 6  

до 10 

включ. 

Св. 10  

до 18 

включ. 

Св. 18  

до 30 

включ. 

Св. 30  

до 50 

включ. 

Св. 50  

до 80 

включ. 

Св. 80  

до 120 

включ. 

9 0,025 0,030 0,036 0,043 0,052 0,062 0,074 0,087 

10 0,040 0,048 0,058 0,070 0,084 0,100 0,120 0,140 

11 0,060 0,075 0,090 0,110 0,130 0,160 0,190 0,220 

12 0,100 0,120 0,150 0,180 0,210 0,250 0,300 0,350 

13 0,140 0,180 0,220 0,270 0,330 0,390 0,460 0,540 

14 0,250 0,300 0,360 0,430 0,520 0,620 0,740 0,870 

– поле допуска – поле, ограниченное наибольшим и наименьшим пре-

дельными размерами и определяемое величиной допуска и его положением 

относительно номинального размера (см. рис. Д.19). Поле допуска обознача-

ют сочетанием букв основного отклонения и порядкового номера квалитета, 

например: g6, H11. Поля допусков по ГОСТ 25347–82 для 11-го квалитета и 

размеров от свыше 6 до 10 мм включительно показаны на рис. Д.20. 
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Предельные отклонения размеров следует указывать непосредственно 

после номинальных размеров. Для линейных размеров это делается одним из 

следующих способов (см. рис. Д.12): 

– условными обозначениями полей допусков в соответствии с ГОСТ 

25346–89, например: 11H8 , 11c10 , 8E12 ; 

– числовыми значениями, например: 09,08+ , 
08,0
17,0

10
−
−

, 
059,0
032,0

12
+
+

; 

– условными обозначениями полей допусков с указанием справа в скоб-

ках их числовых значений, например: )09,0(11H8 + , 
)08,0(
)17,0(

11c10
−
−

, 
)059,0(
)032,0(

8E12
+
+

. 

Предельные отклонения угловых размеров указывают только числовыми 

значениями. 

При указании номинальных размеров буквенными обозначениями поля 

допусков должны быть указаны после тире, например: D – H11. 

Числовые значения верхних отклонений помещают над нижними. 

Предельные отклонения, равные нулю, не указывают. 

При симметричном расположении поля допуска абсолютное значение 

отклонений указывают один раз со знаком «±», например: 10±0,045. 

Для размеров относительно низкой точности допускается оговаривать 

общие предельные отклонения записью в ТТ чертежа при условии однознач-

ного понимания значений и знаков. Возможно три варианта такой записи: 

1. Размеры имеют симметричные предельные отклонения по одному из 

четырех классов точности в соответствии с ГОСТ 30893.1–2002 [147]: f – 

«точный», m – «средний», c – «грубый», v – «очень грубый». 

Значения предельных отклонений для интервалов номинальных разме-

ров отдельно для случаев линейных размеров, угловых размеров и размеров 

Рис. Д.20 



 

 955 

притупленных кромок (наружных радиусов скругления и высот фасок) при-

ведены в трех таблицах указанного стандарта. Например, у номинального 

линейного размера 6 мм, указанного для любого элемента на чертеже без 

предельных отклонений, предельное отклонение в классе f составит 

±0,05 мм, в классе m – ±0,1 мм, в классе c – ±0,3 мм, в классе v – ±0,5 мм. 

Пример записи: «Общие допуски по ГОСТ 30893.1 – m». 

2. Размеры отверстий и валов имеют односторонние предельные откло-

нения (в плюс и минус соответственно), а элементы, не относящиеся к отвер-

стиям и валам, – симметричные предельные отклонения. Предельные откло-

нения задаются по одному из четырех классов точности в соответствии с 

ГОСТ 30893.1–2002, но в этом случае они обозначаются буквой t и индексом: 

t1 – «точный», t2 – «средний», t3 – «грубый», t4 – «очень грубый». 

Пример записи: «Общие допуски по ГОСТ 30893.1: 1t+ , 1t− , 21t ». 

Величины симметричных предельных отклонений по классам точности 

( 2t ) совпадают с соответствующими классами точности из п. 1. 

Например, для приведенной записи у номинального линейного размера 

6 мм предельные отклонения для отверстий составят плюс 0,1 мм, для ва-

лов – минус 0,1 мм, для прочих элементов – ±0,05 мм. 

3. Размеры отверстий и валов имеют односторонние предельные откло-

нения (в плюс и минус соответственно), а элементы, не относящиеся к отвер-

стиям и валам, – симметричные предельные отклонения. Предельные откло-

нения задаются по квалитетам в соответствии с ГОСТ 25346–89 и ГОСТ 

25348–82 [148]. 

Пример записи: «Общие допуски по ГОСТ 30893.1: H12, h12, ± 212IT ». 

Например, для приведенной записи у номинального линейного размера 

6 мм предельные отклонения для отверстий составят плюс 0,12 мм, для ва-

лов – минус 0,12 мм, для прочих элементов – ±0,06 мм. 

Также возможна замена симметричных предельных отклонений по ква-

литетам ( 2IT ), где после букв IT указывается номер квалитета, на симмет-

ричные предельные отклонений по классам точности (для 12-го квалитета – 

t1, для 14-го квалитета – t2, для 16-го квалитета – t3, для 17-го квалитета – t4), 

например: «Общие допуски по ГОСТ 30893.1: H12, h12, 21t ». 

Следует отметить, что на чертежах деталей радиоэлектронной аппарату-

ры часто в ТТ помещают ссылку на отраслевой стандарт ОСТ4 ГО.070.014, 

который устанавливает общие ТТ к деталям из разных материалов (металл, 
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резина, древесина и пр.), правила приемки, методы испытаний и др. Также в 

разделе «Общие требования» из этого стандарта уже содержится запись, сде-

ланная по 3-му варианту, для общих допусков по 14-му квалитету. 

Д.7. Допуски формы и расположения поверхностей 

Основные определения даны в утратившем силу ГОСТ 24642–81 [149]: 

– допуск формы – наибольшее допускаемое отклонение формы реаль-

ной поверхности или реального профиля от формы номинальной поверхно-

сти или номинального профиля (например, отклонение от прямолинейности, 

частными случаями которого являются выпуклость и вогнутость); 

– допуск расположения – предел, ограничивающий допускаемое значе-

ние отклонения реального расположения элемента от его номинального рас-

положения (например, отклонение от перпендикулярности). 

Числовые значения на допуски формы и расположения поверхностей 

можно найти в ГОСТ 24643–81 [150] и ГОСТ 30893.2–2002 [151]. 

При необходимости нормирования допусков формы и расположения, не 

указанных в графическом документе числовыми значениями и не ограничи-

ваемых другими указанными допусками формы и расположения, в ТТ долж-

на быть приведена общая надпись о неуказанных допусках формы и распо-

ложения со ссылкой на ГОСТ 30893.2–2002 по одному из трех классов точ-

ности: H, K (грубее, чем H), L (грубее, чем K), 

Пример записи: «Общие допуски формы и расположения – ГОСТ 

30893.2 – H». 

Стоит отметить, что в отраслевом стандарте ОСТ4 ГО.070.014 в разделе 

«Общие требования» уже содержится запись для неуказанных отклонений 

формы и расположения поверхностей по классу точности K. 

Нанесение обозначений допусков. Правила указания допусков формы 

и расположения поверхностей в графических документах устанавливают 

ГОСТ Р 2.308–2023 и ГОСТ Р 53442–2015 [152]. 

При условном обозначении данные о допусках формы и расположения 

поверхностей указывают в прямоугольной рамке, разделенной на две и более 

части, в которых помещают следующую информацию: 

– в первой – условный знак допуска; 

– во второй – числовое значение допуска в миллиметрах; 

– в третьей и последующих – буквенное обозначение базы, общей базы 

или комплекта баз. 
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На рис. Д.21 показано условное обозначение допуска 

параллельности (один из видов допуска расположения) 

относительно базовой плоскости A. Указание означает, 

что выявленная поверхность должна быть расположена 

между двумя параллельными плоскостями, находящимися 

друг от друга на расстоянии 0,02 мм и параллельными ба-

зовой плоскости А. 

Рамки выполняются сплошными тонкими линиями. Высота цифр, букв и 

знаков, вписываемых в рамки, должна быть равна размеру шрифта размер-

ных чисел. 

Рамку располагают горизонтально, при этом не допускается пересекать 

ее какими-либо линиями. 

Рамку соединяют с элементом, к которому относится допуск, сплошной 

тонкой линией, заканчивающейся стрелкой. Соединительная линия может 

быть прямой или ломаной, но направление отрезка соединительной линии, 

заканчивающегося стрелкой, должно соответствовать направлению измере-

ния отклонения. Ее проводят от рамки так, как показано на рис. Д.22, а. 

 

В необходимых случаях допускается проводить соединительную линию 

от второй (последней) части рамки (рис. Д.22, б) и заканчивать ее стрелкой со 

стороны материала детали (рис. Д.22, в). 

Если допуск относится к поверхности или ее профилю, то рамку соеди-

няют с контурной линией поверхности или ее продолжением в виде отрезка 

тонкой линии, при этом соединительная линия не должна быть продолжени-

ем размерной линии (рис. Д.23, а и б). 

Рис. Д.22 [46] 

б 

а 
в 

Рис. Д.21 [46] 
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Если допуск относится к оси или плоскости симметрии, то соединитель-

ная линия должна быть продолжением размерной линии (рис. Д.23, в и г). 

При недостатке места стрелку размерной линии допускается совмещать со 

стрелкой соединительной линии (рис. Д.23, д). 

Если размер элемента уже указан один раз, то на других размерных ли-

ниях данного элемента, используемых для условного обозначения допуска 

формы и расположения, его не указывают. Размерную линию без размера 

следует рассматривать как составную часть условного обозначения допуска 

формы и расположения (рис. Д.23, е). 

Если допуск относится к общей оси (плоскости симметрии) и из чертежа 

ясно, для каких поверхностей данная ось (плоскость симметрии) является 

общей, то рамку соединяют с ней как на рис. Д.23, ж. 

Обозначение баз. База – элемент детали (или сочетание элементов), по 

отношению к которому задается допуск расположения или суммарный до-

пуск формы и расположения рассматриваемого элемента, а также определя-

ется соответствующее отклонение. 

Базы, образующие комплект баз и ука-

зываемые в третьей и последующих частях 

рамки допуска формы и расположения по-

верхностей, записывают в порядке убывания 

числа степеней свободы, лишаемых ими. 

Например, на рис. Д.24: 

– база A лишает деталь трех степеней 

свободы и называется установочной, при 

Рис. Д.23 [46] 

а б в г 

д 
е 

ж 

Рис. Д.24 [149] 

Z 

Y 

X 
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этом данное тело не сможет перемещаться вдоль оси Z и вращаться вокруг 

осей X и Y;  

– база B лишает деталь двух степеней свободы и называется направля-

ющей. В дополнение к базе A тело не сможет перемещаться вдоль оси X и 

вращаться вокруг оси Z; 

– база С лишает деталь одной степени свободы и называется опорной. В 

дополнение к базам A и B тело не сможет перемещаться вдоль оси Y. 

Базу, относительно которой установлен допуск элемента, указывают 

прописной буквой. Рамка базы, в которой размещается буква, соединяется с 

базой сплошной тонкой линией, заканчивающейся зачерненным равносто-

ронним треугольником (см. рис. Д.21). Высота треугольника должна быть 

приблизительно равна размеру шрифта размерных чисел. 

Если базой является линия или поверхность, то треугольник располага-

ют на контуре элемента или на его продолжении, при этом соединительная 

линия не должна быть продолжением размерной линии (рис. Д.25, а). 

 

Если базой является ось или плоскость симметрии, то треугольник рас-

полагают на конце размерной линии (рис. Д.25, б). В случае недостатка места 

стрелку размерной линии допускается заменять треугольником (рис. Д.25, в). 

Если базой является общая ось (плоскости симметрии) и из чертежа яс-

но, для каких поверхностей ось (плоскость симметрии) является общей, то 

треугольник располагают на ней (рис. Д.25, г). 

Допуск плоскостности. Допуск плоскостности (один из видов допуска 

формы) определяет наибольшее допускаемое значение отклонения от плос-

костности, при этом поле допуска (область в пространстве) ограничено двумя 

параллельными плоскостями, расстояние между которыми равно числовому 

значения допуска TFE (рис. Д.26). 

На рис. Д.27 показан пример обозначения допуска плоскостности по-

верхности. Указание означает, что выявленная поверхность должна быть 

Рис. Д.25 [46] 

а 
б в г 
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расположена между двумя параллельными 

плоскостями, находящимися друг от друга на 

расстоянии 0,1 мм. 

Следует отметить, что для элементов с ука-

занными на чертеже предельными отклонения-

ми размеров и неуказанными допусками формы 

допускаются любые отклонения формы в преде-

лах поля допуска размера рассматриваемого 

элемента. 

Значения допусков плоскостности для некоторых ин-

тервалов номинальных размеров и степеней точности даны 

в табл. Д.2. Под номинальным размером здесь понимается 

номинальная длина нормируемого участка. Если послед-

ний не задан, то тогда номинальный размер – номинальная 

длина большей стороны поверхности (размер 1L  или 2L  на рис. Д.26). 

Таблица Д.2 

Допуски плоскостности 

Интервалы  

номинальных 

размеров, мм 

Допуски плоскостности, мкм, при степени точности 

5 6 7 8 9 10 11 12 

Св. 16 до 25 2,5 4 6 10 16 25 40 60 

Св. 25 до 40 3 5 8 12 20 30 50 80 

Св. 40 до 63 4 6 10 16 25 40 60 100 

Св. 63 до 100 5 8 12 20 30 50 80 120 

Св. 100 до 160 6 10 16 25 40 60 100 160 

Степени точности рекомендуется назначать с учетом способа обработки 

поверхностей: 

– 5–6 – шлифование, шабрение, тонкое развертывание, обтачивание и 

фрезерование повышенной точности; 

– 7–8 – грубое шлифование, фрезерование, строгание, чистовое обтачи-

вание, зенкерование и сверление повышенной точности; 

– 9–10 – фрезерование, сверление, строгание, обтачивание, долбление, 

литье под давлением; 

– 11–12 – грубая механическая обработка всех видов. 

Некоторые указанные способы обработки [153], [154]: 

– шабрение – отделочная обработка поверхности, предварительно обра-

ботанной резанием, путем снятия тонкой стружки (скобление) шабером 

Рис. Д.27 [46] 

Рис. Д.26 [149] 
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(рис. Д.28, а). Используется для обеспечения точного сопряжения деталей 

или точного относительного их положения; 

 

– развертывание – чистовая обработка отверстий резанием (после свер-

ления и зенкерования) многолезвийным режущим инструментом – разверт-

кой (рис. Д.28, б); 

– обтачивание – операция обработки цилиндрических и торцевых по-

верхностей на токарном станке резцом (рис. Д.28, в); 

– фрезерование – обработка резанием металлических и неметаллических 

материалов на фрезерном станке, при которой режущий инструмент (фреза) 

имеет вращательное движение, а обрабатываемая заготовка – поступательное 

(на рис. Д.28, г показана концевая фреза). Это основная операция в изготов-

лении «экрана» и «основания»; 

– зенкерование – обработка предварительно полученных отверстий зен-

кером с целью повышения их точности. Зенкер имеет три или четыре режу-

щие кромки (рис. Д.28, д), т. е. больше, чем у сверла, но меньше, чем у раз-

вертки. 

Рис. Д.28 

а 

б 

в 

г е 

д 
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Примечание. Также существует понятие зенкование – операция полу-

чения цилиндрических или конических углублений под головки винтов с помо-

щью цилиндрических или конических зенковок (см. рис. Д.28, е). Такая опера-

ция использована при изготовлении «экрана». 

Допуск перпендикулярности. Допуск перпендикулярности (один из 

видов допуска расположения) определяет 

наибольшее допускаемое значение отклонения 

от перпендикулярности, при этом поле допуска 

ограничено двумя параллельными плоскостями, 

отстоящими друг от друга на расстоянии, рав-

ном значению допуска TPR, и перпендикуляр-

ными к базовой плоскости (рис. Д.29). 

На рис. Д.30 показан пример обозначения 

допуска перпендикулярности поверхности. Ука-

зание означает, что выявленная поверхность должна 

быть расположена между двумя параллельными плос-

костями, находящимися друг от друга на расстоянии 

0,02 мм и перпендикулярными к базовой плоскости А. 

Значения допусков перпендикулярности для не-

которых интервалов номинальных размеров (размер L 

на рис. Д.29) и степеней точности даны в табл. Д.3. 

Таблица Д.3 

Допуски перпендикулярности 

Интервал 

номинальных 

размеров, мм 

Допуск перпендикулярности, мкм, при степени точности 

5 6 7 8 9 10 11 12 

До 10 2,5 4 6 10 16 25 40 60 

Св. 10 до 16 3 5 8 12 20 30 50 80 

Св. 16 до 25 4 6 10 16 25 40 60 100 

Св. 25 до 40 5 8 12 20 30 50 80 120 

Позиционный допуск. Позиционный допуск (один из видов допуска 

расположения) при проектировании будет использоваться только в диамет-

ральном выражении. В этом случае он определяет удвоенное наибольшее до-

пускаемое значение расстояния между реальным расположениям элемента 

(его центра, оси или плоскости симметрии) и его номинальным расположе-

нием в пределах нормируемого участка, при этом поле допуска ограничено 

цилиндром (рис. Д.31), диаметр которого равен значению допуска в диамет-

Рис. Д.29 [149] 

Рис. Д.30 [46] 
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ральном выражении TPP, а ось совпадает с 

номинальным расположением рассматривае-

мой оси (прямой). 

По ГОСТ 14140–81 [155] допуски распо-

ложения осей отверстий для крепежных дета-

лей должны устанавливаться одним из следу-

ющих способов: 

– позиционными допусками осей отвер-

стий, что является предпочтительным для от-

верстий одной сборочной группы при числе 

элементов в группе более двух; 

– предельными отклонениями размеров. 

Числовые значения позиционных допусков в диаметральном выражении 

T должны соответствовать значениям ряда: 0,01; 0,012; 0,016; 0,02; 0,025; 

0,03; 0,04; 0,05; 0,06; 0,08; 0,1; 0,12; 0,16; 0,2; 0,25; 0,3; 0,4; 0,5; 0,6; 0,8; 1; 1,2; 

1,6; 2; 2,5; 3; 4; 5; 6; 8; 10; 12; 16. 

Технологические преимущества пози-

ционных допусков состоят в том, что они 

позволяют использовать наибольшее поле 

допуска. Так, на рис. Д.32 заштрихованным 

квадратом показано поле допуска, опреде-

ляемое предельными отклонениями коор-

динирующих размеров ( L ), а описанной 

окружностью – поле, обеспечиваемое пози-

ционным допуском [156]. 

В отличие от допусков размеров позиционные допуски не складываются 

при задании теоретически точных размеров цепочкой [157]. 

Использование предельных отклонений координирующих размеров це-

лесообразно, например, если по конструктивным условиям необходимо огра-

ничить отклонения именно в соответствующих координатных направлениях 

(неодинаковые допуски в разных координатных направлениях; в тонкостен-

ных деталях и др.). 

Линейные и угловые размеры, определяющие номинальное расположе-

ние и (или) номинальную форму элементов, ограничиваемых допуском, при 

назначении позиционного допуска и некоторых других видов допуска указы-

вают без предельных отклонений и заключают в прямоугольные рамки. 

Рис. Д.32 

Рис. Д.31 [149] 
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На рис. Д.33 показан пример обо-

значения позиционного допуска. 

Зависимые и независимые до-

пуски. Допуски формы и расположе-

ния поверхностей могут быть незави-

симыми и зависимыми. 

Независимый допуск – допуск, 

числовое значение которого постоян-

но для всей совокупности деталей, из-

готавливаемых по данному чертежу, и не зависит от действительного размера 

нормируемого (или базового) элемента. Если допуск не указан как зависи-

мый, то его считают независимым. 

Зависимый допуск – допуск, числовое значение которого переменно для 

различных деталей, изготовленных по данному чертежу, и зависит от дей-

ствительного размера нормируемого (или базового) элемента. В чертежах 

или ТТ зависимый допуск задается своим минимальным значением, которое 

допускается превышать на величину, соответствующую отклонению дей-

ствительного размера рассматриваемого или базового элемента данной дета-

ли от наибольшего предельного размера вала или наименьшего предельного 

размера отверстия. 

Зависимый допуск обозначается буквой М в окружности (рис. Д.33). 

Зависимые допуски более экономичны и выгодней для производства, 

чем независимые. В отдельных случаях при зависимых допусках путем до-

полнительной обработки (например, развертыванием отверстий) имеется 

возможность перевести деталь из брака в годные. 

Разница между зависимым и независимым допусками будет показана на 

примере рис. Д.33. 

На рисунке задан зависимый позиционный допуск в диаметральном вы-

ражении (перед значением допуска 0,2 мм указан знак диаметра) осей четы-

рех отверстий по отношению друг к другу. Номинальные расстояния между 

осями отверстий – 32 мм. Диаметр каждого отверстия может лежать в диапа-

зоне 6,5–6,65 мм. 

Центр каждого из четырех отверстий может находиться внутри окруж-

ностей с диаметром 0,2 мм (закрашенная область на рис. Д.34), центры кото-

рых занимают номинальное расположение в точной прямоугольной решетке 

с размером 32 мм. Другими словами, поверхность каждого отверстия не 

Рис. Д.33 [158] 
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должна выходить за предельный дей-

ствующий контур – цилиндр с диамет-

ром 3,62,05,6 =−  мм (заштрихованная 

область на рис. Д.34). 

Для наименьшего диаметра отвер-

стия (6,5 мм) позиционный допуск его 

оси составит 0,2 мм (как для зависимо-

го, так и для независимого допуска). На 

рис. Д.34 показано одно из возможных 

предельных положений отверстия. 

Для наибольшего диаметра отверстия (6,65 мм) позиционный допуск его 

оси для независимого допуска составит все те же 0,2 мм (рис. Д.35, а), а для 

зависимого: 35,015,02,0 =+  мм (рис. Д.35, б). 

 

В результате при зависимом позиционном допуске отверстие можно до-

полнительно сдвинуть без нарушения собираемости изделия за счет допуска 

на диаметр, и это не будет считаться браком. 

Зависимые допуски расположения по ГОСТ Р 50056–92 могут назна-

чаться равными нулю. В этом случае допуск размера является суммарным 

допуском размера и расположения элемента, а допуск расположения допу-

стим только за счет использования части допуска на размер. 

В качестве примера на рис. Д.36, а приведена эквивалентная замена раз-

дельных допусков размера цилиндрического элемента и зависимого допуска 

его расположения (допуск перпендикулярности) на суммарный допуск раз-

мера и расположения в сочетании с нулевым зависимым допуском располо-

жения, а на рис. Д.36, б – аналогичная эквивалентная замена для рис. Д.33. 

Рис. Д.35 

а б 

Рис. Д.34 
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На рис. Д.37 приведен пример указания независимого позиционного до-

пуска для четырех отверстий относительно комплекта баз: 

– любой местный диаметр в каждом отверстии должен находиться в 

диапазоне 15–15,43 мм; 

– выявленная поверхность каждого отверстия не должна выходить за 

предельный действующий контур диаметром 14,8 мм. Другими словами, вы-

явленная средняя линия каждого отверстия должна располагаться внутри по-

ля допуска, представляющего собой цилиндр диаметром 0,2 мм; 

– оси полей допусков перпендикулярны относительно базы В и парал-

лельны друг другу; 

Рис. Д.37 

Рис. Д.36 [158] 

а 

б 
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– оси полей допусков занимают теоретически точные положения отно-

сительно друг друга (размеры 30 и 35 мм) и относительно баз А и Б (размеры 

12 и 15 мм). 

База В в данном случае является установочной, т. е. при сборке с этой 

поверхностью может контактировать поверхность другой детали. Если ее не 

показывать, то оси полей допусков останутся параллельны друг другу, но на 

их ориентацию не будет наложено ограничений (если нет никаких других 

указаний на чертеже). В этом случае сборку с другой деталью осуществить 

можно, но без условия соприкосновения их плоскостей. 

Примеры с подробными пояснениями по указанию на чертеже различ-

ных допусков формы и расположения поверхностей даны в ГОСТ Р 50056–

92, ГОСТ Р 53089–2008, ГОСТ Р 53090–2008 [159] и ГОСТ Р 53442–2015. 

Расчет позиционных допусков осей отверстий для крепежных дета-

лей. Допуски расположения осей отверстий для крепежных деталей по ГОСТ 

14140–81 назначают в зависимости от типа соединения крепежными деталя-

ми, зазора для прохода крепежных деталей и коэффициента использования 

этого зазора для компенсации отклонений расположения осей. 

Соединения крепежными деталями подразделяются на два типа: 

– А – зазоры для прохода крепежных деталей предусмотрены в обеих 

соединяемых деталях (рис. Д.38, а). Пример такого типа – соединение болтом 

или заклепкой; 

– В – зазоры для прохода крепежных деталей предусмотрены лишь в од-

ной из соединяемых деталей (рис. Д.38, б). Пример такого типа – соединение 

винтом или шпилькой (стержнем с резьбой). 

 

Если позиционные допуски осей отверстий установлены одинаковыми 

для обеих соединяемых деталей, то их можно определить по формулам: 

Рис. Д.38 [155] 

а б 
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minSKT =  – для соединений типа A, 

 min5,0 SKT =  – для соединений типа В, (Д.1) 

 maxminmin dDS −= , (Д.2) 

где K  – коэффициент использования зазора minS , зависящий от условий 

сборки и позволяющий зарезервировать гарантированный зазор; minS – 

наименьший зазор между сквозным гладким отверстием и крепежной дета-

лью, мм; minD – наименьший предельный диаметр сквозного отверстия, мм; 

maxd  – наибольший предельный диаметр стержня крепежной детали, мм. 

Для соединений, не требующих регулировки взаимного расположения 

деталей, рекомендуется выбирать коэффициент K, равным 0,8 или 1. 

Позиционные допуски осей отверстий для обеих соединяемых деталей 

допускается назначать неодинаковыми ( 21 TT  ). При этом они должны соот-

ветствовать следующим условиям: 

min21 2 SKTT =+  – для соединений типа A, 

 min21 SKTT =+  – для соединений типа В. (Д.3) 

Предельные отклонения размеров, координирующих оси отверстий, 

определяют для соответствующего позиционного допуска осей отверстий T  

путем разложения его на составляющие, ограничивающие позиционное от-

клонение оси в каждом координатном направлении ( xT  и yT ). 

Если составляющие позиционного допуска оси по обоим координатным 

направлениям принимаются одинаковыми (см. рис. Д.32), то их можно найти 

по формуле: 

TLTT yx 7,02 == . 

В этом случае предельные отклонения размеров между осями двух лю-

бых отверстий (а также между осью любого отверстия и базовой плоскостью) 

в каждом координатном направлении определяются по формуле: 

 TL 35,0= . (Д.4) 

Следует отметить, что допуски расположения осей сквозных гладких 

отверстий в соединениях типов А и В рекомендуется назначать зависимыми, 

если это не приводит к нарушению прочности детали или к нарушению тре-

бований к внешнему виду. 

Собираемость изделия при соединении типа В. На рис. Д.39 показано 

соединение двух деталей (позиции 1 и 2) винтом позиции 3. Как было рас-

смотрено ранее, такое соединение относится к типу B. 
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Чертежи деталей позиций 1 и 2 показа-

ны на рис. Д.40, а и б соответственно. По-

зиционный допуск отверстий вычислен по 

(Д.1) с коэффициентом 1=K  и задан отно-

сительно двух баз, которыми соприкасают-

ся детали в рассматриваемой плоскости (ба-

за Б в обеих деталях – установочная). 

 

В изготовленных деталях выявленные оси отверстий могут иметь произ-

вольный угол наклона в пределах полей позиционных допусков, представля-

ющих собой цилиндры с диаметрами 0,3 мм, оси которых строго перпенди-

кулярны базам Б в каждой детали и имеют теоретически точное местораспо-

ложение, заданное номинальными размерами. 

На рис. Д.40, в показаны расположения выявленных осей отверстия с 

наибольшими допустимыми углами наклона и возможный вид отверстия для 

детали позиции 1, а на рис. Д.40, г – то же самое для детали позиции 2. 

Рис. Д.40 

а б 

в г 

Рис. Д.39 
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Результат соединения деталей с показанными 

на рис. Д.40, в и г углами наклона осей отверстий 

приведен на рис. Д.41. Видно, что винт установить 

проблематично. 

Существует несколько способов решения этой 

проблемы: 

– увеличить диаметр отверстия в детали пози-

ции 1, но этом может оказаться неприемлемым по условиям функционирова-

ния изделия; 

– уменьшить позиционный допуск отверстия в детали позиции 2, но это 

может увеличить стоимость изготовления; 

– указать дополнительный допуск перпендикулярности оси отверстия с 

меньшим значением, чем допускается в указанном позиционном допуске, но 

это также может увеличить стоимость изготовления; 

– использовать выступающее поле допуска расположения – поле или 

часть его, ограничивающее отклонение расположения рассматриваемого 

элемента за пределами протяженности этого элемента (нормируемый участок 

выступает за пределы длины элемента). 

Выступающее поле допуска расположения обозначается буквой P в 

окружности. Контур выступающей части нормируемого элемента ограничи-

вают тонкой сплошной линией, а длину и расположение выступающего поля 

допуска – размерами (рис. Д.42). 

 

Минимальная высота выступающего поля допуска над поверхностью 

детали, в которую вворачивается крепежной изделие, для обеспечения воз-

можности соединений типа B: 

– для винтов (болтов) – максимально допустимая толщина сопрягаемой 

детали (деталей); 

– для шпилек (штифтов) – максимальная длина их выступающей части. 

Рис. Д.42 [46] 

Рис. Д.41 
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Указание выступающего поля позиционного допуска в детали позиции 2 

с величиной, равной толщине детали позиции 1 в месте соединения, показано 

на рис. Д.43, а, а расположения выявленных осей отверстия с наибольшими 

допустимыми углами наклона для него – на рис. Д.43, б. 

Результат соединения приведен на рис. Д.43, в. Видно, что винт устано-

вить можно. 

Д.8. Нанесение надписей, ТТ и таблиц 

К основным правилам нанесения надписей, ТТ и таблиц в графических 

документах, которые устанавливает ГОСТ Р 2.316–2023, можно отнести сле-

дующие: 

1. Графический документ, кроме изображения изделия с размерами, 

предельными отклонениями и другими параметрами, может содержать: 

– текстовую часть, состоящую из ТТ и (или) технических характеристик; 

– надписи с обозначением изображений, а также относящиеся к отдель-

ным элементам изделия; 

– таблицы с размерами и другими параметрами, ТТ, контрольными ком-

плексами, условными обозначениями и т. д. 

2. Текстовую часть, надписи и таблицы включают в графические доку-

менты в тех случаях, когда содержащиеся в них данные, указания и разъяс-

Рис. Д.43 

б а 

в 
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нения невозможно или нецелесообразно выразить графически или условны-

ми обозначениями. 

3. Содержание текста и надписей должно быть кратким и точным. 

4. Около изображений на полках линий-выносок наносят только краткие 

надписи, относящиеся непосредственно к изображению изделия, например 

указания о количестве конструктивных элементов (отверстий, канавок и 

т. п.), если они не внесены в таблицу, а также указания лицевой стороны, 

направления проката, волокон и т. п. 

5. Линию-выноску, пересекающую контур изображения и не отводимую 

от какой-либо линии, заканчивают точкой (рис. Д.44, а и б). 

 

Линию-выноску, отводимую от линий видимого и невидимого контура, 

а также от линий, обозначающих поверхности, заканчивают стрелкой (рис. 

Д.44, б). 

На конце линии-выноски, отводимой от всех других линий, не должно 

быть ни стрелки, ни точки (рис. Д.44, в). 

6. Линии-выноски не должны пересекаться между собой, должны быть 

непараллельными линиям штриховки (если линия-выноска проходят по за-

штрихованному полю) и не должны пересекать, по возможности, размерные 

линии и элементы изображения, к которым не относится помещенная на пол-

ке надпись. 

Рис. Д.44 [16] 

в 

а 

б 

г д е ж 
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Допускается выполнять линии-выноски с изломами (см. рис. Д.44, г) и 

проводить от одной полки две и более линии-выноски (см. рис. Д.44, д), при 

этом не должно нарушаться восприятие (ясность) изображения. 

7. При выполнении линии-выноски с одной полкой надписи, относящие-

ся непосредственно к изображению, могут содержать не более двух строк, 

располагаемых над полкой линии-выноски и под ней. 

Допускается выполнять линии-выноски с несколькими полками (см. рис. 

Д.44, е). В этом случае надписи могут содержать строки, располагаемые над 

полками линии-выноски. 

Допускается, при необходимости помещения большого объема надпи-

сей, выполнять линии-выноски с рамкой (см. рис. Д.44, ж). В этом случае 

надписи могут содержать строки, располагаемые в рамке без междустрочных 

разделителей. 

8. Текстовую часть располагают над основной надписью и выполняют в 

соответствии с ГОСТ Р 2.105–2019. 

Между текстовой частью и основной надписью не допускается поме-

щать изображения, таблицы и т. п. 

На листах формата более А4 допускается размещение текста в несколько 

колонок. Ширина колонки не должна превышать 185 мм. 

9. По Р ГОСТ 2.105–2019 расстояние от рамки до границ текста в начале 

и в конце строк должно быть не менее 3 мм, а расстояние от верхней или 

нижней строки текста до верхней или нижней рамки – не менее 10 мм. 

10. ТТ излагают, группируя вместе однородные и близкие по своему ха-

рактеру требования: 

– требования к материалу, заготовке, термической обработке; 

– размеры, предельные отклонения размеров, формы и взаимного распо-

ложения поверхностей, массы и т. п.; 

– требования к качеству поверхностей, указания об их покрытии; 

– требования к настройке и регулированию изделия; 

– ссылки на другие документы, содержащие ТТ, и др. 

11. Пункты ТТ должны иметь сквозную нумерацию. Каждый пункт ТТ 

записывают с новой строки. 

12. При выполнении графического документа на двух и более листах 

текстовую часть помещают только на первом листе независимо от того, на 

каких листах находятся изображения, к которым относятся указания, приве-

денные в текстовой части. 
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Надписи, относящиеся к отдельным элементам изделия и наносимые на 

полках линий-выносок, помещают на тех листах чертежа, на которых они яв-

ляются наиболее необходимыми для удобства чтения. 

13. Для обозначения изображений (видов, разрезов, сечений), поверхно-

стей, размеров и других элементов изделия применяют прописные буквы 

русского алфавита, за исключением букв Е, З, Й, О, Ч, X, Ъ, Ы, Ь, и, при 

необходимости, буквы латинского алфавита, исключая буквы I, О, V, X. 

Предпочтительно обозначать сначала изображения. 

В случае недостатка букв применяют цифровую индексацию, например: 

А, А1, А2, Б–Б, Б1–Б1, Б2–Б2. 

Буквенные обозначения не подчеркивают. 

14. Размер шрифта буквенных обозначений должен быть больше разме-

ра цифр размерных чисел, применяемых в том же графическом документе, 

примерно в два раза. 

15. Масштаб изображения, отличающийся от указанного в основной 

надписи, записывают непосредственно после надписи, относящейся к изоб-

ражению, например: А–А(1:1), Б(5:1), А(2:1). 

16. Если в графическом документе отыскание дополнительных изобра-

жений (сечений, разрезов, видов, выносных элементов) затруднено вслед-

ствие большой их насыщенности или выполнения графического документа 

на двух и более листах, то у обозначения дополнительных изображений ука-

зывают номера листов, на которых эти изображения помещены. 

В этих случаях над дополнительными изображениями у их обозначений 

указывают номера листов или обозначения зон, на которых дополнительные 

изображения отмечены, например: А–А(1:2)(1), Г(2). 

Д.9. Шероховатость поверхности 

Термины и определения основных понятий, относящихся к шероховато-

сти поверхности, устанавливает ГОСТ 25142–82 [160]: 

– шероховатость поверхности – это совокупность неровностей по-

верхности с относительно малыми шагами, выделенная, например, с помо-

щью базовой длины. Другими словами, шероховатость поверхности – сово-

купность неровностей поверхности, образующих рельеф поверхности в пре-

делах рассматриваемого участка; 

– реальная поверхность – поверхность, ограничивающая тело и отде-

ляющая его от окружающей среды (условно показана на рис. Д.45, а); 
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– номинальная поверхность – поверхность, за-

данная в технической документации без учета допуска-

емых отклонений и неровностей (рис. Д.45, б); 

– профиль поверхности – линия пересечения по-

верхности с плоскостью; 

– отклонение профиля – расстояние между точ-

кой профиля и базовой линией; 

– базовая линия – линия, определенным образом 

проведенная относительно профиля и служащая для 

оценки геометрических параметров поверхности; 

– средняя линия профиля – базовая линия, имеющая форму номиналь-

ного профиля и проведенная так, что в пределах базовой длины среднее 

квадратическое отклонение профиля до этой линии минимально; 

– базовая длина – длина базовой линии, используемая для выделения 

неровностей, характеризующих шероховатость поверхности; 

– высота неровностей профиля по десяти точкам (Rz) – сумма сред-

них абсолютных значений высот пяти наибольших выступов профиля и глу-

бин пяти наибольших впадин профиля в пределах базовой длины; 

– среднеарифметическое отклонение профиля (Ra) – среднеарифме-

тическое абсолютных значений отклонений профиля в пределах базовой 

длины. 

На рис. Д.46 показано условное сечение реальной поверхности с высту-

пами и впадинами профиля. По оси Y отложено отклонение профиля, т. е. 

расстояние между точкой профиля и базовой линией. 

 

Параметр Ra является предпочтительным, так как он удобен для измере-

ния профилометрами. Когда контроль параметра Ra затруднен или невозмо-

жен (например, при сложной форме поверхности), используют параметр Rz. 

Шероховатость поверхностей в основном определяется функциональ-

ными требованиями, предъявляемыми к ним. Например, если имеется непо-

Рис. Д.46 [160] 

Рис. Д.45 [160] 

а 

б 
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движное соединение и подвижное (одной и той же точности), то во втором 

случае неровности рельефа при функционировании будут снашиваться, что 

приведет к изменению характера сопряжения. Поэтому при подвижном со-

единении следует задавать меньшую шероховатость поверхностей, так как 

при этом на той же длине будет больше выступов, а сами выступы – ниже, 

что обеспечит большую стабильность характера сопряжения. 

На практике правильно заданная шероховатость в значительной степени 

определяет экономичность изделия: излишне высокое качество поверхностей 

требует больших затрат на изготовление, а низкое качество приводит к преж-

девременному выходу изделия из строя [161]. 

К основным правилам обозначения и нанесения шероховатости поверх-

ностей на чертежах изделий, которые устанавливает ГОСТ 2.309–73 [162], 

можно отнести следующие: 

1. Шероховатость поверхностей обозначают на чертеже для всех выпол-

няемых по данному чертежу поверхностей изделия, независимо от методов 

их образования, кроме поверхностей, шероховатость которых не обусловлена 

требованиями конструкции. 

2. Структура обозначения шероховатости поверхности приведена на 

рис. Д.47. При применении знака без указания параметра и способа обработ-

ки его изображают без полки. 

 

 Рис. Д.48 [162] 

а б в 

Рис. Д.47 [162] 
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3. В обозначении шероховатости поверхности применяют один из зна-

ков, изображенных на рис. Д.48. 

Высота h должна быть примерно равна применяемой на чертеже высоте 

цифр размерных чисел, а высота H – (1,5…5)h. Толщина линий знаков долж-

на быть приблизительно равна половине толщины сплошной основной ли-

нии, применяемой на чертеже. 

В обозначении шероховатости поверхности, способ обработки которой 

не устанавливается, применяют знак с рис. Д.48, а. 

В обозначении шероховатости поверхности, образованной только уда-

лением слоя материала, применяют знак с рис. Д.48, б. 

В обозначении шероховатости поверхности, образованной без удаления 

слоя материала, применяют знак с рис. Д.48, в, с указанием значения пара-

метра шероховатости. 

4. Поверхности детали из материала определенного профиля и размера, 

не подлежащие по данному чертежу дополнительной обработке, отмечаются 

знаком с рис. Д.48, в без указания параметра шероховатости. 

Состояние такой поверхности должно соответствовать требованиям, 

установленным соответствующим стандартом или техническими условиями, 

или другими документами, причем на этот документ должна быть приведена 

ссылка, например, в виде указания сортамента материала в графе 3 основной 

надписи чертежа (см. рис. 3.6, а и табл. 3.1). 

5. Значение параметра шероховатости указывают в обозначении шеро-

ховатости после соответствующего символа, например: Ra 3,2. 

При указании наибольшего значения параметра шероховатости в обо-

значении приводят параметр шероховатости без предельных отклонений. 

6. Обозначения шероховатости поверхностей на изображении (рис. Д.49) 

изделия располагают на линиях контура, вынос-

ных линиях (по возможности ближе к размерной 

линии) или на полках линий-выносок. 

Допускается при недостатке места распола-

гать обозначение шероховатости на размерных 

линиях или на их продолжениях, на рамке допус-

ка формы, а также разрывать выносную линию. 

7. Обозначения шероховатости поверхности, в которых знак имеет пол-

ку, располагают относительно основной надписи чертежа так, как показано 

на рис. Д.50, а и б. 

Рис. Д.49 [162] 
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8. При указании одинаковой шероховатости для всех поверхностей из-

делия обозначение шероховатости помещают в правом верхнем углу чертежа 

и на изображении не наносят (рис. Д.51, а). 

Размеры и толщина линий знака в обозначении шероховатости должна 

быть приблизительно в 1,5 раза больше, чем в обозначениях, нанесенных на 

изображении. 

 

9. Обозначение шероховатости, одинаковой для части поверхностей из-

делия, может быть помещено в правом верхнем углу чертежа вместе с услов-

ным обозначением с рис. Д.48, а в скобках (рис. Д.51, б и в). 

Размеры знака, взятого в скобки, должны быть одинаковыми с размера-

ми знаков, нанесенных на изображении. 

Таблица Д.4 

Значения параметра Ra для некоторых видов обработки 

Ra, мкм 
Характеристика  

поверхности 
Вид обработки 

100 

Грубо обработанная 

Необработанные или грубо обработанные  

поверхности детали, опиливание драчевыми  

напильниками, отпиливание, черновое точение,  

предварительное строгание 

50 

25 

Рис. Д.50 [162] 

а б 

Рис. Д.51 [162] 

а в б 
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Окончание таблицы Д.4 

Ra, мкм 
Характеристика  

поверхности 
Вид обработки 

12,5 
Маловидимые следы  

обработки 

Предварительное и чистовое фрезерование,  

чистовое точение, чистовое строгание, сверление, 

зенкерование, опиливание личным напильником 

6,3 

3,2 

1,6 
Следы обработки  

незаметны  

невооруженным глазом 

Тонкое строгание, предварительное и чистовое  

шлифование, развертывание, опиливание бархатным 

напильником, грубая притирка 

0,8 

0,4 

0,2 

Высокая степень  

гладкости 

Полирование, тонкое шлифование, средняя и тонкая 

притирка, ручная доводка, опиливание бархатным 

напильником с полировкой мелким  

и тонким наждаком 

0,1 

0,05 

0,025 

0,012 

В табл. Д.4 из [153] и [154] приведено соответствие между предпочти-

тельными значениями параметра Ra и характерными видами обработки. 

Некоторые виды обработки, не указанные в пояснении к табл. Д.2: 

– притирка – операция по чистовой обработке поверхностей изделия, 

выполняемая с помощью абразивных материалов в виде порошков или паст 

для получения плотных, герметичных разъемных и подвижных соединений. 

Является более точной операцией, чем шабрение; 

– доводка – разновидность притирки, предназначена для получения не 

только требуемых форм и шероховатости поверхности, но и заданных разме-

ров деталей с высокой точностью (5-й и 6-й квалитеты). 
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Е. Эскиз «модуля усилителя» 

Е.1. Содержание этапа проектирования 

В данном приложении предлагается выполнить 1-й дополнительный 

этап проектирования, заключающийся в создании упрощенного эскиза «мо-

дуля усилителя» одним из двух способов: 

а) без использования 3D-модели «модуля усилителя» от руки или в лю-

бом пригодном для этого графическом редакторе с достаточным для понима-

ния структуры изделия количеством видов в соответствии с требованиями 

ЕСКД (см. прил. Д) и с обозначением составных частей; 

б) с использованием 3D-модели «модуля усилителя» в КОМПАС-3D в 

следующей последовательности: 

1. Сформировать упрощенную 3D-модель «усилителя»: 

1.1. В папке с 3D-моделью «усили-

теля» создать новую папку, после чего 

скопировать в нее файлы с расширения-

ми «.brd» и «.pro» и изменить их назва-

ния (при этом они обязательно должны 

быть одинаковыми). 

Результат в варианте «П1» показан 

рис. Е.1. 

1.2. Изменить высоту компонентов, 

для чего выполнить следующее: 

– открыть скопированный файл с 

расширением «.pro» в Microsoft Word; 

– открыть окно Найти и заменить комбинацией клавиш Ctrl+H (или на 

вкладке Главная из раздела Редактирование запустить команду Заменить); 

– задать высоту компонентов 1 мм, для чего заполнить поля Найти и 

Заменить на в соответствии с рис. Е.2 (после символов MM должен быть 

пробел) и нажать кнопку Заменить все. 

Примечания:  

– группы символов «^?» (любой знак) и 

«^p» (знак абзаца, т. е. конец текущей 

строки и переход на новую) можно доба-

вить из списка, появляющегося при нажа-

тии кнопки «Специальный»; 

Рис. Е.1 

Рис. Е.2 
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– число групп символов «^?» равно восьми (два знака до десятичного 

разделителя и четыре после него, сам знак и возможный знак абзаца); 

– исходные значения высот в файле с расширением «.pro» записывают-

ся на основании 3D-моделей из посадочных мест компонентов. 

– задать высоту КП 0,1 мм, для чего за-

полнить поля Найти и Заменить на в соот-

ветствии с рис. Е.3 и нажать кнопку Заме-

нить все. 

Примечание. Строку можно скопиро-

вать прямо из документа, не закрывая окно «Найти и заменить»; 

– закрыть окно Найти и заменить; 

– сохранить изменения в документе, подтвердив потерю отдельных 

свойств документа при преобразовании его в обычный текст, после чего за-

крыть Microsoft Word. 

1.3. В КОМПАС-3D запустить 3D-конвертер Altium Designer-КОМ-

ПАС (см. п. 3.1 из 13.1) и в открывшемся окне Конвертер eCAD-КОМПАС 

(3D) выполнить следующее: 

– кнопкой Файл около поля Исходные данные указать скопированный 

файл с расширением «.brd»; 

– появившийся путь в поле Модель платы оставить по умолчанию; 

– отключить опцию Только монтажные отверстия; 

– выбрать опцию Условная габа-

ритная модель платы и нажать кнопку 

Создать. 

1.4. В появившемся окне Единица 

измерения высот компонентов вклю-

чить опцию mm и нажать OK. 

В результате будет создана 3D-

модель «усилителя» с компонентами в 

виде параллелепипедов (рис. Е.4). 

1.5. Cкрыть Начало координат и зафиксировать группу Компоненты. 

1.6. Войти в режим контекстного редактирования компонента Панель, 

после чего войти в режим редактирования эскиза (Эскиз:1) и удалить в нем 

все отверстия, кроме крепежных. 

Затем выйти из режима редактирования эскиза и из режима контекстно-

го редактирования компонента Панель. 

Рис. Е.3 

Рис. Е.4 
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1.7. В «усилителе» оставить следующие составные части: Панель, вход-

ные и выходные КП, несколько любых компонентов по усмотрению. 

Остальные компоненты в Дереве модели исключить из расчета. 

1.8. В Дереве модели изменить наименование 3D-модели сборки на имя 

файла (см. п. 5 из 13.1) и сохранить изменения (Ctrl+S). 

Результат в варианте «П1» на данном этапе показан на рис. Е.5. 

 

2. Упростить 3D-модель «экрана». 

Так как упрощение в 3D-модели «экрана» будет заключаться в отключе-

нии некоторых операций (выдавливание, вырезание и др.), то предлагается не 

создавать упрощенную версию в виде отдельного файла, а внести изменения 

в уже созданную 3D-модель, использовав для перехода между ее версиями 

переменную. 

Для этого выполнить следующие действия: 

2.1. В КОМПАС-3D открыть 3D-модель «экрана» (расположение указа-

но в п. 7 из разд. 14). 

2.2. Нажать пиктограмму Переменные на ПИ Стандартная или выпол-

нить команду Вид ⇒ Панели инструментов ⇒ Переменные. 

В результате появится окно Переменные, в котором в виде таблицы бу-

дут перечислены все операции, участвующие в построении 3D-модели, с пе-

ременными, присвоенными им по умолчанию. 

2.3. В варианте «П1» в упрощенной версии 3D-модели «экрана» будут 

оставлены только те операции, которые необходимы для получения его в ви-

де параллелепипеда с крепежными отверстиями. 

Рис. Е.5 
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Для этого в окне Переменные необходимо назначить собственную пе-

ременную тем операциям по построению 3D-модели, которые требуется ис-

ключить из расчета:  

– раскрыть группу с названием 3D-модели; 

– отдельно для каждой требуемой операции раскрыть соответствующую 

группу и в столбце Выражение для переменной, у которой в столбце Пара-

метр указано Исключить из расчета, ввести имя новой переменной Simple 

(после этого она автоматически появится в списке переменных 3D-модели 

сверху окна); 

– в списке переменных 3D-модели сверху окна на переменной Simple 

выполнить команду ПКМ ⇒ Внешняя, в результате чего фон ее ячейки из-

менится на синий, а сама переменная станет доступной для изменения в лю-

бой сборке, в которую будет установлена данная 3D-модель; 

– в столбце Комментарий кратко описать назначение переменной; 

– в столбце Выражение задать переменной значение 1 (то есть Истина); 

– нажать клавишу F5 (или выполнить команду Вид ⇒ Перестроить) и 

убедиться в том, что в Дереве модели исключены необходимые операции, а 

в рабочем поле показан упрощенный вариант 3D-модели (рис. Е.6); 

 Рис. Е.6 
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– в столбце Выражение вернуть значение переменной 0 (то есть Ложь); 

– нажать клавишу F5 и сохранить изменения (Ctrl+S). 

Примечание. Внешние переменные позволяют менять вид 3D-модели в 

сборке без изменений в исходном файле и других сборках. Например, если от-

крыть 3D-модель «модуля усилителя» и в «Дереве модели» для «экрана» ис-

ключить вручную операции, то в любой другой сборке и в 3D-модели «экра-

на», открытой в отдельном окне, эти операции также будут исключены. 

3. По п. 2 упростить 3D-модель «основания» (расположение указано в 

п. 4 из разд. 15). 

В варианте «П1» из расчета была исключена только последняя операция, 

отвечающая за прорези под штыревые выводы компонентов. Результат 

упрощения показан на рис. Е.7. 

 

Необходимо обратить внимание на то, что сохраненные 3D-модели 

«экрана» и «основания» должны быть без упрощений, т. е. со значением пе-

ременной Simple, равной 0. 

4. Упростить 3D-модель «модуля усилителя». 

Все необходимые изменения будут внесены в уже существующий файл с 

помощью создания в нем нового исполнения. 

Примечание. Исполнение 3D-модели в КОМПАС-3D – это один из ее ва-

риантов, обладающий общими конструктивными признаками и незначи-

тельно отличающийся от нее. 

Для этого выполнить следующее: 

4.1. В КОМПАС-3D открыть 3D-модель «модуля усилителя» (располо-

жение указано в п. 3 из разд. 14). 

Рис. Е.7 
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В появившемся окне с предложением перестроить сборку, так как были 

внесены изменения в 3D-модели «экрана» и «основания», нажать Да. 

4.2. В Дереве модели перейти на вкладку Исполнения и на названии 

«модуля усилителя» выполнить команду ПКМ ⇒ Создать исполнение. 

В Панели свойств на вкладке Параметры отключить опцию Зависи-

мое исполнение и нажать пиктограмму Создать объект. 

Примечание. Независимое исполнение – исполнение, на составные части 

которого не влияют изменения в базовом (исходном) исполнении. 

4.3. В Дереве модели на вкладке Исполнения (или в списке Управле-

ние исполнениями на ПИ Текущее состояние) выбрать ЛКМ созданное ис-

полнение, тем самым сделав его текущим. 

Примечание. Базовое исполнение и созданное отличаются номером в 

обозначении изделия (у созданного добавится «-01»). 

4.4. В Дереве модели перейти на вкладку Построение и выполнить сле-

дующие действия: 

– исключить из расчета все крепежные изделия; 

– исключить из расчета эскизы с топологией слоев ПП «усилителя»; 

– на «усилителе» выполнить команду ПКМ ⇒ Свойства компонента и 

в Панели свойств на вкладке Файл-источник рядом с полем Файл-источ-

ник нажать одноименную пиктограмму; 

– в открывшемся окне указать файл упрощенной 3D-модели «усилите-

ля» из п. 1 и открыть его; 

– нажать пиктограмму Создать объект. 

4.5. Открыть окно Переменные (см. п. 2.2), в котором для «экрана», 

«основания» и двух СВЧ-разъемов найти переменные с именами, заканчива-

ющимися на _Simple, после чего в столбце Выражение задать для них зна-

чение 1 и нажать клавишу F5. 

4.6. Переключиться на базовое исполнение и убедиться в том, что в нем 

ничего не поменялось. 

Затем переключиться на исполнение с упрощенной версией 3D-модели 

«модуля усилителя» и сохранить изменения (Ctrl+S). 

Результат в варианте «П1» на данном этапе показан на рис. Е.8. 

4.7. Закрыть вкладки с «экраном», «основанием» и упрощенной версией 

«усилителя», а также окно Переменные. 

5. Запустить команду Сервис ⇒ Разнести компоненты ⇒ Параметры 

и задать расстояния между составными частями «модуля усилителя». 
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Принцип работы с командой для всех компонентов одинаковый, поэто-

му далее он будет разобран только для «экрана». После запуска команды в 

Панели свойств выполнить следующие действия: 

– в окне Шаг разнесения нажать пиктограмму Добавить; 

– нажать пиктограмму Выбрать компоненты для разнесения; 

– в Дереве модели ЛКМ выбрать «экран», при этом в рабочем поле он 

окрасится в красный цвет; 

– нажать пиктограмму Объект направления разнесения; 

– в Дереве модели раскрыть группу Начало координат и выбрать ось, 

по которой планируется сдвинуть компонент (так как «экран» будет сдвинут 

вверх, то выбрать Ось Z); 

– в поле Расстояние ввести величину сдвига (например, 20 мм) и нажать 

клавишу Enter; 

– нажать пиктограмму Применить. 

Выполнить аналогичные действия для «усилителя» и СВЧ-разъемов, по-

сле чего завершить команду кнопкой Прервать команду. 

Рис. Е.8 
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При необходимости можно корректировать заданные ранее расстояния 

разнесения, выбирая соответствующую операцию в окне Шаг разнесения. 

О нахождении в режиме разнесения компонентов свидетельствует икон-

ка в правом верхнем углу рабочего поля. 

Результат разнесения в варианте «П1» показан на рис. Е.9. 

 

6. Сориентировать 3D-модель «модуля усилителя» с разнесенными ком-

понентами в рабочем поле так, как она будет выглядеть на эскизе, и сохра-

нить полученную ориентацию, добавив новый вид с помощью команды 

Вид ⇒ Ориентация и присвоив ему имя (например, Для эскиза). 

После этого сохранить изменения в 3D-модели (Ctrl+S). 

Примечание. Полезными могут оказаться следующие сочетания клавиш 

для поворота модели: 

– Ctrl+Shift+(Up или Down) – вверх или вниз в вертикальной плоскости, 

перпендикулярной плоскости экрана на угол из настроек. Для аналогичных 

поворотов на угол 90° служат комбинации Space+(Up или Down); 

– Ctrl+Shift+(Right или Left) – вправо или влево в горизонтальной плоско-

сти, перпендикулярной плоскости экрана на угол из настроек. Для аналогич-

ных поворотов на угол 90° служат комбинации Space+(Right или Left); 

– Alt+(Left или Right) – против часовой стрелки или по часовой стрелке в 

плоскости экрана на угол из настроек. Для аналогичных поворотов на угол 

90° служат комбинации Alt+(Up или Down). 

Угол поворота задается в поле «Шаг угла поворота модели» в окне 

«Параметры» (команда Сервис ⇒ Параметры) на вкладке «Система» в 

группе Редактор моделей ⇒ Управление изображением. 

Исходная ориентация 3D-модели – «Изометрия YZX» в списке видов. 

Рис. Е.9 

Режим разнесения 

компонентов 
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7. Создать эскиз из 3D-модели «модуля усилителя»: 

7.1. По информации из 7.1 создать новый чертеж и задать следующие 

настройки листа: 

– формат – A3; 

– ориентация – горизонтальная; 

– оформление – Без внутренней рамки. 

7.2. Сохранить чертеж командой Файл ⇒ Сохранить как с расширени-

ем «.cdw». Имя файла в варианте «П1» – имя ориентации из п. 6, а путь со-

хранения – созданная папка в п. 1.1. 

7.3. Убедиться в том, что включены глобальные привязки, задан шаг 

сетки 0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

7.4. Запустить команду Произвольный вид (см. рис. 7.6) из ПИ Ком-

пактная панель ⇒ Виды, выбрать 3D-модель «модуля усилителя» с испол-

нением «-01» и в Панели свойств на вкладке Параметры задать настройки: 

– в поле Ориентация главного вида – Для эскиза (задан в п. 6); 

– в поле Масштаб вида – 2:1. 

После этого разместить вид в рабочем поле. 

7.5. В Дереве чертежа на добавленном виде запустить команду ПКМ ⇒ 

Параметры вида, после чего в Панели свойств на вкладке Параметры 

нажать пиктограмму Разнесенный вид и завершить команду пиктограммой 

Создать объект. 

7.6. Перестроить чертеж клавишей F5. 

Результат в варианте «П1» на данном этапе показан на рис. Е.10. 

 

7.7. По примеру рис. 2.4 командой Отрезок из ПИ Компактная па-

нель ⇒ Геометрия показать условные обозначения винтов, а командой Ли-

Рис. Е.10 
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ния-выноска из ПИ Компактная панель ⇒ Обозначения (см. рис. 7.26) – 

обозначения составных частей. 

8. На вкладке с «модулем усилителя» переключиться на базовое испол-

нение и сохранить изменения (Ctrl+S). 

9. Удалить backup-файлы из папки, созданной в п. 1.1, и из папки 

…\ИДРЭС-П1\_Модели. 

10. В данном дополнительном этапе проектирования были внесены из-

менения в 3D-модели «экрана» и «основания». Если эти действия были со-

вершены после создания чертежей на указанные детали, то при их открытии 

появятся запросы на перестроение ассоциативных видов. 

В результате в чертеже «экрана» потребуется выполнить п. 28 из 20.1. 

Перестроение же чертежа «основания» не повлечет за собой дополнительных 

действий. 

Е.2. Содержание отчета 

По 1-му дополнительному этапу проектирования (см. табл. 2.3) в отчете 

необходимо привести рисунок эскиза «модуля усилителя» с обозначением 

составных частей, выполненный одним из двух способов, указанных в Е.1. 

При использовании сокращений дать их расшифровку. 
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Ж. Расчет коэффициента шума 

Ж.1. Теоретические сведения 

Фактор шума или шум-фактор ( F , noise factor) тестируемого устрой-

ства характеризует ухудшение отношения сигнал/шум при прохождении че-

рез него сигнала под действием собственных шумов.  

Численно шум-фактор равен отношению полной мощности шумов на 

выходе устройства к выходной мощности такого же идеального (не шумяще-

го) устройства при условии, что единственный источник входного шума в 

обоих случаях – тепловой шум согласованного сопротивления, находящегося 

при температуре 290 К: 
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где inS  и outS  – мощность сигнала на входе и выходе устройства соответ-

ственно, Вт; inN  и outN  – мощность шума на входе и выходе устройства со-

ответственно, Вт; К  – коэффициент передачи по мощности, разы; aN  – 

мощность собственных шумов, Вт [163], [164]. 

Наряду с шум-фактором широко используется величина коэффициент 

шума ( NF , noise figure) – шум-фактор, выраженный в децибелах. Связь ко-

эффициента шума и шум-фактора устанавливается выражениями: 

 FNF lg10= ; (Ж.1) 

 1010NFF = . (Ж.2) 

Для пассивного устройства (например, ПФ на МПЛ, аттенюатор) при 

идеальном согласовании по входу и выходу, когда его температура равна 

температуре источника сигнала, шум-фактор определяется выражением: 

 KF 1= . (Ж.3) 

Пересчет коэффициента передачи по мощности из децибелов в разы 

осуществляется по формуле: 

 1010GK = . (Ж.4) 

Для покупного активного устройства (например, микросхема усилителя) 

значение коэффициента шума указывается в документации производителя. 

Определение шум-фактора может применяться как к отдельным компо-

нентам, так и к системе в целом, состоящей из отдельных каскадов (функци-

ональных узлов). Например, разрабатываемый «модуль усилителя» является 

трехкаскадным, так как состоит из ПФ, усилителя и аттенюатора. 
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Шум-фактор многокаскадных систем ( sF ) определяется уравнением 

каскадного шума (формулой Фрииса): 
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где n  – число каскадов, шт.; nF  – шум-фактор n-го каскада, разы; 1−nK  – ко-

эффициент передачи по мощности ( 1−n )-го каскада, разы. 

Следует обратить внимание на то, что общий шум-фактор определяется 

в основном шум-фактором 1-го каскада, а также вторым слагаемым, называ-

емым вкладом 2-го каскада, если коэффициент передачи по мощности 1-го 

каскада мал. Поэтому для улучшения шумовых свойств системы стремятся к 

тому, чтобы 1-й каскад обладал большим усилением и малым коэффициен-

том шума. Например, приемники с высокой чувствительностью зачастую 

начинаются с малошумящего усилителя (LNA, low-noise amplifier). 

Ж.2. Порядок проведения расчетов 

В данном приложении предлагается выполнить 2-й дополнительный 

этап проектирования, заключающийся в расчете значения коэффициента шу-

ма «модуля усилителя»: 

1. Определить значения величин, указанных в табл. Ж.1 (необходимые 

для расчетов значения пфG , уG  и уровней ослабления микросхемы аттенюа-

тора были найдены в 3.3). 

Таблица Ж.1 

Величины для расчета коэффициента шума «модуля усилителя» 

Величина Назначение Способ определения 

пфK  Коэффициент передачи по мощности 

ПФ, разы 
Расчет по (Ж.4) 

уK  Коэффициент передачи по мощности 

микросхемы усилителя, разы 

пфF  Шум-фактор ПФ Расчет по (Ж.3) 

maxаF  
Максимальное значение шум-фактора 

микросхемы аттенюатора 
Расчет по (Ж.3) и (Ж.4) 

minаF  
Минимальное значение шум-фактора 

микросхемы аттенюатора 

уNF  Коэффициент шума микросхемы уси-

лителя, дБ 

По таблице п. 9.7 из 3.3 для заданной 

микросхемы усилителя на частоте 0F  

уF  Шум-фактор микросхемы усилителя Расчет по (Ж.2) 
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2. По (Ж.1) и (Ж.5) определить минимальное и максимальное значения 

коэффициента шума «модуля усилителя» ( minмуNF  и maxмуNF  соответ-

ственно). 

Стоит отметить, что так как изделие состоит из трех каскадов, то (Ж.5) 

будет состоять только из первых трех слагаемых. 

3. По (Ж.1) и (Ж.5) определить минимальное значение коэффициента 

шума «модуля усилителя» ( minмузNF ) при взаимной замене 1-го и 2-го кас-

кадов. 

Ж.3. Содержание отчета 

По 2-му дополнительному этапу проектирования (см. табл. 2.3) в отчете 

необходимо привести: 

1. Расчет минимального и максимального значений коэффициента шума 

«модуля усилителя» и всех величин из табл. Ж.1 с пояснениями. 

2. Расчет минимального значения коэффициента шума «модуля усили-

теля» при взаимной замене 1-го и 2-го каскадов. 

3. Выводы по результатам сравнения значений минимальных коэффици-

ентов шума из пп. 1 и 2, а также предположение о том, почему при проекти-

ровании в качестве 1-го каскада стоит ПФ. 
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И. Корректировка расчетов схемы «токового зеркала» 

И.1. Содержание этапа проектирования 

Расчет схемы «токового зеркала» (см. рис. 8.37) в п. 7.7 из 8.3 был вы-

полнен по приближенной формуле (8.1), не учитывающей разные условия, в 

которых оказываются транзисторы транзисторной сборки. На практике это 

приведет к тому, что при найденных номиналах резисторов R1–R3 ток кол-

лектора правого транзистора транзисторной сборки окажется меньше требу-

емого (см. А.4). 

В данном приложении предлагается выполнить 3-й дополнительный 

этап проектирования, состоящий из четырех частей: 

1. Первая часть заключается в выводе формулы в символьном виде для 

корректировки сопротивления резистора R2 из схемы на рис. 8.37. 

Вывод осуществляется с использованием закона Ома, правил Кирхгофа, 

(В.5), (В.6), формулы разности логарифмов, а также зависимости напряжения 

база–эмиттер транзистора от тока эмиттера, полученной из (В.2): 

 ЭrI
I

I
UmU +








+= Э

оЭ

Э
тЭБЭ 1ln , (И.1) 

где Эm  – коэффициент неидеальности ВАХ эмиттерного перехода; оЭI  – об-

ратный ток насыщенного эмиттерного перехода, А; Эr  – последовательное 

сопротивление потерь эмиттерного перехода, Ом. 

При выводе необходимо обратить внимание на следующее: 

– в (И.1) для упрощения итоговой формулы следует пренебречь вторым 

слагаемым с последовательным сопротивлением потерь и единицей под ло-

гарифмом, а также использовать вместо тока ЭI  ток КI ; 

– для токов и напряжений, относящихся к транзисторам транзисторной 

сборки, должны быть использованы индексы: «п» – для правого транзисто-

ра, «л» – для левого транзистора; 

– транзисторы в транзисторной сборке считать одинаковыми; 

– формула разности логарифмов: 

 ( )BABA logloglog =− ;  

– итоговая формула должна содержать только следующие известные ве-

личины в явном виде: КпI , R3I , R1, Эm , тU ,  .  

2. Вторая часть заключается в вычислении сопротивления резистора R2 

по выведенной в первой части этапа формуле. 
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Значения параметров транзисторов в транзисторной сборке BCV62A,215 

для температуры 25 °C: 01,1Э =m ; 100= ; 1=Эr  Ом; 14
оЭ 102 −=I  А. 

Значения КпI , R3I  и R1 определены в п. 7.7 из 8.3. 

Полученное значение сопротивления округлить в меньшую сторону не 

более чем на 3 % и выбрать номинал из ряда E48 или E96 (табл. И.1). 

Таблица И.1 

Значения номинальных рядов Е48 и Е96 

E48 E96 E48 E96 E48 E96 E48 E96 E48 E96 E48 E96 

100 100 147 147 215 215 316 316 464 464 681 681 

– 102 – 150 – 221 – 324 – 475 – 698 

105 105 154 154 226 226 332 332 487 487 715 715 

– 107 – 158 – 232 – 340 – 499 – 732 

110 110 162 162 237 237 348 348 511 511 750 750 

– 113 – 165 – 243 – 357 – 523 – 768 

115 115 169 169 249 249 365 365 536 536 787 787 

– 118 – 174 – 255 – 374 – 549 – 806 

121 121 178 178 261 261 383 383 562 562 825 825 

– 124 – 182 – 267 – 392 – 576 – 845 

127 127 187 187 274 274 402 402 590 590 866 866 

– 130 – 191 – 280 – 412 – 604 – 887 

133 133 196 196 287 287 422 422 619 619 909 909 

– 137 – 200 – 294 – 432 – 634 – 931 

140 140 205 205 301 301 442 442 649 649 953 953 

– 143 – 210 – 309 – 453 – 665 – 976 

Для резистора в том же типоразмере составить Part Number. Обратить 

внимание на допуск номинала из выбранного ряда по документации и В.1. 

Если не планируется выполнять 6-й дополнительный этап проектирова-

ния (см. табл. 2.3), то изменить четыре параметра резистора в схеме Э3 «уси-

лителя», а также скорректировать перечень элементов ПЭ3 «усилителя» и 

спецификацию на «усилитель» (при их наличии). Затем сохранить изменен-

ные КД в основных форматах и в формате PDF с новыми версиями. Прошлые 

версии файлов можно удалить. 

3. Третья часть заключается в определении по схеме с рис. 8.37 с учетом 

скорректированного номинала резистора R2 следующих токов и напряжений: 

R1I , R1U , R2I , R2U , 3RU , БЭлU , БлI , КЭлU , КлI , БЭпU , БпI , КЭпU , тзI . 
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Известными величинами кроме найденного сопротивления резистора R2 

являются: КпI , R3I , КпU , тзU , R3, R1 (см. п. 7.7 из 8.3). 

4. Четвертая часть заключается в формулировке двух условий, при неза-

висимом выполнении которых расчеты в схеме «токового зеркала», выпол-

ненные по приближенной формуле на этапе создания схемы Э3 «усилителя», 

будут получаться достаточно точными, и их не потребуется корректировать. 

И.2. Содержание отчета 

По первой части 3-го дополнительного этапа проектирования (см. табл. 

2.3) в отчете необходимо привести полный вывод формулы для расчета ука-

занного в п. 1 из И.1 сопротивления резистора с расшифровкой всех исполь-

зованных величин. 

По второй части 3-го дополнительного этапа проектирования (см. табл. 

2.3) в отчете необходимо привести: 

1. Расчет сопротивления резистора по выведенной в первой части этапа 

формуле с подставленными числовыми значениями величин. 

2. Сравнение результата расчета со значением, полученным до коррек-

тировки (см. п. 7.7.5 из 8.3). 

3. Part Number резистора. 

4. На отдельных листах последние версии скорректированных КД и опи-

сание произведенных изменений в том случае, если 6-й дополнительный этап 

проектирования выполняться не будет. 

По третьей части 3-го дополнительного этапа проектирования (см. табл. 

2.3) в отчете необходимо привести: 

1. Расчеты указанных в п. 3 из И.1 токов и напряжений. 

2. На отдельном рисунке направления протекания токов в схеме «токо-

вого зеркала», в том числе на двух разветвлениях и на всех выводах транзи-

сторов внутри транзисторной сборки. 

По четвертой части 3-го дополнительного этапа проектирования (см. 

табл. 2.3) в отчете необходимо привести требуемые в п. 4 из И.1 условия с 

пояснениями. 
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К. Схема электрическая функциональная 

К.1. Общие сведения 

Определения терминам схема и схема электрическая были даны в 3.1. 

Схема функциональная – документ, разъясняющий процессы, протека-

ющие в отдельных функциональных цепях изделия (установки) или изделия 

(установки) в целом. Код этого типа схемы – 2. Такими схемами пользуются 

для изучения принципов работы изделий (установок), а также при их налад-

ке, контроле и ремонте. 

Общий код для схемы электрической функциональной – Э2. 

К основным правилам оформления схем Э2 по ГОСТ 2.702–2011 отно-

сятся следующие: 

1. На схеме изображают функциональные части изделия (элементы, 

устройства и функциональные группы), участвующие в процессе, иллюстри-

руемом схемой, и связи между этими частями. 

По сравнению со схемой Э1 в схеме Э2 подробно раскрывают функции 

отдельных элементов и устройств. 

2. Функциональные части и взаимосвязи между ними на схеме изобра-

жают в виде УГО, установленных в стандартах ЕСКД. 

Отдельные функциональные части допускается изображать в виде пря-

моугольников. 

3. Графическое построение схемы должно давать наиболее наглядное 

представление о последовательности процессов, иллюстрируемых схемой. 

4. На схеме следует указывать: 

– для каждой функциональной группы – обозначение, присвоенное ей на 

принципиальной схеме, и (или) ее наименование (если функциональная 

группа изображена в виде УГО, то ее наименование не указывают); 

– для каждого устройства, изображенного в виде прямоугольника, – по-

зиционное обозначение, присвоенное ему на принципиальной схеме, его 

наименование и тип и (или) обозначение документа (основной КД, стандарт, 

технические условия), на основании которого это устройство применено; 

– для каждого устройства, изображенного в виде УГО, – позиционное 

обозначение, присвоенное ему на принципиальной схеме, его тип и (или) 

обозначение документа; 

– для каждого элемента – позиционное обозначение, присвоенное ему на 

принципиальной схеме, и (или) его тип. 
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Обозначение документа, на основании которого применено устройство, 

и тип элемента допускается не указывать. 

Наименования, типы и обозначения рекомендуется вписывать в прямо-

угольники. 

5. Схему Э2 можно условно представить как промежуточную между Э1 

и Э3, поэтому для нее справедливы и их правила оформления (см. 3.1 и 8.1). 

Функциональные схемы применяются, как правило, совместно с прин-

ципиальными, поэтому позиционные обозначения элементов и устройств на 

этих документах совпадают. Поэтому в этом случае отдельный перечень эле-

ментов для функциональной схемы не разрабатывают [165], [166]. 

К.2. Создание схемы Э2 

В данном приложении предлагается выполнить 4-й дополнительный 

этап проектирования, заключающийся в разработке схемы Э2 «усилителя». 

Так как в схеме Э2 будут компоненты из схемы Э3 «усилителя» (см. 

разд. 8), то имеет смысл создать ее на основе последней, заменив отдельные 

функциональные части изображениями, использованными в схеме Э1 (см. 

разд. 3). Поэтому рекомендуется следующий порядок действий: 

1. Сделать копию файла схемы Э3 «усилителя», изменить его имя и пе-

реместить файл в папку …\ИДРЭС-П1\Усилитель. 

В варианте «П1» – «УП1.01.01Э2 - Усилитель - v0.1». 

2. Открыть файлы схем Э2 «усилителя» и Э1 «модуля усилителя» в Al-

tium Designer (см. п. 2 из 10.1). 

3. В схеме Э2 в основной надписи рамки скорректировать значения двух 

параметров (вкладка Parameters в окне, вызываемом командой Design ⇒ 

Document Options). 

Примечание. Так как схема Э2 не входит в состав проекта (Free Docu-

ment), то созданного параметра в п. 5.2 из 8.2 не будет, и его значение по-

требуется ввести вручную вместо ссылки. 

4. Изменить состав компонентов из схемы Э2 с учетом следующего: 

4.1. Должно быть раскрыто содержание функциональных частей: 

– усилитель; 

– узел вторичного питания (см. п. 4.2); 

– узел управления (при наличии). 

Остальные функциональные части представить в виде изображений, ско-

пированных из схемы Э1 «модуля усилителя». 
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 Рис. К.1 
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Примечание. Линии электрической связи до скопированных изображе-

ний из схемы Э1 «модуля усилителя» рекомендуется проводить заново. 

4.2. В узле вторичного питания должны быть полностью раскрыты сле-

дующие его составные части с указанием наименований: 

– ЗП; 

– ИПС (при наличии); 

– параметрический стабилизатор напряжения (при наличии). 

Микросхему стабилизатора и относящиеся к нему компоненты предста-

вить в виде прямоугольного контура с названием. 

5. Узел вторичного питания и раскрытые его составные части обвести 

контурами из штрихпунктирных линий с параметрами по п. 4.5 из 8.3. 

6. Удалить метки цепей и расшифровку дополнительной функции. 

7. Для сокращений и условных наименований привести их расшифровку. 

8. Добавить значения всех напряжений и токов, вычисленных при созда-

нии схемы Э3 «усилителя» в 8.3. 

9. При необходимости уменьшить формат листа, заменив рамку на A4-1-

ИДРЭС-AD.SchDot (см. п. 3 из 3.2.3). 

Чтобы значения параметров не изменились, в окне Update Template 

необходимо выбрать опцию Do not update any parameters (не обновлять па-

раметры) или Add new parameters that exist in the template only (добавить 

только те параметры, которые отсутствуют в заменяемой рамке). 

10. Сохранить изменения в схеме (Ctrl+S). 

Результат в варианте «П1» показан на рис. К.1. 

11. В папке …\ИДРЭС-П1\Усилитель удалить папку History с резерв-

ными копиями файла схемы Э2. 

12. Сохранить схему в формате PDF по 8.4. 

Имя файла в варианте «П1» – «УП1.01.01Э2 - Усилитель - v0.1», а путь 

сохранения – …\ИДРЭС-П1\Усилитель\_pdf. 

К.3. Содержание отчета 

По 4-му дополнительному этапу проектирования (см. табл. 2.3) в отчете 

необходимо привести: 

1. Схему Э2 «усилителя», распечатанную на отдельном листе. 

2. Описание изменения (с поясняющим рисунком), которое потребова-

лось бы выполнить при включении схемы Э2 «усилителя» в комплект КД. 
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Л. Файлы форматов Gerber и Excellon 

Л.1. Основания для использования 

Производители могут принимать заказы на изготовление ПП в виде 

файлов с расширениями тех программ для трассировки, которыми пользуют-

ся разработчики (например, для Altium Designer – «.PcbDoc», для P-CAD –

 «.pcb»). Однако это нехорошая практика по следующим причинам: 

– у производителя не может быть абсолютно всех программ, которыми 

пользуются разработчики; 

– версия одной и той же программы у производителя и разработчика 

может отличаться, что иногда приводит к ошибкам; 

– некоторые внутренние настройки файла трассировки могут понимать-

ся производителем не совсем так, как задумывал разработчик; 

– в файле трассировки обычно содержится полная информация о разме-

щаемых компонентах и связях между ними, которую в случае уникальных 

схемных решений разработчику не получится сохранить в тайне. 

Решением является представление проекта ПП в стандартных форматах, 

которыми пользуются производители. Во всем мире де-факто такими стан-

дартами являются языки управления фотоплоттером компании Gerber Scien-

tific (формат Gerber) и сверлильным оборудованием компании Excellon Au-

tomation Company (формат Excellon). 

Л.2. Формат Gerber 

Формат Gerber разработан основателем компании Джозефом Гербером 

для векторных фотоплоттеров в начале 1980-х годов в версии RS-274D 

(«стандартный Gerber»).  

В упрощенной структуре фотоплоттера на рис. Л.1 показаны следующие 

его составные части: 

– координатный стол, перемещаемый по двум осям, на котором закреп-

ляется фотошаблон; 

– оптическая система, образованная источником света высокой яркости, 

затвором, коллимирующей и фокусирующей оптикой; 

– апертурный диск с апертурами (отверстиями определенной формы и 

размеров). 

Луч света, проходя через систему оптики и апертурный диск, при от-

крытом затворе оставляет на фотошаблоне пятно с формой апертуры. Требу-

емая в данный момент апертура выбирается поворотом апертурного диска. 
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При движении координатного стола на фотошаблоне вычерчивается ли-

ния с соответствующей толщиной и формой концов. 

Таким образом, для получения изображения на фотошаблоне программа 

должна состоять из команд, которые управляют затвором, положением коор-

динатного стола и выбором апертуры. Это и было заложено в «стандартном 

Gerber». 

Позднее, с развитием технологий растровых фотоплоттеров, появилась и 

новая спецификация Gerber-файлов, в частности поддерживающая формиро-

вание полигонов. К середине 1990-х годов формат Gerber был поддержан ря-

дом ведущих производителей оборудования и систем проектирования ПП. 

Современной версией является RS-274X («расширенный Gerber»), которая 

обновляется и публикуется компанией Ucamco. 

Файл трассировки, преобразованный в формат Gerber, представляет со-

бой набор текстовых файлов, каждый из которых описывает только один 

слой ПП независимо от его назначения. 

Примечание. Расширения Gerber-файлов, созданных в Altium Designer, 

состоят из буквы G (Gerber) и одного или двух символов, характеризующих 

слой (примеры расширений приведены в табл. Л.1). 

В версии RS-274X каждый файл представляет собой законченную про-

грамму, не требующую каких-либо дополнительных файлов или внешних 

параметров (например, в версии RS-274D требовался отдельный файл с опи-

санием апертур). При выполнении программы коды считываются и выпол-

няются последовательно без возвратов к ранее выполненным командам. 

Рис. Л.1 
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Таблица Л.1 

Расширения некоторых Gerber-файлов, получаемых из Altium Designer 

Слой Расширение 

Top Overlay «.GTO» 

Top Solder «.GTS» 

Top Paste «.GTP» 

Top Layer «.GTL» 

Внутренние слои в МПП «.G1», «.G2», «.G3», … 

Bottom Layer «.GBL» 

Bottom Paste «.GBP» 

Bottom Solder «.GBS» 

Bottom Overlay «.GBO» 

Механические слои «.GM1», «.GM2», «.GM3», … 

Формат Gerber является векторным форматом, т. е. по его данным фор-

мируется изображение, не зависящее от разрешения [167], [168]. 

Всю информацию в Gerber-файле можно разделить на две группы: коор-

динаты и команды. 

Координаты определяют точку по осям X и Y, в которой будет соверше-

но какое-либо действие (например, X00840000Y00066000). Для минимизации 

количества байтов, необходимых для представления данных, при записи ко-

ординат используется несколько особенностей: 

1. Вместо десятичной точки во всем файле специальной командой ука-

зывается только число знаков целой и дробной частей. Так, указанные выше 

координаты записаны в формате 4:4 (по оси X – 84,0 мм, по оси Y – 6,6 мм). 

2. Во всем файле задается подавление нулей (zero suppression) – ведущих 

(leading) или замыкающих (trailing). Например, указанные выше координаты 

без подавления нулей можно преобразовать в следующие виды: 

– с подавлением ведущих нулей – X840000Y66000; 

– с подавлением замыкающих нулей – X0084Y00066. 

3. Модальность координат, что означает запоминание последнего значе-

ния координаты. Если оно не поменяется на следующем шаге, то оно не за-

писывается. Например, при перемещении из точки с координатами (5; 6) в 

точку (8; 6) для второй точки указывается только координата X. 

Каждая строка в Gerber-файле завершается знаком «*» и содержит в яв-

ном виде команды и (или) координаты (некоторые команды модальны). 

Все команды можно разделить на две группы: команды функциональ-

ных кодов и команды расширенных кодов. 
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Различают три группы команд функциональных кодов: 

– D-коды (рисование и выбор апертуры); 

– G-коды (подготовительные операции); 

– M-коды (вспомогательные коды). 

Примеры таких команд приведены в табл. Л.2. 

Таблица Л.2 

Некоторые команды функциональных кодов 

Команда Назначение 

D01 или D1 

Перемещение в указанную точку с открытым затвором. Используется 

для рисования проводников. Является модальной. Следует за передава-

емыми данными. 

Пример: X0084Y00066D01* 

D02 или D2 
Перемещение в указанную точку с закрытым затвором. Является мо-

дальной. Следует за передаваемыми данными 

D03 или D3 

Перемещение в указанную точку с закрытым затвором с последующим 

кратковременным его открыванием и закрыванием (вспышка или flash). 

Используется для создания КП. Следует за передаваемыми данными 

D10 и больше Каждая команда является ссылкой на соответствующую апертуру 

G01 Устанавливает режим рисования линий 

G02 Устанавливает режим рисования дуги по часовой стрелке 

G03 Устанавливает режим рисования дуги против часовой стрелки 

G04 

Комментарий. До знака «*» после этой команды может помещаться лю-

бая информация, не влияющая на выполнение программы. 

Пример: G04 это комментарий* 

G36 Начало создания контура полигона 

G37 Конец создания контура полигона и его заполнение 

G54 

Осуществляет выбор апертуры (D10 и больше), следующей непосред-

ственно за G54. Может отсутствовать, так как на многих фотоплоттерах 

считается избыточной. 

Пример: G54D17* 

G70 
Установка единиц измерения в дюймы. В RS-274X заменяется коман-

дой MO 

G71 
Установка единиц измерения в миллиметры. В RS-274X заменяется ко-

мандой MO 

G74 Режим рисования дуги в одном квадранте (от 0 до 90º) 

G75 Режим рисования дуги в нескольких квадрантах (от 0 до 360º) 

G90 

Установка абсолютных координат, т. е. каждая пара координат отсчи-

тывается от точки (0; 0). Может отсутствовать, так как такой режим 

устанавливается по умолчанию. В RS-274X заменяется командой FS 

G91 

Установка относительных координат, т. е. каждая следующая координа-

та измеряется относительно предыдущей. Устаревшая команда. В RS-

274X заменяется командой FS 

M02 Конец файла 
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Команды расширенных кодов характерны для версии RS-274X и в тек-

сте программы заключаются между парой символов «%». Примеры таких 

команд приведены в табл. Л.3. 

Таблица Л.3 

Некоторые команды расширенных кодов 

Команда Назначение 

MO 

Устанавливает единицы измерения. 

Пример: 

– %MOIN*% – дюймы; 

– %MOMM*% – миллиметры 

FS 

Устанавливает формат и режим координат, а также способ подавления нулей. 

Пример: %FSLAX25Y25*%, где L – подавление ведущих нулей, A – абсо-

лютные координаты, 2 – количество знаков целой части (отдельно для коор-

динаты X и Y), 5 – количество знаков дробной части (отдельно для координа-

ты X и Y). 

Вместо L может быть буква T (подавление замыкающих нулей), а вместо A – 

I (относительные координаты), однако в настоящее время оба эти параметра 

являются устаревшими и не рекомендуются к использованию. 

Количество знаков целой части может принимать значения от 0 до 6, а дроб-

ной части – от 4 до 6 

LP 

Устанавливает тип полярности объектов, чередованием которых можно 

нарисовать сложное изображение. 

Пример: 

– %LPD*% – объекты с черной полярностью (черные); 

– %LPC*% – объекты с чистой полярностью (белые) 

AD 

Создает апертуру, присваивая ей номер, имя и параметры. Если параметров 

два и более, то они разделяются буквой «X». 

Пример: %ADD15R,0.2000X0.1000*% 

AM Создает макрос для апертуры сложной формы 

В версии RS-274X есть возможность использования четырех стандарт-

ных апертур и апертур сложной формы, которые получаются с использова-

нием макросов из восьми примитивов. 

Стандартные апертуры приведены в табл. Л.4 и показаны на рис. Л.2.  

Таблица Л.4 

Стандартные апертуры 

Имя Форма Параметры 

C Круг Внешний диаметр, диаметр отверстия 

R Прямоугольник Размер по оси X, размер по оси Y, диаметр отверстия 

O 
Прямоугольник с закруг-

ленными сторонами 
Размер по оси X, размер по оси Y, диаметр отверстия 

P 
Многоугольник, вписан-

ный в окружность 

Диаметр описанной окружности, количество углов 

(от 3 до 12), угол поворота (в градусах против часо-

вой стрелки), диаметр отверстия 
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Примером создания стандартной апертуры D15 прямоугольной формы 

(R) с размерами 0,2 × 0,1 мм без внутреннего круглого выреза в центре явля-

ется команда %ADD15R,0.2000X0.1000*% из табл. Л.3. 

Примечание. Номер апертуры записан произвольно. 

Пример апертуры сложной формы – скругленный прямоугольник для 

шаблона КП s140r50. Текст ее создания приведен на рис. Л.3, а. 

 

Название макроса (ROUNDEDRECTD11) может быть произвольным, но 

Altium Designer добавляет в конце обозначение апертуры, для которой он 

предназначен. После названия макроса приводятся примитивы, из которых 

строится апертура, с указанием их параметров через запятую. 

Назначение параметров примитивов из примера дано в табл. Л.5.  

В данном случае это два прямоугольника (1,4 × 0,7 мм и 0,7 × 1,4 мм) с 

центрами в точке (0; 0) и четыре окружности диаметром 0,7 мм с центрами в 

точках (0,35; –0,35), (–0,35; –0,35), (–0,35; 0,35) и (0,35; 0,35). Вид получив-

шейся апертуры с узлами сетки 0,1 мм и вспомогательными линиями, прохо-

дящими через указанные точки, показан на рис. Л.3, б. 

а б 

Рис. Л.3 

Рис. Л.2 

Circle (C) Rectangle (R) Obround или Oval (O) Polygon (P) 
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Таблица Л.5 

Некоторые примитивы, используемые в макросах 

Номер Форма Параметры 

1 Круг 

Экспозиция (1 или 0), диаметр, положение центра по оси 

X, положение центра по оси Y, угол поворота (в градусах 

против часовой стрелки) 

21 Прямоугольник  

Экспозиция (1 или 0), ширина, высота, положение центра 

по оси X, положение центра по оси Y, угол поворота (в 

градусах против часовой стрелки) 

Примечание. При значении экспозиции «1» примитив добавляется к 

нарисованному изображению (черный цвет), а при значении «0» примитив 

стирает часть созданного в том же макросе изображения (белый цвет). 

Более подробная информация о формате Gerber содержится в [169]. 

На рис. Л.4, а приведен текст Gerber-файла с расширением «.GTL», по-

лученного из Altium Designer для файла трассировки, в слое Top Layer кото-

рой изображены две КП, соединенные трассой шириной 0,4 мм (рис. Л.4, б). 

 

В комментариях в начале текста приводится информация о том, что дан-

ный слой физический (в нем располагается металлизация) и имеет порядко-

Рис. Л.4 

а б 

5 8,4 10 

6 

7,6 

9,2 
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вый номер 1 (находится сверху). Также дана информация о цвете слоя. Эти 

данные ни на что не влияют (см. табл. Л.2). 

После комментариев задаются все настройки Gerber-файла: формат и 

режим координат, способ подавления нулей, единицы измерения (как коман-

дой расширенных кодов, так и командой функциональных кодов), режим ри-

сования линий и способ рисования дуг (см. табл. Л.2 и Л.3).  

Далее определяются все используемые в данном файле апертуры в по-

рядке увеличения их номеров. Перед каждым макросом приводится коммен-

тарий к нему (на рис. Л.4, а он приведен частично из-за большого размера). 

Затем следуют команды рисования фотошаблона, собранные по аперту-

рам в порядке увеличения их номеров (обычно текст становится компактнее 

при создании Gerber-файлов после переоткрытия файла трассировки). 

Примечание. Если на ПП есть полигоны, то в Altium Designer они со-

здаются командами функциональных и расширенных кодов (G36, G37 и LP) 

сразу после определения всех используемых апертур.  

Л.3. Формат Excellon 

Формат Excellon получил свое название от компании Excellon Automa-

tion Company, ставшей лидером по производству оборудования для сверле-

ния ПП в 1980-х годах (компания существует и ныне). Он похож на формат 

Gerber, в нем заложено большое количество разнообразных команд, но про-

граммы по разработке ПП используют лишь их минимальный набор, приве-

денный в табл. Л.6. 

Таблица Л.6 

Некоторые команды формата Excellon 

Команда Назначение 

M48 Начало заголовка 

; Символ, после которого записывается комментарий 

METRIC, LZ 

Составная команда, устанавливающая единицы измерения (METRIC – 

миллиметры, INCH – дюймы), наличие нулей (LZ – только лидирую-

щие, TZ – только ведущие, без информации – подавления нулей нет) 

TXCY.Z 

Сопоставление диаметра C инструменту T (сверлу), где X, Y и Z – 

числа. 

Пример: T02C1.2000. Здесь инструменту T02 задается диаметр 1,2 мм 

(при опции METRIC). Инструменты с номерами от 1 до 9 могут быть 

указаны без начального нуля (T02 или T2). 

В команде может содержаться дополнительная информация, связанная 

с технологическим процессом: F – скорость подачи (погружения) 

сверла, S – скорость вращения сверла и др. Altium Designer по умолча-

нию включает эти данные с нулевыми значениями 
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Окончание таблицы Л.6 

Команда Назначение 

% Конец заголовка 

TX 

Выбор инструмента с номером X. Инструменты с номерами от 1 до 9 

могут быть указаны без начального нуля. 

Пример: T01 или T1 

G00 

Включение режима фрезерования и отключение режима сверления с 

перемещением в указанную точку. Обработку этой командой делать 

нельзя, так как путь перемещения может быть произвольным 

Пример: G00X005Y00415 

G01 Перемещение инструмента по прямой до указанной точки 

G05 Включение режима сверления и отключение режима фрезерования 

G85 

Команда слотового сверления, т. е. создание прорези путем сверления 

ряда близко расположенных отверстий между двумя точками. Обыч-

ные параметры: неравномерности стенок – не более 12,7 мкм, диаметр 

сверла – от 0,6 мм, длина – от 2 до 10 диаметров сверла. 

Пример: X00395Y-002G85X00415. Здесь до команды G85 указаны ко-

ординаты начальной точки (39,5; –20), а после – координаты конечной 

точки (41,5; –20). 

G90 и G91 См. табл. Л.2 

M15 Погружение инструмента (начальная точка фрезерования) 

M16 Подъем инструмента (конечная точка фрезерования) 

M17 Конец подпрограммы фрезерования 

M30 Конец программы 

Текст программы в Excellon-файле состоит из заголовка, в котором за-

даются параметры данных и назначаются размеры инструментам, и основной 

части, в которой приводятся идентификаторы инструментов и координаты 

отверстий, выполняемых данным инструментом [170]. 

Координаты записываются по аналогии с Gerber-файлом. 

Типовое расширение Excellon-файла – «.TXT». 

На рис. Л.5, а приведен текст Excellon-файла, полученного из Altium De-

signer для файла трассировки с двумя металлизированными отверстиями 

диаметром 0,5 мм (рис. Л.5, б). 

 Рис. Л.5 

б 

5 8,4 

8,1 

а 
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Файлы Excellon часто называются NC drill, так как они используются 

для управления сверлильными станками с числовым программным управле-

нием (Computer Numerical Control drilling and routing machine) по стандарту 

IPC-NC-349 (Computer Numerical Control Formatting for Drillers and Routers). 

Л.4. Экспорт в форматы Gerber и Excellon 

В данном приложении предлагается выполнить 5-й дополнительный 

этап проектирования, заключающийся в создании файлов форматов Gerber и 

Excellon из разработанного в разд. 12 файла трассировки. 

Последовательность действий: 

1. В Altium Designer открыть проект ПП (см. п. 1 из 12.1). 

2. Открыть файл трассировки по п. 3 из 8.3. 

3. В настройках проекта (команда Project ⇒ Project Options) на вкладке 

Options в группе Output Options отключить опцию Open outputs after com-

pile (автоматическое открытие сгенерированных файлов) и применить изме-

нения кнопкой OK. 

4. Для создания Gerber-файлов запустить команду File ⇒ Fabrication 

Outputs ⇒ Gerber Files и в открывшемся окне Gerber Setup выполнить сле-

дующее: 

4.1. На вкладке General (рис. Л.6): 

– выбрать единицы измерения Millimeters; 

– выбрать формат данных 4:4. 

 

4.2. На вкладке Layers в таблице Layers To Plot поставить галочки в 

столбце Plot около слоев, для которых будут созданы Gerber-файлы: Top 

Overlay, Top Solder, Top Layer, Bottom Layer, M1 Board. 

Рис. Л.6 
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Примечания: 

– таблица Mechanical Layers(s) to Add to All Plots предназначена для 

включения графики выбранных механических слоев во все Gerber-файлы из 

таблицы Layers To Plot; 

– опция Mirror в таблице Layers To Plot позволяет отзеркалить слой. 

Данная настройка не требует включения, так как это делается на произ-

водстве после проверки на технологичность изготовления ПП; 

– так как шелкография в варианте «П1» отсутствует (см. примечание 

к п. 30.6 из 16.1), то слой Top Overlay не отмечен (рис. Л.7). 

 

4.3. На вкладке Drill Drawing оставить все опции отключенными. 

Примечание. На данной вкладке можно сформировать файлы с инфор-

мацией слоев Drill Drawing и Drill Guide (см. табл. Г.14) для существующих в 

проекте пар слоев (см. п. 4 из Г.21). 

4.4. На вкладке Apertures (рис. Л.8) убедиться в том, что включена оп-

ция Embedded apertures (RS274X). 

 

Примечание. При включении данной опции в каждый Gerber-файл будет 

включено описание всех используемых в нем апертур. 

4.5. На вкладке Advanced задать параметры в соответствии с рис. Л.9. 

Рис. Л.8 

Рис. Л.7 
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Примечания: 

– в группе Film Size заданы размеры пленки фотошаблона (поля X и Y) и 

величина технологического поля (поле Border size). Данные значения опреде-

ляются на производстве; 

– настройки группы Leading/Trailing Zeroes описаны в п. 2 из Л.2; 

– в группе Aperture Matching Tolerances задаются настройки точности 

размеров апертур (указаны минимальные значения); 

– в группе Position on Film задается положение ПП на пленке фотошаб-

лона: Reference to absolute origin – относительно точки начала абсолютной 

системы координат (нижний левый угол рабочего поля), Reference to relative 

origin – относительно точки начала пользовательской системы координат 

(см. п. 5.6 из 12.3), Center on film – в центре фотошаблона; 

– в группе Batch Mode задается способ вывода: Separate file per layer – 

для каждого слоя будет создан отдельный Gerber-файл, Panelize layers – все 

слои будут собраны в один Gerber-файл; 

– в группе Plotter Type указывается тип фотоплоттера (по умолчанию 

выбран растровый). В данной версии Altium Designer значимых различий в 

текстах Gerber-файлов между опциями из этой группы не обнаружено; 

– опция G54 on aperture change – включение команды G54 из табл. Л.2; 

Рис. Л.9 
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– опция Optimize change location commands – включение модальности ко-

ординат (см. п. 3 из Л.2). 

4.6. Запустить процесс создания Gerber-файлов кнопкой OK. 

После его окончания в подпапке Project Outputs, находящейся в папке 

проекта ПП, будут созданы Gerber-файлы выбранных слоев и вспомогатель-

ные файлы (не требуются для производства): 

– файл с расширением «.apr» – перечень апертур стандартных форм; 

– файл с расширением «.APR_LIB» – перечень апертур сложных форм; 

– файл с расширением «.EXTREP» – таблица соответствия расширений 

созданных Gerber-файлов и названий слоев ПП; 

– файл с расширением «.REP» – перечень номеров апертур, использо-

ванных в каждом созданном Gerber-файле.  

5. Для создания Excellon-файла запустить команду File ⇒ Fabrication 

Outputs ⇒ NC Drill Files, в открывшемся окне NC Drill Setup задать настрой-

ки в соответствии с рис. Л.10 и нажать кнопку OK. 

 Рис. Л.10 
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Примечания: 

– желательно, чтобы настройки в окнах NC Drill Setup и Gerber Setup 

при создании файлов для одного проекта совпадали; 

– опция Generate separate NC Drill files for plated & non-plated holes – со-

здание отдельных Excellon-файлов для металлизированных и неметаллизиро-

ванных отверстий. Если опция отключена, то вся информация будет со-

держаться в одном файле; 

– опция Use drilled slot command (G85) – создание отверстий типа Slot 

командой G85 (см. табл. Л.6). Микрорельеф, получаемый при этом, хорошо 

подходит для металлизации. Если опция отключена, то подобные отвер-

стия будут получены фрезерованием; 

– опция Generate Board Edge Rout Paths – создание файла для фрезеро-

вания контура ПП и вырезов в ней фрезой с диаметром, указанным в поле 

Rout Tool Dia. 

После окончания процесса в подпапке Project Outputs, находящейся в 

папке проекта ПП, будет создан Excellon-файл и вспомогательные файлы (не 

требуются для производства): 

– файл с расширением «.DRR» – таблица отверстий; 

– файл с расширением «.LDP» – соответствие пар слоев отверстий со-

зданному Excellon-файлу. 

Примечания: 

– если в проекте есть не только круглые отверстия, то будет создано 

несколько Excellon-файлов с одинаковыми расширениями, но разными назва-

ниями, характеризующими тип отверстий (например, RoundHoles и 

SlotHoles). Также будет создано несколько файлов, если в проекте МПП 

кроме сквозных отверстий есть глухие и (или) скрытые отверстия; 

– сгенерированные файлы отображаются в панели 

Projects (рис. Л.11) в двух подгруппах группы Generated 

(CAMtastic! Documents – файлы форматов Gerber и Ex-

cellon, Text Documents – вспомогательные файлы); 

– в настройках проекта при включении опции Use 

separate folder for each output type на вкладке Option ге-

нерируемые файлы будут сохраняться в отдельные 

подпапки в папке Project Outputs; 

– настройки в окнах Gerber Setup и NC Drill Setup 

сохраняются с файлом трассировки (проектом); Рис. Л.11 
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– после возможных корректировок ПП файлы в форматах Gerber и Ex-

cellon необходимо создавать заново; 

– в случае работы с однотипными ПП имеет смысл создать файл Out-

put Job File, в котором один раз задать все необходимые настройки, после 

чего использовать его в требуемых проектах. 

6. Просмотреть созданные файлы в форматах Gerber и Excellon. 

Это можно сделать отдельно для каждого файла, открывая его из панели 

Projects по аналогии с п. 3 из 8.3, но лучше просматривать их одновременно в 

отдельном документе: 

6.1. В панели Projects на названии проекта выполнить команду ПКМ ⇒ 

Add New to Project ⇒ CAM Document. 

Примечание. Редактор CAM Editor (CAMtastic) в Altium Designer исполь-

зуется для просмотра и редактирования файлов в форматах Gerber и Excel-

lon, но обладает меньшим набором возможностей в сравнении со специали-

зированными САПР (например, CAM350 фирмы DownStream Technologies). 

Настройки редактора CAM Editor задаются в одноименном разделе окна 

Preferences (команда DXP ⇒ Preferences). 

По целевому назначению САПР, используемые для технологической под-

готовки изделий, имеют аббревиатуру CAM (computer-aided manufacturing). 

6.2. Импортировать файлы в созданный документ CAMtastic1.Cam, для 

чего при активной вкладке с ним запустить команду File ⇒ Import ⇒ Quick 

Load и убедиться в следующем: 

– в поле Select Import Directory должна быть выбрана папка Project 

Outputs текущего проекта ПП; 

– в поле File(s) in Directory должны быть выбраны все файлы (можно 

выбрать только необходимые файлы с зажатой клавишей Ctrl); 

– в окне, открывающемся после нажатия 

кнопки Default Units, должны быть такие же 

настройки, что и указанные при создании 

Gerber-файлов (рис. Л.12). 

После этого запустить процесс импорта 

кнопкой OK. 

В появившемся окне Import Drill Data 

нажать кнопку Units и убедиться в соответ-

ствии настроек заданным при создании Excellon-файла (рис. Л.12), после чего 

продолжить процесс импорта. 

Рис. Л.12 
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6.3. Закрыть появившуюся в рабочем поле вкладку с отчетом. 

6.4. Просмотреть добавленные файлы: 

– развернуть окно Altium Designer на полный экран; 

– перейти в панель CAMtastic (рис. Л.13). 

 

Примечание. Если панели нет, то ее можно запустить из нижнего пра-

вого угла рабочего поля после нажатия одноименной кнопки; 

– просмотреть отдельно первый файл, для чего в группе со слоями 

щелкнуть ЛКМ по первой строке и нажать клавишу Left (или запустить ко-

манду ПКМ ⇒ Isolate); 

– перемещаясь по списку слоев клавишами Down и Up внимательно 

просмотреть информацию с других слоев; 

– включить отображение файлов только с расширениями «.gtl» и «.gts» и 

сделать текущим последний из них. После этого визуально проверить пра-

вильность расположения областей отсутствия защитной паяльной маски.  

Примечания: 

– управление видимостью файла осуществляется галочкой слева от его 

названия или командой ПКМ ⇒ ON; 

– текущий файл – файл, изображение которого показано поверх других 

изображений (в панели он отмечается белым перекрестием в ячейке с цве-

том объектов файла). Чтобы сделать файл текущим, по нему необходимо 

дважды щелкнуть ЛКМ или запустить команду ПКМ ⇒ Current; 

Рис. Л.13 
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– вместо файла с расширением «.gts» включить файл (или файлы) с рас-

ширением «.txt», сделав его текущим. После этого визуально проверить пра-

вильность расположения отверстий. 

Примечания: 

– в режиме NC Editor (включается в верхней части панели), предназна-

ченном для просмотра Excellon-файлов, одиночные отверстия дополнитель-

но помечаются маркерами в виде белых перекрестий. При наличии фрезеро-

вания или слотового сверления будут показаны маркеры направления следо-

вания инструментов, точки начала и конца создания прорезей; 

– в режиме CAM Editor, предназначенном для просмотра Gerber-фай-

лов, дополнительные маркеры у отверстий отсутствуют; 

– при просмотре файлов может потребоваться режим выбора объек-

тов (клавиша Q или команда Analysis ⇒ Query ⇒ Object) и режим измерения 

между двумя объектами (команда Analysis ⇒ Measure ⇒ Object to Object). 

Результаты приводятся в панели CAMtastic на вкладке Info. 

6.5. Закрыть вкладку с документом CAMtastic1.Cam без сохранения из-

менений. 

7. Сохранить изменения в проекте (см. п. 4 из 5.5). 

8. Сохранить в отчет изображение панели Projects со всеми раскрытыми 

группами и подгруппами. 

Примечание. Перед передачей производителю файлов в форматах Ger-

ber и Excellon обычно выполняется следующее: 

– файлы дополнительно просматриваются в специализированной САПР 

CAM (например, в CAM350) и там же осуществляется проверка правил про-

ектирования. Кроме просмотра результатов в сторонней программе можно 

найти места с нарушением минимального размера зазора между участками 

заполнения одного и того же полигона Polygon Pour, что невозможно авто-

матически обнаружить средствами Altium Designer; 

– после успешной проверки в блокноте вручную создается текстовый 

файл, в котором указываются: название проекта, размеры ПП, материал и 

толщина диэлектрика, толщина фольги, тип финишного покрытия, цвета 

защитной паяльной маски и шелкографии (при наличии), минимальные значе-

ния параметров элементов конструкции ПП, порядок слоев (для МПП), 

назначение каждого передаваемого файла; 

– все файлы из подгруппы CAMtastic! Documents панели Projects объеди-

няются с текстовым файлом в одном архиве с названием проекта. 
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Л.5. Содержание отчета 

По 5-му дополнительному этапу проектирования (см. табл. 2.3) в отчете 

необходимо привести: 

1. Скриншот панели Projects со всеми раскрытыми группами и подгруп-

пами. 

2. Назначение каждого созданного файла форматов Gerber и Excellon. 

3. Текст Gerber-файла для слоя M1 Board с текстовыми пояснениями к 

каждой строке. Также нарисовать рисунок с результатом выполнения про-

граммы из этого файла и указать все координаты. 

4. Текст Excellon-файла для круглых отверстий с заголовком и частью 

программы, начиная с момента выбора последнего инструмента. Каждую 

строку сопроводить текстовым комментарием. Также нарисовать рисунок с 

результатом выполнения этой части программы и указать все координаты 

(можно совместить с рисунком из п. 3). 
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М. Внесение изменений в КД 

М.1. Общие сведения 

После утверждения КД в них могут быть внесены изменения по следу-

ющим причинам: исправление ошибок, усовершенствование конструкции, 

изменение литеры, преобразование единичного КД в групповой и др. 

К общим правилам внесения изменений по ГОСТ 2.503–74 и ГОСТ Р 

2.503–2023 относятся следующие: 

1. Основные положения. 

1.1. Под изменением документа понимается любое исправление, исклю-

чение или добавление каких-либо данных в этот документ. 

1.2. Изменения в документы вносят, если они не нарушают взаимозаме-

няемость изделия с изделиями, изготовленными ранее. 

1.3. Любое изменение в документе, вызывающее какие-либо изменения в 

других документах, должно одновременно сопровождаться внесением соот-

ветствующих изменений во все взаимосвязанные документы. 

1.4. Если хотя бы для одного изделия изменение документа окажется не-

приемлемым, то на изменяемое изделие должен быть выпущен новый доку-

мент с новым обозначением. 

1.5. При нарушении взаимозаменяемости изменяемого изделия с издели-

ями, изготовленными ранее, изменения в документы последних не вносят, а 

выпускают новые документы с новыми обозначениями или единичные КД 

преобразуют в групповые по ГОСТ 2.113–75 (см. прил. Н). 

На изделия единичного производства и на опытный образец (опытную 

партию) допускается не выпускать КД с новыми обозначениями, если их 

применяют не более чем в одном документе. 

1.6. Изменение документов на всех стадиях жизненного цикла изделия 

вносят на основании ИИ. 

Извещение об изменении (ИИ) – документ, содержащий сведения, не-

обходимые для внесения изменений в подлинники конструкторских (техно-

логических) документов, их замены или аннулирования, в том числе причину 

и срок внесения изменений, а также указания об использовании задела изме-

няемого изделия. 

1.7. Информацию о факте изменения в бумажных КД указывают в таб-

лице изменений основной надписи (графы 14–18 по табл. 3.1, рис. 3.6, а и б, 

рис. 9.1) и/или в ЛР (см. рис. 9.3). 
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1.8. Выпускать ИИ и вносить изменения в подлинники изменяемых до-

кументов имеет право только организация – держатель подлинников этих до-

кументов. 

1.9. Изложенные в ИИ указания обязательны для всех подразделений ор-

ганизации, выпустившей извещение, а также организаций, применяющих из-

меняемую документацию. 

1.10. В документах без ЛР таблицу изменений заполняют на листах(е): 

– первом (заглавном) нового подлинника, изготовленном в целом взамен 

старого; 

– измененных; 

– выпущенных взамен замененных; 

– введенных вновь. 

В документах, имеющих ЛР, заполняют его, а таблицу изменений запол-

няют только на листах, выпущенных вместо замененных и добавленных 

вновь. При замене всех листов подлинника при ручном способе внесения из-

менений заполняют только ЛР. 

1.11. Заполнение таблицы изменений в основной надписи КД произво-

дят в соответствии с табл. М.1. 

Таблица М.1 

Содержание граф таблицы изменений в основной надписи КД 

Название  

и номер графы 
Данные в графе 

Изм. (14) 

Порядковый номер изменения документа. 

При замене подлинника новым очередной порядковый номер про-

ставляют исходя из последнего номера изменения, указанного в за-

мененном подлиннике 

Лист (15) 

На листах, выпущенных вместо замененных, указывают «Зам». 

На листах, добавленных вновь, указывают «Нов». 

При замене всех листов подлинника при ручном внесении изменений 

на первом (заглавном) листе указывают «Все». 

В остальных случаях графу прочеркивают 

№ докум. (16) 
Обозначение ИИ. 

Код организации, выпустившей ИИ, допускается не проставлять 

Подп. (17) Подпись лица, ответственного за правильность внесения изменения 

Дата (18) Дата внесения изменения 

Таблица изменений заполняется снизу вверх и в общем случае может 

продолжаться вверх или влево от основной надписи [14], [171]. 

1.12. Заполнение граф ЛР производят в соответствии с табл. М.2. 
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Таблица М.2 

Содержание граф ЛР 

Название графы Данные в графе 

Изм. 

Графы заполняются аналогично табл. М.1 
Номер документа 

Подпись 

Дата 

Номера листов (страниц)  

измененных, замененных, новых,  

аннулированных 

Номера листов (страниц) соответственно изменен-

ных, замененных, добавленных и аннулированных 

по данному ИИ. 

При переиздании всего документа в графе «Номера 

листов (страниц) замененных» указывают «Все» 

Всего листов (страниц)  

в документе 

Графу заполняют в случае заполнения граф «Номера 

листов (страниц) новых» и (или) «Номера листов 

(страниц) аннулированных». 

В остальных случаях графу прочеркивают 

Входящий номер  

сопроводительного документа  

и дата 

Заполняют при внесении изменений в эксплуатаци-

онные документы в соответствии с правилами, уста-

новленными ГОСТ 2.603–68 [172]. 

В остальных случаях графу прочеркивают или в ЛР 

не предусматривают 

1.13. При замене всех листов подлинника в ЛР не воспроизводят номера 

изменений и другие данные, относящиеся ко всем ранее внесенным в доку-

мент изменениям. 

1.14. Необходимые исправления документов, вызванные внесением 

ошибочных изменений по ранее выпущенным ИИ, следует оформлять новы-

ми ИИ. 

2. Внесение изменений. 

2.1. Внесение изменений в бумажный документ осуществляют: 

– зачеркиванием; 

– подчисткой (смывкой); 

– закрашиванием белым цветом; 

– введением новых данных; 

– заменой листов или всего документа; 

– введением новых дополнительных листов и/или документов; 

– исключением отдельных листов документа. 

2.2. При добавлении нового листа в бумажный документ допускается 

присваивать ему номер предыдущего листа с добавлением очередной строч-

ной буквы русского алфавита или через точку арабской цифры, например 3а 



 

 1021 

или 3.1. При этом на первом (заглавном) листе изменяют общее количество 

листов. При аннулировании листа нумерацию последующих листов сохра-

няют. 

2.3. Если недостаточно места для внесения изменений, или возможно 

нарушение четкого изображения при исправлении, или невозможно выпол-

нить требования к микрофильмированию, то изготовляют новый подлинник с 

учетом вносимых изменений и сохраняют его прежнее обозначение. 

2.4. Внесение изменений зачеркиванием размеров, знаков, надписей, от-

дельных слов и строк осуществляют сплошной тонкой линией с проставле-

нием новой информации в непосредственной близости от зачеркнутого. 

При изменении части изображения его обводят сплошной тонкой лини-

ей, образующей замкнутый контур, и крестообразно перечеркивают сплош-

ными тонкими линиями. Измененный участок изображения выполняют на 

свободном поле документа. Новое изображение измененного участка должно 

быть выполнено в прежнем масштабе без поворота. Обозначают перечеркну-

тый и вновь изображенный участки так же, как выносные элементы. Над но-

выми изображениями указывают: «Взамен перечеркнутого». 

Если изменяется все изображение (вид, разрез или сечение), то его пере-

черкивают и выполняют заново. Над вновь выполненным изображением, при 

необходимости, помещают надпись, например: «Вид слева», «Вид снизу». 

При недостатке места для внесения изменений в основную надпись со-

ответствующие изменения помещают на свободном поле документа над ней с 

указанием наименования графы и содержания помещаемых данных, напри-

мер: «Материал: Сплав Д16 ГОСТ 4784–97». При этом запись в графе вычер-

кивают и указывают: «См. выше». 

2.5. Изменения обозначают порядковыми номерами арабских цифр (1, 2, 

3 и т. д.). Один порядковый номер изменения присваивают всем изменениям, 

которые вносят в документ по одному извещению. Его указывают для всего 

документа независимо от того, на скольких листах он выполнен. 

2.6. При внесении изменений рукописным способом около каждого из-

менения, в том числе около места, исправленного подчисткой (смывкой) или 

закрашиванием белым цветом, за пределами изображения или текста наносят 

порядковый номер изменения в окружности диаметром 6–12 мм, в квадрате 

со стороной 6–8 мм или в скобках и от этой окружности (квадрата, скобок) 

проводят сплошную тонкую линию к измененному участку. 

Допускается линию к изменяемому участку не проводить. 
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Также допускается от окружности (квадрата, скобок) с номером измене-

ния проводить несколько линий к участкам, изменение которых проведено 

под одним номером. 

При внесении изменений в текстовые документы (в текстовую часть до-

кументов) линии от окружности (квадрата, скобок) с номером изменения не 

проводят. 

3. Извещение об изменении. 

3.1. ИИ составляют на один или несколько документов. Одно общее ИИ 

составляют на несколько документов при условии одновременного проведе-

ния изменений во все изменяемые документы. 

При составлении одного общего ИИ на несколько документов желатель-

но, чтобы у этих документов были одинаковые внешние абоненты. 

3.2. ИИ должно иметь обозначение, которое может состоять из кода ор-

ганизации, отделенного точкой кода (номера) подразделения организации, 

выпустившей ИИ, и отделенного точкой порядкового регистрационного но-

мера, например: АБВГ.42.107; К.05.49. Регистрационные номера допускается 

присваивать в пределах подразделения организации, выпустившего ИИ. 

В случае если ИИ не рассылают внешним абонентам, то порядок при-

своения ему обозначения допускается устанавливать самой организации, вы-

пустившей ИИ. 

Порядковый регистрационный номер обозначения ИИ устанавливают в 

пределах организации. 

Допускается к обозначению ИИ добавлять год выпуска ИИ, отделенный 

знаком дефис, например: АБВГ.16-2004; К.137-2004. 

3.3. ИИ для случая из п. 1.3 можно оформить в виде комплекта извеще-

ний. При этом для всех выпускаемых в комплекте ИИ должен быть одинако-

вый срок внесения изменений. 

Каждому ИИ в комплекте присваивают один регистрационный номер с 

добавлением дробного числа, в числителе которого указывают порядковый 

номер ИИ в комплекте, в знаменателе – общее число ИИ, например: 

АБВГ.136.2/6; К.281.1/4-2004. 

ИИ, вызывающее выпуск других ИИ, считают основным и присваивают 

первый номер в комплекте. 

3.4. ИИ выполняют на бумажном носителе в соответствии с формами, 

приведенными на рис. М.1 (первый лист) и рис. М.2 (последующие листы). В 

круглых скобках указаны номера граф, а их содержание – в табл. М.3. 
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 Рис. М.1 
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 Рис. М.2 
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Таблица М.3 

Содержание граф ИИ 

Номер 

графы 
Данные в графе 

1 
Наименование или код организации, выпустившей ИИ. 

Допускается графу не заполнять 

1а Номер или наименование подразделения организации, выпустившее ИИ 

2 Обозначение ИИ 

3 

Обозначение изменяемого документа. 

Если выпущено одно общее ИИ, то в графе записывают «См. ниже», а обозна-

чения изменяемых документов указывают в графе 18 и подчеркивают 

4 Дата выпуска ИИ (дата сдачи в службу технической документации – СТД) 

4а Графа не заполняется 

5 

Срок внесения изменения. 

Указывается дата (при необходимости время суток), до наступления которой 

должны быть внесены изменения в документы или документы должны быть 

аннулированы, а также отосланы копии извещения внешним абонентам. 

При необходимости срочного внесения изменений в этой графе также должна 

быть надпись «Срочно» 

5а, 6, 7 Графы не заполняются 

8 
Порядковый номер листа ИИ. 

Если ИИ состоит из одного листа, графу не заполняют 

9 Общее количество листов ИИ 

10 Причина изменения (табл. М.4). 

11 

Код причины изменения (табл. М.4). 

Допускается: 

– код не указывать (в этом случае графу прочеркивают); 

– однозначным цифрам кода добавлять слева ноль, например: 01, 02 и т. д.; 

– при необходимости, по усмотрению организации, указывать другие причины 

изменения и их коды. 

Если изменения вносят по нескольким причинам, то причины и коды измене-

ний приводят в графе 18 на первом листе ИИ после надписи «Причины и ко-

ды». При этом в графе 10 указывают «См. ниже», а графу 11 прочеркивают 

12 

Конкретные указания по использованию задела изменяемых изделий (в том 

числе запасных частей). Подробнее – см. п. 3.6. 

Если в графе недостаточно места для указания об использовании задела, то 

текстовую часть помещают на первом листе ИИ в нижней части графы 18 или 

на последующих листах после надписи: «Указание о заделе». В этих случаях в 

графе 12 дают ссылку «См. ниже» или «См. лист…» 

12а Графа не заполняется 

13 

Конкретные указания о внедрении: заводские номера изделий, номера серий, 

заказов или дату внедрения изменений в производство. Например: «Предприя-

тию… внедрить в производство с изделия…, серии…», «Внедрить с 20.04.17». 

Графу прочеркивают, если в графе 12 указано: «Не отражается», «Изменение в 

заделе учтено» или «Задела нет» 

13а Графа не заполняется 
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Окончание таблицы И.2 

Номер 

графы 
Данные в графе 

14 

Обозначение документов, в которых применяется изменяемый документ. Ис-

пользуется для проверки возможности внесения изменений. 

Если изменения не относятся к документам, в которых применяется изменяе-

мый документ (замена литеры, исправление ошибок без изменения размеров 

изделия и т. п.), то в графе указывают: «На применяемости не отражается» 

15 Абоненты, которым следует направлять ИИ 

16 

Приложение(я) к ИИ (при наличии) и количество листов приложений. При от-

сутствии приложений графу прочеркивают. 

При наличии приложений они могут содержать, например, копии изменяемых 

документов с внесенными в них изменениями, необходимые расчеты и пояс-

нения, подтверждающие целесообразность вносимых изменений и т. п. 

17 Очередной порядковый номер изменения в данном КД 

18 Содержание изменения для данного КД. Подробнее – см. п. 3.9 

19 Функция (должность) лиц из служб предприятия, с которыми согласовано ИИ 

20 Фамилия 

21 Подпись 

22 Дата подписания 

23 Подпись лица, внесшего изменение 

24 Дата внесения изменения 

Таблица М.4 

Коды причин изменений 

Причина изменения Код 

Введение улучшений и усовершенствований (конструктивных) 1 

Введение улучшений и усовершенствований (технологических) 2 

Введение улучшений и усовершенствований (в результате  

стандартизации и унификации) 
3 

Внедрение и изменение стандартов и технических условий 4 

По результатам испытаний 5 

Отработка документов с изменением литеры 6 

Устранение ошибок 7 

Улучшение качества 8 

Требования заказчика (представительства заказчика) 9 

Изменение схемы 10 

Улучшение электрического монтажа 11 

Изменение средств технологического оснащения 12 

Изменение условий труда 13 

Введение новых технологических процессов (операций) 14 

Замена исходной заготовки 15 

Изменение норм расхода материалов 16 
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3.5. Необходимо обратить внимание на то, что содержание граф в 

табл. М.3 приведено только для ИИ. Кроме него на формах, показанных на 

рис. М.1 и М.2, заполняются: дополнительное ИИ (ДИ), предварительное ИИ 

(ПИ), дополнительное ПИ (ДПИ), предложение об изменении (ПР). 

ДИ – документ, содержащий сведения, необходимые для изменения 

производственно-технических указаний в выпущенном ИИ. Составляется 

при обнаружении в ИИ ошибок в указании о заделе, в сроках внедрения из-

менений в производство и т. п. 

ПИ – временный документ, содержащий сведения, необходимые для 

внесения изменений в копии конструкторских (технологических) докумен-

тов, находящихся в производстве, и действующих до погашения их ИИ или 

до переоформления в ИИ, окончания срока действия или аннулирования. Со-

ставляется: при обнаружении в документе ошибки, которая может вызвать 

брак изделия или задерживает производство; при предварительной проверке 

предлагаемых изменений в производстве; при необходимости проведения 

технологической подготовки производства. 

ДПИ – документ, содержащий сведения, необходимые для изменения 

производственно-технических указаний в выпущенном ПИ. 

ПР – документ, содержащий предлагаемые сведения, необходимые для 

внесения изменений в конструкторские (технологические) документы, их за-

мены или аннулирования. 

3.6. Под заделом изменяемых изделий, указываемых в графе 12, пони-

мают все полностью или частично изготовленные, но не реализованные из-

делия, выполненные по документам до внесения в них изменений по данному 

ИИ. В графе дают следующие указания: 

– «Не отражается» – если изменения не отражаются на конструкции из-

делия и не влияют на использование задела; 

– «Не использовать» – при недопустимости использования или невоз-

можности доработки задела; 

– «Использовать» или «Использовать на пять комплектов» – при исполь-

зовании задела без учета вносимых изменений; 

– «Доработать» или «Использовать с дополнительным сверлением 2 отв. 

Ø3,5 Н12» – если задел можно использовать с дополнительной доработкой; 

– «Изменение в заделе учтено» или «Задела нет» – если известно, что за-

дел изделий изготовлен с учетом проводимого изменения или задел отсут-

ствует; 
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– «Доработать: в КИНО – с третьего комплекта; в ЕЖИК – с первого 

комплекта; в КЛЕН – задел использовать» – если указания о заделе не одно-

значны для всех предприятий. 

3.7. При составлении одного общего ИИ на несколько документов при 

несовпадении порядковых номеров изменений заголовки с обозначениями 

документов группируют по одинаковым порядковым номерам изменения, а 

порядковые номера проставляют раздельно по каждой группе (рис. М.3). 

 

При составлении одного общего ИИ на несколько документов с одина-

ковыми изменениями при несовпадении порядковых номеров изменений в 

графе 18 составляют таблицу, а графу 17 прочеркивают (рис. М.4). 

 

3.8. При внесении изменений в документы, содержащие текст, разбитый 

на графы, в целях оптимизации записи содержания текста изменения допус-

кается взамен этих граф применять таблицы или блоки информации с соот-

ветствующей логически расположенной указательной информацией. 

Рис. М.3 

Рис. М.4 
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3.9. Особенности заполнения графы 18: 

3.9.1. В одном общем ИИ на несколько документов содержание измене-

ния по каждому документу отделяют горизонтальной линией (см. рис. М.3). 

3.9.2. В графе указывают содержание изменяемого участка (графическо-

го, текстового и т. д.) в том виде, в котором он должен быть после внесения 

изменений в подлинник документа. 

3.9.3. При возможности неоднозначного понимания изменения приводят 

содержание изменяемого участка документа до и после внесения изменений с 

указаниями над ними «Имеется» и «Должно быть». 

3.9.4. Если изменение необходимо осуществить в подлиннике подчист-

кой (смывкой), над изменяемыми участками помещают надпись: «Изменение 

осуществить подчисткой» или «Изменение осуществить смывкой». 

3.9.5. При аннулировании документа в графе делают надпись, например: 

АБВГ.ХХХХХХ.018 аннулировать. 

Графу 17 при этом прочеркивают. 

3.9.6. Если взамен аннулированного документа следует пользоваться до-

кументом с другим обозначением, то в графе делают надпись, например: 

АБВГ.ХХХХХХ.380 аннулировать. 

Примечание – Заменен документом АБВГ.ХХХХХХ.936. 

3.9.7. При замене подлинника новым с тем же обозначением, кроме за-

писи о замене обычно приводят перечень внесенных изменений (рис. М.5). 

 

3.9.8. Если в связи с выпуском ИИ выпущены новые и/или применены 

ранее разработанные документы (например, при введении новых изделий или 

замене их в спецификациях), то после содержания изменения дают примеча-

ние о выпуске или применении таких документов, например: 

Примечания: 

1 Выпущены документы АБВГ.ХХХХХХ.171 и АБВГ.ХХХХХХ.186. 

2 Применен документ АБВГ.ХХХХХХ.336. 

Рис. М.5 
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При введении в изделие сборочной единицы, комплекта или комплекса в 

примечании дают ссылку только на вновь выпущенную или вновь применен-

ную спецификацию вводимого изделия без перечисления входящих в нее до-

кументов. 

3.9.9. Одинаковые изменения, повторяющиеся в одном документе на од-

ном или нескольких листах, указывают один раз с соответствующими пояс-

нениями (рис. М.6, а). 

 

3.9.10. При заполнении графы допускаются следующие упрощения: 

– при условии однозначного понимания изменения указание об измене-

нии размеров оформлять без изображения (рис. М.6, б); 

– вместо изображений исключаемого вида, разреза или сечения давать 

соответствующие текстовые указания, например: «Разрез А–А перечерк-

нуть», «Вид Б перечеркнуть», «Вид справа перечеркнуть»; 

– текст пункта, полностью исключаемого из ТТ, на чертеже документа 

или текстового документа, имеющего нумерацию пунктов, не повторять, а в 

графе давать соответствующую запись, например «Пункт 5 вычеркнуть». До-

пускается последующие пункты не перенумеровывать; 

– при изменении части текста не приводить предыдущий и последую-

щий тексты, заменяя их многоточием (рис. М.6, в). 

М.2. Разработка извещения об изменении 

и внесение изменений в КД 

В данном приложении предлагается выполнить 6-й дополнительный 

этап проектирования, связанный с выпуском одного общего ИИ на несколько 

КД и внесением в них соответствующих корректировок по замене одного из 

следующих компонентов: 

а) если был выполнен 3-й дополнительный этап проектирования (см. 

табл. 2.3) и для резистора выбран Part Number, то ИИ должно содержать ин-

формацию о замене этого резистора; 

б) если 3-й дополнительный этап проектирования не был выполнен или 

был выполнен частично без выбора Part Number для резистора, то ИИ должно 

Рис. М.6 

а 

б в 
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содержать информацию о замене микросхемы стабилизатора напряжения из 

табл. 8.5 на один из соответствующих аналогов, документация на которые 

находится в папке …\ИДРЭС\Компоненты\Стабилизаторы: 

– MC33275ST-Х.ХT3G фирмы ON Semiconductor, где Х.Х – уровень 

выходного напряжения; 

– SPX3819S-L/TR фирмы MaxLinear. 

В случае замены микросхемы стабилизатора на SPX3819S-L/TR необ-

ходимо обратить внимание на формулу расчета выходного напряжения и 

расположение резисторов. 

Для разработки ИИ и внесения изменений в КД проделать следующее: 

1. Подготовить форму ИИ с рис. М.1: 

1.1. В КОМПАС-3D по информации из 7.1 создать новый чертеж и за-

дать следующие настройки листа: 

– формат – A4; 

– ориентация – горизонтальная; 

– оформление – Извещен. об изменен. Первый лист. ГОСТ 2.503-2013 

Ф1. 

1.2. Убедиться в том, что включены глобальные привязки, задан шаг 

сетки 0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

1.3. Так как изменения коснутся трех КД (схема Э3 «усилителя», пере-

чень элементов ПЭ3 «усилителя» и спецификация на «усилитель»), то графу 

18 необходимо разделить на три части (см. п. 3.9.1 из М.1 и рис. М.3). 

Рекомендуется это сделать в виде добавления двух отдельных таблиц: 

1.3.1. Запустить команду Создать новый вид из ПИ Компактная па-

нель ⇒ Виды (см. рис. 7.6) и щелкнуть ЛКМ в рабочем поле. 

1.3.2. Запустить команду Ввод таблицы из ПИ Компактная панель ⇒ 

Обозначения (см. рис. 17.24) и указать ЛКМ примерное расположение лево-

го верхнего угла таблицы в рабочем поле. 

1.3.3. В появившемся окне Создать таблицу задать настройки: 

– число столбцов – 2; 

– число строк – 1; 

– высота строки – 6. 

Затем закрыть окно кнопкой OK. 

1.3.4. Для левой ячейки в Панели свойств перейти на вкладку Таблица, 

нажать пиктограмму Формат ячейки и в открывшемся окне в поле Ширина 

столбца ввести 17. После чего закрыть окно кнопкой OK. 
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1.3.5. Для правой ячейки в Панели свойств перейти на вкладку Табли-

ца и выполнить следующее: 

– в списке Стиль выбрать Основная; 

– в списке Границы включить пиктограмму Левая граница и отжать 

пиктограмму Нижняя граница; 

– по п. 1.3.4 задать ширину столбца 185. 

1.3.6. В Панели свойств нажать пиктограмму Создать объект, а затем 

клавишу Esc. 

1.3.7. Отредактировать положение таблицы командой Сдвиг из ПИ 

Компактная панель ⇒ Редактирование (см. рис. 6.20). 

1.3.8. Создать новый вид, скопировать в него созданную таблицу и отре-

дактировать ее положение. 

2. Задать обозначение ИИ в соответствии с п. 3.2 из М.1: 

– код организации при выполнении 9-го дополнительного этапа проек-

тирования (см. табл. 2.3) – СПВГ (в противном случае – код по рис. 2.3); 

– номер подразделения – номер группы; 

– порядковый регистрационный номер при выполнении 9-го дополни-

тельного этапа проектирования – номер варианта задания (в противном слу-

чае – произвольное двузначное число). 

3. Сохранить ИИ с расширением «.cdw». 

В имени файла указать обозначение ИИ и расшифровку, например: 

«СПВГ.2319.53 - Извещение об изменении». Так как ИИ не является КД, то 

его желательно сохранить в отдельную папку внутри папки с КД на «модуль 

усилителя» (например, …\ИДРЭС-П1\_ИИ). 

Стоит отметить, что дальнейшее заполнение граф ИИ можно сделать 

вручную на распечатанной форме. 

4. Заполнить графы ИИ (см. рис. М.1 и табл. М.3), кроме граф 17 и 18, 

дважды щелкнув по ним в рабочем поле ЛКМ. 

Комментарии к заполнению: 

4.1. Графу 1 допускается не заполнять, если для изменяемых КД выпол-

нен 9-й дополнительный этап проектирования. В противном случае в ней 

необходимо записать СПбГЭТУ «ЛЭТИ». 

4.2. В графе 4 указать дату разработки ИИ. 

4.3. В графе 5 указать примерную дату защиты проекта. 

4.4. В графе 12 записать следующее: 

– в четных вариантах задания – «Задела нет»; 
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– в нечетных вариантах задания дать указание о доработке с первого 

комплекта. В графе 13 при этом отметить: «Срок внедрения изменений в 

производство устанавливает организация». Это означает, что организация, 

выпускающая ИИ, не может установить наличие и состояние задела изделий, 

технологической оснастки и прочих производственных условий в других ор-

ганизациях, изготавливающих данное изделие. 

4.5. В графе 15 поставить прочерк. 

4.6. Графы 19–22 с левой нижней стороны рамки ИИ (см. рис. М.1) оста-

вить пустыми. 

4.7. Графы 20 в полях «Составил», «Проверил» и «Утвердил» заполнить 

аналогично графам 11 из табл. 9.1. 

4.8. Графы 23 и 24 заполняет студент, внесший изменения в КД. 

5. Сформулировать изменения по замене компонента (или компонентов) 

и для каждого из трех КД, создавая предварительно новый вид, заполнить 

графу 18, при этом учесть, что в спецификацию на «усилитель» изменения 

впоследствии должны быть внесены заменой листа (листов), а в схему Э3 

«усилителя» и перечень элементов к ней – вручную. 

В графе 17 для каждого КД поставить цифру 1. 

При нехватке места на первом листе по 7.1 добавить второй лист (гори-

зонтальный А4) с оформлением – Извещен. об изменен. Посл. листы. 

ГОСТ 2.503-2013 Ф1а. 

6. Сохранить изменения в ИИ (Ctrl+S). 

7. Сохранить ИИ в формате PDF по 17.3 (имя файла и путь – по п. 3). 

8. Внести изменения в КД: 

8.1. Внести изменения в КД с учетом п. 5. 

Если в схему Э3 «усилителя» и перечень элементов к ней по 3-му до-

полнительному этапу проектирования уже были внесены изменения, то пред-

варительно необходимо восстановить в них исходную информацию. 

8.2. Графы 14–18 из таблиц изменений в основных надписях КД запол-

нить вручную в соответствии с табл. М.1, при этом в графе «№ докум.», если 

не был выполнен 9-й дополнительный этап проектирования, обозначение ИИ 

записать полностью (иначе – по усмотрению вносящего изменения). 

ЛР (при наличии) заполнить в соответствии с табл. М.2. 

В качестве примера на рис. М.7 приведено ИИ, составленное для схемы 

Э1 «модуля усилителя» после выполнения 9-го дополнительного этапа про-

ектирования, по которому в нее необходимо добавить следующие данные: 
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 Рис. М.7 



 

 1035 

 Рис. М.8 
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– значения токов потребления «токового зеркала» и управляемого атте-

нюатора; 

– значения уровней управляющего напряжения, подаваемых на выводы 

управления аттенюатора; 

– максимальное значение коэффициента шума, определенное по 2-му 

дополнительному этапу проектирования (см. табл. 2.3). 

На рис. М.8 показан пример внесения изменений в схему Э1 «модуля 

усилителя» по ИИ с рис. М.7 (для сравнения см. рис. 8.67). 

Примеры внесения изменений в различные КД по ИИ также приведены 

в прил. Н. 

М.3. Содержание отчета 

По 6-му дополнительному этапу проектирования (см. табл. 2.3) в отчете 

необходимо привести: 

1. ИИ, распечатанное на отдельном листе (листах). 

2. КД с внесенными изменениями. 

Таблица М.5 

Пример оформления таблицы с перечнем изменений в КД 

КД До изменения После изменения 

   

3. Описание изменений для КД, в которых были выпущены новые листы 

вместо замененных, оформленное в виде таблицы по примеру табл. М.5. 

4. Пояснения к заполнению граф в таблицах изменений основных 

надписей скорректированных КД и в ЛР (при наличии). 
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Н. Преобразование единичных КД в групповые 

Н.1. Групповые и базовые КД 

Достаточно часто разрабатываются изделия, обладающие общими кон-

структивными признаками при некоторых различиях между собой: 

– единство конструкции при различных параметрах (например, электри-

ческих), материалах, покрытиях и др. (например, одинаковые по форме и 

размерам шайбы из разного материала или с разным покрытием); 

– единство конструкции при различных размерах (например, болты оди-

наковой формы, но с разными размерами); 

– сходство конструкции при различной конфигурации, различном рас-

положении или разном количестве некоторых составных частей или кон-

структивных элементов (например, ключи с разной конфигурацией зубьев 

для различных замков). 

На группу подобных изделий вместо единичных КД на каждое изделие 

рекомендуется выполнять КД групповым или базовым способом. Каждое из-

делие в такой группе называется исполнением. Основные определения и пра-

вила выполнения таких КД содержатся в ГОСТ 2.113–75. 

Групповой способ выполнения КД. Групповой способ – способ вы-

полнения комплекта КД на изделия, при котором все исполнения этих изде-

лий содержатся в одном групповом основном КД. При этом такой КД можно 

выполнять на группу изделий, которые имеют одинаковое наименование и 

могут быть отнесены к одной классификационной характеристике, входящей 

в состав обозначения. 

Групповой КД – КД, содержащий постоянные и переменные данные ис-

полнений. Постоянные данные (информация, одинаковая для всех исполне-

ний) вносятся в КД один раз без указания о том, что они относятся ко всем 

изделиям, на которые распространяется этот КД. Переменные данные (ин-

формация, которой различаются исполнения) вносятся в КД с указанием о 

том, к каким конкретно изделиям они относятся. 

Основными критериями для оценки целесообразности выполнения 

групповых КД вместо единичных являются компактность КД на группу из-

делий, обладающих общими конструктивными признаками, и наглядность в 

показе различий между изделиями этой группы.  

По ГОСТ Р 2.201–2023 каждому исполнению присваивается самостоя-

тельно обозначение, структура которого приведена на рис. Н.1. 
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Номер исполнения устанавливают в пределах базового обозначения и 

отделяют разделительным знаком (по умолчанию – дефис). 

Дополнительный номер исполнения – необязательная группа знаков, 

применяемая при наличии переменных характеристик (например, парамет-

ров, покрытий, условий работы, дополнительной комплектации изделия со-

ставными частями и т. п.), которые возможны для исполнений (в рамках пер-

вой группы знаков «ZZ»). В этом случае номер конкретного исполнения 

представляет собой сочетание обеих групп знаков. 

В качестве каждого из двух номеров в общем случае может быть: 

– порядковая нумерация цифрами (начиная с 01) или буквами; 

– характерные (отличительные) признаки исполнений (например, значе-

ние переменного размера). 

Для групп «ZZ» и «VV» допускается изменять количество знаков, а так-

же использовать и не использовать разделительные знаки. 

При групповом способе одно из исполнений условно принимают за ос-

новное и присваивают ему базовое обозначение без номера исполнения 

(например, СПВГ.687253.523). Остальные исполнения содержат номера ис-

полнений (обычно в виде цифр). 

При групповом способе на все исполнения выполняется одна групповая 

спецификация (или один групповой чертеж деталей) и по одному групповому 

неосновному КД необходимого вида (один групповой сборочный чертеж, од-

на групповая схема Э3, один групповой перечень ПЭ3 и др.). 

Вместо одного неосновного группового КД с данными о всех исполне-

ниях допускается выполнять несколько единичных неосновных КД, каждый 

из которых будет содержать данные об одном исполнении, и (или) несколько 

групповых неосновных КД, каждый из которых будет содержать данные о 

нескольких (но не всех) исполнениях (например, сборочный чертеж на ос-

новное исполнение, сборочный чертеж на исполнение 01, групповой сбороч-

ный чертеж на исполнения 02–04 и др.). Такой вариант рекомендуется при 

передаче другому предприятию КД только некоторых исполнений. 

Рис. Н.1 

Номер исполнения 

Общая часть обозначения (базовое обозначение)  

XXXX.AABCDE.NNN-ZZ.VV 

Дополнительный номер исполнения 
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Неосновному КД, относящемуся ко всем исполнениям, присваивают ба-

зовое обозначение с добавлением кода документа в соответствии с рис. 2.2 

(например, СПВГ.468732.523Э3). 

Неосновному КД, выполненному на одно исполнение, присваивают обо-

значение этого исполнения с добавлением кода документа (например, 

СПВГ.468732.523-01Э3). 

Неосновному КД, выполненному на несколько исполнений (но не на 

все), присваивают меньшее (младшее) обозначение из исполнений с добавле-

нием кода документа. Например, у сборочного чертежа, выполненного на ис-

полнения СПВГ.687252.020-02, СПВГ.687252.020-03 и СПВГ.687252.020-10, 

будет обозначение СПВГ.687252.020-02СБ. 

Разным исполнениям могут быть присвоены разные условные наимено-

вания (коды, типы или условные обозначения) в дополнение к общему 

наименованию изделия, например: Пускатель ПК-1Н, Пускатель ПК-1Т и др. 

Их рекомендуется устанавливать только для изделий, подлежащих самостоя-

тельной поставке, и только при необходимости применения наименования в 

сфере эксплуатации, в технической переписке и т. п. Они не могут однознач-

но определять изделия в сфере производства и учета. 

Преобразование единичного КД в групповой. Обозначение основного 

исполнения без указания порядкового номера исполнения при групповом 

способе позволяет достаточно просто преобразовать разработанный ранее 

единичный документ в групповой: обозначение изделия сохраняется неиз-

менным и становится обозначением основного исполнения, а очередным но-

вым исполнениям присваивают порядковые номера, начиная с 01. 

При преобразовании единичных документов в групповые их обозначе-

ния сохраняют неизменными даже в том случае, когда возникает необходи-

мость переиздания документа на другом формате или на другом количестве 

листов. 

Базовый способ выполнения КД. Базовый способ – способ выполне-

ния комплекта КД на изделия, при котором все исполнения этих изделий со-

держатся в одном базовом основном КД. При этом такой КД можно выпол-

нять на группу изделий с одинаковыми наименованиями и классификацион-

ными характеристиками и только на специфицированные изделия. 

Базовый КД – КД, содержащий только постоянные данные исполнений. 

Переменные данные приводятся в отдельных документах исполнений вместе 

с ссылкой на базовый КД. 
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Базовый способ рекомендуется применять в следующих случаях: 

– если при разработке изделия невозможно проработать конструкцию и 

установить конструктивные разновидности, при этом переменные данные 

конкретизируются по мере поступления заказов; 

– при очень большом возможном количестве исполнений, которые могут 

быть оформлены только по мере поступления заказов; 

– если недопустимо наличие в комплекте КД данных других исполнений 

и внесение новых исполнений в ранее разработанные КД нежелательно. 

Базовый способ используется редко и практически не подходит для пре-

образования единичного документа, поэтому далее он не рассматривается. 

Н.2. Правила выполнения КД групповым способом 

К основным правилам выполнения КД групповым способом относятся: 

1. Правила выполнения групповых чертежей (схем). 

1.1. Все сведения о переменных данных (изображениях, размерах, элек-

трических параметрах и др.), которые подлежат включению в чертеж (схему) 

согласно его назначению, должны быть приведены в таблице исполнений. 

На рис. Н.2 показан пример груп-

пового чертежа деталей, которые раз-

личаются данными, не влияющими на 

изображение. 

1.2. На чертеже с соблюдением 

масштаба должно быть изображено 

основное исполнение. Количество 

изображений (видов, разрезов, сече-

ний) основного исполнения и степень 

их упрощения выбираются аналогично 

основному исполнению единичного 

документа. 

На групповой схеме полностью следует изображать схему, относящуюся 

к основному исполнению. 

1.3. Переменные исполнения, различающиеся по форме, показывают на 

отдельных изображениях. Их выполняют в объеме, достаточном для одно-

значного понимания отличия от основного исполнения. 

На таких изображениях следует указывать масштаб, если он отличается 

от приведенного в основной надписи. 

Рис. Н.2 
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1.4. Изображения, относящиеся к одному исполнению, располагают в 

одном месте и рассматривают как отдельный рисунок. 

Каждому рисунку присваивают порядковый номер в пределах чертежа 

(схемы) и записывают над изображениями в виде заголовков. Изображениям 

основного исполнения при наличии переменных изображений других испол-

нений присваивают первый порядковый номер. 

Под наименованием рисунка, начиная со второго, делают запись: 

«Остальное – см. рис. 1». Рисунок и ссылка должны полностью определять 

изображение того исполнения, на которое распространяется рисунок. 

В таблице исполнений помещают графу с заголовком «Рис.», в которой 

указывают один номер рисунка для каждого исполнения (рис. Н.3). 

 

Примечание. Деталь со скруглением полки вместо фаски (то есть с не-

прямолинейным контуром полки) не может быть указана в качестве испол-

нения в групповом чертеже с рис. Н.3, так как такая деталь имеет другой 

код классификационной характеристики (745231). 

1.5. Каждый рисунок может быть выполнен на несколько исполнений, 

которые при одинаковых изображениях различаются другими переменными 

данными, в том числе переменными размерами (рис. Н.4). 

1.6. Допускается переменные элементы показывать на изображениях ос-

новного исполнения, если их принадлежность к определенным исполнениям 

однозначно определена в таблице исполнений. Например, в таблице испол-

нений может быть указано о наличии или отсутствии в разных исполнениях 

элемента, обозначенного на изображении буквой. 

Рис. Н.3 
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На изображениях основного исполнения переменные элементы или 

группы элементов следует изображать сплошными тонкими линиями. 

1.7. Постоянные размеры и другие постоянные данные (шероховатость 

поверхностей и др.) указывают на изображениях основного исполнения. На 

остальных изображениях эти данные не повторяют, если в них нет необхо-

димости для пояснения таких изображений. 

Переменные размеры и другие переменные данные, одинаковые для ис-

полнений, охваченных одним рисунком, указывают на этом рисунке. 

Переменные размеры, не одина-

ковые для всех исполнений, охвачен-

ных одним рисунком, наносят на чер-

теже буквенными обозначениями, 

установленными соответствующими 

стандартами (см. п. 1.8). Конкретные 

номинальные значения этих размеров 

и их предельные отклонения указыва-

ют в таблице исполнений без вырав-

нивания количества знаков для раз-

личных исполнений (рис. Н.4 и Н.5). 

Переменные отклонения форм и 

расположения поверхностей следует наносить на чертеже и указывать в таб-

лице исполнений подобно переменным размерам. 

Переменную шероховатость поверхности, не одинаковую для всех ис-

полнений, охваченных одним рисунком, указывают в таблице исполнений. 

Рис. Н.4 

Рис. Н.5 
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1.8. Основные буквенные обозначения размеров, которые устанавливает 

ГОСТ 2.321–84 [173], приведены в табл. Н.1. 

Таблица Н.1 

Основные буквенные обозначения, применяемые в КД 

Величина Обозначение 

Длина L, l 

Ширина B, b 

Высота, глубина H, h 

Толщина (листов, стенок, ребер и т. д.) s 

Диаметр D, d 

Радиус R, r 

Межосевое и межцентровое расстояние A, a 

Шаг винтовых пружин, болтовых соединений и т. п., 

кроме зубчатых зацеплений и резьбы 
t 

Углы α, β, γ, δ и др. 

Прописные буквы рекомендуется применять для обозначения габарит-

ных и суммарных размеров. 

В случае обозначения в одном документе различных величин одной и 

той же буквой применяют цифровые или буквенные индексы, или их комби-

нацию, причем первый цифровой индекс рекомендуется присваивать второй 

величине, обозначенной данной буквой, например: d, d1, d2, bn, bn1, bn2. 

1.9. На поле чертежа (схемы) должны быть приведены постоянные ТТ и 

другие постоянные данные. 

Переменные ТТ и другие переменные данные, как правило, приводят 

непосредственно в таблице исполнений. 

1.10. Если материал, литера или масса переменные, то их значения ука-

зываются в таблице исполнений, а в соответствующих графах основной 

надписи дается ссылка: «См. табл.». 

Если изображения, относящиеся к исполнениям, невозможно выполнить 

в одном масштабе (например, при переменных размерах), то в графе «Мас-

штаб» ставят прочерк и около изображений масштаб не указывают. 

1.11. Таблица исполнений должна быть помещена на поле чертежа (схе-

мы), как правило, на первом листе. 

Если таблица исполнений занимает много места и ее размещение на 

первом (или на одном) листе нецелесообразно из-за значительного увеличе-

ния формата, то допускается помещать ее на последующих листах чертежа 
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(схемы). В этом случае над основной надписью первого листа должна быть 

запись по типу: «Таблицу исполнений см. на листе 3». 

При выполнении таблицы исполнений рекомендуется оставлять свобод-

ное место справа и снизу для новых граф и строк. 

1.12. В таблицу исполнений должны быть внесены обозначения всех ис-

полнений, на которые распространяется чертеж (схема). 

Обозначения исполнений следует записывать в первую графу слева, 

имеющую заголовок «Обозначение». Запись ведется, как правило, в порядке 

возрастания обозначений. При записи группы исполнений с одинаковыми ба-

зовыми обозначениями полное обозначение следует записывать только для 

одного исполнения, а в последующих строках – дефис и порядковый номер 

исполнения (см. рис. Н.2–Н.5). 

Если для нескольких исполнений, обозначения которых составляют не-

прерывный ряд, данные в таблице одинаковы, то обозначения допускается 

записывать по примеру рис. Н.6, а. 

 

Если одинаковые данные относятся к нескольким исполнениям, обозна-

чения которых не составляют непрерывного ряда, то обозначения исполне-

ний допускается записывать по примеру рис. Н.6, б. Также возможны раз-

личные комбинации из указанных примеров. 

Допускается обозначения исполнений указывать в головке, а наимено-

вания переменных данных – в боковике таблицы (рис. Н.6, в). 

1.13. Переменная составная часть должна иметь для всех исполнений 

один номер позиции независимо от различий в обозначениях, изображениях 

и количестве таких частей для разных исполнений. 

Рис. Н.6 

а 
б 

в 
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Если для одного исполнения применяется несколько одинаковых со-

ставных частей, а для другого исполнения эти составные части разные (име-

ют разные обозначения), то им следует присвоить разные номера позиций. 

Составной части, которая для разных исполнений должна быть записана 

в разных разделах спецификации (например, для одних исполнений применя-

ется сборочная единица, а для других – деталь), следует присваивать один 

номер позиции. 

 

1.14. Номера позиций следует наносить на изображения основного ис-

полнения. На изображениях других исполнений наносят номера позиций 

Рис. Н.7 

а б 

в 
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только для составных частей, не применяемых в основном исполнении, и по-

вторяют номера позиций для составных частей, имеющих иное изображение. 

Примеры групповых сборочных чертежей показаны на рисунках: 

– на рис. Н.7, а – групповой сборочный чертеж, в котором составные ча-

сти различаются данными, не влияющими на изображение; 

– на рис. Н.7, б – групповой сборочный чертеж, в котором составные ча-

сти различаются размерами, не влияющими на изображение; 

– на рис. Н.7, в – групповой сборочный чертеж, в котором составные ча-

сти различаются данными, влияющими на изображения. 

2. Правила выполнения групповых спецификаций. 

2.1. Неосновные групповые документы следует записывать в специфи-

кацию так же, как единичные. При этом документы, распространяющиеся на 

все исполнения, охваченные данной спецификацией, следует записывать как 

постоянные, а остальные документы – как переменные данные. 

2.2. При последовательной записи в пределах одного листа специфика-

ции нескольких документов и составных частей, имеющих одинаковое базо-

вое обозначение, первый документ или составную часть следует записывать 

за полным обозначением, при записи последующих составных частей указы-

вают дефис и порядковый номер исполнения, а при записи документов – де-

фис, порядковый номер исполнения и код документа; при этом для исполне-

ний, оформленных групповым документом, формат указывают только в 

строке, где указано полное обозначение документа (рис. Н.8). 

 

2.3. В групповых спецификациях допускается предусматривать свобод-

ные строки как резерв для последующего внесения постоянных и перемен-

ных данных (например, при оформлении документации нового исполнения). 

2.4. Групповую спецификацию по усмотрению разработчика допускает-

ся выполнять в одном из четырех вариантов (А, Б, В и Г), выбор которого 

Рис. Н.8 
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определяется количеством исполнений и удобством записи постоянных и пе-

ременных данных в конкретном случае. 

В данном учебном пособии будет использоваться вариант А, при кото-

ром групповая спецификация выполняется на отдельных листах формата А4 

со стандартным оформлением для единичных спецификаций (см. рис. 18.1). 

2.5. Групповую спецификацию по варианту А оформляют по правилам 

единичных спецификаций (см. 18.1) с учетом следующих особенностей: 

– вначале записывают постоянные документы и составные части, а затем 

под заголовком «Переменные данные для исполнений» – переменные доку-

менты и составные части раздельно для каждого исполнения под его обозна-

чением, записанным в виде заголовка в графе «Наименование» (рис. Н.9); 

 

– если исполнения имеют условные наименования и (или) находятся на 

разных стадиях разработки, то соответствующую запись (код, литеру), при 

необходимости, дают под заголовком с обозначением исполнения. При этом 

в графе «Лит.» основной надписи ставят прочерк; 

– переменные данные для основного исполнения следует записывать с 

соблюдением правил, установленных для единичных спецификаций, но по-

рядковые номера позиций должны быть продолжением позиций постоянных 

составных частей; 

– переменные данные для каждого последующего исполнения следует 

записывать с соблюдением правил, установленных для единичных специфи-

каций, но составные части независимо от их обозначений следует записывать 

в каждом разделе в порядке возрастания номеров позиций, определившихся 

при записи составных частей для основного исполнения. 

Составные части, не применявшиеся в основном исполнении, следует 

записывать в конце соответствующего раздела; 

Рис. Н.9 
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– при записи в групповую спецификацию очередного исполнения, дан-

ные которого полностью соответствуют одному из предыдущих исполнений 

(например, имеются различия в расположении одинаковых составных ча-

стей), заголовок для переменных данных этого исполнения делают по типу: 

«СПВГ.468732.401-10 (как для СПВГ.468732.401)», «СПВГ.468732.401-05 

(как для 02)». Соответствующие переменные данные при этом вторично не 

записывают. 

Допускается в подобных случаях для нескольких исполнений, непре-

рывно следующих друг за другом, делать общий заголовок по типу: «От 

СПВГ.468732.401 до СПВГ.468732.401-05»; 

– если для какого-либо исполнения переменные данные не применяют-

ся, то ниже заголовка пишут «Отсутствуют». При отсутствии переменных 

данных для всех исполнений в конце групповой спецификации дают запись 

по типу: «Различия исполнений СПВГ.468732.401 и СПВГ.468732.401-01 по 

сборочному чертежу». 

3. Правила выполнения неосновных текстовых документов, содержащих 

текст, разбитый на графы (ведомости, таблицы и т. п.). 

3.1. При выполнении групповых и базовых неосновных текстовых доку-

ментов и соответствующих документов исполнения следует соблюдать тре-

бования стандартов на единичные документы того же вида. 

3.2. Групповые текстовые документы следует выполнять по правилам, 

аналогичным выполнению групповых спецификаций. 

3.3. По варианту А можно выполнять любые групповые документы на 

листах по формам, установленным для единичных документов. 

Н.3. Создание исполнения «усилителя» 

В данном приложении предлагается выполнить 7-й дополнительный 

этап проектирования, заключающийся в преобразовании разработанных на 

«усилитель» единичных КД в групповые с целью добавления исполнения, в 

котором для подачи и снятия СВЧ-сигнала используются указанные в общем 

задании на проектирование коаксиальные торцевые СВЧ-разъемы. 

Основной комплект КД «усилителя» состоит из четырех КД (специфи-

кация, сборочный чертеж, схема Э3 и перечень элементов ПЭ3), в каждый из 

которых необходимо внести соответствующие корректировки в следующей 

рекомендуемой последовательности: 

1. Преобразование схемы Э3. 
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1.1. В Altium Designer открыть проект ПП (см. п. 1 из 12.1) и открыть 

схему Э3 «усилителя» (см. п. 3 из 8.3). 

1.2. Сохранить схему командой File ⇒ Save As в ту же папку и с тем же 

расширением, но с новой версией файла. 

1.3. Сохранить изменения в проекте (см. п. 4 из 5.5). 

1.4. По ГОСТ 2.113-75 при преобразовании документов необходимо 

максимально использовать (без переиздания) подлинники ранее выпущенных 

документов с внесением в них данных, относящихся к новым исполнениям. 

Компоненты в варианте «П1» на схеме находятся в центре листа и зани-

мают много места (см. рис. 8.66). Чтобы ничего не перемещать, вместо изоб-

ражения переменного исполнения переменные элементы будут показаны на 

изображении основного исполнения, что позволит внести изменения в КД по 

ИИ (см. М.1) вручную без замены подлинника. 

В вариантах задания также можно осуществить преобразование добав-

лением изображения переменного исполнения (см. п. 1 из Н.2) или не осу-

ществлять преобразование, а выполнить отдельную единичную схему Э3 на 

переменное исполнение. В последнем случае необходимо сделать копию 

файла схемы, приписать к обозначению изделия в названии файла и в графах 

рамки 2 и 26 (см. табл. 3.1 и рис. 3.6, а и в) номер исполнения и добавить два 

разъема с подключениями без таблицы исполнений. 

1.5. Перейти в сетку 3 мм. 

1.6. Изменить УГО входных и выходных КП: 

– на любой входной или выходной КП запустить команду ПКМ ⇒ Find 

Similar Objects; 

– в открывшемся окне в правом столбце для параметра Current Foot-

print из группы Object Specific выбрать опцию Same; 

– включить опции Select Matching и Run Inspector; 

– нажать кнопку Apply и убедиться в том, что в рабочем поле выделены 

нужные объекты. После этого нажать кнопку OK; 

– в открывшейся панели SCH Inspector в группе Graphical для парамет-

ра Display Mode выбрать опцию Alternate 1 (рис. Н.10); 

– в рабочем поле снять фильтра-

цию (Shift+C). 

Примечание. Особенности рабо-

ты с командой Find Similar Objects 

приведены в Г.6. Рис. Н.10 
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1.7. Добавить два компонента RF-JACK из библиотеки X и расположить 

их слева и справа от входных и выходных КП соответственно. 

После этого выполнить следующее: 

– сориентировать УГО добавленных СВЧ-разъемов так, чтобы их пины 

были направлены на группы КП, около которых они расположены. 

Примечание. Переворот вдоль оси X осуществляется клавишей X; 

– в свойствах СВЧ-разъемов напротив системного параметра Comment 

отключить опцию Visible; 

– левому СВЧ-разъему вручную присвоить позиционное обозначение 

XW1, а правому – XW2; 

– последовательным нажатием клавиш P ⇒ W (создание линии электри-

ческой связи) соединить пины СВЧ-разъемов со свободными отводами КП. 

1.8. Скомпилировать схему и пропу-

стить четыре обнаруженные ошибки, разме-

стив на линиях электрической связи, отхо-

дящих от пинов СВЧ-разъемов, соответству-

ющие директивы (см. п. 9.8 из 8.3). 

Результат для левого СВЧ-разъема пока-

зан на рис. Н.11. 

1.9. Перейти в сетку 1 мм. 

1.10. Последовательным нажатием клавиш P ⇒ D ⇒ L (создание линии) 

нарисовать таблицу из двух столбцов и трех строк высотой по 8 мм каждая. 

После этого последовательным нажатием клавиш P ⇒ T (создание 

надписи) заполнить таблицу по анало-

гии с рис. Н.12 (подробнее см. в Н.2). 

При записи названия СВЧ-разъема 

первым символом необходимо поста-

вить пробел, чтобы надпись не превра-

тилась в гиперссылку. 

Примечание. Вместо прочерка можно написать «Отсутствуют». 

1.11. Сохранить изменения в схеме Э3 (Ctrl+S). 

Результат в варианте «П1» с внесенными изменениями по ИИ и с 6-м 

дополнительным этапом проектирования (см. табл. 2.3) показан на рис. Н.13. 

1.12. Сохранить схему Э3 в формате PDF по 8.4. 

Прошлые версии файлов схемы Э3 «усилителя» в форматах SCH и PDF 

можно удалить. 

Рис. Н.12 

Рис. Н.11 
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 Рис. Н.13 
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2. Преобразование перечня элементов ПЭ3. 

2.1. Открыть перечень элементов ПЭ3 «усилителя» в Microsoft Word и 

сохранить его с новой версией файла. 

Следует отметить, что в вариантах задания вместо преобразования мож-

но выполнить отдельный единичный перечень элементов ПЭ3 на переменное 

исполнение. В этом случае необходимо сделать копию файла перечня, при-

писать к обозначению изделия в названии файла и в графе основной надписи 

на первом и втором листах номер исполнения и добавить два разъема. 

2.2. После всех компонентов в соответствии с пп. 2 и 3 из Н.2 записать 

переменные данные, обратив внимание на следующее: 

– заголовок «Переменные данные для исполнений» следует записать в 

графе «Наименование»; 

– СВЧ-разъемы должны быть указаны как в основном исполнении, так и 

в переменном, при этом в основном исполнении в графе «Наименование» за-

писывается «Отсутствуют», а графы «Кол.» и «Примечание» не заполняются; 

– до и после заголовка необходимо оставить по одной пустой строке; 

– добавление новых строк осуществляется по п. 7 из 9.2; 

– удаление лишних строк осуществляется по п. 8 из 9.2; 

– если вся информация в перечне элементов не поместилась на двух ли-

стах, то по аналогии с п. 9 из 9.2 необходимо показать ЛР. 

2.3. Сохранить изменения в перечне элементов (Ctrl+S). 

Результат в варианте «П1» с внесенными изменениями по ИИ и с 6-м 

дополнительным этапом проектирования показан на рис. Н.14.  

2.4. Сохранить перечень элементов в формате PDF по п. 11 из 9.2. 

Прошлые версии файлов перечня элементов ПЭ3 «усилителя» в форма-

тах DOC и PDF можно удалить. 

3. Преобразование сборочного чертежа. 

3.1. Открыть сборочный чертеж «усилителя» в КОМПАС-3D и сохра-

нить его с новой версией файла. 

В варианте «П1» на листах чертежа практически нет свободного места 

(см. рис. 19.40) и добавление переменных элементов на изображения основ-

ного исполнения без перемещения графических объектов невозможно. По-

этому для минимизации корректировок будет добавлен новый лист формата 

А4 (при преобразовании формата второго листа из А4 в А3 придется вносить 

дополнительное изменение в спецификацию) с изображениями переменного 

исполнения и установочным чертежом разъемов. 
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 Рис. Н.14 Начало (окончание см. на с. 1054) 
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 Рис. Н.14 Окончание (начало см. на с. 1053) 
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В вариантах задания вместо преобразования можно выполнить отдель-

ный единичный сборочный чертеж на переменное исполнение. 

3.2. Убедиться в том, что включены глобальные привязки, задан шаг 

сетки 0.1 мм и включено ее отображение (см. пп. 4 и 5 из 6.5). 

3.3. По пп. 27.1 и 27.2 из 17.2 на пер-

вом листе чертежа создать новый вид, доба-

вить в него таблицу с тремя столбцами и 

строками и заполнить ее по рис. Н.15, а. 

Массу для основного исполнения взять 

из графы «Масса» основной надписи, а для 

исполнения 01 добавить к этому значению 

массу двух торцевых разъемов – 3,4 г. 

3.4. Удалить значение массы из графы 

«Масса» основной надписи чертежа. 

Затем создать новый вид, добавить в 

него в две строки надпись «См. табл.» с вы-

равниванием по центру и переместить его в графу «Масса» (рис. Н.15, б). 

3.5. Создать новый вид над изображениями Вида спереди и Вида слева. 

Командой Ввод текста (ПИ Компактная панель ⇒ Обозначения) до-

бавить обозначение рисунка «Рис. 1» со следующими параметрами: Шрифт – 

GOST type A; высота символов – 5; Курсив и Подчеркнутый – включить. 

3.6. По 7.1 добавить третий лист (вертикальный А4) с оформлением 

Чертеж констр. Посл. листы. ГОСТ 2.104-2006. 

3.7. На листе № 3 создать новый вид (масштаб – масштаб чертежа, имя – 

Рис. 2) и скопировать в него изображение с Вида спереди. 

3.8. Удалить с добавленного изображения размеры, обозначение пози-

ции и позиционные обозначения. 

 Рис. Н.16 

Рис. Н.15 

а 

б 
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Для выделения нужных объектов выделить вид Рис. 2 и запустить ко-

манду Выделить ⇒ По свойствам. В появившемся окне выбрать группу 

Размеры и опции Обозначение позиций и Тексты в группе Обозначения, 

после чего нажать OK (см. рис. Н.16). 

3.9. Над изображением в виде Рис. 2 командой Ввод текста добавить 

обозначение рисунка «Рис. 2» и параметрами шрифта из п. 3.5, при этом сле-

дует обратить внимание на информацию п. 1.4 из Н.2. 

3.10. Открыть файл установочного чертежа торцевого СВЧ-разъема из 

папки …\ИДРЭС\Монтаж элементов. 

На вкладке с установочным черте-

жом сделать текущим Вид 1, после чего 

выделить и скопировать изображение за 

точку начала координат (рис. Н.17). 

3.11. Входная и выходная КП на ПП 

расположены симметрично относительно 

крепежных отверстий, поэтому для пози-

ционирования торцевых СВЧ-разъемов на изображении переменного испол-

нения следует провести вспомогательную линию. 

В варианте «П1» на вкладке со сборочным чертежом на изображении в 

виде Рис. 2 командой Биссектриса (см. рис. 6.13) из ПИ Компактная па-

нель ⇒ Геометрия после двух щелчков ЛКМ по горизонтальным осевым 

линиям отверстий добавлена средняя прямая между ними (рис. Н.18, а). 

 

3.12. Вставить скопированное изображение в требуемые места изобра-

жения на виде Рис. 2 (рис. Н.18, б). 

При необходимости воспользоваться командами Сдвиг, Поворот или 

Симметрия (см. рис. 6.20) из ПИ Компактная панель ⇒ Редактирование. 

3.13. Получившееся изображение на виде Рис. 2 в варианте «П1» оказа-

лось расположено впритык к рамке листа, поэтому у вида был изменен мас-

Рис. Н.18 

а б 

Рис. Н.17 
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штаб на 2:1, и указанное значение добавлено в надпись с обозначением ри-

сунка. 

Примечание. В обозначении рисунка масштаб вида можно указать не 

вручную, а ссылкой. Для этого в режиме редактирования надписи запуска-

ется команда ПКМ ⇒ Вставить ссылку и в открывшемся окне «Ссылка» 

выполняется следующее: 

– в поле «Тип источника» выбирается опция «Вид»;  

– в поле «Ссылка на» выбирается опция «Масштаб»; 

– включается опция «В скобках»; 

– в группе «Список источников» выбирается вид «Рис. 2». 

Затем у добавленной ссылки изменяются параметры шрифта. 

3.14. Командой Линейный размер или Авторазмер (см. рис. 7.21) из 

ПИ Компактная панель ⇒ Размеры показать габаритные размеры исполне-

ния, изменившиеся в результате установки СВЧ-разъемов. 

После размерных чисел поставить знак «*». 

3.15. Командой Ввод текста добавить позиционные обозначения разъ-

емов СВЧ, присвоенные им на схеме Э3 «усилителя», с параметрами шрифта 

по п. 14.8 из 19.3. 

Результат в варианте «П1» на данном этапе показан на рис. Н.19. 

 

3.16. Добавить вид слева на изображение переменного исполнения, для 

чего на виде Рис. 2 с левой стороны от изображения показать стрелку взгля-

Рис. Н.19 
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да, а вид по стрелке в масштабе, указанном в основной надписи, поместить 

на свободном месте чертежа (так как виды на чертеже не являются ассоциа-

тивными, то опция Проекционная связь отсутствует). 

Следует обратить внимание на то, что в зависимости от размеров изоб-

ражения и расположения СВЧ-разъемов в других вариантах задания можно 

сделать следующее: 

– повернуть вид по стрелке (см. п. 12.1 из 21.1); 

– изменить масштаб вида по стрелке (при этом в параметрах вида необ-

ходимо включить опцию Масштаб); 

– вместо вида по стрелке добавить с Вида слева необходимое количе-

ство выносных элементов в нужном масштабе (при этом показывать изобра-

жения выносных элементов для основного исполнения не нужно). 

3.17. В созданный вид по стрелке копированием поместить изображение 

с Вида слева, после чего выполнить следующее: 

– удалить все размеры; 

– вставить с вида Рис. 2 необходимую для позицио-

нирования входного СВЧ-разъема горизонтальную линию 

(рис. Н.20); 

– перейти на вкладку с установочным чертежом, сде-

лать текущим Вид 2 и скопировать изображение за точку 

начала координат; 

– перейти на вкладку со сборочным чертежом и вста-

вить скопированное изображение в точку пересечения 

вспомогательной линии и верхней поверхности ПП; 

– при необходимости добавить изображение с вида 

Вид 3 из вкладки с установочным чертежом; 

– удалить лишние линии командой Усечь кривую (см. рис. 6.20) из ПИ 

Компактная панель ⇒ Редактирование. В варианте «П1» также была уда-

лена часть изображения, совпадающая с изображением на Виде слева для 

основного исполнения (для создания обрыва использована команда Сплайн 

по точкам с настройками по п. 16 из 7.3); 

– командой Линейный размер или Авторазмер показать размеры, из-

менившиеся в результате установки СВЧ-разъемов. После размерных чисел 

поставить знак «*». 

3.18. Удалить вспомогательные линии со всех изображений переменного 

исполнения. 

Рис. Н.20 
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 Рис. Н.21 Начало (продолжение и окончание см. на с. 1060 и 1061) 
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 Рис. Н.21 Продолжение (начало см. на с. 1059, окончание – на с. 1061) 
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 Рис. Н.21 Окончание (начало см. на с. 1059 и 1060) 
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3.19. По пп. 23.1–23.7 из 19.3 добавить установочный чертеж коаксиаль-

ного торцевого СВЧ-разъема. 

Затем заменить номер пункта на линии-выноске с обозначением пайки 

ссылкой на 2-й пункт ТТ. Настройки окна Ссылка задать по п. 28.4 из 19.3. 

3.20. Сохранить изменения в сборочном чертеже (Ctrl+S). 

Результат в варианте «П1» с внесенными изменениями по ИИ показан на 

рис. Н.21. 

3.21. Сохранить сборочный чертеж в формате PDF по 17.3. 

Прошлые версии файлов сборочного чертежа в форматах CDW и PDF 

можно удалить. 

4. Преобразование спецификации. 

4.1. Открыть спецификацию на «усилитель» в Microsoft Word и сохра-

нить ее с новой версией файла. 

В варианте «П1» все неосновные единичные КД на «усилитель» преоб-

разованы в групповые, поэтому в спецификации в переменных данных будут 

только разъемы СВЧ. Если в вариантах задания какой-либо неосновной КД 

не был преобразован в групповой (на исполнение был выполнен единичный 

неосновной КД), то такой КД записывается в переменных данных. 

4.2. После всех записанных данных добавить заголовок «Переменные 

данные для исполнений», располагающийся в графах «Обозначение» и 

«Наименование» (см. рис. Н.9), для чего выполнить следующее: 

– запустить команду Вставка ⇒ Фигуры ⇒ 

Надпись (см. рис. Н.22); 

– зажатой ЛКМ показать границы надписи; 

– внутри надписи записать название заго-

ловка (параметры шрифта: Шрифт – GOST type 

A; Размер шрифта – 12; Курсив – включить); 

– выполнить на границе добавленной 

надписи команду ПКМ ⇒ Формат автофигуры 

или рисунка; 

– в открывшемся окне Формат текстового 

поля на вкладке Надпись включить опцию под-

гонять размер автофигуры под текст, а на 

вкладке Цвета и линии в группах Заливка и Линии для параметра Цвет 

выбрать опцию Нет цвета (см. рис. Н.23); 

– зажатой ЛКМ скорректировать положение надписи. 

Рис. Н.22 
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4.3. В соответствии с п. 2 из Н.2 записать переменные данные, обратив 

внимание на следующее: 

– до и после заголовков необходимо оставить по одной пустой строке; 

– добавление новых строк осуществляется по п. 7 из 9.2; 

– удаление лишних строк осуществляется по п. 8 из 9.2; 

– если вся информация в спецификации не поместилась на четырех ли-

стах, то по аналогии с п. 9 из 9.2 необходимо показать ЛР. 

4.4. Если были изменены форматы листов групповых КД, то внести со-

ответствующие корректировки в разделе «Документация». 

4.5. Сохранить изменения в спецификации (Ctrl+S). 

Результат в варианте «П1» с внесенными изменениями по ИИ и с 6-м 

дополнительным этапом проектирования показан на рис. Н.24. 

4.6. Сохранить спецификацию в формате PDF по п. 11 из 9.2. 

Прошлые версии файлов спецификации в форматах DOC и PDF можно 

удалить. 

5. Удалить вспомогательную информацию из папки …\ИДРЭС-П1\Уси-

литель: 

– backup-файл сборочного чертежа «усилителя»; 

– папку History с резервными копиями схемы Э3 «усилителя», создава-

емых при каждом их сохранении. 

В результате при групповом способе выполнения КД в варианте «П1» на 

два изделия создано четыре КД вместо восьми, при этом для второго изделия 

не понадобилось использовать обозначение с новым порядковым регистра-

ционным номером. 

ИИ, по которому были внесены изменения в данном этапе проектирова-

ния, показано на рис. Н.25. 

Рис. Н.23 
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 Рис. Н.24 Начало (продолжение и окончание см. на с. 1065 и 1066) 
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 Рис. Н.24 Продолжение (начало см. на с. 1064, окончание – на с. 1066) 
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 Рис. Н.24 Окончание (начало см. на с. 1064 и 1065) 
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 Рис. Н.25 Начало (продолжение и окончание см. на с. 1068 и 1069) 
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 Рис. Н.25 Продолжение (начало см. на с. 1067, окончание – на с. 1069) 
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 Рис. Н.25 Окончание (начало см. на с. 1067 и 1068) 
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3D-вид исполнения показан на рис. Н.26. 

Примечание. Изображение получено в Altium Designer после добавления 

в формате STEP из КОМПАС-3D на слой M5 Top 3D 3D-моделей торцевых 

СВЧ-разъемов с включенным отображением резьбы и укороченной на 1 мм 

центральной жилой (см. пп. 1 и 5 из 6.6). Для скрытия появившихся ошибок в 

окне PCB Rules and Constraints Editor (команда Design ⇒ Rules) в подразделе 

Design Rules ⇒ Placement ⇒ Component Clearance предварительно было со-

здано правило проектирования с высшим приоритетом между КП и моде-

лями разъемов (InNamedUnion('InputPads') OR InNamedUnion('OutputPads') и 

Identifier = 'EMPCB.SMAFSTJ.B.HT' соответственно). В правиле включена 

опция Infinite, а расстояние по горизонтали задано отрицательной величи-

ной (в этом случае зазоры не проверяются). 

Н.4. Содержание отчета 

По 7-му дополнительному этапу проектирования (см. табл. 2.3) в отчете 

необходимо привести: 

1. Четыре КД (спецификация, сборочный чертеж, схема Э3 и перечень 

элементов ПЭ3), в которых содержится информация об исполнении «усили-

теля» с двумя торцевыми коаксиальными СВЧ-разъемами. 

2. Краткое описание произведенных изменений. 

Рис. Н.26 
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П. Ведомость покупных изделий 

П.1. Общие сведения 

Ведомость покупных изделий (ВП) по ГОСТ Р 2.102–2023 – текстовый 

КД, содержащий перечень покупных изделий, примененных в разрабатывае-

мом изделии. 

Код ведомости покупных изделий – ВП. 

Правила оформления ВП содержатся в ГОСТ Р 2.106–2019, среди кото-

рых можно выделить следующие: 

1. ВП составляют на основании всех спецификаций данного изделия на 

отдельных листах формата А3 с оформлением в рамках по ГОСТ Р 2.104–

2023, которое упрощенно показано на рис. 3.5, б. 

Оформление основной надписи и дополнительных граф для текстовых 

документов описано в п. 3 из 9.1. 

ВП оформляют в виде таблицы (рис. П.1), заполняемой сверху вниз, с 

фиксированными размерами столбцов и строк. На рисунке размеры столбцов 

приведены с отступлением от принятого масштаба. 

 

2. Запись покупных изделий производят по 

разделам, наименования которых устанавливают в 

зависимости от характера покупных изделий, вно-

симых в ведомость. Разделы записывают в виде за-

головков в графе «Наименование» и подчеркивают 

(рис. П.2). 

3. В каждом разделе ВП рекомендуется запи-

сывать изделия по однородным группам, в преде-

лах групп – в алфавитном порядке их наименований, в пределах каждого 

наименования – по типам и видам, в пределах типов и видов – в порядке воз-

растания размеров или других параметров. 

Рис. П.1 

Рис. П.2 
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4. В графе «№ строки» указывают порядковый номер строки. На каж-

дом последующем листе нумерация начинается заново. 

5. В графе «Наименование» указывают наименование и типоразмер из-

делия в соответствии с обозначением, установленным в документе на постав-

ку. При записи изделий одинакового наименования, отличающихся размера-

ми или другими данными, допускается наименование этих изделий записы-

вать на каждом листе ВП один раз. 

6. В графе «Код продукции» указывают код продукции по классифика-

тору продукции страны – разработчика конструкторской документации. Ко-

ды покупных изделий по классификаторам продукции других стран не ука-

зывают. 

В Российской Федерации в настоящее время действует Общероссийский 

классификатор продукции по видам экономической деятельности классифи-

катор ОК 034–2014 (КПЕС 2008), также известный под сокращением ОКПД 2 

[174]. Он был принят приказом Росстандарта от 31.01.2014 № 14-ст взамен 

ранее действовавшего классификатора ОК 005–93, известного под сокраще-

нием ОКП. 

Например, использованные в варианте «П1» крепежные изделия имеют 

следующие коды продукции: 

– винты ГОСТ 1491–80 и ГОСТ 17475–80 – 25.94.11.110; 

– шайба ГОСТ 10450–78 – 25.94.12.110.  

Цифры в коде 25.94.11.110 означают (слева направо): 

– 25 – изделия металлические готовые, кроме машин и оборудования; 

– 9 – изделия металлические готовые прочие; 

– 4 и 1 – изделия крепежные и винты крепежные; 

– 1 – изделия крепежные резьбовые из черных металлов, не включенные 

в другие группировки; 

– 110 – болты и винты из черных металлов; 

Последние четыре цифры в коде 25.94.12.110 означают (слева направо): 

– 2 – изделия крепежные нерезьбовые из черных металлов, не включен-

ные в другие группировки; 

– 110 – шайбы из черных металлов. 

7. В графе «Обозначение документа на поставку» указывают номер 

документа на поставку (например, техническое условие на изделие). При за-

писи нескольких изделий, поставляемых по одному документу, допускается 

обозначение документа записывать на каждом листе ВП один раз. 
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8. В графе «Поставщик» указывают наименование (адрес) предприя-

тия-поставщика. Графу заполняют по усмотрению разработчика. Например, 

здесь обычно записывают наименования фирм для импортных компонентов. 

9. В графе «Куда входит (обозначение)» указывают обозначение спе-

цификации изделия или его составных частей, в которые непосредственно 

входит записанное в ВП покупное изделие. 

Для изделий, входящих непосредственно в изделие, на которое состав-

ляют ВП, эту графу допускается не заполнять, если ее заполняют для всех 

изделий, входящих в специфицированные составные части. 

10. В графе «Количество на изделие» указывают количество записан-

ных в ВП покупных изделий, входящих в одно изделие, а также в состав 

набора подборных частей. 

11. В графе «Количество в комплекты» указывают количество покуп-

ных изделий, входящих в комплекты (монтажных частей, сменных частей, 

запасных частей, инструмента и принадлежностей, укладок, тары и пр.) или 

записанных в спецификациях изделия и его составных частей в разделе 

«Комплекты». 

12. В графе «Количество на регулир.» указывают количество изделий, 

которое амортизируется при регулировке и испытании одного изделия, запи-

санного в графе «Куда входит (обозначение)». Количество изделий, как пра-

вило, выражают десятичной дробью. Например, 0,2 означает, что для регули-

ровки 10 изделий, на которые составляют ВП, требуется два изделия. 

13. В графе «Количество, всего» указывают общее количество изделий, 

записанных в графах «Количество на изделие», «Количество в комплекты» и 

«Количество на регулир.». 

Если записанное в ВП покупное изделие входит в изделие и в одну или 

несколько составных частей изделия, то в графе «Количество, всего» указы-

вают под итоговой чертой общее количество покупных изделий (рис. П.3). 

 Рис. П.3 
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14. В графе «Примечание» указывают дополнительные данные, напри-

мер единицы измерения для изделий, измеряемых не в штуках. 

15. При большом количестве разделов ВП допускается в начале первого 

(заглавного) листа в графе «Наименование» приводить перечень разделов 

данной ведомости с указанием в графе «Обозначение документа на постав-

ку» номеров листов, на которых помещены эти разделы (рис. П.4). 

 

16. В ВП комплекса не перечисляют покупные изделия составных ча-

стей, на которые имеются свои ВП. В этом случае в конце ведомости дают 

ссылку на ВП входящих составных частей. 

17. При применении в изделии импортных покупных изделий в графы 

ВП их вносят с теми обозначениями и наименованиями, которые содержатся 

в сопроводительной технической документации (документах на поставку), в 

графе «Обозначение документа на поставку» указывают обозначение сопро-

водительного технического документа (документа на поставку). 

Допускается одновременно указывать аутентичные обозначения и 

наименования на русском языке. 

П.2. Создание ВП 

В данном приложении предлагается выполнить 8-й дополнительный 

этап проектирования, состоящий в разработке ВП на «модуль усилителя». 

ВП будет оформлена в Microsoft Word на заранее подготовленной заго-

товке «Ведомость ВП, вариант А.doc» из папки …\ИДРЭС\MSWord заго-

товки (см. рис. 2.9). 

Отличие данной заготовки от заготовки для перечня элементов (см. 9.2) 

только в форме заполняемой таблицы в рабочем поле листа и в формате ис-

пользуемых листов. 

Для создания ВП следует выполнить следующее: 

1. Открыть указанную выше заготовку. 

Рис. П.4 
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2. Сохранить заготовку командой Файл ⇒ Сохранить как с расшире-

нием «.doc». Имя файла в варианте «П1» – «УП1.00.01ВП - Модуль усили-

теля - v0.1», а путь сохранения – …\ИДРЭС-П1. 

3. Войти в режим редактирования нижних колонтитулов п. 3 из 9.2 и за-

полнить без копирования графы рамки в соответствии с табл. П.1. Содержа-

ние остальных граф должно соответствовать данным табл. 9.1. 

Пояснения к графам даны в табл. 3.1, на рис. 9.1 и на рис. 3.6, б и в. 

Таблица П.1 

Содержание граф рамки для ВП на «модуль усилителя»,  

отличающихся от перечня элементов ПЭ3 «усилителя» 

Номер  

графы 
Содержание Комментарий к заполнению 

1 

Модуль усилителя 

Ведомость покупных 

изделий 

Наименование изделия определено в табл. 2.1. 

Наименование документа присутствует в используе-

мой заготовке по умолчанию 

2 

(на первом и 

втором ли-

сте, и на ЛР) 

УП1.00.01ВП 

Обозначение документа указано для варианта «П1». 

Обозначение со второго листа при увеличении числа 

листов повторяется на каждом последующем 

25 УП1.00.01 
Обозначение спецификации, в которой записан КД, 

определено в табл. 2.1 и указано для варианта «П1» 

4. Выйти из режима редактирования колонтитулов по п. 4 из 9.2. 

5. Используя спецификации на «усилитель» и «модуль усилителя», в со-

ответствии с информацией из П.1 заполнить графы таблицы из рабочего по-

ля, кроме графы «№ строки», при этом необходимо обратить внимание на 

следующее: 

– после каждого заголовка должна быть одна пустая строка; 

– перед каждым заголовком должно быть не менее одной пустой строки; 

– добавление новых строк осуществляется по п. 7 из 9.2; 

– удаление лишних строк осуществляется по п. 8 из 9.2. 

– если слово не помещается в ячейку, то необходимо либо перенести его 

часть в ячейку ниже, либо вписать в ячейку по п. 6 из 11.1. 

6. Заполнить графу «№ строки». 

7. Если вся информация в ВП поместилась на двух первых листах, то в 

соответствии с п. 13 из 9.1 скрыть ЛР. 

Для этого выполнить п. 9 из 9.2. 

8. Сохранить изменения в ВП (Ctrl+S). 

Результат в варианте «П1» показан на рис. П.5. 
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 Рис. П.5 Начало (окончание см. на с. 1077) 
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 Рис. П.5 Окончание (начало см. на с. 1076) 
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9. Сохранить ВП в формате PDF по п. 11 из 9.2. 

Имя файла в варианте «П1» – «УП1.00.01ВП - Модуль усилителя - 

v0.1», а путь сохранения – …\ИДРЭС-П1\_pdf. 

П.3. Содержание отчета 

По 8-му дополнительному этапу проектирования (см. табл. 2.3) в отчете 

необходимо привести: 

1. ВП на «модуль усилителя», распечатанную на отдельных листах. 

2. Описание изменения (с поясняющим рисунком), которое потребова-

лось бы выполнить при включении ведомости покупных изделий «модуля 

усилителя» в комплект КД. 
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Р. Обозначения разработанных КД по основной структуре 

системы обозначения 

Р.1. Общие сведения 

При проектировании в данном учебном пособии был использован моди-

фицированный объектно-ориентированный способ обозначения изделий и 

КД, что связано с некоторыми отмеченными в 2.3 упрощениями, которые он 

обеспечивает. Однако на многих предприятиях на стадии рабочей конструк-

торской документации в основном используется обезличенный способ, кото-

рый до недавнего времени (по старой редакции ГОСТ 2.201) был единствен-

но возможным. 

В табл. Р.1 приведены возможные варианты обозначения основных КД 

изделий, разработанных в варианте «П1», по обезличенной способу со сле-

дующими предположениями: 

– организацией-разработчиком является СПбГЭТУ «ЛЭТИ»; 

– коды классификационной характеристики для деталей выбраны после 

их разработки, т. е. уже после того, как были определены значения парамет-

ров, влияющих на присвоение данных кодов; 

– по каждому коду классификационной характеристики в организации 

уже было разработано некоторое количество изделий, например: для кода 

741512 – 168 изделий, для кода 735214 – 86 изделий. 

Таблица Р.1 

Обозначения основных КД, принятые в учебном пособии, 

и варианты их обозначения по основной структуре системы обозначения 

Наименование изделия  

по табл. 2.1 

Обозначение основного КД 

по табл. 2.1 
по основной структуре  

системы обозначения 

Модуль усилителя УП1.00.01 СПВГ.468732.524 

Основание УП1.00.02 СПВГ.741512.169 

Экран УП1.00.03 СПВГ.735214.087 

Усилитель УП1.01.01 СПВГ.468732.523 

Плата печатная УП1.01.02 СПВГ.687252.523 

В качестве примера в табл. Р.1 показано следующее: 

– изделия с разными кодами классификационной характеристики могут 

иметь одинаковые порядковые регистрационные номера («усилитель» и ПП); 

– изделия с разными наименованиями могут иметь одинаковые коды 

классификационной характеристики («усилитель» и «модуль усилителя»). 
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Обозначение неосновного КД изделия состоит из обозначения его ос-

новного КД и кода документа (см. рис. 2.2). Например, обозначение сбороч-

ного чертежа «усилителя» по основной структуре системы обозначения бу-

дет записано как СПВГ.468732.523СБ. 

В табл. Р.2 дана расшифровка кодов классификационной характеристики 

их табл. Р.1. 

Таблица Р.2 

Расшифровка кодов классификационной характеристики 

Код  

классификационной  

характеристики 

Расшифровка 

468732 

Класс 46 – средства радиоэлектронные управления, связи, 

навигации и вычислительной техники. 

Подкласс 8 – составные части функциональные формирования 

и обработки сигналов, контроля, технической диагностики, сиг-

нализации, защиты, отражатели защитные, управления, коммута-

ции, сопряжения, образования видеосигнала, развертывающие, 

отклоняющие, фокусирующие, корректирующие, антенн, фидер-

ного тракта, телеграфных, телефонных средств, усилители, гене-

раторы, задержки электрического сигнала, фильтры. 

Группа 7 – усилители, генераторы. Средства задержки элек-

трического сигнала. 

Подгруппа 3 – усилители непрерывных сигналов с частотой до 

3 ГГц, кроме операционных. 

Вид 2 – электронные с диапазонами частот свыше 3 МГц до 

3 ГГц 

687252 См. 2.3 

735214 

Класс 73 – «детали – не тела вращения» корпусные, опорные, 

емкостные. 

Подкласс 5 – емкостные (резервуары, коробки, футляры, кожу-

хи, капоты, крышки, поддоны, донья, укладки и др.). 

Группа 2 – кроме изогнутых из листов, полос и лент. 

Подгруппа 1 – из твердых материалов с наружной поверхно-

стью призматической. 

Вид 4 – кроме откидных без патрубков с отверстиями 

741512 

Класс 74 – «детали – не тела вращения» плоскостные; рычаж-

ные, грузовые, тяговые; аэрогидродинамические; изогнутые из 

листов, полос и лент; профильные; трубы. 

Подкласс 1 – плоскостные с параллельными основными плос-

костями. 

Группа 5 – с основными плоскостями ступенчатыми (с одной 

стороны). 

Подгруппа 1 – с плоскими выступами, без пазов на основных 

плоскостях, с контуром прямолинейным с L до 3B включительно. 

Вид 2 – без пазов на гранях, с отверстиями 
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Коды классификационной характеристики в вариантах задания могут 

отличаться от приведенных в табл. Р.1 для следующих изделий: 

– ПП (код вместо 687252 может быть 687253, где вид 3 означает, что 

ширина ПП находится в диапазоне «свыше 50 до 125 мм включительно»); 

– «усилитель» и «модуль усилителя» (код вместо 468732 может быть 

468719, где подгруппа 1 означает «усилители сигналов с частотой от 3 ГГц», 

а вид 9 – «прочие»). 

Комментарии к табл. Р.2 по 73-му и 74-му классам: 

– «деталь – тело вращения» – деталь, наружной поверхностью которой 

является поверхность вращения (рис. Р.1, а). В том числе – детали с элемен-

тами не тел вращения любой длины, вписывающимися в окружность 

наибольшего диаметра детали (рис. Р.1, б). 

На рис. Р.1, б диагоналями со сплошными тонкими линиями обозначена 

плоская поверхность предмета в соответствии с ГОСТ 2.305–2008; 

 

– поверхность вращения – поверхность, образованная вращением ли-

нии вокруг оси с постоянным радиусом вращения; может быть цилиндриче-

Рис. Р.1 [175] 

а б в 

г д е ж 

з и к 
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ской, конической, криволинейной и комбинированной, а также наружной и 

внутренней; 

– паз – выемка (углубление) в детали, являющаяся конструктивным эле-

ментом, расположенным на боковой поверхности или на торце. 

Паз может быть открытым с одной (см. рис. Р.1, в) или двух противопо-

ложных сторон (см. рис. Р.1, з) или закрытым. Углубление, круглое в попе-

речном сечении, классифицируется как отверстие вне оси детали; 

– деталь емкостная – деталь коробчатой формы, имеющая в одном или 

нескольких сечениях замкнутый контур (рис. Р.1, г); 

– деталь корпусная с призматической наружной поверхностью – де-

таль, наружная поверхность которой образована плоскими поверхностями, 

образующими трехгранные углы (рис. Р.1, д); 

– деталь плоскостная – деталь, форма наружной поверхности которой 

образована основными плоскостями и другими поверхностями любой формы 

(рис. Р.1, в, е, ж, и, к); 

– основные плоскости – две противоположные наибольшие по площади 

плоские поверхности детали. Если все поверхности детали равны по площа-

ди, то ими считаются плоскости с наиболее сложным контуром в плане; 

– деталь плоскостная ступенчатая – деталь с основными плоскостя-

ми, на которых имеются выступы, открытые с трех или четырех сторон. При 

этом под выступами понимается часть детали, выступающая от основной 

плоскости и образующая ступень (рис. Р.1, ж, и, к); 

– контур прямолинейный – контур детали, образованный прямыми ли-

ниями (рис. Р.1, е, ж, и, к). Фаски или скругления кромок при этом не учиты-

ваются; 

– при определении длины (L), ширины (B) и высоты (H) детали исходят 

из правила, что L > B > H. 

Р.2. Замена обозначений разработанных КД 

В данном приложении предлагается выполнить 9-й дополнительный 

этап проектирования, заключающийся в замене обозначений всех разрабо-

танных КД на указанные в Р.1. 

Необходимо обратить внимание на следующее: 

– в порядковых регистрационных номерах первые две цифры должны 

быть номером варианта задания, а третья – произвольная с учетом информа-

ции из данного приложения и 2.3; 
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 Рис. Р.2 Начало (окончание см. на с. 1084) 
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 Рис. Р.2 Окончание (начало см. на с. 1083) 
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– в проекте со схемой Э3 «усилителя» обозначение КД следует изменить 

на новое в значении параметра, созданного в п. 5.2 из 8.2; 

– допускается все необходимые изменения аккуратно внести вручную в 

распечатанные версии КД, скрыв ненужные надписи канцелярскими коррек-

тирующими средствами; 

– корректировки могут потребоваться не только в графах рамки. 

В качестве примера на рис. Р.2 показана спецификация на «модуль уси-

лителя» (для сравнения см. рис. 22.3), в которой произведены следующие 

корректировки: 

– в графе 2 основной надписи на 1-ом и 2-ом листах заменено обозначе-

ние КД; 

– заменены обозначения семи КД в столбце «Обозначение»; 

– в разделе «Детали» изделия поменяны местами (см. п. 1.5 из 18.1). 

Р.3. Содержание отчета 

По 9-му дополнительному этапу проектирования (см. табл. 2.3) в отчете 

необходимо привести: 

1. Последние версии КД с корректировками, возникшими при замене 

обозначений. 

2. Перечень всех произведенных в КД изменений, оформленный в виде 

таблицы по примеру табл. М.5. 

3. Расшифровку использованных кодов классификационной характери-

стики. 
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